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Introducing SiteScope
HPE SiteScope is an agentless monitoring solution designed to help you ensure the availability and performance of distributed IT
infrastructure and applications. SiteScopemonitors collect server and application health across physical, virtual and cloud
infrastructures through a web-based architecture that does not require installing data collection agents on your production systems.
For details, see "SiteScopeOverview" on page 9.

In addition to the full edition, SiteScope is also available in the following editions:

l SiteScope Failover. This edition enables you to implement failover capability for infrastructuremonitoring. It automatically
switches the functions of a primary system to a standby server if the primary system fails or is temporarily taken out of service. For
details, see "SiteScope Failover Overview" on page 14.

l SiteScope for Load Testing. This edition, which is provided with LoadRunner and Performance Center, enables LoadRunner and
Performance Center users to define and use SiteScopemonitors on a LoadRunner or Performance Center application. For details,
see "Integrating with HP Load Testing Products" on page 207.



Chapter 1: SiteScope Overview
SiteScopemonitors collect key performancemeasurements and report topology on a wide range of back-end
infrastructure components. Themonitors are individually configured to automatically test performance and
availability of systems and services in the network environment.

SiteScopemonitoring includes alerting and reporting capabilities, along with a dashboard for a real-time
picture of themonitored environments. SiteScope can be configured to send alerts whenever it detects a
problem in the IT infrastructure. In addition, SiteScope can create reports for monitors or monitor groups that
display information about how the servers and applications you aremonitoring have performed over time. For
details, see "SiteScopeMonitoringModel" below.

To help you deploy monitors with similar monitoring configuration criteria across the enterprise, you can define
templates, or use preconfigured SiteScope solution templates. The use of templates enables you to develop
andmaintain a standardized set of monitor types and configurations in a single structure that can be
repeatedly deployed and easily updated using global change and replace capabilities, without having to update
each object individually.

SiteScope also includes alert template types that you can use to communicate and record event information in
a variety of media. You can customize alert templates tomeet the needs of your organization.

For a list of features in SiteScope, see "Key Features of SiteScope" below.

SiteScope Monitoring Model
SiteScope's Web-enabled architecture enables the creation and ongoing administration of a centralized,
scalable monitoring environment.

It consists of the following key components:

l Browser-based interface.Manages end user status information requests, configuration change requests,
and access control.

l Scheduler. Coordinates the running of monitors, alert creation, and report generation.
l Groups. A group is a container for monitoring assets. Groups may contain subgroups and are used to
organizemonitors. Groups are created prior to monitors.

l Monitors. A monitor collects performance and availability information about the system beingmonitored.
It checks the status of server components, key application processes, log files, or network devices, to
name a few. It also collects data based on selectedmetrics and displays a status of good, warning, or
error with respect to the configured thresholds.

l Alerts. An alert is an action triggered by a change in the status of amonitored asset. Alerts notify required
users when negative events or failures occur. An alert can be sent to a variety of media including email,
pager, Short Message Service (SMS)messages, or an SNMP trap.

l Reports. A report is a historical representation of monitored data for trending and analysis purposes.
SiteScope offers a variety of reports from quick monitor reports to detailedmanagement reports. Reports
enable you to track trends and operational performance and to troubleshoot problems.

Key Features of SiteScope
SiteScope has the following features:
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Agentless, Enterprise-Ready Architecture
l Enterprise-ready architecture. SiteScope provides simultaneous monitoring of a large number of
systems, and support for secure connections.

l Agentless monitoring. SiteScopemonitors without the deployment of agent software on the servers to
bemonitored. This functionmakes deployment andmaintenance of SiteScope relatively simple compared
to other performancemonitoring solutions.

l Simple installation and deployment. SiteScope is installed on a single server running as a service or a
process. This results in quick installation and easy monitoring configuration.

Web-Based User Interface
l Intuitive administration. SiteScope reduces the time spent managing amonitoring environment by
providing a user friendly browser-based interface for viewing and administering of themonitoring platform.
For details, see "Navigate SiteScope" on page 20.

l Unified Console. The Unified Console simplifies themanagement of large, distributed environments and
accelerates your ability to identify and resolve issues. It is also ideal for displaying enterprise-wide
monitoring status in a network operations setting. The Unified Console contains the following views:
l Event Console. Enables you to track the real time status of your monitored environment, prioritize and
dispatch events, andmanage the event lifecycle from a single interface. You can also see details of
historical events, which is useful for tracking the resolution of previous issues, and for identifying
trends and hidden patterns. For details, see "Event Console" on page 914.

l Multi-View. Enables you to see the status of everything that is beingmonitored in your IT infrastructure
in a single view, without losing the relationship between the data. You can group objects in various
different ways to fit the perspective of different personas. Multi-View is ideal for displaying enterprise-
widemonitoring status in a network operations setting. For details, see "Multi-View" on page 936.

l Ops View. Combines Multi-View and the Event Console in a single view. Working side-by-side helps
you isolate and diagnose problems by enabling you to identify events associated with a selected
monitor or monitor group, or amonitor associated with a selected event, and to drill down and perform
troubleshooting. For details, see "Ops View" on page 954.

l Manage. Provides self-servicemonitoring to non-admin users, and reduces the amount of monitoring
support required from the SiteScope administrator or monitoring team. After being granted the
necessary permissions by the SiteScope administrator, the application owner can perform common
administration actions such as deploy templates, updatemonitor configurations, runmonitors, view
associated alerts, and enable/disable monitors, groups, and alerts. For details, see "Manage View" on
page 955.

Standardized Monitor Deployments and Updates Using Templates
l User-defined templates. SiteScope supports the ability to create and publish reusable templates,
enabling you to set up and deploy multiple IT elements with similar monitoring configuration criteria. Using
the Publish Template Changes wizard, you can rapidly update your monitoring environment across the
entire enterprise, without the need for extensivemanual updates. For details, see "Create Templates" on
page 667.

l Solution Templates. SiteScope offers solution templates that feature built-in domain expertise in the
form of specializedmonitors, default metrics and thresholds, proactive tests, and best practices for a
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given application or component beingmonitored. For details, see "Deploy Solution Templates" on
page 762.

l Automated deployment with XML. SiteScope enables you to bypass the user interface and deploy
templates using an XML file. This saves your IT organization time andmoney by enabling the introduction
of a large number of monitors in a single operation. For details, see "Deploy Templates Automatically
Using an XML File" on page 732.

Infrastructure Performance and Availability Monitoring
l Out-of-the-box monitors. SiteScope provides more than 100 out-of-the-box monitors covering aspects
such as utilization, response time, usage, and resource availability. For details, see "Monitors and
Groups" on page 211.

l Customizable monitors. SiteScope provides custommonitors that enable you to extend your SiteScope
environment by creating new monitor types and customizing existingmonitors. By using custommonitors,
HPE customers and partners have the ability to develop solutions for environments not supported by
existing SiteScopemonitors. Custommonitors can also be shared with other users by publishing them to
the HPE SiteScope community on the HPE Live Network. For details, see "Create CustomMonitors" on
page 273.

l Elastic configuration. Elastic configuration is a way to automatically adjust the SiteScopemonitoring
configuration based on changes that are happening in your IT environment. SiteScope provides various
dynamic monitors that automatically update themselves over time by adding and removing counters and
thresholds as virtual machines move from one host system to another. In addition, baselining is supported,
where thresholds are dynamically changed based on historical monitoring data. Dynamic monitors include
VMware Host Monitors, VMware DatastoreMonitor, Generic Hypervisor Monitor, HadoopMonitor, HP
Vertica JDBC Monitor, KVMMonitor, Dynamic Disk SpaceMonitor, Dynamic JMX Monitor, and Dynamic
Docker Monitor.

l Baseline management. SiteScope can be used to create baselines and schedule specific thresholds
based on a time period or date. The baseline calculated for your configuration can be tested against actual
performance conditions to view the errors and warnings that would have been reduced by the calculated
baseline. Graphs can be used to compare your calculated baseline with current threshold settings to
determine potential performance improvements. For details, see "Set Monitor Thresholds Using a
Baseline" on page 279.

l Customization capabilities. SiteScope permits the display of customizations of groups andmonitors by
using custom data fields and HTML-sensitive description tags. In addition, SiteScope permits the
customization of alert text and report configurations by using templates and user-defined variables. For
details, see "Properties Available in Alerts, Templates, and Events" on page 1126.

l Self-monitoring. SiteScopemonitors key aspects of its own operability and identifies monitor
configuration problems and critical server load. It alsomonitors its own integration and data events when
configured to report to Application PerformanceManagement. For details, see "SiteScope Server Health
Monitors" on page 989.

Alerts, Notifications,and Reports
l Proactive alerting. Provides alerting capabilities, based on customizable thresholds, so that you can fix
problems before end users experience them. Alerts are sent to IT administrators based on configured
thresholds and defined schedules. There are several types of alert actions, such as sending email
messages, Simple Network Management Protocol (SNMP) traps, or executing a script. For details, see
"Configure SiteScope Alerts" on page 1072.

l Server-based reporting. SiteScope can collect multiple pre-selectedmetrics from a specific server and
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combine them into a single graph—giving you quick access to key performancemonitoring data for any
server in your environment. One of the key benefits of server-based reporting is the ability to drill down into
reports to troubleshoot server related issues. For details, see "Reports" on page 1138.

Predictive Analytics
Predictive Analytics. Predictive Analytics helps protect businesses from the impact of IT issues by
predicting potential problems in critical applications and informing you of issues that can affect the business
flow. SiteScope uses baseline and correlation calculations to analyze system problems and provide details to
assist with root cause analysis so that you can anticipate issues before business flows are impacted. For
details, see "Configure Predictive Analytics" on page 1188.

Integration With a Wide Variety of HPE Software and Third Party Products
SiteScope can be integrated with a variety of HPE software and third party products, including:

l Application Performance Management. SiteScope can be used as a data collector for Business
ServiceManagement (BSM). BSM receives data about end-users, business processes, and systems and
uses the data in reports and analysis. SiteScopemonitor data can be sent to BSM for all monitors, or for
selectedmonitors only. For details, see " Connecting to a BSM Server" on page 181.

l Operations Manager and Operations Management: combining agentless and agent-based
monitoring. SiteScope can be used in conjunction with Operations Manager (HPOM) or Operations
Management (OMi), such that a single console acts as a central repository for all discovered
events.SiteScope collects events and then logs it to an agent data store using the Operations Agent which
must be installed on the SiteScope server. This information is then forwarded to HPOM/Operations
Management. For details, see Integrating SiteScope with HP Operations Manager Products in the
SiteScope Help.

l Performance Manager and Performance Graphing: view both agentless and agent-based data
when monitoring performance. Using the Operations Agent that resides on the SiteScope server or a
profile database in BSM (for reporting to PerformanceGraphing only), you have visibility of SiteScope
metrics in PerformanceManager as well as the graphing component of Operations Management. For
details, see Integrating SiteScope with HP Operations Manager Products in the SiteScope Help.

l Other HPE software products. Data integration enables SiteScope reports to be displayed and the
SiteScope user interface to be hosted—all within Performance Center. You can also view SiteScope
system level performance and availability information within Diagnostics. Other integrations include the
ability to send SiteScope events andmetrics to Network NodeManager (NNMi) and the automatic
creation of monitors in SiteScope through its integration with Operations Orchestration. SiteScope also
integrates with Application Lifecycle Management (ALM) to sharemonitoring data and templates from the
production environment to enable load testing engineers to plan performance tests and application
deployment. Lastly, SiteScope serves as themonitoring foundation for LoadRunner and Performance
Center software, to better identify bottlenecks during the load testing phase. For details, see "Integrations
Overview" on page 169.

l Amazon CloudWatch. SiteScope can be used to report SiteScopemonitor measurement data to an
Amazon CloudWatch service. This integration enables customers who use SiteScope for monitoring their
AWS-hosted applications to report any SiteScopemetrics to Amazon CloudWatch service. SiteScope
metrics data can be used for AWS AutoScaling, reporting, and alerting. For details, see "Amazon
CloudWatch Integration Preferences" on page 563.

For a diagram illustrating the various SiteScope integrations, see "Integrating with Other Applications" on
page 172.
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Mobile Access
Monitor IT health from anywhere. You can access SiteScope from amobile device using SiteScope’s free
downloadable apps (supported on iPhone, iPad, iPod touch, and Android phones or tablets). With this
capability, you can search SiteScope servers to view individual monitors and group statistics, perform actions
on search results to mitigate issues, respond to email alerts when a problem is detected in the IT
infrastructure, add selectedmonitors and groups to a favorites list, and generate ad hoc reports for monitors,
groups, or alerts for specific time periods. For details, see "SiteScopeMobile Apps" on page 150.

Failover Capability for Monitoring Mission-Critical Applications in High Availability
Environments
Failover capabilities. SiteScope offers failover support to give you added redundancy and automatic failover
protection if a SiteScope server experiences availability issues. When the primary SiteScope server becomes
unavailable, a secondary server takes over, providing uninterruptedmonitoring. This capability does not
require additional hardware and takes advantage of mirroring operations that enables rollback capabilities in
the event of interruption. For details, see "SiteScope Failover Overview" on page 14.

Embraces Industry Standards and Government Certification Programs
SiteScope is committed to providing industry-leading infrastructuremonitoring software that embraces
industry standards and government certification programs.

l Common Criteria Certification. HPE SiteScope has been evaluated under the terms and conditions of
the Canadian CommonCriteria Scheme and complies with the requirements for CommonCriteria
Recognition Agreement (CCRA). SiteScope has achieved the CommonCriteria certification with
Evaluation Assurance Level (EAL) 2+.

l FIPs 140-2 Compliancy. SiteScope can be configured to work in FIPS 140-2 compliant mode. FIPS 140-
2 is a cryptographic module validation program, administered by the National Institute of Standards and
Technology (NIST), that specifies the security requirements for cryptographic modules.

For details, see the Running SiteScope Securely section of the SiteScope Deployment Guide (<SiteScope
root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Using SiteScope
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Chapter 2: SiteScope Failover Overview
The SiteScope Failover solution enables you to implement failover capability for infrastructuremonitoring by
provisioning for backups, redundancy, and failover mechanisms. It automatically switches the functions of a
primary system to a standby server if the primary system fails or is temporarily taken out of service.

SiteScope Failover provides the following:

l Automated, periodic mirroring of monitoring configurations from the primary SiteScope server to the
SiteScope Failover server.

l Automatedmonitoring of the availability of the primary SiteScope server.
l Automated enabling and disabling of mirroredmonitors based on the availability of the primary SiteScope.
A separate Failover license is required to enable the SiteScope instance to act as a failover for another
SiteScope installation (the Failover Edition license is provided with the Premium, Ultimate, and System
Collector editions at no additional cost).

For details on installing and using SiteScope Failover, see the HPE SiteScope Failover Guide (available from
<SiteScope root directory>\sisdocs\pdfs\SiteScopeFailover.pdf).
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Part 1: Getting Started
This section explains how to access SiteScope ("Log into SiteScope" on page 16) and how to navigate the
SiteScope user interface ("Navigate SiteScope" on page 20). It also provides a recommended flow for setting
up and administering your monitoring solution ("Set Up and Administer SiteScope" on page 54).

To help you get started with SiteScope, see the suggested workflows onmanually creating amonitoring
structure and creating amonitoring structure using a template in "Start Using SiteScope" on page 59.



Chapter 3: Log into SiteScope
You can access SiteScope from any computer with a network connection (intranet or Internet) to the
SiteScope server using a supportedWeb browser or from the Start menu onWindows platforms.
Alternatively, you can use a silent login URLwhich enables you to go directly to the specified SiteScope
server without showing the SiteScope login page (for details, see "Silent Login" below).

For details on browser requirements, as well as minimum requirements to successfully view SiteScope, see
the System Requirements section in the SiteScope Deployment Guide.

Learn About
Silent Login
You can access SiteScope using a silent login URL. This enables you to skip the login page and directly open
the user account for the given user name and password using the silent login address.

In addition, you can use silent login in conjunction with a page option view that you saved in your browser's list
of Favorites to open SiteScope directly to a particular group or view. For details on configuring a favorite page
option view, see PageOptions in "Common Toolbar" on page 22.

To start SiteScope using silent login, youmust encrypt the user login name and password using the
SiteScope Encryption Tool, and enter the encrypted information in the silent login URL. For task details, see
"How to access SiteScope using silent login" on the next page.

Notification Message Displayed When Logging in to SiteScope
The SiteScope Administrator can enable SiteScope to display a customizedmessage that is displayed in the
login screen when a user logs on to SiteScope. The administrator can determine the text of themessage. For
example, the administrator might want to notify users that they are about to log in to a secure system.

If a notificationmessage is displayed, click OK to confirm themessage, before you can proceed to use
SiteScope.

For details on enabling and configuring the login notificationmessage, see the Hardening section of the
SiteScope Deployment Guide.

Tasks
How to access SiteScope from a browser or from the Start menu
l To access SiteScope from a browser, enter the SiteScope address in aWeb browser. The default address
is: http://<server name>:8080/SiteScope.

l To access SiteScope from the Start menu (Windows platforms only), click Start > Programs > HP
SiteScope > Open HP SiteScope.

The first time SiteScope is deployed, there is a delay for initialization of the interface elements. When you
connect to a SiteScope, the SiteScope opens to the Dashboard view.

Tip:
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l To restrict access to this account and its privileges, you should edit the Administrator account profile
to include a user login name and login password. SiteScope then displays a login page before
SiteScope can be accessed. If no user name and password are defined for the Administrator user,
SiteScope skips the login page and automatically logs in. For details on editing the Administrator
account profile, see "User Management Preferences" on page 625.

l It is also recommended to change the Integration Viewer account profile to include a user login name
and login password.

How to access SiteScope using silent login
This task describes how to create a silent login URL, and how to access the specified SiteScope server
directly without showing the SiteScope login page.

1. Create a user profile
In thePreferences context, click theUser Management Preferences menu and create a user account.
For user interface details, see "User Management Preferences Page" on page 628.

Note:

l The Administrator account is the default account that is active when the product is installed. To
create other accounts, youmust first edit the Administrator account profile to include a user login
name and password.

l Silent login is not supported for users that contain any of the following special characters in the
password: ‘ (quote), “ (double quote), / (slash), \ (backslash) and ’ (apostrophe).

Example:

A user profile with the displayed name Regular Userwas added with login name Regular and
password Regular.

Using SiteScope
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2. Configure user permissions - optional
Configure the user action permissions in thePermissions section of the New/Edit User dialog box. By
default, a new user has full permissions except for the permission tomodify or delete other user
preferences.
For user interface details, see "Permissions" on page 636.

3. Encrypt the user profile
Encrypt the user login name and password.
a. In a command prompt, run the following command for the login name:

<SiteScope root directory>\tools\AutoDeployment\
encrypt_password.bat <login name>
For example:
C:\SiteScope\tools\AutoDeployment\encrypt_password.bat Regular
The encrypted value for Regular is (sisp)uq1zrGl1Ims=.

b. Encode any non-standard URL characters as required. Information about encoding non-standard
URL characters is available frommany publicly available web sites. Note that URL encoding of a
character consists of a % symbol, followed by the two-digit representation for the character.
In this example, = is a reserved character, and should be replaced by %3D. Thus, the encoded value
for Regular is (sisp)uq1zrGl1Ims%3D.

c. Save the encrypted value so that you can add it to the silent login URL.
d. Repeat the encryption process for the login password (if different from the login name).

4. Enter the SiteScope silent login URL in a browser
Create a SiteScope silent login URL for the user profile, and enter the URL in aWeb browser. The URL
should be in the format:

Using SiteScope
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http://<server_name>:8080/SiteScope?sis_silent_login_type=encrypted&login=
<encrypted_login_name>&password=<encrypted_password>
where <encrypted_login_name> and <encrypted_password> are replaced by the encrypted login name
and password.

Note: To force SiteScope to reject URL encrypted login, you need to set the _
rejectCredentialsInURL property in <SiteScope root directory>\groups\master.config file to
true. However, when you use this option, all URLs which provide drill down functionality and contain
encrypted login properties will stop working.

5. Results
SiteScope skips the login page and directly opens the user account for the given user name and
password.

Note: If values entered for the login name and password parameters do not exist, are not found, or if
authentication fails, then the SiteScope login page is displayed.

User Sessions and Concurrency
By default, SiteScope allows concurrent user sessions. You can havemultiple sessions that are active
simultaneously for a single user ID.

If you want to have only one active session of SiteScope at a time for a single user ID, you can add the
parameter _allowConcurrentSession to themaster.config file and set it to false. Themaster.config file is
located at <SiteScope_InstallDir>/SiteScope/Groups. If you want to enable concurrent user sessions again,
set the parameter _allowConcurrentSessionto true (_allowConcurrentSession=true) in themaster.config
file.

Note: You DONOT have to restart SiteScope after you add this parameter since SiteScope checks for
this at every log in.

Using SiteScope
User Sessions and Concurrency
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Chapter 4: Navigate SiteScope
When you connect to a SiteScope, the SiteScope opens to the Dashboard view as shown below. If you enter
a user name to log on to SiteScope, it appears on the upper-right side of the window.

Learn About
This section contains:

l "Key Navigation Elements" below
l "Navigating and Performing Actions in the Context Tree" on the next page
l "SiteScope Keyboard Shortcuts" on the next page

Key Navigation Elements
The SiteScope window contains the following key elements:

l SiteScope common toolbar. Provides access to page options, documentation, and additional
resources. This toolbar is located on the upper part of the window. For more details, see "Common
Toolbar" on page 22.

l SiteScope context toolbar. Contains buttons for frequently-used commands in the selected SiteScope
context. For more details, see "Context Toolbar Buttons" on page 22.

l SiteScope context tree. Enables you to create andmanage SiteScope objects in a tree structure. For
details, see "Monitor Tree" on page 26, "Remote Server Tree" on page 36, and "Template Tree" on
page 37.

l SiteScope context buttons. Provide access to the SiteScopeMonitors, Remote Servers, Templates,
Preferences, Server Statistics, and Diagnostic Tools. For more details, see "Context Buttons" on page 25.

Note: The SiteScope Classic interface that was available in earlier SiteScope versions using the
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URL http://<sitescope_host>:8888 is no longer available for managing SiteScope. For more
information, see SiteScope Classic Interface in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

Navigating and Performing Actions in the Context Tree
There are several ways to navigate the context tree, perform actions, and edit object properties.

You can perform actions using the context toolbar, or you can select any object within the context tree itself,
and right-click the object to access amenu of options for that object. For example, if you right-click the
SiteScope node in themonitor tree, you select from amenu listing only those actions that can performed on
the SiteScope node. You can also perform actions onmultiple groups andmonitors. For details, see "Perform
Actions onMultiple Groups andMonitors" on page 73.

For details of the context tree objects and context menu options available for each object in the tree, see
"Monitor Tree" on page 26, "Remote Server Tree" on page 36, "Template Tree" on page 37, "Preferences
Menu" on page 45, "Server Statistics Menu" on page 47, and "Tools Menu" on page 48.

SiteScope Keyboard Shortcuts
You can perform the following commands in themonitor tree, template tree, and remote server tree by
pressing the corresponding shortcut keys:

Shortcut
Key Description

CTRL+A Opens the New Alert dialog box, enabling you to create a new alert. For user interface details,
see "New/Edit Alert Dialog Box" on page 1092.

CTRL+C Copies the selected item and puts it on the Clipboard.

CTRL+D Deletes the selected item.

CTRL+F Opens the New Filter dialog box, enabling you to create a new filter. For user interface details,
see "Filter Objects in the SiteScope View" on page 65.

CTRL+G Opens the New Group dialog box, enabling you to create a new group. For user interface
details, see "New SiteScopeGroup Dialog Box" on page 215.

CTRL+J Opens the Select Template/Group dialog box, enabling you to select the template that you
want to deploy or the group to which you want to deploy a template. For details on the Select
Template user interface, see "Select Template Dialog Box" on page 270. For details on the
Select Group user interface, see "Select Group Dialog Box" on page 726.

CTRL+M Opens the New Monitor dialog box, enabling you to add a new monitor. For user interface
details, see "New Monitor Dialog Box" on page 229.

CTRL+R Clears the filter configured in the Filter dialog box. For user interface details, see "Filter Objects
in the SiteScope View" on page 65.

CTRL+V Pastes the contents of the Clipboard to the selected location.

CTRL+X Cuts the selected item and puts it on the Clipboard.

Using SiteScope
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Shortcut
Key Description

DELETE Deletes the selection.

F5 Refreshes the tree.

UI Descriptions
Common Toolbar
The SiteScope common toolbar, located at the top of the SiteScope window, is accessible from all contexts,
and contains the following buttons:

UI Element Description

Enables you to select the following page options:

l Add to Favorites. Enables you to add the current SiteScope view to your list of
Favorites in your browser.

l Save Layout to User Preferences. Enables you to save the current view as the
default layout for the specific SiteScope user.

Enables you to access SiteScope Help, context-sensitive help for specific windows, and
other additional online resources.

You can also see descriptions of user interface elements in most pages or dialog boxes.

To enable this feature, click theQuick Help button in the specific page or dialog box,
and rest themouse pointer on the element box to display a Tool Tip description. Tomake
this feature unavailable, click theQuick Help button again.

Logs you out of your SiteScope session.

You can customize your view of themonitor tree to list only those SiteScope elements with which you are
working. You can also assign search/filter tags to your groups, monitors, reports, and alerts to further refine
your selection. For details on this topic, see "Filter Objects in the SiteScope View" on page 65.

SiteScope enables you to changemonitor configurations across multiple monitors, groups, or multiple
SiteScopes using Global Replace. For details on the Global Replace user interface, see "Global Search and
Replace" on page 78.

Context Toolbar Buttons
The context toolbar, which is displayed above the upper left pane, enables you to perform common functions
in theMonitors, Remote Servers, and Templates views.

Some toolbar buttons are not available in all SiteScope views. For more details on each view, see "Monitor
Tree" on page 26, "Remote Server Tree" on page 36, "Template Tree" on page 37.

Using SiteScope
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UI
Element Description

New. Adds SiteScope objects (groups, monitor, alerts, remote servers, and templates) to the
relevant tree. The objects that you can add depend on the context.

Edit. Enables you to select one of the following editing options:

l Copy.Makes a copy of the selected object.
l Paste. Copies or moves an object to the selected location in the tree.
l Cut.Moves the selected object to another location in the tree.
l Delete. Deletes the selected object from the tree.

Delete. Deletes the selected remote server from the tree.

Note:Available in the remote server tree toolbar only.

Test. Tests the connection to the server.

Note:Available in the remote server tree toolbar only.

DetailedTest. Runs a test that displays the result of running commands on the remote server.
This enables checking the permissions for the defined user.

Note:Available in the remote server tree toolbar for UNIX servers only.

Filter. Filters themonitor tree to display only those SiteScope objects that meet the criteria that
you define.

Select a filter option:

l New Filter. Opens the New Filter dialog box which enables you to create a filter. For user
interface details, see "Filter Objects in the SiteScope View" on page 65.

l Clear Filter. Clears the filter settings.
l <List of existing filters>. Displays a list of existing filters. The following options are
available:

l Apply. Applies the filter to the left tree pane.

l Edit. Opens the Edit Filter dialog box which enables you to edit the filter. For user interface
details, see "Filter Objects in the SiteScope View" on page 65.

l Delete. Deletes the filter from the filter list.

Note:Available in themonitor tree toolbar only.

Manage Monitors and Groups. Enables you to perform an action (copy, move, delete, run
monitors, enable/disable monitors, enable/disable associated alerts) onmultiple groups and
monitors in themonitor tree. You can also filter the list of objects in themonitor tree. For details
on theManageMonitors andGroups dialog box, see "Perform Actions onMultiple Groups and
Monitors" on page 73.

Note: Available in themonitor tree toolbar only.

Using SiteScope
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UI
Element Description

Collapse All. Collapses all branches in the tree.

Note: Available in themonitor and template tree toolbar only.

Expand All. Expands all branches in the tree.

Note: Available in themonitor and template tree toolbar only.

Refresh. Refreshes the data in the tree.

Show all. Displays hidden toolbar buttons.

Quick Search. Enables you to search configuration objects (groups, monitors, remote servers,
templates, or counters) for a specific name or value in themonitor, template, remote server, or
counters tree (in themonitor properties for some browsable counter monitors).

Click the left end of the box to open the drop-downmenu of filter options:

l Select Case sensitive to search for the filter string exactly as entered. Select Case
insensitive to ignore the case of the filter string.

l Select Use wild cards to use the wildcard symbol * in the filter string. Enables you to use
asterisk (*) characters in your search string in order to type only part of the item.

l SelectMatch from start to search for the filter string at the beginning of a property name or
value. SelectMatch exactly to search for the exact filter string. SelectMatch anywhere to
search for the filter string anywhere in the properties.

l SelectMatch leaf node only to search for the filter string in leaf nodes (monitors and empty
groups only) in the tree. Clear to search all nodes.

l Select Hide nodes without children to hide groups that have no leaf nodes that match the
filter string (empty groups).

l Select Keep the children if any of their ancestors match to display all child nodes of
groups that match the filter string, even though the child does not match the search string.

l Select Use auto filter to search automatically after a letter is entered in the search text
field. You can configure a delay before the auto filter runs inPreferences > Infrastructure
Preferences > General Settings > Quick search auto filter delay (milliseconds). The
default delay is 800milliseconds (0.8 seconds). If Use auto filter is not selected, youmust
press the Enter key every time you want to run the search.

Tip: In a loaded environment, it is recommended to increase the delay time inQuick search
auto filter delay time, or to disable theUse auto filter option.

Note: If a filter is applied to a tree, the search is restricted to the records currently displayed.

Show/Hide Pane. (Between left and right panes) Shows or hides the tree, and expands or
contracts the right pane.

Using SiteScope
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UI
Element Description

(Below context menus) Click to configure the context button display. The following options are
available:

l Show More Buttons. Click to show the next highest ranking SiteScope context button in
the left pane. This button is available only if not all the context buttons are displayed.

l Show Fewer Buttons. Click to hide the lowest ranking SiteScope context button from the
left pane. This button is available only if at least one context button is displayed.

l Option. Choose the order in which the SiteScope context buttons are displayed. Use the
Move Up andMove Down buttons to rearrange the order. To hide a button from the left
pane, clear the check box for the context. By default, all the context buttons are selected
(displayed in the left pane).

l Add or Remove Buttons. Shows the show/hide status of the context buttons. By default,
all the context buttons are selected (displayed in the left pane). To hide a button, clear the
check mark for the context.

Context Trees and Menu Options
l "Monitor Tree" on the next page
l "Remote Server Tree" on page 36
l "Template Tree" on page 37
l "Preferences Menu" on page 45
l "Server Statistics Menu" on page 47
l "Tools Menu" on page 48

Tabs
l Dashboard Tab (see "View andManage Data in the SiteScope Dashboard" on page 891)
l Properties Tab (see "CommonMonitor Settings" on page 242)
l "Analytics Tab / New Predictive Analytics Dialog Box" on page 1201
l "Alerts Tab" on page 51
l "Reports Tab" on page 52

Context Buttons
SiteScope has the following contexts that are available from the left pane:

UI Element Description

Enables you to create andmanage SiteScope groups andmonitors in a hierarchy
represented by amonitor tree. For user interface details, see "Monitor Tree" on the next
page.

Enables you to set up the connection properties so that SiteScope canmonitor systems
and services running in remoteWindows and UNIX environments. For user interface
details, see "Remote Server Tree" on page 36.

Using SiteScope
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UI Element Description

Enables you to use templates to deploy a standardized pattern of monitoring tomultiple
elements in your infrastructure. You can use preconfigured SiteScope solution template
or create andmanage your own templates. For user interface details, see "Template
Tree" on page 37.

Enables you to configure specific properties and settings related tomost of the
administrative tasks within SiteScope. For user interface details, see "Preferences
Menu" on page 45.

Enables you to view key SiteScope server performancemetrics. For user interface
details, see "Server Statistics Menu" on page 47.

Displays diagnostic tools that can help you troubleshoot problems in SiteScope and
facilitate monitor configuration. For details on the available tools, see "SiteScope Tools"
on page 91.

Monitor Tree
Themonitor tree represents the organization of systems and services in your network environment. The tree
includes containers and objects within your infrastructure. The shortcut menu options include descriptions of
the context menu options available for each object in themonitor tree.

To access Select theMonitors context. Themonitor tree appears in the left pane.

Important
information

l The root node of the tree is the SiteScope container. Only one SiteScope node exists in
themonitor tree. You add all other elements to the tree under the SiteScope node.

l You can search for objects in themonitor tree by selecting a node and typing the
characters you want to search in the popup search box. Click the ESC key to close the
search box.

See also "Monitors andGroups" on page 211

Monitor Tree Objects
User interface elements are described below:

UI
Element Description

Represents an individual SiteScope server.

Parent:Enterprise node or container.

Add to tree by: Importing or adding an empty SiteScope profile.

Using SiteScope
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UI
Element Description

Represents a SiteScopemonitor group or subgroup (with enabledmonitors/with nomonitors or
no enabledmonitors).

If an alert has been set up for themonitor group or subgroup, the alert symbol appears next to
the group icon.

If a Management report has been set up for themonitor group or subgroup, the report symbol
appears next to the group icon.

Parent:SiteScope or SiteScope group.

Add to tree by:Creating, or importing with a SiteScope that has groups defined.

Represents a SiteScopemonitor (enabled/disabled).

If an alert has been set up for themonitor, the alert symbol appears next to themonitor icon.

If a Management report has been set up for themonitor, the report symbol appears next to the
monitor icon.

Parent:SiteScope group or subgroup, template, or solution template.

Add to tree by:Creating, or importing with a SiteScope that has monitors configured.

Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScopemonitors.

Parent:SiteScope.

Add to tree by:Automatically added with SiteScope object.

Using SiteScope
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SiteScope Shortcut Menu Options
User interface elements are described below:

Menu Item (A-Z) Description

Baselining Enables you to create a baseline for monitoring variations in
response times and performance in the infrastructure for all monitors
under SiteScope.

l Calculate. Enables you to select monitors, and specify the
relevant time and schedule to be used for calculating the
baseline. It also enables you to select and fine-tune the baseline
adherence level and define boundaries.

l Review & Activate. Displays a summary of calculatedmonitors
and baseline data. It also enables you to save the current monitor
configuration, view and retry failed operations, view baseline
measurement graphs, and apply the baseline configuration.

l Remove. Enables you to remove the baseline threshold or
recalculate the baseline after a baseline has been calculated.

l Status Report. Displays information about the baseline status
for all monitors under SiteScope.

For details on this topic, see "Set Monitor Thresholds Using a
Baseline" on page 279.

Deploy Template Opens the Select Template dialog box that enables you to select a
template to deploy to the group. For user interface details, see
"Select Template Dialog Box" on page 270.

Deploy Template Using CSV Opens the Select Template dialog box which enables you to select a
template to deploy to the group using a CSV file. For user interface
details, see "Select Template Dialog Box" on page 270.

Expand All Opens all the subtrees under SiteScope.

Global Search and Replace Opens theGlobal Search and ReplaceWizard, which enables you to
run a global search and replace for monitor, alert, group, preferences,
alert action, and report properties. For details on this topic, see
"Global Search and Replace" on page 78.

Monitor Deployment Wizard This menu item is available only to those users accessing SiteScope
from System Availability Management (SAM) Administration in
APM. Opens theMonitor Deployment Wizard. For details on this
topic, see "Monitor Deployment Wizard" in the APM Application
Administration Guide in the APMHelp.

New > Alert Opens the New Alert window which enables you to define a new alert
for SiteScope. For details on this topic, see "Configure SiteScope
Alerts" on page 1072.
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Menu Item (A-Z) Description

New > Group Opens the New Group window which enables you to define a new
SiteScope group. For user interface details, see "New SiteScope
Group Dialog Box" on page 215.

Paste Pastes the selected SiteScope object (that was previously copied or
cut) to the SiteScope node.

Paste from other SiteScope This menu item is available only through SAM Administration when
there is more than one SiteScope connected to APM. Pastes the
selected SiteScope object (that was previously copied or cut) from
another SiteScope to the SiteScope node.

Reports >
Management/Quick/Monitor/Alert

Enables you to select the type of SiteScope report you want to
define. For details on these reports, see "Create SiteScope Reports"
on page 1139.

Reports > Server-Centric Enables you to generate a Server-Centric report for any remote
server beingmonitored by aMicrosoft Windows Resources or UNIX
Resources monitor, provided themonitor has theEnable Server-
Centric Report check box selected. For details, see "Create Server-
Centric Reports" on page 1179.

Reports > BSM Configuration
Changes

This menu item is available only through SAM Administration when
the SiteScope is connected to APM. Displays a log of configuration
changes made to APM. For details, see "Create SiteScope Reports"
on page 1139.

Tools Available when configuring or editing specific monitors (provided you
are an administrator in SiteScope, or a user grantedUse monitor
tools permissions). If a tool is available, click to open and run the
tool with themonitor's existing data as its input. The test results
appear in theResults pane. For details on the available tools, see
"SiteScope Tools" on page 91.
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Group Shortcut Menu Options
User interface elements are described below:

Menu Item (A-Z) Description

Baselining Enables you to create a baseline for monitoring variations in
response times and performance in the infrastructure for all monitors
in the group.

l Calculate. Enables you to select monitors from the group and
specify the relevant time and schedule to be used for calculating
the baseline. It also enables you to select and fine-tune the
baseline adherence level and define boundaries.

l Review & Activate. Displays a summary of calculatedmonitors
and baseline data for the group. It also enables you to save the
current monitor configuration, view and retry failed operations,
view baselinemeasurement graphs, and apply the baseline
configuration.

l Remove. Enables you to remove the baseline threshold or
recalculate the baseline after a baseline has been calculated.

l Status Report. Displays information about the baseline status
for all monitors in the group.

For details on this topic, see "Set Monitor Thresholds Using a
Baseline" on page 279.

Copy Copies the group and its contents (monitors, alerts, and reports) to a
monitor group or template.

Note:When copying a group that contains monitors with baseline
thresholds, the baseline thresholds are replaced with static
thresholds (which are the current percentile values), and themonitors
are no longer in baselinemode.

Copy to other SiteScope This menu item is available only through SAM Administration when
there is more than one SiteScope connected to APM. Copies the
group and its contents (monitors, alerts, and reports) from another
SiteScope to amonitor group or template in the SiteScope node.

Note:When copying several monitors which have dependencies
between them to other SiteScopes, copy them together with the
group container in case it is required to keep the dependency
between them.

Copy to Template Copies the group and its contents (monitors, alerts, and reports) to a
template group. For details on this topic, see "How to Create a
Template by Copying Existing Configurations" on page 682.
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Menu Item (A-Z) Description

Cut Moves the group and its contents (monitors, alerts, and reports) or a
monitor and its contents (alerts and reports) to amonitor group.

Note:Whenmoving a group that contains monitors with baseline
thresholds, the baseline thresholds are replaced with static
thresholds (which are the current percentile values), and themonitors
are no longer in baselinemode.

Delete Deletes the group.

Note:You cannot delete a group if it has dependent alerts or reports
at the container level. To delete a group with dependencies, you
must remove the group from Alert Targets andReport Targets for
each dependency, and then delete the group. You can delete groups
that have dependencies at the child level.

Deploy Template Opens the Select Template dialog box that enables you to select a
template to deploy to the group. For user interface details, see
"Select Template Dialog Box" on page 270.

Deploy Template Using CSV Opens the Select Template dialog box which enables you to select a
template to deploy to the group using a CSV file. For user interface
details, see "Select Template Dialog Box" on page 270.

Enable/Disable Monitor Opens the Enable/Disable Monitors in Group dialog box which
enables you to enable or disable monitors in the group, regardless of
the setting in themonitor properties. If you select Disable, the
monitors are disabled until you return to this dialog box and select
Enable. For details on the Enable/Disable Monitor user interface,
see "Enable/Disable Monitors in Group Dialog Box" on page 903.

Expand All Opens all the subtrees under the group.

Global Search and Replace Opens theGlobal Search and ReplaceWizard, which enables you to
run a global search and replace for monitor, alert, group, preferences,
alert action, and report properties. For details on this topic, see
"Global Search and Replace" on page 78.

Monitor Deployment Wizard This menu item is available only to those users accessing SiteScope
from SAM Administration in APM. Opens theMonitor Deployment
Wizard. For details on this topic, see "Monitor Deployment Wizard"
in the APM Application Administration Guide in the APMHelp.

New > Alert Opens the New Alert window which enables you to define a new alert
for the group. For details on this topic, see "Configure SiteScope
Alerts" on page 1072.

New > Group Opens the New Group window which enables you to define a new
SiteScope group. For user interface details, see "New SiteScope
Group Dialog Box" on page 215.
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Menu Item (A-Z) Description

New > Monitor Opens the New Monitor window which enables you to define a new
SiteScopemonitor. For user interface details, see "New Monitor
Dialog Box" on page 229.

Paste Pastes the selected group and its contents (monitors, alerts, and
reports) or amonitor and its contents (alerts and reports) to the
specifiedmonitor group.

Paste from other SiteScope This menu item is available only through SAM Administration when
there is more than one SiteScope connected to APM. Pastes the
selected group and its contents (monitors, alerts, and reports) or a
monitor and its contents (alerts and reports) from another SiteScope
to the specifiedmonitor group.

Reports >
Management/Quick/Monitor/Alert

Enables you to select the type of SiteScope report you want to
define. For details on this topic, see "Create SiteScope Reports" on
page 1139.

Reports > Server-Centric Enables you to generate a Server-Centric report for any remote
server beingmonitored by aMicrosoft Windows Resources or UNIX
Resources monitor within the specifiedmonitor group, provided the
monitor has theEnable Server-Centric Report check box selected.
For details, see "Create Server-Centric Reports" on page 1179.

Run Monitors Runs any monitors configured in the group, and opens an information
window with the results.
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Monitor Shortcut Menu Options
User interface elements are described below:

Menu Item (A-Z) Description

Baselining Enables you to create a baseline for monitoring variations in
response times and performance in the infrastructure for the specific
monitor.

l Calculate. Enables you to select themonitor and specify the
relevant time and schedule to be used for calculating the
baseline. It also enables you to select and fine-tune the baseline
adherence level and define boundaries.

l Review & Activate. Displays a summary of the calculated
monitor's baseline data. It also enables you to save the current
monitor configuration, view and retry failed operations, view
baselinemeasurement graphs, and apply the baseline
configuration.

l Remove. Enables you to remove the baseline threshold or
recalculate the baseline after a baseline has been calculated.

l Status Report. Displays information about themonitor's
baseline status.

For details on this topic, see "Set Monitor Thresholds Using a
Baseline" on page 279.

Copy Copies themonitor and its contents (alerts and reports) to amonitor
group or template.

Note:When copying amonitor with baseline thresholds, the baseline
thresholds are replaced with static thresholds (which are the current
percentile values), and themonitor is no longer in baselinemode.

Copy to other SiteScope This menu item is available only through SAM Administration when
there is more than one SiteScope connected to APM. Copies the
monitor and its contents (alerts and reports) from another SiteScope
to amonitor group or template.

Note:When copying several monitors which have dependencies
between them to other SiteScopes, copy them together with the
group container in case it is required to keep the dependency
between them.

Copy to Template Copies themonitor and its contents (alerts and reports) to a template
group. For details on this topic, see "How to Create a Template by
Copying Existing Configurations" on page 682.
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Menu Item (A-Z) Description

Cut Moves themonitor and its contents (alerts and reports) to amonitor
group.

Note:Whenmoving amonitor with baseline thresholds, the baseline
thresholds are replaced with static thresholds (which are the current
percentile values), and themonitor is no longer in baselinemode.

Delete Deletes themonitor.

Note:You cannot delete amonitor if it has dependent alerts or
reports at the container level. To delete amonitor with dependencies,
youmust remove themonitor from Alert Targets andReport
Targets for each dependency, and then delete themonitor. You can
deletemonitors that have dependencies at the child level.

Enable/Disable Monitor Opens the Enable/Disable Monitors in Group dialog box which
enables you to enable or disable themonitor, regardless of the
setting in themonitor properties. If you select Disable, themonitor is
disabled until you return to this dialog box and select Enable. For
details on the Enable/Disable Monitor user interface, see
"Enable/Disable Monitors in Group Dialog Box" on page 903.

Global Search and Replace Opens theGlobal Search and ReplaceWizard, which enables you to
run a global search and replace for monitor, alert, group, preferences,
alert action, and report properties. For details on this topic, see
"Global Search and Replace" on page 78.

New > Alert Opens the New Alert window which enables you to define a new alert
for themonitor. For details on this topic, see "Configure SiteScope
Alerts" on page 1072.

Paste Pastes the selectedmonitor context object to the specifiedmonitor.

Paste from other SiteScope This menu item is available only through SAM Administration when
there is more than one SiteScope connected to APM. Pastes the
selectedmonitor context object from another SiteScope to the
specifiedmonitor.
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Menu Item (A-Z) Description

Predictive Analytics l New Predictive Analytics. Enables you to configure analytics
for the selectedmonitor. This menu item is available only if:
l Analytics is enabled in Infrastructure Preferences >
Analytics Settings > Analytics enabled (this is the default
setting).

l Themonitor is not of an excluded type that is listed in
Infrastructure Preferences > Analytics Settings >
Excluded monitor types.

l Delete Predictive Analytics. Enables you to remove predictive
analytics from the selectedmonitor. This menu item is available
only if analytics have been configured for the selectedmonitor.

For details on this topic, see "Configure Predictive Analytics" on
page 1188.

Reports >
Management/Quick/Monitor/Alert

Enables you to select the type of SiteScope report you want to
define. For details on this topic, see "Create SiteScope Reports" on
page 1139.

Reports > Server-Centric Enables you to generate a Server-Centric report for any remote
server beingmonitored by aMicrosoft Windows Resources or UNIX
Resources, provided themonitor has theEnable Server-Centric
Report check box selected. For details, see "Create Server-Centric
Reports" on page 1179.

Run Monitor Runs themonitor and opens an information window with the results.
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SiteScope Health Shortcut Menu Options
User interface elements are described below:

Menu Item (A-Z) Description

Disable Logging Disables logging SiteScope server health data to the daily log file. For details on
SiteScope server health, see "SiteScope Server Health Monitors" on page 989.

Enable Logging Enables logging SiteScope server health data to the daily log file. For details on
SiteScope server health, see "SiteScope Server Health Monitors" on page 989.

Expand All Opens all the subtrees under SiteScope Health.

New > Alert Opens the New Alert window which enables you to define a new alert for Health. For
details on this topic, see "Configure SiteScope Alerts" on page 1072.

New > Group Opens the New Group window which enables you to define a new SiteScope group.
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

New > Monitor Opens the New Monitor window which enables you to define a new SiteScope
monitor. For user interface details, see "New Monitor Dialog Box" on page 229.

Paste Pastes monitors andmonitor groups into the Health container.

Recreate
missing health
monitors

Enables you to restore health monitors that have been deleted from theHealth
container.

Reports Enables you to select the type of SiteScope report you want to define. For details on
this topic, see "Create SiteScope Reports" on page 1139.

Run Monitors Runs the health monitors and opens an information window with the results.

Remote Server Tree
The remote server tree represents the remote servers configured in your network environment. The shortcut
menu options include descriptions of the context menu options available for each object in the remote server
tree.

To access Select theRemote Servers context. The remote server tree appears in the left pane.

See also "Remote Servers Properties Page" on page 458

Remote Server Tree Objects
User interface elements are described below:

UI Element Description

Represents theWindows/UNIX remote server container in the remote server view.
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UI Element Description

Represents aWindows/UNIX remote server.

Parent:Windows/UNIX Remote Server container.

Add by:Creating in theWindows/UNIX Remote Server container or template tree.

Remote Servers Shortcut Menu Options
User interface elements are described below:

Menu Item (A-Z) Description

New Microsoft Windows/UNIX
Remote Server

Opens the New Server window which enables you to define a new
Microsoft Windows or UNIX server.

Remote Server Shortcut Menu Options
User interface elements are described below:

Menu
Item (A-Z) Description

Copy to
Template

Copies the remote server to a template group. For details on this topic, see "How to Create a
Template by Copying Existing Configurations" on page 682.

Delete Deletes the remote server

Detailed
Test

Enables you to test the running commands on the remote host and check the permissions for
the defined user. Available for UNIX servers only.

Test Enables you to test the connection to the remote server.

Template Tree
The template tree represents user-defined templates, SiteScope solution template sets, template examples,
andMonitor Deployment Wizard templates that are available for deployment to monitor groups. The shortcut
menu options include descriptions of the context menu options available for each object in the template tree.

To access Select the Templates context. The template tree appears in the left pane.

See also l "Create Templates" on page 667
l "Deploy Solution Templates" on page 762
l "SiteScope Templates Page" on page 687
l "Templates Tree - Alerts Tab" on page 689
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Template Tree Objects
User interface elements are described below:

UI
Element Description

Represents an individual SiteScope server.

Parent:Enterprise node or container.

Add to tree by: Importing or adding an empty SiteScope profile.

Represents a solution template container (available/unavailable). Only licensed solution
templates that have the available icon are configurable solution templates.

Parent:SiteScope.

Represents a template container. A template container is used to organize configuration
deployment templates.

Parent:SiteScope.

Add to template tree by:Creating, or importing with a SiteScope that has template
containers defined.

Represents a template configuration for deploying SiteScope objects.

Parent: Template container.

Add to template tree by:Creating.

Represents a SiteScope template group or subgroup (with enabledmonitors/with nomonitors
or no enabledmonitors).

If an alert has been set up for the template group or subgroup, the alert symbol appears next
to the group icon.

If a Management report has been set up for the template group or subgroup, the report
symbol appears next to the group icon.

Parent: Template.

Add to tree by:Creating, or importing with a SiteScope that has template groups defined.

Represents a SiteScope templatemonitor (enabled/disabled).

If an alert has been set up for the templatemonitor, the alert symbol appears next to the
monitor icon.

If a Management report has been set up for the templatemonitor, the report symbol appears
next to themonitor icon.

Parent: Template group or subgroup, template, or solution template.

Add to tree by:Creating, or importing with a SiteScope that has templatemonitors
configured.
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UI
Element Description

Represents aWindows/UNIX remote server.

Parent: Template.

Add by:Creating in the remote server tree or template tree.

Represents a variable used as placeholder to prompt for input when deploying a template.

Parent: Template.

Add to template tree by:Creating.

SiteScope Root - Shortcut Menu Options
User interface elements are described below:

Menu
Item (A-Z) Description

Expand
All

Opens all the subtrees under SiteScope.

Import >
Template

Opens the Template Import window which enables you to import a template file. For details,
see "Template Import Dialog Box" on page 719.

Import >
Content
Package

Opens the Import Content Package window which enables you to import a content package
that can include one or more templates and their dependencies (for example, templates.os
files, .jar files, and .conf files). Content packages are required for sharing Custommonitors, or
monitors with extension files like scripts or alert files, with other SiteScope users. For details,
see "Import Content Package Dialog Box" on page 719.

New >
Template
Container

Opens the New Template Container window which enables you to define a new template
container.

Paste Pastes a template container under the SiteScope root.

Solution Template Container - Shortcut Menu Options
User interface elements are described below:

Menu Item (A-Z) Description

Expand All Expands the solution templates container to display all the solution templates
within the container.
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Solution Template - Shortcut Menu Options
User interface elements are described below:

Menu Item
(A-Z) Description

Copy Copies a solution template. You can paste the solution template to a template container in the
template tree.

Deploy
Template

Opens the Select Group dialog box which enables you to select the group to which to deploy
the solution template. For user interface details, see "Select Group Dialog Box" on page 726.

Deploy
Template
Using
CSV

Opens the Select Group dialog box which enables you to select the group to which to deploy
the template using a CSV file. For user interface details, see "Select Group Dialog Box" on
page 726.

Expand
All

Expands the solution templates container to display all the solution templates within the
container.

Generate
XML

Opens theGenerate Auto Deployment XMLwindow which enables you to create an XML file
to use for automatically deploying the solution template. For details, see "Deploy Templates
Automatically Using an XML File" on page 732.

Template Container - Shortcut Menu Options
User interface elements are described below:

Menu
Item (A-Z) Description

Copy Copies the template container and its contents. You can paste the template container under
the SiteScope root or a selected template container in the template tree.

Cut Moves the template container and its contents. You can paste the template container under
the SiteScope root or a selected template container in the template tree.

Delete Deletes the template container.

Deploy
Template

Opens the Select Group dialog box which enables you to select the group to which to deploy
one or multiple templates. For user interface details, see "Select Group Dialog Box" on
page 726.

Expand
All

Expands the templates container to display all the template objects within the container.

Export >
Template

Opens the Export Template window which enables you to export a template file. For details,
see "Export Template Dialog Box" on page 713.
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Menu
Item (A-Z) Description

Export >
Content
Package

Opens the Export Content PackageWizard which enables you to export one or more
templates and their dependencies to a content package file. Content packages are required for
sharing Custommonitors, or monitors with extension files like scripts or alert files, with other
SiteScope users. For details, see "Export Content PackageWizard" on page 714.

Generate
XML

Opens theGenerate Auto Deployment XMLwindow which enables you to create an XML file
to use for automatically deploying the templates in the container.

Import Opens the Content Import dialog box which enables you to import a template file, or a content
package that can include one or more templates and their dependencies (for example,
templates.os files, .jar files, and .conf files). For details, see "Template Import Dialog Box" on
page 719.

New >
Template

Opens the New Container window which enables you to define a new template.

New >
Template
Container

Opens the New Template Container window which enables you to define a new template
container.

Paste Pastes a template or template container into the template container.

Template - Shortcut Menu Options
User interface elements are described below:

Menu
Item
(A-Z) Description

Copy Copies the template and its contents. You can paste the template to a template container in the
template tree.

Cut Moves the template and its contents. You can paste the template to a template container in the
template tree.

Delete Deletes the template.

Deploy
Template

Opens the Select Group dialog box which enables you to select the group to which to deploy
the template. For user interface details, see "Select Group Dialog Box" on page 726.

Deploy
Template
Using
CSV

Opens the Select Group dialog box which enables you to select the group to which to deploy
the template using a CSV file. For user interface details, see "Select Group Dialog Box" on
page 726.

Expand
All

Opens all the subtrees under the template.
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Menu
Item
(A-Z) Description

Export >
Template

Opens the Export Template window which enables you to export a template file. For details,
see "Export Template Dialog Box" on page 713.

Export >
Content
Package

Opens the Export Content PackageWizard which enables you to export one or more templates
and their dependencies to a content package file. Content packages are required for sharing
Custommonitors, or monitors with extension files like scripts or alert files, with other
SiteScope users. For details, see "Export Content PackageWizard" on page 714.

Export to
OM

Exports the template to Operations Manager (HPOM). This enables SiteScope templates and
monitors to be configured through the HPOM policy assignment and deployment. For more
details, see the section on Centralized TemplateManagement from HPOM in Integrating
SiteScope with HP Operations Manager Products in the SiteScope Help. You can check the
HPE Software Integrations site for the latest version of this guide.

Note: This menu option is available only if:

l HPOM and SiteScope are installed on the samemachine, and SiteScope is connected to a
supported version of HPOM. For the HPOM versions supported in this SiteScope release,
refer to the HPE SiteScope Support Matrices section in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

l The HPE Operations Agent is installed on the SiteScope server. For details on installing the
agent, see the Integrating SiteScope with HP Operations Manager Products Guide
available on the HPE Software Integrations site.

l HP Operations Manager integration is configured in SiteScope and theEnable exporting
templates to HP Operations Manager check box is selected in HP Operations Manager
IntegrationMain Settings.

New >
Group

Opens the New Group window, which enables you to define a new template group. For user
interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Note: This menu item is available only if the template does not already contain a template
group.

New >
UNIX
Remote
Server

Opens the New UNIX Remote Server window, which enables you to define a new remote
UNIX template.

Note: This menu item is available only if the template does not already contain a remote
server.

New >
Variable

Opens the New Variable window, which enables you to define a new template variable.

New >
Microsoft
Windows
Remote
Server

Opens the New Microsoft Windows Remote Server window, which enables you to define a
new remoteWindows template.

Note: This menu item is available only if the template does not already contain a remote
server.

Paste Pastes a template group, monitor, or alert to a template.
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Menu
Item
(A-Z) Description

Publish
Changes

Opens the Publish Template Changes wizard, which enables you to check deployed groups for
template compliancy and to update SiteScope objects deployed by templates whenever the
template is updated.

Template Variable - Shortcut Menu Options
User interface elements are described below:

Menu Item
(A-Z) Description

Copy Copies the template variable. You can paste the template variable to a template in the
template tree.

Cut Moves the template variable. You can paste the template variable to a template in the
template tree.

Delete Deletes the template variable.

Template Remote - Shortcut Menu Options
User interface elements are described below:

Menu
Item (A-Z) Description

Copy Copies the template remote server. You can paste the template remote server to a template in
the template tree.

Note:You can add only one template remote server to a template. This does not apply to
templates created in older versions of SiteScope.

Cut Moves the template remote server. You can paste the template remote server to a template in
the template tree.

Note:You can add only one template remote server to a template. This does not apply to
templates created in older versions of SiteScope.

Delete Deletes the template remote.
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Template Group - Shortcut Menu Options
User interface elements are described below:

Menu
Item
(A-Z) Description

Copy Copies the template group and its contents (monitors, alerts, and subgroups). You can paste the
template group to a template in the template tree.

Cut Moves the template group and its contents (monitors, alerts, and subgroups). You can paste the
template group to a template in the template tree.

Delete Deletes the template group.

Expand
All

Opens all the subtrees under the template group.

New >
Alert

Opens the New Alert window which enables you to define a new alert for the template group. For
details on this topic, see "Configure SiteScope Alerts" on page 1072.

New >
Group

Opens the New Group window which enables you to define a new template subgroup. For user
interface details, see "New SiteScopeGroup Dialog Box" on page 215.

New >
Monitor

Opens the New Monitor window which enables you to define a new SiteScopemonitor for the
template group. For user interface details, see "New Monitor Dialog Box" on page 229.

Paste Pastes the selected template group and its contents (monitors, alerts, and subgroups) to a
template.
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Template Monitor - Shortcut Menu Options
User interface elements are described below:

Menu
Item
(A-Z) Description

Copy Copies the templatemonitor and its contents (alerts). You can paste the templatemonitor to a
template group in the template tree.

Cut Moves the templatemonitor and its contents (alerts). You can paste the templatemonitor to a
template group in the template tree.

Delete Deletes the templatemonitor.

New >
Alert

Opens the New Template Alert window which enables you to define a new alert for the template
monitor. For details on this topic, see "Configure SiteScope Alerts" on page 1072.

Paste Pastes the selected templatemonitor and its contents (alerts) to a template group.

Preferences Menu
The Preferences menu represents the preference types that enable you to configure specific properties and
settings related tomost of the administrative tasks available within SiteScope.

To access Select thePreferences context. The Preferences menu options are displayed in the left
pane.

Important
information

Only an administrator, or a user grantedEdit <preference type> permissions, can create or
make changes to SiteScope Preferences. For details on user permissions, see "User
Management Preferences" on page 625.

Using SiteScope
Chapter 4: Navigate SiteScope

HPE SiteScope (11.33) Page 45 of 1206



UI Element Description

<Preference
types>

l Certificate Management. Use to add and remove server certificates and reload the
keystore, without having to restart SiteScope after each certificate change operation.
For details, see "Certificate Management" on page 461.

l Common Event Mappings. Use to create event mapping instances between
SiteScope runtime data and the event attribute values that are sent to the HPOM/APM
server. For details, see "Common Event Mappings" on page 465.

l Credential Preferences. Use to create andmanage credentials for SiteScope
resources. For details, see "Credential Preferences" on page 476.

l Email Preferences. Use to define email server settings and profiles for SiteScope
emails alert and status reports. For details, see "Email Preferences" on page 482.

l Event Console Preferences. Use to define filters for forwarding alerts triggered from an
Event Console alert action to different groups of users. For details, see "Event Console
Preferences" on page 487.

l Failover Preferences. Use to configure behavior for SiteScope Failover, a separate
installation of SiteScope that is designed to automatically assume the functions of a
SiteScope system if the system fails or is temporarily taken out of service. For details,
see "Failover Preferences" on page 491.

l General Preferences. Use to perform post-configuration tasks, such as enter standard
and optional SiteScope license keys, control display functions, and set security options.
For details, see "General Preferences" on page 500.

l HTTP Preferences. Use to define settings that are used by SiteScope when sending
event data tomanagement consoles using the Generic Events integration. For details,
see "HTTP Preferences" on page 511.

l Infrastructure Preferences. Use to define the values of global settings in SiteScope.
For details, see "Infrastructure Preferences" on page 517.

l Integration Preferences. Use to configure SiteScope as a data collector for APM. For
details, see "Integration Preferences" on page 563.

l Log Preferences. Use to controls the accumulation and storage of monitor data logs.
For details, see "Log Preferences" on page 597.

l Pager Preferences. (Deprecated) Use to configure settings and additional pager profiles
that SiteScope uses for sending Pager alerts. For details, see "Pager Preferences
(Deprecated)" on page 603.

l Schedule Preferences. Use for customizing the operation of SiteScopemonitors and
alerts to run only at specific times or during specific time periods. For details, see
"Schedule Preferences" on page 608.

l Search/Filter Tags. Use tomanage the Search/Filter tags defined in SiteScope. You
can assign tags to one or more items in the context trees and preference profiles, and
then use the tags as an object for a filter. For details, see "Search/Filter Tags" on
page 614.

l SNMP Preferences. Use to define settings that are used by SiteScope SNMP Trap
alerts when sending data tomanagement consoles. For details, see "SNMP
Preferences" on page 618.

l User Management Preferences. Use to define andmanage user login profiles that
control how others access SiteScope. For details, see "User Management Preferences"
on page 625.
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Server Statistics Menu
The Server Statistics menu enables you to view an overview of several key SiteScope server performance
statistics. This includes the load on the SiteScope server, a list of currently runningmonitors and themost
recently runmonitors, perfex pool summary and statistics, WMI statistics, SSH connections, Telnet
connections, and dynamic monitoring statistics. It also displays the SiteScope log files.

To access Select theServer Statistics context. The Server Statistics menu options appear in the left
pane.

Important
information

Only an administrator, or a user grantedView server statistics permissions, can view the
monitor performance data pages. For details on user permissions, see "User Management
Preferences" on page 625.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011
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User interface elements are described below:

UI
Element Description

<Menu
options>

The following are the available monitor performance data options in SiteScope:

l Dynamic Monitoring. Displays statistics when using the dynamic monitoringmechanism
to automatically update dynamic monitoring counters and thresholds. For details of the user
interface, see "Dynamic Monitoring Page" on page 1015.

l General. Displays SiteScope server statistics, including the load on the SiteScope server
(number of runningmonitors, waitingmonitors, monitor runs per minute), and a list of running
monitors by type. For details, see "General Page" on page 1017.

l Log Files. Displays the list of log files in SiteScope that are useful for understanding
SiteScope performance issues, for troubleshootingmonitor and alert problems, and for
reviewing SiteScopemanagement actions. For details of the user interface, see "Log Files
Page" on page 1018.

l Perfex Processes Pool. Displays the process manager summary, and pool statistics and
status tables for each pool. For details, see "Perfex Process Pool Page" on page 1023.

l PowerShell Process Pool. Displays the PowerShell pools which are used by the
Microsoft Exchange Basemonitor. For details, see "PowerShell Process Pool Page" on
page 1025.

l Running Monitors. Displays a list of which SiteScopemonitors are running, and which
monitors have run recently, at what time, and what was the returned status. For details, see
"RunningMonitors Page" on page 1026.

l SSH Connections. Displays Secure Shell (SSH) statistics and a summary of SSH
connections when using SSH to connect to remote UNIX orWindows servers. For details,
see "SSH Connections Page" on page 1027.

l Telnet Connections. Displays telnet statistics when using telnet to connect to remote
UNIX orWindows servers. For details of the user interface, see "Telnet Connections Page"
on page 1029.

l WMI Statistics. Displays the process manager summary forWindows Management
Instrumentation (WMI) statistics. For details, see "WMI Statistics Page" on page 1030.

Tools Menu
The Tools menu displays a list of diagnostic tools that can help you troubleshoot problems in SiteScope and
facilitate monitor configuration.

To access Select the Tools context. The Tools menu options are displayed in the left pane. You can
select tools from the following categories: "Application Tools" on the next page,
"CommonUtility Tools" on the next page, "Database Tools" on page 50, "Mail Tools" on
page 50, "Network Tools" on page 50, "Operating System Tools" on page 50, "SNMP
Tools" on page 51, "Web Tools" on page 51.
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Important
information

l To view or use the tools in the Tools context in the left pane, youmust be an
administrator in SiteScope, or a user grantedUse tools permissions. For details on
user permissions, see "User Management Preferences" on page 625.

l Some tools are also available when configuring or editing specific monitors (provided
you are an administrator in SiteScope, or a user grantedUse monitor tools
permissions). If a tool is available when configuring or editing amonitor (see "Testing
Monitor Configuration Using Diagnostic Tools" on page 892), you can access the tool
by:

l Clicking theUse Tool button in the new monitor dialog box when configuring a
new monitor, or in themonitorProperties tab when configuring an existingmonitor.

l Clicking the Tools button in the SiteScope Dashboard toolbar when running the
test tool for an existingmonitor. This opens and runs the tool with themonitor's
existing data as its input, and displays test results in theResults pane.

l To avoid character set problems when the SiteScope client uses amultibyte locale
different from the SiteScope server, set the value in the <SiteScope
root directory>\groups\master.config file for the _httpCharset setting toUTF-8.
By default, the _httpCharset value is empty, whichmeans that the default server
locale is used.

See also "SiteScope Tools" on page 91

Application Tools

UI Element Description

News Server
Tool

Checks whether a News Server is operational. For more information, see "News Server
Tool" on page 112.

Common Utility Tools

UI Element Description

Regular
Expression
Tool

Tests a regular expression for content matching against a sample of the content you
want to monitor. For more information, see "Regular Expression Tool" on page 117.

XSL
Transformation
Tool

Tests custom XSL transformation of XML data to bemonitored with the Browsable XML
Monitor. For more information, see "XSL Transformation Tool" on page 136.

Log Analysis
Tool

Analyze patterns in a log file and provides a list of all reoccurring patterns. Each pattern
can be transferred into a regular expression that can be used in the Log File monitor. For
more information, see "Log Analysis Tool" on page 106.

SiteScope Log
Grabber Tool

Retrieves and displays the SiteScope log and configuration files. For more information,
see "SiteScope LogGrabber Tool" on page 119.
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Database Tools

UI Element Description

Database
Connection
Tool

Checks connectivity and configuration of JDBC database connections. For more
information, see "Database Connection Tool" on page 94.

Database
Information
Tool

Retrieves and displays database server metadata such as product and driver version,
SQL compatibility level information, and supported SQL functions. For more information,
see "Database Information Tool" on page 96.

LDAP
Authentication
Status Tool

Tests an LDAP server by requesting a user authentication. For more information, see
"Link Check Tool" on page 103.

Mail Tools

UI Element Description

Mail Round
Trip Tool

Tests amail server by sending and retrieving a test message. For more information, see
"Mail Round Trip Tool" on page 109.

Network Tools

UI Element Description

DNS Tool Tests a DNS server to verify that it can resolve a domain name. For more information, see
"DNS Tool" on page 97.

Network
Status Tool

Displays the server's network interface status and active connections. For more
information, see "Network Status Tool" on page 112.

Note: This tool is not supported on SiteScopes installed on UNIX platforms.

Ping Tool Performs a round-trip Ping test across the network. For more information, see "Ping Tool"
on page 115.

Trace Route
Tool

Performs a traceroute from your server to another location. For more information, see
"Trace Route Tool" on page 127.

Operating System Tools

UI Element Description

Event Log Tool Displays portions of theWindows Event Log locally or on a remote server. For more
information, see "Event Log Tool" on page 98.

Note: This tool is not supported on SiteScopes installed on UNIX platforms.
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Performance
Counters Tool

Checks connectivity to and values inWindows Performance Counter registries. For
more information, see "Performance Counters Tool" on page 113.

Note: This tool is not supported on SiteScopes installed on UNIX platforms.

Processes Tool Shows a list of currently running processes either locally or on a remote server. For
more information, see "Processes Tool" on page 116.

Services Tool Shows a list of currently runningWindows Services. For more information, see
"Services Tool" on page 118.

Note: This tool is not supported on SiteScopes installed on UNIX platforms.

SNMP Tools

UI Element Description

SNMP
Browser
Tool

Browses an SNMP MIB and displays available OIDs. For more information, see "SNMP
Browser Tool" on page 121.

SNMP Tool Performs a SNMP get command to a specified SNMP host to retrieve a list of OIDs. For
more information, see "SNMP Tool" on page 123.

SNMP Trap
Tool

Displays the log of SNMP Traps received by SiteScope from SNMP-enabled devices. For
more information, see "SNMP Trap Tool" on page 126.

Web Tools

UI
Element Description

FTP Tool Checks the availability of an FTP server and whether a file can be retrieved. For more
information, see "FTP Tool" on page 100.

Link
Check
Tool

Checks the availability of all internal and external links on aWeb page to ensure that they can
be reached. For more information, see "Link Check Tool" on page 103.

URL
Tool

Requests a URL from a server and prints the returned data. For more information, see "URL
Tool" on page 128.

Web
Service
Tool

Tests the availability of SOAP enabledWeb Services. For more information, see "Web
Service Tool" on page 132.

Alerts Tab
The Alerts tab displays information about the alerts associated with the selectedmonitor or group. Use this
tab to add, edit, or delete alert definitions.

The Alerts tab shortcut menu options include descriptions of the context menu options available for alerts.

Using SiteScope
Chapter 4: Navigate SiteScope

HPE SiteScope (11.33) Page 51 of 1206



To access Select theMonitors or Templates context, and then click theAlerts tab in the right
pane.

See also "Configure SiteScope Alerts" on page 1072

User interface elements are described below:

Menu Item
(A-Z) Description

Copy Copies the alert to the selected location in themonitor tree.

Note:Available for alerts in theAlerts on Monitor/Group table only.

Copy to
other
SiteScope

This menu item is available only through SAM Administration when there is more than one
SiteScope connected to APM. Copies the alert from another SiteScope to the selected
location in themonitor tree.

Delete Deletes the alert.

Disable
Alert

Disables the alert.

Edit Alert Opens an editing window for the alert, which enables you to edit its settings.

Enable
Alert

Enables the alert.

New Alert Opens the New Alert dialog box, which enables you to create a new alert definition. For
details on how to perform this task, see "Configure SiteScope Alerts" on page 1072.

Note:Available for alerts in theAlerts on Monitor/Group table only.

Paste Pastes the selected alert.

Note:Available for alerts in theAlerts on Monitor/Group table only.

Show All
Descendant
Alerts

Displays all descendent alerts of the selected node.

Show Child
Alerts

Displays only those alerts that are direct children of the selected node.

Test Opens the Test Alert dialog box which enables you to test the alert.

Reports Tab
The Reports tab displays information about the reports defined in SiteScope. Use this page to add, edit, or
delete report definitions.

The Reports tab shortcut menu options include descriptions of the options available for Management reports
in themonitor tree.
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To access Select theMonitors or Templates context, and then click theReports tab in the right
pane.

See also "Create SiteScope Reports" on page 1139

User interface elements are described below:

Menu Item (A-Z) Description

Clear Selection Clears the selection.

Copy Report Copies the report to the selected location in themonitor tree.

Note:Available for reports in theReports on Monitor/Group table only.

Create New
Report

Enables you to select the type of SiteScope report you want to create. For details on
this topic, see "SiteScope Report Types" on page 1139.

Note:

l Available for reports in theReports on Monitor/Group table only.
l Only Management reports are added to the Reports tab.

Delete Report Deletes the report.

Edit Report Opens an editing window for the report, which enables you to edit its settings.

Generate Report Generates the report.

Paste Report Pastes the selected report.

Note:Available for reports in theReports on Monitor/Group table only.

Select All Selects all the listed reports.

Show All
Descendant
Reports

Displays all descendent reports of the selected node.

Show Child
Reports

Displays only those reports that are direct children of the selected node.
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Chapter 5: Set Up and Administer SiteScope
This task describes a suggested working order for preparing to use SiteScope.

Note:

l If you need to configure SiteScope to require a secure connection (https), refer to the hardening
section of the SiteScope Deployment Guide (available from <SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

l If you are using SiteScope Failover to provide backup infrastructuremonitoring availability, see the
HPE SiteScope Failover Guide (available from <SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm) for a suggested working order.

1. Log on to SiteScope
Enter the SiteScope address in aWeb browser. The default address is:
http://localhost:8080/SiteScope.

2. Enter your SiteScope license
If you did not enter your SiteScope license information during installation, enter it inPreferences >
General Preferences > Licenses.
For user interface details, see "Licenses" on page 503.

3. Create a SiteScope user account - optional
The Administrator account is the default account that is active when the product is installed. It has full
privileges tomanage SiteScope and is the account that all users who access the product use unless you
restrict the account. Therefore, it is recommended to create and configure other user accounts based on
the requirements of the organization. For task details, see "How to Create a SiteScope User Profile" on
page 627.

Note:

l If no user name and password are defined for the administrator user, SiteScope skips the login
page and automatically logs in.

l You can restrict access to the SiteScope user interface for a given IP address or host name. For
details, see "Restrict Access to SiteScope" on page 56.

4. Configure SiteScope preferences (as required)
Configure specific properties and settings related to administrative tasks within SiteScope.
a. Configure the SiteScope Email Preferences server. Configure an administrators email address

and specify amail server that SiteScope can use to forward email messages and alerts to users. For
user interface details, see "Email Preferences Page" on page 482.

b. Adjust Log Preferences. Set the number of days of monitor data that are retained on the SiteScope
server. By default, SiteScope deletes logs older than 40 days. If you plan to havemonitor data
exported to an external database, prepare the database, the necessary drivers, and configure the Log
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Preferences as applicable. For user interface details, see "Log Preferences" on page 597.
c. Configure credentials for SiteScope objects. UseCredential Preferences to store andmange

credentials for SiteScope objects that require user authentication. For task details, see "Credential
Preferences" on page 476.

d. In addition, you can configure any of the other SiteScope preferences as required. For details, see
"Preferences Menu" on page 45.

5. Configure SiteScope to integrate with other applications - optional
SiteScope can be used as a data collector for various other applications, including:
l Application PerformanceManagement (APM). Enables logging of SiteScopemonitor data and
topology reporting to APM. For task details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

l Operations Manager (HPOM). Enables sending SiteScope events and reportingmetrics data to
HPOM and APM products. For task details on enabling SiteScope to send events to HPOM or OMi,
and enabling SiteScope to report metrics using the Operations Agent, see Integrating SiteScope with
Operations Manager Products in the SiteScope Help. You can check the HPE Software Integrations
site for the latest version of this guide.

l Network NodeManager i (NNMi). Enables sending SiteScope events and reportingmetrics data to
NNMi. For task details, see Integrating SiteScope with NNMi in the SiteScope Help. You can check
the HPE Software Integrations site for the latest version of this guide.

l Diagnostics. Enables you to see amore complete view of the application servers that aremonitored
by Diagnostics. For user interface details, see Integrating SiteScope with Diagnostics in the
SiteScope Help. You can check the HPE Software Integrations site for the latest version of this
guide.

l Generic data integration. Enables forwarding SiteScopemetrics to an application for which a direct
integration does not exist. For user interface details, see "Generic Data Integration Preferences" on
page 584.

l Generic event integration. Enables forwarding events to a third-party application or management
console for which a direct integration does not exist. For user interface details, see "Generic Event
Integration Preferences" on page 588.

6. Configure connection profiles for remote servers
Specify the connectionmethod for the remote servers you want to monitor in accordance with your
security requirements.
For details on enabling SiteScope tomonitor data on remoteWindows servers, see "Configure
SiteScope toMonitor RemoteWindows Servers" on page 402.
For details on enabling SiteScope tomonitor data on remote UNIX servers, see "Configure SiteScope to
Monitor Remote UNIX Servers" on page 420.

7. Install middleware drivers (if required)
Install middleware drivers for connectivity with remote databases and applications for thosemonitors
that require drivers.
For details, see the help for the specific monitor.
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8. Enable JMX server password protection - optional
To prevent unauthorized entry to the JMX server embedded in SiteScope, enable JMX password
authentication. For details, see "How to Enable Authentication for the JConsole" on the next page.
For details on using the JMX Console, see "How to Use the JMX Console" below.

9. Start using SiteScope
You are now ready to use SiteScope.
For details on creating amonitoring structure, see the suggested workflows in "Configure SiteScope for
monitoring" on page 59.

Restrict Access to SiteScope
This task describes how to restrict access to the SiteScope user interface for a given IP address or host
name.

1. Open the server.xml file that is located in the <SiteScope root directory>\Tomcat\conf directory.
2. Locate theRemoteAddrValve andRemoteHostValveValves, uncomment and configure them to allow

or deny IP addresses or host names as required. For details on configuring these values, see the
explanations and examples in the server.xml file. By default, any host is allowed access.

3. To log the IP addresses and host names from which requests are sent to SiteScope through the user
interface (and the access status of these hosts), uncomment the FastCommonAccessLogValve
Valve.

4. To restrict access to SiteScope's reports on port 8888, set the following properties in the <SiteScope
root directory>\groups\master.config file:
l _checkAddressAndLogin. Set the value to =true.

l _authorizedIP. Provide a comma-separated list of all IP addresses that are allowed to access the
reports. By default, any host is allowed access to the SiteScope reports.

How to Use the JMX Console
SiteScope includes the Javamonitoring andmanagement instrumentation (JConsole) tool. This tool uses
JavaManagement Extension (JMX) technology to provide information on performance and resource
consumption of applications running on the Java platform.

You can use JConsole to perform remotemanagement operations, view performance of processes, and
troubleshoot problematic areas of SiteScope. This tool may help in debugging difficult issues related to
memory consumption, threading, and other issues in the production environment.

How to Access the JConsole Tool
1. To access the JConsole tool, run <SiteScope root directory>\java\bin\jconsole.exe onWindows

platforms (and <SiteScope root directory>/java/bin/jconsole binary file on UNIX platforms).
2. Depending on which SiteScope you want to monitor, select Local, orRemotewith port 28006 (the

default JMX port).
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Note:

l Because access to the JMX server is not password protected (JConsole password authentication is
disabled by default in SiteScope), we recommend that you enable JMX password authentication to
prevent unauthorized entry. For details, see "How to Enable Authentication for the JConsole" below.

l We recommend not changing any other JConsole settings.

How to Enable Authentication for the JConsole
1. Create property files to configure users, passwords, and access roles (forWindows/UNIX/Linux

platforms).
a. Create a property file named password.properties that contains users and passwords, and copy it

to the <SiteScope root directory>\conf folder:

# specify actual password instead of the text password
userLogin1=password
userLogin1=password

b. Create a property file named access.properties that contains users and access roles, and copy it to
the <SiteScope root directory>\conf folder:

# The "monitorRole" role has readonly access.
# The "controlRole" role has readwrite access.
userLogin1=readonly
userLogin2=readwrite

c. Change access permissions to both files. Allow only read access to current user and remove all
others.
o You can find additional information on theOracle website:

http://docs.oracle.com/javase/7/docs/technotes/guides/management/agent.html.
o Formore information on how to Secure a Password File onMicrosoft Windows Systems, see

http://docs.oracle.com/javase/6/docs/technotes/guides/management/security-windows.html.
o OnUNIX/Linux systems, you can set the file permissions for the password file by running the

following command:

chmod 600 jmxremote.password

2. Perform the following for SiteScope installed onWindows platform:
l If you start SiteScope using the go.bat file, perform the following:

i. Open the <SiteScope root directory>\conf\go.bat file for editing.
ii. Find the string that starts ..\java\bin\SiteScope, and add the following parameters to the end

of this string:

-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties

iii. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its value

Using SiteScope
Chapter 5: Set Up and Administer SiteScope

HPE SiteScope (11.33) Page 57 of 1206

http://docs.oracle.com/javase/7/docs/technotes/guides/management/agent.html
http://docs.oracle.com/javase/7/docs/technotes/guides/management/agent.html


from false to true.
iv. Save changes.

l If you start SiteScope using the SiteScope service, perform the following:
i. Open the registry editor, regedit.exe.
ii. Locate and then click the following registry subkey:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\HP
SiteScope\serviceParam

iii. Add the following parameters to the end of the default value:

-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties

iv. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its value
from false to true.

v. Save changes.

3. Perform the following for SiteScope installed on a UNIX/Linux platform:
l If you start SiteScope using the go.sh file, perform the following:

i. Open the <SiteScope root directory>/bin/go.sh file for editing.
ii. Find the string that starts ../java/bin/SiteScope, and add the following parameters to the end

of this string:

-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties

iii. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its value
from false to true.

iv. Save changes.

l If you start SiteScope using the start command in the SiteScope bin folder, perform the following:
i. Open the <SiteScope root directory>/bin/start-monitor file for editing.
ii. Find the string that starts ../java/bin/SiteScope, and add the following parameters to the end

of this string:

-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties

iii. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its value
from false to true.

iv. Save changes.
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Chapter 6: Start Using SiteScope
This provides an overview of how to get started with SiteScope.

1. Log on to SiteScope
You can access SiteScope from a browser or from the Start menu.
Alternatively, you can use silent login to skip the initial login page and go directly to a SiteScope client.
For details, see "Log into SiteScope" on page 16.

Note: You canmanage large and dynamic environments from the command line on aWindows or
UNIX platform using the SiteScope Configuration API. For details, see "SOAP-based APIs" on
page 139.

2. Configure SiteScope for monitoring
Tomonitor the availability and performance of your IT infrastructure and applications, you canmanually
create amonitoring structure in SiteScope, or you can create your own templates or use SiteScope
solution templates.

Tip: Templates are amore efficient method for monitoring different IT elements in your enterprise
and for deployingmonitors in mass deployments. By standardizing a set of monitor types and
configurations into a single structure, you can repeatedly deploy a group of monitors targeting
multiple elements of themonitored environments that share similar characteristics.

a. Manually Create aMonitoring Structure.
Use this workflow for creating a simplemonitoring structure in SiteScope.

For task details, see "How to Create and Deploy aMonitor" on page 226.
b. Create aMonitoring Structure Using a Template.

Templates are used to standardize a set of monitor types and configurations into a single structure.
This structure can then be repeatedly deployed as a group of monitors targetingmultiple elements of
themonitored environments that share similar characteristics.
Creating amonitoring structure using templates involves the steps in the image below:

HPE SiteScope (11.33) Page 59 of 1206



For task details, see "How to Create aMonitoring Structure Using a Template" on page 677

3. Run SiteScope and viewmonitoring data in the Unified Console or the
Dashboard
You can view current performance data for the infrastructure elements beingmonitored by SiteScope in
the Unified Console or in the SiteScope Dashboard.
l Unified Console. Use the Unified Console (amodern and intuitive Java-free interface) to simplify the
management of large, distributed environments, and to accelerate your ability to isolate and diagnose
problems. This is an HTML-based user interface that contains a lightweight Event Console for
managing the event lifecycle,Multi-View for viewing the real-time performance status of everything
beingmonitored in a single view, andManage view which extends template deployment and the
ability to updatemonitor configuration to non-admin users. For details, see "Unified Console" on
page 913.

l Dashboard. The Dashboard provides a real-time picture of system availability and performance. It
displays a table of groups andmonitors for the element highlighted in themonitor tree hierarchy. You
can customize themonitor information that is displayed in the Dashboard, and use the Dashboard
links andmenus to navigate through the hierarchy of monitor elements, manually runmonitors,
disable monitors, and access alert definitions. For details, see "View andManage Data in the
SiteScope Dashboard" on page 891.

4. Use filters and tags to find and display the monitors you want to track -
optional
Use the filter and tagging features to helpmanage and track monitors in SiteScope. This enables you to
more easily find and display only themonitors you need to see.
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Filter Option /
Description How To Use:

Where Do I
Get More
Details?

Status Filter: Use to filter
by monitor status, such as
Error, Warning, Good, or
Disabled.

Select one of the predefined status filters from the
Status list in Multi-View, or from the Favorites filter in
the SiteScope Dashboard context toolbar. (No
configuration is required.)
Tip: We recommend usingMulti-View since it displays
the status of all groups andmonitors without losing the
hierarchical relationship between the data.

"How to
Select and
Configure a
View" on
page 940

Configuration (Custom)
Filter: Use to filter by
various criteria such as
monitor name, monitor
type, target server, and by
monitors that have a
specific tag value assigned
to them.

a. Create filter using the Filter in the SiteScope
Dashboard context toolbar.

b. View results in:
o Multi-View (click the filters drop-down list and

select a filter)
o Dashboard (select the filter you want to use from

the drop-down filter list)
Tip: We recommend usingMulti-View since it displays
the status of all groups andmonitors without losing the
hierarchical relationship between the data.

"How to Filter
the View
Using a
Configuration
Filter" on
page 66

Filter by Search/Filter
Tags: Filter by keyword
tags assigned tomonitors.
This enables grouping
monitors to fit the
perspective of different
personas viewing
SiteScope data.

a. Create tags inSearch/Filter Tags preferences, and
assign tomonitors fromMonitor properties
(Search/Filter Tag panel).

b. View results in:
o Multi-View (select Tags in the views drop-down

list)
o Dashboard (create a filter and select the tags by

which you want to filter in the Tags field)
Tip: We recommend usingMulti-View since it enables
you to group SiteScopemonitors based onmonitor tags;
eachmonitor is displayed under a new group according
to its tags. This lets you see the status of your system
in several ways. You can drill down on tags or tag
values to display only themonitors to which these tags
or tag values have been assigned

"Search/Filter
Tags" on
page 614
"How to Filter
the View
Using
Search/Filter
Tags" on
page 67

5. Access SiteScope from a mobile device - optional
You can use SiteScope's free downloadablemobile apps to keep track of your monitored IT infrastructure
and perform monitoring specific actions while you are away from your computer. For details, see
"SiteScopeMobile Apps" on page 150.
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Part 2: General and Administration
This section includes:

l Using the SiteScope search and filter ("Quick Search" on page 63, "Filter Objects in the SiteScope View"
on page 65)

l Performingmass operations on SiteScope objects ("Perform Actions onMultiple Groups andMonitors" on
page 73)

l Copying/moving SiteScope objects to different locations ("Copy andMove SiteScopeObjects" on
page 76)

l Global Search and Replace ("Global Search and Replace" on page 78)
l SiteScope diagnostic tools ("SiteScope Tools" on page 91)
l Using SiteScope configuration and data acquisition APIs ("SOAP-based APIs" on page 139)
l SiteScopemobile apps ("SiteScopeMobile Apps" on page 150)
l Using regular expressions ("Regular Expressions" on page 153)



Chapter 7: Quick Search
You can use the quick search to search for SiteScope configuration objects such as groups, monitors, remote
servers, templates, and counters in themonitor, template, remote server, and counters tree.

To access
In themonitor, template, remote server, or counters tree (in themonitor properties for some browsable counter
monitors), enter the characters you want to search in the search box or in theQuick Search box.

Learn About
Quick Search Overview
Use the quick search to search configuration objects for a specific property name or value. Quick search is
available in themonitor, template, remote server, and counters tree (in themonitor properties for some
browsable counter monitors). Enter a string in the Quick search box to filter the property names and values.
The tree expands all nodes containing the given string text.

The quick search provides options that enable filtering the search by case sensitivity, wild cards, match
options, and node/child options. It also includes an automatic filter that if selected, enables the search to be
performed automatically after typing the search word, without having to press the Enter key every time you
want to run the search.

For task details, see "How to use the quick search" below.

Tasks
How to use the quick search
To configure the search options, click the left end of theQuick Search box to open the drop-down
menu, and select the required options. For details on the quick search options, see "Quick Search" on the next
page.

Enter a string in theQuick Search box to filter the property names and values. The tree expands all nodes
containing the given string text.

Related tasks: "Filter Objects in the SiteScope View" on page 65
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UI Descriptions
Quick Search

UI
Element Description

Quick Search. Enables you to search configuration objects (groups, monitors, remote servers,
templates, or counters) for a specific name or value in themonitor, template, remote server, or
counters tree (in themonitor properties for some browsable counter monitors).

Click the left end of the box to open the drop-downmenu of filter options:

l Select Case sensitive to search for the filter string exactly as entered. Select Case
insensitive to ignore the case of the filter string.

l Select Use wild cards to use the wildcard symbol * in the filter string. Enables you to use
asterisk (*) characters in your search string in order to type only part of the item.

l SelectMatch from start to search for the filter string at the beginning of a property name or
value. SelectMatch exactly to search for the exact filter string. SelectMatch anywhere to
search for the filter string anywhere in the properties.

l SelectMatch leaf node only to search for the filter string in leaf nodes (monitors and empty
groups only) in the tree. Clear to search all nodes.

l Select Hide nodes without children to hide groups that have no leaf nodes that match the
filter string (empty groups).

l Select Keep the children if any of their ancestors match to display all child nodes of
groups that match the filter string, even though the child does not match the search string.

l Select Use auto filter to search automatically after a letter is entered in the search text field.
You can configure a delay before the auto filter runs inPreferences > Infrastructure
Preferences > General Settings > Quick search auto filter delay (milliseconds). The
default delay is 800milliseconds (0.8 seconds). If Use auto filter is not selected, youmust
press the Enter key every time you want to run the search.

Tip: In a loaded environment, it is recommended to increase the delay time inQuick search
auto filter delay time, or to disable theUse auto filter option.

Note: If a filter is applied to a tree, the search is restricted to the records currently displayed.
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Chapter 8: Filter Objects in the SiteScope
View
The SiteScope filter enables you to filter the display to show only those SiteScopemonitors that meet the
criteria that you define. Filters can be defined with different criteria that can be applied for viewing the data
from different user perspectives, including filtering by monitor name, monitor type, target server, keyword
tags, enabled/disabled status of monitors or alerts, and BSM reporting settings.

You can also filter SiteScopemonitors in Multi-View by using the filters defined in the SiteScopemonitor tree,
or using predefined status filters to see all monitors that are in a particular status. For details on usingMulti-
View, see "Multi-View" on page 936.

Tip: You can view a guided and narrated demonstration onmanaging and trackingmonitors using filters
and tags on YouTube: http://hpsw.co/r5D4GxA.

To access

In theMonitor tree context toolbar (above the left pane), click the Filter button. You can select a
predefined filter, create a new filter, or edit values in an existing filter. You can view andmanage all filters from
the Filter Manager dialog box.

In the New/Edit Filter dialog box, click theBrowse button next toMonitor type, Target server, or
Tags to access the required filter dialog box.

Tip: The filter options are also available when performing operations onmultiple SiteScope objects from
theManageMonitors andGroups dialog box. For details, see "Perform Actions onMultiple Groups and
Monitors" on page 73.

Learn About
Filtering Overview
When administratingmonitor deployment, extensive trees displaying every object added to them could prove
difficult to manage. SiteScope enables you to select whichmonitors you want to view, based on filter criteria.
You can definemultiple filters with different conditions that can be applied for varying configuration tasks.

For example, you can create a filter to display only SiteScopemonitors that aremonitoring CPU utilization and
Disk Space. The result of this filter displays a tree with all CPU and Disk Spacemonitor types directly under
the enterprise node.

For task details, see "How to Filter the View Using a Configuration Filter" on the next page.

Note: To create a filter based on specific common properties, use Global Search and Replace. For
details, see "Global Search and Replace" on page 78.

Filtering Using Search/Filter Tags
Keyword tags are used to search and filter SiteScopemonitors. You can assign tags to any monitor in
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SiteScope, and use those tags to search or filter the display. You define the tags and their values, and assign
these to the different elements in your enterprise.

For example, you could define a tag called Prioritywith the possible values of Critical, High, Medium,
and Low. You assign these tag values to different monitors in the infrastructure. Monitors of Web servers and
databases that support 24x7 customer access could be assigned a category value of Priority: Critical.
While adding a new filter setting, you select Tags in the Filter Options section, enter Priority:Critical as
the value of the object, and click Save. This filter displays only those elements to which you assigned this tag
and value.

Tags can also be used in alert templates using the <tag> attribute. Using the <tag:[tagName]> property, you
can include values in the filter tag as parameters in alerts. This provides similar functionality to the custom
properties mechanism that was removed in SiteScope 10.00. For example, you have a tag named AppServer
with value Apache assigned to amonitor, and you include <tag:AppServer> in the alert template configured
for that monitor. If an alert is triggered, the new property is replaced with Apache in the alert text. For details on
alert template properties, see "Properties Available in Alerts, Templates, and Events" on page 1126.

For task details, see "How to Filter the View Using Search/Filter Tags" on the next page.

Tasks
How to Filter the View Using a Configuration Filter
This task describes the steps involved in filtering themonitors in themonitor tree and inMulti-View.

1. Create a new filter or select an existing filter.

In theMonitor tree context toolbar (above the left pane), click the arrow next to the Filter button.
l To view andmanage all filters from one convenient table, selectManage Filters.... This enables you
to add, edit, and delete filters. For user interface details, see "Filter Manager Dialog Box" on page 72.

l If you have any filters defined, they appear in the drop-down filter list above themonitor tree. Select
the filter you want to use.

l To create a new filter, select New Filter, and configure the filter to search for specific object types
and property values in SiteScope in the New/Edit Filter dialog box. For user interface details, see
"New/Edit Filter Dialog Box" on page 69.

After you select a predefined filter from the list or create a new filter, the tree displays only those objects
defined in your filter selection. After applying a filter, the filter icon appears as .
To clear a filter selection and display all objects in themonitor tree, click Clear Filter. After clearing the
filter, the icon is displayed.

2. Filtering in Multi-View.
When working in SiteScopeMulti-View, you can:
l Filter monitors by selecting any of the filters defined in the SiteScopemonitor tree. In SiteScopeMulti-
View, click the filters drop-down list (to the right of theMonitors/Servers/Tags drop-down), and select
a filter.

l Use the predefined status filters to see the groups andmonitors that meet a particular status criteria.
For example, you can view all monitors in error or disabled status. Click the status drop-down list (to
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the right of the filters drop-down), and select the status criteria to display.

Tip: You can apply the status filter to a filter selected in the filters drop-down to view only those
monitors that meet the filter criteria and have a particular status.

For details on usingMulti-View, see "Multi-View" on page 936.

How to Filter the View Using Search/Filter Tags
This task describes the steps involved in defining a Search/Filter tag and assigning it to one or moremonitors,
and then using those tags to search or filter the display.

1. Prerequisites.
l To be able to view Search/Filter tags, youmust be an administrator in SiteScope, or a user granted
View tags permissions.

l To be able to add, edit, or delete search/filter tags and tag values, youmust be an administrator in
SiteScope, or a user grantedAdd, edit or delete tags permissions.

For details on user permissions, see "Permissions" on page 636.
2. Create a search/filter tag.

In SiteScopePreferences > Search/Filter Tags, create search/filter tags for use in filtering the display.
You define the tags and their values. For example, you could define a tag called Applicationwith the
possible values of HR, CRM, and Online Banking.

Example:Create a tag indicating the type of operating system onwhich themonitors are running.
The tag Platformmight have values such as Windows 2008, Windows XP, Solaris, Linux, and so
forth.

For user interface details, see "New/Edit Tag Dialog Box" on page 617.
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3. Assign search/filter tags to SiteScopemonitors.
a. In the SiteScopemonitor tree, select themonitor you want to tag.
b. In the Properties tab, expand theSearch/Filter Tags panel, and assign a tag and tag values to the

monitor.
c. Repeat for all monitors to which you want to assign this tag and value.

Example: To assign the tag to amonitor, open the Search/Filter Settings for themonitor, and select
the appropriate tag value under the Platform tag.

Using this new tag, you could define a filter setting to display only thosemonitors running on a
particular platform.

4. Filter SiteScopemonitors by tags.
After you have assigned the tag to one or moremonitors, you can use the tag as an object for a filter.

a. In the context menu, click the arrow next to the Filter button, and create a filter that includes
the tag values you want to see. For user interface details, see "New/Edit Filter Dialog Box" on the
next page.

b. In the Tags field, enter tag values, or click theBrowse button and select the tag values by which you
want to filter in the Tags list. For details on the Filter Tags user interface, see "Filter Tags Dialog
Box" on page 72.

c. After you create a filter, the tree displays only thosemonitors that have the selected tag values
assigned to them.

5. View monitors grouped by tags in Multi-View.
Multi-View provides a new grouping option to fit the perspective of different personas viewing SiteScope
data. It enables you to group SiteScopemonitors based onmonitor tags; eachmonitor is displayed under
a new group according to its tags. This lets you see the status of your system in several ways. You can
drill down on tags or tag values to display only themonitors to which these tags or tag values have been
assigned.
For details onMulti-View, see "Multi-View" on page 936.

UI Descriptions
This section includes:
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l "New/Edit Filter Dialog Box" below
l "Filter Monitor Types Dialog Box" on page 71
l "Filter Target Servers Dialog Box" on page 71
l "Filter Tags Dialog Box" on page 72
l "Filter Manager Dialog Box" on page 72

New/Edit Filter Dialog Box
The Filter button is located in the context toolbar of theMonitor Tree.

User interface elements are described below:

UI Element Description

General Settings

(This panel does not appear when accessing the filter from theManageMonitors andGroups dialog box)

Filter name This name appears in the list of available filters when you click the Filter arrow.

Filter
description

Description for the filter. This description appears only when editing the filter.

Note: This field is optional.

Public filter Describes the permissions of the filter. If the filter is public, all users can see, use, and
edit the filter, but only the public filter owner can change this filter to a private filter.

If the filter is not public, only the current user can see and use it.

Filter Options

Regular
expression

Enables using standard regular expressions to filter themonitor tree.

When selected, you cannot select monitor names, monitor types, or tag values from the
filter lists. The filter uses the POSIX regular expression format when the check box is
cleared.

Default value:Selected

Monitor name To filter the objects appearing in the tree by themonitor name, type amonitor name.

l Themonitor name is the string entered in theName box in the General Settings panel
duringmonitor configuration.

l You can enter a regular expression to widen the filter. This is done by using wild card
("*") and or expressions to filter SiteScope objects appearing in the tree by the
monitor name.

Themonitor tree displays only thosemonitors, within their groups, matching the string
entered and only those groups containing thesemonitors.

Example: The expression /URL Monitor.* \.gov/matches all monitor names
containing the string URL Monitorwith addresses containing the domain .gov.

Note: This field is case sensitive.
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UI Element Description

Monitor type To filter the objects appearing in the tree by themonitor type, enter themonitor type, or
click theBrowse button and select themonitor types by which you want to
filter in theMonitors list.

For example, you can define a filter that includes all CPU monitors, regardless of their
properties. In this view, themonitor tree lists all the CPU monitors defined in the
SiteScope.

For details on the Filter Monitor Types user interface, see "Filter Monitor Types Dialog
Box" on the next page.

Note:

l When enteringmultiple monitors, separate them with a comma (",").
l When entering amonitor type, you can enter a regular expression.

Example: SAP* or CPU*

Target server To filter the objects appearing in the tree by the target server, type a server name or click
theBrowse button and select the remote servers by which you want to filter
from the Targets list.

l The target is the string entered in theServer box in theMonitor Settings panel during
monitor configuration.

l You can enter a regular expression to widen the filter.
The tree displays only thosemonitors, within their groups, whose target server matches
the string entered and only those groups containing thesemonitors.

For details on the Filter Target Server user interface, see "Filter Target Servers Dialog
Box" on the next page.

Note:When enteringmultiple targets, separate them with a comma (",").

Tags Enables you to define a filter that includes all SiteScope objects that have a specific tag
value. For example, if there is a platform tag with values Windows, Linux, AIX, and
Solaris, you can filter for all objects that have the AIX tag value assigned to them.

Enter tag values, or click theBrowse button and select the tag values by which
you want to filter in the Tags list. For details on the Filter Tags user interface, see "Filter
Tags Dialog Box" on page 72.

Note:

l When enteringmultiple tag values, separate them with a comma (",").
l You can use the wild card character ("*") and the and or or expressions to filter tag
values.

Enable/Disable
Monitor

Enables you to define a filter that includes only enabled or disabled SiteScopemonitors.

Default value: None
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UI Element Description

Enable/Disable
Associated
Alerts

Status (enabled/disabled) of associated alerts by which you want to filter.

Default value: None

BSM Logging Enables you to define a filter that includes monitors based on their settings for reporting
data to APM.

For details on the logging options, see "HP Integration Settings" on page 253.

Filter Monitor Types Dialog Box
This dialog box enables you to select themonitor type by which you can filter SiteScope objects.

UI Element Description

Available
Monitor
Types

Displays the available monitor types.

Select themonitor types you want to include in the filter and click theMove to Selected
Monitor Types button. The selectedmonitor types aremoved to the SelectedMonitor Types
list.

Selected
Monitor
Types

Displays themonitor types currently selected for this filter.

To removemonitor types from this list, select themonitor types and click theMove to
Available Monitor Types button. Themeasurements aremoved to the Available Monitor
Types list.

Filter Target Servers Dialog Box
This dialog box enables you to filter SiteScope objects by the selected server targets configured in SiteScope.

UI Element Description

Available
Target
Servers

Displays the remote servers available in SiteScope.

Select the remote servers you want to include in the filter and click theMove to Selected
Target Servers button. The selected remote servers aremoved to the Selected Target
Servers list.

Selected
Target
Servers

Displays the remote servers currently selected for this filter.

To remove remote servers from this list, select the remote servers and click theMove to
Available Target Servers button. Themeasurements aremoved to the Available Target
Servers list.
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Filter Tags Dialog Box
This dialog box enables you to select the tag values by which you can filter SiteScope objects.

UI Element Description

<Tag name
and values>

Displays the tag names and tag values if tags have been created. Select the check box
next to the tags that you want to include in the filter, and click Save.

For details on creating search/filter tags, see "New/Edit Tag Dialog Box" on page 617.

Tree Filter Select an operator to define tag tree filter conditions:

l and. Displays all objects that have all the tags selected.
l or. Displays all objects that have at least one of the tags selected.
Note:You can select only one type of operator (mixed conditions cannot be used).

Filter Manager Dialog Box
Filter Manager enables you to view andmanage all your filters in one table.

UI Element Description

New Filter. Opens the New Filter dialog box enabling you to configure a filter. For user
interface details, see "New/Edit Filter Dialog Box" on page 69.

Edit Filter. Opens the Edit Filter dialog box enabling you to edit the properties of the
selected filter. For user interface details, see "New/Edit Filter Dialog Box" on page 69.

Delete Filter. Deletes the selected filters from the filters list.

Filter Name Displays the name of each filter.

You can change the order of the listed filters, by clicking the column header. An arrow is
displayed to indicate the sort order (ascending or descending).

Filter
Description

Displays the description for the filter (if added when creating the filter).

You can change the order of the listed filters, by clicking the column header. An arrow is
displayed to indicate the sort order (ascending or descending).
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Chapter 9: Perform Actions on Multiple
Groups and Monitors
You can perform mass operations on one or multiple SiteScope objects using theManageGroups and
Monitors feature. Using theManageMonitors andGroups dialog box, you can select one or more groups,
monitors, or both from an expandable hierarchical view of the organization, and select the action you want to
perform (copy, move, delete, runmonitors, enable/disable monitors, enable/disable associated alerts).

You can also use the filter options to create a filtered list of groups andmonitors based on a filter criterion, or
select an existing filter previously defined in themonitor tree filter.

To access
Select theMonitors context. In themonitor tree toolbar, click theManage Monitors and Groups button.

UI Descriptions
Manage Monitors and Groups Dialog Box

Important
information

l The toolbar actions are available according to the user permissions and the
objects selected.

l The Health container cannot be deleted.

Relevant tasks l "How toManage aGroup" on page 213
l "How to Create and Deploy aMonitor" on page 226
l "Filter Objects in the SiteScope View" on page 65

User interface elements are described below:

UI Element Description

Filter. Enables you to filter themonitor tree to display only those SiteScope objects that
meet the criteria that you define. After applying a filter, the name of the filter is displayed in
the button (custom, if the filter was created in theManageMonitors andGroups dialog
box; otherwise, the name of the filter defined in themonitor tree filter).

Click the Filter button arrow and select a filter option:

l New Filter. Opens the New Filter dialog box which enables you to create a filter. For
user interface details, see "Filter Objects in the SiteScope View" on page 65.

l Clear Filter. Clears the filter settings.
l <List of existing filters>. Displays a list of existing filters previously defined in the
monitor tree filter.

Select All. Selects all listed SiteScope objects.
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UI Element Description

Clear Selection. Clears the selection.

Cut.Moves the selected objects to the destination group.

Note:

l Any alerts defined for a specific monitor are transferred with themonitor.
l Moving amonitor restarts its history and any reports generated for themonitor are
started from the time that themonitor was moved. The history data is still in the log
files, but it is inaccessible from the reports for themonitor after it has beenmoved.
Moving groups has no effect on history.

l Moving amonitor may break group-to-monitor dependencies. If you have one or more
groups dependent on the status of themonitor you aremoving, update that
dependency after moving themonitor.

Copy.Makes a copy of the selected objects for pasting to the destination group.

Paste. Pastes the selected objects to the destination group. If youmake a copy of a
SiteScope object and it has the same name as an existing object in the container,
SiteScope automatically adds a suffix (number) to the end of the object's name.

Example: If you create a copy of monitor Mail Flow and paste it in the samemonitor
group, SiteScope automatically renames it Mail Flow(1).

Delete. Deletes the selected objects from themonitor tree.

Run Monitors. Runs themonitor or any monitors configured in the group. This opens an
information window with the results.

Enable/Disable Monitor. Opens the Enable/Disable Monitor dialog box which enables
you to enable or disable themonitor or all themonitors in the group, regardless of the
setting in themonitor properties. If you select Disable, themonitors are disabled until you
return to this dialog box and select Enable. For user interface details, see "Enable/Disable
Monitors in Group Dialog Box" on page 903.

Enable/Disable Associated Alerts. Open the Enable/Disable Associated Alerts dialog
box which enables you to enable or disable all alerts associated with themonitor or all
monitors in the group. For more details, see "Enable/Disable Associated Alerts" on
page 265.
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UI Element Description

<SiteScope
objects>

Actions are applied to all monitors and groups that are selected using the check box
selections in the tree. The display of the tree is saved across visits to the dialog box and
the actions associated with it.

l To select an object, select the check box to the left of the object name. Any
combination of groups or monitors can be selected. A icon displayed to the left of a
group indicates that not all monitors and subgroups contained within that group have
been selected.

l To select a destination for copying or moving an object, click the object name (not the
check box).

Default value: The top level groups are shown, but no objects are selected.
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Chapter 10: Copy and Move SiteScope
Objects
You can copy SiteScope objects to different locations within a context tree. In addition, you can copy
SiteScope objects to templates. You can alsomovemonitors and groups, together with their contents, to
different groups in themonitor tree.

To enable you to differentiate between objects, object names must be unique within the parent container. For
instance, when you copy or move SiteScope objects, you cannot create twomonitors within the same group
with exactly the same name. If youmake a copy of a SiteScope object and it has the same name as an
existing object in the container, SiteScope automatically adds a suffix (number) to the end of the object's
name. For example, if you create a copy of monitor Mail Flow and paste it in the samemonitor group,
SiteScope automatically renames it Mail Flow(1).

You can copy or move the following SiteScope objects:

SiteScope
Object Action and Description

Group Copy/Paste. Copy amonitor group, including its subgroups, monitors, alerts, and reports, to
the same or a different monitor group.
Cut/Paste.Move amonitor group, including its subgroups, monitors, alerts, and reports, to a
different monitor group.

Copy to Template. Copy amonitor group, including its monitors, alerts, and reports, to a
template.

Note:

l You cannot move or copy amonitor group to its subgroup.
l If youmove a group that is targeted by an alert or report without alsomoving the alert or
report, the group is removed from the alert or report target.

l Baseline thresholds are not copied or moved with amonitor whose thresholds were set
using the baseline.

Monitor Copy/Paste. Copy amonitor, including its alerts and reports, to the same or a different
monitor group.
Cut/Paste.Move amonitor, including its alerts and reports, to a different monitor group.

Copy to Template. Copy amonitor, including its alerts and reports, to a template.

Note:

l If youmove amonitor that is targeted by an alert or report without alsomoving the alert or
report, themonitor is removed from the alert or report target.

l After copying amonitor, you normally need to change the system or application that the
monitor is targeting, otherwise the copiedmonitor duplicates themonitoring actions of the
original monitor instance.

l Baseline thresholds are not copied or moved with amonitor whose thresholds were set
using the baseline.
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SiteScope
Object Action and Description

Remote
Server

Copy to Template. Copy a remote server profile to a template.

Template
Container

Copy/Paste. Copy a template container and paste it to another template container or to the
SiteScope root.

Template Copy/Paste. Copy a template including its groups, monitors, alerts, and report, to a template
container.

Template
Group

Copy/Paste. Copy a template group including its subgroups, monitors, alerts, and reports to a
template (provided the template does not already contain a template group) or to a template
group.

Template
Monitor

Copy/Paste. Copy a templatemonitor including its alerts and reports to a template group.

Alert Copy/Paste. Copy an alert definition (from the Alerts tab) to the same or a different location
(group or monitor) in themonitor tree or template tree.

Report Copy/Paste. Copy a report definition (from the Reports tab) to the same or a different location
(group or monitor) in themonitor tree or template tree.

Note: You can alsomove or copy multiple monitors and groups to a target group by clicking theManage
Monitors and Groups button in themonitor tree toolbar. For details, see "Perform Actions on
Multiple Groups andMonitors" on page 73.

For details on copying or moving SiteScope objects, expand the context menu option for the relevant
SiteScope view in "Context Trees andMenuOptions" on page 25.
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Chapter 11: Global Search and Replace
TheGlobal Search and ReplaceWizard enables you tomake changes tomonitor, alert, alert action, group,
preferences, and report properties. You can select an object based on object type, and globally replace any of
the selected object's properties across a SiteScope or across multiple SiteScopes when working in SAM
Administration.

For example, when upgrading APM, use the Global Search and ReplaceWizard to configure all the
SiteScopes reporting data to APM to the upgraded version.

To access
l In SiteScope, right-click SiteScope root or the group or monitor in themonitor tree to which you want to
perform the global replace. To replace Preferences objects, right-click theSiteScope root. To replace alert
objects, right-click theSiteScope root, or the relevant group or monitor object. Select Global Search and
Replace from the context menu.

l In APM, select Admin > System Availability Management. Below the SiteScope Summary table in the
right pane, click theGlobal Search and Replace button.

Learn About
Filter Affected Objects
Use the Filter Affected Options option to further refine your selected object for the search operation. You can
select specific properties and select or enter values pertaining to your object. This enables you to limit the
selected objects but not the value to replace.

When performing the replace operation, only the value to replace is replaced and only on those objects that
match the properties selected in the Filter Affected Options page. For example, select all monitors with
frequency set to 5minutes and replace themonitor dependency setting for all of thosemonitors, or select only
thosemonitors monitoring a specific server and replace the threshold settings for only thosemonitor
instances matching the value of the server entered in the filter.

Replace or Find and Replace
Use the replacemethod to search for a field value and replace it with a new value. For example, change the
default monitor run frequency setting for the selectedmonitors by selecting the Frequency check box in the
Monitor Run Settings panel, and updating the frequency value from 10 to 15minutes.

Use the find and replacemethod to search for specific settings and property values and replace only those
objects with the entered setting or value. You can search a string, value, or regular expression pattern and
replace only that string. Replacements aremade only if the filter criteria match. For example, search for all
monitors whose name value includes a server name that is no longer in use. Replace the string representing
the old server with a new string representing the updated server.

Threshold Settings

Tip:We recommend using the Publish Changes feature to replace thresholds, since incorrect threshold
names can sometimes appear when changing Threshold Settings with GSAR. See "Publish Changes to
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Templates" on page 745.

When replacing threshold settings for monitors, by default you replace only those settings that share all of the
following:

l Have the same condition (Error if,Warning if, orGood if).
l Are configured for the same schedule.
l Use the same operator type (< <=, > >=, ==, !=, contains, !contains).

Note: < (less than) and <= (less than and equal to) are considered the same operator type, as are >
(greater than) and >= (greater than and equal to).

You also have the option to override all the existing threshold settings that have the same condition (Error if,
Warning if, orGood if) regardless of the operator used and the schedule configured. The option is called
Override Category and appears in the Choose Changes page of the wizard under the Threshold Settings
panel if you selectedMonitor in the Select Type page of the wizard.

For example, you want to change theError if threshold settings for all CPU monitors to greater than 85%. In
the wizard, you selectMonitor in the Select Type page, CPU in the Select Subtype page, and expand the
Threshold Settings panel in the Choose Changes page.

If you select theOverride Category option when selecting greater than 85% as theNew Error if status
condition, all the existingError if settings for all CPU monitors are overwritten and changed to greater than
85% when you complete the wizard.

If you leave the option cleared, the greater than 85% Error if setting you select in the wizard replaces only
thoseError if settings that use the > (greater than) and >= (greater than and equal to) operators and were
configured for the same schedule for all CPU monitors.

For details on setting thresholds, see "Setting Status Thresholds" on page 223.

Tasks
How to Perform a Global Search and Replace
This task describes how to perform a global search and replace for objects, using the Global Search and
ReplaceWizard.

1. Begin running the Global Search and Replace Wizard
Right-click SiteScope root or the group or monitor in themonitor tree to which you want to perform the
global replace. To replace Preferences objects, right-click SiteScope root. To replace alert objects, right-
click SiteScope root, or the relevant group or monitor object. Select Global Search and Replace from
the context menu.
For user interface details, see the UI Descriptions section below.

2. Select SiteScope (in SAM only)

Note: This step is only applicable when you access the Global Search and Replace wizard from
SAM.

In theSelect SiteScope page, select one or more SiteScopes on which to run the search and replace.
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3. Select object type
In theSelect Type andSelect Subtype page, select the object and, if relevant, the subtype on which
you want to make a replacement.
For user interface details, see "Global Search and ReplaceWizard - Select Type Page" on page 84 and
"Global Search and ReplaceWizard - Select Subtype Page" on page 85.

Example: To change the threshold boundaries for all CPU monitors, selectMonitor as the object
type.

Select CPU as the specific monitor type.

4. Search and replace objects
In theReplace Mode page, select the type of replacement. Select Replace to globally replace the object
or select Find and Replace to replace specific instances of the object. Optionally, you can open the
Advanced Filter dialog box to filter by the object properties. Here you select on which objects to perform
the replace operation. In theChoose Changes page, you select what properties or values to replace.
For user interface details, see "Global Search and ReplaceWizard - ReplaceMode Page" on page 85
and "Global Search and ReplaceWizard - Choose Changes Page" on page 85.

Example:Reducing the Frequency of aMonitor Run on a Specific Server.

To reduce the frequency of how often amonitor runs on a specific server in your company, filter your
selection in theMonitor Settings panel in the Choose Changes page to include only thosemonitors
monitoring the specified server.
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In theMonitor Run Settings panel, enter a new frequency of once a day, to monitor the specified
server.
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Example:Setting Up Alert Action to Send Alert Messages to Specified Email Addresses.

If one of the email addresses you configured to receive alerts has changed, you can update the email
address that has changed. In the Select Type page, select Alert Action as the object type, and in
the ReplaceMode page select Find and Replace.

In the Choose Changes page, enter the old email address in the Find field and the new email
address in the and replace with field.

5. Check affected objects
In theAffected Objects page, view the affected objects and, if necessary, clear or select objects for the
replacement operation. Optionally, you can open the Filter Affected Objects dialog box to filter by the
object properties. Here you select on which objects to perform the replace operation.
For user interface details, see "Global Search and ReplaceWizard - Affected Objects Page" on page 88.
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Example:Reducing the Frequency of aMonitor Run on a Specific Server.

You want to reduce the frequency of how often amonitor runs on a specific server in your company.
If you had selected Replace in the ReplaceMode page, in the Choose Changes page, you then enter
a new frequency of once a day, to monitor the specified server.

The affected objects are displayed in the Affected Objects page.
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You can filter your selection in the Filter Affected Objects page to include only thosemonitors
monitoring the specified server.

6. Review replaced objects
In theReview Summary page, review the results of the replacement operation and click Finish to
complete the wizard. You can view a summary of the changes in theSummary page to see which
changes were implemented successfully and in which errors occurred.
For user interface details, see "Global Search and ReplaceWizard - Review Summary Page" on page 89
and "Global Search and ReplaceWizard - Summary Page" on page 89.

UI Descriptions
Global Search and Replace Wizard - Select SiteScope Page
This wizard page enables you to select the SiteScope on which tomake replacements.

Note: This page appears only when you are working in System Availability Management Administration.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<SiteScope
machines>

Select one or more SiteScopes on which to run the search and replace.

Note:Only SiteScopes running version 9.0 and later and whose connection status
permits configuration changes from SAM are listed.

Global Search and Replace Wizard - Select Type Page
This wizard page enables you to select the object type on which you want to make replacements.

User interface elements are described below:

UI Element Description

<object type>

(Alert, Alert Action,
Group, Monitor,
Preference, Report)

You can select only one object type for each replace operation. Only those types of
objects available for the node you selected are listed.

When performing Global Search and Replace from SAM Administration, group,
monitor, alert, alert action, and preferences appear only if they exist on at least one
SiteScope selected in the previous page.
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Global Search and Replace Wizard - Select Subtype Page
This wizard page enables you to select the properties of the object type on which you want to make
replacements.

User interface elements are described below:

UI Element Description

<Object
type
properties>

Displays properties of the object type. For example, if you selected Monitor as the object
type, it lists all monitor types for the selected SiteScopes.

Note: This page is not available if you selected the object typeGroup, Alert, orReport in
the "Global Search and ReplaceWizard - Select Type Page" on the previous page of the
wizard.

Global Search and Replace Wizard - Replace Mode Page
This wizard page enables you to select the type of replacement: global replacement or replacement based on
filter criteria.

User interface elements are described below:

UI
Element Description

Replace Globally replaces all matching objects with the new string or value.

Find
and
Replace

Searches the target objects for properties that match a string or regular expression and replaces
only thematching pattern with the replacement value.

This method of replacement includes a search for specific settings and property values and
replaces only those objects with the entered setting or value. You can select only a partial value
and replace only that string.

Note:

l If you select this option, only settings whose values can contain a string are available in the
settings area of theChoose Changes page and can be selected for the find and replace
action.

l Use this setting to determine the selection and the value to replace. It differs from the
Advanced Filter option, which is a way to limit the selected objects but not the value to
replace.

Example: Search for all monitors whose name value includes a server name that is no longer in
use. Replace the string representing the old server with a new string representing the updated
server.

Global Search and Replace Wizard - Choose Changes Page
This wizard page enables you to select what to replace for the global replace. The wizard displays only the
settings and properties that may be changed for the object type selected in the previous pages. The filter
criteria is built from your selections in the Type, Subtype, and Advanced Filter pages.
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Important
information

l The subtype's properties may appear differently from how they appear when editing a
monitor, alert, preference, and so forth in SiteScope.
Examples:Mail Preferences is a text box in Global Search and Replace utility rather
than a drop-down list, and theDepends on property does not appear in the Global
Search and Replace utility.

l TheServer property is available only whenmonitors from the following group are
selected: CPU, Disk Space, Memory, Microsoft Windows Performance Counter, Web
Server, and Servicemonitor. For other monitors, you can only change the server attribute
by selecting that specific monitor subtype in the Select Subtype page. For example, if a
CPU monitor is selected with aWeb Server monitor, the server property is available. If a
monitor not from this group is also selected, the server property is not available.

l You cannot find and replace a password string.
l Note for users of SiteScope within SAM Administration: If the SiteScopes selected
for the replace operation are not all the same version, the subtypes of the SiteScopes
may have different properties.

l UsingGSAR to replace values in URL Sequencemonitors that do not all contain the
same number of steps (x), might result in monitors with less than x steps containing
irrelevant values.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

Find
Replace
With

If you chose the Find and Replace option in the ReplaceMode page, the text boxes Find and
Replace With are added to the top of this page.

l In the Find box, enter the search string, value, or regular expression pattern for the setting
or property you want to replace.

l In theReplace With box, enter the string or value to which you want all matching patterns
to be changed.

Note: If you select Frequency in theMonitor Run Settings, the values you enter in the Find
andReplace With text boxes must be in seconds. For example, you want to findmonitors
with a frequency of 10minutes and change the frequency to 20minutes. In the Find text box,
enter 600 and in theReplace With text box enter 1200.

If no objects are found that meet the filter criteria, an error message appears. Reselect your
filter criteria.
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UI
Element Description

<Settings
area>

This area includes the settings for the object you selected. For details about these settings,
refer to the selected object's settings page.

l If you selected Find and Replace in the ReplaceMode page, you select only the setting in
the settings area. Enter the old and new values to replace in the Find/Replace with boxes.

l If you selectedReplace in the ReplaceMode page, you select the setting and the new
value in the settings area.

For details about some of the areas:

Threshold Settings Area
l The Threshold Settings area appears only if you selectMonitor in the Select Type page,
and onemonitor in the Select Subtype page. It is not displayed if you select more than one
monitor in the Select Subtype page, and one of themonitors does not include threshold
definitions.

l TheOverride Category option is displayed only if you selectedMonitor in the Select Type
page:
l When this option is selected, you can override the threshold settings of the same
threshold condition (Error if,Warning if, orGood if) for the selectedmonitor instances
with the settings you enter here for the replace operation.

l When this option is cleared, the settings you enter here replace only those settings with
the same operator type (< <=, > >=, !=, ==, contains, doesNotContain)) and the same
configured schedule for themonitor instances. Any other settings for the same condition
but with a different operator type or a different schedule remain. For details on this option
and an example, see "Threshold Settings" on page 78.

Filter Settings Area
If you selectedAlert in the Select Type page, theMonitor type match field in the Filter
Settings is not displayed and its values cannot be replaced in the wizard.

Server Settings Area
The Server Settings area appears only if you selectMonitor in the Select Type page, and one
monitor in the Select Subtype page. It is not displayed if you select more than onemonitor in
the Select Subtype page, and thesemonitors do not belong to the same family, as listed
below:

l SAP monitors: SAP CCMS, SAP CCMS Alerts, SAP JavaWeb Application Server, SAP
Performance, SAPWork Processes.

l Server monitors: CPU, Disk Space, Memory, Microsoft Windows Performance Counter,
Service, UNIX Resources, Web Server.

l SNMP monitors: Cisco, F5 Big-IP, Network Bandwidth, SNMP by MIB.
l URLmonitors: URL, URL List, URLContent, URL Sequence.
l Windows Counter monitors: ASP, Citrix, ColdFusion, Microsoft Hyper-V, Microsoft IIS
Server, Microsoft SQL Server, Microsoft Windows Media, Real Monitor.
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Global Search and Replace Wizard - Affected Objects Page
This wizard page enables you to view the objects that you selected to change. The page displays the selected
objects in tree format. You can clear or select objects in the Affected Objects tree for the replacement
operation.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

Filter. Optionally, click to open the dialog box if you want to further refine your selections. For
user interface details, see "Global Search and ReplaceWizard - Filter Affected Objects Dialog
Box" below.

<Affected
Objects
tree>

The Affected Objects tree includes all objects that arematched against the filter criteria
selected in the previous pages of the wizard.

Select or clear objects as required for the replace operation.

Note:

l When using Global Search and Replace from SAM Administration, a tree is displayed for
each SiteScope selected.

l The objects displayed depend on whether the user has change permissions on those
objects.

l In SAM Administration, the permissions are set in APM's Permissions Management
(Admin > Platform > Users and Permissions).

l In SiteScope standalone, the permissions are set inPreferences > User Management
Preferences.

l If you selected Find and Replace in the ReplaceMode page, replacements aremade only
if the filter criteria arematched. If you selectedReplace, replacements aremade in all
selected objects.

Global Search and Replace Wizard - Filter Affected Objects Dialog Box
This dialog box enables you to select objects based on their specific settings and not only based on object
type. For example, you can select all alerts that have a defined category of critical and replace any setting for
those alerts. You can also select all groups with a dependency set to a specific monitor or group and replace
any setting for those groups.

To access, click the Filter button in the "Global Search and ReplaceWizard - Affected Objects Page"
above.

Note: Using this option only refines your selection for the replace and does not determine what to
replace.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description

<Settings
areas>

The setting areas pertinent to the object you selected appear. For details about these settings,
refer to the selected object's settings page. Select the properties and enter the values by which
to filter the selected objects.

Global Search and Replace Wizard - Review Summary Page
This wizard page enables you to preview the objects on which the replacement operation is performed. When
working with multiple SiteScopes in SAM Administration, a table appears for each SiteScope and the name of
the SiteScope appears above the table.

Important
information

l The number of objects that are affected by the global replacement is displayed above
the table.

l Each table column can be sorted in ascending or descending order by right-clicking the
column title. An up or down arrow indicates the sort order.

l Once you click Apply in this page, you cannot undo the replacement operation.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Change the sort order in the columns by clicking the up and down arrow in the
column title.

Default: The Full Name column is in alphabetical order, from top to bottom.

Full Name Displays a tree of the server name, group, monitor name, and themonitor's
properties whose value is being replaced.

<property> The box name that youmarked in the Choose Changes page that changes as a
result of the replace operation.

Previous Value The current value that changes as a result of the replace operation.

Note: If the value being replaced is a check box that was cleared and is now
being selected, youmay not see the previous value (cleared) for the check box.

New Value The new value that you entered in the Choose Changes page.

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties against the
remote servers on which the changes are beingmade.

Default value:Selected

Note:When this option is selected, it takes more time tomake changes due to
the remote connections.

Global Search and Replace Wizard - Summary Page
The Summary page reports the changes that were implemented successfully and those in which errors
occurred. The page displays the changes in table format. When working with multiple SiteScopes in SAM
Administration, a table is displayed for each SiteScope and the name of the SiteScope appears at the top of
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the table.

Important
information

l There is no way to undo changes made by the replace operation.
l The number of objects affected by the global replacement is given above the table.
l Each table column can be sorted in ascending or descending order by right-clicking the
column title. An up or down arrow indicates the sort order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Change the sort order in the columns by clicking the up and down arrow in the column title.

Default: The Full Name column is in alphabetical order, from top to bottom.

Click to open a report of the results in a PDF file.

Note: This option is available only to users accessing Global Search and Replace from SAM
Administration.

Click to open a report of the results in a CSV format file.

Note: This option is available only to users accessing Global Search and Replace from SAM
Administration.

Print. Click to print the table. This icon appears for each table in the summary.

Full Name Displays a tree of the server name, group, monitor name, and themonitor's properties whose
value is being replaced.

<property> The box name that youmarked in the Choose Changes page that changes as a result of the
replace operation.

Previous
Value

The value that was replaced in the global replace operation.

New Value The new value that resulted from the global replace operation.

Apply Closes the wizard.
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Chapter 12: SiteScope Tools
SiteScope provides a number of diagnostic tools that are useful to test themonitoring environment. You can
use these tools before configuring amonitor to uncover issues and facilitate monitor configuration, and after
configuring amonitor to troubleshoot and diagnose problems.

To access
l Select the Tools context. The Tools menu options are displayed in the left pane (provided you are an
administrator in SiteScope, or a user grantedUse tools permissions).

l Some tools are also available when configuring or editing specific monitors (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions). If a tool is available when
configuring or editing amonitor (see "TestingMonitor Configuration Using Diagnostic Tools" on page 892),
you can access the tool by:
l Clicking theUse Tool button in the new monitor dialog box when configuring a new monitor, or in
themonitorProperties tab when configuring an existingmonitor.

l Clicking the Tools button in the SiteScope Dashboard toolbar when running the test tool for an existing
monitor. This opens and runs the tool with themonitor's existing data as its input, and displays test
results in theResults pane.

Learn About
SiteScope Tools Overview
Use these tools to make a variety of requests and queries of systems you aremonitoring and to view detailed
results of the action. Requests may include testing network connectivity or verifying login authentication for
accessing an external database or service.

Some tools are available when configuring specific monitor types to help you configure themonitor settings.
You enter data into the tool fields, and SiteScope tests the data. After SiteScope tests the data , you can
apply the tested data directly to themonitor configuration form. For example, before configuring a DNS
monitor, you can use the DNS Tool to translate a domain name to an IP address. After the name has been
translated, SiteScope can apply the data to the new monitor.

For the list of SiteScope tools that are available and tool descriptions, see "Tools Menu" on page 48.

Tasks
How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor
This task describes the steps involved in using a SiteScope tool to assist you to configure or troubleshoot a
monitor.

1. Prerequisites
l To view and use the tools in the Tools context in the left pane, youmust be a SiteScope administrator
user, or a user grantedUse tools permissions.

HPE SiteScope (11.33) Page 91 of 1206



l To use the tools that are available when configuring specific monitors, youmust be a SiteScope
administrator user, or a user grantedUse monitor tools permissions.

2. Add and configure amonitor
Select New > Monitor, and add a new monitor from the New Monitor dialog box. If a tool is available to
help you configure themonitor, click theUse Tool button at the bottom of the new monitor dialog box.

3. Configure and run the test
Enter the required information in the tool dialog box, and run the tool. Any server-side validation errors are
displayed in the result pane.

4. Apply the tested data to themonitor fields
After the configuration data has been successfully tested, click theApply to New Monitor button (or
Apply to Monitor button when editing an existingmonitor) to have SiteScope apply the data to the
monitor configuration.

5. Use a tool to edit or test monitor properties - optional
You can also use SiteScope tools, where available, to edit or test configuration properties for existing
monitors.
l To edit monitor configuration properties, click theUse Tool button in themonitorProperties tab, and
complete the two previous steps.

l To open and run the tool with themonitor's existing data as its input, click the Tools button in the
SiteScope Dashboard toolbar. The test results appear in theResults pane. To save the results to a
file, click theSave to File button.

How to Use the Log Analysis Tool – Use-Case Scenario
This task describes the steps involved in using the Log Analysis Tool when you want to configure a Log File
monitor.

The administrator wants to create a Log File monitor for themost common problems or situations that are
described in the log to bemonitored. Once he selects the situation and creates the corresponding Log File
monitor, themonitor runs as soon as a line corresponding to the selected situation is added to the log.

1. Prerequisites
l To view and use the tool in the Tools context in the left pane, the administrator must be a SiteScope
administrator user, or a user grantedUse tools permissions.

l To use the tools that are available when configuring specific monitors, the administrator must be a
SiteScope administrator user, or a user grantedUse monitor tools permissions.

2. Copy the log to analyze
The administrator copies the log he wants to analyze to the local SiteScopemachine.

3. Run the Log Analysis Tool on that log
a. The administrator selects Tools > Common Utility Tools > Log Analysis Tool.
b. In the Log Analysis Tool dialog box, the administrator enters:

o File location. The location of the log copied to the local SiteScope server. To analyze several
files at the same time, copy the files to the designated folder and create a regular expression that
matches the file names of the log files to be analyzed.
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o Message position. The number of blocks (separated by blanks) that are to the left of the
message to analyze for patterns.
For example, in the log structure that follows, the part of the log entry you are interested in is the
message that starts after the 7th blank space (the space inside the date format is not included as
it is part of the date format).

2010-11-02 11:49:02,738 [SiteScope Main Thread]
(SiteScopeHeartbeatManager.java:53) INFO - The Heartbeat Scheduler was
started. 2010-11-02 11:49:02,786 [SiteScope Main Thread]
(ServiceController.java:82) INFO - Registering service: Host DNS Resolution
Service

o Location of the date in the pattern. The order of the block of text where the date is located. In
the example above, the date is part of the first block of text.

o Date format. In the example above, the date format follows the default. The default includes
blanks.

o The administrator clicks Run Tool.
The Results box, in the Log Analysis Tool dialog box, displays the Regular Expression patterns
found in the log and the number of instances of the pattern.

c. The administrator selects the relevant pattern and clicks theCreate New Log File Monitor button.
In the Select group dialog box that opens, the administrator can select an existing group or create a
new group by clicking theNew Group button.
TheNew Log File Monitor dialog box opens, with the selected regular expression displayed in the
Content match box.

d. In that dialog box, the administrator enters the rest of the information needed to run the Log File
monitor, including the path to the "real" log you want to analyze.

e. The administrator clicks Save to save the new Log File monitor.
4. Results

The Log File monitor watches for specific entries added to themonitored log file that contain the selected
regular expression. Depending on themonitor configuration, the administrator or the user can be notified
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of these conditions that youmay have otherwise been unaware of until somethingmore serious
happened.
The new Log File monitor tool the administrator created is listed in the selected group in themonitor tree.
For details on the user interface, see "Log Analysis Tool" on page 106.
For details on the Log File monitor, see Log File Monitor in the SiteScopeMonitor ReferenceGuide.

Tips/Troubleshooting
Notes and Limitations
To avoid character set problems when the SiteScope client uses amultibyte locale different from the
SiteScope server, set the value in the <SiteScope root directory>\groups\master.config file for the _
httpCharset setting toUTF-8. By default, the _httpCharset value is empty, whichmeans that the default
server locale is used.

Database Connection Tool
This tool enables you to test and verify connectivity between SiteScope and an external JDBC compatible
database. This diagnostic tool checks to see if:

l The supplied database driver can be found and loaded.
l A connection can bemade to the database.
l An optional SQL query can be run and the results displayed.
l The database connection and resources can be closed.
This tool can be useful in verifying connection parameter values needed to set up databasemonitors,
database alerts, and database logging.

To access l Select Tools context > Database Tools > Database Connection Tool (youmust have
Use tools permissions)

l Also available when configuring or viewing the Database Counter monitor, Database
Query monitor, DB2 JDBC monitor, or Technology Database Integrationmonitor
(provided you are an administrator in SiteScope, or a user grantedUse monitor tools
permissions):
l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Important
information

l If exceptions or errors occur during the test, the information is printed along with
suggested actions to help with troubleshooting.

l When using the Database Connection Tool to apply properties to the DatabaseQuery
monitor or Technology Database Integrationmonitor, youmust enter the credential data
manually (if you select a credential profile the credential data is lost).
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Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Database
connection
URL

Database connection URL used when setting up themonitor. When using the Oracle thin
driver, the database connection URL has the form of: jdbc:oracle:thin:@<server name
or IP address>:<port>:
<database sid>.

Example: To connect to the ORCL database on amachine using port 1521, enter
jdbc:oracle:thin:@206.168.191.19:1521:ORCL. The colon (:) symbol must be included
as shown. For other examples of common database connection URLs, see the "Setup
Requirements and User Permissions" section for the relevant databasemonitor.

Note: If you want to access the database usingWindows authentication, enter
jdbc:mercury:sqlserver://<server name or
IP address>:1433;DatabaseName=<database name>;
AuthenticationMethod=type2 as the connection URL, and
com.mercury.jdbc.sqlserver.SQLServerDriver as your database driver. Leave theUser
Name andPassword boxes empty so that the credentials of the currently logged on
Windows user (the account from which SiteScope service is running) are used to establish a
connection to the database.

Database
driver

JDBC driver that SiteScope should use. The .jar file or library containing the .class file must
be installed in the  <SiteScope root directory>\WEB-INF\lib directory. To use a database,
youmust install the driver files into the proper directory before SiteScope can use them.

Example: For examples of common database driver strings, see the "Setup Requirements
and User Permissions" section for the relevant databasemonitor.

Credentials Option for authorizing credentials if the database specified requires a name and password for
access:

l Use user name and password. Select this option tomanually enter user credentials.
Enter the user name and password to access the database in theUser name and
Password box.

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the database (default option). Select the
credential profile to use from theCredential profile drop-down list, or click Add
Credentials and create a new credential profile. For details on how to perform this task,
see "How to Configure Credential Preferences" on page 478.

Query (Optional) SQL query to run on the database. If you do not supply a SQL query string, the
driver is loaded and the connection to the database is tested but no query is run.
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UI Element Description

Result set
maximum
columns

Maximum number of columns to display in the query result set if you entered a SQLQuery.

Default value: 10

Result set
maximum
rows

Maximum number of rows to display in the query result set if you entered a SQLQuery.

Default value: 10

Run Tool Runs the connection test. Connection results are displayed in the Results pane.

Save to
File

Saves the results to a file.

Example
The following is an example of the data returned from a successful database connection with a SQL query
(limited to one row).

serverName
group
ID frameIndex

frame
ID

setting
Name settingLine

line
Chunk chunkValue

10.0.0.157 master.
config

1 _config _database
Max
Summary

1 1 200

Database Information Tool
This tool enables you to view database server metadata such as product and driver version, SQL compatibility
level information, and supported SQL functions.

To access Select Tools context > Database Tools > Database Information Tool (youmust
haveUse tools permissions)

Important
information

Different database drivers and user names can significantly change what information is
displayed.

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48
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User interface elements are described below:

UI Element Description

Database
connection
URL

Database connection URL used when setting up themonitor. When using the Oracle thin
driver, the database connection URL has the form of: jdbc:oracle:thin:@<server name
or IP address>:<port>:<database sid>.

Example: To connect to the ORCL database on amachine using port 1521, enter
jdbc:oracle:thin:@206.168.191.19:1521:ORCL. The colon (:) and the (@) symbols must
be included as shown. For other examples of common database connection URLs, see the
"Setup Requirements and User Permissions" section for the relevant databasemonitor.

Database
driver

JDBC driver that SiteScope should use. The .jar file or library containing the .class file must
be installed in the <SiteScope root directory>\WEB-INF\lib directory. To use a database,
youmust install the driver files into the proper directory before SiteScope can use them.

Example: For examples of common database driver strings, see the "Setup Requirements
and User Permissions" section for the relevant databasemonitor.

Credentials Option for authorizing credentials if the database specified requires a name and password for
access:

l Use user name and password. Select this option tomanually enter user credentials.
Enter the user name and password to access the database in theUser name and
Password box.

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the database (default option). Select the
credential profile to use from theCredential profile drop-down list, or click Add
Credentials and create a new credential profile. For details on how to perform this task,
see "How to Configure Credential Preferences" on page 478.

Run Tool Runs the tool and displays database information. Test results are displayed in the Results
pane.

Save to
File

Saves the results to a file.

DNS Tool
This tool enables you to look up names from aDomain Name Server and show you the IP address for a
domain name. It also shows you information about the name servers for a domain.

You can use this utility to verify that your DNS server is returning the correct addresses for your own servers.
You can also use it to verify that it can look up the addresses for external domains.
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To
access

l Select Tools context > Network Tools > DNS Tool (youmust haveUse tools
permissions)

l Also available when configuring or viewing the DNS monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

DNS
server

IP address or host name of a DNS server. If left empty, the local DNS server is used.

Host
name to
resolve

Domain name that you want translated into an IP address.

Run
Tool

Runs the test. The tool sends the request to the DNS server entered in theDNS server box and
displays the IP address for the host name entered in theHost name to resolve box. The results
of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Event Log Tool
This tool enables you to view portions of theWindows event log locally or on a remote server.
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To access l Select Tools context > Operating System Tools > Event Log Tool (youmust have
Use tools permissions)

l Also available when configuring or viewing theMicrosoft Windows Event Logmonitor
(provided you are an administrator in SiteScope, or a user grantedUse monitor tools
permissions):
l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the
SiteScope Dashboard toolbar. This opens and runs the tool with themonitor's existing
data as its input, and displays the test results in the Results pane.

Important
information

l Different database drivers and user names can significantly change what information is
displayed.

l This tool is not supported on SiteScopes installed on UNIX platforms.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

Server The server on which you want to monitor event logs. Select a server from the server list (only
those remote servers that have been configured in SiteScope are displayed). Alternatively,
click theBrowse Servers button to select a server from the local domain, orAdd Remote
Server to add a new server.

Default value:SiteScope Server (the server on which SiteScope is installed)

Browse
Servers

Select the server to bemonitored:

l Browse servers. Select a server from the drop-down list of servers visible in the local
domain.

l Enter server name. If the server you want to monitor does not appear in the Servers list
because it has not been identified in the network or has not been configured in Remote
Servers, enter the IP address or name of the server to monitor. A double slash ("\\") is
automatically prefixed to any machine name supplied in theEnter server name box.

Note:Youmust have domain privileges or authenticated access to theWindows remote
server. For details on how to configure a remoteWindows server, see "Configure SiteScope to
Monitor RemoteWindows Servers" on page 402.

Add
Remote
Server

Add and configure the remote server. For user interface details, see "New/Edit Microsoft
Windows Remote Server Dialog Box" on page 406.
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UI
Element Description

Log
name

Select the type of log file you want to view:

l Application
l Directory Service
l DNS
l File Replication Service
l Security
l System
Default value:System

Number
of events
displayed

Number of entries to list for this event log. Themost recent entries in the log are displayed first.

Default value: 10

Run Tool Runs the test and refreshes the log entry listing. Log entries are displayed in the Results pane.

Save to
File

Saves the results to a file.

FTP Tool
This tool enables you to access an FTP server and view the interaction between SiteScope (acting as an FTP
client) and the FTP server. For example, if you receive an alert from SiteScope indicating that your FTP server
is not working properly, the first step is to use this tool to help track down the problem.

To
access

l Select Tools context >Web Tools > FTP Tool (youmust haveUse tools permissions)
l Also available when configuring or viewing the FTP monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):
l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48
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User interface elements are described below:

UI
Element Description

Basic FTP Settings

FTP
server

IP address or the name of the FTP server that you want to test.

Example: 206.168.191.22 or ftp.thiscompany.com

File File name to retrieve.

Example: /pub/docs/mydoc.txt

User
name

Name used to log on to the FTP server.

Password Password used to log on to the FTP server.

File
encoding

If the file content to bemonitored uses an encoding that is different than the encoding used on
the server where SiteScope is running, enter the encoding to use. This may be necessary if
the code page which SiteScope is using does not support the character sets used in the target
file. This enables SiteScope tomatch and display the encoded file content correctly.

Default value:windows-1252

Passive
mode

SiteScope uses a passive FTP connection. This is commonly required to access FTP servers
through a firewall.

HTTP Proxy Settings

HTTP
proxy

Proxy name or IP address if you want to use a proxy server for the FTP test.

Proxy
user
name

Name used to log into the proxy server.

Proxy
password

Password used to log into the proxy server.

Run Tool Runs the test. Check The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Example

The following is a sample output from the FTP tool. In this case, the FTP server enabled us to log on
without a problem, indicating that the server is running and accepting requests. The failure is caused
when the server was unable to locate the file that was requested: file.txt. Correcting this particular
problemmay be as easy as replacing themissing file or verifying the file location.

Received: 220 public Microsoft FTP Service (Version 2.0).
Sent: USER anonymous
Received: 331 Anonymous access allowed, send identity (e-mail name) as password.
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Sent: PASS anonymous
Received: 230 Anonymous user logged in.
Sent: PASV
Received: 227 Entering Passive Mode (206,168,191,1,5,183).
Connecting to server 206.168.191.1 port 1463
Sent: RETR file.txt
Received: 550 file.txt: The system cannot find the file specified.
Sent: QUIT
Received: 221

LDAP Authentication Status Tool
This tool enables you to verify that a Lightweight Directory Access Protocol (LDAP) server can authenticate a
user by performing a simple authentication.

To access l Select Tools context > Database Tools > LDAP Authentication Status Tool (you
must haveUse tools permissions)

l Also available when configuring or viewing the LDAP monitor or Active Directory
Replicationmonitor (provided you are an administrator in SiteScope, or a user granted
Use monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

Security
principal

The constant that holds the name of the environment property for specifying the identity of the
principal that authenticates the caller to the service. The format of the principal depends on the
authentication scheme. If this property is unspecified, the behavior is determined by the
service provider. This should be in the format: uid=testuser,ou=TEST,o=mydomain.com.

Note: SiteScope does not support users that contain one or more of the following character
inside the users name: equal ("="), semicolon (";"), inverted commas (""").
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UI
Element Description

Security
credential

The constant that holds the name of the environment property for specifying the credentials of
the principal for authenticating the caller to the service. The value of the property depends on
the authentication scheme. For example, it could be a hashed password, clear-text password,
key, certificate, and so on. If this property is unspecified, the behavior is determined by the
service provider.

LDAP
service
provider

The constant that holds the name of the environment property for specifying configuration
information for the service provider to use. The value of the property should contain a URL
string. This property may be specified in the environment, an applet parameter, a system
property, or a resource file. If it is not specified in any of these sources, the default
configuration is determined by the service provider.

Example: ldap://<somehost>:389

Object
query

An object query to look at a LDAP object other than the default user dn object. Youmust enter
a valid object query in this text box if you are using a LDAP filter. For details about the search
filter, see the description below.

Example:Enter themail object to check for an email address associated with the dn object
entered above.

LDAP
filter

Searches LDAP using the filter criteria. The LDAP filter syntax is a logical expression in prefix
notationmeaning that logical operator appears before its arguments.

Example: The item sn=Freddiemeans that the sn attributemust exist with the attribute value
equal to Freddie.

Multiple items can be included in the filter string by enclosing them in parentheses, such as
(sn=Freddie) and combined using logical operators such as the & (the conjunction operator) to
create logical expressions.

Example: The filter syntax (& (sn=Freddie) (mail=*)) requests LDAP entries that have
both a sn attribute of Freddie and amail attribute.

Run Tool Runs the test. LDAP Authentication test results are displayed in the Results pane.

Save to
File

Saves the results to a file.

Link Check Tool
This tool enables you to verify all the internal and external links on aWeb page to ensure that they can be
reached. It checks the URL specific parameters, such as Web page availability, size, content type, and
average time for retrieving a page.

Each time you run the tool, results are displayed in the Results pane. You can export the results to an Excel of
PDF file.
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To access l Select Tools context >Web Tools > Link Check Tool (youmust haveUse tools
permissions)

l Also available when configuring or viewing the Link Check monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Important
information

Depending on data type, the data in the table can be sorted in ascending or descending
order, or it can be filtered by time, size, type, internal/external data, or count.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

Link Check Tool Panel
User interface elements are described below:

UI Element Description

Main Settings

URL URL that is the starting point for checking links. The link tool retrieves the page for this
URL and reads the URLs for any links on the page. It continues until it has checked all of
the links on the site. It checks links to other servers, but it does not check all the links of
those other servers.

Example: http://demo.thiscompany.com

Pause
(milliseconds)

Delay, in milliseconds, between each link check. Larger numbers lengthen the total time
to check links but decrease the load on the server.

Default value: 15milliseconds

Timeout
(seconds)

Amount of time, in seconds, that the tool should wait for a page to begin downloading
before timing-out. Once this time period passes, the URLmonitor logs an error and
reports an error status.

Default value: 5 seconds

Maximum
links

Maximum number of links this tool checks. When themaximum number of links is
reached themonitor stops and reports the results of those links that were checked.
Increase this number if you have a large site and want to check every link on the site.

Default value: 100
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UI Element Description

Use monitor
run result
data

If selected, the tool displays link check result data from the last monitor run.

Note: This check box is available if the tool is run from the Dashboard only (it is not
available if run from the Tools panel).

Default value:Selected

Authorization Settings

Authorization
user name

User name to access the URL if required.

Authorization
password

Password to access the URL if required.

Proxy Settings

HTTP proxy Domain name and port of an HTTP Proxy Server if a proxy server is used to access the
URL.

Proxy server
user name

Proxy server user name if the proxy server requires a name to access the URL. Technical
note: your proxy server must support Proxy-Authenticate for these options to function.

Proxy server
password

Proxy server password if the proxy server requires a name to access the URL.

Note:Your proxy server must support Proxy-Authenticate for these options to function.

Run Tool Runs the test and displays the results in the Results pane. Each link in the URL is
displayed on a separate line with the followed information. For details, see "Results
Panel" below.

Results Panel
User interface elements are described below:

UI
Element Description

Export to Excel/PDF. Enables you to save link check results by exporting them to an Excel
or PDF file.

Edit the filter. Enables filtering the data displayed in the table.

Operator. Click the down-arrow to select the operator (= Equals, != Not the same as, < Less
than, <= Less than or equal to, > Greater than, >= Greater than or equal to, In - contains the
value entered).

Apply current filter. Click the green check to apply the filter.

Clear current filter. Click the trash can to clear the filter.
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UI
Element Description

Change visible columns. Enables you to select the columns you want to display in the table.
TheStatus and Time columns are always displayed.

Status The status of the link in the URL:

l ok

l error
If error status displayed, an error description is included.
For example, bad request, unauthorized, unable to connect, timed out reading.

Size (K
bytes)

The size of theWeb page available from the link.

Time Response time for the link in the URL.

Est. time
(seconds)

Estimated time in seconds.

Content
Type

The content type of the link in the URL.

URL The URL of the link. Click the hyperlink to open the link page.

Source
Page

The source page of the link. Click the hyperlink to open the source page.

External Indicates whether the link is external (yes) or internal (no) .

Count The number of links to get to the URL page.

Log Analysis Tool
This tool enables you to scan a log file to indicate recurring patterns in the file. Once the tool has listed the
patterns, you can have the tool create a SiteScope Log File monitor to monitor that pattern in the log.

To access Select Tools context > Common Utility Tools > Log Analysis Tool (youmust haveUse
tools permissions)

Important
information

l If the structure of the log you want to analyze is not consistent, you cannot use this tool.
l After you have created the Log File monitor for a pattern discovered by the Log Analysis
Tool, the new monitor is listed in themonitor tree.

l To tell the Log Analysis Tool where the text you want to analyze is located in the log file,
you can provide a regular expression or the number of blocks of text before the text you
want to analyze.

Limitation: The size of the log file you want to analyze should not bemore than 10MB.
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Relevant
tasks

l "How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91
l "How to Use the Log Analysis Tool – Use-Case Scenario" on page 92

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Log Analysis Tool Area

Folder
location on
SiteScope
Server

Enter the path of the folder, on the SiteScope server, where the log files to be analyzed are
located.

File name Enter the name of the log file to be analyzed. To analyze several files at the same time,
copy the files to the designated folder and create a regular expression that matches the file
names of the log files to be analyzed.

Example: enter /error/ to analyze the error123.log and error345.log at the same time.

Use regular
expression

You can provide a regular expression or the number of blocks of text before the text you
want to analyze.

Select this option to use a regular expression to find the text you want to analyze in the log
file.

Regular
expression

Enter the regular expression you want the tool to use to find the text you want to analyze.
The regular expressionmust be entered between slashes (/).

This field is enabled only when you select theUse regular expression option.

Example: For examples of regular expressions, see "Examples of Regular Expressions"
on the next page.

Number of
blocks
before
message

Log files include lots of information. The Log Analysis Tool is looking for patterns in the
message (for example, themessage after INFO or ERROR).

This field is not enabled when you select theUse regular expression option.

To indicate to the tool where themessage to analyze starts, youmust specify the number
of blocks of text (strings) separated by blank spaces that appear in each line of the log,
before the start of themessage you want to analyze. Ignore the blanks in the date if the
date format includes blanks (seeDate format below).

Note: Logs that do not have a consistent structure cannot be analyzed by this tool.

Order of
block where
date is
located

Enter the order of the block of text where the date is located counting from the left. The
number of the first block is 1.

This field is disabled when you select theUse regular expression option.
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UI Element Description

Date format Select the date format used in the log.

Default format:yyyy-mm-dd HH:mm:ss,SSS

Tool
timeout (in
seconds)

Amount of time, in seconds, to wait for the Log Analysis tool to run before timing out.

Default value: 30 seconds

Run Tool Runs the test. A list of all recurringmessage patterns is displayed in the Results box.

Results Area

Create New
Log File
Monitor

Select a pattern and click the button to open the Select group dialog box where you can
select a existing group or create a new group by clicking theNew Group button. TheNew
Log File Monitor dialog box opens, with the selected regular expression displayed in the
Content match box.

Message
Pattern

Displays a list of patterns found in the log.

The list is ordered according to the number of occurrences of the patterns.

Number of
Occurrences

Displays the number of instances of each pattern.

The list is ordered according to the number of occurrences of the patterns.

Examples of Regular Expressions
Use the following regular expression:

\d*-\d*-\d*\s\d*.*,\d*\s\[\w.*\]\s\(\w.*\)\s\w.*\s\-\s

where d indicates a digit, w indicates a word, s indicates a space, and * indicates any character, for a log with
the following structure:

2010-11-02 11:49:02,738 [SiteScope Main Thread] (SiteScopeHeartbeatManager.java:53)
INFO - The Heartbeat Scheduler was started.
2010-11-02 11:49:02,786 [SiteScope Main Thread] (ServiceController.java:82) INFO -
Registering service: Host DNS Resolution Service
2010-11-02 11:49:02,951 [SiteScope Main Thread] (ServiceController.java:82) INFO -
Registering service: Monitor History Event Sink Service
2010-11-02 11:49:03,035 [SiteScope Main Thread] (ServiceController.java:82) INFO -
Registering service: Alert Action Execution Counter Registry Service
2010-11-02 11:49:03,035 [SiteScope Main Thread] (ServiceController.java:82) ERROR -
Connection Error while trying to connect
2010-11-02 11:49:03,037 [SiteScope Main Thread] (ServiceController.java:82) INFO -
Registering service: Alert Open Status Registry Service
2010-11-02 11:49:03,277 [SiteScope Main Thread] (SiteScopeSupport.java:655) INFO

Use the following regular expression:

\d*\s\w*\s\w*\s\**\d*\**\s\-\s

where d indicates a digit, w indicates a word, s indicates a space, and * indicates any character, for a log with
the following structure:
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123 Error starts *****12**** - The Heartbeat Scheduler was started.
123 Error starts *****23**** - Registering service: Host DNS Resolution Service
123 Error starts *****34**** - Registering service: Monitor History Event Sink
Service
123 Error starts *****45**** - Registering service: Alert Action Execution Counter
Registry Service
123 Error starts *****45**** - Registering service: Alert Action Execution Counter
Registry Service

Mail Round Trip Tool
This tool enables you to check aMail Server by using the network to verify that themail server is accepting
requests and that amessage can be sent and retrieved. It does this by sending a standardmail message
using SMTP and then retrieving that samemessage by using a POP user account. Eachmessage that
SiteScope sends includes a unique key which it checks for to ensure that it does not retrieve the wrong
message and return a false OK reading.

To
access

l Select Tools context >Mail Tools >Mail Round Trip Tool (youmust haveUse tools
permissions)

l Also available when configuring or viewing theMail monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Basic Mail Settings

Using SiteScope
Chapter 12: SiteScope Tools

HPE SiteScope (11.33) Page 109 of 1206



UI Element Description

Action Select the action to take:

l Send and receive. Enables you to send a test message to an SMTP server and then
receive it back from the POP3 or IMAP4 server to check that themail server is up and
running. (Default option)

l Receive only. Checks the incoming POP3 or IMAP4mail servers for amessage that
was sent previously. This check is done by matching the content of the previously-
sent message.

l Send only. Checks that the receivingmail server has accepted themessage.

Sending
email server
(SMTP)

Host name of the SMTP mail server to which the test mail message should be sent.

Example: mail.thiscompany.com

Send to
address

Mail address to which the test message should be sent.

Receiving
protocol

Protocol used by the receivingmail server. Select one of the following options:

l IMAP4 to use an IMAP4mail server for receivingmail.
l IMAP4S to use a secure IMAP4mail server for receivingmail.
l POP3 to use a POP3mail server for receivingmail.
l POP3S to use a secure POP3mail server for receivingmail.
Default value:POP3

Receiving
email server

Host name of the POP mail server that should receive the test message. This can
be the same mail server to which the test message was sent.

Example: mail.thiscompany.com

Receiving
email server
user name

POP user account name. A test email message is sent to this account and the logs in to
the account to verify that themessage was received. No other mail in the account is
touched. You can use your own personal mail account or another existing account for this
purpose.

Note: If you use an email reader that automatically retrieves and deletes messages from
the server, there is a chance that theMail Round Trip Tool never sees themail message
and reports an error.

Receiving
email server
password

Password, if necessary, for the test mail account.
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UI Element Description

Receive only
content match

String of text to match against the contents of the incomingmessage. If the text is not
contained in the incomingmessage, theMail Round Trip reports an error. This is for the
receiving only option (for example, Subject:MySubject). The search is case sensitive.

HTML tags are part of a text document, so include the HTML tags if they are part of the
text you are searching for (for example, "< B> Hello< /B> World"). This works for XML
pages as well.

You can perform a regular expressionmatch by enclosing the string in forward slashes,
with an i after the trailing slash indicating case-insensitivematching. An examplemight
be "/href=Doc\d+\.html/" or "/href=doc\d+\.html/i".

If you want a particular piece of text to be saved and displayed as part of the status, use
parentheses in a regular expression (for example, /Temperature: (\d+)/ ). This
returns the temperature as it appears on the page.

Advanced Mail Settings

Timeout
(seconds)

Number of seconds to wait for amail message to be received before timing-out.

Default value: 300 seconds

POP check
delay
(seconds)

After SiteScope sends the test message, it immediately logs into themail account to
verify that themessage has been received. If themessage has not been received,
SiteScope automatically waits 10 seconds before it checks again. You can adjust this
wait time by indicating an alternate number of seconds to wait in this box.

Default value: 10 seconds

SMTP user User name required for SMTP authentication if the SMTP server requires authentication
before sendingmessages.

SMTP
password

Password for the SMTP authentication (if required).

NTLM
authentication

NTLM version (version 1 or 2) if NTLM authentication is used by the email server.

Default value: none

SMTP
SSL/TLS

Enables sending emails securely via SSL/TLS SMTP servers. When selected, the
monitor sends all mails via SSL/TLS.

Note:By default, mail is sent via port 465 of the SMTP mail server unless you specify a
different port inCustom SMTP Port (see below).

Default value:Not selected

Custom
SMTP Port

Enables sending emails via a user-specified port. If this box is left empty, the default port
for sendingmail is used (465 for the SMTP mail server).

Show details Displays details of the round trip test.

Run Tool Runs the test. Check mail server test results are displayed in the Results pane.

Save to File Saves the results to a file.
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Network Status Tool
This tool reports the current network interface statistics and lists the active network connections. This
information can be useful to determine the health of you network interface. You can also use this tool to track
down problems, where network connections are being left open, or runaway conditions, where an increasing
number of connections are being opened without being closed.

To access Select Tools context > Network Tools > Network Status Tool (youmust haveUse
tools permissions)

Important
information

This tool is not supported on SiteScopes installed on UNIX platforms.

Relevant tasks "How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on
page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

Run Tool Runs the Network Status Tool and reports the network information. The data appears in the
Results pane.

Save to
File

Saves the results to a file.

News Server Tool
This tool enables you to access a News server and view the NNTP interaction between SiteScope (acting as
a news client) and the News server.

To
access

l Select Tools context > Application Tools > News Server Tool (youmust haveUse
tools permissions)

l Also available when configuring or viewing the News monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91
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See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

News server Name of the News server in the format
news.sitescope.com or news.sitescope.com:7777.

News groups (Optional) News group names. Separatemultiple news group names by commas (",").

User name User name if the News server specified above requires a name and password for access.

Password Password if the News server specified above requires a name and password for access.

Run Tool Runs the test. The results of the test are displayed in the Results pane.

Save to File Saves the results to a file.

Performance Counters Tool
This tool enables you to check performance counters on a specific machine in aWindows network. It provides
an interface to the perfex.exe executable supplied as part of SiteScope.

To access l Select Tools context > Operating System Tools > Performance Counters Tool (you
must haveUse tools permissions)

l Also available when configuring or viewing the CPU monitor, Dynamic Disk Space
monitor, Memory monitor, or Microsoft Windows Performance Counter monitor (provided
you are an administrator in SiteScope, or a user grantedUse monitor tools
permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Important
information

This tool is not supported on SiteScopes installed on UNIX platforms.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48
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User interface elements are described below:

UI Element Description

Performance Counters Tool Area

Server The server where theWindows performance counter objects you want to monitor are
running. Select a server from the server list (only those remote servers that have been
configured in SiteScope are displayed). Alternatively, click theBrowse Servers button to
select a server from the local domain, orAdd Microsoft Windows Remote Server to add a
new server.

Default value: SiteScope Server (the server on which SiteScope is installed)

Admin User Account/ Password

Enter the administrative user name and password for themachine you want to query. This is
only necessary if you running SiteScope under an account that does not have administrative
privileges to access performance counters for the domain or workgroup to which you are
trying to connect.

If the test indicates you are required to supply a password, it means that the remotemachine
requires authorization to access the performance counter registry.

Tip: If you see themessage "(NOCOUNTERS OBJECTS AVAILABLE using this
username and password)" in the drop down list forCounter objects and you have not
supplied a user name and password, follow one of the suggestions below to ensure that you
have access to the remotemachine's registry that you are setting up:

l Setup a SiteScopeWindows remote connection to the remotemachine that has local
administrator privileges.

l Run the SiteScope service as a user that has access to your remotemachines.

Browse
Servers

Opens the Select Server dialog box, enabling you to select the server to bemonitored:

l Browse servers. Select a server from the drop-down list of servers visible in the local
domain.

l Enter server name. If the server you want to monitor does not appear in the Servers list
because it has not been identified in the network or has not been configured in Remote
Servers, enter the IP address or name of the server to monitor. A double slash ("\\") is
automatically prefixed to any machine name supplied in theEnter server name box.

Note:Youmust have domain privileges or authenticated access to theWindows remote
server. For details on how to configure a remoteWindows server, see "Configure SiteScope
toMonitor RemoteWindows Servers" on page 402.

Add
Remote
Server

Opens the Add Remote Server dialog box, enabling you to select the type of remote you
want to add (Windows or UNIX), and enter the configuration details.

For details on theMicrosoft Windows Remote Servers user interface, see "New/Edit
Microsoft Windows Remote Server Dialog Box" on page 406.

For details on the UNIX Remote Servers user interface, see "New/Edit UNIX Remote
Server Dialog Box" on page 422.

Counters Select a counter object to display the individual performance counters and corresponding
values for the selected counter object.

Using SiteScope
Chapter 12: SiteScope Tools

HPE SiteScope (11.33) Page 114 of 1206



UI Element Description

Run Tool Runs the tool and displays the individual Windows performance counters and corresponding
values for the selected counter object. This information appears in the Results pane.

Save to
File

Saves the results to a file.

Results

Counter
Name

Performance counter name.

Counter
Value

Value for the performance counter object.

Counter
Description

Description of the performance counter.

PERF Type Description of the counter type.

Ping Tool
This tool displays the round trip time along a path. It sends a packet to another location and back to the
sender. When there is a problem with the network, ping can tell you if another location can be reached. The
Ping tool does a ping from the current server to another location.

To
access

l Select Tools context > Network Tools > Ping Tool (youmust haveUse tools
permissions)

l Also available when configuring or viewing the Pingmonitor or Port monitor (provided you
are an administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Host name to
resolve

Domain name or IP address of the host you want to ping.

Example: demo.thiscompany.com or 206.168.112.53
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UI Element Description

Run Tool Pings the domain name or IP address. The results of the test are displayed in the
Results pane.

Save to File Saves the results to a file.

Processes Tool
This tool displays processes running on the server where SiteScope is installed. This can be useful to confirm
that critical processes are available.

To access Select Tools context > Operating System Tools > Processes Tool (youmust haveUse
tools permissions)

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

Server The server where the processes you want to monitor are running. Select a server from the server
list (only those remote servers that have been configured in SiteScope are displayed).
Alternatively, click theBrowse Servers button to select a server from the local domain, orAdd
Remote Server to add a new server.

Default value: SiteScope Server (the server on which SiteScope is installed)

Browse
Servers

Opens the Select Server dialog box, enabling you to select the server to bemonitored:

l Browse servers. Select a server from the drop-down list of servers visible in the local
domain.

l Enter server name. If the server you want to monitor does not appear in the Servers list
because it has not been identified in the network or has not been configured in Remote
Servers, enter the IP address or name of the server to monitor. A double slash ("\\") is
automatically prefixed to any machine name supplied in theEnter server name box.

Note:Youmust have domain privileges or authenticated access to theWindows remote server.
For details on how to configure a remoteWindows server, see "Configure SiteScope toMonitor
RemoteWindows Servers" on page 402.
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UI
Element Description

Add
Remote
Server

Opens the Add Remote Server dialog box, enabling you to select the type of remote you want to
add (Windows or UNIX), and enter the configuration details.

For details on theMicrosoft Windows Remote Servers user interface, see "New/Edit Microsoft
Windows Remote Server Dialog Box" on page 406.

For details on the UNIX Remote Servers user interface, see "New/Edit UNIX Remote Server
Dialog Box" on page 422.

Run
Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Regular Expression Tool
This tool enables you to perform a regular expressionmatch.

To access Select Tools context > Common Utility Tools > Regular Expression Tool (youmust
haveUse tools permissions)

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Text Copy and paste a portion of text containing the string or values on which you want to
perform a regular expressionmatch into this box.

For efficiency in developing regular expressions, include all of the content that would
precede the target data or pattern that you want to match. For example, when developing
a regular expression for content matching on aWeb page, use the "URL Tool" on
page 128 to retrieve the entire HTTP content including the HTTP header.

Regular
expression

Enter a regular expression between the slashes //, to match some part of the text you
entered.

Note: For content with multiple lines with carriage returns and line feeds, consider adding
the s searchmodifier to the end of the expression to have the content treated as a single
line of text.

Example: /value:\W[\d]{2,6}/s

Run Tool Runs the test. The results of thematch test are displayed in the Results pane. If there is
a problem with your regular expression, an error message appears.
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UI Element Description

Save to File
(This option is
not available in
Manage View of
Unified
Console.)

Saves the results to a file.

Parsed Parentheses and Matches Table
This section includes a table that displays any matches requested as retained values or back references by
pairs of parentheses inside the regular expression. If your expression does not include parentheses, this table
is empty. The columns of the parsed parentheses table are:

UI Element Description

Parentheses
counted
from left

Displays any patterns in the regular expression delimited by parentheses as counted from
the left-hand side of the expression.

Matching
text

Displays the text that matched the parenthesis marked patterns listed in the column to the
left.

Whole
Match
Between
Slashes

This is the text area below the table. It echoes the entire content entered in theYour Text
that will be matched box. The content that matched the pattern in your regular expression
is highlighted within this content, normally using a blue font. This is useful for showing
possible problems with wildcard expressions like the .* pattern that match toomuch
content. It can also uncover problems of duplicate patterns within the content that require
you to add other unique patterns to your expression tomatch the desired portion of the
content.

Services Tool
This tool displays services running on the server where SiteScope is installed. This can be useful to confirm
that critical services are available. If Remote UNIX machines have been defined, they are listed in a drop-
downmenu.

To access l Select Tools context > Operating System Tools > Services Tool (youmust haveUse
tools permissions)

l Also available when configuring or viewing the Servicemonitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Using SiteScope
Chapter 12: SiteScope Tools

HPE SiteScope (11.33) Page 118 of 1206



Important
information

This tool is not supported on SiteScopes installed on UNIX platforms.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

Server The server where the services you want to monitor are running. Select a server from the server
list (only those remote servers that have been configured in SiteScope appear). Alternatively,
click theBrowse Servers button to select a server from the local domain, orAdd Remote
Server to add a new server.

Default value:SiteScope Server (the server on which SiteScope is installed)

Browse
Servers

Opens the Select Server dialog box, enabling you to select the server to bemonitored:

l Browse servers. Select a server from the drop-down list of servers visible in the local
domain.

l Enter server name. If the server you want to monitor does not appear in the Servers list
because it has not been identified in the network or has not been configured in Remote
Servers, enter the IP address or name of the server to monitor. A double slash ("\\") is
automatically prefixed to any machine name supplied in theEnter server name box.

Note:Youmust have domain privileges or authenticated access to theWindows remote server.
For details on how to configure a remoteWindows server, see "Configure SiteScope toMonitor
RemoteWindows Servers" on page 402.

Add
Remote
Server

Opens the Add Remote Server dialog box, enabling you to select the type of remote you want to
add (Windows or UNIX), and enter the configuration details.

For details on theMicrosoft Windows Remote Servers user interface, see "New/Edit Microsoft
Windows Remote Server Dialog Box" on page 406.

For details on the UNIX Remote Servers user interface, see "New/Edit UNIX Remote Server
Dialog Box" on page 422.

Run
Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

SiteScope Log Grabber Tool
This tool enables you to collect the SiteScope log and configuration files. In addition, it can be used to gather
the following data:
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l Thread dump of SiteScope
l Results of system commands (such as "netstat", "dir", and so on)
l Information about JVM
l Windows event log entries
You can use the default configuration file (default.loggrabber.conf.xml) or create your own configuration
files, for example, to create a scheduled backup of the SiteScope configuration.

Note: You can use the SiteScope LogGrabber tool manually by running the LogGrabber.bat script
(LogGrabber.sh for UNIX) from the <SiteScope root directory>\tools\LogGrabberSiteScope folder.
In this mode, the configuration file should be used as a parameter: LogGrabber.bat
full.loggrabber.conf.xml.

You can use this tool from either the Script alert (for example, to collect data for troubleshooting if CPU
utilization is greater than 90%, or if a critical error is found in the log), or from the Script monitor (to collect
regular data using the scheduler). The name of the configuration file should be transferred in the script as a
parameter.

To access Select Tools context > Common Utility Tools > SiteScopeLog Grabber Tool (youmust
haveUse tools permissions)

Important
information

Since the SiteScope configuration can contain valuable data such as encoded passwords,
make sure that theDownload SiteScope Log Grabber run results permission (in
Preferences > User Management Preferences > Permissions > Other) is not granted to
untrusted users. For details on user permissions, see "Permissions" on page 636.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

SiteScope Log Grabber Tool Area

Configuration
File

Select the configuration file to use.

Default value: default.loggrabber.conf.xml

Folders Select the folders and/or files to be checked for runtime changes.

Run Tool Runs the tool. The results are displayed in the Results box.

Results

Download file Enables downloading a file containing the last run results.

Note:Youmust haveDownload Log Grabber run results permissions to download the
run results file.
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UI Element Description

File Lists all the result files (in .zip format). Click to open a file and download the results for a
selected file.

Size The size of the results file.

Last Modified Date and time that the results file was last modified.

Export to Excel/PDF. Enables you to save collected log file results by exporting them to
an Excel or PDF file.

SNMP Browser Tool
This tool provides details of an SNMP agent's MIB. It can be used to verify the connection properties of an
SNMP agent and to gainmore information about the SNMP agent's counters.

To access l Select Tools context > SNMP Tools > SNMP Browser Tool (youmust haveUse
tools permissions)

l Also available when configuring or viewing the CiscoWorks monitor, F5 Big-IP monitor,
or SNMP by MIB monitor (provided you are an administrator in SiteScope, or a user
grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Important
information

l This tool operates by traversing all of the OIDs on a given agent and then using theMIB
information in the <SiteScope root directory>\templates.mib directory to display the
OID, counter names, type, and values in a table.

l If MIBs are not listed in theMIB file drop-down box after addingMIB files to the
templates.mib directory when creating an SNMP by MIB monitor, see the
TroubleshootingMIB Compilation steps in SNMP by MIB Monitor in the SiteScope
Monitor ReferenceGuide.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

SNMP Settings
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UI Element Description

Server Host name or IP address of the device on which the SNMP agent is running that you
want to monitor.

Port Port on which the SNMP agent is listening.

Default value: 161

MIB file MIB that you want to view. If you select All MIBs, then all data obtained during theMIB
traversal appears. If you select a specific MIB, then only the OIDs within that MIB
appear. This list of MIBs can be updated or extended by placing new MIB files in the
<SiteScope root directory>\templates.mib directory.

Default value:All MIBs

Starting OID Use this option when selecting counters for this monitor. When themonitor attempts to
retrieve the SNMP agent's tree, it starts with the OID value that is entered here. The
default value is 1, which is commonly used and applicable tomost applications. Edit this
box only when attempting to retrieve values from an application that does not handle
OIDs starting with 1. If the default value of 1 did not enable retrieving any counters, then
youmay have to enter a different value.

SNMP Connection Settings

Timeout
(seconds)

Total time, in seconds, that SiteScope should wait for all SNMP requests (including
retries) to complete.

Default value: 5 seconds

Number of
retries

Number of times each SNMP GET request should be retried before SiteScope considers
the request to have failed.

Default value: 1

Community Community string to use when connecting to the SNMP agent for version 1 or 2
connections.

Default value: public

SNMP version Version of SNMP which the tool should use when connecting to the agent. SiteScope
supports SNMP version 1, version 2, and version 3. Selecting V3 enables you to enter
version 3 settings in the fields below.

Default value:V1

Authentication
algorithm

Authentication algorithm to use for a version 3 connection.

Default value:MD5

Note: This field is available only if SNMP V3 is selected.

User name User name for a version 3 connection.

Note: This field is available only if SNMP V3 is selected.

Password Password to use for authentication in a version 3 connection.

Note: This field is available only if SNMP V3 is selected.
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UI Element Description

Privacy
algorithm

The privacy algorithm used for authentication for SNMP version 3 (DES,128-Bit
AES,192-Bit AES, 256-Bit AES). Leave blank if you do not want privacy.

Default value: DES

Note: This field is available only if SNMP V3 is selected.

Privacy
password

Password to use for DES privacy encryption in a version 3 connection. Leave blank if
you do not want privacy.

Note: This field is available only if SNMP V3 is selected.

Context name Context Name to use for this connection. This is applicable for SNMP V3 only.

Note: This field is available only if SNMP V3 is selected.

Context
engine ID

Hexidecimal string representing the Context Engine ID to use for this connection. This is
applicable for SNMP V3 only.

Note: This field is available only if SNMP V3 is selected.

Run Tool Runs the test. The results of the test appear in the Results pane.

Save to File Saves the results to a file.

SNMP Tool
This tool lets you query a SNMP Management Information Base (MIB) and retrieve a set of OIDs.

To
access

l Select Tools context > SNMP Tools > SNMP Tool (youmust haveUse tools
permissions)

l Also available when configuring or viewing the SNMP monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Host name IP address of the server that hosts the SNMP MIB you want to query.
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UI Element Description

Port Port to use when requesting data from the SNMP agent.

Default value: 161

Object ID Select the Object ID setting:

l Commonly used values. Select the Object ID mnemonic from the drop-down list.
(This is the default option with system.sysDescr set as the default value.)
Enter the index of the SNMP object. Values for an OID come as either scalar or
indexed (array or table) values.
l For a scalar OID, the index valuemust be set to 0.

l For an indexed or table value, youmust provide the index (a positive integer) to the
element that contains the value you want. The index value for Commonly used
values is set to ifSpecific.ifInOctets.
Default value: 0

l Other values. Enter the Object Identifier (OID) for the SNMP value you want to
retrieve. TheOID specifies which value should be retrieved from the device.

Example: 1.3.6.1.2.1.4.3
Tip: To troubleshooting basic connectivity to the device and to confirm that the SNMP
agent is active, select the system.sysDescr object from the drop-down list if other
objects cannot be found.

Note:SiteScope supports SNMP versions 1.0, 2.0, and 3.0.

If you receive the error message error - noSuchName, it means SiteScope was able to
contact the device but the OID given is not known by the device. Youmust provide an
OID that is valid to the device to obtain a value.

If you have aMIB file for the device you want to monitor, you can copy the *.mib (or *.my)
file into the  <SiteScope root directory>\templates.mib subdirectory and use theMIB
Help utility to compile theMIB and browse theOIDs for the device. To use theMIB
Helper tool, select Tools > MIB Browser and enter the connection details. After copying
a new MIB file to SiteScope, youmust restart SiteScope. Select theMIB file to browse
using the drop-down list. Click the browse button to show theOIDs from the selected
MIB file. A tree that represents the chosenMIB on the specified server appears. You can
browse that tree to find the OID that you want to monitor.

It is not necessary to browse aMIB file with the SiteScopeMIB Helper to monitor a
device. TheMIB Helper is provided simply as a tool to help you discover OIDs available
on a device, but it is not the only tool available. You can find other alternative tools on the
Web (for example, MG-SOFT or iReasoning).

Number of
records to get

Number of OID records to retrieve.

Default value: 1

SNMP Connection Settings
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UI Element Description

Timeout
(seconds)

Amount of time, in seconds, that SiteScope should wait for an SNMP request.

Default value: 5 seconds

Number of
retries

Number of SNMP request retries before SiteScope considers themonitor to have failed.

Default value: 1

Community Community string for the SNMP device.

The Community string provides a level of security for a SNMP device. Most devices use
public as a community string. However, the device you are going tomonitor may require
a different Community string to access it.

If you try to monitor an SNMP agent through specific community, youmust make sure
that the SNMP agent is familiar with that community. For example, if you try to monitor a
Windows 2003 server through public community, youmust make sure that the SNMP
agent has this community configured. Otherwise, themonitor cannot connect to the
agent.

Default value: public

Note: The field is valid only for version 1 or 2 connections.

SNMP version SNMP version used by the SNMP host you want to monitor. SiteScope supports SNMP
version 1, version 2, and version 3.

Default value:V1

Authentication
algorithm

Authentication algorithm used for SNMP V3. You can select MD5, SHA, or None.

Note: This field is available only if SNMP V3 is selected.

User name User name to be used for authentication if you are using SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Password Password to be used for authentication if you are using SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Privacy
algorithm

The privacy algorithm used for authentication for SNMP version 3 (DES,128-Bit
AES,192-Bit AES, 256-Bit AES).

Default value: DES

Note: This field is available only if SNMP V3 is selected.

Privacy
Password

The privacy password used for authentication for SNMP version 3. Leave blank if you do
not want privacy.

Note: This field is available only if SNMP V3 is selected.

Context Name The context name of SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Context
Engine ID

The context engine ID of SNMP version 3.

Note: This field is available only if SNMP V3 is selected.
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UI Element Description

Run Tool Runs the test. The results of the test are displayed in the Results pane.

Results

Save to File Saves the results to a file.

SNMP Trap Tool
This tool enables you to view SNMP Traps received by SiteScope's SNMP listener. The tool is only enabled if
you have already created one or more SNMP Trapmonitors. Creating an SNMP TrapMonitor enables the
SiteScope SNMP Trap Log.

To access l Select Tools context > SNMP Tools > SNMP Trap Tool (youmust haveUse tools
permissions).

l Also available when configuring or viewing the SNMP Trapmonitor or Technology SNMP
Trap Integrationmonitor (provided you are an administrator in SiteScope, or a user
grantedUse monitor tools permissions).

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Important
information

ThemessageReceiving SNMP Traps is not active appears at the top of the tool page if
the SNMP Trap Log is not currently active.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI
Element Description

Content
match

Optional text string or regular expression to be used tomatch entries in the SNMP Trap Log.
Content matching can be done for data from any of the columns of the log such as OID,
Community, Agent, and so on.

The SNMP traps in the SiteScope SNMP Trap Log appear in the SNMP Trap Log table. The
number of traps matching the search criteria appears in the SNMP Trap Log table title displayed
in the lower part of the page.
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UI
Element Description

Traps to
show

Number of SNMP Traps to list. The number of traps is calculated, based on average trap length.
If the trap text is longer or shorter than average, the number of traps shown can be different from
the selected value. Themost recent SNMP Traps received by SiteScope appear first.

Default value: 10

Run
Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Trace Route Tool
This tool shows you the network path between two locations and how long it takes to get to each hop in the
path. When there is a problem with the network, traceroute can often be used to narrow downwhere the
problem is occurring. This tool performs a traceroute from your server to another location.

You can use this utility to verify connectivity of a host and to determine how the host is connected to the
Internet. You can also determine the path taken from your server to the specified host. This helps you to
determine where packet loss may be occurring when you attempt to connect to hosts elsewhere on the
Internet.

To access Select Tools context > Network Tools > Trace Route Tool (youmust haveUse tools
permissions)

Important
information

You can use this tool to perform a traceroute onWindows platforms only. For UNIX, you
must stop the SiteScope process, add the path of the traceroute utility (for example
/usr/sbin/traceroute) to the Traceroute command box in Infrastructure Preferences,
and then restart SiteScope.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Host name to resolve Domain name or IP address of the other location to resolve.

Example: demo.thiscompany.com or 206.168.112.53

Run Tool Runs the test. The results of the test are displayed in the Results pane.

Save to File Saves the results to a file.
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URL Tool
This tool enables you to retrieve an item from aWeb server. The URL specifies the server to contact and the
item to return. Because SiteScope displays the content of the requested URL, this tool also functions to
check URLContent. You can use this utility to verify that a given URL can be accessed from aWeb server.
You can also use it to see how long it takes for the page to be returned.

To
access

l Select Tools context >Web Tools > URL Tool (youmust haveUse tools permissions)
l Also available when configuring or viewing the URLmonitor, URLContent monitor, or
Oracle 9i Application Server monitor (provided you are an administrator in SiteScope, or a
user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Main Settings

URL URL that you want to test.

Example: http://demo.company.com

Match
content

String of text to check for in the returned page or frame set. If the text is not contained in
the page, the content match fails. The search is case sensitive. HTML tags are part of a
text document, so youmust include the HTML tags if they are part of the text you are
searching for (for example, "< B> Hello< /B> World").

Match
content for
error

String of text to check for in the returned page or frame set. If the text is contained in the
page, the test indicates an error condition. The search is case sensitive.

Timeout
(seconds)

Amount of time, in seconds, to wait for a page to complete downloading before timing-out.
Once this time period passes, the URLmonitor logs an error and reports an error status.

If you have selected theRetrieve images orRetrieve frames option, SiteScope waits for
these items to be retrieved before considering the page to be fully downloaded.

Default value: 60 seconds
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UI Element Description

Retries Number of times (between 0-10) that SiteScope should retry the request if a recoverable
error was encountered. A timeout of the request is a recoverable error.

Default value: 0

HTTP Settings

Request
headers

Header request lines sent by the HTTP client to the server. Headers should be linebreak
separated. The standard list of HTTP1.1 request headers can be found in
http://www.w3.org/Protocols/rfc2616/rfc2616-sec14.html#sec14.

Note:Although this field is optional, someWeb pages behave unexpectedly when the
request header is missing (such as performing endless redirects, providing wrong content,
and so forth).

URL content
encoding

URL content encoding is the encoding in which the content is written. The encoding can
be found in any of the following:

l HTTP headers: Content-Type: text/html; charset=UTF-8

l HTMLmeta tag <meta http-equiv="Content-Type" content="text/html;
charset=US-ASCII">

l XML: <?xml version="1.0" encoding="ISO-8859-1"?>
Select the encoding type from the drop down list.

Examples:UTF-8, UTF-16, US-ASCII, ISO-8859-1

Default value: Encoding from server response

POST data If the URL is for a POST request, enter the post variables, one per line as name=value
pairs.

This option is used to verify that a form is working correctly by performing the same
request that occurs when a user submits a form. See also theMatch content item for a
way to verify that the correct form response was received.

If this item is blank, a GET request is performed.

The POST data can be used to send cookie data. To send cookies with the request, use
the format Set-cookie: cookieName=cookieValue.

To change the content type of a post, use the format
Content-Type: application/my-format.

To substitute values in the POST data, add a line to themaster.config file, such as:

_private=_name=mysecret _value=rosebud
_private=_name=mypassword _privateValue=sesame

and then use the following form in the POST data:

s|username=$private-mysecret$|
s|password=$private-mypassword$|

and SiteScope substitutes the values from themaster.config into the POST data.
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UI Element Description

POST data
encoding

Determines if the POST data is encoded. Select from the following options:

l Use content type. Encodes the POST data by the content type header. If the header
equals urlencoded then encode, otherwise do not encode.

l Force URL encoding. Always encodes the post data.
l Do not force URL encoding. Does not encode the POST data.

Error if
redirected

Generates an error (and notifies you) if a URL is redirected.

Default value:Not selected

HTTP version HTTP version for SiteScope to use for style request headers (HTTP version 1.1 or 1.0).

Default value: 1.1

Retrieve
images

SiteScope lists the images such as graphics, logos, and so on linked to the URL being
requested.

Default value:Not selected

Retrieve
frames

SiteScope displays the HTML code of a frame linked to the URL being requested.

Default value:Not selected

Use WinInet WinInet is used as an alternative HTTP client for this monitor.

Select this option to useWinInet instead of Java (Apache) when:

l The Apache HTTP client does not support a specific technology required to access the
server you aremonitoring. For example, Kerberos authentication is not supported by
the Apache library, and is supported by WinInet. WinInet also supports trusted client-
side certificates such as SSLv3, while Apache does not.

l You tried running this monitor and the Apache server returned errors. UsingWinInet
may solve these errors.

Default value: Not selected

Note:WinInet functionality is available onWindows versions of SiteScope only. For
troubleshootingWinInet functionality, see "URL Tool" on page 128.

Proxy Settings

HTTP proxy Address or domain name and port of an HTTP Proxy Server used to access the URL.

Proxy server
user name

Name used to log on to the proxy server.

Proxy server
password

Password used to log on to the proxy server.

Proxy NTLM
V2

Proxy uses NTLM (Windows NT LAN Manager) version 2 to authenticate user logon.

Authentication Settings
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UI Element Description

Credentials Option for authorizing credentials if the URL specified requires a name and password for
access:

l Use user name and password. Select this option tomanually enter user credentials.
Enter the user name and password to access the URL in theUser name and
Password box.

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the URL (default option). Select the
credential profile to use from theCredential profile drop-down list, or click Add
Credentials and create a new credential profile. For details on how to perform this
task, see "Credential Preferences" on page 476.

Pre-emptive
authorization

Option for sending authorization credentials if SiteScope requests the target URL:

l Use global preference. Select to have SiteScope use the setting specified in the
Pre-emptive authorization section of the General Preferences page.

l Authenticate first request. Select to send the user name and password on the first
request SiteScopemakes for the target URL.

Note: If the URL does not require a user name and password, this optionmay cause the
URL to fail.

l Authenticate if requested. Select to send the user name and password on the
second request if the server requests a user name and password.

Note: If the URL does not require a user name and password, this optionmay be used.

All options use theUser name andPassword entered for this monitor instance. If these
are not specified for the individual monitor, theDefault authentication user name and
Default authentication password specified in theMain section of the General
Preferences page are used, if they have been specified.

Note: Pre-emptive authorization does not control if the user name and password should
be sent, or which user name and password should be sent.

Client side
certificate

The certificate file, if you need to use a client side certificate to access the target URL.
Normally, this is a .pfx (.p12) type certificate, which usually requires a password. You
enter the password for the certificate in theClient side certificate password box.

Note:Client side certificate files must be copied into the <SiteScope root
directory>\templates.certificates directory.

Client side
certificate
password

Password if you are using a client side certificate and that certificate requires a password.

Authorization
NTLM
domain

Domain forWindows NT LAN Manager (NTLM) authorization if required to access the
URL.

Accept
untrusted
certificates
for HTTPS

If you are accessing a target URL using Secure HTTP (HTTPS) and SiteScope does not
have the required server certificates, you can either select this option or import the related
certificates. For details on importing server certificates, see SSLConnectivity in "URL
Monitor" in the SiteScopeMonitor ReferenceGuide.
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UI Element Description

Accept
invalid
certificates
for HTTPS

Select this option if you are accessing a target URL using Secure HTTP (HTTPS) and
SiteScope has invalid server certificates. This may happen, for example, if the current
date is not in the date ranges specified in the certificate chain.

NTLM V2 Select if the URL you are accessing requires authentication using NTLM version 2.

Preferred
protocols

Select the preferred protocol option to use for the handshake process.

l Any supported protocol. Enables any supported protocol to be used for the
handshake process (this is the default setting). Since this option uses SSL protocols,
SSLmust be enabled on theWeb server to use this option.

l Prefer SSL to TLS. Select if the URL you are accessing cannot handle authentication
using TLS. This enables encrypted handshakemessages to be sent using SSL.
Note: This option is ignored (if selected) when SiteScope is running in FIPS 140-2
mode, since authentication using TLS is mandatory with FIPS 140-2. For details on
FIPS 140-2, see the Running SiteScope Securely section of the SiteScope
Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

l Prefer TLS to SSL. Select if you prefer to use TLS for encrypting handshake
messages or if the URL you are accessing cannot handle authentication using SSL.
TLS is the latest cryptographic protocol. TLS 1.0, 1.1, and 1.2 are supported.

Run Tool Runs the test. The results of the test are displayed in the Results pane. The results
include statistics on the URL retrieval as well as a text representation of the URL content.

Save to File Saves the results to a file.

Web Service Tool
This tool enables you to check Simple Object Access Protocol (SOAP) enabledWeb services for availability,
stability, or to see what an actual SOAP response looks like. It is also useful for diagnosing aWeb service
request failure, or for picking out match strings for use with a specific Web ServiceMonitor. TheWeb Service
Test sends a SOAP request to the server and checks the HTTP response codes to verify that the service is
responding. The actual SOAP response appears, but no further verification occurs on this returnedmessage.

SOAP is a way for a program running under one operating system to communicate with another program
running under the same or different operating system (such as aWindows 2003 program talking to a Linux-
based program). SOAP uses the Hypertext Transfer Protocol (HTTP) and Extensible Markup Language (XML)
for information exchange with services in a distributed environment.
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To access l Select Tools context >Web Tools >Web Service Tool (youmust haveUse tools
permissions)

l Also available when configuring or viewing theWeb Servicemonitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new
monitor, or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Important
information

l The following specification features are currently supported: WSDL 1.2, SOAP 1.1,
Simple and Complex Types based on XMLSchema 2001, SOAP binding with the HTTP
(s) protocol only. SOAP with Attachments is not supported.

l SOAP andWSDL technologies are evolving. As a result, someWSDL documents may
not parse accurately and some SOAP requests may not interact with all Web service
providers.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

WSDL Settings

WSDL
location

Select theWSDL location:

l File. Select theWSDL file to be used. This list reflects the files found by searching on
<SiteScope root directory>\templates.wsdl/*.wsdl. YourWSDL files must have an
extension of .wsdl.

l URL. Enter the URL of theWeb service to be tested.

Get Data Retrieves and analyzes the specifiedWSDL file for method arguments. The Result page
displays themeasurements available.

Service name Name of the service to be invoked. During initial setup, this is extracted from theWSDL
file.

Port name Name of the port to be invoked. During initial setup, this is extracted from theWSDL file.

Method name Name of themethod to be invoked. During initial setup, this is extracted from theWSDL
file.

Method name
space

The XML name space for themethod in the SOAP request. During initial setup this value
is extracted from theWSDL file.
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UI Element Description

Schema
name space

The XML name space for the schema in the SOAP request. During initial setup, this value
is extracted from theWSDL file.

SOAP action The SOAP action URL in the header of the SOAP request to theWeb Service. During
initial setup, this is extracted from theWSDL file.

Name of
arguments

Arguments to themethod specified above and their types. Specify simple type parameters
in the format
parm-name(parm-type) = value, where the <param-name> and <param-type>must
match the servicemethod specifications of its WSDL file exactly. The <value>must
agree with the <param-type>, otherwise the request fails. Strings with embedded spaces
should be enclosed in double quotes (" "). Each parameter must be on a separate line by
adding a carriage return at the end of each value.

Example: stockSymbol (string) = MERQ
numShares (int) = 10

A complex type parameter must be represented as one long string (line breaks are for
readability purposes only):

stocksymbol[COMPLEX] =
<stocksymbol xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:soapenc="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:fw100="urn:ws-stock"
xsi:type="fw100:getQuote">
<ticker xsi:type="xsd:string">MERQ
</ticker>
</stocksymbol>

Note:SiteScope does not perform any validation on your input parameter lists, somake
sure that the complex type values are valid and well-formed XML strings. Do not add any
carriage returns within a complex type parameter—only at the end.

If theWeb servicemethod does not take any parameters, the text box should be left
empty.

Use user-
defined
SOAP XML

Use the XML in theUser SOAP XML box. This enables you to use XML that has been
manually defined.

User SOAP
XML

Displays the SOAP XML for the selectedWeb service extracted from theWSDL file. You
canmake changes to the default XML, and use themanually defined XML in this box by
selecting theUse User-Defined SOAP XML check box.

Main Settings

Request's
schema

The request schema. Currently SiteScope only supports SOAP.
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UI Element Description

Timeout
(seconds)

Total time, in seconds, that SiteScope should wait for theWeb service request to
complete.

Default value: 30 seconds

Use .NET
SOAP

Select if theWeb service is based onMicrosoft .NET.

Content
match

Text to check for in the returned page or frameset. If the text is not contained in the page,
the tool displays themessage nomatch on content.

HTML tags are part of a text document, so include the HTML tags if they are part of the
text you are searching for. This works for XML pages as well.

Example: "< B> Hello< /B> World"

Youmay also perform a regular expressionmatch by enclosing the string in forward
slashes, with an i after the trailing slash to indicate that the search is not case sensitive.

Example: /href=Doc\d+\.html/ or /href=doc\d+\.html/i

If you want a particular piece of text to be saved and displayed as part of the status, use
parentheses in a Perl regular expression.

Example: /Temperature: (\d+)

Note: The search is case sensitive.

HTTP Settings

Web service
server URL

Displays the URL of theWeb service server to be checked.

HTTP user
agent

HTTP user agent for the SOAP request.

HTTP content
type

Content type of the HTTP request.

Proxy Settings

HTTP proxy (Optional) A proxy server can be used to access the URL. Enter the domain name and port
of an HTTP Proxy Server.

Proxy server
user name

User name if the proxy server requires a name and password to access the URL.

Note:Your proxy server must support Proxy-Authentication for these options to function.

Proxy server
password

Password if the proxy server requires a name and password to access the URL.

Note:Your proxy server must support Proxy-Authentication for these options to function.

Login Settings

NTLM
domain

NTLM domain if theWeb service requires NTLM / Challenge Response authentication as
part of your credentials (as well as a user name and password below).
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UI Element Description

Authorization
user name

User name if theWeb service requires a user name and password for access (Basic,
Digest, or NTLM authentication), enter the user name.

Alternately, you can leave this entry blank and enter the user name in theDefault
authentication user name box on theGeneral Preferences page. You use this alternate
method to define common authentication credentials.

Authorization
password

Password if theWeb service requires a user name and password for access (Basic,
Digest or NTLM authentication), type the password.

Alternately, you can leave this entry blank and enter the password in theDefault
authentication password box on theGeneral Preferences page. You use this alternate
method to define common authentication credentials.

Run Tool Runs the test. The results of the test are displayed in the Results pane.

The possible status values returned by the test are:

l OK
l unknown host name
l unable to reach server
l unable to connect to server
l timed out reading
l content match error
l document moved
l unauthorized
l forbidden
l not found
l proxy authentication required
l server error
l not implemented
l server busy

Save to File Saves the results to a file.

XSL Transformation Tool
This tool enables you to test a user-defined XSL file that can be used to transform an XML file or output. This
might be a file from aWeb application that contains performancemetrics data. The use of an XSL
transformationmay be necessary to process XML data into an acceptable format for use by the browsable
XMLMonitor.
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To
access

l Select Tools context > Common Utility Tools > XSL Transformation Tool (youmust
haveUse tools permissions)

l Also available when configuring or viewing the XMLMetrics monitor (provided you are an
administrator in SiteScope, or a user grantedUse monitor tools permissions):

l Click theUse Tool button in the new monitor dialog box when configuring a new monitor,
or in themonitorProperties tab when configuring an existingmonitor.

l To run the test tool for an existingmonitor, click the Tools button in the SiteScope
Dashboard toolbar. This opens and runs the tool with themonitor's existing data as its
input, and displays the test results in the Results pane.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting aMonitor" on page 91

See also l "SiteScope Tools" on page 91
l "Tools Menu" on page 48

User interface elements are described below:

UI Element Description

Main Settings

XML URL URL of the XML file that is the input for the transformation.

XSL file Path to the XSL file you want to test. This pathmust be relative to SiteScope
root folder.

Example: <SiteScope root directory>\templates.applications\XmlApp1.xsl

Authentication Settings

Authorization user
name

User name needed to access the content if access to the target XML file
requires authentication.

Authorization password Password needed to access the content if access to the target XML file
requires authentication.

Proxy server Proxy server address if you are using a proxy server to access the target XML
content.

Proxy server user
name/password

User name and password required to use the proxy if you are using a proxy to
access the target XML content.

Run Tool Runs the test. The results of the test appear in the Results pane.

Save to File Saves the results to a file.
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Chapter 13: SiteScope Public APIs
SiteScope public APIs enable you to run various scenarios automatically without using the SiteScope user
interface. For example, you can:

l Import, export and deploy templates.
l Enable, disable or delete monitors, groups or alerts.
SiteScope provides "SOAP-based APIs" on page 139 and "REST APIs" on page 148 to perform these tasks.

For details on the APIs included with SiteScope, see the HPE SiteScope Public API ReferenceGuide. HPE
SiteScope Public API ReferenceGuide (available from <SiteScope installation>\sisdocs\pdfs\SiteScope_
API_Reference.pdf).
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SOAP-based APIs
SOAP-based APIs can be invoked by any knownWeb Services framework such as Axis orWSIF, or by any
SOAP client application. This provides a powerful set of tools for managing and automating large
environments and implementing complex business logics.

Learn About

SiteScope SOAP-based APIs Overview
SiteScope SOAP-based APIs can be divided in to two core categories: Configuration API and Data
Acquisition API.

l Configuration API is responsible for templatemanagement, deployment andmonitors running. It also
provides powerful management tools for downtime and decommission.

l The Data Acquisition API enables you to retrieve historical monitor run data and VMware reconciliation
topology data.

SiteScope API examples are available from the
<SiteScope installation directory>\examples\integrations\api directory.

API examples include the following content:

l lib folder - All jars required to start using SiteScope API and build you own client application
l bin folder - The scripts (*.bin, *.sh) execute provided examples
l src folder - Code examples show how to use SiteScope APIs
l doc folder - Java documentation (in JavaDoc format) of all available public SiteScope APIs methods and
data structures.

API Reference Guides

For details on the APIs included with SiteScope, see the following guides:

l HPE SiteScope Public API Reference. Contains the complete list of SiteScope API packages, including
exceptions, snapshots, and error codes. To open the guide, extract the contents of the javadoc.zip file
available from <SiteScope installation>\examples\integrations\api\doc and double-click the
index.html file.

l HPE SiteScope Public API ReferenceGuide. Contains detailed information on the SiteScope
Configuration and Data Acquisition API packages, and provides a use-case scenario on configuring
SiteScope APIs calls. This guide is available from <SiteScope installation>\sisdocs\pdfs\SiteScope_
API_Reference.pdf.

SiteScope Configuration APIs
SiteScope configuration APIs provide services for working with SiteScope templates, groups, monitors,
alerts, remote servers, server health, search/filter tags, and configuration. The following actions are supported
using the SiteScope configuration API:
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SiteScope
Object Action

Templates l Templatemanagement (create/delete template, create/delete template container,
import/export template, import templates and override them if they already exist in the
given path, get snapshot of all templates)

l Template deployment (monitor, group, alert, remote server creation), deploy a single
template that gets back details of the deployment

l Publish template changes (groups, monitors, alerts, remote server); update templates
deployed without a root (updates only a single monitor with new variables)

Groups Enable/disable groups, delete groups, search groups by specific criteria

Monitors Enable/disable monitors, delete monitors, runmonitors, run tools, searchmonitors by
specific criteria

Alerts Enable/disable alerts

Remote
Servers

Create remote server (onWindows and UNIX), delete remote server preferences

Status Get SiteScope server status (activemonitoring, booting) statistics

Tags Create tags, add tag values, edit tag description, edit tag values (name, description), delete
tags

Configuration l Get SiteScope configuration
l Import an SSH key file to a remote SiteScopemachine

For task details, see "How to Use SiteScope Configuration API Calls" on the next page.

For a user-case scenario, see "How to Use SiteScope API Calls - Use-Case Scenario" on page 142.

For details on the SiteScope Configuration APIs included with SiteScope, see HPE SiteScope Public API
ReferenceGuide HPE SiteScope Public API ReferenceGuide (available from <SiteScope
installation>\sisdocs\pdfs\SiteScope_API_Reference.pdf).

SiteScope Data Acquisition APIs
The following data acquisition actions are supported using the SiteScope API:

SiteScope Object Action

getData Retrieves historical metrics data for monitor runs matching the
specified query parameters.
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SiteScope Object Action

getDataWithTopology Retrieves historical metrics data for monitor runs matching the
specified query parameters and VMware reconciliation topology
collected by VMwaremonitors currently running on SiteScope.

l Supports given time interval, credentials, and filter (monitor type
(s), name, etc…)

l Returns XML similar to the XML sent with generic data integration
that contains the (historical) metrics data

getMonitorTypesWithMetricNames Scans all themonitors in this SiteScope instance for which the user
has view permissions, and returns a list of their types together with
themetric names per monitor type. The list of metric names is
merged from all themonitors of each type (repeated occurrences are
removed). Where enabledMonitorsOnly is true, it scans enabled
monitors only. Where enabledMonitorsOnly is false, it scans all
monitors (enabled/disabled) in the SiteScope instance.

The data for these APIs is taken from the SiteScope daily log.

Note: The data acquisition API is intended for querying limited amount of historical data (up to 20MB).
For consumption of near real-time SiteScope data, useGeneric Data Integration. For details, see
"Generic Data Integration Preferences" on page 584.

For task details, see "How to Use the Data Acquisition API" on the next page.

For details on the SiteScope Data Acquisition APIs included with SiteScope, see HPE SiteScope Public API
ReferenceGuide.

Tasks

How to Use SiteScope Configuration API Calls
This task describes how to use API calls which enable you to run various scenarios automatically without
using the SiteScope user interface.

Tip: For a use-case scenario on using API calls, see "How to Use SiteScope API Calls - Use-Case
Scenario" on the next page.

1. Create your own Java project.
2. Add all SiteScope client jars into the project (these jars are located in

<SiteScope installation>\examples\integrations\api\lib).
3. Connect to SiteScope using theSiteScopeCommandLineUtil.java file located in

<SiteScope installation>\examples\integrations\api\src. In the createConnectionmethod section,
enter the required login information:

// SiteScope connection properties creation
SiteScopeConnectionPropertiesForExternal props = new
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SiteScopeConnectionPropertiesForExternal(hostName, port, login, password,
isUseSSL);
// SiteScope API Connector creation

SiteScopeExternalAPIConnector siteScopeExternalAPIConnector = new
SiteScopeExternalAPIConnector();
// Get the API instance using connection properties

IAPIConfiguration apiConfiguration =
siteScopeExternalAPIConnector.getAPIConfiguration(props);

4. Run the required API methods. For example: apiConfiguration.getConfigurationSnapshotEx
(login, password);

How to Use SiteScope API Calls - Use-Case Scenario
SiteScope APIs enable you to run various scenarios automatically without using the SiteScope user interface.
For example, you can create and deploy templates, enable and disable monitors, groups, and alerts, and
delete monitors, groups, and remote servers.

1. Initial set up
Install SiteScope.
Create a template container using the createTemplateContainer API method (done only once).

2. Create or import a template
Create a template in the SiteScope user interface, or import it using the importTemplateAPI method.

3. Deploy a template and run monitors
Deploy the template for a remote server using the deploySingleTemplateWithConnectToServer API
method.
Use the getConfigurationSnapshotExAPI method to get all deployedmonitors, groups, and alerts.
Use the runExistingMonitorExAPI method to run deployedmonitors.

4. Downtime
Use the disableAlertEx, disableMonitorEx, or disableGroupFullPathExAPI method to disable an
alert, monitor, or group for a downtime period.

5. Decommission
Use the deleteGroupEx, deleteMonitorEx, or deleteRemoteAPI method to delete a group, monitor, or
remote server.

How to Use the Data Acquisition API
1. When running in SiteScope standalonemode (when SiteScope is not connected to a APM server), select

theEnable topology collection in standalone deployment check box inPreferences >
Infrastructure Preferences > General Settings. This enables SiteScope to collect topology in the
background, and not when request is made. Youmust restart SiteScope for this change to take effect.

2. Optionally, you canmodify the following data acquisition settings (youmust restart SiteScope for these
changes to take effect):
l Topology resolving frequency (minutes). Amount of time, in minutes, to wait between checking
the topology of the server beingmonitored. This applies to non-dynamic monitors only; for dynamic
monitors, frequency can be configured per instance in the user interface. If this time is exceeded
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during amonitor run, when running in SiteScope standalonemode the topology is saved in SiteScope;
when SiteScope is integrated with APM the topology is created again in APM's RTSM. The default
value is 60minutes.

l Data acquisition API single request size (MB). Themaximummemory size, in megabytes,
allocated for fetching data from the daily log in a single data acquisition API request. Loading too
much data from the daily log to process a request might have a negative performance impact on
SiteScope, because thememory allocated for the data is out of SiteScope’s available memory pool.
The default value is 20MB.

l Data acquisition API total request size (MB). Themaximummemory size, in megabytes,
allocated for fetching data from the daily log in all simultaneous data acquisition API requests.
Loading toomuch data from the daily log to process requests might have a negative performance
impact on SiteScope, because thememory allocated for the data is out of SiteScope’s available
memory pool. The default value is 100MB.

l To include deletedmonitors in data acquisition API results, select the Include deleted monitors in
data acquisition API results option inPreferences > Infrastructure Preferences > General
Settings.

3. When specifyingmonitor types for which to get data in the data acquisition API, youmust use the "topaz
name" of themonitor.
The following lists themonitor topaz name to use when specifying amonitor type query:

Monitor Display Name Monitor Topaz Name

Active Directory Replication
(created from the Active Directory Solution
template only)

Active Directory Replication

AmazonWeb Services AmazonCloudWatch

Apache Server Apache

BAC Integration Configuration BAC Integration Configuration

BAC Integration Statistics BAC Integration Statistics

BroadVision Application Server BroadVision

CheckPoint CheckPoint

CiscoWorks CiscoWorks

Citrix Citrix MetaFrame Presentation Server

ColdFusion Server MS ColdFusion Server

COM+ Server COM+

Composite Composite

Connection Statistics Monitor Connection Statistics Monitor
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Monitor Display Name Monitor Topaz Name

CPU CPU

Custom CustomMonitor

Custom Database Custom DatabaseMonitor

Custom Log File Custom LogMonitor

CustomWMI CustomWMI Monitor

Database Counter DatabaseCounter

DatabaseQuery SQLQuery

DB2 JDBC DB28x

DHCP DHCP

Directory Directory

DNS DNS

Dynamic Disk Space Dynamic Disk Space

Dynamic Monitoring Statistics Dynamic Monitoring Statistics

eBusiness Transaction Ebus ChainMonitor

F5 Big-IP F5

File File

Formula Composite Bandwidth

FTP FTP Monitor

Generic Hypervisor Generic Hypervisor

HAProxy HAProxy Monitor

Health of SiteScope Server Health Server LoadMonitor

HP iLO HP iLO

HP NonStop Event Log NonStop Event Log

HP NonStop Resources NonStop Resources

HP ServiceManager HP Incidents

IPMI IPMI

JMX JMX Monitor

KVM KVM
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Monitor Display Name Monitor Topaz Name

LDAP LDAP Monitor

License UsageMonitor License Usage

Link Check Link Monitor

Log Event Checker Log Event Health Monitor

Log File LogMonitor

Mail E-mail Monitor

MAPI mapimon

Memcached Statistics Monitor Memcached Stats

Memory Memory

Microsoft A/V Archiving Server Microsoft Lync Server 2010 Archivingmonitor

Microsoft A/V Conferencing Server Microsoft Lync Server 2010 A/V Conferencing
monitor

Microsoft ASP Server MS Active Server Pages

Microsoft Director Server Microsoft Lync Server 2010 Director monitor

Microsoft Edge Server Microsoft Lync Server 2010 Edgemonitor

Microsoft Exchange 2007Message Traffic
Microsoft Exchange 2007Message Traffic

Microsoft Exchange Microsoft Exchange 2007

Microsoft Exchange Base Microsoft Exchange Base

Microsoft Front End Server Microsoft Lync Server 2010 Front Endmonitor

Microsoft Hyper-V HyperVMonitor

Microsoft IIS Server MS IIS Server

Microsoft Mediation Server Microsoft Lync Server 2010Mediationmonitor

Microsoft Monitoring and CDR Server Microsoft Lync Server 2010Monitoring and CDR
monitor

Microsoft Registrar Server Microsoft Lync Server 2010 Registrar monitor

Microsoft SQL Server MS SQLServer

Microsoft Windows Event Log Microsoft Windows Event Log

Microsoft Windows Media Server MSWinodws Media Server
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Monitor Display Name Monitor Topaz Name

Microsoft Windows Performance Counter Browsable NT Counters

Microsoft Windows Performance Counter Windows Performance

Microsoft Windows Resources Windows Resources

Microsoft Windows Services State Windows Services State

Monitor Load Checker Monitor LoadMonitor

Multi Log Multi Log

NetScout Event NetScout Event

Network Bandwidth Network BandwidthMonitor

News NNTP

Oracle 10g Application Server Oracle10gAS

Oracle Database Oracle

Oracle 9i Application Server Oracle9iAS HTTP Server

Ping Ping

Port Port

Radius Radius

Real Media Server Real Media Server

SAP CCMS CCMS SAP

SAP CCMS Alert SAP CCMS Alerts

SAP JavaWeb Application Server SAP JavaWeb Application Server

SAP Performance SAP Performance

SAPWork Processes SAPWork Processes

Script Script

Service Service

Siebel Application Server Siebel Application Server

Siebel Log Siebel Log

Siebel Web Server Siebel Web Server

SNMP SNMP

SNMP by MIB SNMP by MIB Monitor
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Monitor Display Name Monitor Topaz Name

SNMP Trap SNMP Trap

Solaris Zones Solaris Zones

SSLCertificates State in Health SSLCertificates Status

SunONEWeb Server SunONE

Sybase Sybase

Syslog SyslogMonitor

Technology Database Integration EMS Database

Technology Log Integration EMS LogMonitor

Tuxedo Tuxedo

UDDI Server UDDI Server

UNIX Resources Unix Resources

URL URLMonitor

URLContent URLContent

URL List URL List

URL Sequence URL SequenceMonitor

VMware Datastore VMware DatastoreMonitor

VMware Host CPU VMware Host CPU Monitor

VMware Host Memory VMware Host Memory Monitor

VMware Host Network VMware Host Network Monitor

VMware Host State VMware Host StateMonitor

VMware Host Storage VMware Host StorageMonitor

VMware Performance VMware

Web Script Web Script

Web Server Web Server

Web Service Technology Web Service

Web Service Web Service

WebLogic Application Server BEAWebLogic 6.0

WebSphere Application Server WebSphere
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Monitor Display Name Monitor Topaz Name

WebSphereMQStatus MQStatusMonitor

WebSphere Performance Servlet WebSphereServlet

XMLMetrics XMLMetrics

Tips/Troubleshooting

SiteScope API Calls - Notes and Limitations
l Most API methods require a SiteScope user and password as part of themethod invocation. Before using
thesemethods, change theAccess controlled property inPreferences > Infrastructure Preferences >
Custom Settings to true. The user and password can be in plain text or encrypted. To encrypt a string,
use <SiteScope installation>\tools\AutoDeployment\encrypt_password.bat.

l All API methods that do not have a user name and password will be deprecated in future versions of
SiteScope. All analogous API methods with user and password authentication have been renamed and
now have an Ex suffix (for example, enableGroupEx) to avoid the samemethod names being used with
different parameters.

l The access level of the SiteScope user affects the behavior of themethods. For example, when calling
getConfigurationSnapshot and getFullConfigurationSnapshot, the returnedmaps contain only
those entities that the user is privileged to access.

l To use applications created with previous versions of this API, set _accessControlled=false and use
the deprecated APIs. These deprecatedmethods will not be supported in a future version and you will
have to port your application to use the secure versions of the API methods.

l Attempting to use the deprecated forms of themethods when _accessControlled=true or to use the
securemethods when _accessControlled=false results in an exception.

l The .bat files (.sh files for UNIX) are examples only and not intended as production scripts. You can
change the scripts to fit your requirements.

l Special characters are not supported in the parameter values.
l The disable alerts API is not supported when theDisable alerts temporarily permission is not selected in
Preferences > User Management Preferences > Permissions > Alerts.

l SomeAPI operations can be disabled on the server. This supports a read-only mode, such that the
configuration cannot be changed remotely using the API.

REST APIs
SiteScope supports a set of REST APIs that enable running of various scenarios automatically without using
the SiteScope user interface. SiteScope REST APIs can be invoked using any knownREST CLient
framework or tool.

Common characteristics of SiteScope REST APIs are as follows:

l All SiteScope REST endpoints are accessed by sending an HTTP request to the SiteScope server. The
server response contains either the data requested, or the status indicator, or both.

l All endpoints are located in a hierarchy starting from http(s)://<<SiteScope_Host>>:<<SiteScope_
Port>>/api/

Using SiteScope

HPE SiteScope (11.33) Page 148 of 1206



l All endpoints may return different HTTP status codes. Themost common status codes and their
description are as follows:

Status
Code Description

200 Success with the response containing requested data.

204 Success response where no data is expected to be returned.

400 Bad request; A message with details of the error condition is returned along with the
response.

500 Error condition on the server along with amessage indicating the details of the error
condition.

l All SiteScope REST endpoints allow authentication through the following ways:
l HTTP basic authentication by including the user name and password in the request header.

l Client certificate authentication by sending a certificate along with the request when SiteScope APIs
are configured for client certificate authentication as per hardening instructions available in the
SiteScope Deployment Guide.

l For POST requests, the request media typemust be "multipart/form-data" when the request contains
binary or file upload parameters. For all other POST requests, the supported request media type is
"application/x-www-form-urlencoded".

SiteScope Configuration APIs
SiteScope configuration APIs provide services for working with SiteScope templates, groups, monitors, and
alerts. The following actions are supported using the SiteScope configuration API:

SiteScope
Object Action

Templates l Templatemanagement (create/delete template, create/delete template container,
import/export template, import templates and override them if they already exist in the
given path, get snapshot of all templates)

l Template deployment (monitor, group, alert, remote server creation), deploy a single
template that gets back details of the deployment

l Publish template changes (groups, monitors, alerts, remote server); update templates
deployed without a root (updates only a single monitor with new variables)

Groups Enable/disable groups, delete groups, search groups by specific criteria

Monitors Enable/disable monitors, delete monitors, runmonitors, run tools, searchmonitors by specific
criteria

Alerts Enable/disable alerts

For details on the SiteScope Configuration APIs included with SiteScope, see HPE SiteScope Public API
ReferenceGuide.
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Chapter 15: SiteScope Mobile Apps
SiteScope provides free downloadable apps that enable you to keep track of your monitored IT infrastructure
while you are away from your computer. SiteScopemobile apps connect your company's people and
information by giving your team access to SiteScope through the use of smartphone devices.

Tip: You can view a guided and narrated demonstration for using the SiteScopeMobile App on YouTube:
http://www.youtube.com/watch?v=MuLAmO322nI.

Learn About
SiteScope Features Supported on Mobile Apps
SiteScopemobile apps enable your SiteScope staff to have 24/7mobile access while out of the office so that
they can:

l Receive email notifications about problems related to your organization's monitored applications and take
corrective action (rerun themonitors, view monitor report, acknowledge alerts, enable/disable associated
alerts, view acknowledgment logs).

l Review group andmonitor states to verify availability issues ahead of time, so that you can solve them
before they affect your business.

l Use the search to gain access tomonitor statistics, and perform actions on the search results to mitigate
issues (view monitor details, enable/disable monitors, runmonitors, set alert actions).

l Create ad hoc reports for monitors, groups, and alerts that display how the servers and applications have
performed over time.

l Add selectedmonitors and groups to a favorites list.
For more details on using SiteScope on amobile device, refer to the help supplied with the SiteScopemobile
app. For additional information on how to use the features that are available on the SiteScopemobile app, see
the relevant topic in the SiteScope Help.

Tip: You can also access SiteScope data on supported iPad and Android tablets using the "Unified
Console" on page 913. This is an HTML-based user interface that contains a lightweight Event Console
for managing the event lifecycle, Multi-View for viewing the real-time performance status of everything
beingmonitored in a single view, andManage view which extends template deployment and the ability to
updatemonitor configuration to non-admin users granted the necessary permissions. Note that the
Unified Console is not supported on the SiteScopemobile app.

Supported Devices
SiteScopemobile apps are supported on the following devices:

l iPhone, iPad, or iPod touch. The SiteScope iPhonemobile app is available from the Apple Store
(http://itunes.apple.com/us/app/hp-sitescope/id410294629?mt=8#).

l Android phone or tablet. The SiteScope Android mobile app is available from Google Play Store
(https://play.google.com/store/apps/details?id=com.hpe.sitescope.mobile.android_app).

HPE SiteScope (11.33) Page 150 of 1206

http://www.youtube.com/watch?v=MuLAmO322nI
http://itunes.apple.com/us/app/hp-sitescope/id410294629?mt=8#
https://play.google.com/store/apps/details?id=com.hpe.sitescope.mobile.android_app


Note:Youmust uninstall the currently installed app, and then download the latest app from the URL
provided. Since configurations cannot bemigrated across from the old app to the new app, you need to
reconfigure the new app before you can start using it.

Check the SiteScopemobile app download page for the list of operating system versions that are supported.

Supported SiteScope Versions
SiteScopemobile apps are supported for the following SiteScope versions:

l SiteScope 10.13 (with patch SIS_108 for Linux or SIS_110 forWindows) or later.
l SiteScope 11.01 (with patch SIS_00114 for Linux or SIS_00116 forWindows) or later.
l SiteScope 11.10 or later.

Tasks
How to Configure Alerts to be Sent to a Mobile Device
Use theMobileAppMail template in the <SiteScope root directory>\ templates.mail folder, as this
template contains a link that can be used to open the app from your email.

How to Include HTML Content in Mail Templates Sent to a Mobile Device
When an email alert is triggered and sent to amobile device, HTML content is not displayed as an active link.

For the HTML to be converted to an active link in the email, set the value for the _
defaultMailAlertContentType property to =text/html in the <SiteScope
root directory>\groups\master.config file, and then restart SiteScope.

How to Use SiteScope in Secure Mode on a Mobile Device
InPreferences > Infrastructure Preferences > Custom Settings, change theAccess controlled property
to true. Otherwise, the SiteScope user name and password are ignored.

Tips/Troubleshooting
Notes and Limitations
l Make sure themobile device is set to the correct local time.
l Monitors that are disabled temporarily (regardless of whether they were disabled in the SiteScope user
interface or from amobile device) appear in themonitor details summary according to server time.

l When deleting a SiteScope user account from your mobile device, any monitors or groups that are saved
to favorites under that account are also removed.

l When changing SiteScope user account settings (for example, changing a profile's protocol from http to
https, or changing the SiteScope port), all monitors related to that profile disappear from the favorites list.

l If you encounter insufficient memory resourcemessages when generating a report, free upmemory on the
mobile device (for example, by closing running apps). You can increase or decrease thememory required
by SiteScope reports by moving theMinimum memory for reports (MB) slider in the iPhone or Android
Settings under HPE SiteScope.

l If you are unable to connect themobile app to SiteScope using a 3G signal but you can connect using a
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wireless network (WiFi), try changing the SiteScope port to 80, as the service provider might be blocking
some ports (such as the default SiteScope port, 8080).
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Chapter 16: Regular Expressions
SiteScopemakes use of regular expressions tomatch text content. Several SiteScopemonitors enable for
content matching on the text returned from amonitor's request or action. This chapter includes information on
using regular expressions tomatch text content in SiteScopemonitors.

Regular expressions is a name given to a text parsing tool that was developed for use with scripting
languages such as Awk and Perl, as well as several programming environments, such as Emacs, Visual
C++, and Java. Regular expressions themselves are not a programming language. They do, however, make
use of many special combinations of characters and symbols that oftenmake themmore difficult to interpret
than some programming languages. Themany different combinations of these special characters, known as
metacharacters, make regular expressions a very powerful and flexible tool for parsing and isolating specific
text within a larger body of text.

Including a regular expression in theMatch content text box of amonitor instructs SiteScope to parse the text
returned to themonitor when it is run and look for content that satisfies the pattern defined by the regular
expression. This document presents an overview of the syntax andmetacharacters used in regular
expressions for use inmatching content for SiteScopemonitors.

Define a Regular Expression
The element of amatch content expression in SiteScope is the forward slash (/) character. Entries in the
Match content text box of a SiteScopemonitor must start and end with a forward slash to be recognized as
regular expressions. For example, entering the expression /website/ into theMatch content box of a
monitor instructs SiteScope to search the text content received by themonitor for the literal text string:
website. If a match is not found, themonitor reports an error status. When amatch is found, themonitor
reports a good status, as long as all other monitor status threshold conditions are alsomet. If you enter text or
other characters into theMatch content box without delimiting the entry with forward slashes, the entry is
either ignored or reported as a content match error by SiteScope.

Adding parentheses ( ) within the forward slashes surrounding the regular expression is another very useful
function for regular expressions in SiteScope. The parentheses are used to create a "back reference." As a
back reference, SiteScope retains what was matched between the parentheses and displays the text in the
Status field of themonitor detail page. This is very useful for troubleshootingmatch content. This is also a
way to pass amatched value from onemonitor to another, or from one step of a URL SequenceMonitor to the
next step of the same transaction. Parentheses are also used to limit alternations, as discussed below.

Generally, it is best to use an iterative approach when building regular expressions for content matching within
SiteScope. The following are some general steps and guidelines for developing regular expressions for
content matches:

l Create a regular expression using literal characters to match a single sample of the data you want to
monitor. For example, /value: 1022.5/.

l Iteratively replace literal characters with character classes andmetacharacters to generalize the literal into
a pattern. For example, the literal in the example above could be changed to: /value:\s\d\d\d\d\.\d/ to
match any four digits, a decimal point, and onemore digit.

l Consider that the pattern of the data you want to matchmay vary. Adjust your pattern tomatch expected
or possible variations in the target data. Continuing with the example used above, the expression
/value:\s\d\d\d\d\.\d/might become /value:\s[\d]{1, 8}\.[\d]{1,2}/. This pattern enables
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variation in the number of digits to the left of the decimal point and the number of digits to the right of the
decimal point. It expects that there is a decimal point. See the following sections for more information
about the character classes used here.

l Consider that the literal string or pattern you want to matchmay appear more than once in the content.
Identify unique content that precedes the content you want to match, and add regular expression patterns
tomake sure that the expressionmatches that unique content before it tries to match the content you are
trying tomonitor. In the example used here, the patternmay match the first of several entries that have a
similar /value: numbers/ pattern. Adding a literal to the pattern, that matches some static content that
delimits the particular data, can be used to be sure thematch is made for the target data. For example, if
the data you want to match is preceded by the text Open Queries, this literal can be added to the pattern,
along with a pattern for any intervening content: /Open Queries[\s\W]{1,5} value:\s[\d]{1, 8}\.
[\d]{1,2}/.

Match String Literals
Finding andmatching an exact or literal string is the simplest form of patternmatching with regular
expressions. In matching literals, regular expressions behavemuch as they do in search/replace in word
processing applications. The example abovematched the text Web site. The regular expression /Buy Now/
succeeds if the text returned to themonitor contains the characters Buy Now, including the space, in that
order.

Note that regular expressions are, by default, case sensitive and literal. This means that the content must
match the expression in case and order, including non-alphanumeric characters. For example, a regular
expression of /Website/, without any modifiers, succeeds only if the content contains the string Website
exactly but fails even if the content on the page is website, WEBSITE, or Web site. (In the last case thematch
fails because there is space between the two words but not in the regular expression.)

There are cases where youmay want to literally match certain non-alphanumeric characters which are special
"reserved" metacharacters used in regular expressions. Some of thesemetacharacters may conflict with
important literals that you are trying tomatch with your regular expression. For example, the period or dot
symbol (.), the asterisk (*), the dollar sign ($), and back slash (\) have special meanings within regular
expressions. Because one of these characters may be a key part of a particular text pattern you are looking
for, youmust "escape" these characters in your regular expression so that the regular expression processing
treats them as literal characters rather than interpreting them as special metacharacters. To force any
character to be interpreted as a literal rather than ametacharacter, add a back slash in front of that character.

Example - Matching a Literal String
For example, if you wanted to find the string 4.99 on aWeb page youmight create a regular expression of
/4.99/. While this matches the string 4.99, it would alsomatch strings like 4599 and 4Q99 because of the
special meaning of the period character. To have the regular expression interpret the period as a literal, escape
the period with a forward slash as follows: /4\.99/. You can add the back slash escape character in front of
any character to force the regular expression processing to interpret the character following the back slash as
a literal. In general, use this syntax whenever you want to match any punctuationmark or other non-
alphanumeric character.

Using Alternation
Alternation enables you to construct either/or matches where you know that one of two or more strings should
appear in the content. The alternation character is the vertical pipe symbol ("|").
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The vertical pipe is used to separate the alternate strings in the expression. For example, the regular
expression /(e-mail|e-mail|contact us)/ succeeds if the content contains any one of the three strings
separated by the vertical pipes. The parentheses are used here to delimit alternations. In this example, there
are no patterns outside of the alternation that must bematched. In contrast, a regular expressionmight be
written as /(e-mail|e-mail|contact) us/. In this case, thematch succeeds only when any of the three
alternates enclosed in the parentheses is followed immediately by a single white space and the word us. This
is more restrictive than the previous example, but also shows how the parentheses limit the alternation to the
three words contained inside them. Thematch fails even if one or more of the alternates are found but the
word "us" is not the next word.

Match Patterns with Metacharacters
Often youmay not know the exact text you need tomatch, or the text patternmay vary from one session or
from one day to another. Regular expressions have a number of special metacharacters used to define
patterns andmatch whole categories of characters. While matching literal alphanumeric characters seems
trivial, part of the power of regular expressions is the ability to match non-alphanumeric characters as well.
Because of this, it is important to keep inmind that your regular expressions need to account for the presence
of non-alphanumeric characters in the content you are searching. This means that characters such as periods,
commas, hyphens, quotationmarks, and even white spaces, must be considered when constructing regular
expressions.

This section contains the following topics:

l "Metacharacters Used in Regular Expressions" below
l "Defining Character Classes" on the next page
l "Using Quantifiers" on page 157

Metacharacters Used in Regular Expressions

Metacharacter Description

\s Matches generic white space (that is, the Spacebar key). This metacharacter is
particularly useful when combined with a quantifier to match varying numbers of white
space positions that may occur between words that you are looking tomatch.

\S Matches characters that are not white space. Note that the \S is capitalized as opposed
to the small \swhich is used tomatch white space.

. This is the period or dot character. Generally, it matches all characters. Because
SiteScope considers the dot as a form of character class on its own, do not include it
inside the square brackets of a character class.

\n Matches the linefeed or newline character.

\r Matches the carriage return character.

\w Matches non-white space word characters, the same as what is matched by character
class [A-Za-z0-9_]. It is important to note that the \w metacharacter matches the
underscore character but not other punctuationmarks such as hyphens, commas,
periods, and so forth.
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Metacharacter Description

\W Matches characters other than thosematched by \w (lowercase). This is particularly
useful for matching punctuationmarks and non-alphabetic characters, such as
~!@#$%^&*()+={[}]:; and including the linefeed character, carriage return, and white
space. It does not match the underscore character, which is considered a word
constituent matched by \w.

\d Matches digits only. This is equivalent to the [0-9] character class.

\D Matches non-numeric characters (what \d does not match) plus other characters. Similar
to \W but alsomatches on alphabetic characters. In SiteScope, this generally matches
everything, includingmultiple lines, until it encounters a digit.

\b Requires that thematch have a word boundary (usually a white space) at the position
indicated by the \b.

\B Requires that thematch not have a word boundary at the position indicated.

Defining Character Classes
An important and very useful regular expression construct is the character class. Character classes provide a
set of characters that may be found in a particular position within a regular expression. Character classes may
be used to define a range of characters to match a single position or, with the addition of a quantifier, may be
used to universally matchmultiple characters and even complete lines of text.

You form character classes by enclosing any combination of characters andmetacharacters in square
brackets: [ ]. Character classes create an "any-or-all-of-these" group of characters that may bematched.
Unlike literals andmetacharacters outside character classes, the physical sequence of characters and
metacharacters within a character class has no effect on the search or match sequence. For example, the
class [ABC0123abc] matches the same content as [0123abcABC].

The hyphen is used to further streamline character classes to indicate a range of letters or numbers. For
example, the class [0-9] includes all digits from zero to nine inclusive. The class [a-z] includes all lowercase
letters from a to z. You can also createmore restrictive classes with the hyphen, such as [e-tE-T], to match
upper or lowercase letters from E to T, or [0-5] to match digits from zero to five only.

You can use the caret character (^) within a character class as a negation or to exclude certain characters
from a content match.

Example Character Classes

Example Description

[a-zA-Z] This matches any alphabetic character, both upper case and lowercase, from the letter a to the
letter z. Tomatchmore than one character, append a quantifier after the character class as
described below.

[0-9] This matches any digit from 0 to 9. Tomatchmore than one digit, append a quantifier after the
character class as described below.

[0-9A-Za-
z]

This matches any alphanumeric character, excluding the underscore.
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Example Description

[\w\s] This matches any alphanumeric character, any white space, or both.

Using Quantifiers
Another set of metacharacters used in regular expressions provides character counting options. This adds a
great deal of power and flexibility in content matching. Quantifiers are appended after themetacharacters and
character classes described above to specify against which positions the precedingmatch character or
metacharacter should bematched. For example, in the regular expression /(contact|about)\s+us/, the
metacharacter \smatches on a white space. The plus sign quantifier following the \smeans that theremust
be at least one white space between the words contact (or about) and us.

The following table describes the quantifiers available for use in regular expressions. TheQuantifier applies to
the single character immediately preceding it. When used with character classes, the quantifier is placed
outside the closing square bracket of the character class. For example: [a-z]+ or [0-9]*.

Quantifier Description

? The questionmark means the preceding character or character class may appear once, but is
optional and not required to appear in the position indicated.

* The asterisk requires that any number of the preceding character or character class appear in
the designated position. This includes zero or morematches.

Note: Caremust be used in combining this quantifier with the dot (.) metacharacter or a
character class including the \W metacharacter, as these are likely to "grab" more content
than anticipated and cause the regular expression engine to use up all of the available CPU
time on the SiteScope server.

+ The plus sign requires that the preceding character or character class appear at least once.

{min,max} Using curly braces creates a quantifier range. The range enumerator digits are separated by
commas. This construct requires that the preceding character or character class appear at
least as many times as specified by themin enumerator up to but nomore than the value of
themax enumerator. Thematch succeeds as long as there are at least as many matches as
specified by themin enumerator. However, thematching continues up to the number of times
specified by themax enumerator or until nomorematches are found.

Match content in SiteScope is run against the entire HTTP response, including the HTTP header, which is not
normally viewable by using the browser. The HTTP header usually contains several lines of text including
words coupled with sequences of numbers. This may cause failure of some otherwise simple content
matching on short sets of numbers and letters. To avoid this, identify a unique sequence of characters near
the text you are trying tomatch and include them as literals, where applicable, in the regular expression.

Search Mode Modifiers
Regular expressions used in SiteScopemay include optional modifiers outside of the slashes used to delimit
the expression. Modifiers after the ending slash affect the way thematching is performed. For example,
regular expression of /website/iwith the i searchmodifier addedmakes thematch content search
insensitive to upper and lowercase letters. This wouldmatch either website, Website, WEBSite, or even
WEBSITE.
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With the exception of the imodifier, somemetacharacters and character classes can override searchmode
modifiers. In particular, the dot (.) and the \Wmetacharacters can override the m and smodifiers, matching
content across multiple lines despite themodifier.

More than onemodifier can be added by concatenating them together after the closing slash of the regular
expression. For example: /matchpattern/ic combines both the i and c modifiers.

Regular Expression Match Mode Modifiers

Mode
Modifier Description

/i Ignore casemode. This makes the search insensitive to upper case and lowercase letters. This
is a useful option especially when searching for matches in the text content of Web pages.

/c Thematched patternmay NOT appear anywhere in content that is being searched. This is a
"complement" match, returning an error if the pattern IS found, and succeeding if the pattern is
NOT found.

/m Match across multiple lines WITHOUT ignoring intervening carriage returns and linefeeds. With
this modifier youmay still need to account for possible linefeeds and carriage returns with a
character class such as [\w\W]* or [\s\S\n\r]*. The .* does not match carriage returns or linefeed
characters with this modifier.

/s Consider the content as being on a single line, ignoring intervening carriage returns and linefeed
characters. With this modifier, both the [\w\W]* character class and the .* patternmatch across
linefeeds and carriage returns.

/d Converts the returned date/time to a single numerical value.

For example, if you want to match the following line on aWeb page:

Previous Run: 2004-07-26 14:56:35.767

Create a regular expression content match in the SiteScope URLmonitor:

/Previous Run: (\d+-\d+-\d+.\d+:\d+:\d+)/d

The /d qualifier at the end of the above expression converts the returned time to a single
numerical value, so it must be used in all instances of this type of regular expression. The
parenthesis () indicates the value that needs to be converted.

/w Removes all white space characters (except space) and also removes all double spaces from
the string.

/a Returns the absolute value of a string. For example, if the string is -10, themodifier returns a
value of 10.

Retain Content Match Values
Somemonitors, like the URLMonitor and URL SequenceMonitor, have a content match value that is logged
and can be used to set error status thresholds. Another purpose of the parentheses /(match pattern)/ used in
regular expression syntax is to determine which text is retained for the Content Match Value. You use this
function to use content match values directly as thresholds for determining the error threshold of a URL
monitor or URL Sequencemonitor.
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For example, if the content match expression was:

/Copyright (\d*)/

and the content returned to themonitor by the URL request included the string:

... Copyright 2007 by HP

then thematch is made and the retained content match value would be:

2007

Under the error-if option at the bottom of themonitor set up page, you could then change the error-if condition
from the default of status != 200 to content match, then specify the relational operator as !=, and then specify
the value 2008. This sets the error threshold for this monitor so that whenever the year in the string Copyright
is other than 2008, themonitor reports an error. This mechanism could be used to watch for unauthorized
content changes onWeb pages.

Checking aWeb page for links to other URLs can be an important part of constructing URL Sequence
Monitors. The following regular expression can be used tomatch the URL text of a link on aWeb page:

/a href="?([:\/\w\s\d\.]*)"?/i

This expressionmatches the href="protocol://path/URLname.htm" for many URLs. The questionmark
modifiers enable the quotationmarks around the HREF= attribute to be optional. The imodifier enables the
match pattern to be case-insensitive.

Retained or remembered values from content matches can be referenced and used as input for subsequent
steps in a URL SequenceMonitor. See theMatch content section of the URL SequenceMonitor for the
syntax used for Retaining and Passing Values Between Sequence Steps.

SiteScope Date Variables
SiteScope uses specially defined variables to create expressions that match the current date or time. These
variables can be used in content match fields to find date-coded content. TheGeneral Date Variables are
useful for matching portions of date formats. The Language/Country Specific Date Variables enable you to
automatically extend the language used for month names and weekday names to specific countries, based on
ISO codes.

This section contains the following topics:

l "General Date Variables" below
l "Language/Country Specific Date Variables" on the next page
l "Special Substitution for Monitor URL or File Path" on page 161

General Date Variables
The following table lists the general variables:

Variable Range of Values

$hour$ 0 - 23

$minute$ 0 - 59

$month$ 1 - 12
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Variable Range of Values

$day$ 1 - 31

$year$ 1000 - 9999

$shortYear$ 00 - 99

$weekdayName$ Sun - Sat

$fullWeekdayName$ Sunday - Saturday

$0hour$ 00 - 23

$0minute$ 00 - 59

$0day$ 01 - 31 (two-digit day format)

$0month$ 01 - 12 (two-digit month format)

$monthName$ Jan - Dec (three-letter month format in English)

$fullMonthName$ January - December

$ticks$ milliseconds sincemidnight, January 1, 1970

For example, if the content match search expression was defined as:

/Updated on $0month$\/$0day$\/$shortYear$/

and the content returned by the request includes the string:

Updated on 06/01/98

then the expression wouldmatch when themonitor is run on June 1, 1998. Thematch fails if the content
returned does not contain a stringmatching the current system date or if the date format is different than the
format specified.

If you want the time to be before or after the current time, you can add a $offsetMinutes=mmmm$ to the
expression, and this offsets the current time bymmmmminutes (negative numbers are permitted for going
backwards in time) before doing the substitutions.

For example, if the current day is June 1, 2007, and the search expression is:

/$offsetMinutes=1440$Updated on $0month$\/$0day$\/$shortYear$/

the content string that wouldmatch would be:

Updated on 06/02/07

Note: The date is one day ahead of the system date.

Language/Country Specific Date Variables
The following table lists the SiteScope special variables for use with international day andmonth name
matching. The characters LL and CC are placeholders for two-letter ISO 639 language code characters and
two-letter ISO 3166 country code characters (see the notes below the table for more details). Information
about these codes is available frommany publicly available web sites.
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Variable Range of Values

$weekdayName_LL_
CC$

Abbreviated weekday names for the language (LL) and country (CC) specified
(see notes below).

$fullWeekdayName_
LL_CC$

Full weekday names for the language (LL) and country (CC) specified.

$monthName_LL_CC$ Abbreviatedmonth names for the language (LL) and country (CC) specified.

$fullMonthName_LL_
CC$

Full month names for the language (LL) and country (CC) specified.

CC - an uppercase 2-character ISO-3166 country code. Examples are: DE for Germany, FR for France, CN
for China, JP for Japan, BR for Brazil.

LL - a lowercase 2-character ISO-639 language code. Examples are: de for German, fr for French, zh for
Chinese, ja for Japanese, pt for Portuguese.

For example, if the content match expression was defined as:

/$fullWeekdayName_fr_FR$/i

and the content returned by the request includes the string:

mercredi

then this expression wouldmatch when themonitor was run onWednesday.

If you are not concerned with the country-specific language variations, it is possible to use any of the above
variables without including the country code. For example:

/$fullWeekdayName_fr$/

could be used tomatch the same content as /$fullWeekdayName_fr_FR$/.

Special Substitution for Monitor URL or File Path
SiteScope Date Variables are useful for matching content as part of a regular expression. The date variables
can also be used as a special substitution to dynamically create URLs or file paths for specific monitors. This
is useful for monitoring date-coded files and directories where the URL or file path is updated automatically
based on system date information. SiteScope is an example of an application that creates date-coded log
files. The log file names include some form of the year, month, and day as part of the file name, such as
File2001_05_01.log,where the year, month, and date are included.

Based on this example, a new file is created each day. Monitoring the creation, size, or content of the current
days file would normally require the file path or URL of themonitor to bemanually changed each day. Using
the SiteScope date variables and special substitution, SiteScope can automatically update the file path to the
current day's log file. By knowing the pattern used in naming the files, you can construct a special substitution
string similar to a regular expression that substitutes portions of the system date properties into the file path.

For example if the absolute file path to the current day's log file in a file monitor is:

D:/Production/Webapps/Logs/File2001_05_01.log

the log file for the following day would be:

D:/Production/Webapps/Logs/File2001_05_02.log
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You can construct a special substitution expression to automatically update the file path used by themonitor,
with the following syntax:

s/D:\/Production\/Webapps\/Logs\/File$year$_$0month$_$0day$.log/

The substitution requires that the expression start with a lower-case s and that the expression is enclosed by
forward slashes /.../. Forward slashes that are part of the file pathmust be escaped by adding the back
slash (\) character as shown. The SiteScope date variables are separated by the underscore character literals.
SiteScope checks the system time properties each time themonitor runs and substitutes with applicable
values into the file path or URL before accessing the file.

SiteScopemonitor types that support the special substitution are:

l e-Business Transactionmonitor
l File monitor
l FTP monitor
l Log File monitor
l URLmonitor
l URLSequenceMonitor
l Web server monitor
While the special substitution syntax is similar in syntax to the substitution syntax used in regular
expressions, they are not the same. While all of the SiteScope date variables can be used inmatch content
regular expressions, the special substitution discussed here can not be used as part of amatch content
expression.

Examples for Log File Monitoring
SiteScope's Log File Monitor and File Monitor check for entries in files created by other applications. These
files may be data files created by a third-party application or they may be logs created by a custom system
specially designed for your environment. Where the logs or files are written with a known, predictable format,
SiteScope can be configured to regularly check the files for new entries andmatch on specific content strings.
The following are several examples of log file entries and simple regular expression patterns that can be used
to check the entries. You can use these examples or modify them to work with a specific case.

Note: All regular expressions must be entered on a single line in SiteScope. Some of the examples below
may break across more than one line to fit on this page.

This section contains the following topics:

l "Searching Paths for Log Files" below
l "Matching Comma-Separated Values" on the next page
l "Matching Space Separated Values" on page 164
l "Matching and Retaining the Numbers in a Line of Text and Numbers" on page 164
l "Matching Integers and Floating-point Numbers (Positive or Negative)" on page 165
l "Matching Date and Time-Coded Log Entries" on page 165

Searching Paths for Log Files
UNIX andWindows operating systems treat the case ("N" and "n") of file names in incompatible ways.
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Windows operating systems are case insenstive whichmeans that when a file is being searched, its case is
ignored. UNIX operating systems are case sensitive whichmeans that the case of a name is significant at all
times. To avoid log file errors when using regular expressions to search for path names on UNIX operating
systems, usemarkers to change the character case in the path expression.

Marker Description

$L Enables changing characters between the $Lmarker and the $E marker to lowercase.

$U Enables changing characters between the $U marker and the $E marker to upper case.

$E The endmarker used for changing character case.

Example:

If you define the following path expression:

s/\/tmp\/logs\/arcv.log.$weekdayName$/

for the /tmp/logs/arcv.log.tue log file on a Linux machine, you get a log file error because SiteScope
tries to find tmp/logs/arcv.log.Tue, and Linux is case sensitive.

To resolve this problem, define the path expression as follows:

s/\/tmp\/logs\/arcv.log.$L$weekdayName$$E/

Themonitor converts the characters between $L and $E to lowercase, /tmp/logs/arcv.log.tue.

Conversely, use $U and $E to enable SiteScope to change the characters between themarkers to upper
case. For example, if you define the path expression:

s/\/tmp\/logs\/arcv.log.$L$weekdayName$$E/

themonitor converts the path to /tmp/logs/arcv.log.TUE.

You can use $L and $Umultiple times in a path expression, and you can use them both in the same
expression.

For example:

s/\/tmp\/logs-$L$weekdayName$$E\/arcv.log.$U$weekdayName$$E/

converts the path to /tmp/logs-tue/arcv.log.TUE

s/\/tmp.$L$monthName$$E\/logs-$L$weekdayName$$E\/arcv.log.$U$weekdayName$$E/

converts the path to /tmp.mar/logs-tue/arcv.log.TUE

Matching Comma-Separated Values
The following is an example of log file entries that are comma-separated strings of digits and letters:

new,open,changed,12,alerts
new,open,changed,13,alerts
new,open,changed,13,alerts
new,open,changed,14,alerts
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A regular expression tomatch on log file entries that are comma-separated strings of digits and letters.

/([\w\d]+,[\w\d]+,[\w\d]+,[\w\d]+,[\w\d]+)[\n\r]?/

Note: If the file entries include punctuationmarks such as an underscore or a colon, add that character
explicitly to the [\w\d] class pattern. For example, to include a colon character, change each of the
[\w\d] patterns to [\w\d:].

Matching Space Separated Values
The following is an example of log file entries that are a sequence of strings and digits separated by spaces:

requests 12 succeeded 12 failed
requests 12 succeeded 12 failed
requests 11 succeeded 11 failed
requests 12 succeeded 12 failed
requests 10 succeeded 10 failed

The following is a regular expression tomatch on log file entries that are a sequence of strings and digits
separated by spaces.

/([\w\d]+\s+[\w\d]+\s+[\w\d]+\s+[\w\d]+\s+[\w\d]+)[\n\r]?/

Note: The use of the + character forces thematch to include the number of sequences per line included in
thematch pattern: in this example, five word or number sequences per line of the log file. If the
sequences include punctuationmarks such as an underscore or colon, add that character explicitly to the
[\w\d] class pattern. For example, to include a colon character, change each of the [\w\d] patterns to
[\w\d:].

Matching and Retaining the Numbers in a Line of Text and Numbers
The following is an example of log file entries that are comma separated strings that combine digits and
letters:

request handle number 12.56, series 17.5, sequence reported 97.45, 15.95 and 19.51
request handle number 15.96, series 27.5, sequence reported 107.45, 25.95 and 19.52
request handle number 11.06, series 36.5, system codes 9.45, 35.95 and 19.53
log reference number 12.30, series 17.5, channel reset values 100.45, 45.95 and 19.54

The following is a regular expression tomatch on log file entries that are comma-separated strings that
combine digits and letters and retain the decimal numeric data:

/[,\w\s]+(\d+\.\d+)[,\w\s]+(\d+\.\d+)[,\w\s]+(\d+\.\d+)[,\w\s]+
(\d+\.\d+)[,\w\s]+(\d+\.\d+)[\n\r]?/.

Note: If the file entries include punctuationmarks such as an underscore or colon, add that character
explicitly to the [,\w\s] class pattern. For example, to include a colon character that appears embedded
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in the text sequences, change each of the [,\w\s] patterns to [,:\w\s].

Matching Integers and Floating-point Numbers (Positive or Negative)
The following is an example of log file entries that are a sequence of integers and floating point numbers that
may be negative or positive:

12.1987 -71 -199.1 145 -1.00716
13.2987 -72 -199.2 245 -1.00726
14.3987 -73 -199.3 345 -1.00736
15.4987 -74 -199.4 445 -1.00746

The following is a regular expression tomatch on log file entries that are a sequence of 5 integers and floating
point numbers that may be negative or positive. The numbers in each entry must be separated by one or more
spaces.

/(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\s]+
(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\n\r]?/

Matching Date and Time-Coded Log Entries
Many log files include some form of date and time data with each entry. The following is an example of log file
entries that include date and time information together with string data separated by commas:

20/04/2003 14:29:22,ERROR,request failed
20/04/2003 14:31:09,INFO,system check complete
20/04/2003 14:35:46,INFO,new record created

The following is a regular expression tomatch on log file entries that are date- and time-coded followed by
comma-separated strings of letters and digits. This example uses the SiteScope date variables tomatch only
on entries that were created on the same day, month, and year as indicated by the system clock of the server
where SiteScope is running.

/$0day$\/$0month$\/$year$\s+\d+:\d+:\d+,[\w\d]+,[\w\d]+/

The following example uses the SiteScope date variables tomatch on amore restricted set of entries that
were created on the same day, month, year, and within the same hour as indicated by the system clock of the
server on which SiteScope is running.

/$0day$\/$0month$\/$year$\s+$0hour$:\d+:\d+,[\w\d]+,[\w\d]+/

ProblemsWorking with Regular Expressions
This section contains problems encountered when working with regular expressions.

This section contains the following topics:
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l "Using the .* construct presents a very large number of possible matches on any page of content" below
l "Text matching is done against code lines of the script (instead of against the browser's output from the
script) for URLs containing client side-scripts, such as JavaScript" below

l "Regular expressionmatch succeeds as soon as theminimummatch requested is satisfied" below
l "Forgetting to account for non-alphanumeric content" below
l "Use of excessivemetacharacters can be problematic" on the next page
l "Example Regular Expression Syntax" on the next page

Using the .* construct presents a very large number of possible matches on any
page of content
The use of the .* construct is known to cause the regular expression-matching engine used by SiteScope to
take over all available CPU cycles on the SiteScope server. If this occurs, SiteScope is unable to function
andmust be restarted each time themonitor with the offending regular expression is run, until the expression
has been corrected.

Note: Regular expressionmatching is run against the entire text content returned to the SiteScope
monitor request. This includes HTTP headers that are normally not viewable in the browser window (for
example, not visible using theView > Source option). This alsomeans that youmust account for other
information that may not be displayed in the browser view. This includes text in META tags used by
Internet search engines as well as client side-scripts.

Text matching is done against code lines of the script (instead of against the
browser's output from the script) for URLs containing client side-scripts, such as
JavaScript
This means that if the script dynamically writes or replaces text on theWeb page with values calculated by
the script, it may not be possible to match this content with regular expressions. If the script is only changing
text, youmay be able tomatch the corresponding text strings that appear in the script code. A further pitfall
would be that you are trying to check that a certain condition was met in the browser but thematching text
string appears in the script content regardless of any user action.

Regular expression match succeeds as soon as the minimummatch requested is
satisfied
After amatch is made, no further matching is performed. Therefore, regular expressions are not well suited to
count the number of occurrences of a repeating text pattern. For example, if you want to check aWeb page
with a catalog list of items and each item has a link next to it saying Buy Now! and you want to make sure that
at least five items are listed, a regular expression of /Buy Now!/would succeed inmatching only the first Buy
Now!. Likewise, if your regular expression searches the word catalog on themain browser screen, thematch
may succeed if the word appears as aMETA tag in the HTML header section or if it appears as a hyperlink in a
site navigationmenu that appears in the content before the occurrence you intend tomatch.

Forgetting to account for non-alphanumeric content
Regular expressions need to be written to account for all of the characters that are andmay be present. This
includes white space, linefeed, and carriage returns. This is not normally a problem whenmatching a single-
word literal. It can be a challenge when you need to create amatch of several words separated by unknown
amounts of white space and other non-alphanumeric characters and possibly spanmore than one line. The
[\s\n\r]+ character class can be useful between words used in the expression. Always check the format of
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the content you are trying tomatch to look for patterns and special characters, such as periods, commas, and
hyphens, that may cause a seemingly simplematch to fail.

Use of excessive metacharacters can be problematic
In some cases, overly generous quantifiers combined with the . or \Wmetacharacters can grab content that
you were intending tomatch with a literal string elsewhere in your regular expression resulting in amatch
failure. For example, the followingmight be used tomatch the URL content of the hyperlink anchor reference:
/a href="([\W\w\s]*)"/. When themonitor performs the check for this regular expression, however, the
match grabs the first occurrence of the pattern /a href="... and continues matchingmultiple lines of text up to
the last quotationmark found on the page. Without some other unique ending delimiter, the [\W\w\s]* class
and quantifier combination is too excessive. A more successful syntax that narrows the class of expected
characters would be: /a href="?([:\/\w\s\d\.]*)"?/

Example Regular Expression Syntax
The following are some examples of syntax for use in regular expressions:

Example Expression Description

/CUSTID\s?=\s?([A-
Z0-9]{20,48})/

This examplematches an ID string that is made of 20 or more digits and upper-
case letters with no spaces or other non-alphanumeric characters. The \s?
construct permits a white space on either side of the equals sign. Using the
parentheses around the character class instructs SiteScope to retain this value
(up to themaximum of 48 characters) as a content match value and thematched
value is displayed in themonitor detail status column.

/a href="?
([:\/\w\s\d\.]*)"?/i

This examplematches the URL string in an HTML hyperlink. The "? construct
makes a quotationmark on either end of the URL string optional. Using the
parentheses instructs SiteScope to retain this value as a content match value
and the value is displayed in themonitor status. The imodifier tells the search
to treat upper- and lower-case letters equally.

/"[^"]*"/ This examplematches text sequences that are contained between quotation
marks. Note the use of the negation caret (^) to define a character class of all
characters other than the quotationmark.

As with programming and scripting languages, there is almost always more than one way to construct a
regular expression to accomplish a particular match. There is not one right way to build regular expressions.
You should plan to test andmodify regular expressions as necessary until you get the results you need.
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Part 3: Integrations
SiteScope can be integrated with a wide variety of HPE software and third party products, including Business
ServiceManagement (BSM), Operations Manager (HPOM), Network NodeManager i (NNMi), LoadRunner,
Performance Center, Operations Orchestration (OO), Application Lifecycle Management (ALM), Diagnostics,
Continuous Delivery Automation (CDA), and Amazon CloudWatch.

For more details on SiteScope integrations, see "Integrations Overview" on page 169.

For a diagram illustrating the various integrations available, what each integration gives you, and how the
integration works, see "Integrating with Other Applications" on page 172.

For the versions of HPE software that are supported in this release, refer to the SiteScope Support Matrices
section in the SiteScope Deployment Guide.



Chapter 17: Integrations Overview
SiteScope can be integrated with the following applications:

Application Performance Management (APM)
SiteScope can be used as a data collector for Application PerformanceManagement (APM) 8.x or 9.x. APM
receives data about end-users, business processes, and systems and uses the data in reports and analysis.
You can configure SiteScopemonitor data to be sent to APM for all monitors, or for selectedmonitors only.
For details, see Connecting SiteScope to a APM Server.

Operations Manager Products (HPOM/Operations Management (OMi) in APM 9.x)
SiteScope can work together with Operations Manager products to provide a combination of agentless and
agent-based infrastructuremanagement.

l Event Integration. SiteScope uses the Operations Agent to forward event data to Operations Manager
(HPOM) or to Operations Management (OMi) in APM 9.x. This enables amore comprehensive and
detailed overview of the health of your IT operation. To forward event data to OMi10, see "HP Operations
Manager i 10 (OMi10)" below.

l Metrics Integration.
l To report metrics for use in PerformanceManager (a reporting component of HPOM), SiteScope uses
the Operations Agent to act as data storage for metrics collected data by SiteScope.

l To report metrics for use in PerformanceGraphing in APM's Operations Management, SiteScope uses
either the profile database in APM (the recommended option) or the HPE Operations Agent.

For more details on configuring these integrations, see the Integrating SiteScope with HP Operations Manager
Products Guide in the SiteScope Help Guide (check the HPE Software Integrations site for the latest version
of this guide).

Tip: For best practices and troubleshooting for using and configuring the integration of SiteScope with
APM andHPOM products, see Integration with APM andHPOM Best Practices Overview.

HP Operations Manager i 10 (OMi10)
SiteScope can be used as a data collector for HP Operations Manager i 10 (OMi10); this is a separate product
from APM andHP Operations Manager. SiteScope forwards events and topology to OMi 10. OMi’s embedded
graphing allows you to visualize performance data collected by SiteScope in near real-time. In addition,
SiteScopeMulti-View is available in the OMi workspace.

OMi10 can also import SiteScope templates to create sets of monitors that can be assigned to CIs based on
dynamic updates to the RTSM. Thesemonitors can be deployed out to multiple SiteScope servers, based on
user-configured criteria.

For details on configuring the integration with OMi 10, see the Operations Manager i - HP SiteScope
Integration section of the OMi Integrations Guide 10.00.

HPE Network Node Manager i (NNMi)
SiteScope can be used as a data collector for HP Network NodeManager i (NNMi), which is an event console
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used for network monitoring. SiteScopemonitors the application side of the system that NNMi is monitoring,
and uses SNMP Traps to forward event data from SiteScopemonitors to NNMi. SiteScope can also report
metrics data to NNMi. For details, see Integrating SiteScope with NNMi in the SiteScope Help (check the
HPE Software Integrations site for the latest version of this guide).

HP LoadRunner/HP Performance Center
SiteScope can be used with an HP LoadRunner or HP Performance Center installation to enable users to
define and use SiteScopemonitors on a LoadRunner or Performance Center application. SiteScope provides
additional monitoring that complements the native LoadRunner and Performance Center monitors. To
integrate SiteScope with LoadRunner or Performance Center, the HPE SiteScope for Load Testing setup type
must be installed. For details, see "Integrating with HP Load Testing Products" on page 207.

HP Operations Orchestration (OO)
TheOperations Orchestration (OO) SiteScope integration enables OO administrators to connect specific
events or alerts in SiteScope to the execution of OO flows. The administrator builds OO flows using
SiteScope operations (which use SiteScope API calls) in OOStudio. For example, an OO administrator can
create flows that automatically createmonitors in SiteScope when a new server is added, or delete monitors
when the server is decommissioned. For details, see the HP Operations Orchestration SiteScope Integration
Guide in the OO documentation set.

HP Application Lifecycle Management (ALM)
SiteScope integrates with HP Application Lifecycle Management (ALM) to sharemonitoring data and
templates from the production environment to enable load testing engineers to plan performance tests and
application deployment. For details, see the "Application Lifecycle Management Integration" page in the APM
Application Administration Guide in the APMHelp.

HPE Diagnostics
HPE Diagnostics monitors application servers using SiteScope. SiteScope forwards data about these
application servers to Diagnostics, providing an insight into the infrastructure components onto which the
application servers are deployed. Diagnostics presents the data in its reports and graphs. For details, see
Integrating SiteScope with HPE Diagnostics in the SiteScope Help (check the HPE Software Integrations
site for the latest version of this guide).

HP Service Health Reporter (SHR)
HP Service Health Reporter (SHR) is business service driven IT reporting software that provides reporting on
data collected frommultiple sources. SiteScope can be configured as one of the data source for SHR. The
SiteScope-SHR integration enables SiteScope to forwardmetrics data collected by various SiteScope
monitors to SHR. Thesemetrics can be used to analyze the load and efficiency of the infrastructure, forecast
the performance, and plan the capacity and usage. This integration works with SHR 9.4 version or higher. For
details, see the SHR documentation on the HPE Software Integrations site.

Amazon CloudWatch
SiteScope can be used to report SiteScopemonitor measurement data to an Amazon CloudWatch service.
This integration enables customers who use SiteScope for monitoring their AWS-hosted applications to report
any SiteScopemetrics to Amazon CloudWatch service. SiteScopemetrics data can be used for AWS
AutoScaling, reporting, and alerting. For details, see "Amazon CloudWatch Integration Preferences" on
page 563.
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Generic Data integrations
SiteScope can be used to forwardmetrics to other applications that can receive XML files. These files contain
information about the status of SiteScope groups, monitors, andmeasurements. For details, see "Generic
Data Integration Preferences" on page 584.

Generic Event integrations
SiteScope can be used to forward events to a third-party application or management console. The event that
is sent contains information regarding themonitor and its measurement, including the status change that
triggered the event. For details, see "Generic Event Integration Preferences" on page 588.

For a diagram illustrating the various integrations available, what each integration gives you, and how the
integration works, see "Integrating with Other Applications" on page 172.
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Chapter 18: Integrating with Other
Applications
You can integrate SiteScope with the various different applications as listed in the following sections:

l "Integrating with BSM andOperations Manager Products" below
l "Integrating with Other HPE Products" on page 177

Integrating with BSM and Operations Manager Products
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Integration What the Integration Gives You How the Integration Works
Where to Get
the Details

(1)
SiteScope
events ->
BSM events
and health
indicators.

If you have an Event Management
Foundation license, the events
corresponding to SiteScope metrics
status changes and alerts are
displayed in the Event Browser in
Operations Management.

If the SiteScope events have
corresponding event type indicators
(ETIs), the health indicators affect
the status of the relevant CIs in APM
applications such as Service Health
and Service Level Management
(regardless of whether you have an
Event Management Foundation
license).

If SiteScope is configured as a data
collector for APM's Operations
Management, SiteScope sends data
about SiteScope metrics status
changes and alerts to Operations
Management using the Operations
Agent technology.

l Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help

l Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help(End-to-
end flow)

Note: Check
the
HPE Softwar
e Integrations
site for the
latest version
of this guide.

l For
information
on the
Operations
Management
(OMi)
licensing
structure, see
Licensing in
the APM User
Guide in the
APM Help
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Integration What the Integration Gives You How the Integration Works
Where to Get
the Details

(2)
SiteScope
events ->
HPOM
events.

Events generated from SiteScope
metrics status changes and alerts
are displayed in HPOM.

If SiteScope is configured to report
events to HPOM, SiteScope sends
data about SiteScope metrics status
changes and alerts to HPOM using the
Operations Agent technology.

l Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help

l Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-to-
end flow)

Note: Check
the
HP Software
Integrations
site for the
latest version
of this guide.

l For
information
on the
Operations
Management
(OMi)
licensing
structure, see
Licensing in
the APM User
Guide in the
APM Help
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Integration What the Integration Gives You How the Integration Works
Where to Get
the Details

(3)
SiteScope
events ->
BSM events
and health
indicators
using HPOM.

If you have an Event Management
Foundation license, events
generated from SiteScope metrics
status changes and alerts are sent
to Operations Management using
HPOM.

If the SiteScope events have
corresponding event type indicators
(ETIs), the health indicators affect
the status of the relevant CIs in APM
applications such as Service Health
and Service Level Management
(regardless of whether you have an
Event Management Foundation
license).

If SiteScope is configured to report
events to HPOM, SiteScope sends
data about SiteScope metrics status
changes and alerts to HPOM using the
Operations Agent technology.

l Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help

l Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-to-
end flow)

Note: Check
the
HPE Softwar
e Integrations
site for the
latest version
of this guide.

l For
information
on the
Operations
Management
(OMi)
licensing
structure, see
Licensing in
the APM User
Guide in the
APM Help

(4)
SiteScope
metrics ->
BSM metrics
and health
indicators.

If the SiteScope metrics have health
indicators assigned to them, these
health indicators affect the status of
the relevant CIs in APM applications
such as Service Health, Service
Level Management, and Service
Health Analyzer.

If the SiteScope metrics have health
indicators assigned to them, these
health indicators affect the status of
the relevant CIs in APM applications
such as Service Health and Service
Level Management. SiteScope
metrics are also used in Service
Health Analyzer.

SiteScope sends metrics to APM over
HTTP/HTTPS.

l Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help

l "How to
Configure
SiteScope to
Communicat
e with BSM"
on page 190
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Integration What the Integration Gives You How the Integration Works
Where to Get
the Details

(5)
SiteScope
metrics ->
Performance
Graphing
(BSM).

SiteScope collects metrics data, and
logs it to the data source. The data
source depends on which
integrations are enabled.

l If only the BSM integration is
enabled, data is logged to the
Profile database.

l If both BSM and HP Operations
Manager metrics integration are
enabled, SiteScope logs the
data to the HP Operations agent
data store installed on the
SiteScope host.

When a user draws or designs a
graph in Performance Graphing in
Operations Management,
Performance Graphing collects
metrics data from the data source for
the selected CI, which is monitored
by SiteScope, and draws the graph.

Data source used:

l Profile database: SiteScope reports
metrics data to the profile database
in BSM. To use this data source,
SiteScope must be connected to a
BSM server and reporting monitor
metrics to BSM should be enabled.

l HPE Operations Agent: SiteScope
uses the HPE Operations Agent to
make its metrics data available to
Performance Graphing. To enable
SiteScope to report metrics, the
agent must be installed on the
SiteScope server, and metrics
reporting must be enabled for each
monitor instance you want to report.

l Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help

l Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help(End-to-
end flow)

Note: Check
the
HPE Softwar
e Integrations
site for the
latest version
of this guide.

(6)
SiteScope
metrics ->
Performance
Manager
graphs
(HPOM).

SiteScope collects metrics data, and
logs it to the Operations agent data
store, which is installed on the
SiteScope host.

When a user in Performance
Manager draws or designs a graph,
Performance Manager collects
metrics data from the Operations
agent data store for the selected
node in Performance Manager that
is monitored by SiteScope, and
draws the graph.

SiteScope uses the HPE Operations
Agent to make its metrics data
available to Operations Manager
(Performance Manager). To enable
SiteScope to report metrics, the HPE
Operations Agent must be installed on
the SiteScope server.

l Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help

l Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-to-
end flow)

Note:Check
the
HPE Softwar
e Integrations
site for the
latest version
of this guide.
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Integrating with Other HPE Products

Integration

What the
Integration Gives
You

How the Integration
Works Where to Get the Details

(7) SiteScope
metrics ->
HPE
Diagnostics
data.

SiteScope forwards
metrics to HP
Diagnostics,
displaying a more
complete view of
the performance of
the application
server that is
monitored by
Diagnostics. The
metrics can provide
insight into the
infrastructure
components onto
which the
application servers
are deployed.

SiteScope forwards
metrics to HPE
Diagnostics using
Diagnostics Integration
Preferences.

Integrating SiteScope with HPE Diagnostics in
the SiteScope Help (End-to-end flow)

Note: Check the HPE Software Integrations site
for the latest version of this guide.
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Integration

What the
Integration Gives
You

How the Integration
Works Where to Get the Details

(8) SiteScope
events ->
NNMi.

The SiteScope-
NNMi event
integration enables
SiteScope to
forward events from
SiteScope monitors
(events generated
from alerts), and
displays the event
data in the NNMi
incident console.
(SiteScope 11.10
and NNMi 9.10 or
later are required)

SiteScope sends SNMP
traps to NNMi. The
SNMP traps are
converted to NNMi
incidents. From the
resulting incidents, an
NNMi console user can
launch SiteScope in the
context of that monitor
(using the URL in the
SNMP trap sent to the
NNMi server).

l Integrating SiteScope with HPE NNMi in the
SiteScope Help (End-to-end flow)

Note: Check the HPE Software Integrations
site for the latest version of this guide.

l You can view a guided and narrated
demonstration for the SiteScope-NNMi
integration on YouTube:
https://www.youtube.com/watch?v=21VSL
3_I7oM

(9) SiteScope
metrics ->
NNMi.

The SiteScope-
NNMi metrics
integration enables
SiteScope to
forward metrics
data from
SiteScope monitors
(metrics status
changes and alerts)
to NNMi.
(SiteScope 11.10
and NNMi 9.10 or
later are required)

The HPE NNMi-HPE
SiteScope System
Metrics integration
populates the NNM iSPI
Performance for Metrics
Network Performance
Server (NPS) with
system metrics data
collected by SiteScope
monitors using the
Generic Data
Integration.

l Integrating SiteScope with HPE NNMi in the
SiteScope Help (End-to-end flow)

Note: Check the HPE Software Integrations
site for the latest version of this guide.

l You can view a guided and narrated
demonstration for the SiteScope-NNMi
integration on YouTube:
https://www.youtube.com/watch?v=21VSL
3_I7oM

(10) Run
SiteScope-
related
actions in
Operations
Orchestration
(OO).

The Operations
Orchestration (OO)
SiteScope
integration enables
administrators to
build OO flows that
are integrated with
HP SiteScope.

The administrator builds
OO flows using
SiteScope operations
(which use SiteScope
API calls) in OO Studio.
For example, you can
create flows that
automatically create
monitors in SiteScope
when a new server is
added, or delete
monitors when the
server is
decommissioned.

Operations Orchestration - SiteScope
Integration Guide in the OO documentation
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Integration

What the
Integration Gives
You

How the Integration
Works Where to Get the Details

(11)
SiteScope
metrics and
configuration
-> ALM/PAL.

SiteScope
integrates with
Application
Lifecycle
Management
(ALM)/Performance
Application
Lifecycle (PAL) to
share monitoring
data and templates
from the production
environment to
enable load testing
engineers to plan
performance tests
and application
deployment.

You can export
SiteScope related data
(metrics, templates, and
topology) from APM to
ALM and vice versa.
Exporting data to ALM
enables you to plan
scripts and load tests
that resemble your
production environment,
and importing data from
ALM enables you to use
scripts and SiteScope
configurations that have
already been tested.
You perform this from
the Application Lifecycle
Management Integration
page in BSM.

l "Integrating with Application Lifecycle
Management" on page 209

l Application Lifecycle Management
Integration Page in the APM Application
Administration Guide in the APM Help

(12)
SiteScope
metrics ->
LoadRunner
/Performance
Center.

Performance
metrics collected by
SiteScope can be
utilized by load
testing analysis
products and
solutions, for
example, by HP
LoadRunner and
HP Performance
Center.

To integrate SiteScope
with LoadRunner or
Performance Center, the
HPE SiteScope for Load
Testing setup must be
installed. The
integration should be
configured in the
respective load testing
product.

l "Integrating with HP Load Testing Products"
on page 207

l HP LoadRunner Controller User's Guide
which is available from the HPE Software
Integrations site.

l HP Performance Center Administrator
Guide which is available from the
HPE Software Integrations site.

(13)
SiteScope
events ->
CDA
(Continuous
Delivery
Automation).

HP Continuous
Delivery
Automation (CDA)
integrates with
SiteScope to
deploy SiteScope
monitors and
receive events from
them. Monitoring
status based on the
events received is
available in the
CDA user interface.

SiteScope forwards
events to CDA using an
out-of-the-box template
that is specially
configured for CDA. The
template is available
from Preferences >
Common Event
Mappings.

l "How to Configure SiteScope Generic Event
Integration" on page 589

l Continuous Delivery Automation
documentation

Using SiteScope
Chapter 18: Integrating with Other Applications

HPE SiteScope (11.33) Page 179 of 1206

https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01695208
https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01695208
https://hpenterprise.sharepoint.com/teams/aztec/Portal/index.html


Integration

What the
Integration Gives
You

How the Integration
Works Where to Get the Details

(14)
SiteScope
metrics -> HP
Service
Health
Reporter
(SHR)
(not on
diagram)

HP Service Health
Reporter (SHR) is
business service
driven IT reporting
software that
provides reporting
on data collected
from multiple
sources. SiteScope
can be configured
as one of the data
source for SHR.

The SiteScope-SHR
integration enables
SiteScope to forward
metrics data collected
by various SiteScope
monitors to SHR. These
metrics can be used to
analyze the load and
efficiency of the
infrastructure, forecast
the performance, and
plan the capacity and
usage. This integration
works with SHR 9.4
version or higher.

Check the SHR documentation on the
HPE Software Integrations site.
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Chapter 19: Connecting to a BSM Server
SiteScope can be used as a data collector for APM. APM uses data about end-users, business processes,
and systems. When configured as a data collector for APM, themetrics and topology data collected by
SiteScopemonitors can be passed on to APM for analysis and for use in reports. Monitor data can be sent for
all monitors or for selectedmonitors only.

The following diagram illustrates the use of SiteScope as a data collector for APM:

Note: The APM integration should not be confused with the integration using the Operations Agent,
which is required for displayingmetrics data in PerformanceGraphing (in BSM's OperationManagement)
and in PerformanceManager (a reporting component of HPOM). For details on collectingmetrics using
the Operations Agent, see Integrating SiteScope with HP Operations Manager Products in the SiteScope
Help. You can check the HPE Software Integrations site for the latest version of this guide.

APM includes a System Availability Management (SAM) Administration page, that enables you tomanage
SiteScopemonitor configurations for one or more SiteScope servers through a central console. After
activating the APM integration, SiteScope data flows to APM regardless of whether youmanage SiteScopes
through SAM Administration or the SiteScope standalone user interface.

For the APM versions supported in this release, refer to the SiteScope Support Matrices section in the
SiteScope Deployment Guide.

Tip: For best practices and troubleshooting for reportingmetrics data to APM andHPOM, see Integration
with BSM andHPOM Best Practices Overview in the Integration with BSM andHPOM Best Practices
Guide in the SiteScope Help.

Troubleshooting/Limitations
This section includes:
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l "Reporting Data to BSM" below
l "Disabling the Data ReductionMechanism to Troubleshoot Data Flow Problems" below
l "SiteScope Reports the IP Address Instead of the HostnameConfigured in theMonitor" below
l "Additional Troubleshooting" on the next page

Reporting Data to BSM
l SiteScope reports numeric metric values only to APM. It does not report metrics containing string values.
l Unable to register SiteScope in an HPE SaaS environment if its APM SaaS user contains special
characters, such as the@ sign. The APM user account should contain alphabetic and/or numeric
characters only.

l Due to the complexity of somemonitoring deployments and network communications, SiteScopemay be
temporarily unable to communicate with the APM server. SiteScope Health monitoring includes several
monitors for watching connectivity and data transfers to the APM server.
If SiteScope is unable to connect to the APM Server, SiteScope continues to record and storemonitor
data files locally. After the number of data files exceeds a specified threshold, SiteScope saves the data
files in a cache folder with the syntax <SiteScope root
directory>\cache\persistent\topaz\data<index>.old. It also saves the heartbeat samples to bus_
<index>.old and configuration samples to config_<index>.old. You can configure the number of
data.old folders to keep by modifying the _topazMaxOldDirs property in the <SiteScope root
directory>\groups\master.config file.

Note: By default, the threshold number of data files is set to 1,000 files. You can change this setting
by modifying the _topazMaxPersistenceDirSize property in themaster.config file.

After the connection between SiteScope and the Agent Server is restored, youmust manually copy
the files from these folders to the <SiteScope root directory>\cache\persistent\topaz\data folder.
We recommend that you only copy these files when the data folder is empty to avoid overloading the
system with large amounts of data to upload. When the number of data.old folders exceeds a
specified threshold, by default 10 folders, the oldest folders are deleted.

Disabling the Data Reduction Mechanism to Troubleshoot Data Flow Problems
By default, SiteScope uses a data reductionmechanism which reduces the sample load from SiteScope to
APM by up to 80%. This is done by sending special samples only when there is some change in the data
reading rather than repeating the same sample eachmonitor run.

Note: The SiteScope Heartbeat sample (ss_heartbeat) indicates that SiteScope is functioning properly
and that its integration with BSM is healthy. The sample is only sent if SiteScope is in data reduction
mode (in which case the sample is sent every minute).

It is possible to disable this mechanism for troubleshooting data flow problems by setting the property _
topazEnforceUseDataReduction= to false in the <SiteScope root directory>\groups\master.config file.
However, it is not recommended to change this default setting.

SiteScope Reports the IP Address Instead of the Hostname Configured in the
Monitor
When reverse DNS lookup is either not configured or is faulty for themonitored remote server, SiteScope
reports the IP address of the host to BSM instead of the hostname configured in themonitor
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Workaround:You can force themonitor to send the hostname instead of the IP address to BSM by setting
the _disableHostDNSResolution property to “=true” in the <SiteScope root
directory>\groups\master.config file.

Additional Troubleshooting
For additional troubleshooting issues related to SiteScope-APMmetrics integration, CI topology reporting, and
CI downtime,see Troubleshooting SiteScope Integration Issues in the Integration with BSM andHPOM Best
Practices Guide in the SiteScope Help.

Configure the Connection
To enable the connection between SiteScope and APM, the SiteScopemust be configured as a data collector
for APM. This involves adding a SiteScope to the SAM Administration page in the APM. For details on this
task, see "How to Configure SiteScope to Communicate with BSM" on page 190.

For information about troubleshooting reporting data to APM, see " Connecting to a BSM Server" on page 181.

Using a Secure Connection for SiteScope-BSM
Communication
You can use a secure connection to transmit data from SiteScope to the APM server. If you have installed a
certificate signed by a root Certificate Authority on the APM server, no additional setup is required on the
SiteScope server.

If you are using a self-signed certificate on the APM server and want to use that certificate for secure
communication with SiteScope, youmust perform the steps as described in "Configure SiteScope to connect
to a BSM server that requires a client certificate or a secure connection (recommended for enterprise
security)" on page 192.

Changing the Gateway Server to Which SiteScope Sends
Data
You can change theGateway Server to which a SiteScope reports its data. Generally, this is only applicable if
you are working with a APM deployment with components installed onmore than one server (in the case of a
distributed deployment where the APMGateway Server is installed on a different machine from the Data
Processing Server).

For details onmaking this change, see "Change theGateway Server to which SiteScope sends data -
optional" on page 192.

Integrate SiteScope Data with BSM's Configuration
Items
When amonitor instance is added to a SiteScope reporting data to APM, that monitor creates a corresponding
configuration item (CI) in Run-time ServiceModel (RTSM). For details on understanding configuration items,
see the introduction section in the RTSM Administration Guide in the APMHelp.
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The SiteScopemonitors that populate RTSM include both actual monitors and the groups in which they are
created.

l Actual monitors instances are represented in RTSM as monitor CIs. Monitor CIs receive data from the
corresponding SiteScopemonitor instance and use the data, along with health indicators (HIs) and event
type indicators (ETIs) that are assigned to SiteScopemonitor metrics, to calculate key performance
indicator status. These indicators provide amore detailed view of the health of a CI. For details on
understanding indicators, see "Health Indicators and KPIs - Overview" in the APMUser Guide in the APM
Help.

l SiteScope groups are represented as group CIs in RTSM and receive KPI status from themonitor CIs
created by themonitors they are running.

Monitor Types and Topology Reporting
SiteScope reports different levels of topology data to RTSM depending on the type of monitor and the options
selected for themonitor. SiteScope forwards the topology to create or update a CI under the following
conditions:

l When the CI is created in SiteScope for the first time as a result of themonitor retrieving data, regardless
of whether the CI exists in RTSM.

l If there were any changes to any of the CI's properties.
This prevents overloading RTSMwith CI updates coming from themonitor.

When working with specific monitors, you do not select a topology and the topology is preconfigured with the
necessary data for the integration.

The types of monitors are as follows:

l Technology Integration Monitors. Thesemonitors report data based on the topology settings script you
select and edit for themonitor. The data they report is tightly integrated with APM. You can create a
custom topology or use a predefined script to forward the relevant data. For details on thesemonitors and
how to work with their topology settings, see "Topology Settings for Technology IntegrationMonitors" on
page 328.

l Monitors of Supported Environments. For these supported environments, SiteScope acts like a
discovery probe when themonitor is created or its configuration is changed. When topology reporting is
enabled, SiteScope automatically discovers the application's topologies and populates RTSMwith the
relevant CIs andmonitor CIs. For details and a list of supported environments, see "Report Discovered
Topologies to BSM" on page 188.
You can create a custom topology for monitors of a supported environment (except for monitors where the
CI type is per metric as described in "Monitors Reporting CI Per Metric" on page 206). For details on
creating a topology, see "How to Configure Topology Reporting" on page 195.

l Monitors Not Reporting Topology Data By Default. SiteScope includes monitors that do not report
hosts or servers and, therefore, it is not possible to know the CI type that is beingmonitored in advance.
To include topology data for thesemonitors when reporting to APM, youmust select the CI type, define CI
type key attributes, andmapmetrics related to themonitor type to specific indicators. SiteScope then
creates a CI for themonitor in RTSM and forwards monitor CI data to APM. For the list of monitors that do
not have a default topology defined, see "Monitors Not Reporting Topology Data By Default" on page 205.
For details on how to create a topology for thesemonitors, see "How to Configure Topology Reporting" on
page 195.
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Creating Relationships Between Monitors and CIs
You can also create relationships between SiteScopemonitor CIs and existing CIs in RTSM. This
relationship enables themonitor to pass HI status information to the CI to which it is attached, even if that CI
was not created from a topology forwarded by SiteScope.

You can create these relationships in SiteScope or in SAM Administration. For details, see task step "Create
relationships between SiteScopemonitors and existing CIs in RTSM - optional" on page 193.

Aging of CIs in RTSM
In RTSM, CIs that have had no activity over a period of time are removed from the database. The CIs created
from SiteScope data are also subject to this aging policy. To prevent the aging policy from acting on CIs that
SiteScope has sent to APM, SiteScope synchronizes the data it sends to APM. The synchronization
refreshes the data for those CIs and creates activity on the CIs.

For details on setting the time interval for topology synchronization, see Topology Settings in the APM
Application Administration Guide in the APMHelp. For details on the agingmechanism, seeWorking with CIs
in theModeling Guide in the APMHelp.

Note:

l Synthetic monitors and groups created by the EMS integrationmonitors that useMeasurement field
mapping are subject to the aging process regardless of the synchronization.

l To prevent CIs for EMS integrationmonitors being removed from RTSMwhen aging is enabled, EMS
topology is resent during a hard synchronization of SiteScope. In addition, you can enable topology
resending as part of an anti-aging process by adding the property _
reportEmsCIsAsPartOfAntiAging=true to the
<SiteScope root directory>\groups\master.config file.

l If you delete a CI from RTSM youmust perform a resynchronization or a hard synchronization of
SiteScope (in Integration Preferences), or youmust wait for a restart of SiteScope so the CI is
restored to RTSM. This is due to the CI cache in SiteScope that prevents SiteScope from sending an
unchanged CI twice. For details, see the section on APM Integration Preferences.

Managing Indicator Assignments in System Availability Management

Note: This section is relevant only to those users connecting SiteScope with APM 9.00 or later.

SiteScopemetrics that aremapped to indicators, are stored andmanaged in the Indicator Assignments
repository in SAM Administration. The repository provides the following benefits:

l Centralizedmanagement of metric mappings in APM, whichmakes it easier to manage large numbers of
SiteScope andmonitors. The Indicator Assignments repository is available for editing in theMetrics and
Indicators tab in SAM Administration.

l Metrics aremapped from different SiteScopemonitors to indicators, per monitor type. You can create,
edit, and delete indicator assignments for specific monitor types.

l If new indicator assignments are added or existing assignments aremodified in the Indicator Assignments
repository, these changes can be published to all SiteScopes that are connected to APM. This ensures
that new monitor instances created in SiteScope have indicators according to the latest centralized
assignments. You can restore the default assignments included in your current version of SiteScope by
clicking theReset to Default button inHP Integration Settings > Indicator Settings section of the
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monitor properties.

Note:Where indicator assignments have beenmodified on a local SiteScope server (mappings for
monitor metrics were changed):

l These assignments are not overridden by the centralized assignments when SiteScope
downloads the updatedmappings.

l If an assignment is deleted from the Indicator Assignments repository, the local assignment is not
automatically deleted and SiteScope keeps sending the old indicator value to APM. In this case, a
different indicator assignment should be selected for themonitor metric.

l If an indicator is deleted from the Indicator repository, a different indicator assignment should be
selected for monitor metrics that used themapping.

l The central repository ensures compatibility with earlier versions of SiteScope by mappingmetrics from
earlier SiteScopes to indicators.

l When a hard synchronization is performed on SiteScope, all the indicator mappings are downloaded from
APM.

For details on editing the centralized Indicator Assignments in SAM Administration, see "Indicator
Assignment Settings" in the APM Application Administration Guide in the APMHelp.

Assigning SiteScope Metrics to Indicators

Note: This section is relevant only to those users connecting SiteScope with APM 9.00 or later.

When configuringmonitor instances, you can alsomap ametric to an indicator. SiteScopemonitor metrics are
mapped to indicators on amonitor type basis as follows:

l Monitors of supported environments andmonitors that have a defined topology have indicators assigned to
metrics by default. For details of thesemonitors, see "Monitor Types and Topology Reporting" on
page 184. For the list of default indicator assignments, see Indicator Mapping Alignment in the APMUser
Guide in the APMHelp.

l For SiteScopemonitors that do not have a defined topology, there are no default indicator mappings, since
thesemonitors can be linked to different CI types, and a single mapping cannot be set. For thesemonitors,
you canmapmetrics to the appropriate indicators for the CI type linked to themonitor. For a list of
monitors that do not have a defined topology, see "Monitors Not Reporting Topology Data By Default" on
page 205.

You can change the default metrics mappings in SiteScope. If indicator mappings aremodified locally in
SiteScope, thesemappings are not overridden by the centralized repository mappings when SiteScope
downloads the latest mappings from APM. This enables you to:

l Override indicators for amonitor instance or somemetrics of amonitor.
l Configure non-default indicators in templates. Note that the CI type for custom topology andmetric
mappings is not configurable through variables in templates (they should be predefined in a template).

l Configure indicators for alerts. Since the CI type of a triggered alert is not always knownwhen configuring
an alert for groups or for monitors reporting a CI per metric (see "Monitors Reporting CI Per Metric" on
page 206), you canmanually enter the indicator and indicator state for an alert. For details, see "HP
Operations Manager Integration Settings" on page 1096.

For task details onmapping SiteScopemetrics to indicators, see "Map Indicators to metrics" on page 196.
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For user interface details, see "Indicator Settings" on page 258.

When are Health Indicators Created?
l Events in SiteScope are based on SiteScopemonitor metric status changes and alerts being triggered.
Events are created after the first event arrives to the CI. For more details, see Integrating SiteScope with
HP Operations Manager Products. You can check the HPE Software Integrations site for the latest
version of this guide.

l Metrics are created when themonitor topology is reported to RTSM. For more details, see "Report
Discovered Topologies to BSM" on the next page.

Discovery Scripts and the Package Manager

Note: This section applies to users integrating with Business Availability Center/APM 8.00 or later.
When integrating topology data with earlier versions of APM, SiteScope uses legacy scripts which are
stored on the SiteScope server.

The scripts that enable SiteScope to act as a discovery probe are stored on the APM server in the SiteScope
package. When SiteScope is configured to discover an application's topology, SiteScope downloads the
appropriate script from the APM server. It then uses the script to perform the discovery while monitoring the
application.

The SiteScope package includes scripts and other SiteScope-related RTSM resources, such as views and
enrichments. You can access this package in APM inAdmin > RTSM Administration > Administration >
Package Manager. The package is a factory package, meaning that the out-of-the-box configurations for the
package enable it to perform the discoveries in SiteScope. For details on working with packages, see
Package Administration in theModeling Guide in the APMHelp.

Note: Advanced users may want to modify the topology scripts within the package. Be warned that the
SiteScope package uses scripts from other packages whichmay be shared by SiteScope and Data Flow
Management. Any changes made to the scripts in the package can also affect Data Flow Management.

Any changes made to the topology script that influence the way a topology is reported to APM can affect
all the applications that use those topologies, including APM applications andOperations Management.

Topology Script Properties File
If you are working in a secure APM installation that has a certificate, youmay have to insert the following line
into the <SiteScope root directory>\discovery\discovery_agent.properties file:
appilog.agent.Probe.BasicAuth.Realm=authRealm.

Where authRealm is a variable for Basic Authentication Realm. If you want to find out what realm a given
URL belongs to, you can open the URLwith aWeb browser and see the first line in the popup box.

Note:When youmodify the discovery_agent.properties, youmust restart SiteScope to enable your
changes to take effect.

Topology Reporting Limitation
The number of characters in SiteScope group andmonitor descriptions that can be reported to APM is limited
to 600 characters. If a group or monitor description contain more than this number, SiteScope truncates the
description to the first 600 characters.
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Report Discovered Topologies to BSM
SiteScope can act as a discovery probe and discover the hierarchy of themonitored entities of selected
environments. These hierarchies are represented by topologies that SiteScope reports to APM. The CIs
within the topologies correspond to the hosts, servers, and applications that SiteScopemonitors, and are
created in APM's RTSM. Monitor andmeasurement CIs are also created and SiteScope reports their status to
APM. The relationships between the CIs are defined by the topology reported by SiteScope.

You enable this feature by selecting theReport monitor and related CI topology option under theHP
Integration Settings panel when creating or configuring amonitor instance. If this option is cleared, the CIs
that were created in RTSM are not automatically deleted. If there is no activity on the CI, they are eventually
removed from the database through aging or they must bemanually deleted.

For details on the Topology Settings user interface, see Topology Settings in the APM Application
Administration Guide in the APMHelp.

For troubleshooting problems involving topology reporting, see Application PerformanceManagement
Topology Issues in the Integration with BSM andHPOM Best Practices Guide.

Supported Environments
This direct connection between SiteScope and APM is available for selected environments only and with
specific versions of APM. SiteScope reports specific topologies for the followingmonitors (documentation for
thesemonitors is available from the SiteScopeMonitor ReferenceGuide in the SiteScope Help):

Environment/
Monitor Type Monitors

Monitors
Reporting
Node
Topology

This includes all monitors that report the status of a host or server (other than Technology
Integrationmonitors and the supported environments listed below) that can forward
topology data to APM using a predefined CI type such as Node, Computer, or some other
child CI type derivative. When topology reporting is enabled, SiteScope forwards the
topology along with monitor CI data to APM. For details on this option, see "HP
Integration Settings" on page 253.

Note: This does not includemonitors that do not monitor the status of a host or server,
since it is not possible to know the CI type that is beingmonitored in advance. For the list
of monitors without host data, see "Monitors Not Reporting Topology Data By Default" on
page 205.

Database
Environments

(Available when integrating with Business Availability Center version 8.00 or later.)

l Database Counter Monitor
l DatabaseQuery Monitor
l DB2 JDBC Monitor
l Microsoft SQL Server Monitor
l Oracle DatabaseMonitor

Big Data
Environments

l HadoopMonitor
l HP Vertica JDBC Monitor
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Environment/
Monitor Type Monitors

ERP/CRM
Application
Environments

l SAP CCMS Monitor
l SAP MAI Alerts Monitor
l SAPWork Processes Monitor
l Siebel Application Server Monitor
l Siebel Web Server Monitor

Server
Environments

(Available when integrating with BSM 9.0 or later.)

Dynamic Disk SpaceMonitor

SOA
Environments

WebServiceMonitor

Virtualization
Environments

(Available when integrating with Business Availability Center/APM 8.02 or later.)

l Solaris Zones Monitor
l VMware DatastoreMonitor
l VMware Host Monitors
l VMware PerformanceMonitor

Web server
Environments

l Microsoft IIS Server Monitor
l WebLogic Application Server Monitor, using the JMX Monitor or Dynamic JMX
Monitor

l WebSphere Application Server Monitor

CI Downtime
Note: This section is relevant only to those users connecting SiteScope with APM 9.00 or later.

Downtimes are defined andmanaged in APM using the DowntimeManagement page in Platform
Administration. For details about configuring downtime, refer to DowntimeManagement in the APM Platform
Administration Guide in the APMHelp.

SiteScope is affected by downtime if a SiteScopemonitor or measurement CI is directly linked to a CI that
APM detects is in downtime. SiteScope is also affected by downtime if a Business Application CI, Business
Service CI, Infrastructure Service CI, or a CI Collection linked to a SiteScopeGroup CI is in downtime.

Monitors affected by a CI that is currently in downtime do not go into downtime immediately. The time that it
takes for themonitors to go into downtime is affected by two configuration parameters:

l The interval between SiteScope queries to APM for downtime requests (the default downtime retrieval
frequency value is 15minutes). This can bemodified in SiteScope inPreferences > Infrastructure
Preferences > General Settings > BSM downtime retrieval frequency (minutes).

l The interval between updating the SiteScope downtime cache in APM (the default value is 5minutes).
This can bemodified in APM inAdmin > Platform > Setup and Maintenance > Infrastructure
Settings. Select Applications > End User/System Availability Management. In theDowntime table,
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locateSiteScope Downtime Cache Update Interval. Change the value to the required cache update
interval.

The action that is taken in SiteScope during the downtime depends on the downtime configuration in APM.
Downtime can be enforced on the following:

l Alerts. No alerts are sent for any of the CIs associated with the downtime.
l Reports. Reports are not updated and display the downtime for the CI.
l KPIs. KPIs attached to the CI are not updated and display the downtime for the CI in Service Health.
l Monitoring. SiteScopemonitoring stops for any of the CIs associated with the downtime.
A monitor that is in downtime is indicated in the SiteScope DashboardSummary column by "disabled by
<Downtime Name> from BSM". Details of downtimes that are associated with themonitor and are currently
taking place are displayed in theMonitor Downtime table in theEnable/Disable Monitor panel. For details,
see "Enable/Disable Monitor" on page 264.

If themonitor is affected by a CI that is currently in downtime and the downtime applies to associated alerts of
themonitor, downtime details are displayed in theAssociated Alerts Downtime table in theEnable/Disable
Associated Alerts panel. For details, see "Enable/Disable Associated Alerts" on page 265.

Notes and Limitations
l When SiteScope queries APM for downtime requests, it gets the downtimes for the downtime period (up to
amaximum of 24 hours). A record is written to <SiteScope root directory>\logs\audit.log which
includes new downtimes, changes to existing downtimes, and deleted downtimes.

l When SiteScopeis connected to APM 9.00 or later, the downtimemechanism is enabled by default. To
change the default setting, clear theEnable downtime mechanism check box in SiteScope's
Preferences > Infrastructure Preferences > General Settings.

l Downtime is not supported for SAP, Siebel, or SOA topologies (regardless of whether the Application
Management for Siebel/SAP license is installed).

l Formonitors that report the CI per metric, when a CI connected to ametric is in downtime, this sends the
monitor to which themetric belongs into downtime. This is applicable to the VMware PerformanceMonitor
and Solaris Zones Monitor.

l Downtime information is not available in System Availability Management reports.
l When SiteScope is connected to APM 9.10, downtime on the SiteScope profile is upgraded to downtime
on the hosts and software elements that aremonitored by the SiteScope profile monitors and
measurements.

l For additional troubleshooting relating to CI downtime, see Business ServiceManagement CI Downtime
Issues in the Integration with APM andHPOM Best Practices Guide.

How to Configure SiteScope to Communicate with
BSM
This task describes how to configure SiteScope to be used as a data collector for APM.

1. Prerequisites
l Before starting the integration, check the Support matrix for the list of BSM versions supported in this
release. For details, see the Business ServiceManagement Integration Support Matrix in the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
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Documentation.htm).

l To integrate SiteScope with APM, youmust be a SiteScope administrator user. For details on user
permissions, see "User Management Preferences" on page 625.

l Prepare a plan that maps out the specific IT infrastructure resources whose data you want to collect.
Include information about the business processes that are affected by the specified infrastructure
components. For example, business processes beingmonitored by Business Process Monitor, that
are running on an application server against which you plan to run SiteScopemonitors.

l If smart card authentication is configured in APM and you want to integrate SiteScope with APM, you
must configure SiteScope smart card authentication to authenticate the APM client certificate. For
details, see Smart Card Authentication in the SiteScope Deployment Guide.

l On the BSM side:
o Make sure BSM has a valid System Availability Management license (inAdmin > Platform >

Setup and Maintenance > License Management), which is required to enable the SiteScope
integration.

o Check that System Availability Management is enable in the Server Deployment page (inAdmin
> Platform > Setup and Maintenance > Server Deployment); otherwise you will not see the
SAMmenu in BSM.

Note:When connecting SiteScope with APM 9.x, theHPOprInf, HPOprMss, HPOprOra, and
HPOprJEE content packs are required (they are installed by default, so you generally do not need to
do anything). If you do not have these content packs, you need to import them as described in "How
to Create andManage Content Packs" in the APM Platform Administration Guide in the APMHelp.

2. Download and install SiteScope (if not already installed)
In APM, navigate toAdmin > Platform > Setup and Maintenance, and click Downloads. Download
and save the SiteScope installation files (forWindows or Solaris) to a local or network drive.
Install SiteScope onmachines designated to run the SiteScope data collector. You can runmultiple
SiteScopes frommultiple platforms. For more information, see the Installing SiteScope section in the
SiteScope Deployment Guide.

3. Install the Operations Agent on the SiteScope server (required for sending
events and metrics to BSM's Operations Management)
The agent is required for displayingmetrics data in PerformanceGraphing in BSM's Operation
Management, and for sending events to APM for use in Operations Management (OMi).
Install Operations Agent 11.14 on the SiteScope server. For details, see Integrating SiteScope with
Operations Manager Products in the SiteScope Help. You can check the HPE Software Integrations site
for the latest version of this guide.

4. Connect the installed SiteScope with BSM
In APM, navigate toAdmin > System Availability Management, and add the SiteScope to SAM
Administration. For user interface details, see New SiteScope Page in the APM Application
Administration Guide in the APMHelp.
After the integration has completed successfully, the SiteScope Profile is added to the left pane in SAM
Admin. The profile status is blue (not up-to-date) because SiteScope has not yet sent any data or
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samples to BSM. In SiteScope, the BSM host is added toPreferences > Integration Preferences, and
the HP Integration Settings panel is displayed in themonitor Properties page.
l To change logging options, edit a specific monitor and select the relevant option in theHP Integration
Settings panel of themonitor Properties page. For details, see "HP Integration Settings" on page 253.
You can use theGlobal Search and Replace wizard to update the logging options on thosemonitors
created before the integration was established. For details on the wizard, seeGlobal Search and
ReplaceWizard in the APM Application Administration Guide in the APMHelp.

l Monitors created in SiteScope before registration to APM have their logging option set toDisable
reporting to BSM. After you configure SiteScope as a data collector reporting to APM, the default for
new monitors created in SiteScope is to log their monitoring data to APM.

Note:

o If you are working with a SiteScope that is not accessible to APM (for example in Software-
as-a-Service), the procedure for the connection includes creating an empty profile in SAM
Administration and creating an Integration Preference for BSM in SiteScope. For task details,
see "How to Configure SiteScope-APM Integration Preferences for Inaccessible Profiles" on
page 569.

o A SiteScope server can be integrated with one BSM server only. However, multiple
SiteScope servers can be integrated with a BSM server.

o Whenworking under high load, suspend all monitors before connecting to APM for the first
time.

5. Configure SiteScope to connect to a BSM server that requires a client
certificate or a secure connection (recommended for enterprise security)
If the APM server requires a secure connection, youmust perform the appropriate step below:
l For a APM server that requires a secure connection, see "How to Connect SiteScope to a BSM
Server That Requires a Secure Connection" on page 195.

l For a APM server that requires a client certificate, see Configuring SiteScope to Connect to a BSM
Server That Requires a Client Certificate in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

6. Change the Gateway Server to which SiteScope sends data - optional
You can change theGateway Server to which a SiteScope reports its data. Generally, this is only
applicable if you are working with a APM deployment with components installed onmore than one server.
l In SiteScope's APM Integration Preferences, enter the required Gateway Server name or IP address
in the Business Service Management machine name/IP address box. For user interface details,
see "BSM Integration Preferences" on page 567.

l In SAM Administration, update the SiteScope settings with the Gateway Server name inDistributed
Settings. For user interface details, see New/Edit SiteScope Page in the APM Application
Administration Guide in the APMHelp.

Note: This can only be used for changing the Gateway Server for a SiteScope that is already
registered with a given APM installation. It cannot be used to add a new SiteScope, or to connect
a SiteScope to a different APM system.
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7. Create a monitoring structure in SiteScope
a. Create groups and subgroups to organize themonitors to be deployed, and then createmonitors in

these groups. When configuringmonitors, verify that APM data logging and topology settings are set
as required.
For details on creating amonitoring structure, see the suggested workflows in "Configure SiteScope
for monitoring" on page 59.

b. Configure SiteScope to sendmetrics, events, and topology data to BSM.
In addition, SiteScope can also storemetrics data to the Operations Agent data store which is
installed on the SiteScope host, or in the profile database in BSM (when graphingmetrics data for
use in PerformanceGraphing in Operations Management).

Tip: The profile database in BSM is the recommended option, since it is amore robust and
scalable data source, and does not require configuration of the Operations Integration.

o Metrics and Topology (using the classic SiteScope-BSM Integration). For details, see "HP
Integration Settings" on page 253.

o Events and Metrics (using the Operations Agent or Profile DB in BSM). For details, see
Integrating SiteScope with HP Operations Manager Products in the SiteScope Help. You can
check the HPE Software Integrations site for the latest version of this guide.

8. Create relationships between SiteScope monitors and existing CIs in RTSM -
optional
You can create relationships to enable amonitor to pass HI status information to the CI to which it is
attached (even if that CI was not created from a topology forwarded by SiteScope):
l In SiteScope, you can customize the relationship between SiteScopemonitor CIs and existing CIs in
HP Integration Settings by manually selecting the CI type option when editing amonitor instance.
The CI type is defined by default for monitors of supported environments andmonitors that have a
defined topology. For task details, see "Select the CI type" on page 196.

l In SAM Administration, by using theMonitor Deployment Wizardwhich uses the existing CI
property data in RTSM to deploy SiteScopemonitors, groups, and remote servers. This creates in
RTSM amonitored by relationship between themonitored CI and the createdmonitor. For concept
details, seeMonitor Deployment Wizard in the APM Application Administration Guide in the APM
Help.

Once defined, the SiteScope and its groups andmonitors are added as CIs to RTSM and are
automatically attached to the relevant monitor views, from where they can be added to other views.
When editing amonitor in SAM Administration, you can associate themonitor with existing CIs usingHP
Integration Settings. For example, you can attach the CPU monitor to an existing logical CI
representing amachine whose CPU is beingmonitored.
The data from the SiteScope is available in Service Health and Service Level Management.

9. Map SiteScope metrics to indicators - optional
In SiteScope, you can addmappings for monitors that do not have default indicator metric mappings, or
modify settings for existingmappings (monitors of supported environments andmonitors that have
indicators mapped tometrics by default).
For task details, see "Map Indicators to metrics" on page 196.
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10. Assign permissions in BSM
In APM, navigate toAdmin > Platform > Users and Permission, and click User Management.
For each defined user, assign permissions to view SiteScope groups and their subgroups in SAM reports
and custom reports. For details, see the User Management Operations section in the APM Application
Administration Guide in the APMHelp.
For details on how permissions are applied, see Accessing SiteScope and Building Permissions Model in
the APM Application Administration Guide in the APMHelp.

11. Modify the connection settings - optional
After you have created the connection, you canmodify the settings either in SiteScope or in APM,
depending on the setting that you aremodifying.
l In APM, select Admin > System Availability Management. In the list of SiteScopes, right-click the
relevant SiteScope and select Edit SiteScope from the context menu. For user interface details, see
New/Edit SiteScope Page in the APM Application Administration Guide in the APMHelp.

l In SiteScope, open thePreferences context and select Integration Preferences. Edit the BSM
Integration Preference. For user interface details, see "BSM Integration Preferences" on page 567.

Tip:

o To secure the connection to APM (since the APM user name and password are not used for
authentication), it is recommended to configure either Basic Authentication in SiteScope or
use two-way SSL. If APM is configured to use Basic Authentication, the same user name and
password entered in theAuthentication user name andAuthentication password fields in
SiteScope are used for reporting both data and topology to APM. If APM is not configured to
use Basic Authentication, the credentials sent are ignored.

o To enable data to be compressed before being sent from the SiteScope server to APM, set _
topazCompressDataInGzip=true in the <SiteScope root
directory>\groups\master.config file. When enabled, SiteScopemonitor (ss_monitor_t) and
SiteScopemetric (ss_t) samples are compressed in gzip before being sent to APM (where it
is decompressed). Data compression can be used only when SiteScope is reporting to
BAC/APM 8.05 or later.

How to Configure SiteScope to Send Bulk Data to the
Run-Time Service Model
SiteScope results can be sent to APM’s Run-time ServiceModel (RTSM) either zipped or unzipped. The
request includes a parameter that indicates to RTSMwhether the results being sent are in zipped or unzipped
format.

To send SiteScope results in a zipped format:

1. Open the following file: <SiteScope root directory>\discovery\discovery_agent.properties.
2. Locate the line beginning appilog.agent.probe.send.results.zipped. If the line does not exist, add

it to the file.
3. Change the value to =true.
4. Restart SiteScope. SiteScope results are zipped before being sent to RTSM.
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How to Connect SiteScope to a BSM Server That
Requires a Secure Connection
This task describes the steps involved in enabling secure communication between SiteScope and APMwhen
the APM server requires a secure connection.

1. Prepare SiteScope to use a secure connection. For details, see the section on configuring SiteScope to
use a secure connection in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm).

2. Import the CA or APM server certificate into SiteScope using Certificate Management in the SiteScope
user interface. For task details, see "How to Import Server Certificates Using Certificate Management"
on page 461.

Note: Themachine name in the certificate must be a fully qualified domain name that is exactly the
same name (including case sensitive) as the one used in the New SiteScope page in System
Availability Management Administration.

3. In APM, select Admin > System Availability Management Administration, and click theNew
SiteScope button to add the SiteScope instance. In the New SiteScope page, make sure the following
settings are configured:
l Distributed Settings:Check that theGateway Server name/IP address contains the correct server
name and port (default 443).

l Profile Settings:Select theBSM Front End Use HTTPS check box (in versions of BSM earlier than
9.20, select theWeb Server Use SSL check box).

How to Configure Topology Reporting
Note: Only advanced users with a thorough knowledge of CIs and indicators should attempt to edit the
indicator mappings or to addmappings tometrics.

This task describes how to configure topology settings for monitors. It also describes how to select or modify
the CI type andmapmetrics to indicators.

1. Prerequisites
l If BSM requires a client certificate, youmust configure the topology discovery agent in SiteScope to
report topology to the APM server. For details, see Configuring the Topology Discovery Agent in
SiteScopeWhen BSM Server Requires a Client Certificate in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

l For SiteScope to forward the host topology along with monitor CI data to APM, theReport monitor
and related CI topology optionmust be selected under theHP Integration Settings panel in the
monitor properties. By default, this option is selected for monitors of supported environments and
monitors that have a CI type defined by default. For user interface details, see "APM Integration Data
and Topology Settings" on page 254.
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2. Select the CI type
Formonitors that report a topology by default (the default CI type associated with themonitor is
displayed in parenthesis in theCI type list), you can use the default selection, or override the selection
by modifying the CI type and entering key attributes.
For monitors that do not report a topology by default, select theCI type for themonitor in theBSM
Integration Data and Topology Settings section, and enter values for the CI type key attributes. For
the list of monitors that do not report a topology by default, see "Monitors Not Reporting Topology Data
By Default" on page 205.

Note: Formonitors where the CI type is per metric (for the list of monitors, see "Monitors Reporting
CI Per Metric" on page 206), the CI type cannot bemodified and CI key attributes are not displayed.

Tip: It is recommended to perform a resynchronization of SiteScope if APM is restarted within 10
minutes after making changes to amonitor's topology settings. To do so, select Preferences >
Integration Preferences > BSM Integration > BSM Preferences Available Operations, and
click Re-Synchronize.

For user interface details, see "APM Integration Data and Topology Settings" on page 254.

3. Map Indicators to metrics
When aCI type is selected, the table in the Indicator Settings section is filtered to show indicator
settings for the selected CI type. Monitors of supported environments andmonitors that have a defined
topology have indicators mapped tometrics by default. You can add new metric mappings or edit
settings for existingmappings.
For monitors that do not have default indicator metric mappings, you canmapmetrics to the appropriate
indicators for the CI type linked to themonitor. For the list of default indicator assignments, see Indicator
Mapping Alignment in the APM Application Administration Guide in the APMHelp.
For concept details, see "Assigning SiteScopeMetrics to Indicators" on page 186.
For user interface details, see "Indicator Settings" on page 258.

4. Select a preference for influencing BSM Service Health when events and
metrics are reported to BSM - optional
Since SiteScope events andmetrics can affect APM's Service Health, select the preference for
influencing Service Health when both data types are reported. Select the preference in theBSM Service
Health Preferences section of HP Integration Settings. For user interface details, see "BSM Service
Health Preferences" on page 261.
This preference is relevant only when:
l Both APM andOperations Manager integrations are active.

l TheOperations Manager event integration is connected to the APM server—not the HPOM server.

l The following settings are selected in themonitor's HP Integration Settings:

o In the APM Integration Data and Topology Settings section: Enable reporting monitor status
and metrics orEnable reporting monitor status and metrics with thresholds.

o In the HP Operations Manager Integration Settings section: Send events.
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Note:

l The preference can also be set globally for each newly-createdmonitor in Integration
Preferences > HP Operations Manager Integration > HP Operations Manager Integration
Main Settings by selectingPrefer events over metrics in BSM Service Health (global
preference). For user interface details, see "HP Operations Manager IntegrationMain Settings"
on page 579.

l Formore information on choosing which preference to use, see Integrating SiteScope with
Business ServiceManagement Applications.

5. Results
After configuring the topology settings click Save. SiteScope creates a CI for themonitor in RTSM and
forwards monitor CI data to APM.

How to Configure Topology Reporting for a Custom
Monitor
This task describes how to configure topology settings, select or modify the CI type, andmapmetrics to
indicators for a custommonitor type.

1. Prerequisites
If BSM requires a client certificate, youmust configure the topology discovery agent in SiteScope to
report topology to the APM server. For details, see Configuring the Topology Discovery Agent in
SiteScopeWhen BSM Server Requires a Client Certificate in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

2. Select the CI type
In theBSM Integration Data and Topology Settings section of HP Integration Settings, configure
the topology reporting settings that define how SiteScope reports CIs to BSM.
You can report the following types of CI topology data:
l User-defined CI type topology. In theCI type list, select a CI type and define the key attribute
values for the selected CI type. For details on key attribute values, see "<CI type key attributes>" on
page 258.

l Custom topology script. Select theCustom topology setting option, and create the topology
script which defines how to report CIs to BSM. Only select this option if you are familiar with the
Jython language, because youmust create the topology script in Jython yourself. For task details,
see "How to Configure Custom Topology for a CustomMonitor" on page 199.

l If you do not want to report topology for themonitor, you can choose to report themonitor CI only. In
theCI type list, select Default(None). This is the default setting.

Note: If you do not want to report topology for a custommonitor, but you want to map its metrics
to CIs with a custom CI hint andmapmetrics to indicators in the user interface, youmust perform
the following:
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i. Select theCustom topology setting option.
ii. In theData Processing Script box, enter the following (empty) script:

from java.lang import *
from java.util import *
from appilog.common.system.types.vectors import ObjectStateHolderVector
from appilog.common.system.types import ObjectStateHolder

def DiscoveryMain(Framework):
OSHVResult = ObjectStateHolderVector()
return OSHVResult

For user interface details, see "APM Integration Data and Topology Settings" on page 254.

3. Map Indicators to metrics
Map indicators to metrics for the selected CI type.
l When aCI type is selected, the table in the Indicator Settings section is filtered to show indicator
settings for the selected CI type. You can add new metric mappings or edit settings for existing
mappings.

l WhenCustom topology setting is selected, configure the indicator mappings using the HIs you
used in your HI assignment (see "Define an HI Assignment" on the next page).
Unlike for regular monitors, the CI Type can be edited in Indicator Settings when creating a custom
topology script for a custommonitor. When adding an indicator setting, select the CI type from theCI
Type list, and SiteScope displays the appropriate indicators for the CI type.

Note: Do not definemore than one indicator mapping with different CI types that match the same
metric.

l WhenCI typeDefault(None) is selected, indicator mappings are not available.

For concept details, see "Assigning SiteScopeMetrics to Indicators" on page 186.
For user interface details, see "Indicator Settings" on page 258.

4. Select a preference for influencing BSM Service Health when events and
metrics are reported to BSM - optional
Since SiteScope events andmetrics can affect APM's Service Health, select the preference for
influencing Service Health when both data types are reported. Select the preference in theBSM Service
Health Preferences section of HP Integration Settings. For user interface details, see "BSM Service
Health Preferences" on page 261.
This preference is relevant only when:
l Both APM andOperations Manager integrations are active.

l TheOperations Manager event integration is connected to the APM server—not the HPOM server.

l The following settings are selected in themonitor's HP Integration Settings:

o In the APM Integration Data and Topology Settings section: Enable reporting monitor status
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and metrics orEnable reporting monitor status and metrics with thresholds.
o In the HP Operations Manager Integration Settings section: Send events.

Note:

l The preference can also be set globally for each newly-createdmonitor in Integration
Preferences > HP Operations Manager Integration > HP Operations Manager Integration
Main Settings by selectingPrefer events over metrics in BSM Service Health (global
preference). For user interface details, see "HP Operations Manager IntegrationMain Settings"
on page 579.

l Formore information on choosing the preference to use, see Integrating SiteScope with BSM in
the Integration with BSM andHPOM Best Practices Guide.

5. Results
After configuring the topology settings click Save. SiteScope creates the topology according to your
definition, and forwards monitor data to APM.

How to Configure Custom Topology for a Custom
Monitor
This task describes the steps involved in creating a custommonitor with a custom topology script.

1. Change the CI Resolver TQL (only if SiteScope is connected to a version of
BSM earlier than 9.20)
a. In APM, select Admin > Platform > Infrastructure Settings.

o Select Applications.
o Select End User/System Availability Management.
o In theEnd User/System Availability Management - SiteScope CI Resolver Settings, check

if the value of the TQL Queries parameter is CIs Monitored by SiteScope. If it is, change it to
OMiAutoView.

b. Restart APM to apply the change.

Note: This TQL does not support models with a large number of CIs (it may cause performance
problems in suchmodels).

2. Define an HI Assignment
You need to define an HI assignment that will assign the HI to a CI. The assignment also defines which
data samples will be captured by this HI and which business rule will be used to calculate the status of
the HI according to the data samples.
For more information on HI assignments in Service Health, see "Health Indicator Assignments Page" in
the APM Application Administration Guide in the APMHelp. For more information on HI assignments in
SLM, see "Health Indicator Assignments Page" in the APM Application Administration Guide in the APM
Help.
To define an HI assignment:
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a. In APM, select Admin > Service Health / Service Level Management > Assignments > Health
Indicator Assignments.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to report from your
topology script. The assigned indicators for the CI type are displayed in the Indicators pane. When
you select an indicator, its details are displayed in the right pane.

c. Create a new HI assignment. For details on how to create the assignment, see "How to Define a KPI
or HI Assignment" in the APM Application Administration Guide in the APMHelp.
o In theMonitored By property in theCondition area, enter a value that enables you to distinguish

between the CIs reported by this monitor and CIs of the same type which are reported by other
monitors. The condition of the assignment should correspond with the CIs you report in the
topology script (see "Create the custom topology script" on page 204).

Tip: It is recommended that the CI has the value "SiteScope" in theMonitored By property,
and that it has a unique value to enable you to differentiate between this CI and CIs of the
same type reported by other monitors. For this purpose, we recommend using theNote
property of the CI.

o When you create the topology script for themonitor, enter the monitored_by attribute with this
value on the CI you report. For more details on topology scripts, see "Create the custom topology
script" on page 204.

o Choose the business rule to use for the HI calculation. We recommend using theSiteScope
Worst Status Rule. You can also use theSiteScope Consecutive Worst Status Rule or
SiteScope Best Status Rule.

o In the selector, enter the following:

l eti_id = (Binary) <<Health Indicator Type ID>>

l ci_id = (Binary) <<CI ID>>

l sampleType = (String) ss_t

The custommonitor sends metrics samples (ss_t) that contain the same eti_id as the HI used in
the assignment, and the sameCI ID as the CI's.

Example: Indicator assignment for CI Type Computer in Service Health
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Example: Indicator configuration and selector settings in Service Health

3. Define the custommonitor
In SiteScope, create the custommonitor and add the required data for themonitor settings in theMain
Settings, Advanced Settings, and Timeout Settings sections. You can choose from the following custom
monitors: CustomMonitor, Custom DatabaseMonitor, Custom Log File Monitor, CustomWMI Monitor.
For details on configuring thesemonitors, see the SiteScopeMonitor ReferenceGuide.
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Example:Settings for a Custom Log File monitor

The complete strings used in the example are:
Content match: /([a-z])=([0-9]+),*([a-z])*=*([0-9]+)*,*([a-z])*=*([0-9]+)*,*([a-z])*=*([0-9]+)*,*([a-z])*=*
([0-9]+)*/
Match value labels: disk1,val1,disk2,val2,disk3,val3,disk4,val4,disk5,val5

4. Create the data processing script
In the Data Processing Script section of the CustomMonitor Settings panel, enter the script for
processing the collected data.
In the script, supply the CI resolution hint for the different metrics by using setCIHintmethod. For an
explanation on the format to use for the hint, see "CI Resolution Hint Formats" on page 333.

Note: An example data processing script is available in a text file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and select Custom_Monitor_
Data_Processing_Script.txt.

When working in templatemode with a template containing a custommonitor with the example data
processing script, you also need to define a variable SERVER_NAME. When deploying the
template, you need to enter a value for the server name.
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5. Create the custom topology script
In the HP Integration Settings panel, create the topology script that defines how to report CIs to BSM.
a. In the BSM Integration Data and Topology Settings section, select theCustom topology script

option and develop a custom topology script that reports the CIs defined in the HI assignment.

For the monitored_by attribute of the CI, youmust enter SiteScope. This is the same value you
used in the HI assignment in "Define an HI Assignment" on page 199.

Note: An example custom topology script is available in a text file attached to this PDF. To view
the attachment, select View > Navigation Panels > Attachments, and select Custom_
Monitor_Topology_Script.txt.

In the example, you need to replace <IP Address>, <name>, and <Server DNS name>with the
relevant values.

Tip: It is recommended to perform a resynchronization of SiteScope if APM is restarted within
10minutes after making changes to amonitor's topology settings. To do so, select Preferences
> Integration Preferences > BSM Integration > BSM Preferences Available Operations,
and click Re-Synchronize.

b. In the Indicator Settings section, configure the HI mappings using the HIs you used in the HI
assignment in "Define an HI Assignment" on page 199.

Note: Do not definemore than one indicator mapping with different CI types that match the
samemetric. For details on defining indicator mappings in SiteScope, see "Map Indicators to
metrics" on page 196. Alternatively, you can define themappings in APM inAdmin > System
Availability Management > Metrics and Indicators and click Publish Changes. The
mappings are then downloaded to SiteScope and displayed in the user interface. For details on
definingmappings in APM, see How to Create andManage Indicator Assignments in the APM
Application Administration Guide in the APMHelp.

Example: Indicator Mappings for Computer CI Type

6. View Results
After you have configured the HI assignments in APM and themonitor settings including the topology
script in SiteScope, you can run themonitor. After themonitor run has finished,you can view the results
in APM's Service Health.
We recommend creating a view that shows the reported CIs for this monitor. After you save themonitor
and themonitor has run, you can see the results in APM's Service Health in the view that you created.

Example:View Created for CIs Reported for this Monitor in Service Health
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Example: Indicator Status Results on theMonitoredMachine in Service Health

Monitors Not Reporting Topology Data By Default
Following is a list of monitors that do not monitor the status of a host or server.

Note: For thesemonitors to report CI information to APM, youmust select the CI type, enter the required
CI key attributes, and select an indicator relevant for the CI type linked to themonitor. For task details,
see "How to Configure Topology Reporting" on page 195.

l Composite Monitor
l Custom Log/Database/WMI Monitors
l Directory Monitor
l Dynamic JMX Monitor (when not monitoringWebLogic)
l e-Business TransactionMonitor
l File Monitor
l Formula Composite Monitor
l HP NonStop Event LogMonitor
l JMX Monitor (when not monitoringWebLogic)
l Link Check Monitor
l Log File Monitor
l Multi LogMonitor
l Script Monitor
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l SNMP TrapMonitor
l SyslogMonitor
l URLMonitor
l URLContent Monitor
l URL List Monitor
l URLSequenceMonitor
l XMLMetrics Monitor

Monitors Reporting CI Per Metric
Following is a list of monitors that report CI per metric. Because thesemonitors havemultiple CIs, you cannot
modify the CI for thesemonitors and you canmodify the indicator mappings for thesemonitor types from APM
only (in theSAM Admin > Metrics and Indicators tab).

l SAP CCMS Monitor
l SAPWork Processes Monitor
l Siebel Application Server Monitor
l Siebel Web Server Monitor
l Solaris Zones Monitor
l VMware Host CPU Monitor
l VMware Host Memory Monitor
l VMware Host Network Monitor
l VMware Host StateMonitor
l VMware Host StorageMonitor
l VMware PerformanceMonitor

Note: You can define a custom topology Node for themonitor and specify a host name for it. If there is a
remote server in any SiteScope connected to this APM, this CI is automatically changed toUnix or
WindowsCI type, depending on the environment of the remote server.
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Chapter 20: Integrating with HP Load Testing
Products
Performancemetrics collected by SiteScope can be utilized by load testing analysis products and solutions,
for example, by LoadRunner and Performance Center. When running a load testing scenario, it is sometimes
necessary to correlate the behavior of the application under test with various software and hardware
performancemetrics available from the system where the application is running.

Learn About
This section includes:

l "Supported SiteScope Installations/License Editions" below
l "Supported LoadRunner/Performance Center Versions" below
l "Differences Between SiteScope and SiteScope for Load Testing" below

Supported SiteScope Installations/License Editions
The integration with LoadRunner or Performance Center is supported using either:

l A regular SiteScope installation, using the Premium, Ultimate, or System Collector edition license.
l A SiteScope for Load Testing installation, using the SiteScope for Load Testing license. This is a free,
non-IP locked license, that is instantly activated after a SiteScope for Load Testing installation. This
license provides a limited capacity of 25 OS instances and 25 URLs.

For details on SiteScope editions and licensing, see the SiteScope Editions and SiteScope Licensing
sections of the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

Supported LoadRunner/Performance Center Versions
For the list of supported LoadRunner and Performance Center versions supported in this release, refer to the
HP Integrations site:

l LoadRunner: https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01695208

l Performance Center: https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01695224

Note: Access requires an HP Passport login (register for an HP Passport at
http://h20229.www2.hp.com/passport-registration.html).

Differences Between SiteScope and SiteScope for Load Testing
When using LoadRunner or Performance Center, you can choose a performance data collection option
through a native solution available in the products or through SiteScope. In a variety of cases, SiteScope
provides moremonitoring options and deeper performance coverage of systems and applications.
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SiteScope for Load Testing is an installation option of SiteScope which is optimized for load testing scenarios
and provided for LoadRunner and Performance Center users. This installation type is not meant to monitor
production environments. As a result, some options which are available in a regular SiteScope installation are
not available in SiteScope for Load Testing.

Themain differences between regular SiteScope and SiteScope for Load Testing are:

Description
SiteScope for Load
Testing SiteScope

Minimum run frequency for SiteScope
monitors

1 second* 15 seconds

Default run frequency (available when a new
monitor is created)

5 seconds* 10minutes

SiteScope Reports Not available Available

Analytics Not available Available

Integration with APM Not supported Supported

*TheMinimum run frequency for SiteScope for Load Testingmonitors and the default run frequency apply
only for API executions.

Note: The integration between SiteScope and LoadRunner or Performance Center should be configured
in the respective load testing product and not in SiteScope. For more information, see "How to Set Up the
Monitoring Environment -Workflow", "ConfiguringMonitors User Interface", and "SiteScope Resource
Monitoring" in the HP LoadRunner Controller User Guide, and "Adding Hosts" in the HP Performance
Center Administrator Guide.

Tips/Troubleshooting
l To enable SiteScope to integrate with LoadRunner, user authenticationmust be disabled in SiteScope. For
details, see "User Management Preferences" on page 625.

l To use LoadRunner or Performance Center with a regular SiteScope installation, youmust set the value
forMinimal monitor run interval (seconds) inPreferences > Infrastructure Preferences > Server
Settings to 1 (second) to avoid frequency validation errors.

l Integration between SiteScope for Load Testing and BSM is not supported.
l The DashboardMonitor History view is not supported in SiteScope for Load Testing.
l The integration between SiteScope and LoadRunner does not support user authentication when using a
version of LoadRunner earlier than 12.00.
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Chapter 21: Integrating with Application
Lifecycle Management
You can export SiteScope related data from APM to Application Lifecycle Management (ALM) and vice versa.
Exporting data to ALM enables you to plan scripts and load tests that resemble your production environment,
and importing data from ALM enables you to use scripts and SiteScope configurations that have already been
tested.

To access
In APM, select Admin > Integrations > Application Lifecycle Management Integration.

Learn About
This section also includes:

l "Export Data from APM (SiteScope) to ALM" below
l "Import Data from ALM to APM (SiteScope)" below

Export Data from APM (SiteScope) to ALM
You can export SiteScope configuration data for a single application. The exported data includes information
about the SiteScopemetrics, templates, and topology data. Sharing such information between operations and
development assists you in planning your scripts and load tests in ALM, so that they better resemble your
production environment.

Import Data from ALM to APM (SiteScope)
You can import data from ALM that includes SiteScope configuration templates. Sharing such information
between development and operations enables you to use SiteScope configurations that have already been
tested and fine tuned. Imported SiteScope configuration templates are stored in the SiteScope template tree
for each SiteScope registered to APM. A default directory calledAutoSyncContainer is created in the
SiteScope root folder, and for each application for which a template is imported, a sub-directory is created
with the application name.

Tasks
How to export data from APM to ALM
For details, see the Application Lifecycle Management Integration page in the APM Application Administration
Guide in the APMHelp.

How to import data from ALM to APM (SiteScope)
1. Prerequisites

l The SiteScope Administrator user must be configured with a user name and password (it cannot be
left blank).

HPE SiteScope (11.33) Page 209 of 1206



l The passphrase string for all HPE software applications integrated using LW-SSOmust be identical.
Make sure that LW SSO Init String in SiteScopePreferences > General Preferences > LW SSO
Settingsmatches the string in APM.

2. In Performance Center, design and create a performance test. For details, refer to the task on how to
design a performance test in the HP ALM Performance Center User and Administrator Guide.

3. Import the .zip file from ALM that includes the SiteScope configurations
a. In APM, select Admin > Integrations > Application Lifecycle Management Integration >

Import from ALM.
b. In theSelect File box, enter the path to the .zip file you want to import, or click Browse to open a

dialog box in which you can browse to the required .zip file.
For details on creating the .zip file for importing, refer to the ALM documentation.

c. Click Upload Content to upload the content of the selected .zip file. The upload status is displayed.

Note:

l If you previously imported data from ALM, the data is deleted and replaced with the latest .zip file.
To avoid losing changes made to previously imported templates, rename the templates to avoid
these changes being lost.

l If you have already deployedmonitors from synchronized templates and then import another .zip
package that does not contain the necessary templates, thesemonitors will be unlinked from the
templates that should be deleted.

For more details, see the Application Lifecycle Management Integration page in the APMHelp.
4. Edit and publish changes to templates in SiteScope - optional

Imported SiteScope configuration templates are copied to the following location within each SiteScope
registered to APM:
Templates > SiteScope root folder > AutoSyncContainer > < application name>
You canmake changes to the templates, andmanually deploy the templates. For details on deploying
templates, see "Deploy Templates" on page 721.

Tip: It is recommended to rename any imported templates that youmodify in order to avoid these
changes being overwritten the next time data is imported from ALM.

You can also publish changes to templates using the Publish Template Changes Wizard. For details, see
"Publish Changes to Templates" on page 745.
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Part 4: Monitors and Groups
Group containers help you organize themonitor instances that you create. Monitor instances that you create
must be added within a SiteScopemonitor group container. For details, see "Create Groups in SiteScope" on
page 212.

SiteScopemonitors are tools for automatically connecting to and querying different kinds of systems and
applications used in enterprise business systems. The different monitor types provide the generic capabilities
for performing actions specific to different systems. You create one or more instances of amonitor type to
instruct SiteScope how tomonitor specific elements in your IT infrastructure. For details, see "Create
Monitors in SiteScope" on page 218.

You can create custommonitors to broaden the capabilities of regular SiteScopemonitors by developing your
own solutions for environments that are not supported by predefined SiteScopemonitors. For details, see
"Create CustomMonitors" on page 273.

You can create baselines and schedule specific thresholds based on a time period or date. Baselines enable
you to understand how your applications typically perform and determine whether a performance problem is an
isolated incident or a sign of a significant downward performance trend. For details, see "Set Monitor
Thresholds Using a Baseline" on page 279.

You can also configure thresholds based on calculatedmetrics—ametric produced by performing an
arithmetic function or logical operation on existing SiteScopemetrics. For details, see "Create Calculated
Metrics" on page 308.

SiteScope provides various dynamic monitors that automatically update themselves over time by adding and
removing counters as changes occur in your IT environment. For details, see "Dynamic Monitoring
Mechanism" on page 318.

SiteScope also includes the capability to monitor XML documents. For details, see "Monitor XML
Documents" on page 321.

Tip:

l For details onmonitor settings for a specific SiteScopemonitor, including supported versions and
platforms, and a list of counters or metrics that can be configured for themonitor, see themonitor type
in the SiteScopeMonitor ReferenceGuide.

l You can also use the SiteScope API when working with monitors. For details, see "SOAP-based
APIs" on page 139.



Chapter 22: Create Groups in SiteScope
You create group containers tomake the deployment of monitors and associated alerts manageable and
effective for your environment and organization. It is also useful to groupmonitors that should generate similar
alerts.

To access
Select theMonitors context. In themonitor tree, right-click the SiteScope container or an existingmonitor
group, and select New > Group.

Learn About
This section includes:

l "SiteScopeGroups Overview" below
l "Copying or Moving Existing Groups" below
l "Creating Group Alerts and Reports" on the next page

SiteScope Groups Overview
You create groups that reflect your environment, and for organizing your monitors in SiteScope. A group is a
collection of one or moremonitors. It might contain several of one type of monitor, such as URLmonitors, or
several different monitors that track a specific part of yourWeb environment, such as aWeb server, URL, and
network parameters related to a specific transaction.

Each SiteScopemonitor instance that you createmust belong to a SiteScope group, either a top level group or
a subgroup nested within other group containers.

For example, if you intend tomonitor a large number of processes running on your system, youmay want all of
them to be in a single group namedProcesses. If you aremonitoring processes on several machines using
remotemonitors, you could create a primary group calledProcesseswith several subgroups named after
each of the remotemachines that you aremonitoring.

When you add a new monitor you either add it to an existing group, or youmust first create a group for it. You
can add groups individually to SiteScope, or you can deploy groups along with multiple monitors by using
templates. For details on templates, see "Create Templates" on page 667.

You can perform mass operations on group objects using theManageGroups andMonitors feature. This
enables you to perform move, copy, delete, runmonitors in group, enable/disable monitors, and
enable/disable associated alert actions onmultiple SiteScope objects. For details, see "Perform Actions on
Multiple Groups andMonitors" on page 73.

Note: You can also use the SiteScope API when working with groups. For details, see "SOAP-based
APIs" on page 139.

Copying or Moving Existing Groups
In addition to creating groups, you can copy or move existing groups to a new location within the SiteScope
tree. Copying or moving a group duplicates the configuration settings for the group and all monitors within the
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group. After copying or moving a group, you normally need to edit the group and the configuration properties for
each individual monitor within the group to direct themonitors to a unique system or application. Otherwise,
themonitors in the group duplicate themonitoring actions of the original group.

Tip: Instead of copying groups which can lead to redundant monitoring, use templates tomore efficiently
replicate common group andmonitor configuration patterns. For more information about working with
templates, see "Create Templates" on page 667.

Note:

l To avoid group identity problems within SiteScope, object names must be unique within the parent
group. If you copy or move a group to another group in which there is group with exactly the same
name, SiteScope automatically adds a suffix (number) to the end of the copied/moved group's name.

l You cannot move or copy amonitor group to its subgroup.

Creating Group Alerts and Reports
After creating a group, you can create alerts and reports for the group. By default, group alerts and reports are
associated with all monitors within the group.

You create an alert by adding an alert definition to a group container. This means that when any onemonitor in
the group reports the status category defined for the alert (for example, error or warning), the group alert is
triggered. You can configure a group alert to exclude one or more of themonitors in the group by using the
Alert targets selection tree. For details on this topic, see "Configure SiteScope Alerts" on page 1072.

You create a group report by adding a report definition to a group container. You can configure a group report to
exclude one or more of themonitors in the group by using theMonitors and groups to report on selection
tree. For details on this topic, see "Reports" on page 1138.

If you delete a group, SiteScope removes the applicable monitor actions and disables any alert actions
associated with the group.

Tasks
How to Manage a Group

1. Create SiteScope groups and subgroups
Create groups according to themonitor hierarchy which you want to implement. For example, you can
create groups of locations, server types, network resources, and so forth.
l Create a new group. Right-click the SiteScope or group container in which to create the group, and
select New > Group. For user interface details, see the UI Descriptions section below.

l Create a group by copying or moving an existing group.

o Right-click the group you want to copy, and click Copy. Right-click the location in themonitor tree
where you want to copy the group container, and click Paste.

o Right-click the group you want to move, and click Cut. Right-click the location in themonitor tree
where you want to move the group container, and click Paste.

o To copy or movemultiple monitors and groups to a target group, click theManage Monitors and
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Groups button in themonitor tree toolbar. Select the objects for copying or moving and click
Copy/Cut. Select the destination group and click Paste. For details, see "Perform Actions on
Multiple Groups andMonitors" on page 73.

2. Add URL links to group descriptions - optional
You can add additional information to describe a group, and include HTML tags for hyperlinks to enable
you to access URLs from the SiteScope Dashboard.
a. To add a hyperlink, open the Properties tab for the selected group.
b. Expand theGeneral Settings panel and enter the URL in theGroup description field. For example,

<a href="http://www.hp.com">My Link</a>.
c. Click theDashboard tab. A URL is displayed in theDescription field for the selected group. To

open the URL, click the group's Description field, and then click the link.

Tip: To automatically adjust the row height to make all cell contents visible in the Dashboard,
select theWrap text option in Dashboard Settings. For details, see "Dashboard Settings Dialog
Box" on page 900.

3. Create monitor instances
Select themonitor instances you want to add to the group.
For task details, see "How to Create and Deploy aMonitor" on page 226.

4. Set group dependencies - optional
You can set group dependencies tomake the running of monitors in this group dependent on the status of
another monitor.
For concept details, see "Monitoring Group Dependencies" on page 221.

Example: Themonitors in the group being configured run normally as long as themonitor selected in
theDepends on box reports the condition selected in theDepends condition box. In this example,
the group being configured is enabled only when theServicemonitor reports a status of Good.

5. Set up group alerts - optional
Create alerts to send notification of an event or change of status in some element or system in your
infrastructure.
To create an alert for the group, right-click the group and select New > Alert. For each alert scheme, you
can create one or more alert actions. In the New Alert dialog box, click New Alert Action to start the
Alert Action wizard.
For task details, see "How to Configure an Alert" on page 1076.

6. Set up group reports - optional
Create reports to display information about how the servers and applications you aremonitoring have
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performed over time.
To create a report for the group, right-click the group and click Reports. Select a report type and
configure the report settings.
For task details, see "Create SiteScope Reports" on page 1139.

7. Results
Themonitor group, including its monitors, alerts, and reports, is added to themonitor tree.

UI Descriptions
New SiteScope Group Dialog Box
The New SiteScopeGroup dialog box enables you to define a new group for SiteScope, or a subgroup for an
existingmonitor group.

Important
information

l Only a SiteScope administrator user, or a user granted the appropriate permissions can
edit, refresh, or disable groups. For details on user permissions, see "Permissions" on
page 636.

l You cannot delete amonitor group if it has dependent alerts or reports at the container
level. To delete amonitor group with dependencies, youmust remove themonitor group
from Alert Targets andReport Targets for each dependency, and then delete the
monitor group. You can deletemonitor groups that have dependencies at the child level.

l You can also use the SiteScope API when working with groups. For details, see "SOAP-
based APIs" on page 139.

The following elements are found throughout the New SiteScopeGroup dialog box:

General Settings

UI Element Description

Group
name

Name that describes the content of the group, or the purpose of themonitors added to the
group. For example, <host_name> or <business_unitresource_name> or <resource_
type>.

Note:

l The group name cannot contain any of the following characters: ` ; "& | < > / \ +
l The group name is case sensitive. This means that you can havemore than one group
with the same name provided they each have a different case structure.
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UI Element Description

Group
description

Description of the group. This can include themost commonHTML tags for text styling,
such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed only when
viewing or editing the group's properties in the SiteScope Dashboard. For details on adding a
hyperlink, see "Add URL links to group descriptions - optional" on page 214.

Note:

l This field does not support JavaScript/iframes/frames or other advanced features. HTML
code entered in this box is checked for validity and security, and corrective action is
taken to fix the code (for example, code is truncated if it spans more than one line). If
malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:
l Tags: script, object, param, frame, iframe.

l Any tag that contains an attribute starting with on is declined. For example, onhover.

l Any attribute with javascript as its value.

l If the field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.

Source
template

Displays the path of the source template if the group was created from a template. If you are
using deployed templates created in older versions of SiteScope, enables you tomanually
associate the root groups with the source template by entering the path of the source
template.

Clear Removes the source template associated with the root group.

Dependencies

UI
Element Description

Depends
on

Themonitor on which you want to make the running of this monitor group dependent.

Click theDepends on button to open the Select Depends OnMonitor dialog box, and
select themonitor on which you want to create a dependency. For user interface details, see
"Select Depends OnMonitor Dialog Box" on page 270.

For concept details, see "Monitoring Group Dependencies" on page 221.

Default: No dependency is set for amonitor group.

Depends
condition

TheDepends condition that theDepends onmonitor should have for the current monitor
group to run normally. If the selected condition is not satisfied then themonitor selected in the
Depends on box is automatically disabled. The conditions are:

l Good
l Error
l Available
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Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope, this
section appears but is empty. If tags have been created, they are listed here and you can select
them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.
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Chapter 23: Create Monitors in SiteScope
SiteScope collects data samples from components in your infrastructure using out-of-the-box monitors and
custommonitors. These are tools that connect to and query different kinds of systems and applications. You
configuremonitors to collect the data from remote servers you want to monitor.

To access
Select theMonitors context. In themonitor tree, right-click a group and select New > Monitor.

Learn About
This section includes:

l "Monitor Types" below
l "Monitoring Remote Servers" on page 220
l "Monitoring Group Dependencies" on page 221
l "Setting Status Thresholds" on page 223

Monitor Types
SiteScopemonitors are grouped according to classes that indicates their availability and category that reflect
their function. When you select to add a new monitor to a SiteScope agent, the list of available monitor types
for that agent are displayed both alphabetically and divided by category in the product interface. The
availability of themonitor category is dependent on the class of monitor.

Note: User permissions and credentials are needed to access eachmonitor. For details on the required
permissions and credentials, and the corresponding protocol used by eachmonitor, seeMonitor
Permissions and Credentials in the SiteScopeMonitor ReferenceGuide.

This section describes themonitor classes and the category listing formats. To see the list of monitors
contained in eachmonitor category, see "Monitor Categories List" on page 231.

Standard Monitors
Standardmonitor categories represent themonitor categories available with a general SiteScope license.
Thesemonitor categories includemany of the general purposemonitor categories.

l Application Monitors. Monitors in this category monitor third-party applications. Thesemonitors enable
SiteScope to access and retrieve data from themonitored applications.

l Big Data.Monitors in this category monitor Big Data platforms to gain real-time visibility and insight into
the health and performance of the big data infrastructure.

l Database Monitors.Monitors in this category monitor different types of database applications. There are
monitors that access data from specific database applications and generic monitors that can be configured
tomonitor any database application.

l Generic Monitors. Monitors in this category monitor different types of environment. Thesemonitors can
monitor networks, applications, and databases depending on how they are configured.

HPE SiteScope (11.33) Page 218 of 1206



l Media Monitors.Monitors in this category monitor applications that play media files and stream data.
l Network Monitors.Monitors in this category monitor network health and availability.
l Server Monitors. Monitors in this category monitor server health and availability.
l Virtualization and Cloud Monitors.Monitors in this category monitor virtualized environments and
cloud infrastructures.

l Web Transaction Monitors.Monitors in this category monitor web-based applications.

Customizable Monitors
Custommonitors broaden the capabilities of regular SiteScopemonitors for tracking the availability and
performance of your infrastructure systems and applications. Using custommonitors, you can develop your
own solutions for environments that are not supported by predefined SiteScopemonitors.

You can create your ownmonitor that collects data, and define a script that processes the collected data and
creates metrics. Each time the custommonitor runs, it updates themetrics and returns a status for the
metrics defined in the script.

Custommonitors can be published to the HPE Live Network for sharing with other SiteScope users. For more
details on using Custommonitors, see "Create CustomMonitors" on page 273.

Dynamic Monitors
Dynamic monitors automatically adjust the SiteScopemonitoring configuration based on changes that are
happening in your IT environment.

SiteScope provides various dynamic monitors that automatically update themselves over time by adding and
removing counters and thresholds as virtual machines move from one host system to another. In addition,
baselining is supported, where thresholds are dynamically changed based on historical monitoring data.

Dynamic monitors include:

l Dynamic Disk SpaceMonitor
l Dynamic JMX Monitor
l Generic Hypervisor Monitor
l HadoopMonitor
l HP Vertica JDBC Monitor
l KVMMonitor
l VMware DatastoreMonitor
l VMware Host Monitors

Integration Monitors
Integrationmonitors are used to capture and forward data from third-party domainmanagers or applications
(typically EnterpriseManagement Systems (EMS)) into BSM.

Thesemonitor types require additional licensing andmay only be available as part of another HPE product.
For more information about IntegrationMonitor capabilities, see "IntegrationMonitors Overview" on page 324.

Solution Template Monitors
Solution templatemonitor types are a special class of monitors that enable new monitoring capabilities for
specific applications and environments. As part of a solution template, thesemonitor types are deployed
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automatically together with other, standardmonitor types to provide amonitoring solution that incorporates
best practice configurations. After deploying solution templates, you can edit or delete them using the same
steps as with other monitor types. For more information, see "Deploy Solution Templates" on page 762.

SiteScope provides the following solution templates that include standard SiteScopemonitor types and
solution-specific monitors:

l Active Directory (with and without Global Catalog)
l AIX Host
l Apache Cassandra
l Apache Tomcat
l Hadoop
l HP Quality Center
l HP ServiceManager
l HP Vertica
l JBoss Application Server
l Linux Host (OS )
l Microsoft Exchange
l Microsoft IIS Server
l Microsoft Lync Server
l Microsoft SharePoint
l Microsoft SQL Server
l Microsoft Windows Host
l .NET
l Oracle Database
l SAP Application Server
l Siebel Application/Gateway/Web Server (for UNIX andWindows)
l VMware Capacity Management
l VMware Host CPU/Memory/Network/State/Storage
l VMware Host For Performance Troubleshooting
l WebLogic Application Server
l WebSphere Application Server

Monitoring Remote Servers
The requirements for monitoring services and applications that are running on remote servers vary according
to the application and network policies in your environment. Some SiteScopemonitors use Internet protocols
to test Web systems and applications. Other SiteScopemonitors use network file system services and
commands tomonitor information on remote servers.

For information about how SiteScopemonitors connect to remote systems, see "How to Configure SiteScope
toMonitor a RemoteMicrosoft Windows Server" on page 402 and "Configure SiteScope toMonitor Remote
UNIX Servers" on page 420.
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Monitoring Group Dependencies
To prevent redundant alerting frommultiple monitors that aremonitoring different aspects of a single system,
select onemonitor to check the basic availability of the system and then create other monitors that perform
more detailed tests of that system. This creates a dependency relationship that enables you tomake the
running of amonitor group dependent on the status of a selectedmonitor.

When creating dependencies in templates, you can enter the full path or a relative path to a dependent monitor
in the Dependencies panel. You can also have SiteScope ignore dependency changes when publishing
template changes.

For information about configuring dependency settings, see "Depends On" below and "Depends Condition" on
the next page.

Depends On
You can use this option tomake the running of amonitor dependent on the status of another monitor. This can
be used to prevent redundant alerting frommultiple monitors that aremonitoring different aspects of a single
system. You can create a simple systemmonitor to check the basic availability or heartbeat of a system, and
then create other monitors that perform more detailed tests of that system. The figure below shows an
example dependency relationship where three systemmonitors have beenmade dependent on a Service
Monitor instance.

You canmake the detailed test monitors dependent on the status of the heartbeat monitor by selecting that
monitor. This means the dependent monitors run as long as the dependency condition is satisfied. If the
heartbeat monitor detects that the target system has become unavailable, the dependency relationship
automatically disables the other monitors. This has the effect of disabling any alerts that would have been
generated by thosemonitors. The figure below shows the examplemonitors are disabled because themonitor
on which they depend is reporting an error condition.
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By default, no dependency is set for amonitor instance. Tomake the running of themonitor dependent on the
status of another monitor, expand the node in the SiteScope tree containing themonitor to which to you want
to create dependence, and select the check box next to the requiredmonitor. To remove dependence on a
monitor, clear the required check box.

Depends Condition
If you choose tomake amonitor dependent on the status of another monitor (by using theDepends on
setting), you use this option to select the status category or condition that theDepends onmonitor should
have for the current monitor to run normally.

The status categories include:

l Good
l Error
l Available
l Unavailable
Themonitor being configured is run normally as long as themonitor selected in theDepends on box reports
the condition selected in this box. If you have selectedUnavailable and theDepends on monitor reports this
status, the current monitors are not disabled.

For example, by selecting Good, this monitor is only enabled as long as themonitor selected in theDepends
on box reports a status of Good. The current monitor is automatically disabled if themonitor selected in the
Depends on box reports a category or condition other than the condition selected for this setting. See the
examples for "Depends On" on the previous page.

Dependencies When Configuring Template Monitors and Groups
When deployingmonitors and groups using a template, monitor and group dependencies are also published.
This enables the template to automatically write the groups andmonitors into their proper place in the tree and
automatically create any number of dependencies, without you having to do this manually.

If a change is required to a templatemonitor dependency, you can update the template once and publish the
changes to all deployed groups without having to update eachmonitor individually. For details, see "Publish
Changes to Templates" on page 745.

Alternatively, if you do not want dependency settings for selectedmonitors and groups in the source template
to overwrite dependency settings in deployed template objects, select the Ignore dependencies when
publishing changes check box in the Dependencies panel. When template changes are published to the
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deployed objects, dependency settings for the selected templatemonitors and groups are ignored and the
existing dependency settings in the deployed objects are preserved.

When configuring a template, you can createmonitor and group dependencies to existingmonitors that are not
part of the current template. This avoids having to recreate the tree structure within the template. You do this
in theDepends on box of themonitor or group template, by entering the full or relative path to themonitor in
themonitor tree.

For example, you can enter:

l Full path:

<group name>\<group name>\<monitor name>

l Relative path:

..\..\<group name>\<monitor name>

Template Dependency Recommendations:

Use Case Template Dependency Recommendations

All depended onmonitors are in a heartbeat
monitor group.

Use the full path to the depended onmonitor.

Templates are deployed in the same structure for
a given host.

For a given host, you havemonitor groups (such
as a basic systemmonitors template, application
template, etc) and a heartbeat monitors group;
both are located under the host group.

Use the relative path to the depended onmonitor.

Inside the template dependency (existed before
SiteScope 11.20).

Use theDepends on button inside the template (the
depended onmonitor does not have to be deployed).

Self Managed dependency. If monitor dependencies were set in themonitors view,
use the Ignore dependencies when publishing
changes option so as not to override them when
publishing template changes to deployed groups.

Setting Status Thresholds
When you configure amonitor, you can determine whether its performance thresholds are determined by
static thresholds (specific threshold values that you configure), or are calculated using baselines based on
historical transaction data.

Tip: Having SiteScope calculate thresholds using baselines instead of setting thresholds manually is
useful to indicate data volatility, where current monitor readings significantly deviate frommonitor
previous runs. For details, see "Set Monitor Thresholds Using a Baseline" on page 279.

You can set thresholds manually by setting logic conditions that determine the reported status of eachmonitor
instance. The status is based on the results or metrics returned by themonitor action on the target system as
compared to the thresholds set for themonitor.

You can set status threshold criteria for eachmonitor instance to determine anError,Warning, andGood
status. Each status threshold consists of ametrics parameter, a logic comparison operation, and ametrics
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value that youmay specify. The parameter and the value depend on themonitor type. For example, the
metrics parameter for a CPU monitor is CPU utilization (%).

You can set up one or more status threshold criteria for each status condition. Most monitor types include one
default setting for each of the three status conditions. Default thresholds of themonitor appear when you first
configure themonitor. When themonitor is not available, it is assigned a status that is based on the user
definition in the If Unavailable drop-down list. A monitor can have a state of Unavailable as well as a status
of Good,Warning, orError. Alerts are triggered according to availability, status, or both availability and
status.

For dynamic monitors (such as Disk Space or VMware Host), you can display thresholds for all regular
expression patterns that are translated to actual current counters. Patterns enable themonitor to
automatically configure itself with counters on the relevant dynamic environment components. For more
details, see Dynamic MonitoringMechanism in the SiteScopeMonitor ReferenceGuide.

This section includes:

l "Scheduling" below
l "Impact of Threshold Status" below
l "SettingMultiple Thresholds" below
l "Indicator Mappings when Reporting Topology to BSM" on the next page

Scheduling
You can select a schedule to determine the status of themonitor instance if you want to define when to check
themonitor run result against the threshold. This is useful if you want to restrict checking themonitor run
results against the threshold to certain days or hours only. For example, youmay want themonitor status to
be based on results gathered during business hours only. At times outside the threshold schedule period, the
monitor is assigned the predefined status in theDefault status box. By default, monitor run results are
checked against the threshold on anEvery day, all day schedule.

Impact of Threshold Status
A change of status can have the following impact:

l It signals an event and acts as a trigger for alerts associated with themonitor or the group to which the
monitor belongs. For example, if themonitor detects that the system has become unavailable, the status
change fromGood toError is used to trigger an alert on error.

l It can affect the state of a dependency betweenmonitors. For example, amonitor that detects a change
that results in anError status may be a trigger to disable one or more other monitors that are dependent on
the system. For information about dependency settings, see "Monitoring Group Dependencies" on
page 221.

l It can affect the status of themonitor in the SiteScope Dashboard. When viewing SiteScope data in the
Current Status tab of Dashboard, you can drill down in themonitor tree to view monitor andmeasurement
status and availability. The status is displayed by color and a status icon in the SiteScope Dashboard. For
information onmeasurement status and availability in the Dashboard user interface, see "SiteScope
Dashboard - Current Status View" on page 905.

Setting Multiple Thresholds
The individual threshold criteria results are combined as logicalOR relationships whenmore than one
threshold condition is defined for any of the three settings. When one or more of the conditions (for example
when two conditions forError if setting) aremet for a status setting themonitor status is set to the
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corresponding status condition. If status conditions aremet for more than one status condition setting the
status of themonitor is set to the highest valued status condition.

For example, if one condition selected as Error if and another condition selected asWarning if are bothmet,
the status would be reported as anError, withError being the highest value,Warning the next highest, and
Good the lowest value.

Indicator Mappings when Reporting Topology to BSM
When SiteScope is reporting data to APM, indicators provide amore detailed view of the health of a
configuration item (CI). For details on understanding indicators, see "Health Indicators, KPIs, and KPI
Domains" in the APMUser Guide in the APMHelp.

When configuring thresholds for amonitor metric, monitors that have a defined topology and a default mapping
have an indicator state and severity value assigned to themetric status by default.

l Every indicator can have several states. For example, whenmeasuring CPU Load, the indicator state
might be Bottlenecked or Busy, whereas whenmeasuringMemory Load, the indicator state might be
Paging or Starving for Memory.

l Indicator severity is the severity corresponding to the indicator state. The available indicator severity
levels are Critical, Major, Minor, Warning, Normal, and Unknown.

Indicator states are assigned to themetric status according to the closest available severity that exists in the
states for the indicator associated with themetric. The selected severity is shown in the SiteScope threshold.

Example:

l Whenmeasuring percent used on aMemory monitor, themetric is mapped to Major severity in the
Error threshold, since Critical severity is not available for the Memory Load indicator.

l Whenmeasuring round trip time on a Pingmonitor, the closest severity level in theWarning
threshold is Major, since the Minor severity level does not exist for this indicator state.

TheGood threshold is always mapped to the Normal severity level.

The association between the indicator state and severity cannot be changed on the local SiteScope server.

If you select a different indicator mapping in the HP Integration Settings panel for themonitor, the indicator
state and severity values are updated in the Threshold Settings.

Note: If the Indicator State and Severity box is empty, themetric is not colored in Service Health,
except for always (default)which is automatically assigned.

The default indicator assignments (mappings) are stored in the Indicator Assignment Settings in SAM
Administration. For details, see "Indicator Assignment Settings" in the APMUser Guide in the APMHelp.

When there is a change to an assignment in the Indicator Assignment Settings, SiteScope detects the change
and downloads the updated assignments. If indicator assignments have been changed on a local SiteScope
server, these assignments are not overridden by the Indicator Assignment Settings. This includes indicator
states where the state selected in the user interface is the same as the default value.

Note:

l If overlapping thresholds have been set (for example, Error if cpu utilization > 80% and Error
if cpu utilization > 90%), the indicator state and severity value that is mapped to the closest
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threshold value is sent. In this example, if the actual metric value is 95%, then the indicator value that
is mapped to Error if cpu utilization > 90% is sent. This is applicable only to thresholds where
the values are numeric.

l Indicator state and severity are not displayed in SiteScope reports.

"Reference Information: Monitors" on page 231

Tasks
How to Create and Deploy a Monitor
This task describes the steps involved in deploying amonitor.

1. Prerequisites
l Check if there are setup requirements and user permissions that need to be obtained for themonitor
before configuring themonitor. For details, see the help for the specific monitor in the SiteScope
Monitor ReferenceGuide.

l Monitors must be created in a group in themonitor tree. For task details, see "Create SiteScope
groups and subgroups" on page 213.

Note: To enable SiteScope tomonitor data on remote servers, youmust configure remote servers.
For details on configuring aWindows remote server, see "Configure SiteScope toMonitor Remote
Windows Servers" on page 402. For details on configuring a UNIX remote server, see "Configure
SiteScope toMonitor Remote UNIX Servers" on page 420.

2. Create monitor instances
a. To create a new monitor instance, right-click the group into which you want to add themonitor

instance, and select New > Monitor. For user interface details, see "New Monitor Dialog Box" on
page 229.

Note: Alternatively, you can create a new monitor instance by copying or moving existing
monitor instances to the group in themonitor view. For details, see "Copy andMove SiteScope
Objects" on page 76.

b. Select themonitor you want to add from the New Monitor dialog box, and configure the settings for
the specific monitor. For a description of themonitor settings, see the help for the specific monitor in
the SiteScopeMonitor ReferenceGuide.

c. You can configure other properties that affect themonitor. For example:
o In theMonitor Run Settings panel, you can set how often SiteScope attempts to run the action

defined for themonitor instance. You can also set the range schedule if you want themonitor to
run on certain days or on a fixed schedule. For user interface details, see "Monitor Run Settings"
on page 245.

o In theDependencies panel, you can set monitor dependencies tomake the running of this
monitor dependent on the status of another monitor. For user interface details, see
"Dependencies" on page 247.
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Example:

Themonitor being configured is run normally as long as themonitor selected in theDepends
on box reports the condition selected in theDepends condition box. In this example, the
monitor being configured is enabled only when theServicemonitor reports a status of Good.

o In theCalculated Metrics panel, you canmanually configure calculatedmetrics to calculate the
relation between two or moremetrics for one or moremonitors. For user interface details, see
"CalculatedMetrics Settings" on page 311.

o In the Threshold Settings panel, you canmanually set logic conditions that determine the
reported status of eachmonitor instance. For user interface details, see "Threshold Settings" on
page 248.
Alternatively, you can set thresholds for one or multiple monitors using a baseline. For task
details, see "How to Set Monitor Thresholds Using a Baseline" on page 280.

Example:

The following shows the default threshold settings for a disk spacemonitor:

Disk space of less than 95 percent full results in a good status; disk space greater than 95
percent full but lower than 98 percent full results in a warning status; disk space greater than 98
percent full or "n/a" results in an error status.

o In the Logging Settings panel, you can create a dedicated log file for the selectedmonitor
instance and view that file from this panel. You can also enable debugging for perfex process. For
user interface details, see "Logging Settings" on page 268.

o In theSearch/Filter Tags panel, define a keyword search/filter tag, assign it to one or more
monitors, and then use the tag to search or filter the display so that only themonitors you want to
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see are displayed. For details, see "Filter Objects in the SiteScope View" on page 65.
o For details of the other commonmonitor properties, see "CommonMonitor Settings" on page 242.

3. Set up monitor alerts - optional
Create alerts to send notification of an event or change of status in some element or system in your
infrastructure.
To create an alert for themonitor, right-click themonitor and select New > Alert. For each alert scheme,
you can create one or more alert actions. In the New Alert dialog box, click New Alert Action to start the
Alert Action wizard.
For task details, see "Configure SiteScope Alerts" on page 1072.

Note:

l You can disable alerts associated with specific groups andmonitors in the SiteScope tree from
theEnable/Disable Associated Alerts panel in themonitor Properties tab, or by clicking the
Enable/Disable Associated Alerts icon in the Dashboard and selecting the required disable
option. Note that this disables only the triggers that come from that specific monitor. If an alert is
assigned tomore the onemonitor, the alerts on the other monitors are unaffected and keep
working. When an associated alert is disabled from the Properties tab, the alert itself is still
enabled in the Alerts tab.

l You can filter the SiteScope tree to show all groups andmonitors with associated alerts enabled
or disabled by clicking the Filter button in the tree toolbar, and selecting Enabled or
Disabled from theEnable/Disable Associated Alerts list in the Filter Options section. The
results of this filter appear in themonitor tree.

4. Set up monitor reports - optional
Create reports to display information about how the servers and applications you aremonitoring have
performed over time.
To create a report for themonitor, right-click themonitor and click Reports. Select a report type and
configure the report settings.
For task details, see "Create SiteScope Reports" on page 1139.

5. Configure analytics - optional
Configure analytics which enables SiteScope to anticipate potential problems on business monitors and
alert users of issues in critical applications before they occur. Analytics is also able to provide details to
assist with root cause analysis to help expedite problem resolution.
For details. see "Configure Predictive Analytics" on page 1188.

6. Results
Themonitor is added to themonitor group in themonitor tree with the configuration settings that you
specified displayed in the Properties tab.
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UI Descriptions
NewMonitor Dialog Box
The New Monitor dialog box enables you to define a new monitor in amonitor group.

User interface elements are described below:

UI Element Description

Quick
Search

Enter amonitor name in theQuick Search box. You can select the following settings to help
you with your search:

l All. Search for matches in all columns.
l Monitor. Search for matches in theMonitor column only.
l Category. Search for matches in the Category column only.
l Case sensitive. Search for matches that are case sensitive.
l Case insensitive. Search for matches that are not case sensitive.
l Use wild cards. Enables you to use wild card characters in your search. For example,
use an asterisk wildcard (*) to represent a string of characters, or a questionmark wild
card (?) to represent one character only.

l Match from start. Search for monitors/monitor categories that match the search text
from the start.

l Match exactly. Search for monitors/monitor categories that exactly match the search
text.

l Match anywhere. Search for monitors/monitor categories that contain the search text
somewhere in the name.

Recently
Used
Monitors

Displays the fivemost recently selectedmonitors. Click a link to create a new monitor for the
selectedmonitor type.

Note: The displayedmonitors may change as more selections aremade.

Monitor Displays the list of SiteScopemonitors. Select amonitor from the list by clicking themonitor
link. A grayed-out link indicates that themonitor is not available.

You can change the order of the listedmonitors, by clicking the column header. An arrow is
displayed to indicate the sort order (ascending or descending).

You can also select amonitor by clicking the arrow to the right of theMonitor heading, and
selecting amonitor from the list, or you can choose (Custom...), which enables you to
customize themonitor filter using various conditions.
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UI Element Description

Category Displays the list of monitor categories.

You can change the order of the listed categories, by clicking the column header. An arrow is
displayed to indicate the sort order (ascending or descending).

To select amonitor by category, click the arrow to the right of theCategory heading, and
select a category from the list detailed below.

l (All) - This is the default setting.
l (Custom...) - Enables you to customize the category filter using various conditions.
l Application
l Customizable
l Database
l Generic
l Integration
l Media
l Network
l Server
l Virtualization and Cloud
l Web Transaction
For themonitors in each category, see "Monitor Categories List" on the next page.

Availability Displays themonitor availability status (Available/Not Available).

You can change the availability status order, by clicking the column header. An arrow is
displayed to indicate the sort order (ascending or descending), or by clicking the arrow to the
right of theAvailability heading, and selecting a status.

Other Related UI Pages: "SiteScopeMonitors User Interface" on page 242

Tips/Troubleshooting
General Notes and Limitations
l Monitors can be created only in a SiteScope group.
l Only a SiteScope administrator user, or a user granted the appropriate permissions can create, edit,
refresh, disable, or acknowledgemonitors. For details on user permissions, see "Permissions" on
page 636.

l To avoid leaving hanging groups when deletingmonitors (if no other monitors are deployed in the group),
use the following SiteScope APIConfigurationmethod to identify if one of the groups has monitor in it:

APIConfiguration#getGroupsConfigurationSnapshot(String[], boolean, String, String)

l You cannot delete amonitor if it has dependent alerts or reports at the container level. To delete amonitor
with dependencies, youmust remove themonitor from Alert Targets andReport Targets for each
dependency, and then delete themonitor. You can deletemonitors that have dependencies at the child
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level.
l TheMonitor description field supports HTML tags (HTML version 3.2) including themost common tags for
text styling, such as <BR>, <HR>, and <B>, and hyperlinks. It does not support
JavaScript/iframes/frames or other advanced features.

l You can also use the SiteScope API when working with monitors. For details, see "SOAP-based APIs" on
page 139.

l If a monitor fails to complete its actions before it is scheduled to run again, see "SkippedMonitor Events"
on page 990 for troubleshooting information.

Reference Information: Monitors
You can find additional reference information on SiteScopemonitor in the following sections:

l "Monitor Categories List" below
l "Monitors Supported in SiteScopes Installed onWindows Environments Only" on page 235
l "Monitors SupportingWindows Management Instrumentation (WMI)" on page 235
l "Server Monitors that Support Monitoring Amazon EC2 Instances From SiteScopes Not Installed on EC2"
on page 236

l "Ports Used for SiteScopeMonitoring" on page 236
l "List of Deprecated SiteScopeMonitors" on page 241

Monitor Categories List
This section displays the SiteScopemonitors in eachmonitor category. For information about the usage and
configuring eachmonitor type, see themonitor type in the SiteScopeMonitor ReferenceGuide.

l "ApplicationMonitors" below
l "Big Data" on page 233
l "Customizable Monitors" on page 233
l "DatabaseMonitors" on page 233
l "Generic Monitors" on page 233
l "IntegrationMonitors" on page 233
l "MediaMonitors" on page 234
l "Network Monitors" on page 234
l "Server Monitors" on page 234
l "Virtualization and CloudMonitors" on page 235
l "Web TransactionMonitors" on page 235

Application Monitors
l Active Directory ReplicationMonitor
l Apache Server Monitor
l BroadVision Application Server Monitor
l Check Point Monitor

Using SiteScope
Chapter 23: CreateMonitors in SiteScope

HPE SiteScope (11.33) Page 231 of 1206



l CiscoWorks Monitor
l Citrix Monitor
l ColdFusion Server Monitor
l COM+ Server Monitor
l Dynamic Docker Monitor
l F5 Big-IP Monitor
l HAProxy Monitor
l Mail Monitor
l MAPI Monitor
l Memcached Statistics Monitor
l Microsoft ASP Server Monitor
l Microsoft ExchangeMonitor
l Microsoft Exchange BaseMonitor
l Microsoft Exchange 2000*/2003*/2007Message Traffic Monitor (*Deprecated)
l Microsoft Exchange 5.5Message Traffic Monitor (Deprecated)
l Microsoft Exchange 2003Mailbox Monitor (Deprecated)
l Microsoft Exchange 2003 Public Folder Monitor (Deprecated)
l Microsoft IIS Server Monitor
l News Monitor
l Oracle 9i Application Server Monitor
l Oracle 10g Application Server Monitor
l Radius Monitor
l SAP CCMS Monitor
l SAP CCMS Alerts Monitor
l SAP JavaWeb Application Server Monitor
l SAP MAI Alerts Monitor
l SAP PerformanceMonitor
l SAPWork Processes Monitor
l Siebel Application Server Monitor
l Siebel Log File Monitor
l Siebel Web Server Monitor
l SunONEWeb Server Monitor
l TuxedoMonitor (Deprecated)
l UDDI Monitor
l WebLogic Application Server Monitor
l WebServer Monitor
l WebSphere Application Server Monitor
l WebSphereMQStatus Monitor
l WebSphere Performance Servlet Monitor
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Big Data
l HadoopMonitor
l HP Vertica JDBC Monitor

Customizable Monitors
l CustomMonitor
l Custom DatabaseMonitor
l Custom Log File Monitor
l CustomWMI Monitor

Database Monitors
l Database Counter Monitor
l DatabaseQuery Monitor
l DB2 JDBC Monitor
l LDAP Monitor
l Microsoft SQL Server Monitor
l Oracle DatabaseMonitor
l SybaseMonitor (Deprecated)

Generic Monitors
l Composite Monitor
l Directory Monitor
l Dynamic JMX Monitor
l File Monitor
l Formula Composite Monitor
l JMX Monitor
l Log File Monitor
l Multi LogMonitor
l Script Monitor
l SyslogMonitor
l WebServiceMonitor
l XMLMetrics Monitor

Integration Monitors
l HP OMEvent Monitor
l HP ServiceManager Monitor
l NetScout Event Monitor
l Technology Database IntegrationMonitor
l Technology Log File IntegrationMonitor
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l Technology SNMP Trap IntegrationMonitor
l Technology Web Service IntegrationMonitor

Media Monitors
l Microsoft Lync Server 2010Monitors (Microsoft A/V Conferencing Server, Microsoft Archiving Server,
Microsoft Director Server, Microsoft Edge Server, Microsoft Front End Server, Microsoft Mediation
Server, Microsoft Monitoring and CDR Server, andMicrosoft Registrar Server)

l Microsoft Windows Media Player Monitor (Deprecated)
l Microsoft Windows Media Server Monitor
l Real Media Player Monitor (Deprecated)
l Real Media Server Monitor

Network Monitors
l DNS Monitor
l FTP Monitor
l Microsoft Windows Dial-upMonitor (Deprecated)
l Network BandwidthMonitor
l PingMonitor
l Port Monitor
l SNMP Monitor
l SNMP TrapMonitor
l SNMP by MIB Monitor

Server Monitors
l BrowsableWindows Performance Counter Monitor
l CPU Monitor
l Disk SpaceMonitor (Deprecated)
l DHCP Monitor
l Dynamic Disk SpaceMonitor
l HP iLO (Integrated Lights-Out) Monitor
l HP NonStop Event LogMonitor
l HP NonStop Resources Monitor
l IPMI Monitor
l Memory Monitor
l Microsoft Windows Event LogMonitor
l Microsoft Windows Performance Counter Monitor
l Microsoft Windows Resources Monitor
l Microsoft Windows Services StateMonitor
l ServiceMonitor
l UNIX Resources Monitor
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Virtualization and Cloud Monitors
l AmazonWeb Services Monitor
l AzureMonitor
l Generic Hypervisor Monitor
l KVMMonitor
l Microsoft Hyper-V Monitor
l Solaris Zones Monitor
l VMware DatastoreMonitor
l VMware Host Monitors (VMware Host CPU, VMware Host Memory, VMware Host Network, VMware
Host State, and VMware Host Storage)

l VMware PerformanceMonitor

Web Transaction Monitors
l e-Business TransactionMonitor
l Link Check Monitor
l REST API Monitor
l URLMonitor
l URLContent Monitor
l URL List Monitor
l URLSequenceMonitor
l WebScript Monitor

Monitors Supported in SiteScopes Installed on Windows
Environments Only
The following is a list of themonitors supported in SiteScopes that are running onWindows versions only.
Where relevant, themonitors canmonitor remote servers running on any platform/operating system.

l MAPI Monitor
l Microsoft ExchangeMonitor
l Microsoft Exchange BaseMonitor

Monitors Supporting WindowsManagement Instrumentation
(WMI)
For the list of themonitors that support theWindows Management Instrumentation (WMI) method for
collecting data, see "Configure theWMI Service for RemoteWindows Monitoring" on page 417.
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Server Monitors that Support Monitoring Amazon EC2
Instances From SiteScopes Not Installed on EC2
Supported protocols for monitoring Amazon EC2 instances using SiteScope deployed in a private customer
network:

Protocol Windows UNIX

Required
configuration in
Amazon security
group

Required
configuration in
OS

NetBIOS Supported Not supported Enable 443, 445
tcp ports

Enable incoming
requests in
Windows Firewall

WMI Not supported Not supported N/A N/A

SSH Supported Supported Enable 22 tcp port Configure standard
sshd

Telnet Not supported Supported Enable telnet port

The following is a list of the SiteScope server monitors that support monitoring Amazon EC2 instances from
outside EC2:

l CPU Monitor
l Directory Monitor
l Disk SpaceMonitor (Deprecated)
l Dynamic Disk SpaceMonitor
l File Monitor
l HP Vertica JDBC Monitor
l Log File Monitor
l Memory Monitor
l Microsoft ASP Server Monitor
l Microsoft Hyper-V Monitor
l Citrix Monitor
l ColdFusion Server Monitor

l Microsoft IIS Server Monitor
l Microsoft SQL Server Monitor
l Microsoft Windows Event LogMonitor
l Microsoft Windows Media Server Monitor
l Microsoft Windows Performance Counter
Monitor

l Microsoft Windows Services StateMonitor
l Real Media Server Monitor
l Script Monitor
l ServiceMonitor
l Siebel Log File Monitor
l SyslogMonitor
l WebServer Monitor

Ports Used for SiteScope Monitoring
The following table lists the network ports that are generally used for SiteScopemonitoring. In many cases,
alternate ports may be configured depending on the security requirements of your environment.

Note: All monitors that support perfex—SiteScope's internal application that connects toWindows
APIs—may use port 135, in addition to other ports.
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Monitor Type Ports Used

Apache Server Monitor Port which Apache Server Admin pages located.
Configurable by using server configuration file.

BroadVision Application Server Monitor Uses the Object Request Broker (ORB) port number
for the BroadVision server you are trying tomonitor.

Check Point Monitor SNMP monitor. Default is port 161. This is
configurable.

CiscoWorks Monitor CiscoWorks resources are usually available by
using port 161 or 162 (SNMP), depending on the
configuration of the server.

Citrix Monitor Ports 137, 138, and 139 (NetBIOS).

ColdFusion Server Monitor Ports 137, 138, and 139 (NetBIOS).

CPU Monitor For local CPU, no ports required.

For CPUs on remote servers (Windows-based
systems): ports 137, 138, and 139 (NetBIOS).

For CPUs on remote servers (Solaris/Linux-based
systems): ports 22 (SSH), 23 (telnet), or 513 (rlogin).

DatabaseQuery Monitor This is configurable and depends on JDBC driver
and DB configuration.

DB2 JDBC Monitor Default is port 50000. This is configurable.

DHCP Monitor Default is port 68.

Directory Monitor For local directory, no ports required.

For directories on remote servers (Windows-based
systems): ports 137, 138, and 139 (NetBIOS).

For directories on remote servers (Solaris/Linux-
based systems): ports 22 (SSH), 23 (telnet), or 513
(rlogin).

Disk SpaceMonitor (Deprecated)

Dynamic Disk SpaceMonitor

For local disk space, no ports required.

For disk space on remote servers (Windows-based
systems): ports 137, 138, and 139 (NetBIOS).

For disk space on remote servers (Solaris/Linux-
based systems): ports 22 (SSH), 23 (telnet), or 513
(rlogin).

Note that diskperf -ymust be enabled , and the
monitored client requires a reboot.

DNS Monitor Default is port 53.

F5 Big-IP Monitor Uses SNMP. This is configurable.
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Monitor Type Ports Used

File Monitor Local disk. No ports required.

For files on remote servers (Windows-based
systems): ports 137, 138, and 139 (NetBIOS).

For files on remote servers (Solaris/Linux-based
systems): ports 22 (SSH), 23 (telnet), or 513 (rlogin).

FTP Monitor Default is port 21. This is configurable.

Generic Hypervisor Monitor Ports 22 (SSH), 23 (telnet), or 513 (rlogin).

HAProxy Monitor The default is port 80. This is configurable.

HP Vertica JDBC Monitor The default is port 5433. This is configurable.

KVMMonitor Ports 22 (SSH), 23 (telnet), or 513 (rlogin).

LDAP Monitor The default is port 389. This is configurable.

Link Check Monitor The default is port 80. This is configurable.

Log File Monitor Ports 137, 138, and 139 (NetBIOS) forWindows
based systems.

Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Mail Monitor Port 110 for POP3, port 25 for SMTP, port 143 for
IMAP.

MAPI Monitor MAPI uses the NameService Provider Interface
(NSPI) on a dynamically assigned port higher than
1024 to perform client-directory lookup.

Memory Monitor Ports 137, 138, and 139 (NetBIOS) forWindows
based systems, ports 22 (SSH), 23 (telnet), or 513
(rlogin) for Solaris/Linux based systems.

Memcached Statistics Monitor Default is port 11211. This is configurable.

Microsoft Exchange BaseMonitor If “Test-ImapConnectivity” counters are selected,
monitor checks IMAP4 service on Exchange Server
using port 993 for SSL, or 143 for Plain Text/TLS.

If “Test-PopConnectivity” counters are selected,
monitor checks POP3 service on Exchange Server
using port 995 for SSL, or 110 for Plain Text/TLS.
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Monitor Type Ports Used

Microsoft Lync Server 2010Monitors (Microsoft A/V
Conferencing Server, Microsoft Archiving Server,
Microsoft Director Server, Microsoft Edge Server,
Microsoft Front End Server, Microsoft Mediation
Server, Microsoft Monitoring and CDR Server, and
Microsoft Registrar Server)

Windows Performance Counters over ports 137,
138, and 139 (NetBIOS).

Microsoft Hyper-V Monitor Windows Performance Counters over ports 137,
138, and 139 (NetBIOS).

Microsoft IIS Server Monitor Windows Performance Counters over ports 137,
138, and 139 (NetBIOS).

Microsoft SQL Server Monitor Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Event LogMonitor Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Media Server Monitor Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Performance Counter Monitor Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Resources Monitor Ports 137, 138, and 139 (NetBIOS).

Multi LogMonitor Ports 137, 138, and 139 (NetBIOS) forWindows
based systems.

Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Network BandwidthMonitor No ports required; monitors only the local machine.

News Monitor Default is port 144. This is configurable.

Oracle DatabaseMonitor This is configurable. Depends on target DB. Default
is port 1521.

Oracle 9i Application Server Monitor

Oracle 10g Application Server Monitor

This is configurable. Port whichWebcaching admin
page located.

PingMonitor Default is port 7.

Port Monitor Monitors any port.

Radius Monitor Currently supports Password Authentication
Procedure (PAP) authentication but not the
Challenge Handshake Authentication Protocol
(CHAP) or Microsoft Challenge Handshake
Authentication Protocol (MS-CHAP). The RADIUS
servers must be configured to accept PAP requests.

Default is port 1645. In recent changes to the
RADIUS spec, this may be changed to 1812. The
monitor is configurable.
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Monitor Type Ports Used

Real Media Server Monitor Ports 137, 138, and 139 (NetBIOS).

SAP CCMS Monitor Uses SAP Client software (SAP Front End) to run
certain SAP transactions. Therefore, same ports as
SAP.

Script Monitor Ports 137, 138, and 139 (NetBIOS) forWindows
based systems.

Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

ServiceMonitor Ports 137, 138, and 139 (NetBIOS) forWindows
based systems.

Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

SNMP Monitor Default is port 161. This is configurable.

SNMP TrapMonitor Uses port 162 for receiving traps. This is
configurable.

SunONEWeb Server Monitor URL to the stats-xml file on the target SunONE
server. The port is configurable.

SybaseMonitor Monitor requires Sybase Central client on the
machine where SiteScope is running to connect to
the Adaptive Server EnterpriseMonitor Server. Port
number the same as Sybase client.

SyslogMonitor Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

TuxedoMonitor The default port for the TUXEDOworkstation
listener is port 65535. This is configurable.

URLMonitor Generally port number 80. This is configurable.

Web Server Monitor Ports 137, 138, and 139 (NetBIOS) forWindows
based systems.

Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Web ServiceMonitor This is configurable.

WebLogic Application Server Monitor OracleWebLogic Application Server monitor uses
the Java JMX interface. Port is configurable.

WebSphere Application Server Monitor Same port as the IBMWebSphere Administrator's
Console.

WebSphere Performance Servlet Monitor WebSphere Performance Servlet. Port is
configurable.
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List of Deprecated SiteScope Monitors
In recent versions of SiteScope, a number of monitors were deprecated and are no longer supported. The
following table lists the deprecatedmonitors and, where available, the respectivemonitors that can replace
them:

Deprecated Monitor Recommended Alternative Monitor

Active Directory Performance N/A

Asset N/A

Astra Load Test Web Script Monitor

DB2 DB2 JDBC Monitor

Disk Space Dynamic Disk SpaceMonitor

Dynamo N/A

IPlanet Application Server SunONEWeb Server Monitor

IPlanet Server SunONEWeb Server Monitor

IPlanet Web Server SunONEWeb Server Monitor

Microsoft Exchange 2003Mailbox

Microsoft Exchange 2003 Public Folder

Microsoft Exchange 5.5, 2000, 2003Message Traffic

Microsoft ExchangeMonitor

Microsoft Exchange BaseMonitor

Microsoft Windows Dial-Up N/A

Microsoft Windows Media Player N/A

Network Network BandwidthMonitor

Quick Test Pro Web Script Monitor

Real Media Player Monitor N/A

RTSP N/A

SAP SAP PerformanceMonitor

SAP Portal SAP CCMS Monitor

SilverStream Server N/A

Sybase N/A

Tuxedo N/A

WebLogic 5.x Application Server N/A
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SiteScope Monitors User Interface
This section includes:

l "New Monitor Dialog Box" on page 229
l "CommonMonitor Settings" below

l "General Settings" on page 244

l "Monitor Run Settings" on page 245

l "Dependencies" on page 247

l "CalculatedMetrics Settings" on page 311

l "Threshold Settings" on page 248

l "HP Integration Settings" on page 253

l "Event Mapping Settings" on page 263

l "Enable/Disable Monitor" on page 264

l "Enable/Disable Associated Alerts" on page 265

l "Search/Filter Tags" on page 266

l "Baseline Settings" on page 267

l "Logging Settings" on page 268

l "Select Depends OnMonitor Dialog Box" on page 270
l "Select Template Dialog Box" on page 270
l "Copy to Template Tree Dialog Box" on page 271

Common Monitor Settings
The commonmonitor settings enable you to configure settings for a new monitor.

To
access

Select theMonitors context.

l For new monitors: In themonitor tree, right-click a group, select New > Monitor, and select
amonitor from the New Monitor dialog box. In the right pane, click theProperties tab.

l For existingmonitors: In themonitor tree, expand the group folder that contains themonitor,
and select themonitor. In the right pane, click theProperties tab.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226

See also "Monitor Tree" on page 26

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description

Properties
Tab

The following setting panel in themonitor Properties tab are common to all monitors. For
details on the settings for a specific SiteScopemonitor, see the user interface page for the
monitor type.

l "General Settings" on the next page
l <Monitor Name> Monitor Settings. For a description of monitor settings and details on
how to configure eachmonitor, see the specific monitor in the SiteScopeMonitor
ReferenceGuide.

Note: The following special characters are not supported in this field: " ' > <.

l "Monitor Run Settings" on page 245
l "Dependencies" on page 247
l "CalculatedMetrics Settings" on page 311
l "Threshold Settings" on page 248
l "HP Integration Settings" on page 253 (displayed when SiteScope is integrated with APM,
or with Operations Manager (HPOM) and event or metrics integration is enabled)

l "Event Mapping Settings" on page 263 (displayed when SiteScope is integrated with
HPOM and event integration is enabled, or when aGeneric Event Integration is configured
in Integration Preferences)

l "Enable/Disable Monitor" on page 264
l "Enable/Disable Associated Alerts" on page 265
l "Search/Filter Tags" on page 266
l "Baseline Settings" on page 267
l "Logging Settings" on page 268
Note: The Link Monitor to CI settings panel was removed in SiteScope 11.00 and the
functionality was replaced by the report custom topology feature in the HP Integration
Settings panel.

Verify &
Save

Verifies the correctness of themonitor configuration locally and on the remote server to be
monitored, before saving the settings. If SiteScope fails to connect to the remote server, or if
there is an invalid property in the configuration settings, verification fails and an error message
is displayed.

Tip:Performance is not as fast if you useVerify & Save instead of Save, because SiteScope
needs to establish a connection to the remote server to verify the settings. For bulk operations
such as Publish Template Changes andGlobal Search and Replace, we recommend using
theSave option only
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UI
Element Description

Save Performs a local verification of the configuration settings, and saves the settings (without
verifying the correctness of themonitor configuration on the remote server).

Tip:Performance is faster if you useSave instead of Verify & Save, because SiteScope
does not need to establish a connection to the remote server to verify the settings. For bulk
operations such as Publish Template Changes andGlobal Search and Replace, we
recommend using theSave option only.

Note:When saving a customizable monitor type, Save has the same affect as Verify &
Save. SiteScope verifies the correctness of themonitor configuration both locally and on the
remote server to bemonitored, before saving the settings.

General Settings
TheGeneral Settings panel enables you to create a name and description for themonitor instance.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
General Settings.

Important
information

l HTML code entered in the name and description fields is checked for validity and
security, and corrective action is taken to fix the code (for example, code is truncated if it
spans more than one line). If malicious HTML code or JavaScript is detected, the entire
field is rejected. The following is prohibited HTML content:
l Tags: script, object, param, frame, iframe.

l Any tag that contains an attribute starting with on is declined. For example,
onmouseover.

l Any attribute with javascript as its value.

l If the name or description fields contain an ampersand (&), less than (<), or greater than
(>), they are automatically escaped, for example, &amp;, &lt;, or &gt;.

l To automatically adjust the row height to make all cell contents visible in the Dashboard,
select theWrap text option in Dashboard Settings. For details, see "Dashboard Settings
Dialog Box" on page 900.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226
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User interface elements are described below:

UI Element Description

Name Name that describes the element or system beingmonitored. Use a useful naming
convention for all monitors to make creating view filters and category assignments more
effective.

Example: <hostname:resource_type> or <business_unit  resource_name monitored_
element>

Default value: If this field is left empty, SiteScope creates a default name based on the
host, system, and/or URL beingmonitored or the default name defined for themonitor type. If
the automatic name creation operation detects escape characters, it prompts the user to
manually enter a valid monitor name.

Note: Themonitor name cannot contain any of the following characters: ` " < >

Monitor
description

Additional information to describe amonitor. This can include themost commonHTML tags
for text styling, such as <BR>, <HR>, and <B>. The description is displayed only when
viewing or editing themonitor's properties in the SiteScope Dashboard.

You can also include HTML tags to enable you to access URLs from the SiteScope
Dashboard. To add a hyperlink, enter the URL (UNC path is supported forWindows
remotes). For example, <a href="http://www.hp.com">My Link</a>. The URL is
displayed in theDescription field for the selectedmonitor in the SiteScope Dashboard.

Note: This field does not support JavaScript/iframes/frames or other advanced features.

Report
description

Optional description for this monitor to make it easier to understand what themonitor does.
This description is displayed on each bar chart and graph inManagement Reports.

Example: Network traffic or main server response time.

Instruction
text

(Optional) Enables instructions or help text to be included in SiteScopemessages when
events are sent to HP Operations Manager/OMi. To use this property, add the <<_
instructiontext>> tag into the event mapping template (Preferences > Common Event
Mappings) and the text will be added to the required event property.

Monitor Run Settings
TheMonitor Run Settings panel enables you to configure settings for themonitor run.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Monitor Run Settings.

Important
information

For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226

See also "Schedule Preferences" on page 608
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User interface elements are described below:

UI
Element Description

Frequency How often SiteScope attempts to run the action defined for themonitor instance. Each
monitor run updates the status of themonitor. Use the drop-down list to specify increments of
seconds, minutes, hours, or days.

When configuring this setting in a template, the variable value can only be in time units of
seconds.

Default value: 10minutes

Minimum value: 15 seconds

Note: Frequency must be greater than the timeout value of amonitor.

Error
frequency

Monitoring interval for monitors that have reported an error condition.

Example:Youmay want to run themonitor every 10minutes normally, but as often as every
2minutes if an error has been detected. When themonitor's status is no longer in error, the
monitor reverts to the run interval specified in the Frequency setting.

Note:

l Increasing themonitor run frequency affects the number of alerts generated by the
monitor.

l When configuring this setting in a template, the variable value can only be in time units of
seconds.

Verify
error

Automatically runs themonitor again if it detects an error. It runs themonitor immediately after
the regular run returned an error to make sure that the first error was not a false alert. If the
error is returned again, it is reported as a result of themonitor run, and the next run takes place
according to themonitor schedule.

To changemonitor scheduling while themonitor is in error status, see theError frequency
setting. This is a preferred and recommended setting overVerify error, especially for large
SiteScope environments.

The status returned by the Verify error run of themonitor replaces the status of the originally
scheduled run that detected an error. The data from the verify runmay be different than the
initial error status, causing the loss of important performance data.

Tip:We recommend using this option in small monitoring environments only. Significant
monitoring delays may result if multiple monitors are rescheduled to verify errors at the same
time.

Monitor
schedule

Range schedule if you want themonitor to run only on certain days or on a fixed schedule.
The range schedules created inSchedule Preferences appear in the drop-down list. For
more information about creatingmonitor schedules, see "Schedule Preferences" on page 608.

Default value: Every day, all day

Note: If you select a threshold schedule in the Threshold Settings, at least one threshold
schedulemust coincide with themonitor run schedule (at least oneminute of themonitor run
schedulemust be covered by one of the threshold schedules).
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UI
Element Description

Show run
results on
update

Whenever a change is made to amonitor's configuration settings, themonitor is run. Displays
the results of that monitor run in a popup dialog box.

Note: The updated run results are always displayed in the applicable Dashboard views for the
monitor.

Dependencies
The Dependencies panel enables you to create a dependency relationship that enables you tomake the
running of this monitor dependent on the status of another monitor.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Dependencies.

Important
information

For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226

See also "Monitoring Group Dependencies" on page 221

User interface elements are described below:

UI Element Description

Depends on Click Depends on to open the Select Depends OnMonitor dialog box, and select the
monitor on which you want to make the running of this monitor dependent. For details on
the Select Depends OnMonitor dialog box, see "Select Depends OnMonitor Dialog Box"
on page 270.

Use this option to prevent redundant alerting frommultiple monitors that aremonitoring
different aspects of a single system.

Example:Create a systemmonitor to check the basic availability of a system and then
create other monitors that perform more detailed tests of that system. Set the detailed test
monitors to be dependent on the status of themonitor checking basic availability.

If the systemmonitor detects that the target system has become unavailable, the
dependency relationship automatically disables the other monitors. This also disables any
alerts that would have been generated by the dependent monitors.

Default value: No dependency is set for amonitor instance.

Note when working in template mode: This field is cleared and is not available when
Ignore dependencies when publishing changes is selected.

Using SiteScope
Chapter 23: CreateMonitors in SiteScope

HPE SiteScope (11.33) Page 247 of 1206



UI Element Description

Depends
condition

If youmake this monitor dependent on the status of another monitor (by using the
Depends on setting), use this option to select the status condition of theDepends on
monitor for the current monitor to run normally.

The status categories include:

l Good
l Error
l Available
l Unavailable
Themonitor being configured is run normally as long as themonitor selected in the
Depends on box reports the condition selected in this box.

Example:Select Good and this monitor is enabled only when themonitor selected in the
Depends on box reports a status of Good. The current monitor is automatically disabled if
themonitor selected in theDepends on box reports a category or condition other than
Good. You can also enable dependent monitors specifically for when amonitor detects an
error.

Default value:Good

Ignore
dependencies
when
publishing
changes
(available in
Template
mode only)

When template changes are published to the deployed objects, dependency settings for
the selected template group are ignored and the existing dependency settings in the
deployed objects are preserved. For details, see "Dependencies When Configuring
TemplateMonitors andGroups" on page 222.

Default value:Not selected

Note:When selected, theDepends on field is cleared and is not available.

Threshold Settings
The Threshold Settings panel enables you to set conditions that determine the reported status of eachmonitor
instance. The status result is based on the results or metrics returned by themonitor action on the target
system during a specified period of time.

Status threshold criteria for eachmonitor instance can be set for theError if,Warning if, andGood if status
conditions. You can also set monitor thresholds using a baseline to provide a comparison for establishing
acceptable or expected threshold ranges. For details, see "Setting Status Thresholds" on page 223.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Threshold Settings.
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Important
information

l You can apply multiple status threshold criteria for each status condition per monitor
instance. A single monitor instancemay have one or more criteria used to determine
Error status, one or more conditions to determineWarning status, and one or more
conditions to indicateGood status. Most monitor types include one default setting for
each of the three status conditions.

l When setting a baseline threshold, you can only change certain threshold conditions
during the baseline calculation and after the baseline is activated. For details on the
threshold changes that are allowed, see "Changing Threshold Settings" on page 253.

l Whenworking with Global Search and Replace, if you select to replace threshold
settings, theOverride Category option appears. When selected, all the threshold
settings for the selectedmonitor instances are overridden with the settings you entered
for the replace operation. If this option is cleared and you selected to replace threshold
settings, the settings you entered are added to the existing threshold settings for the
monitor instances.

l If an alert was defined for unavailable status, it results in two alerts being sent when the
monitored system or application is unavailable—an unavailable alert, and an alert
showing the status assignment when themonitor is not available (either Good, Warning,
or Error).

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Set Monitor Thresholds Using a Baseline" on page 280
l "How to Create a CalculatedMetrics Expression" on page 309
l "How to Set Combined Threshold CalculatedMetrics" on page 311

See also "Set Monitor Thresholds Using a Baseline" on page 279

User interface elements are described below:

UI Element Description

New. Creates additional thresholds that determine theError/Warning/Good status. For
each threshold, select themetric and operator, and enter a value for themetric.

By default, two thresholds are displayed for theError status when you first configure the
monitor, and one threshold for theWarning andGood status.

Delete. Deletes the selected threshold.
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UI Element Description

If
unavailable

Status assignment for when themonitor is not available from the following options:

l Set monitor status according to thresholds. Themonitor gets a new status according
to the thresholds.

l Set monitor status to Good. Themonitor's status is set to Goodwhen it is unavailable
without thresholds being checked.

l Set monitor status to Warning. Themonitor's status is set to Warningwhen it is
unavailable without thresholds being checked.

l Set monitor status to Error. Themonitor's status is set to Errorwhen it is unavailable
without thresholds being checked.

Note:A monitor instance can have a status of Unavailable as well as a status of Good,
Warning, or Error. Alerts are triggered according to availability, status, or both availability
and status, depending on how the alert is configured. For details, see "Configure SiteScope
Alerts" on page 1072.

Default
status

Monitor status (Good,Warning, orError) if the threshold criteria for themonitor instance
are not met.

Default value:Good

On internal
error

Monitor status assignment if a configuration or internal error occurs:

l Set monitor status according to Thresholds. Themonitor's status is set according to
its current thresholds if a configuration or internal error occurs (default setting). It is
unreliable to rely on the threshold since there is no way of knowing at what point the error
occurred (and whether the threshold is based on old data, updated data, or both). For
example, amonitor may remain in its current status even though themonitor did not run;
change status if thresholds were defined that were not applicable; or trigger false alerts
as if a remote was not available, when in fact, the remote was not contacted.

l Set monitor status to Error. Themonitor's status is set to Error if a configuration or
internal error occurs without thresholds being checked.

l Set monitor status to Warning. Themonitor's status is set to Warning if a
configuration or internal error occurs without thresholds being checked.

l Set monitor status to Good. Themonitor's status is set to Good if a configuration or
internal error occurs without thresholds being checked.

l Treat monitor as unavailable. Themonitor is treated as being Unavailable if a
configuration or internal error occurs without thresholds being checked.

Add
Default
Thresholds

Adds default threshold settings to themonitor instance, for the applicable status categories.
Default thresholds are indicated by the (default) label. Default thresholds are editable only
after selecting a condition from theCondition field (the default condition can be selected).
After any criteria of the default threshold is changed, the (default) label is removed.

Remove
Default
Thresholds

Deletes the default threshold settings (those indicated by the (default) label) from the
monitor instance. Default settings that were added and were subsequently modified, are not
removed.
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Threshold
Preview

Opens the Threshold Preview dialog box that displays a preview of thresholds for static
counters and for regular expression patterns translated to actual current counters. Patterns
enable themonitor to automatically configure itself with counters and thresholds on the
relevant dynamic environment components (currently available for VMware Host monitors).

The table also displays an Indicator State and Severity value for each current counter
translated from a pattern (this value is not available for patterns in Threshold Settings).

For more details on dynamic monitors, see "Dynamic MonitoringMechanism" on page 318.

Example: The pattern /.*/VirtualMachine/.*/cpu/usage.average\[\]/ displays the
average CPU usage threshold condition for each VM currently beingmonitored.

Error if Conditions for themonitor instance to report anError status.

Condition Metrics parameter for determining the status of this monitor instance. The list of metrics is
dynamically updated based on the type of monitor you are configuring.

Default value:Default metrics exist for many monitor types and differ according tomonitor
type. For many default metrics, there are corresponding defaults for the operator and value
boxes that are not editable.

Operator Metrics operator for determining the status of this monitor instance. The following operators
are available:

l >= Greater than or equal to
l > Greater than
l == Equals
l != Not the same as
l <= Less than or equal to
l < Less than
l containsContains the value entered
l !containsDoes not contain the value entered
Note: To indicate data volatility (where current monitor readings significantly deviate from
previous runs), set status thresholds using a baseline. For details, see "Set Monitor
Thresholds Using a Baseline" on page 279.

Value Value applicable to themetrics parameter.

Note:

l If a monitor has an activated baseline, its metrics values are non-editable and the
Percentiles Table button is displayed. You can change baseline threshold values by
clicking the button and changing the current percentile value from the Percentiles Table.
For user interface details, see "Percentile RangeMapping Table" on page 294.

l You cannot change themetrics value, operator or schedule for a baseline threshold
condition.
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Schedule Range schedule to determine the status of this monitor instance if you want to define when
to check themonitor run result against the threshold. This is useful, for example, if you want
to check themonitor run result against the threshold only on certain days or during peak
hours. The range schedules created inSchedule Preferences appear in the drop-down list.
For more information about creatingmonitor schedules, see "Schedule Preferences" on
page 608.

Default value:Every day, all day

Note:When selecting threshold schedules, at least one threshold schedulemust coincide
with theMonitor schedule in theMonitor Run Settings (at least oneminute of themonitor
run schedulemust be covered by one of the threshold schedules).

Indicator
State and
Severity

State of the indicator (for example, Bottlenecked), and the severity corresponding to the
indicator state (for example, Critical).

Every indicator can have several states. For example, whenmeasuring CPU Load, the
indicator state might be Bottlenecked or Busy, whereas whenmeasuringMemory Load, the
indicator state might be Paging or Starving for Memory.

Indicator state and severity level aremapped tometric status according to the closest
available severity that exists in the states for the indicator associated with themetric. The
indicator state and severity values are updated when a different indicator mapping is
selected in the HP Integration Settings panel.

For more information on indicator mappings, see "Indicator Mappings when Reporting
Topology to BSM" on page 225.

Note:

l SiteScopemust be connected to APM 9.00 or later for the Indicator State and Severity
column to be displayed.

l Indicator state and severity values are not displayed in SiteScope reports.
l If the Indicator State and Severity box is empty, themetric is not colored in Service
Health, except for always (default)which is automatically assigned.

l To display the Indicator State and Severity value for each current counter for a dynamic
monitor (these are the actual counters translated from a regular expression pattern), click
the Threshold Preview button. The indicator state and severity value is displayed for
each actual counter in the Threshold Preview dialog box.

l The association between the indicator state and severity cannot be changed on the local
SiteScope server.

l When there are several indicator states of the same severity associated with a given
metric and threshold, the default state is taken (as it is configured in APM's Service
Health CI Indicator Repository). If no default state is defined, an arbitrary state is
chosen. For example, if the Host Disk Utilization indicator is mapped to the MB free
metric and the indicator has two Critical severity states Higher than normal and Lower
than normal (and neither is defined as default), either one of these states can be used
as the indicator state assigned to this threshold.

Warning if Conditions for themonitor instance to report a Warning status. For each threshold, select the
measurement and operator, and enter a value for themetric.

Using SiteScope
Chapter 23: CreateMonitors in SiteScope

HPE SiteScope (11.33) Page 252 of 1206



UI Element Description

Good if Conditions for themonitor instance to report a Good status. For each threshold, select the
measurement and operator, and enter a value for themetric.

Changing Threshold Settings
You canmake changes to threshold conditions according to the baseline status of themonitor instance.

Monitor
Baseline
Status Change Threshold Condition

Add/Delete
Threshold
Condition

Not baselined You can change any condition of any threshold. Allowed

In calculating/
activating
process

You can only change themeasurement value for static thresholds.

For example, Error if CPU >= 70 every day, all day, you
can only change the value 70 to another value.

Not allowed

Baselined l You can change any condition for static thresholds.
l You can change the percentile value only for baseline
thresholds.

Allowed for static
thresholds only

HP Integration Settings
The HP Integration Settings panel enables you to control what data amonitor forwards to the applications
integrated with SiteScope.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select HP
Integration Settings.

Important
information

l The HP Integration Settings panel is displayed only when SiteScope is integrated with
APM, or when SiteScope is integrated with Operations Manager (HPOM) and event or
metrics integration is enabled. It is not displayed for EMS Integrationmonitors.

l The custom topology is available only if SiteScope is connected to APM version 9.00 or
later.

l The indicator settings are available only if SiteScope is connected to APM version 9.00
or later or to HPOM.

l TheOperations Manager integration settings are available only if an HPOM integration
has been configured and SiteScope is connected to HPOM. For details on configuring
the HPOM Integration, see "HP Operations Manager Integration Preferences" on
page 577.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure SiteScope to Communicate with BSM" on page 190

See also "Integration Preferences" on page 563
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APM Integration Data and Topology Settings
This section enables you to select APM logging options and topology reporting settings for themonitor
instance.

Important
information

l The APM logging options are available only if APM integration is enabled.
l After upgrading to APM 9.2x, monitors configured to report status changes no longer
affect APM's Service Health (except for SystemMonitors view). This occurs because
status change event samples are sent per monitor which does not correlate with the
measurement-to-indicator mappings. If you were using status change event samples in
Service Health, do the following:

l Switch tometrics reporting if you do not have an SLM for these events.

l If both Service Health and SLM are being used for status change event samples, we
recommend upgrading to SiteScope 11.x and switching to event reporting in addition to
reporting status change samples.

l TheEnable reporting changes in status option was removed due to the introduction of
event management in APM. This option can be enabled for backward compatibility by
changing the property Allow sending monitor status only to BSM 9.x to =true in
Preferences > Infrastructure Preferences > Custom Settings.

l APM logging selection should be based on how much data is relevant to report to APM
for this monitor and how much space the APM database has for this data.

l Publishing changes to custom topology is not supported when working in templatemode
(it does not affect themonitor's custom topology in APM). Tomodify topology settings in
deployed templatemonitors, use Global Search and Replace instead. For details, see
"Global Search and Replace" on page 78.

l For troubleshooting problems involving topology reporting, see APM Topology Issues in
the Integration with APM andHPOM Best Practices Guide in the SiteScope Help.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure SiteScope to Communicate with BSM" on page 190
l "How to Configure Topology Reporting" on page 195

See also l "Integration Preferences" on page 563
l " Connecting to a BSM Server" on page 181 (for APM integration data reporting issues)
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

BSM Logging Options

Disable
reporting
metrics to
BSM

Prevents the status information or metrics for this monitor being transferred to APM or
temporarily disables reporting this monitor to APM.

Enable
reporting
monitor
status and
metrics

Sends all monitor data to APM for each time that themonitor runs. This option enables the
largest data transfer load.

Default value:Selected

Enable
reporting
monitor
status (no
metrics)

Sends only monitor category (error, warning, good), status string, and other basic data
for each time that themonitor runs. No information on specific performance counters is
included.

Note: This option is supported only for backward compatibility with legacy SLM, and not
for Service Health.

Enable
reporting
monitor
status and
metrics with
thresholds

Sends monitor data to APM for only thosemetrics counters that have configured
thresholds (for example, Error If, Warning If, Good if). The data is sent for each time
that themonitor is run.

Topology Settings
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Report
monitor and
related CI
topology

SiteScope reports monitor and related CI topology data to APM's RTSM (Run-time
ServiceModel). The data that SiteScope forwards depends on themonitor type. This
option enables SiteScope to:

l Discover topologies and forward specific CI data for themonitors that monitor
applications from among a group of supported environments. For details and a list of
these supported environments, see "Report Discovered Topologies to BSM" on
page 188.

l Report Computer CI data for thosemonitors that monitor hosts (SiteScope sends
Computer CI type for eachmonitored host). If this option is selected, themonitor
creates a topology that includes the host as a CI in APM's RTSM.

l Report CI data based on the user-defined CI type and key attribute values.
If this option is cleared, themonitor and related CI topology data is not reported to APM,
and the Indicator Settings section is unavailable.

For details on how SiteScope reports data to RTSM, see "Integrate SiteScope Data with
BSM's Configuration Items" on page 183.

Note: If SiteScope is connected to APM (and you have an Event Management
Foundation license), and sending events is enabled, hosts are reported to APM through
Operations Management.

Default value:

l Selected for monitors of supported environments andmonitors that have a CI type
defined by default.

l Cleared for monitors that do not have a topology defined by default. For a list of these
monitors, see "Monitors Not Reporting Topology Data By Default" on page 205.
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CI type Themonitor's topology that is used for reporting data to APM's RTSM. You can link
between this monitor instance and any existing, logical configuration item type (CIT) in
APM's RTSM. This link or relationship enables themonitor to pass KPI status to the CI to
which it is linked.

The CI type indicates the following:

l Default (<CI type>). The default CI type for themonitor (for most monitors, the
default CI type is Computer). For a list of monitors where the default CI type is not
Computer, see "Report Discovered Topologies to BSM" on page 188.
CI types include BusinessApplication, BusinessService, DB2, InfrastructureService,
JBoss AS, Node, Oracle, Oracle iAS, SQL Server, Sybase, Unix, WebLogic AS,
WebSphere AS, andWindows.
Added support for the generic Running Software CI type when SiteScope 11.23 (or
later) is integrated with BSM 9.23 (or later). This CI type can reconcile with any of its
descendant CI types such as Database, Application Server, Web Server and so forth
(for the full list of descendant CI types, see the RTSM documentation).

l Default (Multiple). Themonitor has multiple CIs (this is where the CI type is per
metric). The CI type for thesemonitors is fixed and cannot bemodified. For a list of
thesemonitors, see "Monitors Reporting CI Per Metric" on page 206.

l None. Themonitor instance is not linked to a CI type. For a list of thesemonitors, see
"Monitors Not Reporting Topology Data By Default" on page 205. You can select a CI
type from anRTSM view to link to this monitor instance. For details on selecting and
working with views, see "Working with the CI Selector" in theModeling Guide in the
APMHelp.

Note:

l This setting is active only whenReport monitor and related CI topology is
selected.

l After a CI type is selected, the Indicator Settings table is filtered to show mappings
that exist for the selected CI type only.
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<CI type key
attributes>

CI type key attributes are displayed according to the CI type selected for themonitor
instance. Enter the key attribute values for the selected CI type:

l Server. Container CI for the selected CI. This attribute is required for DB2, JBoss AS,
Oracle, Oracle iAS, SQL Server, Sybase, WebLogic AS, WebSphere AS, and
Windows CI types.

l Name. Name of the CI (for BusinessApplication, BusinessService, Computer, DB2,
InfrastructureService, JBoss AS, Oracle, Oracle iAS, SQL Server, Sybase,
WebLogic AS, andWebSphere AS CI types).

l Organization Type. Identifier used to differentiate levels within an organization. This
attribute is required for BusinessApplication, BusinessService, and
InfrastructureService CI types.

l Organization Name. Name of the organization. This attribute is required for
BusinessApplication, BusinessService, and InfrastructureService CI types.

Note:

l This setting is active only whenReport monitor and related CI topology is
selected.

l CI key attributes are not available for monitors where the CI type is per metric. For a
list of thesemonitors, see "Monitors Reporting CI Per Metric" on page 206.

l When upgrading to SiteScope 11.23 or later, SiteScope is unable to update custom
topology for amonitor that had BusinessElement CIs if there was an error in the
Organization Type field, such as a spellingmistake or the wrong parameter was
defined. There will be an empty value in this field.
Workaround:After performing the upgrading, select the required Organization type
from the drop down list.

Indicator Settings
This section displays themetrics for the SiteScopemonitor type and the health indicators (HIs) and event
type indicators (ETIs) to which themetric is assigned. Indicators provide amore detailed view of the health of
a configuration item (CI) when themonitor's topology is reported to APM's RTSM. The Indicator Settings table
is filtered to show mappings for themonitor instances that exist for the selected CI type only.

Using SiteScope
Chapter 23: CreateMonitors in SiteScope

HPE SiteScope (11.33) Page 258 of 1206



Important
information

l Indicator Settings are available only if Operations Manager event integration or APM
integration is enabled, and:

l TheReport monitor and related CI topology setting is selected in APM Integration
Data and Topology Settings section.

l Themonitor has default metric-to-indicator mappings. For a list of monitors that do not
have default indicator mappings, see "Monitors Not Reporting Topology Data By
Default" on page 205.

l Indicator mappings for monitors that report CI type per metric (where CI type is displayed
as Default (Multiple)) cannot be added/deleted from the Indicator Settings panel.
Mappings for thesemonitor types can only be added/deleted from APM (SAM Admin >
Metrics and Indicators tab). For a list of thesemonitors, see "Monitors Reporting CI
Per Metric" on page 206.

l The indicator assignments table in SiteScopemight contain assignments that do not
exist in the Indicator Assignments repository in APM. This is becausemappings that are
incorrectly defined in APM are not validated when they are downloaded to SiteScope
(whereas they are validated, and therefore, not displayed in APM).

l Only advanced users with a thorough knowledge of CIs and indicators should attempt to
edit any of the indicator mappings or to addmappings tometrics.

l If any of the settings in the indicator mapping table aremodified by a user, a note to
indicate this is displayed below the table.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure Topology Reporting" on page 195

See also "Integrate SiteScope Data with BSM's Configuration Items" on page 183

User interface elements are described below:

New. Enables you to add ametric-to-indicator mapping to amonitor instance based on the
monitor type.

Note: This button is not available for monitors that havemultiple CI types (see "Monitors
Reporting CI Per Metric" on page 206). Indicator mappings for thesemonitors can only be
added from APM (SAM Admin > Metrics and Indicators tab).

Delete. Deletes the selectedmetric-to-indicator mapping.

Note: This button is not available for monitors that havemultiple CI types (see "Monitors
Reporting CI Per Metric" on page 206). Indicator mappings for thesemonitors can only be
removed from APM (SAM Admin > Metrics and Indicators tab).
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Reset to Default. Resets themetric-to-indicator mapping for themonitor type to the default
mappings included in your current version of SiteScope. Indicators mappings are stored in a
central repository in System Availability Management (SAM) in APM. SiteScope checks every
5minutes to see if themappings in SAM have changed, and if they have, downloads the latest
mappings.

If indicator mappings on a local SiteScope server have beenmodified, thesemappings are not
overridden by the centralizedmappings when the topology is next reported to APM.

For details onmodifying the centralizedmappings, see "Indicator Assignments Overview" in in
the APM Application Administration Guide in the APMHelp.

Move Down. Enables you to change the sort order of the indicator mappings by moving the
selected indicator mapping down the list. If themapping order is changed locally, the local
mapping order is not overridden whenmapping changes are downloaded from the Indicator
repository in SAM Administration.

Move Up. Enables you to change the sort order of the indicator mappings by moving the
selected indicator mapping up the list. If themapping order is changed locally, the local
mapping order is not overridden whenmapping changes are downloaded from the Indicator
repository in SAM Administration.

Metric
Pattern

Displays themetrics name, or a regular expression pattern based on themetric name, mapped
to the indicator of this monitor instance. You canmodify an existingmapping or create a new
one. Where there is more than one CI type for the same regular expression, they are displayed
in different rows. For details on using regular expressions, see "Regular Expressions" on
page 153.

Note: The list of available metrics is dynamically updated based on the type of monitor you are
configuring. Default metrics exist for many monitor types and differ from one type to another.

CI Type Displays the CI type selected for themonitor instance (the Indicator Settings table is filtered to
show mappings that exist for the selected CI type only).

Note: This field is not editable.

Indicator Displays the indicator mapping for themetric. In the drop-down list, health indicators are
displayed above the divider line, and event type indicators below the line.

HP Operations Manager Integration Settings
This section enables you to configure SiteScope to send events and report metrics to the Operations Agent.
The agent is required for sending events to HPOM and APM's Operations Management, and for reporting
metrics to PerformanceManager (a reporting component of HPOM) and PerformanceGraphing (in Operations
Management). It also enables you to select the event preferencemapping that is used for sending events for
themonitor instance.

Important
information

These settings are available only if the Operations Agent is installed and connected to an
HPOM server, and event/metrics integration is enabled in the Operations Manager
Integration dialog box.
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Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure Common Event Mappings for HPOM or APM" on page 466
l For details on how to enable SiteScope to send events to HPOM or Operations
Management, or how to enable SiteScope to report metrics using the Operations Agent,
see Integrating SiteScope with Operations Manager Products in the SiteScope Help.
You can check the HPE Software Integrations site for the latest version of this guide.

See also l "Integration Preferences" on page 563
l "Common Event Mappings" on page 465

User interface elements are described below:

Report
metrics to
Operations
Agent

Enables SiteScope to report metrics for themonitor instance to the Operations Agent, from
which HPOM andOperations Management (in APM) can collect the data.

Note:Monitor metrics are sent to the agent only if metrics integration is enabled in the
Operations Manager Integration dialog box. For user interface details, see "HP Operations
Manager IntegrationMain Settings" on page 579.

Default value: Selected if metrics integration is enabled (otherwise this setting is not
available).

Send
events

Enables sending events to HPOM or Operations Management (in APM) when there is a
change of a counter/metric status (Good,Warning, Error, Unavailable) for themonitor
instance. Status change is only applicable on counters or metrics that are configured in the
monitor's Threshold Setting.

Note: This setting is available only if the Operations Agent is installed and connected to an
HPOM or APM server, and event integration is enabled in the Operations Manager Integration
dialog box. For user interface details, see "HP Operations Manager IntegrationMain
Settings" on page 579.

Default value: Selected if event integration is enabled (otherwise this setting is not
available).

Manually
send first
event

When creating a new monitor in a SiteScope connected to APM, it is possible that the first
event is triggered before the topology is reported to APM, and the event is lost from the
Service Health perspective (it is still shown in the Operations Management Event Browser).
Select this option to avoid waiting for the next event to be sent. The event is resent during the
next monitor run, regardless of themonitor's metrics reaching their status change conditions.

Default value: Not selected

Note:

l This option is automatically disabled after themonitor run.
l You can configure this setting globally using Global Search and Replace.

BSM Service Health Preferences
This section enables you to configure the preference for influencing APM's Service Health when both
SiteScope events andmetrics are reported to APM.
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Important
information

This setting is available only when:

l Both APM andOperations Manager integrations are active, and are connected to the
same APM server (the APM server is used instead of the HPOM server).

l The following settings are selected in themonitor's HP Integration Settings:
l In APM Integration Data and Topology Settings: Enable reporting monitor status
and metrics orEnable reporting monitor status and metrics with thresholds, and

l In HP Operations Manager Integration Settings: Send events.

Note:

l If only Send events is selected, theBSM Service Health affected by preference is set
toEvents.

l If only Report monitor and related CI topology is selected, theBSM Service Health
affected by preference is set toMetrics.

l If both are selected,Metrics is the default preference.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure Topology Reporting" on page 195
l "How to Enable SiteScope to Send Events to HPOM or Operations Management" in
Integrating SiteScope with HP Operations Manager Products in the SiteScope Help. You
can check the HPE Software Integrations site for the latest version of this guide.

User interface elements are described below:

BSM
Service
Health
affected
by

Select the preference (events or metrics) for influencing APM's Service Health when both
SiteScope events andmetrics are reported to Service Health (since indicators for SiteScope
events andmetrics both affect CIs).

l Metrics. If selected, each SiteScopemetric affects CIs in APM (status change events
reported by SiteScope do not have any influence on CIs in Service Health).

l Events. If selected, only status change events affect CIs in APM's Service Health (SAM
reports for themonitored CIs are still based onmetrics).

For more information on choosing the preference to use, see Integrating SiteScope with APM in
Integration with APM andHPOM Best Practices in the SiteScope Help.

Default value: Metrics

Note:You can also configure a global default preference (events or metrics) for all new monitors
created when configuring the Operations Manager integration. For details, seePrefer events
over metrics in BSM Service Health (global preference) in "HP Operations Manager
IntegrationMain Settings" on page 579.

HP Event Rules Settings
The HP Event Rules Settings panel enables you to send events from SiteScope to Operations Manager
(HPOM) at a defined time and frequency.
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To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select Event
Rules Settings.

Important
information

l The HP Integration Settings panel is displayed only when SiteScope is integrated with
APM, or when SiteScope is integrated with Operations Manager (HPOM) and event
integration is enabled.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure SiteScope to Communicate with BSM" on page 190

Event Rules Settings
User interface elements are described below:

Enable Event
Rules

Select the check box to enable or disable event rules.

Severity Select the severity of the event from the drop-down list.

Time in Minutes Enter the time inminutes to specify the time interval when the events will be sent.

Quantity Specify the number of events that must be generated before an event can be sent to
HPOM.

Event Mapping Settings
The Event Mapping Settings panel is used for selecting a template for mapping SiteScope runtime data to the
attribute values that are used for sending events for themonitor instance.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select Event
Mapping Settings.

Important
information

l The Event Mapping Settings panel is available only if the Operations Agent is installed
and connected to an HPOM or APM server, and event integration is enabled in the
HP Operations Manager Integration dialog box, or when aGeneric Event Integration is
configured in Integration Preferences. For user interface details, see "HP Operations
Manager Integration Preferences" on page 577.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure SiteScopeGeneric Event Integration" on page 589

See also l "Generic Event Integration Preferences" on page 588
l "HTTP Preferences" on page 511

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description

Event
mapping

Select the desired event mapping template, or use the default mapping. Click New orEdit to
open the Common Event Mappings dialog box and configure a new event preference or modify
an existing one. For user interface details, see "New/Edit Event Mappings Dialog Box - General
Tab" on page 469 and "New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on
page 473.

Note:When editing an event mapping from here, it changes the event pattern for all monitors
using this template. We recommend creating a new event mapping if you want a specific
monitor to report different attributes.

Enable/Disable Monitor
The Enable/Disable Monitor panel enables you to set the status (enabled/disabled) for the selectedmonitor.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Enable/Disable Monitor.

Important
information

l HTML code entered in themonitor description fields is checked for validity and security,
and corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field is
rejected.

l TheMonitor Downtime table is displayed only when SiteScope is connected to APM if
the selectedmonitor is affected by a CI currently in downtime. For details, see "CI
Downtime" on page 189.

l When publishing changes to a template that contains a custommonitor, themonitor is
temporarily disabled before changes are published, and is restored to the enabled state
after changes have beenmade.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226

See also "Enable/Disable Monitors in Group Dialog Box" on page 903

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Enable monitor Enables themonitor if themonitor was previously disabled.

Default value:Selected

Disable monitor Disables themonitor. When amonitor has been disabled, SiteScope continues to
schedule themonitor to run based on the Frequency setting for themonitor but the
monitor action is not run. SiteScope records amonitor data log entry for themonitor
when it was scheduled to be run but reports themonitor status as disabled in the
place of metrics data.
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UI Element Description

Disable monitor
for the next <time
period>

Time period that themonitor should remain disabled. Select Seconds,Minutes,
Hours, orDays to define the disable time period as applicable.

Disable monitor
on a one time
schedule from
<time> to <time>

Temporarily disables themonitor for a time period in the future. The time period can
spanmore than one day.

Enter or select the start time and end time for the disable period using the format:
hh:mm:ss mm/dd/yyyy.

Disable
description

Optional descriptive text that appears as part of themonitor status in themonitor
group display. The disable status text also includes a string indicating which disable
option is in force for themonitor, for example Disabled manually indicates that the
monitor was disabled using theDisable monitor option.

Monitor Downtime Table

(This table is displayed only when SiteScope is connected to APM if the selectedmonitor is affected by a
CI currently in downtime. For details, see "CI Downtime" on page 189.)

Downtime Name The name of the downtime as configured in the APMDowntime wizard.

Downtime
Description

A description of the downtime if entered in the APMDowntime wizard.

Current
Occurrence End
Date

Date and time that the current downtime occurrence is scheduled to end.

Enable/Disable Associated Alerts
The Enable/Disable Associated Alerts panel enables you to set the status (enabled/disabled) for associated
alerts.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Enable/Disable Associated Alerts.

Important
information

l HTML code entered in themonitor description fields is checked for validity and security,
and corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field is
rejected.

l The Associated Alerts Downtime table is displayed only when SiteScope is connected to
APM if themonitor is affected by a CI that is currently in downtime, and the downtime
applies to associated alerts of themonitor. For details, see "CI Downtime" on page 189.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Configure an Alert" on page 1076

See also "Configure SiteScope Alerts" on page 1072
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Enable all associated alerts Enable the alerts if the alerts associated with this monitor were
previously disabled.

Default value:Selected

Disable all associated alerts
indefinitely

Prevents SiteScope from executing the alert action even if the alert
condition is met until this radio button is cleared and the alert definition
is updated.

Note:Use of this optionmay result in loss of expected alert capability
if the alert is disabled to accommodate a temporary condition. It is
important to review this status at a later time, and tomanually enable
the alert definition as necessary.

Default value:Not selected

Disable all associated alerts
for the next <time period>

Time period that the associated alerts should remain disabled. Select
Seconds,Minutes, Hours, orDays to define the disable time period
as applicable.

Default value:Not selected

Disable all associated alerts
on a one time schedule from
<time> to <time>

Temporarily disables the associated alerts for a time period in the
future. The time period can spanmore than one day.

Enter the start time and end time for the disable period using the
format: hh:mm:ss mm/dd/yyyy.

Default value:Not selected

Disable description Optional descriptive text.

Associated Alerts Downtime Table

(This table is displayed only when SiteScope is connected to APM if themonitor is affected by a CI that is
currently in downtime, and the downtime applies to associated alerts of themonitor. For details, see "CI
Downtime" on page 189.)

Downtime Name The name of the downtime as configured in the APMDowntime wizard.

Downtime Description A description of the downtime if entered in the APMDowntime wizard.

Current Occurrence End Date Date and time that the current downtime occurrence is scheduled to
end.

Search/Filter Tags
The Search/Filter Tags panel enables you to define a keyword search/filter tag, assign it to one or more
monitors, and then use the tag to search or filter the display.

If no tags have been created for the SiteScope, this section appears but is empty. If tags have been created,
they are listed here and you can select them as required.
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To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Search/Filter Tags.

Important
information

l If no tags have been created for the SiteScope, this section appears but is empty. If tags
have been created, they are listed here and you can select them as required.

l You can edit existing tags in the Preferences context (Preferences > Search/Filter
Tags). For details on this topic, see "Search/Filter Tags" on page 614.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Filter the View Using Search/Filter Tags" on page 67

See also "Filter Objects in the SiteScope View" on page 65

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Displays the tag names and tag values if tags have been created. Select the tags or tag values
that you want to assign to themonitor. If no tags have been created for the SiteScope, this
section appears but is empty.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Baseline Settings
The Baseline Settings panel displays the baseline status for the selectedmonitor.

To access Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select
Baseline Settings.

Important
information

l Baseline Settings are not available for monitors that use the dynamic monitoring
mechanism to update thresholds settings.

l For buttons common to all panes, see "CommonMonitor Settings" on page 242.

Relevant
tasks

l "How to Create and Deploy aMonitor" on page 226
l "How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279
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User interface elements are described below:

UI
Element Description

Baseline
status

Themonitor's baseline status. The following statuses are available:

l Monitor not selected for baselining. Themonitor has not been selected for baselining.
l Calculating baseline.SiteScope is in the process of calculating the baseline.
l Calculation failed.SiteScope was unable to calculate a baseline.
l Calculated, not activated. A baseline was calculated for themonitor, but it has not yet
been activated.

l Activating baseline.SiteScope is in the process of activating the baseline.
l Activation failed.SiteScope was unable to activate the baseline.
l Baseline activated. The baseline has been activated for themonitor.
TheBaseline mode check box is selected if the baseline status is anything other thanMonitor
not selected for baselining.

For details on using the baseline threshold, see "Set Monitor Thresholds Using a Baseline" on
page 279.

Remove
Baseline

Removes the baseline threshold. The baseline thresholds are removed and the static threshold
value is used to create a threshold. To recalculate a baseline, youmust first remove the existing
baseline (even if the calculation failed).

For details on this topic, see "Set Monitor Thresholds Using a Baseline" on page 279.

Logging Settings
The Logging Settings panel enables you to create a dedicated log file with a specified log level for each
monitor instance and view that log file.

To
access

Select theMonitors context. In themonitor tree, expand the group folder that contains the
monitor, and select themonitor. In the right pane, click theProperties tab, and select Logging
Settings.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226

See also l "Log Files Page" on page 1018
l "Log Preferences" on page 597
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User interface elements are described below:

UI
Element Description

Enable
separate
log for
this
monitor

Enables sending log data to a dedicated log file for that monitor instance in the <SiteScope
root directory>\logs\monitor_runs folder. This folder contains one file per monitor
instance. The format of log file names is determined according to themonitor path in the
SiteScope tree, as follows: SiteScope_<monitorGroup>_<monitorName>.log. After each
monitor run, this log file appears on the Log File page. For details, see "Log Files Page" on
page 1018.

When this is disabled, log data for the selectedmonitor is not sent to the dedicatedmonitor
log file. However, log data is still sent to general log files (for example, error.log or
RunMonitor.log), together with log data from all other monitors.

Note:

l To enable a separate log for this monitor (and for all other monitors wheremonitor instance
logging is enabled), theDisable separate logging for monitors check box must be
cleared inPreferences > Log Preferences (the setting is cleared by default). If the
separate logging for monitors option is disabled in Log Preferences, a warning is displayed
in the Logging Settings panel when you enable logging for amonitor instance, and you
must first clear theDisable separate logging for monitors check box in Log
Preferences.

l The <SiteScope root directory>\logs\monitor_runs folder contains historical log data
from themonitor run instances. The log file is appended at each run of themonitor
instance.

Log level Select DEBUG, INFO,WARN, ERROR, or FATAL. Your selection determines which log
messages for this monitor instance are sent both to the dedicated log file for the selected
monitor instance and to the general log files. For more details about log levels, see "Log
Levels" below.

You can select a log level only if Enable separate log for this monitor is enabled. If
Enable separate log for this monitor is disabled, the log level for all monitors is determined
by the log4j.properties file.

Enable
debugging
for perfex
process

Enables debugging for perfex process. For details about perfex process, see "Perfex Process
Pool Page" on page 1023.

You can enable debugging for perfex process only if Enable separate log for this monitor
is enabled.

View Log Click to view the log. The log appears only if there is data for the selected log level.

Log Levels
Log levels operate hierarchically, meaning that some log levels also produce results for other log levels, as
follows:
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Log level writes messages for the following log
levels: DEBUG INFO WARN ERROR FATAL

DEBUG X X X X X

INFO X X X X

WARN X X X

ERROR X X

FATAL X

Select Depends On Monitor Dialog Box
This dialog box enables you tomake the running of this monitor or monitor group dependent on the status of
another monitor.

To
access

Select theMonitors context. In themonitor tree, select amonitor, and click theProperties tab.
Expand theDependencies tab, and click Depends on . Select themonitor on which to you
want to create a dependency.

Relevant
tasks

"How to Create and Deploy aMonitor" on page 226

See also l "Monitoring Group Dependencies" on page 221
l "Monitor Tree" on page 26

User interface elements are described below:

UI
Element Description

Represents an individual SiteScope server.

Represents a SiteScopemonitor group or subgroup (with enabledmonitors/with nomonitors or
no enabledmonitors).

If a group alert has been set up for themonitor group or subgroup, the alert symbol appears
next to the group icon.

Represents a SiteScopemonitor (enabled/disabled).

If an alert has been set up for themonitor, the alert symbol appears next to themonitor icon.

Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScopemonitors.

Parent:SiteScope.

Select Template Dialog Box
This dialog box enables you to select the templates you want to deploy to themonitor group.
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To access Select theMonitors context. In themonitor tree, right-click the group into which you want to
deploy a template, and select Deploy Template orDeploy Template Using CSV.

Important
information

l Templates that do not contain any child objects (subgroups, monitors, variables, or a
remote server) are not displayed in the template tree.

l Solution templates are not displayed in the Select Template dialog box and can be
deployed from the Template context only. For details, see "How to Deploy a SiteScope
Solution Template" on page 767.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also l "Publish Changes to Templates" on page 745
l "Deploy Solution Templates" on page 762
l "Monitor Tree" on page 26
l "Template Tree" on page 37

User interface elements are described below:

UI
Element Description

Represents the SiteScope root group.

Represents a template container. A template container is used to organize configuration
deployment templates. Expand to display the templates.

Represents a template configuration for deploying SiteScope objects. Select the templates that
you want to deploy. You can select multiple templates using the CTRL or SHIFT keys.

Copy to Template Tree Dialog Box
This dialog box enables you to copy a SiteScope object (group, monitor, or remote server) and its contents
(monitors, alerts, and reports) to a template or template group.

To access In themonitor or remote server tree, right-click the object you want to copy to a template,
and select Copy to Template. In the Copy to Template Tree dialog box, select the
destination to which to copy the template object.

Important
information

l You can copy a group and its contents to a template provided the template does not
already contain a group.

l When copying a server monitor to a template, SiteScope replaces the server namewith
the $$SERVER_LIST$$ variable.

Tip:We recommend creating a remote server in the template after copying themonitor to
the template, and replacing the $$SERVER_LIST$$ variable with this remote server.

l TheWeb Script Monitor is not supported in templatemode.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677
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See also l "Monitor Tree" on page 26
l "Template Tree" on page 37

User interface elements are described below:

UI
Element Description

Represents an individual SiteScope server.

Represents a template container. A template container is used to organize configuration
deployment templates.

Template containers can hold templates only.

Represents a template configuration for deploying SiteScope objects.

You can copy a template group (provided the template does not already contain a group), or a
remote server to a template group.

Represents a SiteScopemonitor group or subgroup (with enabledmonitors/with nomonitors or
no enabledmonitors).

You can copy a template group or monitor to a template group.

If a group alert has been set up for themonitor group or subgroup, the alert symbol appears
next to the group icon.
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Chapter 24: Create Custom Monitors
Custommonitors broaden the capabilities of regular SiteScopemonitors for tracking the availability and
performance of your infrastructure systems and applications. Using custommonitors, you can develop your
own solutions for environments that are not supported by predefined SiteScopemonitors. This provides you
with greater flexibility that is not available in existingmonitors.

Tip: You can view guided and narrated demonstrations for using theWMI Custommonitor on YouTube:

l CustomWMI Monitor Creation Process and Packaging -
http://www.youtube.com/watch?v=bB6NlTGdd88

l CustomWMI Monitor Data Processing Script - http://www.youtube.com/watch?v=GIw3JVnunWE

To access
Select theMonitors context. In themonitor tree, right-click a group, select New > Monitor, and select one of
the custommonitors (see "List of CustomMonitors" on page 275).

Learn About
Custom Monitor Overview
You can use the Custommonitors to:

l Collect data that is not available in existing monitors
You can create your own customizedmonitor that collects data and processes the results of the collected
data to create new metrics.

l Process the collected data
The collected data is processed using a script you defined in themonitor. Each time themonitor runs, the
script extracts and processes the results of the collected data, and updates and returns a status for the
metrics defined in the script.
For example, you can definemetrics based on data collected from a database, and perform mathematical
operations on it. When creating a script, you can use Java code developed by yourself or by a third-party to
process the data.

Tip:

l Sample scripts for all the custommonitors are available from the sample content package located
in the <SiteScope installation directory>\examples\
monitors\custom folder. CustomMonitorSamplePackage.zip contains examples for SiteScope
11.20, andCustomMonitorsExamples_11_21.zip contains updated examples including a
Custom Databasemonitor with a dynamic query, amanifest file created using the Export Content
PackageWizard, and templatemail and templatemail subject files, To use these scripts, you
need to import the custommonitor content package and then deploy the custommonitor template.
For details, see "How to import and use a customizable monitor" for the specific custommonitor in
the SiteScopeMonitor ReferenceGuide.
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l For details on themethods and classes that are available in the script, see the HP SiteScope
CustomMonitor API Reference (available from <SiteScope installation
directory>\examples\monitors\custom\doc\javadoc.zip).

l Debug custom monitors remotely on a local machine
You can perform offline debugging of a custommonitor script using a remote debugging server. This
makes the script development process easier, since it enables you to complete the code and see the
debugged data inside the script during the data processing stage. For details, see "Debug Custom
Monitors on a Local Machine" on page 277.

l Collect data dynamically (for query-based custom monitors)
You can include dynamically-defined queries in the data processing script. These queries are executed
while the script is running, in contrast to predefined queries, which are executed before the script is run.
Dynamically-executed queries provide the added benefit of enabling you to create queries based on values
that are not in themonitored entity data store (for example, timestamp), create queries based on previous
query results or calculations, and include variables in queries. For details, see "Data Processing Script
with Dynamic Queries" on page 276.

l Customize how results are displayed
You can determine how results are displayed. For example, whether result data is displayed inmegabytes
or kilobytes.

After developing themonitor, you can:

l Define thresholds for new metrics
Since somemetrics are only defined during a script run, you cannot define thresholds for them in advance.
Once the script has run for the first time andmetrics have been defined, you can define thresholds for
thesemetrics. This provides more advanced data processing options than regular monitors.
Note that metrics can change between script runs, for example, where variables are used inmetric names.
Thresholds using ametric that does not exist after themonitor run are removed automatically.

l Share the monitor with other SiteScope users
After developing themonitor, you can export themonitor to a template, add external jars and/or classes if
themonitor depends on them, and create a content package. For details on creating content packages,
see "Create Content Packages" on page 703.
The content package can then be sent to specific users, or shared with other SiteScope users by
publishing it to the HPE Live Network (https://hpln.hpe.com/group/sitescope) community. For details, see
"Share SiteScope Content on the HPE Live Network" on page 758.
By sharing knowledge with other SiteScope users, you can benefit from extended SiteScopemonitor
coverage and the development of new monitors outside the SiteScope release cycle.

This section also includes:

l "List of CustomMonitors" on the next page
l "Topology Reporting" on the next page
l "Indicator Settings" on the next page
l "Data Processing Script" on the next page
l "Data Processing Script with Dynamic Queries" on page 276
l "Debug CustomMonitors on a Local Machine" on page 277
l "Tips/Troubleshooting" on page 277
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List of Custom Monitors

Monitor
Name Description

Custom
Monitor

You can create your ownmonitor by developing a script that collects data using custom Java
or JavaScript code, and then processes the data and creates metrics.

Custom
Database
Monitor

You can create your own databasemonitor by developing queries (static or dynamically-
defined) that collect data, and a script that processes the collected data and creates metrics.

Custom
Log File
Monitor

You can create your own Log File monitor that scans for matches in the form of text phrases or
regular expressions, and a script that processes the collected data and creates metrics.

Custom
WMI
Monitor

You can create your ownWMI monitor by developingWMI Query Language (WQL) queries
(static or dynamically-defined) that collect data, and a script that processes the collected data
and creates metrics.

For details on custommonitors, see the specific monitor in the SiteScopeMonitor Reference.

Topology Reporting
You can enable SiteScope to report monitor and related CI topology data to APM's RTSM by selectingReport
monitor and related CI topology in the HP Integration Settings panel for the custommonitor, and
configuring the topology reporting settings in the BSM Integration Data and Topology Settings section. This
defines how SiteScope reports CIs to APM.

You can report the following types of CI topology data:

l User-defined CI type topology. You select a CI type and define the key attribute values for the selected CI
type. For details on key attribute values, see "<CI type key attributes>" on page 258.

l Custom topology script. You create the topology script which defines how to report CIs to APM. Only
select this option if you are familiar with the Jython language, because youmust create the topology script
in Jython yourself. For task details, see "How to Configure Custom Topology for a CustomMonitor" on
page 199.

l If you do not want to report topology for themonitor, you can choose to report themonitor CI only.
For more details on configuring topology reporting settings, see "How to Configure Topology Reporting for a
CustomMonitor" on page 197.

Indicator Settings
The table in the Indicator Settings section of HP Integration Settings displays indicator settings for the
selected CI type. Indicators provide amore detailed view of the health of a CI when themonitor's topology is
reported to APM's RTSM. You can add new metric mappings or edit settings for existingmappings. For task
details, see "How to Configure Topology Reporting" on page 195.

Data Processing Script
In the script you develop, you can use Java code developed by yourself or by a third-party. You can store Java
objects in themonitor storage.
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For details on themethods and classes that are available in the script, see the HP SiteScope CustomMonitor
API Reference (available from <SiteScope installation
directory>\examples\monitors\custom\doc\javadoc.zip).

For details on themonitor configuration properties, including how to access them, and themonitor storage and
metrics names, see "How to Access theMonitor Configuration Parameters Exposed in the Script" for the
specific custommonitor (in the SiteScopeMonitor ReferenceGuide).

Note:Whenworking in templatemode, you can use template variables in a data processing script.

Sample Scripts

SiteScope provides a sample data processing script in theData Processing Script box for each custom
monitor. You need to uncomment the script in order to use it.

Sample scripts for all the custommonitors are available from CustomMonitorSamplePackage.zip and
CustomMonitorsExamples_11_21.zip in the <SiteScope installation
directory>\examples\monitors\custom\ folder. To use these scripts, you need to import the custommonitor
content package and then deploy the custommonitor template. For details, see "How to Develop a Custom
Monitor" for the specific custommonitor (in the SiteScopeMonitor ReferenceGuide).

Script Log File

SiteScope provides a custommonitor log which you can use for script debugging purposes. The log file
(custom_monitor.log) is located in <SiteScope root directory>\logs\custom_monitors. This log can be
used for info, warning, error, and debugmessages from running the script.

Data Processing Script with Dynamic Queries

Note: This section is applicable to the Custom Database and CustomWMI monitors only.

When creating query-based custommonitors, you can include dynamically-defined queries in the data
processing script. Dynamic queries are executed while the script is running, in contrast to predefined queries
which are executed before the script is run. Dynamically-defined queries have the same syntax and structure
as the queries predefined in the queries table.

Using dynamically-defined queries provides the following benefits:

l You can create queries based on values that are not in themonitored entity data store. For example,
timestamp.

l You can create queries based on previous query results.
l You can include variables in queries.

Flow of a monitor run with dynamic queries

When a custommonitor with dynamic queries is run, the following sequential flow takes place:

1. The predefined queries in the queries table are executed by themonitor, and the data returned is passed
to the script engine.

2. The script engine starts to execute the script.
3. If a query is encountered in the script, the script engine hands it over to themonitor to execute, and stops

the script execution.
4. Themonitor executes the query on themonitored entity, and returns the data to the script engine.
5. The script engine resumes the script execution.
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Sample Script with Dynamic Queries

For a sample data processing script containing dynamic queries, see the sample content package,
CustomMonitorsExamples_11_21.zip in the <SiteScope installation
directory>\examples\monitors\custom folder. To use these example scripts, you need to import the
custommonitor content package and then deploy the custommonitor template. For details, see "How to
Develop a CustomMonitor" for the specific custommonitor (in the SiteScopeMonitor ReferenceGuide).

Debug Custom Monitors on a Local Machine
You can perform offline debugging of a custommonitor script using a remote debugging server. This makes
the script development process easier, since it enables you to complete the code and see the debugged data
inside the script during the data processing stage. Offline debugging provides full simulation of the remote
system code execution without the need for an open connection to the debugged system. As a result, there is
minimal impact on the remotemachine CPU andmemory resources.

To perform offline debugging, youmust install and configure the CustomMonitor Debugger Eclipse project on
a local machine. The debugger project is available from <SiteScope root
directory>\examples\monitors\custom\CustomMonitorDebuggingEclipseProject or from the HPE Live
Network.

For task details, see "How to Debug a CustomMonitor Offline" for the specific custommonitor in the
SiteScopeMonitor ReferenceGuide. 

Tasks
See the Tasks section for the relevant custommonitor in the SiteScopeMonitor Reference.

Tips/Troubleshooting
General Tips/Limitations
l If a user-defined or imported Java package has the same name as an existing SiteScope or standard Java
package, SiteScope ignores the user-defined/imported Java package.

l When setting custommonitor metrics with a string (non-numeric) value, themaximum and average values
in theMeasurement Summary table of theManagement Report are shown as 'n/a'. This also occurs if you
change themetric value type, for example, if you set themetric with a numeric value, and later change it to
a string value or vice versa.

l When deploying a custommonitor using a template, clearing theVerify monitor properties with remote
server check box in the Deployment Values dialog box has no effect, because themonitor configuration
properties in the templatemust be checked against the remote server on which the template is being
deployed.

l When publishing changes to a template that contains a custommonitor, we recommend using theDisable
custom monitors while publishing changes option (selected by default) inPreferences >
Infrastructure Preferences > Custom Monitor Settings. Themonitor is temporarily disabled before
changes are published and is restored to the enabled state after changes have beenmade.

l Setting status thresholds using a baseline is not supported on user-definedmetrics.
l You can use third-party .jar files without removing the JVM security from the registry by adding the _
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scriptSandboxRuntimePermissions property to the <SiteScope root directory>;\groups\
master.config file, and specifying the permitted jar files. For example, to use signed libraries
jopcagtbase.jar and jopcagtmsg.jar, configure the parameter as follows: _
scriptSandboxRuntimePermissions=loadLibrary.jopcagtbase, loadLibrary.jopcagtmsg.
For the types of runtime permissions that can be used, see Runtime Permission class in the Java API
documentation (http://docs.oracle.com/javase/7/docs/api/java/lang/RuntimePermission.html).

Custom Monitor Troubleshooting
l Errors in themonitor (including errors in the script) are written to the SiteScope logs in the sameway as for
any other monitor. Check the error.log andRunMonitor.log files.

l Error messages from the script are displayed in the custom_monitor.log file located in <SiteScope root
directory>\logs\custom_monitors. This log can be used for info, warning, error, and debugmessages
from running the script.
To change the log level toDEBUGmode, in <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties, change ${loglevel} toDEBUG in the
following paragraph:
# Custommonitors category
log4j.category.CustomMonitor=${loglevel},custom.monitor.appender
log4j.additivity.CustomMonitor=false change

l For query-based custommonitors: If running a dynamic query from within a data processing script fails, an
exception is thrown.
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Chapter 25: Set Monitor Thresholds Using a
Baseline
Creating a baseline enables you to learn the normal performance of your applications. Knowing how an
application typically performs enables you to determine whether a performance problem is an isolated incident
or a sign of a trend. This section provides information about baselines and how to set monitor thresholds using
a baseline.

Learn About
Baseline Overview
Baselines enable you to understand how your applications typically perform and determine whether a
performance problem is an isolated incident or a sign of a significant downward performance trend. Baseline
data is gathered frommonitor performancemetrics over a period of time and is used to provide a comparison
for establishing acceptable or expected threshold ranges. When themonitor's performance exceeds that
range by some value (or does not reach that range, for example, in the case of Free Disk Space), themonitor
can signal an error or warning. The acceptable threshold range of amonitor is determined by how far the
current performance is from the baseline.

Baselines are updated periodically as new metrics data are received.

Calculating the Baseline
To enable SiteScope to begin calculating baselines, you select the groups, monitors, or both, to be used for
collecting baseline data. You can also select the schedule ranges used for collecting baseline threshold data.
This enables you to restrict to certain days or hours of the week the periods during which SiteScope collects
data for the baseline calculation. For example, youmay want themonitor status to be based on results
gathered during peak business hours only.

You can also select the adherence level used for determining the extent to which values for the baseline
calculation affect the threshold values and set threshold boundaries for all monitor measurements. For details,
see "Baseline Adherence Level" on page 287 and "Good and Error Boundaries" on page 287.

The baseline engine calculates the baseline for each schedule usingmeasurements collected from the
monitors during the data collection period. SiteScope uses a percentile algorithm in the baseline calculation, in
which a percentile value is used to determine the value of the baseline. For details on how baseline thresholds
are calculated, see "Baseline Threshold Values" on page 288.

Activating the Baseline
After the baseline is calculated, you can review a summary of calculatedmonitors and analyze the baseline
data in the Activate Baseline dialog box. The dialog box lists all themonitor instances for which a baseline
was calculated, the date of the baseline calculation, and the reduction in the number of error and warning
statuses that would have been generated for amonitor if the baseline thresholds were applied. If SiteScope is
unable to calculate a baseline for amonitor, it lists a reason for calculation failure.

You can also view a graph that displays the current thresholds, the baseline thresholds, and historical data of
all baseline-relatedmonitor measurements over a 24-hour time period for eachmonitor measurement. The
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graph includes an annotation tool that enables you to annotate a snapshot of the graph you are viewing, to
highlight important areas. You can save, print, or email an annotation graph. For user interface details, see
"Annotation Tool" on page 299.

After reviewing the baseline data, you can activate baseline threshold configuration. This applies the baseline
values to the thresholds for the selectedmonitors. You can also activate the baseline for monitors that failed
for the reason Insufficient data by using the limitedmeasurement samples that were collected.

Before activating the baseline threshold, consider saving the current monitor configuration, because you
cannot undo threshold configuration changes (and go back to the previous settings) after the baseline has
been activated.

When the baseline is activated, the baseline thresholds are displayed in the Threshold Settings panel for each
monitor. The baseline value is recalculated each day according to the history samples collected for the
measurement and the current day's readings, and the baseline threshold values are recalculated and updated
accordingly.

At any time, you can create a baseline summary report showing the baseline status and baseline status
description for eachmonitor in the selected context.

Tasks
How to Set Monitor Thresholds Using a Baseline
This task describes the steps involved in settingmonitor thresholds using a baseline.

1. Configure baseline setting preferences - optional
You can view and define the values of global SiteScope baseline settings in Infrastructure Preferences.
This includes calculation and activation priority settings, the number of days of historical data to include
in baseline calculations, and the offset for calculating the error boundary.
For user interface details, see "Baseline Settings" on page 546.

2. Calculate the baseline
Define thresholds on themonitor measurements for which the baseline should be calculated.
a. Select themonitor instances you want to baseline. For user interface details, see "Select Monitors

for Baseline Calculation" on page 291.
b. Select one or more schedule ranges to be used for collecting baseline data, or accept the default

schedule (Every day, all day). For user interface details, see "Schedule" on page 292.
c. Select the global baseline adherence level that is used for determining the extent to which values for

the baseline calculation affect the threshold values for all monitor measurements. For user interface
details, see "Adherence Level" on page 292.

d. Additionally, you can click the Fine-Tune Adherence Levels/Set Boundary button to:
o Individually fine-tune the baseline adherence level for any monitor measurement.
o Define a good boundary for eachmonitor measurement. A measurement within this boundary is

not in error status, even though it should report an error according to existing baseline percentiles.
For user interface details, see "Fine-Tune Adherence Levels/Set Boundary Dialog Box" on
page 293.

e. Click Calculate to perform the baseline threshold calculation.
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Example:Calculate Baseline dialog box - only monitors that the user is eligible to see according
to their user permissions are displayed

Example: Fine-Tune Adherence Levels/Set Boundary dialog box
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3. Review the baseline settings
Review the summary of calculatedmonitors and baseline data in the Activate Baseline dialog box. Only
themonitors that the user is eligible to see according to their user permissions are displayed.
For user interface details, see "Activate Baseline Dialog Box" on page 305.

Example:Activate Baseline dialog box - only monitors that the user is eligible to see according to
their user permissions are displayed
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4. View the baseline monitor measurements graphs
You can view a graphical display of eachmonitor's baselinedmeasurements to analyze the baseline data
for a selected day. You can also use the annotation tool to create a snapshot of the graph you are viewing
and highlight important areas.
For user interface details, see "BaselineMonitor Measurement Graphs Dialog Box" on page 296.

Note: The data displayed in the graphs is an aggregate of themeasurement data and as such, the
time periods may not accurately reflect the time the data was collected.

Example:BaselineMonitor Measurements Graph
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5. Activate the baseline settings
Select themonitors for which you want to set thresholds using a baseline, and click Activate. You can
select all monitors with a successfully calculated baseline, and those that failed with the reason
Insufficient data (indicated by Yes in theCan Be Activated column). Themonitor thresholds are
configured according to the baseline calculation, and are set to change status when the thresholds
settings are exceeded.
For user interface details, see "Activate Baseline Dialog Box" on page 305.

Note: If you want to revert to the current monitor threshold configuration, save the current monitor
configuration before activating the baseline configuration.

6. View baseline properties in the Baseline Status Report
You can create an ad hoc report showing information about eachmonitor in the selected context,
including eachmonitor's baseline status and baseline status description. For user interface details, see
"Baseline Status Report" on page 303.
You can also track the baseline status for amonitor in themonitor's Baseline Settings. For user interface
details, see "Baseline Settings" on page 267.
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Example:Baseline Status Report

7. View and modify baseline thresholds
In the Threshold Settings, you can view the baseline thresholds andmanually fine-tune the thresholds by
changing the percentile value from which the threshold value is derived.
For user interface details, see "Threshold Settings" on page 248.

Example:Monitor's baseline threshold settings
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In the example, theError if percent used threshold value is >= 42.81 and theWarning if percent
used threshold value is >= 40.77 (both these values are non-editable). To change the threshold
values, youmust change the percentile value from which the threshold values are derived. To help
you understand what the new threshold value is after you change the percentile value, click the
Percentiles Table button to open the percentile table that shows the threshold value that is
mapped to each percentile range.

Note: TheError if percent used (default)> 90 threshold is the error boundary. This is the value of a
measurement considered to be in error status, even though according to existing baseline
percentiles it should not report an error. For example, if the baseline threshold were updated toError
if percent used (%)>= 96, all measurements greater than 90 are in error status, even if the
calculated baseline error threshold of 96 is not exceeded. For details on this topic, see "Good and
Error Boundaries" on the next page.

Tips/Troubleshooting
Notes and Limitations
l Only an administrator in SiteScope, or a user grantedAdd, edit or delete monitors orEdit or delete
monitors only permissions, can use the baseline feature to set monitor thresholds, and only for the
monitors that are in the users allowed groups list. Any user can view the Baseline Status Report
regardless of edit permissions.

l You cannot add or delete thresholds or measurements, or copy or movemonitors during the baseline
calculation process (up until the point that themonitor baseline is activated).

l If you add, edit, or delete thresholdmeasurements from browsablemonitors after the baseline is activated
for amonitor, themonitor needs to be recalculated and reactivated as a baselinemonitor.

l Baseline thresholds are not copied or moved along with the other group or monitor objects when copying or
moving a group or monitor with an activated baseline.

l If SiteScope is restarted before the remove baseline process is complete, the process is not continued
after the restart, and youmust run the remove baseline process again.

l If SiteScope is restarted before the baseline calculation or activation process is complete, it automatically
continues the process after the restart. Monitors with any other baseline status (Calculated, not
activated; Activation failed; Calculation failed; Baseline activated) are not affected by the restart.

l Before the baseline is calculated, themonitors should be enabled and permitted to run for a period long
enough for SiteScope to accumulate sufficient data to calculate the baseline. This period depends on the
Minimum number of days required for baselining andMinimum number of samples required for
baselining settings inPreferences > Infrastructure Preferences > Baseline Settings. For details, see
"Baseline Settings" on page 546. The baseline can still be calculated and activated even if themonitor has
insufficient data, although the calculationmay not be accurate.

l After you define a set of counters for a browsablemonitor and themonitor runs with these counters for
some time, if you later change the counters (for example, remove existing counters and/or add new
counters), and then you attempt to calculate baseline, the calculation results may be incorrect. This can
occur because old data, possibly for counters that no longer exist, interferes with the new data. The
calculationmay also be incorrect for counters that have not changed since themonitor was created. To
avoid this problem, do not make any changes to amonitor's browsable counters during theminimum
number of days period required for calculating the baseline.
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l You can change threshold related properties using Global Search and Replace, regardless of whether the
threshold was created using a baseline or manually. However, you cannot activate a baseline threshold for
amonitor using Global Search and Replace.

l During the baseline calculation and after the baseline is activated, only certain baseline threshold changes
are supported. The same restrictions apply when you change threshold related properties using Global
Search and Replace. For details on the threshold changes that are allowed, see "Changing Threshold
Settings" on page 253.

l Memory consumption increases for eachmonitor threshold set using a baseline. To reducememory
consumption, you can set the Interval for saving accumulated baseline data to disk settings in the
Baseline Settings. For details, see "Baseline Settings" on page 546.

Additional Information: Understanding Baseline
Calculations
This section includes:

l "Baseline Adherence Level" below
l "Good and Error Boundaries" below
l "Baseline Threshold Values" on the next page
l "How SiteScope Calculates Thresholds" on page 289
l "How SiteScope Calculates the Error Boundary" on page 289

Baseline Adherence Level
You can select the baseline adherence level used for determining the threshold value. This is the extent to
which values for the baseline calculation affect the threshold values for all monitor measurements. You can
select High adherence,Medium adherence, or Low adherence. The higher the adherence level, the closer
the threshold range is to themonitor measurement baseline values. Conversely, the lower the adherence
level, the further the threshold range is from themonitor measurement baseline values.

In addition to selecting the adherence level, you can also fine-tune the adherence level for individual monitor
measurements by configuring adherence percentiles separately for eachmonitor measurement. Adherence
levels are based on adherence percentiles—ameasurement value that determines when ameasurement is in
error or warning. For browsablemonitor measurements, you can configure only one set of adherence
percentiles that is used by all browsablemonitors.

Tomanually fine-tune the adherence level, you need to understand how the threshold values are created. For
details on this topic, see "Baseline Threshold Values" on the next page.

Good and Error Boundaries
Configuring good and error boundaries is useful to avoid setting off errors and warnings unnecessarily when
using baseline thresholds. You canmanually set a good boundary for eachmonitor measurement and the
browsablemonitor counters. SiteScope automatically configures the error boundary for eachmonitor
measurement.

Note: To set good boundaries, it is important to understand how baseline threshold values are created.
For details on this topic, see "Baseline Threshold Values" on the next page.
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Good Boundary

This is the value of ameasurement that is not considered to be in error status, even though according to
existing baseline percentiles it should report an error. For example, consider a low load system where CPU
utilizationmeasurements are constantly below 3%. Based on thesemeasurements, SiteScopemight
calculate a baseline threshold with a 5% error threshold. Because this is not an accuratemeasure of CPU
load error, youmay want to define 70% CPU utilization as the good boundary to avoid generating false errors.
Provided CPU utilization remains below this limit (even though it is above the baseline error threshold), the
monitor is not in error status.

Youmanually set the Good Boundary in the Fine Tune Adherence Levels /Set Boundary dialog box. For user
interface details, see "Fine-Tune Adherence Levels/Set Boundary Dialog Box" on page 293.

Error Boundary

This is the value of ameasurement that is considered to be in error status, even though according to existing
baseline percentiles it should not report an error. This can occur when ameasurement value grows slowly
over a period of time, for example, due to a slow memory leak. Because the baseline threshold is recalculated
and updated every day as themeasurement average increases, themeasurement value does not cross the
new threshold.

To overcome this problem, SiteScope automatically sets the error boundary for eachmonitor measurement. It
does this by setting a limit that triggers errors whenmonitor measurements exceed a specified value,
regardless of the baseline. For example, if SiteScope sets an error boundary of 80% CPU utilization, values
over 80% CPU utilization are in error status even if the calculated baseline error threshold is not exceeded.

For information on how the error boundary is calculated, see "Baseline Threshold Values" below.

Baseline Threshold Values
To help you fine-tune the percentile value used in the baseline calculation at each adherence level and to set
the "Good and Error Boundaries" on the previous page, it is important to understand:

l The types of threshold values.
l How they are applied tometrics.
l How metrics are used to calculate baseline thresholds and boundaries.
Baseline thresholds are added or updated dynamically to themonitor configuration for eachmeasurement the
monitor had before the baseline was calculated. Baseline thresholds are added for each schedule selected for
collecting baseline data.

In general, there are two types of thresholds: baseline thresholds and static thresholds. Baseline thresholds
have a percentile value that is used to determine when ameasurement is in error or warning status, while
static thresholds have an actual fixed value. Baseline thresholdmetrics have a condition of either >= or <=
depending on the direction of themeasurement.

Baseline thresholds are changed, added, or deleted onmetrics provided the following two conditions aremet:

l Themeasurement can be used in the baseline calculation. To be used in the baseline calculation, a
measurement must be numeric and it must have a direction. An example of ameasurement that cannot be
used in the baseline calculation is a URL 404 error code (it is numeric, but it has no direction).

l Themeasurement has a static threshold defined for any schedule and any status category (Good,
Warning, Error) prior to the baseline calculation.

Metrics that do not adhere to these conditions are not affected (in terms of the thresholds defined on them),
and a baseline is not calculated for thesemetrics.
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How SiteScope Calculates Thresholds
When SiteScope calculates the baseline, it creates a percentile value for each baselinable threshold
measurement for each schedule. SiteScopemakes an adjustment for extrememetrics by discarding, by
default, 2% of themost extreme samples (considered "noise" metrics), and calculates the percentiles on the
remainingmetrics. For example, if most monitor run results on a server show CPU utilization of nomore than
20% and one peak value of 50%, the peak value is not used to determine the baseline. You can change the
percentage of discardedmeasurement samples in the Baseline Settings.

The baseline engine uses a sliding-window approach to calculate thresholds. This means that newer data
samples havemore influence on the baseline calculation than older samples, and that after a period of time
(by default 30 days), the historical data becomes obsolete. You can set the number of days to include in the
calculation in the Baseline Settings.

For information about configuring Baseline Settings, see "Infrastructure Preferences" on page 517.

How SiteScope Calculates the Error Boundary
SiteScope uses the percentile value to create an error boundary for eachmeasurement. This is the value of a
measurement that is considered to be in error status, even though according to existing baseline percentiles it
should not report an error. For details, see "Good and Error Boundaries" on page 287.

SiteScope calculates the error boundary in one of the following ways:

l If themeasurement has a static error threshold for the specific schedule, the percentile value of the
baseline threshold is calculated into an actual value and this value is then compared to the value of the
static threshold as follows:

l If the static error threshold value is more extreme than the baseline threshold value, the static error
threshold value is used as the error threshold boundary for that measurement.

Example:

If the static error threshold is 100%CPU utilization and the computed baseline threshold is 67%CPU
utilization, the static error threshold value (100%CPU utilization) is used as the error boundary.

l If the baseline threshold value is more extreme than the static error threshold value, then the offset value
is used. The offset is a percentage value that SiteScope adds to the baseline threshold value (or
subtracts from, depending on the direction of themeasurement), and the resulting value is used as the
error boundary for that measurement. You can determine the offset value in the Baseline Settings panel
of Infrastructure Preferences.

Example:

If the static error threshold for a schedule is 60%CPU utilization and the computed baseline threshold
value is 65%CPU utilization, the error boundary is calculated as:
65%CPU utilization * 130% (using the default offset value of 0.3) = 84.5%CPU utilization.

l If there is no error threshold value for themeasurement with the specific schedule prior to calculating the
baseline (themeasurement has a warning or good threshold value but no error threshold value), and the
Automatically create an error boundary if no error thresholds are defined option is selected in the
Baseline Settings, the percentile value of the baseline threshold is calculated into an actual value and the
offset value is added to/subtracted from the baseline threshold value (depending on the direction of the
measurement). The resulting value is used as the error boundary for themeasurement.
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Note: An error boundary is not created if:

l There is no error threshold value for themeasurement with the specific schedule prior to calculating
the baseline (for example, themeasurement has a warning or good threshold value but no error
threshold value), and

l TheAutomatically create an error boundary if no error thresholds are defined option is not
selected.

For details on defining the offset value and automating error boundary creation, see "Infrastructure
Preferences" on page 517.

Baseline Thresholds User Interface
This section includes:

l "Calculate Baseline Dialog Box" below
l "Fine-Tune Adherence Levels/Set Boundary Dialog Box" on page 293
l "Percentile RangeMapping Table" on page 294
l "Backup Configuration Dialog Box" on page 296
l "BaselineMonitor Measurement Graphs Dialog Box" on page 296
l "Annotation Tool" on page 299
l "Remove Baseline Dialog Box" on page 302
l "Baseline Status Report" on page 303
l "Activate Baseline Dialog Box" on page 305

Calculate Baseline Dialog Box
This dialog box enables you to select the groups, monitors, or both, to include in the baseline calculation,
select the time range schedule for collecting baseline data, select and fine-tune the adherence level to
determine the extent that monitor measurement sample values have on the threshold values, and calculate
the baseline threshold.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope container, a
group, or amonitor, and select Baselining > Calculate.
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Important
information

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete monitors or
Edit or delete monitors only permissions can use the baseline feature to set monitor
thresholds, and only for themonitors that are in the users allowed groups list. Monitors in
groups for which the user does not have permissions are not displayed in the dialog box.
For details on user permissions, see "User Management Preferences" on page 625.

l The amount of time required to calculate the baseline thresholds depends on the speed of
the SiteScope server and the number of monitors selected for baselining. If SiteScope
needs to restart before the calculation process is complete, SiteScope automatically
continues the process after the restart.

l Enable themonitors run for a period that is long enough for SiteScope to accumulate
sufficient data to calculate the baseline. This period depends on theMinimum number
of days required for baselining andMinimum number of samples required for
baselining settings in Infrastructure Preferences. For details, see "Infrastructure
Preferences" on page 517. The baseline can still be calculated and activated even if the
monitor has insufficient data, although the calculation is unlikely to be accurate.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

Select Monitors for Baseline Calculation
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<List of available
groups and/or
monitors>

Groups, monitors, or both, to include in calculating the baseline threshold. The list
includes the currently selected container and all of the child containers that are in the
users allowed groups list.

Default value: The current container and all child elements are selected.

Note:You cannot select amonitor instance if:

l Its baseline has already been activated. In such cases, the selection check box is
not displayed.

l There is another monitor in SiteScope with the same name (the file path, group
name, andmonitor name are identical). In such cases, Duplicate name appears
next to themonitor name.
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Schedule
User interface elements are described below:

UI
Element Description

Schedule
Range
Name

Schedule ranges used for collecting baseline threshold data. This enables you to restrict to
certain days or hours of the week the periods during whichmonitor data is collected for the
baseline calculation. The baseline thresholds that are created are only effective for the same
schedule range period. The range schedules displayed are created inSchedule Preferences.
For more information about creating range schedules, see "Schedule Preferences" on
page 608.

Note:You can select multiple ranges using the CTRL or SHIFT keys.

Default value: If no schedule range is selected, baseline threshold data is collected all day,
every day.

Adherence Level
User interface elements are described below:

Description Enables you to select the adherence level that determines the extent to whichmonitor
measurement sample values used in calculating the baseline affect the threshold values.
The adherence level is based on a percentile value that is applied to all monitor
measurements to determine when ameasurement is in error or warning. You can also fine-
tune the adherence level for individual monitor measurements, and set the Good Boundary.

To access: In themonitor tree, right-click the SiteScope container, a group, or amonitor,
and select Baselining > Calculate. Expand theAdherence Level panel.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Additional Information: Understanding Baseline Calculations" on page 287

User interface elements are described below:

UI Element Description

Low
adherence

The further the values used to update the thresholds are from the values calculated by the
baseline. Select this option if you aremore tolerant to extrememeasurement values having
an effect on the baseline.

Medium
adherence

The values used to update the thresholds are at amid-range from the values calculated by
the baseline (default setting).

High
adherence

The closer the values used to update the thresholds are to the values calculated by the
baseline. Select this option if you are less tolerant to extrememeasurement values having
an effect on the baseline.
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UI Element Description

Fine-Tune
Adherence
Levels/Set
Boundary

Opens the Fine-Tune Adherence Levels/Set Boundary dialog box, enabling you to fine-tune
the baseline adherence level and define a good boundary for any measurement of any
monitor type within the selected context. For user interface details, see "Fine-Tune
Adherence Levels/Set Boundary Dialog Box" below.

Fine-Tune Adherence Levels/Set Boundary Dialog Box
This dialog box displays the percentile value used in the baseline calculation at each adherence level and the
good boundary (if configured), for eachmonitor measurement in the selected context. This enables you to fine-
tune the baseline adherence level and set good boundaries for any measurement of any monitor type.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope container, a
group, or amonitor, and select Baselining > Calculate. Expand theAdherence Level
panel, and click the Fine-Tune Adherence Levels/Set Boundary button.

Important
information

You can set adherence level percentile values to over 100%. This enables you to raise the
threshold level above the level that would have been set, based on the sample
measurements collected. For example, if measurements collected for CPU Utilization are
between 10%-60%, and you only want to get errors above 80%CPU Utilization, set theError
Percentiles Low value to a percentile that raises the error threshold level to the desired
level. In this instance, set the percentile to 134% (60%CPU Utilization * 134% = 80.4% CPU
Utilization).

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

User interface elements are described below:

UI Element Description

Reset. Restores the default error and warning threshold adherence level values for the
monitor measurement and to remove theGood Boundary.

Select All. Selects all listedmonitor measurements.

Clear Selection. Clears the selection.

Monitor
Name:
Measurement
Name

For eachmonitor in the selected context, displays themeasurements that are used in the
baseline calculation. It also displays onemeasurement that represents the
measurements for all browsablemonitors (at the bottom of the list).

Warning
Percentiles

Displays the Low,Medium, andHigh adherence level percentile value that is used to
calculate the warning baseline threshold. For more details on this topic, see "Baseline
Adherence Level" on page 287.

Default value: Low 110; Medium 93; High 90
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UI Element Description

Error
Percentiles

Displays the Low,Medium, andHigh adherence level percentile value that is used to
calculate the error baseline threshold. For more details on this topic, see "Baseline
Adherence Level" on page 287.

Default value: Low 120; Medium 98; High 95

Good
Boundary

Displays the actual value for the Good Boundary for eachmonitor measurement type.
This is the value of ameasurement that is not considered to be in error status, even
though according to existing baseline percentiles it should report an error. For more
details on this topic, see "Good and Error Boundaries" on page 287.

Default value:No value

All browsable
monitor
measurements

Displays the Low,Medium, andHigh adherence level percentile value that is used to
calculate the warning and error baseline threshold for all browsablemonitor
measurements.

Default Warning values: Low 110; Medium 93; High 90

Default Error values: Low 120; Medium 98; High 95

Percentile Range Mapping Table
This table displays the actual value that is mapped to each percentile range. SiteScope uses the percentile
value to define the baseline error and warning thresholds. Use this table to view the actual value that
corresponds to the percentile value, and tomanually change the percentile value.

To access Select theMonitors context. In themonitor tree, select amonitor with an activated baseline
(you can check whether amonitor has an activated baseline by right-clicking a group or
monitor, and select Baselining > Status Report). Expand themonitor's Threshold
Settings, and click thePercentiles Table button.

Important
information

This table is available for monitors with an activated baseline only.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also l "Set Monitor Thresholds Using a Baseline" on page 279
l "Threshold Settings" on page 248
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User interface elements are described below:

UI Element Description

Percentiles
Range

Percentile range that correlates to the actual value used for defining the baseline error and
warning thresholds. You can set the number of percentile ranges displayed in the table from
the SiteScope Preferences (Preferences > Infrastructure Preferences > Baseline
Settings).

Note: The left-hand value is exclusive and the right-hand value is inclusive. This means that
for a percentile range of 33-100, all values above 33 (but not 33 itself) up to 100 are included
in the range. The value 33 falls into the previous range and 100.01 falls into the next range.

Actual
Value

The actual value that is mapped to the percentile range.

Current
Percentile

Percentile value that correlates to the actual value that is used to define the baseline
thresholds.

Note:

l You can set the current percentile to a value over 100%. This enables you to raise the
threshold level above the level that would have been set, based on the sample
measurements collected. For example, if measurements collected for CPU Utilization
are between 10%-60%, and you only want to get errors above 80%CPU Utilization, set the
percentile value to a percentile that raises the error threshold level to the desired level. In
this instance, set the percentile to 134% (60%CPU Utilization x 1.34 = 80.4%CPU
Utilization).

l SiteScope calculates the percentile range as follows:
l For ranges below 100%, percentiles represent the amount of samples in each range.
So the 80th percentile is the range that 80 percent of the CPU Utilization values are
smaller than or equal to.

l Ranges above 100%: The 110th percentile is calculated as the 100th percentile x 1.1
(66.42 x 1.10 = 73.06); the 120th percentile is calculated as the 100 percentile x 1.2 ( 
66.42 x 1.2 = 79.7), and so forth.
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Backup Configuration Dialog Box
This dialog box enables you to save the current monitor threshold configuration before activating the baseline
threshold. You use the Configuration Tool to restore the configuration settings. For details on the
Configuration Tool, see the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, a group, or
amonitor and select Baselining > Review & Activate. Click theBackup Configuration
button.

Important
information

Create a backup configuration before activating the baseline configuration, since you cannot
undo threshold configuration changes after the baseline has been activated.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

User interface elements are described below:

UI Element Description

Enter target
directory

Target directory where the backup configuration file is saved or use the default SiteScope
installation directory.

Default value:C:\SiteScope

Enter the
backup file
name

Name for the configuration backup file. By default, the file is named using the format:
SiteScope_<MM_DD_YYYY>_<HH_MM_SS>. SiteScope saves a backup file in zip format to the
specified location.

Example:SiteScope__11_05_2008_08_24_06

Baseline Monitor Measurement Graphs Dialog Box
This dialog box displays a graph per measurement, for all themeasurements of themonitor. The default date
selected for displaying the graph is the day with themaximum error reduction. Each graph shows the current
warning and error thresholds, the baseline warning and error thresholds, and historical data of all baseline-
relatedmonitor measurements over a 24-hour time period (from 00:00-23:59).
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To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, a group or a
monitor container, and select Baselining > Review & Activate. In theSuccessfully
Calculated Monitors panel, select amonitor with calculated baseline data, and click the
View Graph button.

Important
information

The data displayed in themonitor measurement graphs is an aggregate of themeasurement
data and as such, the time periods may not accurately reflect the time the data was
collected.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

Graph Settings
User interface elements are described below:

UI
Element Description

Annotation Tool. Creates a snapshot of the graph you are viewing and highlight important
areas of the graph by drawing shapes, lines, and adding text to the snapshot. For user interface
details, see "Annotation Tool" on page 299.
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UI
Element Description

Collapse Report Filter. Click to collapse or expand the report filter.

Tooltip:When the collapsible report filter closes, the icon's tooltip displays details about the
selections youmade in the filter.

Run. After you have specified the report setup, click to run the report for the date displayed in
the date link.

Historic
date
<date
link>

Opens the calendar, enabling you to select the date for which you want to createmonitor
measurement graphs. The calendar contains the following buttons:

l Revert. Returns to the previously selected report date.
l Current. Selects today's date in the calendar.
l OK. Updates the date link for the selected date and closes the calendar.
l Cancel. Closes the calendar without making any changes.

Graph Content
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Legend> Describes the color coding used in the graph.

Measurement
name

Name of themeasurement appears above the graph.

Date Time and date on which the graph was generated.

<Data points> Displays for each 2 hour period of time on the Time axis, the value for the selected
monitor measurement.

Tooltip: Themeasurement value.

<Measurement
Type> <y-
axis>

Displays themonitor measurement type.

Hours <x-
axis>

Time division units for the date specified when generating the report (from 0-24 hours).

Baseline Error
Threshold

Displays the baseline threshold line that determines Error status. Measurements beyond
this line exceed the error baseline status threshold for themonitor. This is displayed on
the graph as a solid red line.

Baseline
Warning
Threshold

Displays the baseline threshold line that determinesWarning status. Measurements
beyond this line exceed the warning baseline status threshold for themonitor. This is
displayed on the graph as a solid orange line.
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UI Element Description

Current Error
Threshold

Displays the threshold line that determines Error status. Measurements beyond this line
exceed the error status threshold for themonitor. This is displayed on the graph as a
dashed black line.

Current
Warning
Threshold

Displays the threshold line that determinesWarning status. Measurements beyond this
line exceed the warning status threshold for themonitor. This is displayed on the graph
as a dashed blue line.

Annotation Tool
This tool enables you to annotate a snapshot of the report you are viewing, to highlight important areas. The
Annotation Tool is available when viewing BaselineMonitor Measurements Graphs. The Annotation Options
enable you to customize your snapshot.

The AnnotationMenu Bar contains elements that enable you to:

l Change the appearance of the snapshot.
l Save, print, or email an annotation report.
l Customize the appearance of text annotated onto your snapshot. These elements are enabled only when
the Text Tool button is selected.

To access Click theAnnotate button on the right side of the page.

Important
information

To use the Annotation Tool, the Sun JRE plug-in 1.6.0_x (latest version recommended)
must be installed on your machine. If the plug-in is not installed on your machine, you are
prompted to install it.

See also "Set Monitor Thresholds Using a Baseline" on page 279

Annotation Options
User interface elements are described below:

UI Element
(A–Z) Description

Pan Tool. Click to navigate the snapshot.

Select Tool. Click to select a specific area of the snapshot.
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UI Element
(A–Z) Description

Shape Tool. Click to add a shape to the snapshot. Clicking the shape tool button enables
the following shape buttons:

l Rectangle. Click tomark an area of the snapshot with a rectangle.

l Filled Rectangle. Click tomark an area of the snapshot with a filled rectangle.

l Oval. Click tomark an area of the snapshot with an oval.

l Filled Oval. Click tomark an area of the snapshot with a filled oval.

l Rounded Rectangle. Click tomark an area of the snapshot with a round
rectangle.

l Filled Rounded Rectangle. Click tomark an area of the snapshot with a filled
round rectangle.

Customization. After selecting this button, you can customize your line appearance
through the following parts of the interface:

l Line Type. Choose the type of line you want to add. Options include:
l Solid Line

l Jagged Line

l Line Width. Select the width of the line, in pixels, in the annotation.

Line Tool. Click to enable the line tool, whichmarks the selected area of the snapshot
with a line.

Customization. After selecting this button, you can customize your line appearance
through the following parts of the interface:

l Line Style. Choose the style of line you want to add. Options include:
l Regular line

l Line with endpoints

l Line with arrows

l Line Type. Choose the type of line you want to add. Options include:
l Solid Line

l Jagged Line

l Line Width. Select the width of the line, in pixels, in the annotation.

Text Tool. Click to add text to the snapshot.

Example:Add the syntax This is the problematic transaction above a line
marking an area of the report.
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UI Element
(A–Z) Description

Border and
Fill Colors

Select the relevant square to choose the color of the border and fill of your annotations.
The available squares are:

l Upper Square. Click to choose the color of lines, as generated by the line tool and
displayed in unfilled shapes.

l Lower Square. Click to choose the color to fill shapes.
Clicking either of the squares generates a dialog box with the following tabs where you
choose the color:

l Swatches
l HSB
l RGB

Opacity Slide the opacity bar to choose the darkness level of the selected shape line, text line, or
shape color in the annotation.

Note:

l A higher opacity percentagemeans that the selection appears darker. A lower opacity
percentagemeans that the selection appears lighter.

l This field is enabled when either the shape tool, line tool, or text tool button is
selected.

Annotation Menu Bar
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A–Z) Description

Save. Saves the snapshot on your local machine.

Note:

l The snapshot is saved in .png format.

l You cannot select theNew Folder icon when saving in theMy Documents directory or
any of its subdirectories.

Select All. Selects all of the annotations added to your snapshot.

Clear Selected. Clears all annotations.

Undo. Rolls back themost recent action performed on the snapshot.

Redo. Cancels the roll back of themost recent action performed on the snapshot.
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UI
Element
(A–Z) Description

Zoom In. Brings the snapshot view closer.

Zoom Out. Sets the snapshot view further away.

Restore original size. Restores the snapshot to its original size.

Print. Prints the snapshot.

Send E-mail. Click to send the snapshot via email.

Save to repository. Uploads the snapshot to Report Manager. For details on Report Manager,
see "Report Manager Overview" in the APMUser Guide in the APMHelp.

Note: This option is not available when accessing the Annotation Tool from SiteScope.

Help. Displays online documentation help for the page you are currently viewing.

Bold. Bolds the text.

Note: This field is enabled only when selecting the Text Tool button.

Italic. Italicizes the text.

Note: This field is enabled only when selecting the Text Tool button.

Underline. Underlines the text.

Note: This field is enabled only when selecting the Text Tool button.

Anti-aliasing. Adjusts the pixel reading of text or annotation lines so that they appear
smoother.

Note: This field is only enabled when selecting the Text Tool button.

<Font
Family>

Select the font for the text in the report.

Note: This field is only enabled when selecting the Text Tool button.

<Font
Size>

Select the size of the font in the report.

Note: This field is only enabled when selecting the Text Tool button.

Remove Baseline Dialog Box
This dialog box enables you to select the groups, monitors, or both from which to remove the baseline. You
must remove amonitor's existing baseline calculation before you can recalculate themonitor's threshold
baseline.
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To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, a group, or
amonitor and select Baselining > Remove.

Important
information

Only an administrator in SiteScope, or a user grantedAdd, edit or delete monitors orEdit
monitors only permissions can remove a baseline, and only for themonitors that are in the
users allowed groups list. Monitors in groups for which the user does not have permissions
are not displayed in the dialog box. For details on user permissions, see "User Management
Preferences" on page 625.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<List of
groups
and/or
monitors>

Groups, monitors, or both, from which you want to remove baseline threshold calculation.
The list includes all groups and/or monitors in the currently selected container, and all child
containers in the users allowed groups list.

Default value: The current container and all child elements are selected.

Baseline Status Report
This report displays information about the baseline status for all monitors in the selected context.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, a group, or
amonitor and select Baselining > Status Report.
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Important
information

l This is an ad hoc report that is not saved to the SiteScope configuration data for later
use.

l You can sort monitor types in ascending or descending order by clicking the column
header. An arrow is displayed showing the sort order direction.

l You can filter the display for Monitor Type and Baseline Status by clicking the down
arrow and selecting amonitor type or baseline status by which to filter. To clear the
filter, select (All).

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

User interface elements are described below:

UI
Element Description

Monitor
Name

Name and path of the SiteScopemonitor depending on the context.

Note:Only monitors in groups or subgroups that a user has permissions to access are
displayed in the report.

Monitor
Type

The type of SiteScopemonitor.

Baseline
Status

Themonitor's baseline status. The following statuses are available:

l Monitor not selected for baselining. Themonitor has not been selected for baselining.
l Calculating baseline. SiteScope is in the process of calculating the baseline.
l Calculation failed.SiteScope was unable to calculate a baseline.
l Calculated, not activated. A baseline was calculated for themonitor, but it has not yet
been activated.

l Activating baseline.SiteScope is in the process of activating the baseline.
l Activation failed.SiteScope was unable to activate the baseline.
l Baseline activated. The baseline has been activated for themonitor.

Baseline
Status
Details

Displays additional details for monitors with the following status:

l Calculating baseline. Displays the baseline calculation stage for themonitor.
l Calculation failed. Displays the reason that the baseline calculation failed (Insufficient
data, No measurements to baseline). Monitors that failed due to insufficient data are
selected by default for automatic baseline calculation after themonitors have run for a period
that is sufficient for SiteScope to accumulate data for the baseline period. For details, see
"Activate Baseline Dialog Box" on the next page.

Refresh Click during the calculation process to update the data in the status report.
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Activate Baseline Dialog Box
This dialog box displays a summary of the calculatedmonitor's baseline data, and enables you to save the
current monitor configuration, view baselinemeasurement graphs, view failed operations, and activate
baseline threshold configuration. For monitors that SiteScope is unable to calculate a baseline, it includes the
reason for the failure.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, a group, or
amonitor and select Baselining > Review & Activate.

Important
information

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete monitors or
Edit or delete monitors permissions can use the baseline feature to set monitor
thresholds, and only for themonitors that are in the users allowed groups list. Monitors in
groups for which the user does not have permissions are not displayed in the dialog box.
For details on user permissions, see "User Management Preferences" on page 625.

l To revert to the current monitor configuration, youmust create a backup configuration
before activating the baseline configuration.

l The amount of time required to activate the baseline threshold depends on the speed of
the SiteScope server and the number of monitors selected for baselining. If SiteScope
needs to restart before the activation process is complete, SiteScope automatically
continues the process after the restart.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 280

See also "Set Monitor Thresholds Using a Baseline" on page 279

User interface elements are described below:

UI Element Description

Successfully Calculated Monitors

View Graph. Displays a graphical representation of baseline data for all the
measurements of themonitor. For details, see "BaselineMonitor Measurement Graphs
Dialog Box" on page 296.

Select All. Selects all listedmonitors.

Clear Selection. Clears the selection.

Monitor Name Name of the SiteScopemonitor selected for baselining.

Calculation
Date

Date on which the baseline was calculated.
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UI Element Description

Error Status
Reduction

Reduction in the number of error statuses for amonitor if the baseline threshold were
applied. A negative number indicates an increase in the number of error statuses for a
monitor if the proposed baseline thresholds were applied.

Example:Suppose youmanually configure the threshold status for CPU Utilization to
Error if >= 65% and there are 5 error statuses for the CPU monitor (of which 3 errors
are for data samples between 65%-70%, and 2 errors for above 70%). If you have
SiteScope calculate the threshold using a baseline and the threshold is set to Error if
>= 70%, Error Status Reduction would be 3.

Note: The Error Status Reduction value is based on collected data on the calculation
date.

Tip: If more than three days have elapsed since the calculation date, we recommend
that you recalculate the baseline.

Warning Status
Reduction

Reduction in the number of warning statuses for amonitor if the baseline threshold were
applied. A negative number indicates an increase in the number of warning statuses for
amonitor if the proposed baseline thresholds were applied.

Example:Suppose youmanually configure the threshold status for CPU Utilization to
Warning if >= 55% and there are 3 warning statuses for the CPU monitor (of which 2
warnings are for data samples between 55%-60%, and 1 warnings for above 60%). If
you have SiteScope calculate the threshold using a baseline and the threshold is set to
Warning if >= 60%, Warning Status Reduction would be 2.

Note: TheWarning Status Reduction value is based on collected data on the
calculation date.

Tip: If more than three days have elapsed since the calculation date, we recommend
that you recalculate the baseline.

Failed Monitors

Select All. Selects all listed failedmonitors.

Clear Selection. Clears the selection.

Monitor Name Name of themonitor for which SiteScope was unable to calculate a baseline.
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UI Element Description

Reason for
Failure

Reason that SiteScope was unable to calculate a baseline value for themonitor. They
include:

l Insufficient data. Themonitor has not run for a sufficient period of time to collect
data to produce ameaningful baseline threshold. This period depends on the
Minimum number of days required for baselining andMinimum number of
samples required for baselining settings in Infrastructure Preferences. For
details on configuring the Baseline Settings, see "Baseline Settings" on page 546.

l No measurements to baseline. Themonitor has nomeasurements that can be
used in the baseline calculation. You cannot select themonitor for baseline
activation.

l No samples for the requested schedule. No data samples were collected for the
range schedule specified. You cannot select themonitor for baseline activation.

l Unknown. The reason for baseline calculation failure is unknown. You cannot
select themonitor for baseline activation.

Can Be
Activated

Indicates whether a baseline can be activated even if themonitor baseline calculation
failed.

Displays No if the baseline calculation failed for any reason other than Insufficient
data.

Displays Yes if the baseline calculation failed with the reason Insufficient data.
SiteScope uses the limitedmeasurement samples that were collected to calculate the
baseline.
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Chapter 26: Create Calculated Metrics
A calculatedmetric is ametric produced by performing an arithmetic function or logical operation on existing
SiteScopemetrics. The calculatedmetric then appears in the Thresholds Settings panel, enabling you to
configure thresholds based on that metric.

For example, you can create a calculatedmetric to calculate the average of two or more existingmetrics for a
monitor instance, and then configure a threshold that triggers an alert if that average exceeds a certain
number.

To access
Select theMonitors context. In themonitor tree, expand the group folder that contains themonitor, and select
themonitor. In the right pane, click theProperties tab, and select the CalculatedMetrics Settings panel.

Learn About
This section includes:

l "CalculatedMetrics Overview" below
l "Examples of CalculatedMetrics" below
l "CalculatedMetrics for Dynamic Monitors" on the next page

Calculated Metrics Overview
Use calculatedmetrics to:

l Analyzemetrics that are constantly changing, making it difficult to define status thresholds.
l Define new arithmetic or logic metrics based on SiteScope regular metrics.
l Enable you to run operations onmonitor metrics using out-of-the-box operators, such as sum, average,
minimum, maximum, frequency, and previous.

l Enhance the business impact of certain SiteScopemetrics.
To create a new calculatedmetric, you create an expression that consists of metrics, operators, and values.
You can check the validity of the expression at any time while creating the expression. To enable you to
distinguish between themetrics, operators, and values within an expression, they are separately color-coded.

You can also create calculatedmetrics when you create a templatemonitor instance. For details on creating
templatemonitors, see "How to Create aMonitoring Structure Using a Template" on page 677.

SiteScope calculates the results for calculatedmetrics, and the results appear in the SiteScope Dashboard
and in themonitor's status summary.

Examples of Calculated Metrics

Example 1:

Youwant to calculate the percentage of the page reads/sec to pages/sec for theMicrosoft Windows
Performance Counter monitor. Create a calculatedmetric on theMicrosoft Windows Performance
Counter monitor using the following expression:
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(<<Memory: Page Reads/sec>> / <<Memory: Pages/sec>>)*100

Example 2:

Youwant to calculate themaximum CPU usage on a CPU Monitor. Create a calculatedmetric on the
CPU Monitor using the following expression:

#max(<<CPU Utilization # 1>>, <<CPU Utilization # 2>>, <<CPU Utilization # 3>>, <<CPU
Utilization # 4>>)

Example 3:

Youwant to check themaximum utilization of vCenter environments. Create the following calculated
metric expression:

#max(<</labm3esx01/HostSystem/cpu/coreUtilization.average*/>>)

Calculated Metrics for Dynamic Monitors
Dynamic monitors automatically updatemetrics and thresholds according to ametrics pattern that specifies
themetrics you want to monitor. When creating a calculatedmetric expression, you can use only those
regular expressions that are part of the dynamic monitors’ configured patterns.

For example, the Dynamic Disk Spacemonitor tracks how much disk space is currently in use on your server.
When dynamic monitoring is configured, themetrics and thresholds are automatically updated as disks are
added to or removed from the server. This enables you to configure themonitor once, and leave it to detect
disks and file system changes.

You can configure calculatedmetrics for dynamic monitors based on a common function, such as average or
sum.

Example:

To calculate the total free space for all disks, create a calculatedmetric expression that is the sum of all
metrics created from /.*/MB free/ as follows:

SUM(<</.*/MB free/>>)

Note: You can use only one regular expression per calculatedmetric that is not part of a function (that is,
a calculatedmetric that returns only one result).

For more details on dynamic monitors, see Dynamic MonitoringMechanism in the SiteScopeMonitor
ReferenceGuide.

Tasks
How to Create a Calculated Metrics Expression
1. Prerequisites
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l Only a SiteScope administrator, or a SiteScope user grantedAdd, edit or delete monitors orEdit
or delete monitors permissions, can use the calculatedmetrics feature, and only for themonitors
that are in the user's allowed groups list. If a user does not have permissions to a group of monitors,
thosemonitors do not appear in the CalculatedMetrics Settings panel. For details on user
permissions, see "User Management Preferences" on page 625.

l To configure calculatedmetrics to perform some arithmetic functions, theremust be at least one
previous value of the selectedmetric. For example, you cannot calculate a previous function without
at least one previous run of themonitor.

2. Create a calculatedmetric expression
a. Select themonitor for which you want to create a calculatedmetric expression, and open the

CalculatedMetrics Settings panel in themonitor properties. For user inerface details, see
"CalculatedMetrics Settings" on the next page.

b. Configure the calculatedmetric expression to includemetrics, operators, and values.
To insert a metric or operator in theExpression field, double-click themetric or operator, or drag and
drop it into theExpression field. You can alsomanually enter it in theExpression field. The
selectedmetric or operator appears in theExpression field in purple.
o Metrics. The list of metrics is dynamically updated based on the type of monitor that you are

configuring. For example, for a Disk Spacemonitor, the available metrics are <<percent full>>
and <<MB free>>.

o Operators. Defines the relation between themetric and the value. Operators contain functions.
For details about operators, see "Operators" on page 313.

o Values. A number or numerical expression applicable to themetrics parameter. For relational or
Boolean operations, enter 1 or 0. For SiteScope functions, enter values in the inside parentheses
of the operator. For example, to calculate the average of the numbers 7, 9, and 11, enter those
numbers inside the operator parentheses as follows: #Average(7, 9, 11).

Note:

l Calculatedmetric expressions involving the following features cannot be calculated:
l A number divided by 0.
l A non-numerical string divided by a number. For example, the expression

<<Overlicensed status>>/100 for a License UsageMonitor cannot be calculated
because <<Overlicensed status>> is non-numerical.

For such calculatedmetrics, n/a appears in the Summary column of the Dashboard for
the relevant calculatedmetric.
For more details about available operations when creating calculatedmetric expressions,
see "Available Data Processing Operations" on page 334.

l You can include nested functions in expressions. For example, #average(#max
(<<access permitted>>.length,<<directory exists>>.length),2).

l Formonitors, the Summary column in the Dashboard displays themost recent
measurement results reported by themonitor. This may includemore than one
measurement, depending on themonitor type. For monitor groups, the summary displays
the number of monitors within the group and the number of monitors, if any, that are
reporting an error status.

l Owing to a limitation of the JavaScript engine, calculatedmetric expressions cannot
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include values greater than 252. For more details, see http://ecma-international.org/ecma-
262/5.1/.

3. Check the validity of the expression - optional
To enable you to distinguish between themetrics, operators, and values within an expression, they are
separately color-coded. If any character is missing from ametric or operator, themetric or operator
remains black.
To check the validity of the expression at any time while creating the expression, click Validate.

How to Set Combined Threshold Calculated Metrics
You can create calculatedmetrics which include logical expressions that can be used in thresholds.

To do this, configure two calculatedmetrics in theExpression field in the New/Edit CalculatedMetrics dialog
box, and insert an operator between those two calculatedmetrics.

Example:

(utilization cpu#11==3)&(utilization cpu#12==5)

UI Descriptions
Calculated Metrics Settings

UI Element Description

New. Enables you to creates a new calculatedmetric in the New/Edit CalculatedMetrics
dialog box. For details, see "New/Edit CalculatedMetric Dialog Box" below.

Delete. Deletes the selected calculatedmetric.

Edit. Enables you to edit the selected calculatedmetric.
For details, see "New/Edit CalculatedMetric Dialog Box" below.

Name Name that describes the calculatedmetric.

Expression Defines the calculatedmetric. Expressions includemetrics, operators, and values. For
details, see "New/Edit CalculatedMetric Dialog Box" below.

Description Optional description of the calculatedmetric to make it easier to understand what the
calculatedmetric does.

New/Edit Calculated Metric Dialog Box
This dialog box enables you to create a new calculatedmetric or edit an existing calculatedmetric.

UI Element Description

Calculated Metric Panel
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UI Element Description

Name Name that describes the calculatedmetric. The name should be unique, to distinguish it
from the names of other calculatedmetrics.

If you do not enter a name, the default name is Calculated Metric, followed by the number
of the calculatedmetric. For example, if there already exists one calculatedmetric for a
monitor and you create an additional calculatedmetric for that monitor, the default name of
the additional calculatedmetric is Calculated Metric 2.

Note: The following special characters are not supported in this field: " ' > <

Description Optional description of the calculatedmetric to make it easier to understand what the
calculatedmetric does.

Expression Calculatedmetric expressions includemetrics, operators, and values.

Validate Checks the validity of the syntax of the expression in theExpression field. If the expression

is valid, the ok test icon appears. If the expression is invalid, an Error dialog box
opens indicating that the expression could not be calculated.

Clear Deletes the expression in theExpression field.

Metrics Metrics to insert in theExpression field. The list of metrics is dynamically updated based on
the type of monitor that you are configuring. For example, for a Disk Spacemonitor, the
available metrics are <<percent full>> and <<MB free>>.

To insert a metric in theExpression field, double-click themetric, or drag and drop the
metric into theExpression field. You can alsomanually enter themetric in theExpression
field. The selectedmetric appears in theExpression field in purple. If any character is
missing from ametric, themetric remains black; if you click Validate, it appears highlighted.

Operators Operators define the relation between themetric and the value. Operators contain functions.
For more details about operators, see "Operators" on the next page.

To insert an operator in theExpression field, double-click the operator, or drag and drop the
operator into theExpression field. You can alsomanually enter the operator in the
Expression field. The selected operator appears in theExpression field in blue. If any
character is missing from an operator, the operator remains black; if you click Validate, it
appears highlighted.

Integration Panel

Monitored
Entity

Displays the name of themonitored entity for the current calculatedmetric. If SiteScope is
connected to Application PerformanceManagement (APM), the Integration Panel displays
the CI that is reported to APM. For more details about monitored entities, see "Monitored
Entity" on page 314.

Note: If you have selected a CI in theCI Type field in the HP Integrations Settings panel,
this CI Type appears as themonitored entity in the CalculatedMetric Integration Panel. For
more information about the HP Integrations Settings panel, see "HP Integration Settings" on
page 253.
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Operators
Operators include:

l Arithmetic operators. +, -, *, /, (, ).
l Boolean operators.

Logical Binary

and & &&

or | ||

not ~ !

Note: You can use the operator | followed by zero (that is, |0) at the end of an expression to determine
whether the expression is true or false. For example, if themetric <<utilization cpu #1>> is
greater than themetric <<utilization cpu #2>>, the expression (<<utilization cpu #1>> >
<<utilization cpu #2>>)|0 returns the result 1, indicating that the expression is true. If the
expression is false, it returns the result 0.

l Relational operators. <, >, ==, !=, <=, >=.
l JavaScript String Object Methods:

.length .charAt() .concat() .indexOf() .lastIndexOf()

.match() .replace() .search() .split() .slice()

.substr() .substring() toLowerCase() .toUpperCase() .valueOf()

l SiteScope functions:
l #Average() - Calculates the average (mean) value among a series of numbers or value of numerical
expressions, separated by commas. For example, #Average(value 1, value 2, value 3)
calculates the average of value 1, value 2, and value 3.
This function works only if Java version 7 is installed on each client side user station.

l #Frequency() - Returns the value of themonitor running frequency in seconds. For example, if the
running frequency of amonitor is set at oneminute, #frequency() returns the result 60.0.

l #longToDate() - Converts a time stamp in numerical format to a regular readable format. The function
receives a number (Long) and converts it to a date string according to the date format in the second
parameter: #longToDate(Long, Date Format). The returned timestamp is the number of
milliseconds since January 1, 1970 00:00:00.000GMT. If GMT on the SiteScope server machine is set
to +6 for example, then the “start date” will be 1st January 1970 06:00:00.000

l #Max() - Returns themaximum value among a series of numbers or value of numerical expressions,
separated by commas. For example, #Max(value 1, value 2, value 3) calculates themaximum
value of value 1, value 2, and value 3.
This function works only if Java version 7 is installed on each client side user station.

l #maxMetric() - Returns the name of themetric which has themaximum value. It works only if the
expression includes regular expressions.
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For example, if the value of themetric <<Zone/l2sun23-z1/mem/%memory>> is greater than the value
of themetric <<Zone/l2sun23-z2/mem/%memory>>, then #maxMetric(<<Zone/l2sun23-
z1/mem/%memory>>,<<Zone/l2sun23-z2/mem/%memory>>) returns <<Zone/l2sun23-
z1/mem/%memory>> (but not its value).
This function works only for dynamic monitors.

l #Min() - Returns theminimum value among a series of numbers or value of numerical expressions,
separated by commas. For example, #Min(value 1, value 2, value 3) calculates theminimum
value of value 1, value 2, and value 3.
This function works only if you have installed Java version 7.

l #minMetric() - Returns the name of themetric which has theminimum value. It works only if the
expression includes regular expressions.

For example, if the value of themetric <<Zone/l2sun23-z1/mem/%memory>> is less than the value of
themetric <<Zone/l2sun23-z2/mem/%memory>>, then #minMetric(<<Zone/l2sun23-
z1/mem/%memory>>,<<Zone/l2sun23-z2/mem/%memory>>) returns <<Zone/l2sun23-
z1/mem/%memory>> (but not its value).
This function works only for dynamic monitors.

l #Previous() - Returns the value of ametric from the previous monitor run. For example, if theMB free
value of amemory monitor on its last run was 7828MB and its current run is 7821MB, #previous
(<<MB free>>) returns the result 7828.0.

l #Sum() - Returns the sum of a series of numbers or value of numerical expressions, separated by
commas. For example, #Sum(value 1, value 2, value 3) calculates the sum of value 1, value 2,
and value 3.
This function works only if Java version 7 is installed on each client side user station.

l #valueOf() - Returns the value of themetric. Themetric name should be inserted inside parentheses,
without angle brackets.

For example, you enter the expression #valueOf(#maxMetric(/(.)/cpu*1/) + "cpuClick"). If the
value of the regular expression (/(.)/cpu*1) is VM1/cpuBla1, then the returned value is VM1.

l #numberOfRuns() - Returns the sequential number of amonitor run 1,2,3… taken from themonitor
property with the name “sample”. This enables you to switch themonitor status for every run between
two states of themetric. For example, (#numberOfRuns()/2 + "").indexOf('.').

Monitored Entity
Most SiteScopemonitors report onemonitored CI to APM. This CI automatically appears as themonitored
entity in theMonitored Entity field. For monitors that report separate CI for eachmetric, the calculatedmetric
is connected to CIs according to the following table:

Note: After you have created a calculatedmetric with a particular monitored entity, you cannot later
select another monitored entity for that calculatedmetric. In that case, you need to delete the calculated
metric and create a new one with the desiredmonitored entity.
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Monitor
Name CI Type

Dynamic
Disk Space
Monitor

Always a computer.

SAP CCMS
Monitor

SAP System

Note: If a SAP CCMS monitor is not connected to APM, or you do not have the license
required to enable this monitor type, NODE appears in theMonitored Entity field.

SAPWork
Processes
Monitor

SAP ABAP Application Server

Note: If a SAP Work Processes monitor is not connected to APM, or you do not have the
license required to enable this monitor type, NODE appears in theMonitored Entity field.

Siebel Web
Server
Monitor

Siebel Web Server Extension

Note: If a Siebel Web Server Extensionmonitor is not connected to APM, or you do not
have the license required to enable this monitor type, NODE appears in theMonitored Entity
field.

Siebel
Application
Server
Monitor

Siebel Application Server

Note: If a Siebel Application Server monitor is not connected to APM, or you do not have the
license required to enable this monitor type, NODE appears in theMonitored Entity field.

Solaris
Zones
Monitor

In regular mode:

Youmust select amonitored entity by clicking theMonitored Entities button and
selecting amonitored entity from themonitored entity tree.

In template mode:

If the calculatedmetric includes a free regular expression, the "Monitored Entity is set by
regular expression" message appears in theMonitored Entity field. This means that the
monitored entity is calculated automatically during the template deployment. However, you
may still select amonitored entity by clicking theMonitored Entities button and
selecting amonitored entity from themonitored entity tree.

If the calculatedmetric does not include a free regular expression, youmust select a
monitored entity from themonitored entity tree.

For information about free regular expressions, see "Free regular expressions" on the next
page.

VMware
Performance
Monitor
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Monitor
Name CI Type

VMware
Host
Monitors

If the calculatedmetric includes a free regular expression, the "Monitored Entity is set by
regular expression" message appears in theMonitored Entity field. This means that the
monitored entity is calculated automatically for each calculatedmetric that results from the
calculatedmetric. However, youmay still select amonitored entity by clicking the
Monitored Entities button and selecting amonitored entity from themonitored entity
tree.

If the calculatedmetric does not include a free regular expression, youmust select a
monitored entity from themonitored entity tree.

For information about free regular expressions, see "Free regular expressions" below.

VMware
Datastore
Monitor

Free regular expressions

A free regular expression is a regular expression that is not inside a function. For more details about regular
expressions, see "Regular Expressions" on page 153.

For example, the following is a free regular expression: /.*VirtualMachine/.*/cpu/usagemhz.average[]/

This is calculated into four different calculatedmetrics, as follows:

labm3esx01/VirtualMachine/sisqavm01/cpu/usagemhz.average[]
labm3esx01/VirtualMachine/sisqavm02/cpu/usagemhz.average[]
labm3esx01/VirtualMachine/sisqavm03/cpu/usagemhz.average[]
labm3esx01/VirtualMachine/sisqavm04/cpu/usagemhz.average[]

Each of these calculatedmetrics has its ownmonitored entity according to the virtual machine name, as
follows:

sisqavm01
sisqavm02
sisqavm03
sisqavm04

Tips/Troubleshooting
Troubleshooting/Limitations
l The CalculatedMetrics Settings panel does not appear for custommonitors. You can create calculated
metrics in custommonitors inside their data processing script.

l You can create calculatedmetrics when you create a templatemonitor instance. For details on creating
templatemonitors, see "How to Create aMonitoring Structure Using a Template" on page 677.

l You can limit the number of calculatedmetrics per monitor that can be displayed in the Dashboard (default
is 100). In the case of dynamic monitors, the number of calculatedmetrics per monitor is calculated after
SiteScope has evaluated all dynamic monitors regular expressions. You can change themaximum
number of calculatedmetrics per monitor inPreferences > Infrastructure Preferences > Calculated
Metrics Settings. For details, see "CalculatedMetrics Settings" on page 541.
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Note: If you reduce themaximum number of calculatedmetrics to less than the number of calculated
metrics already configured for that monitor, the number of calculatedmetrics that appear in the
Dashboard and in the calculatedmetrics table for that monitor is the new maximum number of
calculatedmetrics and an error is written toRunMonitor.log.

l The Arithmetic Counters feature was deprecated and replaced by CalculatedMetrics. If you created
Arithmetic Counters in an earlier version of SiteScope and performed a SiteScope upgrade, you need to
recreate the counters in the CalculatedMetrics panel, and then delete the Arithmetic Counters.

l When you run a CPU Monitor on a server that has nometrics, the calculatedmetric result that appears in
the SiteScope Dashboard is n/a. If you then select a server that has metrics and run themonitor again, the
calculatedmetric result remains n/a. To obtain a calculatedmetric result for themonitor that has metrics,
you need to create a new calculatedmetric for that monitor.
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Chapter 27: Dynamic Monitoring Mechanism
Elastic or dynamic configuration is a way to automatically adjust the SiteScopemonitoring configuration
based on changes that are happening in your IT environment. SiteScope provides various dynamic monitors
that automatically update themselves over time by adding and removing counters as changes occur in the
system (for example, as disks/MBeans are added to or removed from the server, as datastores and virtual
disks are added or removed from the VMware Datacenters, or as virtual machines move from one host
system to another). In addition, you can select counter patterns to be used as threshold conditions. In this
way, thresholds are also updated automatically when the counters are updated.

Learn About
This section includes:

l "List of Dynamic Monitors" below
l "Dynamic MonitoringMechanism" below
l "CalculatedMetrics for Dynamic Monitors" on the next page

List of Dynamic Monitors
The following dynamic monitors are available in SiteScope:

l Dynamic Disk SpaceMonitor
l Dynamic JMX Monitor
l Generic Hypervisor Monitor
l HadoopMonitor

l HP Vertica JDBC Monitor
l KVMMonitor
l VMware DatastoreMonitor
l VMware Host Monitors

For task details, UI description, and tips/troubleshooting, see the specific dynamic monitor in the SiteScope
Monitor Reference guide.

Dynamic Monitoring Mechanism
The dynamic monitoringmechanism works as follows:

l Define Counter Patterns
To enable themonitor to dynamically update counters, you define the counter patterns you want to monitor
using regular expressions. SiteScope uses Perl regular expressions for patternmatching. For example, if
you enter /cpu.*/ or cpu, any counters with cpu in their namematch this pattern and are added to the
counters list.

Examples:

Dynamic Disk Space monitor: If you enter the pattern /.*/.*platform.*/MB free/, themonitor
retrieves theMB free counters on disks that contain the word platform in their file system's name.

Dynamic JMX, Hadoop monitor: If you enter the pattern /java.lang/ClassLoading/.*/, the
monitor retrieves all the ClassLoading counters in the JMX application, such as
TotalLoadedClassCount, UnloadedClassCount, LoadedClassCount, ObjectName.
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KVM/Generic Hypervisor monitor: If you enter the pattern /.*/Domains Information/.*/Used
Memory/, themonitor retrieves the Used Memory counter for all VMs.
VMware Datastore monitor: If you enter the pattern /.*/.*/accessible/, themonitor retrieves the
accessible counter for all datastores.
VMware Host monitor: If you enter the pattern /.*/VirtualMachine/.*/cpu/usage.average\
[\]/, themonitor retrieves the usage.average[] counter for all VMs.

l Set Update Frequency
You set the frequency of the dynamic updatemechanism at themonitor level. This is the frequency that
SiteScope uses to update the counters retrieved from the server. This enables running the update
mechanism at a frequency that is appropriate for themonitor type. The update frequency should not be
less than themonitor run frequency in Monitor Run Settings. For example, if themonitor runs every 10
minutes, the dynamic update frequency should be at least 10minutes.

l Use Counter Patterns as Threshold Conditions
You can also select counter patterns to be used as threshold conditions. In this way, thresholds are also
updated automatically when the counters are updated. For example, in the Dynamic JMX example above,
you could set an error threshold based on the /java.lang/ClassLoading/.*/ counter pattern.
The thresholds list always contains the counter patterns that were defined in the counters pattern table
(not the final counters that were found). The values in this list are updated according to changes youmake
in the counter patterns table.

l Update Mechanism
During each update, themonitor connects to the server and automatically updates the status of each
counter that matches the pattern defined by the regular expression as follows:
l It adds counters that match the patterns defined by the regular expression, and updates the status of
each counter.

l If theContinue displaying counters that no longer exist after update option is cleared, it removes
counters that no longer exist (avoids errors unnecessarily being logged). If this option is selected (the
default setting), counters are only added; not deleted.

l If you also defined a threshold using a counter pattern, then thresholds are added or removed according
to the counters available on server that match the pattern.

In this way, themonitor automatically configures itself with counters on the relevant dynamic environment
components.
If there are no counters that match themonitor patterns and no static counters, then the changes are not
saved since themonitor must have counters.

Note:When you define static counters (with no regular expression), these counters are never
removed from themonitor, even if they are no longer available on the server.

Calculated Metrics for Dynamic Monitors
A calculatedmetric is ametric produced by performing an arithmetic function or logical operation on existing
SiteScopemetrics. The calculatedmetric then appears in the Thresholds Settings panel, enabling you to
configure thresholds based on that metric. For example, you can create a calculatedmetric to calculate the
average of two or more existingmetrics for amonitor instance, and then configure a threshold that triggers an
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alert if that average exceeds a certain number. For more details on calculatedmetrics, see "Create Calculated
Metrics" on page 308.

When creating a calculatedmetric expression for dynamic monitors, you can use both static metrics (for
which you can use calculatedmetrics normally, without using patterns), and you can use regular expressions
that are part of the dynamic monitor’s configured patterns.

For example, the Dynamic Disk Spacemonitor tracks how much disk space is currently in use on your server.
When dynamic monitoring is configured, themetrics and thresholds are automatically updated as disks are
added to or removed from the server. This enables you to configure themonitor once, and leave it to detect
disks and file system changes.

You can configure calculatedmetrics for dynamic monitors based on a common function, such as average or
sum.

Example:

To calculate the total free space for all disks, create a calculatedmetric expression that is the sum of all
metrics created from /.*/MB free/ as follows:

SUM(<</.*/MB free/>>)

Note: You can use only one regular expression per calculatedmetric that is not part of a function (that is,
a calculatedmetric that returns only one result).
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Chapter 28: Monitor XML Documents
SiteScope's content matching capabilities is an important function in monitoring networked information
systems and content. For SiteScopemonitors that provide content matching, the basic content matching is
available through the use of Perl regular expressions.

SiteScope also includes the capability of matching document content by traversing XML documents. For
example, you can include an XMLmatch content string using the URLMonitor andWeb Services Monitor to
match an XML element name, an attribute of an XML element, or the content of an element. You can use this
to check for content in XML basedWeb pages, SOAP or XML-RPC documents, and evenWML pages served
toWAP-enabled devices.

Learn About
Content Matching for XML Documents
The syntax of XMLmatch content strings reflects the hierarchal structure of the XML document. Match
content strings that start with "xml" are recognized as element names within an XML document. The element
names are added, separated by periods, in the order of their relationship to the root element. For example, in
the document weather.xml the root element is <weather>. This element includes child elements named
<area>, <skies>, <wind>, <forecast>, and so forth. To access the content of these XML elements or their
attributes, you would use a syntax like xml.weather.area.

To check that specific content or value is present, add an equals sign after the element namewhose content
you are testing and then add the value of the content. If there aremultiple instances of an element name in the
document, you can check a particular instance of that element by adding the number indicating the order of the
element in the document in square brackets (see the example in the table below). You can also test for
multiple elements or values by separating individual search strings with commas. The table below gives
several examples of the syntax used tomatch content in XML documents.

Example Match Content Description

xml.weather.temperature Succeeds if any <weather> node in the document contains one or more
<temperature> elements. The content of the <temperature> elements is
returned by themonitor. If no <temperature> element is found within the
<weather> node, an error is returned.

xml.weather.temperature=20 Succeeds if any <weather> node in the document contains one or more
<temperature> elements where the content of the <temperature> element
equals 20. The content of the <temperature> element is not returned by the
monitor if thematch is found. An error is returned if no <temperature>
element is found within the <weather> node or if no <temperature> element
contains the value 20.
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Example Match Content Description

xml.weather.forecast.
[confidence]

Succeeds if any <weather> node in the document contains a <forecast>
element that has an attribute called confidence. The value of the
confidence attribute is returned by themonitor if thematch is found. An
error is returned if no <forecast> element is found within the <weather>
node or if no confidence attribute is found.

xml.weather.forecast[3].
[confidence]=50

Succeeds if any <weather> node in the document contains three or more
<forecast> elements where the third <forecast> element has a confidence
attributewith a value of 50. An error is returned if the <weather> node has
fewer than three <forecast> elements or if the value of the confidence
attribute is not equal to 50.

xml.weather.temperature=20,
xml.weather.skies=rain

Succeeds if any <weather> node in the document contains one or more
<temperature> elements where the content of the <temperature> element
equals 20 and if any <weather> node contains one or more <skies>
elements where the content of the <skies> element equals rain. Returns an
error if either of thematches fails.

xml.wml.card.p.table.tr.td.
anchor=Home Page

Checks the content of <anchor> elements in the designated path of aWML
document. Succeeds if any <card> node containing table cells with one or
more <anchor> elements where the content of any of the <anchor>
elements equals "Home Page."

XML Content Match Values in Monitor Configurations
Monitors like the URLMonitor have a content match value that is logged to the SiteScopemonitor data log
and can also be used to set error and warning status thresholds for themonitor. The values of the XML names
are saved as the content match values for themonitor.

For example, if thematch content expression was xml.weather.temperature and the document was the
contents of the file weather.xml, then the content match value would be 46.

You can then set the error, warning, and good status thresholds in the AdvancedOptions section for the
monitor to compare your specific thresholds to the value returned by the content match.

For example, if you aremonitoring temperature values and want to be alerted when the temperature value
drops below 72 degrees, you could set themonitor status thresholds as follows:

Error if content match < 72

Warning if content match = 72

Good if content match > 72

With this configuration, themonitor checks the content of the temperature element and then compares it to the
error and warning thresholds. In the example above, the status of themonitor would be error because the
temperature value is 46, which is less than 72.
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Part 5: Integration Monitors
Integrationmonitors are used to capture and forward data from third-party domainmanagers or applications
(typically EnterpriseManagement Systems (EMS)) into BSM. Thesemonitor types require additional
licensing andmay only be available as part of another HPE product.

This section describes the following:

l An overview of integrationmonitors, which includes integrationmonitor categories and a list of integration
monitors, field mapping scripts to map the data themonitors collect to a format recognizable by APM,
event handler structure, topology script for reporting topology to BSM, and instructions on deploying
integrationmonitors andmigrating existing integrationmonitors from SiteScope to BSM Connector. For
details, see "IntegrationMonitors Overview" on page 324.

l How to configure generic integrationmonitors to collect time-basedmetrics data. For details, see
"Configure IntegrationMonitors to Collect Metrics Data" on page 343.

l How to configure generic integrationmonitors to collect common or legacy event-based data. Common
events data is used to integrate events collected from third-party domainmanagers or applications to BSM
9.x. Legacy events are used to collect data on specific events in BAC 8.x and earlier (retained for
backward compatibility). For details, see "Configure IntegrationMonitors to Collect Event Data" on
page 374.

l How to configure generic integrationmonitors to collect incidents and events from ticketing systems. Data
collected by integrationmonitors that use the ticketing data type is integrated into BSM and can be viewed
in Service Health and Service Level Management. For details, see "Configure IntegrationMonitors to
Collect Ticketing Data" on page 390.

l How to report the topology discovered by the SiteScope Technology Integrationmonitors, without
reporting the data. For details, see "Report Topology Without Data" on page 397.

l How to forward event data from Network NodeManager (NNM) to APM. For details, see "Network Node
Manager Integration" on page 399.

Note: Since EMS functionality was moved to BSM Connector, a free HPE application that provides more
functionality and coverage of third-party data, not all EMS monitors are available (check the specific
monitor for details). HPE recommends using BSMConnector for all new third-party data integrations.
Note that BSM Connector works with BSM 9.20 and later only. For details on BSMConnector, see the
BSM Application Administration Guide in the BSMHelp.



Chapter 29: Integration Monitors Overview
Integrationmonitors are run by the SiteScope data collector and are used to capture and forward data from
third-party domainmanagers or applications (typically EnterpriseManagement Systems (EMS)) into APM.
There are two levels of configuration for collecting the data and forwarding that data to APM:

l Required: Themonitors must be configured to properly map to themonitored system and collect the
required data samples, whether in the form of events, metrics, or tickets. The field mapping from the
monitored system is done by selecting a data type in the Field Mapping setting and editing the
corresponding script in a text editor.

l Optional: The data can also bemapped to a topology to forward data to the correct CI hierarchy in APM.
This enables themonitor to accurately report status to the required CIs within APM for use by the different
applications in the product. The topology settings are configured using a topology script that is loaded
depending on the type of topology you want to create.

Note: You can have SiteScope report only the topology discovered by the SiteScope Technology
Integrationmonitors, without reporting the data. For details, see "Report Topology Without Data" on
page 397.

Learn About
This section also includes:

l "IntegrationMonitor Categories" below
l "Field Mapping Data Types" on the next page

Integration Monitor Categories
Integrationmonitors can be divided into two categories: Application-Specific monitors andGeneric Integration
monitors.
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Category Description

Application-
Specific
Monitors

These integrationmonitors are designed for use with specific EMS applications. These
monitors are predefined with the required field mapping and topology settings. Themonitors
include:

l HP OMEvent Monitor
l HP ServiceManager Monitor
l NetScout Event Monitor
Note:

l The HP OM Event monitor is not available when SiteScope is connected to APM version
9.00 or later (unless themonitor was created in an earlier version of SiteScope that was
upgraded to SiteScope 11.20). OM events can be forwarded to APM 9.00 from the HPOM
Server, provided you have an Event Management Foundation license and an integration is
configured betweenOperations Manager and APM.

l Topology Settings are not available for the NetScout Event Monitor.

Generic
Integration
Monitors

Technology IntegrationMonitors designed for use with most EMS applications that support
extraction of data from a database, log file, SNMP trap, orWeb service interface. The field
mapping and topology settings for thesemonitors must be configured by loading the
applicable scripts and editing them in a separate text editor duringmonitor creation. The
monitors include:

l Technology Database IntegrationMonitor
l Technology Log File IntegrationMonitor
l Technology SNMP Trap IntegrationMonitor
l Technology Web Service IntegrationMonitor
Note:

l If you are using SiteScope 11.30 or earlier, and SiteScope is connected to BSM 9.20 or
later, you can only use previously created Generic Integrationmonitors.

l To block the creation of this monitor in the SiteScope user interface, change the _
enableEMSMonitors property value to false in the <SiteScope root
directory>\groups\master.config file, and restart SiteScope (by default, the value is set
to true).

l For all new third-party data integrations, HPE recommends using BSMConnector. BSM
Connector provides more functionality and coverage regarding the types of third-party
data that can be collected than Technology Integrationmonitors. Note that BSM
Connector works with BSM 9.20 and later only. For details on BSMConnector, see the
BSM Application Administration Guide in the BSMHelp.

l Generic Integrationmonitors are not available in the user interface when using
Community or Load Testing edition.

For monitor details on Integrationmonitors, see the IntegrationMonitors section of the SiteScopeMonitor
ReferenceGuide in the SiteScope Help.

Field Mapping Data Types
The integrationmonitors use field mapping scripts to correctly map the data they collect to a format
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recognizable by APM. You use the field mapping scripts that come prepackaged with SiteScope as a basis for
creating a customized configuration required for your specific environment. When you configure an integration
monitor, you select the data type to load the required script and edit the script to collect the data you want to
forward to APM.

l For generic integrationmonitors, you can configure and customize themapping as required. When you
select a field mapping type, you can use the script editor provided, or you can copy the script into your
preferred text editor, make your changes, and then copy the script back into the field mapping text box.

l For application-specific monitors, themapping are not editable while configuring themonitor, and we
recommend that you use the out-of-the-box integrationmapping already configured for thosemonitors.

You can select from the following types of sample scripts (when configuring the generic integrationmonitors):

Data
Type Description

Metrics Used to collect time-based data. Data collected by IntegrationMonitors that use themetrics data
type is integrated into APM as typical SiteScope data and can be viewed in all contexts that
support viewing SiteScope data (for example, Service Health, Service Level Management, SAM,
user reports, and so on). For more details, see "Configure IntegrationMonitors to Collect Metrics
Data" on page 343.

For details on customizing the field mapping scripts, see "IntegrationMonitor Field Mapping for
Metrics Samples" on page 343.

Events l Common Events. Used to integrate events collected from third-party domainmanagers or
applications to BSM 9.x. Unlike the legacy EMS events, the Common Event integration
allows you tomanage the events in Operations Management event sub system and the
Service Health console. In addition, the common event channel provides the option to report
topology to APM without reporting the data. For more details, see "How to Configure
IntegrationMonitors to Collect Data on Common Events" on page 383.

l Legacy Events. Used to collect data on specific events in BAC 8.x and earlier (retained for
backward compatibility). Data collected by IntegrationMonitors that use the event data type is
integrated into APM using the UDX framework and can be viewed in contexts that support the
display of UDX data (Event Log, Service Health, trend reports). The data can also be
accessed using the APM API. For more details, see "How to Configure IntegrationMonitors to
Collect Data on Legacy Events" on page 386.
For details on customizing the field mapping scripts, see "IntegrationMonitor Field Mapping
for Event Samples" on page 374.

Note: Events sent by EMS applications are event samples. They are not the same as
Operations Management events in APM.

Tickets Used to collect incidents and events from ticketing systems. Data collected by integration
monitors that use the ticketing data type is integrated into APM and can be viewed in Service
Health and Service Level Management. For more details, see "How to Configure Integration
Monitors to Collect Ticketing Data" on page 393.

For details on customizing the field mapping scripts, see "IntegrationMonitor Field Mapping for
Ticketing Samples" on page 390.
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Troubleshooting/Limitations
This section describes troubleshooting and limitations when working with SiteScope IntegrationMonitors.

l "IntegrationMonitor Logs" below
l "Other Log and Troubleshooting Issues" below
l "Additional Troubleshooting Information" on the next page

Integration Monitor Logs
IntegrationMonitor activity is logged to <SiteScope root directory>\logs\
RunMonitor.log and <SiteScope root directory>\logs\bac_integration\bac_integration.log.

You canmodify the level and type of information reported to the log file by changing the log file settings in the
<SiteScope root directory>\conf\core\
Tools\log4j\PlainJava\log4j.properties file. You can instruct the loggingmechanism to:

l Report logged information in less or greater detail than is reported by default.
l Log all samples sent by IntegrationMonitors to APM.
l Log all received events from external EMS systems.
To modify log settings:

1. Open the log4j.properties file in a text editor.
2. To specify that samples sent by IntegrationMonitors to APM be logged:

a. Locate the following lines in the file:

log4j.category.EmsSamplePrinter=${loglevel}, integration.appender
log4j.additivity.EmsSamplePrinter=false

b. Change the argument of log4j.category.EmsSamplePrinterfrom ${loglevel} toDEBUG, as
follows:

log4j.category.EmsSamplePrinter=DEBUG, integration.appender

c. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to the bac_integration.log file.
3. To specify that all received events from external EMS systems be logged:

a. Locate the following lines in the file:

log4j.category.EmsEventPrinter=${loglevel}, monitors.appender
log4j.additivity.EmsEventPrinter=false

b. Change the argument of log4j.category.EmsEventPrinter from ${loglevel} toDEBUG, as follows:
log4j.category.EmsEventPrinter=DEBUG, monitors.appender

c. Save the file. It may take a few seconds for the changes to take effect. The results are logged to the
RunMonitor.log file.

Other Log and Troubleshooting Issues
l Look for errors in <SiteScope root directory>\logs\error.log and in <SiteScope root
directory>\logs\bac_integration\bac_integration.log.

l If samples are created and sent from SiteScope but cannot be seen in APMService Health, Event Log, or
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SiteScope reports, search for the string ERROR or WARN in thewde.logl and loader.logl files in the <BSM
root directory>\log\mercury_wde\ directory to make sure the samples were not dropped due tomissing
fields or values.

l Increase the level of Service Health logging in <BSM
root directory>\conf\core\Tools\log4j\EJB\ble.properties file to verify that Service Health is receiving
samples. Locate the following parameter and change the log level status toDEBUG:
log4j.category.Trinity.BLE_SAMPLES=DEBUG, trinity.samples.appender

The results are logged to the <BSM root directory>\log\EJBContainer\TrinitySamples.log.

Tip: After you have determined the cause of the problem, we recommend that you set log levels to their
default settings so as not to overload the system.

Additional Troubleshooting Information
Additional troubleshooting information is located in the HPE Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result) (youmust log on to the knowledge
base with your HPE Passport ID) and in the following sections of the documentation:

l For troubleshooting the Technology Database Integrationmonitor, see Technology Database Integration
Monitor in the SiteScopeMonitor ReferenceGuide.

l For troubleshooting the Technology Log File monitor, see Technology Log File IntegrationMonitor in the
SiteScopeMonitor ReferenceGuide.

l For troubleshooting the Technology SNMP Trapmonitor, see Technology SNMP Trap IntegrationMonitor
in the SiteScopeMonitor ReferenceGuide.

l For troubleshooting the Technology Web Service Integrationmonitor, see Technology Web Service
IntegrationMonitor in the SiteScopeMonitor ReferenceGuide.

Topology Settings for Technology Integration
Monitors
To report topology to APM, you can select an out-of-the-box topology script for your integrationmonitor. You
do this while creating an integrationmonitor in the Topology Settings panel.

Jython language is used for developing topology scripts. For details on how to work in Jython, refer to
http://www.jython.org and http://www.python.org.

Selecting a Topology
Whenworking with generic integrationmonitors, you can select from the following topology settings (the
topology scripts that are available depend on the field mapping type selected):

l Computer. Creates a topology with a Computer CI. It is available forCommon Events data type only.
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l Computer - Running Software. Creates a topology with a Computer CI and a Running Software CI
connected to it with a Composition relationship. It is available forCommon Events data type only. The
following illustrates the topology created for the Computer - Running Software integration type which
retrieves events data from a third-party system:

l Custom. You create your own topology if you want the retrieved data to be forwarded to specific CIs and
not one of predefined topology scripts. It is available for all field mapping types. You should only select
Custom if you are familiar with the Jython language, because no topology script is loaded and youmust
create the topology script in Jython yourself. We recommend that you begin with one of the predefined
scripts.

Tip:When selecting a topology setting, you can have it report only the topology discovered by the
SiteScope Technology Integrationmonitors, without reporting the data. For task details, see "Report
Topology Without Data" on page 397.

Legacy Topology Scripts
The following are legacy topology scripts:

l "Node Topology" below
l "Node - Running Software Topology" below
l "Tickets" on the next page

Node Topology

Creates a Node CI with an EMS monitor CI connected to it with Monitored By relationship. The EMS Monitor
CI propagates status onto the Node CI.

Node - Running Software Topology

Creates a topology with a Node CI and a Running Software CI connected to it with a Composition
relationship, and an EMS monitor CI which can be connected to either the Node CI or the Running Software
CI with Monitored By relationship.

In this integration type, there are two types of data that can be retrieved from a third-party system: events
related to Running Software and events related to Nodes.

The following table illustrates the topology created for each type of event:
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Topology Created for Running Software-Related
Events

Topology Created for Node-Related
Events

You can configure which events are related to Running Software and which are related to Node by editing the
topology script as follows:

Search for the following string in the topology script:

if (subject != "system"):

The variable subject represents the subject field in the event. The value system is an example of possible
values representing the data that is considered related to Node and not forwarded to the Running Software CI.

Tickets

Creates a Business Service CI with an EMS monitor CI connected to it with Monitored By relationship. The
EMS Monitor CI propagates status onto the Business Service CI. It is available for Tickets data type only.

For more information on the legacy integration types, see "Understanding Node, Tickets, or Node - Running
Software Integration Types" in the BSM section of the Integrations tab in the HPE Software Integrations site.

Editing the Topology Script
To configure the topology, you can edit the topology script that appears in the Topology Settings panel when
creating an integrationmonitor. You can use the script editor provided, or use any other script editor.

You can choose one of the predefined topologies which are already configured with the necessary information.
Following are the guidelines for editing the script if you want to create your own topology.

General Script Editing Guidelines
l The Jython language is sensitive to spaces and tabs. For more information on Jython, see
http://wiki.python.org/moin/HowToEditPythonCode.

l Youmust leave the import section of the predefined topology scripts as is and only add to it.
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l Themain body of the script is mandatory and consists of:

def DiscoveryMain(Framework)

This main function is responsible for creating Object State Holder Vector (OSHV) results. It holds the CI
and CI relationship data, and how tomap the incoming samples to the CIs.

l Use the built-in "logger" to debug the topology scripts when samples arrive. You do this by modifying the
level and type of information reported to the log file:
a. Add the logger import statement before system_lib import statement to the topology script, for

example:

import logger
…
import system_lib

b. Change the log file settings in the <SiteScope root
directory>/conf/core/Tools/log4j/PlainJava/bac_integration.properties file as follows:
Open the bac_integration.properties file in a text editor and locate the following lines in the file:

# Jython logger
log4j.category.PATTERNS_DEBUG=${loglevel}, discovery.appender

Change the argument of log4j.category.PATTERNS_DEBUG from ${loglevel} toDEBUG, as
follows:

log4j.category.PATTERNS_DEBUG=DEBUG, discovery.appender

c. Save the file. It may take a few seconds for the changes to take effect.
The debug data is written to the <SiteScope root directory>/log/discovery.log file.

Guidelines Relating Specifically to Integration Monitors
l When using field mapping, you can use the field mapping fields as an input for the topology script. For
example, if using common event mapping, you can access the value of the Category field in the following
way:

category = Framework.getDestinationAttribute("Category").

In addition, you can access values of the "monitor variables", such as group0, group1, and so forth, from
Technology Log File Integrationmonitor, or the names of database columns in Technology Database
Integrationmonitor, or other variables in the other integrationmonitors. For example, you can access the
value of the group1 variable, in the following way:
group1 = Framework.getDestinationAttribute("group1")

l If you report an EMS monitor CI in your script, each CI should not havemore than one EMS monitor CI as
a leaf node.

l For legacy event scripts, the following expressions must appear as the last lines in the script:

Framework.setUserObject("result_object",monitoredCiType)
return OSHVResult
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The variable monitoredCiType is a type of CI beingmonitored by the EMS Monitor CI that receives the
event.
If the script creates more than one EMS Monitor CI for one retrieved event, youmust determine to which of
the CIs that event belongs and passes status. You do this by assigning the correct value to the
monitoredCiType. For example, if the script creates one EMS Monitor CI for a Running Software CI and
one for a Node CI, and you want the event to pass status to the Node CI, the value of the variable
monitoredCiType should be "node".

Additional Documentation
For general information on topology scripts, see "Create Jython Code" and "Developing Jython Adapters" in
the RTSMDeveloper ReferenceGuide in the APMHelp.

For information about Java classes that can be used in topology scripts, see "HP Data Flow Management API
Reference" in the RTSMDeveloper ReferenceGuide in the APMHelp.

Notes and Limitations
l The script for EMS topology from SiteScope 10.x is displayed in SiteScope in the previous content
language format, even if SiteScope is connected to BSM 9.00. For example, the Host CI type appears in
the script instead of Node.

l If SiteScope is connected to APM versions earlier than 9.00, theHosts andHost-Software elements
topology script are displayed in the topology script list for themonitor instead of Computer,Computer -
Running Software, Node, andNode - Running Software.

Field Mapping Structure
The field mapping contains instructions on how to process the data as it arrives at the integrationmonitors.
The instructions that constitute the field mapping are grouped into event handlers—independent sections that
contain instructions relevant to specific data. Each event handler contains amatching condition by which
SiteScope can determine whether to use a particular event handler for an arriving event.

When an event or metrics data arrives at the integrationmonitor, it iterates over the different event handlers in
the field mapping, in the order that they appear, testing thematching condition of each handler. If a matching
handler is found, themonitor uses the instructions within that handler to process the event and perform the
action defined for this handler (for example, forward it to APM or discard). No further sections are checked
after the first match. If nomatches are found, the event is discarded.

In addition to the event handlers, the field mapping can contain special entries that affect the integration
monitor engine as a whole. These values are grouped into the [$DEFAULT_PARAMETERS$] section. This
section defines default values for tags that are common for all handlers. Any tag can be set in this section of
the field mapping. It is used to create a reported value unless overridden in thematched event handler. For
each incoming event, this event handler is always run prior to thematched event handler.

For details on event handler structure, see "Event Handler Structure and Syntax" on the next page.
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CI Resolution Hint Formats
You can use the following formats for CI resolution hints:

Format Description Example

Standalone CIs
that do not exist
in the context of
Node and
descendant CI
types

For example, Business Application, Business
Service, or Siebel Enterprise. CI resolution hint
should be a CI name.

For a Business Service CI
named
myBusinessService, the CI
resolution hint would be:

MeasurementCIHint
(1)="myBusinessService"
.

Note: The CI namemust be
unique in RTSM.

Node topology
and descendant
CI types

CI resolution hint should be a fully qualified domain
name or an IP address of a node.

To report a node with IP
address 12.34.56.78, the
CI resolution hint would be:

"12.34.56.78" or

"<MachineName>".

CIs which exist
in the context of
Node and
descendant CI
types

For example, CIs which belong to CI types that inherit
from Running Software, Node Element, or Network
Entity. Youmust specify in the hint both the
Node/descendant CI and the CI connected to the
Node/descendant CI, separated by @@.

For anOracle Database CI
connected to the
Node/descendant CI, the CI
resolution hint should be in
the format:

"<oraclesid>:<product
name>@@<fqdnhostname>".

Event Handler Structure and Syntax
Each event handler has the following structure:

[name]Matching condition
Action directive
Tags

The names ofMatching condition, Action directive, and additional directives start with the dollar sign
symbol ($). The names of tags should not start with the dollar sign.

Comments are permitted in the field mapping. The comment starts with either #, !, or ; character and
continues to the end of the line.

Note: Use only themandatory and optional fields defined in the scripts when working with the field
mapping. See the tables in the following sections for more information.

This section also includes:
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l "Matching Condition" below
l "Available Data Processing Operations" below
l "Conditional Expression" on page 339
l "Action Directive" on page 339
l "Tags" on page 339
l "IntegrationMonitor Field Mapping Examples" on page 340

Matching Condition
TheMatch Conditionmust be a valid boolean expression. The expression can contain calls to the operators
and functions defined below. The expression can access the contents of the data that is being processed
using the dollar sign ($) notation. For example, if the incoming data is SNMP Trap, then its enterprise OID can
be accessed as $oid. For names specific to amonitor, refer to the documentation of the relevant monitor
type:

l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)
l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)
l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)
l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

Note: TheMatch Condition expression is limited to 4,000 characters.

Thematching condition has the form:

$MATCH=Boolean expression

where the Boolean expression is a combination of one of the expressions listed in "Available Data Processing
Operations" below. The value of the expression, which can be either true or false, determines whether the
event handler is be used to process the event or not.

Available Data Processing Operations
The language used in the field mapping is a simplified version of Java programming language, which allows
the following operations only.

Expressions and
Functions Description

+ String concatenation.

Example: "trap type is " + $trap

 <, <=,  > ,  >=, ==, != Checks the numerical correctness of the expression.  Can be used with numeric
values.

Example: $MATCH=$numberOfLines == 100

&&, || To be used to combine any of the above boolean expressions.

Example: $MATCH=$status.equals("ERROR") || ($numberOfLines == 100)
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Expressions and
Functions Description

true, false Constant Boolean values.

Example: $MATCH=true

boolean contains
(String str)

Returns true if and only if this string contains the specified sequence of char
values.

For more details, see http://download.oracle.com/javase/7/docs/api/
java/lang/String.html#contains(java.lang.CharSequence).

Example:MonitorName=$group0.contains("monitor")? $group0 : $group0 +
"monitor"

boolean endsWith
(String suffix)

Tests if this string ends with the specified suffix.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#endsWith(java.lang.String).

Example:MonitorName=$group1.endsWith("Operations")? $group1 : $group1 +
"Operations"

boolean equals
(String anotherString)

Compares this string to another string.

For more details, see http://download.oracle.com/javase/7/docs/api/java/lang/
String.html#equals(java.lang.Object).

Examples:

$MATCH="ERROR".equals($status)

or

$MATCH=$status.equals("ERROR")

boolean
equalsIgnoreCase
(String anotherString)

Compares this String to another String, ignoring case considerations.

For more details, see http://download.oracle.com/javase/7/docs/api/java/lang/
String.html#equalsIgnoreCase%28java.lang.String%29.

Examples:

$MATCH="ERROR".equalsIgnoreCase($status)

or

$MATCH=$status.equalsIgnoreCase("ERROR")

boolean exists(String
property)

Checks for an existence of a property in the processed event andmake sure that it
is not an empty value.

Example: $MATCH=exist($status)
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Expressions and
Functions Description

String getToken
(String str, String
delimiterRegular
Expression,int
zeroBasedTokenIndex
)

Splits input string according to a supplied delimiter (in regular expression format),
and returns one of the result strings according to a specified zero-based index.

Example: getToken($var, "/", 1) will produce "y" if $var equals "x/y/z"

int indexOf
(String str)

Returns the index within this string of the first occurrence of the specified
substring.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#indexOf(int).

Example:Severity=$group0.lastIndexOf("Critical")>-1? "Critical" : "Normal"

int indexOf
(String str, int
fromIndex)

Returns the index within this string of the first occurrence of the specified
substring, starting at the specified index.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#indexOf(java.lang.String,%20int).

Example:Severity=$group0.indexOf("Critical",3)>-1? "Critical" : "Normal"

boolean isDouble
(String number)

Checks if the input string can be interpreted as a double number.

Example: $MATCH=isDouble($size)

boolean isEmpty() Tests for an empty string (length() == 0).

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#isEmpty().

Example:Description=$group1.isEmpty()?$group0 :$group1

boolean isInt
(String number)

Checks if the input string can be interpreted as an integer number.

Example: $MATCH=isInt($size)

int lastIndexOf (String
str, int fromIndex)

Returns the index within this string of the last occurrence of the specified
substring, searching backward starting at the specified index.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#lastIndexOf(java.lang.String,%20int).

Example:Severity=$group0.lastIndexOf("Critical",2)>-1? "Critical" : "Normal"

int lastIndexOf
(String str)

Returns the index within this string of the rightmost occurrence of the specified
substring.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#lastIndexOf(java.lang.String).

Example:Severity=$group0.lastIndexOf("Critical")>-1? "Critical" : "Normal"
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Expressions and
Functions Description

int length() Returns the length of this string.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#length().

Example:Description=$group1.length() <10 ? $group0+$group1 :$group1

booleanmatches
(String regex)

Tells whether or not the stringmatches the given regular expression.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#matches(java.lang.String).

Example:Severity=$group0.matches("(.*)Critical(.*)")? "Critical" : "Normal"

double parseDouble
(String number)

Use to convert strings to numeric values. The input string should be a valid
representation of an integer or a floating point number.

Note:Calling this function on a string that cannot be interpreted as a number
causes an error and the incoming data is dropped.

Example: $MATCH=parseDouble($size) > 10

int parseInt
(String number)

Use to convert strings to numeric values. The input string should be a valid
representation of an integer or a floating point number.

Note:Calling this function on a string that cannot be interpreted as a number
causes an error and the incoming data is dropped.

Example: $MATCH=parseInt($size) > 10

String resolveHostIP
(String hostName)

Performs DNS resolution from a server to its IP address.
If the DNS resolution fails, the function returns the value unknown host.

Example: target_ip=resolveHostIP($host)

String
resolveHostName
(String hostIP)

Performs DNS resolution from an IP address to a fully qualified domain name.
If the DNS resolution fails,
the function returns the original input host name.

Example: target_name=resolveHostName($host)

boolean startsWith
(String prefix)

Tests if this string starts with the specified prefix.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#startsWith(java.lang.String).

Example:MonitorName=$group1.startsWith("Operations")? $group1 :
"Operations"+$group1
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Expressions and
Functions Description

boolean startsWith
(String prefix, int
offset)

Tests if the substring of this string beginning at the specified index starts with the
specified prefix.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#startsWith(java.lang.String,%20int).

Example:MonitorName=$group1.startsWith("Operations",2)? $group1 :
"Operations" + $group1

long str_to_seconds
(String dateTime,
String format)

Calculates the timestamp (in seconds, since January 1, 1970 format) held in the
first String using the format in the second string.

True if the date specified in $time in yyyy-MM-dd HH:mm:ss.SSS format is later
than the current time.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/text/SimpleDateFormat.html.

Example: $MATCH=str_to_seconds ($time,"yyyy-MM-dd HH:mm:ss.SSS") >
time()

Note:Use the following symbols to represent time:

Year - `y'; Month - `M"; Day of month - `d'; Hour - `H'; Minute - `m'; Second - `s'

String substring
(int beginIndex)

Returns a new string that is a substring of this string. The substring begins with
the character at the specified index and extends to the end of this string.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#substring(int).

Example: Title=$group0.substring(2)

String substring
(int beginIndex, int
endIndex)

Returns a new string that is a substring of this string.

For more details, see http://download.oracle.com/javase/7/docs/api/
java/lang/String.html#substring(int).

Example: Title=$group0.substring(2,9)

int time() Returns the current time, in seconds, since January 1, 1970 format.

Example: $MATCH=$timeStampField > (time()-600)

True if the value of the $timeStampField is newer than tenminutes ago (in
seconds, since January 1, 1970 format).

String toLowerCase() Converts all of the characters in this to lower case using the rules of the default
locale.

Example: Title=$group0.toLowerCase()
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Expressions and
Functions Description

String toUpperCase() Converts all of the characters in this to upper case using the rules of the default
locale.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#toUpperCase().

Example: Title=$group0.toUpperCase()

String trim() Returns a copy of the string, with leading and trailing whitespace omitted.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#trim().

Example:Category=$group3.trim()

Conditional Expression
One conditional expression is supported; the ? operator. This operator can be used to compose three
expressions into one. For example:

<Conditional part> ? <if true part> : <if false part>)

Action Directive
The action directive has the form:

$ACTION= SEND or DISCARD

TOPAZ_BUS_POST is the equivalent of SEND,which is used only for backwards compatibility.

The value of the Action directive defines whether the event is processed and forwarded to APM, or discarded.
This value takes effect only if thematching condition within the handler had been evaluated to positive value
(that is, to true). The table below describes the effect of the different actions.

Action Description For Use With

SEND(event) Send the event to the APM bus and database. APM

SEND(ss_t) Send themetrics to RTSM as SiteScope Data. APM

DISCARD Do not send the data to APM. events you want to filter out

Note: If you are using themetrics mapping, SEND(ss_t), the data is sent to the APM database as
SiteScope data, and thus saved to the database. For details onmetrics mapping, see "Configure Field
Mapping for Metrics Samples" on page 344.

Tags
In addition to directives, the event handler contains tags. Each tag represents a field if it is forwarded to APM.
The tag's value can be evaluated when the event arrives to the integrationmonitor.

The general format of a tag is:

name[:type]=value
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The <name> is any string without spaces or dollar signs ($). The <type> specifies the type of field as reported
to APM. It can be either INT, DOUBLE orSTRING. The default type is STRING. You can view available data
processing operations in "Available Data Processing Operations" on page 334.

By defining a tag, you can customize event forwarding to APM. Thus gettingmore value from the external
applications that create those events. For example, if themonitor pulls out data from a database table column
called AlertText, which contains a textual description of an alert, it is possible to send that data to APM by
adding the following line to an event handler section:

[event handler]
$MATCH=true
$ACTION=SEND(event)
text=$AlertText

Note:When adding tags, always add them after the $MATCH and $ACTION.

Integration Monitor Field Mapping Examples
Example 1: Universal Event Handler

[post them all]
$MATCH=true
$ACTION=SEND(event)
severity:INT=SEVERITY_INFORMATIONAL
szAlarmText:STRING="post them all handler received an event"

Note that the $MATCH directive in the handler is set to true. This causes every event to match the handler
and therefore every event is sent to the APM bus.

Example 2: Different Event Handlers for Different Severities

[Error Handler]
$MATCH= $status.equals("ERROR")
$ACTION=SEND(event)
severity:INT=SEVERITY_CRITICAL
[Info Handler]
$MATCH= $status.equals("INFO")
$ACTION=SEND(event)
severity:INT=SEVERITY_INFORMATIONAL
[post them all]
$MATCH=true
$ACTION=SEND(event)
severity:INT=SEVERITY_INFORMATIONAL

In this example, an incoming event is matched against theError Handler event handler. If the handler's
condition is true (that is, the value in the status field equals ERROR), then an event with a field called
severity, whose value is SEVERITY_CRITICAL, is sent to APM. An event can bematched only by a single
handler. The first match stops the processing and therefore once an event is matched by a section, it is not
processed by the next handler.
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If the event was not matched by the first handler, the second handler comes into action and its match (which
looks for status of INFO) is used to decide whether the second handler needs to take action. Finally, if the
event does not match the second handler, the third universal handler is evaluated.

How to Migrate Technology Integration Monitors to
BSMConnector
You canmigrate existing technology integrationmonitors from SiteScope to BSM Connector. The export
downloads a technology integrationmonitor from SiteScope and converts it to the BSMConnector format for
import to BSM Connector. Such imported policies can bemaintained and further customized in BSM
Connector. Exporting technology integrationmonitors for use in BSM Connector enables you to use BSM
Connector for all your third party integrations.

Note: The Export to BSM Connector policy functionality is relevant only where BSMConnector 9.22 (or
later) is integrated with BSM version 9.20 or later.

Supported SiteScope Technology Integration Monitors
Only the following technology integrationmonitors with ametrics, common events, or legacy events field
mapping data type are supported for export in SiteScope:

l Technology Database IntegrationMonitor
l Technology Log File IntegrationMonitor
l Technology Web Service IntegrationMonitor

Note: The Technology SNMP Trap IntegrationMonitor, HP OM Event Monitor, HP ServiceManager
Monitor, and NetScout Event Monitor do not support export to BSM Connector policies.

Migrate Technology Integration Monitors to BSM Connector Policies
1. In SiteScope, export the technology integrationmonitor that you want to migrate to BSM Connector

a. In SiteScope, open themonitor properties for the technology integrationmonitor that you want to
export, and expand theExport to BSM Connector panel.

b. In the Export to BSM Connector panel, click theExport button, and select a folder on the client file
system in which to save the policy files, and then click Open.

c. The export process is performed, and a popupmessage displays the results (success/error).
In case of an error, a detailed error message is written in <SiteScope root
directory>\logs\error.log.
The SiteScopemonitor is converted to a policy data and a header file. The files are saved to the
selected location on the client machine in the format:
o <policy_id>_data for the policy data file
o <policy_id>_header.xml for the header file
where the policy_id is a generated UUID for the new policy.

2. Transfer the generated policy files to the BSMConnector system.
3. Import themigrated integrationmonitor to BSM Connector
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Import the policy data file and the header file to a BSMConnector machine using the BSMConnector's
import policy mechanism. For details, see the BSMConnector online help system (available from the
toolbar of the BSMConnector user interface).
After importing the files, the policy can then be activated in BSM Connector like any other policy.

How to Deploy Integration Monitors
Note: You can deploy integrationmonitors while working in:

l A standalone SiteScope that reports to APM
l Directly in SAM Administration

The steps involved in configuring the integration depend on the type of sample data being captured (metrics,
events, or tickets), and on whether the data is mapped to a topology (in order to forward it to the correct CI
hierarchy in APM).

Collect metrics samples
Select theMetrics field mapping data type to forwardmetrics data to APM, and choose from the following
topology scripts:

l Computer - Monitor. SiteScope reports this data to the Computer CI, a descendant of the Node CI. For
task details, see "How to Configure IntegrationMonitors to Collect Metrics DataWith Computer - Monitor
Topology" on page 345.

l Custom. Enables you to create your own topology. For task details, see "How to Configure Integration
Monitors to Collect Metrics DataWith Custom Topology" on page 352.

l No Topology. Select if you do not want to send any topology (although data is still sent). For task details,
see "How to Configure IntegrationMonitors to Collect Metrics DataWith No Topology" on page 363.

Collect event samples
Select theCommon Events or Legacy Events field mapping data type to integrate events collected from
third-party domainmanagers or applications to APM. Unlike the legacy EMS events, the Common Event
integration allows you tomanage the events in Operations Management event sub system and the Service
Health console. In addition, the common event channel provides the option to report topology to APM without
reporting the data.

l For task details on using the common event integration, see "How to Configure IntegrationMonitors to
Collect Data on Common Events" on page 383.

l For task details on using the legacy event integration, see "How to Configure IntegrationMonitors to
Collect Data on Legacy Events" on page 386.

Collect ticketing samples
Select the Tickets field mapping data type to forward ticketing data to APM,

For task details on collecting incidents and events from third-party ticketing systems, see "How to Configure
IntegrationMonitors to Collect Ticketing Data" on page 393.
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Chapter 30: Configure Integration Monitors to
Collect Metrics Data
When configuring the generic integrationmonitors, you can select themetrics data type to collect time-based
data. Data collected by IntegrationMonitors that use themetrics data type is integrated into APM as typical
SiteScope data and can be viewed in all contexts that support viewing SiteScope data.

Integration Monitor Field Mapping for Metrics
Samples
You can enable capturingmetrics data from EnterpriseManagement Systems (EMS), automated support
systems, and other management applications by configuring integrationmonitors and their field mapping
scripts.

Integrationmonitors depend on the field mapping you customize within the user interface in the settings for the
monitor. Themapping defines the processing of incoming data and defines the output sample forwarded to
APM.

IntegrationMonitors designed for use with specific EMS applications (these currently include HPOM, Service
Center, and NetScout) can be configured without editing their field mapping script. Themapping is predefined
by HPE and requires modification only if specific customizations are required. For details on editing these field
mapping scripts, see the description for the field mapping element in the user interface pages for themonitor
you are deploying.

For Technology IntegrationMonitors (Technology SNMP Trap, Technology Log File, and Technology
Databasemonitors), youmust select the data type and the required script is loaded directly into the field
mapping text box. Youmust edit the field mapping script to suit your organization's needs. The Technology
Web Service IntegrationMonitor field mappingmay also need to be customized.

When you select theMetrics data type to forwardmetrics data to APM, and you want to integrate to APM
using topology settings, you can select from the following predefined topology scripts:

l Computer - Monitor. Select to send SiteScope topology (monitors). This is the default setting. SiteScope
reports this data to the Computer CI, a descendant of the Node CI.

l No Topology. Select if you do not want to send any topology (although data is still sent).
l Custom. Enables you to create your own topology. Only select this option if you are familiar with the
Jython language, because youmust create the topology script in Jython yourself.

For details on selecting a topology setting, see "Topology Settings for Technology IntegrationMonitors" on
page 328.

Note: SiteScope uses indicator definitions for monitor CIs created by the integration that are defined in
APM (and that are applicable for Computer CI type). If a different ETI is specified in themonitor's field
mapping, it overrides the default indicator definition.
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Configure Field Mapping for Metrics Samples
You usemetrics data type to extract metrics collected by external systems and import them to APM.

When configuring an integrationmonitor's field mapping, select theMetrics data type to load themetrics
script. You can then copy the contents of the Field Mapping text box and paste it into a text editor to make
your configuration changes. When you are done, copy the contents back into the Field Mapping text box.

For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page 333.

For CI resolution hint formats, see "CI Resolution Hint Formats" on page 333.

This section also includes:

l "Mandatory Values for theMetrics Script" below
l "Optional Values for theMetrics Script" below
l "Metrics Script Example" on the next page

Mandatory Values for the Metrics Script
The table below lists mandatory values for themetrics script.

Field Name Type Description Example

TimeStamp DOUBLE Time stamp in the seconds since Jan
1st 1970 format.

TimeStamp:DOUBLE=time()

Quality INT Quality in SiteScope terms. Possible
values are: QUALITY_ERROR,
QUALITY_WARNING, QUALITY_
GOOD.

Quality:INT= QUALITY_ERROR

MonitorName STRING Logical monitor name. MonitorName="NT cpu
Monitor"

MonitorState STRING Themonitor status, for example, N\A,
Good, Error, and so on.

MonitorState="Received " +
$count + " events"

MonitorType STRING Themonitor type. MonitorType="System
Monitor"

TargetName STRING The target of this monitor (e.g. name of
host machine).

TargetName=$Device

MeasurementName
(N)

STRING Name the Nthmetric. MeasurementName(1)="CPU
Temperature"

Value(N) DOUBLE Value of Nthmetric. Value
(1):DOUBLE=$CPUTemperature

Optional Values for the Metrics Script
The table below lists optional values for themetrics script.
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Field Name Type Description Example

MeasurementETI STRING The display name of the ETI.

Note:When using APM 9.00, add the relevant
indicator names to the integration field mapping
(otherwise the system KPI is used instead), or
configure the indicator in SAM Administration. For
details, see Indicator Assignment Settings in the
APMUser Guide in the APMHelp.

MeasurementETI(1)=
"Indicator display
name"

MeasurementCI
Hint

STRING CI resolution hint that is used to identify monitored
CIs and relate metrics to them. SiteScope sends an
out-of-the-box CI resolution hint in the format based
on themonitor's internal IDs.

For EMS metric field mapping, youmight want to
send a custom CI resolution hint when:

l Sending a custom topology without monitor CIs
using a custom topology script.

l You only want to forward third-party metrics and
connect them to an existing topology. In this
case, you create a field mapping, provide CI
resolution hints, and select theNo Topology
option in the integrationmonitor's Topology
Settings.

The CI resolution hint must be specified in a format
recognizable in APM, as described in "Field
Mapping Structure" on page 332.

MeasurementCIHint
(1)=
"SCDAM038.testlab"

Metrics Script Example

Note: Themetrics script example is available in a text file attached to this PDF. To view the attachment,
select View > Navigation Panels > Attachments, and selectMetrics_Script_Example.txt.

When specifyingmore than onemetric in the script, a separate sample is sent with each of themetrics.

Note:When specifyingmultiple metrics per file, themetric numberingmust be consecutive.

In the case of failure, errors appear in theRunMonitor.log but the error does not affect themonitor status.

How to Configure Integration Monitors to Collect
Metrics Data With Computer - Monitor Topology
This task describes the steps involved in designing and implementing the EMS metrics flow using the
Computer - Monitor topology script. The topology describes a Computer CI connected to a SiteScopemonitor
CI with aMonitored By link.

Note: For an example of this task, see "Example – Create aMetrics Flow With Computer - Monitor
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Topology" on page 349.

1. Configure BSM integration
Integrate SiteScope and APM. For details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

2. Select the SiteScope
Select the SiteScope server from which you want to deploy the integrationmonitor:
l For SiteScope standalone, select and open a SiteScope instance.

l When in SAM Administration, select the SiteScope server from which you want to deploy the
integrationmonitor. For user interface details, see "System Availability Management Administration
Page" in the APMUser Guide in the APMHelp.

3. Create a group for the integration monitor
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Tip:We recommend that you create special groups for the integrationmonitors. This enables you to
more easily recognize the data that is reported to APM as coming from the integrations.

4. Add the integration monitor
Configure the integrationmonitor and add the required data for themonitor's settings. You can choose
from the following application-specific integrations:
l HP OMEvent Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l HP ServiceManager Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l NetScout Event Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

You can choose from the following generic integrationmonitors (note that generic integrationmonitors are
supported for BSM 9.1x and earlier versions only; for all new third-party data integrations in BSM 9.2x,
use BSMConnector as described in the APM Application Administration Guide in the APMHelp.)
l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor Reference
Guide)

5. Plan the topology flow
Before you start, plan the following:
l The type of themonitor and themetrics you will have.

l The HIs you want to be created on the Computer CI you will report in topology.
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l Formost of the default HIs, there are already HI and KPI assignments, and there is no need to create
new ones.

l Themetrics you want to map to the HIs.

6. Edit the monitor's field mapping
Themapping defines the processing of incoming data and the output sample forwarded to APM.
a. In the Field Mapping panel, select theMetrics field mapping script, and click Load File.
b. Map the script values to the corresponding field mapping group in which they appear in the entity

(database, log file, SNMP trap, orWeb service) from which you want to extract data.
o Formandatory script values, see "Mandatory Values for theMetrics Script" on page 344.
o For optional script values, see "Optional Values for theMetrics Script" on page 344.

Note: Integration field mapping should be configured in such a way that assures that each
monitor CI created by the integration is connected to a single monitored CI (such as
Computer). Avoid creatingmonitor CIs connected tomultiple Computer CIs. To achieve this,
it is recommended to use a value for the TargetName field as part of aMonitorName. For
example:

Recommended:

MonitorName="Disk usage on " + $group0
TargetName=$group0

Avoid:

MonitorName="Disk usage on my computer"
TargetName=$group0

c. The indicator mapping fields can be configured in either the Field Mapping panel in SiteScope or in
SAM Administration. For details, see the following step.

Note: The Field Mapping settings are not available when theReport topology without data check
box is selected in the Topology Settings panel. For details on reporting topology without data, see
"Report Topology Without Data" on page 397.

7. Map metrics to indicators
Define themapping of your metrics to HIs. There are two ways to define the indicator mappings:
l In System Availability Management (SAM) Administration. Use this option to create a general
mapping for your monitor type, or if you want to use regular expressions for themeasurements in the
mapping. For details, see "How to Create andManage Indicator Assignments" and "Create New
Monitor Dialog Box" in the APMUser Guide in the APMHelp.

l In the Field Mapping of the technology integrationmonitor. Use this option for simpler cases. For
example, if you want to define amapping between ametric to an HI without using regular
expressions. For details, see the previous step ("Edit themonitor's field mapping" above).

To map metrics to indicators:
a. If you use SAM Administration to define the indicator mapping, enter themonitor name you used in

the indicator mapping in SAM Administration for theMonitorType value in the Field Mapping panel.
b. If you already defined amapping between themetric and the indicator in SAM Administration for the
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MeasurementETI(x) value, this field should not be set in the Field Mapping panel (keep it
commented out). Otherwise, it should be uncommented and you should enter the label (display
name) of one of the existing indicators that is defined on the Computer CI that suits your
requirements. For example, CPU Load, for ameasurement that checks CPU usage.

c. TheMeasurementCIHint(x) value should not be set (keep it commented out), since SiteScope sets
the CI hint automatically.

8. Select a Topology Script
In the Topology Settings section of the integrationmonitor, select Computer - Monitor from the
Topology script list. You do not need to fill any topology script.

Note: TheComputer - Monitor topology integration requires that the names or IP addresses of the
nodes that it adds to RTSM are accessible through DNS resolution. To successfully populate a
Node CI specified in the TargetName field to RTSM, SiteScopemust be able to resolve the node's
fully qualified domain name and IP address through a DNS service.

9. Assign group permissions if using SAM reports
If you configure a generic integrationmonitor with aMetrics field mapping, youmust assign for each
defined user, permissions to view SiteScope groups and their subgroups in System Availability
Management reports and custom reports. For more information, see the section on Permissions in the
APM Platform Administration Guide in the APMHelp.

10. Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running themonitor. This tests
the following:
l Checks the field mapping and topology script syntax.

l Displays themapping results.

l Displays the topology results if a topology script has been configured.

11. View Integration Results
After definingmetrics assignments and configuring themonitor in SiteScope (including field mapping and
topology script), you can view the results in the following applications:
In Service Health:
a. In APM, select Applications > Service Health > Top View.
b. In the drop down list, select:

o System Hardware Monitoring to view the status of the Computer CI.
o System Monitors view to view themonitor and its status.

In SAM Reports:
You can also view the data of your integration in SAM reports. In the different reports, specify a filter for
the data that you want to be displayed in the graphs.
Configure the filter to include the following values that you defined in the field mapping (see "Edit the
monitor's field mapping" on the previous page):
l Target: Select a value that was defined in the TargetName field in the IntegrationMonitor Field
Mapping.
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l Monitor type:Select a value that was defined in the MonitorType field in the IntegrationMonitor
Field Mapping.

l Monitor title/name: Select a value that was defined in the MonitorName field in the Integration
Monitor Field Mapping.

l Measurement: Select a value that was defined in the MeasurementName(x) field in the Integration
Monitor Field Mapping.

Example – Create a Metrics FlowWith Computer - Monitor
Topology
This example describes how to create an integrationmonitor to capture and forwardmetrics samples from a
third-party system that monitors different disks to APM using the Computer - Monitor topology script.

Note: For a task related to this example, see "How to Configure IntegrationMonitors to Collect Metrics
DataWith Computer - Monitor Topology" on page 345.

1. Design stage
You have a third-party application that writes to a log file. It writes to the log the disk usage of different
computers.
Since the application writes to log files, create a Technology Log File Integrationmonitor for the
integration in SiteScope. Use theMetrics field mapping and theComputer - Monitor topology script,
and select the Host Disk Utilization indicator. There is no need to create assignments for this HI or
KPI since there are existing assignments for them.
Entries in the log file:

l labamrnd42,disk,d,65,warning

l labamrnd42,disk,d,70,warning

l labamrnd42,disk,d,70,warning

2. Map Metrics to Indicators in SAM Administration
Create a new monitor type inBSM > Admin > System Availability Management > Metrics and
Indicators.

My Disk Usage is themonitor type and Custom is the category.
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Now, define a new indicator mapping for themonitor:

This is how the table looks when you save it:

3. Define the Field Mapping

Note: The field mapping script to use is available in a text file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and selectMetrics_Computer_
Monitor_Topology_Field_Mapping.txt.

In the field mapping script, you can see that theMonitorType value is My Disk Usage (as defined in the
indicator mapping in SAM Administration).
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Themeasurement matches the regular expression defined in the indicator mapping: MeasurementName
(1)="disk " +$group2 + " utilization".
MeasurementETI(1) is commented out since you already defined amapping in SAM Administration.
MeasurementCIHint(1) is commented out since SiteScope sets the hint automatically.

4. Select a Topology Script
In the Topology Settings section of the integrationmonitor, select theComputer - Monitor script from
the Topology script list.

5. View Integration Results
In BSM, select Applications > Service Health and view the target computer beingmonitored
(labamrnd42) in the System HardwareMonitoring view.

These are the results of the indicator status on themonitoredmachine:
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How to Configure Integration Monitors to Collect
Metrics Data With Custom Topology
This task describes the steps involved in creating an integration for metrics samples using the custom
topology flow.

Note: For an example of this task, see "Example – Create aMetrics Flow With Custom Topology" on
page 355.

1. Change the CI Resolver TQL (only if SiteScope is connected to a version of
BSM earlier than 9.20)
a. In APM, select Admin > Platform > Infrastructure Settings.

o Select Applications.
o Select End User/System Availability Management.
o In theEnd User/System Availability Management - SiteScope CI Resolver Settings, check

if the value of the TQL Queries parameter is CIs Monitored by SiteScope. If it is, change it to
OMiAutoView.

b. Restart APM to apply the change.

Note: This TQL does not support models with a large number of CIs (it may cause performance
problems in suchmodels).

2. Configure BSM integration
Integrate SiteScope and APM. For details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

3. Select the SiteScope
Select the SiteScope server from which you want to deploy the integrationmonitor:
l For SiteScope standalone, select and open a SiteScope instance.

l When in SAM Administration, select the SiteScope server from which you want to deploy the
integrationmonitor. For user interface details, see "System Availability Management Administration
Page" in the APMUser Guide in the APMHelp.

4. Create a group for the integration monitor
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Tip:We recommend that you create special groups for the integrationmonitors. This enables you to
more easily recognize the data that is reported to APM as coming from the integrations.

5. Add the integration monitor
Configure the integrationmonitor and add the required data for themonitor's settings. You can choose
from the following application-specific integrations:
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l HP OMEvent Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l HP ServiceManager Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l NetScout Event Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

You can choose from the following generic integrationmonitors (note that generic integrationmonitors are
supported for BSM 9.1x and earlier versions only; for all new third-party data integrations in BSM 9.2x,
use BSMConnector as described in the APM Application Administration Guide in the APMHelp.)
l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor Reference
Guide)

6. Edit the monitor's field mapping
Themapping defines the processing of incoming data and the output sample forwarded to APM.
a. In the Field Mapping panel, select theMetrics field mapping script, and click Load File.
b. Enter the details you want to send in the ss_t sample file.

o For theMeasurementETI value, enter the label of the HI you chose previously in "How to
Configure IntegrationMonitors to Collect Metrics DataWith Custom Topology" on the previous
page.

o Enter a hint for the CI inMeasurementCIHint. This hint helps the CI resolver in APM to
recognize the CI to which the sample should be attached.
For details on values for themetrics script, see "Configure Field Mapping for Metrics Samples" on
page 344.

Note: The Field Mapping settings are not available when theReport topology without data check
box is selected in the Topology Settings panel. For details on reporting topology without data, see
"Report Topology Without Data" on page 397.

7. Design the topology flow
When planning the design strategy for the custom topology flow, you need to consider the following:
l CIs for topology
Consider the entities that you want to report to APM. For these entities, youmight also want to report
data and to view the health status of these entities in APM's Service Health.

For example, you have a third-party application named TPA that writes to a database. The entries in
this database contain performance data on CPU and network usage of different computers. In this
case, you will probably want to create a topology that reports Computer CIs to APM.

l Data that you want to be reported for these CIs
Consider what data you have for these CIs and how it can be attached to the CIs. What is the relevant
health indicator (HI) for the data being reported? If there is no such indicator, consider creating a new
HI. Which KPI or HI assignments create the desired HIs and KPIs? If no such assignments exist,
consider creating your own.
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8. Create the custom topology script
Finally you create the topology script. The script defines how to report CIs to APM. For details on the
topology script, see "Topology Settings for Technology IntegrationMonitors" on page 328.

For the monitored_by attribute of the CI, enter the identifier for this integration. This is the same value
you used in the HI assignment in "How to Configure IntegrationMonitors to Collect Metrics DataWith
Custom Topology" on page 352.

Note:

l When using field mapping, you can use the field mapping fields as an input for topology script.
For example, if using common event mapping, you can access the value of the Category field in
the following way:

category = Framework.getDestinationAttribute("Category")

l In addition, you can access values of the "monitor variables", such as group0, group1, and so
forth, from Technology Log File Integrationmonitor, or the names of database columns in
Technology Database Integrationmonitor, or other variables in the other integrationmonitors. For
example, you can access the value of the group1 variable, in the following way:
group1 = Framework.getDestinationAttribute("group1")

Tip: To troubleshoot topology issues, see BSM Topology Issues in the Integration with BSM and
HPOM Best Practices Guide.

9. Assign group permissions if using SAM reports
If you configure a generic integrationmonitor with aMetrics field mapping, youmust assign for each
defined user, permissions to view SiteScope groups and their subgroups in SAM reports and custom
reports. For more information, see the section on Permissions in the APM Platform Administration Guide
in the APMHelp.

10. Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running themonitor. This tests
the following:
l Checks the field mapping and topology script syntax.

l Displays themapping results.

l Displays the topology results if a topology script has been configured.

11. View Integration Results
After configuring the HI and KPI assignments in APM and themonitor in SiteScope (including field
mapping and topology script), you can view the results.
l Create a view in RTSM to view the results of the integration in APM's Service Health or Service Level
Management application. The view should describe the topology you defined in "Create the custom
topology script" above.
For details on creating the view, see "Modeling Studio Page" in theModeling Guide in the APMHelp.
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If you defined the integration for SLM as well, you can view the integration results in SLM reports. For
more information on SLM and on the reports, see "Working with the Service Level Management
Application" in the APMUser Guide in the APMHelp.

l You can also view the integration data in System Availability Management reports. In the different
reports, specify a filter for the data that you want to be displayed in the graphs.
Configure the filter to include the following values that you defined in the field mapping in "Edit the
monitor's field mapping" on page 353:
o Target: Select a value that was defined in the TargetName field in the IntegrationMonitor Field

Mapping.
o Monitor type:Select a value that was defined in the MonitorType field in the IntegrationMonitor

Field Mapping.
o Monitor title/name: Select a value that was defined in the MonitorName in the IntegrationMonitor

Field Mapping.
o Measurement: Select a value that was defined in the MeasurementName(x) field in the Integration

Monitor Field Mapping.

Example – Create a Metrics FlowWith Custom Topology
This example describes how to create an integrationmonitor to capture and forwardmetrics samples from a
third-party system that monitors different Oracle databases to APM using the custom topology script. This
script enables you to create your own topology.

Note: For a task related to this example, see "How to Configure IntegrationMonitors to Collect Metrics
DataWith Custom Topology" on page 352.

1. Design Stage
You have an application named My Oracle Monitoring. This application writes measurements from
Oracle databases running on different computers to a log file.
Since the application writes to log files, create a Technology Log File Integrationmonitor for the
integration. The topology that you want to report includes Oracle CIs, and you will create a HI on these
CIs. You will focus on one indicator and onemeasurement that you are interested in.
Entries in the log file:
l amrnd153,27,1,good

l amrnd153,82,1,warning

l amrnd153,80,1,warning
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The Technology Log File Integrationmonitor in SiteScope:

2. Select an Indicator
In APM, select Admin > Service Health > Repositories > Indicators. For the My Oracle
Monitoring application, use theCPU Usage by SQL (Database) indicator. This indicator reports SQL
as well as Oracle usage.

Using SiteScope
Chapter 30: Configure IntegrationMonitors to Collect Metrics Data

HPE SiteScope (11.33) Page 356 of 1206



This indicator is defined on theOracle CI type (the CI that will be reported), and is appropriate for the
measurement being read from the log. This measurement describes the amount of CPU that Oracle
uses.

3. Define an HI Assignment
In APM, select Admin > Service Health > Assignments > Health Indicator Assignments and
create the indicator assignment.
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In theMonitored by property, manually enter My Oracle Monitoring integration. This value helps
you distinguish Oracle CIs reported by this integration from other Oracle CIs that are being reported. This
assigns the CPU Usage by SQL indicator on the Oracle CIs that are reported by this integration only.
If you edit the indicator in this assignment, you get this:
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The CPU Usage by SQL indicator is calculated using the SiteScopeWorst Status Rule. The selector
defines that samples of type ss_t (themetrics data type) with the same ci_id and eti_id as the current
CI and ETI are captured by this indicator on this Oracle CI. You do not want other samples to be
captured.

4. Define a KPI Assignment
Since you used a default indicator, you do not need to create a KPI assignment as there is an existing
Service Health KPI assignment onOracle CIs.
In APM, select Admin > Service Health > Assignments > KPI Assignments, and in the CI Type tree
select Oracle and chooseOracle KPI Assignment.
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Select theSoftware PerformanceKPI:
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You can see that one of the indicators related to this KPI is the CPU Usage by SQL indicator which you
used.
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5. Configure Field Mapping

Note: The field mapping script to use is available in a text file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and selectMetrics_Custom_
Topology_Field_Mapping.txt.

In the field mapping script, you can see that you defined a new monitor type: My Oracle.
Themonitor name is My Oracle mon on $group0where $group 0 is also the target computer on which
the Oracle database is running.

Themeasurement name is oracle cpu usage and its value is taken from the log file. The quality that is
sent is conditional and depends on what is written in the log file.

The ETI to which themeasurement is mapped is CPU Usage by SQL.
The CI hint is in the format <<oracle sid>>@@<<computer name>>. The CI hint helps the CI Resolver in
APM to find the CI to which this data sample should be attached.

6. Create the Custom Topology Script

Note: The custom topology script to use is available in a text file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and selectMetrics_Custom_
Topology_Script.txt.

In the custom script, you can see that:
l system_lib.createNode(Framework) creates the node on which the database is running.

l modeling.createDatabaseOSH creates the Oracle CI.

l mainInstance is the SID of the Oracle you used.

l My Oracle Monitoring integration is the monitored_by attribute which is the condition you gave
in the indicator assignment (see "Define an HI Assignment" on page 357).

7. View Integration Results
In APM, select Applications > Service Health andmanually create a view for the integration. For
example, here we created a view named My Oracle Monitoring (it is also displayed in System
SoftwareMonitoring view):
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These are the results of the indicator status on themonitoredmachine:

The state and value are the same as you assigned in the field mapping.

How to Configure Integration Monitors to Collect
Metrics Data With No Topology
This task describes the steps involved in designing and implementing the EMS metrics flow using theNo
Topology script.

Use this flow to use integrationmonitors to sendmetrics samples for an already existing topology in APM. In
this flow, SiteScope sends data without sending topology.

Note: For an example of this task, see "Example – Create aMetrics Flow With No Topology" on
page 367.

1. Change the CI Resolver TQL (only if SiteScope is connected to a version of
BSM earlier than 9.20)
a. In APM, select Admin > Platform > Infrastructure Settings.

o Select Applications.
o Select End User/System Availability Management.
o In theEnd User/System Availability Management - SiteScope CI Resolver Settings, check

if the value of the TQL Queries parameter is CIs Monitored by SiteScope. If it is, change it to
OMiAutoView.

b. Restart APM to apply the change.

Note: This TQL does not support models with a large number of CIs (it may cause performance
problems in suchmodels).

2. Select an Indicator
To view the status of a CI, you need an HI which provides a fine-grainedmeasure of the health of the CI.
In most cases, you want to view the HI in APM's Service Health. The HI is also used in Service Level
Management (SLM). For details on HIs, see "Health Indicators and KPIs - Overview" in the APMUser
Guide in the APMHelp.

Note: For alignment reasons, we recommend using an out-of-the-box HI; only create your ownHI if
you do not find an existing HI that fits your needs.

To select an existing HI or create a new HI:
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a. In APM, select Admin > Service Health / Service Level Management > Repositories >
Indicators.

b. Select a CI type.
c. Check if you already have an existing HI that fits your requirements. If you do not, create a new one.

For details on how to create HIs, see "How to Create or Edit an ETI or HI Template in the Indicator
Repository" in the APMUser Guide in the APMHelp.

d. If you create a new HI, publish the changes to SiteScope. In APM, select Admin > System
Availability Management > Metrics and Indicators and click Publish Changes. The changes
should reach SiteScope within nomore than 5minutes.

3. Define an HI Assignment
After you select an HI, you need to define an HI assignment that will assign the HI to a CI. The
assignment also defines which data samples will be captured by this HI and which business rule will be
used to calculate the status of the HI according to the data samples.
For more information on HI assignments, see the APM Application Administration Guide in the APM
Help.
To define an HI assignment:
a. In APM, select Admin > Service Health / Service Level Management > Assignments > Health

Indicator Assignments.
b. Select a CI type.
c. Create a new HI assignment. For details on how to create the assignment, see "How to Define a KPI

or HI Assignment" in the APM Application Administration Guide in the APMHelp.
o In theCondition area, enter a unique value for your integration in theMonitored By property.

This enables you to distinguish between the CIs reported by your integration to other CIs of this
type which are not reported by the integration.

o Select the HI you chose in "Select an Indicator" on the previous page.
o Choose the business rule to use for the HI calculation. We recommend using the SiteScope

Worst Status Rule. You can also use the SiteScope ConsecutiveWorst Status Log or SiteScope
Best Status Rule.

o In the selector, enter the following:
l eti_id = (Binary) <<Health Indicator Type ID>>
l ci_id = (Binary) <<CI ID>>
l sampleType = (String) ss_t
The integrationmonitor sends metrics samples (ss_t) that contain the same eti_id as your ETI
and sameCI ID as the CI's.
The eti_id in the sample is sent by SiteScope according to your field mapping entry for themonitor
in "Edit themonitor's field mapping" on page 366.
The ci_id is found by the CI resolver in BSM. For it to find the CI, it uses the CI hint sent by
SiteScope in the sample, according to your field mapping entry for themonitor in "Edit the
monitor's field mapping" on page 366.
For details on field mapping for metrics samples, see "Configure Field Mapping for Metrics
Samples" on page 344.

4. Define a KPI Assignment for each CI type
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Verify whether you have an appropriate KPI assignment, or create one if one does not already exist. The
assignment determines which KPI to assign to the CI and for which HIs.
If you use one of the default HIs then there should already be a default KPI assignment for your HI and
you do not need to create one.
For more information on KPI assignments, see the APM Application Administration Guide in the APM
Help.
To create a KPI assignment:
a. In APM, select Admin > Service Health > Repositories > Indicators.
b. Choose the type of your CI.
c. Create a new KPI assignment. For details, see "How to Define a KPI or HI Assignment" in the APM

User Guide in the APMHelp.
d. In the KPI assignment, the related HI should be the one you chose in "Select an Indicator" on

page 363.

Note: If you also want to view the integration results in Service Level Management (SLM), you
need to define the Service Level Agreement (SLA). For more information on SLAs, see
"Agreements Manager Page" in the APMUser Guide in the APMHelp.

5. Configure BSM integration
Integrate SiteScope and APM. For details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

6. Select the SiteScope
Select the SiteScope server from which you want to deploy the integrationmonitor:
l For SiteScope standalone, select and open a SiteScope instance.

l When in SAM Administration, select the SiteScope server from which you want to deploy the
integrationmonitor. For user interface details, see "System Availability Management Administration
Page" in the APMUser Guide in the APMHelp.

7. Create a group for the integration monitor
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Tip:We recommend that you create special groups for the integrationmonitors. This enables you to
more easily recognize the data that is reported to APM as coming from the integrations.

8. Add the integration monitor
Configure the integrationmonitor and add the required data for themonitor's settings. You can choose
from the following application-specific integrations:
l HP OMEvent Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l HP ServiceManager Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l NetScout Event Monitor (for details, see the SiteScopeMonitor ReferenceGuide)
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You can choose from the following generic integrationmonitors (note that generic integrationmonitors are
supported for BSM 9.1x and earlier versions only; for all new third-party data integrations in BSM 9.2x,
use BSMConnector as described in the APM Application Administration Guide in the APMHelp.)
l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor Reference
Guide)

9. Edit the monitor's field mapping
Themapping defines the processing of incoming data and the output sample forwarded to APM.
a. In the Field Mapping panel, select theMetrics field mapping script, and click Load File.
b. Enter the details you want to send in the ss_t sample file.

o For theMeasurementETI value, enter the label of the HI you chose previously in "Select an
Indicator" on page 363.

o Enter a hint for the CI inMeasurementCIHint. This hint helps the CI resolver in BSM to
recognize the CI to which the sample should be attached.
For details on values for themetrics script, see "Configure Field Mapping for Metrics Samples" on
page 344.

Note: The Field Mapping settings are not available when theReport topology without data check
box is selected in the Topology Settings panel. For details on reporting topology without data, see
"Report Topology Without Data" on page 397.

10. Plan the no topology flow
When planning the design strategy for the no topology flow, you need to consider the following:
l CIs for topology
Since you are using the No Topology option, you probably already have CIs in the RTSM to which you
want to report data using EMS monitors.

l Data that you want to be reported for these CIs
Consider what data you have for these CIs and how it can be attached to the CIs. What is the relevant
health indicator (HI) for the data being reported? If there is no such indicator, consider creating a new
HI. Which KPI or HI assignments create the desired HIs and KPIs? If no such assignments exist,
consider creating your own.

For example, if you have data on CPU usage and network usage, you can use the CPU Load and
Interface UtilizationHIs that are defined for the Computer CI type, and you can use the System
Performance KPI. Check if there are HI and KPI assignments that meet your needs, and if not,
consider creating them.

11. Assign group permissions if using SAM reports
If you configure a generic integrationmonitor with aMetrics field mapping, youmust assign for each
defined user, permissions to view SiteScope groups and their subgroups in SAM reports and custom
reports. For more information, see the section on Permissions in the APM Platform Administration Guide
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in the APMHelp.

12. View Integration Results
After configuring the HI and KPI assignments in BSM and themonitor in SiteScope (including field
mapping), you can view the results.
l Create a view in RTSM to view the results of the integration in APM's Service Health or Service Level
Management application. The view should describe the CIs you want to view.
For details on creating the view, see "Modeling Studio Page" in theModeling Guide in the APMHelp.
If you defined the integration for SLM as well, you can view the integration results in SLM reports. For
more information on SLM and on the reports, see "Working with the Service Level Management
Application" in the APMUser Guide in the APMHelp.

l You can also view the integration data in System Availability Management reports. In the different
reports, specify a filter for the data that you want to be displayed in the graphs.
Configure the filter to include the following values that you defined in the field mapping in step 9:
o Target: Select a value that was defined in the TargetName field in the IntegrationMonitor Field

Mapping.
o Monitor type:Select a value that was defined in the MonitorType field in the IntegrationMonitor

Field Mapping.
o Monitor title/name: Select a value that was defined in the MonitorName field in the Integration

Monitor Field Mapping.
o Measurement: Select a value that was defined in the MeasurementName(x) field in the Integration

Monitor Field Mapping.

Example – Create a Metrics FlowWith No Topology
This example describes how to create an integrationmonitor to capture and forwardmetrics samples from a
third-party system that monitors different Oracle databases to APM using the No Topology flow. This flow is
used to sendmetric samples when a topology already exists in APM, and there is no need to report the CIs.

Note: For a task related to this example, see "How to Configure IntegrationMonitors to Collect Metrics
DataWith No Topology" on page 363.

1. Design Stage
You have an application named My Oracle Monitoring. This application writes various measurements
from Oracle databases running on different computers to a log file.
Since the application writes to log files, you need to create a Technology Log File Integrationmonitor for
the integration. Themeasurements will be assigned to Oracle CIs that already exist in RTSM; therefore
the CIs do not need to be reported. The data is assigned to HIs on the CIs. You will focus on one
indicator and onemeasurement that you are interested in.
Entries in the log file:
l amrnd153,27,1,good

l amrnd153,82,1,warning

l amrnd153,80,1,warning
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The Technology Log File Integrationmonitor in SiteScope:

2. Select an Indicator
In APM, select Admin > Service Health > Repositories > Indicators. For the My Oracle
Monitoring application, use theCPU Usage by SQL (Database) indicator. This indicator reports SQL
as well as Oracle usage.

Using SiteScope
Chapter 30: Configure IntegrationMonitors to Collect Metrics Data

HPE SiteScope (11.33) Page 368 of 1206



This indicator is defined onOracle CI type and is appropriate for themeasurement being read from the
log. This measurement describes the amount of CPU that Oracle uses.

3. Define an HI Assignment
In APM, select Admin > Service Health > Assignments > Health Indicator Assignments and
create the indicator assignment.
The assignment condition shouldmatch the Oracle CIs on which you want to define the indicators (and
not other Oracle CIs that do not belong to this integration). In the indicator assignment, select theCPU
Usage by SQL indicator.
If you edit the indicator in this assignment, you get this:
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The CPU Usage by SQL indicator is calculated using the SiteScopeWorst Status Rule. The selector
defines that samples of type ss_t (themetrics data type) with the same ci_id and eti_id as the current
CI and ETI are captured by this indicator on this Oracle CI. You do not want other samples to be
captured.

4. Define a KPI Assignment
Since you used a default indicator, you do not need to create a KPI assignment as there is an existing
Service Health KPI assignment onOracle CIs.
In APM, select Admin > Service Health > Assignments > KPI Assignments, and in the CI Type tree
select Oracle and chooseOracle KPI Assignment.
In theMonitored by property, manually enter My Oracle Monitoring integration. This value helps
you distinguish Oracle CIs reported by this integration from other Oracle CIs that are being reported. This
assigns the CPU Usage by SQL indicator on the Oracle CIs that are reported by this integration only.
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Select theSoftware PerformanceKPI:
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You can see that one of the indicators related to this KPI is the CPU Usage by SQL indicator which you
used.
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5. Define the Field Mapping

Note: Thefield mapping script to use is available in a text file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and selectMetrics_No_
Topology_Field_Mapping.txt.

In the field mapping script, you can see that a new monitor type was defined: My Oracle.
Themonitor name is My Oracle mon on$group0where $group 0 is also the target computer on which
the Oracle database is running.

Themeasurement name is oracle cpu usage and its value is taken from the log file. The quality that is
sent is conditional and depends on what is written in the log file.

The ETI to which themeasurement is mapped is CPU Usage by SQL.
The CI hint is in the format <<oracle sid>>@@<<computer name>>. The CI hint helps the CI Resolver in
APM to find the CI to which this data sample should be attached.

6. View Integration Results
In APM, select Applications > Service Health andmanually create a view for the integration. For
example, here we created a view named My Oracle Monitoring (it is also displayed in System
SoftwareMonitoring view):

These are the results of the indicator status on themonitoredmachine:

The state and value are the same as you assigned in the field mapping.
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Chapter 31: Configure Integration Monitors to
Collect Event Data
When configuring the generic integrationmonitors, you can select the event data type to collect common or
legacy event-based data. Common events data is used to integrate events collected from third-party domain
managers or applications to BSM 9.x. Legacy events are used to collect data on specific events in BAC 8.x
and earlier (retained for backward compatibility).

Troubleshooting/Limitations
General Notes/Limitations
This section describes troubleshooting and limitations for IntegrationMonitor field mapping.

l For event samples, themonitor_id of the reported EMS monitor is built in the following way:
l For Events samples andComputer topology, themonitor_id is:
< target_name>

l For Events samples andComputer - Running Software topology (where subject is not equal to
system), themonitor_id is:
<subject (running software name)>

l For Events samples andComputer - Running Software topology (where subject equals system), the
monitor_id is:
< target_name>

l Do not use XML special characters (",',<,>,&) in the fields used to create themonitor_id, since these
characters causes problems for these samples in BSM.

Integration Monitor Field Mapping for Event Samples
You can enable capturing event data from EnterpriseManagement Systems (EMS), automated support
systems, and other management applications by configuring integrationmonitors and their field mapping
scripts.

Integrationmonitors depend on the field mapping you customize within the user interface in the settings for the
monitor. Themapping defines the processing of incoming data and defines the output sample forwarded to
APM.

IntegrationMonitors designed for use with specific EMS applications (these currently include HPOM, Service
Center, and NetScout) can be configured without editing their field mapping script. Themapping is predefined
by HPE and requires modification only if specific customizations are required. For details on editing these field
mapping scripts, see the description for the field mapping element in the user interface pages for themonitor
you are deploying.

For Technology IntegrationMonitors (Technology SNMP Trap, Technology Log File, and Technology
Databasemonitors), youmust select the data type and the required script is loaded directly into the field

HPE SiteScope (11.33) Page 374 of 1206



mapping text box. Youmust edit the field mapping script to suit your organization's needs. The Technology
Web Service IntegrationMonitor field mappingmay also need to be customized.

You can select theCommon Events or Legacy Events data type to integrate events collected from third-
party domainmanagers or applications to BSM 9.x. Unlike the legacy EMS events, the Common Event
integration allows you tomanage the events in Operations Management event sub system and the Service
Health console. In addition, the common event channel provides the option to report topology to APM without
reporting the data.

When you select theCommon Events data type to forward event data to APM, and you want to integrate to
APM using topology settings, you can select from the following predefined topology scripts:

l Computer. Select to create a topology with a Computer CI.
l Computer - Running Software. Select to create a topology with a Computer CI and a Running Software
CI connected to it with a Composition relationship.

l Custom. Select to create your own topology script, if you want the retrieved data to be sent to specific CIs
instead of the Computer or Running Software CIs. Only select this option if you are familiar with the
Jython language, because youmust create the topology script in Jython yourself.

When you select the LegacyEvents data type to forward event data to APM, and you want to integrate to
APM using topology settings, you can select from the following topology scripts:

l Node. Creates a Node CI with an EMS monitor CI connected to it with Monitored By relationship.
l Node - Running Software. Creates a topology with a Node CI and a Running Software CI connected to it
with a Composition relationship, and an EMS monitor CI which can be connected to either the Node CI or
the Running Software CI with Monitored By relationship.

l Custom. Select to create your own topology script, if you want the retrieved data to be sent to specific CIs
instead of the Computer or Running Software CIs. Youmust be familiar with the Jython language, since
youmust create the topology script yourself.

Note:

l Events sent by EMS applications are event samples. They are not the same as Operations
Management events in APM.

l When SiteScope version 11.10 or earlier is connected to APM 9.00, theHosts-Applications
topology script is no longer available in the topology script list for themonitor. Only existing
integrations that report Hosts-Applications (created in SiteScope connected to APM 8.x) continue
reporting to APM 9.00. You cannot create new integrations using this script type.

l SiteScope uses indicator definitions for monitor CIs created by the integration that are defined in APM
(and that are applicable for Computer CI type). If a different ETI is specified in themonitor's field
mapping, it overrides the default indicator definition.

For details on selecting a topology setting, see "Topology Settings for Technology IntegrationMonitors" on
page 328.

Note: Use only themandatory and optional fields defined in the scripts when working with the field
mapping. For more information, see the tables for each data type.

Configure Field Mapping for Common Event Samples
The events data type is used for extracting events collected by external systems and importing them to APM.
When configuring an integrationmonitor's field mapping, select theCommonEvents data type to load the
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events script. You can then copy the contents of the Field Mapping text box and paste it into a text editor to
make your configuration changes. When you are done, copy the contents back into the Field Mapping text
box.

For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page 333.

For CI resolution hint formats, see "CI Resolution Hint Formats" on page 333.

This section also includes:

l "Mandatory Values for the Common Events Script" below
l "Mandatory Values WhenReporting Topology Without Data" below
l "Optional Values for the Common Events Script" on the next page
l "Common Events Script Example" on page 378

Mandatory Values for the Common Events Script
The table below lists mandatory values for the common events script. Map the values to the corresponding
field mapping group in which they appear in the log file from which you want to extract data.

Field
Name Description

Title Summary of the event.

Severity Severity of the event. Possible values are: Normal, Warning, Minor, Major, and Critical.

SourceHint Information about themonitoring application and the corresponding probe/agent that is
responsible for creating the event.

Mandatory Values When Reporting Topology Without Data
The following values aremandatory when reporting only the topology discovered by the SiteScope
Technology Integrationmonitors, without reporting the data:

For Topology
Script

Field
Name Description

l Computer
l Computer -
Running
Software

target_
name

Name of the host or machine that generated the event. This can be added
manually or taken from:
Framework.getDestinationAttribute("<someAttribute>")

Examples:

Technology Log File Integrationmonitor: Framework.getDestinationAttribute
("group0") where group0 is the value of the first patternmatching group.

Technology Database Integrationmonitor: Framework.getDestinationAttribute
("NAME") where NAME is the name of a database column.

Technology Web Service Integrationmonitor:
Framework.getDestinationAttribute(“Host") where HOST is the key in the
SOAP request <key>Host</key>.
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For Topology
Script

Field
Name Description

l Computer
l Computer -
Running
Software

target_
ip

IP of the host or machine. This can be addedmanually, or calculated using:
HostIPCachingManager.getIPByHostName(target_name)

where target_name represents a valid host or machine, or you can use:
HostIPCachingManager.getIPByHostName("<someAttribute>")

Computer -
Running
Software

name Name of Running Software. This can be addedmanually, or taken from:
Framework.getDestinationAttribute("<someAttribute>")

Optional Values for the Common Events Script
The table below lists optional values for the common events script. Map the values to the corresponding field
mapping group in which they appear in the log file from which you want to extract data.

Field Name Description

CiHint Information about a CI that is related to the event. For details of the formats for CI
resolution hints, see "Field Mapping Structure" on page 332.

EtiHint Event Type Indicator hint in the format:
[ETI Name]:[ETI Value]:[Metric Value]

Example: CPULoad:Critical:50

For more information on BSM indicators, see "Health Indicators and KPIs" in the APM
User Guide in the APMDocumentation Library.

ComponentCi Information used to identify a subcomponent of a CI. This CI subcomponent is used to
calculate an aggregated status within BSM's Service Health for selected CIs.

If an HI is populated by events frommultiple components, you can specify a component
name in this field in order to ensure the correct calculation of the HI state.

Example: If you have a Computer CI with two CPUs, cpu #1 and cpu #2, events from
both CPUs will be sent to the same CPU LoadHI. By default, the events will override each
other and create an incorrect HI state. To prevent this, you can populate ComponentCiwith
values "cpu #1" and "cpu #2" which will cause the HI state to be calculated as an
aggregated state between the two events.

HostHint Information about a CI of type Node that is hosting the CI related to the event. This field is
mandatory when reporting topology which includes Node CIs.

Description Additional information describing the event.

Category Name of a logical group to which the event belongs. An event category is similar to a
message group in HPOM.

Example (from log file): Database, Security, Network
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Field Name Description

SubCategory Name of a logical subgroup (category) to which the event belongs.

Example (from log file): Oracle (database), Accounts (security), Routers (network))

Key A unique string representing the type of event that occurred. Two events can have the
same key if both events represent the same situation in themanaged environment. Events
with the same key are treated as duplicates.

Example (from log file): foohost:barhost:CPULoad:Critical

CloseKey Enables the event that is sent to close all events whoseKey attributematches the
CloseKey pattern expression. You can use wildcards (*) if necessary.

Example (from log file): barhost:CPULoad<*>

LogOnly This field allows submitting an event that goes directly into the history event browser as a
closed event. Such an event goes though the complete event processing (CI Resolution,
updating HIs, and so forth), but has its Life Cycle State set to closed from the beginning.
For details on CI Resolution, see "CI Resolution" in the APMUser Guide in the APM
Documentation Library.

Typical examples of events having this attribute set to "True" are events that will result in
resetting a Health Indicator to a "Normal" or "Good" state, or an event signaling that a
previous problem no longer exists (where the problem was reported in another event).

Possible values are:

l True. Logs all events automatically on arrival.
l False. Events are not logged automatically.
l True for normal severity. Automatically logs events with Normal severity only.
Default value: False

Attributes

#cma1=

#cma2=

#cma3=

#cma4=

#cma5=

Use these attributes to send any custom attributes in the event.

Note: Only the predefined custommapping attributes are supported. You cannot change a
custom attribute name (cma1-cma5) or add a new one.

Common Events Script Example
The example below shows a section of the Common Events script with script values mapped to the
corresponding field mapping group ($group<#>) in which they appear in the log file.

[$DEFAULT_PARAMETERS$]
############################################
# NOTE: the following fields are mandatory #
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############################################
# Brief summary of the event
Title=$group0
# Severity of the event. Possible values are: "Normal", "Warning", "Minor", "Major",
and "Critical"
Severity=$group2
# Information about the monitoring application and the corresponding probe/agent that
is responsible for creating the event
# If the field is left empty then it will be auto filled with SiteScope@@
[SiteScope Node FQDN]
SourceHint=$group8
############################################
NOTE: the following fields are optional #
# An unfilled field must remarked with '#' #
#############################################
# Information about a CI that is related to the event. For more information, see
"Preferences" > "Common Event Mappings" > "New/Edit Event Mapping Dialog Box" in the
SiteScope documentation
CiHint=$group6
# Event Type Indicator hint in the format: [ETI Name]:[ETI Value]:[Metric Value].
Example: CPULoad:Critical:50
EtiHint=$group5
# Information used to identify a subcomponent of a CI. This CI subcomponent is used
to calculate an aggregated status within BSM Service Health for selected CIs
#ComponentCi=

Configure Field Mapping for Legacy Event Samples
The events data type is used for extracting events collected by external systems and importing them to APM.
When configuring an integrationmonitor's field mapping, select the Legacy Events data type to load the
events script. You can then copy the contents of the Field Mapping text box and paste it into a text editor to
make your configuration changes. When you are done, copy the contents back into the Field Mapping text
box.

For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page 333.

For CI resolution hint formats, see "Field Mapping Structure" on page 332.

This section also includes:

l "Mandatory Values for the Legacy Event Script" below
l "Optional Values for the Legacy Event Script" on page 381
l "Conditional Expression Example 1" on page 382
l "Conditional Expression Example 2" on page 382
l "Event Script Example" on page 382

Mandatory Values for the Legacy Event Script
The table below lists mandatory values for the legacy event script.
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Field Name Type Description Example

time_stamp DOUBLE Time stamp in seconds since Jan 1
1970.

time_stamp:DOUBLE=str_to_seconds
($time,"yyyy-MM-dd
HH:mm:ss.SSS").

time_stamp:DOUBLE=int time()

For details on int time(), see
"Available Data Processing
Operations" on page 334.

severity INT Can be one of the following
preconfigured severities (based on
applicable integer):
0:SEVERITY_UNKNOWN
1:SEVERITY_INFORMATIONAL
2:SEVERITY_WARNING
3:SEVERITY_MINOR
4:SEVERITY_MAJOR
5:SEVERITY_CRITICAL

severity:INT=SEVERITY_MINOR

target_name STRING Name of device or host machine that
generated the event.

target_name=$hostName

target_name=String
resolveHostName(String hostIP)

For details on String
resolveHostName(String hostIP),
see "Available Data Processing
Operations" on page 334.

status STRING Status of event in external EMS
terminology.

status="OPEN"

status="ASSIGNED"

status="CLOSED"

subject STRING Subject of event (e.g. CPU, SAP
application, Hard Disk), middle/high
level hierarchy describing the event
source.

subject="DISK"

instance STRING Instance of subject that generated
the event (e.g D:\). Lowest level of
hierarchy describing the event
source.

instance="E:\\"

description STRING Textual description of event. description="free space on drive
e is below 10%"

data_source STRING System that generated the event. data_source="HP OVO"
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Optional Values for the Legacy Event Script
The table below lists optional values for the legacy event script.

Field Name Type Description Example

target_ip STRING IP of device or host machine that
generated the event.

target_ip=$IPString

object STRING Optional level in the hierarchy
describing the event source.

object="OS"

event_id STRING Unique identifier of this event. event_id=$id

logical_group STRING Logical grouping of this event. logical_group="error
messages"

monitor_
group

STRING Monitor group that reported this event. monitor_group="log monitors
on \\hostname"

orig_
severity_name

STRING Severity in external EMS terminology. orig_severity_name
="Cleared"

acknowledged_
by

STRING Name of user that acknowledged this
event.

acknowledged_by =$username

owner STRING Name of user who owns this event. owner="admin"

value DOUBLE Use to transfer numerical values from
the event.

value=$thresholdViolated

attr1 STRING Extra data slot. attr1=$history

attr2 STRING Extra data slot. attr2=$moreHistory

attr3 STRING Extra data slot. attr3="Design"

attr4 STRING Extra data slot. attr4=$MonitorOutput

attr5 STRING Extra data slot for long strings. attr5=$Longhistory

Host DNS Resolution for Event Sample
Both the FQDN (fully qualified domain name) and valid IP address are necessary for the fields that are used to
create Node CIs in the APM integration.

If you do not know the FQDN, IP address, or both, then you can use the following functions in the field
mapping to resolve the names and access them from the source of the integration:

target_name=resolveHostName($SomeHost)

target_ip=resolveHostIP($SomeHost)

Note: The variable $SomeHostmust be replaced by a variable from the integration source.
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These functions are not necessary if:

l The FQDN, IP address, or both, are available from the source that the integration is accessing. In this
case, input the value for target_name= as a FQDN and the value for the target_ip= without the function.

l It is not possible for the SiteScope server to resolve the FQDN, IP address, or both, for the servers from
the source that the integration is accessing. In this case, the functions may not provide the valid values.

Conditional Expression Example 1

severity:INT=$var6.equals("red") ? SEVERITY_CRITICAL
: SEVERITY_INFORMATIONAL

In this example, the value of sixth variable binding is compared to string red. If the variable binding is indeed
equal to string red, then the value of the severity tag is set to SEVERITY_CRITICAL, otherwise it is set to
SEVERITY_INFORMATIONAL.

Conditional Expression Example 2

severity:INT=$var6.equals("red") ? SEVERITY_CRITICAL :
$var6.equals("green") ? SEVERITY_INFORMATIONAL : $var6.equals("yellow")
? SEVERITY_MINOR : SEVERITY_WARNING

This example chains the conditional operator into a decision chain. If the sixth variable binding holds string
red, then severity tag has the value SEVERITY_CRITICAL. If the sixth variable binding holds string green,
then severity tag has the value SEVERITY_INFORMATIONAL. If the variable binding holds string yellow, the
tag has the value SEVERITY_MINOR. If none of the above conditions are true, then the tag has the value
SEVERITY_WARNING.

Event Script Example
In the example below, two types of events are sent: the first are events of status "OPEN" and the second are
events cleared by a user. The data is retrieved from incoming event fields using the $ notation. All other
events are discarded by the last handler.

[$DEFAULT_PARAMETERS$]
################################################
# NOTE: the following parameters are mandatory #
################################################
time_stamp:DOUBLE=str_to_seconds($time,"yyyy-MM-dd HH:mm:ss.SSS")
severity:INT= SEVERITY_UNKNOWN
target_name=$Device
status=$Status
subject="EMS X Events"
instance=$target
description=$description
data_source="EMS X"

#send an open event with the value in value fields and with the event id
[OPEN events]
$MATCH="OPEN".equals($Status)
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$ACTION=SEND(event)
value:DOUBLE=parseDouble($threshold)
event_id=$uid

#send clear events with the event id and acknowledging username
[clear events]
$MATCH="CLEAR".equals($Status)
$ACTION=SEND(event)
event_id=$uid
acknowledged_by=$ClearedBy

[event sink]
$MATCH=true
$ACTION=DISCARD

How to Configure Integration Monitors to Collect Data
on Common Events
This task describes the steps involved in configuring the common event integration, which is used to collect
data on specific events, and tomake the data available for use in APM's Operations Management event sub
system, the Service Health console, and Service Level Management.

1. Plan the integration strategy
Review the IntegrationMonitor types. Consider the type of information you want to view in APM from
your EMS system. Determine whether one of the specific IntegrationMonitors meets your organization's
needs or whether a generic IntegrationMonitor (Technology Log File, Database, SNMP Trap, Web
Service) is required.
For concept details, see "IntegrationMonitors Overview" on page 324.

2. Configure BSM integration
Integrate SiteScope and APM. For details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

3. Configure Operations Manager event integration
Follow the steps for configuring the event integration. For details, see "How to enable SiteScope to send
events to HPOM or OMi" in Integrating SiteScope with Operations Manager Products. You can check the
HP Software Integrations site for the latest version of this guide.

Note:

l You do not need to select Enable sending events in the HP Operations Manager Integrations
Main Settings panel (the "Enable SiteScope to send events to HPOM or BSM" step), because
this step applies only to sending events for regular SiteScopemonitors. Events for integration
monitors are automatically sent when the integrationmonitor is configured to use theCommon
Events samplemapping script.
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l The "Enable/Disable sending events for monitor instances and alerts" step is not relevant when
sending events for integrationmonitors.

l You do not need to select theEnable HP Operations Manager metrics integration check box
in the HP Operations Manager Metrics Integrations panel.

4. Select the SiteScope server
Select the SiteScope server from which you want to deploy the integrationmonitor:
l For SiteScope standalone, select and open a SiteScope instance.

l When in SAM Administration, select the SiteScope server from which you want to deploy the
integrationmonitor. For user interface details, see "System Availability Management Administration
Page" in the APMUser Guide in the APMHelp.

5. Create a group for the integration monitor
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Tip:We recommend that you create special groups for the integrationmonitors. This enables you to
more easily recognize the data that is reported to APM as coming from the integrations.

6. Add the integration monitor
Configure the integrationmonitor and add the required data for themonitor's settings. You can choose
from the following application-specific integrations:
l HP OMEvent Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l HP ServiceManager Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l NetScout Event Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

You can choose from the following generic integrationmonitors (note that generic integrationmonitors are
supported for BSM 9.1x and earlier versions only; for all new third-party data integrations in BSM 9.2x,
use BSMConnector as described in the APM Application Administration Guide in the APMHelp.)
l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor Reference
Guide)

7. Edit the monitor's field mapping
Themapping defines the processing of incoming data and the output sample forwarded to APM.
a. In the Field Mapping panel, select theCommon Events field mapping script, and click Load File. A

template script is displayed in the Field mapping box.
b. Edit the script to enable SiteScope to retrieve the data from themonitored application that you want

to forward to BSM by mapping the script values to the corresponding field mapping group in which
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they appear in the log file from which you want to extract data. For details on the file structure and
syntax, see "Event Handler Structure and Syntax" on page 333.
For mandatory script values, see "Mandatory Values for the Common Events Script" on page 376.
For optional script values, see "Optional Values for the Common Events Script" on page 377.

Note: The Field Mapping settings are not available when theReport topology without data check
box is selected in the Topology Settings panel. For details on reporting topology without data, see
"Report Topology Without Data" on page 397.

8. Map the data to a topology script - optional (required when reporting topology
to APM)
In the Topology Settings panel, select a topology script to forward the data to the correct CI hierarchy in
APM:
l Computer. Select to create a topology with a Computer CI.

Note: Information about Computer CI is taken from theHostHint field.

l Computer - Running Software. Select to create a topology with a Computer CI and a Running
Software CI connected to it with a Composition relationship.

Note: Information about Node CI is taken from theHostHint field and the name of the Running
Software CI is taken from theCategory field.

l Custom. Select to create your own topology script.
Edit the topology settings. The topology scripts are specially configured with the necessary values to
forward data to the required CIs in APM's RTSM. For concept details, see "Topology Settings for
Technology IntegrationMonitors" on page 328.

Note:

o When using field mapping, you can use the field mapping fields as an input for topology script.
For example, if using common event mapping, you can access the value of the Category field
in the following way:

category = Framework.getDestinationAttribute("Category").
o In addition, you can access values of the "monitor variables", such as group0, group1, and

so forth, from Technology Log File Integrationmonitor, or the names of database columns in
Technology Database Integrationmonitor, or other variables in the other integrationmonitors.
For example, you can access the value of the group1 variable, in the following way:
group1 = Framework.getDestinationAttribute("group1")

9. Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running themonitor. This tests
the following:
l Checks the field mapping and topology script syntax.

l Displays themapping results.

l Displays the topology results if a topology script has been configured.
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The test does not forward events or topology to APM.

10. Results
When events are gathered from a third-party system and processed by integrationmonitors, common
events are generated, and SiteScope writes the event data to the
HPSiteScopeOperationsManagerIntegration.log file in the <SiteScope root directory>\logs
directory. Each event is written as a separate line in the log. The log file policy instructs the agent to read
this file and create event messages that are sent to APM.
You can view the event in the Operations Management Event Browser (if you have an Event
Management Foundation license). If Operations Management is not part of your APM installation, you
can view events that affect CI status using a health indicator in Service Health.

How to Configure Integration Monitors to Collect Data
on Legacy Events
This task describes the steps involved in configuring the legacy event integration, which is used to collect
data on specific events, and tomake the data available for use in APM's Service Health, Event Log, and trend
reports.

1. Plan the integration strategy
Review the IntegrationMonitor types. Consider the type of information you want to view in APM from
your EMS system. Determine whether one of the specific IntegrationMonitors meets your organization's
needs or whether a generic IntegrationMonitor (Technology Log File, Database, SNMP Trap, Web
Service) is required.
For concept details, see "IntegrationMonitors Overview" on page 324.

2. Configure BSM integration
Integrate SiteScope and APM. For details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

Note: You do not need to configure the Operations Manager event integration when the integration
monitor is configured to use the Legacy Events samplemapping script.

3. Select the SiteScope server
Select the SiteScope server from which you want to deploy the integrationmonitor:
l For SiteScope standalone, select and open a SiteScope instance.

l When in SAM Administration, select the SiteScope server from which you want to deploy the
integrationmonitor. For user interface details, see "System Availability Management Administration
Page" in the APMUser Guide in the APMHelp.

l When in EMS Integrations Administration, click theNew Integration orEdit Integration button. In
the Edit Integration dialog box, click the link in the System Availability Management panel to open
SAM Administration window where you can select a SiteScope server. For user interface details, see
"Edit Integration Dialog Box" in the APM Application Administration Guide in the APMHelp.
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4. Create a group for the integration monitor
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Tip:We recommend that you create special groups for the integrationmonitors. This enables you to
more easily recognize the data that is reported to APM as coming from the integrations.

5. Add the integration monitor
Configure the integrationmonitor and add the required data for themonitor's settings. You can choose
from the following application-specific integrations:
l HP OMEvent Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l HP ServiceManager Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l NetScout Event Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

You can choose from the following generic integrationmonitors (note that generic integrationmonitors are
supported for BSM 9.1x and earlier versions only; for all new third-party data integrations in BSM 9.2x,
use BSMConnector as described in the APM Application Administration Guide in the APMHelp.)
l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor Reference
Guide)

6. Edit the monitor's field mapping
Themapping defines the processing of incoming data and the output sample forwarded to APM.
a. In the Field Mapping panel, select the Legacy Events field mapping script, and click Load File.
b. Edit the script to enable SiteScope to retrieve the data from themonitored application that you want

to forward to APM by mapping the script values to the corresponding field mapping group in which
they appear in the log file from which you want to extract data. For details on the file structure and
syntax, see "Event Handler Structure and Syntax" on page 333.
For mandatory script values, see "Mandatory Values for the Legacy Event Script" on page 379.
For optional script values, see "Optional Values for the Legacy Event Script" on page 381

Note: The Field Mapping settings are not available when theReport topology without data check
box is selected in the Topology Settings panel. For details on reporting topology without data, see
"Report Topology Without Data" on page 397.

7. Map the data to a topology script - optional (required when reporting topology
to APM)
In the Topology Settings panel, select a topology script to forward the data to the correct CI hierarchy in
APM:
l Node. Select to create a Node CI with an EMS monitor CI connected to it with Monitored By
relationship.
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l Node - Running Software. Select to create a topology with a Node CI and a Running Software CI
connected to it with a Composition relationship, and an EMS monitor CI which can be connected to
either the Node CI or the Running Software CI with Monitored By relationship.

Note: Information about Computer CI is taken from theHostHint field and the name of the
Running Software CI is taken from theCategory field.

l Custom. Select to create your own topology script.
Edit the topology settings. The topology scripts are specially configured with the necessary values to
forward data to the required CIs in APM's RTSM. For concept details, see "Topology Settings for
Technology IntegrationMonitors" on page 328.

Note:

o When using field mapping, you can use the field mapping fields as an input for topology script.
For example, if using legacy event mapping, you can access the value of the Subject field in
the following way:

subject = Framework.getDestinationAttribute("Subject")
o In addition, you can access values of the "monitor variables", such as group0, group1, and

so forth, from Technology Log File Integrationmonitor, or the names of database columns in
Technology Database Integrationmonitor, or other variables in the other integrationmonitors.
For example, you can access the value of the group1 variable, in the following way:
group1 = Framework.getDestinationAttribute("group1")

8. Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running themonitor. This tests
the following:
l Checks the field mapping and topology script syntax.

l Displays themapping results.

l Displays the topology results if a topology script has been configured.

The test does not forward events or topology to APM.

9. Configure the EMS Integrations application in BSM
In addition to configuring themonitor, you need to configure the EMS Integrations application in APM. For
details, see the remaining steps in "Create an EMS integration (for Event or Ticket Samples)" in "How to
Integrate Data from Third-Party Sources (EMS Data) into HP Business ServiceManagement" in the
APM Application Administration Guide in the APMHelp.

Note: If you are configuring ametrics integration, do not need to go to APM's SAM Administration
and configure a new integration. You just need to create amonitor and select theReport topology
option.

10. Results
When events are gathered from a third-party system and processed by integrationmonitors, the events
are generated and the event data is written to theHPSiteScopeOperationsManagerIntegration.log file
in the <SiteScope root directory>\logs directory. Each event is written as a separate line in the log.
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The log file policy instructs the agent to read this file and create event messages that are sent to APM.
You can view events in Service Health, System Availability Management Event Logs, and trend reports.
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Chapter 32: Configure Integration Monitors to
Collect Ticketing Data
When configuring the generic integrationmonitors, you can select the ticketing data type to collect incidents
and events from ticketing systems. Data collected by integrationmonitors that use the ticketing data type is
integrated into APM and can be viewed in Service Health and Service Level Management.

Troubleshooting/Limitations
General Troubleshooting/Limitations
This section describes troubleshooting and limitations for IntegrationMonitor field mapping.

l For Tickets samples and Tickets topology, the monitor_id of the reported EMS monitor is:
<data_source>_<target_name>

l Do not use XML special characters (",',<,>,&) in the fields used to create the monitor_id, because these
characters causes problems for these samples in APM.

Integration Monitor Field Mapping for Ticketing
Samples
You can enable capturing event andmetrics data from EnterpriseManagement Systems (EMS), automated
support systems, and other management applications by configuring integrationmonitors and their field
mapping scripts.

Integrationmonitors depend on the field mapping you customize within the user interface in the settings for the
monitor. Themapping defines the processing of incoming data and defines the output sample forwarded to
APM.

IntegrationMonitors designed for use with specific EMS applications (these currently include HPOM, Service
Center, and NetScout) can be configured without editing their field mapping script. Themapping is predefined
by HPE and requires modification only if specific customizations are required. For details on editing these field
mapping scripts, see the description for the field mapping element in the user interface pages for themonitor
you are deploying.

For Technology IntegrationMonitors (Technology SNMP Trap, Technology Log File, and Technology
Databasemonitors), youmust select the data type and the required script is loaded directly into the field
mapping text box. Youmust edit the field mapping script to suit your organization's needs. The Technology
Web Service IntegrationMonitor field mappingmay also need to be customized.

When you select Tickets and you want to integrate to APM using topology settings, you can select the
following topology script: Tickets or Custom (only if you are familiar with the Jython language, since you
must create the Jython topology script yourself).

For details, on selecting a topology setting, see "Topology Settings for Technology IntegrationMonitors" on
page 328.
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Note: Use only themandatory and optional fields defined in the scripts when working with the field
mapping. For more information, see the tables for each data type.

Configure Field Mapping for Ticket Samples
The ticket data type is used for extracting events collected by external systems and importing them to APM.

To configuring an integrationmonitor's field mapping:

1. Select the Tickets data type to load the tickets script.
2. Copy the contents of the Field Mapping text box and paste it into a text editor to make your

configuration changes.
3. Copy the contents back into the Field Mapping text box.
For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page 333.

This section also includes:

l "Mandatory Values for the Ticket Script" below
l "Optional Values for the Ticket Script" on the next page
l "Conditional Expression Example" on page 393
l "Ticket Script Example" on page 393

Mandatory Values for the Ticket Script
The table below lists mandatory values for the ticket script.

Field
Name Type Description Example

time_
stamp

DOUBLE Time stamp in seconds
since Jan 1 1970.

time_stamp:DOUBLE=str_to_seconds($time,"yyyy-
MM-dd HH:mm:ss.SSS").

severity INT Can be one of the
following preconfigured
severities (based on
applicable integer):
SEVERITY_
UNKNOWN
SEVERITY_
INFORMATIONAL
SEVERITY_
WARNING
SEVERITY_MINOR
SEVERITY_MAJOR
SEVERITY_CRITICAL

4".equals($severity) ? "Low" : ("3".equals
($severity) ? "Average" : ("2".equals
($severity) ? "High" : ("1".equals($severity)
? "Critical" : "Unknown")))

target_
name

STRING Name of the entity
(usually a service) that
generated the ticket.

target_name="mail service" (Do not enter static
string here, should be retrieved dynamically from the
ticket.)
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Field
Name Type Description Example

data_
source

STRING System that generated
the ticket.

data_source="ticketing" (This string should not be
edited for HPE ServiceCenter integration andmust be
edited for a generic technology integrationmonitor.)

ticket_id STRING ID of the ticket. ticket_id=112233

ticket_
state

STRING One of the states in the
incident lifecycle as
defined in the ticketing
system.

"Open" / "Closed"

ticket_
type

STRING Type of the incident as
defined in the ticketing
system.

"Incident"

orig_
severity_
name

STRING Severity in external
EMS terminology.

orig_severity_name ="Cleared"

Optional Values for the Ticket Script
The script includes comments describing the optional values available for the ticket script. They include those
listed here:

Field
Name Type Description Example

subject STRING Middle/High level hierarchy describing the event source. CPU, SAP
application, hard
disk

instance STRING Instance of subject that generated the event. The lowest
level hierarchy describing the event source.

D:\\

object STRING Optional level in the hierarchy describing the ticket
source.

object="OS"

logical_
group

STRING Logical grouping of this ticket. logical_group="error
messages"

monitor_
group

STRING Monitor group that reported this ticket. monitor_group="log
monitors on
\\hostname"

elapsed_
time

STRING Elapsed time of the ticket.
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Field
Name Type Description Example

orig_
severity_
name

STRING Severity name as defined in the ticketing system.

attr1 STRING Extra data slot. attr1=$history

attr2 STRING Extra data slot. attr2=$moreHistory

attr3 STRING Name of organization which owns a business service (if
used in the Business Service integration topology flow).

Attr3="XYZ Inc"

attr4 STRING Type of organization which owns a business service (if
used in the Business Service integration topology flow).

Attr4="department"

attr5 STRING Extra data slot for long strings. Use for values up to
2000 chars.

attr5=$Longhistory

Conditional Expression Example
This example configures the severity of the ticket sample. It matches between the status terms used in the
ticketing system to those used in APM.

4".equals($severity) ? "Low" : ("3".equals($severity) ? "Average" :
("2".equals($severity) ? "High" : ("1".equals($severity) ? "Critical" :
"Unknown")))

Ticket Script Example

[$DEFAULT_PARAMETERS$]
time_stamp:DOUBLE=$time_stamp
ticket_id=$ticket_id
ticket_state=$ticketStatus
severity:INT=$severity
target_name=$target_name
data_source="ticketing"
ticket_type="Incident"
orig_severity_name="4".equals($severity) ? "Low" : ("3".equals($severity)
? "Average" : ("2".equals($severity) ? "High" : ("1".equals($severity)
? "Critical" : "Unknown")))

How to Configure Integration Monitors to Collect
Ticketing Data
This task describes the steps involved in configuring SiteScope to collect incidents and events from third-
party ticketing systems, and to import the data samples into APM.
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1. Plan the integration strategy
Review the IntegrationMonitor types. Consider the type of information you want to view in APM from
your EMS system. Determine whether one of the specific IntegrationMonitors meets your organization's
needs or whether a generic IntegrationMonitor (Technology Log File, Database, SNMP Trap, Web
Service) is required.
For concept details, see "IntegrationMonitors Overview" on page 324.

2. Configure BSM integration
Integrate SiteScope and APM. For details, see "How to Configure SiteScope to Communicate with
BSM" on page 190.

3. Select the SiteScope server
Select the SiteScope server from which you want to deploy the integrationmonitor:
l For SiteScope standalone, select and open a SiteScope instance.

l When in SAM Administration, select the SiteScope server from which you want to deploy the
integrationmonitor. For user interface details, see "System Availability Management Administration
Page" in the APM Application Administration Guide in the APMHelp.

l When in EMS Integrations Administration, click theNew Integration orEdit Integration button. In
the Edit Integration dialog box, click the link in the System Availability Management panel to open
SAM Administration window where you can select a SiteScope server. For user interface details, see
"Edit Integration Dialog Box" in the APM Application Administration Guide in the APMHelp.

4. Create a group for the integration monitor
For user interface details, see "New SiteScopeGroup Dialog Box" on page 215.

Tip:We recommend that you create special groups for the integrationmonitors. This enables you to
more easily recognize the data that is reported to APM as coming from the integrations.

5. Add the integration monitor
Configure the integrationmonitor and add the required data for themonitor's settings. You can choose
from the following application-specific integrations:
l HP OMEvent Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l HP ServiceManager Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

l NetScout Event Monitor (for details, see the SiteScopeMonitor ReferenceGuide)

You can choose from the following generic integrationmonitors (note that generic integrationmonitors are
supported for BSM 9.1x and earlier versions only; for all new third-party data integrations in BSM 9.2x,
use BSMConnector as described in the APM Application Administration Guide in the APMHelp.)
l Technology Database IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology Log File IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)

l Technology SNMP Trap IntegrationMonitor (for details, see the SiteScopeMonitor ReferenceGuide)
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l Technology Web Service IntegrationMonitor (for details, see the SiteScopeMonitor Reference
Guide)

6. Edit the monitor's field mapping
Themapping defines the processing of incoming data and the output sample forwarded to APM.
a. In the Field Mapping panel, select the Tickets field mapping script, and click Load File.
b. Edit the script to enable SiteScope to retrieve the data from themonitored application that you want

to forward to APM by mapping the script values to the corresponding field mapping group in which
they appear in the log file from which you want to extract data.
For mandatory script values, see "Mandatory Values for the Ticket Script" on page 391.
For optional script values, see "Optional Values for the Ticket Script" on page 392.

Note: The Field Mapping settings are not available when theReport topology without data check
box is selected in the Topology Settings panel. For details on reporting topology without data, see
"Report Topology Without Data" on page 397.

7. Map the data to a topology script - optional (required when reporting topology
to APM)
In the Topology Settings panel, select a topology script to forward the data to the correct CI hierarchy in
APM:
l Tickets. Select to create a Business Service CI with an EMS monitor CI connected to it with

Monitored By relationship. The EMS Monitor CI propagates status onto the Business Service CI.

Note: The topology script must include the EMS monitor CI as the lowest leaf in the topology
created by the integration

l Custom. Select to create your own topology script.
Edit the topology settings. The topology scripts are specially configured with the necessary values to
forward data to the required CIs in APM's RTSM.

Note:

o When using field mapping, you can use the field mapping fields as an input for topology script.
For example, if using legacy event mapping, you can access the value of the Subject field in
the following way:

subject = Framework.getDestinationAttribute("Subject")
o In addition, you can access values of the "monitor variables", such as group0, group1, and

so forth, from Technology Log File Integrationmonitor, or the names of database columns in
Technology Database Integrationmonitor, or other variables in the other integrationmonitors.
For example, you can access the value of the group1 variable, in the following way:
group1 = Framework.getDestinationAttribute("group1")

8. Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running themonitor. This tests
the following:
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l Checks the field mapping and topology script syntax.

l Displays themapping results.

l Displays the topology results if a topology script has been configured.

9. Configure the EMS Integrations application in BSM
In addition to configuring themonitor, you need to configure the EMS Integrations application in APM. For
details, see the remaining steps in "Create an EMS integration (for Event or Ticket Samples)" in "How to
Integrate Data from Third-Party Sources (EMS Data) into HP Business ServiceManagement" in the
HPE Software Integrations site.

Note: If you are configuring ametrics integration, do not need to go to APM's SAM Administration
and configure a new integration. You just need to create amonitor and select theReport topology
option.

10. Results
When events are gathered from a third-party system and processed by integrationmonitors, the events
are generated and the event data is written to theHPSiteScopeOperationsManagerIntegration.log file
in the <SiteScope root directory>\logs directory. Each event is written as a separate line in the log.
The log file policy instructs the agent to read this file and create event messages that are sent to APM.
You can view events in Service Health, System Availability Management Event Logs, and trend reports.
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Chapter 33: Report TopologyWithout Data
You can enable SiteScope to report only the topology discovered by the SiteScope Technology Integration
monitors, without reporting the data.

Tasks
How to Report Topology Without Data
This task describes how to enable reporting topology discovered by the SiteScope Technology Integration
monitors without sending data.

1. Configure the Technology Integrationmonitor
a. When configuring a Technology Integrationmonitor, in the Topology Settings panel, select the

Report topology without data check box.

Note:When this option is selected, the Field Mapping area is not available.

b. Select a topology script from the following options:
o Computer. Select to create a topology with a Computer CI.
o Computer - Running Software. Select to create a topology with a Computer CI as the parent CI

and a Running Software CI under it.
o Custom. Select to create your own topology script, if you want the retrieved data to be sent to

specific CIs instead of the Computer or Running Software CIs.
c. Map the data discovered by themonitor to the relevant attributes in the topology settings. The

topology scripts are specially configured with the necessary values for reporting topology only to
APM.
For mandatory script values, see "Configure Field Mapping for Common Event Samples" on
page 375.

Note:

o Computer andComputer - Running Software are out-of-the-box topology scripts that are
available for the report topology without data type flow.

o TheComputer andComputer - Running Software scripts are available only when
SiteScope is connected to BSM versions 9.x or later.

Note: You can access values of the "monitor variables", such as group0, group1, and so forth,
from the Technology Log File Integrationmonitor, or the names of database columns in the
Technology Database Integrationmonitor, or other variables in the other integrationmonitors.
For example, you can access the value of the group1 variable, in the following way:

group1 = Framework.getDestinationAttribute("group1")

2. Test the script - optional
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In the Topology Settings panel, click Test Script to test the script before running themonitor. This
displays the topology results.
The test does not forward topology to APM.
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Chapter 34: Network Node Manager
Integration
APM can accept events from Network NodeManager (NNM). You can forward event data from Network
NodeManager (NNM) by configuring NNM to run a script for each event that you want forwarded to APM. The
script that you write and associate with NNM can do one of the following actions:

l Write the NNM data to a log file.
l Send an SNMP trap with the NNM data to a SiteScope server.
If your script writes the data to a log, you then use a Technology Log File IntegrationMonitor to read the data
and forward it to APM. If you use a script to send an SNMP trap to a SiteScope server, you use an
Technology SNMP Trap IntegrationMonitor configured to receive it and forward to APM.

Learn About
Scripts to Export Network Node Manager Data
The script you use should accept data from NNM as a command line argument, and process the data so that it
can be forwarded to APM. The following sections describe example scripts that can be used to export NNM
data.

Sample Script for Writing to a Log File

The following Perl script receives data from the command line and writes it to a log file as a comma separated
vector of values that can be parsed by the Log File IntegrationMonitor:

#!/usr/bin/perl
open LOG, ">>log1.log" or die;
print LOG (join ',', @ARGV) . "\n";
close LOG;

Sample Script for Sending SNMP Trap Data

The following Perl script receives data from the command line and sends it as amessage in an SNMP trap
(using SNMP data generated by Network NodeManager) that can be caught by a Technology SNMP Trap
IntegrationMonitor. It accepts the host name to which the trap is sent as the first parameter and a string
description of the alert as the second parameter.

#!/usr/bin/perl
$host = $ARGV[0];
$message = $ARGV[1];
system("snmptrap $host \"\" \"\" 6 0 5 system.sysDescr.0 " . "octetstringascii $message");
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Tasks
How to Configure Events in Network Node Manager
Use the following steps to configure NNM 7.x to run a script for the requested events in NNM.

Note: For later versions of NNM andNNMi, refer to the NNMi documentation.

1. From theOptionsmenu, chooseEvent Configuration.
2. Select the requested enterprise and event from theEvent Configuration dialog box.
3. Select the Actions tab from theEdit > Events > Modify Events dialog box.
4. Enter the command line for the script in theCommand for Automatic Action text box. Youmay use

NNM variables to pass data to the command line.
5. Click OK to close theModify Events dialog box.
6. From the Filemenu in theEvent Configuration dialog box, select Save.
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Part 6: Remote Servers
You configuremonitors to collect the data from remote servers you want to monitor. This means selecting a
remote server, and configuring connection properties so that SiteScope canmonitor systems and services
running in remote environments.

This section describes the following:

l How to configure SiteScope tomonitor remoteWindows and UNIX servers ("Configure SiteScope to
Monitor RemoteWindows Servers" on page 402, "Configure SiteScope toMonitor Remote UNIX Servers"
on page 420).

l How to configure SiteScope tomonitor remoteWindows servers usingWindows Management
Instrumentation (WMI) ("Configure theWMI Service for RemoteWindows Monitoring" on page 417).

l How to create and customize adapter files for UNIX monitoring ("Extend UNIX Monitoring Using
Operating System Adapters" on page 428).

l How to enable SiteScope to prefer IPv6 addresses over IPv4 when connecting to remote servers ("Enable
SiteScope to Prefer IP Version 6 Addresses" on page 434).

l How to use Secure Shell (SSH) connection for remotemonitoring ("Configure RemoteMonitoring Using
Secure Shell (SSH)" on page 439).

You can also add remote servers from theManage view of the Unified Console. For details, see "Create New
Remote Server" on page 983.



Chapter 35: Configure SiteScope to Monitor
Remote Windows Servers
Microsoft Windows Remote server options are used to set up the connection properties, such as credentials
and protocols, so that SiteScope canmonitor systems and services running in remote environments. You can
then createmonitors to watch the resources and performance counters for that server. Multiple monitors can
use the same connection profile. You can also createmultiple remote servers for the same host machine.

To access
Select theRemote Servers context. In the remote servers tree, click theMicrosoft Windows Remote
Servers container.

Learn About
Remote Server Overview
SiteScopemust be able to establish a connection to the servers you want to monitor.

It must also be authenticated as a user having account permissions to access theWindows performance
registry on theMicrosoft Windows remotemachine, and to run command line tools on the UNIX remote
machine as a remote user.

Monitoring remoteWindows servers also requires that a supported operating system is running on the remote
server (see the list of supported operating systems for remoteWindows servers below).

Operating Systems Supported for Monitoring Remote Windows Servers
The following operating systems are supported for monitoring remoteWindows servers:

l Windows Server 2003, 2003 R2
l Windows Server 2008, 2008 R2
l Windows Server 2012, 2012 R2

Tasks
How to Configure SiteScope to Monitor a Remote Microsoft Windows Server
This task describes the steps involved in configuring SiteScope tomonitor data on remoteWindows servers.

1. Prerequisites (for Windows Server 2008, 2008 R2, 2012, and 2012 R2 remote
servers)
l Only an administrator in SiteScope, or a user grantedAdd, edit or delete remote servers
permissions can view or edit the Remote Servers page. For details on user permissions, see "User
Management Preferences" on page 625.
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l SiteScope supports monitoring onMicrosoft Windows Server 2008/2008 R2/2012/2012 R2 remote
servers with User Account Control (UAC) enabled or disabled. Where UAC is enabled, youmust
make the following registry changes on the remote server so as to avoid access issues or problems
getting data on perfex monitors (such as CPU, Memory, Disk Space, Microsoft Windows Resources,
Microsoft Windows Event Log, Microsoft Windows Performance Counter, Services, Microsoft IIS
Server, Microsoft SQL Server) when using theWMI or NetBIOS protocol.
i. Click Start, click Run, type regedit, and then press ENTER.
ii. Locate and then click the following registry subkey: HKEY_LOCAL_

MACHINE\SOFTWARE\Microsoft\Windows\
CurrentVersion\Policies\System

iii. If the LocalAccountTokenFilterPolicy registry entry does not exist, follow these steps:
l On theEditmenu, select New >DWORDValue.
l Type LocalAccountTokenFilterPolicy, and then press ENTER.

iv. Right-click LocalAccountTokenFilterPolicy, and then click Modify.
v. In theValue data box, type 1, and then click OK.
vi. Exit Registry Editor.

l To remotely monitor on aWindows Server 2008 or 2012machine, youmust enable the Remote Event
LogManagement exception in theWindows Firewall Settings on the remote server to which you want
to connect. Otherwise, when you try to use the session handle, the call will result in a RPC_S_
SERVER_UNAVAILABLE error.

2. Enable SiteScope to monitor data on remote Windows servers
To enable SiteScope tomonitor data on remoteWindows servers, youmust perform one of the following
steps:
l Define an individual remote Windows server connection profile for each server.
Monitoring remoteWindows server data requires authenticated access to the remote server. A
Windows server connection profile provides the necessary address and login credentials for
SiteScope to log on to a remote server and to access theWindows performance registry on that
remotemachine.
To log on to a remote server using theWindows server connection profile, either:
o Log on to the remote server as a user with administrator privileges, or
o Create or modify a user account on the remote server that corresponds with the connection

method and login permissions used in the SiteScope connection profile for that server.

l Set domain access privileges to permit SiteScope to access remote servers.
SiteScope forWindows automatically generates a list of servers visible in the local domain. These
servers are listed in the Servers list for monitor types where a server must be specified. SiteScope
running onWindows may be able to use this list to monitor remoteWindows servers without having to
create individual connection profiles for each server.
To set domain privileges, use one of the followingmethods:
o Set the SiteScope service to run as a user in the Domain Admin group.

By default, SiteScope is installed to run as a "Local System account". However, we recommend
setting the SiteScope service to log on as a user with domain administration privileges since the
"Local System account" may not have sufficient privileges (the local system account has domain
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administrator user privileges in a domain environment, and build-in administrator user privileges in
a non-Domain environment). This gives SiteScope access privileges tomonitor server data within
the domain.
To change the user account of the SiteScope service:
A. In Administrative Tools, openServices, and select SiteScope from the list of services.

The SiteScope Properties dialog box opens.
B. Click the Log On tab, and in the Log on as area, enter an account that can access the

remote servers.
C. Click OK to save your settings and close the SiteScope Properties dialog box.
D. Right-click SiteScope. Click Stop to stop the SiteScope service.
E. Click Start. The SiteScope service now uses the new account.

o Add the server where SiteScope is running to the Domain Admin group in
ActiveDirectory (for Windows 2003 or later).
With this option, the SiteScope service is set to log on as a Local System account, but the
machine where SiteScope is running is added to a group having domain administration privileges.

o Edit the registry access permissions for all machines in the domain to enable non-admin
access.
This option requires changes to the registry on each remotemachine that you want to monitor.
This means that while the list of servers in the domain includes all machines in the domain, only
those remotemachines whose registry has beenmodified can bemonitored without use of a
connection profile.

Note: If you configure the SiteScope service to run as a domain user, SiteScope uses this
account for all Windows-related authorization. Youmust ensure that this account has the
necessary privileges across the domain.

3. Configure user permissions for remote monitoring
For SiteScope to collect performancemeasurements on a remoteWindows machine, SiteScopemust
have permission to access the remotemachine.

Note:

l Microsoft Best Practice recommends giving permissions to groups instead of to users.

l Back up the registry beforemaking any registry changes.

To configure user permissions on the SiteScopemachine:
a. On the SiteScopemachine, select Start > Run. In the Open text box, enterRegedt32.exe. The

Registry Editor dialog box opens.
b. In theHKEY_LOCAL_MACHINE window, select SOFTWARE > Microsoft > Windows NT >

CurrentVersion > Perflib.
c. Click Edit in the Registry Editor tool bar and select Permissions. The Permissions for Perflib dialog

box opens.
d. In the Name pane, select the user SiteScope uses to access the remotemachine. In the

Permissions pane, select theAllow check box forRead. Click OK to save the configuration and
close the Permissions for Perflib dialog box.
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e. In theHKEY_LOCAL_MACHINE window, select SYSTEM > CurrentControlSet > Control >
SecurePipeServers > winreg. Click Security in the Registry Editor tool bar and select
Permissions. The Permissions for winreg dialog box opens.

f. In the Name pane, select the user that SiteScope uses to access the remotemachine. In the
Permissions pane, select theAllow check box forRead. Click OK to save the configuration and
close the Permissions for winreg dialog box.

g. In the Registry Editor tool bar, click Registry and select Exit to save the configuration and exit.
h. Restart the SiteScopemachine.

4. Configure and test the settings for the Windows remote server
a. Configure the remoteWindows server in the remote server tree. For user interface details, see

"New/Edit Microsoft Windows Remote Server Dialog Box" on the next page.

Note:

o If you are configuring remoteWindows Servers for SSH monitoring with SiteScope, see
"How to Configure RemoteWindows Servers for SSH monitoring" on page 447.

o If WMI is selected as the connectionmethod for gatheringmanagement data from remote
servers (in theMethod field in Main Settings), theWMI servicemust be configured on the
remotemachine. For task details, see "How to Configure theWMI Service for Remote
Monitoring" on page 417.

o When configuring theWMI connection typemethod for monitoring on the localhost machine
(themachine where SiteScope is running), theUser name andPasswordmust be left blank
in the Credentials section.

o If specifying a literal IPv6 address as the name for the remotemonitored server when using
the NetBIOS connectionmethod, the IPv6 address must be customized by:

1. Replacing any colon (":") characters with a dash ("-") character.
2. Appending the text .ipv6-literal.net to the IP address.

For example, the IPv6 address: 2004:DB8:2a:1005:230:48ff:fe73:982d
would be: 2004-DB8-2a-1005-230-48ff-fe73-982d.ipv6-literal.net

Alternatively, you can switch to theWMI connectionmethod (where supported), and avoid
having tomake changes to the IPv6 address.

b. After defining theMicrosoft Windows remote server definition for SiteScope, click the Test
button for the applicable server to test the connection.

Note: If an "unable to connect to remote machine" error message opens when trying to
view remote counters, refer to theMicrosoft Knowledge Base
(http://support.microsoft.com/search/).

5. Results
The server is added to the list of remoteWindows Remote servers in the remote server tree. You can
then createmonitors to watch the resources and performance counters for that server. Multiple monitors
can use the same connection profile.
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Note: For information about troubleshooting and limitations of SiteScopemonitoring of remote
servers, see "Tips/Troubleshooting" on page 411.

UI Descriptions
New/Edit Microsoft Windows Remote Server Dialog Box

Important
information

l You cannot delete a server from the list of remote servers if the server is referenced by a
monitor. Select a different server in theServer box of theMonitor Settings panel for each
monitor that references the remote server, and then delete the remote server from the
remote server list.

l Remote server passwords support empty spaces and the following special characters: \
" & | > < ^

l When configuring aMicrosoft Windows remote server in templatemode, theMethod
valuemust be entered using the same case that follows, otherwise verification does not
work properly: NetBIOS, WMI, or ssh (or SSH)

See also l "Remote Server Tree" on page 36
l "Remote Servers Properties Page" on page 458

The following elements are included:

UI Element Description

General Settings

Name Name by which the remotemachine should be known in SiteScope. This name appears in
theServer list of monitors that can use this connection profile.

Note when working in template mode:

l For each templatemonitor that requires this remote server, youmust enter this same
value in theServers box for the templatemonitor.

l Names must be unique, otherwise the deployment fails.

Description Description for the remoteWindows server. This text appears only when editing the
remote's properties.

Main Settings
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UI Element Description

Server Real IP address or UNC name of themonitoredWindows server. Network address
translation (NAT) is not supported for SiteScopemonitors that require a remote host
definition. SiteScope is unable to determine if an external (real IP) or internal IP (NAT) is
used when you configure amonitor with an IP address or host. Tomonitor servers in a
NAT environment, we recommend placing SiteScope inside the firewall. Virtual IPs can
be used inmonitors which do not collect host specific information, such as in the URL
monitor or other similar monitors.

An IP host name also works if the SiteScope server can translate this common name into
an IP address by using a hosts file, DNS, orWINS/DNS integration.

You can createmultiple remote servers for the same host machine. For example, you can
create one remote server that uses the NetBIOS protocol and another that uses WMI for
the same host machine, provided the name in General Settings is unique.

To use the same login credentials to configuremultiple servers at the same time, enter
the server names or addresses separated by a comma (","), semicolon (";"), or a space.
For example, \\server1,\\server2,\\.

Note: In the list of Windows Remote Servers, click the Test button to test
connectivity after the profiles have been added.

Note when working in template mode:Name of a template variable that represents the
remote server name, for example, %%host%%. This enables you to add each server as you
deploy the template when asked to enter the required information for the variables. Each
time you enter a server name for the variable, amonitor instance is created for that server
and the server is added to the remote server tree. If the host name does not match a
server name at that time, themonitor fails.

If the remote servers onto which you want to deploy monitor templates already exist
under Remote Servers, you can reference these servers within themonitor template. You
do this by referencing the system variable $$SERVER_LIST$$ which identifies the
servers accessible to the SiteScope. For details, see "Syntax for System Variables" on
page 675.

Using SiteScope
Chapter 35: Configure SiteScope toMonitor RemoteWindows Servers

HPE SiteScope (11.33) Page 407 of 1206



UI Element Description

Credentials Option for providing the user name and password for the remoteWindows server:

l Use user name and password. Select this option tomanually enter user credentials.
l User name. Enter the user name for the remote server or use a template variable
that represents the user login name (for example, %%user%%).
Note: If the server is within the same domain as the SiteScopemachine, include the
domain name in front of the user login name. For example: <DOMAIN>\<username>. If
using a local machine login account for machines within or outside the domain,
include themachine name in front of the user login name. For example:
<machinename>\<username>.

l Password. Enter the password for the remote server or the passphrase for the SSH
key file, or use a template variable that represents the password (for example,
%%password%%). When using SSH authentication with public/private key based
authentication enter the passphrase for the identity file here.

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the server (selected by default).
Select the credential profile to use from theCredential profile drop-down list, or click
Add Credentials and create a new credential profile. For details on how to perform
this task, see "Credential Preferences" on page 476.

Trace Traces messages to and from the subject server, and records them in the
SiteScopeRunMonitor.log file.

Default value:Not selected
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UI Element Description

Method Connection types for monitoringWindows server resources:

l NetBIOS. The default server-to-server communication protocol for Microsoft
Windows networks.
Note:SiteScopes running onWindows platforms need to be running under an account
that has the necessary administrative security privileges to access performance
counter data from remote servers when the NetBIOS connection is used and the
Trace option is selected. If the servers you want to monitor are in a different domain,
are governed under a different policy, or require a unique login different than the
account SiteScope is running under, then youmust define the connection to these
servers under theMicrosoft Windows Remote Servers option in the remote server
view.

l SSH. Secure Shell, a more secured communication protocol that can be installed on
Microsoft Windows networks. This connectionmethod normally requires installing
SSH libraries on each server to be connected, unless you are using agentless
Windows SSH. For the list of monitors that support Windows SSH (agentless or using
the SiteScope remoteWindows SSH files), see "Monitors SupportingWindows SSH
(Agentless or Using the SiteScope RemoteWindows SSH Files)" on page 442. For
more information on SSH requirements, see "Configure RemoteMonitoring Using
Secure Shell (SSH)" on page 439.

l WMI.Windows Management Instrumentation, amore secured communication
protocol than NetBIOS, supports Windows server monitors that use perfmon to gather
performance data. For the list of monitors that support WMI and details on how to
configure theWMI service for remotemonitoring, see "Configure theWMI Service for
RemoteWindows Monitoring" on page 417.
Note:
l Remote servers that have been configured with theWMI method are not displayed
in the list of available remote servers when configuring amonitor that does not
support WMI.

l When configuring theWMI connection typemethod for monitoringWindows server
resources on the localhost machine (themachine where SiteScope is running), the
User name andPasswordmust be left blank in the Credentials section.

Remote
server
encoding

Encoding for the remote server, if the remote server is running an operating system
version that uses a different character encoding than the server on which SiteScope is
running. This enables SiteScope to display encoded content correctly.

Default value:Cp1252 encoding

Advanced Settings

SSH port
number

Port on which the remote SSH server is listening.

Default value: 22
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UI Element Description

Connection
limit

Number of open connections that SiteScope permits for this remote. If there aremany
monitors configured to use this connection, set the number of open connections high
enough to relieve a potential bottleneck.

Default value: 3

Note: This setting does not effect running tests for a remote server. Tests always create
a new connection.

Disable
connection
caching

Turns off connection caching for this remote. By default, SiteScope caches open
connections.

Default value:Not selected

SSH
authentication
method

Authenticationmethod to use for SSH connections:

l Password. Authenticates using a password (default setting).
l Key File. Authenticates using public/private key authentication. When this option is
selected SiteScope uses the private key in the file
<SiteScope root directory>\groups\identity to authenticate. The corresponding
public key must be listed in the authorized_keys file on the remote host.

For information about SSH requirements, see "Configure RemoteMonitoring Using
Secure Shell (SSH)" on page 439.

Key file for
SSH
connections

Path and name of the file that contains the private key for this connection. The default key
file is <SiteScope root directory>\groups\identity. This setting applies only when the
authenticationmethod is Key File.

SSH version
2 only

Forces SiteScope to use SSH protocol version 2 only.

Default value:Not selected

SSH keep
alive
mechanism

Engages a keep alivemechanism for SSH version 2 sessions. This option applies only
when using the integrated Java Client. SSH keepalive packets are sent every 55
seconds.

Default value:Not selected

SSH using
preinstalled
SiteScope
remote
Windows
SSH files

Uses preinstalled SiteScope remoteWindows SSH files. For the list of monitors that
support Windows SSH using SiteScope SSH files, see "Monitors SupportingWindows
SSH (Agentless or Using the SiteScope RemoteWindows SSH Files)" on page 442.

Default value:Selected

Search/Filter Tags

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.
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UI Element Description

<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Save Saves the settings without verifying the correctness of the configuration on the remote
server.

Tip:Performance is faster if you useSave instead of Save & Test, because SiteScope
does not need to establish a connection to the remote server to verify the settings.

Save & Test Saves the settings and verifies the correctness of the configuration on the remote server.
If SiteScope fails to connect to the remote server, or if there is an invalid property in the
configuration settings, an error message is displayed.

Tip:Performance is slower if you useSave & Test instead of Save, because SiteScope
needs to establish a connection to the remote server to verify the settings.

Other Related UI Pages: "Remote Servers Properties Page" on page 458

Tips/Troubleshooting
This section describes troubleshooting and limitations when working with remote servers.

l "General Issues MonitoringWindows Remote Servers" below
l "Recommended Network Settings for MonitoringWindows Servers" on the next page
l "Understanding Error Codes When TestingWindows Remote Servers" on the next page
l "Microsoft Windows Event Log Access on RemoteWindows Servers" on the next page
l "Viewing Data Returned when SiteScope is Trying to Access the Remote Registry" on page 413
l "System Encoding UsedWhenDisplaying System Resources for Remote Hosts Connected Through
NETBIOS" on page 415

l "SiteScope Uses theWrong Credentials for RemoteWindows Connections Using Perfex" on page 415
l "Perfex-BasedMonitors Fail When Selecting a Remote Server Using the Browse Servers Button" on
page 416

l "Perfex-BasedMonitors Fail with Error 1219" on page 416
l "WMI Issues" on page 416

Troubleshooting/Limitations

General Issues Monitoring Windows Remote Servers
The following is additional information relating to setting up and troubleshooting SiteScopemonitoring of
remoteWindows servers.

l Connect to the remotemachine using PERFMON. If a connection cannot bemade using this tool, there is
probably a problem with the user access permissions granted to the SiteScope account on the remote
server. SiteScope requires certain administrative permissions to be able tomonitor server statistics.

Using SiteScope
Chapter 35: Configure SiteScope toMonitor RemoteWindows Servers

HPE SiteScope (11.33) Page 411 of 1206



l If multipleWindows remote servers are configured for the same host machine using the NetBIOS method,
the connection fails. This is becauseWindows does not permit multiple connections to a server or shared
resource by the same user, usingmore than one user name (System error 1219).

l For security reasons, SiteScopemay not be permitted to use the permissions of a full administrator
account. SiteScope can be granted restrictedmonitoring access by editing certainWindows Registry
Keys. For information about restricting access to the registry from a remotemachine, refer to theMicrosoft
Knowledge Base (http://support.microsoft.com/kb/q153183/).

l When you need tomonitor a server which is a standalone server or not part of a domain already visible to
the SiteScope server, try entering themachine name followed by a slash and then the login name in the
Login box. For example, loneserver\sitescope.

l To remotely monitor aWindows Server 2008 or 2012machine, youmust enable the Remote Event Log
Management exception in theWindows Firewall Settings on the remote server to which you want to
connect. Otherwise, when you try to use the session handle, the call will result in a RPC_S_SERVER_
UNAVAILABLE error.

Note:

l For additional information on how to secure performance data inWindows operating systems, refer
to theMicrosoft Knowledge Base (http://support.microsoft.com/kb/q146906/).

l For information about troubleshooting performancemonitor counter problems, refer to theMicrosoft
Knowledge Base (http://support.microsoft.com/kb/152513/).

Recommended Network Settings for Monitoring Windows Servers
WhenmonitoringWindows-based servers, it is recommended to disable NetBIOS over TCP/IP on networks
whereWINS in not enabled to avoid network-related errors such as "System error: 53 - The network path was
not found".

1. OpenNetwork Connections.
2. Right-click the network connection you want to configure, and then click Properties.
3. On theGeneral tab, click Internet Protocol (TCP/IP), and then click Properties.
4. Click Advanced, click theWINS tab, and then select theDisable NetBios over TCP/IP option.

Understanding Error Codes When Testing Windows Remote Servers
Problem:

In the remote server test results, the status string does not contain descriptive error codes.

Resolution:

Use the net helpmsg command to help explainWindows network messages and provide problem-solving
information.

Run the following:

net helpmsg <error code number>

For example, entering net helpmsg 53 returns "The network path was not found."

Microsoft Windows Event Log Access on Remote Windows Servers
Problem:
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When viewing RemoteWindows event logs or getting alerts relating tomonitoring a remoteWindows
machine, the followingmessage is displayed:

"The description for Event ID ( XXXX ) in Source ( XXXX ) could not be found. It contains
the following insertion string(s):
The operation has completed successfully."

Cause:

If the required registry keys (and referenced files) are not present on the remote computer, SiteScope is
unable to format the data when viewing the event log on a computer from a remote computer; hence it displays
the data in a generic format.

Resolution:

The required registry entries and DLL files must be copied to the remote computer on which the event viewer
application is being run.

To get the remote registry entries and DLL files onto the local SiteScope machine:

1. Locate on the remotemachine which event you are not getting properly in SiteScope by finding the entry
in the Event Viewer. Write down the information for the source, event id, and description. For example:

Source: MSExchangeSA, Event ID: 5008, Description: The message tracking log file
C:\exchsrvr\tracking.log\20020723.log was deleted.

2. Open the registry settingHKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\EventLog
\Application and click the source (for example, MSExchangeSA).

3. Click EventMessageFile and write down the data for where that DLL is located (for example,
C:\EXCHSRVR\bin\madmsg.dll).

4. Locate the DLL on the remote and copy it to the SiteScopemachine. You can perform the copy in one of
two ways:
l Use the Initlog.exe utility, in the BackOffice Resource Kit, Second Edition, to copy the required
registry entries from the Exchange Server computer to the remote computer. This utility can also copy
the required DLL files if you are logged on toWindows with an account that has Administrator privilege
on the Exchange Server computer (seeMicrosoft Article Q184719).

l Use FTP, mail, and so forth, to get the file to your local drive.

5. SiteScope uses the data from theEventMessageFile field in step 3 to determine where to find the DLL
on the local machine. Youmust create the same folder structure as in this step and place the file in that
directory.

Alternatively, you can change the directory structure to say c:\Windows\System32 (SiteScope looks in
the ADMIN$ by default on the remotemachine), and places the DLL in that folder, but youmust have this
structure and the DLL on bothmachines. If you do this, youmust update the registry in step 3 to reflect
the directory in which the DLL is located.

Viewing Data Returned when SiteScope is Trying to Access the Remote Registry
Use the following steps to view that data is being returned when SiteScope is trying to access the remote
registry:

1. Open a commandwindow on the SiteScope server.
2. Change the directory to <SiteScope root directory>\tools.
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3. Enter the following in a command line:

perfex \\MACHINE -u username -p password -d -elast "Application"

This command gives you the number of entries in your Application log. For example:

4. List only the last 10 or 12 events to find the one you are looking for. For this example, the command is:

perfex \\MACHINE -u username -p password -d -elog "Application" 2355 | more

5. Look through each entry until you find the one you need. Note the Record id for easier searching next
time when using the command in Step 3.

6. This output tells you what data SiteScope is receiving. In the example given, the following is an example
of the data that typically would be returned:

Type: Information
Time: 02:00:24 08/01/102
Source: MSExchangeMTA
ID: 298
Category: 1
Record: 2342
Machine: EX-SRV
FILE=C:\EXCHSRVR\res\mtamsg.dll
REMOTE FILE=
String 835050d is: MTA
Next String 835054d is: OPERATOR
Next String 83505dd is: 34
Next String 835060d is: 0
Next String 835062d is:
File: C:\EXCHSRVR\res\mtamsg.dll
Remote Path:
calling FormatMessage()
Formatted Message 142 bytes long
Raw message is: The most current routing information has been loaded by the MTA,
and a text copy was saved in the fileGWART0.MTA. [MTA OPERATOR 34 0] (12)
Message: The most current routing information has been loaded by the MTA, and a
text copy was saved in the file GWART0.MTA.[MTA OPERATOR 34 0] (12)

The file path is where the remote file is being found. If you copy the DLL to theWINDOWS\SYSTEM, the
file and remote file path like this:
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Type: Information
Time: 03:15:00 08/01/102
Source: MSExchangeIS Public
ID: 1221
Category: 6
Record: 2350
Machine: EX-SRV
FILE=C:\WINNT\SYSTEM32\mdbmsg.dll
REMOTE FILE=\\ex-srv\ADMIN$\SYSTEM32\mdbmsg.dll
String 835054d is: 0
Next String 835056d is:
File: C:\WINNT\SYSTEM32\mdbmsg.dll
Remote Path: \\ex-srv\ADMIN$\SYSTEM32\mdbmsg.dll
LOADING LIB REMOTE: \\ex-srv\ADMIN$\SYSTEM32\mdbmsg.dllcalling
FormatMessage()Formatted Message 89 bytes long
Raw message is: The database has 0 megabytes of free spaceafter online
defragmentation has terminated.Message: The database has 0 megabytes of free
space afteronline defragmentation has terminated.

System Encoding Used When Displaying System Resources for Remote Hosts
Connected Through NETBIOS
This limitation affects all server monitors that use encoding of the remote host to display received data.

SiteScope uses default system encoding when displaying system resources information for the remote hosts
connected through NETBIOS. TheRemote server encoding field (available in the remote server's Main
Settings) is not used. For example, if system encoding is ASCII and remote encoding is Unicode, the ASCII
characters are displayed correctly and the Unicode symbols are not supported.

SiteScope Uses the Wrong Credentials for Remote Windows Connections Using
Perfex
Problem:

SiteScope ignores the credentials provided for specific remotes and tries to runmonitoring commands and
actions for perfex-basedmonitors (such as CPU, Memory, andWindows monitors) using credentials that are
used to start the SiteScope service.

Resolution:

For perfex-basedmonitors to work correctly withWindows remote servers, youmust add -
optionalSetupConnection toPerfex options inPreferences > Infrastructure Preferences > Monitor
Settings, or to the _perfexOptions= property in the <SiteScope root directory>\groups\master.config file.
Use a single space as a separator if other strings have already been added to this property.

For example:

_perfexOptions=-wrmUiTimeout 300 -optionalSetupConnection

Note:When the SiteScope service user has no network permissions and -optionalSetupConnection is set,
the connectionmethod will be at the host level instead of process level for file-basedmonitors (File, Directory,
Log File).
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Perfex-Based Monitors Fail When Selecting a Remote Server Using the Browse
Servers Button
Problem:

When using theBrowse Servers button in monitor properties, all perfex-basedmonitors (such as CPU,
Memory, and so forth) fail.

Resolution:

1. Create a new credential profile for the SiteScope service inPreferences > Credential Preferences (for
example, named Service).

2. Enter the credential name (Service) in theDefault credentials name field inPreferences >
Infrastructure Preferences > Server Settings.

3. Restart SiteScope.

Perfex-Based Monitors Fail with Error 1219
If you encounter Error 1219 (session credentials conflict) when using perfex-basedmonitors (such as CPU,
Memory, Service, and so forth), add the property -ignoreError1219 toPerfex options inPreferences >
Infrastructure Preferences > Monitor Settings, or to the _perfexOptions= property in the <SiteScope root
directory>\groups\master.config file.

When this option is used and perfex encounters Error 1219, themonitor ignores the error and reestablishes the
already active connection using credentials that this connection is using.

WMI Issues
For tips and troubleshooting forWMI issues, see "Configure theWMI Service for RemoteWindows
Monitoring" on page 417
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Chapter 36: Configure the WMI Service for
Remote Windows Monitoring
You can use SiteScope tomonitor data on remoteWindows servers usingWindows Management
Instrumentation (WMI). WMI is amore secure communicationmethod than NetBIOS for gathering
management data from remote servers running onWindows servers.

UsingWMI, you can access system counter data from objects in the performance libraries. This is the same
performance data that appears in the Perfmon utility.

Learn About
Monitors Supporting WMI
The following is a list of themonitors that support theWMI method for collecting data.

l Citrix Monitor
l CPU Monitor
l Disk SpaceMonitor (Deprecated)
l Dynamic Disk SpaceMonitor
l Memory Monitor
l Microsoft Lync Server 2010Monitors (Microsoft A/V Conferencing Server, Microsoft Archiving Server,
Microsoft Director Server, Microsoft Edge Server, Microsoft Front End Server, Microsoft Mediation
Server, Microsoft Monitoring and CDR Server, andMicrosoft Registrar Server)

l Microsoft ASP Server Monitor
l Microsoft Hyper-V Monitor
l Microsoft IIS Server Monitor
l Microsoft SQL Server Monitor
l Microsoft Windows Event LogMonitor
l Microsoft Windows Media Server Monitor
l Microsoft Windows Resources Monitor
l Microsoft Windows Services StateMonitor
l Real Media Server Monitor
l ServiceMonitor

Tasks
How to Configure the WMI Service for Remote Monitoring
This task describes the steps involved in configuring SiteScope tomonitor data on remoteWindows servers
usingWMI. For the list of monitors that support theWMI protocol, see "Monitors SupportingWMI" above.

HPE SiteScope (11.33) Page 417 of 1206



Note: This task is part of a higher-level task. For details, see "Configure SiteScope toMonitor Remote
Windows Servers" on page 402.

1. Prerequisites
SiteScopemust be installed on aWindows machine.

2. Configure theWMI service on the remote server
The following are requirements for using SiteScope to collect performancemeasurements on a remote
machine usingWMI:
l TheWMI servicemust be running on the remotemachine. For details, refer to theWindows
Management Instrumentation documentation (http://msdn.microsoft.com/en-us/library/aa826517
(VS.85).aspx).

l The user entered on theWMI remote server must have permissions to read statistics remotely from
WMI namespace root\CIMV2. For details, refer to http://support.microsoft.com/kb/295292.

l Themonitoring user must be added to the PerformanceMonitor Users group on the target server, and
have DCOM remote launch and activation permissions (see http://msdn.microsoft.com/en-
us/library/Aa393266.aspx).

For information about troubleshootingWMI service problems, see "Tips/Troubleshooting" below.
3. ConfigureWMI preference settings in SiteScope - optional

You can configure the connection type for monitoringWindows server resources on the local host
machine and theWMI timeout settings inPreferences > General Preferences > WMI Preferences.
For user interface details, see "WMI Preferences" on page 508.

4. Configure amonitor
Add aWMI supportedmonitor, and configure themonitor settings.

Note:When configuring theWMI connection typemethod for monitoringWindows server resources
on the localhost machine (themachine where SiteScope is running), theUser name andPassword
must be left blank in the Credentials section.

Tips/Troubleshooting
WMI Limitations
It is not recommended to havemore than 4000monitors usingWMI.

When a counter or object is shared between resources, SiteScope is unable to receive data for the counters
and the query fails. If other counters are referenced in the same query, they also fail to receive data. For
details and troubleshooting information, refer to http://support.microsoft.com/kb/836802.

WMI Fails to Retrieve Counters
In some cases, WMI shows n/a for counters while perfmon gives the value 0 for the same counters. This is
the behavior for counters that are also not selectable using the perfmon utility. The reason that perfex can get
values for these counters is that it bypasses perfmon and accesses them through the registry.
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WMI Data Not Synchronized
WMI data relies on being synchronized with the Perfmon utility. If WMI data is not synchronized, perform the
following:

1. Check that theWMI service is started on the target machine. For details, refer to
http://msdn.microsoft.com/en-us/library/aa826517(VS.85).aspx.

2. Check that the namespace root\CIMV2 is configured to enable remote access to the user specified in
the SiteScopeWMI remote server. For details, refer to http://support.microsoft.com/kb/295292.

3. On the target machine, run the command perfmon and verify that the required perfmon objects appear.
For details, refer to http://msdn.microsoft.com/en-us/library/aa645516(VS.71).aspx.
For details on how to rebuild these libraries, refer to http://support.microsoft.com/?kbid=300956.

4. On the target machine, run the command perfmon /wmi and verify that the required perfmon objects
appear. For details, refer to http://msdn.microsoft.com/en-us/library/aa645516(VS.71).aspx.
If the required perfmon objects do not appear, run the command perfmon wmiadap /f. For details, refer
to http://msdn.microsoft.com/en-us/library/aa394528(VS.85).aspx.
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Chapter 37: Configure SiteScope to Monitor
Remote UNIX Servers
UNIX Remote server options are used to set up the connection properties, such as credentials and protocols,
so that SiteScope canmonitor systems and services running in remote environments. You can then create
monitors to watch the resources and performance counters for that server. Multiple monitors can use the
same connection profile. You can also createmultiple remote servers for the same host machine.

Tip: You can use SiteScope UNIX operating system adapters to extend SiteScope to connect to, and
remotely monitor versions of UNIX that are not supported by default. For details, see "Extend UNIX
Monitoring Using Operating System Adapters" on page 428.

To access
Select theRemote Servers context. In the remote servers tree, click theUNIX Remote Servers container.

Learn About
UNIX Remote Server Overview
SiteScope canmonitor systems and services running on remote UNIX servers for certain statistics (such as
CPU, Disk Space, Memory, and Processes) without the installation of agent software on each server. Select
the servers to display when configuring UNIX monitors. SiteScope creates a new remote connection profile
for each server address in the list.

Tasks
How to Configure SiteScope to Monitor a Remote UNIX Server
This task describes the steps involved in configuring SiteScope tomonitor data on remote UNIX servers.

1. Enable SiteScope tomonitor data on remote UNIX servers
l Only an administrator in SiteScope, or a user grantedAdd, edit or delete remote servers
permissions can view or edit the Remote Servers page. For details on user permissions, see "User
Management Preferences" on page 625.

l Monitoring remote UNIX server data requires authenticated access to the remote server. A UNIX
server connection profile provides the necessary address and login credentials for SiteScope to log on
to a remote server.
To log on to a remote server using the UNIX server connection profile, either:
o Log on to the remote server as a user with administrator privileges, or
o Create or modify a user account on the remote server that corresponds with the connection

method and login permissions used in the SiteScope connection profile for that server.
You need to define an individual remote UNIX server connection profile for each remote UNIX server
you want SiteScope tomonitor.
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2. Configure and test the settings for the UNIX remote server
a. Configure the remote UNIX server in the remote server tree.
b. Test the settings for the applicable server.

o Click the Test button to test the connection to the server.

o Click theDetailed Test button to test the running commands on the remote host and check
the permissions for the defined user.

3. Results
The server is added to the list of UNIX Remote Servers in the remote server tree. You can then create
monitors to watch the resources and performance counters for that server. Multiple monitors can use the
same connection profile.

Note: For information about troubleshooting and limitations of SiteScopemonitoring of remote
servers, see "Tips/Troubleshooting" on page 427.

How to Configure SiteScope to Monitor Secure Shell (SSH) Login on Sun Fire
ILOM X64 Servers
This task describes the steps involved in configuring SiteScope tomonitor SSH login on Sun Fire ILOM X64
remote servers.

1. Create a Sun Fire X64 ILOM remote server.
Select Remote Servers > New UNIX Remote Server, and configure a remote server with the following
settings:
l Main Settings:

o Operating system:Sun Fire X64 ILOM
o Method:SSH

l Advanced Settings:
o Disable connection caching: Selected. This turns off connection caching for this remote.

For additional details on configuring SiteScope tomonitor data on remote UNIX servers, see the task
above.

2. Create a Script monitor as described in Script Monitor in the SiteScopeMonitor ReferenceGuide, and
select the following:
l Server:Select the Sun Fire X64 ILOM  remote server configured in the previous step.

l Remote script command file: sun-ilom.txt.

3. Save and run themonitor.
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UI Descriptions
New/Edit UNIX Remote Server Dialog Box

Important
information

l You cannot delete a remote server from the list of remote servers if the server is
referenced by amonitor. Select a different server in theServer box of theMonitor
Settings panel for eachmonitor that references the remote server, and then delete the
remote server from the remote server list.

l The HTTP method for connecting to a remote server is no longer supported.
l Remote server passwords support empty spaces and the following special characters: \
" & | > < ^

l When configuring a remote server in templatemode, theMethod andOperating system
values must be entered using the same case that is displayed below, otherwise
verification does not work properly:
l Method. telnet, rlogin, or ssh

l Operating System. AIX, CentOSLinux, FreeBSD, HP, HP-UX, HP64, Linux,
MacOSX, OPENSERVER, RHESLinux, SCO, SGI, Sun, SunOS, ILOM, Tru64,
Tru64_4.x, UbuntuLinux.

See also l "Remote Server Tree" on page 36
l "Remote Servers Properties Page" on page 458

The following elements are included:

UI Element Description

Save Saves the settings without verifying the correctness of the configuration on the remote
server.

Tip:Performance is faster if you useSave instead of Save & Test, because SiteScope
does not need to establish a connection to the remote server to verify the settings.

Save & Test Saves the settings and verifies the correctness of the configuration on the remote server.
If SiteScope fails to connect to the remote server, or if there is an invalid property in the
configuration settings, an error message is displayed.

Tip:Performance is slower if you useSave & Test instead of Save, because SiteScope
needs to establish a connection to the remote server to verify the settings.

General Settings

Name Name by which the remotemachine should be known in SiteScope. This name appears in
theServer list of monitors that can use this connection profile.

Description Description for the remote UNIX server. This text appears only when editing the remote's
properties.

Main Settings
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UI Element Description

Server Real IP address or host name of themonitored server. Network address translation (NAT)
is not supported for SiteScopemonitors that require a remote host definition. SiteScope is
unable to determine if an external (real IP) or internal IP (NAT) is used when you configure
amonitor with an IP address or host. Tomonitor servers in a NAT environment, we
recommend placing SiteScope inside the firewall. Virtual IPs can be used inmonitors
which do not collect host specific information, such as in the URLmonitor or other similar
monitors.

To use the same login credentials to configuremultiple servers at the same time, enter
the server names or addresses separated by a comma (","), semicolon (";"), or a space.

Example: If using NetBIOS to connect to other servers, enter a comma-separated string
of server addresses such as: serveraddress1,serveraddress2,serveraddress3

When completing the other required entries on the form, SiteScope creates a new remote
connection profile for each server address in the list.

Note: To test connectivity after the host is added, click the Test button in the table
listing the UNIX Servers. This tests only the connection to the server. Click theDetailed
Test button to run a test that displays the result of running commands on the remote
host. This enables checking the permissions for the defined user.

Note when working in template mode:Enter the name of a template variable that
represents the remote server name, for example, %%host%%. Each time you enter a server
name for the variable, amonitor instance is created for that server and the server is added
to the remote server tree.

If the remote servers onto which you want to deploy monitor templates already exist
under Remote Servers, you can reference these servers within themonitor template. You
do this by referencing the system variable $$SERVER_LIST$$ which identifies the
servers accessible to the SiteScope. For details, see "Syntax for System Variables" on
page 675.

Credentials Option for providing the user name and password for the remote UNIX server:

l Use user name and password. Select this option tomanually enter user credentials.
l User name. Enter the user name for the remote server or use a template variable
that represents the user login name (for example, %%user%%).

l Password. Enter the password for the remote server or the passphrase for the SSH
key file, or use a template variable that represents the password (for example,
%%password%%). When using SSH authentication with public/private key based
authentication enter the passphrase for the identity file here.

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the server (selected by default).
Select the credential profile to use from theCredential profile drop-down list, or click
Add Credentials and create a new credential profile. For details on how to perform
this task, see "Credential Preferences" on page 476.
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UI Element Description

Trace Traces messages to and from the remote server in theRunMonitor.log file.

Default value:Not selected

Operating
system

Operating system that is running on a remote server. This is required so that the correct
information can be obtained from that server. Select an operating system from the list.

The following operating systems are supported when defining UNIX remote servers: AIX,
CentOSLinux, FreeBSD, HP iLO, HP-UX, HP/UX, HP/UX 64-bit, Linux, MacOSX,
NonStopOS, OPENSERVER, Red Hat Enterprise Linux, SCO, SGI Irix, Sun Fire X64
ILOM, Sun Solaris, SunOS, Tru64 5.x, Tru64 Pre 4.x (Digital), and Ubuntu Linux. For
servers running versions of UNIX which are not included in the list, see "Extend UNIX
Monitoring Using Operating System Adapters" on page 428.

Note:

l TheDisable connection caching optionmust be selected for Sun Fire X64 ILOM. All
other types of remotes works fine with caching.

l The Sun Fire X64 ILOM operating system is available when configuring a Script
monitor only.

Method Connection types for monitoring UNIX server resources:

l Rlogin. Logs in to the remote server using the Rlogin protocol. You can set up your
remote servers to require a password for rlogin, or to enable access without a
password (like "rsh"). SiteScope supports either case.

l SSH. Logs in to the remote server using Secure Shell, a more secured communication
protocol. This may require additional software and setup depending on the version of
UNIX.
For Solaris, using the SSH access method requires that an SSH client is installed on
the SiteScopemachine and the SSH server installed on the servers you are
monitoring. The path to the SSH client on themachine where SiteScope is running
should be /usr/local/bin/ssh or /usr/bin/ssh. For information about SSH
requirements, see "Configure RemoteMonitoring Using Secure Shell (SSH)" on
page 439.
Using SSH requires that digital certificates be installed on each of the servers to
which you are connecting.

l Telnet. Logs in to the remote server using Telnet. Telnet is a popular method for
connecting to remote UNIX servers. You can set up your remote servers to require a
password for telnet, or to enable access without a password (like "rsh"). SiteScope
handles either case.

Prompt Prompt output when the remote system is ready to handle a command.

Login prompt Prompt output when the system is waiting for the login to be entered.

Password
prompt

Prompt output when the system is waiting for the password to be entered.
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UI Element Description

Secondary
prompt

Secondary prompts if the telnet connection to the remote server causes the remote server
to prompt for more information about the connection. Separatemultiple prompt string by
commas (,).

Example: For Telnet connections to some remote servers, the remote server may ask
what terminal type should be emulated for the connection. In this case, enter Terminal
type? as the secondary prompt. The response to the secondary prompt is entered in the
Secondary Response box below.

Mask
secondary
response

Hides the secondary response behind asterisks. If you subsequently clear the check box,
the hidden data is deleted.

Default value:Not selected

Secondary
response

Responses to any secondary prompts required to establish connections with this remote
server. Separatemultiple responses with commas (,).

Initialize shell
environment

Shell commands to be run at the beginning of the session. Separatemultiple commands
with a semicolon (;). This option specifies shell commands to be run on the remote
machine directly after a Telnet or SSH session has been initiated. These commands can
be used to customize the shell for each SiteScope remote. Some examples include:

l The remote shell may not have the correct path set for SiteScope scripts to run. The
following command adds the directory /usr/local/bin into the PATH of the current
shell on the remotemachine: export PATH=$PATH:/usr/local/sbin

l The remote shell may not be initializing the pseudo terminal correctly. Enter the
following command to increase the terminal width to 1024 characters: stty cols
1024;${SHELL}

Note:Commands after a shell invocation are not run.

l There have been cases where the remote Telnet Server does not echo back the
command line properly. This may cause strange behavior for monitors that rely on this
behavior. Enter the following command to force the remote terminal to echo: stty
echo

l Certain UNIX shells have been known to behave erratically with SiteScope. This
includes bash, ksh, and csh. Enter the following command to change the shell to sh
for the SiteScope connection: /bin/sh

l To enable the UNIX Resources monitor to retrieve Network Interface object counters
whenmonitoring a remote Solaris server, you need to enter the following command:
/bin/bash. This enables themonitor to get counters for vnet*, eri*, qfe*, ce*, bge*,
xge*, and e1000g* network adapters (NICs).

Remote
server
encoding

Encoding for the remote server if the remote server is running an operating system
version that uses a different character encoding than the server on which SiteScope is
running. This enables SiteScope to display encoded content correctly.

Default value:Cp1252 encoding

HP NonStop Shell Settings
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UI Element Description

Shell choice
prompt

(For NonStopOS only) Prompt output when the system is waiting for the shell to be
selected.

Default value: >

Shell name (For NonStopOS only) Shell name to be executed.

Default value:OSS

Advanced Settings

SSH port
number

Port on which the remote SSH server is listening.

Default value: 22

Connection
limit

Number of open connections that SiteScope permits for this remote. If there aremany
monitors configured to use this connection, set the number of open connections high
enough to relieve a potential bottleneck.

Default value: 3

Note: This setting does not effect running tests for a remote server. Tests always create
a new connection.

SSH
authentication
method

Authenticationmethod used for SSH connections:

l Password. Authenticates using a password (default setting).
l Key File. Authenticates using public/private key authentication. When this option is
selected, SiteScope uses the private key in the file
<SiteScope root directory>\groups\identity to authenticate. The corresponding
public key must be listed in the authorized_keys file on the remote host. For
information about SSH requirements, see "Configure RemoteMonitoring Using
Secure Shell (SSH)" on page 439.

Disable
connection
caching

Turns off connection caching for this remote. By default, SiteScope caches open
connections.

Default value:Not selected

Note: This optionmust be selected for Sun Fire X64 ILOM. All other types of remotes
works fine with caching.

Key file for
SSH
connections

Path and name of the file that contains the private key for this connection. The default key
file is <SiteScope root directory>\groups\identity. This setting applies only when the
authenticationmethod is Key File.

SSH version
2 only

Forces SiteScope to use SSH protocol version 2 only.

Default value:Not selected

SSH keep
alive
mechanism

Engages a keep alivemechanism for SSH version 2 sessions. This option applies only
when using the integrated Java Client. SSH keepalive packets are sent every 55
seconds.

Default value:Not selected

Using SiteScope
Chapter 37: Configure SiteScope toMonitor Remote UNIX Servers

HPE SiteScope (11.33) Page 426 of 1206



UI Element Description

Search/Filter Tags

<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the , this
section appears but is empty. If tags have been created, they are listed here and you can
select them as required.

For concept details, see "How to Filter the View Using Search/Filter Tags" on page 67.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Other Related UI Pages: "Remote Servers Properties Page" on page 458

Tips/Troubleshooting
Troubleshooting Remote UNIX Servers
l Remote UNIX Servers Not Configured for an English Locale
Problem: The File monitor and Directory monitor may fail when using UNIX remote servers that are not
configured by default for an English locale or language.

Resolution: Add "LANG=C; export LANG" to the Initialize shell environment property of the
problematic UNIX remote server.

l UNIX Resources Monitor Not Getting all Counters For a Non-English Locale
Problem: The UNIX Resources monitor is unable to get counters for file systems or inode cache objects
whenmonitoring a UNIX remote server running on a Linux operating system with a non-english locale.

Resolution: Enter export LANG=en_EN.UTF-8 in the Initialize shell environment field for the
UNIX remote server.
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Chapter 38: Extend UNIX Monitoring Using
Operating System Adapters
You can use SiteScope UNIX operating system adapters to extend SiteScope to connect to, and remotely
monitor other UNIX platforms, in addition to those supported by default. This is done by configuring an adapter
file to support the particular UNIX platform you want to monitor.

Learn About
UNIX Adapters Provided with SiteScope
SiteScope uses adapter files to describe the commands that are needed to retrieve a variety of system
resource information from servers running different platforms of the UNIX operating system. These adapter
files are written in plain text and are stored in the  <SiteScope root directory>/templates.os directory. For a
list of the default UNIX adapters that are provided with SiteScope, see "UNIX Adapters Provided with
SiteScope" above.

You canmodify existing adapter files to adjust for specific system requirements in your environment, or you
can create your own adapter files.

The default UNIX adapters that are provided with SiteScope, include:

Filename Description

AIX.config Adapter file for IBM AIX

CentOS.config Adapter file for CentOS Linux

Digital.config Adapter file for Digital Tru64 UNIX (Pre 4.x)

FreeBSD.config Adapter file for FreeBSD 3.x

HP.config / HP-UX.config Adapter file for Hewlett-Packard HP/UX

HP64.config Adapter file for Hewlett-Packard HP/UX 64-bit

ILO.config Adapter file for Hewlett-Packard Integrated Lights-Out

Linux.config Adapter file for Linux (Red Hat and others)

MacOSX.config Adapter file for AppleMacIntosh OS X

NonStopOS.config Adapter file for Hewlett-Packard NonStopOperating System

OPENSERVER.config Adapter file for SCOOpenServer

RedHatEnterpriseLinux.config Adapter file for Red Hat ES Linux

SCO.config Adapter file for SCOUNIXWare
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Filename Description

SGI.config Adapter file for Silicon Graphics Irix

Sun.config / SunOS.config Adapter file for SunMicrosystems Solaris

Tru64.config Adapter file for Compaq Tru64 UNIX 5.x

Ubuntu.config Adapter file for Ubuntu Linux

Adapter File Format
Each UNIX platform supported for remotemonitoring by SiteScope has an adapter file in the <SiteScope
root directory>/templates.os directory. These files use SiteScope's standard setting file format.

The first group of settings (those settings before the first # sign line) describe the platform:

id=yourPlatform
name=your Platform Name

The id is theSiteScope internal ID for the OS. This ID must be unique, contain no spaces, and can be
alphanumeric.

Tip:We recommend that you use the name of the adapter file as the ID name. For example, if the name
of your adapter file is linux.config, your ID would be linux.

The name is the name you want displayed in theOperating system drop-down list when adding or editing
remote servers.

The rest of the template file contains groups of settings representing a single command, separated by a line of
# characters. For example, the following settings represent the disk space command:

id=disks
command=/usr/bin/df -k
mount=6
name=1

where:

id=disks is the id that SiteScope uses to look up a command. This must be one of the set of SiteScope
commands (see "Adapter Command List" on the next page). This entry is case sensitive.

For example:

command=/usr/bin/df -kmeans that the usr/bin/df -k command is run to get the information about the
disks.

mount=6 and name=1mean that themount name is in column 6 and the name of themount or file system is in
column 1. The data names vary from command to command and are documented below.

Applying the above for the following command output:

Filesystem kbytes used avail capacity Mounted on /proc 0 0 0 0%/proc /dev/dsk/c0t3d0s0
73049 42404 23341 65% /

where the disks command automatically skips lines not starting with (/dev) reads column 1
(/dev/dsk/c0t3d0s0) as the name of the file system, and column 6 ("/") as themount name.
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Adapter Command List
SiteScope requires settings for each the following commands to operate properly. Each command description
requires an ID and a command, one or more fields to specify where the data is being read from, and optionally
a set of modifiers that are used to filter the output of the command to eliminate certain sets of lines (such as
header lines).

Where the variable column is used below, it means the number of the column in which the data appears,
where columns are space delimited sets of data.

In addition, there are certain fields that can be optionally applied to any command description. For details, see
"Optional Adapter CommandDetails" on page 432.

This section includes:

l "Disk Listing" below
l "Disk Information" below
l "Memory" on the next page
l "Page Faults" on the next page
l "CPU Usage" on the next page
l "Process List" on the next page
l "Process List with Details" on page 432
l "Log File Processing" on page 432
l "Optional Adapter CommandDetails" on page 432

Disk Listing

ID Description
Used
by Fields

disks Returns a list of the file systems on the system. The /usr/bin/df -
k command is the standard way to get this data. Lines returned that
do not start with /dev are automatically skipped.

Disk
Space
Monitor

name. The
column of the
name of the file
system.

mount. The
column of the
name of the
mount.

Disk Information

ID Description Used by Fields

disk Takes a disk as an argument and returns the
total, free, and percent used for the disk.

Disk
Space
Monitor

total. The column of the total
kilobytes capacity of the file system.

free. The column of the free kilobytes
of the file system.
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Memory

ID Description Used by Fields

memory The amount of swap space
used and available.

Memory
Monitor

swapUnit. Themultiplier applied to used, free, or
total swap space to give bytes.

used. The amount of swap space used.

free. The amount of swap space free.

total. The amount of total swap space.

Note:Only two of used, free, and total fields need to
read. The other is computed.

Page Faults

ID Description
Used
by Fields

pageFault The number of page
faults/sec. If multiple
page faults lines are
matched, they are
added up.

Memory
Monitor

pageFaults. The column of the number of page faults.

inPageFaults. The column of the number of page in
faults.

outPageFaults. The column of the number of page out
faults.

units. pages (default), pages/sec, or k/sec units for the
paging data.

pageSize. If units are k/sec, the pageSize is used to
compute the number of pages. Otherwise it is ignored.

Note:Either use pageFaults, if there is a single column of
data, or inPageFaults and outPageFaults, if there are
two columns of page fault data. inPageFaults and
outPageFaults are added together to get the total page
faults.

CPU Usage

ID Description Used by Fields

cpu Returns the wait and idle% of the CPU. CPU Monitor idle. The idle% for the CPU.

wait. The wait % for the CPU (optional).

Process List

ID Description Used by Fields

process A list of processes with long process names.
Typically this is /usr/bin/ps -ef

Service
Monitor

name. The column of the
names of the processes.
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Process List with Details

ID Description Used by Fields

processDetail A list of processes with size of the
process. Typically this is
/usr/bin/ps -el

ServiceMonitor (with
Check Memory option
enabled)

name. The column of the
names of the processes

size. The column of the size
of the processes.

pageSize. Page size on the
system (optional). The
default is 8192.

Log File Processing

ID Description Used by Fields

fileExists Checks that the log file exists. Log File monitor
(onWindows or
Linux)

match. The text to match in
the log entries.

filesize Returns the file size to ascertain if the file
changed.

Log File monitor
(onWindows or
Linux)

size. The number in the size
column in the command
output.

tail Reads the file content for local file
processing (not supported for server-side
processing).

Log File monitor
(onWindows or
Linux)

match Performs server-side processing with perl
or awk.

Log File Monitor
(on Linux)

Optional Adapter Command Details
The following fields can optionally be applied to any command description:

Process List with Details

ID Description

startLine The line number where the command starts looking for data.

endLine The line number where the command ends looking for data.

skipLine The pattern that if matched, skips the line.

matchLine The pattern that if matched, looks for data in that line.

startMatch The pattern that if matched, starts the command looking for data.

endMatch The pattern that if matched, ends the command looking for data.

reverseLines If true, the command output lines are reversed and read back to front. This is useful if there
is data at the end of the command and it is too difficult to work out when to start reading.
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If a field name has the format, fieldnameColumnName=COLUMN, the adapter searches the headers (first line)
for COLUMN and records the columns containing the data, and then use those settings to read the fieldname
field. This is useful where the width of the columns varies, and the data has spaces in it.

For example, to read the my data information from the following command output:

MEM NAME DESC12K my data some of my data

you would specify the name field in the command description as:

nameColumnName=NAME

The adapter reads the header line, finds NAME, and records where the previous column ends (MEM in this case)
and where the specified column ends (NAME), and uses that to read, in this case, the text in character columns
6 through 22.

To see an example of the ColumnName reading in action, look at the process and processDetail commands
for the supported UNIX platforms. They use this method to get the process name and the size of the process.

Tasks
How to Add an Adapter
This task describes the steps involved in adding an adapter to specific versions of UNIX.

1. If the UNIX platform to which you want to add support is similar to one of the default SiteScope-
supported UNIX platforms, make a copy of the adapter file for that UNIX platform and use that as a
starting point for your adapter.

2. Modify the adapter file to match the command line requirements for the UNIX platform to which you want
SiteScope to connect.

3. Save your adapter file to the <SiteScope root directory>/templates.os directory. The filenamemust
use the .config extension.

4. Restart the SiteScope service.
5. Open the installation SiteScope to which you have added the new adapter file.
6. In the left pane, click Remote Servers to display the remote servers view.
7. In the remote servers tree, right-click UNIX Remote Servers, and select New UNIX Remote Server.

The New UNIX Remote Server dialog box opens.
8. In theOperating system box, select the name of the UNIX adapter that you have created.
9. Click OK. SiteScope uses the new adapter file to try and retrieve that applicable data from the remote

server.
10. If youmake changes to the adapter file after you have configured one or more server connection profiles

to use the adapter, you can use theDetailed Test option in the UNIX Remote Servers to test your
adapter. After adding the remote server, the Detailed Test displays the output of the command that
SiteScope is running remotely, along with SiteScope's parsing of the output.

The amount of work required tomodify a particular template depends on how different the new UNIX platform
is from the supported UNIX platforms.
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Chapter 39: Enable SiteScope to Prefer IP
Version 6 Addresses
By default, SiteScope connects to remote servers using IPv4 addresses. If you want your environment to
resolve host names to IPv6, you need to enable SiteScope to prefer IPv6 addresses over IPv4 when
connecting to remote servers. Using IPv6 solves many of the problems of IPv4 such as address depletion,
security, auto-configuration, and extensibility.

Learn About
Resolving Host Names to IPv6 Overview
The level of support for IPv6 depends on the operating system onwhich SiteScope is installed. Windows
Server 2008 has full-featured support for IPv6, which is installed and enabled by default. As a result, IPv6 is
supported by most SiteScopemonitors when SiteScope is installed onWindows Server 2008 or later
versions. Support for IPv6 onWindows Server 2003 is limited, as many core services and networking
components do not support it. IPv6 is also fully supported when SiteScope is installed on UNIX operating
systems that provide full support for IPv6.

For your environment to resolve host names to IPv6, select thePrefer IP version 6 addresses option in
SiteScope Infrastructure Settings. When this option is selected, the followingmust occur for the IPv6 over
IPv4 preference to take effect:

l A host namemust be specified for the remote server. If an IP address is specified, the prefer IPv6 setting
has no effect on the host since the IP address determines the IP version that is used.

l The host name resolves to both an IPv4 and an IPv6 address. If the host name resolves only to an IPv4
address, then the IPv4 address is used.

Note:

l If a host name is specified and the host name resolves to both an IPv4 and an IPv6 address, but the
monitor does not support IPv6, themonitor will not work. For details on how to resolve this issue, see
"Working in aMixed IPv4 and IPv6 Environment" on the next page. For the list of monitors supporting
IPv6, see "Monitors Supporting IP Version 6 Addresses" on the next page.

l When specifying a literal IPv6 address as the name for the remotemonitored server when using the
NetBIOS connectionmethod, the IPv6 address must be customized by:

1. Replacing any colon (":") characters with a dash ("-") character.
2. Appending the text .ipv6-literal.net to the IP address.

For example, the IPv6 address: 2004:DB8:2a:1005:230:48ff:fe73:982d
would be: 2004-DB8-2a-1005-230-48ff-fe73-982d.ipv6-literal.net

Alternatively, you can switch to theWMI connectionmethod (where supported), and avoid having to
make changes to the IPv6 address.
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Working in a Mixed IPv4 and IPv6 Environment
Whenworking in amixed environment where both IPv4 and IPv6 are used, the DNS server might return both
an IPv4 and an IPv6 address for a host name. To instruct SiteScope which IP address to use for each
resolved host name, you can:

l Select thePrefer IP version 6 addresses option, and perform one of the following (for the hosts that you
want to use the IPv4 protocol):
l Enter the IP address instead of the host name for the specified remote server.

l Configure the DNS server so that the host name resolves to the IP address that you want to use for the
remote server. You can do this by removing the IPv6 address from the DNS server for the specified
host.

l Clear thePrefer IP version 6 addresses option, and perform the following (for the hosts that you want to
use the IPv6 protocol):
l Enter the IP address instead of the host name for the specified remote servers.

l Configure the DNS server so that the host name resolves to the IP address that you want to use for the
specified remote servers. You can do this by removing the IPv4 address from the DNS server for the
specified hosts.

Supported Protocols
The following protocols are supported when IPv6 is used in SiteScopes installed onWindows and UNIX
platforms:

Target
SiteScope Installed on Windows
Platform SiteScope Installed on UNIX Platform

Windows NetBios

WMI

SSH

UNIX Not supported SSH

Note:

l SiteScope installed onWindows platforms canmonitorWindows machines only.
l NetBIOS andWMI are supported when SiteScope is installed onWindows platforms only .
l SSH is supported only when SiteScope is installed on UNIX machines. For the list of Windows-based
monitors supporting IPv6 in SiteScopes running on UNIX using SSH, see "Monitors Supporting IP
Version 6 Addresses" below.

Monitors Supporting IP Version 6 Addresses
The following lists themonitors that support IPv6. A check mark indicates that themonitor requires additional
IPv6 address customization in SiteScope.
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Monitors Supporting IPv6 Addresses

Additional
Configuration
Required

Windows-Based
Monitors
Supporting IPv6
in SiteScopes
Running on UNIX
Using SSH

CiscoWorks Monitor

Citrix Monitor a a

ColdFusion Server Monitor a a

CPU Monitor a a

Custom DatabaseMonitor

Database Counter Monitor

DatabaseQuery Monitor

DB2 JDBC Monitor

Disk SpaceMonitor (Deprecated) a

Dynamic Disk SpaceMonitor a

F5 Big-IP Monitor

HAProxy Monitor a

Log File Monitor a a

Memcached Statistics Monitor

Memory Monitor a a

Microsoft ASP Server Monitor a a

Microsoft Hyper-V Monitor a

Microsoft IIS Server Monitor a a

Microsoft Lync Server 2010Monitors (Microsoft A/V Conferencing
Server, Microsoft Archiving Server, Microsoft Director Server,
Microsoft Edge Server, Microsoft Front End Server, Microsoft
Mediation Server, Microsoft Monitoring and CDR Server, and
Microsoft Registrar Server)

a

Microsoft SQL Server Monitor a a

Microsoft Windows Event LogMonitor a a

Microsoft Windows Media Server Monitor a
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Monitors Supporting IPv6 Addresses

Additional
Configuration
Required

Windows-Based
Monitors
Supporting IPv6
in SiteScopes
Running on UNIX
Using SSH

Microsoft Windows Resources Monitor a a

Microsoft Windows Services StateMonitor a a

Network BandwidthMonitor

Oracle DatabaseMonitor

PingMonitor

Port Monitor

Real Media Server Monitor a a

ServiceMonitor a a

SNMP Monitor

SNMP by MIB Monitor

SNMP TrapMonitor

Technology SNMP Trap IntegrationMonitor

UNIX Resources Monitor

URLMonitor a

URLContent Monitor a

URL List Monitor a

URLSequenceMonitor a

WebServiceMonitor a

Tasks
How to Enable SiteScope to Prefer IP Version 6 Addresses
This task describes how to enable SiteScope to prefer IPv6 addresses over IPv4 when connecting to remote
servers.

1. Enable SiteScope to prefer IPv6 addresses
InPreferences > Infrastructure Preferences > Server Settings, select Prefer IP version 6
addresses.
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For user interface details, see "Server Settings" on page 528.

Note:

l Youmust restart SiteScope before changes to this setting can take effect.

l If a host name is specified and the host name resolves to both an IPv4 and an IPv6 address, but
themonitor does not support IPv6, themonitor will not work. For details on how to resolve this,
see "Working in aMixed IPv4 and IPv6 Environment" on page 435.

2. Customize IPv6 address as the name for the remotemonitored server (for specific monitors only)
Somemonitors have additional customization requirements or limitations when using IPv6 addressing.
For monitors that require additional IPv6 address customization, see "Monitors Supporting IP Version 6
Addresses" on page 435.
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Chapter 40: Configure Remote Monitoring
Using Secure Shell (SSH)
SiteScope supports a number of security capabilities. One of these is support for remote server monitoring
using Secure Shell (SSH) connections. You can use SSH to connect to a server and automatically send a
command, so that the server runs that command and then disconnects. This is useful for creating automated
processing and scripting.

Learn About
This section includes:

l "SSH Overview" below
l "Integrated Java SSH Client" below
l "SSH Connectivity Options" on the next page
l "Monitoring RemoteWindows Servers Using SSH" on page 442
l "Monitors SupportingWindows SSH (Agentless or Using the SiteScope RemoteWindows SSH Files)" on
page 442

l "SSH Guidelines" on page 444

SSH Overview
Secure Shell (SSH), sometimes known as Secure Socket Shell, is a UNIX-based command interface and
protocol for securely accessing a remote computer. It is widely used by network administrators to remotely
control Web and other kinds of servers. SSH commands are encrypted and secure in several ways. Both
ends of the client/server connection are authenticated using a digital certificate, and passwords are protected
by encryption. Secure Shell client machines make requests of SSH daemons or servers on remotemachines.

Monitoring with SiteScope over SSH has the following basic requirements:

1. The servers that you want to havemonitored by SiteScope using SSH must have an SSH daemon (or
server) installed and active.

2. The SiteScope server has an integrated Java SSH client. SiteScope includes an SSH client written in
Java and native to the SiteScope application code. For details, see "Integrated Java SSH Client" below.

Note: MindTerm is the only connection client available for SSH connections.

Integrated Java SSH Client
If you need to use Secure Shell (SSH) to connect to remote UNIX orWindows servers, SiteScopemust be
able to access a SSH client to make the connection and transmit data. This section contains some of the
client configuration possibilities and issues involved in using SSH for SiteScopemonitoring.

SiteScope provides an SSH client written in Java that is integrated into the SiteScope application. This client
significantly reduces the required system resources used by SiteScope when connecting to servers using
SSH. The Java client supports both SSH version 1 (SSH1) and version 2 (SSH2) protocols as well as both
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password-based and key-based authentication. The SiteScope configuration for the client is identical for
UNIX, Linux, andWindows SiteScope.

Working with the Integrated SSH Client

While SSH1 and SSH2 are both Secure Shell protocols, they are considered to be two different protocols and
are not compatible with each other. Some security vulnerabilities have been found in SSH1 that has resulted
in SSH2 being considered the current standard. Most SSH software supports both protocols. To be sure that a
request for an SSH connection uses SSH2 instead of SSH1, it is necessary to configure SSH clients and
SSH hosts to use the same protocol version between them to communicate. In many cases, SSH1 is the
default version used for connections, as it is considered the lowest common denominator between an SSH
client and an SSH host.

There are two ways to force SSH2 connections:

l Configure all SSH daemons or servers to accept only SSH2 connection requests.
This is themost secure option but may be themost time- consuming unless each server was configured
for this option when it was installed and activated.

l Configure the SSH client on the SiteScope server to only make SSH2 requests.
Requires changes only to the client on the SiteScope server. For the integrated Java SSH client, this can
be controlled by a setting in the Advanced Settings section on the remote server setup page. Making the
change on the SiteScopemachinemay be easier than having to reconfigure a large number of remote SSH
servers.

Setting Up Key-Based Authentication

Another part of SSH security is authentication. The integrated SSH client for SiteScope can be configured to
use one of two authentication options:

l Password Authentication. Password Authentication is the default method for SSH connections in
SiteScope.

l Key-Based Authentication. Key-Based Authentication adds an additional level of security through the use
of a passphrase and a public-private key authentication.

To use Key-Based Authentication for SSH remote servers, youmust first create a pair of public/private keys.
The public key resides on the remote and the private key is kept on the SiteScopemachine. Both Cygwin
OpenSSH andOpenSSH forWindows comewith a key generation tool called ssh-keygen. The ssh-keygen
tool enables you to create both protocol version 1 and version 2 keys. For details on how to set up key-based
authentication for SSH connections, see "How to Set Up Key-Based Authentication" on page 454.

When setting up a UNIX orWindows remote server using the Internal Java Libraries Client, use the key
generation tool calledMindTerm to create a public/private key pair for RSA (version 1 and version 2) and DSA
(version 2).

SSH Connectivity Options
The following tables outline the SSH connectivity options currently supported with SiteScope. For important
information about configuring andmanaging SSH connectivity, see "SSH Guidelines" on page 444.
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SiteScope Installed on Windows Platform:

Target

SiteScope
Client
Options

Relevant
Target
Servers Comments

Windows SiteScope
integrated
Java SSH
Client

SSH server
(Cygwin
OpenSSH)

l Agentless SSH. The RemoteNTSSH package is not required
for monitors that support agentless SSH. For a list of agentless
SSH supportedmonitors, see "Monitors SupportingWindows
SSH (Agentless or Using the SiteScope RemoteWindows
SSH Files)" on the next page.

l SSH using the SiteScope remoteWindows SSH files. The
RemoteNTSSH package should be installed under the home
user directory on the remote server. For details, see "Install
SiteScope RemoteWindows SSH Files" on page 453.

UNIX/
Linux

SiteScope
integrated
Java SSH
Client

SSH host
daemon
(sshd -
either
proprietary
or
OpenSSH)

SiteScope Installed on UNIX or Linux Platform:

Target
SiteScope Client
Options

Relevant
Target
Servers Comments

Windows l SiteScope
integrated Java
SSH Client

l SSH client
(/usr/local/bin/ss
h or usr/bin/ssh)

SSH
server
(Cygwin
OpenSSH)

l Agentless SSH. The RemoteNTSSH package is not
required for monitors that support agentless SSH. For
a list of agentless SSH supportedmonitors, see
"Monitors SupportingWindows SSH (Agentless or
Using the SiteScope RemoteWindows SSH Files)" on
the next page.

l SSH using the SiteScope remoteWindows SSH files.
The RemoteNTSSH package should be installed
under the home user directory on the remote server.
For details, see "Install SiteScope RemoteWindows
SSH Files" on page 453.

UNIX/
Linux

l SiteScope
integrated Java
SSH Client

l SSH client
(/usr/local/bin/ss
h or usr/bin/ssh)

SSH host
daemon
(sshd -
either
proprietary
or
OpenSSH)
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Monitoring Remote Windows Servers Using SSH
NetBIOS is the default remote connectionmethod used by SiteScope forWindows-to-Windows connectivity
andmonitoring inWindows networks. While this provides easier connectivity, it does have several
disadvantages; it is relatively vulnerable in terms of network security, and it does not support remote
execution scripts. Running commands on remote servers requires that scripts be run locally, with commands
to the remotemachine being written using the UNC syntax of remote servers. Even then, some parameters
are not returned from the remote server by using NetBIOS. (SiteScope also supports theWindows
Management Instrumentation (WMI) protocol which is amore secured communication protocol than NetBIOS
for gathering data from remote servers running onWindows servers. For details, see "Configure theWMI
Service for RemoteWindows Monitoring" on page 417.)

SiteScope supports monitoring of remoteWindows servers using SSH. This technology has been tested with
the OpenSSH binaries from Cygwin (available at http://www.cygwin.com/) installed as the SSH server on the
remote server. It has also been tested with the server available from F-Secure. You can also try OpenSSH for
Windows (formerly Network Simplicity "OpenSSH onWindows") which is available on SourceForge
(available at http://sshwindows.sourceforge.net/).

The following is a comparison overview of two of the packages.

OpenSSH
Package Advantages Disadvantage

Cygwin
OpenSSH

1. Provides access to eitherWindows or UNIX-style
scripting on aWindows machine.

2. Provides access to UNIX-style system tools and
utilities.

3. SiteScope can access the remote server both as a
Windows Remote and /or a UNIX Remote.

Complicated setup procedure.

OpenSSH
for
Windows

Simple setup procedure. Only provides access toWindows
commands, scripts, and utilities.

Note:

l OpenSSH forWindows and the Cygwin SSH implementations are incompatible with each other. They
should not be installed on the samemachine.

l If there is more than one version of the Cygwin utilities or more than one SSH server installed on a
machine, theremay be conflicts that prevent the SSH connections from working. An error message
such as "could not find entry point" is an indication of this kind of conflict. If you suspect this error,
search themachine for multiple copies of cygwin1.dll. It may be necessary to remove all versions of
the utilities and then reinstall only a single installation to resolve this problem.

For details on configuring remoteWindows servers for SSH monitoring, see "How to Configure Remote
Windows Servers for SSH monitoring" on page 447.

Monitors Supporting Windows SSH (Agentless or Using the SiteScope Remote
Windows SSH Files)
The following lists themonitors that support agentless Windows SSH, orWindows SSH using the
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SiteScope's remoteWindows SSH files. All themonitors that support Windows SSH using SiteScope's SSH
files are supported in SiteScopes running on UNIX platforms.

Monitor

Supports Windows SSH Using
SiteScope's Remote Windows
SSH Files

Supports Agentless
Windows SSH

Citrix Monitor a a

ColdFusion Server Monitor a a

CPU Monitor a a

Directory Monitor a

Disk SpaceMonitor a a

Dynamic Disk SpaceMonitor a a

Log File Monitor a

Memory Monitor a a

Microsoft Lync Server 2010Monitors a a

Microsoft ASP Server Monitor a a

Microsoft Hyper-V Monitor a a

Microsoft IIS Server Monitor a a

Microsoft SQL Server Monitor a a

Microsoft Windows Event LogMonitor a

Microsoft Windows Media Server
Monitor

a a

Microsoft Windows Performance
Counter Monitor

a

Microsoft Windows Resources
Monitor

a a

Microsoft Windows Services State
Monitor

a

Multi LogMonitor a

Real Media Server Monitor a a

Script Monitor a

ServiceMonitor a
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SSH Guidelines
l There are two different versions of the SSH protocol: version 1 and version 2. Version 1 and version 2 are
different protocols and are not compatible with each other. This means that the SSH clients and SSH
hosts must be configured to use the same protocol version between them to communicate. In many
cases, SSH version 1 (SSH1) is the default version used. Some security vulnerabilities have been found
in SSH version 1. Also, the SSH1 protocol is not being developed anymore and SSH2 is considered the
current standard.

Tip:We recommend using SSH version 2 (SSH2) for all SSH connections.

l If SiteScope is configured to run in FIPS 140-2mode (a U.S. government computer security standard used
to accredit cryptographic module), youmust use SSH2 for all SSH connections. For details, see the
CommonCriteria Certification section in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

l The release version number of the SSH utilities and libraries you have installedmust not be confused with
the version of the SSH protocol that you want to be using. For example, OpenSSH release 3.5 supports
both SSH1 and SSH2 protocols. The release version 3.5 does not mean that the libraries use an SSH
version 3.5 protocol. Youmust configure the OpenSSH software to use either SSH1 or SSH2.

l If you have set up SiteScope remotemonitoring using SSH connections and thenmake configuration
changes or upgrades to the SSH daemon or server software deployed on remote servers in the
environment, it may be necessary to reconfigure the SSH connectivity between themachine on which
SiteScope is running and the remote servers that are beingmonitored.

l Wedo not recommend creatingmore than 1000monitors that use an SSH connection (assuming the
default parameter settings, such as run frequency, number of connections, and so forth, are used). If you
need tomonitor more than 1000monitors using SSH, you should add another SiteScope server.

Tips/Troubleshooting
This section contains troubleshooting and limitations whenmonitoring using SSH.

l "Windows SSH Using the SiteScope remote SSH Files is Not Working" below
l "Unable to Create an SSH ConnectionWhenOpenSSH 6.7 is Used" below
l "Skips inWindows SSH BasedMonitors on Red Hat Linux 5" on the next page
l "Agentless Windows SSH is Not Working" on the next page
l "Agentless SSH Fails to Retrieve Counters" on the next page
l "Error: "resize: unknown character exiting"" on the next page

Windows SSH Using the SiteScope remote SSH Files is Not Working
Check that the prerequisites forWindows SSH monitoring using the SiteScope SSH files have beenmet. For
details, see "Install SiteScope RemoteWindows SSH Files" on page 453.

Unable to Create an SSH Connection When OpenSSH 6.7 is Used
Unable to create an SSH connection between SiteScope and theWindows machine whenOpenSSH 6.7 is
used. This is becauseOpenSSH 6.7 supports another set of key exchange algorithms by default.

Workaround:
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1. OpenC:\cygwin\etc\sshd_config in a text editor and add any one, or all, of the following algorithms to
the end of the file:

diffie-hellman-group1-sha1, diffie-hellman-group1-sha14, diffie-hellman-
group-exchange-sha1

Example:

KexAlgorithms
diffie-hellman-group1-sha1,diffie-hellman-group1-sha14,diffie-hellman-group-exchange-
sha1,curve25519-sha256@libssh.org,ecdh-sha2-nistp256,ecdh-sha2-nistp384,ecdhsha2-
nistp521,diffie-hellman-group-exchange-sha256,diffie-hellman-group14-sha1

2. Restart the sshd service.

Skips in Windows SSH Based Monitors on Red Hat Linux 5
If you encounter skips inWindows SSH basedmonitors running on RedHat Linux 5 platforms, in the
opt/SiteScope/java/lib/security/java.security file, change:

"securerandom.source=file:/ dev/urandom"

to

"securerandom.source=file:///dev/urandom"

Agentless Windows SSH is Not Working
If Windows SSH is working using the SiteScope remoteWindows SSH files, but agentless Windows SSH is
not, perform the following:

l Check that perfmon is working correctly. On the target machine, run the command perfmon and verify
that the required perfmon objects appear. For details on how to rebuild these libraries, refer to
http://support.microsoft.com/?kbid=300956.

l Check that the remotemachine has a working typeperf command (sample command to test) by entering
the following in the command line:

typeperf "\Processor(_Total)\% Processor Time"

For details, refer to http://technet.microsoft.com/en-us/library/cc753182.aspx.

Agentless SSH Fails to Retrieve Counters
In some cases, agentless SSH shows n/a for counters while perfmon gives the value as 0 for the same
counters. This is the behavior for counters that are also not selectable using the perfmon utility. The reason
that SSH using the SiteScope remoteWindows SSH files can get values for these counters is because it
bypasses perfmon and accesses them through the registry.

Error: "resize: unknown character exiting"
If SiteScope fails to create a connection using SSH and the error.log or runMonitor.log contain a server
error message similar to "resize: unknown character exiting", this is probably caused by an invalid bash-
related command. SiteScope supports basic bash environments only. Bash commands are usually found in
the .bashrc file under the user default directory.

Using SiteScope
Chapter 40: Configure RemoteMonitoring Using Secure Shell (SSH)

HPE SiteScope (11.33) Page 445 of 1206

http://support.microsoft.com/?kbid=300956
http://technet.microsoft.com/en-us/library/cc753182.aspx


How to Configure Remote UNIX Servers for SSH
monitoring
SiteScope for Solaris or Linux supports remotemonitoring by using SSH. This task describes the steps
involved in configuring remote UNIX Servers for SSH monitoring with SiteScope.

Note: Setting up the SSH hosts on the remote servers you want to monitor in the UNIX environment can
be very complex and is beyond the scope of this document. Some suggested resources on installation of
the OpenSSH daemon are http://sunfreeware.com/introduction.html (for Solaris) and
http://docs.redhat.com/docs/en-US/Red_Hat_Network_Satellite/5.4/html/Reference_Guide/sect-
Reference_Guide-Monitoring-RHN_Monitoring_Daemon_rhnmd.html#sect-Reference_Guide-RHN_
Monitoring_Daemon_rhnmd-Configuring_SSH (for Red Hat Linux).

1. Prerequisites
The following are requirements for configuring remote UNIX servers for SSH monitoring with SiteScope
in a UNIX environment:
l Secure Shell daemons or servers (sshd) must be installed on each remote server you want to monitor
with SiteScope.

l The SSH daemons on the remote servers must be running and the applicable communication ports
must be open. For example, the default for SSH is port number 22.

l A SSH client must be installed on the server where SiteScope is running. The SiteScope integrated
Java SSH client fills this requirement.

2. Verify SSH connectivity

Verify SSH client-to-server connectivity from themachine where SiteScope is running to the remote
machine you want to monitor. Check SSH connectivity outside of the SiteScope application before
setting up remote server connections using SSH in SiteScope. For example, if SiteScope is running on
Solaris or Linux, use the following command line to request an SSH connection using SSH2 to the server
<remotehost>:

ssh -2 <remotehost>

This normally returns text information that indicates the version of SSH protocol that is being used. Also,
this attempts to authenticate the current user. Use the -l username switch to request a login as a
different user.

3. Configure the integrated java SSH client to connect to the remote servers
After you have set up SSH servers or daemons on remote servers, youmust configure the integrated
Java SSH client that SiteScope uses to connect to the remote servers.
a. Select an authentication option for SSH connections:

o Password authentication. This is the default method for SSH connections in SiteScope.
o Key-based authentication. This adds an additional level of security through the use of a

passphrase and a public-private key authentication. For details on configuring key-based
authentication, see "How to Set Up Key-Based Authentication" on page 454.
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b. If SSH2 connections are required, configure the SiteScope java client to use SSH2 connections by
selecting theSSH version 2 only check box (in Advanced Settings of theMicrosoft
Windows/UNIX Remote Servers dialog box).

4. Configure UNIX remote settings to use the SSH connection method
After you have confirmed SSH connectivity, create or configure UNIX Remote settings in SiteScope to
use SSH as the connectionmethod.
For user interface details, see "New/Edit UNIX Remote Server Dialog Box" on page 422.

How to Configure Remote Windows Servers for SSH
monitoring
This task describes the steps involved in configuring remoteWindows Servers for SSH monitoring with
SiteScope.

1. Install and configure a SSH server
Install and configure a SSH server on each remote server to which you want SiteScope to connect.
There are two software packages generally available that enable SSH capability:
l Cygwin environment available from http://www.cygwin.com/. For task details, see "Install Cygwin
OpenSSH onWindows" on the next page.

l OpenSSH forWindows available at OpenSSH forWindows. For task details, see "Install OpenSSH
forWindows" on page 452.

Note: These setup steps must be performed for each server that runs the SSH daemon or server.

2. Enable Windows SSH monitoring using preinstalled SiteScope SSH files -
optional
Depending on themonitor that you are using, you can choose to use preinstalled SiteScope SSH files or
agentless Windows SSH for monitoring the remote server (for the list of supportedmonitors, see
"Monitors SupportingWindows SSH (Agentless or Using the SiteScope RemoteWindows SSH Files)"
on page 442.
l Using preinstalled SiteScope remote Windows SSH files. To enable SSH monitoring of the
remote server using the preinstalled SSH files, youmust install the SiteScope remoteWindows SSH
files on each remote server to enable commonly used server monitoring functions. For task details,
see "Install SiteScope RemoteWindows SSH Files" on page 453.

l Agentless SSH. If you are using agentless Windows SSH, you do not need to install SiteScope
remoteWindows SSH files on the remoteWindows server.

Tip: If a monitor supports both preinstalled SiteScope SSH files and agentless Windows SSH,
we recommend using agentless Windows SSH.

3. Configure the integrated java SSH client to connect to the remote servers
After you have set up SSH servers or daemons on remote servers, youmust configure the integrated
Java SSH client that SiteScope uses to connect to the remote servers using (in Advanced Settings of
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theMicrosoft Windows/UNIX Remote Servers dialog box).
a. Select an authentication option for SSH connections:

o Password authentication. This is the default method for SSH connections in SiteScope.
o Key-based authentication. This adds an additional level of security through the use of a

passphrase and a public-private key authentication. For details on configuring key-based
authentication, see "How to Set Up Key-Based Authentication" on page 454.

b. If SSH2 connections are required, configure the SiteScope java client to use SSH2 connections by
selecting theSSH version 2 only check box (in Advanced Settings of theMicrosoft
Windows/UNIX Remote Servers dialog box).

4. Configure Windows remote settings to use the SSH connection method
After confirming SSH connectivity between SiteScope and the remote server, set upWindows remote
server settings in SiteScope as follows:
l In Main Settings, select SSH as the connectionmethod. You can then configuremonitors to use the
SSH connectivity.

l To enable SSH monitoring of the remote server using the preinstalled SiteScope SSH files, make
sureSSH using preinstalled SiteScope remote Windows SSH files is selected in the Advanced
Settings panel (this is the default setting).

l Tomonitor using agentless Windows SSH, clear theSSH using preinstalled SiteScope remote
Windows SSH files check box in the Advanced Settings panel.

For user interface details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on page 406.

Install Cygwin OpenSSH on Windows
This task describes the steps involved in installing and configuring a Cygwin OpenSSH server onWindows
servers.

Note:

l This task is part of a higher-level task. For details, see "How to Configure RemoteWindows Servers
for SSH monitoring" on the previous page.

l The following instructions assume that no other Cygwin or other SSH utilities are installed on the
machine and that themachine has Internet access.

l The user login account used to install and run the SSH daemon needs adequate permissions to install
the necessary programs, configure several file options, and control Windows services. It does not
need to be the account that SiteScope uses to connect to the subject server, although that account
must be configured within the Cygwin installation before you canmonitor that server with SiteScope.

Supported versions

Cygwin 1.7.x (the latest certified Cygwin version is 1.7.7)

To install and configure a Cygwin OpenSSH server on Windows servers:

1. Create a new System Environment variable with the following definition: CYGWIN = ntsec tty.
2. Add the string ;C:\cygwin\bin to your PATH variable. Save the changes to the variables.
3. Download the Cygwin setup program into a temporary folder. For example: C:\temp. The setup program
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is used to select, download, and install different packages and components available with Cygwin.
4. Run the downloaded setup program and choose the Install from Internet option when prompted to

Choose A Download Source. Click Next to continue.
5. If prompted, select a root install directory where the Cygwin package should be installed. This is where

the SSH daemon and related files are installed. For example, C:\cygwin. Click Next to continue.
6. If prompted, select a temporary directory where the Cygwin installation files should be stored. For

example, C:\temp. Click Next to continue.
7. If prompted, select an Internet Connection option. Normally, you can useDirect Connection. Click

Next to continue.
8. Select a suitable mirror site from which to retrieve the files using the selection list when prompted. Click

Next to continue.
9. The Setup program queries themirror site for the packages available and displays a hierarchy tree of

package categories. To view and select the packages to download, click on the plus (+) symbol to the
left of the category name to expand any of the package trees. Packages that are selected for download
and installation display a version number in theNew column. If a version number is not displayed for a
particular package, it is not downloaded and installed. Click Skip to the left of package name to select the
package for download.

Note: Many of the development (Devel) and database (Database) tools that may be selected by
default for download are not necessary to run the SSH daemon and can be deselected to reduce
download time and installation space.

Select each of the following packages for download and installation:
l cygrunsrv from the Admin branch

l cygwin-doc from the Doc branch

l pdksh from the Shells branch

l openssh and openssl from the Net branch

l your choice of UNIX-style text editor from the Editors branch (for example: vim or emacs)

Then click to download the files as prompted.
10. Depending on your installation options, the Cygwin setup downloads and installs the selected packages.

Youmay be prompted to choose to have a shortcut to the Cygwin terminal window added to the Desktop
or Program Start menu. Click to continue and complete the installation.

11. After the Cygwin setup is complete, open a Cygwin terminal window by clicking on the Cygwin desktop
shortcut or Program Start menu item.

Note: Depending on the user profile in theWindows system, the default directory that opens in the
terminal window may not be within the root Cygwin installation tree. Use the pwd command to
display the current directory. Typing in the command string cd / normally changes the directory to
the Cygwin root, which by default corresponds to theWindows C:\cygwin directory.

Update the default Cygwin group file with the group names in use on themachine and on your network.
Use themkgroup utility to update the default Cygwin group file with the groups defined on the server and
in your domain. Examples of the commands to use are as follows:

mkgroup -l >> ../etc/group mkgroup -d >> ../etc/group
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Note:

l To have Cygwin recognize both domain and local group accounts, run themkgroup utility twice,
once for local users (-l option) and once for domain users (-d option). Remember to use >>
syntax and not just >, to append entries to the file.

l If you use both the local and domain options, youmust manually edit the /etc/group file (using
the UNIX style text editor you downloaded) to remove any duplicate group entries. Youmay also
want to remove group entries that are not needed for monitoring or should not have access to this
machine.

Update the default Cygwin user (passwd) file with the users defined on the local machine plus any
individual domain users you want to grant access to Cygwin on this machine. Use themkpasswd utility
to update the default Cygwin user file.
Examples of the commands to use are as follows:

mkpasswd -l >> ..\etc\passwd mkpasswd -d -u username >> ..\etc\passwd (domain users)

Note:

l By default, Cygwin is set to run the OpenSSH daemon as the local user called SYSTEM. To have
Cygwin recognize both domain and local machine user accounts, run themkpasswd using the -l
option to add all local users, and run it with the -d and -u options to add individual domain users.
Remember to use >> syntax and not just >, to append entries to the file.

l If you use both the local and domain options, youmust manually edit the /etc/passwd file (using
the UNIX style text editor you downloaded) to remove any duplicate user entries. Youmay also
change the default /home path and default shell for individual users. This may be necessary to
install the RemoteNTSSH package in the /home/sitescopeaccount/ directory of the user
account to be used by SiteScope.

12. Change the active directory to the /bin directory by typing cd /bin.
13. Create a symbolic link in the /bin directory that points to theWindows Command (CMD) shell by

entering the following command line (be sure to include the trailing space and period):

ln -s /cygdrive/c/winnt/system32/cmd.exe .

14. We recommend that you change permissions and ownership of several Cygwin files and directories.
Also create a log file for the SSH daemon. Enter the following command lines in the Cygwin terminal
command line and press ENTER after each command line entered:

cd /
chmod -R og-w .
chmod og+w /tmp
touch /var/log/sshd.log

Note:

l Exact syntax is required, including spaces.

l Inconsistent and incorrectly assigned file and directory permissions can be one reason that the
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SSH daemon can not be started or that SiteScope is unable to connect to and run commands or
scripts on the remote server.

15. Configure the SSH daemon to run as aWindows service by entering the following command:

ssh-host-config -y

When presented with the CYGWIN= prompt, type ntsec tty to match the environment variable you set at
the beginning of this procedure. Normally, this configures the SSH daemon or service to restart
automatically if the server needs to be restarted.

16. Configure the encryption keys and files for the SSH daemon using the following command:

ssh-user-config -y.

Enter required passphrases for several keystore files when prompted. The program asks you to re-enter
the passphrase for confirmation.

17. Youmust change the ownership of several files and folders for use by the SSH daemon. The program
does not normally run if the permissions on these files enable them to be changed or run by group or
"world" level users. Enter the following command strings to restrict access to these files:

chown SYSTEM:Users /var/log/sshd.log /var/empty /etc/ssh_h*
chmod 755 /var/empty

18. Check the installation by starting and then stopping the CYGWIN sshd service using thePrograms >
Administrative Tools > Services panel.

Note: Cygwin includes a server utility to start the SSH daemon. However, there have been a
number of situations where this method failed to start the server, whereas using theWindows
Services panel was able to start the server.

19. Configure the default shell or command environment for the user account you use for monitoring with
SiteScope. The shell you select effects what types of scripts or commands can be run remotely using
the SSH connection. Use the UNIX-style text editor and edit the /etc/passwd file. Find the entry for the
SiteScope login account you intend to use and change the shell from /bin/bash to the shell you want to
use as described below. This is normally the last entry in the line for that account entry.
l If you chose to have SiteScope interact with the remote server using theWindows Command shell,
change the default shell entry to /bin/cmd.Use this option when you plan to useWindows-style batch
files and scripts Youmust also include the symbolic link to theWindows cmd.exe kernel in the /bin
directory as described in a previous step of this procedure.

l If you chose to have SiteScope interact with the remoteWindows server using a Cygwin UNIX shell,
change the default shell entry to be /bin/pdksh. The SiteScope SSH client may not accurately parse
Cygwin's default bash shell. Youmust also configure a Remote UNIX server connection to this
(Windows) server that connects to the Cygwin SSH daemon.

Save the changes to the file.

20. Edit the PATH and the default prompt commands in the /etc/profile file to make sure that Cygwin can
find certain files and that SiteScope can parse the output from the remote shell. Use the UNIX-style text
editor and edit the /etc/profile file. Find the PATH definition entry near the top of the file. For example:

PATH=/usr/local/bin:/usr/bin:/bin:$PATH

Change this to include the following:
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PATH=.:/usr/local/bin:/usr/bin:/bin:$PATH

21. To change the default prompt commands, edit the /etc/profile file, and find the section similar to the
following:

;;
sh | -sh | */sh |\
sh.exe | -sh.exe | */sh.exe )
#Set a simple prompt
PS1='$ '
;;

Immediately under this entry, add the following:

;;
pdksh | -pdksh | */pdksh |\
pdksh.exe | -pdksh.exe | */pdksh.exe )
#Set a simple prompt
PS1='> '
;;

22. Save the changes to the file.
23. Change the active directory to the home directory of the user you have created for SiteScopemonitoring.

After making these changes and starting the SSH daemon, you should be able to connect to the server
using an SSH client.

Note: Any time you run the mkpasswd -l /etc/passwd command (for example, when adding a new
user), edit the /etc/passwd file again tomake sure that the default shell for that user is set to the
required value for any account being used by SiteScope.

Install OpenSSH for Windows
This task describes the steps involved in installing and configuring anOpenSSH server onWindows servers.

TheOpenSSH forWindows package is an alternative to the Cygwin SSH package and can be easier to
install. Likemost products, the Cygwin product and the Open SSH forWindows are subject to change. There
are cases where some versions of the Cygwin SSH server have not returned the data needed for SiteScope
monitoring. If the OpenSSH forWindows package can solve this problem, use this package in place of the
Cygwin package.

Note: This task is part of a higher-level task. For details, see "How to Configure RemoteWindows
Servers for SSH monitoring" on page 447.

How to install and configure an OpenSSH for Windows server on
Windows servers:
1. Download and install the OpenSSH forWindows package.
2. Open a command prompt and change to the installation directory (C:\Program Files\OpenSSH is the

default installation path).
3. Change the active directory to the OpenSSH\bin directory.
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4. Youmust update the default group file with the group names in use on themachine and in your network.
Use the mkgroup utility to update the default OpenSSH group file with the groups defined on the server
and in your domain. Examples of the commands to use are as follows:

mkgroup -l >> ..\etc\group mkgroup -d >> ..\etc\group

Note:

l To haveOpenSSH recognize both domain and local group accounts, run themkgroup utility
twice, once for local users (-l option) and once for domain users (-d option). Remember to use
>> syntax and not just >, to append entries to the file.

l If you use both the local and domain options, youmust manually edit the /etc/group file (using
the UNIX style text editor you downloaded) to remove any duplicate group entries. Youmay also
want to remove group entries that are not needed or should not have access to this machine.

5. Youmust update the default OpenSSH user (passwd) file with the users defined on the local machine
plus any domain user you want to grant access to the SSH server on this machine. Use themkpasswd
utility to update the default user file. Examples of the commands to use are as follows:

mkpasswd -l >> ..\etc\passwd
mkpasswd -d -u username >> ..\etc\passwd

Note:

l To haveOpenSSH recognize both domain and local machine user accounts, run themkpasswd
utility using the -l option to add all local users and run it with the -d and -u options to add
individual domain users. Remember to use >> syntax and not just >, to append entries to the file.

l If you use both the local and domain options, youmust manually edit the /etc/passwd file (using
the UNIX style text editor you downloaded) to remove any duplicate user entries. Youmay also
change the default /home path and shell for individual users (see instructions below).

6. Check the installation by starting theOpenSSH Server service using thePrograms > Administrative
Tools > Services panel.

Install SiteScope Remote Windows SSH Files
This task describes the steps involved in installing SiteScope remoteWindows files on each remoteWindows
server according to the SSH package you are working with.

Note:

l This task is part of a higher-level task. For details, "How to Configure RemoteWindows Servers for
SSH monitoring" on page 447.

l SiteScope remoteWindows files do not need to be installed on remoteWindows server monitors that
support agentless SSH. For a list of monitors that support agentless SSH, see "Monitors Supporting
Windows SSH (Agentless or Using the SiteScope RemoteWindows SSH Files)" on page 442.

How to Install the SiteScope SSH Files on Cygwin Installations
1. Verify that a \sitescope_login_account_name directory exists within the <install_
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drive>:\cygwin\home directory on eachmachine that is monitored by SiteScope using SSH. Replace
sitescope_login_account_namewith the user account name you use to connect to themachine using
the SSH server.

2. One of the advantages of using SSH onWindows is that it enables SiteScope to run scripts on the
remote server running the SSH daemon. To be able to use the Script Monitor to run remote scripts, create
a scripts subdirectory in the /home/sitescope_login_account_name directory. Scripts you create for
execution by the SiteScope Script Monitor must be placed inside this directory.

3. On themachine where SiteScope is installed, find the file calledRemoteNTSSH.zip in the
<SiteScope root directory>\tools directory.

Note: All .exe and .dll files inRemoteNTSSH.zip should have executable permissions. Use the
command chmod +x * to grant executable permissions to the relevant files.

4. Copy this file to the <install_drive>:\cygwin\home\sitescope_login_account_name directory on each
of the remoteWindows servers where you have installed the SSH server or daemon software.

5. Unzip theRemoteNTSSH.zip file on the remote server. Place the contents of the zip file into the
<install_drive>:\cygwin\home\sitescope_login_account_name directory. This should create a
<install_drive>:\cygwin\home\sitescope_login_account_name\scripts subfolder. You use this
subfolder to hold scripts that can be run by the SiteScope Script Monitor.

Note: If theRemoteNTSSH.zip file is from a version of SiteScope earlier than 11.10, youmust
reinstall the zip file from <SiteScope 11.10 root>\tools directory on all monitored remote servers.

6. Start the CYGWIN sshd service on the remote server.

How to Install the SiteScope SSH Files on OpenSSH for Windows Installations
1. On themachine where SiteScope is installed, find the file calledRemoteNTSSH.zip in the

<SiteScope root directory>\tools directory.
2. Copy this file to the user home directory where the user is automatically directed after logging on to the

machine using the SSH server that was previously installed. This is the directory on each of the remote
Windows servers where you have installed the SSH server or daemon software.

3. Unzip theRemoteNTSSH.zip file on the remote server into the user home directory. This should create
a <user home directory>\scripts subfolder. You use this subfolder to hold scripts that can be run by the
SiteScope Script Monitor.

Note: If theRemoteNTSSH.zip file is from a version of SiteScope earlier than 11.10, youmust
reinstall the zip file from <SiteScope root directory>\tools directory on all monitored remote
servers.

4. Start the OpenSSH server service on the remote server.

How to Set Up Key-Based Authentication
This task describes the steps involved in setting up key-based authentication for SSH remote servers. You
can copy a SiteScope SSH key to the remote server, or take the remote server key from a remote server and
copy it to SiteScope.

To use Key-Based Authentication for SSH remote servers, youmust first create a pair of public/private keys.
The public key resides on the remote and the private key is kept on the SiteScopemachine. Both Cygwin
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OpenSSH andOpenSSH forWindows comewith a key generation tool called ssh-keygen. The ssh-keygen
tool enables you to create both protocol version 1 and version 2 keys.

Tip: It is recommended tomaintain one key file on the SiteScope server and copy it to the remote servers
instead of generate a file for eachmachine and copy them to the SiteScopemachine.

Creating a Key on a SiteScope Windows Server
To create a public or private key pair on a SiteScope Windows server:

1. Open a commandwindow on the SiteScope server, and run the following command to launchMindTerm:

<SiteScoperoot directory>\java\bin\java -jar c:\<SiteScope root directory>\
WEB-INF\lib\mindterm.jar

2. In MindTerm, select File > Create Keypair > DSA (or RSA). Also select OpenSSH .pub format.
Note: Select theMindTerm key length as 1024 or higher.

3. The key pair is written to the <USER_HOME>\mindterm directory.
4. Copy the private key (file not ending in *.pub) to the <SiteScope root directory>\groups directory.
5. Copy the identity.pub file to the <USER_HOME>/.ssh directory on the remotemachine and rename it

authorized_keys (or authorized_keys2 for SSH2). You also can add content of identity.pub to existing
authorized_keys/authorized_keys2 file if you want to allow a number of different users to connect to
the server with different keys files.

6. On the remotemachine, run the command chmod 744 authorized_keys in the <USER_HOME>/.ssh
directory, andmake sure that User has read, write, and execute permissions, and that Group and Other
have read permissions on the authorized_keys file.

7. Create a remote connection in SiteScope for the remote server using key file authentication and Internal
Java Libraries.
The public key goes in the <USER_HOME>/.ssh/authorized_keys file on the remotemachines.
The private key file can be put into the <SiteScope root directory>\groups directory, and renamed
identity, which enables SiteScope to automatically take it without having to specify the file path in
Advanced Settings of the remote server. Alternatively, you can put the private key in any other
SiteScope directory, or outside of SiteScope.
The key generated fromMindTerm is inOpenssh format.

Note: Youmust verify that the server key and theMindTerm key are at the same level. For example,
if the server key is 768 bit and theMindTerm key is 1024 bit, the authentication procedure fails.

8. In SiteScope, create a new Windows remote server with the following in theMain Settings:
l User name.. This must be the name of a user that you want to connect to the remote server.

l Password.The passwordmust be left blank. It is taken automatically from the remote server.

l Method. SSH.

9. Set the Advanced Settings as follows.
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10. Test the remote server connection.

Creating a Key on a UNIX Remote Server and Copying it to the SiteScope Server
To find out what your server is using:

1. Stop the sshd service on the remote server. On a RedHat Linux server, run the command:
/etc/rc.d/init.d/sshd stop

2. Start the sshd service in debugmode on the remote server. On a RedHat Linux server, run the
command:

/usr/sbin/sshd -d

You should see output similar to Generating 1024 bit RSA key.

Note:When using theKey File for SSH connections box in SiteScope, if there is a trailing space
after the information entered, this causes an "unknown error (-1)" failure. Remove the trailing space
to fix the problem.

To convert the openSSH key to SEC SSH format:

1. Create a RSA key inMindTerm (which is an openSSH key pair).
2. Run the following command on the remote server to convert the openSSH key to SEC SSH format:

ssh-kegen -e -f <public key>

3. Leave the private key on the SiteScope server in the openSSH format.

Note:When using Key-Based authentication, the Key File suppliedmust be a version 2 private key.

To set up a connection by taking the remote machine key and put it into SiteScope:

1. Log on to your UNIX remote server as a user with root permissions.
2. To generate a public/private RSA key pair for protocol version 1, run the following command:

$> ssh-keygen -t rsa

If you want to generate key pair for version 2, run the command:

$> ssh-keygen -t dsa

The possible output is:
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Enter file in which to save the key (~/.ssh/id_rsa):
Enter passphrase* (empty for no passphrase):
Enter same passphrase again:

where the passphrase is the password used to decode your private key file; it can be left blank.

Your identification is saved in ~/.ssh/id_rsa and the public key in ~/.ssh/id_rsa.pub (protocol
version 1); or ~/.ssh/id_dsa and ~/.ssh/id_dsa.pub for protocol version 2.

3. The corresponding public key must be listed in the authorized file on the remote host. Add the content of
generated public key to this file (the default authorized_keys file location is the ~/.ssh directory).
To do this run the commands:

$> chmod 700 .ssh
$> cd .ssh
$> touch authorized_keys (for ver. 2: touch authorized_keys2)
$> chmod 600 authorized_keys (for ver. 2: chmod 600 authorized_keys2)
$> cat id_rsa.pub >> authorized_keys (for ver. 2: cat id_dsa.pub >> authorized_keys2)
$> rm id_rsa.pub (for ver. 2: rm id_dsa.pub)

4. Copy the identification file, private key, to the SiteScopemachine.
5. In SiteScope, create a new UNIX remote server with the followingMain Settings:

l User name. This must be the name of a user that you want to connect to the remote server.

l Password. The passwordmust be left blank. It is taken automatically from the remote server.

l Method. SSH.

6. Set the Advanced Settings as follows:

7. Test the remote server connection.
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Chapter 41: Remote Servers Properties Page
This page displays information about the remote servers configured in your network environment. Use this
page to add, edit, or delete remote server profiles.

To access Select theRemote Servers context. In the remote servers tree, click theMicrosoft
Windows Remote Servers orUNIX Remote Servers container.

Important
information

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete remote
servers permissions can view or edit the Remote Servers page. For details on user
permissions, see "User Management Preferences" on page 625.

l You cannot delete a server from the list of remote servers if the server is referenced by a
monitor. Select a different server in theServer box of theMonitor Settings panel for each
monitor that references the remote server, and then delete the remote server from the
remote server list.

l You can createmultiple remote servers for the same host machine.

Relevant
tasks

l "How to Configure SiteScope toMonitor a RemoteMicrosoft Windows Server" on
page 402

l "How to Configure SiteScope toMonitor a Remote UNIX Server" on page 420

See also "Remote Server Tree" on page 36

User interface elements are described below:

UI Element Description

New Microsoft Windows/UNIX Remote Server. Opens the New Microsoft
Windows/UNIX Remote Server dialog box enabling you to configure a remote server and
add it to the tree. For details, see "New/Edit Microsoft Windows Remote Server Dialog Box"
on page 406 or "New/Edit UNIX Remote Server Dialog Box" on page 422.

Edit Remote Server. Enables you to edit the properties of the selected remote server.

Delete Remote Server. Deletes the selected server from the tree.

Test. Tests the connection to one or multiple servers.

l When testing the connection to a single remote server, the test results are displayed in a
popup window.

l When testing the connection for multiple remote servers, the test is performed in the
background so you can continue to use SiteScope. The test results are displayed in
Server Statistics > Log Files > Other Logs in the remotes_multi_test.log.

Detailed Test. Runs a test that displays the result of running commands on UNIX remote
servers. This enables checking the permissions for the defined user.

Select All. Selects all listed remote servers.
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UI Element Description

Clear Selection. Clears the selection.

<Remote
servers
list>

Lists the remote servers that have been configured in SiteScope. Double-click a remote
server to open the Edit Remote Server page for the selected remote server type.

Name Name by which the remote server is known in SiteScope.

Server IP address or name of themonitored remote server. You can create two remote servers with
the same host name.

Status Connection status of the remote server. If SiteScope is unable to connect to the remote
server, a reason for the connection failure is provided.

Last Test The date and time that the remote server connection was last tested.

Operating
System

Operating system that is running on the remote server.

Method Connection type for monitoring the server resources (NetBIOS, WMI, and SSH for
Windows; Rlogin, Telnet, and SSH for UNIX).

Description Description of the remote server that was assigned when creating or editing the remote
server.

Associated
Monitors

Number of monitors used by each remote server. This enables sorting the table by the
number of monitors used by each remote server, and removal of unused remote servers
(those with 0 associatedmonitors can subsequently be deleted).
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Part 7: Preferences
The Preferences menu represents the preference types that enable you to configure specific properties and
settings related tomost of the administrative tasks available within SiteScope.

You can configure the following preference types within SiteScope:

l "Certificate Management" on page 461
l "Common Event Mappings" on page 465
l "Credential Preferences" on page 476
l "Email Preferences" on page 482
l "Event Console Preferences" on page 487
l "Failover Preferences" on page 491
l "General Preferences" on page 500
l "HTTP Preferences" on page 511
l "Infrastructure Preferences" on page 517
l "Integration Preferences" on page 563
l "Log Preferences" on page 597
l "Pager Preferences (Deprecated)" on page 603
l "Schedule Preferences" on page 608
l "Search/Filter Tags" on page 614
l "SNMP Preferences" on page 618
l "User Management Preferences" on page 625
Other sections related to preferences:

l "Internationalization in SiteScope" on page 651
l "Authentication Strategies" on page 656



Chapter 42: Certificate Management
Whenmonitoring a remote server, if the target server uses a self-signed certificate, the certificate must be
added to a trusted keystore. If you aremonitoring a URL, aWebSphere Application Server, or a VMware-
based server using a secure connection, you canmanage self-signed certificates from the Certificate
Management page.

Note: You can still import certificates using the keytool method if preferred. For details onmanually
importing certificates, see the documentation for the specific monitor type.

To access
Select Preferences > Certificate Management.

l To view certificate details, double-click a certificate (opens the Certificate Details dialog box).
l To add certificates, click the Import Certificates button (opens the Import Certificates dialog box).

Note: To view the Certificate Management page, youmust be an administrator in SiteScope, or a user
grantedView certificates list permissions. Edit certificates list permissions are required tomanage
certificates using the Certificate Management page. For details on this topic, see "User Management
Preferences" on page 625.

Learn About
Benefits of Certificate Management
l Certificates do not need to bemanaged using the standard JVM tools (keytool). This avoids the
requirement for a desktop/shell session to the SiteScopemachine.

l Provides visual keystoremanagement (add and remove certificates) and enables dynamic keystore
reload, without having to restart SiteScope after each certificate change operation.

l Monitors are bound to the keystores that they are using. For URL, WebSphere Application Server, and
VMwaremonitors, the following keystore is used:
<SiteScope root directory>\java\lib\security\cacerts. Other keystores are ignored.

l If you use a self-generated Certificate Authority (CA) certificate to sign all the server certificates, you only
need to import the CA certificate once.

Tasks
How to Import Server Certificates Using Certificate Management
This task describes the steps involved in importing self-signed certificates using Certificate Management.

1. Prerequisites
l Certificate Management can be used to import server certificates that are required when configuring
secure connections for the SiteScopeURL, WebSphere Application, and VMwaremonitors.
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l Only a SiteScope administrator user, or a user withView/Edit certificates list permissions, can
view, add, or make changes to the certificates keystore on the Certificate Management page. For
details on user permissions, see "Permissions" on page 636.

2. Import the server certificate

If theWeb server on which you aremonitoring has an https:// prefix, it is a secure, encrypted
connection, and you need to import the server certificate.

a. Select Preferences > Certificate Management, and click the Import Certificates button.
Select File orHost, and enter the details of the source server. For user interface details, see "Import
Certificates Dialog Box" on the next page.

b. From the Loaded Certificates table, select the server certificates to import and click Import. The
imported certificates are listed on the Certificate Management page. For user interface details, see
"Certificate Management Page" below.

3. Configure themonitor properties
After importing the required server certificates, you can create amonitor with a secured connection.

UI Descriptions
This section includes:

l "Certificate Management Page" below
l "Import Certificates Dialog Box" on the next page
l "Certificate Details Dialog Box" on page 464

Certificate Management Page
This page is used for managing certificates used with SiteScope URL, WebSphere Application, and VMware
monitors. The Certificate Management page enables you to add, remove, and refresh keystore contents.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Import Certificates. Opens the Import Certificates dialog box and add certificates to the
Certificate Management keystore list. For user interface details, see "Import Certificates
Dialog Box" on the next page.

Remove Certificates. Deletes the selected certificates from the Certificate Management
keystore list.

ReloadCertificate List. Reloads the keystore certificates from the <SiteScope root
directory>\java\lib\security\cacerts files on the remote server. This enables you to
manually reload keystore changes without having to restart SiteScope.

Select All. Selects all listed certificates.

Clear Selection. Clears the selection.
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UI Element Description

<certificates> Lists the server certificates that have been imported. Double-click a certificate to open the
Certificate Details dialog box and display the certificate's properties and values. For user
interface details, see "Certificate Details Dialog Box" on the next page.

Alias Certificate alias name.

Note:Alias names of imported certificates cannot bemodified (they can bemodified only
during the import certificate step).

Issuer Name of the certificate issuer.

Valid Until Time and date until which the certificate is valid.

Version Certificate version number.

Import Certificates Dialog Box
This dialog box is used for adding certificates to the Certificate Management list keystore. You can change
the sort order in the columns by clicking the arrow in the column title. A small down or up arrow is displayed
indicating the column is sorted in ascending or descending order.

User interface elements are described below:

UI
Element Description

Source Selection

Host Select this option to add certificates from a host server. Enter the real IP address or host name
of themonitored server.

Port Port number of the host machine (available only if theHost option is selected).

Default Port value: 443

Load Loads certificates for themachine specified in theHost field. The certificates are displayed in
the Loaded Certificates table.

File Select this option to add certificates from a file.

Select Use to navigate to the file from which you want to import certificates, and click Open. Add the
required certificates to the Certificate Management list.

Loaded Certificates

Select All. Selects all listed certificates.

Clear Selection. Clears the selection.
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UI
Element Description

Alias Certificate alias name. You canmodify a certificate alias during the import certificate step by
entering a new alias in theAlias column.

Note:An alias name cannot bemodified after the certificate has been imported.

Issuer Name of the certificate issuer.

Valid
Until

Time and date until which the certificate is valid.

Version Certificate version number.

Import Select the certificates to import from the Loaded Certificates table, and click Import. The
imported certificates are displayed in the Certificate Management page.

Certificate Details Dialog Box
This dialog box displays properties and values for the selected server certificate. Double-click a certificate in
the Certificate Management page to open this dialog box.

User interface elements are described below:

UI Element Description

Alias Certificate alias name.

Certificate Properties

Fingerprint The certificate's fingerprint.

Type The certificate type.

Version Version number of the certificate.

Issuer principal Name of the certificate issuer.

Serial number Serial number of the certificate.

Signature algorithm name Name of the signature algorithm of the certificate.

Valid from Time and date from which the certificate is valid.

Valid until Time and date until which the certificate is valid.
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Chapter 43: Common Event Mappings
This page is used to define event mappings and settings. It enables you to configuremappings between
SiteScope runtime data and the attribute values of the event to be sent. Common event mappings are used
when configuring the Operations Manager event integration, the Generic Event integration, and the SiteScope
Event Console.

To access

Select Preferences > Common Event Mappings, and click theNew Event Mapping button, or select

an existing event and click theEdit Event Mapping button.

You can also access the New/Edit Event Mappings dialog box when:

l Configuring alerts from theAlerts tab, New/Edit Alert > HP Operations Manager Integration Settings
> Event mapping.

l Configuring amonitor instance frommonitorProperties tab, Event Mapping Settings, provided the
Operations Agent is installed and connected to an HPOM or APM server, and Event Integration is enabled
in the HP Operations Manager Integration dialog box, or Generic Event Integration is configured in
Integration Preferences.

l Configuring an Event Console alert action from theAlerts tab, New/Edit Alert > Alert Actions > Event
Console > Event Mapping.

Note: Youmust be an administrator in SiteScope, or a user grantedView common event mappings
permissions to be able to view Common Event Mappings. Add, edit or delete common event
mappings permissions are required to create or edit Common Event Mappings. For details on this topic,
see "User Management Preferences" on page 625.

Learn About
Common Event Mappings Overview
You can configure SiteScope to send events directly to Operations Manager (HPOM) or to Operations
Management in APM. You do this by using Common Event Mappings to create event mapping instances
between SiteScope runtime data and the event attribute values that are sent to the HPOM or APMGateway
Server. Common event mappings are also used for sending events to the SiteScope Event Console, and
when configuring the Generic Event integration for sending events to other management consoles.

When the event trigger condition is met, the event template is used tomap the SiteScope runtime data to the
event attributes. These attributes have values that are passed to the event subsystem to create the
corresponding event (for example, the template translates the runtime data into an event in HPOM or APM).
The event is then sent to HPOM, APM, or the specifiedmanagement console.

You can do this by using the default event mapping associated with themonitor or alert, select a different
event mapping (if any exist), or create a new event mapping in Common Event Mappings. Alternatively, for
alerts, you can use the event mapping template associated with themonitor that triggered the alert. For details
on creating event mappings for an event in HPOM or APM, see "How to Configure Common Event Mappings
for HPOM or APM" on the next page.
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SiteScope contains the HP CDA Event Mapping template, an out-of-the-box template that is specially
configured for CDA (Continuous Delivery Automation). CDA is a policy-based platform that provides
infrastructure provisioning in hybrid cloud environments. CDA integrates with SiteScope to deploy SiteScope
monitors and receive events from them. Monitoring status based on the events received is available in the
CDA user interface. For more details on CDA, refer to the CDA documentation.

For details on configuring SiteScope to report events directly to the Operations Manager server, see "How to
Enable SiteScope to Send Events to HPOM or Operations Management" in Integrating SiteScope with HP
Operations Manager Products in the SiteScope Help. You can check the HPE Software Integrations site for
the latest version of this guide.

For details on creating event mappings to report events to amanagement console using the Generic Event
integration, see "How to Configure SiteScopeGeneric Event Integration" on page 589.

For details on how to configure event mappings for the SiteScope Event Console, see "Event Console" on
page 914.

For details on event mapping attribute properties, see "Properties Available in Alerts, Templates, and Events"
on page 1126.

Tip: It is recommended to disable any existing event integrations and to configure new integrations when
upgrading from versions of SiteScope earlier than 11.00 and versions of APM earlier than 9.00. Although
integrations work after an upgrade, events are used only in the APM Event Browser.

Tasks
How to Configure Common Event Mappings for HPOM or APM
This task describes how to use Common Event Mappings to configure event mappings for monitors and
alerts. This is themapping between SiteScope run time data and the values of event attributes that will be
sent.

1. Prerequisites
l To create or make changes to event mappings, youmust be an administrator in SiteScope, or a user
grantedAdd, edit or delete common event mappings permissions. For details on user
permissions, see "User Management Preferences" on page 625.

l To select an event mapping when configuring an alert or amonitor instance, the Operations Agent
must be installed and connected to an HPOM or APM server, and event integrationmust be enabled
in the HP Operations Manager Integration dialog box (Preferences > Integration Preferences >
HP Operations Manager Integration). For task details, see "How to Enable SiteScope to Send
Events to HPOM or Operations Management" in Integrating SiteScope with HP Operations Manager
Products in the SiteScope Help. You can check the HPE Software Integrations site for the latest
version of this guide.

2. Configure the alerts or monitor instances
You configure the alerts or monitor instances that, where triggered, create the relevant events in the
event system.
For task details on creating SiteScope alerts, see "Configure SiteScope Alerts" on page 1072.
For task details on creatingmonitor instances, see "How to Create and Deploy aMonitor" on page 226.
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For task details on configuring Event Console alert actions, see "How to Configure andManage the
Event Console (SiteScope Administrator)" on page 919.

3. Configure the event mappings for an alert, Event Console, or monitor instance
You configure an event mapping tomap an alert or monitor instance to the corresponding event
attributes. You can create several mappings for each type of alert or monitor.
l You configure alerts from theAlerts tab > New/Edit Alert > HP Operations Manager Integration
Settings > Event mapping.

l You configure amonitor instance frommonitorProperties tab > Event Mapping Settings.

l You configure an Event Console alert action from theAlerts tab, New/Edit Alert > Alert Actions
> Event Console > Event Mapping.

For each alert, or monitor instance, you can select an existing event mapping, or create a new event
mapping in Common Event Mappings. For user interface details, see "New/Edit Event Mappings Dialog
Box - General Tab" on page 469 and "New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on
page 473.

Note:

l The event mapping settings are only available when SiteScope is integrated with HPOM and
event integration is enabled (Enable sending events is selected in the HP Operations Manager
IntegrationMain Settings panel of the HP Operations Manager Integration dialog box), or when a
Generic Event Integration is configured in Integration Preferences.

l You cannot delete a common event mapping if it is referenced by amonitor or an alert action. You
must change the event mapping referenced by themonitor or alert before you can delete the
mapping.

4. Results
You can view the events corresponding to the triggered alerts or changes in amonitor's metric status in
the HPOMConsole, or in Operations Management in APM (if you have an Event Management
Foundation license). If Operations Management is not part of your APM installation, you can view events
that affect CI status using a health indicator in Service Health.
You can see events corresponding to triggered Event Console alerts in the SiteScope Event Console.
For details, see "Event Console" on page 914.

How to Configure Event Mappings for the SiteScope Event Console
For details on how to configure event mappings for the SiteScope Event Console, see "Event Console" on
page 914.

Related Task: "How to Configure SiteScopeGeneric Event Integration" on page 589

UI Descriptions
This section includes:

l "Common Event Mappings Page" on the next page
l "New/Edit Event Mappings Dialog Box - General Tab" on page 469
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l "New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page 473

Common Event Mappings Page
User interface elements are described below:

UI Element Description

New Event Mapping. Creates a new event mapping. For user interface details, see
"New/Edit Event Mappings Dialog Box - General Tab" on the next page and "New/Edit
Event Mappings Dialog Box - Custom Attributes Tab" on page 473.

Edit Event Mapping. Enables editing the event mapping. For user interface details, see
"New/Edit Event Mappings Dialog Box - General Tab" on the next page and "New/Edit
Event Mappings Dialog Box - Custom Attributes Tab" on page 473.

Delete Event Mapping. Deletes the selected event mapping from Common Event Mapping
list.

Select All. Selects all listed events.

Clear Selection. Clears the selection.

Default
Settings

Click the arrow next toDefault Settings, and select an option:

l Edit Default Monitor Event Mapping. Opens the Edit Event Mapping dialog box which
enables you to change the default monitor event mappings settings.

l Edit Default Alert Event Mapping. Opens the Edit Event Mapping dialog box which
enables you to change the default alert event mappings settings.

l Edit Default Console Event Mapping. Opens the Edit Event Mapping dialog box which
enables you to change the default event mapping settings for the SiteScope Event
Console.

For user interface details, see "New/Edit Event Mappings Dialog Box - General Tab" on the
next page and "New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page 473.

Title Title string assigned to the setting profile when you create a new event.

The HP CDA Event Mapping template is included by default in the Common Event
Mappings. This template is used by CDA (Continuous Delivery Automation). For details,
see "Common Event Mappings Overview" on page 465.

Description Description of themapping that was assigned when creating or editing the event.

Using SiteScope
Chapter 43: Common Event Mappings

HPE SiteScope (11.33) Page 468 of 1206



New/Edit Event Mappings Dialog Box - General Tab
This dialog box enables you to create new common event mappings or edit existingmappings between
SiteScope runtime data and the attribute values that are used for sending events. Thesemappings are used
when configuring the Operations Manager event integration, the Generic Event integration, and the SiteScope
Event Console.

User interface elements are described below:

UI Element Description

Main Settings

Name The name used to identify the common event.

Description Description of the common event.

Common Event Model Settings

General

Title Descriptive text describing the occurrence represented by the event. This should include
information about what threshold has been crossed (or other trigger conditions), and the
current values.

Default value:

l Formetric status change: Metric '<<metric>>' changed status from '<<oldStatus>>' to
'<<newStatus>>'

l For alerts: Alert '<<alertName>>' was fired onmonitor '<<fullMonitorName>>' status
change

l For console events: Console Event was triggered due to alert '<<alertName>>' being
fired onmonitor '<<fullMonitorName>>'

Tip:Since the text is typically shownwithin a single line in the event browser, it is
recommended to put themost relevant information at the beginning.

Description Additional information describing the event.

Default value:

l Formetric status change: Metric '<<metric>>' crossed '<<thresholdCrossed>>' with
value '<<metricValue>>'

l For alerts: Monitor '<<fullMonitorName>>' changed status from '<<oldStatus>>' to
'<<newStatus>>'

l For console events: Monitor '<<fullMonitorName>>' changed status from
'<<oldStatus>>' to '<<newStatus>>'

Tip:When configuring console event mappings and using Predictive Analytics, we
recommend adding the <alertShortAnalyticsResults> attribute to the description to provide
a correlation that shows themonitor status of the 5 highest counters of the Analytics Target
monitors. This property is supported for alert events (monitor status change only) in the
SiteScope Event Console andOMi. It is not supported in Generic Event Integration or for
metrics status changes events (monitor events).
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UI Element Description

Main Settings

Severity Severity of the occurrence related to the event. The severity level can be Unknown,
Normal, Warning, Minor, Major, or Critical.

Default value: <<severity>>.

l Formetric status change and alerts: It is taken from the severity mapping in the HP
Operations Manager Integration Advanced Settings panel (inPreferences >
Integration Preferences > HP Operations Manager Integration).

l For console events: It is taken from the severity mapping in Event Console
Preferences. For details, see "Severity Mapping Preferences Dialog Box" on page 489.

Category Value used for organizing or grouping events by monitor type.

Default value: <<monitorType>>

Examples:Database, Application, J2EE

Subcategory Value used for organizing or grouping events that have the same category.

Default value:

l Formetric status change: <<metric>>
l For alerts: <<fullMonitorName>>
l For console events: <<fullMonitorName>>
Example:Oracle

Using SiteScope
Chapter 43: Common Event Mappings

HPE SiteScope (11.33) Page 470 of 1206



UI Element Description

Main Settings

Log only l If False is selected, events are not written to the Event History view or to the event
history log file.

l If True is selected, enables submitting an event that goes directly into the history event
browser in HPOM/OMi, or into the Event History view in the SiteScope Event Console,
as a closed event. Such an event goes through the complete event processing, but has
its Life Cycle State set to closed from the beginning. These events are not displayed in
the HPOM/OMi history event browser/SiteScope Event Console.
Typical examples are events that result in resetting an indicator to a normal or good
state, or an event signaling that a previous problem no longer exists (where the problem
was reported in another event).

l If True for normal severity is selected, all messages forwarded from SiteScope to
HPOM/SiteScope Event Console/external applications are sent to theAcknowledged
message browser/console (instead of theActivemessage browser) if their severity is
normal. This prevents theActivemessage browser becoming unnecessarily cluttered
with normal severity messages.

Default value:

l Formetric status change: False
l For alerts: False
l For console events: True for normal severity (this means that events triggered for a
monitor in normal severity (fired when themonitor status changes to Good), are sent or
written directly to history as closed events (they are available in the history log and
Event History view).

Event Type
Indicator

Link between the event and the indicator so that information about the indicator can be
updated as a result of submitting the event.

Default value:

l Formetric status change: <<etiType>>:<<etiValue>>:<<metricValue>>
l For alerts: <<etiType>>:<<etiValue>>
l For console events: no value
Example of metric status change: CPU Load:High:90

Note: This field is mandatory for updating the indicator. It is not recommended to change
the template value of this attribute.

Correlation
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UI Element Description

Main Settings

Key A unique string representing the type of event that occurred. Two events can have the
same key if both events represent the same situation in themanaged environment (the two
events are duplicates). Duplicate events are discarded after the number of duplicate events
is increased in the "Number of Duplicates" count.

Default value:

l Formetric status change:
<<siteScopeHost>>:<<monitorUUID>>:<<metric>>:<<etiValue>>:<<severity>>

l For alerts: <<siteScopeHost>>:<<monitorUUID>>:<<alertName>>:<<etiValue>>
l For console events:
<<siteScopeHost>>:<<monitorUUID>>:<<alertName>>:<<severity>>

Example of metric status change:

labmachine1:OMEventIntegration:CPU Utilization on SiteScope Server:utilization:Good

Submit
close key
condition

Enables the close key pattern to be evaluated by the event subsystem. If selected, enter
the pattern in theClose key pattern box below.

Default value:Selected

Close key
pattern

(This box is available only if Submit close key condition is selected.) Enables the event
that is sent to automatically close all the events whose key attributematches this
expression. It is recommended that this field contain the same value as in theKey field.

Note:SiteScope event integration policy always adds "<*>" to the end of your close key
pattern. The "<" and ">" signs cannot be used here since they cannot be interpreted by the
log file policy.

Default value:

l Formetric status change:
<<siteScopeHost>>:<<fullgroupid>>:<<monitorName>>:<<metric>>

l For alerts: <<siteScopeHost>>:<<monitorUUID>>:<<alertName>>
l For console events: <<siteScopeHost>>:<<monitorUUID>>:<<alertName>>
Example of metric status change:

labmachine1:OMEventIntegration:CPU Utilization on SiteScope Server:utilization<*>

Advanced Parameters

CI hint Information about the CI that is related to the event. This attribute is used for providing hints
to enable the event processing to find the correct related CI (RTSM ID of the related CI).

Default value:

l <<ciHint>>. The value in this field varies, depending on whether SiteScope is
connected to APM or HPOM. This field is not editable.

l For console events: <<targetHost>>
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UI Element Description

Main Settings

Host hint The target host beingmonitored by themonitor that triggered the event. The value is
translated to the legacy node attribute in HPOM. If the node does not exist in HPOM, the
event will be lost.

Default value: <<targetHost>>

Examples:

l IPv4: 15.15.12.13,
l DNS: host1.hp.com

Generating
source hint

Information about themonitoring application and the corresponding probe/agent that is
responsible for creating the event.

Default value:SiteScope@@<<siteScopeHost>>

Example: SiteScope@@host1.hp.com

Attributes

<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by dragging it from
theAttributes list to the selected text box, or select the cell in which to copy the selected
attribute, and click Ctrl+I.

For a description of the available attribute variables, see "Alerts, Alert Template, and Event
Properties" on page 1126.

New/Edit Event Mappings Dialog Box - Custom Attributes Tab
Use this tab to add custom attributes. Custom attributes can be used to provide additional information about
the event that is not provided in any of the other common event attributes.

l Make sure that the name of the attribute you are defining is unique and does not already exist in the list of
factory attributes.

l A custom attribute consists of a key and a value (both are strings). The value can be any string and is used
by the common event mapping as any other value.

l You cannot rename any of the predefined custommapping attributes (cma1-cma5).
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User interface elements are described below:

UI Element Description

Enables creating a new custom attribute for the event. Each event can have any number of
custom attributes.

l New Key. Adds a new line to the table, enabling you to add a name and value for the
attribute.

l Known Key. Opens a submenu with the known keys as options. You can select the
relevant key. A new row opens in the Name/Value table, with the name of the selected
key in the Name column. You can then enter the value of the key in the corresponding
Value column.

Delete Custom Attribute. Deletes the selected custom attribute from the table.

Name and
Value

Each event can have any number of custom attributes. Custom attributes can be used to
provide additional information with the event that is not provided in any of the other common
event attributes or that is contained in any of the other attributes. Each custom attribute is a
Name-Value pair, where you enter the name of the attribute in theName field and the value
of the attribute in theValue field.

This featuremay be used when youmanage the environment of multiple customers using
one instance of the product. Themultiple customers might be handled by a custom attribute
object.

Example:Name = "cma1" ; Value = "XYZ Company"

Attributes
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UI Element Description

<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by dragging it from
theAttributes list to the selected box, or select the cell in which to copy the selected
attribute, and click Ctrl+I.

For a description of the available attribute variables, see "Alerts, Alert Template, and Event
Properties" on page 1126.

Default Console Event Mappings:

The following attributes are included in the Custom Attributes tab for the Default Console
Event Mapping template which is included by default in Common Event Mappings:

l <<monitorServiceId>>. Enables customizing the service name that is sent from
SiteScope events to the Event Console by entering the value of themonitor service ID.
This is useful for relating the SiteScopemonitor with the HPOM Service Name.

l <<monitorDrilldownURL>>. Creates a hyperlink in the event to themonitor from which
the event was triggered.

l <<unifiedConsoleUrl>>. Creates a hyperlink in the event to the Event Console in the
Unified Console.

HP CDA Event Mappings:

The following attributes are included in the Custom Attributes tab for the HP CDA Event
Mapping template which is included by default in Common Event Mappings (for details on
CDA, see "Common Event Mappings Overview" on page 465):

l <<TemplateDeployPath>>. Displays the full path to the template group from which the
monitor was deployed.

l <<monitorServiceId>>. Enables customizing the service name that is sent from
SiteScope events to HPOM by entering the value of themonitor service ID. This is useful
for relating the SiteScopemonitor with the HPOM Service Name.

l <<monitorDrilldownURL>>. Creates a hyperlink in the event to themonitor URL.
l <<newStatus>>. Current status of themetric.

Tips/Troubleshooting
Known Issues
l You cannot delete a common event mapping if it is referenced by amonitor or an alert action. Youmust
change the event mapping referenced by themonitor or alert before you can delete themapping.

l SiteScopemight not be able to send events if a long description is entered, or if changes aremade to fields
in common event mappings that result in field names being too long.

l Do not use apostrophes ('') for custommapping attribute values. For example, use <<alertName>>
instead of '<<alertName>>'.

Using SiteScope
Chapter 43: Common Event Mappings

HPE SiteScope (11.33) Page 475 of 1206



Chapter 44: Credential Preferences
Credential Preferences provide centralized credential management for SiteScope resources. It enables you to
input user names and passwords for SiteScopemonitors, templates, and remote hosts once as a credential
profile, and then have SiteScope automatically supply that information when you configure those resources.

To access
Select Preferences > Credential Preferences.

To view or edit a credential profile, click theNew/Edit Credential Profile button.

Note: Youmust be an administrator in SiteScope, or a user grantedView credential list permissions to
be able to view Credential Preferences. Add, edit or delete credential preferences permissions are
required to create or edit Credential Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About
Benefits of Credential Preferences
Using Credential Preferences enables you to:

l Create andmanage your credentials. You can add, modify, and delete credentials from one central
location.

l Update credentials. If credentials for a resource expire or need to be updated, the credential profile can be
updated and the changes are applied to all usages of the resource within SiteScope. This saves having to
find andmanually update all usages of the resource in SiteScope.

l Keep user credentials secure. All passwords stored in Credential Preferences are encrypted. Only an
administrator, or a user grantedAdd, edit or delete credential preferences permissions, canmake
changes to the credentials.

l Search and replace by credential properties, and replace credentials with other credentials using Global
Search and Replace.

l Copy monitors in SiteScope with their credential settings. You can also copy monitors to other SiteScopes
when there is more than one SiteScope connected to APM (only available through SAM Administration). If
a credential profile does not exist in the SiteScope to which themonitor is copied, the credential profile is
created in that SiteScope.
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Supported Monitors
You can use Credential Preferences to store credentials for the followingmonitors:

Monitor Category Monitor

Application l COM+ Server Monitor
l SAP CCMS Monitor
l SAP CCMS Alerts Monitor
l SAP JavaWeb Application Server Monitor
l SAP PerformanceMonitor
l SAPWork Processes Monitor
l Siebel Application Server Monitor
l WebSphere Application Server Monitor

Database l Database Counter Monitor
l DB2 JDBC Monitor
l Oracle DatabaseMonitor

Server l HP NonStop Event LogMonitor
l IPMI Monitor

Web Transaction l URLMonitor
l URLContent Monitor
l URL List Monitor

Virtualization and Cloud l VMware DatastoreMonitor
l VMware Host Monitors
l VMware PerformanceMonitor
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Tasks
How to Configure Credential Preferences
This task describes the steps involved in configuring andmanaging credentials for SiteScope objects that
require user authentication.

1. Prerequisites
To create or make changes to the credentials, youmust be an administrator in SiteScope, or a user
grantedAdd, edit or delete credential preferences permissions.
For details on user permissions, see "Permissions" on page 636.

2. Create a credential profile
Configure a credential profile in Credential Preferences for each SiteScope resource that requires user
authentication. For user interface details, see "Credential Preferences Page" on the next page.
For a list of supportedmonitors, see "SupportedMonitors" on the previous page.

3. Configure SiteScope resources using credential profiles
When you configure a SiteScope resource that has a credential profile, select the profile in the
Credentials box in the resource's settings area.
l For user interface details when configuring amonitor, see theMonitor Settings for the specific
monitor.

l For user interface details when configuring a remote server, expandMain Settings in:

o "New/Edit Microsoft Windows Remote Server Dialog Box" on page 406.
o "New/Edit UNIX Remote Server Dialog Box" on page 422.

4. Update credential profiles
If credentials for a resource change, you can update the credential profile without having to find all
usages of the resource and update each resource separately in SiteScope. To change a profile, select
the profile in Credential Preferences, click Edit Credential Profile, andmake the necessary changes.

Note: You cannot delete a credential profile if it is referenced by amonitor. Youmust remove the
profile from each dependency before you can delete the profile.

5. Results
SiteScope authenticates the login and password for the resource using the credentials supplied in
Credential Preferences.

Using SiteScope
Chapter 44: Credential Preferences

HPE SiteScope (11.33) Page 478 of 1206



UI Descriptions
Credential Preferences Page
This page provides centralized credential management for SiteScope resources. This enables you to add,
update, and delete credentials that are used in configuring SiteScopemonitors, templates, and remote hosts.

User interface elements are described below:

UI Element Description

New Credential Profile. Creates a new credential profile. For user interface details, see
"New/Edit Credential Profile Dialog Box" below.

Edit Credential Profile. Enables editing a credential profile. For user interface details, see
"New/Edit Credential Profile Dialog Box" below.

DeleteCredential Profile. Deletes the selected credential profile from Credentials
Preferences.

Select All. Selects all listed credential profiles.

Clear Selection. Clears the selection.

Name Name string assigned to the setting profile when you create a new credential profile.

Login User name to access the resource using this credential profile.

Description Description of the setting profile that was assigned when creating or editing the credential
profile.

New/Edit Credential Profile Dialog Box
This dialog box enables you to create a new credential profile or edit an existing profile. You use credential
profiles for storing andmanaging authentication credentials for SiteScope resources. This page opens in view
mode or edit mode depending on your user permissions.

User interface elements are described below:

UI Element Description

Main Settings

Name Descriptive name for the credential profile.

Maximum length: 50 characters

Domain Domain for the credential. During the connection, the domain is added to the login in the
format: <domain>\<login>.

Login User name to access the resource using this credential profile.
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UI Element Description

Main Settings

Password Password to access the resource using this credential profile.

All SiteScope passwords are encrypted using 3DES (also known as TDES or Triple Data
Encryption Algorithm). For more information, refer to Hardening the SiteScope Platform in
the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

Confirm
password

Confirmation of the password entered in thePassword box. This is used when creating a
new credential or changing the password of an existing credential.

Advanced Settings

Description Description for the setting profile, which appears only when editing or viewing its properties.
You can include HTML tags such as the <BR>, <HR>, and <B> tags to control display
format and style.

Note:HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than one line).
If malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.

Search/Filter Tags

<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope,
this section appears but is empty. If tags have been created, they are listed here and you
can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Tips/Troubleshooting
General Notes/Limitations
l Copying credential settings to other SiteScopes is not supported when copyingmonitors to older versions
of SiteScope.

l You cannot delete a credential profile if it is referenced by amonitor or a remote host. Youmust remove the
credential profile from each dependency before you can delete the credential profile.

l If a credential that is used in a template remote host or templatemonitor has been deleted, youmust add
themissing credential to Credential Preferences or manually enter credentials for the resource in the
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template object before deploying the template.

Monitoring Credential Profiles
If user credentials expire or change, themonitors using these credentials fail and are inError status. To avoid
this situation, you can create amonitor for each credential profile that checks the authentication, andmakes
all monitors of themonitor type dependent on the test monitor.

For example, you can create an IPMI monitor, IPMI_test_credentials, andmanually configure the server
login and password. When you configure your IPMI monitors, in the Dependencies panel, enter IPMI_test_
credentials in theDepends on box and select Available as theDepends condition. If the IPMI_test_
credentials monitor becomes unavailable for any reason, the IPMI monitors are automatically disabled.
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Chapter 45: Email Preferences
Use this page to configure the settings SiteScope needs to communicate with an external email server. These
are the default settings that SiteScope uses to send event alerts as email messages.

To access
Select Preferences > Email Preferences.

Note: Youmust be an administrator in SiteScope, or a user grantedView email, pager, HTTP and
SNMP lists permissions to be able to view Email Preferences. Add, edit or delete email, pager,
HTTP and SNMP preferences permissions are required to create or edit Email Preferences. For details
on this topic, see "User Management Preferences" on page 625.

Learn About
Email Preferences Overview
The Email Preferences page displays the defined custom Email Recipient profiles to send email alert
messages to recipients. The Email Recipient profile can be associated with one or more Email alerts by
editing the applicable alert definition.

Email is the default media for sending event alerts when a problem has been detected by SiteScope (in
addition to the visual icons and status messages displayed in the SiteScope interface). Use the Email
Preferences to indicate the SMTP mail server, recipient addresses, and other settings that SiteScope should
use when sending email alerts and other SiteScopemessages (such as enabling SiteScope to send emails
securely via SSL SMTP servers).

UI Descriptions
This section includes:

l "Email Preferences Page" below
l "New/Edit Email Recipient Dialog Box" on the next page
l "Email Preferences Default Settings Dialog Box" on page 484

Email Preferences Page
User interface elements are described below:

UI Element Description

New Email Recipient. Creates a new Email Recipient profile. For user interface details,
see "New/Edit Email Recipient Dialog Box" on the next page.

Edit Email Recipient. Enables editing the Email Recipient profile. For user interface
details, see "New/Edit Email Recipient Dialog Box" on the next page.
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UI Element Description

Delete Email Recipient. Deletes the selected Email Recipient profile from Email
Preferences.

Test Email Recipient. Tests that you can send amessage to the Email address. Enter a
message in the Email dialog box, and click Test.

Select All. Selects all listed Email Recipient profiles.

Clear Selection. Clears the selection.

Default
Settings

Click the arrow next toDefault Settings, and select an option:

l Edit. Opens the Email Preferences Default Settings dialog box which enables you to
change the default settings displayed in the New Email Recipient dialog box. For details
on the settings, see "Email Preferences Default Settings Dialog Box" on the next page.

l Test. Test that you can send an email to the selected addresses. Select the email
recipients you want to test from the list of Available Recipients, or enter email addresses
in theEmail addresses box.

Name Name string assigned to the setting profile when you create a new Email Recipient.

Description Description of the setting profile that was assigned when creating or editing the profile.

Email Email address to which the alert is to be sent.

Enabled Status of the email alert. If the status is No, email alerts are stopped from being sent to
these email addresses.

New/Edit Email Recipient Dialog Box
This dialog box enables you to create a new Email Recipient profile or edit an existing profile. SiteScope uses
Email Recipient profiles for sending email alerts.

Note: Youmust be an administrator in SiteScope, or a user grantedView email, pager, HTTP and
SNMP lists permissions to be able to view Email Preferences. Add, edit or delete email, pager,
HTTP and SNMP preferences permissions are required to create or edit Email Preferences. For details
on this topic, see "User Management Preferences" on page 625.

User interface elements are described below:

UI Element Description

Main Settings

Name Name for the Email Recipient profile definition that is used to identify the profile in the
product display.
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UI Element Description

Main Settings

Description Description for the setting profile, which appears only when editing or viewing its properties.
You can include HTML tags such as the <BR>, <HR>, and <B> tags to control display
format and style.

Note:HTML code entered here is checked for validity and security, and corrective action is
taken to fix the code (for example, code is truncated if it spans). If malicious HTML code or
JavaScript is detected, the entire field is rejected. The following is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.

Email to Email addresses to which you want to send the alert.

Example:test@mycompany.com

You can enter multiple email addresses by separating the email addresses with semi colons.

Example:test@mycompany.com; sysadmin@thiscompany.com

Note:Emails can be sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" below.

Disabled Stops email alerts from being sent to these email addresses. Use this option to temporarily
disable a particular email without editing every alert that contains this email setting.

Advanced Settings

Template Template defining the email alert settings. Once a setting is defined, a single alert is sent to
people and pagers. Use theShortMail template for pagers.

Schedule Specifies when email settings should be enabled. Youmay select amore restricted
schedule from the names schedules in the drop-downmenu.

Default value:Every day, all day

Search/Filter Tags

<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope,
this section appears but is empty. If tags have been created, they are listed here and you
can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Email Preferences Default Settings Dialog Box
This dialog box enables you to configure the default Email Recipient settings.
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User interface elements are described below:

UI Element Description

Email server
domain name

Domain name of the SMTP mail server that SiteScope should use when sending email
messages.

Example:mail.thiscompany.com

If you are unsure of your mail server's domain name, check with your System
Administrator.

Note: This field is mandatory if you want to receive reports over email.

Administrator
email address

Email address to which SiteScope should send status messages.

Example:sysadmin@thiscompany.com

Note: This field is mandatory if you want to receive reports over email.

Daily status SiteScope sends a brief daily status message to the administrator's email address. This
email is scheduled to be generated at 7:07 AM every day. The subject of email sent
includes SiteScope daily status. The email content includes the number of active
monitors and groups, along with a URL link to the applicable SiteScopemain page plus
the version number of SiteScope installation.

SiteScope
starts/restarts

SiteScope sends a brief message each time that SiteScope restarts. Restarts may be an
indication of amonitor run problem. For more information, see "SiteScope Server Health
Monitors" on page 989.

Note:SiteScope no longer automatically restarts itself once a day.

From email
address

Email address used as the From Address for mail generated by SiteScope. Specifying an
email address may make it easier to browse and sort email sent by SiteScope. If nothing
is entered, the From email address stays the same as the address where themail is
sent from.

Example:sitescope@mycompany.com

If themail server being used required NTLM authentication (see below), the email address
entered heremust be a valid email address.

Note: This field is mandatory if you want to receive reports over email.

Backup email
server
domain name

Domain name of the SMTP mail server that SiteScope should use whenever the primary
mail server cannot be reached. If unsure of backupmail server's domain name, check
with the System Administrator.

Example:gateway.mycompany.com.

Login Username required by the SMTP server. This user name is used for both the primary and
backupmail servers.

Note:Youmust restart SiteScope if you change this setting.
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UI Element Description

Password Password required by the SMTP server. This password is used for both the primary and
backupmail servers.

Note:Youmust restart SiteScope if you change this setting.

NTLM
authentication

Select an NTML authentication option from the drop-down list:

l none. Select if themail server does not require NTLM authentication.
l NTLMv1. Select if themail server requires authentication using NTLM version 1.
l NTLMv2. Select if themail server requires authentication using NTLM version 
Note:Youmust restart SiteScope if you change this setting.

Default value: none

Timeout
(seconds)

Amount of time, in seconds, to wait for a response from the SMTP server. If a response
from the primary mail server is not received within the timeout period, SiteScope switches
to use the backupmail server.

Default value: 60 seconds

SMTP SSL Enables sending emails securely via SSL SMTP servers. When selected, SiteScope
sends all mails via SSL, except for theMail monitor andMail Round Trip Tool which have
their own SMTP mail setting.

Note:By default, mail is sent via port 465 of the SMTP mail server unless you specify a
different port inCustom SMTP Port (see below).

Default value:Not selected

Custom
SMTP Port

Enables sending emails via a user-specified port. If this box is left empty, the default port
for sendingmail is used (465 for the SMTP mail server).
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Chapter 46: Event Console Preferences
Event Console Preferences enable the SiteScope administrator to configure filters to allow different group of
users to focus on the events they need to see. For example, a NOC operator might need to see events filtered
by status or priority, whereas an application support expert might need to see events associated to specific
server monitors only.

For more details, see "Event Console" on page 914.

To access
Select Preferences > Event Console Preferences.

Tasks
How to Configure Event Filters
This task describes the steps involved in configuring a filter to determine which events are displayed in the
Event Console.

1. Prerequisites
Youmust be an administrator in SiteScope, or a user granted theView and edit event console
preferences permission to be able to view and edit Event Console Preferences. For details on
permissions, see "User Management Preferences" on page 625.

2. Configure an event filter (based on the requirements of specific users or user groups)
a. Select Preferences > Event Console Preferences, and click New/Edit Event Filter to open the

New/Edit Event Filter dialog box.
b. Type a name and description for the filter in theGeneral Settings pane.
c. In the Settings area of theEvent Filters pane, select the event attribute values by which to filter. For

details, see "New/Edit Event Filter Dialog Box" on the next page.

Note: At least one check box must be selected for each group of event attributes (status,
severity, assigned to, lifecycle state, priority).

d. (Optional) You can also filter by event title, description, category, subcategory, or target of the event
you want to filter. To do so, type a regular expression tomatch against the event attribute in the
appropriate box.

3. Results

Users can filter events in the Event Console by clicking the Filter button and selecting any of the
predefined filters. For details, see "Event Console" on page 914.

UI Descriptions
This section includes:
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l "Event Console Preferences Page - Event Filters" below
l "New/Edit Event Filter Dialog Box" below
l "Severity Mapping Preferences Dialog Box" on the next page

Event Console Preferences Page - Event Filters
User interface elements are described below:

UI Element Description

New Event Filter. Creates a new filter for displaying events sent to the Event Console. For
user interface details, see "New/Edit Event Filter Dialog Box" below.

Edit Event Filter. Enables editing the selected event filter. For user interface details, see
"New/Edit Event Filter Dialog Box" below.

Delete Event Filter. Deletes the selected event filter from Event Console Preferences.

Select All. Selects all listed event filters.

Clear Selection. Clears the selection.

Default
Settings

Click the arrow next toDefault Settings, and select Edit Severity Settings. Opens the
Severity Mapping Preferences dialog box which enables you to change the default severity
mapping related to the event (see the Severity description in the "New/Edit Event Mappings
Dialog Box - General Tab" on page 469).

For details on the Severity Mapping Preferences dialog box, see "Severity Mapping
Preferences Dialog Box" on the next page.

Name Name string assigned to the event filter for the Event Console.

Description Description for the event filter, which appears only when editing or viewing its properties.

New/Edit Event Filter Dialog Box
This dialog box enables you to create custom event filters to show only those SiteScope Event Console
events that meet the criteria that you define.

Note: If a regular expression used in the Title, Description, Category, Subcategory, or Target field does
not match any events, the full list of events is displayed in the Event Console. You can use the Regular
Expression Tool to check your regular expressions. For details, see "Regular Expression Tool" on
page 117.

User interface elements are described below:

UI Element Description

General Settings

Name Name string assigned to the event filter for the Event Console.
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UI Element Description

Description Description for the event filter, which appears only when editing or viewing its properties.

Event Filters

Settings Create an event filter by selecting at least one setting from each of the following groups:

l Status: Themonitor threshold status in SiteScope that corresponds to the console
event. The status can beGood, Error, orWarning.

l Severity:Severity of the occurrence related to the event. The severity level can be
Unknown, Normal, Warning, Minor, Major, or Critical.

l Assigned To:User who is responsible for solving the problem. This value can beMe,
Others, or None.

l Lifecycle State: The state used to describe the lifecycle of the event. The values can
beOpen, In progress, Resolved, or Closed.

l Priority: The importance attached to the selected event. The values can be None,
Lowest, Low, Medium, High, or Highest.

Note:Severity mappings correlate themonitor threshold status in SiteScope to the
severity level in console events. If required, you can customize the event severity
mappings in the Severity Mapping Preferences dialog box inPreferences > Event
Console Preferences > Default Settings > Edit Severity Settings. For details, see
"Severity Mapping Preferences Dialog Box" below.

Title To filter events by title, type a regular expression tomatch against the title.

Description To filter events by description, type a regular expression tomatch against the description.

Category To filter events by category, type a regular expression tomatch against the category.

Subcategory To filter events by subcategory, type a regular expression tomatch against the
subcategory.

Target To filter events by target, type a regular expression tomatch against the target.

Severity Mapping Preferences Dialog Box
This dialog box enables you to customize event severity mappings. Severity mappings correlate themonitor
threshold status in SiteScope to the severity level in console events. For details on the severity levels, see
the Severity description in the "New/Edit Event Mappings Dialog Box - General Tab" on page 469.

User interface elements are described below:

UI Element Description

Error Mapping between the Error status threshold for eachmonitor instance in SiteScope and
the severity level in the console event.

Default value:Critical
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UI Element Description

Warning Mapping between theWarning status threshold for eachmonitor instance in SiteScope
and the severity level in the console event.

Default value:Minor

Good Mapping between theGood status threshold for eachmonitor instance in SiteScope and
the severity level in the console event.

Default value:Normal

Unavailable Mapping between the Unavailable status threshold for eachmonitor instance in
SiteScope and the severity level in the console event.

Default value:Unknown
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Chapter 47: Failover Preferences
You use Failover Preferences to configure SiteScope Failover behavior. SiteScope Failover is a separate
installation of SiteScope that is designed to automatically assume the functions of a SiteScope system
(referred to as the primary system) if the system fails or is temporarily taken out of service.

For details on SiteScope Failover, see "SiteScope Failover Overview" on page 14.

To access
Select Preferences > Failover Preferences.

Note: Youmust be an administrator in SiteScope, or a user grantedView failover preferences
permissions to be able to view Failover Preferences. Edit failover preferences permissions are required
to edit Failover Preferences. For details on this topic, see "User Management Preferences" on page 625.

Tasks
How to Configure a SiteScope Failover Profile
This task describes how to use SiteScope Failover Preferences to configure a SiteScope Failover profile.

1. Prerequisites
Youmust be an administrator in SiteScope, or a user grantedEdit failover preferences permissions, to
be able to create or make changes to the SiteScope Failover profile.
For details on user permissions, see "User Management Preferences" on page 625.

2. Create or edit a profile
In the SiteScope Failover user interface, select Preferences > Failover Preferences, and build a new
profile or modify an existing profile. (From the primary SiteScope user interface, you can only test or
delete profiles.)
For user interface details, see "New/Edit Failover Profile Dialog Box" on page 493.

Note: The Lightweight single sign-on authentication authentication strategy is required for
SiteScope Failover. See "Authentication Strategies" on page 656.

UI Descriptions
This section includes:

l "Failover Preferences Page" on the next page
l "New/Edit Failover Profile Dialog Box" on page 493
l "Default Failover Server Settings Dialog Box" on page 497

HPE SiteScope (11.33) Page 491 of 1206



Failover Preferences Page
This page enables you tomanage SiteScope Failover profiles. It provides different commands depending on
whether it is accessed from the primary SiteScope user interface or the SiteScope Failover user interface.

User interface elements are described below:

UI
Element Description

New Failover Profile. Opens the New Failover Profile dialog box. For user interface details,
see "New/Edit Failover Profile Dialog Box" on the next page.

Note: This is available on the SiteScope Failover server only.

Edit Profile. Opens the Edit Failover Profile dialog box. For user interface details, see
"New/Edit Failover Profile Dialog Box" on the next page.

Note: This is available on the SiteScope Failover server only.

Delete Profile. Deletes the selected profile from Failover Preferences. This can be performed
from either the primary SiteScope or SiteScope Failover. If the remote SiteScope (for
instance, SiteScope Failover if you are on primary SiteScope) is not accessible at the time of
deletion, the profile is deleted only from the local SiteScope. Youmust thenmanually delete
the profile from the remote SiteScope user interface.

Tip: You can disable a profile instead of deleting it. See Main Settings > Profile disabled in
the Edit Failover Profile Dialog Box.

Select All. Selects all listed profiles.

Clear Selection. Clears the selection.

Default
Settings

On the primary SiteScope server, click the arrow next toDefault Settings, and select:

l Test. Tests the profile and checks access to remote SiteScope Failover.
On the SiteScope Failover server, click the arrow next toDefault Settings, and select an
option:

l Test. Displays the Test Failover dialog box. Using the dialog box, you can first test an
email address of a notification recipient by entering the email address in theSend email
to field and clickingSend Test Notification. The recipient can verify that the notification
is received in their email, to ensure that future notifications will be delivered correctly.
You can then click the Test button to test the profile and verify access to the primary
SiteScope.

l Edit. to change the default settings used for sending email notifications from the Failover
server. For details on the settings, see "Default Failover Server Settings Dialog Box" on
page 497.

Profile
Type

Indicates whether the Failover Preferences page is being accessed on a primary SiteScope or
SiteScope Failover server.
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UI
Element Description

Remote
Host

On the primary SiteScope, the remote host is the SiteScope Failover host. On the SiteScope
Failover host, the remote host is the primary SiteScope host.

Enabled Indicates whether the profile is enabled (Yes/No). To disable or enable a profile, access it from
the SiteScope Failover user interface.

New/Edit Failover Profile Dialog Box
This dialog box enables you to create a new failover profile or edit an existing profile. This dialog box is
available on the SiteScope Failover server only.

Note:

l Only an administrator in SiteScope, or a user grantedEdit failover preferences permissions can
create or make changes to Failover Preferences. For details on this topic, see "User Management
Preferences" on page 625.

l The LW-SSO authentication strategy is required for SiteScope Failover. See "Authentication
Strategies" on page 656.

User interface elements are described below:

UI Element Description

Main Settings

Host Enter the name or IP address of the server that is to be the primary server for this
SiteScope Failover server.

The SiteScope Failover checks the availability of the primary SiteScope andmirrors
themonitoring configurations from it.

Note: For an SSL environment, make sure that the primary SiteScope host name is
identical to that used in the server certificate (the name is case sensitive), otherwise
the connection will fail due to an SSL error.

Port Enter the port of the user interface for the primary SiteScope Server host specified
above.

Default value: 8080
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UI Element Description

Main Settings

Secure
connection

Enables SSL on the SiteScope Failover server. Using SSL has the following
requirements:

l The primary SiteScope and the SiteScope Failover must either be both enabled
for SSL or both disabled. That is, you cannot have one enabled for SSL and one
using standard protocol.

l The Port field abovemust specify the SSL-specific port.
l Certificates must already be imported to the SiteScope Failover host before the
profile is created.

For more information, see "Add Certificates to SSL-Enabled SiteScope Failover" in
the HPE SiteScope Failover Guide.

Default value:Not selected

Profile disabled Disable the profile, which stops all monitoring andmirroring of the primary by this
instance of the SiteScope Failover.

Default value:Not selected

Run Settings

Primary
availability every
(seconds)

Choose the frequency of checking the availability of the primary SiteScope server;
specify an integer in the range 15-10000.

Default value: 60 seconds

Mirror every
(minutes)

Choose the frequency of copying configuration data from the primary SiteScope
server to the SiteScope Failover server; specify an integer in the range 15-10000.
This setting keeps the SiteScope Failover server synchronized with the same
updates and changes to themonitoring configuration on the primary SiteScope
server.

Default value: 240minutes (4 hours)

Pause (minutes) Choose the delay in automatically switching the SiteScope Failover server to active
mode when the primary SiteScope server begins a planned shutdown. Enter an
integer in the range 0-20. A planned shutdown is one of the following:

l A scheduled restart occurs
l A restart requested through the user interface occurs
Default value: 3minutes
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UI Element Description

Main Settings

Schedule Choose the schedule for mirroring and checking availability of the primary SiteScope.
Schedules must be specified inPreferences > Schedule Preferences > Failover
Schedule Preferences before they can be chosen here.

If you choose an absolute schedule, mirroring occurs as determined by the schedule;
theMirror every (minutes) setting above is ignored. For example, if the absolute
schedule specifies mirroring happens at 6:00 AM every day thenmirroring happens
only at 6:00 AM regardless of theMirror every (minutes) setting.

An absolute schedule does not affect the frequency of checking availability of the
primary SiteScope. That frequency is determined by thePrimary availability every
(seconds) setting.

If you choose a range schedule, it is combined with the frequencies specified by the
Primary availability every (seconds) andMirror every (minutes) settings above.
For example assume the profile has the following values:

Schedule:  a range schedule enabled between 1 PM and 5 PM

Primary availability every (seconds): 3600 seconds

Mirror every (minutes): 240minutes

The resultingmirroring and primary availability checking: 

1 PM availability check
1 PMmirroring
2 PM availability check
3 PM availability check
4 PM availability check
5 PM availability check
5 PMmirroring

Last mirror time The time and date of themost recent mirroring operation.

Next mirror time The time and date of the next scheduledmirroring operation based on the specified
Primary availability every (seconds) andSchedule values in the profile.

Click to beginmirroring of the primary SiteScope.

The SiteScope Failover instance restarts when themirroring operation is complete.
After the restart, refresh yourWeb browser or redirect it to the SiteScope Failover
URL.

After mirroring, a copy of all of the groups from the primary SiteScope should display
in the SiteScope Failover instance's Monitor context. Their status is disabled until
the SiteScope Failover is activated.

Notification Settings
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UI Element Description

Main Settings

Emails on
primary restored

Enter one or more email addresses to receive notification when the primary
SiteScope server becomes available after a period of being unavailable. Separate
multiple entries with commas.

Note:Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in
the "Email Preferences Default Settings Dialog Box" on page 484.

Emails on
primary
unavailable

Enter one or more email addresses to receive notification when the SiteScope
Failover becomes active.

Note:

l If primary SiteScope performs a planned shutdown and is restored within the time
specified by thePause field value, the SiteScope Failover does not become
active.

l Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" on page 484.

Advanced Settings

Number of
backups

Number of backups with the primary SiteScope configuration.

Default value: 2

Mirroring
configuration

Predefined settings that describe themirroring strategy.

Default value: default

Disable BSM
Integration

Select if you do not want SiteScope Failover to report to BSM.

Note:Youmust restart the SiteScope Failover server for changes to this setting to
take effect.

Default value:Not selected

Merge back *.dyn
files

If selected, sends the *.dyn files created when SiteScope Failover was active back
to the primary SiteScope when it becomes active.

SiteScope uses internal files with the .dyn suffix to store data on which consecutive
monitor run counts andmonitor states are based. For somemonitor types, it is
important to have the *.dyn file include data from when an active SiteScope Failover
took over themonitor runs. You can choose to have the *.dyn file data from an active
SiteScope Failover merged back to the primary SiteScope *.dyn files when primary
SiteScope is restored. This ensures that all monitor runs, both primary and failover,
contribute to the data.

This setting is relevant for Microsoft Windows Event LogMonitor, Log File Monitor,
and other monitor types.

Default value:Not selected
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UI Element Description

Main Settings

Merge back
configuration

If selected, sends configuration data created when SiteScope Failover was active
back to the primary SiteScope when it becomes active.

Merge back configuration overwrites changes performed on the primary SiteScope
after the last mirroring operation, resulting in the loss of those changes. To reduce the
risk of losing this information, it is recommended that you schedule the interval
betweenmirroring operations to be as short as possible.

Before performing amerge back configuration, SiteScope backs up the existing
configuration on the primary SiteScope to a folder in <SiteScope root
directory>\high_availability\snapshots named based on the time of the backup
operation. To restore a backed up configuration, run the script restore.bat
(restore.sh on Unix) and restart SiteScope. Backups expire after 30 days.

Example: The last mirroring operation was performed at 10 AM. The primary
SiteScope failed at 11 AM andwas restored at 3 PM. As a result of merge back
configuration, configuration data changes on the primary SiteScope between 10
AM and 11 AM have been lost. You can restore the changes made on the primary
SiteScope between 10 AM and 11 AM from the relevant backup file. If you do this,
changes made on the SiteScope Failover between 11 AM and 3 PM will be lost from
the active primary SiteScope. However, these changes are also backed up in
<SiteScope root directory>\high_availability\snapshots and can be restored.

Note:

l Perform merge back configuration only if you plan tomodify monitors on the
SiteScope Failover. This is to prevent possible mismatching of data between the
primary SiteScope and the SiteScope Failover.

l You do not need to enablemerge back configuration in advance; it can be enabled
on the SiteScope Failover server even when the primary SiteScope is down.

l All merge back operations occur when the primary SiteScope restarts after a
failure and the SiteScope Failover is in activemode at that time. If merge back
operations cannot be performed in real time for technical reasons (for example,
SiteScope Failover is disabled or unavailable due to network issues), merge back
operations cannot be performed, either at that time or in the future. This is to
prevent possible mismatching of data between the primary SiteScope and the
SiteScope Failover.

Default value:Not selected

Merge back daily
log files

If selected, sends the daily log files that were created when SiteScope Failover was
active back to the primary SiteScope when it is restored. These files are used for
reports.

Default value:Not selected

Default Failover Server Settings Dialog Box
This dialog box enables you to configure the default notification settings. This dialog box is available on the
SiteScope Failover server only.
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Note: Only an administrator in SiteScope, or a user grantedAdd, edit or delete email, pager, HTTP
and SNMP preferences permissions can create or make changes to Email Preferences. For details on
user permissions, see "User Management Preferences" on page 625.

User interface elements are described below:

UI Element Description

Email server
domain name

Domain name of the SMTP mail server that SiteScope should use when sending email
messages.

Example:mail.thiscompany.com

If you are unsure of your mail server's domain name, check with your System
Administrator.

Note:Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" on page 484.

From email
address

Email address used as the From Address for mail generated by SiteScope. Specifying an
email address may make it easier to browse and sort email sent by SiteScope. If nothing
is entered, the From email address stays the same as the address where themail is
sent from.

Example:sitescope@mycompany.com

Note: If themail server being used required NTLM authentication (see below), the email
address entered heremust be a valid email address.

Login Username required by the SMTP server. This user name is used for both the primary and
backupmail servers.

Note:Youmust restart SiteScope if you change this setting.

Password Password required by the SNTP server. This password is used for both the primary and
backupmail servers.

Note:Youmust restart SiteScope if you change this setting.

NTLM
authentication

Select an NTML authentication option from the drop-down list:

l none. Select if themail server does not require NTLM authentication.
l NTLMv1. Select if themail server requires authentication using NTLM version 1.
l NTLMv2. Select if themail server requires authentication using NTLM version 
Note:Youmust restart SiteScope if you change this setting.

Default value: none

Timeout
(seconds)

Amount of time, in seconds, to wait for a response from the SMTP server. If a response
from the primary mail server is not received within the timeout period, SiteScope switches
to use the backupmail server.

Default value: 60 seconds
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UI Element Description

Notification
Subject

Select the subject field template for the email notification sent when the primary
SiteScope is unavailable.

Default value: default template

Note: This template can be customized or localized. The template is located at
<SiteScope Failover installation directory>\templates.ha\mail.subject.

Notification
template

Select the template for the email notification sent when the primary SiteScope is
unavailable.

Default value: default template

Note: This template can be customized or localized. The template is located at
<SiteScope Failover installation directory>\templates.ha\mail.
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Chapter 48: General Preferences
Use this page to enter and view licensing information, and other general display functions, optional functions,
and access options for SiteScope. You can also configure SSH, WMI, JDBC, LW-SSO (authentication), and
Dashboard settings.

Note: For information on general preferences relating to internationalization issues, see
"Internationalization in SiteScope" on page 651.

To access

Select Preferences > General Preferences.

Note: Youmust be an administrator in SiteScope, or a user grantedView general preferences
permissions to be able to view General Preferences. Edit general preferences permissions are required
to edit General Preferences. For details on this topic, see "User Management Preferences" on page 625.

Learn About
Using Default Authentication Credentials
You can use this section to enter default authentication credentials that SiteScope uses to log into certain
applications and systems. This user name and password are used if the following conditions aremet:

l No other authentication credentials are entered as part of an individual monitor configuration.
l The target application or system requires authentication credentials. The URLmonitor, URL Sequence
monitor, andWeb Servicemonitor can use this function.

Suspending Monitor Processes
In large and complex monitoring environments, it is possible that SiteScope can become heavily loaded with a
large number of monitors running and the responsiveness may become slow. This may be due to some
monitors being configured tomonitor too aggressively or systems that are becoming overloaded. If monitoring
actions are slowing the performance of SiteScope, it can be useful to temporarily suspendmonitoring actions
tomake configuration changes. You can temporarily suspendmonitors to reduce the time required to
complete large configuration operations such as a global search and replace operation. TheSuspend all
monitors option provides this function.

Web Script Monitor Files Directory
TheWeb Script Monitor runs VuGen scripts to monitor performance and content onWeb applications. The
VuGen scripts used by themonitor can be stored in the default directory for these scripts, <SiteScope root
directory>\templates.webscripts, or you can define a different directory in General Preferences.

Note: TheWeb Script monitor is available only to users accessing SiteScope directly and not to users
accessing SiteScope by using SAM Administration in APM.
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UI Descriptions
Search Options
User interface elements are described below:

UI
Element Description

Find Enables you to search for a specific string in preference settings. Type the string you want to
find in the box. The search filter runs automatically after a letter is entered in the box, and
highlights the first matching result. If there are nomatches, the box is displayed in red.

The search automatically looks for the string in the first word of each setting label. To check for
the string anywhere else in the setting label, type an asterisk wildcard (*) before the search
string.

You can also use the questionmark wild card (?) to represent one character only.

To clear the Find box, click the button.

Find
Next

Finds the next occurrence of the string for which you are searching.

Find
Previous

Finds the previous occurrence of the string for which you are searching.

Highlight Highlights all occurrences of the search phrase for which you are searching.

Match
Case

Select to search for the filter string exactly as entered. Clear this option to ignore the case of
the filter string.

Default value:Not selected
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General Settings
User interface elements are described below:

UI Element Description

VuGen scripts
path root

A directory to store the zip files of VuGen scripts for use by theWeb Script Monitor. The
files in the directory you enter here appear in the list of available scripts when configuring
theWeb Script Monitor. If you do not enter a value here, the files in the default directory
<SiteScope root directory>\templates.webscripts appear when configuring the
monitor.

For details on working with themonitor, seeWeb Script Monitor.

Default
authentication
user name

Default user name to be used for authentication with remote systems. Both <username>
and <DOMAIN>\<username> are valid formats. SiteScope uses this user name unless a
different user name is entered explicitly as part of themonitor configuration.

Default
authentication
password

Default password used for authentication with remote systems. SiteScope uses this
password for the URL, URL Sequence, andWeb Servicemonitor types unless a different
password is entered explicitly as part of themonitor configuration.

Pre-emptive
authorization

Displays the option used for authenticating the default user credentials when SiteScope
requests the target URL.

l Authenticate first request. Sends the username and password on the first request
SiteScopemakes for the target server.

l Authenticate if requested. Sends the username and password on the second
request if the server requests a username and password.

Default value:Authenticate first request

SiteScope
restart
schedule

Enables selecting a schedule for restarting SiteScope (Off, Every 24 hours after
restart), or a schedule defined in Absolute Schedule Preferences. For details on
defining a schedule, see "Absolute Schedule Page" on page 609.

Default value:Off

Number of
backups per
file

Displays the number of SiteScope configuration file backups to be kept. This function
helps preserve important monitor, alert, and general SiteScope configuration information.
This number represents the number of backups per file that is maintained. SiteScope
uses a naming convention of filename.bak.1, filename.bak.2, filename.bak.#,
where 1 is the latest backup file.

Example:You can backup files containing general SiteScope configuration information in
<SiteScope root directory>\groups.

Default value: 1
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UI Element Description

Locale-
specific date
and time

Displays dates and times in a format that is applicable to a certain locale, country, or
culture. To use a different locale setting, modify the SiteScope configuration file to include
the codes for the desired locale and select this option in the General Preferences
Settings. For details on how to perform this task, see "How to Configure SiteScope for a
Non-English Locale" on page 653.

Default value:Selected (the default is United States format)

International
version

Enables international character sets. When this option is selected, SiteScope honors all
character encoding. Use this option to instruct SiteScope to simultaneously handle
character encoding frommultiple sources and operating systems (for example, foreign
languageWeb pages).

If not selected, only the default character set of the operation system where SiteScope is
installed is supported. The exceptions are all the URLmonitor types, the Log File Monitor,
and the File Monitor. Thesemonitor types support multiple character encoding regardless
of the International Version option setting. For details on how to perform this task, see
"How to Configure SiteScope for a Non-English Locale" on page 653.

Default value:Selected

Suspend all
monitors

Temporarily suspends the execution of all monitors. Use tomake configuration changes
across your monitoring infrastructure. To reactivate monitoring, clear the option.

Note: This option disables all monitors currently defined for this SiteScope installation. If
setting SuspendMonitors and later clearing this option to re-enable themonitors, the
individual monitors that were set as disabled prior to the SuspendMonitors action, retain
their original disabled state.

Using this optionmay affect reports. Monitors that would have run during the time that
monitoring was suspendedmay display blanks for that period in reports.

Warning: There is currently no visual indication in the interface that SiteScope is in a
suspendedmonitor state. When theSuspend all monitors option is enabled, the
followingmessage is displayed: SiteScope is in Suspended mode; no monitors
are currently running.

Default value:Not selected

Licenses
The Licenses panel enables you to view the license edition, status, and capacity type details for all installed
licenses. It also enables you to import a license file to SiteScope, and to try the free 30-day Trial Edition when
using the Community edition.

To access Select Preferences > General Preferences > Licenses
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Important
information

l To use SiteScope, youmust have a valid license. SiteScope comes with the Community
edition license that is automatically activated after performing a regular SiteScope
installation. It enables partial functionality of SiteScope for an unlimited period of time. To
obtain full SiteScope functionality, you need to purchase a commercial edition license.
For license purchase inquiries (or if you require additional capacity), contact your HPE
sales representative or use the “Contact Us” link in the HPE SiteScope Product page. If
you own a license and require a license key file, use the HPE Licensing for Software
Portal.

l After upgrading to SiteScope 11.30, it might take a short period of time before the
Licensing panel is updated with the current licenses.

l If you upgrade the license of a SiteScope for Load Testing installation to Premium
edition, youmust perform the following changes to get the full functionality of Premium
edition:
a. Select Preferences > Infrastructure Preferences > Custom Settings, and set the

values of the following properties to:
o disableRepeatedSchedules=false
o disableReports=false
o MultiViewDashboardEnabled=true

b. Restart SiteScope.

Note: Alternatively, you can remove the _disableRepeatedSchedules=true, _
disableReports=true, _MultiViewDashboardEnabled=false properties from the
<SiteScope root directory>\groups\master.config file, and then restart
SiteScope.

See also SiteScope Licenses and Editions section in the SiteScope Deployment Guide (<SiteScope
root directory>\sisdocs\doc_lib\Get_Documentation.htm).

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description

<License
summary>

Displays the active SiteScope edition, and a summary of the capacity type (availability and
usage).

The edition can be:

l Community. This edition is instantly available upon a regular SiteScope installation. It
enables partial functionality of SiteScope for an unlimited period of time, for free. The
license has a fixed capacity for monitoring up to 25Operating System instances (OSi)
and 25 URLs (the capacity cannot be increased).

l Trial. Enables the full functionality of SiteScope during a free 30-day trial period (the
number of days remaining is displayed on the license). When activated from Community
edition, the Trial license includes a capacity for monitoring up to 25OS instances, 25
URLs, and 10 transactions.

l Premium/Ultimate. Enables full functionality of SiteScope (there is a difference in the
integrations that are supported in Premium edition). All capacity types (OSi, URL,
Transaction) are supported in these editions; the quantity is determined by the user.

l System Collector. A version of SiteScope provided with Operations Manager Integration
that enables SiteScopemonitors to be used on HPOM applications. This edition is
available for monitoring OS instances only with the HPOM (the quantity is determined by
the user).

l Load Testing. This edition is automatically activated after installing the HPE SiteScope
for Load Testing setup type, a version of SiteScope provided with
LoadRunner/Performance Center that enables users to define and use SiteScope
monitors on a LoadRunner or Performance Center application. The license includes a
fixed capacity for monitoring up to 25OS instances and 25 URLs (the capacity cannot be
increased).

l Failover. Enables functionality of SiteScope Failover when the primary SiteScope server
is down. The Failover licensemust be imported after installing SiteScope Failover (the
Failover license is provided with the Premium, Ultimate, and System Collector editions at
no additional cost).

The license can include the following capacity types:

l OSI (Operating System Instance). Used by themajority of monitors except URL-type,
Web Script, Web Service, Link Check, XMLMetrics, and freemonitors. This license
model is calculated according to the number of hosts or operating system instances being
monitored. SiteScope consumes oneOS instance per monitored host, regardless of the
number of monitors that aremonitoring this host. OS instances are not aggregated
between different editions, such as between Ultimate and Premium edition, because the
cost of an OS instance license differs for each edition type. However, OS instances are
aggregated betweenOS licenses of the same edition (for example if you havemultiple
Premium edition licenses each containing OS instances). Also another exception is the
System Collector OSi license that is aggregated with the Premium or Ultimate editions.

Note: To aggregate System Collector OSi license with other OSi license editions
(Premium or Ultimate), import only the System Collector OSi license on Premium or
Ultimate license.
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UI
Element Description

l URL. Used by all URL-typemonitors, Web Service, Link Check, and XMLMetrics
monitors. Eachmonitored URL or URL step consumes one URL license instance. URL
licenses are aggregated from all editions, except from the Community, Trial, and Load
Testing edition which have their own URL license.

l Transaction. Used by Web Script monitors to monitor VuGen script transactions. Each
monitored transaction consumes one Transaction license instance. Transaction licenses
are aggregated from all editions, except from the Community and Load Testing editions
which do not support transactionmonitoring.

License
file

Enter the path to your SiteScope license file, or click theSelect button, and select the license
file.

Import Imports the licenses from the selected license file.

Remove
License

Deletes the selected license.

Trial
License

Activates the 30-day free trial license, that enables you to use SiteScope with full
functionality.

Installed Licenses

Show only
active
licenses

Select to include only active licenses in the table.

Edition:
Capacity
Type

Lists the installed edition licenses grouped by capacity type. Click the expand (+) icon to
show all licenses for the selected capacity type. For a description of the SiteScope editions
and capacity types, see "<License summary>" on the previous page.

For more details, see the SiteScope Licenses section in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Capacity The total capacity for each capacity type.

If you expandOSI/URL/TRANSACTION (Total), you can see the total capacity of the
selected capacity type for each license edition.

Note: The Transaction capacity type is not available in Community, System Collector, or
Load Testing edition. The URL capacity type is not available in System Collector edition.

Used The total number of instances being used by each capacity type.

If you expandOSI/URL/TRANSACTION (Total), you can see the total number of instances
that are being used by each edition for the selected capacity type.

Remaining The total number of unused instances for each capacity type.

If you expandOSI/URL/TRANSACTION (Total), you can see the total number of available
instances in each edition for the selected capacity type.
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UI
Element Description

Expires The expiration date of the first license to expire for each capacity type.

If you expandOSI/URL/TRANSACTION (Total), you can see the expiration date of each
edition for the selected capacity type.

Status The status of the license (Active, Expired, Suspended). Only one license can be active at a
time.
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SSH Preferences
This panel enables you to configure preferences for securely accessing a remote computer.

To access Select Preferences > General Preferences > SSH Preferences

User interface elements are described below:

UI Element Description

SSH V2 connect timeout
(seconds)

Total number of seconds SiteScope should wait for a successful reply.
When the time is exceeded, the connection is automatically closed.

Default value: 30 seconds

SSH V2 hello timeout
(seconds)

Handshake timeout (in seconds).

Default value: 30 seconds

SSH V2 key exchange
timeout (seconds)

Total number of seconds SiteScope should wait for SSH key exchange.

Default value: 30 seconds

SSH V2 authentication
phase timeout (seconds)

Total number of seconds SiteScope should wait for SSH authentication.

Default value: 30 seconds

WMI Preferences
This panel enables you to configure preferences for usingWindows Management Instrumentation (WMI) to
access a remote computer. WMI is amore secure communicationmethod than NetBIOS for gathering data
from remote servers running onWindows servers.

To access Select Preferences > General Preferences >WMI Preferences

Relevant tasks "Configure theWMI Service for RemoteWindows Monitoring" on page 417

Important
information

"Monitors SupportingWindows Management Instrumentation (WMI)" on
page 235

User interface elements are described below:

UI Element Description

SiteScope NT
Localhost method

Connection typemethod (NetBIOS orWMI) for monitoringWindows server
resources on the localhost machine.

Default value:NetBIOS

WMI query timeout
(seconds)

WMI query timeout, in seconds, for eachmonitor run. If this box is empty, the
timeout is 120 seconds.

Default value: 120 seconds

Dashboard Monitor History View Options
This panel enables you to configureMonitor History settings to view monitor history on all monitors and
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monitor groups.

To access Select Preferences context > General Preferences > Dashboard Monitor History View
Options

Important
information

In the Dashboard layout, you can then use a filter to further limit themonitors displayed to
those that meet selected criteria. Your preferences are saved with the Dashboard filter
settings. For details, see "Customizing the SiteScope Dashboard" on page 891.

User interface elements are described below:

UI Element Description

Enable monitor
history view

Enables Monitor History in Dashboard. Disabling this option after it has been
enabled deletes all the view data displayed in the history view.

Default value:Not selected

Collect monitor
history data during
time period

Time frame for displaying past runs. Older runs are dropped. This setting overrides
any dashboard filtering. To change dashboard filter settings, see "Monitor History
Settings" on page 900.

Default value:Past 1 hour

Collect monitor run
statuses

Displays the required run status. Runs with other statuses are dropped. This
setting overrides any dashboard filtering.

Default value:Any

Maximum number
of runs to display

Number of rows of data to keep inmemory.

Default value: 100000

Minimum value: 1000
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JDBC Global Options
This panel enables you to apply global JDBC options to the SiteScope database logger, the Database
Connection and Database Information tools, Database alerts, and Databasemonitors (Oracle Database,
Database Counter, DatabaseQuery, DB2 JDBC, Technology Database Integration).

To access Select Preferences > General Preferences > JDBC Global Options

User interface elements are described below:

UI Element Description

Connection
timeout

Amount of time, in seconds/minutes/hours/days, to wait for a new SQL connection to be
made. Not all SQL drivers have this function. If your SQL driver does not support this
function, this parameter is ignored.

Default value: 5minute

Driver trace
log file

Creates a driver trace log file for troubleshooting database drivers. To create the log file,
enter the full path or UNC name of the driver trace file (for example, e:\mydir\myfile.log).

Note: The target log file can contain login information, table names and queries.

Tip:We recommend using this option for troubleshooting purposes only (it is empty by
default).

LW SSO Settings
This panel enables you to change the Lightweight Single Sign-On (LW-SSO) authentication string in
SiteScope.

To access Select Preferences context > General Preferences > LW SSO Settings

User interface elements are described below:

UI
Element Description

LW
SSO
Init
String

Must contain a shared string that is used by all trusted applications integrating with Lightweight
Single Sign On (LW-SSO).

Tip:We recommend using at least 12 characters for the passphrase parameter. You can use
any Unicode character, excluding the surrogate blocks, FFFE, and FFFF.

Note: The default SiteScope passphrase string is not secured. To use a secured string, change
the default passphrase value in SiteScope and for all HPE software applications that are
integrated using LW-SSO.

For details on LW-SSO, see "How to change the LW-SSO string in SiteScope" on page 659.
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Chapter 49: HTTP Preferences
You can use HTTP Preferences to configure the settings SiteScope needs to communicate with HTTP
connectors, which are used for reporting not only data and events, but also for monitors that use HTTP
preferences. SiteScope uses the SiteScope HTTP recipient to integrate with HTTP-based network
management systems and to send generic event data to third-party applications andmanagement consoles.

To access
Select Preferences > HTTP Preferences.

l To create a new HTTP recipient, click theNew HTTP Recipient button.
l To edit an existing recipient, click theEdit HTTP Recipient button .

Note: Youmust be an administrator in SiteScope, or a user grantedView email, pager, HTTP and
SNMP lists permissions to be able to view HTTP Preferences. Add, edit or delete email, pager,
HTTP and SNMP preferences permissions are required to create or edit HTTP Preferences. For details
on this topic, see "User Management Preferences" on page 625.

Tasks
Related Task: "How to Configure SiteScopeGeneric Event Integration" on page 589

UI Descriptions
This section includes:

l "HTTP Preferences Page" below
l "New/Edit HTTP Recipient Dialog Box" on the next page

HTTP Preferences Page
The HTTP Preferences page displays the defined custom HTTP recipients or templates to send data to hosts.
HTTP recipients can be associated with connectors in the Generic Events integration, when configuring
connection type. For details, see "Generic Event Integration Preferences" on page 588.

User interface elements are described below:

UI Element Description

New HTTP Recipient. Creates a new HTTP recipient. For user interface details, see
"New/Edit HTTP Recipient Dialog Box" on the next page.

Youmust be an administrator in SiteScope, or a user grantedAdd, edit or delete email,
pager, HTTP and SNMP preferences to be able to create or edit HTTP Preferences. For
details on this topic, see "User Management Preferences" on page 625.
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UI Element Description

Edit HTTP Recipient. Enables editing the HTTP recipient. For user interface details, see
"New/Edit HTTP Recipient Dialog Box" below.

Youmust be an administrator in SiteScope, or a user grantedAdd, edit or delete email,
pager, HTTP and SNMP preferences to be able to create or edit HTTP Preferences. For
details on this topic, see "User Management Preferences" on page 625.

Delete HTTP Recipient. Deletes the selected HTTP recipient from HTTP Preferences.

Note:You cannot delete an HTTP recipient if it is referenced by aGeneric Event Integration.
Youmust change the HTTP recipient in the Generic Event Integration before you can delete
the HTTP recipient.

Test HTTP Recipient. Tests that you can send amessage to the HTTP recipient. Enter a
message in the Test HTTP recipient dialog box, and click Test.

Select All. Selects all listed HTTP recipients.

Clear Selection. Clears the selection.

Name Name string assigned when you create a new HTTP recipient.

Description Description that was assigned when creating or editing the HTTP recipient.

URL Endpoint URL to be used for data or event reporting and inmonitors that will use HTTP
preferences.

New/Edit HTTP Recipient Dialog Box
This dialog box enables you to create a new HTTP recipient or edit an existing recipient.

User interface elements are described below:

UI Element Description

General Settings

Name Name string assigned when creating a new HTTP recipient.

Description Description for the HTTP recipient, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.

Note:HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than one
line). If malicious HTML code or JavaScript is detected, the entire field is rejected. The
following is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.
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UI Element Description

General Settings

HTTP Preferences Settings

URL Endpoint URL of the application that receives all HTTP messages.

If secure connection (SSL), then enter https.

Syntax:http or https://<fully qualified domain name of the receiving
server>:<port number receiving data>/<path>

Request
headers

Header request lines sent by the HTTP client to the server. Headers should be linebreak
separated. The standard list of HTTP1.1 request headers can be found in
http://www.w3.org/Protocols/rfc2616/rfc2616-sec14.html#sec14.

Note:Although this field is optional, someWeb pages behave unexpectedly when the
request header is missing (such as performing endless redirects, providing wrong
content, and so forth).

URL content
encoding

SiteScope retrieves the correct encoding from the server response. The default value
appearing here should not be edited.

Default value:Encoding from server response

POST data
encoding

Determines if the POST data is encoded. Select from the following options:

l Use content type. Decide to encode the POST data by the content type header. If
the header equals urlencoded then encode, otherwise do not encode.

l Force URL encoding. Always encode the post data.
l Do not force URL encoding. Do not encode the POST data.

HTTP version HTTP version for SiteScope to use for style request headers (HTTP version 1.1 or 1.0).

Default value: 1.1

Use WinInet WinInet is used as an alternative HTTP client for this monitor.

Select this option to useWinInet instead of Apache when:

l The Apache HTTP client does not support a specific technology required to access
the server you aremonitoring. For example, Kerberos authentication is not supported
by the Apache library, and is supported by WinInet. WinInet also supports trusted
client-side certificates while Apache does not.

l You tried running this monitor and the Apache server returned errors. UsingWinInet
may solve these errors.

Default value: Not selected

Note:WinInet functionality is available onWindows versions of SiteScope only.

Error on
redirect

Generates an error (and notifies you) if a URL is redirected.

Default value:Not selected
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UI Element Description

General Settings

Request
timeout
(seconds)

Amount of time, in seconds, to wait for the HTTP requests (including retries) to complete.
A timeout value of zero is interpreted as an infinite timeout.

Default value: 120

Connection
timeout
(seconds)

Amount of time, in seconds, to wait until a connection is established. A value of zero
means the timeout is not used.

Default value: 120

Number of
retries

Number of times each HTTP request should be retried before SiteScope considers the
request to have failed.

Default value: 3

Authentication
when
requested

If selected, authentication (when requested) is done using theWeb Server user name
and password.

Default value:Selected

Web Server Security Settings

Credentials Option to use for authorizing credentials if the URL specified requires a name and
password for access:

l Use user name and password. Select this option tomanually enter user
credentials. Enter the user name and password to access the URL in theUser name
andPassword box.

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the URL (default option). Select the
credential profile to use from theCredential profile drop-down list, or click Add
Credentials and create a new credential profile. For details on how to perform this
task, see "Credential Preferences" on page 476.
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UI Element Description

General Settings

Pre-emptive
authorization

Option for sending authorization credentials if SiteScope requests the target URL:

l Use global preference. Select to have SiteScope use the setting specified in the
Pre-emptive authorization section of the General Preferences page.

l Authenticate first request. Select to send the user name and password on the first
request SiteScopemakes for the target URL.

Note: If the URL does not require a user name and password, this optionmay cause
the URL to fail.

l Authenticate if requested. Select to send the user name and password on the
second request if the server requests a user name and password.

Note: If the URL does not require a user name and password, this optionmay be used.

All options use theUser name andPassword entered for this monitor instance. If these
are not specified for the individual monitor, theDefault authentication user name and
Default authentication password specified in theMain section of the General
Preferences page are used, if they have been specified.

Note: Pre-emptive authorization does not control if the user name and password should
be sent, or which user name and password should be sent.

Client side
certificate

The certificate file, if you need to use a client side certificate to access the target URL.
Normally, this is a .pfx (.p12) type certificate, which usually requires a password. You
enter the password for the certificate in theClient side certificate password box.

Note:Client side certificate files must be copied into the <SiteScope root
directory>\templates.certificates directory.

Default value: none

Client side
certificate
password

Password if you are using a client side certificate and that certificate requires a
password.

Default value:Empty

Authorization
NTLM domain

Domain forWindows NT LAN Manager (NTLM) authorization if required to access the
URL.

Default value:Empty

Accept
untrusted
certificates for
HTTPS

If you are accessing a target URL using Secure HTTP (HTTPS) and SiteScope does not
have the required server certificates, you can either select this option or import the
related certificates. For details on importing server certificates, see SSLConnectivity in
"URLMonitor" in the SiteScopeMonitor ReferenceGuide.

Default value:Not selected
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UI Element Description

General Settings

Accept invalid
certificates for
HTTPS

Select this option if you are accessing a target URL using Secure HTTP (HTTPS) and
SiteScope has invalid server certificates. This may happen, for example, if the current
date is not in the date ranges specified in the certificate chain.

Default value:Not selected

NTLM V2 Select if the URL you are accessing requires authentication using NTLM version 2.

Default value:Not selected

Proxy Server Settings

Address Address of the proxy server, if applicable.

User name Proxy server user name if the proxy server requires a user name to access the URL.

Note:Your proxy server must support Proxy-Authenticate for these options to function.

Password Proxy server password if the proxy server requires a user name to access the URL.

Note: Your proxy server must support Proxy-Authenticate for these options to function.

Search/Filter Tags

<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.
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Chapter 50: Infrastructure Preferences
Infrastructure Preferences enable you to view and define the values of global SiteScope settings that
determine how SiteScope runs.

To access
Select Preferences > Infrastructure Preferences.

Note: Youmust be an administrator in SiteScope, or a user grantedView infrastructure preferences
permissions to be able to view Infrastructure Preferences. Edit infrastructure preferences permissions
are required to edit Infrastructure Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About
Infrastructure Preferences Overview
Infrastructure Preferences are sorted and grouped into the following categories: General Settings, Server
Settings, Monitor Settings, Skip Monitor Settings, Dynamic Monitoring Settings, CalculatedMetrics Settings,
CustomMonitor Settings, Alert Settings, Multi-View Settings, Template Settings, Persistency Settings,
Report Settings, Baseline Settings, Analytics Settings, Event Console Settings, and Custom Settings.

After you edit setting values in Infrastructure Preferences, SiteScope validates that all input data is in the
correct format and warns you if restarting SiteScope is required. You can restart SiteScope from the
Infrastructure Preferences page.

Note: You can also view and define infrastructure settings from the <SiteScope
root directory>\groups\master.config file.

UI Descriptions
This section includes:

l "Search Options" on the next page
l "General Settings" on the next page
l "Server Settings" on page 528
l "Monitor Settings" on page 529
l "Skip Monitor Settings" on page 539
l "Dynamic Monitoring Settings" on page 540
l "CalculatedMetrics Settings" on page 541
l "CustomMonitor Settings" on page 541
l "Alert Settings" on page 542
l "Multi-View Settings" on page 543
l "Template Settings" on page 544
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l "Persistency Settings" on page 544
l "Report Settings" on page 545
l "Baseline Settings" on page 546
l "Analytics Settings" on page 549
l "Event Console Settings" on page 553
l "Custom Settings" on page 554

Search Options
User interface elements are described below:

UI
Element Description

Find Enables you to search for a specific string in preference settings. Type the string you want to
find in the box. The search filter runs automatically after a letter is entered in the box, and
highlights the first matching result. If there are nomatches, the box is displayed in red.

The search automatically looks for the string in the first word of each setting label. To check for
the string anywhere else in the setting label, type an asterisk wildcard (*) before the search
string.

You can also use the questionmark wild card (?) to represent one character only.

To clear the Find box, click the button.

Find
Next

Finds the next occurrence of the string for which you are searching.

Find
Previous

Finds the previous occurrence of the string for which you are searching.

Highlight Highlights all occurrences of the search phrase for which you are searching.

Match
Case

Select to search for the filter string exactly as entered. Clear this option to ignore the case of
the filter string.

Default value:Not selected

General Settings
User interface elements are described below:

UI Element Description

Accept
untrusted SSL
certificates

Enables SiteScope to accept any untrusted certificate when SSL is used. Otherwise,
only certificates specified in the keystore file or that have a trust chain leading to a
registered CA certificate are accepted.

Default value:Not selected

Property name: _sslAcceptAllUntrustedCerts
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UI Element Description

BSM
downtime
retrieval
frequency
(minutes)

Amount of time, in minutes, that SiteScope waits between querying APM for downtime
requests.

Default value: 15minutes

Data
acquisition
API single
request size
(MB)

Themaximummemory size, in megabytes, allocated for fetching data from the daily log
in a single data acquisition API request.

Loading toomuch data from the daily log to process a request might have a negative
performance impact on SiteScope, because thememory allocated for the data is out of
SiteScope’s available memory pool.

Default value: 20MB

Note:Youmust restart SiteScope if you change this setting.

Property name: _dataAcquisitionAPISingleRequestSizeMB

Data
acquisition
API total
request size
(MB)

Themaximummemory size, in megabytes, allocated for fetching data from the daily log
in all simultaneous data acquisition API requests.

Loading toomuch data from the daily log to process requests might have a negative
performance impact on SiteScope, because thememory allocated for the data is out of
SiteScope’s available memory pool.

Default value: 100MB

Note:Youmust restart SiteScope if you change this setting.

Property name: _dataAcquisitionAPITotalRequestsSizeMB

Default
collection
method for
Microsoft
Windows
Resources
monitor

Default collectionmethod (pdh or registry) used for theMicrosoft Windows Resources
monitor when theUse global setting option is selected in theCollection method field
of themonitor settings. For details, seeMicrosoft Windows Resources Monitor Settings.

Default value: pdh

Delay between
host resolution
requests
(milliseconds)

Delay, in milliseconds, between successive calls to the DNS server.

Default value: 0milliseconds

Destroy
process by
external
command

Default value:Not selected
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UI Element Description

Disable quotes
for cmd.exe

Avoids wrapping parameters in quotes when running cmd.exe for specific tasks.

Default value:Not selected

Property name: _disableDoubleQuotesInTemplates

DNS name
tags

A comma-separated list of values considered by DNS-related functionality as the DNS
"name" tag.

Default value:Name:,Nombre:,Navn:,Nome:,Nom :,Nom\u00FF:

Property name: _dnsNameTags

DNS server
tags

A comma-separated list of values considered by DNS-related functionality as the DNS
"server" tag.

Default value:Server:,Servidor:,Serveur:,Serveur\u00FF:

Property name: _dnsServerTags

Don't check
default
thresholds

Checks monitor results against user selected thresholds only and not against the default
SiteScopemonitor thresholds.

Default value:Selected

Property name: _noCheckDefaultThresholds

Email
character set

Character set for email generated by SiteScope in Email Preferences and Email alerts.

Default value: If no value is entered, UTF-8 is used.

Property name: _mailCharSet

Email subject
character set

Subject character set for email generated by SiteScope in Email Preferences and Email
alerts.

Default value: If no value is entered, UTF-8 is used.

Property name: _mailSubjectCharSet

Enable
downtime
mechanism

Enables the CI downtimemechanism when SiteScope is connected with APM.
SiteScope is affected by downtime if a SiteScopemonitor, measurement, group, or
profile CI is directly linked to a CI that BSM detects is in downtime.

Default value:Selected

Property name: _downtimeEnable

Enable report
credentials to
BSM

If selected, SiteScope sends the credentials of any host to APM.

Default value:Not selected

Property name: _sendCredentials
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UI Element Description

Enable
topology
collection in
standalone
deployment

Enables SiteScope to collect topology when running in standalonemode (when
SiteScope is not connected to a BSM server). This setting should be enabled when
using the Data Acquisition API.

Default value:Not selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _CollectTopologyInStandaloneMode

Frequency of
VM
configuration
retrieval from
vCenter
(hours)

Frequency that VM configuration data is retrieved from vCenter and saved to the cache.
This enables supporting VM changes such as change of IP or host name in the vCenter.

Default value: 4 hours

Property name: _vmwareRetrieveConfFrequencyHours

Include
deleted
monitors in
data
acquisition
API results

Data acquisition API includes data on deletedmonitors in results.

Default value:Not selected

Property name: _dataAcquisitionAPIIncludeDeletedMonitorsData

LDAP binary
attributes

SiteScope uses the names of all known binary LDAP attributes for configuration
requests and responses (this affects the format of LDAP query's output).

Default value: audio, auditingPolicy, authorityRevocationList, cACertificate,
certificateRevocationList, crossCertificatePair, dSASignature, extensionData,
javaSerializedData, jpegPhoto,msExchIMACL, msExchMailboxGuid,
msExchMailboxSecurityDescriptor, mSMQDigests, mSMQSignCertificates,
objectGUID, objectSid, personalSignature, photo, replicationSignature, thumbnailLogo,
thumbnailPhoto, userCertificate, userParameters, userPassword, x500UniqueIdentifier

Property name: _ldapBinaryAttributes

Log enabled
monitors only

SiteScope does not logmonitor runs in the daily log files for monitors that have not been
enabled. This option also affects Management andQuick reports. If selected, monitors
that have been disabled are not included inManagement andQuick reports.

Default value:Not selected

Property name: _onlyLogEnabledMonitors

Maximum idle
threads per
pool

Maximum number of idle threads per thread pool.

Default value: 100

Note:Youmust restart SiteScope if you change this setting.

Property name: _threadPoolMaxIdle
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Maximum idle
time (ms) for a
thread in the
pool

Amount of time, in milliseconds, to wait before SiteScope cleans idle thread pools.

Default value: 600000milliseconds (10minutes)

Note:Youmust restart SiteScope if you change this setting.

Property name: _threadPoolMaxIdleTime

Maximum idle
time for perfex
process in
minutes

Amount of time, in milliseconds, to wait before SiteScope cleans idle perfex processes.
Cleaning processes improves thememory footprint on the SiteScopemachine.

Default value: 60minutes

Property name: _perfexProcessMaxIdleTime

Maximum
processes per
pool

Maximum number of processes per process pool.

Default value: 200

Note:Youmust restart SiteScope if you change this setting.

Property name: _processPoolMaxPerPool

Maximum size
of data
integration
sample's
queue

Upper limit of the data integration sample's queue. When this limit is reached, old
samples are discarded.

Default value: 1000

Property name: _dataSamplesQueueMaxSize

Maximum SSH
connection
attempts

Maximum number of attempts tomake an SSH connection.

Default value: 1

Property name: _numberOfRepeatExecForSSHConnection

Monitor delay
between
refresh
(milliseconds)

Amount of time, in milliseconds, to wait before running amonitor after it has already been
run since startup.

Default value: 1000milliseconds

Property name: _monitorDelayBetweenRefresh

NT SSH
timeout
(seconds)

Amount of time, in seconds, to wait for an SSH connection to remoteWindows servers
before timing out.

Default value: 60 seconds

Property name: _NTSSHTimeout

Number of
open port tries

Maximum number of attempts to open a reserved port in the 811-1024 range for rlogin
and rsh remote access methods.

Default value: 25

Note:Youmust restart SiteScope if you change this setting.

Property name: _localPortRetryCount
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Number of
repeated
attempts for
Telnet
connection

Maximum number of repeated attempts tomake a Telnet connection.

Default value: 1

Property name: _numberOfRepeatExecForTelnetConnection

Number of
samples to
discard if
queue max
size reached

The number of samples to discard if the queue sizemaximum has been reached.

Default value: 500

Property name: _dataSamplesQueueDiscardSamples

Numeric
values format

Format of numeric values when converting to string representation.

The 0 symbol shows a digit, or 0 if no digit is present.

The # symbol shows a digit, or nothing if no digit is present.

Examples:

l For 000000.00 format:
-1234.567 is written as -001235.57
1.1 is written as 000001.10

l For #.###### format:
-1234.567 is written as -1234.567
1234 is written as 1234

l For #.000000 format:
-1234.567 is written as -1234.567000

Note: If you enter 0.000000000 format, all numbers are written in rounded form, including
numeric-like values such as PID number, user ID, and process ID. The report production
system is unable to differentiate between numeric and numeric-like values.

Default value: #.##

Property name: _noScientificNotation

Perfex timeout
(seconds)

Amount of time, in seconds, to wait for perfex to attempt to make a connection or to
attempt to run amonitor before timing out.

Default value: 120 seconds

Property name: _perfexTimeout
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Power Shell
execute
command

To enable use of theMicrosoft Exchangemonitor on a 64-bit version of Windows Server
2003 orWindows Server 2008 (since a 32-bit application cannot access the system32
folder on a computer that is running a 64-bit version of Windows Server 2003 or 2008),
perform the following:

l (ForWindows 2003) Apply theMicrosoft hotfix available from
https://support.microsoft.com/en-us/kb/942589 (not required when using the
Microsoft Basemonitor)

l Enter the PowerShell execute command. For example:

C:\Windows\Sysnative\WindowsPowerShell\v1.0\powershell.exe

In some cases when using theMicrosoft Exchange Basemonitor, youmight also need
to enter the PowerShell execute command (without installing theMicrosoft hotfix).

Note:Symlink Sysnative is not available by default onWindows 2003.

Default value:PowerShell

PowerShell
pool:
maximum
number of
active
processes (per
key)

Maximum number of active PowerShell processes per key (connection).

Default value: 20

Note:Youmust restart SiteScope if you change this setting.

Property name: _powerShellPoolMaxActive

PowerShell
pool:
maximum
number of idle
processes (per
key)

Maximum number of idle PowerShell processes per key (connection).

Default value: 8

Note:Youmust restart SiteScope if you change this setting.

Property name: _powerShellPoolMaxIdle

PowerShell
pool:
maximum
number of
processes

Maximum number of PowerShell processes which can be in the pool simultaneously (all
idle processes and all active processes).

Default value: 20

Note:Youmust restart SiteScope if you change this setting.

Property name: _powerShellPoolMaxTotal

PowerShell
pool:
maximum wait
time until new
or idle process
is available
(milliseconds)

Maximum wait time, in milliseconds, until a new or idle PowerShell process is available.

Default value: 1000milliseconds (1 second)

Note:Youmust restart SiteScope if you change this setting.

Property name: _powerShellPoolMaxWait
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PowerShell
pool:
minimum idle
time for
processes
(milliseconds)

Minimum amount of time, in milliseconds, that an object can sit idle in the pool before it
is eligible for eviction due to idle time. If set to a negative (-) number, no object will be
dropped from the pool due to idle time alone. This setting has no effect unless
PowerShell pool: time between eviction runs (milliseconds) > 0.

Default value: 300000milliseconds (5minutes)

Note:Youmust restart SiteScope if you change this setting.

Property name: _powerShellPoolMinEvictableIdleTimeMillis

PowerShell
pool: time
between
eviction runs
(milliseconds)

Interval, in milliseconds, between eviction thread runs for closing idle PowerShell
processes. When a negative (-) number is set, no eviction thread is launched.

Default value: 900000milliseconds (15minutes)

Note:Youmust restart SiteScope if you change this setting.

Property name: _powerShellPoolTimeBetweenEvictionRunsMillis

Processes wait
for server
timeout in
multithreading

If selected, a separate thread is opened for each process that is waiting for a server
timeout to close the connection, or for an answer to return the process to the pool. This
setting increases the thread count and usedmemory if many servers are down. When
this setting is cleared (recommended), SiteScope uses only one thread tomanage such
processes.

Default value:Not selected

Process pool
kill timeout
(milliseconds)

Amount of time, in milliseconds, to wait before SiteScope kills a non-responsive
process. This is to avoid killing processes on every timeout.

Default value: 60000milliseconds (themaximum recommended value is 180000
milliseconds)

Note:Youmust restart SiteScope if you change this setting.

Property name: _processPoolKillTimeout

Quick search
auto filter
delay
(milliseconds)

Amount of time to wait before the auto filter runs. If set to -1, the ENTER key must be
pressed to run the search. For details on quick search, see "Quick Search" on page 64.

Default value: 800milliseconds

Note:Youmust restart SiteScope if you change this setting.

Recursive
'depends on'

Enables recursion in themonitorDepends on box. This means that subgroups become
disabled when the parent group is disabled because of a dependency. By default, only
the immediate group impacted by the dependency is disabled.

Default value:Not selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _dependsOnRecursive
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Report
VMware
Performance
monitor
metrics to OA
metrics
classes

The VMware Performancemonitor reports eachmetric to a specific table with its ESX
host server, VM, or resource pool target, according to its metrics class. To report all
VMware Performancemonitor metrics to one table, clear this check box.

Default value:Selected

Property name: _omReportNewVmwareMetricClasses

Send remote
server display
name to BSM

Sends the remote server display name to APM instead of the remote server host name.
It is preferable to use this setting when DNS resolution is disabled.

Default value:Not selected

Property name: _sendRemoteServerDisplayNameToBAC

SiteScope
sleep delay
(milliseconds)

Amount of time, in milliseconds, of the sleep interval in themain thread.

Default value: 180milliseconds

Note:Youmust restart SiteScope if you change this setting.

Property name: _monitorProcessCheckDelay

SiteScope tree
refresh rate
(seconds)

Amount of time, in seconds, to wait between refreshing the SiteScope tree. The
minimum value is 30 seconds.

Default value: 60 seconds

Property name: _sisTreeRefreshRateSecs

Sleep interval
on error
(milliseconds)

Amount of time, in milliseconds, to wait before rerunning amonitor using theVerify error
option.

Default value: 5000milliseconds

Property name: _verifySleepDuration

SSH
connection
repeats
number

Maximum number of attempts tomake an SSH connection.

Default value: 1

SSH prompt
timeout
(milliseconds)

Amount of time, in milliseconds, for SiteScope to wait for an SSH connection prompt to
finish before running the first command.

Default value: 3000milliseconds

Property name: _waitSshPromptTimeout

Timeout
proxied query
drivers list

A comma-separated list of database drivers that have timeout problems. Database
queries processed with the drivers listed here exceed the timeout specified in the
monitor's Query timeout field. These drivers are queried separately with amonitor-
based timeout.

Default value: org.postgresql.Driver

Property name: _timeoutProxiedDrivers
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Time period
for cleaning
idle SSH
connections
from pool
(minutes)

Amount of time, in minutes, for cleaning idle SSH connections from the SSH
connections pool.

Default value: 10minutes

Property name: _SSHConnectionIdleCleanTimeMinutes

Time zone
offset

Manually sets the time zone offset, in hours, from GreenwichMean Time (GMT). You
can enter both positive and negative, integer and non-integer values.

Default value: -999 (no offset)

Example: In Eastern US (EST), where the time zone offset is GMT -5, enter the value 5.
In central Europe, where the time zone offset is GMT +2, enter the value -2.

Note:Youmust restart SiteScope if you change this setting.

Property name: _timeZoneOffset

Topology
resolving
frequency
(minutes)

Amount of time, in minutes, to wait between checking the topology of the server being
monitored. This applies to non-dynamic monitors only; for dynamic monitors, frequency
can be configured per instance in the user interface.

If this time is exceeded during amonitor run:

l In SiteScope standalone, the topology is saved in SiteScope.
l When SiteScope is integrated with BSM, themonitor creates the topology again in
APM's RTSM.

Default value: 120minutes

Note:Youmust restart SiteScope if you change this setting.

Property name: _topologyResolvingFrequencyInMinutes

Traceroute
command

(For Unix) Path to the traceroute command to override the default for the platform.

Default value:No value

Property name: _tracerouteCommand

Wait for SSH
connection
prompt

SiteScope waits for the end of the SSH connection prompt before it starts to run the first
command. Select this setting if the SSH remote server has a long start prompt.

Default value:Not selected

Property name: _readUntilPromptFound
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Server Settings
User interface elements are described below:

UI Element Description

Default credentials
name

Use a default credential name for a remote connection.

Default value:No value

Property name: _defaultServiceCredentialsName

Host name override Overrides the SiteScope host name for APM. This value will be used as the host
name for all the host name queries.

Default value:No value

Property name: _sisHostNameOverride

Note: If you do not specify this value, youmight encounter duplicate
SiteScope host CIs in OMi's RTSM.

Kill processes Kills child processes when the SiteScope process is stopped.

Default value:Selected

Property name: _killProcesses

Maximum monitor
processes

Maximum number of monitor processes in the process pool.

Default value: 100

Note:Youmust restart SiteScope if you change this setting.

Property name: _maxMonitorProcesses

Maximum monitor
running

Maximum number of runningmonitor processes in the queue.

Default value: 400

Note:Youmust restart SiteScope if you change this setting.

Property name: _maxMonitorsRunning

Minimal monitor run
interval (seconds)

Minimal possible monitor frequency. If you try to create amonitor with frequency
less then this frequency, a validation error is displayed.

Note:Youmust restart SiteScope if you change this setting.

Default value: 15

Property name: _monitorMinInterval
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Prefer IP version 6
addresses

If a host is resolved to both IPv6 and IPv4, IPv6 is used. For details on support for
IPv6 in SiteScope, see "Enable SiteScope to Prefer IP Version 6 Addresses" on
page 434.

Note:Youmust restart SiteScope if you change this setting.

Default value:Not selected

Property name: _preferIPV6Address

SiteScope heartbeat
restart timeout
(minutes)

Maximum time, in minutes, before SiteScope restarts itself when no heartbeat
events are detected.

Note:Youmust restart SiteScope if you change this setting.

Default value: 5minutes

Property name: _heartbeatRestartTimeout

SiteScope restart
timeout (minutes)

Maximum time for SiteScope to restart itself.

Default value: 15minutes

Property name: _restartTimeout

SiteScope shutdown
timeout (seconds)

Amount of time, in seconds, that SiteScope should wait to shutdown before timing
out.

Default value: 60 seconds

Property name: _shutdownTimeout

Startup script Runs this script whenever SiteScope starts up, regardless of the platform or
procedure used to start SiteScope. (Empty=none)

Default value:No value

Property name: _startupScript

Monitor Settings
User interface elements are described below:

UI Element Description

Additional error
tokens

Additional list of keywords that should be handled as signs of failure during server
output parsing.

Default value: Failed to .* Error code:

Property name: _scriptMonitorErrorMsgs2

Additional event
log name

Enables theMicrosoft Windows Event Logmonitor to monitor event logs other than
the standard logs, by entering additional log names.

Default value:No value

Property name: _additionalEventLogNames
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Additional event
types

Enables theMicrosoft Windows Event Logmonitor to monitor event types other than
the standard application, system, or security logs, by entering additional event type
categories.

Default value:No value

Property name: _additionalEventTypes

Allow all request
headers in URL
specific monitors

Allows all request headers in URL specific monitors.

Default value:Not selected

Property name: _urlOtherHeader=

Allow all request headers in URL specific monitors

If selected, enables all request header types in URL specific monitors to be allowed.
The request header types that are allowed include: Custom-Content, Custom-
Header, Content-Type, Host, User-Agent, Set-Cookie, Method, Protocol, Action,
and sslgetOptions. When the setting is cleared, only custom headers are allowed.

Default value: Not selected

Property name: _allowAllRequestHeaders

Browsable EXE
timeout
(milliseconds)

Maximum amount of time, in milliseconds, to wait for retrieving counter information
and for running themonitor. This setting only applies to executable-based browsable
monitors, such as SAP, Sybase, and DB2 JDBC monitors.

Default value: 45000

Property name: _browsableExeTimeout

Browsable
monitors - If in
error, send status
of all counters to
BSM

When a browsablemonitor is in error status, SiteScope only sends the list of
counters in error and their current values to BSM. At other times (when themonitor is
in good status), SiteScope forwards all the counter names and values to BSM.

If selected, SiteScope sends all the counters (the ones in error, and the ones with
good status) and their values to BSM even during error.

Default value:Not selected

Property name: _isSendStatusOfAllBrowsableCountersToBAC

CPU error at 100% CPU monitor switches to the default error status when CPU utilization reaches
100% on the target machine.

Default value:Selected

Property name: _cpuEnableErrorAt100

CPU maximum
units

Maximum number of CPU units supported by the CPU monitor.

Default value: 16

Property name: _cpuMaxProcessors
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DB maximum
columns

Maximum number of columns processed by DB monitors.

Default value: 10

Property name: _databaseMaxColumns

DB maximum
rows

Maximum number of rows processed by DB monitors.

Default value: 1

Property name: _databaseMaxRows

DB maximum
value length

Maximum length, in characters, of the data processed by DB monitors.

Default value: 200

Property name: _databaseMaxSummary

Default frequency
for new monitors
(seconds)

Default frequency which is set in all new monitors for running themonitor instance
(unless a different frequency is set by manually editing the frequency value for a
monitor instance).

Default value: 600 seconds (10minutes) in SiteScope; 5 seconds in SiteScope for
Load Testing.

Property name: _defaultMonitorRunFrequency

Default precision The default precision for floating-point values processed by somemonitors.

Default value: 0 (disabled)

Property name: _defaultPrecision

Description
mandatory when
enabling/disabling
alert or monitor

Enables you tomake adding a description a required field when enabling or disabling
an alert or monitor.

Default value:Not selected

Property name: _enableDisableDescriptionMandatory

Dynamic Docker:
Delete monitors
created by
discovery
mechanism when
Docker monitor
deleted

When the Dynamic Docker monitor is deleted, applicationmonitors created by the
automatic discovery mechanism are automatically deleted. When the check box is
cleared, the Dynamic Docker monitor is deleted, but applicationmonitors created by
the automatic discovery mechanism are not deleted.

Default value:Selected

Property name: _dynamicDockerAppDiscoverAutoDeleteAppMonitors

Dynamic Docker:
Enable automatic
application
discovery

Enables the application discovery mechanism used with the Dynamic Docker
monitor. This mechanism searches for applications running in new containers on the
Docker node or cluster, and automatically creates a new monitor or set of monitors
using a predefined template.

Default value:Selected

Property name: _dynamicDockerAppDiscoverEnabled
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Dynamic JMX
connection pool:
maximum active
connections in
pool (per key)

Themaximum number of active connections that can be open in the connection pool
at the same time per key. (The connection pool is a set of pools per key. A key is the
combination of a JMX URL, a user, and a password).

Default value: 10

Dynamic JMX
connection pool:
maximum idle
connections in
pool (per key)

Themaximum number of idle connections in the connection pool (per key). (The
connection pool is a set of pools per key. A key is the combination of a JMX URL, a
user, and a password). When this value is exceeded, the number of unused
connections that exceed this value are closed rather than kept in the connection
pool.

Default value: 5

Dynamic JMX
connection pool:
minimum
evictable idle time
(milliseconds)

Theminimum time that a connectionmust be idle before the eviction thread can evict
it. Note that the actual amount of time a connection will be idle depends on when the
eviction thread runs (Dynamic JMX connection pool: time between eviction runs
(milliseconds)).

Default value: 1800000milliseconds (30minutes)

Dynamic JMX
connection pool:
time between
eviction runs
(milliseconds)

Interval between eviction thread runs for closing idle connections.

Default value: 600000milliseconds (10minutes)

Dynamic JMX
connection pool:
total number of
connections for
whole pool

The total number of dynamic JMX connections available for the JMX connection pool
(for all the keys together). When this number is exceeded, the number of
connections that exceed this value are closed.

Default value: 500

Dynamic JMX
connection pool:
waiting for
connection
timeout
(milliseconds)

The amount of time to wait for a connection from the JMX connection pool before
timing out.

Default value: 60000milliseconds (1minute)

Empty last line
reading

Includes the last empty line in the Script monitor output.

Default value:Not selected

Property name: _enable_script_monitor_non_empty_last_line_reading

Enable JDBC
logging

Enables JDBC search results logging for the Link Check monitor.

Default value:Not selected

Property name: _linkMonitorJdbcEnabled
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Error tokens for
Script monitor

List of keywords that should be handled as signs of failure during server output
parsing.

Default value: not found, Not Found, denied, Denied, cannot execute such file or
directory

Property name: _scriptMonitorErrorMsgs

Event log
messages to save

Number of Microsoft Windows Event Log descriptions to save when saving
diagnostic text for alerts.

Default value:10

Property name: _eventLogMessagesToSave

Force rerun of
heartbeat monitor
that has
dependent
monitors

Forces a rerun of the heartbeat monitor when the heartbeat monitor status is not in
error and the dependent monitor status is in error. This is to make sure that the
heartbeat monitor is not the cause of the problem (to check that the heartbeat
monitor is not currently in error).

Default value:Selected

Property name: _runOkDependsOnError

FTP content
match maximum
size

Maximum size of the buffer used tomatch FTP content.

Default value: 50000

Property name: _ftpContentMatchMax

FTP download
limit

Maximum number of bytes downloaded from each file to match.

Default value: -1 (no limit)

Property name: _ftpDownloadLimit

FTP maximum
threads

Maximum number of simultaneous FTP worker threads.

Default value: 1

Property name: _ftpMaxThreads

HTTP content
match display
limit

Maximum number of bytes to display for URLmonitor content match.

Default value: 150

Property name: _urlContentMatchDisplayMax

HTTP content
match limit

Maximum number of bytes to check for URLmonitor content match.

Default value: 50000

Property name: _urlContentMatchMax

JMX thread pool
core size

Number of threads to keep in the JMX pool that can be created for JMX tasks, even
if they are idle.

Default value: 10
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JMX thread pool
idle time
(seconds)

When the number of threads is greater than the core, this is themaximum time that
excess idle threads will wait for new JMX tasks before timing out.

Default value: 30 seconds

JMX thread pool
maximum size

Maximum number of threads to allow in the pool. If the number of threads in the pool
is greater than the core but less than themaximum and the queue is full, then new
threads will be created for the JMX tasks until themaximum number of threads in
pool is reached.

Default value: 200

JMX thread pool
queue size

Maximum number of JMX tasks that can be added to the queue. If all the core
threads are busy now, the new tasks will be added to queue until themax queue size
is reached.

Default value: 400

Mail attachment
content support
base64

Supports mail attachment content-transfer-encoding with base64 for theMail
monitor.

Default value:Not selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _mailAttachmentBase64Support

Maximum
browsable
counters to be
selected

Maximum number of browsable counters that can be selected from the browsable
tree. If you create or edit a monitor so that it has more counters than this value, only
the number of counters up to this value is saved.

Note:When a browsablemonitor is deployed in a template, the number of counters
that match the selected patterns are limited by the _maxCountersForRegexMatch
parameter in the <SiteScope root directory>\groups\master.config file. If, during
deployment, the number of counters that match the patterns exceeds this value, only
the number of counters up to this value is saved. Therefore, we recommend using
the same value for this setting and the _maxCountersForRegexMatch parameter.
The default value for both of these parameters is 1000.

Default value: 1000

Property name: _browsableContentMaxCounters

Maximum
counters for
application
monitors

Maximum number of counters that can be selected for applicationmonitors.

Default value: 100

Property name: _ApplicationMonitorMaxCounters=100

Maximum
counters for
SNMP by MIB
monitor

Maximum number of counters supported by the SNMP by MIB monitor.

Default value: 32

Property name: _maxSNMPbyMIBCounters
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Maximum number
of messages to
fetch from
mailbox and scan

Maximum number of messages that can be fetched from themail box.

Default value: 50

Maximum
Windows
Performance
Counter monitor
counters

Maximum number of counters for each instance of aMicrosoft Windows
Performance Counter monitor.

Default value: 8

Property name: _NTCounterMonitorMaxCounters

Microsoft
Windows Media
Server monitor
service names

Service names tomonitor using theMicrosoft Windows Media Server monitor.

Default value:Windows Media Services (this includes Windows Media Station
Service andWindows Media Unicast) Service)

Property name: _counterObjectsWindowsMediaMonitor

MQ Server CCSID Default WebSphereMQ server CCSID in SiteScope.

Default value:No value

Property name: _mqServerCCSID=

MS Media Player 9
account blocked

Select this option and add the account directory path to theMS Media Player 9
account directory box if your Media Player account stops working with a 17999
error.

Default value:Not selected

Property name: _MediaPlayer9AccountBlocked

MS Media Player 9
account directory

Enter theMedia Player account directory if you get a 17999 error for theMedia Player
monitor.

Default value:No value

Example:C:\Documents and Settings\<USER>\Local Settings\Application
Data\Microsoft\Windows Media\9.0

Property name: _MediaPlayer9AccountBlockedDir

Network
Bandwidth
monitor sanity
check

Performs a sanity check on the Network Bandwidthmonitor.

Default value:Selected

Property name: _performNetworkBandwidthSanityCheck
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Oracle Database
session counters

The set of session counters used for each session. Use to avoid a Java Heap Space
error on the applet side where the current Oracle Database has a large number of
sessions.

Select from:

l None. All Oracle session counters are disabled.
l FullList. All Oracle session counters are enabled.
l DefaultList. By default, only the following Oracle session counters which exist
for the current Oracle Database are enabled:
l recursive calls

l db block gets

l consistent gets

l physical reads

l redo size

l bytes sent via SQL*Net to client

l bytes received via SQL*Net from client

l SQL*Net roundtrips to/from client

l sorts (memory)

l sorts (disk)

l rows processed

l DefaultList,counter1_name,counter2_name,...,counterN_name. Only the
default Oracle session counters, and counters which were defined after the
DefaultList value are enabled. For example, DefaultList,logons
current,logons cumulative.

l counter1_name,counter2_name,...,counterN_name. Only counters which
were defined in the current setting are enabled. For example, logons
current,logons cumulative.

Default value:DefaultList

Note: If this setting is an empty string, only the default Oracle session counters
which exist for the current Oracle Database are enabled.

Using SiteScope
Chapter 50: Infrastructure Preferences

HPE SiteScope (11.33) Page 536 of 1206



UI Element Description

Perfex options The options which are used to fine-tune perfex settings:

l -wrmTimeout 300. Amount of time, in seconds, to wait when creating a
Microsoft Windows Resources monitor with many counters on a loaded network
environment before timing out.

l -optionalSetupConnection. This option forces perfex to use
ImpersonateLoggedOnUser Microsoft API when authenticating. It allows
SiteScope to set up optional way to connect to the remote workstation when
monitoring using a secure connection. For details, see "Configure Remote
Monitoring Using Secure Shell (SSH)" on page 439.

Default value: -wrmUiTimeout 300

Property name: _perfexOptions

Real Media Server
monitor service
names

Service names tomonitor using the Real Media Server monitor.

Default value:RMServer

Property name: _counterObjectsRealMonitor

Run script
through perfex
tool

Runs the script through the perfex tool.

Default value:Selected

Property name: _scriptRunThroughPerfex

SAP Java
Connector version

The version of the SAP Java Connector libraries used by the SAP monitors to
connect to the SAP R/3 system.

Default value: 2.x

Property name: _jCoVersion

Script monitor
output limit

Number of lines to save from Script output after launching the Script monitor.

Default value: 25

Property name: _scriptMonitorLinesToSave

Script monitor
replacement
strings

Stores a list of space-separated strings which are parameter tags in the remote
script. When the Script monitor is run, it replaces parameters tags from the script
commandwith actual parameter values frommonitor preferences.

Default value: $ %

Property name: _scriptMonitorReplacementChars

Example: If the script command is test $ %, replacement chars are $ %, and
parameters are Param1 Param2, themonitor runs the following command: test
Param1 Param2.
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Simultaneously
running DNS
monitors

Maximum number of DNS monitors that can run simultaneously. This is relevant
only when using the roundTripTime counter. The NSLookup operation can load the
operating system and affect the values.

Default value: 0 (0means that the number of simultaneous DNS monitors is
unlimited)

Note:Youmust restart SiteScope if you change this setting.

Property name: _maxDnsMonitorsRunning

SNMP monitors
maximum number

Maximum number of SNMP monitors that can run at any given time.

Default value: 10

Note:Youmust restart SiteScope if you change this setting.

Property name: _snmpMonitorMaximum

SNMP session
closure timeout
(milliseconds)

Maximum amount of time, in milliseconds, that SiteScope waits before closing the
SNMP session.

Default value: 30000

Property name: _maxSNMPCloseSessionTimeMillis

SNMP Trap
encoding

SNMP Trap encoding for the SNMP Trapmonitor (used for send and receive traps).
Empty=ISO8859-1.

Default value: ISO8859-1

Property name: _snmpTrapEncoding

SNMP Trap
monitor log limit

Maximum number of lines to look through SNMP Trap log for the SNMP Trap
monitor. This box is filled only if Run Alerts is set toOnce, after all SNMP Traps
have been checked in the SNMP Trapmonitor page.

Note:Setting a high limit may increase the size of theSiteScope.log or
RunMonitor.log.

Default value: 1000

Property name: _SNMPTrapMonitorDetailsMax

Use DNS Java
library

Activates Java DNS functionality instead of using the default perfex setting. In some
cases, DNS response times are faster than the perfex response.

Default value:Not selected

Property name: _useDNSJava

Use sequence of
requests for
SNMP by MIB

Activates a new mode of requests for the SNMP by MIB monitor. Using this option,
SiteScope executes a separate request to the remote server for eachOID counter
from themonitor.

Default value:Not selected

Property name: _sequenceSNMP
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Web Script
monitor queue
size

The size of theWeb Script monitor queue.

Default value: 20 (maximum value: 40)

Property name: _maxWebScriptMonitorsRunning

Web Script
monitor queue
timeout (seconds)

The amount of time, in seconds, for theWeb Script monitor to wait in the queue
before timing out.

Default value: 120 seconds

Property name: _webScriptMonitorsWaitingInQueueTimeout

Web Service
monitor maximum
read length (bytes)

Maximum amount of data, in bytes, to read from the log file for theWeb Server
monitor.

Default value: 50000 bytes

Property name: _maxAmountToRead

Web Service
monitor timeout
(seconds)

Maximum amount of time in seconds for theWeb Server monitor to run.

Default value: 30 seconds

Property name: webServiceTimeout=30

Web Service
Monitor use
common content
match

Content match behavior was changed for theWeb Servicemonitor in SiteScope
10.12. This setting enables Web Servicemonitors defined prior to SiteScope 10.12
tomatch the correct value. This means that Web Servicemonitors behave in the
sameway as other monitors where content matching is used. Clear the setting to
revert to the old content match behavior.

Default value:Selected

Skip Monitor Settings
User interface elements are described below:

UI Element Description

Disable period of skip
monitor (seconds)

The period of time, in seconds, that amonitor is disabled after the
maximum number of monitor skips (defined inMaximum monitor skips)
has been exceeded.

Default value: 360 seconds

Property name: _monitorDisablePeriodOnSkip

Maximum monitor skips Maximum number of consecutivemonitor skips before amonitor is
disabled.

Default value: 10

Note:Youmust restart SiteScope if you change this setting.

Property name: _maxMonitorSkips
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Send email to administrator
if monitor is disabled after
a skip

SiteScope sends an email to the administrator if a monitor is disabled after
themaximum number of consecutivemonitor skips has been exceeded.

Default value:Not selected

Property name: _emailSkipNotification

Shutdown on monitor skips SiteScope shuts downwith an error if a monitor exceeds its maximum
skip count.

Default value:Not selected

Property name: _shutdownOnSkips

Dynamic Monitoring Settings
User interface elements are described below:

UI Element Description

Dynamic
monitoring core
thread pool size

Number of threads in pool that will be created for new dynamic monitors changes
check tasks.

Default value: 5

Note:Youmust restart SiteScope if you change this setting.

Property name: _dynamicMonitoringCoreThreadPoolSize

Dynamic
monitoring
maximum queue
size

Maximum number of new dynamic monitors changes check tasks that can be added
to the queue. If all the core threads are busy, the new tasks are added to the queue
until themaximum queue size is reached.

Default value: 5000

Note:Youmust restart SiteScope if you change this setting.

Property name: _dynamicMonitoringMaxQueueSize

Dynamic
monitoring
maximum thread
pool size

Maximum number of threads in pool that will be created for new dynamic monitors
changes check tasks. These extra threads are created only if all the core threads are
busy and themaximum queue size has been reached.

Default value: 30

Note:Youmust restart SiteScope if you change this setting.

Property name: _dynamicMonitoringMaxThreadPoolSize

Using SiteScope
Chapter 50: Infrastructure Preferences

HPE SiteScope (11.33) Page 540 of 1206



Calculated Metrics Settings
User interface elements are described below:

UI Element Description

Maximum number of calculated
metrics

Maximum number of calculatedmetrics that can be created for a
monitor.

Default value: 100

Note:Youmust restart SiteScope if you change this setting.

Property name: _customCalculatedCounters

Custom Monitor Settings
User interface elements are described below:

UI Element Description

Allow network
access

Enable this setting if your custommonitor needs to open a network connection to
another server from the data processing script or the Java code that is called from the
script. Clear the selection to block network access.

Default value:Not selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _customMonitorAllowNetworkAccess

Disable custom
monitors while
publish changes

Disables deployed custommonitors while publish changes runs. Themonitor is
temporarily disabled before changes are published and is restored to the enabled
state after changes have beenmade.

Default value:Selected

Property name: _disableForPublish

Enable custom
monitor
debugging

Enables sending debugging logs for custommonitors to a remote debugging server.
Note that custommonitor debuggingmust also be enabled for the specific custom
monitor instance in themonitor settings.

<SiteScope>\logs\custom_monitors\custom_monitor.log

Default value:Not selected

Property name: _customMonitorEnableDebugging

Maximum
number of
counters

Maximum number of counters that can be created in a custommonitor.

Default value: 1000

Note:Youmust restart SiteScope if you change this setting.

Property name: _customMonitorMaxNumOfCounters
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Maximum
number of
queries

Maximum number of queries that can be added to the queries table to query-based
custommonitors.

Default value: 10

Note:Youmust restart SiteScope if you change this setting.

Property name: _customMonitorMaxNumOfQueries

Reload classes
and jars on each
monitor run

Checks for any changed classes and jar files on eachmonitor run, and reloads them.
Enabling this option saves having to restart SiteScope if you add or modify
jars/classes after the first monitor run.

Default value:Not selected

Note: This option should only be used be during script development, and should be
cleared in the production stages since it impacts performance.

Property name: _customMonitorReloadClassLoaderFiles

Alert Settings
User interface elements are described below:

UI Element Description

Alert attempt delay
(seconds)

Amount of time, in seconds, to wait between each attempt to send a Post Alert.

Default value: 120 seconds

Property name: _postAttemptDelay

Maximum alert
threads

Maximum number of alert threads in the pool.

Default value: 100

Property name: _threadPoolAlertMaxThreads

Maximum runs for
Post action

Maximum number of attempts to send a Post Alert.

Default value: 4

Property name: _postAttempts

Maximum script alert
processes

Maximum number of Script Alert processes that can run simultaneously.

Default value: 25

Property name: _maxScriptAlertProcesses

Maximum sound alert
length (milliseconds)

Maximum length of time, in milliseconds, of the Sound Alert sound.

Default value: 0

Property name: _AudioSleepTime
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Pager delay (seconds) (Pager Alerts were deprecated; this setting remains for backward compatibility
purposes only.) Delay between pager signals when using a Pager Alert.

Default value: 5

Property name: _delayBetweenPages

Multi-View Settings
User interface elements are described below:

UI Element Description

Configuration
change refresh
frequency (seconds)

Amount of time, in seconds, to wait between refreshing the configuration changes
inMulti-View. Configuration data includes adding, deleting, or moving a group or
monitor, and changing a group or monitor name.

Note:Youmust restart SiteScope if you change this setting.

Default value: 60 seconds (this is also theminimum value you can enter)

Runtime data
refresh frequency
(seconds)

Amount of time, in seconds, to wait between refreshing the runtime data in Multi-
View. Runtime data includes monitor or group status changes and enable/disable
information.

Note:Youmust restart SiteScope if you change this setting.

Default value: 5 seconds (this is also theminimum value you can enter)

Maximum number
of Multi-Views

Themaximum number of Multi-Views that can be open simultaneously. Once the
maximum number of openMulti-Views has been reached, a popup window is
displayed informing the user, and no additional Multi-Views can be opened.

This number is dependent on the caching frequency; increasing the cache clearing
interval reduces the number of views that can be open simultaneously.

Note:Youmust restart SiteScope if you change this setting.

Default value: 20 (must be a value between 1 and 20)

Interval before
clearing view cache
since last used
(seconds)

Amount of time, in seconds, to wait since a view was last used, before clearing the
cache.

This number impacts the number of Multi-Views that can be open simultaneously;
increasing the cache clearing interval reduces the number of views that can be
open simultaneously.

Note:Youmust restart SiteScope if you change this setting.

Default value: 120 seconds (5 seconds is theminimum value)
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Template Settings
User interface elements are described below:

UI Element Description

Allow creation of template monitors
directly under a template entity

Enables adding amonitor directly under a template without
creating a group in the template.

Note:

l Youmust restart SiteScope if you change this setting.
l Monitors added directly under a template are not
supported by the Publish Template Changes Wizard.

Default value: Not selected

Property name: _
allowTemplateMonitorDirectlyUnderTemplate

Persistency Settings
User interface elements are described below:

UI Element Description

Maximum
changes per
persistency delta
file

Maximum number of persistency changes kept in each persistency delta file.

Default value: 51

Note:Youmust restart SiteScope if you change this setting.

Property name: _PersistencyMaxChangesInDeltaFile

Maximum
persistence
history items

Maximum number of history items kept in persistence.

Default value: 1000

Property name: _PersistencyMaxHistoryItems

Maximum
persistence
history size

Maximum size, in bytes, of persistence history.

Default value: 20000

Note:Youmust restart SiteScope if you change this setting.

Property name: _PersistencyMaxHistorySize

Maximum
persistency delta
files

Maximum number of delta files kept in persistence. After this number is reached, a
new snaphot (.ssf) file is created with all the persistency objects. All old .ssf files are
moved to the history folder.

Default value: 100

Property name: _PersistencyMaxDeltaFiles
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Maximum temp
directory size

Maximum size, in kilobytes, of the temp directory.

Default value: 10000

Note:Youmust restart SiteScope if you change this setting.

Property name: _tempDirMaxSize

Report Settings
User interface elements are described below:

UI Element Description

Default time length for report
(hours)

Default time period for includingmonitoring data in a Quick or Alert
report.

Default value: 1 hour

Property name: _quickReportDefaultTimePeriod

Include alert.log.old in report Includes the alert.log.old file in the Alert Report.

Default value:Selected

Property name: _includeAlertLogOld

Maximum errors in monitor
history report

Maximum number of errors shown in themonitor history report.

Default value: 100

Property name: _maxReportErrors

Maximum samples in the
history report

Maximum number of samples (readings or lines) in the history report.

Default value: 100

Property name: _reportMaxBuckets

Maximum warnings in monitor
history report

Maximum number of warnings shown in themonitor history report.

Default value: 100

Property name: _maxReportWarnings

Use advanced sampling
algorithm in report

Defines the time between samples in the report as theminimum of all
reportedmonitor frequencies.

Default value:Not selected

Property name: _useReportAdvancedSamplingAlgorithm
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Baseline Settings
User interface elements are described below:

UI Element Description

Activation
thread priority

Priority assigned to the activation thread. The priority, if specified, must be between 1-
10, inclusive. If not specified, the priority is set to 1. Generally, the higher the priority,
the faster the baselines are activated. Keep the priority as low as possible, so as not to
interfere with SiteScope online functionality.

Default value: 1 (low priority)

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningActivationThreadPriority

Automatically
create an error
boundary if no
error thresholds
are defined

Automatically creates a baseline threshold using the error boundary offset value when
no error thresholds have been defined for amonitor.

Default value:Selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningAutomateUpperBoundCreation

Calculation
thread priority

Priority assigned to the calculation thread. The priority, if specified, must be between 1-
10 inclusive. If not specified, the priority is set to 1. Generally, the higher the priority,
the faster the baseline calculations take to complete. Keep the priority as low as
possible, so as not to interfere with SiteScope online functionality.

Default value: 1 (low priority)

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningCalculationThreadPriority

Failed parsings
handler thread
priority

Priority assigned to the failed parsing thread handler. The priority, if specified, must be
between 1-10 inclusive. If not specified, the priority is set to 1. Generally, the higher the
priority, the faster the baseline calculations take to complete. Keep the priority as low
as possible, so as not to interfere with SiteScope online functionality.

Default value: 1 (low priority)

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningFailedParsingHandlerThreadPriority

Include today's
data in
calculation

Specifies whether to include the current day's data in the baseline calculation.

Default value:Selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningCalculationIncludesToday
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Interval for
saving baseline
data to disk
(minutes)

Interval, in minutes, used by SiteScope to save baseline data accumulated in the
memory to the disk. A shorter interval reduces thememory consumption, but increases
the vulnerability to failures and reduces performance.

Default value: 30minutes

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningSaveAccumulatedDataIntervalMinutes

Maximum
number of days
to include in
calculation

Number of days of historical data that are included in baseline calculations. The higher
the number, themore precise the baseline result, but the calculation takes more time
and uses more disk space. Data that is older than this value is not included in the
calculation. For more details on the calculationmodel, see "Baseline Threshold
Values" on page 288.

Default value: 30 days

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningDaysToIncludeInCalculation

Maximum
number of
percentile
ranges

Limits the number of percentile ranges displayed in the Percentile Ranges Mapping
Table.

Default value: 8

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningMaxNumberOfPercentilesRanges

Minimum
number of days
required for
baselining

Minimum number of days that themonitors must have run for SiteScope to calculate
the baseline.

Default value: 14 days

Minimum value: 1 (if you enter a value of less than 1, the default value is used
instead).

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningMinimumNumberOfDays

Minimum
number of
samples
required for
baselining

Minimum number of samples required for SiteScope to calculate the baseline.

Default value: 2016 (the number of samples produced for amonitor running over a two
week period, where themonitor runs every 10minutes)

Minimum value: 1 (if you enter a value of less than 1, the default value is used
instead).

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningMinimumNumberOfSamples
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Offset for
calculating error
boundary

Offset value to use for calculating the error boundary. The baseline threshold is
multiplied by this value when:

l TheAutomatically create Error Threshold Boundary if no error thresholds
are defined option is selected (see below), or

l The current most extreme error threshold is less extreme than the calculated
baseline threshold.

Default value: 0.3

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningUpperBoundOffset

Parsing chunk
size

Number of monitors that are handled simultaneously by the log file parser. The higher
the number, the faster the baselining calculation, but more file handlers are used.

Default value: 100

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningParsingChunkSize

Parsing thread
priority

Priority assigned to the parsing thread. The priority, if specified, must be between 1-10
inclusive. If not specified, the priority is set to 1. Generally, the higher the priority, the
faster the baseline calculations take to complete. Keep the priority as low as possible,
so as not to interfere with SiteScope online functionality.

Default value: 1 (low priority)

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningParsingThreadPriority

Percentile of
discarded
samples

Percentile of themost extreme samples (considered "noise" measurement samples)
that are not included in the baseline calculation.

Default value: 2.0

Note:Youmust restart SiteScope if you change this setting.

Property name: _baseliningNoiseMarginPercentile
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Analytics Settings
User interface elements are described below:

UI Element Description

Analytics
enabled

Enables the predictive analytics mechanism in SiteScope. If this setting is cleared, the
analytics calculation engines are stopped and analytics is disabled in the user interface.

Default value:Selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsEnableDisableCalculation

Automatic
tagging

SiteScope automatically generates an analytics tag value for each analytics
configuration which it assigns to the business monitor. The tag value is in the format
analytics_<monitor_name>, followed by a number in parenthesis if there is more than
onemonitor with the same name.

Default value:Selected

Note:Youmust restart SiteScope if you change this setting.

Property name: _enableAnalyticsAutoTagging

Baseline
calculation:
core thread
pool size

Maximum number of threads to create in the analytics baseline calculation thread pool.
Additional threads are created (up to themaximum) only if all the core threads are busy
and themaximum queue size has been reached.

For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor.html
.

Default value: 1

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineCalculatorThreadPoolSize

Baseline
calculation:
maximum
queue size

Maximum number of analytics baseline calculation tasks that can be added to the queue
when the thread pool is at full capacity.

For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor.html
.

Default value: 5000

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineCalculatorMaxQueueSize
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UI Element Description

Baseline
calculation:
maximum
thread pool
size

Maximum number of threads in the analytics baseline calculation thread pool. More
threads than the core number are created only if all the core threads are busy and the
maximum queue size has been reached.

For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor.html
.

Default value: 1

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineCalculatorMaxThreadPoolSize

Baseline
calculation:
monitors per
thread

Maximum number of monitor baseline calculations to run by a single thread. A larger
number requires more physical memory. A smaller number prolongs the calculation.

Default value: 100

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineCalculationMonitorPerThread

Baseline
calculation
data period
(milliseconds)

Time period (in milliseconds) of historical data over which the analytics baseline
calculation is performed. Data older than this value is excluded from the calculation.

Default value: 2592000000milliseconds (equivalent to 1month)

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineCalculationPeriod

Baseline
calculation
frequency
(milliseconds)

Frequency that the baseline calculation is performed.

Default value: 604800000milliseconds (1 week)

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineTaskRepeatePeriod

Baseline
results aging
period
(milliseconds)

Period of time that baseline results created from SiteScope data have been inactive,
before removing them from persistency.

Default value:432000000milliseconds (5 days)

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineResultAgingPeriod
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UI Element Description

Baseline
sleeve
coefficient

The coefficient is the number of standard deviations above or below themean. A metric
is considered to be abnormal if its value is higher or lower than themean plus or minus
the baseline standard deviationmultiplied by the coefficient.

By default, the baseline sleeve is calculated using a coefficient of + or - 3 times the
standard deviation from ametric's mean value.

This means that ametric is considered abnormal if its value is greater than themean
value plus 3 times the standard deviation, or less than themean valueminus 3 times the
standard deviation.

Default value: 3

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsBaselineBandWidth

Correlation
calculation:
core thread
pool size

Number of threads to create in the analytics correlation calculation thread pool.
Additional threads are created (up to themaximum) only if all the core threads are busy
and themaximum queue size has been reached.

For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor.html
.

Default value: 5

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsCorrelationCalculatorThreadPoolSize

Correlation
calculation:
maximum
queue size

Maximum number of analytics correlation calculation tasks that can be added to the
queue when the thread pool is at full capacity.

For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor.html
.

Default value: 5000

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsCorrelationCalculatorMaxQueueSize

Correlation
calculation:
maximum
thread pool
size

Maximum number of threads in the analytics correlation calculation thread pool. More
threads than the core number are created only if all the core threads are busy and the
maximum queue size has been reached.

For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor.html
.

Default value: 30

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsCorrelationCalculatorMaxThreadPoolSize
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UI Element Description

Correlation
data retention
period (hours)

Time period (in hours) of historical data over which the analytics correlation calculation
is performed. Data older than this value is excluded from the calculation.

Default value: 10 hours

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsCorrelationCalculationTimePeriod

Correlation
result aging
period
(milliseconds)

The period of time, in milliseconds, after which a correlation calculation is considered as
old enough to be re-calculated in case a new analytics alert is fired.

Default value: 3600000 (1 hour)

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsCorrelationAgingMillis

Correlation
score
threshold (%)

The value, as a percentage, above which twometrics are considered correlated. Any
twometrics with a score lower than this value are not considered correlated. The score
determines what results are displayed in the Correlation Results panel and in the
analytics alert.

Default value: 60

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsCorrelationScoreThreshold

Excluded
monitor types

Lists themonitor types that are not available for analytics (generally systemmonitors).
You can add or removemonitor types from this list as required. If you addmonitor types
to this list, youmust use the "topaz name" of themonitor as listed in "How to Use the
Data Acquisition API" on page 142.

Default value:AmazonCloudWatch;CPU;Disk
Space;Memory;Ping;Composite;DHCP;Directory;DNS;Dynamic Disk Space;File;FTP
Monitor;Generic Hypervisor;HP iLO;NonStop
Resources;IPMI;KVM;HyperVMonitor;NT Dialup;Browsable NT Counters;Dynamic
Microsoft Windows Resources;Windows Services State;Network Bandwidth
Monitor;Port;SAP Performance;Service;SNMP;SNMP by MIB Monitor;SNMP
Trap;Unix Resources;VMware DatastoreMonitor;VMware Host CPU Monitor;VMware
Host Memory Monitor;VMware Host Network Monitor;VMware Host State
Monitor;VMware Host StorageMonitor;Vmware;Radius;Solaris Zones;Siebel
Log;HAProxy Monitor;DatabaseCounter;Log Event Health Monitor;Monitor Load
Monitor;BAC Integration Statistics;Health Server LoadMonitor;BAC Integration
Configuration;SSL Certificates Status;Connection Statistics Monitor;Dynamic
Monitoring Statistics;License Usage

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsNotSupportedMonitorTypes
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UI Element Description

Maximum
number of
target monitors

Themaximum number of monitors that can be designated as targets of a givenmonitor
for correlationmatching.

Default value: 700

Note:Youmust restart SiteScope if you change this setting.

Property name: _analyticsMaxMonitors

Stop all
baseline
calculations

If selected, stops all baseline calculations. Use to temporarily stop background
calculations without disrupting access to analytics in the user interface. Clear this
setting to resume baseline calculations.

Default value:Not selected

Property name: _analyticsCorrelationAndBaselineCalculationStop

Event Console Settings
User interface elements are described below:

UI
Element Description

Event
Console
enabled

When selected, new events triggered from Event Console alert actions are displayed in the
Event Console. When the setting is cleared, no new events are triggered from Event Console
alert actions.

Default value:Selected

Property name: _eventConsoleEnabled

Event
Console
UI
logging
enabled

Enables sending errors from the Event Console user interface to the event_console_ui.log
on the SiteScope server.

Default value:Selected

Property name: _eventConsoleUiLoggingEnabled

Maximum
number
of
historical
events

Themaximum number of historical events that can be retrieved from the server logs for display
in the Event History view of the Event Console. This value cannot exceed 5000. Once the
display limit is reached, the oldest events are removed from the Event History view, but they
are still available in the event_console_history.log files (events are never removed from a log
file). The number of history files saved is 40 (one per day). When the 41st day is reached, the
oldest file is deleted.

Default value: 1000

Property name: _eventConsoleMaxHistorcalEvents
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UI
Element Description

Maximum
number
of LDAP
users to
retrieve

Maximum number of LDAP users to retrieve from the LDAP server when loading the users list
to the Event Console. This value cannot exceed 1000.

Note: If you have an Active Directory domain that exceeds this number of users, you cannot
assign an event to an LDAP user that is not listed in the results retrieved from the LDAP
server, even if youmanually enter the email address of the user.

Default value: 400

Property name: _eventConsoleMaxLdapUsers

Maximum
number
of live
events

Themaximum number of live (non-closed) events to store on the server and display in the
Event Console (this value cannot exceed 5000). Once this limit is reached, the oldest events
are automatically closed and displayed in the Event History view, and are written to the event_
console_history.logwith (CLOSED BY AUTOMATIC PURGE)message enabling you to
identify these events. Events are never removed from the log files. You can configure the
number of logs files that can be saved via the log4j.properties file.

Default value: 1000

Property name: _eventConsoleMaxLiveEvents

Number
of
previous
hours of
historical
events to
retrieve

The number of previous hours of historical events to retrieve from the server logs for display in
the Event History view of the Event Console. This value cannot exceed 168 hours (1 week).

Default value: 48 hours

Property name: _eventConsoleMaxHistoryHours

Custom Settings
This table contains some of themore commonly-used custom settings.

User interface elements are described below:

UI Element Description

Access controlled SiteScope is used in securemode. To use auto
template deployment when SiteScope is in secure
mode, see "Deploy Templates Automatically Using
an XML File" on page 732.

Default value: true

Property name: _accessControlled
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Analytics Min Data Days For Seasonality Theminimum number of days of data required for the
baseline to calculate seasonality. If the number of
data days is less than this value, no seasonality
calculation will occur.

Default value: 4

Property name: _
analyticsMinDataDaysForSeasonality

Analytics Min Distinct Values No For
Seasonality

Theminimum number of data points required for the
baseline to calculate seasonality. If the number of
data points is less than this value, no seasonality
calculation will occur.

Default value: 10

Property name: _
analyticsMinDistinctValuesNoForSeasonality

Analytics Min Distinct Values No For Trend Theminimum number of data points required for the
baseline to calculate the trend. If the number of data
points is less than this value, no trend calculation
will occur.

Default value: 10

Property name: _
analyticsMinDistinctValuesNoForTrend

Analytics Min Samples In Bucket Length Theminimum number of data points a bucket
(internal algorithm terminology) must have in order to
be taken into the calculation.

Default value: 2

Property name: _
analyticsMinSamplesInBucketLength

Analytics Min Samples No For Baseline Theminimum number of data points that is required
for the baseline to be calculated. If the number of
data points is less than this value, no baseline
calculation will occur.

Default value: 50

Property name: _
analyticsMinSamplesNoForBaseline
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Analytics Min Samples No For Seasonality Theminimum number of data points that is required
for seasonality to be calculated. If the number of
data points is less than this value, no seasonality
calculation will occur.

Default value: 50

Property name: _
analyticsMinSamplesNoForSeasonality

Analytics Min Samples No For Trend Theminimum number of samples for enabling the
trend calculation. This is a parameter that impacts
internal algorithms. We do not recommend changing
this value without first consulting with
HPE Software support.

Default value: 5

Property name: _analyticsMinSamplesNoForTrend

Analytics Outlier Removal Coef The number of standard deviations used to validate
if outlier removal should be done (outlier is data that
is outside the predictive analytics baseline sleeve).
This parameter impacts internal algorithms. We do
not recommend changing this value without first
consulting with HPE Software support.

Default value: 3

Property name: _analyticsOutlierRemovalCoef

Analytics Outlier Removal Confidence Diff
Thres

The number of standard deviations used to set the
threshold if outlier removal should be done (outlier is
data that is outside the predictive analytics baseline
sleeve). This parameter impacts internal algorithms.
We do not recommend changing this value without
first consulting with HPE Software support.

Default value: 4

Property name: _
analyticsOutlierRemovalConfidenceDiffThres
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UI Element Description

Analytics Outlier Removal Min Confidence Theminimum value, below which, outlier (data that
is outside the predictive analytics baseline sleeve) is
removed from the results. This parameter impacts
internal algorithms. We do not recommend changing
this value without first consulting with
HPE Software support.

Default value: 95

Property name: _
analyticsOutlierRemovalMinConfidence

Analytics Season Significance Threshold The significance of seasonality in which a season
found is used. This parameter impacts internal
algorithms. We do not recommend changing this
value without first consulting with HPE Software
support.

Default value: 0.03

Property name: _
analyticsOutlierRemovalMinConfidence

Analytics Trend Significant P Value The Statistical P value for which the trend is being
assumed to exist. This parameter impacts internal
algorithms. We do not recommend changing this
value without first consulting with HPE Software
support.

Default value: 0.001

Property name: _analyticsTrendSignificantPValue

Analytics Trend Significant R Square The Statistical R Square value in which trend is
being assumed to exist for. This parameter impacts
internal algorithms. We do not recommend changing
this value without first consulting with
HPE Software support.

Default value: 0.7

Property name: _
analyticsTrendSignificantRSquare

Auto Deployment Check Frequency (seconds) Time interval in seconds that the auto template
deployment xml files in the
persistency\autodeployement directory are
deployed. For details, see "Deploy Templates
Automatically Using an XML File" on page 732.

Default value: 120

Property name: _autoDeploymentCheckFrequency

Using SiteScope
Chapter 50: Infrastructure Preferences

HPE SiteScope (11.33) Page 557 of 1206



UI Element Description

Custom monitor maximum number of script
parameters

Maximum number of parameters allowed in the
table. When themaximum number of rows is
reached, no additional rows can be added.

Default value: 10

Property name: _
customMonitorMaxNumOfScriptParams

Note:Youmust restart SiteScope if you change this
setting.

DockerMinimumContainerRunningTimeInMinut
es

Minimum amount of time, in minutes, that containers
must be running before they aremonitored. This is
used to avoid unnecessarily monitoring containers
(those that are dropped after a short period of time).

Default value: 1minute

Minimum value: 1minute

Property name: _
DockerMinimumContainerRunningTimeInMinutes

dynamicDockerAppDiscoverCheckContainersE
xistencesRateInMinutes

Amount of time, in minutes, to wait before checking
for the existence of groups that were deployed on
containers that no longer exist. When a container no
longer exists, the discovery mechanism
automatically deletes any groups deployed on the
container.

Default value: 1440minutes (24 hours)

Minimum value: 5minutes

Property name: _
dynamicDockerAppDiscoverCheckContainersExist
encesRateInMinutes

dynamicDockerAppDiscoverConfigFilesSample
RateInSeconds

Frequency, in seconds, for checking the config file
directory for changes. If a new config file is added, or
an existing file is deleted, the config file list is
updated.

Default value: 30 seconds

Minimum value: 30 seconds

Property name: _
dynamicDockerAppDiscoverConfigFilesSampleRat
eInSeconds
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dynamicDockerAppDiscoverDeployTemplateAtt
empts

The number of attempts to redeploy templates or
publish template changes on some container. This
variable influences the _
dynamicDockerAppDiscoverReDeployTemplate
sRateDueToConfigFileChangesInMinutes and _
dynamicDockerAppDiscoverDeployTemplateRe
triesRateInMinutes schedulers.

Default value: 3 attempts

Minimum value: 1 attempt

Property name: _
dynamicDockerAppDiscoverDeployTemplateAttem
pts

dynamicDockerAppDiscoverDeployTemplateRe
triesRateInMinutes

Amount of time, in minutes, to wait before
attempting to deploy template or publish template
changes after the previous attempt failed. The
mechanism attempts to deploy the template on this
container the number of times specified in the _
dynamicDockerAppDiscoverDeployTemplateAtt
empts parameter. If all attempts fail, the container is
removed from the waiting list.

Default Value: 30minutes

Minimum value: 5minutes

Property name: _
dynamicDockerAppDiscoverDeployTemplateRetrie
sRateInMinutes

dynamicDockerAppDiscoverReDeployTemplate
sRateDueToConfigFileChangesInMinutes

Amount of time, in minutes, to wait between
checking whether the config files were updated. If
config files were updated, the discovery mechanism
searches for all groups that were deployed by the
config files and attempts to redeploy templates or
publish template changes.

Default value: 15minutes

Minimum value: 5 minutes

Property name: _
dynamicDockerAppDiscoverReDeployTemplatesR
ateDueToConfigFileChangesInMinutes
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dynamicDockerAppDiscoverThreadPullSize Amount of thread handlers that handle Docker
monitor deletion, application group deletion, and
docker monitor configuration updates from Dynamic
Docker monitors.

Default value: 15 thread handlers

Minimum value: 1 thread handler

Property name: _
dynamicDockerAppDiscoverThreadPullSize

Generic Event Integration save data to zip Indicates whether the data is saved to the cache as
a .zip file. SiteScope creates a folder named after
the integration’s ID, and within that folder, a file for
each sample cache file in the format:

l (<numberOfEvents>EC_<time-
stamp>.<CacheSuffix>

l <numberOfEvents>EC_<time-
stamp>.<CacheSuffix>.zipped (for zipped
files)

Default value: true

Property name: _
genericEventIntegrationGDSaveZipped

Generic Event Integration resend cache file
interval (minutes)

The interval between each resending of cache files.

Default value: 5minutes

Property name:
_genericEventIntegrationGDIntervalMinutes

Generic Event Integration file count to delete When the cache folder reaches its maximum size,
SiteScope deletes X files from the cache according
to this value. If the value is -1, SiteScope deletes
half of the files in the cache folder (deleting the
oldest files first).

Default value: -1

Property name:
_genericEventIntegrationGDFileCountToDelete
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Generic Event Integration maximum cache size
(MB)

Indicates themaximum size of the cache in
megabytes. When the cache reaches this value,
SiteScope deletes files from the cache (according to
the
_genericEventIntegrationGDFileCountToDelete
parameter).

Default value: 10MB (this valuemust be an integer)

Property name:
_genericEventIntegrationGDCacheMaxSizeMB

Microsoft Windows Event Log monitor WMI
query hour range in first run

If theMicrosoft Event Logmonitor fails to get data
fromWindows remote servers with large amounts of
log items when using theWMI connection type,
change the query hour range of the first monitor run.

Default value: 168 hours (7 days).

Property name: _
ntEventLogWMIQueryHourRangeFirstRun

Save copy of content package with extended
files only

Content packages that contain a template with no
Custommonitors (for example, a template with CPU
monitor only), are no longer saved to the
<SiteScope root directory>\packages\imported
folder. You can override this setting if necessary and
save a copy of the package by changing this
property to true.

Default value: false

Property name: _
saveCopyOfContentPackageWithExtendedFilesOn
ly

Script monitor allow symbolic link Enables support for symbolic links when executing
scripts on remote UNIX servers. When enabled, the
symbolic link appears in the list of available scripts
when configuring a Script monitor to monitor a UNIX
remote.

Default value: false

Property name: _scriptMonitorAllowSymbolicLink

Using SiteScope
Chapter 50: Infrastructure Preferences

HPE SiteScope (11.33) Page 561 of 1206



UI Element Description

Siebel connect command Enables you to customize the command for
connecting to the Siebel server. For details, see
Siebel Application Server Monitor in the SiteScope
Monitor ReferenceGuide.

Default value: $PARAM_PATH$/srvrmgr /g
$PARAM_GATEWAY$ /e $PARAM_
ENTERPRISE$ /s $SERVER$ /u $PARAM_
USERNAME$ /p $PARAM_PASSWORD$ /k
%%%

Property name: _siebelConnectCommand

SSH open connections limit Enables you to close idle connections when the
maximum number of open SSH connections are
reached.

Default value: 500

Property name:  _sshOpenConnectionsLimit

System log match regular expression Enables you to determine how regular expression
strings are combined for the Syslogmonitor.

Default value: /^[0-9A-Za-z ]*[0-9:9\.\,]+[ ]+[^ ]+[ ]+
{process}:{message}$/

Property name: _sysLogMatchRegExp

Unix SSH timeout (seconds) Timeout value in seconds for the command
execution.

Default value: 60

Parameter Name: _UNIXSSHTimeoutSeconds

VMware maximum idle connections in pool Themaximum number of idle connections in the
pool.

Default value: 60

Property name: _
vmWareConncectionPoolMaxIdlePervCenterKey

VMware connection active connections in pool Themaximum number of active connections in the
pool.

Default value: 60

Property name: _
vmWareConnectionPoolMaxSizePervCenterKey

VMware connection timeout (minutes) Connection timeout in minutes.

Default value: 30

Property name: _vmWareConnectionTimeOut
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Chapter 51: Integration Preferences
Using the Integration Preferences interface, you can create integration instances, enabling SiteScope to
report monitoring data to the following applications:

l Amazon CloudWatch
Formore details on the integration, see "Amazon CloudWatch Integration Preferences" below.

l Azure
Formore details on the integration, see Azure Integration Preferences.

l Business Service Management
Formore details on the integration, see "BSM Integration Preferences" on page 567.

l Diagnostics
Formore details on the integration, see "Diagnostics Integration Preferences" on page 573.

l Operations Manager
Formore details on the integration, see "HP Operations Manager Integration Preferences" on page 577.

l Generic Data Integration (metrics)
Formore details on the integration, see "Generic Data Integration Preferences" on page 584.

l Generic Event Integration
Formore details on the integration, see "Generic Event Integration Preferences" on page 588.

Amazon CloudWatch Integration Preferences
This dialog box enables you to create a new Amazon CloudWatch integration or to edit an existing integration.
This enables customers who use SiteScope for monitoring their AWS-hosted applications to report SiteScope
metrics to Amazon CloudWatch service.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:

l Click theNew Integration button, and select Amazon CloudWatch Integration, or
l Select an existing Amazon CloudWatch integration, and click Edit Integration.

Note: Youmust be an administrator in SiteScope, or a user grantedView integration preferences
permissions to be able to view Integration Preferences. Edit integration preferences permissions are
required to create or edit Integration Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About

Amazon CloudWatch Integration Overview
Amazon CloudWatch is aWeb service that provides monitoring for AmazonWeb Services (AWS) cloud
resources, starting with Amazon EC2. It provides visibility into resource utilization, operational performance,
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and overall demand patterns—includingmetrics such as CPU utilization, disk reads and writes, and network
traffic.

This integration enables customers who use SiteScope for monitoring their AWS-hosted applications to report
any SiteScopemetrics to Amazon CloudWatch service. After running the AmazonWeb Services monitor,
SiteScope reports data to Amazon CloudWatch. This data can then be used for AWS AutoScaling, reporting,
and alerting. For details on configuring themonitor, see AmazonWeb Services Monitor in the SiteScope
Monitor ReferenceGuide.

To enable SiteScope to report data to Amazon CloudWatch, youmust configure the integration using the
Amazon CloudWatch Integration Preferences dialog box.

UI Descriptions

Amazon CloudWatch - General Settings
User interface elements are described below:

UI Element Description

Name Name by which to identify this integration in the SiteScope interface.

Note: This is a required field.

Description Description of the integration. This could include information on the application receiving the
data from SiteScope. This description appears only in the Integration Preferences page in
SiteScope.

Amazon CloudWatch - Integration Preferences Settings
User interface elements are described below:

UI Element Description

Namespace The namespace corresponding to the service of interest. This is a required field.

Note:

l You cannot specify a namespace that begins with "AWS/". Namespaces that begin
with "AWS/" are reserved for other AmazonWeb Services products that send
metrics to Amazon CloudWatch.

l Namespace is limited to amaximum of 250 characters.
Default value:HP/SiteScope

Encoding Encoding used by the receiving application.

Default value:UFT-8

Reporting
interval
(seconds)

Time in seconds between when SiteScope finishes sending data to the next period
SiteScope begins sending data. This is a required field.

Default value: 60 seconds
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Time
synchronization
interval
(minutes)

To synchronize between the time of the SiteScope server and the server receiving
SiteScope data, SiteScope can periodically report the time that is registered on its
server. The receiving server can then synchronize the time of the data samples coming
from SiteScope with the time on its own server so that there is no discrepancy between
the time of the SiteScope data and the application's own data.

Select in minutes how often you want SiteScope to report to the time of the SiteScope
server to the server receiving SiteScope data.

Default value: 10minutes

Request
timeout
(seconds)

Timeout, in seconds, until a connection is established with the server. A value of zero
means there is no timeout used.

Note: This is a required field.

Default value: 120 seconds

Connection
timeout
(seconds)

Socket timeout, in seconds, to wait for data. A timeout value of zeromeans there is no
timeout used. This is a required field.

Default value: 120 seconds

Number of
retries

Number of times SiteScope attempts to establish a connection.

Default value: 3

Disable
integration

SiteScope does not forward data to the server. The integration preference setting
remains. Use when temporarily disabling the integration.

Default value:Not selected

Amazon CloudWatch - Security Settings
User interface elements are described below:

UI
Element Description

AWS
Access
Key ID

An alphanumeric token that uniquely identifies you as the party responsible for service requests.
This ID is associated with your AWS Secret Access Key.

AWS
Secret
Key

The secret key assigned to you by AWS when you sign up for an AWS account. Used for
request authentication.

Region The Amazon EC2 region that is used to get or storemeasurements.

Amazon EC2 is currently available in the following regions: US East (Northern Virginia), US
West (Oregon), US West (Northern California), EU (Ireland), Asia Pacific (Singapore), Asia
Pacific (Sydney), Asia Pacific (Tokyo), South America (Sao Paulo), and AWS GovCloud.
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UI
Element Description

Get
Regions

Opens theGet Regions dialog box, enabling you to select the Amazon EC2 region used to get or
storemeasurements.

Amazon CloudWatch - Proxy Server Settings
User interface elements are described below:

UI Element Description

NTLM V2 Proxy Select if the proxy requires authentication using NTLM version 2.

Default value:Not selected

Address Proxy server address if applicable.

User name Username for the proxy server.

Password Password for the specified server.

Amazon CloudWatch - Reporting Tags
User interface elements are described below:

UI
Element Description

<Tag
name
and
values>

SiteScope uses the tag selected here to determine what data is forwarded to the receiving
application. Youmust select at least one tag for each integration. That same tagmust be
selected for the groups, subgroups, andmonitors whose data you want forwarded to the
receiving application.

When selecting an integration tag for an object, the tag propagates to that object's children. If
you tag a group with this Integration tag, all its subgroups andmonitors report their status to the
receiving application.

Example: Create a tag called Integration_ACW and select it here. For each group, monitor, or
both, whose status you want to report to the receiving application, select this tag under the
Search/Filter Tags setting for the object.

Note:

l You can select multiple tags for each integration preference. You can select multiple
Integration tags for the objects to be reported.

l The selected reporting tagmust contain a tag value description.
l SiteScope is unable to sendmetrics to the Amazon CloudWatch service if default reporting
tags (from theMonitor Deployment Wizard group) are used.

Using SiteScope
Chapter 51: Integration Preferences

HPE SiteScope (11.33) Page 566 of 1206



UI
Element Description

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Tip: Use the word Integration_<integration identifier>when creating an integration tag,
since this tag appears along with all other Search/Filter tags created for the SiteScope. This
helps you to identify which tag to select for enabling a group or monitor for the integration.

Note:

l The selected reporting tagmust contain a tag value description.
l SiteScope is unable to sendmetrics to the Amazon CloudWatch service if default reporting
tags (from theMonitor Deployment Wizard group) are used.

Tips/Troubleshooting

Notes/Limitations
l SiteScope is able to report numeric counters only to Amazon CloudWatch, and they must have aminimum
length of 1 character and amaximum length of 255 characters.

l Amazon CloudWatch does not allow names of counters which contain non-ASCII characters. As a result,
if a counter contain non-English characters in name, Amazon rejects all themonitor's counters.

l Amazon CloudWatch truncates values with very large and very small exponents; values with base-10
exponents greater than 126 (1 x 10^126), and values with less than -130 (1 x 10^-130) are truncated.

l The Amazon CloudWatch integration cannot sendmore than 20metrics to the Amazon CloudWatch
service in one request.

l Allow up to 15minutes for themetric to appear in Amazon CloudWatch.
l It is currently not possible to delete SiteScopemetrics reported to the Amazon CloudWatch service. As a
result, metrics are automatically removed from Amazon after two weeks if they are not updated.

l By default, SiteScope gets data from AWS-hosted applications at a 2-minutes interval. You can
customize the period for receiving data from Amazon by adding the _
amazonCloudWebServiceMonitorPeriod property (and a value in minutes) to the <SiteScope root
directory>\groups\master.config file. For example, _amazonCloudWebServiceMonitorPeriod=10
means that SiteScope gets the average values of metrics for the last 10minutes.

BSM Integration Preferences
This dialog box enables you tomodify APM integration settings and to create a new APM integration for a
profile that was created in SAM Administration but when the SiteScope was inaccessible.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:

l Click theNew Integration button, and select BSM Integration, or
l Select an existing BSM integration, and click theEdit Integration button.
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Note: Youmust be an administrator in SiteScope, or a user grantedView integration preferences
permissions to be able to view Integration Preferences. Edit integration preferences permissions are
required to create or edit Integration Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About
This section contains the following topics:

l "APM Integration Preferences Overview" below
l "Using a Secure Connection for SiteScope-APM Communication" below
l "Changing the Gateway Server toWhich SiteScope Sends Data" on the next page
l "Compressing SiteScope Data Sent to APM" on the next page

APM Integration Preferences Overview
To enable logging of SiteScopemonitor data to APM, the SiteScopemust be configured as a data collector for
APM. This involves adding a SiteScope to the System Availability Management (SAM) Administration page in
the APM. After the SiteScope is added and a connection is established, a APM Integration Preference
appears in the Integration Preferences page that includes the relevant configurations as entered in the New
SiteScope Page in SAM Administration.

You use the Integration preference to:

l Modify the available integration settings.
l Disable logging all data to APM. This includes topology reporting.
l Create an integration for an empty SiteScope profile. If when adding the SiteScope to SAM Administration,
the SiteScope was not accessible to APM (for example, when working in Software-as-a-Service), you add
a SiteScope with an Inaccessible profile to SAM Administration. You then configure the connection and
the integration in the Integration Preferences. For details on this task, see "How to Configure SiteScope-
APM Integration Preferences for Inaccessible Profiles" on the next page.

If the APM Server to which you are connecting is on a different machine than the APM Server that SiteScope
reports data, youmust provide connection information for both servers under theMain Settings in
SiteScope's Integration Preferences, or in theDistributed Settings in SAM Administration's New SiteScope
Page.

Using a Secure Connection for SiteScope-APM Communication
You can use a secure connection to transmit data from SiteScope to the APM server. If you have installed a
certificate signed by a root Certificate Authority on the APM server, no additional setup is required on the
SiteScope server. If you are using a self-signed certificate on the APM server and want to use that certificate
for secure communication with SiteScope, youmust perform the appropriate step below:

l For APM server that requires a secure connection, see "How to Connect SiteScope to a BSM Server That
Requires a Secure Connection" on page 195.

l For APM server that requires a client certificate, see Configuring SiteScope to Connect to a APM Server
That Requires a Client Certificate in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

Note:
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l You only need to specify these settings if the certificate installed on the APMmachine is not signed
by a root Certificate Authority (CA). For example, if you are using a certificate signed by a Certificate
Authority such as Verisign, you do not need to change these settings.

l You can import the self-signed certificate into the same keystore file used for other SiteScope
monitors but that is not required. You can create a separate keystore for the APM server certificate.

Changing the Gateway Server to Which SiteScope Sends Data
You can change theGateway Server to which a SiteScope reports its data. Generally, this is applicable only if
you are working with a APM deployment with components installed onmore than one server. Youmake this
change by entering the required Gateway Server name or IP address in the Application Performance
Management machine name/IP address box in the Integration Preferences page. Youmust also update the
SiteScope settings with theGateway Server name in SAM Administration.

Note: This function can only be used for changing the Gateway Server for a SiteScope that is already
registered with a given APM installation. It cannot be used to add a new SiteScope, or to connect a
SiteScope to a different APM system.

Compressing SiteScope Data Sent to APM
By default, when data is sent from the SiteScope server to APM it is sent uncompressed. To enable data
compression of SiteScopemonitor (ss_monitor_t) and SiteScopemetric (ss_t) samples, set the property _
compressDataInGzipFormat= to true in the <SiteScope root directory>\groups\master.config file.
When this setting is enabled, SiteScope data is compressed in gzip before it is sent to APM (where it is
decompressed). Note that data compression can be used only when SiteScope is reporting to BAC 8.05 or
later, or APM 9.01 or later.

Tasks

How to Configure SiteScope-APM Integration Preferences for Inaccessible Profiles
This task describes the steps involved in configuring SiteScope as a data collector for APM when the
SiteScope is inaccessible to the APM, for example when working in Software-as-a-Service.

1. Add a SiteScope profile to APM
In APM, create an empty profile for the SiteScope in SAM Administration's New SiteScope page by
selecting Inaccessible profile.
For user interface details, see the New/Edit SiteScope Page in the APMUser Guide in the APMHelp.

2. Specify connection parameters to APM servers
In SiteScope, add a new APM Integration Preference to the Integration Preferences. Enter the values for
the APM integration. When adding the integration, click theGet Available Profile button and select the
empty profile you created in APM.
For user interface details, see "BSM IntegrationMain Settings" on the next page.

3. Configure a secure connection for SiteScope-APM communication
If you are using a self-signed certificate on the APM server and want to use that certificate for secure
communication with SiteScope, youmust perform the appropriate step below:
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l For a APM server that requires a secure connection, see "How to Connect SiteScope to a BSM
Server That Requires a Secure Connection" on page 195.

l For a APM server that requires a client certificate, see Configuring SiteScope to Connect to a APM
Server That Requires a Client Certificate in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

Related tasks: "How to Configure SiteScope to Communicate with BSM" on page 190, "How to Configure
Topology Reporting" on page 195

UI Descriptions

BSM Integration Main Settings
User interface elements are described below:

UI Element Description

Business
Service
Management
machine
name/IP
address

Machine name or IP address of the APM server to which you want this SiteScope to
connect.

Note: This is a required field.

SiteScope
agent
machine
location

Location of the SiteScope server that you are connecting to APM. You can specify any
value that helps you identify the location of this specific SiteScope server.

Note: This is a required field.

Disable all
logging to
Business
Service
Management

Stops SiteScope from sendingmetrics and data to APM. Clear the check box to enable
logging and data flow.

Note:

l This does not disable topology reporting.
l If SiteScope is configured to send data to APM and your SiteScope license edition
(Premium, Ultimate, or System Collector) expires, SiteScope stops sending all data
(including topology) to APM. When you renew the SiteScope license, youmust clear
this check box to enable logging and data flow to APM, since SiteScope automatically
disables logging to APM on license expiration.

Default value:Not selected

<profile> SiteScope profile in which APM stores the data collected by SiteScope.

Note: The profile must previously have been configured in APM's SAM Administration.

Get
Available
Profiles

Displays a list of available profiles. Use this button only if registering the SiteScope to an
empty profile (Inaccessible Profile) that was created in SAM Administration.
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UI Element Description

Business
Service
Management
user name

Username of a APM administrator-level user.

Business
Service
Management
user
password

Password for the specified user.

Web Server Security Settings
User interface elements are described below:

UI Element Description

Authentication user
name

User name to access the server if the APM server is configured to use basic
authentication.

Authentication
password

Password to access the server if the APM server is configured to use basic
authentication.

Use SSL (HTTPS
protocol)

Select if the APM server is configured to use the HTTPS protocol.

Default value:Not selected

Proxy Server Settings
User interface elements are described below:

UI Element Description

Address Proxy server address if applicable.

User name Username for the proxy server.

Password Password for the specified server.

Topology Reporting Settings
User interface elements are described below:
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UI Element Description

Topology
resynchronization
time interval (days)

Number of days for SiteScope to synchronize topology data with APM.

The topology information SiteScope reports to APM is synchronized when
SiteScope restarts after this time interval has been reached.

Default value: 7 days

Minimum value: 1 day

Note: All topologies created by SiteScope and stored in RTSM are subjected to the
aging process. To prevent aging, see "Integrate SiteScope Data with BSM's
Configuration Items" on page 183.

Default topology
probe domain

Default domain of the SiteScope topology probe.

Default value: DefaultDomain

Note:Youmust restart SiteScope if you change this setting.

Topology receiver
port

Topology receiver port used in APM.

Default value: 80

Note:Youmust restart SiteScope if you change this setting.

Topology receiver
SSL port

Topology receiver SSL port used in APM.

Default value: 443

Note:Youmust restart SiteScope if you change this setting.

Topology anti-
aging offset
(minutes)

Offset frommidnight, in minutes, for running the anti-aging process. For details on
anti-aging, see "Integrate SiteScope Data with BSM's Configuration Items" on
page 183.

Default value: 0

Note:Youmust restart SiteScope if you change this setting.

Example: To run anti-aging at 1:30 am, enter an offset of 90.

BSM Preferences Available Operations
User interface elements are described below:

UI Element Description

Reset Deletes all the APM related settings from the SiteScope server and all SiteScope
configurations are deleted from APM. This also sends amessage to the applicable APM
server to release the SiteScope agent from the corresponding profile.

Note: If you choose to reset the current settings, you have to create or use a different
profile to reconnect SiteScope with APM. APM does not enable you to select a previously
used connection profile.
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UI Element Description

Re-
Synchronize

Forces SiteScope to resend all its configuration data to APM. This data consists of all the
group andmonitor definitions. Re-synchronize also forces SiteScope to resend all topology
data to APM.

Note: If you upgrade to BSM 9.10 or later, you shouldmanually resynchronize SiteScope
instead of waiting for topology data to be sent to APM based on the Topology
resynchronization time interval value.

Hard Re-
Synchronize

Forces SiteScope to resend all its configuration data and topology data to APM. For
configuration data, it also deletes the existingmonitor and group data from APM for this
SiteScope profile.

Tips/Troubleshooting

Notes/Limitations
l To secure the connection to APM (since the APM user name and password are not used for
authentication), it is recommended to configure either Basic Authentication in SiteScope or use two-way
SSL. If APM is configured to use Basic Authentication, the same user name and password entered in the
Default authentication user name andDefault authentication password fields in SiteScope
(Preferences > General Preferences > General Settings) are used for reporting both data and topology
to APM. If APM is not configured to use Basic Authentication, the credentials sent are ignored.

l By default, data sent from the SiteScope server to APM is sent uncompressed. For details on enabling
data compression, see "Compressing SiteScope Data Sent to APM" on page 569.

Troubleshooting
For troubleshooting on reporting data to APM, see " Connecting to a BSM Server" on page 181.

Diagnostics Integration Preferences
SiteScope forwards data to Diagnostics enabling you to see amore complete view of the application servers
that aremonitored by Diagnostics. The data can provide insight into the infrastructure components onto which
the application servers are deployed.

For example, integrating data from the SNMP by MIB monitor can help determine problems with the
infrastructure on which the application server runs.SiteScope forwards data on groups, monitors, and
measurements. Diagnostics can read the data sent from SiteScope and present the data in its reports and
graphs.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:

l Click theNew Integration button, and select Diagnostics Integration, or
l Select an existing Diagnostics integration, and click theEdit Integration button.

Note: Youmust be an administrator in SiteScope, or a user grantedView integration preferences
permissions to be able to view Integration Preferences. Edit integration preferences permissions are
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required to create or edit Integration Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About

Units of Measurements in Diagnostics
SiteScope generates a file <SiteScope root directory>/conf/ integration/data_integration_uom.xml that
controls themappings of SiteScopemonitors to Diagnostics metrics and the units of measurement used for
themetrics. Diagnostics accepts data from SiteScope only if the data is associated with a unit of
measurement that Diagnostics can recognize. SiteScope units are captured from themonitored source and
may need to bemapped to the appropriate Diagnostics unit of measurement. The units of measurements used
by SiteScopemonitors vary, depending on the type of data beingmonitored. For example, the unit of
measurement used for the CPU monitor is a percentage and the unit of measurement used for the Disk Space
monitor is number of bytes. It is therefore recommended that youmodify the xml file as needed so that
Diagnostics recognizes the unit of measurement to use for themonitor data coming from SiteScope.

When new monitors are added to the SiteScope that report data to Diagnostics, it is recommended that you
edit the Diagnostics Integration Preference and click theGenerate UOM XML button. SiteScope generates a
list of currently deployedmonitors and their correspondingmetrics. This list merges with the <SiteScope root
directory>/conf/ integration/data_integration_uom.xml file and updates only those values in the xml file
that were not manually changed. If any values weremanually changed in the xml file, those values are not
updated and are preserved. This merge of information on units of measurements occurs when you click this
button and on each SiteScope restart.

For a reference detailing the XML tags, elements, and attributes included in the integration file that SiteScope
forwards to Diagnostics, see "XML Tag Reference for Generic Data and Diagnostics Integrations" on
page 592.

Tasks

How to Integrate SiteScope with Diagnostics
For an end-to-end flow on integrating SiteScope with Diagnostics, see Integrating SiteScope with Diagnostics
in the SiteScope Help. You can check the HPE Software Integrations site for the latest version of this guide.

UI Descriptions

Diagnostics Integration - General Settings
User interface elements are described below:

UI Element Description

Name Name by which to identify this integration in the SiteScope interface.

Note: This is a required field.
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UI Element Description

Description Description of the integration. This could include information on the Diagnostics server
receiving the data from SiteScope. This description appears only in the Integration
Preferences page in SiteScope.

Diagnostics Integration - Preferences Settings
User interface elements are described below:

UI Element Description

Receiver URL URL of the Diagnostics server to receive the SiteScope data. This must be a full URL
including server, port where diagnostics receives data, and path. The pathmust always
include /metricdata/siteScopeData.

If secure connection (SSL), then enter https.

Syntax: http or https://<fully qualified domain name of the receiving server>:<port
number receiving data>/metricdata/siteScopeData

Example: http://DiagnosticsServer1.hp.net:2006/metricdata/siteScopeData

Encoding Encoding used by the Diagnostics application.

Default value:UTF-8

Reporting
interval
(seconds)

Time in seconds between when SiteScope finishes sending data to the Diagnostics
server to the next period SiteScope sends data. This time interval can prevent
communication delays between the servers as it is an interval of time when no data is
sent.

Default value: 60 seconds

Time
synchronization
interval
(minutes)

To synchronize between the time of the SiteScope server and the Diagnostics server,
SiteScope periodically reports the time that is registered on its server. Diagnostics then
synchronizes the time of the data samples coming from SiteScope with the time on its
own server so that there is no discrepancy between the time of the SiteScope data and
the Diagnostics data.

Select in minutes how often you want SiteScope to report to Diagnostics the time of the
SiteScope server.

Default value: 10minutes

GZIP
compression

Compresses the sample data sent to the Diagnostics server. If the data is compressed,
then performance is improved because the time to send data is reduced. The
Diagnostics application can handle compressed data. Select or clear this field
depending on the amount of data being sent.

Default value:Selected
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UI Element Description

Include
additional data

If cleared, SiteScope reports the status of the following SiteScope objects:

l groups
l monitors
l counters
If selected, the status of these objects are reported along with the status string, which
includes the descriptions of each object.

Default value:Not selected

Tip: It is recommended not to include additional data as it slows performance, and the
status string repeats the status data that is sent by default.

Error on
redirect

SiteScope returns an error status if the target URL is redirected.

Default value:Not selected

Request
timeout
(seconds)

Socket timeout, in seconds, which is the timeout for waiting for data. A timeout value of
zero is interpreted as an infinite timeout.

Default value: 120 seconds

Connection
timeout
(seconds)

Timeout, in seconds, until a connection is established. A value of zeromeans the
timeout is not used.

Default value: 120 seconds

Number of
retries

Number of times SiteScope attempts to establish a connection.

Default value: 3

Authentication
when requested

SiteScope sends user name and password credentials if requested. If cleared,
SiteScope does not forward credentials.

Default value:Selected

Disable
integration

SiteScope does not forward data to the Diagnostics server. The integration preference
settings remain. Use when temporarily disabling the integration.

Default value:Not selected

Generate UOM
XML

Generates a unit of measurement xml file to merge with the <SiteScope root
directory>/conf/ integration/data_integration_uom.xml file. This file enables
Diagnostics to read the SiteScope data and apply the appropriate unit of measurement
to the data. It is recommended that you click this button when amonitor instance is
added that reports data to Diagnostics. If any values weremanually changed in the
data_integration_uom.xml file, those values remain and are not updated by this
merge file. This merge file is also generated and updates the xml file on every
SiteScope restart. For details, see "Units of Measurements in Diagnostics" on
page 574.
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Diagnostics Integration - Web Server Security Settings
User interface elements are described below:

UI Element Description

Authentication user
name

Username to access the server if the server is configured to use basic
authentication.

Authentication
password

Password to access the server if the server is configured to use basic
authentication.

Diagnostics Integration - Proxy Server Settings
User interface elements are described below:

UI Element Description

Address Proxy server address if applicable.

User name Username for the proxy server.

Password Password for the specified server.

Diagnostics Integration - Reporting Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

SiteScope uses the tag selected here to determine what data is forwarded to Diagnostics. You
can select more than one tag for each integration. The tagmust be selected for the groups,
subgroups, andmonitors whose data you want forwarded to Diagnostics.

When selecting an Integration tag for an object, the tag propagates to that object's children. If
you tag a group with this Integration tag, all its subgroups andmonitors report their status to
Diagnostics.

Example: Create a tag called Diagnostics_Integration1 and select it here. For each group,
monitor, or both, whose status you want to report to Diagnostics, select this tag under the
Search/Filter Tags setting.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Tip: Use the word Integrationwhen creating an Integration tag. Because the Integration tags
appear along with all other Search/Filter tags created for the SiteScope, this helps you identify
which tag to select for enabling a group or monitor for the integration.

HP Operations Manager Integration Preferences
Use the HP Operations Integration to enable SiteScope to send common events andmetrics data to HPOM
and APM products. The HP Operations Integration uses the Operations agent, whichmust be installed and
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configured on the SiteScope server, to provide visibility of SiteScope servers andmonitors to HPOM and
Operations Management in APM. For details on installing the agent and configuring the integration, see the
Integrating SiteScope with HP Operations Manager Products Guide available on the available on the HPE
Software Integrations site.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:

l Click theNew Integration button, and select HP Operations Manager Integration, or
l Select an existing HPOM integration, and click theEdit Integration button.

Note: Youmust be an administrator in SiteScope, or a user grantedView integration preferences
permissions to be able to view Integration Preferences. Edit integration preferences permissions are
required to create or edit Integration Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About

Operations Manager Integration Overview
To provide visibility of SiteScope servers andmonitors to Operations Manager (HPOM) andOperations
Management in APM, the HP Operations agent must be installed and configured on the SiteScope server. The
HP Operations agent sends events to the HPOMmanagement server and to Operations Management. It also
acts as a data storage for metrics data collected by SiteScope. The agent must be connected to the
HPOM/APM Server, and event or metrics integration with Operations Manager must be enabled.

l Event Integration. SiteScope events are triggered when there is a change in SiteScopemonitor metric
status (good/warning/error) or when a SiteScope alert is triggered. SiteScope sends events by writing
them to a log file which is monitored by the Operations Agent. The agent reads the data and converts it to
events, which it forwards to the HPOM/APM server.

l Metrics Integration. SiteScope reports metrics data to the Operations Agent for use in HPOM
(PerformanceManager) andOMi (PerformanceGraphing). Metrics integration with Operations Manager
can be activated regardless of the connection status between theOperations Agent and the HPOM/APM
server, sincemetrics are collected by the agent.

Note:While the Operations Agent is supported as a data source for PerformanceGraphing in BSM,
HPE plans to stop supporting the agent for PerformanceGraphing, and recommends that you use the
profile database in BSM as the data source instead. For details, see Integrating SiteScope with HP
Operations Manager Products in the SiteScope Help. You can check the HPE Software Integrations
site for the latest version of this guide.

Tasks

How to Integrate SiteScope with Operations Manager Products
For an end-to-end flow on how to enable SiteScope to send events to HPOM or OMi, or how to enable
SiteScope to report metrics using the Operations Agent, see Integrating SiteScope with HP Operations
Manager Products in the SiteScope Help. You can check the HPE Software Integrations site for the latest
version of this guide.
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UI Descriptions

HP Operations Manager Integration Main Settings
User interface elements are described below:

UI Element Description

Connection Settings

HP Operations
Agent
installation path

Path to the Operations Agent installation on the SiteScopemachine.

l OnWindows platforms, the installation path is automatically resolved from the HP
Operations agent InstallDir key in the registry, and displayed in this field. The
default path is C:\Program Files\HP\HP BTO Software\. If the key is not found,
the field is left empty, and youmust manually enter the agent installation path.

l OnUNIX platforms: SiteScope checks to see if the Operations Agent is installed in
the default /opt/OV path. If it is not there, the field is left empty, and youmust
manually enter the agent installation path.

Click theResolve Path button to restore the default installation path found by
SiteScope if youmanually entered a different path.
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UI Element Description

HP Operations
Manager/BSM
server

Enter the name or IP address of the HPOM/APM server to which you want to connect.
Click theConnect button to connect the agent and the HPOM/APM host machine.

If you are connecting to a APM distributed environment, enter the APMGateway
Server name or IP address. If your APMGateway Servers are behind a load balancer:

l For BSM data/topology integration: Enter the name or IP address of the load
balancer that is configured for users.

l For OM event integration (Operations Management in BSM): Enter the name or IP
address of the load balancer that is configured for data collectors.

For task details, see "How to Enable SiteScope to Send Events to HPOM or
Operations Management" > "Configure the connection request to be passed to the
Data Processing Server if BSM is installed on a distributed environment, or BSM
Gateway Servers are behind a load balancer" in Integrating SiteScope with HP
Operations Manager Products in the SiteScope Help. You can check the
HPE Software Integrations site for the latest version of this guide.

If there are connection problems, click theAnalyze button to perform problem analysis
and to check the status of the agent and the certificate request.

After a connection request is sent, the HPOM/APM server must grant the certificate
request (unless the HPOM/APM server was configured to accept this client
automatically).

After the certificate request has been granted on the HPOM/APM server, click Install
Policies to install and sign the preconfigured log file policy file on the Operations
Agent.

Note:You cannot disconnect or change the connection to another HPOM/APM server
from SiteScope after the certificate request has been granted on the HPOM/APM
server. Contact your HPOM/APM administrator for assistance.

Configuration Settings

Enable sending
events

Enables sending events from SiteScope to the HPOM/APM server.

Default value:Not selected
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UI Element Description

Connect directly
to BSM

When the agent is connected to Operations Management in APM, select to
automatically deactivate the node discovery policy if it was installed and enabled on
the SiteScope server.

When this option is selected:

l TheEnable node discovery policy option is not available, and the node
discovery policy is disabled if it was installed and enabled on the SiteScope server.

l ThePrefer events over metrics in BSM Service Health (global preference)
option is automatically selected.

When this option is cleared:

l TheEnable node discovery policy option is automatically selected.
l ThePrefer events over metrics in BSM Service Health (global preference)
option is automatically cleared.

Default value:Selected

Prefer events
over metrics in
BSM Service
Health (global
preference)

The global default preference for influencing APM's Service Health when both
SiteScope events andmetrics are reported to Service Health (since indicators for
SiteScope events andmetrics both affect CIs). This is relevant only when both APM
andOperations Manager integrations are active, and are connected to the same APM
server (the APM server is used instead of the HPOM server).

If selected, theEvents option is set as the default preference for every new monitor
created (inHP Integration Settings > BSM Service Health Preferences). If not
selected,Metrics is the default preference for reporting data to BSM.

For more information on choosing the preference to use, see Integrating SiteScope
with Application PerformanceManagement Applications in the Integration with BSM
andHPOM Best Practices Guide.

Default value:Selected

Note:

l This option is automatically selected if Connect directly to BSM is selected.
l This setting does not override the preference set for individual monitor instances in
HP Integration Settings > BSM Service Health Preferences.

Enable node
discovery policy

SiteScope enables the node discovery policy (if installed) on the SiteScope server.
This option is automatically selected when theConnect directly to BSM option is
cleared. For details on Node discovery, see "Discovery Scripts and the Drill Down
User For Viewing HPOM Events" in Integrating SiteScope with HP Operations
Manager Products in the SiteScope Help. You can check the HPE Software
Integrations site for the latest version of this guide.

Default value:Not selected
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UI Element Description

Enable
exporting
templates to HP
Operations
Manager

Enables exporting all templates from SiteScope and importing them to HPOM as
policies (only when SiteScope and HPOM are installed on the same system), which
you can later on assign and deploy from HPOM. For details on the template integration
with HPOM, see "Centralized TemplateManagement from HPOM" in Integrating
SiteScope with HP Operations Manager Products in the SiteScope Help. You can
check the HPE Software Integrations site for the latest version of this guide.

Default value:Selected

HP Operations Manager Integration Advanced Settings
User interface elements are described below:

UI Element Description

Event Integration Settings

Test message Checks that the Operations Agent is connected to the
HPOM/APM server and can send amessage. Type a
test message to send to the HPOM/APM server and click
theSend Test Message button.

Note: To run the test, the opcmsg log policy must be
deployed, signed, and installed either manually or after
activating the events integration.

Send Test Event Sends a test event to the HPOM/APM server.

Default Severity Mappings

Severity mappings correlate the severity level in HPOM/BSM to themonitor threshold status in SiteScope.
They are sent in events triggered by SiteScope alerts when SiteScope is not connected to BSM, or where
the indicator state and severity value aremissing. You can use the default severity mappings or customize
themappings.

Error Mapping between the Error status threshold for each
monitor instance in SiteScope and the HPOM/APM
server.

Default value:Critical

Warning Mapping between theWarning status threshold for each
monitor instance in SiteScope and the HPOM/APM
server.

Default value:Minor

Good Mapping between theGood status threshold for each
monitor instance in SiteScope and the HPOM/APM
server.

Default value:Normal
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UI Element Description

Unavailable Mapping between the Unavailable status threshold for
eachmonitor instance in SiteScope and the HPOM/APM
server.

Default value:Unknown

Use default severity When selected, the default mappings are sent in:

l Events created by a triggered alert.
l When SiteScope is not connected to BSM.
l In any case where the indicator state and severity
value is missing. For example, when usingmonitors
that do not have a defined topology.

Note:

l This option is not available when SiteScope is
connected to BSM (and the default global severity
mappings cannot be sent).

l By default, the Warning state is mapped to Minor (not
Warning).

Default value:Not selected.

HP Operations Manager Metrics Integration
User interface elements are described below:

UI Element Description

Enable HP
Operations
Manager
metrics
integration

Enables SiteScope to report metrics to the HP Operations agent, from which HPOM and
the APM reporting products are able to collect the data.

Note:Youmust enable eachmonitor instance that you want to send data to the HP
Operations agent, by selectingReport metrics to HP Operations agent in monitor
properties (HP Integration Settings > HP Operations Manager Integration Settings).
For details, see "HP Integration Settings" on page 253.

Default value:Not selected

Enable
metrics
reporting for
new
monitors

Enables SiteScope to report metrics to the Operations Agent for all newly-created
monitors.

Default value:Not selected

Enable
metrics
reporting for
specific
monitors

Automatically enables reportingmetrics for all existingMemory, CPU, Disk Space, and
Windows Resources monitors without having to select Report metrics to HP
Operations agent in themonitor properties for eachmonitor instance.
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Generic Data Integration Preferences
UseGeneric Integrations to create a new generic data integration to forward data (metrics) to another
application for which a direct integration does not exist. That applicationmust be able to receive the XML files
that SiteScope forwards. These files contain information regarding the status of the SiteScope's groups,
monitors, andmeasurements.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:

l Click theNew Integration button, and select Data Integration, or
l Select an existing Data integration, and click theEdit Integration button.

Note: Youmust be an administrator in SiteScope, or a user grantedView integration preferences
permissions to be able to view Integration Preferences. Edit integration preferences permissions are
required to create or edit Integration Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About

Delivering Data Using HTTP Request
The receiving applicationmust be enabled to receive the data from SiteScope. This means that the application
should be able to receive the http request from the SiteScope server and to decipher the XML file when it
arrives.

The http request includes the following header:

Content-Type: text/xml

If you selected to zip the contents of the XML file, then the http request includes the following header:

Content-Type: text/xml
Content-Encoding: gzip

You select whether to zip the data in the Data Integration Preferences dialog box when creating the integration
in SiteScope. If you select to zip the data, your applicationmust be able to unzip the file SiteScope sends.

Time Synchronization
You can synchronize the time of the SiteScope server with your application's server by enabling SiteScope to
forward a separate time synchronization XML file. This file is sent in the sameway as the data XML and at an
interval you select in the Time synchronization interval field in the Data Integration Preferences dialog box
when creating the integration in SiteScope. If you enter a value in this field, SiteScope forward the date stamp
of its server to the application receiving its data at the interval specified. For details on this option, see the
Time synchronization interval (minutes) field in Data Integration Preferences Settings below. For details
on the contents of this XML file, see "XML Tag Reference for Generic Data and Diagnostics Integrations" on
page 592.
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UI Descriptions

Data Integration - General Settings
User interface elements are described below:

UI Element Description

Name Name by which to identify this integration in the SiteScope interface.

Note: This is a required field.

Description Description of the integration. This could include information on the application receiving the
data from SiteScope. This description appears only in the Integration Preferences page in
SiteScope.

Data Integration - Preferences Settings
User interface elements are described below:

UI Element Description

Receiver URL URL of the application server to receive the SiteScope data. This must be a full URL
including server, port, and path.

If secure connection (SSL), then enter https.

Syntax: http or https://<fully qualified domain name of the receiving server>:<port
number receiving data>/<path>

Encoding Encoding used by the receiving application.

Default value:UFT-8

Reporting
interval
(seconds)

Time in seconds between when SiteScope finishes sending data to the next period
SiteScope begins sending data.

Default value: 60 seconds

Time
synchronization
interval
(minutes)

To synchronize between the time of the SiteScope server and the server receiving
SiteScope data, SiteScope can periodically report the time that is registered on its
server. The receiving server can then synchronize the time of the data samples coming
from SiteScope with the time on its own server so that there is no discrepancy between
the time of the SiteScope data and the application's own data.

Select in minutes how often you want SiteScope to report to the time of the SiteScope
server to the server receiving SiteScope data.

Default value: 10minutes
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UI Element Description

GZIP
compression

Compresses the sample data sent to the receiving server. If the data is compressed,
then performance is improved because the time to send data is reduced. Select or clear
this field depending on the amount of data being sent and whether the receiving
application can handle compressed data.

Default value:Not selected

Include
additional data

If cleared, SiteScope reports the status of the following SiteScope objects:

l groups
l monitors
l counters
If selected, the status of these objects are reported along with the status string, which
includes the descriptions of each object.

Default value:Not selected

Tip: It is recommended not to include additional data as it slows performance, and the
status string repeats the status data that is sent by default.

Error on
redirect

SiteScope returns an error status if the target URL is redirected.

Default value:Not selected

Request
timeout
(seconds)

Timeout, in seconds, until a connection is established with the server. A value of zero
means there is no timeout used.

Default value: 120 seconds

Connection
timeout
(seconds)

Socket timeout, in seconds, to wait for data. A timeout value of zeromeans there is no
timeout used.

Default value: 120 seconds

Number of
retries

Number of times SiteScope attempts to establish a connection.

Default value: 3

Authentication
when requested

SiteScope sends user name and password credentials if requested. If cleared,
SiteScope does not forward credentials.

Default value:Selected

Disable
integration

SiteScope does not forward data to the server. The integration preference setting
remains. Use when temporarily disabling the integration.

Default value:Not selected
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Data Integration - Web Server Security Settings
User interface elements are described below:

UI Element Description

Authentication user
name

Username to access the server if the server is configured to use basic
authentication.

Authentication
password

Password to access the server if the server is configured to use basic
authentication.

Data Integration - Proxy Server Settings
User interface elements are described below:

UI Element Description

Address Proxy server address if applicable.

User name User name for the proxy server.

Password Password for the specified server.

Data Integration - Reporting Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

SiteScope uses the tag selected here to determine what data is forwarded to the receiving
application. Youmust select at least one tag for each integration. That same tagmust be
selected for the groups, subgroups, andmonitors whose data you want forwarded to the
receiving application.

When selecting an integration tag for an object, the tag propagates to that object's children. If
you tag a group with this Integration tag, all its subgroups andmonitors report their status to the
receiving application.

Example: Create a tag called Integration_metrics and select it here. For each group,
monitor, or both, whose status you want to report to the receiving application, select this tag
under theSearch/Filter Tags setting for the object.

Note: You can select multiple tags for each integration preference. You can select multiple
Integration tags for the objects to be reported.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Tip: Use the word Integration_<integration identifier>when creating an integration tag,
since this tag appears along with all other Search/Filter tags created for the SiteScope. This
helps you to identify which tag to select for enabling a group or monitor for the integration.
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Generic Event Integration Preferences
UseGeneric Event Integrations to create a new generic event integration to forward SiteScope events to a
third-party application or management console for which a direct integration does not exist. The event that is
sent contains information regarding themonitor and its measurement, including the status change that
triggered the event.

SiteScope uses the SiteScope HTTP recipient to integrate with HTTP-based network management systems
and to send generic events to management consoles.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:

l Click theNew Integration button, and select Generic Event Integration, or
l Select an existing generic event integration, and click theEdit Integration button.

Note: Youmust be an administrator in SiteScope, or a user grantedView integration preferences
permissions to be able to view Integration Preferences. Edit integration preferences permissions are
required to create or edit Integration Preferences. For details on this topic, see "User Management
Preferences" on page 625.

Learn About

Generic Event Format
The format of the event attributes that are sent to the third-party application or management console is
determined using an event mapping template. The templatemaps SiteScope runtime data to the event
attribute values that are sent when an event is triggered. TheGeneric Event Integration uses Common Event
Mappings with custom attributes. For details on event mappings, see "Common Event Mappings" on
page 465.

Multiple Target Destinations
TheGeneric Event Integration enables you to configuremultiple event integrations. This differs from the
Operations Manager integration which supports only one integration to either the HPOMmanagement server
or to Operations Management in APM.

Delivery Using HTTP Request
The receiving applicationmust be enabled to receive the event from SiteScope. This means that the
application should be able to receive the http request from the SiteScope server and to decipher the XML over
HTTP response when it arrives. You configure the settings SiteScope needs to communicate with HTTP
connectors in the New/Edit HTTP Recipient dialog box.

The http request (that submits the event) includes the following header:

Content-Type: text/xml

If you selected to zip the contents of the XML file, then the http request includes the following header:

Content-Type: text/xml
Content-Encoding: gzip
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You select whether to zip the event in the Generic Event Integration Preferences dialog box when creating the
integration in SiteScope. If you select to zip the event, your applicationmust be able to unzip the file
SiteScope sends.

Support for Guaranteed Event Delivery
Generic Event Integration supports guaranteed event delivery. This means that if SiteScope is unable to send
an event (for example, if there is a network problem, or the receiver is down), SiteScope tries to send the
event again, or it stores the event for future transmission. This prevents the loss of information if events are
initially unable to reach their destination.

You can change the guaranteed event delivery settings inPreferences > Infrastructure Preferences >
Custom Settings or in the <SiteScope root directory>\groups\master.config file.

l Generic Event Integration save data to zip. Indicates whether the data is saved to the cache as a .zip
file.

l Generic Event Integration resend cache file intervals (minutes). The interval between each resending
of cache files.

l Generic Event Integration file count to delete. When the cache folder reaches its maximum size,
SiteScope deletes the specified number of files from the cache.

l Generic Event Integration maximum cache size (MB). Themaximum size of the cache inmegabytes,
before SiteScope deletes files from the cache.

For more details on these settings, see the above-listed properties in "Custom Settings" on page 554.

Tasks

How to Configure SiteScope Generic Event Integration
This task describes the steps involved in configuring SiteScope to forward events to a third-party application
or management console. These files contain information regarding the status of the SiteScope's groups,
monitors, andmeasurements.

1. Prerequisites
Youmust be an administrator in SiteScope, or have the following user permissions:
l Add, edit or delete common event mappings. Required to create or make changes to event
mappings.

l Add, edit or delete email, pager, HTTP and SNMP preferences. Required tomake changes to
HTTP Preferences.

For details on user permissions, see "User Management Preferences" on page 625.
2. Configure HTTP preferences

Select Preferences > Integration Preferences > HTTP Preferences, and configure the HTTP settings
that SiteScope uses when sending events or data tomanagement consoles. This involves creating an
HTTP recipient that SiteScope uses to send events or data to an endpoint URL.
For user interface details, see "New/Edit HTTP Recipient Dialog Box" on page 512.

3. Configure the Generic Event Integration
Select Preferences > Integration Preferences, click New and then select Generic Event Integration.
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a. In theGeneral Settings panel, enter a name and description for the integration.
b. In theGeneric Event Integration Preferences panel, select a connector instance to use for

receiving events.
c. In theReporting Tags panel, select a reporting tag (this is used later in step 5). SiteScope uses this

to determine which tags report this configured integration when an event is triggered by ametrics
status change. All monitors that have this tag will report events via this integration.
Youmust select at least one tag for each integration.

For details on these settings, see the UI Descriptions section below.
4. Configure amonitor instance and select an event mapping

Configure amonitor instance. In theEvent Mapping Settings panel of monitor properties, select an
event mapping template, or create a new event mapping. The template contains themappings between
SiteScope runtime data and the attribute values that are used for sending events to themanagement
console when ametrics status change event is triggered. For user interface details, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 469.

Note: The Event mapping list is available only if SiteScope is integrated with HPOM and event
integration is enabled, or when aGeneric Event Integration is configured in Integration Preferences.
The list is editable if you haveAdd, edit or delete common event mappings permissions.

You can use the HP CDA Event Mapping template when integrating with CDA (Continuous Delivery
Automation), a policy-based platform that provides infrastructure provisioning in hybrid cloud
environments. CDA integrates with SiteScope to deploy SiteScopemonitors and receive events from
them. Monitoring status based on the events received is available in the CDA user interface.

5. Select reporting tags for themonitor
In theSearch/Filter Tags panel of monitor properties, select one or more of the reporting tags (selected
in step 3c) for eachmonitor instance for which you want to trigger metrics status change events.
SiteScope uses the tags selected to determine what data is forwarded to the receiving application when
ametrics status change event is triggered.
For user interface details, see "Search/Filter Tags" on page 266.

6. Configure guaranteed event delivery settings - optional
If SiteScope is unable to send an event (for example, if there is a network problem, or the receiver is
down), SiteScope tries to send the event again, or it stores it for future transmission.
You can determine the guaranteed event delivery setting values using the following settings in
Preferences > Infrastructure Preferences > Custom Settings:
l Generic Event Integration save data to zip Indicates whether the data is saved to the cache as a
.zip file.

l Generic Event Integration resend cache file intervals (minutes). The interval between each
resending of cache files.

l Generic Event Integration file count to delete. When the cache folder reaches its maximum size,
SiteScope deletes the specified number of files from the cache.

l Generic Event Integration maximum cache size (MB). Themaximum size of the cache in
megabytes, before SiteScope deletes files from the cache.

For more details on these settings, see "Custom Settings" on page 554.
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7. Results and troubleshooting
When there is a change in amonitor's metric status, an event is created, based on the format in the event
mapping template. The event is sent to the HTTP connector instance (this is the endpoint URL of the
application that receives all HTTP messages).
Details of events that were successfully sent are displayed in the generic_event_integration.log file,
available from Server Statistics > Log Files.
Event error data is written to the error.log file which is found in the <SiteScope root directory>\logs
directory.
If you encounter an error, open the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties.debug file in SiteScope in debugmode
and copy the Generic Event integration strings to the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties file.

UI Descriptions

Generic Event Integration - General Settings
User interface elements are described below:

UI Element Description

Name Name by which to identify this integration in the SiteScope interface.

Note: This is a required field.

Description Description of the integration. This could include information on the application receiving the
data from SiteScope. This description appears only in the Integration Preferences page in
SiteScope.

Generic Event Integration - Preferences Settings
User interface elements are described below:

UI Element Description

Connector The target instance used for receiving the events. Select from the list of connectors, which
are configured inPreferences > HTTP Preferences. For details, see "HTTP Preferences
Page" on page 511.

Disable
integration

Disables the integration and no events are sent to the receiver. The settings in this
integration are preserved and can be used again when the integration is enabled.

Default value:Not selected

GZIP
compression

Compresses the events before sending it to the receiving server. Compressing data
improves performance because the time to send data is reduced. Using this option
depends on the amount of data being sent and whether the receiving application can handle
compressed data.

Default value:Not selected
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Generic Event Integration - Reporting Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Tags are used to associate monitor instances which trigger an event with a particular event
integration. All monitors that have this tag will report events via this integration.

SiteScope uses the tag selected here to determine the event forwarded to the receiving
application. Youmust select at least one tag for each integration.

Example: Create a tag called Integration_events and select it here. Select this tag under the
Search/Filter Tags setting for eachmonitor instance that you want to report to the receiving
application.

In theSearch/Filter Tags panel of monitor properties, select one or more reporting tags for each
monitor instance for which you want to trigger metrics status change events. SiteScope uses
the tags selected to determine what data is forwarded to the receiving application when a
metrics status change event is triggered.

Note: You can select multiple tags for each integration preference. You can select multiple
Integration tags for the objects to be reported.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Tip: Use the word Integration_<integration identifier>when creating an integration tag,
since this tag appears along with all other Search/Filter tags created for the SiteScope. This
helps you to identify which tag to select for enabling a group or monitor for the integration.

XML Tag Reference for Generic Data and
Diagnostics Integrations
When SiteScope forwards data for generic data or diagnostics integrations, it does so using the XML files
whose elements and attributes are described below. For details on creating the integration, see "Generic Data
Integration Preferences" on page 584 and "Diagnostics Integration Preferences" on page 573.

This section also includes:

l "Data XML Elements and Attributes Table" on the next page
l "Time Synchronization XML" on page 594
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Data XML Elements and Attributes Table

Parent
Element

Description of
Element Attribute Description

performance
Monitors

The parent element of
the XML. Includes all
group elements within it.

collectorHost

collector

SiteScope Host

Application collecting the data, which is
always SiteScope

group Represents the
SiteScope group and is
parent element to group
andmonitor element

name Group name as defined by the user

desc (optional) Group description if entered for the
group

previousName
(optional)

Previous name of the group if existed

monitor Represents the
SiteScopemonitor and
parent element to the
counter element

type Monitor type (as displayed in New
Monitor dialog box)

name Monitor name as defined by the user

target Remote server beingmonitored

targetIP IP address of the remote server being
monitored

time Time of themeasurement

quality Status as determined by themonitor's
thresholds

Possible values:

l 0 - no data (no thresholds defined)
l 1 - informational (good)
l 2 - warning
l 3 - critical

previousName
(optional)

Previous name of themonitor if existed

desc (optional) Monitor description if entered for the
monitor

sourceTemplateName Name of the source template if the
monitor was created from a template or
solution template.

statusDesc This attribute is no longer populated. It is
for backward compatibility purposes
only.
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Parent
Element

Description of
Element Attribute Description

counter Represents the
measurements gathered
by themonitor

name Counter name

value Counter value

quality Status of the counter as determined by
the counter's threshold

Possible values:

l 0 - no data (no thresholds defined)
l 1 - informational (good)
l 2 - warning
l 3 - critical

desc (optional) Monitor description if entered for the
monitor

status (optional) If this attribute appears with a value of 0,
the counter is not available. This
attribute is not sent by SiteScope and
not included in the XML if the counter is
available.

Possible value: 0 - counter not
available

units (optional) Units of measurements for the counter if
relevant

Time Synchronization XML
If you enter a value in the Time synchronization interval field when creating the data integration, SiteScope
sends this XML to synchronize the time of the SiteScope server with that of the receiving application.

Parent Element Description of Element Attribute Attribute Description

performanceMonitors The parent element of the
XML

collectorHost SiteScope host

collector Application collecting the data, which
is always SiteScope

timeStamp Provides the time of the
SiteScope server

timestamp Time stamp, calculated as the
seconds since January 1st 1970

Integration Preferences Page
This page enables you to configure settings when integrating SiteScope with APM, HPOM, Diagnostics, or
other applications.
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To access Select Preferences > Integration Preferences.

To open the Integration Preferences Type dialog box which enables you to select the type of

integration preference you want to configure, click theNew Integration button.

Important
information

Only an administrator in SiteScope, or a user grantedEdit integration preferences
permissions can create or make changes to Integration Preferences. For details on user
permissions, see "User Management Preferences" on page 625.

Relevant
tasks

l "How to Configure SiteScope to Communicate with BSM" on page 190
l "How to Configure SiteScope-APM Integration Preferences for Inaccessible Profiles" on
page 569

See also l "Integration Preferences" on page 563
l " Connecting to a BSM Server" on page 181

User interface elements are described below:

UI Element Description

New Integration. Creates a new integration in SiteScope.

Edit Integration. Enables editing an existing integration in SiteScope. The Edit Integration
dialog box opens according to the integration type selected.

l Amazon CloudWatch Integration. Enables users who use SiteScope for monitoring
their AWS-hosted applications to report any SiteScopemetrics to Amazon CloudWatch
service. For user interface details , see "Amazon CloudWatch Integration Preferences"
on page 563.

l BSM Integration. Use to configure SiteScope as a data collector for APM. For user
interface details, see "BSM Integration Preferences" on page 567.

l Data Integration. Use to create a generic data integration. For user interface details, see
"Generic Data Integration Preferences" on page 584.

l Diagnostics Integration. Use to create a diagnostics integration. For user interface
details, see "Diagnostics Integration Preferences" on page 573.

l Generic Event Integration. Use to create a diagnostics integration. For user interface
details, see "Generic Event Integration Preferences" on page 588.

l HP Operations Manager Integration. Use to configure SiteScope to send events and
report metrics to HPOM and APM servers. For user interface details, see "HP
Operations Manager Integration Preferences" on page 577.

Delete Integration. Deletes the selected integration from Integration Preferences.

Select All. Selects all listed integrations.

Clear Selection. Clears the selection.

Using SiteScope
Chapter 51: Integration Preferences

HPE SiteScope (11.33) Page 595 of 1206



UI Element Description

Detach
SiteScope

(Available from the shortcut menu only) Detaches SiteScope from LoadRunner integrations.
This enables you to delete the current LoadRunner integration from the SiteScope side.
When SiteScope is attached, monitors can be defined from the LoadRunner user interface.

Note: This is available only when SiteScope is integrated with LoadRunner.

Integration
Name

Name string assigned to the integration when you create a new Integration Preference.

Integration
Description

Description of the integration that was assigned when creating or editing the Integration
Preference.
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Chapter 52: Log Preferences
This page enables you to configure SiteScope Log Preferences. Effective system availability monitoring
requires that monitoring data be recorded and stored for a required interval of time. SiteScope Log Preferences
controls the accumulation and storage of monitor data.

To access
Select Preferences > Log Preferences.

Note:

l Youmust be an administrator in SiteScope, or a user grantedEdit log preferences permissions to be
able to create or make changes to Log Preferences. For details on this topic, see "User Management
Preferences" on page 625.

l Changes to Log Preferences have an impact only after SiteScope is restarted.

Learn About
This section contains the following topics:

l "Log Preferences Overview" below
l "SiteScope Log Database Table Structure" below

Log Preferences Overview
Log Preferences enable you to select how muchmonitor data is accumulated andmaintained on the
SiteScope server. It also configures SiteScope to export monitor data to an external database.

By default, SiteScope saves monitor results, alert data, error data, and other readings returned by monitors
into log files. For monitor data results, a date-coded log file is created for each 24-hour period of monitoring.
This data is stored as tab delimited text. SiteScope uses the log files to createmanagement reports on
system availability and performance over time.

Storing data logs can become a problem over time. However, you can limit how much log information
SiteScope saves to the local file system by setting the number of days tomaintain log files or by setting a
maximum data log file size. You can also sendmonitoring data to an external database application. This helps
reduce the data storage capacity required on the SiteScope server andmakes themonitoring data available to
other reporting tools. For details on how to customize the way SiteScope logs monitoring data in the database,
see he HPE Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM304952).

Note: To create SiteScopeManagement Reports themonitoring log information for the desired time
period of the report must be available on the SiteScope server file system. For details on creating
management reports, see "Management Report" on page 1167.

SiteScope Log Database Table Structure
When database login is enabled, monitor data is contained in a single table calledSiteScopeLog. The first
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nine fields of each database record are the same for all monitors. The next ten fields contain different
measurements depending on the kind of monitor supplying the data. All the fields in the table use the VARCHAR
(255) data type. A description of the fields in the log database record are shown in the table below along with
their default field names:

Field Name Example Data Description

datex 1999-01-20 11:54:54 The first field contains the date that themonitor ran.

serverName demo.sitescope.com The second field contains the name of the server where SiteScope
is running.

class URLMonitor The third field contains the type of themonitor.

sample 23 The fourth field contains the sample number of this monitor.

category good The fifth field contains the category name of themonitor.

groupName URLs The sixth field contains the group name of themonitor.

monitorName HomePage The seventh field contains the name of themonitor.

status 1.01 seconds The eighth field contains the status of themonitor.

monitorID 10 The ninth field contains the ID of themonitor.

value1,
value2, ...
value10

(variable) The tenth through nineteenth fields contain themonitor specific data
as described in the Log Columns page (see "Monitor Specific Log
ColumnContent" on page 1036). The first variable field (value1)
corresponds to the value listed as column 7 in the log files.

Note: Field names change dynamically according to your
SiteScopemonitor configuration. Tomanually generate a list of field
names for data logged to a database, see "How to Generate Field
Names for Data Logged to a Database" below.

The SQL statement that is used for database logging can be changed by editing the parameter _
logJdbcInsertSiteScopeLog= in the <SiteScope root directory>\groups\master.config file. A stored
procedure can be called by replacing the insert statement with a call statement. For example, call logit
(?,?,?)would call the stored procedure named logit passing it the first three parameters.

Tasks
How to Generate Field Names for Data Logged to a Database
Monitor field names change dynamically according to your SiteScopemonitor configuration settings, and as
such, the field names may not be written to the database.

Tip: You can see the list of static monitor fields in "Monitor Specific Log ColumnContent" on page 1036.

This task describes the steps involved inmanually generating the field names.
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1. Check which port the Tomcat server is using
Open <SiteScope root directory>\Tomcat\conf\server.xml and search for the string <Connector
port= to determine the port which this Tomcat version is using.

2. Create a new generic data integration
In SiteScope, select Preferences > Integration Preferences, click theNew Integration button, and
select Data Integration. Create a new data integration as described in "Generic Data Integration
Preferences" on page 584.
a. In the Data Integration Preferences Settings panel, enter the URL of the Tomcat server in the

Receiver URL box, and use the same port number from the previous step. (The URL should be in
the format: http://<Tomcat Server>:<port number receiving data>/<receiver path>

where <receiver path> is the location where you get the samples under the <Tomcat root
directory>\webapps folder.

b. In the Reporting Tags panel, add a tag name and value for the integration and select it in the tags
tree.

3. Select reporting tags for themonitor
In the Search/Filter Tags panel of each relevant monitor for which you want counter names, select the
same reporting tag that you added in the previous step. SiteScope uses the tags selected to determine
what data is forwarded to the receiving application.

4. Run themonitor
Run themonitors for which you want counter names.

5. Results
After themonitors have run, SiteScope forwards the column names and values to the Tomcat server in
XML format. These XML files are located in the <Tomcat root directory>\webapps folder and the path
is specified in step 2a.

Example:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<performanceMonitors collectorHost="JBROWN" collector="SiteScope">
<group desc="" name="g">
<monitor quality="1" time="1321445972863" targetIP="16.53.61.95" target="My_Lab_Machine"
type="Memory"

previousName="Memory on My_Lab_Machine" name="Memory on My_Lab_Machine">
<counter quality="0" value="0" name="percent used"/>
<counter quality="0" value="3953" name="MB free"/>
<counter quality="0" value="0.0" name="pages/sec"/>
<counter quality="1" value="0" name="swap space used %"/>
<counter quality="0" value="3953" name="swap space MB free"/>
<counter quality="0" value="16" name="physical memory used %"/>
<counter quality="0" value="3390" name="physical memory MB free"/>
</monitor>
</group>
</performanceMonitors>
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UI Descriptions
Log Preferences Page
User interface elements are described below:

UI Element Description

SiteScope Log File Preferences

Daily logs
to keep

Number of daily log files of monitoring data to keep. Once a day, SiteScope deletes any logs
that exceed the specified number of logs to keep.

Default value: 40

Note:

l The last two logs (today's and yesterday's) are always preserved, regardless of the
number of logs or maximum log size specified.

l Keepingmonitor data logs for long periods can cause a data storage problem for the
SiteScope server depending on the total number of monitors configured and how often the
monitors run per day. You shouldmonitor the size of the log files in the
<SiteScope root directory>\logs directory to estimate the data accumulation rate, and
adjust this setting or server resources as necessary.

Maximum
size of
logs (MB)

Maximum size for all monitoring logs. Once a day, SiteScope checks the total size of all
monitoring logs and removes any old logs that are over themaximum size.

Default value: 0 (the log size is not checked)

Disable
separate
logging for
monitors

When this is selected, log data for amonitor is not sent to a dedicatedmonitor log file, but to
general log files (for example, error.log orRunMonitor.log), together with log data from all
other monitors. For more details, see "Logging Settings" on page 268.

Default value:Not selected

Database Logging Preferences

Database
connection
URL

URL to a database connection.

Note for using Windows Authentication: If you want to access the database using
Windows authentication, enter:

l Database connection URL: jdbc:mercury:sqlserver://<server name or
IP address>:1433;DatabaseName=<database name>;AuthenticationMethod=type2

l Database driver: com.mercury.jdbc.sqlserver.SQLServerDriver
l Database user name andDatabase password: Leave these boxes empty, since the
Windows user credentials of the account from which the SiteScope service is running are
used to establish a connection to the database.
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UI Element Description

SiteScope Log File Preferences

Database
driver

Database driver SiteScope should use to connect to the database. The driver should be a
JDBC driver. To have SiteScope use another driver the driver must also be installed in the
<SiteScope root directory>\WEB-INF\lib directory and the path and filenamemust be
entered in this box.

Database
user name

User name to log on to the database. WithWindows Authentication, you cannot specify a
user name as SiteScope connects using the login account of the SiteScope service.

Note for using Windows Authentication: The user that is running SiteScopemust be able
to access the database to which you are connecting. If SiteScope is running under a Local
Systems Account, it attempts to connect using the name of the server.

Database
password

Password to log on to the database. WithWindows Authentication, you cannot specify a
password as SiteScope connects using the login account of the SiteScope service.

Backup
database
connection
URL

URL to a backup database. Use this option to provide failover of SiteScope database logging
if the primary database becomes unavailable.

Note:

l The same database table definition, database driver, user name, and password are
applied to both database connections.

l After saving changes to the Database Logging preferences, stop and restart the
SiteScope service for the changes take effect.

Tips/Troubleshooting
Troubleshooting - Database Logging
WhenDatabase logging is active and working correctly, see the table namedSiteScopeLog in your database
and a record added to the table every time amonitor runs. The data is sent to the database as a single table in
a flat-file format.

If theSiteScopeLog table is not created or is empty, check the <SiteScope
root directory>\logs\RunMonitor.log and <SiteScope root directory>\logs\Error.log files for log
messages starting with "jdbc". When Database logging is working correctly, see a set of messages in
RunMonitor.log that looks like this:

jdbc log, reconnect seconds=600
jdbc log, loading, driver=sun.jdbc.odbc.JdbcOdbcDriver
jdbc log, connecting, url=jdbc:odbc:SiteScopeLog,
jdbc log, logged in
jdbc log, checking log table
jdbc log, created log table
jdbc log, prepare insert, 19, INSERT INTO SiteScopeLog...
jdbc log, connected
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If these entries do not appear in the log file there is a problem with the database interface or configuration of
the database connection. You should also check the Database Connection URL you entered. This parameter
is case sensitive. Check the spelling and letter case of the connection URL andmake sure there are no
leading or trailing spaces present in the text box.

You can also check the HPE Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=) for other information
relating to database logging. To enter the knowledge base, youmust log on with your HPE Passport ID.
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Chapter 53: Pager Preferences (Deprecated)
This page is used to define pager recipient profiles and settings that SiteScope uses for sending Pager alerts
to individuals or groups. It lists all the currently defined Pager Recipient profiles. Pager alerts can be used to
send an automated notification to system administrators whomay not have immediate access to email, or to
send alert escalations or notify support personnel whomay be away from the office.

Note: Pager Preferences was deprecated, and HP plans to remove support for it in the next version of
SiteScope. For backward compatibility, this preference type can be enabled by adding the property _
enableDeprecatedAlertActions=pager to the <SiteScope root directory>\groups\master.config file.
The value is not case-sensitive, and should be separated by a comma if other values are listed.

To access
Select Preferences > Pager Preferences.

Note: Youmust be an administrator in SiteScope, or a user grantedView email, pager, HTTP and
SNMP lists permissions to be able to view Pager Preferences. Add, edit or delete email, pager,
HTTP and SNMP preferences permissions are required to create or edit Pager Preferences. For details
on this topic, see "User Management Preferences" on page 625.

Learn About
Pager Preferences Overview
You can use Pager Preferences to configure the settings SiteScope needs to communicate with an external
electronic paging service. These are the default settings that SiteScope uses to send alerts to an electronic
pager.

The Pager Preferences page displays the defined custom Pager Recipient profiles. These profiles can be
associated with one or more Pager alerts by editing the applicable alert definition.

You define Pager Recipient profiles in the New/Edit Pager Recipient page. The preferred pager connection
option is Modem to modem connection. When this connection is used, SiteScope can verify that the
message was sent successfully and can receivemessages describing any communication problem. The
other connection options generally sendmessages to automated voice response systems using touch tone
dialing. The touch tone dialingmethod is limited to numeric messages and SiteScope cannot confirm that your
paging service correctly received themessage.

UI Descriptions
This section includes:

l "Pager Preferences Page" on the next page
l "New/Edit Pager Recipient Dialog Box" on the next page

HPE SiteScope (11.33) Page 603 of 1206



Pager Preferences Page
User interface elements are described below:

UI Element Description

New Pager Recipient. Creates a new Pager Recipient profile. For user interface details,
see "New/Edit Pager Recipient Dialog Box" below.

Note:Only an administrator in SiteScope, or a user grantedAdd, edit or delete email,
pager, HTTP and SNMP preferences permissions can create or make changes to Pager
Preferences. For details on user permissions, see "User Management Preferences" on
page 625.

Edit Pager Recipient. Enable editing the Pager Recipient profile. For user interface details,
see "New/Edit Pager Recipient Dialog Box" below.

Note:Only an administrator in SiteScope, or a user grantedAdd, edit or delete email,
pager, HTTP and SNMP preferences permissions can create or make changes to Pager
Preferences. For details on user permissions, see "User Management Preferences" on
page 625.

Delete Pager Recipient. Deletes the selected Pager Recipient profile from Pager
Preferences.

Note:You cannot delete a Pager Recipient profile if it is referenced by an alert action. You
must change the recipient in the alert before you can delete the profile.

Test Pager Recipient. Tests that you can send amessage to the pager. Enter amessage
in the Test Pager dialog box, and click Test. You can enter a prefix that can be added to the
pager message. If you are sending themessage to a numeric pager, do not enter more than
32 digits.

Select All. Selects all listed Pager Recipient profiles.

Clear Selection. Clears the selection.

Default
Settings

Click the arrow next toDefault Settings, and select an option:

l Edit. Opens the Pager Preferences Default Settings dialog box which enables you to
change the default settings displayed in the New Pager Recipient dialog box. For details
on the settings, see "New/Edit Pager Recipient Dialog Box" below.

l Test. Opens the Test Pager dialog box which enables you to test that you can send a
message to the default pager. Enter amessage in theMessage box, and click Test. You
can enter a prefix that can be added to the pager message. If you are sending the
message to a numeric pager, do not enter more than 32 digits.

Name Name string assigned to the setting profile when you create a new pager recipient.

Description Description of the setting profile that was assigned when creating or editing the profile.

New/Edit Pager Recipient Dialog Box
This dialog box enables you to create a new Pager Recipient profile or edit an existing profile. SiteScope uses

Using SiteScope
Chapter 53: Pager Preferences (Deprecated)

HPE SiteScope (11.33) Page 604 of 1206



Pager Recipient profiles for sending Pager alerts.

User interface elements are described below:

UI Element Description

Main Settings

Name Name string assigned to the setting profile when you create a new pager recipient.

Modem
port

Communications port that themodem is connected to on the SiteScope server. For
SiteScope on Solaris or Linux, enter the path and device name for themodem. OnMicrosoft
Windows platforms, SiteScope uses COM port numbers for both RS-232C type serial ports
as well as for USB modem ports.

If you are using a USB typemodem, select the COM port associated with the USB port to
have SiteScope use the USB modem. To find the COM port number for the USB modem,
use theSettings > Network and Dial-up Connectionsmenu. Right-click the desired
modem, and then click Properties. The properties should show the COM port number that is
associated to themodem.

Default value:COM1

Connection
speed
(bit/sec)

Modem speed used for connections to the paging service from the drop-down list.

Default value: 1200 bit/sec
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UI Element Description

Main Settings

Pager
connection
options

Option for sending amessage to your paging service:

l Modem to modem connection (Preferred). Select if you have an alphanumeric pager
and use an alphanumeric paging service.

l Dial and enter message. Select to dial a direct phone number to send a page.
l Dial, enter command and enter message. Select if you have a direct number, but
need to enter a command before sending a page.

l Custom modem connection. Select if your paging company does not use any of the
previous connection choices.

For details of the information required for the selected option, see below:

l Modem number. Phone number to use for sending alphanumeric pages to the paging
servicemodem.

l Modem pin number. Last seven digits of the PIN number for your alphanumeric pager.
If you use an alphanumeric paging service, youmust enter the phone number to use for
sending alphanumeric pages to the paging servicemodem. This number is provided by
your paging service. The paging service sometimes refers to this as the TAP/IXO
number.

l Phone number. Phone number exactly as you would dial it from your telephone,
including other numbers youmay need, such as a number to get an outside line. You can
use dashes tomake the number easier to read. Use commas to separate the portions of
the phone number. Each comma causes themodem script to pause for a few seconds
before dialing the rest of the number.
Example: If you are dialing your pager from your office, and you have to dial 9 to get an
outside line, enter: 9, 555-6789.

l Send page command. Page command exactly as you would dial it from your touch tone
telephone.

l Custom modem command. Entire modem command including the phone number to
dial, any additional digits, and $message. SiteScope replaces $message with the
message you specified for each alert.

Example: If the number for the pager company is 123-4567, your pager PIN is 333-
3333, and your pager company requires that you follow each commandwith the # key,
the commandmight look like this:
ATDT 123-4567,,333-3333#,,$message#

Note: For SiteScope running on UNIX, enter the device path for your modem in the
Modem Path box. To see a list of devices using Solaris, use the ls /dev/term/*
command.

l Disabled. Temporarily disables a particular pager without editing every alert that
contains this persons pager.

Advanced Settings
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UI Element Description

Main Settings

Schedule Specifies when pager settings should be enabled. A more restricted schedule can be
selected from the drop-down list.

Default value:Every day, all day

Description Description for the setting profile, which appears only when editing or viewing its properties.
You can include HTML tags such as the <BR>, <HR>, and <B> tags to control display
format and style.

Note:HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than one line).
If malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.

Search/Filter Tags

<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope,
this section appears but is empty. If tags have been created, they are listed here and you
can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.
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Chapter 54: Schedule Preferences
SiteScopemonitors, alerts, and reports are enabled 24 hours a day, 7 days a week, 365 days a year, by
default. This means that as long as amonitor is enabled, it runs according to the update frequency specified in
the individual monitor configuration. For example, if a monitor is configured to run every 30 seconds,
SiteScope attempts to run themonitor every 30 seconds throughout the day. If SiteScope detects an error
condition, any alert associated with themonitor is triggered as well, regardless of the time of day.

In some situations, it is useful to enable certain SiteScope actions to correspond with a single event or a
particular time of day. For example, youmay want to use this type of scheduling for monitors, such as the Link
Checkingmonitor, which you want to run only once a day at a time when the server generally has a lighter
load. You use Absolute Schedules to do this.

Youmay also want to disable certain SiteScope actions based on the schedules of the individuals or groups
responsible for the servers and systems beingmonitored. You use Range Schedules to instruct SiteScope to
enable or disable monitors according to time periods that you define.

To access
1. Select Preferences > Schedule Preferences to open the Schedule Preferences page.
2. In the Schedule Preferences toolbar, click theNew Schedule button, and select New Absolute

Schedule orNew Range Schedule.

Note:

l Youmust be an administrator in SiteScope, or a user grantedView schedule list permissions to be
able to view Schedule Preferences. Add, edit or delete schedule preferences permissions are
required to create or edit Schedule Preferences. For details on this topic, see "User Management
Preferences" on page 625.

l You cannot delete a Schedule profile if it is referenced by an alert action, report, monitor, or monitor
threshold. Youmust remove the profile from each dependency before you can delete the profile.

Learn About
This section also includes:

l "Absolute Schedules" below
l "Range Schedules" on the next page

Absolute Schedules
Absolute Scheduling lets you set specific times that amonitor is run on a weekly basis. Absolute schedules
are reset at the end of the week and repeated each week. Absolute Schedules trigger amonitor to run only
once at each time specified in the schedule.

Absolute Schedules are inactive until they are explicitly associated with amonitor instance. To associate
Absolute Schedules with amonitor, use theMonitor schedule field in theMonitor Run Settings panel for
themonitor that you want to schedule.
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Note: Absolute Schedules are associated to alerts indirectly by way of themonitors associated with the
alert. Any alerts associated with themonitors disabled by Absolute Schedules are effectively unavailable
for the period during which thosemonitors are disabled. However, if an alert is associated with other
monitors that are not controlled by the same schedule, that alert is still triggered if the other monitors
report an error condition.

Range Schedules
You can use Range Scheduling to specify a time range during which SiteScope either enables or disables
particular monitors. If you specify an enabled time range for amonitor (in theMonitor schedule field of the
Monitor Run Settings panel for the specific monitor), SiteScope only runs themonitor during that range. For
example, if you create a range of 8AM-9PM, Monday through Friday, any monitors that have that range
schedule associated with them are run only during those times.

A common use of range scheduling is to set up different pager alerts associated with monitors running at
times that coincide with work shifts when different administrators are on call. The schedule helps prevent
pager alerts being sent to individuals at an inappropriate time of day relative to the work schedule of that
individual.

Range Schedule Preferences are inactive until they are explicitly associated with amonitor instance. You use
theMonitor Run Settings panel of amonitor configuration page to associate Range Schedule Preferences
with amonitor.

Note: Range Schedules are associated to alerts indirectly by way of themonitors associated with the
alert. Any alerts associated with themonitors disabled by Range Schedules are effectively unavailable
for the period during which thosemonitors are disabled. However, if an alert is associated with other
monitors that are not controlled by the same schedule, that alert is still triggered if the other monitors
report an error condition.

UI Descriptions
This section includes:

l "Absolute Schedule Page" below
l "Range Schedule User Page" on the next page

Absolute Schedule Page
This page is used for customizing the operation of SiteScopemonitors and alerts to run only at specific times.

User interface elements are described below:

UI Element Description

General Settings

Name Name for the Absolute Schedule. The name is used to identify the Absolute Schedule in the
product display.
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UI Element Description

General Settings

Description Description for the setting profile, which appears only when editing or viewing its properties.
You can include HTML tags such as the <BR>, <HR>, and <B> tags to control display
format and style.

Note:HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than one line).
If malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.

Absolute Schedule Settings

<days of
the week>

Time or times that themonitor needs to run in the boxes next to the day of the week. Time
values for absolute schedules must be limited to the 24-hour period of a standard day for
each day. To enter multiple times for a single day, separate the times by a comma (,).

Example:01,02:30,23:30 runs themonitor at 1:00 AM, 2:30 AM, and 11:30 PM

Related Entities

Name Lists the name of each entity (monitor, alert action) that is running under that schedule. This
is useful when editing amonitor schedule, for example, to show whichmonitors are running
under that schedule.

Entity Type Entity type, such as monitor, alert action, or SiteScope restart.

Path The path of the entity type.

Search/Filter Tags

<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope,
this section appears but is empty. If tags have been created, they are listed here and you
can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Range Schedule User Page
This page is used for customizing the operation of SiteScopemonitors and alerts to run only during specific
time periods.

Note:When using SiteScope Failover, an additional table (Failover Schedule Preferences) is displayed
beneath the General Schedule Preferences table. It contains schedules that are used for mirroring and
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checking availability of the primary SiteScope.

User interface elements are described below:

UI Element Description

General Settings

Name Name for the Range Schedule.

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.

Note:HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field
is rejected. The following is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example,

onhover.
l Any attribute with javascript as its value.

Range Schedule Settings
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UI Element Description

General Settings

<days of the
week>

Days and times themonitor needs to run. Time values for range schedules must be
limited to the 24 hour period of a standard day for each day. Select Enabled to run
monitors during the specified time range only, orDisabled to runmonitors during all
hours of the applicable day, except during the time range.

Note: The range schedule uses a 24 hour time format only.

Example: To disable monitors from 6:00 PM on Thursday evening until 8:00 AM the
followingmorning, enter a From value of 18 and a To value of 24 for Thursday and
then enter a From value of 0 and a To value of 8 for Friday. If you enter a From value
of 18 and a To value of 8 on the Thursday schedule, the schedule becomes invalid.

To enter multiple times for a single day, separate the times by a comma (,). For
example, to disable from 2-3AM and 7-8AM, in the From box enter 2:00,7:00 and in
the To box enter 3:00,8:00.

Default value:Enabled (no time values specified). See the table below for more
information.

Enabled
Setting
(Enabled
/
Disabled)

Time Range
(From /To)

Time Range
(From /To)

Enabled From and To
time values
specified

Monitors are enabled to run only during the From and
To time range.

Enabled (no time values
specified)

Monitors are enabled to run during all hours of the
applicable day. This is the default setting for 24-hour
operation.

Disabled From and To
time values
specified

Monitors are enabled to run during all hours of the
applicable day, except during the From and To time
range.

Disabled (no time values
specified)

Monitors are disabled during all hours of the
applicable day.

Failover Schedule Preferences

This table contains schedules that are used for mirroring and checking availability of the primary SiteScope.
It is available on the SiteScope Failover server only.

Name Name for the Failover Schedule which is selected in the Run Settings of the Failover
Profile dialog box. For details, see "New/Edit Failover Profile Dialog Box" on
page 493.
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UI Element Description

General Settings

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.

Note:HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field
is rejected. The following is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example,

onhover.
l Any attribute with javascript as its value.

Search/Filter Tags

<Tag name and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created for
the SiteScope, this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 617.
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Chapter 55: Search/Filter Tags
You use Search/Filter Tag Preferences tomanage the Search/Filter Tags defined in SiteScope. You can
assign keyword tags to one or moremonitors, and then use the tags as an object for a filter. You can add, edit,
or delete tags from this page.

Tags can also be used in alert templates using the <tag> attribute. For details, see "Properties Available in
Alerts, Templates, and Events" on page 1126.

Tip: You can view a guided demonstration on how tomanage and track monitors using filters and tags on
YouTube: http://hpsw.co/r5D4GxA.

To access
Select Preferences > Search/Filter Tags.

Tasks
How to filter monitors using Search/Filter Tags
This task describes the steps involved in defining a tag, assigning it to one or moremonitors, and then using
the tag to search or filter the display.

1. Prerequisites.
Youmust be an administrator in SiteScope, or a user grantedView tags permissions to be able to view
Search/Filter tags. To create or edit Search/Filter tags, youmust haveAdd, edit or delete tags
permissions. For more details on user permissions, see "Permissions" on page 636.

2. Create a Search/Filter Tag.
InPreferences > Search/Filter Tags, create tags for use in filtering the display. You define the tags and
their values. For user interface details, see "New/Edit Tag Dialog Box" on page 617.

Example:Create a tag indicating the type of operating system onwhichmonitors are running. The
tag Operating Systemsmight have values such as Windows 2008, Windows XP, AIX, Solaris,
Linux, and so forth.
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3. Assign Search/Filter Tags to SiteScopemonitors.
a. In the SiteScopemonitor tree, select themonitor you want to tag.
b. In the Properties tab, expand theSearch/Filter Tags panel, and assign a tag and tag values to the

monitor.
c. Repeat for all monitors to which you want to assign this tag and value.

Example: To define a filter to display only thosemonitors running on a particular platform, select the
appropriate Platform tag value to assign to themonitor.

4. Use the tag as an object for a filter.
l In Multi-View:

i. Open SiteScopeMulti-View, and select Tags in the views drop-down list.
ii. Drill down on tags or tag values to display only themonitors to which the selected tag item has

been assigned. For example, you can filter for all monitors that have the Platform tag with the
AIX tag value assigned to them. For details on usingMulti-View, see "Multi-View" on page 936.
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l In the SiteScope Dashboard:

i. In theMonitors context menu, click the arrow next to the Filter button, and create a filter
that includes the tag values you want to see. For user interface details, see "Filter Objects in the
SiteScope View" on page 65.

ii. In the Tags field, enter tag values, or click theBrowse button and select the tag values by
which you want to filter in the Tags list. For details on the Filter Tags user interface, see
"New/Edit Tag Dialog Box" on the next page.

iii. After you create a filter, the tree displays only thosemonitors that have the selected tag values
assigned to them.

UI Descriptions
This section includes:

l "Search/Filter Tags Page" below
l "Search/Filter Tags" on page 614

Search/Filter Tags Page
User interface elements are described below:

UI Element Description

New Tag. Creates a new search/filter tag. For user interface details, see "New/Edit Tag
Dialog Box" on the next page.

Edit Tag. Enable editing a search/filter tag. For user interface details, see "New/Edit Tag
Dialog Box" on the next page.

DeleteTags. Deletes the selected tag from Search/Filter Tag Preferences.

Note:You cannot delete a Search/Filter tag or tag value if it is referenced by a SiteScope
object. Youmust remove the tag or tag value from all SiteScope objects before you can
delete it.

Select All. Selects all listed search/filter tags.

Clear Selection. Clears the selection.

Name Name string assigned to the setting profile when you create a new search/filter tag.

Description Description of the setting profile that was assigned when creating or editing the search/filter
tag.
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New/Edit Tag Dialog Box
User interface elements are described below:

UI Element Description

New. Adds a tag value. A new row is added at the bottom of the list of tag values.

Delete. Deletes the selected value from the tag.

Note:You cannot delete a Search/Filter tag or tag value if it is referenced by a SiteScope
object. Youmust remove the tag or tag value from all SiteScope objects before you can
delete it.

Move up tag value. Moves the selected tag value up the list of tag values. This enables
you to sort the tag values order, instead of ordering alphabetically.

Move down tag value. Moves the selected tag value down the list of tag values. This
enables you to sort the tag values order, instead of ordering alphabetically.

Tag name The name of the search/filter tag.

Maximum length: 255 characters

Tag
description

Description of the search/filter tag.

Values Values included in the tag.

Value
Name

Name for the value to be included in the tag. Each tagmust include at least one value. Each
value appears as a child object of the tag namewhen defining or editing tag settings for all
objects in themonitor tree.

Value
Description

Description for each value. This description appears only when editing the tag.
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Chapter 56: SNMP Preferences
You use SNMP Preferences to configure the settings SiteScope needs to communicate with an external
SNMP host or management console. These are the default SNMP parameters for use with SNMP Trap alerts.

To access
Select Preferences > SNMP Preferences. In the SNMP Trap Preferences page:

l Click theNew SNMP Trap button in the Send/Receive SNMP Traps Preferences section to create a
new profile for sending or receiving SNMP Traps, or

l Select an existing trap profile in the Send/Receive SNMP Traps Preferences section, and click theEdit
SNMP Trap button.

Note: Youmust be an administrator in SiteScope, or a user grantedView email, pager, HTTP and
SNMP lists permissions to be able to view SNMP Preferences. Add, edit or delete email, pager,
HTTP and SNMP preferences permissions are required to create or edit SNMP Preferences. For details
on this topic, see "User Management Preferences" on page 625.

Learn About
SNMP Preferences Overview
SNMP Preferences enable you to define settings that are used by SiteScope SNMP Trap alerts when sending
data tomanagement consoles. It also enables you to define SNMP Trap receivers, and listen tomultiple local
addresses and ports at the same time. SiteScope uses the SiteScope SNMP Trap Alert type to integrate with
SNMP-based network management systems.

The SNMP Preferences page displays the defined custom SNMP Trap profiles or templates to send traps to
hosts. The SNMP Trap profile can be associated with one or more SNMP Trap alerts by editing the applicable
alert definition.

You can use the SNMP trapmonitor to see if a trap was sent to SiteScope. For details, see SNMP Trap
Monitor in the SiteScopeMonitor ReferenceGuide.

Note: The template export and import flow does not contain SNMP Trap Preferences. Therefore, when
exporting and importing a template that contains references to SNMP trap preferences, you should
manually create these preferences, andmanually update the SNMP Traps in the imported template.

UI Descriptions
This section includes:

l "SNMP Preferences Page" on the next page
l "New/Edit SNMP Trap Dialog Box" on page 620
l "New/Edit SNMP Trap Receiver Dialog Box" on page 623
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SNMP Preferences Page
This page displays the defined custom SNMP Trap profiles for sending and receiving traps.

Note: Only an administrator in SiteScope, or a user grantedAdd, edit or delete email, pager, HTTP
and SNMP preferences permissions can create or make changes to SNMP Preferences. For details on
this topic, see "User Management Preferences" on page 625.

User interface elements are described below:

UI Element Description

Send/Receive SNMP Traps Preferences

New SNMP Trap. Creates a new profile for an SNMP Trap/receiver. For user interface
details, see "New/Edit SNMP Trap Dialog Box" on the next page and "New/Edit SNMP Trap
Receiver Dialog Box" on page 623.

Edit SNMP Trap. Enables editing the SNMP Trap/receiver profile. For user interface
details, see "New/Edit SNMP Trap Dialog Box" on the next page and "New/Edit SNMP Trap
Receiver Dialog Box" on page 623.

Delete SNMP Trap. Deletes the selected SNMP Trap profile from SNMP Preferences.

Note:You cannot delete an SNMP Trap profile if it is referenced by an alert action. Youmust
change the SNMP Trap in the alert before you can delete the SNMP Trap profile.

Test SNMP Trap. Tests that you can send amessage to the SNMP trap. Enter amessage
in the Test SNMP Trap dialog box, and click Test.

Select All. Selects all listed send/receive SNMP Trap profiles.

Clear Selection. Clears the selection.

Default
Settings

Click the arrow next toDefault Settings, and select an option:

l Edit. Opens the SNMP Trap Preferences Default Settings dialog box which enables you
to change the default settings displayed in the New SNMP Trap dialog box. For details
on the settings, see "New/Edit SNMP Trap Dialog Box" on the next page.

l Test. Opens the Test SNMP Trap dialog box which enables you to test that you can send
amessage to the default SNMP trap. Enter amessage in the Test SNMP Trap dialog
box, and click Test.

Note: The SNMP Trap test does not send a full trap with all varbinds. It sends the SNMP
Trap with the configured trap OID andmessage only.

Name Name string assigned to the setting profile when you create a new SNMP trap/receiver
profile.

Host Domain name or IP address of themachine that receives all SNMP trapmessages.

Port SNMP port to which the trap is sent.

Description Description of the setting profile that was assigned when creating or editing the profile.
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New/Edit SNMP Trap Dialog Box
This dialog box enables you to create SNMP Trap profiles or edit existing ones.

User interface elements are described below:

UI Element Description

General Settings

Name Name string assigned to the setting profile when creating a new SNMP recipient.

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.

Note:HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than one
line). If malicious HTML code or JavaScript is detected, the entire field is rejected. The
following is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.

Preferences Settings: Main Settings Area

Send to host Domain name or IP address of themachine that receives all SNMP trapmessages. This
machinemust be running an SNMP console to receive the trapmessage.

Examples: snmp.mydomain.com or 206.168.191.20.

SNMP port SNMP port to which the trap is sent.

Default value: 162

Preferences Settings: SNMP Connection Settings Area

Timeout
(seconds)

Amount of time, in milliseconds, to wait for the SNMP trap requests (including retries) to
complete.

Default value: 5

Number of
retries

Number of times each SNMP trapGET request should be retried before SiteScope
considers the request to have failed.

Default value: 1

Community Default SNMP community name used for sending traps. The community stringmust
match the community string used by the SNMP management console.

Default value: public

SNMP version Default SNMP protocol version number to use. SNMP V1 and V2c are currently
supported.

Default value:V1
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UI Element Description

Authentication
algorithm

Authentication algorithm used for SNMP V3. You can select MD5, SHA, or None.

Note: This field is available only if SNMP V3 is selected.

User name User name to be used for authentication if you are using SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Password Password to be used for authentication if you are using SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Privacy
algorithm

The privacy algorithmused for authentication for SNMP version 3 (DES,128-Bit
AES,192-Bit AES, 256-Bit AES).

Default value:DES

Note: This field is available only if SNMP V3 is selected.

Privacy
password

The privacy password used for authentication for SNMP version 3. Leave blank if you do
not want privacy.

Note: This field is available only if SNMP V3 is selected.

Context name The context name of SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Context
engine ID

The context engine ID of SNMP version 3.

Note: This field is available only if SNMP V3 is selected.

Preferences Settings: Advanced Settings Area

SNMP trap ID Select the type of trap to send. There are several predefined ID types for common
conditions:

l Generic SNMP trap ID. Select a generic SNMP type from the drop-down list.
l Enterprise-Specific SNMP trap ID. To use an enterprise specific SNMP ID type,
enter the number of the specific trap type in the box.

Note:When integrating SiteScope with NNMi, youmust select Enterprise-Specific
SNMP trap ID, and enter 1. SiteScope sends a different notification ID for each SNMP
version:

l SNMP V1: .1.3.6.1.4.1.11.15.1.4
l SNMP V2: .1.3.6.1.4.1.11.15.1.4.1
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UI Element Description

SNMP object
ID

Identifies to the console the object that sent themessage.

l Preconfigured SNMP object IDs. Select one of the predefined objects from the
drop-down list.

l Other SNMP object ID. To use another object ID, enter the other object ID in the
box.

Note:

l In SiteScope version 11.20 and later, all logged traps have an object ID that starts
with a dot (“.”). For example, oid=.1.3.6.1.2.1.0.1.3.6.1.4.1.11.2.17.1.

l When integrating SiteScope with NNMi, select Preconfigured SNMP object IDs
and chooseHP SiteScope Event from the list.

Add System
OID as a
prefix to
SNMP Trap

Adds the default system OID (1.3.6.1.2.1) as a prefix to all SNMP TrapOIDs. Clear the
check box if you do not want to use this prefix.

Default value:Selected

SNMP source The SNMP trap source: SiteScope Server or themonitor target server.

Default value:Monitored Host

Note:

l The followingmonitors do not have a target remote server: Composite, e-Business
Transaction, Formula Composite, SNMP Trap, URL List.

l The followingmonitors report the SiteScope host as Monitored Host: Custom,
Custom Database, DHCP, Microsoft NetScout Event, Technology SNMP Trap
Integration, Technology Web Service Integration.

l While somemonitors report the target remote as theMonitored Host, you need to
type the target remotemanually for the followingmonitors:
l Database Counter monitor: Reports the SiteScope host as theMonitored Host
when theDatabase machine name field is empty..

l DatabaseQuery monitor: Reports the SiteScope host as theMonitored Host when
theDatabase machine name field is empty.

l WebLogic Application Server monitor: Reports the address of the server where
WebLogic is running as theMonitored Host when the Target field is empty.

l WebSphere Application Server monitor: Reports the name of the server you want
to monitor as theMonitored Host when the Target field is empty. On UNIX
servers, enter the full path of the server.

Search/Filter Tags
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UI Element Description

<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

New/Edit SNMP Trap Receiver Dialog Box
This dialog box enables you to create SNMP Trap receiver profiles or edit existing ones, and listen tomultiple
local addresses and ports at the same time. When an SNMP Trap receiver session has v3 properties, it is still
able to listen and receive SNMP v1 and v2 traps.

User interface elements are described below:

UI Element Description

General Settings

Name Name string assigned to the setting profile when creating a new SNMP receiver.

Description Description for the setting profile, which appears only when editing or viewing its properties.
You can include HTML tags such as the <BR>, <HR>, and <B> tags to control display
format and style.

Note:HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than one line).
If malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:

l Tags: script, object, param, frame, iframe.
l Any tag that contains an attribute starting with on is declined. For example, onhover.
l Any attribute with javascript as its value.

Preferences Settings

Host Select the host option:

l Host. Select the host name or IP address of the local SNMP address to bind from the
drop-down list.

l Other. Enter the host name or IP address of the local SNMP address to bind.

Port UDP port used for collecting traps.

Default value: 162

V3 Trap Settings

User Name User name used for SNMP authentication.
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UI Element Description

Auth. Type Type of SNMP authentication used (MD5, SHA, or None).

Auth.
Password

Password used for SNMP authentication.

Privacy
Type

The privacy protocol used for SNMP authentication (DES,128-Bit AES,192-Bit AES, 256-Bit
AES).

Privacy
Password

The privacy password used for SNMP authentication.

Context
Engine ID

The SNMP context engine ID.

Search/Filter Tags

<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope,
this section appears but is empty. If tags have been created, they are listed here and you
can select them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.
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Chapter 57: User Management Preferences
Youmanage SiteScope user accounts from the User Management Preferences page. This page enables you
to administer the users that are allowed access to SiteScope.

Note: UserManagement Preferences are available only to users accessing SiteScope directly and not to
users accessing SiteScope using SAM Administration in APM. For details on how SiteScope
permissions interact with APM, see "Accessing SiteScope and Building Permissions Model" in the APM
Application Administration Guide in the APMHelp.

To access
Select Preferences > User Management Preferences

Note:

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete user preferences
permissions can create or make changes to user settings and permissions for the current user or for
other users. By default, a regular user does not haveAdd, edit or delete user preferences
permissions, whichmeans that they can view only their own user properties.

l The Administrator account is the default account that is active when the product is installed. To create
other accounts, youmust first edit the Administrator account profile to include a user login name and
login password. The data provided by SiteScope can bemade available to multiple users without
granting full administrative privileges to all users.

Learn About
User Profiles Overview
As a client-server based architecture, a single SiteScope user profile can be accessed by multiple users
simultaneously. You can definemultiple SiteScope user accounts that provide different views and edit
permissions for different audiences. For example, you can create a user profile that enables users to view
monitor status and reports but does not enable the users to add or edit monitor configurations or alerts.

A user profile limits access to SiteScope to those users that enter a correct user name and password.
Optionally, user authentication can be handled by submitting a query to an LDAP database. This enables you
tomanage users from an external LDAP server by storing authentication information (user names and
passwords) for all SiteScope users in a central repository, and using the LDAP server to verify a user's
credentials. For more details, see "LDAP Authentication and Authorization" on page 659.

A user profile has twomain components:

l User authentication information and access permission
l Action permissions
Configure these settings for each user profile in the applicable User Profile container. For details on creating a
SiteScope user profile, see "How to Create a SiteScope User Profile" on page 627.
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User Types and User Role Types
SiteScope provides the following user types and user role types:

User Types:

l Administrator. SiteScope provides a single administrator by default. An administrator can view and
change anything in SiteScope. It has other special properties as well, such as being allowed to create
other users and to change their profiles in the User Management Preferences page. The administrator
account cannot be disabled or deleted.

l Super User (Power user). This is a regular user that has been granted user management permissions. A
power user can create, edit, or delete other users, except the administrator. A power user can also edit, but
not delete, himself. Both an administrator and a power user can create a power user. Theremay exist any
number of power users. For details about enabling this user type, see "New/Edit User Profile Dialog Box"
on page 633.

l Regular User. A regular user cannot create, delete, or edit any user, including itself. It has all the
permissions defined for it by the administrator or power user. By default, a regular user is granted all
permissions except Add, edit or delete user preferences (underUser Management Preferences). This
limits the user to being able to view their own user properties and the root groups for which they have
permissions. A regular user cannot view or edit settings and permissions of other users.

l Inherited from <user role>. Displayed in the User Type field for the selected user to which a user role
has been assigned. For more details, see User Role Types below.

l Integration Viewer. By default, SiteScope provides an Integration Viewer user that is used for drilling
down from HPOM events. This is a regular user that has been granted view permissions, and permissions
to refresh groups andmonitors. For more details, see Integrating SiteScope with Operations Manager
Products in the SiteScope Help. You can check the HPE Software Integrations site for the latest version
of this guide.

User Role Types: Used tomanage groups of SiteScope users when using an external LDAP server.

l Super User Role. This is a regular user role that has been granted user management permissions (Add,
edit or delete user preferences). Users of this type can create, edit, or delete other users, except the
administrator. They can also edit, but not delete, their own user role. Both an administrator and a power
user can create a super user role. Theremay exist any number of super user roles.

l Regular User Role. A user of this type cannot create, delete, or edit any user, including itself. It has all
the permissions defined for it by the administrator or power user. By default, a regular user role is granted
all permissions except Add, edit or delete user preferences (underUser Management Preferences).
This limits the user to being able to view their own user properties and the root groups for which they have
permissions. A regular user role cannot view or edit settings and permissions of other users. Theremay
exist any number of regular user roles.

Note:When a user role is assigned to a user profile (in theAssign user role field in from the User Profile
dialog box), Inherited from <user role> is displayed in the User Type field for the selected user. The
user inherits the same permissions as the user role.

For details about enabling user role types when using an LDAP server, see "How to enable SiteScope to use
LDAP authentication" on page 660.

For more details about LDAP authentication, see "LDAP Authentication and Authorization" on page 659.

Using SiteScope
Chapter 57: User Management Preferences

HPE SiteScope (11.33) Page 626 of 1206

https://hpenterprise.sharepoint.com/teams/aztec/Portal/index.html


User Permissions
When setting up SiteScope user accounts, the administrator in SiteScope or a power user can configure the
permissions required for different users. Permissions limit the areas in SiteScope that a user can access, and
control the types of action a user can perform on SiteScope objects, such as groups, monitors, alerts, reports,
preferences, remote servers, templates, and Dashboard.

Note: By default, a regular user can view their own user properties and the root groups for which they
have permissions only. If a regular user is grantedAdd, edit or delete user preferences permissions
(thereby making the user a power user), the user can edit its own settings and permissions, and create
andmake changes to the settings and permissions of other users.

User permissions have been extended in SiteScope so that there are specific view, edit, and test permissions
for each preference type, and view, edit, and test permissions for remote servers. This enables the
administrator or power user to restrict access for selected users to specific preference types and to remote
server properties. Where a user does not have view permissions to a specific preference, the tab for that
preference is unavailable.

When selecting permissions for an action type, it is important to understand that there are dependency
relationships between certain permissions. Edit and test permissions are always dependent on the
corresponding view permission. For example, if you select theAdd, edit or delete remote servers or Test
remote servers permission, theView remote servers permission is automatically selected. Conversely, if
you clear theView remote servers permission, theAdd, edit or delete remote servers and Test remote
servers permissions are automatically cleared.

You configure user permissions from thePermissions panel of the New/Edit User Profile dialog box. For
details on SiteScope user permissions, see "New/Edit User Profile Dialog Box" on page 633.

Password Requirement Parameters
You can configure password requirements by setting the following parameters in <SiteScope root
directory>\groups\master.config:

Parameter Description

_adminMinimumLength = x The password lengthmust be at least xcharacters.

_adminRequireAlpha = (1,0) l 0. Password does not require an alphabetic character.
l 1. Passwordmust contain an alphabetic character.

_adminRequireNumber = (1,0) l 0. Password does not require a numeric character.
l 1. Passwordmust contain a numeric character.

_adminRequirePunctuation = (1,0) l 0. Password does not require punctuation.
l 1. Passwordmust contain punctuation.

Tasks
How to Create a SiteScope User Profile
This task describes the steps involved in creating a SiteScope user profile.
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1. Prerequisites
Youmust be an administrator in SiteScope, or a user grantedAdd, edit or delete user preferences
permissions to be able create or make changes to SiteScope user management settings and
permissions. A regular user does not haveAdd, edit or delete user preferences permissions by
default.
For details on user permissions, see "New/Edit User Profile Dialog Box" on page 633.

2. Create a SiteScope user profile

a. In the User Management Preferences page, click the arrow next to theNew User button, and
select New User.

b. In theMain Settings panel, enter the user name, login name and password, and select the groups
that can be accessed by this user profile.
For user interface details, see "New/Edit User Profile Dialog Box" on page 633.

3. Assign permissions to the user - optional
Select the permissions granted to this user in the Permissions panel, or use the default permissions (all
permissions are granted except Add, edit or delete user permissions).
Click OK. The new user profile is added to the User Management Preferences list.

4. Log on to SiteScope
Log on to SiteScope using the new user profile. For details, see "Log into SiteScope" on page 16.

Note: The SiteScope login password is case sensitive.

SiteScope opens to the Dashboard view and the relevant user permissions are ascribed to the user.
5. Changing a User's Password - optional

a. To change a user password, right-click the user profile in the User Management Preferences page,
and select Edit User.

b. In the Edit User Profile dialog box, enter a new password and confirm the password. For details, see
"New/Edit User Profile Dialog Box" on page 633.

If the new password does not comply with password configuration rules, an error message is displayed
and the password is not changed. For password configuration rules, see "Password Requirement
Parameters" on the previous page.

Related tasks: "How to enable SiteScope to use LDAP authentication" on page 660, "How to Configure Silent
LoginWhen Using LDAP Authentication" on page 661

UI Descriptions
User Management Preferences Page
This page enables you to createmultiple user accounts that provide different view and edit permissions for
different audiences.
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UI Element Description

New. Click the arrow next to the button, and select:

l New User. Creates a new user profile. For user interface details, "New/Edit User Profile
Dialog Box" on page 633.

l New User Role. Creates a new user role profile. For user interface details, "New/Edit
User Role Profile Dialog Box" on page 646.

Edit. Enables editing the selected user or user role profile. For user interface details, see
"New/Edit User Profile Dialog Box" on page 633 and "New/Edit User Role Profile Dialog
Box" on page 646.

Delete User/User Role. Deletes the selected user or user role profiles.

Note: You cannot delete a user role that is mapped to a LDAP context using the Assign
User Role property in the LDAP User Authentication Settings. Youmust modify the
mapping to remove reference to the user role before you can delete the user role.

Copy to User Role. Enables coping an existing SiteScope user's permissions to a new user
role.

Note:SiteScope users still need to have a user login and a security group assigned to them
on the LDAP server. (LDAP users have their own LDAP user name and password for logging
on to SiteScope.)

Select All. Selects all listed user and user role profiles.

Clear Selection. Clears the selection.

Default
Settings

Click the arrow next toDefault Settings, and select an option:

l Edit. Opens the User Management Settings dialog box which enables you to change the
default LDAP authentication settings.

l Test. Tests the connection to the LDAP server and the authentication of user.
l Save allowed LDAP users to CSV. Enables saving a list of all LDAP users that have
permissions to log on to SiteScope to a CSV file. For details, see "Save SiteScope LDAP
Users in CSV File Dialog Box" on page 648.

Note: This option is available to SiteScope administrators only

Displayed
Name

The title for the user or user role profile that was provided in theDisplayed user name or
Displayed user role name box.

Note:When configuring a user profile, if a user name is not provided, the Login name value
is used instead.

Login
Name/User
Role
Context

Displays the login name for a user profile, and the LDAP context for a user role.
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UI Element Description

Login
Disabled

Displays the login status. If the check box is cleared, access to SiteScope using the user
profile is enabled. If the check box is selected, access to SiteScope with this user profile is
not allowed.

User Type Type of user. For details on the different user types, see "User Types and User Role Types"
on page 626.

Other User Management UI Pages:

l "User Management Settings Dialog Box" on the next page
l "New/Edit User Profile Dialog Box" on page 633
l "New/Edit User Role Profile Dialog Box" on page 646
l "Save SiteScope LDAP Users in CSV File Dialog Box" on page 648
l "Select User's AllowedGroups Dialog Box" on page 648

Tips/Troubleshooting
Upgrade - Notes/Limitations
l The user preference permissions in SiteScope are not supported in SAM Administration when the
SiteScope is reporting to Business Availability Center version 8.00 or earlier.

l When upgrading from versions of SiteScope earlier than 10.10, the permission values are determined as
follows:

l View <preference type> permission is selected by default for all preference types (since there was no
corresponding preference permission in earlier versions of SiteScope).

l Edit <preference type> permission for all preference types is determined according to theEdit
Preferences permission in the earlier version of SiteScope.

l Test <preference type> permission for all preference types is determined according to the Test
Preferences permission in the earlier version of SiteScope.

User Accounts - Notes/Limitations
l The Administrator account is the default account used when accessing SiteScope. This means that
anyone requesting the server address and port number where SiteScope is running is, by default, logged in
on the administrator account. To restrict access to this account and its privileges, youmust edit the
administrator account profile to include a user login name and login password. SiteScope then displays a
login dialog before SiteScope can be accessed.
It is also recommended to change the Integration Viewer account profile to include a user login name and
login password.

l You can create a named user account that does not require a user login name and password. You do this
by creating a new user profile in the standard format (providing aDisplayed user name), but leave the
Login name andPassword boxes blank. With this configuration, users accessing SiteScope are
presented with an authentication dialogue. They may be authenticated as this named user by leaving the
Login Name andPassword boxes blank and clicking the Log In button. This user is displayed as guest
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on the upper right side of the SiteScope user interface.
l You should restrict the permissions on regular user accounts to avoid unauthorized changes to your
SiteScope configuration.

l User login name and passwordmust be in English characters.

User Management Settings Dialog Box
This dialog box enables you to configure the default LDAP user management settings.

To access Select Preferences > User Management Preferences. In the User Management
Preferences toolbar, select Default Settings > Edit.

Important
information

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete user
preferences permissions can create or make changes to LDAP user management
settings and permissions. By default, a regular user does not haveAdd, edit or delete
user preferences permissions, whichmeans that they can view only their own user
properties.

l We recommend that you contact your LDAP server administrator for assistance when
configuring LDAP server settings.

Relevant
tasks

l "How to enable SiteScope to use LDAP authentication" on page 660
l "How to Configure Silent LoginWhen Using LDAP Authentication" on page 661

See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

LDAP User Management Settings
User interface elements are described below:

UI Element Description

Enable LDAP
authentication

Enables using an external LDAP server for authenticating SiteScope users.

Default value:Not selected

LDAP server
URL

URL of the applicable LDAP server to access the SiteScope service using a centralized
LDAP authentication rather than the SiteScope specific password. This way, password
authentication for access to SiteScope can be performed by LDAP.

Example: ldap://ldap.mydomain.com:389 or ldaps://ldap.mydomain.com:636
(when using an SSL connection).
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UI Element Description

LDAP
credentials

Option for providing LDAP server authentication credentials:

l Use user name and password. Select this option tomanually enter user credentials.
Enter the user name and password used to access the LDAP server in theUser
name andPassword box. This enables SiteScope to run search queries in LDAP.
The user should be an administrator in LDAP, or a user that has been granted search
permissions in LDAP.

Example: The user name can be in the format [Domain]/[user_name] or [user_
name]@[Domain].

l Select predefined credentials. Select this option to have SiteScope automatically
supply a predefined user name and password for the LDAP server (default option).
Select the credential profile to use from theCredential profile drop-down list, or click
Add Credentials and create a new credential profile. For details on how to perform
this task, see "Credential Preferences" on page 476.

Enable same
permissions
for all LDAP
users

Select the check box to enable same permissions for all users in the specified LDAP
context as that of the selected SiteScope user role. You can proceed to select the
SiteScope user role and the LDAP context if you select this check box.

Default value:Not selected

Assign user
role

All user roles configured for SiteScope are displayed in the list. Select the user role whose
permissions are applied to all the users in the specified LDAP context if you selected the
Enable same permissions for all LDAP users check box.

Default value:DEFAULT VIEWER USER

LDAP context

New LDAP context. Adds a new row at the bottom of the LDAP context table, enabling
you to add a new LDAP context.

Delete LDAP context. Deletes the selected LDAP context.

Move Up. Enables you to change the order of the LDAP context list by moving the
selected LDAP context up the list.

Move Down. Enables you to change the order of the LDAP context list by moving the
selected LDAP context down the list.

Context Displays the LDAP root node for the context to search inside of LDAP.

Example: DC=ldap,DC=serverwhere DC refers to domain component.

Note:We recommend that you contact your LDAP server administrator for assistance
when configuring these settings.
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LDAP User Management Advanced Settings
User interface elements are described below:

UI Element Description

All default values in LDAP UserManagement Advanced Settings are relevant for an Active Directory
system. If you are using a different server type, contact your LDAP server administrator for the relevant
setting values.

LDAP user objectClass Query value used for the LDAP user role name.

Default value: user

LDAP user identification
attribute name

Query value used for LDAP users with login identification attributes.

Default value: sAMAccountName

LDAP group objectClass Query value used for the LDAP group (role context).

Default value:Group

LDAP user group
identification attribute
name

Query value used to provide attribute name for the LDAP user identification
in group.

Default value: Member

LDAP activation key
identification attribute

LDAP identity attribute for silent login authentication. This field is used with
an activation key authentication configuration only. You can enter a unique
attribute for identifying the LDAP user, or leave it blank, in which case, the
userPrincipalName attribute is used.

For more on silent login with an activation key, see Silent Authentication
under "LDAP Authentication and Authorization" on page 659.

New/Edit User Profile Dialog Box
This dialog box enables you to create a new user profile or edit an existing profile.

To access Select Preferences > User Management Preferences. In the User Management
Preferences page:

l Click the arrow next to theNew User button, and select New User, or

l Select an existing user profile and click theEdit button.

Important
information

Only an administrator in SiteScope, or a user grantedAdd, edit or delete user preferences
permissions can create or make changes to user settings and permissions for the current
user or for other users. By default, a regular user does not haveAdd, edit or delete user
preferences permissions, whichmeans that they can view only their own user properties.

Relevant
tasks

l "How to Create a SiteScope User Profile" on page 627
l "How to enable SiteScope to use LDAP authentication" on page 660
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See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

Main Settings
User interface elements are described below:

UI
Element Description

Displayed
user name

Title for the user profile. The title is displayed in the list of users. If you do not enter a title, the
Login name value is used as the displayed name.

Login
name

SiteScope login name to access SiteScope using this profile.

Alternatively, users can log into SiteScope using LDAP authentication by entering a value in
the relevant LDAP cells.

Allowed characters: Latin alphanumeric.

Note: Entering characters other than the allowed characters does not cause an error when
creating the user profile. However, the user cannot log on to SiteScope using that login name.

Password SiteScope login password for this user.

If using LDAP for user authentication, there is no need to enter a password here. Users enter
their LDAP password in the SiteScope login dialog box when they log on to their user account.

For information about password requirements, see "Password Requirement Parameters" on
page 627.

All SiteScope passwords are encrypted using 3DES (also known as TDES or Triple Data
Encryption Algorithm). Although the TDES key is stored in SiteScope, it cannot bemodified.
For more information, refer to Hardening the SiteScope Platform in the SiteScope
Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Note:

l The SiteScope login password is case sensitive.
l Silent login is not supported for users that contain any of the following special characters
in the password: ‘ (apostrophe), “ (double quote), or / (backslash).

Confirm
password

Confirmation of the password entered in the Password box. This is used when creating a new
user profile or changing the password of an existing user profile.
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UI
Element Description

LDAP
service
provider

URL of the applicable LDAP server to access the SiteScope service using a centralized
LDAP authentication rather than the SiteScope specific password. This way, password
authentication for access to SiteScope can be performed by LDAP.

You can specify multiple LDAP service providers by entering either the host name and/or the
IP address of each LDAP service provider separated by a semicolon (";"). SiteScope reads
the list of LDAP service providers and searches for the available provider from the list.'

Example: ldap://ldap.mydomain.com:389.

Note:

l Users still need to have a SiteScope login name defined.
l Users can use LDAP to access SiteScope, but they must have a user login and security
principal assigned to them on the LDAP server.

LDAP
security
principal

Security Principal for this user when using LDAP authentication to access the SiteScope
service.

Example: uid=testuser,ou=TEST,o=this-company.com

Note:Users may be defined with special characters on the LDAP server. However,
SiteScope does not support users that contain the following characters in their user name:
equal ("="), semicolon (";"), inverted commas ("""). A user name containing invalid characters
is unable to log on to SiteScope.

Assign
user role

Select to assign the user the same permissions as the user role. The list displays the names
of all user roles defined in SiteScope. If you select a user role, the Login disabled, Allowed
groups, Allowed template containers, andPermissions settings are no longer available
for selection.

For details on creating a user role, see "New/Edit User Role Profile Dialog Box" on page 646.

Example: If a Super User Role is created withAdd, edit or delete user preferences
permissions and this role is assigned to the user, the user inherits the super user permissions
(User Type is displayed as Inherited from Super User Role).

Login
disabled

Disables access to SiteScope with this user name and password. Clear the check box to
enable access using the user profile.

Allowed
groups

Displays the list of groups that can be accessed by this user profile. Click theNew button
to open the Select User's AllowedGroups dialog box, and select groups. For user interface
details, see "Select User's AllowedGroups Dialog Box" on page 648.

To remove user access to a group, select the group and click theDelete button. It is not
possible to delete all groups in the list.

Default value: The SiteScope node is selected to enable access to all groups. To restrict
user access to fewer groups, clear the check box for the SiteScope node and then select the
individual groups below the SiteScope node to which you want to enable access.

Note: This field is not visible for an Administrator's settings.
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UI
Element Description

Allowed
template
containers

Displays the list of template containers that can be accessed by this user profile. Click the

New button to open the Select User's Allowed Template Containers dialog box, and
select template containers. For user interface details, see "Select User's Allowed Template
Containers Dialog Box" on page 649.

To remove user access to a template container, select the template container and click the
Delete button. It is not possible to delete all template containers in the list.

Default value: The SiteScope node is selected to enable access to all template containers.
To restrict user access to fewer template containers, clear the check box for the SiteScope
node and then select the individual template containers below the SiteScope node to which
you want to enable access.

Note: This field is not visible for an Administrator's settings.

Permissions

Enables you to determine user action permissions. To grant a permission, select the check box to the left of
the permission or permission group.

Important
information

l The Permissions panel is not visible for the administrator's account, since they have full
permissions which cannot be changed.

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete user
preferences permissions can create or make changes to user settings and permissions
for the current user or for other users.

l All the permissions in the Permissions panel are selected by default, except for theAdd,
edit or delete user preferences permission whichmust be granted by the SiteScope
administrator.

l The icon displayed to the left of a permission group indicates that not all permissions
contained within that root group have been selected.

See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

Groups

User interface elements are described below:

UI Element Description

Add, edit or
delete
groups

Enables the user to add new groups, rename, copy, and delete existingmonitor groups.
For details, see "New SiteScopeGroup Dialog Box" on page 215.

Default value:Selected

Refresh
groups

Enables the user to refresh or force all themonitors within a group to run regardless of their
schedule. For details, see "New SiteScopeGroup Dialog Box" on page 215.

Default value:Selected
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UI Element Description

Disable
groups

Enables the user to disable groups. For details, see "Enable/Disable Monitors in Group
Dialog Box" on page 903.

Default value:Selected

Monitors

User interface elements are described below:

UI Element Description

Add, edit or
delete
monitors

Enables the user to add new monitors, edit existingmonitor configurations, and delete
monitors. For details, see "Monitors andGroups" on page 211.

Default value:Selected

Note: This option overrides theEdit monitors (cannot create new monitors) option if
both are selected.

Edit or delete
monitors

Enables the user to edit or delete existingmonitor configurations without being able to
create new monitors. If you select this option, youmust clear theAdd, edit or delete
monitors option, otherwise theAdd, edit or delete monitors option prevails and a user
can create new monitors.

Default value:Selected

Note:Selecting this option does not prevent users from creating new monitors when
working in templatemode, unless Add, edit or delete templates is also cleared.

Refresh
monitors

Enables the user to refresh or force individual monitors to run regardless of their schedule.
For details, see "Monitors andGroups" on page 211.

Default value:Selected

Acknowledge
monitors

Enables the user to use the Acknowledge function to comment onmonitor status on the
group detail page. For details, see "AcknowledgingMonitor Status" on page 892.

Default value:Selected

Disable
monitors

Enables the user to disable monitors within a group. "Enable/Disable Monitors in Group
Dialog Box" on page 903.

Default value:Selected

Alerts

User interface elements are described below:

UI Element Description

View alerts
list

Enables the user to view the list of currently configured alert definitions on the Alert List
page. This is a root permission that is required to edit, test, or disable alerts indefinitely. For
details, see "SiteScope Alerts Page" on page 1091.

Default value:Selected
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UI Element Description

Add, edit
or delete
alerts

Enables the user to add a new alert, and edit or delete existing alerts. This option is
dependent on theView alerts list permission. For details on adding or editing alerts, see
"New/Edit Alert Dialog Box" on page 1092.

Default value:Selected

Note:

l Since alert actions are not controlled by alert action preferences permissions, this
permission is not dependent on theView emails, pagers, and SNMP lists permission.

l This option overrides theEdit or delete alerts option if both are selected.

Edit or
delete
alerts

Enables the user to edit or delete existing alert configurations without being able to create
new alerts.This option is dependent on theView alerts list permission. If you select this
option, youmust clear theAdd, edit or delete alerts option, otherwise theAdd, edit or
delete alerts option prevails and a user can create new alerts

Default value:Selected

Note:Selecting this option does not prevent users from creating new alerts when working in
templatemode, unless Add, edit or delete templates is also cleared.

Test alerts Enables the user to test an existing alert definition. This option is dependent on theView
alerts list permission. For details, see "SiteScope Alerts Page" on page 1091.

Default value:Selected

Disable
alerts
indefinitely

Enables the user to disable or enable one or more alerts indefinitely. This option is dependent
on theView alerts list permission. For details, see "New/Edit Alert Dialog Box" on
page 1092.

Default value:Selected

Disable
alerts
temporarily

Enables the user to disable or enable one or more alerts temporarily. For details, see
"New/Edit Alert Dialog Box" on page 1092.

Default value:Selected

Reports

User interface elements are described below:

UI Element Description

Generate
management report

Enables the user to create a scheduledManagement report manually. For details,
see "Management Report" on page 1167.

Default value:Selected

Add, edit or delete
management report

Enables the user to add new report definitions, and edit or delete existing report
definitions. For details, see "Management Report" on page 1167.

Default value:Selected
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UI Element Description

Generate quick
report

Enables the user to create ad hoc SiteScopemanagement reports. For details,
see "Quick Report" on page 1172.

Default value:Selected

Generate alert report Enables the user to create ad hoc or quick alert reports. For details, see "Alert
Report" on page 1178.

Default value:Selected

Generate monitor
summary report

Enables the user to use the BrowseMonitor form and theMonitor Summary
Report. For details, see "Monitor Summary Report" on page 1175.

Default value:Selected

Generate server
centric report

Enables the user to create Server-Centric reports. For details, see "Server-
Centric Report" on page 1184.

Default value:Selected

Remote Servers

User interface elements are described below:

UI Element Description

View remote
servers list

Enables the user to view the list of remote servers configured in SiteScope. This is a root
permission that is required to edit or test remote servers. For details, see "Remote Servers
Properties Page" on page 458.

If this option is not selected, the following entities are not available:

l Remote servers tree and remote servers page in theRemote Servers context.
l Add Remote Servers button in theMonitors context.
Default value:Selected

Add, edit or
delete
remote
servers

Enables the user to add remote servers to SiteScope and edit remote server settings. This
option is dependent on theView remote servers list permission. For details, see "Remote
Servers Properties Page" on page 458.

Default value:Selected

Test remote
servers

Enables the user to test remote server connectivity. This option is dependent on theView
remote servers list permission. For details, see "Remote Servers Properties Page" on
page 458.

Default value:Selected
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General Preferences

User interface elements are described below:

UI Element Description

View
general
preferences

Enables the user to view General Preferences. This is a root permission that is required to
edit General Preferences. For details, see "General Preferences" on page 500.

Default value:Selected

Edit general
preferences

Enables the user to edit General Preferences. This option is dependent on theView
general preferences permission. For details, see "General Preferences" on page 500.

Default value:Selected

Infrastructure Preferences

User interface elements are described below:

UI Element Description

View
infrastructure
preferences

Enables the user to view Infrastructure Preferences. This is a root permission that is
required to edit Infrastructure Preferences. For details, see "Infrastructure Preferences"
on page 517.

Default value:Selected

Edit
infrastructure
preferences

Enables the user to edit Infrastructure Preferences. This option is dependent on theView
infrastructure preferences permission. For details, see "Infrastructure Preferences" on
page 517.

Default value:Selected

Integration Preferences

User interface elements are described below:

UI Element Description

View
integration
preferences

Enables the user to view Integration Preferences. This is a root permission that is required
to edit Integration Preferences. For details, see "Integration Preferences Page" on
page 594.

Default value:Selected

Edit
integration
preferences

Enables the user to create or edit Integration Preferences. This option is dependent on the
View integration preferences permission. For details, see "Integration Preferences Page"
on page 594.

Default value:Selected
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Failover Preferences

User interface elements are described below:

UI Element Description

View
failover
preferences

Enables the user to view Failover Preferences. This is a root permission that is required to
edit Failover Preferences. For details, see "Failover Preferences" on page 491.

Default value:Selected

Edit failover
preferences

Enables the user to edit Failover Preferences. This option is dependent on theView
failover preferences permission. For details, see "Failover Preferences" on page 491.

Default value:Selected

Log Preferences

User interface elements are described below:

UI Element Description

View log
preferences

Enables the user to view Log Preferences. This is a root permission that is required to edit
Log Preferences. For details, see "Log Preferences" on page 597.

Default value:Selected

Edit log
preferences

Enables the user to edit Log Preferences. This option is dependent on theView log
preferences permission. For details, see "Log Preferences" on page 597.

Default value:Selected

Email, Pager, HTTP, and SNMP Preferences

User interface elements are described below:

UI Element Description

View email, pager,
HTTP and SNMP lists

Enables the user to view the Email, Pager, HTTP and SNMP profile lists. This is
a root permission that is required to edit or test Email, and SNMP Preferences.

For details, see "Email Preferences Page" on page 482, "HTTP Preferences
Page" on page 511 and "SNMP Preferences" on page 618.

Default value:Selected

Add, edit or delete
email, pager, HTTP
and SNMP
preferences

Enables the user to create or edit Email, HTTP and SNMP Preferences. This
option is dependent on theView email, pager, HTTP and SNMP lists
permission.

For details, see "Email Preferences Page" on page 482, "HTTP Preferences
Page" on page 511 and "SNMP Preferences" on page 618.

Default value:Selected
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UI Element Description

Test email, pager,
HTTP and SNMP
preferences

Enables the user to test any preference setting for communicating with an
external service such as email, HTTP or SNMP. This option is dependent on the
View email, pager, HTTP and SNMP lists permission.

For details, see "Email Preferences Page" on page 482, "HTTP Preferences
Page" on page 511 and "SNMP Preferences" on page 618.

Default value:Selected

Common Event Mappings

User interface elements are described below:

UI Element Description

View common
event mappings

Enables the user to view Common Event Mappings. This is a root permission that is
required to edit Common Event Mappings. For details, see "Common Event
Mappings" on page 465.

Default value:Selected

Add, edit or delete
common event
mappings

Enables the user to edit Common Event Mappings. This option is dependent on the
View common event mappings permission. For details, see "Common Event
Mappings" on page 465.

Default value:Selected

Schedule Preferences

User interface elements are described below:

UI Element Description

View schedule list Enables the user to view Schedule Preferences. This is a root permission that is
required to edit Schedule Preferences. For details, see "Schedule Preferences" on
page 608.

Default value:Selected

Add, edit or delete
schedule
preferences

Enables the user to create or edit Schedule Preferences. This option is dependent on
theView schedule list permission. For details, see "Schedule Preferences" on
page 608.

Default value:Selected

Using SiteScope
Chapter 57: User Management Preferences

HPE SiteScope (11.33) Page 642 of 1206



UserManagement Preferences

User interface elements are described below:

UI Element Description

Add, edit
or delete
user
preferences

Enables the user to view, add, edit, or delete user preferences for all other users, except the
SiteScope administrator user. A power user cannot delete his/her own account. For users
who do not have this permission, the New/Edit User Profile dialog box is displayed as read
only, and the settings and root groups for which the current user has permissions are
displayed.

Default value:Not selected

Credential Preferences

User interface elements are described below:

UI Element Description

View credential
list

Enables the user to view Credential Preferences. This is a root permission that is
required to edit Credential Preferences. For details, see "Credential Preferences
Page" on page 479.

If this option is not selected, the following entities are not available:

l Credential Preferences tab in the Preferences context.
l Add Credentials button in the Remote Servers andMonitors context.
Default value:Selected

Add, edit or
delete credential
preferences

Enables the user to create, edit, or delete Credential Preferences. This option is
dependent on theView credential list permission. For details, see "Credential
Preferences Page" on page 479.

Default value:Selected

Certificate Management

User interface elements are described below:

UI
Element Description

View
certificates
list

Enables the user to view the Certificate Management page. This is a root permission that is
required to edit Certificate Management. For details, see "Certificate Management" on
page 461.

Default value:Selected

Edit
certificates
list

Enables the user to manage certificates using Certificate Management. This option is
dependent on theView certificates list permission. For details, see "Certificate
Management" on page 461.

Default value:Selected
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Tags

User interface elements are described below:

UI
Element Description

View tags Enables the user to view the New/ Edit SiteScope Tag dialog box to see a list of defined tags.
This is a root permission that is required to edit tags. For details, see "Search/Filter Tags" on
page 614.

Default value:Selected

Add, edit
or delete
tags

Enables the user to add, edit, or delete search/filter tags and tag values. This option is
dependent on theView tags permission. For details, see "Search/Filter Tags" on page 614.

Default value:Selected

Templates

User interface elements are described below:

UI Element Description

View
templates

Enables the user to view templates that exist in themonitor tree. This is a root permission
that is required to edit templates. For details, see "Template Tree" on page 37.

Default value:Selected

Add, edit or
delete
templates

Enables the user to add, edit, and delete templates. This option is dependent on theView
templates permission. For details, see "Template Tree" on page 37.

Default value:Selected

Dashboard

User interface elements are described below:

UI
Element Description

Edit
favorites

Enables the user to add or delete items in the favorite views list in the SiteScope Dashboard
view. For details, see "Save to Dashboard Favorites Dialog Box" on page 904 and "Delete
Dashboard Favorites Dialog Box" on page 902.

Default value:Selected

Edit
layout

Enables the user to permanently disable fields in the SiteScope Dashboard. For example, if you
do not want specific users to see IP addresses of monitored servers, you can permanently hide
the Target column in the Dashboard. Users that do not have this permission cannot see the
columns that have been disabled.

Default value:Selected

View
monitor
history

Enables the user to view the recent history report for amonitor. For details, see "SiteScope
Dashboard - Monitor History View" on page 911.

Default value:Selected
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Event Console

User interface elements are described below:

UI Element Description

View and edit
event console
preferences

Enables the user to view and edit the Event Console Preferences. For details, see "Event
Console Preferences" on page 487.

Default value:Selected

Assigned
Event
Management

Enables the user to manage events that have been assigned to a user.

l Assign event to a user:Enables the user to assign or unassign an event that has
already been assigned using the "Event Details Dialog Box" on page 931.

l Edit event details:Enables the user to update attributes of an event which is
currently assigned to a user using the "Event Details Dialog Box" on page 931. This
permission does not include the ability to update theAssigned User attribute.

Default value:All permissions are selected

Unassigned
Event
Management

Enables the user to manage events that have not been assigned to a user.

l Assign event to a user:Enables the user to assign an event which is not currently
assigned using the "Event Details Dialog Box" on page 931.

l Edit event details:Enables the user to update attributes of an event which is not
currently assigned to a user using the "Event Details Dialog Box" on page 931. This
permission does not include the ability to update theAssigned User attribute.

Default value:All permissions are selected

Other

User interface elements are described below:

UI Element Description

Use tools Enables the user to use SiteScope tools in the Tools container to troubleshoot and
diagnosemonitor configuration problems. For details, see "SiteScope Tools" on page 91.

Default value:Selected

View logs Enables the user to view the raw data reported by SiteScopemonitors sent by alerts, and
other SiteScope logs. For details, see "SiteScope Log Files" on page 1012.

Default value:Selected

View server
statistics

Enables the user to view SiteScope internal data that can be used for analyzing SiteScope
server performance, stability, health, and for debugging bottlenecks. For details, see
"SiteScope Server Statistics" on page 1011.

Default value:Selected
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UI Element Description

Use monitor
tools

Enables the user to use SiteScope tools when configuring or editing particular monitor

types. If a diagnostic tool is available for amonitor type, the Tools button is enabled in
the Dashboard toolbar for that monitor in the group detail page. For details, see "SiteScope
Tools" on page 91.

Note:

l Diagnostic tools may expose sensitive system information.
l This option is dependent on theUse tools permission.
Default value:Selected

Download
SiteScope
Log Grabber
run results

Enables the user to download SiteScope LogGrabber run results files. For details on the
SiteScope LogGrabber Tool, see "SiteScope LogGrabber Tool" on page 119.

Note:Since the SiteScope LogGrabber run results files may expose sensitive
configuration information such as encoded passwords, this permission should not be
granted to untrusted users.

Enable
Docker
dynamic
application
discovery

Enables the user to search for applications running in new containers on the Docker node
or cluster and to automatically create a new monitor or set of monitors for each application
detected (provided the application is matched to some config file) using a predefined
template.

New/Edit User Role Profile Dialog Box
This dialog box enables you to create a new user role profile or edit an existing user role profile. User roles are
used tomanage groups of SiteScope users when using an external LDAP server.

To access Select Preferences > User Management Preferences. In the User Management
Preferences page:

l Click the arrow next to theNew User button, and select New User Role, or

l Select an existing user role profile and click theEdit button.

Important
information

Only an administrator in SiteScope, or a user grantedEdit user preferences permissions
can create or make changes to user settings and permissions for the current user or for other
users. By default, a regular user does not haveEdit user preferences permissions, which
means that they can view only their own user properties.

Relevant
tasks

"How to enable SiteScope to use LDAP authentication" on page 660

See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

Using SiteScope
Chapter 57: User Management Preferences

HPE SiteScope (11.33) Page 646 of 1206



Main Settings
User interface elements are described below:

UI
Element Description

Displayed
user role
name

Title for the use role profile. The title is displayed in the list of users.

User role
context

Security group for this user when using LDAP authentication to access the SiteScope
service. The user role context is the profile used by SiteScope to search inside of LDAP.

Example: uid=testuser,ou=TEST,o=this-company.com

Login
disabled

Disables access to SiteScope with this user name and password. Clear the check box to
enable access using the user role profile.

Allowed
groups

Displays the list of groups that can be accessed by this user role profile. Click theNew
button to open the Select User's AllowedGroups dialog box, and select groups. For user
interface details, see "Select User's AllowedGroups Dialog Box" on the next page.

To remove user access to a group, select the group and click theDelete button. It is not
possible to delete all groups in the list.

Default value: The SiteScope node is selected to enable access to all groups. To restrict
user access to fewer groups, clear the check box for the SiteScope node and then select the
individual groups below the SiteScope node to which you want to enable access.

Note: This field is not visible for an Administrator's settings.

Allowed
template
containers

Displays the list of template containers that can be accessed by this user profile. Click the

New button to open the Select User's Allowed Template Containers dialog box, and
select template containers. For user interface details, see "Select User's Allowed Template
Containers Dialog Box" on page 649.

To remove user access to a template container, select the template container and click the
Delete button. It is not possible to delete all template containers in the list.

Default value: The SiteScope node is selected to enable access to all template containers.
To restrict user access to fewer template containers, clear the check box for the SiteScope
node and then select the individual template containers below the SiteScope node to which
you want to enable access.

Note: This field is not visible for an Administrator's settings.

Permissions
Enables you to determine user role permissions. To grant a permission, select the check box to the left of the
permission or permission group.

For example, to create a Super User Role, select theAdd, edit or delete user preferences permissions.
Users of this type can create, edit, or delete other users, except the administrator. They can also edit, but not

Using SiteScope
Chapter 57: User Management Preferences

HPE SiteScope (11.33) Page 647 of 1206



delete, their own user role. Both an administrator and a power user can create a super user role. Theremay
exist any number of super user roles.

For the list and explanation of each permission, see "New/Edit User Profile Dialog Box" on page 633.

Save SiteScope LDAP Users in CSV File Dialog Box
This dialog box enables a SiteScope administrator to save the list of all LDAP users that have permissions to
log on to SiteScope to a CSV file.

To access Select Preferences > User Management Preferences. In the User Management
Preferences toolbar, select Default Settings > Save allowed LDAP users to CSV.

Important
information

Only an administrator in SiteScope, or a user grantedAdd, edit or delete user preferences
permissions can create or make changes to LDAP user management settings and
permissions. By default, a regular user does not haveAdd, edit or delete user
preferences permissions, whichmeans that they can view only their own user properties.

Relevant
tasks

"How to enable SiteScope to use LDAP authentication" on page 660

See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

User interface elements are described below:

UI
Element Description

CSV file Name of the CSV file to which to save LDAP users that can log on to SiteScope. This file
contain three columns: user role name, LDAP group (role context), and user identical attribute
(login).

Select Click the button and select an existing CSV file, or enter the name of a new file to which to save
the list of LDAP users.

Select User's Allowed Groups Dialog Box
This dialog box enables you to select the groups, subgroups, or both, that the user can access. Select the box
next to individual groups or subgroups to enable access to that group. By default, access is allowed to all
groups. To restrict user access to fewer groups, clear the check box for the SiteScope node and then select
the individual groups below the SiteScope node to which you want to enable access.

To access Select Preferences > User Management Preferences. In the User Management
Preferences page, click theNew User. In theMain Settings panel, click theNew button
next to theAllowed groups box.
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Important
information

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete user
preferences permissions can create or make changes to user settings and permissions
for the current user or for other users. By default, a regular user does not haveAdd, edit
or delete user preferences permissions, whichmeans that they can view only their
own user properties.

l When selected, each of a group's subgroups are also added to the list of allowed groups.

Relevant
tasks

"How to enable SiteScope to use LDAP authentication" on page 660

See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

User interface elements are described below:

UI
Element Description

Represents an individual SiteScope server.

Default value: The current container and all child elements are selected.

Represents a SiteScopemonitor group or subgroup (with enabledmonitors/with nomonitors or
no enabledmonitors).

If an alert has been set up for themonitor group or subgroup, the alert symbol is displayed next
to the group icon.

If a Management report has been set up for themonitor group or subgroup, the report symbol is
displayed next to the group icon.

Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScopemonitors.

Select User's Allowed Template Containers Dialog
Box
This dialog box enables you to select the template containers that the user can access. Select the box next to
individual template container or sub-container to enable access to that container. By default, access is
allowed to all template containers. To restrict user access to fewer template containers, clear the check box
for the SiteScope node and then select the individual template containers below the SiteScope node to which
you want to enable access.

To access Select Preferences > User Management Preferences. In the User Management
Preferences page, click theNew User. In theMain Settings panel, click theNew button
next to theAllowed template containers box.
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Important
information

l Only an administrator in SiteScope, or a user grantedAdd, edit or delete user
preferences permissions can create or make changes to user settings and permissions
for the current user or for other users. By default, a regular user does not haveAdd, edit
or delete user preferences permissions, whichmeans that they can view only their
own user properties.

l When a template container is selected, all of its sub-containers are also added to the list
of allowed template containers.

Relevant
tasks

"How to enable SiteScope to use LDAP authentication" on page 660

See also l "User Management Preferences" on page 625
l "User Management Preferences Page" on page 628

User interface elements are described below:

UI Element Description

Represents an individual SiteScope server.

Default value: The current container and all child elements are selected.

Represents a SiteScope template container or sub-container.
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Chapter 58: Internationalization in SiteScope
You can use SiteScope in an Internationalization (I18N) Environment.

Learn About
Multi-Lingual User (MLU) Interface Support
The SiteScope user interface can be viewed in the following languages in yourWeb browser:

Language Language Preference in Web Browser

Brazilian Portuguese Portuguese (Brazil) [pt-BR]

Dutch Dutch [nl]

English English

French French [fr]

German German [de]

Italian Italian [it]

Korean Korean [ko]

Japanese Japanese [ja]

Russian Russian [ru]

Simplified Chinese Chinese (China) [zh-cn]

Spanish Spanish [es]

Use the language preference option in your browser to select how to view SiteScope. The language
preference chosen affects only the user's local machine and not the SiteScopemachine or any other user
accessing the same SiteScope. For details on setting the user interface viewing language, see "How to View
SiteScope User Interface in a Specific Language" on page 653.

Note: The language is determined when you log on to SiteScope. Changing the language preference in
your browser after you have logged in has no effect until you log out and log back in.

Monitors Supported for Internationalization
The followingmonitors are supported for internationalization. Monitors that have been certified are indicated
by an asterisk (*).

Monitors Supported for Windows Operating Systems
l *CPU Monitor
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l Database Counter Monitor
l *DatabaseQuery Monitor
l *Disk SpaceMonitor
l *DNS Monitor
l *e-Business TransactionMonitor
l *File Monitor
l *FTP Monitor
l Link Check TransactionMonitor
l *Log File Monitor
l *Memory Monitor
l Microsoft IIS Server Monitor
l Microsoft SQL Server Monitor
l Microsoft Windows Event LogMonitor
l Microsoft Windows Performance Counter Monitor
l Microsoft Windows Resources Monitor
l Oracle 9i Application Server Monitor
l *Oracle 10g Application Server Monitor
l *Oracle DatabaseMonitor
l *PingMonitor
l *Port Monitor
l *Script Monitor
l *ServiceMonitor
l SNMP Monitor
l SNMP TrapMonitor
l UDDI Monitor
l *URLMonitor
l URLContent Monitor
l URL List Monitor
l URLSequenceMonitor
l *VMware PerformanceMonitor
l WebScript Monitor

Monitors Supported for UNIX Operating Systems
l CPU Monitor
l DatabaseQuery Monitor
l Disk SpaceMonitor
l Log File Monitor
l Port Monitor
l Script Monitor
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l ServiceMonitor
l UNIX Resources Monitor
l URLMonitor
l URLContent Monitor
l URLSequenceMonitor

Tasks
How to Configure SiteScope for a Non-English Locale
This task describes the steps involved in configuring SiteScope for a non-English locale.

1. Change the locale version setting
In themonitor tree, select Preferences > General Preferences > General Settings. Select
International version, and click Save. Restart SiteScope. This enables SiteScope to work with multiple
character sets.
For user interface details, seeGeneral Settings in the "General Preferences" on page 500.

2. Set new locale time and data settings
You can set a new locale time and data settings for SiteScope.
a. Open <SiteScope root directory>\groups\master.config in a text editor.
b. Find the entry _localeCountry=, and assign it an uppercase 2-character ISO-3166 country code.

For example: _localeCountry=US. A list of country codes is available frommany publicly available
web sites.

c. Find the entry _localeLanguage=, and assign it a lowercase 2-character ISO-639 language code.
For example: _localeLanguage=en. A list of language codes is available frommany publicly
available web sites.

d. Save the file and restart SiteScope.
3. View SiteScope user interface in a specific language

Select a language preference for viewing the SiteScope user interface.
For details on how to perform this task, see "How to View SiteScope User Interface in a Specific
Language" below.

4. Results
SiteScope is configured to work with multiple foreign character sets, the time and data settings are
displayed in a locale-specific format, and the user interface is displayed in a foreign language.

How to View SiteScope User Interface in a Specific Language
This task describes how to select a language preference for viewing the SiteScope user interface.

Note: For a list of supported languages, see "Multi-Lingual User (MLU) Interface Support" on page 651.

1. Install the required language's fonts on your local machine if they have not yet been installed. If you
choose a language in yourWeb browser whose fonts have not been installed, the SiteScope user
interface uses the default language of your local machine.
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For example, the default language on your local machine is English and theWeb browser is configured to
use Japanese. If Japanese fonts are not installed on the local machine, the SiteScope user interface is
displayed in English.

2. If you use Internet Explorer, configure theWeb browser on your local machine as follows:
a. Select the language in which you want to view the SiteScope user interface. For details, see

http://support.microsoft.com/kb/306872/en-us.
b. Proceed to step 4.

3. If you use FireFox, configure theWeb browser on your local machine as follows:
a. Select Tools > Options > Advanced. Click Edit Languages. The Language dialog box opens.
b. Select the language in which you want to view SiteScope.

If the language you want is not listed in the dialog box, expand theSelect language to add... list,
select the language, and click Add.

c. Click Move Up to move the selected language to the first row.
d. Click OK to save the settings and to close the Language dialog box.

4. Click Logout at the top of the SiteScope window. SiteScope refreshes and the user interface is
displayed in the selected language.

Tips/Troubleshooting
This section contains troubleshooting and limitations for the following issues relating to working with
SiteScope in an internationalization environment.

l "General Limitations" below
l "Multi-Lingual User Interface Issues" on the next page
l "Database Environment Issues" on the next page
l "Remote UNIX Servers Not Configured For an English Locale" on the next page

General Limitations
l User name, password, and URLs must be in English characters.
l Themachine on which SiteScope is installed (SiteScopemachine) and themonitoredmachinemust have
the same locale. English is the default locale.

l The SiteScopemachine can have a non-English locale in addition to English. For example, themonitored
machine supports the German locale while the SiteScopemachine supports German and English. For
details on setting a non-English locale, see "How to Configure SiteScope for a Non-English Locale" on the
previous page.

l When deploying theWeb Script Monitor, script names and transaction names must also be in English
characters.

l Script monitor on Red Hat ES4 does not support parameters in any language other than English.
l SiteScope always uses "en_US" locale for parsing dates retrieved from remote UNIX machines (for
example, during a File monitor run). If the UNIX machine's default locale is different from en_US, in the
definition of the UNIX remote for this machine, the Initialize Shell Environment field must contain
"LANG=C; export LANG".

l SiteScopeManagement reports do not support non-English labels.
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l If SiteScope is installed on a non-English operating system, you cannot use the SiteScope Hardening Tool
to configure SiteScope for using TLS. In that case, use themanual procedure described in the appendix
section of the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

Multi-Lingual User Interface Issues
l There is no language pack installation. All translated languages are integrated into SiteScopeMulti-lingual
User interface (MLU).

l Data stays in the language it was entered in, even if the language of theWeb browser changes. Changing
the language of theWeb browser on your local machine does not change the language of monitor
definitions and configurations.

l Names of entities included with the SiteScope installation, such as template examples, solution
templates, views, and health monitors, are in English only.

Database Environment Issues
l When you create a new Oracle instance in anOracle database, youmust specify the character set for the
instance. All character data, including data in the data dictionary, is stored in the instance's character set.

l The DatabaseQuery Monitor can connect to anOracle database but the Oracle user names and
passwords must contain only English characters.

Remote UNIX Servers Not Configured For an English Locale
l The File Monitor and Directory Monitor may fail when using UNIX remote servers that are not configured
by default for an English locale or language.Workaround:Add "LANG=C; export LANG" to the Initialize
Shell Environment property of the problematic UNIX remote server.

UNIX Resources Monitor Not Getting all Counters For a Non-English Locale
l Problem: The UNIX Resources monitor is unable to get counters for file systems or inode cache objects
whenmonitoring a UNIX remote server running on a Linux operating system with a non-english locale.

Resolution: Enter export LANG=en_EN.UTF-8 in the Initialize shell environment field for the
UNIX remote server.
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Chapter 59: Authentication Strategies
SiteScope authentication is based on a concept of authentication strategies. Each strategy handles
authentication against a specific authentication service. Only one authentication service can be configured
with SiteScope at any given time.

The default authentication strategy for logging on to SiteScope is the SiteScope internal authentication
service. In addition, SiteScope supports the following Single Sign-Onmethods: Lightweight Single Sign-On
(LW-SSO) and Lightweight Directory Access Protocol (LDAP).

Learn About
Authentication Strategies Overview
The SiteScope internal authentication service is the default authentication strategy for logging on to
SiteScope. You enter your SiteScope user name and password from the login page, and your credentials are
stored and verified by SiteScope.

SiteScope also supports Single Sign-On (SSO), amethod of access control that enables a user to log on once
and gain access to the resources of multiple software systems without being prompted to log on again. The
applications inside the configured group of software systems trust the authentication, and there is no need for
further authentication whenmoving from one application to another.

SiteScope supports the following SSO authentication strategies:

l Lightweight Single Sign-On (LW-SSO). This is the default single sign-on authentication strategy for
SiteScope. LW-SSO is embedded in SiteScope and does not require an external machine for
authentication. After installing SiteScope, you should immediately change the default passphrase string
for all HPE software applications integrated using LW-SSO. For details on changing the default SSO value
in SiteScope, see "How to change the LW-SSO string in SiteScope" on page 659.
For more details on LW-SSO, including limitations, security warnings, and general reference, see "LW-
SSOAuthentication" below.

l Lightweight Directory Access Protocol (LDAP). You can configure authentication using the
Lightweight Directory Access Protocol (LDAP). This enables you to use an external LDAP server to store
authentication information (user names and passwords). SiteScope uses the LDAP server to verify a
user's credentials. You enable and disable LDAP authentication from UserManagement Preferences. For
details, see "LDAP Authentication and Authorization" on page 659 .

LW-SSO Authentication
LW-SSO is amethod of access control that enables a user to log on once and gain access to the resources of
multiple software systems without being prompted to log on again. The applications inside the configured
group of software systems trust the authentication, and there is no need for further authentication when
moving from one application to another.

The information in this section applies to LW-SSO version 2.4.

LW-SSO Token Expiration

The LW-SSO Token's expiration value determines the application's session validity. Therefore, its expiration
value should be at least the same value as that of the application session expiration value.
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Recommended Configuration of the LW-SSO Token Expiration

Each application using LW-SSO should configure token expiration. The recommended value is 60minutes.
For an application that does not require a high level of security, it is possible to configure a value of 300
minutes.

GMT Time

All applications participating in an LW-SSO integrationmust use the sameGMT time with amaximum
difference of 15minutes.

Multi-domain Functionality

Multi-domain functionality requires that all applications participating in LW-SSO integration configure the
trustedHosts settings (or the protectedDomains settings), if they are required to integrate with applications in
different DNS domains. In addition, they must also add the correct domain in the lwsso element of the
configuration.

Get SecurityToken for URL Functionality

To receive information sent as aSecurityToken for URL from other applications, the host application should
configure the correct domain in the lwsso element of the configuration.

LW-SSO System Requirements
The following table lists LW-SSO configuration requirements:

Application Version Comments

Java 1.5 and higher

HTTP Sevlets API 2.1 and higher

Internet Explorer 6.0 and higher Browser should enable HTTP session cookie and HTTP 302
Redirect functionality

FireFox 2.0 and higher Browser should enable HTTP session cookie and HTTP 302
Redirect functionality

JBoss
Authentications

JBoss 4.0.3

JBoss 4.3.0

Tomcat
Authentications

Standalone
Tomcat 6.0.29

Acegi Authentications Acegi 0.9.0

Acegi 1.0.4

Spring Security
Authentication

Spring Security
2.0.4

Web Services
Engines

Axis 1 - 1.4

Axis 2 - 1.2

JAX-WS-RI 2.1.1
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LW-SSO Security Warnings
This section describes security warnings that are relevant to the LW-SSO configuration:

l Confidential InitString parameter in LW-SSO. LW-SSO uses Symmetric Encryption to validate and
create a LW-SSO token. The initString parameter within the configuration is used for initialization of the
secret key. An application creates a token, and each application using the same initString parameter
validates the token.

Caution:

l It is not possible to use LW-SSOwithout setting the initString parameter.

l The initString parameter is confidential information and should be treated as such in terms of
publishing, transporting, and persistency.

l The initString parameter should be shared only between applications integrating with each other
using LW-SSO.

l The initString parameter should have aminimum length of 12 characters.

l Enable LW-SSO only if required. LW-SSO should be disabled unless it is specifically required.
l Level of authentication security. The application that uses the weakest authentication framework and
issues a LW-SSO token that is trusted by other integrated applications determines the level of
authentication security for all the applications.
It is recommended that only applications using strong and secure authentication frameworks issue an LW-
SSO token.

l Symmetric encryption implications. LW-SSO uses symmetric cryptography for issuing and validating
LW-SSO tokens. Therefore, any application using LW-SSO can issue a token to be trusted by all other
applications sharing the same initString parameter. This potential risk is relevant when an application
sharing an initString either resides on, or is accessible from, an untrusted location.

l User mapping (Synchronization). The LW-SSO framework does not ensure user mapping between the
integrated applications. Therefore, the integrated applicationmust monitor user mapping. We recommend
that you share the same user registry (as LDAP/AD) among all integrated applications.
Failure tomap users may cause security breaches and negative application behavior. For example, the
same user namemay be assigned to different real users in the applications.
In addition, in cases where a user logs onto an application (AppA) and then accesses a second application
(AppB) that uses container or application authentication, the failure tomap the user will force the user to
manually log on to AppB and enter a user name. If the user enters a different user name than was used to
log on to AppA, the following behavior can arise: If the user subsequently accesses a third application
(AppC) from AppA or AppB, then they will access it using the user names that were used to log on to AppA
or AppB respectively.

l Identity Manager. Used for authentication purposes, all unprotected resources in the Identity Manager
must be configured with the nonsecureURLs setting in the LW-SSO configuration file.

l LW-SSO Demo mode.
l The Demomode should be used for demonstrative purposes only.

l The Demomode should be used in unsecured networks only.
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l The Demomodemay not be used in production. Any combination of the Demomodewith the production
mode should not be used.

LDAP Authentication and Authorization
You can choose to configure authentication using the Lightweight Directory Access Protocol (LDAP). This
enables you to use an external LDAP server to store authentication information (user names and passwords).
SiteScope uses the LDAP server to verify a user's credentials.

Storing information on an LDAP server makes it easier to manage large numbers of users across many
SiteScopes. When using LDAP authentication, you can create user role profiles to makemanaging user
permissions more efficient. Instead of assigning access permissions to each user one at a time, you can
group users who are assigned the same permissions levels on the same resources to the same user role
profile. You can also provide detailed permissions to LDAP users similar to that of SiteScope user roles. For
details on user roles, see "User Management Preferences" on page 625.

In addition to creating and assigning user roles andmanaging users outside of SiteScope, a SiteScope
administrator can also save the list of all LDAP users that have permissions to log on to SiteScope to a CSV
file.

LDAP authentication is supported for nested security groups in an Active Directory environment.

For details on enabling LDAP authentication and creating user roles, see "How to enable SiteScope to use
LDAP authentication" on the next page.

Note:

l The audit log contains only the user name (Displayed Name), and not the user role or LDAP group
(User role context or LDAP context).

l When a user logs on using LDAP authentication, the user is created for one SiteScope session only.
When the session ends, the user is deleted (not saved in persistency).

Tip: You can view a guided and narrated demonstration for managing SiteScope users centrally in LDAP
on YouTube: http://www.youtube.com/watch?v=rntIjPOqdJs&feature=plcp.

Silent Authentication

You can also configure authentication via certificates that are stored in the browser or a smart card via client
certificate authentication. This is an automatic process that launches SiteScope without having to enter the
user login name and password in the SiteScope login page.

When you supply the certificate or enter a smart card, SiteScope takes the unique attributes from the
certificate/smart card and uses the LDAP server to verify a user's credentials. When it finds the user, it logs
on automatically using the LDAP user credentials.

For details, see "How to Configure Silent LoginWhen Using LDAP Authentication" on page 661.

Tasks
How to change the LW-SSO string in SiteScope
After installing SiteScope, you should immediately change the default passphrase string for all HPE software
applications integrated using LW-SSO.
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l In applications other than SiteScope, locate the lwssofmconf.xml file and change the value directly in
that file.

l In SiteScope, you can do this directly in the <SiteScope root directory>\conf\lwsso\lwssofmconf.xml
file (only before the first time the service is loaded). You can also change the value inPreferences >
General Preferences > LW SSO Settings > LW SSO Init String.

How to enable SiteScope to use LDAP authentication
This task describes the steps involved in using LDAP authentication and authorization for logging on to
SiteScope. For concept details, see "LDAP Authentication and Authorization" on the previous page.

Tip: You can view a guided and narrated demonstration for managing SiteScope users centrally in LDAP
on YouTube: http://www.youtube.com/watch?v=rntIjPOqdJs&feature=plcp.

1. Prerequisites
l When using LDAP to access SiteScope, users must have a user login and security principal assigned
to them on the LDAP server. For details, contact your LDAP server administrator.

l Youmust be an administrator in SiteScope, or a user grantedAdd, edit or delete user preferences
permissions to be able create or make changes to SiteScope LDAP user management settings and
permissions. A regular user does not haveAdd, edit or delete user preferences permissions by
default. For user interface details, see "New/Edit User Profile Dialog Box" on page 633.

l To use LDAP when using an SSL connection, you need to import a certificate from the LDAP server.
(Obtain a digital certificate issued by a Certificate Authority. If your organization does not currently
have a digital certificate for this purpose, you need tomake a request to a Certificate Authority to
issue you a certificate.)

2. Enable SiteScope to use LDAP authentication
a. In SiteScope, select Preferences > User Management Preferences, click the arrow next to

Default Settings, and select Edit. The User Management Settings dialog box opens, displaying the
LDAP UserManagement settings. For user interface details, see "User Management Settings
Dialog Box" on page 631.

Note:When using an SSL connection, youmust enter the secure LDAP server URL in the
LDAP server URL box. For example, ldaps://ldap.mydomain.com:636

b. Select theEnable LDAP Authentication check box, and configure the LDAP Authentication
settings.

Tip:We recommend that you contact your LDAP server administrator for assistance when
configuring these settings.

c. To test the LDAP connection, click the arrow next toDefault Settings, and select Test. The test
status is returned (if the test is successful, the number of LDAP users is displayed).

Note: All users in an LDAP context will get the same permissions as that of a specified
SiteScope user role if Enable same permissions for all LDAP users is selected in the User
Management Settings dialog box.

3. Create an LDAP user role profile
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In the User Management Preferences page, click the arrow next to theNew User button, and
select New User Role. Enter the user role name, the LDAP security group (context), select the groups
that can be accessed by this user role profile, and select the permissions granted to this user role.
For user interface details, see "New/Edit User Role Profile Dialog Box" on page 646.

4. Copy an existing user's permissions to a user role - optional
You can copy an existing SiteScope user's permissions to a new user role. This enables you to assign
the same permissions as the user role when creating or editing a user profile.
a. In the User Management Preferences page, select a user from which you want to copy permissions

to a user role and select Copy > Copy to User Role.
b. In the New User Role Profile dialog box, enter a name and context for the new user role and save it.

For user interface details, see "New/Edit User Role Profile Dialog Box" on page 646.
c. The permissions of the selected user are copied to the user role, which is added to the User

Management Preferences page as aRegular User Role orSuper User Role type (depending on
the permissions granted). For user interface details, see "User Management Preferences Page" on
page 628.

5. Log off of SiteScope
Click the Logout button to log out of SiteScope.

6. Log on to SiteScope
When using LDAP to access SiteScope, users can access SiteScope in the usual ways. For details, see
"Log into SiteScope" on page 16.

Note: SiteScope users still need to have a SiteScope login name and password defined, which they
must enter in the SiteScope Login page. (LDAP users have their own LDAP user name and
password for logging on to SiteScope.)

7. Results
After a user enters their login name and password in the SiteScope Login page (or uses silent login),
SiteScope sends a request to LDAP.
If the request returns confirmation of the user and the user's groups match the user role definition, the
relevant user role permissions are ascribed to the user, and SiteScope opens to the Dashboard view.

How to Configure Silent Login When Using LDAP Authentication
This task describes the steps involved in configuring silent login to SiteScope via client certificate
authentication.

1. Obtain Client Certificate
Obtain a digital certificate issued by a Certificate Authority. If your organization does not currently have a
digital certificate for this purpose, you need tomake a request to a Certificate Authority to issue you a
certificate.

2. Configure the server certificate properties
Enable silent login by making changes to the configuration files used by the Tomcat server.
a. Open the server.xml file that is located in the <SiteScope root directory>\Tomcat\conf directory.
b. Locate the section of the configuration file that looks like the following:

<!-- Define a SSL HTTP/1.1 Connector on port 8443 -->
<!--
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<Connector port="8443"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS" />
-->

c. Change this section to the following, and enter the required parameters:

<!-- Define a SSL HTTP/1.1 Connector on port 8443 -->
<Connector port="8443"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
sslProtocol="TLS"
keystoreFile="<Keystore_file_path>"
keystorePass="<Keystore_password>" keystoreType="<Keystore_type>"
keyAlias="<Keystore_alias>"
truststoreFile="<truststore_File>" truststorePass="<truststore_password>"

truststoreType="<truststore_type>"
clientAuth="true" />

/>

For example:

<!-- Define a SSL HTTP/1.1 Connector on port 8443 -->
<Connector port="8443"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
sslProtocol="TLS"
keystoreFile="c:\myclientstore.p12"
keystorePass="testing" keystoreType="PKCS12" keyAlias="client"
truststoreFile="..\java\lib\security\cacerts"
truststorePass="changeit" truststoreType="JKS" clientAuth="true" />

/>

Note: If there are other HP products installed on the same server as SiteScope, youmight need
to change port 8443 to another port to avoid conflict.

Tomcat log output is written to the <SiteScope root dir>\logs\
tomcat.log file. Settings for the log file can be configured from the
<SiteScope root dir>\Tomcat\common\classes\log4j.properties file.

d. After setting up SSL access on port 8443, restrict unsecured access to SiteScope by commenting
out theDefine a non-SSL HTTP/1.1 Connector on port 8080 section.

3. Import server certificate to SiteScope
Use Certificate Management to import the Certificate Authority certificate. Select Preferences >
Certificate Management, and click the Import Certificates button. Select File orHost, and enter the
details of the source server.
For user interface details, see "Certificate Management Page" on page 462.
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Note: Only a SiteScope administrator user, or a user withView/Edit certificates list permissions
can view, add, or make changes to the certificates keystore on the Certificate Management page.

4. Configure the LDAP user management settings
a. Configure the settings in the LDAP UserManagement Settings panel. For user interface details, see

"User Management Settings Dialog Box" on page 631.
b. In the LDAP User Management Advanced Settings panel, you can enter a unique attribute for the

LDAP user in the LDAP activation key identification attribute box (or you can leave it blank, in
which case, the userPrincipalName attribute is used).

5. Results
When a user attempts to log on to SiteScope using silent login, SiteScope sends a request to LDAP. If
the request returns confirmation of the user and the user's groups match the user role definition, the
relevant user role permissions are ascribed to the user, and SiteScope opens to the Dashboard view.
The user name displayed in SiteScope is taken from the user's personal name on the user certificate.

Note:

l The user is created for one SiteScope session only. When the session ends, the user is deleted
(not saved in persistency).

l When you log off of SiteScope (by clicking the Logout button), the silent login parameter (sis_
silent_login_type_default) is displayed in the URL. Youmust remove this parameter before
you can log back on to SiteScope using the refresh action.

Tips/Troubleshooting
This section contains the troubleshooting and limitations for LW-SSO authentication.

l "LW-SSOKnown Issues" below
l "LW-SSO Limitations" on the next page
l "Authentication Strategies" on page 656

LW-SSO Known Issues
This section describes known issues for LW-SSO authentication.

l Security context. The LW-SSO security context supports only one attribute value per attribute name.
Therefore, when the SAML2 token sends more than one value for the same attribute name, only one value
is accepted by the LW-SSO framework.
Similarly, if the IdM token is configured to sendmore than one value for the same attribute name, only one
value is accepted by the LW-SSO framework.

l Multi-domain logout functionality when using Internet Explorer 7. Multi-domain logout functionality
may fail under the following conditions:
The browser used is Internet Explorer 7 and the application is invokingmore than three consecutive HTTP
302 redirect verbs in the logout procedure.
In this case, Internet Explorer 7may mishandle the HTTP 302 redirect response and display an Internet
Explorer cannot display the webpage error page instead.
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As a workaround, it is recommended to reduce, if possible, the number of application redirect commands
in the logout sequence.

LW-SSO Limitations
Note the following limitations when working with LW-SSO authentication:

l Client access to the application.
If a domain is defined in the LW-SSO configuration:

l The application clients must access the application with a Fully Qualified Domain Name (FQDN) in the
login URL, for example, http://myserver.companydomain.com/WebApp.

l LW-SSO cannot support URLs with an IP address, for example, http://192.168.12.13/WebApp.

l LW-SSO cannot support URLs without a domain, for example, http://myserver/WebApp.

If a domain is not defined in the LW-SSO configuration: The client can access the application without
a FQDN in the login URL. In this case a LW-SSO session cookie is created specifically for a single machine
without any domain information. Therefore, the cookie is not delegated by the browser to another, and does
not pass to other computers located in the sameDNS domain. This means that LW-SSO does not work in
the same domain.

l LW-SSO framework integration. Applications can leverage and use LW-SSO capabilities only if
integrated within the LW-SSO framework in advance.

l Multi-Domain Support.
l Multi-domain functionality is based on the HTTP referrer. Therefore, LW-SSO supports links from one
application to another and does not support typing a URL into a browser window, except when both
applications are in the same domain.

l The first cross domain link usingHTTP POST is not supported.
Multi domain functionality does not support the first HTTP POST request to a second application (only
theHTTP GET request is supported). For example, if your application has an HTTP link to a second
application, anHTTP GET request is supported, but anHTTP FORM request is not supported. All
requests after the first can be eitherHTTP POST orHTTP GET.

l LW-SSO Token size:
The size of information that LW-SSO can transfer from one application in one domain to another
application in another domain is limited to 15Groups/Roles/Attributes (note that each itemmay be an
average of 15 characters long).

l Linking from Protected (HTTPS) to non-protected (HTTP) in amulti-domain scenario:
Multi domain functionality does not work when linking from a protected (HTTPS) to a non-protected
(HTTP) page. This is a browser limitation where the referer header is not sent when linking from a
protected to a non-protected resource.

l Third-Party cookie behavior in Internet Explorer:
Microsoft Internet Explorer 6 contains amodule that supports the "Platform for Privacy Preferences
(P3P) Project," meaning that cookies coming from a third-party domain are by default blocked in the
Internet security zone. Session cookies are also considered third-party cookies by IE, and therefore are
blocked, causing LW-SSO to stop working.
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To solve this issue, add the launched application (or a DNS domain subset as *.mydomain.com) to the
Intranet/Trusted zone on your computer (in Microsoft Internet Explorer, selectMenu > Tools > Internet
Options > Security > Local Intranet > Sites > Advanced), which causes the cookies to be accepted.

Caution: The LW-SSO session cookie is only one of the cookies used by the third-party application
that is blocked.

l SAML2 token.
l Logout functionality is not supported when the SAML2 token is used.
Therefore, if the SAML2 token is used to access a second application, a user who logs out of the first
application is not logged out of the second application.

l The SAML2 token's expiration is not reflected in the application's sessionmanagement.
Therefore, if the SAML2 token is used to access a second application, each application's session
management is handled independently.

l JAAS Realm. The JAAS Realm in Tomcat is not supported.
l Using spaces in Tomcat directories. Using spaces in Tomcat directories is not supported.
It is not possible to use LW-SSOwhen a Tomcat installation path (folders) includes spaces (for example,
Program Files) and the LW-SSO configuration file is located in the common\classes Tomcat folder.

l Load balancer configuration. A load balancer deployed with LW-SSOmust be configured to use sticky
sessions.

l Demo mode. In Demomode, LW-SSO supports links from one application to another but does not
support typing a URL into a browser window, due to an HTTP referrer header absence in this case.
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Part 8: User-Defined Content
SiteScope supports the ability to create and publish reusable templates and content packages, enabling you
to rapidly set up and deploy multiple IT elements with similar monitoring configuration criteria.

Templates are used to standardize a set of monitor types and configurations into a single structure. This
structure can then be repeatedly deployed as a group of monitors targetingmultiple elements of themonitored
environments that share similar characteristics. For details, see "Create Templates" on page 667.

Content packages are used for sharing user-defined templates that contain Custommonitors or regular
monitors that reference a script or alert template file. You create content packages using the Export Content
PackageWizard. A content package can include one or more templates and their dependencies.
Dependencies are additional files such as jars and configuration files that are required for running themonitor.
For details, see "Create Content Packages" on page 703.

You can export and import templates and content packages for use in other SiteScope installations. This
enables you to replicate standardizedmonitor configurations across the enterprise. For details, see "Export
and Import Templates and Content Packages" on page 704.

You can also share templates and content packages with other SiteScope users by publishing them to the
HPE Live Network. For details, see "Share SiteScope Content on the HPE Live Network" on page 758.

After creating a SiteScopemonitoring template, you can deploy the templates to a group. For details, see
"Deploy Templates" on page 721. SiteScope also enables you to automatically deploy a SiteScope template
(or solution template) using an XML file external to the SiteScope user interface. For details, see "Deploy
Templates Automatically Using an XML File" on page 732.

After deploying a template, you canmake changes to the template and automatically publish those changes
to all SiteScope objects deployed by the template using the Publish Template Changes Wizard. For details,
see "Publish Changes to Templates" on page 745.

For troubleshooting and limitations when working with user-defined templates, see "Tips/Troubleshooting" on
page 668.

https://hpln.hpe.com/group/sitescope


Chapter 60: Create Templates
SiteScope templates provide an enterprise solution for standardizing themonitoring of the different IT
elements in your enterprise into a single reusable structure. You use templates to rapidly deploy sets of
monitors that check systems in the infrastructure that share similar characteristics.

This section includes information on user-defined templates. For information on SiteScope's predefined
solution templates that feature built-in domain expertise, see "Solution Templates" on page 761.

Note: SiteScope also contains Monitor Deployment Wizard templates that can be used when SiteScope
is connected to BSM. For details, see theMonitor Deployment Wizard section in the APM Application
Administration Guide in the APMHelp.

Learn About
Creating Templates Overview
Templates are objects you use to reproduce groups, monitors, servers, and alerts according to a predefined
pattern and configuration (see "Template Objects" on page 671). You can also use variables within templates
as substitutionmarkers for configuration settings that you want to change dynamically or interactively each
time you deploy the template (see "Template Variables" on page 673).

You can create templates using one of the followingmethods:

l Copy an existing group andmonitor hierarchy from a SiteScope to a template and edit the elements for use
as a template. For details, see "How to Create a Template by Copying Existing Configurations" on
page 682.

l Manually create template groups, monitors, servers, and alerts in the template. For details, see "How to
Create aMonitoring Structure Using a Template" on page 677.

After you create and configure a template, the template objects are displayed in the template tree. From there,
you can deploy all of the items defined in the template in a single operation by copying the template to a
location in the SiteScope hierarchy. For details on deploying templates, see "Deploy the template" on
page 681.

You can alsomake changes to the source template, and automatically publish the changes to SiteScope
objects deployed by the template using the Publish Template Changes Wizard. For details on updating
templates, see "Publish Changes to Templates" on page 745.

You can export and import templates and content packages for use in other SiteScope installations (content
packages consist of templates and their dependency files that are required for sharing Custommonitors with
other SiteScope users). This enables you to share content and replicate standardizedmonitor configurations
across the enterprise. For details, see "Export and Import Templates and Content Packages" on page 704.

Tip:

l Effective development and use of templates requires some planning because you can addmultiple
objects types to the template. For more information, see "Planning Templates" on page 672.

l If SiteScopemonitoring has not yet been configured and you are not familiar working with SiteScope
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monitors and groups, set up some sample groups, monitors, and alerts before you create templates.
This helps familiarize you with themonitor configurations and the relationship betweenmonitors,
groups, and alerts. Afterward, you can copy the structure from the SiteScope and convert the
configurations to a template.

l To help you get started with templates, SiteScope provides example templates for monitoring in
Windows and UNIX environments. For details, see "Template Examples" on page 672.

l When creating a template which includes monitors that use aGet Counters/Measurements browser
function tomonitor measurements specific to the target system, additional steps are required for
selecting counters when deploying templates. For details, see "Select BrowsableMonitor Counters in
Monitor Templates" on page 683.

Advantages of Using Templates
l Templates can be repeatedly deployed as a group of monitors targetingmultiple elements of themonitored
environments.

l Templates speed the deployment of monitors across the enterprise through the single-operation
deployment of groups, monitors, alerts, remote servers, and configuration settings.

l Templates provide the ability to view how the actual monitored deployments comply with the standardized
deployment as defined in the template. This ensures that any changes in themonitored environment can
be quickly updated in themonitoring infrastructure and that themonitoring infrastructure is still compliant
with the standards set in the template.

l Templates can be silently deployed in the background without having to wait for the template deployment
process to finish. If SiteScope restarts before all requests in the queue are complete, it automatically
continues the deployment process after the restart.

Benefits of user-defined templates:

l You can create and customize your own templates tomeet the requirements of your organization.
l You canmake changes to a template, and publish the changes to all SiteScope objects deployed by the
template. If a change is required to a template object, you can update the template once and publish the
changes to all deployed groups. For details, see "Publish Changes to Templates" on page 745.

l You can deploy multiple templates simultaneously from the SiteScope user interface or from an external
CSV file. For details, see "Deploy Templates" on page 721. You can also deploy templates automatically
using an XML file external to the SiteScope user interface. For details, see "Deploy Templates
Automatically Using an XML File" on page 732.

l You can share your templates with other SiteScope users by publishing them to the HPE Live Network.
For details, see "Share SiteScope Content on the HPE Live Network" on page 758.

l You can use SiteScope APIs to create, deploy, andmanage templates. For details, see "SOAP-based
APIs" on page 139.

Tips/Troubleshooting
This section describes tips, troubleshooting and limitations when working with user-defined templates.

l "User-Defined Templates Tips/Troubleshooting" on the next page
l "Templates and Template Containers:" on the next page
l "TemplateMonitors andGroups:" on the next page
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l "Template Remotes:" below
l "Template Variables:" on the next page
l "Template Alerts:" on the next page
l "Deleting Templates:" on the next page
l "Reserved Template Group Types" on the next page

User-Defined Templates Tips/Troubleshooting
Templates and Template Containers:

l Template containers can be added only to the SiteScope node in the template tree.
l A user can only access the template containers for which they have permissions in theAllowed template
containers list (inPreferences > User Management Preferences > <selected_user> > Main
Settings).

l A template can have only one template group directly under it (the parent group).
Template Monitors and Groups:

l Some fields that contain drop-down lists when configuring objects in normal mode, are displayed as text
boxes when configuring the object in templatemode.

l By default, monitors must be created in a template group. You can override this setting inPreferences >
Infrastructure Preferences > Template Settings by selectingAllow creation of template monitors
directly under a template entity.

l You can also define a template subgroup so that its content is not a part of the template, and is ignored,
when publishing changes to deployed groups. This enables deploying templates inside different deployed
groups. For details, see Ignore group when publishing changes in General Settings.

l Templatemonitors are not activemonitor instances. Monitors are created and activated based on these
template configurations only when you deploy the template.

l Do not use "\\" in themonitorServer field, and in the remote serverName andServer fields.
l When using regular expressions to select metrics counters or match thresholds, SiteScope checks only
whether one string is a substring of another, rather than performing an equality check. This means that the
incorrect set of metrics and thresholds could be defined in themonitor after deployment. This is because
SiteScope, by default, treats every metric in themetrics table as a regular expression, andmatches the
threshold setting with all metrics that fit this expression. For example, if the chosenmonitor threshold is
x/y, and x/yy alsomatches the regular expression, this threshold is also defined. To avoid this, add
specific regular expressions tomeet your exact requirements.

l When adding a Search/Filter tag to a templatemonitor, you cannot use both actual parameters and
variable parameters in the same tag values group.

l When deploying a Script monitor from a template, the case of the remote script namemust match that of
the script name in the scripts subdirectory. Otherwise, the selected script is shown as 'none'.

l The Network Bandwidthmonitor's non-default thresholds are not copied properly to a template.
Template Remotes:

l You can add only one remote server to a template.
l You cannot delete a server from the remote servers list if the server is referenced by a templatemonitor.
Select a different server in theServer box of theMonitor Settings panel for eachmonitor that references
the remote server, and then delete the remote server from the remote server list.

l You cannot replace an existingmonitor target server using the Publish Template Changes wizard or auto
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deployment update (see Publishing Template Changes Using the XML), although you can change property
values of the target server itself, if required.

l If a remote server is specified with a variable namewith no additional characters prefixed or suffixed to it
(for example, %%hostname%%), and the same variable is specified for any field in amonitor, after
deployment the value appears as Remote-## on UNIX and \\<variable_value> onWindows, instead of
just the variable value that was specified on deployment. To avoid this, where a variable name is used for
a remote server, additional characters should be prefixed or suffixed to the name.

l A templatemonitor can run on servers that are defined by template servers at the time of template
deployment or on servers definedmanually in the Remote Servers container of the remote server tree.
Whichever is the case, the value in theServer box must match the host name of an actual server at the
time that the template is deployed after values have been substituted for the template variables. If the
server name does not match the host name of a real server, themonitor fails. To automatically retrieve the
template remote server name (if one was created), select the Use already configured template remote
under current template check box in theMonitor Settings field. For user interface details, see "New
TemplateMonitor Dialog Box" on page 699.

l If the templatemonitor was configured with explicit counter selections that can bematched using the
regular expression that was entered, you can delete the extra counter strings by clicking theDelete
Counter button.

Template Variables:

l When configuring variables for Frequency andError frequency in theMonitor Run Settings, the variable
values can only be in time units of seconds.

l When amonitor is copied or moved from one template to another, any user-defined variables in themonitor
are also copied or moved.

l If you change the name of an assigned template variable, all monitors using that variable are automatically
updated to use the new variable name.

Template Alerts:

l You cannot select theDisable or Enable Monitors alert action when creating an alert template.
Template alerts are enabled for all themonitors belonging to the object for which they were defined. For
example, if an alert is defined for amonitor, then it is activated on that monitor only. If an alert is defined for
a template, then it is activated for all themonitors in the template.

Deleting Templates:

l To delete a template or template container after deploying templates, youmust first delete each group to
which the templates were deployed in themonitor tree, and then you can delete the template or template
container.

Reserved Template Group Types
The following table shows template types used by the SiteScope application. The templates in these
directories are reserved, and are not used by alerts. For a list of templates used in alerts, see "Alert Template
Directories" on page 1118.

Tip:Wedo not recommendmodifying the templates in these directories without following the specific
procedures provided in the product documentation or as instructed by HPE Software Support.
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Template Group Description Location

MIB Text used with SNMP traps <SiteScope root directory>\
templates.mib

Operating System Shell commands to be run whenmonitoring remote
UNIX servers

<SiteScope root directory>\
templates.os

Performance
Monitor

Used forWindows performancemonitoring <SiteScope root directory>\
templates.perfmon

Sound Audio files used for sound alerts <SiteScope root directory>\
templates.sound

View Query and XML/XSL templates <SiteScope root directory>\
templates.view

Template Objects
Templates are created and stored in a template container in the template tree. The template variable
definitions and SiteScope objects configurable using the template are displayed as objects within the
template.

The following table describes the objects used in templates:

Icon
Object
Type Description

Template
Container

A template container enables you tomanage your templatemonitoring solutions. You
can add a template to a template container only. For details on configuring this object,
see "New Template Container Dialog Box" on page 690.

Template The template contains the SiteScope group, monitors, remote servers, variable
definitions, and alerts that make up the templatemonitoring solution. For details on
configuring this object, see "New Template Dialog Box" on page 691.

Template
Variable

A variable is used to prompt for user input during template deployment. Template
variables are either user-defined or predefined system variables. For details on
configuring this object, see "New Variable Dialog Box" on page 692.

Template
Remote
Server

A template remote server is used to defineWindows or UNIX remote server preferences
that are created when the template is deployed. For details on configuring this object,
see "New Template Remote Server Dialog Box" on page 694.

Template
Group

A template group contains the templatemonitors and associated alerts. You use
template groups tomanage the deployment of monitors and associated alerts in your
infrastructure. For details on configuring this object, see "New Template Group Dialog
Box" on page 695.

Template
Monitor

Templatemonitors are used to definemonitors that are created when the template is
deployed. For details on configuring this object, see "New TemplateMonitor Dialog Box"
on page 699.
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Icon
Object
Type Description

Template
Alert

Template alerts are used to define alerts on groups andmonitors that are created when
the template is deployed. If an alert has been set up for the templatemonitor or group,
the alert symbol is displayed next to themonitor or group icon. For details on configuring
this object, see "New Alert Dialog Box" on page 701.

Template Examples
SiteScope provides template examples for monitoring inWindows and UNIX environments. These templates
are available from the Template Examples folder in the template tree. You can use the template examples to
help familiarize you with using SiteScope templates. Among other things, you can use it to see the following:

l How template groups, monitors, and remote servers are used
l The connection between the template remote server and themonitor using it
l Variable value usage and system variable usage
The following example shows theWindows basic template. The template contains a template group,
Windows monitors for %%host%%, two templatemonitors (CPU andMemory), four user-defined variables
(host, user, password, and frequency), and a template remote server.

Planning Templates
Template planning is important for effective SiteScopemanagement. You should consider the group and
monitor relationships and properties in the template structure and how it fits into the overall monitoring
environment.

The following are things to consider as you plan templates:

Object Consideration

Variable
properties

Decide whichmonitor configuration properties vary from one template deployment to another.
For example, the target server address or resource to bemonitored is a common variable
property. Also consider what naming conventions you want to use for groups andmonitors.
You use template variables to enter or select values for variable properties each time you
deploy the template. Not all monitor configuration properties can be configured using
variables. For more information, see "Template Variables" on the next page.
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Object Consideration

Servers Decide which servers are the target servers. This is where the objects beingmonitored are
located. Template servers are replicated automatically when the template is deployed. You
can also define themmanually in theMicrosoft Windows Remote Servers or UNIX Remote
Servers container of the remote server tree. For more information, see "Remote Servers" on
page 401.

Monitor
types

Decide whichmonitor types you want to replicate using templates. These should bemonitor
types that monitor multiple systems. For example, CPU, Disk, Memory and Servicemonitor
types are commonly deployed for each server in the infrastructure. You can also include
multiple instances of the ServiceMonitor type in a template tomonitor different services or
processes running on each server.

Common
properties

For configuration properties that should be the same from one template deployment to
another, youmust decide what the values should be. For example, the Frequency setting is a
required setting for eachmonitor type. The default setting is 10minutes. Depending on what is
to bemonitored and the overall monitor load, youmay want to change this value so that
monitors created using the template runmore often.

Group
structure

Decide the group structure you want to use to organize themonitors. The organization groups
andmonitors in the template should be compatible with your overall plan for organizing the
monitoring in your environment. The group structure you usemay affect reporting, alerting,
andmonitoring.

Alerts Decide if you want to deploy alerts as part of the template. Consider which alert types and
actions you want to associate with the templates andmonitors. Alerts deployed as part of a
template have theirAlert Targets property set to all monitors defined in the template (see
"SiteScope Alerts Page" on page 1091). For example, a template alert added to a template
group alerts on any monitor belonging to that group. If this does not fit your alerting plan, you
must edit the alert configuration after deployment or add alerts manually.

Template Variables
While you can create templates without using template variables, the use of variables is central to the power
and utility of templates. Template variables are substitutionmarkers for monitor configuration settings. You
create template variables to represent monitor configuration settings that you want to be able tomodify
whenever you deploy the template. You reference the variable in a text box in one or more templatemonitors.
Each variable that is referenced in amonitor or group object in a template prompts the display of a
corresponding entry box when the template is deployed. The variable name is used as a label for the text entry
box.

Examples of common uses for template variables are:

l Server or host addresses
l Disk drive designators
l File paths
l Monitor name descriptions

Note: You can see examples of variables used in templates in the Template Examples folder in the
template tree. For details, see "Template Examples" on the previous page.
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Learn About
This section contains the following topics:

l "Guidelines for Using Template Variables" below
l "Variable Syntax" below
l "Referencing Template Variables" on the next page

Guidelines for Using Template Variables
l Plan and create the template variables before you create other template objects, such as servers and
monitors. This enables you to enter the references to the variables into the templatemonitors, groups, or
alerts as you add them to the template. Deleting a template variable that has already been referenced in a
template object requires that the referencing object be deleted from the template to clear the broken
reference. For details on referencing template variables, see "Referencing Template Variables" on the next
page.

l Somemonitor configuration settings cannot be set using template variables. With the exception of the
remote server selectionmenu, configuration items that are normally selected using a selection drop-down
cannot be defined using template variables. Configuration items that are normally selected using a check
box or radio selection cannot be configured using template variables.

l Template variables are always child elements of the template container in which they reside. Variables
can be referenced and used to define configuration settings for group, monitor, or alert configuration
templates within the template. For information about the types of template variables in SiteScope and the
specific syntax conventions, see "Variable Syntax" below.

Variable Syntax
The following types of template variables are available in SiteScope:

l User-defined variables. They are used to enter text-based values during template deployment. User-
defined variables must have the "%%" symbol either side of the variable name.

l System variables. A set of predefined variables you use to access both the list of remote servers known
to SiteScope and system time information. System variables must have the "$$" symbol either side of the
variable name.

Note: User-defined and pre-defined system variables are available in all text fields and text table cells
when configuring templates. To display the list of available variables, type either%% or $$ in the field,
and select the relevant variable. The variable is then displayed in the field.

Each type of variable has specific syntax conventions which are described in the following sections:

Syntax for User-Defined Variables
User-defined template variables can contain only alphanumeric characters and the underscore character. You
can create as many variables as you need.

Examples of valid template variable syntax:

description_text
DiskDrive
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TARGET_URL
matchExpression

Choose variable names that describe the configuration parameter that is represented. The variable name is
used as a label for the variable entry box on the variable value entry window when you deploy the template.

Syntax for System Variables
SiteScope recognizes several pre-defined template variables. These are values that are known by the
system, including the list of servers for SiteScope, detected servers such as NetBIOS, and user-defined
server connection profiles such as remote UNIX. The syntax and description for the pre-defined system
variables are:

Syntax for
System
Variables Description

$$SERVER_
LIST$$

Returns a list from which to select one of all the servers known by the platform. Use this to
enable selection of remote servers forServer orHost Name properties only.

Note:When this variable is used in a template, the template cannot be deployed using the
SiteScope API since it requires user interaction.

$$SERVER_
NAME$$

Derived from the $$SERVER_LIST$$ variable. Returns the name of the current server with \\
(backslashes) before the name. Use when referencing the server in other boxes.

$$SERVER_
NAME_
BARE$$

Derived from the $$SERVER_LIST$$ variable. Returns the name of the current server
without \\ (backslashes) before the name. Use when referencing the server in a box
requiring just the name of the server (for example, when deploying CPU monitors or when
referencing the name of the server in a description: "Disk space on server Mail.")

$$DATE$$ Returns the system date on the server where SiteScope is running. Use to add the date that
amonitor was created to a name or description.

$$TIME$$ Returns the system time on the server where SiteScope is running. Use to add the time that
amonitor was created to a name or description. The value represents the time that the
template is deployed.

Referencing Template Variables
After you have added template variables to a template, youmust create references to them in amonitor or
group configuration object. The syntax you use to reference a variable depends on the type of variable.
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Variable
Type Syntax Information

User-
Defined

%%variable_
name%%

The reference is case sensitive and syntax sensitive.

Note:User-defined template variables must be created before they can be
referenced inmonitor or group configuration templates. Using the %% symbols
with a text string that has not already been added to the template as a template
variable does not create a reference to a template variable even if a matching
variable name is added later.

System $$VARIABLE_
NAME$$

The reference is case sensitive and syntax sensitive.

The $$SERVER_LIST$$ variable must be defined explicitly as a variable in the
template. After this variable is defined, the $$SERVER_NAME$$ and $$SERVER_
NAME_BARE$$ variables may be used in configuration objects by referencing
them using the $$VARIABLE_NAME$$ syntax directly in themonitor or group
configuration object.

The $$TIME$$ and $$DATE$$ variables can also be referenced directly.

For information about system variables, see "Variable Syntax" on page 674.

Example:How to reference user-defined variables and the $$SERVER_LIST$$, and the derived system
variables for amonitor template

Using SiteScope
Chapter 60: Create Templates

HPE SiteScope (11.33) Page 676 of 1206



How to Create a Monitoring Structure Using a
Template
This task describes the steps for creating and publishing reusable templates, enabling you to deploy multiple
IT elements with similar monitoring configuration criteria. It also includes steps for publishing changes across
the entire enterprise to all SiteScope objects deployed by templates, without the need for extensivemanual
updates.

Flowchart of this task:

Tip:We recommend that you create template objects in the order listed. You can skip the steps for any
template objects that you do not require. To help you get started with templates, use the example
templates provided for monitoring inWindows and UNIX environments. For details, see "Template
Examples" on page 672.

1. Prerequisites
l To be able to add, edit, and delete templates, youmust have theView templates andAdd, edit or
delete templates permissions.

l To deploy a template, regardless of its content, youmust have edit permissions on the deployment
target group. You do not need edit permissions on the template objects (monitors, remotes, and
alerts). For details on user permissions, see "Permissions" on page 636.

2. Create a template container
Create a template container to enable you tomanage your monitoring solution.
For user interface details, see "New Template Container Dialog Box" on page 690.

3. Create a template
Add a template to the template container. This is the container for your monitoring solution, in which you
create groups, monitors, remote server, variables, and alerts for themonitoring solution. You can create
multiple templates in a template container.
For user interface details, see "New Template Dialog Box" on page 691.
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Note: You can also copy an existing group andmonitor hierarchy from a SiteScope to the template
and edit the elements for use as a template. For task details, see "How to Create a Template by
Copying Existing Configurations" on page 682.

4. Create template variables
You can create template variables in the template that enable you to specify a different name for an
object every time that you deploy the template. Variables should be the first objects you create in a
template, because they are referred to when you create groups, monitors, servers, and alerts.
a. Create the template variable in the template. For more information on the user interface, see "New

Variable Dialog Box" on page 692.
b. Reference the variable in one or more configuration objects in the template. For more information on

this topic, see "Referencing Template Variables" on page 675.

Note:

o If a remote server is specified with a variable namewith no additional characters prefixed or
suffixed to it (for example, %%hostname%%), and the same variable is specified for any field in
amonitor, after deployment the value appears as Remote-## on UNIX and \\<variable_
value> onWindows, instead of just the variable value that was specified on deployment. To
avoid this, where a variable name is used for a remote server, additional characters should
be prefixed or suffixed to the name.

o User-defined and pre-defined system variables are available in all the text fields and text
table cells when configuring templates. To display the list of available variables, type either
%% or $$ in the field, and select the relevant variable. The variable is then displayed in the
field.

5. Create a template remote server
In the template, you can define a remoteWindows or UNIX server where themonitored objects are
located. A templatemonitor may run on servers that are defined by template servers at the time of
template deployment or on servers definedmanually in Remote Servers. Template servers are added to
the remote server tree under Microsoft Windows Remote Servers or UNIX Remote Servers when the
template is deployed.
For user interface details, see "New Template Remote Server Dialog Box" on page 694.

Note: You can add only one remote server to a template.

Example:AWindows template remote server has been created with the name %%host%% remote
windows.
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6. Create a template group
In the template, create a template group tomake the deployment of monitors and associated alerts
manageable and effective for your organization.
For user interface details, see "New Template Group Dialog Box" on page 695.

Note:

l By default, monitors must be created in a template group. You can override this setting in
Preferences > Infrastructure Preferences > Template Settings by selectingAllow creation
of template monitors directly under a template entity.

l You can also define a template subgroup so that its content is not a part of the template, and is
ignored, when publishing changes to deployed groups. This enables deploying templates inside
different deployed groups. For details, see "Ignore group when publishing changes" on page 697
in General Settings.

l A template can have only one template group directly under it (the parent group).

7. Create template monitor instances
a. Select themonitor instances you want to add to the template group. For user interface details, see

"New TemplateMonitor Dialog Box" on page 699.
b. Enter values for themonitor properties.

o If you are using template variables, enter the variable syntax for all fields whose values are to be
replaced with a variable. This includes use of the $$SERVER_LIST$$ system variable. For
concept details, see "Syntax for System Variables" on page 675.

o To enter a variable, type either%% or $$. The list of available variables of that type is displayed
automatically. Click the relevant variable to select it (using the keyboard to navigate through the
list of available variables is not supported). The variable is then displayed in the field.
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Example:Using a variable when configuring amonitor. In this example, the templatemonitor
(a SiteScope CPU monitor) is configured to run on the template remote server, %%host%%
remote windows.

Note:

l A templatemonitor can run on servers that are defined by template servers at the time of
template deployment or on servers definedmanually in the Remote Servers container of the
remote server tree. Whichever is the case, the value in theServer box must match the host
name of an actual server at the time that the template is deployed after values have been
substituted for the template variables. If the server name does not match the host name of a
real server, themonitor fails. To automatically retrieve the template remote server name (if
one was created), select the Use already configured template remote under current
template check box in theMonitor Settings field. For user interface details, see "New
TemplateMonitor Dialog Box" on page 699.

l Do not use "\\" in themonitorServer field, and in the remote serverName andServer
fields.

l You can addmonitor instances directly to the template entity if you select Allow creation
of template monitors directly under a template entity inPreferences > Infrastructure
Preferences > Template Settings.

c. For monitors with browsable counters, select counters to monitor measurements specific to the
target system.
o Click theGet Counters button, and select a server or enter the connection information for a

server that is running the service or application that you want to monitor.
o Click theGet Counters button again to retrieve the available counters. The counter selection

dialog box is updated.
o Select themeasurements or counters that you want to monitor. If the specific counters on the

target system vary from one deployment to another, you can use a regular expression tomatch a
pattern that represents the type or category of counter you want to monitor. For task details, see
"How toModify Counter Selection Strings to Use Regular Expressions" on page 686.
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d. Configure other monitor settings in the Properties tab, such as:
o Manually set thresholds for monitors by setting logic conditions that determine the reported

status of eachmonitor instance. For user interface details, see "Threshold Settings" on page 248.

Note: After deploying a template, you can also set thresholds for one or multiple monitors
using a baseline. For task details, see "How to Set Monitor Thresholds Using a Baseline" on
page 280.

o Manually configure calculatedmetrics to calculate the relation between two or moremetrics for
one or moremonitors. For user interface details, see "CalculatedMetrics Settings" on page 311.

o Build dependencies between groups and key monitors to help control redundant alerting. For
concept details, see "Monitoring Group Dependencies" on page 221.

o For the complete list of common user settings, see "CommonMonitor Settings" on page 242.

Note: If you copy, move, or delete a template containing custommonitors, this affects the
content package folder (created in the <SiteScope root directory>\packages\workspace
directory) as follows:

o Copy.Makes a copy of the content package folder in the <SiteScope root
directory>\packages\workspace folder.

o Cut. No change.
o Delete. If you delete the custommonitor template, the content package folder is removed

from the <SiteScope root directory>\packages\workspace folder of the SiteScope file
system.

8. Set up monitor and group alerts
Create alerts to send notification of an event or change of status in some element or system in your
infrastructure.
For task details, see "Configure SiteScope Alerts" on page 1072.

9. Deploy the template
After creating a SiteScopemonitoring template, you can deploy templates to a group.
l You can deploy a single template, or multiple templates simultaneously to a group from the user
interface. For task details, see "How to Deploy Templates Using the User Interface" on page 722.

l You can perform mass deployments of a single template using a CSV file external to the SiteScope
user interface. A CSV file is better suited for performingmass deployments, since it is easier to enter
and update all the template variable values in one CSV file. For details, see "Deploy a Template Using
a CSV File" on page 721.

l You can deploy a template using an XML file external to the SiteScope user interface. For details, see
"Deploy Templates Automatically Using an XML File" on page 732.

Note: If you deploy a template containing a custommonitor, the template and the deployedmonitor
both point to the samemonitor. If a deployedmonitor is copied, the content package will be copied to
the <SiteScope root directory>\packages\workspace folder of the SiteScope file system.

10. Results
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SiteScope adds the groups, monitors, and alerts to the specified group in themonitor tree.
For troubleshooting and limitations when configuring user-defined templates, see Troubleshooting
SiteScope Templates.

Example: The template example,Windows basic template, was deployed to a group container
named Lab Test. It contains aCPU monitor andMemory monitor, and was deployed tomonitor
resource usage on a server named doors.

11. Set up monitor and group reports in the monitor view - optional
Create reports to display information about how the servers and applications you aremonitoring have
performed over time.
For task details, see "Create SiteScope Reports" on page 1139.

12. Publish changes to the monitoring solution - optional
You canmake changes to deployed templates, for example, by adding or removingmonitors or modifying
monitor properties. You do this by editing the template and using the Publish Template Changes Wizard
to publish the changes to all the relevant objects deployed by the template.
For task details, see "How to Publish Template Updates to Related Group Deployments" on page 746.

13. Share the template with other SiteScope users - optional
You can share templates by sending them to individual SiteScope users, or by publishing them to the
HPE Live Network. The HPE Live network is an online community providing a central location for HPE
customers to share information and learn about add-on content, extensions and related activities across
the HPE Software portfolio.
For task details, see "Share SiteScope Content on the HPE Live Network" on page 758.

How to Create a Template by Copying Existing
Configurations
This task describes the steps involved in copying an existing group, monitor, or remote server from a
SiteScope to the template and editing the elements for use as a template.

1. Prerequisites
Before copying an existing configuration from a SiteScope to a template, the template container and
template into which you want to copy the entity must exist in the template tree.

Note:When copying an existingmonitor or remote server to a template, a template groupmust also
exist in the template.
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For details on creating a template container, template, and template group, see "How to Create a
Monitoring Structure Using a Template" on page 677.

2. Copy the configuration to the template
Right-click the group, monitor, or remote server you want to copy, and select Copy to Template. In the
Copy to template tree dialog box, select the template or template group to which you want to add the
copied configurations.
For user interface details, see "Copy to Template Tree Dialog Box" on page 271.

3. Edit template variables
If you are using template variables in the new template, edit each copied object by replacing the
applicable configuration field's value with the required variable syntax.
For concept details, see "Referencing Template Variables" on page 675.

4. Results
SiteScope adds the group, monitor, or remote server to the specified template or template group in the
template tree.

Select Browsable Monitor Counters in Monitor
Templates
SiteScope includes a number of applicationmonitor types that are designed tomonitor measurements
specific to the target system. These browsable counter monitor types use aGet Counters/Measurements
browser function in theMonitor Settings panel. Configuring thesemonitor types manually requires the
following steps after selecting themonitor type:

l Specifying connection properties to the target system and then requesting that SiteScope retrieve the
measurement counters from the remote system.

l Selecting the desired counters to bemonitored and adding them to the configuration. After this, themonitor
can be added to SiteScope.

Counter Selection for Browsable Monitors Overview
Deployingmonitors using templates does not accommodate a separate step for counter selection. Another
mechanism is used to enable the selection of counters for thesemonitor types using templates. SiteScope
uses text matching or regular expressionmatching to automate the counter selection step for template
deployment. You use a counter selection step when you create the templatemonitor.

The simplest method for counter selection in templates is to select the specific counters explicitly in the
monitor template. This creates an explicit text match used to select thematching counter during deployment.
For information about the steps required to add a browsable counter monitor type with explicitly selected
counters, see the "Create templatemonitor instances" step in "How to Create aMonitoring Structure Using a
Template" on page 677.

If the specific counters on the target system vary from one deployment to another, youmay be able to use a
regular expression tomatch a pattern that represents the type or category of counter you want to monitor. For
more information, see "Counter Selection Using Regular Expressions" on the next page.

Using SiteScope
Chapter 60: Create Templates

HPE SiteScope (11.33) Page 683 of 1206



You canmodify counter selection strings for templatemonitors to use regular expressions when you create
themonitor, or you can edit themonitor later. For more information onmodifying a templatemonitor for regular
expression counter matching, see "How toModify Counter Selection Strings to Use Regular Expressions" on
page 686.

Counter Selection Using Regular Expressions
Many applications have a number of measurement counters that vary according to the system onwhich it is
running, the configuration of system options, and the components installed. In this case, selecting explicit
counters in amonitor templatemay not be useful across multiple instances of an application or system. Some
systems havemeasurement counters that have a similar pattern but may vary by the name of a node or object
context. You can use regular expressions in monitor templates to help automate the selection of multiple
measurement counters.

Note: Use of this regular expression counter matching function requires knowledge of the counters on the
system to bemonitored. You shouldmanually set up amonitor of the type you want to add to the template
and carefully review the counters available on the type of system you want to monitor. Creating a
"greedy" regular expression that matches large numbers of counters on a remote systemmay adversely
affect SiteScope performance.

The steps you use to create a templatemonitor to use regular expressions are very similar to the procedure
described in the previous section. Instead of selecting all of the counters to bemonitored explicitly, you select
one or more counters that are representative of all the counters you want to select. The counter selections in
monitor templates are stored as text strings. You edit these strings to create patterns that SiteScope uses to
findmatching counters that are selected when themonitor is deployed.

Note:When using regular expressions to select measurement counters or match thresholds, SiteScope
checks only whether one string is a substring of another, rather than performing an equality check. This
means that the incorrect set of counters and thresholds could be defined in themonitor after deployment.
For example, if the chosenmonitor threshold is x/y, and x/yy alsomatches the regular expression, this
threshold is also defined.

Regular Expression Examples
l Example 1. The following is a simple example of how a regular expression can be used for counter
selection for a SNMP by MIB Monitor type in a template:
You want to monitor the following three counters from several SNMP agents in your infrastructure:

iso/org/dod/internet/mgmt/mib-2/system/sysDescr
iso/org/dod/internet/mgmt/mib-2/system/sysUpTime
iso/org/dod/internet/mgmt/mib-2/system/sysName

You could select all three counters explicitly in the templatemonitor. Alternately, you could select one of
these and thenmodify the counter string to be a regular expression such as the following:

/iso\/org\/dod\/internet\/mgmt\/mib-2\/system\/sys[DUN][a-zT]*/

In this example, the counter selection string has been edited to add a pair of / slashes before and after the
string. This is necessary to indicate that the string is to be interpreted as a regular expression. Because
the selection string included several / slash characters initially, each of these characters must be escaped
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by adding a \ backslash character immediately preceding it. The [DUN][a-zT]* string includes two
character class declarations commonly used in regular expression syntax. For more information on regular
expression syntax, see "Regular Expressions" on page 153.

l Example 2. The following is an example of how a regular expression can be used for counter selection for
a UNIX ResourceMonitor type in a template:
You want to monitor daemon processes running on several UNIX or Linux servers in your infrastructure.
The list of processing runningmight include the following:

Process\-bash\NUMBER RUNNING
Process\../java/bin/java\NUMBER RUNNING
Process\./ns-admin\NUMBER RUNNING
Process\./ns-proxy\NUMBER RUNNING
Process\./ns-sockd\NUMBER RUNNING
Process\/bin/sh\NUMBER RUNNING
Process\/etc/init\NUMBER RUNNING
Process\/usr/apache/bin/httpd\NUMBER RUNNING
Process\/usr/lib/nfs/statd\NUMBER RUNNING
Process\/usr/lib/saf/sac\NUMBER RUNNING
Process\/usr/lib/saf/ttymon\NUMBER RUNNING
Process\/usr/lib/snmp/snmpdx\NUMBERRUNNING
Process\/usr/lib/ssh/sshd\NUMBER RUNNING
...

You can create a regular expression counter selection string tomatch only those processes that end with
the letter "d". The following is an example regular expression tomatch this pattern:

/Process[\W\w]{5,18}d[\W]{1,2}NUMBER RUNNING/

As with Example 1, the counter selection string includes / slashes before and after the string to indicate
that the string is a regular expression. The example process strings on the UNIX server include
combinations of \ back slash and / forward slash characters. Because these characters have special
meaning in regular expressions, they would have to be escaped. This can be complicated because the
process strings havemany variations and combinations of these and other symbols.
The example regular expression used here simplifies the expression by using character class
declarations. The [\W] class is used tomatch punctuationmarks. This matches on the \, -, :, and /
characters that appear in some of the process strings without the need to escape the characters
individually. For more information on regular expression syntax, see "Regular Expressions" on page 153.

l Example 3. The following aremore complex examples of how regular expressions can be used for counter
selection for different monitors in a template, where%% <variable name>%% represents a template
variable:

VMware Host Network Monitor:

/%%host%%\/HostSystem\/net\/packetsRx.summation\[.*\]
/ /%%host%%\/HostSystem\/net\/packetsTx.summation\[.*\]/

VMware Datastore Monitor:
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/.*\/.*\/accessible/
/.*\/.*\/.*\/capacity/

VMware Performance Monitor on Resource Pool:

/ResourcePool/%%resource_pool_name%% (.*)/Historical\[300 secs\]/mem/consumed.average\[\]/
/ResourcePool/%%resource_pool_name%% (.*)/Historical\[300 secs\]/cpu/usagemhz.average\[\]/

Microsoft Windows Resources Monitor:

/Network Interface\\(.*)\\Packets\/sec/
/Network Interface\\(.*)\\Bytes Total\/sec/ /Network Interface\\(.*)\\Bytes Received\/sec/ /Network
Interface\\(.*)\\Current Bandwidth/
/Process\\java(.*)\\% User Time/ /Process\\java(.*)\\ID Process/ /.NET CLR Exceptions\\(.*)\\# of
Exceps Thrown \/ sec/

How to Modify Counter Selection Strings to Use Regular Expressions
This task describes the steps involved inmodifying a templatemonitor to use a regular expression for
measurement counter selection.

Note: This task applies tomonitors with browsable counters only.

1. In the template tree, click themonitor template you want to modify to open the templatemonitor
Properties view.

2. Open theMonitor Settings panel, and in theMeasurements orCounters section (depending on the
monitor type), select a counter selection string that is representative of the pattern of counters you want
to configure for themonitor.

3. Modify the counter selection string to be a regular expression by adding a slash ("/") character to the
beginning and end of the string. Modify the string to use other patternmatching syntax as required.
For counter selection examples, see "Regular Expression Examples" on page 684.
For more information on regular expression syntax, see "Regular Expressions" on page 153.

Note: If the templatemonitor was configured with explicit counter selections that can bematched
using the regular expression that was entered, you can delete the extra counter strings by clicking the
Delete Counter button.

Maximum Number of Counters That Can be Saved
Browsablemonitors are limited by the number of counters they have. Themaximum number of counters is
determined by the _browsableContentMaxCounters parameter in themaster.config file (also in
Preferences > Infrastructure Preferences > Monitor Settings > Maximum browsable counters to be
selected). If you create or edit a monitor so that it has more counters than this value, only the number of
counters up to this value is saved.

When a browsablemonitor is deployed in a template, the number of counters that match the selected patterns
is limited by the _maxCountersForRegexMatch parameter in themaster.config file. If during deployment,

Using SiteScope
Chapter 60: Create Templates

HPE SiteScope (11.33) Page 686 of 1206



the number of counters that match the patterns exceeds this value, only the number of counters up to this
value is saved.

The _maxCountersForRegexMatch parameter is also used to limit the number of counters that match the
selected counter patterns when creating and updating dynamic monitors. We recommend using the same
value for both _browsableContentMaxCounters and _maxCountersForRegexMatch parameters in the
master.config file. The default value for both of these parameters is 1000.

When upgrading from earlier versions of SiteScope, the value for both of these parameters is set to the higher
of these two parameter values in the previous version, or to 1000 (whichever is greater).

SiteScope Templates User Interface
This section includes:

l "SiteScope Templates Page" below
l "Templates Tree - Properties Page" on the next page
l "Templates Tree - Alerts Tab" on page 689
l "New Template Container Dialog Box" on page 690
l "New Template Dialog Box" on page 691
l "New Variable Dialog Box" on page 692
l "New Template Remote Server Dialog Box" on page 694
l "New Template Group Dialog Box" on page 695
l "New TemplateMonitor Dialog Box" on page 699
l "New Alert Dialog Box" on page 701
l "Search/Filters Tag Dialog Box" on page 701

SiteScope Templates Page
This page displays the name and description of the selected template container. Use this page to add
template containers, or edit the properties of existing template containers (not Solution Templates).

To access Open the Templates context. In the template tree, select theSiteScope node.

Important
information

l You can also use the SiteScope API when working with templates. For details, see
"SOAP-based APIs" on page 139.

l Only a SiteScope administrator user, or a user granted the appropriate template
permissions can view, add, or edit templates. For details on user permissions, see
"Permissions" on page 636.

l A user can only access the template containers for which they have permissions in the
Allowed template containers list. This is set by the SiteScope administrator in
Preferences > User Management Preferences > user_profile > Main Settings >
Allowed template containers.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also "Template Tree" on page 37
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User interface elements are described below:

UI Element Description

New Template Container. Opens the New Template Container dialog box, enabling you to
create a new template container. For user interface details, see "New Template Container
Dialog Box" on page 690.

Edit Template Container. Enable editing the selected template container.

Delete Template. Deletes the template container.

<SiteScope
Templates
table>

Lists the predefined template that comewith SiteScope (Template Examples, Monitor
Deployment Wizard Templates, and Solution Templates), and any user-defined template
containers. Double-click a template container to open the template container page for the
selected template.

Name Name string assigned to the template container.

Description Description of the template container that was assigned when creating or editing the
template container.

Templates Tree - Properties Page
This page displays the name and description of the selected template object. In the template tree, select a
template object (template group, templatemonitor, template variable) to display properties for the specific
object. Use this page to edit the properties of the template.

To
access

l Select the Templates context. In the template tree, select a template object to display
properties for the object. The template Properties tab is displayed only when a template
group or monitor is selected.

l Only a SiteScope administrator user, or a user granted the appropriate template permissions
can view, add, or edit templates. For details on user permissions, see "Permissions" on
page 636.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also "Template Tree" on page 37

Main Settings
User interface elements are described below:

UI Element Description

Name The template name.

Description Description of the template.
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UI Element Description

Last edited
by

SiteScope user that last edited the template. This field is read-only.

Note: This field is displayed only when a template is selected in the template tree.

Last edited
on

Time and date that the template, or any object within the template, was last edited. This
field is read-only.

Note: This field is displayed only when a template is selected in the template tree.

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope, this
section appears but is empty. If tags have been created, they are listed here and you can select
them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add
Existing
Tag

Click to add existing tags. The Search/Filters dialog box opens. For details, see "Search/Filters
Tag Dialog Box" on page 701.

Templates Tree - Alerts Tab
This tab displays a list of alerts associated with the solution template. Use this page to add, delete, or edit
alerts associated with the template. In the template tree, select a template group or monitor to display alerts
for the selected object.

To
access

Select the Templates context. In the template tree, navigate to the group or monitor to which
you want to view, add, or edit alerts. Click theAlerts tab.

Relevant
tasks

l "Deploy Solution Templates" on page 762
l "Configure SiteScope Alerts" on page 1072

See also l "Template Tree" on page 37
l "SiteScope Alerts Page" on page 1091

User interface elements are described below:

UI Element Description

New Alert. Opens the New Alert dialog box enabling you to define a new alert. For user
interface details, see "New/Edit Alert Dialog Box" on page 1092.

Edit Alert. Opens the Edit Alert dialog box enabling you to edit the alert. For user interface
details, "New/Edit Alert Dialog Box" on page 1092.
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UI Element Description

Copy Alert. Copies the alert.

Paste Alert. Pastes the alert.

Delete Alert. Deletes the alert.

Name Name string assigned to the alert definition.

Status The enabled/disabled status of the alert.

l Enabled. Overrides any disable action on the alert and enables the alert for execution
based on the conditions defined.

l Disabled indefinitely. Prevents SiteScope from executing the alert action even if the
alert condition is met until this radio button is cleared and the alert definition is updated.

l Disable on a one time schedule from <Time1> to <Time2>. Prevents SiteScope
from executing the alert action for the time period indicated, even if the conditions are
met. The alerts are disabled at the beginning of the time period and re-enabled after the
time period expires.

Description Description of the alert definition that was assigned when creating or editing the alert.

Action
Name

Name given to the action to be done when the alert is triggered. It is not the name of the alert.

New Template Container Dialog Box
This dialog box enables you to define a new template container. You use template containers to store and
manage templates. Template containers enable you to group and organizemultiple templates in ways that
describe their purpose or classification.

To access Select the Templates context. In the template tree, right-click the SiteScope node or an
existing template container, and select New > Template Container.

Important
information

l Template containers can be added only to the SiteScope node in the template tree.
l Templates are displayed with the icon in the template tree. Template containers can
hold templates only.

l To delete a template container after deploying templates, youmust first delete each
group to which the templates were deployed in themonitor tree, and then you can delete
the template container.

l A user can only access the template containers for which they have permissions in the
Allowed template containers list. This is set by the SiteScope administrator in
Preferences > User Management Preferences > user_profile > Main Settings >
Allowed template containers.

Relevant
tasks

l "How to Create aMonitoring Structure Using a Template" on page 677
l "How to Create a Template by Copying Existing Configurations" on page 682
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See also l "Create Templates" on page 667
l "Template Examples" on page 672
l "Template Tree" on page 37

Main Settings
User interface elements are described below:

UI Element Description

Name Name for the template container.

Maximum length: 250 characters

Description Description for the template container.

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope, this
section appears but is empty. If tags have been created, they are listed here and you can select
them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

New Template Dialog Box
This dialog box enables you to add a template to a template container. An individual template is comprised of
the object definitions of those objects that are created when the template is deployed. Templates are
displayed with the icon in the template tree.

To access Select the Templates context. In the template tree, right-click a template container, and
select New > Template.

Important
information

l A template can have one template group only directly under it (the parent group).
l Templates can contain a group and subgroups, variables, and a remote server. They can
also contain monitors, providedAllow creation of template monitors directly under a
template entity is selected inPreferences > Infrastructure Preferences > Template
Settings.

l To delete a template after deploying it, youmust first delete each group to which the
template was deployed in themonitor tree, and then you can delete the template.

Relevant
tasks

l "How to Create aMonitoring Structure Using a Template" on page 677
l "How to Create a Template by Copying Existing Configurations" on page 682
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See also l "Create Templates" on page 667
l "Template Examples" on page 672
l "Template Tree" on page 37

Main Settings
User interface elements are described below:

UI Element Description

Name Name for the template. The name you enter appears in the template tree as a child node of
the template container.

Maximum length: 250 characters.

Description Description for the template.

Last edited
by

SiteScope user that last edited the template. This field is updated only after the template is
created.

Default value:N/A

Last edited
on

Time and date that the template (or any object within the template) was last edited. This field
is updated only after the template is created.

Default value:N/A

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope, this
section appears but is empty. If tags have been created, they are listed here and you can select
them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

New Variable Dialog Box
This dialog box enables you to add a template variable to a template. A variable is used to enable prompting
for user input during template deployment. Template variables are either user-defined or predefined system
variables that provide access to the list of remote server connections known to SiteScope. Template
variables are displayed with the icon in the template tree.
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To access l Select the Templates context. In the template tree, right-click a template, and select
New > Variable.

l In the Template <monitor> page, click New Variable. For details, see "New Template
Monitor Dialog Box" on page 699.

l In the New Template Alert dialog box, click New Variable. For details, see "New Alert
Dialog Box" on page 701.

l In the Alert Action dialog box, click New Variable. For details, see "Alert Action Dialog
Box" on page 1101.

l In the New Microsoft Windows Remote Server dialog box, click New Variable. For
details, see "New Template Remote Server Dialog Box" on the next page.

l In the New UNIX Remote Server dialog box, click New Variable. For details, see "New
Template Remote Server Dialog Box" on the next page.

Important
information

l When configuring variables for Frequency andError frequency in theMonitor Run
Settings, the variable values can only be in time units of seconds.

l When amonitor is copied or moved from one template to another, any user-defined
variables in themonitor are also copied or moved.

l If you change the name of an assigned template variable, all monitors using that variable
are automatically updated to use the new variable name.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also l "Create Templates" on page 667
l "Template Variables" on page 673
l "Template Examples" on page 672
l "Template Tree" on page 37

Main Settings
User interface elements are described below:

UI Element Description

Name Name for the template variable. The name you enter is used to identify the variable in the
template in the template tree. This is the name that must be used when referring to the
variable in other template objects.

Note: The name of a variable cannot be edited after the variable has been added. To change
a variable name, delete the variable and create a new one with the correct name.

Display
name

Display name if you want a different name to be displayed instead of the variable name on
deployment. Youmust still use the variable namewhen referencing the variable in a
template object.

Description Description for the variable.
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UI Element Description

Default
value

Default value to be used for this variable. If you do not enter a value in this box and the box
requires a value, you are prompted to enter a value when deploying the template.

Note: If thePassword variable option is selected, the default value is hidden behind
asterisks. If you subsequently clear the check box, the hidden data is deleted.

Display
order in
template

Variable display sequence number. This is the order in which SiteScope prompts you to
enter values for a variable on deployment. Variables are displayed in ascending order.
Variables that have no display number are displayed at the end.

Note: The display order does not change the order of the variables within the template
definition.

Password
variable

Hides the default value and the value entered during deployment behind asterisks. If you
subsequently clear the check box, the hidden data is deleted.

Default value:Not selected

Note: This option is automatically selected for any variable from previous versions of
SiteScope that has a name ending with PASSWORD or password.

Mandatory
variable

The variable field requires a value and prompts you to enter a value when deploying the
template. To set a variable with a non-mandatory value, clear the check box. When this
option is cleared, SiteScope uses an empty String ("") as a value for a non-mandatory
variable.

Default value:Selected

New Template Remote Server Dialog Box
This dialog box enables you to create a UNIX orWindows remote server in the template. A template remote
server is used to define remote server preferences that are created when the template is deployed. A template
remote server is displayed with the icon in the template tree.

To access Select the Templates context. In the template tree, right-click a template, and select New >
Microsoft Windows/UNIX Remote Server.
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Important
information

l Enter the actual values for those fields that remain constant throughout the template
deployment. Enter template variables in those fields whose values are replaced with a
variable value when the template is deployed. For details, see "Referencing Template
Variables" on page 675.

l You can add only one remote server to a template.
l You cannot delete a server from the remote servers list if the server is referenced by a
templatemonitor. Select a different server in theServer box of theMonitor Settings
panel for eachmonitor that references the remote server, and then delete the remote
server from the remote server list.

l You can add a new variable from the New Template Remote Server dialog box by
clicking theNew Variable button, and configuring the variable as described in "New
Variable Dialog Box" on page 692.

l You cannot replace an existingmonitor target server using the Publish Template
Changes wizard or auto deployment update (see "Publish Template Changes Using the
XML" on page 733), although you can change property values of the target server itself, if
required.

l Do not use "\\" in the remote serverName andServer fields, and in themonitorServer
field.

l Some fields that contain drop-down lists when configuring objects in normal mode, are
displayed as text boxes in templatemode.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also l "Create Templates" on page 667
l "Remote Servers" on page 401
l "Template Examples" on page 672
l "Template Tree" on page 37

The following user interface element is common to all areas in the page:

UI Element Description

New Variable Click to define a new variable. For details, see "New Variable Dialog Box" on page 692.

For a description of the elements found in theMicrosoft Windows New Remote Server dialog box, see
"New/Edit Microsoft Windows Remote Server Dialog Box" on page 406.

For a description of the elements found in the New UNIX Remote Server dialog box, see "New/Edit UNIX
Remote Server Dialog Box" on page 422.

New Template Group Dialog Box
This dialog box enables you to add a template group to a template, or to an existing template group to create a
subgroup. You use template groups to replicate monitoring deployment to multiple locations in the
infrastructure. Template groups are displayed with the icon in the template tree.

To access Select the Templates context. In the template tree, right-click a template or template group,
and select New > Group.

Using SiteScope
Chapter 60: Create Templates

HPE SiteScope (11.33) Page 695 of 1206



Important
information

l A template can have only one template group directly under it (the parent group).
l By default, you can create templatemonitors, alerts, and subgroups in the parent group
or in subgroups only. If you want to create templatemonitors directly under a template
entity, select theAllow creation of template monitors directly under a template
entity check box inPreferences > Infrastructure Preferences > Template Settings.

l You can add a new variable from the New Template Group dialog box by clicking the
New Variable button, and configuring the variable as described in "New Variable Dialog
Box" on page 692.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also l "Create Templates" on page 667
l "Template Examples" on page 672
l "Template Tree" on page 37
l "Dependencies When Configuring TemplateMonitors andGroups" on page 222

The following user interface element is common to all areas in the page:

UI Element Description

New Variable Click to define a new variable. For details, see "New Variable Dialog Box" on page 692.

General Settings
User interface elements are described below:

UI Element Description

Group
Name

Name for the template group (preferably using a template variable). A template variable
enables you to specify a different name for the group every time you deploy the template. If
the group name does not include a variable, multiple deployments of the template in the
same directory fail because the group name is not unique. For details on using template
variables, see "Referencing Template Variables" on page 675.

Note:

l Template deployment fails if a template contains multiple groups with the same name,
even if each group has a different parent group.

l The group name cannot contain any of the following characters: ` ;" & | < > / \ +

Group
Description

Description for the template group. This can include themost commonHTML tags for text
styling, such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed only
when viewing or editing the group's properties in the SiteScope Dashboard. For details on
adding a hyperlink, see "Add URL links to group descriptions - optional" on page 214.

Note: This field does not support JavaScript/iframes/frames or other advanced features.
HTML code entered in this box is checked for validity and security, and corrective action is
taken to fix the code (for example, code is truncated if it spans more than one line).
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UI Element Description

Ignore
group
when
publishing
changes

(This option is not available for the root group, and is inactive for Solution Templates.)

Changes made to any objects within this subgroup are ignored when publishing changes to
deployed groups.

This option enables you to:

l Deploy a template inside an existing deployed group and publish template changes to the
deployed group without affecting SiteScope objects that are in the ignored group. This
means you can edit or delete monitors, groups, or alerts in a deployed group without them
being affected when publishing changes.

l Delete objects in deployed groups that were removed from the source template (when
theEnable delete on update option is selected), without deleting other objects created
in the deployed group that were not part of the source template.

Default value:Not selected

For the effect of this setting when performing different actions, see the table below.

The following lists the impact of the Ignore group when publishing changes setting when different actions
are performed:

Action Effect when Ignore group when publishing changes is selected

RenameDeployedGroup The change of name is ignored by the publish changes flow.

Rename Template Group

Delete DeployedGroup The group is recreated when you publish changes.

Delete Template Group The publish changes flow removes the deployed group whenEnable delete
on update is selected.

Copy a template group The Ignore group when publishing changes setting does not change
when copying a template group and its contents to a template.

Copy to a template The Ignore group when publishing changes setting is set to false
(cleared) when copying a group and its contents to a template.

Copy between templates The Ignore group when publishing changes setting is copied along with
the other template group settings.

Import template from a
previous version of
SiteScope

The Ignore group when publishing changes setting is interpreted as
false (cleared).

Export a template The Ignore group when publishing changes setting does not change
when exporting a template.
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Dependencies
User interface elements are described below:

UI Element Description

Depends on Click Depends on to open the Select Depends OnMonitor dialog box, and select the
monitor on which you want to make the running of this monitor dependent. For details on
the Select Depends OnMonitor dialog box, see "Select Depends OnMonitor Dialog Box"
on page 270.

Use this option to prevent redundant alerting frommultiple monitors that aremonitoring
different aspects of a single system.

Example:Create a systemmonitor to check the basic availability of a system and then
create other monitors that perform more detailed tests of that system. Set the detailed test
monitors to be dependent on the status of themonitor checking basic availability.

If the systemmonitor detects that the target system has become unavailable, the
dependency relationship automatically disables the other monitors. This also disables any
alerts that would have been generated by the dependent monitors.

Default value: No dependency is set for amonitor instance.

Note: This field is cleared and is not available when Ignore dependencies when
publishing changes is selected.

Depends
condition

If youmake this monitor dependent on the status of another monitor (by using the
Depends on setting), use this option to select the status condition of theDepends on
monitor for the current monitor to run normally.

The status categories include:

l Good
l Error
l Available
l Unavailable
Themonitor being configured is run normally as long as themonitor selected in the
Depends on box reports the condition selected in this box.

Example:Select Good and this monitor is enabled only when themonitor selected in the
Depends on box reports a status of Good. The current monitor is automatically disabled if
themonitor selected in theDepends on box reports a category or condition other than
Good. You can also enable dependent monitors specifically for when amonitor detects an
error.

Default value:Good
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UI Element Description

Ignore
dependencies
when
publishing
changes

When template changes are published to the deployed objects, dependency settings for
the selected template group are ignored and the existing dependency settings in the
deployed objects are preserved. For details, see "Dependencies When Configuring
TemplateMonitors andGroups" on page 222.

Default value:Not selected

Note:When selected, theDepends on field is cleared and is not available.

Search/Filter Tags
Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote servers, templates,
and preference profiles).

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

You can either:

l Click theAdd existing tag button to open the Search/Filter Tags dialog box where you can
select an existing tag. For details, see "Search/Filters Tag Dialog Box" on page 701.

l Enter values in the Tag Name andValues boxes to create new tags. You can also use
variables as tags and values. For concept details and for details on how to format the tag
names and values, see "Filter Objects in the SiteScope View" on page 65.

The Tag Name andValues boxes display the selected or entered values. The boxes are empty
at first, until you select tags.

Add
Existing
Tag

Opens the Search/Filters Tag dialog box, enabling you to add existing keyword tags or to define
new tags. For user interface details, see "Search/Filters Tag Dialog Box" on page 701.

New Template Monitor Dialog Box
This dialog box enables you to add a templatemonitor to a template group or subgroup. Templatemonitors are
used as the basis for the creation of actual monitors at the time that the template is deployed. Template
monitors are displayed with the icon in the template tree.

To access Select the Templates context. In the template tree, right-click a template group, and select
New > Monitor. Select themonitor type you want to configure for the template.
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Important
information

l By default, you create templatemonitors in a template group. To create template
monitors directly under a template entity, select theAllow creation of template
monitors directly under a template entity check box inPreferences > Infrastructure
Preferences > Template Settings. Templatemonitors can contain alerts.

l Templatemonitors are not activemonitor instances. Monitors are created and activated
based on these template configurations only when you deploy the template.

l Do not use "\\" in themonitorServer field, and in the remote serverName andServer
fields.

l When using regular expressions to select metrics counters or match thresholds,
SiteScope checks only whether one string is a substring of another, rather than
performing an equality check. This means that the incorrect set of metrics and thresholds
could be defined in themonitor after deployment. This is because SiteScope, by default,
treats every metric in themetrics table as a regular expression, andmatches the
threshold setting with all metrics that fit this expression. For example, if the chosen
monitor threshold is x/y, and x/yy alsomatches the regular expression, this threshold is
also defined. To avoid this, add specific regular expressions tomeet your exact
requirements (see "Select BrowsableMonitor Counters in Monitor Templates" on
page 683).

l When adding a Search/Filter tag to a templatemonitor, you cannot use both actual
parameters and variable parameters in the same tag values group.

l When deploying a Script monitor from a template, the case of the remote script name
must match that of the script name in the scripts subdirectory. Otherwise, the selected
script is shown as 'none'.

l The Network Bandwidthmonitor's non-default thresholds are not copied properly to a
template.

l The templatemonitor name cannot contain any of the following characters: " ` < >

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also l "CommonMonitor Settings" on page 242
l "Create Templates" on page 667
l "Template Examples" on page 672
l "Template Tree" on page 37

User interface elements are described below:

UI Element Description

The settings below are specific to the New Monitor dialog box when working in templatemode only. For
settings common to all monitors, see "CommonMonitor Settings" on page 242.

Use already configured
template remote under
current template

When selecting the server that you want to monitor, enables using the
template remote server (if one was created) without having to enter its
name.

Default value:Not selected
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UI Element Description

New Variable Opens the New Variable dialog box, which enables you to create a new
variable without navigating away from the New Monitor dialog box. For
user interface details, see "New Variable Dialog Box" on page 692.

New Alert Dialog Box
This dialog box enables you to define alerts for a template group or a templatemonitor. Template alerts are
used to define alerts onmonitors that are created when the template is deployed. If an alert has been set up for
the template group or monitor, the alert symbol is displayed next to the group or monitor icon.

To access Select the Templates context. In the template tree, right-click a template group or template
monitor, and select New > Alert.

Important
information

You cannot select theDisable or Enable Monitors alert action when creating an alert
template. Template alerts are enabled for all themonitors belonging to the object for which
they were defined. For example, if an alert is defined for amonitor, then it is activated on that
monitor only. If an alert is defined for a template, then it is activated for all themonitors in the
template.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also l "CommonMonitor Settings" on page 242
l "Create Templates" on page 667
l "SiteScope Alerts Page" on page 1091
l "Template Examples" on page 672
l "Template Tree" on page 37

The following element is common to all action types:

UI Element Description

New Variable Click to define a new variable. For details, see "New Variable Dialog Box" on page 692.

For a description of the other elements found in the New Alert dialog box, see "New/Edit Alert Dialog Box" on
page 1092.

Search/Filters Tag Dialog Box
This dialog box enables you to select one or more existing tags or to create a new tag.

To access Click Add Existing Tag in the Search/Filters Tag panel of template groups, template
monitors, and template alerts.

Relevant
tasks

"How to Create aMonitoring Structure Using a Template" on page 677

See also "Search/Filter Tags" on page 614
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User interface elements are described below:

UI
Element Description

Add Tag Click to create a new tag. For details, see "New/Edit Tag Dialog Box" on page 617.

Represents a SiteScopemonitor group or subgroup (with enabledmonitors/with nomonitors or
no enabledmonitors).

Represents a tag.
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Chapter 61: Create Content Packages
Content Packages are used for sharing user-defined content with other SiteScope users. You create content
packages using the Export Content PackageWizard.

Learn About
SiteScope Content Packages Overview
Content packages are required for sharing Custommonitors andmonitors that reference a script or alert
extension file.

Package
Type Description

Where to
Get Details

Custom
Monitor
Content
Package

A Custommonitor content package is created when creating a Custom
monitor (for details, see "Create CustomMonitors" on page 273). This is a set
of files in a predefined folder structure on the SiteScope file system which can
be created and referenced from aCustommonitor. You can add files to this
package that are required for running the Custommonitor. A content package
can include templates and additional dependency files such as jars and
configuration files.

The content package is created under <SiteScope root
directory>\packages\workspace\package_<Package ID>.

"How to
Create,
Export, and
Import a
Custom
Monitor
Content
Package" on
page 706

Template
Extension
Content
Package

A template extension content package is required for sharing a template
monitor that references script or alert extension files in the SiteScope file
system. The content package is comprised of a template (containingmonitors
and variables), and a set of predefined folders, that include the extension files
referenced by monitors in the template.

Script and alert extension files referenced by monitors in the template should
be copied to the relevant folders in the <SiteScope root
directory>\packages\workspace\extensions directory.

"How to
Create,
Export, and
Import a
Template
Extension
Content
Package" on
page 710

Tasks
This section includes:

l "How to Create, Export, and Import a CustomMonitor Content Package" on page 706
l "How to Create, Export, and Import a Template Extension Content Package" on page 710
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Chapter 62: Export and Import Templates and
Content Packages
You can export and import SiteScope content packages and user-defined templates for use in other
SiteScope installations. This enables you to share content with other SiteScope users, and to deploy multiple
IT elements with similar monitoring configuration criteria across the enterprise.

Learn About
Exporting and Importing SiteScope Content Overview
You can export templates for use in other SiteScope installations. This enables you to replicate standardized
monitor configurations across the enterprise. When you export a template container that includes one or more
templates, the template container and the templates are exported. After exporting, the templates still remain in
the template container. For details about exporting and importing templates, see "How to Export and Import a
Template" below.

You can also export SiteScope content in content packages for use in other SiteScope installations. Content
packages are used for sharing user-defined templates that contain Custommonitors or regular monitors that
reference a script or alert template file in the SiteScope root directory. For details about exporting and
importing content packages, see "How to Create, Export, and Import a CustomMonitor Content Package" on
page 706 and "How to Create, Export, and Import a Template Extension Content Package" on page 710.

After exporting to a template or content package, you can share the template or content package by sending it
to individual SiteScope users, or by publishing it to the HPE Live Network. For details, see "Share SiteScope
Content on the HPE Live Network" on page 758.

You can also export SiteScope templates to Operations Manager (HPOM) when SiteScope is connected to
HPOM 9.10 with patch 9.10.210 and hotfix QCCR1A125751, or to HPOM 9.10 with patches later than
9.10.210. This enables SiteScope templates andmonitors to be configured through the HPOM policy
assignment and deployment. For details, see the HP Operations Manager 9.10 documentation.

After exporting a template, you can copy the export file to another SiteScope server and import the template
container that contains the template or templates you want to use. This enables you to efficiently replicate
standardizedmonitor configurations across the enterprise.

Note: Youmust be an Administrator or a Super User to be able to import content package that contains
script files.

Tasks
How to Export and Import a Template
This task describes the steps involved in exporting and importing templates for use in other SiteScope
installations.
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Note: If the import fails or you no longer see the solution templates in the Solution Templates tree, you
can restore them by copying them from the <SiteScope root directory>\export folder to the
<SiteScope root directory>\persistency\import folder. If the \export folder also contains the template
examples, the template container should be renamed to prevent unique name violations.

1. Prerequisites
l Youmust be an Administrator or a Super User to be able to import content package that contains
script files.

l To add, edit, and delete templates, youmust haveAdd, edit or delete templates permissions.

l To deploy a template, regardless of its content, youmust have edit permissions on the deployment
target group. You do not need edit permissions on the template objects (monitors, remotes, and
alerts). For details on user permissions, see "Permissions" on page 636.

2. Export a template
To export a template for use in other SiteScope installations, right-click the template or template
container object in the template tree that contains the templates you want to export, and select Export >
Template. For details, see "Export Template Dialog Box" on page 713.
After exporting a template, you can share the template by sending it to individual SiteScope users, or by
publishing it to the HPE Live Network. For details, see "Share SiteScope Content on the HPE Live
Network" on page 758.

3. Export a template to Operations Manager (HPOM) - Optional
To enable SiteScope templates (not Solution Templates) andmonitors to be configured through the
HPOM policy assignment and deployment, right-click the template in the template tree you want to
export, and click Export to OM.

Note: This option is available only when HPOM 9.x or later and SiteScope are installed on the same
machine on a UNIX environment only, and when theOperations Manager integration has been
enabled in SiteScope. For details on configuring the Operations Manager integration, see Integrating
SiteScope with HP Operations Manager Products Guide. You can check the HPE Software
Integrations site for the latest version of this guide.

For details on how tomanage SiteScope templates with HPOM, see the HPOM documentation.

4. Import a template
After you have exported a template, you can copy the export file to another SiteScope server and import
the template container that contains the template or templates you want to use. Right-click the template
container in the template tree into which you want to import the template or templates, and click Import >
Template. Enter the name and location of the file you want to import.
For user interface details, see "Template Import Dialog Box" on page 719.

Note:When importing templates to SiteScope that contain deprecatedmonitors from earlier version
of SiteScope, the deprecatedmonitors are not displayed in the template tree.

5. Result
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Templates contained in the file are added to the template container. The imported templates can be used
directly or modified as required.

How to Create, Export, and Import a Custom Monitor Content Package
This task describes the steps involved in creating, exporting, and importing a content package to share
Custommonitors with other SiteScope users.

1. Prerequisites
l Youmust be an Administrator or a Super User to be able to import content package that contains
script files.

l Youmust have created a Custommonitor. For details, see "Create CustomMonitors" on page 273.

l To add, edit, and delete content packages, youmust haveAdd, edit or delete templates
permissions.

2. Copy the monitor to a template
For details, see "How to Create a Template by Copying Existing Configurations" on page 682.

3. Copy the files used for running the monitor
Copy the files required for running themonitor, such as the additional jars used in the script and other
resource files, to the predefined content package folders in the <SiteScope root
directory>\packages\workspace\package_<Package ID> directory:

Predefined
Folders Description

\classes If you have any compiled java classes that are used by amonitor, copy them with the
entire package folder structure to this folder; this is not required if the class files were
packaged in a jar that was copied to the \lib folder. The class files can be accessed from
the data processing script.

\conf If you have any configuration or documentation files, copy them to this folder. The data
processing script has read only access to this folder.

\lib If you have any external jars used by the Custommonitor script, copy them to this
folder. Java classes from the jar files can be accessed from the data processing script.
Note that you can use this monitor without external jars.

\META-INF Contains themanifest file where information about the content package is stored. The
manifest file is created automatically by the export process (see "Export the content
package to a zip file using the Export Content PackageWizard" on the next page).

\templates Copy the template files exported from SiteScope that contain the templates with the
Custommonitor(s) to this folder. Each template can contain various types of monitors;
custom and regular.

4. Copy extension files referenced by the monitor - optional
If themonitor references script or alert extension files in the SiteScope file system, copy them to the
relevant folders in the <SiteScope root directory>\packages\workspace\extensions> directory:
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Predefined
Folders Description

\scripts Stores script files that are used to run shell commands or other scripts on the
machine where SiteScope is running.
Note:After importing a content package, file permissions for script files imported to
this folder are changed to 755 (read, write and execution) for all users working in a
Linux environment.

\scripts.remote Used for storing script files that are used for running a script that is stored on a
remotemachine.
Note:After importing a content package, file permissions for script files imported to
this folder are changed to 755 (read, write and execution) for all users working in a
Linux environment.

\templates.mail Used for storing the file containing the format and content of alert messages sent by
email.

\templates.
mail.subject

Used for storing the file containing the subject line of alert messages sent by email.

\templates.mib Used for storing theMIB files that are used to create a browsable tree that contains
names and descriptions of the objects found during a traversal.
Note:As part of the import process, templates.mib files are edited and the unique
package ID is added to some properties inside the files.

\templates.os Used for storing the shell commands to be run whenmonitoring remote UNIX
servers.
Note:As part of the import process, template.os files are edited and the unique
package ID is added to some properties inside the files.

5. Export the content package to a zip file using the Export Content Package
Wizard
Select the Templates context. In the template tree, right-click the template or template container that
you want to export to a content package, and select Export > Content Package.
In the Export Content PackageWizard, enter details of the content package (manifest), and select the
templates and files associated with the templates to include. ForWizard details, see "Export Content
PackageWizard" on page 714.

Note: The Select Files page of theWizard displays files from the <SiteScope root
directory>\packages\workspace\package_<Package ID> and <SiteScope root
directory>\packages\workspace\extensions> folders listed in steps 3 and 4 above, except for the
\META-INF and \templates folders which are not displayed.

6. Share Custommonitors with other SiteScope users
You can distribute a content package zip file by sending it to individual SiteScope users. Alternatively,
you can use the HPE Live Network (https://hpln.hpe.com/group/sitescope) community for sharing
templates and content packages with other users.
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For details on publishing content packages to the HPE Live Network community, see "How to Publish
Content to the HPE Live Network Community" on page 759.
For details on downloading a content package to your SiteScopemachine, see "How to Download
Content from the HPE Live Network" on page 759.

7. Import a Content Package
a. In SiteScope, select the Templates context. In the template tree, right-click the template container

into which you want to import the content package, and click Import > Content Package.
b. In the Import Content Package dialog box, click Browse, and navigate to the folder containing the

package you want to import (packages are distributed in zip format). Click Open, and then click OK.
The Custommonitor templates are added to the selected template container.
For details, see "Import Content Package Dialog Box" on page 719.

Note:

o Content packages can contain any type of file from the predefined folders listed in steps 3
and 4 above. If the content package contains any other folders, an error is displayed and the
import operation fails.

o Existing SiteScope files cannot be overridden by files from content packages. However,
templates (located in the <SiteScope root directory>\packages\imported\templates
folder) can be overridden if theOverride existing templates check box is selected in the
Content Import dialog box. For details, see "Template Import Dialog Box" on page 719.

o When importing templates to SiteScope that contain deprecatedmonitors from earlier
version of SiteScope, the deprecatedmonitors are not displayed in the template tree.

o When importing a content package that is too large (the package size limitation depends on
the user VM size), SiteScope displays an error and the path to the applet.logwhere the error
is written. Since the exception is thrown from the user interface side, each user can
encounter the exception in different package sizes.

o Do not edit imported files.

8. Verify the template was imported successfully by checking it was added to the
template tree
a. Check that the content package was copied to the <SiteScope root

directory>\packages\imported folder, and a new folder was created with the name: <Package/Zip
Name>.zip_<Package ID>.
The folder contains:

Folder Description

\classes Stores compiled Java classes.

\conf Used for storing configuration files, documentation, and XML files.

\extensions Stores script and alert files referenced by monitors in the imported
templates.

\lib Stores external jar files used by themonitor script.
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Folder Description

\META-INF Contains themanifest file where information about the content package is
stored.

\templates Contains files from which templates in this content package were
imported into SiteScope.

<Package/Zip
Name>

Uncompressed package that contains the above-mentioned folders.

<Package/Zip
Name>.zip.properties

Descriptor (manifest) file for content packages created in SiteScope
11.20, that is used in case of rollback, uninstall, or upgrade. The file
contains the ID of the SiteScope template that was deployed, the location
of the files in SiteScope, and other information about the content package.

The imported templates and dependency files can be used directly or modified as required.
Where script or alert templates are referenced in the user interface, the unique package ID is added
as a suffix.

Example:ShortMail alert action template referenced in the Template field

b. If the templatemonitors are using extended files, check that these files were copied to the relevant
scripts and/or templates folder in theSiteScope root directory on the SiteScope file system (folders
have the same name as listed in step 4 above).

9. Managing content packages
After importing a content package, you can copy, move, and delete the imported Custommonitors.
When doing so, this affects the content package as follows:

Action File System Impact

Copy Monitor Copies the content package folder in the <SiteScope root
directory>\packages\workspace folder.

Cut Monitor No change.

DeleteMonitor Deletes the content package from the <SiteScope root
directory>\packages\imported folder of the SiteScope file system (if you
deleted all themonitors that were imported from the content package).
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Action File System Impact

Deploy template with
Custommonitor +
content package

No change.
If a deployedmonitor is copied, the content package is copied to the
<SiteScope root directory>\packages\workspace folder of the SiteScope
file system.

How to Create, Export, and Import a Template Extension Content Package

Note: This content package is an extension of the template concept, which enables sharing and reusing
templates with similar monitoring configuration criteria between different SiteScope deployments.

This task describes the steps involved in creating, exporting, and importing a content package for sharing a
templatemonitor that references script or alert extension files located in the SiteScope root directory, where
the extension files are used for running themonitor. This content package is applicable for all monitor types.

1. Prerequisites
l To add, edit, and delete content packages, youmust haveAdd, edit or delete templates
permissions.

l Youmust be an Administrator or a Super User to be able to import content package that contains
script files.

2. Create a SiteScope monitoring template or select an existing user-defined
template from the templates tree
For task details, see "How to Create aMonitoring Structure Using a Template" on page 677.

3. Copy extension files referenced by the monitor
For templatemonitors that reference script or alert extension files in theSiteScope root directory in the
SiteScope file system, copy the applicable extension files to the relevant folders in the <SiteScope root
directory>\packages\workspace\extensions> directory:

Predefined
Folders Description

\scripts Stores script files that are used to run shell commands or other scripts on the
machine where SiteScope is running.
Note:After importing a content package, file permissions for script files imported to
this folder are changed to 755 (read, write and execution) for all users working in a
Linux environment.

\scripts.remote Stores script files that are used for running a script that is stored on a remote
machine.
Note:After importing a content package, file permissions for script files imported to
this folder are changed to 755 (read, write and execution) for all users working in a
Linux environment.

\templates.mail Stores the file containing the format and content of alert messages sent by email.
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Predefined
Folders Description

\templates.
mail.subject

Stores the file containing the subject line of alert messages sent by email.

\templates.mib Stores theMIB files that are used to create a browsable tree that contains names
and descriptions of the objects found during a traversal.
Note:As part of the import process, templates.mib files are edited and the unique
package ID is added to some properties inside the files.

\templates.os Stores the shell commands to be run whenmonitoring remote UNIX servers.
Note:As part of the import process, template.os files are edited and the unique
package ID is added to some properties inside the files.

Note:When exporting files to a content package, the unique package ID is added to the script and
template files as a suffix (before the file extension) in the <SiteScope root
directory>\packages\imported\ directory, and under the relevant folder in the SiteScope root
directory.

4. Export the content package to a zip file using the Export Content Package
Wizard
Select the Templates context. In the template tree, right-click the template or template container that
you want to export to a content package, and select Export > Content Package.
In the Export Content PackageWizard, enter details of the content package (manifest), and select the
templates and extension files associated with themonitors that you want to include. ForWizard details,
see "Export Content PackageWizard" on page 714.

5. Share the template monitor with other SiteScope users
You can distribute a content package zip file by sending it to individual SiteScope users. Alternatively,
you can use the HPE Live Network (https://hpln.hpe.com/group/sitescope) community for sharing
templates and content packages with other users.
For details on publishing content packages to the HPE Live Network community, see "How to Publish
Content to the HPE Live Network Community" on page 759.
For details on downloading a content package to your SiteScopemachine, see "How to Download
Content from the HPE Live Network" on page 759.

6. Import a Content Package
a. In SiteScope, select the Templates context. In the template tree, right-click the template container

into which you want to import the content package, and click Import > Content Package.
b. In the Import Content Package dialog box, click Browse and navigate to the folder containing the

package you want to import (packages are distributed in zip format). Click Open, and then click OK.
For details, see "Import Content Package Dialog Box" on page 719.

Note:

o Content packages can contain any type of file from the predefined folders listed in step 3
above. If the content package contains any other folders, an error is displayed and the import

Using SiteScope
Chapter 62: Export and Import Templates and Content Packages

HPE SiteScope (11.33) Page 711 of 1206

https://hpln.hpe.com/group/sitescope


operation fails.
o Existing SiteScope files cannot be overridden by files from content packages. However,

templates (located in the <SiteScope root directory>\packages\imported\templates
folder) can be overridden if theOverride existing templates check box is selected in the
Content Import dialog box. For details, see "Template Import Dialog Box" on page 719.

o When importing templates to SiteScope that contain deprecatedmonitors from earlier
version of SiteScope, the deprecatedmonitors are not displayed in the template tree.

o When importing a content package that is too large (the package size limitation depends on
the user VM size), SiteScope displays an error and the path to the applet.logwhere the error
is written. Since the exception is thrown from the user interface side, each user can
encounter the exception in different package sizes.

o Do not edit imported files.

7. Verify the template extension files were imported successfully
Check that the template extension files were extracted from the content package and copied to the
relevant scripts and/or templates folder in theSiteScope root directory on the SiteScope file system
(folders have the same name as listed in step 3 above).

Note: Content packages that contain a template with no Custommonitors (for example, a template
with CPU monitor only), are no longer saved to the <SiteScope root
directory>\packages\imported folder. You can override this setting if necessary and save a copy
of the package by changing the property Save copy of content package with extended files only
to true inPreferences > Infrastructure Preferences > Custom Settings.

How to Enable Unicode Font When Exporting to a PDF
This task describes how to configure Unicode font to display characters that differ from the current locale
when exporting a report to a PDF. This also enables you to view text consisting of characters frommultiple
languages.

Note: If you are using amachine that has Microsoft Office installed, Arial UnicodeMS font is already
installed and you do not need to download or configure the font.

To configure Arial Unicode MS font using the font library:
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1. Navigate to the font library on the SiteScope server. For example:

Environment Font Library

AIX /usr/lpp/Acrobat3/Fonts

HPUX /usr/contrib/xf86/xterm/fonts

/usr/lib/X11/fonts/ms.st/typefaces

Linux /usr/share/fonts/truetype

/usr/share/fonts/local

UNIX /usr/openwin/lib/X11/fonts/TrueType

/usr/X11/lib/X11/fonts/TrueType

/usr/X11/lib/X11/fonts/Type1

Windows C:\Windows\Fonts

C:\WINNT\Fonts

2. Download the Arial UnicodeMS font into the selected font library. The font is available from
http://www.microsoft.com/typography/fonts/family.aspx?FID=24.

3. Restart SiteScope.

Content package import fails when exported with the same version. As a workaround, use '>=' instead of '=' in
the Supported SiteScope versions field (CreateManifest page of the Export Content Package wizard). Using
'=' in the Supported SiteScope versions field causes the import to fail.

Import/Export Content User Interface
This section includes:

l "Export Template Dialog Box" below
l "Export Content PackageWizard" on the next page
l "CreateManifest Page" on page 715
l "Select Templates Page" on page 716
l "Select Files Page" on page 716
l "Export Page" on page 717
l "Summary Page" on page 718
l "Template Import Dialog Box" on page 719
l "Import Content Package Dialog Box" on page 719

Export Template Dialog Box
This dialog box enables you to export templates for use in other SiteScope installations. This enables you to
replicate standardizedmonitor configurations across the enterprise. After exporting, the template still remains
in the template container.
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To access Select the Templates context. In the template tree, right-click the template container object
that contains the template or templates you want to export, and select Export.

You can also right-click a template in the template tree and click Export.

Important
information

l SiteScope templates are stored as binary data. This is different from the text-based
monitor sets used in earlier versions of SiteScope. Any changes to templates must be
performed using the SiteScope interface.

l The template export and import flow does not contain SNMP Trap Preferences.
Therefore, when exporting and importing a template that contains references to SNMP
trap preferences, you shouldmanually create these preferences, andmanually update
the SNMP Traps in the imported template.

Relevant
tasks

"How to Export and Import a Template" on page 704

See also l "CommonMonitor Settings" on page 242
l "Create Templates" on page 667
l "Export and Import Templates and Content Packages" on page 704
l "Template Tree" on page 37

User interface elements are described below:

UI
Element Description

File
Name

1. Click the File Name button to open the Save dialog box where you can browse and select
the location where you want to save the file for export.

2. In the File Name field in the Save dialog box, enter a name that is descriptive of the
template or templates to be exported.

3. Click Save to return to the Export Template dialog box. The path and file name you
selected are displayed in the File Name field in the Export Template dialog box.

Template
Tree

Select the templates you want to export.

Default value:No templates within the template container are selected.

Export Content Package Wizard
This wizard enables you to export one or more templates and their dependencies to a content package.
Content packages are required for sharing Custommonitors, or monitors with extension files like scripts, with
other SiteScope users. This enables you to replicate standardizedmonitor configurations across the
enterprise.

To access Select the Templates context. In the template tree, right-click the template or template
container that you want to export to a content package, and select Export > Content
Package.
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Important
information

l Only user-defined templates can be exported to content packages (imported templates,
solution templates, andMonitor Deployment Wizard templates cannot be exported to
content packages).

l To be able to export templates to content packages, youmust haveAdd, edit or delete
templates permissions. For details on user permissions, see "Permissions" on
page 636.

l The template container from which the export wizard is started, is designated as the root
container for the export. All ancestor containers of a selected template, up to and
including the root container, are exported with the template. A container which does not
have a descendant template cannot be exported. To export a template without any
container, start the export flow by right-clicking the template.

Relevant
tasks

l "Export Content PackageWizard" on the previous page
l "How to Create, Export, and Import a Template Extension Content Package" on
page 710

Wizard
map

This wizard contains:

"CreateManifest Page" below > ("Select Templates Page" on the next page) > "Select Files
Page" on the next page > "Export Page" on page 717 > "Summary Page" on page 718.

See also l "Create Content Packages" on page 703
l "Export and Import Templates and Content Packages" on page 704
l "Create CustomMonitors" on page 273
l "Share SiteScope Content on the HPE Live Network" on page 758
l "Template Tree" on page 37

Create Manifest Page
This wizard page enables you to create the content packagemanifest where information about the content
package is stored. This page is part of the Export Content PackageWizard. Refer to "Export Content
PackageWizard" on the previous page for important information on the wizard.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Name The name of the content package.

Description Description of the content package.

Provider URL The URL of the content package provider.

Provider company The company name of the content package provider.

Version The version of the content package.
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UI Element Description

Supported
SiteScope versions

The operating systems on which SiteScope should be installed in order to support
the content in the content package.

Select an operator (">=" greater than or equal to, or "=" equals) , and enter the
version number for determining the supported SiteScope versions required for the
content package.

Note:

l When using the "=" operator, you can enter multiple versions, separated with a
comma (",").

l The version numbermust consist of a minimum of 3 digits.
Example:

l 11.2 or 11.20 indicate that the content package is supported on SiteScope
11.2x versions.

l 11.12 indicates that the content package is supported on SiteScope version
11.12.

Supported
SiteScope server
operating systems

The operating systems on which the SiteScope server is supported.

Note:At least one operating systemmust be selected.

Default value:Windows and UNIX are selected.

Select Templates Page

Note: This page is available when selecting a template container only.

This wizard page enables you to select the user-defined templates to include in the content package. This
page is part of the Export Content PackageWizard. Refer to "Export Content PackageWizard" on page 714
for important information on the wizard.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<User-defined
templates>

The user-defined templates included in the content package.

By default, all available user-defined templates in the template container are
selected.

To clear the selection, click theClear Selection button.

Note: It is not mandatory to select any templates.

Select Files Page
This wizard page enables you to select the files associated with the selected templates to include in the
content package. This page is part of the Export Content PackageWizard. Refer to "Export Content Package
Wizard" on page 714 for important information on the wizard.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element Description

<SiteScope
files>

The files to include in the content package.

By default, all files from packages associated with the selected templates are selected. You
can add or remove files as required.

To clear the selection, click theClear Selection button.

To select all files, click theSelect All button.

Note:

l It is not mandatory to select any files.
l Only files from packages that you have created (under the <SiteScope root
directory>\packages\workspace directory) are displayed for selection, except the
contents of the \templates and \META-INF folders. Content from packages that you
have imported (under the <SiteScope root directory>\packages\imported directory)
cannot be exported and are not displayed.

l You cannot select files that have identical file names.
l If the filename of a file selected for exporting is not in ASCII characters, its namemight
be corrupted in the output zip file.

l Files selected from the \classes, \conf, or \lib folders from different packages are all
merged into the same \classes, \conf, and \lib folder in the exported content package.

l If you go back and select additional templates from the Select Templates page, files
associated with these templates are not selected by default in the Select Files tree; you
need tomanually select the files you want to include from the corresponding packages in
the content package.

l The following folders under <SiteScope root directory>\packages\workspace are also
displayed:
l \scripts

l \scripts.remote

l \templates.mail

l \templates.mail.subject

l \templates.mib

l \templates.os

Extension files you select from these folders are included in the exported content
package under a set of identically named folders.

Export Page
This wizard page enables you to select the name and location where you want to save the content package
file. It also enables you to review your selections in the previous pages. This page is part of the Export
Content PackageWizard. Refer to "Export Content PackageWizard" on page 714 for important information
on the wizard.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

File name Name and path of the content package file. You can either:

l Enter the path and name of the content package file, or
l Click theBrowse button, and select the location where you want to save the content
package file for export. In the File Name field in the Open dialog box, enter a name
that is descriptive of the content package to be exported, or select an existing file to
overwrite, and click Open. The path and file name you selected are displayed in the
File name field.

Note:

l Files are automatically saved in zip format. A '.zip' extension is automatically
appended to the file name by the wizard.

l The file path cannot end with a directory separator ('\' or '/'); a legal file name needs to
be appended to the path.

l Empty spaces and the following special characters are not supported in the file name:
\ " | > < ^

Manifest Displays the content package information that was entered in the CreateManifest page.

Selected
Templates

The templates to be included in the content package (selected in the Select Templates
page).

Selected
Files

The files to be included in the content package (selected in the Select Templates page).

Password You can protect the content package with a password. Type the password for the
package.

Confirm
Password

Retype the password to confirm.

Hide
Configuration
File

Select this option to hide the configuration file while exporting the content package.

Hide Script Select this option to hide the Data Processing Script while exporting the content package.

Export Exports the selected files to a zip file on the local file system.

Summary Page
This wizard page displays the status of the content package, and if the package is successfully created, it
provides a link to content package zip file. This page is part of the Export Content PackageWizard. Refer to
"Export Content PackageWizard" on page 714 for important information on the wizard.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element Description

<Summary> Reports the export status of the content package.

If the package was successfully exported, it displays a link with the name and path of the
zip file to which the content package was exported. Click the link to open the folder where
the export file was created.

If SiteScope was unable to export the content package, the reasons for failure are
displayed.

Template Import Dialog Box
This dialog box enables you to import template configurations from other SiteScope installations. This enables
you to replicate standardizedmonitor configurations across the enterprise.

To
access

Select the Templates context. In the template tree, right-click the template container into which
you want to import the template or content package, and click Import > Template.

Relevant
tasks

l "How to Export and Import a Template" on page 704
l "Share SiteScope Content on the HPE Live Network" on page 758

See also l "CommonMonitor Settings" on page 242
l "Create Templates" on page 667
l "Export and Import Templates and Content Packages" on page 704
l "Template Tree" on page 37
l "Share SiteScope Content on the HPE Live Network" on page 758

User interface elements are described below:

UI
Element Description

File
Name

The name of the template file to be imported.

Click theBrowse button to browse and select the location of the file you want to import.

Override
existing
templates

Select this option if you want templates from the imported template file to override existing
templates with the same name.

Note: If a template container in the template tree has the same name as the template
container from the imported file, selecting this option overrides the existing templates with the
same namewithin the container andmerges other templates from the imported file with
existing templates.

Import Content Package Dialog Box
This dialog box enables you to import content packages that may include one or more templates and their
dependencies from other SiteScope installation. Dependencies are additional files such as jars and
configuration files. When exporting a custommonitor, themonitor template and the additional jars used in the
script and other resources are packed into a content package. This enables you to replicate standardized
monitor configurations across the enterprise.
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To
access

Select the Templates context. In the template tree, right-click the template container into which
you want to import the template or content package, and click Import > Content Package.

Relevant
tasks

l "How to Export and Import a Template" on page 704
l "Share SiteScope Content on the HPE Live Network" on page 758

See also l "CommonMonitor Settings" on page 242
l "Create Templates" on page 667
l "Export and Import Templates and Content Packages" on page 704
l "Template Tree" on page 37
l "Share SiteScope Content on the HPE Live Network" on page 758

User interface elements are described below:

UI
Element Description

File
Name

The name of the content package file to be imported.

Click theBrowse button to browse and select the location of the file you want to import. Note
that the file browser displays zip files only. Content packages must contain at least one
template. Each template can contain various types of monitors; custom and regular.

For more details on content packages, see "Create Content Packages" on page 703.

Override
existing
templates

Select this option if you want templates from the imported content package to override existing
templates with the same name.

Note: If a template container in the template tree has the same name as the template
container from the imported file, selecting this option overrides the existing templates with the
same namewithin the container andmerges other templates from the imported file with
existing templates.

Using SiteScope
Chapter 62: Export and Import Templates and Content Packages

HPE SiteScope (11.33) Page 720 of 1206



Chapter 63: Deploy Templates
You use templates to rapidly deploy sets of monitors that check systems in the infrastructure that share
similar characteristics. After you create and configure templates, you deploy them in the SiteScope hierarchy.
You can deploy templates directly from the user interface, or you can deploy templates from an external
CommaSeparated Value (CSV) file.

To access
Select the Templates context. In the template tree, right-click a template, and select Publish Changes.

Learn About
Deploying Templates Overview
After creating a SiteScopemonitoring template, you can deploy templates to a group in the following ways:

l You can deploy a single template, or deploy multiple templates simultaneously to a group from the user
interface. For task details, see "How to Deploy Templates Using the User Interface" on the next page.

l You can perform mass deployments of a single template using a CSV file external to the SiteScope user
interface. A CSV file is better suited for performingmass deployments, since it is easier to enter and
update all the template variable values in one CSV file. For details, see "Deploy a Template Using a CSV
File" below

l You can deploy a template using an XML file external to the SiteScope user interface. For details, see
"Deploy Templates Automatically Using an XML File" on page 732.

l You can also deploy templates from theWeb user interface (Unified Console). For details, see "Manage
View" on page 955.

l When SiteScope is integrated with HPOM, you can centrally manage and deploy templates frommultiple
SiteScope instances from within HPOM. For details, see the section on Centralized Template
Management from HPOM in Integrating SiteScope with HP Operations Manager Products. You can check
the HPE Software Integrations site for the latest version of this guide.

If you subsequently want to make changes to the source template, you can automatically publish the changes
to SiteScope objects deployed by the template using the Publish Template Changes Wizard. For details on
updating templates, see "Publish Changes to Templates" on page 745.

Note:When deployingmonitors and groups using a template, monitor and group dependencies are also
published. This enables the template to automatically write the groups andmonitors into their proper
place in the tree and automatically create any number of dependencies, without you having to do this
manually. For details and recommendations, see "Dependencies When Configuring TemplateMonitors
andGroups" on page 222.

Deploy a Template Using a CSV File
After you create and configure templates, you deploy them in the SiteScope hierarchy. You can deploy
templates directly from the user interface (see "How to Deploy Templates Using the User Interface" on the
next page), or you can deploy templates from an external CommaSeparated Value (CSV) file. The CSV file is
used to deploy the variable values defined in the template.
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Advantages of using SiteScope CSV template deployment include:

l It is better suited than the user interface for performingmass deployments, since it is easier to enter and
update all the template variable values in one CSV file.

l You can perform multiple deployments at one time, without having tomanually enter variable values for
each deployment in the user interface.

l The template is deployed silently—the template deployment request is submitted to a queue and the
deployment is handled in the background. This enables you to continue to use SiteScope without having to
wait for the template deployment process to finish. All submitted requests and their corresponding
deployment results are logged to <SiteScope root directory>\logs\silent_deployment.log.

Note: Themaximum queue length for silent deployment is 2000 (each line in a CSV file represents
one deployment in the queue).

For details on how to perform this task, see "How to Deploy Templates Using a CSV File" on the next page.

Tasks
How to Deploy Templates Using the User Interface
This task describes the steps involved in deploying SiteScope templates using the user interface.

Tip:

l Formass deployments of a single template, you can also deploy templates using a CSV file. For
concept details, see "Deploy a Template Using a CSV File" on the previous page.

l You can also deploy templates from theWeb user interface (Unified Console). For details, see
"Manage View" on page 955.

l You can also deploy and update the template using an XML file external to the SiteScope user
interface. For topic details, see "Deploy Templates Automatically Using an XML File" on page 732.

1. Prerequisites
l Create a SiteScopemonitoring template or select an existing user-defined template from the
templates tree. For task details, see "How to Create aMonitoring Structure Using a Template" on
page 677.

l If you intend to deploy monitors to multiple servers at the same time, youmust use a variable as the
Host value for the template remote server. On deployment, specify multiple server names separated
by commas (",") for the host variable.

2. Deploy a single template - optional
a. Deploy the template to a group.

o From themonitor tree, right-click the group into which you want to deploy the template, and select
Deploy Template. In the Select Template dialog box, select the template you want to deploy. For
user interface details, see "Select Template Dialog Box" on page 270.

o From the template tree, right-click the template you want to deploy, and select Deploy Template.
In the Select Group dialog box, select a group into which you want to deploy the template.
Alternatively, you can click theNew Group button and create a new group to which you can
deploy the template. For user interface details, see "Select Group Dialog Box" on page 726.
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b. In the Deployment Values dialog box, enter the required variable values in the entry boxes displayed.
The entry boxes displayed correspond to the template variables used in the template objects. For
user interface details, see "Deployment Values Dialog Box" on page 728.

Example:

If you deploy theWindows basic template from the Template Examples folder in the template
tree to a SiteScope group, the following entry boxes are displayed in the Deployment Values
input window.

3. Deploy multiple templates - optional
a. From the template tree, right-click any template container, and select Deploy Template. In the

Select Group dialog box, select a group into which you want to deploy the templates. Alternatively,
you can click theNew Group button and create a new group to which you can deploy the template.
For user interface details, see "Select Group Dialog Box" on page 726.

b. In the Deploy Multiple Templates dialog box, perform the following:
o In the left pane, select the templates that you want to deploy to the group. If you select a template

container, all templates within that container are automatically selected.
o In the right pane, enter the required variable values in the entry boxes displayed.
o Below the variable values section in the right pane, configure the permanent options for all the

templates being deployed.
For user interface details, see "Deploy Multiple Templates Dialog Box" on page 727.

4. Results
A summary of the template deployment is displayed. If the deployment is successful, the template
objects are added to themonitor tree.
If a template deployment fails, a message displays reasons for the failure. A templatemonitor might fail
to deploy, for example, in the case of a Disk Spacemonitor, if the disk drive specified in the template
does not exist on the deployed server.

How to Deploy Templates Using a CSV File
This task describes the steps involved in deploying a SiteScope template using a CSV file.

Tip:

l Alternatively, you can deploy templates using the user interface. For details, see "How to Deploy
Templates Using the User Interface" on the previous page.

l You can also deploy templates using a CSV file from theWeb user interface (Unified Console). For
details, see "Manage View" on page 955.

l You can also deploy and update the template using an XML file external to the SiteScope user
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interface. For details on this topic, see "Deploy Templates Automatically Using an XML File" on
page 732.

1. Prerequisites
l Create a new SiteScopemonitoring template or select an existing user-defined or solution template
from the templates tree. For task details, see "How to Create aMonitoring Structure Using a
Template" on page 677.

l To deploy a solution template using a CSV file, youmust first make a copy of the solution template to
a template container, and thenmake the changes required in the steps below to the copied template.

l Make sure that the template group name has a unique value in each deployment instance. You can do
this by using a variable in the group name, and entering a different variable value in each deployment.
You can see an example of this in the Template Examples folder where the group name inWindows
basic template contains the %%host%% variable.

2. Check the template variable display order
Before creating a CSV file, check the template variable display order for each variable. The column order
in the CSV file starts from 0, somake sure the template variable display order also starts from 0 (instead
of 1). This is to ensure that the correct columns from the CSV file aremapped to the variables on
deployment.
To check the template variable display order:
a. Select the Templates context. In the template tree, expand the template container that contains the

template that you want to deploy using a CSV file, and select the template.
b. Select the template variable you want to display first when deploying the template, and check that

theDisplay order in template value is 0.
c. Repeat for each variable in the template, making sure that the correct display number is used

(incremented by 1 each time).

Note: Theremust be a display order defined for each variable, otherwise the deployment fails.

3. Create the CSV File
Open a new text file, and perform the following:
a. Type a variable value for each variable necessary in the deployment, separated by a comma (",").

Youmust be familiar with all the variables defined for the template. Enter values in the order that they
are set to be displayed in theDisplay order in the template field (starting from the variable with
display order 0).

b. Add variable values on a separate line for each deployment instance.

Note:

o Spaces are considered part of a field and should not be ignored.
o You do not need to type non-mandatory variables or default variable values in the CSV file.

Instead, type a comma followed by a comma (",,") to represent the variable value. However,
if the deployment of onemonitor fails, then the template deployment also fails.

o If you want to use a comma in a variable value, for the comma to be handled correctly, you
must type \, otherwise the comma is handled as a new variable. For example, to deploy an
LDAP monitor template with ou=Joe,cn=test,dc=com, type ou=Joe\,cn=test\,dc=com.
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o If you want to use a backslash in a variable value, for the backslash to be handled correctly,
youmust type \\ otherwise the backslash will be skipped. For example, to deploy a file
patch tomonitor template with c:\file.txt, type c:\\file.txt.

o When using credentials, we only recommend using a variable for the credential name, since
passwords cannot be encrypted in the CSV file.

c. Save the file in CSV format. After the template is deployed, a group is created for each line in the
CSV file.

Example:

To deploy theWindows basic template using a CSV file, make sure that the display order for
the variables is set as follows: host (0), user (1), password (2), and frequency variables (3). The
host template variable settings are displayed below.

Then create a CSV file and enter host, user, password, and frequency values separated by a
comma, for each deployment instance (this is the variable display order used in the template).

You do not need to enter a value in the CSV file for the Frequency variable (even though it is a
mandatory variable), because a default value has been set for this variable in the template
(provided you want to use the 600 seconds default value).

4. Deploy the template
a. After creating a CSV file for the template, deploy the template to a group.

o From themonitor tree, right-click the group into which you want to deploy the template, and select
Deploy Template Using CSV. In the Select Template dialog box, select the template you want
to deploy. For user interface details, see "Select Template Dialog Box" on page 270.

o From the template tree, right-click the template you want to deploy, and select Deploy Template
Using CSV. In the Select Group dialog box, select a group into which you want to deploy the
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template. Alternatively, you can click theNew Group button and create a new group to which you
can deploy the template. For user interface details, see "Select Group Dialog Box" below.

b. In the Select CSV File dialog box, select the CSV file to use for template deployment. For user
interface details, see "Select CSV File Box Dialog Box" on page 730.

5. Results
If the deployment is successful, the template objects are added to themonitor tree. Themonitor tree
updates itself periodically. Click Refresh in the tree toolbar to update the tree and check your
deployment.
You can also check the silent_deployment.log file for a summary of the deployment. For user interface
details, see "Log Files Page" on page 1018.

Note: Typed password values are not displayed in the log file, and instead of the real password, you
see a sequence of asterisks ("****").

Related tasks (from theWebUI - Unified Console): "How to Deploy Monitors from a Template (Application
Owner)" on page 959.

Tips/Troubleshooting
Notes and Limitations
l Template deployment fails if a template contains multiple groups with the same name, even if each group
has a different parent group.

l Multiple deployments of a template in the same directory fails if the template group name does not include
a variable, because the group name is not unique.

l When deploying a template that uses regular expressions for monitor counters, theVerify monitor
properties with remote server optionmust be selected, otherwise themonitor deployment fails.

Deploy Templates User Interface
This section includes:

l "Select Group Dialog Box" below
l "Deploy Multiple Templates Dialog Box" on the next page
l "Deployment Values Dialog Box" on page 728
l "Select CSV File Box Dialog Box" on page 730

Select Group Dialog Box
This dialog box enables you to select a group in themonitor tree to which you can deploy templates.
Alternatively, you can select the SiteScope node, and create a new group to which you can deploy templates.

To
access

Select the Templates context. In the template tree, right-click the template you want to deploy,
and select Deploy Template orDeploy Template Using CSV.
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Relevant
tasks

l "How to Create aMonitoring Structure Using a Template" on page 677
l "How to Publish Template Updates to Related Group Deployments" on page 746
l "How to Deploy a SiteScope Solution Template" on page 767

See also l "Publish Changes to Templates" on page 745
l "Template Tree" on page 37

User interface elements are described below:

UI
Element Description

Represents the SiteScope root group. You can deploy the templates in the SiteScope root
group, or click theNew Group button and create a new group to which you can deploy the
templates.

Represents a SiteScopemonitor group or subgroup (with enabledmonitors/with nomonitors or
no enabledmonitors). Select the group to which you want to deploy the templates, or click the
New Group button and create a new group in which you can deploy the templates.

Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScopemonitors.

Deploy Multiple Templates Dialog Box
This dialog box enables you to select multiple templates for deployment to a group simultaneously (instead of
deploying each template separately).

To access Select the Templates context. In the template tree, right-click any template container and
select Deploy Template. In the Select Group dialog box, select the group in which you want
to deploy the templates and click OK. The Deploy Multiple Templates dialog box opens.

Important
information

l To deploy monitors to multiple servers at the same time, enter the server names or
addresses separated by a comma (","). When doing this, the value in theHost property
for the template remote server referenced by themonitors must consist of a variable
value, and only one variable is allowed.

l You can deploy a template, regardless of its content, provided you have edit permissions
on the deployment target group. You do not require edit permissions on the template
objects such as monitors, remotes, and alerts.

l An error message is displayed if a monitor cannot be deployed. This may occur, for
example, when deploying the Disk Spacemonitor template, if the disk drive does not
exist on the deployed server.

Relevant
tasks

l "How to Create aMonitoring Structure Using a Template" on page 677
l "How to Deploy Templates Using the User Interface" on page 722
l "How to Publish Template Updates to Related Group Deployments" on page 746

See also l "Publish Changes to Templates" on page 745
l "Template Tree" on page 37

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element Description

Select Templates (left pane)

<template
tree>

Select the templates that you want to deploy from the template tree.

l When you select a template container, all templates within that container are selected. If
you select the SiteScope root, all templates in the template tree are selected.

l The icon displayed to the left of the SiteScope root or a template container indicates
that not all templates within SiteScope or the specific container have been selected.

Template Deployment Settings (right pane)

<template
variable
values>

A list of variables used in each selected template is displayed under a label with the full path
of the corresponding template in the right pane. Enter deployment values for the variables
(variables that aremandatory are denoted by a red asterisk).

Silent
deployment

Submits the template deployment request to a queue. SiteScope handles the deployment in
the background, enabling you to continue to use SiteScope without having to wait for the
template deployment process to finish. All submitted requests and their corresponding
deployment results are logged to <SiteScope root directory>\logs\silent_
deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in each template against the
remote servers on which the templates are being deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote servers after the templates have
been deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected

Deployment Values Dialog Box
This dialog box enables you to enter variable values when deploying the template.

To access Select the Templates context. In the template tree, right-click the template that you want to
deploy (it must contain variables), and select Deploy Template. In the Select Group dialog
box, select the group in which you want to deploy the template and click OK. The
Deployment Values dialog box opens.
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Important
information

l To deploy monitors to multiple servers at the same time, enter the server names or
addresses separated by a comma (","). When doing this, the value in theHost property
for the template remote server referenced by themonitors must consist of a variable
value, and only one variable is allowed.

l You can deploy a template, regardless of its content, provided you have edit permissions
on the deployment target group. You do not require edit permissions on the template
objects such as monitors, remotes, and alerts.

l An error message is displayed if a monitor cannot be deployed. This may occur, for
example, when deploying the Disk Spacemonitor template, if the disk drive does not
exist on the deployed server.

Relevant
tasks

l "How to Create aMonitoring Structure Using a Template" on page 677
l "How to Deploy Templates Using the User Interface" on page 722
l "How to Publish Template Updates to Related Group Deployments" on page 746

See also l "Publish Changes to Templates" on page 745
l "Template Tree" on page 37

User interface elements are described below:

UI Element Description

Variable Values

For details of deployment values for SiteScope solution templates, see the documentation for the specific
solution template ("Deploy Solution Templates" on page 762).

<variable
name>

Each variable that is referenced in a template object prompts the display of a
corresponding entry box when the template is deployed. The variable name is used as
a label for the text entry box. Enter deployment values for the variables.

For details on configuring and deploying a specific SiteScope solution template, see
the help for the specific solution template in "Deploy Solution Templates" on page 762.

Silent
deployment

Submits the template deployment request to a queue, and have SiteScope handle the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests
and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected
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UI Element Description

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is being deployed.

Note:

l When this option is selected, deployment time is slowed due to the remote
connection.

l When deploying a template that uses regular expressions for monitor counters, this
optionmust be selected, otherwise themonitor deployment fails.

l When deploying a template for a customizable monitor, clearing this check box has
no effect, since themonitor configuration properties in the templatemust be
checked against the remote server on which the template is being deployed.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the template has
been deployed. The test is performed in the background, enabling you to continue to
use SiteScope.

Note: This option is displayed only when deploying a template that includes a remote
server.

Default value:Not selected

Select CSV File Box Dialog Box
This dialog box enables you to select the CSV file to use when deploying a template.

To
access

Use one of the following:

l Open the Templates context. In the template tree, right-click the template you want to
deploy, and select Deploy Template Using CSV. In the Select Group dialog box, select
the group to which you can deploy the template, and click OK.

l Open theMonitors context. In themonitor tree, right-click the group to which you want to
deploy the template, and select Deploy Template Using CSV. In the Select Template
dialog box, select the template that you want to deploy, and click OK.

Relevant
tasks

l "How to Create aMonitoring Structure Using a Template" on page 677
l "How to Deploy Templates Using a CSV File" on page 723

See also l "Publish Changes to Templates" on page 745
l "Template Tree" on page 37
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User interface elements are described below:

UI Element Description

CSV file CommaSeparated Values (CSV) file to use for deploying the variable values
defined in the template. Click theSelect button, and select a CSV file to use for the
template deployment.

Note:You can only use a file with a CSV extension.

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template
against the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection to the template remote server after the template has been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Note: This option is displayed only when deploying a template that includes a
remote server.

Default value:Not selected
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Chapter 64: Deploy Templates Automatically
Using an XML File
SiteScope enables you to create an XML file to use for automatically deploying SiteScope template or solution
template in a highlighted template container. After you generate the XML file, you can edit the file and use it to
deploy the templates from the file directory external to the SiteScope user interface.

To access
Select the Templates context. In the template tree, right-click the template container for which you want to
create an auto deploy XML file, and select Generate XML.

Learn About
Deploying Templates Automatically Overview
SiteScope enables you to create an XML file to use for automatically deploying the templates in the
highlighted template container. After you generate the XML file, you can edit the file and use it to deploy the
templates from the file directory not in the SiteScope user interface.

SiteScope enables you to automatically deploy a SiteScope template or solution template using an XML file
external to the SiteScope user interface. The XML file is used to deploy the objects defined in the template,
whichmust include a parent group and can include subgroups, monitors, a remote server, alerts, and variable
definitions. You can edit the XML file to assign variable definitions for mandatory, global, and instance
variables.

For details on user-defined templates, see "Create Templates" on page 667. For details on predefined solution
templates, see "Deploy Solution Templates" on page 762.

You can also use the auto template deployment to publish template changes to deployed groups. The auto
template deployment uses the same functionality as the Publish Template Changes Wizard. For details on
how the wizard works, see "Publish Changes to Templates" on page 745.

Auto template deployment is an alternative to using the user interface to deploy templates and publish
template changes to deployed groups. It is better suited than the user interface for working with scripts and
deploying ontomultiple SiteScopes. This is because it uses standard XML scripting and can be deployed onto
multiple SiteScopes using one file.

Create and Work with the XML File
Use one of the following options to create the XML file:

l Generate and edit your XML in any tool that supports text. The file must be based on the XSD file supplied
in the SiteScope file directory. The XSD file is a basic XML file which already includes the appropriate
tags, elements, and attributes for creating your own version of the deployment XML.

l Generate the deployment XML file using the SiteScope interface from a template container or solution
template. Each template container and solution template includes the option to generate this auto template
deployment XML file. For details, see "Generate Auto Deployment XMLUser Interface" on page 737.
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The XML you use, whether generated from the template or solution template, or generatedmanually, must be
a valid XML andmatch the ATD schema (XSD). You can use the dedicated tool to validate your XML file.

Deploying the XML file is dependent on the target SiteScope having the relevant template or solution template
in its monitor tree. You deploy the template or solution template by copying the XML file into the persistency
folder of the target SiteScope with the relevant template or solution template. You can group several
deployments into a single XML file.

Publish Template Changes Using the XML
You can also use the auto template deployment XML to publish template changes to update the values or
structure of a deployed group. If the group's Source Template field is identified as the same template that the
XML is referencing, you can update the values and objects of the group using the auto template deployment
XML.

The XML uses the same functionality as the Publish Template Changes Wizard but without having to access
the user interface. In the XML file, you can identify values for variables to use for publishing the changes in the
template. For details on the wizard and the template update feature, see "Publish Changes to Templates" on
page 745.

You can use auto template deployment to publish the changes made to a template onto the template's
deployed groups in the sameway you use the XML to create a group deployment. After the template has been
modified, you create the XML and copy/paste the edited XML into the persistency folder of the target
SiteScopemachines.

Update Deployment XML Tag Details

The XML file for updating the values or objects of a deployed groupmust use the
<sitescope:templateDeploymentUpdate> tag (and not the <sitescope:templateDeployment> tag used for
deploying the template). For details on the elements and attributes to use in the XML file, see "XML Tag
Reference" on page 742.

Within the <sitescope:templateDeploymentUpdate> tag, you can select to give the
enableDeleteOnUpdate attribute a value of yes to make sure that any objects within the deployed groups
that do not appear in the template referenced by the auto template deployment XML are deleted when updating
the deployment with the XML file. Enter a value of no to make sure that all objects within the group are
retained, even if they do not appear in the template referenced by the XML file, after the updating the
deployment. For details on this option in the Publish Template Changes Wizard, seeEnable delete on
update in the "Select DeployedGroups Page" on page 751.

To successfully perform the update, youmust define the target SiteScope group name of the deployed group
as the value of the deploy:fullPathToDestinationGroup tag. The fullPathToDestinationmust end with the
root group of the deployment, the equivalent of the template's root group. Each deployment section updates
one group so if you havemultiple groups, youmust define separate deployment update sections for each and
define the group name for each.

Template Update Report

After performing the auto template deployment update, a report is available in XML format. The report file is
namedwith the name of the XML file along with a time stamp and the string_reports. These reports are
available in the following location: <SiteScope root directory>\persistency\autodeployment\reports.

The report is in XML format and includes the following tags at the beginning:

l totalNumberOfDeployments
l totalNumberOfFailedDeployments
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l totalNumberOfSucDeployments
The <publishChangesSummaryPage> section of the XML appears for each deployment instance listing the
details of what has been updated. Unsuccessfully changed deployments are specified first in the file.

This file is an XML version of the PDF file created by the Publish Template Changes Wizard if using the
SiteScope user interface to update deployed groups. For details on the report, see "Publish Template
Changes Summary Report" on page 755.

Tasks
How to Deploy a Monitoring Structure Using an XML File
This task describes how to perform an auto template deployment. You can follow the same steps for
deploying a Solution Template.

1. Prerequisites
Each SiteScope into which you want to automatically deploy a templatemust include the template within
a template container. The templatemust have a group object at the top level. All other objects must be
created within that group. The template can contain subgroups, monitors, alerts, one remote server, and
variables.
If you are working with multiple SiteScopes:
l You can create the template in one SiteScope and export it to other SiteScopes using the
Export/Import options in the Template containers context menu. For task details, see "Export
Template Dialog Box" on page 713 and "Template Import Dialog Box" on page 719.

l If you are working in APM, you can copy templates from one SiteScope to another using the Sync
SiteScopeWizard in SAM Administration. For user interface details, see Sync SiteScopes Wizard in
the APM Application Administration Guide in the APMHelp.

2. Create the XML file
You can create the XML file using one of these options:
l Right-click the template container and select Generate XML in the context menu. When deploying
solution templates, this option appears at the template level. For user interface details, see "Generate
Auto Deployment XMLUser Interface" on page 737.

l Create the XML file using a dedicated XML application. The file must be a valid XML file and based on
the XSD files located in the following directories:

o <SiteScope root directory>\conf\xsds\deploy.xsd
o <SiteScope root directory>\conf\xsds\sitescope.xsd

3. Edit the XML file
Youmust edit the XML file to enter the values necessary for deployment. For details on editing the file
and a sample of the file, see "XML File Example and Variables" on page 739.
For details on the XML file's tags, see "XML Tag Reference" on page 742.

Note: If the XML is generated from the user interface, mandatory variable fields are generated based
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on the templates mandatory variables. If you create the XML file, and there are fields that are
mandatory for successful deployment, youmust make sure that these fields have been assigned
values before deploying the XML.

4. Specify login details (mandatory if working in a secure environment)

If you are working in a secure environment, youmust give a valid user name and password for each
deployment. Login credentials can also be used in the audit.log file to track the identity of users making
template changes.
l By default, theAccess controlled property is set to true inPreferences > Infrastructure
Preferences > Custom Settingswhichmeans that SiteScope is used in securemode. To use auto
template deployment when SiteScope is in securemode, youmust add the following string to your
generated XML file on the SiteScopemachine for each deployment (after
</deploy:fullPathToDestinationGroup>):
<deploy:login user="<myUserName>" password="<myPassword>" />

Use the encryption tool and follow the steps in the procedure for encrypting the user name and
password. For details, see the next step.

l If you use a non-secure environment, this string should look like:

<deploy:login user="" password="" />

l If you set Access controlled to false, you can use auto template deployment without adding the
string to your XML file, and it will pass successfully regardless of whether you are using a secure
environment.

Note: XML files generated in earlier versions of SiteScope are supported, provided that you add
the login when working in a secure environment.

5. Encrypt fields such as passwords - optional
Use the encryption tool for deploying templates that include fields that you do not want to appear in
viewable text. This tool encrypts the field only in the XML; the templates themselves control the
encryption of variables in the persistency directory.
a. Run the following batch file:

o ForWindows: <SiteScope root directory>/tools/AutoDeployment/encrypt_password.bat
o For UNIX: <SiteScope root directory>/tools/AutoDeployment/encrypt_password.sh

b. Open a command prompt window.
o InWindows, drag and drop the file into your command prompt window.
o In UNIX, youmust run the .sh file from its directory.

c. Enter space and the password value (for example Mypassword). Click ENTER.
d. Use the returned string as a value for the encrypted variable in the XML file. Youmuch change the

value of the attribute encrypted to yes and the value of the variable attribute to the returned string.
For example, the following value was generated by the encryption tool: <deploy:variables
encrypted="yes" name="password" value="(sisp)d5JLOSWaVfE="/>

6. Validate the XML file
We recommend validating the XML file before it is deployed. If the XML file does not pass validation
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when attempting to deploy, the deployment fails.
Use the validation tools located in the following directories:
l ForWindows: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.bat

l For UNIX: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.sh

For concept details, see "XML Validator" on page 742.

7. Copy the validated XML to the SiteScope server machines
Copy the XML file into the \persistency\autodeployment directory on each SiteScopemachine where
you want to deploy the templates in the XML.
The templates are automatically deployed every twominutes by default. You can change the frequency
in Infrastructure Preferences > Custom Settings in theAuto Deployment Check Frequency
(seconds) field.

8. Check if deployment was successful
When you copy the XML file, for both deploying and updating, into the persistency folder of the target
SiteScope, the file is copied into one of two directories as follows:
l <SiteScope root directory>\persistency\autodeployment\successHistory directory includes
those XML files that deployed or updated successfully all instances of the deployed group.

l <SiteScope root directory>\persistency\autodeployment\failHistory directory includes those
XML files that failed to deploy or update any instance of the deployed group. If even one instance
failed and all the others succeeded, the XML is published to this folder.

The XML file name is changed to include an underscore and a timestamp added to the original name of
the XML file. For example the XML file named CPUgroups.XML that succeeded in deploying all its groups
and instances is saved to the <SiteScope root
directory>\persistency\autodeployment\successHistory directory and is now named CPUgroups_
1203951216931.xml.
You can also check the SiteScope's Error Log.

How to Update a Deployment
This task describes how to use the auto template deployment XML to update an existing, deployed group. You
can update the structure of the deployment if the template was changed or update object properties by giving
new values to the variables that are declared in the template for those properties.

This task follows the same steps as the previous task to deploy a template with the exceptions and additional
information listed in the steps below.

1. Prerequisites
TheSource Template field of the deployed groups that you want to updatemust be identical to the
template in the XML deployment update file. This is in addition to the updated template existing in the
target SiteScope.

2. Create and edit the XML file to update objects and values
Whenworking with the XML file, youmust do the following:
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l Use the <templateDeploymentUpdate> tag instead of the <templateDeployment> tag.

l Enter a yes or no value for the enableDeleteOnUpdate attribute of the
<templateDeploymentUpdate> tag.

l Define the deploy:fullPathToDestinationGroup tag with the group name to be updated as the value
for this tag.

For details on these tags and the update XML file, see Update Deployment XML Tag Details in "Publish
Template Changes Using the XML" on page 733.

3. Copy the publish template update XML to the target SiteScopes
Copy the publish template update XML to the target SiteScope's persistency directory as you would
when deploying the auto template deployment XML file.

4. Encrypt text such as a password - optional
For task details, see the encryption step in "How to Deploy aMonitoring Structure Using an XML File" on
page 734.

5. Validate the publish template update XML
Use the validator tool to validate the edited XML file as you would when deploying the auto template
deployment XML file.

6. Results report
After deploying the update auto template deployment XML, a results report file is created in XML format.
These reports are available in the following location: <SiteScope root
directory>\persistency\autodeployment\reports.
For user interface details, see Template Update Report in "Publish Template Changes Using the XML"
on page 733.

UI Descriptions
Generate Auto Deployment XML User Interface
User interface elements are described below:

UI
Element Description

File
Name

Name of the XML file to create. This is the file you can edit and use to automatically deploy the
templates in this template container.
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UI
Element Description

Path Location in which the XML file is saved. Accept the default location, or enter a different
location. If the path is empty, the XML file is saved to the root drive where SiteScope is
installed.

Default value: <SiteScope_install_path>\SiteScope\persistency\
autodeployment\drafts

Note: If an XML file has been generated previously using the same File Name andPath, the
previously saved XML file is not overwritten. The previous file is renamedwith the following
addition: _bck<number of backup>. For example, if you enter CPUtemplate as the File
Name and accept the default location, the existing file in the default folder becomes
CPUtemplate.xml_bck1 and the current XML file being generated is saved as
CPUtemplate.xml.

Template
Tree

Templates for which to create the XML file. The XML file's contents are based on the objects in
the template you select. For each template selected, the generated XML includes a separate
deploy section.

Tips/Troubleshooting
Note: All notes, limitations, and troubleshooting issues that apply to SiteScope templates, solution
templates, and the Publish Template Changes Wizard also apply to the functionality of the auto template
deployment.

This section describes troubleshooting and limitations when working with auto template deployment.

l "User-Defined Templates" below
l "Publishing Template Changes to DeployedGroups Using XML" on the next page
l "Solution Templates" on the next page
l "I18N Users" on the next page
l "Characters Not Permitted in XML" on the next page

User-Defined Templates
l Unable to Automatically Deploy Template with NoGroups.
Problem: If you attempt to automatically deploy a template using an XML file where the template has no
parent group defined (that is to say, the template has monitors directly under the root template), the
deployment fails and the following error is written to the <SiteScope root directory\logs\>error.log file:
[Autodeployment new XML detection] (XMLAutomationParser.java:294) ERROR -
Prerequisites of template structure are unmet. Template must be rooted by only one
group.

Note that Automatic deployment fails even if Allow creation of template monitors directly under a
template entity is selected inPreferences > Infrastructure Preferences > Template Settings.
Workaround:Deploy the templatemanually (right-click the template in the Template tree, and then select
Deploy Template).
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l Other Issues Related to SiteScopeTemplates.
For other issues related to SiteScope templates, see Troubleshooting SiteScope Templates.

Publishing Template Changes to Deployed Groups Using XML
For limitations on using the auto template deployment XML to update an existing deployment, see "Publishing
Template Changes: Troubleshooting and Limitations" on page 750.

Solution Templates
You cannot perform auto template deployment for the following Solution Templates because the variables in
these solution templates are dynamically created and cannot be given a value in the XML file:

l JBoss Application Server 4.x
l WebLogic Application Server
l WebSphere 5.x Application Server
l WebSphere 6.x Application Server

I18N Users
l Do not edit the XML file using Notepad. The file cannot be parsed because Notepad adds an extra
character to the beginning of the file. This character is not visible but prevents the file from being parsed
when not in English. UseWordpad or an XML editor instead.

l If the path to the SiteScope root directory includes non-English characters, the validation tool cannot be
used to validate the XML before it is copied to the SiteScope's persistency directory. This means that
there is no validation that the XML follows the XSD or that mandatory fields have values.

Characters Not Permitted in XML
Avoid using the ampersand (&), quotemarks ("), and angle brackets (< >) characters, as they are not
permitted in XML attribute values.

To escape illegal XML characters, use a common encoding, (for example, &amp; instead of &), or enclose the
character with the CDATA (character data) section. Information on XML escape sequences is available from
many publicly available web sites.

XML File Example and Variables
For a reference detailing all the XML tags, elements, and attributes included in the auto template deployment
file, see "XML Tag Reference" on page 742.

Each auto template deployment XMLmust begin with the following declarations:

l <?xml version="1.0" encoding="UTF-8" ?> This states that this is an XMLwith UTF-8 character
encoding.

l <sitescope:sitescopeRoot ...> This is the schema declaration. Despite the URLs mentioned, this does
not try to connect to any location outside of your SiteScope at any time.

Each section of the XML file begins with one of the following tags, with the instruction to perform one of the
following actions:

l <sitescope:templateDeployment> Deploys a template or solution template. You can havemultiple
instances within the same XML file.

l <sitescope:templateDeployUpdate> Publishes changes to an existing deployment.
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Within each action, youmust specify the following:

l <deploy:fullPathtoTemplate> The path to the template within the SiteScope tree in the user interface,
not including the SiteScope root node. In the XML file example, this value is Templates/Windows.

l <deploy:fullPathToDestinationGroup> The path, within the SiteScope tree, of the target group on which
the action is performed. For example, in the XML file example, any template group objects are created as
subgroups within the following group SiteScope/Windows_Monitors.

This section contains the following topics:

l "XML File Example" below
l "Variables" below

XML File Example
Here is an example of the auto template deployment XML file. This file was generated from the user interface.

Variables
After the template and destination have been specified, the next section of the XML file deals with the
template variables and values. The XML file gives you the flexibility of defining variables and their values,
declaringmandatory variables, and determining if their corresponding values should be applied globally across
the deployment or per instance.

If you generated the XML file from the user interface and if a variable has a defined value, that value is
assigned to the variable in the XML file.
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Mandatory Variables
A declaration of any mandatory variables in the template appears in the <deploy:mandatoryFields> tag. If a
variable is declaredmandatory, a corresponding value for the variable must be defined in the in the file.

If you generated the XML from the user interface and if theMandatory option was selected when creating or
editing a variable, that variable appears in the <deploy:mandatoryFields> tag. You can alsomanually add a
variable name to this list to declare it mandatory.

In the file example above, group and frequency have been defined as mandatory variables. Values for
these variables must appear within the <deploy:variables> tags for either the <deploy:globalVariables> or
the <deploy:templateInstanceDeployVariables>.

Global Variables or Instance Variables
The optional <deploy:globalVariables> tag includes the default global template variables for the
deployment. Defining global template variables is optional. When you define a global template variable, you
can overwrite the variable's value by identifying a different variable value in the deployment instance area of
the file (<templateInstanceDeployVariables> tag). Global variable values can be overwritten with a different
value in each deployment instance.

Multiple instances of a template that are deployed into the same location onto the same SiteScope, as seen in
the XML file example, must include a variable for the group name. Group namemust bemade amandatory
variable and given a different value in each deployment instance. The group template object must have the
same variable defined as its value. The template could include other groups whose name value is not a
variable and those groups would be deployed once.

In the XML file example above, there are two instances of the deployment, so a variable called group has
been defined as mandatory and a different value has been given to it in each instance deployment (Critical_
monitors and Minor_monitors). This results in two groups created under the group object of the template
with the samemonitor objects.

The following groups would result from the XML file example being deployed:

l SiteScope/Windows_Monitors/Critical_monitors in the first instance of the deployment.
Included in this group would be any monitors and alerts defined in the template. Any of the template
monitor objects whose frequency value was defined as the variable frequencywould have a value of 600
seconds (every 10minutes).

l SiteScope/Windows_Monitors/Minor_monitors in the second instance of the deployment.
Included in this group would be any monitors and alerts defined in the template. Any of the template
monitor objects whose frequency value was defined as the variable frequencywould have a value of 6000
seconds (every hour and forty minutes). The connectToServer="no" attribute was added to this group.
This means that themonitor configuration properties in the template will not be verified against the remote
server on which the template is deployed.

The XML file example also contains a login with a user name and password (<deploy:login
user="admin99" password="(sisp)n9JRVALxIsq=" />). It is mandatory to specify a valid user name and
password for each deployment when using a secure environment. You can use the encryption tool to encrypt
the user name and password.

Note: If you have any system variables defined in a template (those defined by $$ and not %%), they are
treated as normal variables in the auto template deployment XML file. The same limitations that apply to
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using system variables in templates apply to using them in the XML file.

XML Validator
The XML validator is a utility that validates the XML file against the schemas used by the auto template
deployment. It does not validate the SiteScope deployment itself. The path to the validator file is:

l ForWindows: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.bat
l For UNIX: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.sh
This utility checks the structure of the XML against the XSD files tomake sure that the contents of the file are
valid XML and correspond to the XSD. It also validates that there have been values defined for all mandatory
variables. The values can be defined either as global variables or deployment instance variables. If the
validation fails, the reason for the failure is printed to screen.

XML Tag Reference
The following tables list all the elements and attributes used in the auto template deployment XML files:

l "Elements Table" below
l "Attributes Table" on the next page

Elements Table

Elements Description

sitescope:sitescopeRoot This must be the first tag in the XML file giving the instruction to create the
deployment, the version of XML used, and the location of the XSD file.

Note: This is the first element in all XML files related to SiteScope.

sitescope:template
Deployment

This tag enables the deployment of the template or solution template, creating
new group structures in the target SiteScope. This is the default tag used in
the XML file when generated from the user interface.

sitescope:template
DeploymentUpdate

This tag enables publishing the changes of a template that has been updated.
These changes can be applied to themonitoring structure of a group whose
Source Template field matches the template identified in the XML. The XML
file also enables you to update the values of the variables used in the
template.

For example, if you want to add alerts or an additional monitor to an existing
group that was created by a template, you canmodify the template and
deploy it using this tag.

deploy:fullPathToTemplate This tag gives the full path, within the SiteScope tree, of the template or
solution template to be deployed.

Syntax:<template container name>/<template name>
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Elements Description

deploy:fullPathTo
DestinationGroup

This tag gives the full path location within the SiteScope tree of the group
namewhere the deployedmonitoring structure is to be created. If this tag has
no value, the deployment is created at the SiteScope node level.

deploy:mandatoryFields The values within this tag are those variables that were selected as
mandatory fields when the template was created. If there are any values
appearing within this tag, they must be given a value in the
<deploy:globalVariables> tag for global variables or the
<deploy:variables> tag for other variables. If there are no corresponding
values for thesemandatory fields, the XML fails validation.

deploy:globalVariables This tagmarks the section of the file that includes the variables that are
deployed across the entire selected template.

Includes attributes. For details, see the Attributes table below.

deploy:templateInstance
DeployVariable

This tagmarks the section of the file that includes the variables that are
deployed per instance of the selected template.

If the same variable appears in the <deploy:globalVariables>, the instance
variable value overrides the global variable value only for the instance in
which it appears. All other instances have the value entered in the
<deploy:globalVariables> section.

Includes attributes. For details, see the Attributes table below.

deploy:variables This tag defines the variables and their values.

Includes attributes. For details, see the Attributes table below.

Attributes Table

Parent Element Attribute Description

templateDeploymentUpdate enableDeleteOnUpdate Indicates whether any instances of
objects appearing in a deployment of a
template should be deleted when not
appearing in the XML file used for
updating the structure of a
deployment.

Possible values: yes, no

For details on this option, seeEnable
delete on update in the "Select
DeployedGroups Page" on page 751.
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Parent Element Attribute Description

deploy:globalVariables

deploy:templateInstanceDeployVariable

description (Optional) User description for the
deployment.

connectTo
Server

(Optional) Verifies themonitor
configuration properties in the
template against the remote server on
which the template is being deployed.
This is the default behavior (even if
this attribute is not specified). To
avoid connecting to the remote server,
add connectToServer="no" to the
<deploy:globalVariables> or
<deploy:templateInstanceDeploy
Variable> tag.

Possible values: yes, no

For details, seeVerify monitor
properties with remote server in the
"Deploy Multiple Templates Dialog
Box" on page 727.

access
Controlled

(Optional) Tests the connection
created from the template remote
server after the template has been
deployed.

Possible values: true, false

deploy:variables encrypted Indicates whether the value of the
variable's field is encrypted or not.

Possible values: yes, no

To encrypt a value, use the encryption
tool to provide the value for the
variable. For details, see "How to
Deploy aMonitoring Structure Using
an XML File" on page 734.

name The name of the variable.

value The value of the variable.
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Chapter 65: Publish Changes to Templates
You canmake changes to the template, and publish the changes to all SiteScope objects deployed by the
template using the Publish Template Changes Wizard. If a change is required to a template object, for
example, a threshold value changes or a new monitor or alert is required, you can update the template once
and publish the changes to all deployed groups without having to update each object individually.

You can also view how the actual monitored deployments comply with the standardized deployment as
defined in the source template using the Publish Template Changes Wizard. This ensures that any changes in
themonitored environment can be quickly updated in themonitoring infrastructure and that themonitoring
infrastructure is still compliant with the standards set in the source template.

To access
Select the Templates context. In the template tree, right-click a template, and select Publish Changes.

Learn About
Publishing Template Changes Overview
When you deploy a template, the deployed parent group is automatically associated to the source template. If
you subsequently make changes to the source template, you can automatically publish the changes to
SiteScope objects deployed by the template using the Publish Template Changes Wizard. The wizard
enables you to update related deployed groups across the enterprise whenever the source template is updated
without having to update each object individually.

A deployed group consists of the groups, monitors, alerts, variables, and the remote server configured in the
template. For details on how to deploy a template, see the Deploy a Template step in "Deploy the template"
on page 681.

The Publish Template Changes Wizard enables you to update deployed groups in the following ways:

l You can publish only the changes in the source template to the deployed groups. This creates added
objects and updates values of existing objects, but leaves other objects not in the source template intact.

l You can publish the changes in the source template to the deployed groups and have SiteScopemake the
above changes and delete all other SiteScope objects that are not in the source template from the
deployed groups.

l When publishing changes, you can have SiteScope ignore publishing changes to groups under the root
group. This enables:

l Deploying a template inside an existing deployed group and publishing template changes to the deployed
group without affecting SiteScope objects that are in the ignored group. This enables deploying templates
inside different deployed groups.

l Deleting objects in deployed groups that were removed from the source template (when theEnable
delete on update option is selected), without removing other objects created in the deployed group that
were not part of the source template.

l When deployingmonitors and groups using a template, monitor and group dependencies are also
published. This enables the template to automatically write the groups andmonitors into their proper
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place in the tree and automatically create any number of dependencies, without you having to do this
manually.

l When publishing changes, monitor and group dependencies are also updated without you having to do this
manually (the template automatically writes the groups andmonitors into their proper place in the tree and
automatically create dependencies). If you do not want dependency settings for selected template
monitors and groups to overwrite dependency settings in deployed template objects, select Ignore
dependencies when publishing changes in the Dependencies panel. Dependency settings for the
selected templatemonitors and groups are ignored and the existing dependency settings in the deployed
objects are preserved. For details, see "Dependencies When Configuring TemplateMonitors andGroups"
on page 222.

Tasks
How to Publish Template Updates to Related Group Deployments
This task describes the steps involved in publishing template changes to related group deployments using the
Publish Template Changes Wizard.

1. Prerequisites
You can run the Publish Template Changes Wizard provided you haveAdd, edit or delete groups
permissions, and only:
l On groups for which you have permissions in theAllowed groups list.

l For templates in template containers for which you have permissions in theAllowed template
containers list.

Any deployed groups that are not in your allowed groups list are not displayed in the wizard.

2. Run the Wizard
In the template tree, right-click a template, and select Publish Changes to run the wizard. On the first
page, select the related template groups that you want to update. You can also select the following
options:
l Enable delete on update to delete SiteScope objects from the deployed groups that are not in the
source template.

l Verify template changes with remote servers to verify the correctness of themonitor configuration
changes in the selected template with the remote servers on which the template is deployed.

Note:When publishing changes to a custommonitor template, clearing this check box has no
effect, since themonitor configuration properties in the templatemust be checked against the
remote server on which the template is being deployed.

For user interface details, see "Publish Template Changes Wizard" on page 751.

Example - Select Deployed groups
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3. View the structural and content differences
View the structural differences between the template and the deployed groups. For details on the Review
Compliancy user interface, see "Review Compliancy Page" on page 752.
To view content differences in the template objects, click theView Differences link to open the Content
Changes dialog box. This link appears only for template objects that have content differences. For details
on the Content Changes user interface, see "Content Changes Dialog Box" on page 753.
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Example - Review Compliancy Page:

Example - Content Changes Page:

4. Add new variable values
Add values for any new variables in the template. Variable values that aremandatory are indicated by a
red asterisk (*). You can also edit values of existing variables. Click Apply to complete the wizard and
publish the template updates.
For user interface details, see "Modify Variables Page" on page 754.
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Example - Modify Variables Page:

5. Review the publish template changes results
Review the results of the publish template changes and, if necessary, retry publishing the changes to the
deployed groups that failed to update. For details on the Publish Results Summary user interface, see
"Publish Results Summary Page" on page 754.

Example - Publish Results Summary Page:

6. Export the template changes to a summary report - optional
Optionally, you can export the publish template change results to a summary report (PDF file). For details
on the summary report, see "Publish Template Changes Summary Report" on page 755.
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Tips/Troubleshooting
Publishing Template Changes: Troubleshooting and Limitations
This section describes troubleshooting and limitations whenmaking changes to user-defined templates.

l Monitors added directly under a template (without creating a group in the template) are not supported by
the Publish Template Changes Wizard.

l Templates and deployed groups are internally linked by an ID. This means that you can publish changes
even if the name of the template or the root group in a deployed group have changed. However, if you
manually associate a group to a template using theSource template property of the root group, you
cannot publish changes if the root group namewas changed in the deployment.

l For changes to be published, all changes in the root group hierarchy must succeed. If any changes to a
group fail, all changes to that group are rolled back.

l Changes to Search/Filter tag values are not shown in the Review Compliancy page of the Publish
Template Changes Wizard. However, the changes are published to the deployed group.

l The Publish Template Changes Wizard does not support regular expressions in threshold settings.
l For characters to be displayed inmost languages when exporting a report to a PDF, Arial UnicodeMS font
must be installed on themachine used to view the PDF. For details, see "How to Enable Unicode Font
When Exporting to a PDF" on page 712.

l Properties are displayed in the Publish Template Changes Wizard according to the locale of the server
where SiteScope is installed. The browser locale has no effect on how the properties are displayed.

l You cannot replace an existingmonitor target server using the Publish Template Changes wizard or auto
deployment update (see "Publish Template Changes Using the XML" on page 733), although you can
change property values of the target server itself, if required.

l To publish changes in browsablemonitor counters to deployed groups, theremust be a connection to the
remote server on which themonitor groups are deployed.

l You can also use the SiteScope API to update groups, monitors, alerts, and remote servers deployed by a
template. For details, see "SOAP-based APIs" on page 139.

l When publishing changes to a custommonitor type, themonitor is temporarily disabled before changes
are published and is restored to the enabled state after changes have beenmade.

l Publishing changes to custom topology is not supported (it does not affect themonitor's custom topology
in BSM). Tomodify topology settings in deployed templatemonitors, use Global Search and Replace
instead. For details, see "Global Search and Replace" on page 78.

l Publishing changes for SiteScope remote servers is not supported.
l When usingmultiple variables in a template object's property, the variables must be separated by a
character or character sequence. It is recommended to use a delimiter character such as # or _ to ensure
that the correct variable values are displayed in the Publish Template Changes Wizard. For example, if
using two variables in theGroup name box, you could separate them as follows:
%%firstVar%%#%%secondVar%%.
It is important that the separator should not be a part of the variable’s real value. For example, if the
template’s value consists of %%firstVar%%agf%%secondVar%% and the value in the deployed group is
11111agf222, then firstVar is defined as 11111 and secondVar as 222 in the publishing process.
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Note that if the template’s value consists of %%firstVar%%agf%%secondVar%% and the value in the
deployed group is 1agf1agf222, then firstVar is defined as 1 and secondVar as 1agf222 in the publish
process, even though the real value of firstVar is 1agf1 and the real value of secondVar is 222.

Publish Template ChangesWizard
This wizard enables you to check deployed groups for template compliancy and to update SiteScope objects
deployed by templates whenever the source template is updated.

To access Select the Templates context. In the template tree, right-click a template, and select
Publish Changes.

Important
information

l You can run the Publish Template Changes Wizard provided you haveAdd, edit or
delete groups permissions, and only:
l On groups for which you have permissions in theAllowed groups list.

l For templates in template containers for which you have permissions in theAllowed
template containers list.

Any deployed groups that are not in your allowed groups list are not displayed in the
wizard.

l The wizard opens only if there are deployments associated with the selected template.
For details on deploying templates, see "Deploy the template" on page 681.

Relevant
tasks

"How to Publish Template Updates to Related Group Deployments" on page 746

Wizard
map

This wizard contains:

"Select DeployedGroups Page" below > "Review Compliancy Page" on the next page >
"Content Changes Dialog Box" on page 753 > "Modify Variables Page" on page 754 >
"Publish Results Summary Page" on page 754 > ("Publish Template Changes Summary
Report" on page 755)

See also l "Publish Changes to Templates" on page 745
l "Template Tree" on page 37

Select Deployed Groups Page
This wizard page enables you to select groups associated with the source template for which you want to
apply template changes. This is part of the Publish Template Changes Wizard. Refer to "Publish Template
Changes Wizard" above for important information on the wizard.
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User interface elements are described below:

UI Element Description

<List of
groups
associated
with the
selected
template>

Groups associated with the selected template that you want to update with the template
changes.

Default value:All associated groups and subgroups are selected.

Enable
delete on
update

Select this option to ensure template compliancy. Deletes all SiteScope objects that are
not in the source template from the deployed groups, except for objects in groups under the
root group where the Ignore group when publishing changes option is selected. For
details on the ignore group setting, see "New Template Group Dialog Box" on page 695.

Note: Template groups with the Ignore group when publishing changes option selected
that were deployed and then removed from the template are removed from the deployment
after publishing changes withEnable delete on update selected.

Default value:Not selected

Verify
template
changes
with remote
servers

Verifies the correctness of themonitor configuration changes in the selected template with
the remote servers on which the template is deployed.

Note:Selecting this option slows update performance time due to the remote connection.

Default value:Not selected

Review Compliancy Page
This wizard page enables you to view the structural differences between the source template and the
deployed groups, and provides links to content differences in the deployed group objects. This is part of the
Publish Template Changes Wizard. Refer to "Publish Template Changes Wizard" on the previous page for
important information on the wizard.

Note: Changes to Search/Filter tag values are not shown in the Review Compliancy page of the Publish
Template Changes Wizard. However, they are published to the deployed group.

User interface elements are described below:

UI Element Description

<N>
deployed
groups
with
structural/
content
differences

Displays the deployed groups and group objects (subgroups, monitors, alerts, and remote
servers) that have structural or content differences to the source template.
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UI Element Description

<N>
deployed
groups
with no
structural/
content
differences

Displays the deployed groups that have no structural or content differences to the source
template. Groups with no deployment differences are displayed collapsed.

Group
Name

Displays the name of the deployed group and all its objects—subgroups, monitors, alerts,
alert actions, and remote servers. Structural differences in the objects are displayed in the
group tree hierarchy with the following text and color coding:

l Added. Indicates a new object to be added to the deployed group. The object is
displayed in green.

l Does not exist in template (available only when theEnable delete on update option is
not selected in the Select DeployedGroups). Indicates an object that does not exist in
the source template. The object is displayed in blue.

l Ignored. Indicates a subgroup that has the Ignore group when publishing changes
option selected. Ignored groups are displayed in gray.

l Removed. (available only when theEnable delete on update option is selected in the
Select DeployedGroups). Indicates an object to be deleted from the deployed group. The
object is displayed in red.

l Unused. Indicates that the template remote server is not being used. An unused remote
server is displayed in gray.

Content
Differences

For objects that contain content differences in properties, thresholds, and any other non-
structural differences, theView Differences link is displayed. Click the link to open the
Content Changes dialog box and view differences in the property level for the deployed group
or object. For user interface details, see "Content Changes Dialog Box" below.

Template remote servers that have been deployed are displayed in theMicrosoft Windows
Remote Servers orUNIX Remote Servers section. If a remote server already exists in
Microsoft Windows/UNIX Remote Servers, it is not deployed again when the template is
deployed.

Content Changes Dialog Box
This wizard page enables you to view a list of all properties of the selected object to be updated, the current
and the replacement values, and the property action status. This is part of the Publish Template Changes
Wizard. Refer to "Publish Template Changes Wizard" on page 751 for important information on the wizard.

User interface elements are described below:

UI Element Description

Type Object type (Group, Monitor, Alert, Alert Action, Remote).

Name Name of the selected object.
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UI Element Description

Property
Name

Name of the property affected by publishing the change.

Current
Value

Existing property value in the deployed group. This value is empty if the property is going to
be added to the deployed group.

Note:Existing password properties are displayed encrypted.

Replacement
Value

Replacement property value in the template. This value is empty if the property is going to
be deleted from the deployed group.

Note:

l Replacement password properties are displayed encrypted.
l If youmake changes to theDepends on property in a templatemonitor, the full path of
the templatemonitor to which there is a dependence is displayed (for example,
SiteScope\tc\template\group\CPU).

Action Status of the action (Modified, Added, Deleted, Ignored). Ignored status is used for
baselinemonitors, if there are no changes to the baseline thresholds.

Modify Variables Page
This wizard page enables you to add values for new variables in the deployed group. You can also edit
existing variable values. This is part of the Publish Template Changes Wizard. Refer to "Publish Template
Changes Wizard" on page 751 for important information on the wizard.

User interface elements are described below:

UI
Element Description

Variable
Name

Name of a new or existing variable in the deployed group. A red asterisk indicates that the
variable value is mandatory.

Note:You can expand groups with variable values already filled, andmodify the variables as
required. You cannot expand groups that do not contain variables.

Variable
Value

Value for new variables added to the deployed group. You can also edit existing variable values.

Note:

l The variable value for the remote server is read only and cannot be changed.
l Hypertext tags in a variable string cause the string to be truncated and be incorrectly
displayed in the Variable Value box (part of the string is displayed in the text label).

Publish Results Summary Page
This wizard page enables you to view a summary of the published template updates. This is part of the
Publish Template Changes Wizard. Refer to "Publish Template Changes Wizard" on page 751 for important
information on the wizard.
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User interface elements are described below:

UI
Element Description

Export. Exports the results of publishing for each root group to a PDF file. For details, see
"Publish Template Changes Summary Report" below.

Group
Name

Displays the root group name and the group's objects (subgroups andmonitors).

Reason If SiteScope is unable to publish changes to a deployed group, the reason for failure is displayed
for eachmonitor in the group.

Publish Template Changes Summary Report
This report displays information about the template changes published to the deployed groups. It also displays
information for group objects that failed to update or that were ignored. Results are at the object level (Group,
Monitor, Alert, Alert Action, Remote Server).

This is part of the Publish Template Changes Wizard. Refer to "Publish Template Changes Wizard" on
page 751 for important information on the wizard.
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To access In the Publish Results Summary Page of the Publish Template Changes wizard, click the

Report button.

Important
information

l General information about this wizard is available here: "Publish Template Changes
Wizard" on page 751.

l The Publish Template Changes Summary Report PDF is not supported in Firefox 2.x.
l For characters to be displayed inmost languages when exporting a report to a PDF, Arial
UnicodeMS font must be installed on themachine used to view the PDF. For details,
see "How to Enable Unicode Font When Exporting to a PDF" on page 712.

Relevant
tasks

"How to Publish Template Updates to Related Group Deployments" on page 746

Wizard
map

The "Publish Template Changes Wizard" on page 751 contains:

"Select DeployedGroups Page" on page 751 > "Review Compliancy Page" on page 752 >
("Content Changes Dialog Box" on page 753) > "Modify Variables Page" on page 754 >
"Publish Results Summary Page" on page 754 > (Publish Template Changes Summary
Report)

See also "Publish Changes to Templates" on page 745

Report Content
User interface elements are described below:

UI Element Description

<Report
summary>

Total number of root groups selected for publishing changes, including the number of groups
that were successfully and unsuccessfully changed.

Deployed
Root
Group
<group
path>

Name of the deployed group and all group objects that were successfully or unsuccessfully
updated with the template changes. The deployed groups that were not updated are
displayed first.

Note: For changes to be published, all changes in the root group hierarchy must succeed. If
any changes to a group object fail, all changes to that group are rolled back.

Type Object type (Group, Monitor, Alert, Alert Action, Remote Server).

Name Name of the object and its path.

Reason Publish status for the object (Successfully added, Successfully modified,
Successfully deleted, Failed to add, Failed to modify, Failed to delete,
Ignored, Unchanged).

Message For deployed group objects that were not updated by the template changes, the reason for
the failure to publish the changes.
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UI Element Description

<Property
details>

For deployed group objects that had content changes:

l Property Name. The name of the property that was updated.
l Deployment Value (previous). The previous property value in the deployed group. This
value is empty for a property that was added to the deployed group. Previous password
variables are displayed encrypted.

l Template Value (current). The replacement property value in the deployed group. This
is the current property value in the template. This value is empty if the property was
deleted from the deployed group. Replacement password variables are displayed
decrypted.

l Action on Property Value. The type of changemade to the property value
(Successfully modified, Successfully added, Successfully deleted).
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Chapter 66: Share SiteScope Content on the
HPE Live Network
You can use the HPE Live network to share custom SiteScopemonitors and regular SiteScopemonitors that
reference a script or alert template in the SiteScope root directory. By sharing knowledge with other SiteScope
users, you can benefit from extended SiteScopemonitor coverage and the development of new content
outside the SiteScope release cycle.

To access
l SiteScope user community page. Here you can read or participate in discussions in the SiteScope
community forum, get product announcements, and access content and other files shared with the
SiteScope community.
To access this page, enter https://hpln.hpe.com/group/sitescope in aWeb browser.

l Community Content for SiteScope page. This area is used for the development and exchange of
SiteScope content. You can share content you developed, download and rate content provided by other
users, and post feedback on the forum.
To directly access the Community Content for SiteScope page, enter
https://hpln.hp.com/group/community-content-sitescope in aWeb browser.

Learn About
Content Sharing Overview
After developing a SiteScopemonitor, you can copy themonitor to a template, and export it to a template file
which you can share with other SiteScope users. For details on copying amonitor to a template, see "How to
Create a Template by Copying Existing Configurations" on page 682. For details, on exporting a template, see
"How to Export and Import a Template" on page 704.

In addition, when sharing Custommonitors or regular SiteScopemonitors that reference a script or alert
template in the SiteScope root directory, you need to copy the files used for creating themonitor and
extension files referenced by themonitor to a content package. For details on creating content packages, see
"Create Content Packages" on page 703.

You can distribute a template or content package by sending it to individual SiteScope users, or by publishing
it to the SiteScope community on HPE Live Network. HPE Live network is an online community providing a
central location for HPE customers to share information and learn about add-on content, extensions, and
related activities across the HPE Software portfolio.

Tasks
This section includes:

l "How to Publish Content to the HPE Live Network Community" on the next page
l "How to Download Content from the HPE Live Network" on the next page
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How to Publish Content to the HPE Live Network Community
1. Navigate to the Community Content for SiteScope page on the HPE Live Network.

a. Prerequisites for accessing the site:
o Full access to the site is available to HPE Customers with current maintenance contracts for

their specific products.
o For full access, youmust have an HPE Passport account, and youmust have entered your

products Contract identifier (SAID), here:
https://softwaresupport.hp.com/group/softwaresupport/settings

b. Enter https://hpln.hpe.com/group/sitescope in aWeb browser. From the SiteScope user community
page, click theCONTENT link, and then click theCommunity Content for SiteScope link.
Alternatively, you can access the page directly from: https://hpln.hp.com/group/community-content-
sitescope.

2. In the Community Content for SiteScope page, click theCONTENT link, select the appropriate folder
into which you want to upload the content file (or create a new one), and click Add content file.
In the Create File box:
a. Enter a name for the file and select a status for the file (for example, draft, alpha, beta, stable,

released).
b. Enter a description of the file.
c. Select a file type option:

o Regular file. Click Browse, select the file containing the content you want to upload (content
packages are in zip format), and then click Open.

o Link. Enter a link to the file path.
Click Save to upload the content file to the site.

3. To notify other users of the new content, click theANNOUNCEMENTS link, and add details of the
uploaded content. All users that have subscribed to product announcements are automatically notified of
the new content.

How to Download Content from the HPE Live Network
You can download content from the HPE Live Network community as follows:

1. Access the Community Content for SiteScope page on HPE Live Network
(https://hpln.hp.com/group/community-content-sitescope).
Prerequisites for accessing the site:
l Full access to the site is available to HPE Customers with current maintenance contracts for their
specific products.

l For full access, youmust have an HPE Passport account, and youmust have entered your products
Contract identifier (SAID), here:

2. Click theCONTENT link, expand the folder from which you want download a file, and then click the
relevant file link.

Note:
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l You can also check the Announcements and Forums pages for discussions and announcements
on SiteScope community content.

l To receive notifications of product announcements, forum topic posts, and content file posts,
click the relevant Subscribe to link, select the send interval andmethod, and click Subscribe.

3. Continue with the steps for importing a content file, as described in the relevant section of the
documentation.

4. After downloaded and using a content file, you can give the download a rating in the Content page, and
post comments in the Forums page.
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Part 9: Solution Templates
SiteScope offers solution templates that feature built-in domain expertise in the form of specializedmonitors,
default metrics and thresholds, proactive tests, and best practices for a given application or component being
monitored.

For details on working with solution templates in general, see "Deploy Solution Templates" on page 762.

For details on configuring and deploying a specific template, see the help for the specific solution template.

Note: Solution Templates are only available in the user interface after acquiring an HP license edition that
supports them. For details on acquiring the necessary license, see the Licensing section of the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).



Chapter 67: Deploy Solution Templates
SiteScope solution templates are preconfiguredmonitor set templates designed tomonitor popular enterprise
applications and network systems. Using solution templates, you can rapidly deploy a combination of
standard SiteScopemonitor types and solution-specific monitors with settings that are optimized for
monitoring the availability, performance, and health of the target application or system.

Deploying the solution creates a new monitor group container in which the individual solutionmonitors are
added. You can deploy a solution template for each server in your environment. For solution templates that
use the system variableSERVER_LIST, you can deploy the solution onmultiple remote hosts.

To access
Select the Templates context. In the template tree, expand theSolution Templates container and select the
required template.

Learn About
List of Solution Templates
The following table lists solution templates available for SiteScope. For more information about each solution,
including the solution specific monitor types and the supported versions, see the chapter for the specific
solution template.

Solution Name Description
Supported
Versions Supported Platforms

"Active
Directory
Solution
Templates" on
page 770

Monitors the performance and
efficiency of Microsoft domain
controllers (with or with global
category) for Microsoft
Windows servers.

Windows
Server 2003,
2003 R2,
2008, 2008 R2

Windows

"AIX Host
Solution
Template" on
page 773

Monitors performance,
availability, and health for AIX
host machines.

AIX 5.2, 5.3 All

"Apache
Cassandra
Solution
Template" on
page 776

Monitors the health,
availability and performance of
a Cassandra database node.

Cassandra
2.0.9

Windows/Linux
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Solution Name Description
Supported
Versions Supported Platforms

"Apache
Tomcat Solution
Template" on
page 779

Monitors the health,
availability and performance of
a Apache Tomcat server.

Standalone
Apache
Tomcat
versions
7.0.61, 7.0.62,
8.0.23 and
Tomcat with
SiteScope
11.30
onwards.

Windows/Linux

"Hadoop
Cluster
Monitoring
Solution
Templates" on
page 781

Monitor the health and
performance statistics of
Hadoop Distributed File
System (HDFS) and Hadoop
MapReducemaster nodes of
the Hadoop cluster
infrastructure.

Hadoop 1.x. GNU/Linux

"HP Quality
Center Solution
Templates" on
page 785

Monitors performance,
availability, and health for HP
Quality Center application
servers onWindows and
UNIX, HP Quality Center
license usage and expiration
time on anOracle Database
server.

HP Quality
Center
Application
Server 9.2,
10.x

HP Quality
Center Server
License Server
9.2, 10.x

Windows / UNIX

"HP QuickTest
Professional
License Server
Solution
Template" on
page 795

Monitors performance,
availability, and health for
QuickTest Professional
license server application and
system availability.

HP QTP
License Server
7.1.0

Windows / UNIX

"HP Service
Manager
Solution
Templates" on
page 798

Monitors HP ServiceManager
application servers availability
and system status on
Windows and UNIX
platforms.

Service
Manager 7.11

Windows / UNIX

"HP Vertica
Solution
Template" on
page 804

Monitors performance,
availability, and health
aspects of the HP Vertica
cluster infrastructure.

HP Vertica
6.0.1, 6.1, 7.0,
7.1.1

All
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Solution Name Description
Supported
Versions Supported Platforms

"JBoss
Application
Server Solution
Template" on
page 806

Monitors performance,
availability, and health for
JBoss environments.

JBoss 4.x,
5.x, 6.1.0,
6.3.0, 7.1 - 7.4

All

"Linux Host
Solution
Template" on
page 811

Monitors performance,
availability, and health for
Linux host machines.

Red Hat 7.x,
8.x, 9.x

Red Hat
Enterprise
Linux 3.x, 4.x,
5.2, 5.4, 5.5
(ES/AS)

All

"Microsoft
Exchange
Solution
Template" on
page 814

Monitors performance,
availability, and usage
statistics for Microsoft
Exchange servers. The
templates includemonitors
that check Windows Event log
entries, Exchange test
operations and statistics,
system performance
counters, andmessage
system usage statistics

Microsoft
Exchange
2007 (version
8.0), 2010,
2013 Server

All

"Microsoft IIS
Solution
Template" on
page 820

Monitors performance,
availability, and health for
Microsoft IIS environments.

Microsoft IIS
Server 6.0,
7.x, 8.0

Windows

"Microsoft Lync
Server 2010
Solution
Template" on
page 823

Monitors performance,
availability, and health for the
followingMicrosoft Lync
Server 2010 Servers: A/V
Conferencing Server,
Archiving Server, Director
Server, Edge Server, Front
End Server, Lync Server
Event Log, Mediation Server,
Monitoring Server, and
Registrar Server.

Microsoft Lync
Server 2010
Servers

Windows
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Solution Name Description
Supported
Versions Supported Platforms

"Microsoft
SharePoint
2010 Solution
Template" on
page 827

Monitors performance,
availability, and health for
Microsoft SharePoint 2010.

Microsoft
SharePoint
2010

Windows

"Microsoft SQL
Server Solution
Template" on
page 830

Monitors performance,
availability, and usage
statistics for Microsoft SQL
servers.

Microsoft SQL
Server 2005,
2008, 2008
R2, 2012,
2014

Windows

"Microsoft
Windows Host
Solution
Template" on
page 836

Monitors performance,
availability, and health for
Microsoft Windows host
machines.

Microsoft
Windows
Server 2003,
2008, 2012,
Windows XP

Windows

".NET Solution
Template" on
page 839

Monitors performance,
availability, and health of
.NET applications and
environments onWindows
Server machines.

.NET 1.x, 2.x Windows

"Oracle
Database
Solution
Template" on
page 842

Monitors performance,
availability, and usage
statistics for Oracle
databases.

Oracle
Database 10g,
11g

Windows / UNIX / Linux

"SAP Solution
Templates" on
page 850

Monitors performance,
availability, and usage
statistics for SAP system
components.

SAP R/3
servers
(versions 4.5B
and later

Windows / Linux / Solaris

"Siebel Solution
Templates" on
page 854

Monitors performance,
availability, and usage
statistics for Siebel
Application Server installed on
Windows and UNIX operating
systems.

Siebel
Application
Server 6.x,
7.x, 8.x

Windows / UNIX

"Solaris Host
Solution
Templates" on
page 862

Monitors performance,
availability, and health for
Solaris host machines.

Solaris 9, 10 All
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Solution Name Description
Supported
Versions Supported Platforms

"VMware
Capacity
Management
Solution
Templates" on
page 865

Enables SiteScope to collect
data from VMwaremonitors
and report it to the data store
on the HP Operations agent
for use in supported reporting
products, including HP
Service Health Optimizer
(SHO), HP's capacity
management solution, and
Service Health Reporter
(SHR), HP's service centric
cross-domain reporting
solution.

VMware
VirtualCenter
2.x

VMware ESX
3.x, 4.0, 4.1

VMware ESXi
3.5, 4.0, 4.1,
5.0, 5.1

VMware ESX
2.5 via
VirtualCenter
2.x

VMware ESX
3.x via
VirtualCenter
3.x

VMware
vSphere 4.0,
4.1, 5.0, 5.1
(also
supported with
SSO login),
5.5

vCenter server: Windows XP
Professional, Window Server 2003,
2003 R2, 2008, 2008 R2, 2012, 2012
R2, Virtual Appliance. See VMware
Compatibility Guide
(http://www.vmware.com/
resources/compatibility)

ESX server: ownOS

"VMware Host
Solution
Template" on
page 872

Monitors CPU, memory,
storage, state, and network
performance and usage
statistics for the VMware Host
server and on guest virtual
machines on the host server.
Use this solution template if
you just want to monitor
vCenter without having the
ability to pinpoint performance
problems.

"VMware Host
For
Performance
Troubleshooting
Solution
Template" on
page 876

Deploys a set of monitors that
follow VMware's official best
practice scenarios for
performance troubleshooting
of VMware vSphere. These
monitors use SiteScope’s
CalculatedMetrics to pinpoint
specific performance
problems on the VMware host,
and report the problematic
ESX host and/or VMs. This
template can also be used for
collecting data andmonitoring
the overall performance and
availability on the VMware
host.
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Solution Name Description
Supported
Versions Supported Platforms

"WebLogic
Solution
Templates" on
page 881

Monitors performance,
availability, and usage
statistics for OracleWebLogic
application servers.

WebLogic
Application
Server 6.x,
7.x, 8.x, 9.x,
10.x

All

"WebSphere
Solution
Templates" on
page 886

Monitors performance,
availability, and usage
statistics for IBMWebSphere
application servers.

WebSphere
Application
Server 6.x,
7.x, 8.x

All

Tasks
How to Customize a Solution Templates
Since a solution template is unlikely to match all your system configurations, you can customize the solution
template tomeet your system requirements as follows:

l Copy the solution template to a template container, modify it to suit your system requirements, and then
deploy themodified solution template (see below for deployment details).

l Deploy the solution template (see below), andmodify it after the deployment to suit your system's
requirements.
For example, when using the HP Quality Center Application Server solution template tomonitor the
repository disk variable, and the repository is on a different host to the application server, after deploying
the template, youmust change the repository disk utilizationmonitor to use the other host.

How to Deploy a SiteScope Solution Template
This task describes the steps involved in deploying a solution template. Deploy a solution template for each
server in your environment.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HP license edition that
supports them. For details on acquiring the necessary license, see the Licensing section of the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

l An in-depth description of each solution template is provided in the solution template best practices
guides (available from <SiteScope root directory>\sisdocs\pdfs\<solution template name>_
Best_Practices.pdf). These guides (except for Hadoop Cluster Monitoring and HP Vertica) are
password protected; the password is provided after acquiring an HP license edition that supports
solution templates.

2. Deploy the template
Select themethod for deploying the solution template to a group:

Using SiteScope
Chapter 67: Deploy Solution Templates

HPE SiteScope (11.33) Page 767 of 1206



l You can deploy a solution template directly from the user interface. In the template tree, right-click the
solution template you want to deploy, and select Deploy Template. In the Select Group dialog box,
select themonitor group into which you want to deploy the solution template. For user interface
details, see "Select Group Dialog Box" on page 726.

Note: Solutions that provide a number of templates (these are grouped in a template container),
can be deployed to a group individually or simultaneously. For example, when deploying the
Microsoft Exchange 2010 solution, you can select only the templates that you require, and deploy
them against distributed Exchange server installations on separate servers. For details on
deployingmultiple templates simultaneously, see the Deploy multiple templates step in "How to
Deploy Templates Using the User Interface" on page 722.

l You can deploy a solution template using a CSV file that contains the variable values defined in the
template. For details, see "Deploy a Template Using a CSV File" on page 721.

l You can deploy and update the template using an XML file external to the SiteScope user interface.
For details, see "Deploy Templates Automatically Using an XML File" on page 732.

3. Enter variable values for the template deployment (for deployment through the
user interface only)
Complete the items on the Deployment Values page for the selected solution template. For user interface
details, see the UI Descriptions section for the specific solution template.

4. Configure alerts and reports
Configure alerts and reports for the newly created solutionmonitors.
For details on configuring alerts, see "Configure SiteScope Alerts" on page 1072.
For details on configuring reports, see "Create SiteScope Reports" on page 1139.

5. Results
The solution template creates a new monitor group container in which the individual solutionmonitors are
added. Themonitor group container is assigned a name in the format <Solution Template name> on
<server_name>where server_name is the server selected from theServer box.
You can view, edit, and delete thesemonitors in the sameway as any other monitors in SiteScope.

Note: If some of themonitors fail to deploy, amessage is shown listing the names of themonitors
together with amessage describing the error.

UI Descriptions
Solution Templates Page
User interface elements are described below:

UI Element Description

Name Name of the solution template (read-only).
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UI Element Description

Description Description of the solution template (read-only).

Tips/Troubleshooting
Notes and Limitations
l The Search/Filter Tags panel is not available for filtering Solution Template objects.
l Errors detected during the creation of monitors using a solution template are independent of the status
returned when the individual monitors are run. This means that themonitors may be created successfully
but that the configuration settings may be incorrect or that the system beingmonitored is unavailable.

l After some solution templates are deployed, the relevant monitors may be defined with a APM reporting
level of Disable reporting to BSM. Therefore after deploying a solution template, we recommend that
you check themonitors' reporting level. If you want to change the reporting level for the deployedmonitors,
you can use theGlobal Search and Replace wizard to update the reporting level option.

l Solution templates do not configure any automated alerts or reports for themonitors created. Youmay
create and associate one or more alert definitions or reports to themonitors or monitor groups created by
solution templates.

Troubleshooting Issues
l Reinstalling Solution Templates
The installed solution templates are located in the <SiteScope root directory>\persistency directory. If
the contents of this directory are deleted, the solution templates are not displayed in the template tree. To
reinstall the solution templates, youmust copy the solution template files back to the persistency
directory.

Note:Wedo not recommend deleting the persistency directory as this permanently deletes all
SiteScope configuration data and all historical data in APM (if SiteScope is integrated with APM).

To reinstall the solution template files:
a. Locate the solution template files in the following directory: <SiteScope root directory>\export.
b. Copy the contents of <SiteScope root directory>\export into <SiteScope root

directory>\persistency\import.
c. Check that the solution templates have been reinstalled by locating them in theSolution Templates

folder in the template tree.
l Importing Solution Templates

l When importing templates, if templates already exist with the same name in the same template
container, the import may fail, due to unique name violation. To prevent this, rename the existing
template containers.

l If the import fails or you no longer see the solution templates in the Solution Templates tree, you can
restore the solution templates as described in Reinstalling the Solution Templates above. If the \export
folder also contains the template examples, the template container should be renamed to prevent the
unique name violations mentioned above.
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Chapter 68: Active Directory Solution
Templates
You can use the Active Directory solution templates to providemonitoring of domain controller performance—
services on which Active Directory depends—and distributed Active Directory performance.

The Active Directory solution templates deploy a set of monitors against a particular Domain Controller.
Thesemonitors encompass best practices monitoring for Active Directory. This template includes Windows
Event Log, Service, LDAP, performance counter, and Active Directory Replicationmonitors.

The Active Directory solution templates provide comprehensivemonitoring without requiring the SiteScope
user or the IT organization to be experts on the application. They also reduce the time to configure and deploy
monitors, help identify both real-time performance bottlenecks and longer term trends, and add only minimal
overhead to production systems.

Note: An in-depth description of the Active Directory Solution Template is available in the SiteScope
Active Directory Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Active_Directory_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
Active Directory solution template.

Learn About
Supported Versions
The Active Directory solution templates support Microsoft Windows Server 2003, 2003 R2, 2008, 2008 R2.

Solution Template Monitors
l Domain controller performance. This category refers to the low level health of each domain controller in
the environment. The Active Directory solution template automatically configures monitors for domain
controller health.

l Dependent services. Active Directory depends on several key services. Without these services, Active
Directory can become unresponsive or fail altogether. The Active Directory solution template
automatically configures monitors for a list of important services on which Active Directory performance is
dependent.

l Distributed Active Directory performance. Perhaps themost important aspect and key indicator of
Active Directory performance is how fast Active Directory is replicating changes out to all domain
controllers. The Active Directory solution template automatically configures monitors for monitoring and
testing replication of changes and updates.
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License Consumption

Points-based Usage Capacity-based Usage

Active Directory with Global Catalog -
34 points per solution template

Active Directory with noGlobal Catalog
- 33 points per solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load
Testing edition, see the SiteScope Deployment Guide.

Tasks
How to Deploy Active Directory Solution Templates
This task describes the steps involved in entering variables for the Active Directory solution template.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for user interface deployment only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Active Directory Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

ReplicatingDomain
Controllers

Comma separated list of domain controllers that replicate data from the domain
controller selected above.

LDAPSecurity
Principal

LDAP Security Principal of a Domain Admin account. For Active Directory this is in
the format of cn=Domain Admin User,cn=users,dc=yoursite,dc=com.

LogicalDrive Logical drive that this Domain Controller is using for its database and log files.

PASSWORD Password for the user selected above.

HostName Host part of the domain controller's host name (do not include the fully qualified
domain name).
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UI Element Description

Global Catalog
(AD with Global
Catalog only)

Select if the Domain Controller is a Global Catalog server.

SERVER_LIST Domain Controller that you want to monitor. If the server you want to monitor is not
in the list, youmust define a connection profile to the server.

Silent deployment Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template
against the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers
(AD 2008 R2 only)

Tests the connection created from the template remote server after the templates
have been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.

Default value:Not selected
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Chapter 69: AIX Host Solution Template
The AIX Host solution template is a template that you can use to deploy a collection of monitors configured
with default metrics that test the health, availability, and performance of the AIX host. The template supports
the versions of AIX that are supported by SiteScope. For details, see System Requirements in the SiteScope
Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

For UNIX ResourceMonitors, you can create a Server-Centric report which displays data from three different
metrics about the server beingmonitored. For more information on generating a Server-Centric report, see
"Create Server-Centric Reports" on page 1179.

Tip:We recommend using solution templates when creating the UNIX ResourceMonitor, because the
requiredmonitors andmetrics are already configured.

The AIX Host solution template provides comprehensive AIX operating systemmonitoring without requiring
the SiteScope user or the IT organization to be experts on the application. It also reduces the time to configure
and deploy performancemonitors, helps identify both real-time performance bottlenecks and longer term
trends, and adds only minimal overhead to production systems.

Note: An in-depth description of the AIX Host Solution Template is available in the SiteScopeOperating
System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected guide; the
password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select AIX Host.

Learn About
Supported Versions
The AIX Host solution template supports AIX 5.2 and 5.3.

Solution Template Monitors
The AIX Host solution template deploys monitors that target the following aspects of AIX performance and
health:

l CPU status and utilization details
l Memory status and utilization details
l File system status and utilization details
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License Consumption

Points-based Usage Capacity-based Usage

13 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy Active Directory Solution Templates
This task describes the steps involved in configuring the server environment and entering variables for the AIX
Host solution template.

Note: The AIX Host solution template deploys a UNIX ResourceMonitor for each target host. This is a
supplemental monitor that is required for Server-Centric Report support.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l The SiteScope server must be able to connect to the target AIX host.

l The target server must be added to SiteScope as a UNIX remotemachine and should pass the UNIX
remote test (Remote Servers > UNIX Remote Servers). For details, see "Configure SiteScope to
Monitor Remote UNIX Servers" on page 420.

Note:

o The SiteScope server itself can also bemonitoring if it runs a supported AIX operating
system.

o The template supports the AIX versions supported by SiteScope. For details, see System
Requirements in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm).

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.
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UI Descriptions
AIX Host Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. For the steps you use to create a UNIX
connection profile, see "Configure SiteScope toMonitor Remote UNIX Servers" on
page 420.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 70: Apache Cassandra Solution
Template
The Apache Cassandra solution templates deploy a collection of monitors configured with default metrics that
test the availability, performance, and health of a Cassandra database. The solution template deploys the
monitors only on a specified node of the Cassandra database.

Note: An in-depth description of the Cassandramonitoring solution template is available in the SiteScope
Cassandra Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Cassandra_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expandSolution Templates > Apache Cassandra and
select > Cassandra Node Monitoring.

Learn More
Supported Versions
The Apache Cassandra solution template supports Cassandra version 2.0.9.

Solution Template Monitors
The Apache Cassandra solution template deploys monitors that target the following aspects of Cassandra
server performance and health:

l Node availability
l Node compaction
l Node gossip stage
l Node latency
l Nodemutation stage
l Node read stage
l CPU status and utilization details
l Headmemory usage
l Physical memory usage

License Consumption

Points-based Usage Capacity-based Usage

16 points per solution
template

Available with Community, Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.
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Tasks
How to Deploy the Apache Cassandra Monitoring Solution Template
This task describes the steps involved in entering variables for the Apache CassandraMonitoring solution
template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Enable JMX remote on the Cassandra node.

2. Deploy the solution template.
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Apache Cassandra Solution Template Page

UI Element Description

Port Port that SiteScope should use to access the JMX remote, if set.

JMX User
Name

The user name required to connect to the JMX remote server, if set.

JMX Password The password required to connect to the JMX remote server, if set.

Server_List Name of the server you want to monitor. If the server you want to monitor is not in the
list, youmust define a connection profile to the server. For the steps you use to create a
connection profile, "Configure SiteScope toMonitor RemoteWindows Servers" on
page 402 or see "Configure SiteScope toMonitor Remote UNIX Servers" on page 420.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected
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UI Element Description

Verify monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value:Selected
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Chapter 71: Apache Tomcat Solution
Template
The Apace Tomcat solution template deploys a set of monitors that test the performance and availability of
the Apache Tomcat server. The solution template provides monitors to check availability, performance,
session performance, and thread pool of the Tomcat server.

Note: An in-depth description of the Tomcat monitoring solution template is available in the SiteScope
Tomcat Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Tomcat_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expandSolution Templates > Apache Tomcat and
select Tomcat Monitoring.

Learn More
Supported Versions
The Apache Tomcat solution template supports standalone Apache Tomcat versions 7.0.61, 7.0.62, 8.0.23
and Tomcat versions packaged with SiteScope 11.30 or later.

License Consumption

Points-based
Usage Capacity-based Usage

4 points per solution
template

Available with Community, Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the Apache Tomcat Solution Template
This task describes the steps involved in entering variables for the Apache Tomcat solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Enable JMX remote on the Tomcat server.
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2. Deploy the solution template.
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Apache Tomcat Solution Template Page

UI Element Description

Port Port that SiteScope should use to access the JMX
remote, if set.

Server-Name Host name of the Apache Tomcat server.

JMX-Username The user name required to connect to the JMX
remote, if set.

JMX-Password The password required to connect to the JMX
remote, if set.

Silent Deployment Submits the template deployment request to a
queue, and SiteScope handles the deployment in
the background. This enables you to continue to
use SiteScope without having to wait for the
template deployment process to finish. All
submitted requests and their corresponding
deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor properties with remote server Verifies the correctness of themonitor
configuration properties in the template against the
remote server on which the template is deployed.

Note: When this option is selected, deployment
time is slowed due to the remote connection.

Default value:Selected

Tips/Troubleshooting
JMX Timeout Exception
If you encounter a JMX Timeout exception error, increase the timeout interval to 120 seconds or higher. By
default, the timeout interval is 60 seconds.
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Chapter 72: Hadoop Cluster Monitoring
Solution Templates
You can use the Hadoop Cluster Monitoring solution templates to providemonitoring of the health and
performance statistics of Hadoop Distributed File System (HDFS) and HadoopMapReducemaster nodes of
the Hadoop cluster infrastructure.

The Hadoop Cluster Monitoring solution templates deploy a set of monitors against a specified Hadoop
cluster host. Thesemonitors are designed tomanage large, fast-growing volumes of data and provide fast
query performance when used for data warehouses and other query-intensive applications.

These templates includes the Hadoop, UNIX Resources, Memory, andMulti Logmonitors.

The Hadoop Cluster Monitoring solution templates provide comprehensivemonitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to configure
and deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.

Note: An in-depth description of the Hadoop Cluster Monitoring Solution Template is available in the
SiteScope Hadoop Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Hadoop_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expandSolution Templates > Hadoop Cluster
Monitoring, and select the required template (HDFS orMapReduce).

Learn More
Supported Versions
The Hadoop Cluster Monitoring solution template supports Hadoop 1.x onGNU/Linux.

License Consumption

Points-based Usage Capacity-based Usage

HDFS solution template: 4 + (Number of files matched
by Multi Logmonitor)
MapReduce solution template: 15 + (Total number of
configured job queues) + (Number of files matched by
Multi Logmonitor)

Available with Community, Premium, Ultimate or
System Collector Editions.

Note: For the list of Solution Templates available
with Load Testing edition, see the SiteScope
Deployment Guide.
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Tasks
How to Deploy the Hadoop Cluster Monitoring Solution Template
This task describes the steps involved in entering variables for the Hadoop Cluster Monitoring solution
templates.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Description
HDFS (Hadoop Distributed File System) Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

HDFS
master
node

Name of the server which hosts the HDFS master node.

Enter the URL in the format:

service:jmx:rmi:///jndi/rmi://<host>:<port>/jmxrmi

JMX
Domain

Domain that is used to gather Hadoop statistics (optional). If this field is left blank, the
default Hadoop domain filter is used.

JMX Port JMX port configured for the HDFS master node.

JMX User
name

Login for connecting to the HDFS master node JMX (if configured).

JMX
Password

Password for connecting to the HDFS master node JMX (if configured).

User name
for remote

Login name for the HDFS master node host.

Password Password for the HDFS master node host.

Using SiteScope
Chapter 72: Hadoop Cluster Monitoring Solution Templates

HPE SiteScope (11.33) Page 782 of 1206

http://www.hp.com/go/sitescope


UI Element Description

Frequency Themonitor run frequency (in seconds).

Default value: 600

HDFS logs
folder

Path to the HDFS logs folder.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the templates have been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected

MapReduce Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

MapReduce
master
node

Name of the server which hosts the HadoopMapReducemaster node.

Enter the URL in the format:

service:jmx:rmi:///jndi/rmi://<host>:<port>/jmxrmi

JMX
Domain

Domain that is used to gather Hadoop statistics (optional). If this field is left blank, the
default Hadoop domain filter is used.

JMX Port JMX port configured for the HadoopMapReducemaster node.

JMX User
name

Login for connecting to the HadoopMapReducemaster node JMX (if configured).

JMX
Password

Password for connecting to the HadoopMapReducemaster node JMX (if configured).
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UI Element Description

User name
for remote

Login name for theMapReducemaster node host.

Password Password for theMapReducemaster node host.

Frequency Themonitor run frequency (in seconds).

Default value: 600

MapReduce
logs folder

Path to theMapReducemaster node logs folder.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the templates have been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected
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Chapter 73: HP Quality Center Solution
Templates
The HP Quality Center solution templates are templates that you can use to deploy a collection of monitors
configured with default metrics that test the availability of HP Quality Center application servers, and license
status on HP Quality Center database servers.

The HP Quality Center solution templates provide comprehensive HP Quality Center monitoring without
requiring the SiteScope user or the IT organization to be experts on the application. They also reduce the time
to configure and deploy performancemonitors, help identify both real-time performance bottlenecks and longer
term trends, and add only minimal overhead to production systems.

Note:

l HP Quality Center Application Server forWindows is not supported on SiteScopes installed on UNIX
platforms.

l An in-depth description of the HP Quality Center Solution Template is available in the SiteScope
Quality Center Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_HP_QC_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required HP
Quality Center solution template.

Learn About
Supported Versions
The HP Quality Center solution templates support:

l HP Quality Center Application Server 9.2 and 10.x
l HP Quality Center Server License Server 9.2 and 10.x

Solution Template Monitors
The HP Quality Center solution includes solution templates for monitoring the following key components:

l HP Quality Center Application Server for UNIX/Windows. Use this solution template tomonitor the
availability and performance of the HP Quality Center application server on the operating system onwhich
the application is installed.

l HP Quality Center 9.2/10.0 License Status. Use this solution template tomonitor HP Quality Center
license usage and expiration time on an HP Quality Center database server (the solution template has
been certified on anOracle andMicrosoft SQL database).
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Note: The solution template uses the Pingmonitor to monitor system availability. If Ping traffic is blocked
on your network, use Port monitor instead.

Monitoring Quality Center Third-Party Applications
We recommend using other SiteScope solution templates, monitors, or both, to monitor Quality Center third-
party components, such as the application server on which Quality Center is deployed, and the database it
uses.

For details on the solutions that are recommended for monitoring Quality Center third-party components, see
the tables below:

Database Server Monitoring

Database Type Recommended Solution

Oracle "Oracle Database Solution Template" on page 842

Microsoft SQL Server "Microsoft SQL Server Solution Template" on page 830

LDAP LDAP Monitor

Application/Web Server Monitoring

Application/Web Server Type Recommended Solution

Apache Server Apache Server Monitor

JBoss "JBoss Application Server Solution Template"
on page 806

Microsoft IIS "Microsoft IIS Solution Template" on page 820

Microsoft IIS Server Monitor

WebLogic 6.x-8.x, 9.x-10.x "WebLogic Solution Templates" on page 881

WebSphere 5.x, 6.x "WebSphere Solution Templates" on page 886

OtherWeb/Application Servers that support JMX
access (JSR 160)

JMX Monitor
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License Consumption

Points-based Usage Capacity-based Usage

HP Quality Center Application Server for
UNIX - 11 points per solution template

HP Quality Center Application Server for
Windows - 11 points per solution template

HP Quality Center 10.0 License Status - 12
points per solution template

HP Quality Center 9.2 License Status - 6
points per solution template

Available with Premium, Ultimate or System Collector
Editions.

Note: For the list of Solution Templates available with Load
Testing edition, see the SiteScope Deployment Guide.

Tasks
How to Deploy the HP Quality Center Solution Template
This task describes the steps involved in entering variables and deploying the HP Quality Center solution
templates.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Youmust have the following information:

Solution Template
Name Requirements

HP Quality Center
Application Server for
Windows

l The SiteScope server must have access to the Quality Center
components.

l Youmust have the following information:

o Quality Center application version (9.2, 10.0)
o Full host name and login credentials for the application server
o Quality Center repository disk or repository location if it is located on

another host
o Port used in the login URL (usually none, whichmeans that port 80 is

used)
l This solution template is not supported on SiteScopes installed on
UNIX platforms.
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Solution Template
Name Requirements

HP Quality Center
Application Server for
UNIX

l The SiteScope server must have access to the Quality Center
components.

l Youmust have the following information:

o Quality Center application version (9.2, 10.0)
o UNIX operating system type
o Full host name and login credentials for the Application server
o System file system
o Quality Center repository disk or repository location if it is located on

another host
o Port used in the login URL (usually none, whichmeans that port 80 is

used)
o Name of the java process command that runs the Quality Center

application on the UNIX operating system. (you can use "ps -ef |
grep java")

HP Quality Center
9.2/10.0 License Status

l The SiteScope server must have access to the Quality Center 9.2 or
10.0 components.

l Youmust have the following information on theQuality Center
database:

o Database host name
o Type (Oracle, Microsoft SQL, MSDE 2000)
o Driver (possibly a SiteScope built-in database driver)
o Database Connection URL

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
HP Quality Center Application Server for Windows
User interface elements (Variable Values) are described below:
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UI Element Description

Application
server host
name

Host name of the Quality Center application server.

Application
server user
name

Login user name for the host on the Quality Center application server.

Application
server
password

Password for the host on the Quality Center application server.

System disk Logical disk drive where the Quality Center application server is installed.

Default value:C

Repository
disk

Logical disk drive where the Quality Center repository is located. If the repository is
located on another host, enter the system disk drive and alter the Repository Disk
Utilizationmonitor after you deploy your template.

Default value:D

Site
Administration
path

Suffix for the Quality Center Site Administration URL.

Default value: qcbin/SiteAdmin.htm (for Quality Center version 9.x, change this to
sabin)

Application
port

Port used in the login URLs to the Quality Center application. Usually no port is specified
whichmeans port 80 is used.

Default value: 80

Maximum
round trip time
(milliseconds)

Value inmilliseconds, used as an error status threshold for a reasonable round trip time
for getting a response from your application URLs.

Default value: 1500milliseconds

Quality Center
service name

Name of the Quality Server service.

Default value:HP Quality Center. For Quality Center version 9.x, change this to
Mercury Quality Center.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected
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UI Element Description

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the template has
been deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected

HP Quality Center Application Server for UNIX
User interface elements (Variable Values) are described below:

UI Element Description

Application
server host
name

Host name for the Quality Center application server.

Application
server user
name

Login user name for the host on the Quality Center application server.

Application
server
password

Password for the host on the Quality Center application server.

UNIX
operating
system

UNIX operating system type, such as Solaris, Red Hat Enterprise Linux. The complete
list of UNIX operating system types is available in theOperating system field of the
New/Edit UNIX Remote Server dialog box.

Default value: Linux

System file
system

File system where the Quality Center application is installed.

Repository file
system

File system where the Quality Center repository is located. If the repository is located on
another host, enter the system disk file system, and alter the Repository Disk Utilization
monitor after you deploy your template.

Site
Administration
path

Suffix for the Quality Center Site Administration URL.

Default value: qcbin/SiteAdmin.htm (for Quality Center version 9.x, change this to
sabin)
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UI Element Description

Application
port

Port used in the login URLs to the Quality Center application. Usually no port is specified
whichmeans port 80 is used.

Default value: 80

Maximum
round trip time
(milliseconds)

Value inmilliseconds, used as an error status threshold for a reasonable round trip time
for getting a response from you application URLs.

Default value: 1500milliseconds

Quality Center
process
unique name

Name used to identify the Quality Center java process from the other processes running
on the system. It can be theQuality Center process name, or a unique part of it taken
from the java process command that runs the Quality Center application on the UNIX
operating system (you can use ps -ef | grep java).

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the template has
been deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected

HP Quality Center 9.2/10.0 License Status
User interface elements (Variable Values) are described below:

UI Element Description

Site
Administration
database host

Host namewhere the Quality Center Site Administration is installed.

Database
driver

Database driver used for connecting to your database. If a custom driver is used, the
driver must also be installed in the <SiteScope root directory>\WEB-INF\lib directory.

Default value: com.inet.ora.OraDriver (supports Oracle Database). For Microsoft SQL,
use: com.mercury.jdbc.sqlserver.SQLServerDriver.
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UI Element Description

Connection
URL (full)

Quality Center database connection URL.

Examples:

jdbc:inetora:[host]:[port]:[sid] (for Oracle Database)

jdbc:mercury:sqlserver://labm1qcrnd05.devlab.ad:1433;DatabaseName=May22_2008_
db (for Microsoft SQL)

Connection
URL (part 0-3)

If your connection URL is composed of semicolon (;) separated values, enter each part
in a separate field in addition to the full Connection URL (full) field.

Example:

Connection URL (part 0) = jdbc:mercury:sqlserver://labm1qcrnd05.devlab.ad:1433

Connection URL (part 1) = DatabaseName=May22_2008_db

Otherwise enter your whole connection URL in Connection URL (part 0) for example:

Connection URL (part 0) = jdbc:inetora:[host]:[port]:[sid]

Note: The reason for this separation is that the connection URL is used as a Script
monitor parameter, and the semicolon (;) character is not permitted for security reasons.

Database user User name required for querying the database.

The specified user namemust have privileges to run the SELECT queries on the ADMIN
and SESSION_LICENSE tables of the Site Administration database.

Database
password

Password required for the given user name to log on to the database and run the
SELECT queries.

Database
password -
encrypted

Encrypted form of the database password. To get the encrypted password, run the
following tool on your password:

<SiteScope root directory>\tools\AutoDeployment\encrypt_password.bat
<password>

For UNIX platforms, run enrypt_password.sh <password>.

Note: The encrypted password is used as a Script monitor parameter, and is required for
security reasons.

Admin table
name

Name of the Quality Center ADMIN table.

Default value:ADMIN (supports Oracle database). For Microsoft SQL database, use
td.ADMIN.

Session
license table
name

Name of the Quality Center Session License table.

Default value:SESSION_LICENSE (supports Oracle database). For Microsoft SQL
database, use td.SESSION_LICENSE.
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UI Element Description

SiteScope
expiration
error status
(days
remaining)

License expiration error threshold. Each License Expiration Status deployedmonitor is in
error status if the number of days until the license expires is less than the number
specified here.

Default value: 7 days

SiteScope
expiration
warning status
(days
remaining)

License expiration warning threshold. Each License Expiration Status deployedmonitor
is in warning status if the number of days until the license expires is less than the number
specified here.

Default value: 30 days

Number of free
licenses for
error

License usage error threshold. Each License Usage Status deployedmonitor is in error
status if the number of free licenses is less than the number specified here.

Default value: 5

Number of free
licenses for
warning

License usage warning threshold. Each License Usage Status deployedmonitor is in
warning status if the number of free licenses is less than the number specified here.

Default value: 20

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Note:

l TheQuality Center license is in XML format that is stored in the ADMIN table on the Site
Administration database. It contains information about the Quality Center license expiration and quota
for each of the different Quality Center modules (for example, Defects, Requirements, and so forth).
The XML format is different for Quality Center 9.2 andQuality Center 10.0. Another table named
SESSION_LICENSE contains an entry on real time for each logged in session and the license type
used.

l To calculate the license usage and expiration, the SiteScope solution template uses a Script monitor
that runs a script (runQCLicenseTool.bat onMicrosoft Windows platforms, and
runQCLicenseTool.sh on UNIX platforms). The script queries the Quality Center database, and
returns the following information for the requested license type to the Script monitor:
Total=<total quota>;used=<currently used of this type>;free=<total-free>;exp_
days=<left days for license to expire>.
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Troubleshooting and Limitations
Content Match Error
If you encounter monitors that have a content match error after deploying the solution template, it is possible
that your Quality Center does not support this type of license.

l If this is the case, delete the unsupportedmonitor.
l If themonitor is supported, check the log file:
<SiteScope root directory>\scripts\qc_license_tool.log.
To set the log file to debug, open <SiteScope root directory>\conf\
ems\tools\conf\core\Tools\log4j\PlainJava\log4j.properties
and set

loglevel=DEBUG
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Chapter 74: HP QuickTest Professional
License Server Solution Template
The HP QuickTest Professional License Server solution template is a template that you can use to deploy a
collection of monitors configured with default metrics that test the HP QuickTest Professional license server
application and system availability.

The solution template provides comprehensive HP QuickTest Professional License Server monitoring without
requiring the SiteScope user or the IT organization to be experts on the application. They also reduce the time
to configure and deploy performancemonitors, help identify both real-time performance bottlenecks and longer
term trends, and add only minimal overhead to production systems.

Note:

l TheQuickTest Professional License Server solution template is not supported on SiteScopes
installed on UNIX platforms.

l An in-depth description of the HP QuickTest Professional License Server Solution Template is
available in the SiteScopeQuality Center andQuickTest Professional License Server Best Practices
document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_HP_QC_Best_
Practices.pdf. This is a password protected guide; the password is provided after acquiring an HP
license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the HP
QuickTest Professional License Server solution template.

Learn About
Supported Versions
The HP QuickTest Professional License Server solution template supports HP QTP License Server 7.1.0.

License Consumption

Points-based
Usage Capacity-based Usage

3 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.
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Tasks
How to Deploy the HP QuickTest Professional License Server Solution Template
This task describes the steps involved in entering variables and deploying the HP QuickTest Professional
License Server solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Youmust have the following information:
o The SiteScope server must have access to the QuickTest Professional License server.
o Youmust have the QuickTest Professional License server host name and login credentials.
o This solution template is not supported on SiteScopes installed on UNIX platforms.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
QuickTest Professional License Server
User interface elements (Variable Values) are described below:

UI Element Description

QTP
license
server host
name

Host name for the QuickTest Professional license server.

QTP
license
server user
name

User name for the QuickTest Professional license server system login.

QTP
license
server
password

Password for the QuickTest Professional license server system login.
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UI Element Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the template has been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected
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Chapter 75: HP Service Manager Solution
Templates
SiteScope's HP ServiceManager solution templates enable you tomonitor and troubleshoot HP Service
Manager application servers availability and system status onWindows and UNIX platforms. They measure
HP ServiceManager load balancer status, sharedmemory usage, andmonitors logs for fatal errors. They can
also be used tomonitor HP ServiceManager in Horizontal Scaledmode.

The HP ServiceManager solution templates provide comprehensivemonitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to configure
and deploy performancemonitors, and help identify both real-time performance bottlenecks and longer term
trends.

Note: An in-depth description of the HP ServiceManager Solution Template is available in the SiteScope
ServiceManager Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_HP_SM_Best_Practices.pdf. This is a password protected guide;
the password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required HP
ServiceManager solution template.

Learn About
Supported Versions
The HP ServiceManager solution template supports ServiceManager 7.11.

Solution Template Monitors
The HP ServiceManager solution templates create a dynamic set of monitors that target the HP Service
Manager server performance and health onWindows and UNIX platforms. For details on themonitors, see the
SiteScope HP ServiceManager Server Best Practices document.

License Consumption

Points-based Usage Capacity-based Usage

48 points per solution
template for Unix

12 points per solution
template forWindows

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition,
see the SiteScope Deployment Guide.
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Tasks
How to Deploy the HP Service Manager Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the HP
ServiceManager solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l The HP ServiceManager solution templates supports ServiceManager 7.11 only.

l All processes to bemonitoredmust be up and running when deploying the template. If SiteScope
does not find the processes when it tries to create the target monitor, a "No counters selected" error is
displayed and themonitor is not created.
Workaround: If not all processes are up and running, you can copy the template to your own template
container and delete the processes monitors. You can later create themmanually, or deploy another
copy of the template that contains only the processes monitors.

l For the HP ServiceManager forWindows solution template, the sm-lbstatus-win-ssh.bat and sm-
shm-win-ssh.bat scripts must be run on theMicrosoft Windows remote server where HP Service
Manager is installed. For details, see the following step.

Note: The HP ServiceManager for UNIX solution template uses the sm-shm.txt and sm-
lbstatus.txt files located in <SiteScope root directory>/scripts.remote to run commands on
the remote ServiceManager UNIX host.

2. Run the sm-lbstatus-win-ssh.bat and sm-shm-win-ssh.bat scripts (for HP ServiceManager for
Windows)
a. Install and configure the SSH Server (OpenSSH). For details, see "How to Configure Remote

Windows Servers for SSH monitoring" on page 447.
b. On themachine where SiteScope is installed, find the file calledRemoteNTSSH.zip in the

<SiteScope root directory>\tools directory. Unzip theRemoteNTSSH.zip file on the remote
monitored ServiceManager host. Place the contents of the zip file into the scripts subdirectory in the
home directory of the account SiteScope uses to access the remote server (UNIX andWindows-
Windows SSH only). For example, home/sitescope/scripts.

Note: OnWindow platforms, the path to the user home directory depends on the particular SSH
server. For example, if you install a Cygwin SSH server in C:\Cygwin, the default path to the
home directory for the Administrator user will be C:\Cygwin\home\Administrator. For
additional information, see the documentation for your SSH server.

c. On themachine where SiteScope is installed, find the file calledSM_Scripts_win_ssh.zip in the
<SiteScope root directory>\tools\ServiceManager directory. Unzip the file on the remote
monitored ServiceManager host to the scripts directory in the home directory of the account
SiteScope uses. (The zip contains the sm-lbstatus-win-ssh.bat and sm-shm-win-ssh.bat files.)
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Make sure both scripts have execute permissions. If you are running ServiceManager in
Horizontally Scaledmode, you need to repeat this on every system.

d. Share the ServiceManager logs folder. Right-click the logs folder and select Properties > Sharing.
Select Share this folder, and enter aShare name. Set the share permissions for the user that
SiteScopemonitor uses to run themonitors on that machine, and click OK.

3. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

4. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
HP Service Manager for Windows
User interface elements (Variable Values) are described below:

UI Element Description

SM
installation
partition

Disk drive where HP ServiceManager is installed.

Default value:C

Application
server host
name

Name of the application server host.

User name Login name to access the application server using this profile.

Password Application server login password for this user.

Installation
path

Path to the directory on which HP ServiceManager binary is running.

Default value: C:\Program Files\HP\ServiceManager 7.11\Server\RUN

Log files
path

A shared path to the HP ServiceManager \logs directory.

Example: \\< HP ServiceManager host name>\logs

CPU error
threshold

Threshold for triggering CPU errors.

Default value: 90

CPU
warning
threshold

Threshold for triggering CPU warnings.

Default value: 80

Memory
error
threshold

Threshold for triggeringmemory errors.

Default value: 2202012 KB
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UI Element Description

Memory
warning
threshold

Threshold for triggeringmemory warnings.

Default value: 1782580 KB

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the template has been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected

HP Service Manager for UNIX
User interface elements (Variable Values) are described below:

UI Element Description

Application
server host
name

Name of the application server host.

User name Login name to access the application server using this profile.

Password Application server login password for this user.

UNIX
operating
system

UNIX operating system onwhich HP ServiceManager is running.

UNIX
connection
method

Method used to connect to the UNIX operating system.

Shell
prompt

Prompt output when the remote system is ready to handle a command (for Telnet or Rlogin
connectionmethod only).
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UI Element Description

Installation
path

Path to the directory on which HP ServiceManager binary is running.

CPU error
threshold

Threshold for triggering CPU errors.

Default value: 90

CPU
warning
threshold

Threshold for triggering CPU warnings.

Default value: 80

Memory
error
threshold

Threshold for triggeringmemory errors.

Default value: 2202012 KB

Memory
warning
threshold

Threshold for triggeringmemory warnings.

Default value: 1782580 KB

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote server after the template has been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected

Tips/Troubleshooting
General Tip/Limitation
If you are running HP ServiceManager in Horizontally Scaledmode, you need to deploy and configure the HP
ServiceManager solution template on every system.

No counters selected
All processes to bemonitoredmust be up and running when deploying the template. If you get a "no counters
selected" error, it means that some processes are down. To resolve this problem, make a copy of the
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template and delete themonitors for which you get errors before deploying the template.

Ping traffic blocked
The solution template uses the Pingmonitor to monitor system availability. If Ping traffic is blocked on your
network, use the Port monitor, and useGlobal Search and Replace to replace the dependency from the Ping
monitor to the Port monitor.
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Chapter 76: HP Vertica Solution Template
You can use the HP Vertica solution template to providemonitoring of different aspects of the Vertica cluster
infrastructure.

The HP Vertica solution template deploys a set of monitors against a particular Vertica cluster. These
monitors are designed tomanage large, fast-growing volumes of data and provide fast query performance
when used for data warehouses and other query-intensive applications.

Vertica can bemonitored by SNMP trap, System Tables, and log files.

This template includes the HP Vertica JDBC and SNMP Trapmonitors.

The HP Vertica solution template provides comprehensivemonitoring without requiring the SiteScope user or
the IT organization to be experts on the application. It also reduce the time to configure and deploy monitors,
help identify both real-time performance bottlenecks and longer term trends, and add only minimal overhead to
production systems.

Note: An in-depth description of the HP Vertica Solution Template is available in the SiteScope HP
Vertica Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Vertica_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the HP Vertica
solution template.

Learn More
Supported Versions
The HP Vertica solution template supports monitoring on Vertica 6.0.1, 6.1, 7.0, and 7.1.1.

License Consumption

Points-based
Usage Capacity-based Usage

4 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the HP Vertica Solution Template
This task describes the steps involved in entering variables for the HP Vertica solution template.
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1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l To be able to deploy the HP Vertica solution template on a Vertica 7.0 cluster environment, youmust
be a Super User. For details on user types, see "User Types and User Role Types" on page 626.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Description
HP Vertica Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

Database Name of the Vertica database server.

Host Name of the host.

Port Port that SiteScope should use to access the Vertica database server.

Driver Name of the Vertica JDBC driver to be used by this monitor.

Default value: com.vertica.jdbc.Driver

Username User name that SiteScope should use to access the Vertica database server.

Password Password to be used to access the Vertica database server.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 77: JBoss Application Server Solution
Template
You can use the JBoss Application Server solution templates to deploy a collection of monitors configured
with default metrics that test the health, availability, and performance of JBoss application servers.

The JBoss Application Server solution templates provide comprehensive JBoss monitoring without requiring
the SiteScope user or the IT organization to be experts on the application. It also reduces the time to configure
and deploy performancemonitors, helps identify both real-time performance bottlenecks and longer term
trends, and adds only minimal overhead to production systems.

Note: An in-depth description of the JBoss Solution Template is available in the SiteScope JBoss Best
Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_JBoss_
Best_Practices.pdf. This is a password protected guide; the password is provided after acquiring an HP
license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
JBoss solution template.

Learn About
Supported Versions
The JBoss Application Server solution templates support JBoss Application Server versions 4.x, 5.x, 7.1 -
7.4.

Red Hat JBoss Enterprise Application Platforms 6.1.0 and 6.3.0 are also supported by the JBoss AS 7.1 - 7.4
solution template.

Solution Template Monitors
The JBoss Application Server solution templates create a dynamic set of monitors that target the JBoss
application server performance and health. The exact monitor set depends on the entities you select during
the solution template deployment. For details on themonitors, see the SiteScope JBoss Application Server
Best Practices document.

License Consumption

Points-based Usage Capacity-based Usage

JBoss Application Server 4.x - 3 points per solution
template

JBoss Application Server 7.1 - 7.3 - Approximately 15
points on the JBoss Application Server + 1 point for
each application deployed

Available with Premium, Ultimate or System
Collector Editions.

Note: For the list of Solution Templates available
with Load Testing edition, see the SiteScope
Deployment Guide.
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Tasks
How to Deploy the JBoss Application Server Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
JBoss Application Server solution templates.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Youmust know the URL for gathering JMX statistics (including the host name and port of the JMX
instance), and the JMX user name and password.

l SiteScope and the target server can run on the same host.

l Youmust start JBoss in a particular way, so that SiteScope canmonitor it. For details, see the
following step.

2. Start JBoss
l For JBoss 4.x only:
To enable SiteScope tomonitor JBoss, specify the following options for the JBoss JVM:

-Dcom.sun.management.jmxremote
-Dcom.sun.management.jmxremote.port=12345
(any other port can be used of course; then it must be specified during ST
deployment)
-Dcom.sun.management.jmxremote.ssl=false
-Dcom.sun.management.jmxremote.authenticate=false
-Djboss.platform.mbeanserver
-
Djavax.management.builder.initial=org.jboss.system.server.jmx.MBeanServerBuild
erImpl

You can perform this using the following batch file:

@echo off
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote.port=12345
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote.authenticate=false
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote.ssl=false
set JAVA_OPTS=%JAVA_OPTS% -
Djavax.management.builder.initial=org.jboss.system.server.jmx.MBeanServerBuilderImpl
set JAVA_OPTS=%JAVA_OPTS% -Djboss.platform.mbeanserver
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote
call run.bat -b my-jboss-host
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Note:

o run.bat is the default script used to start JBoss AS 4.x.
o -b option binds JBoss 4.2.2 to the correct network interface (it binds only to local host by

default making it inaccessible from other hosts).
o You can build a similar script for UNIX.

l For JBoss 7.1 - 7.4 only:
Standalone mode
To enable SiteScope tomonitor JBoss, perform the following steps:
i. Change all 127.0.0.1 entries to your JBoss server's IP address in the xml configuration files in

the <JBoss_home>\standalone\configuration\ directory, otherwise JBoss will only be
available from the local host.

ii. Change the HTTP port to a different port by editing the <socket-binding name="http"
port="8080"/> property (for example, if you have installed SiteScope and JBoss on the same
server).

iii. You can change the JMX remoting port by editing the jboss.management.native.port:9999
property.

iv. Add a new Management user using <JBoss_home>\bin\add-user.bat onWindows platform,
or <JBoss_home>/bin/add-user.sh on Linux platform.

v. Start JBoss using <JBoss_home>\bin\standalone.bat onWindows platform, or <JBoss_
home>/bin/standalone.sh on Linux platform.

Domain mode
To enable SiteScope tomonitor JBoss, perform the following steps:
i. Change all 127.0.0.1 entries to your JBoss server's IP address in the xml configuration files in

the <JBoss_home>\domain\configuration\ directory, otherwise JBoss will only be available
from the local host.

ii. Change the HTTP port to a different port by editing the <socket-binding name="http"
port="8080"/> property (for example, if you have installed SiteScope and JBoss on the same
server).

iii. You can change the JMX remoting port by editing the <socket-binding name="remoting"
port="4447"/> property.

iv. Edit <JBoss_home>\domain\configuration\domain.xml:
For JBoss AS 7.1:
replace <remoting-connector/> with
<remoting-connector use-management-endpoint="false"/>
for JBoss EAP 6.1 - 6.2:
replace <!--<remoting-connector use-management-endpoint="false"/>-->
with <remoting-connector use-management-endpoint="false"/>

v. Add a new Application user using <JBoss_home>\bin\add-user.bat onWindows platform, or
<JBoss_home>/bin/add-user.sh on Linux platform.

vi. Start JBoss using <JBoss_home>\bin\domain.bat onWindows platform, or <JBoss_
home>/bin/domain.sh on Linux platform.
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3. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

4. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
JBoss AS 4.x Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

JMX_URL URL to gather JMX statistics. Typically the URL is in the format:
service:jmx:rmi:///jndi/rmi://{hostname}:{port}/jmxrmi.

Enter the host name and port of the JMX instance you want to monitor.

USERNAME User name for connection to the JMX application (optional).

PASSWORD Password for connection to the JMX application (optional).

Counters Displays the server performance counters you want to check with this monitor. Use the
Get Counters button to select counters.

Get
Counters

Opens theGet Counters dialog box, enabling you to select the entities you want to monitor.
For each instance, a specific set of monitors and thresholds is created. For details, see the
SiteScope JBoss Application Server Best Practices Guide which can be found at
<SiteScope root directory>\sisdocs\pdfs\
SiteScope_JBoss_Best_Practices.pdf.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

JBoss AS 7.1 - 7.4 Solution Template Page
User interface elements (Variable Values) are described below:
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UI Element Description

JMX URL URL to gather JMX statistics from the JBoss Application Server. Typically the URL is in the
format: service:jmx:remoting-jmx://<server_name>:<port>.

Hostname Hostname of machine where is JBoss AS server located. Will be used as hostname of
JBoss CI type for sending topology to the HP BSM.

Login Login name for connection to the JBoss Application Server.

Password Password for connection to the JBoss Application Server.

Additional
Classpath

Path for the client JBoss Application Server jar files. File path elements should be separated
by a semicolon (";"). The client files are located in the <SiteScope root
directory>\templates.applications\lib folder.

Default value: ../templates.applications/lib/jboss-
client.jar;../templates.applications/lib/jboss-common-core-2.2.17.GA-redhat-2.jar

Timeout Timeout value for the Dynamic JMX monitors in seconds.

Default value: 120

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 78: Linux Host Solution Template
The Linux Host solution template is a template that you can use to deploy a collection of monitors configured
with default metrics that test the health, availability, and performance of the target Linux host. The template
supports the versions of Linux that are supported by SiteScope. For details, see System Requirements in the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

For UNIX ResourceMonitors, you can create a Server-Centric report which displays data from three different
metrics about the server beingmonitored. For more information on generating a Server-Centric report, see
"Create Server-Centric Reports" on page 1179.

Tip:We recommend using solution templates when creating the UNIX ResourceMonitor, because the
requiredmonitors andmetrics are already configured.

The Linux Host solution template provides comprehensive Linux operating systemmonitoring without
requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the time to
configure and deploy performancemonitors, helps identify both real-time performance bottlenecks and longer
term trends, and adds only minimal overhead to production systems.

Note: An in-depth description of the Linux Host Solution Template is available in the SiteScopeOperating
System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected guide; the
password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select Linux Host.

Learn More
Supported Versions
The Linux Host solution template supports:

l RedHat 7.x, 8.x, 9.x
l RedHat Enterprise Linux 3.x, 4.x, 5.2, 5.4, 5.5 (ES/AS)

Solution Template Monitors
The Linux Host solution template deploys monitors that target the following aspects of Linux performance and
health:

l CPU status and utilization details
l Memory status and utilization details
l File system status and utilization details
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License Consumption

Points-based Usage Capacity-based Usage

13 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the Linux Host Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Linux Host solution template.

Note: The Linux Host solution template deploys a UNIX ResourceMonitor for each target host. This is a
supplemental monitor that is required for Server-Centric Report support.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l The SiteScope server must be able to connect to the target Linux host.

l The target server must be added to SiteScope as a UNIX remotemachine and should pass the UNIX
remote test (Remote Servers > UNIX Remote Servers). For details, see "Configure SiteScope to
Monitor Remote UNIX Servers" on page 420.

Note:

o The SiteScope server itself can also bemonitoring if it runs a supported Linux operating
system.

o The template supports the Linux versions supported by SiteScope. For details, see System
Requirements in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm).

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.
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UI Descriptions
Linux Host Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. For the steps you use to create a UNIX
connection profile, see "Configure SiteScope toMonitor Remote UNIX Servers" on
page 420.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 79: Microsoft Exchange Solution
Template
TheMicrosoft Exchange solution templates providemonitoring of performance, availability, and usage
statistics for Microsoft Exchange servers. The templates includemonitors that check Windows Event log
entries, Exchange test operations and statistics, system performance counters, andmessage system usage
statistics.

TheMicrosoft Exchange solution templates provide comprehensiveMicrosoft Exchange systemmonitoring
without requiring the SiteScope user or the IT organization to be experts on the application. They also reduce
the time to configure and deploy monitors, help identify both real-time performance bottlenecks and longer
term trends, and add only minimal overhead to production systems.

Note: An in-depth description of theMicrosoft Exchange Solution Template is available in the SiteScope
Microsoft Exchange Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Exchange_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
Microsoft Exchange solution template.

Learn About
Supported Versions
TheMicrosoft Exchange solution templates support:

l Microsoft Exchange 2007 Server (version 8.0)
l Microsoft Exchange 2010 Server
l Microsoft Exchange 2013 Server

Solution Template Monitors
TheMicrosoft Exchange solution templates deploy monitors that target the following aspects of Microsoft
Exchange performance and health:

l Basic server/OS performance. This category refers to the system-level health of a server. TheMicrosoft
Exchange solution templates automatically configuremonitors for server health.

l Application performance. Application performance is ameasure of how well specific Exchange
components are functioning. TheMicrosoft Exchange solution templates automatically configuremonitors
for a list of important Exchange application components.

l Exchange Server test operations and statistics. TheMicrosoft Exchange solution templates can
monitor different tests and statistic command-lets (cmdlets) of the Exchange Server. Cmdlets can be
used to:
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Verify: l Exchange ActiveSync (Microsoft Exchange 2013 Solution Template only)

l WebServices Functionality

l Anonymous calendar sharing is enabled and worked properly (Microsoft Exchange 2013
Solution Template only)

l Mailbox Replication Service (Microsoft Exchange 2013 Solution Template only)

l Required services are running (Microsoft Exchange 2013 Solution Template only)

l End to EndMail Delivery

Test: l POP3 Service (Microsoft Exchange 2013 Solution Template only)

l IMAP4 Service (Microsoft Exchange 2013 Solution Template only)

l DAGMembers (Microsoft Exchange 2013 Solution Template only)

l Mailbox Databases

l Mailbox Assistance performance (Microsoft Exchange 2013 Solution Template only)

l Is Exchange Search currently enabled and is indexing new email messages is a timely
manner

Get: l Average store usage statistics values (Microsoft Exchange 2013 Solution Template only)

l Usage statistics. The last category related toMicrosoft Exchange performance is usage. While usage in
and of itself is not necessarily a key indicator of performance, changes in usage can affect overall
Microsoft Exchange performance. In addition, Microsoft Exchange usage statistics help IT organizations
spot trends and plan for the future. TheMicrosoft Exchange solution templates automatically configure
monitors for a list of important Microsoft Exchange usage parameters.

Note: Some of themonitor types deployed by the solution templates can only be added to SiteScope by
using theMicrosoft Exchange solution templates. See the section for the particular monitor types for
more information.
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License Consumption

Points-based Usage Capacity-based Usage

Microsoft Exchange 5.5 - 39 points per solution
template

Microsoft Exchange 2000 - 40 points per solution
template

Microsoft Exchange 2003 - 49 points per solution
template

Microsoft Exchange 2007 - 83 points per solution
template

Microsoft Exchange 2010 - 83 points per solution
template

Microsoft Exchange Server 2013: Client Access
Server Role - 64 points ( +/- 1 to 6 points, as
someMicrosoft Windows Resources monitors
contain counter’s regex)

Microsoft Exchange Server 2013: Mailbox Server
Role - 60 points ( +/- 1 to 6 points, as some
Microsoft Windows Resources monitors contain
counter’s regex)

Only Microsoft Exchange 2010 andMicrosoft
Exchange 2013 are available with Community Edition.
All others are available with Premium, Ultimate or
System Collector Editions only.

Note: For the list of Solution Templates available with
Load Testing edition, see the SiteScope Deployment
Guide.

Tasks
How to Deploy Microsoft Exchange Solution Templates
This task describes the steps involved in configuring the server environment and entering variables for the
Microsoft Exchange solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Before deploying aMicrosoft Exchange solution template, youmust perform specific steps depending
on the solution template you want to deploy.

o Microsoft Exchange 2007, 2010 solutions. These solution templates make use of theMicrosoft
Exchange 2007 and 2010monitors. Successful deployment of thesemonitor types require specific
setup configuration. For details, seeMicrosoft ExchangeMonitor in the SiteScopeMonitor
ReferenceGuide.

o Microsoft Exchange 2013 solutions. These solution templates make use of theMicrosoft
Windows Event Log, Microsoft Windows Resources, Microsoft Exchange Base, and Service
monitor. Successful deployment of thesemonitor types requires specific setup configuration. For
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details, seeMicrosoft Windows Event LogMonitor, Microsoft Windows Resources Monitor,
Microsoft Exchange BaseMonitor, and ServiceMonitor in the SiteScopeMonitor ReferenceGuide.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.
For details on configuring the templatemonitor, see the documentation for the specific Microsoft
Exchangemonitor in the SiteScopeMonitor ReferenceGuide.

Note: TheMicrosoft Exchange 2010 andMicrosoft Exchange 2013 solutions provide a number of
templates in a template container, that can be deployed either individually, or simultaneously, to a
group. This enables you to select only the templates that you require, and to deploy them against
distributed Exchange server installations on separate servers. For details on deployingmultiple
templates simultaneously, see "Deploy Multiple Templates Dialog Box" on page 727.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Microsoft Exchange 2007, 2010 Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

Domain
(Exchange
2007 and
2010 only)

Domain to which both the owner of themailbox being used and theMicrosoft Exchange
server belong.

Note: The owner of themailbox to be used by this solutionmust also have administrative
account privileges on themachine where SiteScope is running. SiteScope also needs user
account access to the domain where theMicrosoft Exchange server is running.

Mailbox Name (alias) of themailbox to be used for testing email round trip times usingMAPI. This is
often the email account name but it may be a different name.

Tip:We recommend copying themailbox name as it appears in the E-Mail Account
properties for the email account you are using for this solution.

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. For the steps you use to create a
Windows connection profile, see "Configure SiteScope toMonitor RemoteWindows
Servers" on page 402.
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UI Element Description

Exchange
PS
Console
File Path
(Microsoft
Exchange
2007 and
2010 only)

Path to theMicrosoft ExchangeManagement Shell PowerShell console file.

Default value:C:\Program Files\Microsoft\Exchange Server\Bin\ExShell.psc1

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Microsoft Exchange 2013 Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

Exchange
server name
(ID)

Name (ServerIdParameter) of theMicrosoft Exchange Server that you want to monitor,
without the domain.

Example: exchange1

Exchange
domain

Domain name of theMicrosoft Exchange Server that you want to monitor.

Example: some.exchange.domain

Mailbox
account

Name of some existingmailbox for the current Exchange Server.

Example:Administrator

Remote
Exchange
script file
path

Full path to theMicrosoft Exchange Server Management Shell script file.

Default value:C:\Program Files\Microsoft\Exchange
Server\V15\Bin\RemoteExchange.ps1
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UI Element Description

Timeout
(seconds)

Amount of time to wait, in seconds, for getting a response. You can set the timeout to no
less than 1 second and nomore than 15minutes.

Default value: 600 seconds

User for
remote server
(domain\user)

User of the remote server on which the current Exchange Server is installed.

Example: exchange-domain\Administrator

Password of
the remote
server's user

Password for user of the remote server on which the current Exchange Server is installed.

POP3 service
port

Port number for POP3 service on the current Exchange Server.

Default value: 995 (use 995 for SSL; 110 for plain text /TLS)

IMAP4
service port

Port number for IMAP4 service on the current Exchange Server.

Default value: 993 (use 993 for SSL; 143 for plain text /TLS)

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 80: Microsoft IIS Solution Template
TheMicrosoft IIS solution templates are templates that you can use to deploy a collection of monitors
configured with default metrics that test the health, availability, and performance of Microsoft IIS servers.

TheMicrosoft IIS solution templates provide comprehensive IIS monitoring without requiring the SiteScope
user or the IT organization to be experts on the application. It also reduces the time to configure and deploy
performancemonitors, helps identify both real-time performance bottlenecks and longer term trends, and adds
only minimal overhead to production systems.

Note: An in-depth description of theMicrosoft IIS  Solution Template is available in the SiteScope
Microsoft IIS  Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_IIS_Best_Practices.pdf. This is a password protected guide; the
password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
Microsoft IIS solution template (Microsoft IIS 6 orMicrosoft IIS 7.x).

Learn More
Supported Versions
TheMicrosoft IIS solution templates support Microsoft IIS 6.0, 7.x, and 8.0.

IIS Solution Template Monitors
TheMicrosoft IIS solution templates deploy monitors that target the following services and aspects of IIS
server performance and health:

l Active Server Pages (ASP errors, requests, templates, sessions, transactions)
l FTP service, Web service, SMTP server, NNTP server, HTTP/HTTPS services, MSMQQueue service,
IIS Server, Global IIS status, IIS WAS, IIS W3SVC, IIS Windows Log, Indexing services

l IIS statistics as aWindows process

License Consumption

Points-based Usage Capacity-based Usage

Microsoft IIS 6 - 98 points per
solution template

Microsoft IIS 7.x - 79 points per
solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing
edition, see the SiteScope Deployment Guide.
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Tasks
How to Deploy the Microsoft IIS Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Microsoft IIS solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l The SiteScope server must be able to connect to the target Microsoft IIS host. Use theMicrosoft
Windows Resources Monitor to monitor the server performance statistics from remoteWindows
servers. TheMicrosoft Windows Resourcemonitor may require special configuration. For details, see
Microsoft IIS Server Monitor in the SiteScopeMonitor ReferenceGuide.

l The target server must be added to SiteScope as aWindows remotemachine and should pass the
Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For details, see
"New/Edit Microsoft Windows Remote Server Dialog Box" on page 406.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope toMonitor a RemoteMicrosoft Windows Server" on
page 402.

Note: SiteScope and the target IIS server can run on the same host.

2. Configure the server environment (for Microsoft IIS 6 only)
Configure the IIS Server so that it contains the ASP component path in the components tree.
a. In the Control Panel, select Add or Remove Programs > Add/Remove Windows Components.
b. InWindows Component Wizard, on theWindows Components page, highlight Application Server,

and click Details.
c. In Application Server, select theASP.NET check box.
d. Highlight Internet Information Services (IIS), and then click Details.
e. In Internet Information Services (IIS), select theWorld Wide Web Service check box, and then

click Details.
f. InWorldWideWeb Service, select theActive Server Pages check box, and then click OK.
g. In Internet Information Services (IIS) click OK.
h. In Application Server, ensure that the Internet Information Services (IIS) check box is selected,

and then click OK to install the components.
i. Click Next, and when theWindows Components Wizard completes, click Finish.
j. To enable ASP.NET, select Administrative Tools > Internet Information Services (IIS)

Manager in the Control Panel.
k. In the console tree, expand the local computer, and then clickWeb Service Extensions.
l. In the details pane, click ASP.NET, and then click Allow.
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3. Configure the server environment (for Microsoft IIS 7.x only)
Configure the IIS Server so that it contains the ASP component path in the components tree.
a. Start the Server Manager (click Start, click Run, and then type CompMgmtLauncher).
b. In the tree view, select Roles, and in theRoles pane click Add Roles.
c. In the Add Roles Wizard, click Select Server Roles, select theWeb Service (IIS) check box, click

Next, and then click Next again.
If the "Add features required forWeb Server (IIS)?" message is displayed, click Click Add
Required Features.

d. In the Select Role Services window, make sure that theASP.NET andASP service is selected
(underApplication Development).

4. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

5. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Microsoft IIS Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. For the steps you use to create a
Windows connection profile, see "Configure SiteScope toMonitor RemoteWindows
Servers" on page 402.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 81: Microsoft Lync Server 2010
Solution Template
You can use theMicrosoft Lync Server 2010 solution templates listed below to providemonitoring of different
aspects of theMicrosoft Lync Server 2010 server. These templates provide comprehensivemonitoring
without requiring the SiteScope user or the IT organization to be experts on the application. They also reduce
the time to configure and deploy monitors, help identify both real-time performance bottlenecks and longer
term trends, and add only minimal overhead to production systems.

For Microsoft Lync Server 2010monitors, you can create a Server-Centric report which displays data from
three different metrics about the server beingmonitored.

Note: An in-depth description of theMicrosoft Lync Server 2010 Solution Template is available in the
SiteScopeMicrosoft Lync Server 2010 Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_MS_Lync_Server_2010_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expandSolution Templates > Microsoft Lync Server
2010, and select the requiredMicrosoft Lync Server 2010 solution template.

Learn More
Microsoft A/V Conferencing Server
Monitors the server performance statistics of theMicrosoft Lync A/V Conferencing Server. A/V conferencing
enables real-time audio and video A/V communications between your users (provided they have appropriate
client devices such as headsets for audio conferences and web cams for video conferences). A/V
Conferencing Server provides A/V conferencing functionality to your deployment. It can be collocated with
Front End Server, or deployed separately as a single server or A/V Conferencing Server pool.

Microsoft Archiving Server
Monitors the server performance statistics of theMicrosoft Lync Archiving Server. The Archiving Server
enables you to archive instant messaging (IM) communications andmeeting content for compliance reasons.
Corporations and other organizations are subject to an increasing number of industry and government
regulations that require the retention of specific types of communications. With the Archiving Server feature,
Microsoft Lync Server 2010 communications software provides a way for you to archive IM content,
conferencing (meeting) content, or both, that is sent through Lync Server 2010. If you deploy Archiving Server
and associate it with Front End pools, you can set it to archive instant messages and conferences and specify
the users for which archiving is enabled.

Microsoft Director Server
Monitors the server performance statistics of theMicrosoft Lync Director Server. A Director is a server
runningMicrosoft Lync Server communications software that authenticates user requests, but does not home
any user accounts or provide presence or conferencing services. Directors aremost useful in deployments
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that enable external user access, where the Director can authenticate requests before sending them on to
internal servers. Directors can also improve performance in organizations with multiple Front End pools.

Microsoft Edge Server
Monitors the server performance statistics of theMicrosoft Lync Edge Server. The Edge Server enables your
users to communicate and collaborate with users outside the organization's firewalls. These external users
can include the organization's own users who are currently working offsite, users from federated partner
organizations, and outside users who have been invited to join conferences hosted on your Lync Server
deployment. Edge Server also enables connectivity to public IM connectivity services, includingWindows
Live, AOL, and Yahoo!.

Microsoft Front End Server
Monitors the server performance statistics of theMicrosoft Lync Front End Server. The Front End Server is
the core server role, and runs many basic Lync Server functions. The Front End Server, along with the Back
End Servers, which provide the database, are the only server roles required to be in any Lync Server
Enterprise Edition deployment.

A Front End pool is a set of Front End Servers, configured identically, that work together to provide services
for a common group of users. A pool provides scalability and failover capability your users.

Front End Server includes the following functionality:

l User authentication and registration
l Presence information and contact card exchange
l Address book services and distribution list expansion
l IM functionality, includingmultiparty IM conferences
l Web conferencing and application sharing (if deployed)
l Application hosting services, for both applications included with Lync Server (for example, Conferencing
Attendant and ResponseGroup application) and third-party applications

l Application services for application hosting and hosts applications (for example, ResponseGroup
application, and several others)

Microsoft Mediation Server
Monitors the server performance statistics of theMicrosoft Lync Mediation Server. TheMediation Server is a
necessary component for implementing Enterprise Voice and dial-in conferencing. TheMediation Server
translates signaling and, in some configurations, media between your internal Lync Server infrastructure and a
public switched telephone network (PSTN) gateway, IP-PBX, or a Session Initiation Protocol (SIP) trunk. On
the Lync Server side, Mediation Server listens on a single mutual TLS (MTLS) transport address. On the
gateway side, Mediation Server listens on a single TCP and single TLS transport address or a single TLS
transport address. All qualified gateways must support TLS, but can enable TCP as well.

Microsoft Monitoring and CDR Server
Monitors the server performance statistics of theMicrosoft Lync Monitoring and CDR Server. TheMonitoring
Server collects data about the quality of your network media, in both Enterprise Voice calls and A/V
conferences. This information can help you provide the best possible media experience for your users. It also
collects call error records (CERs), which you can use to troubleshoot failed calls. Additionally, it collects
usage information in the form of call detail records (CDRs) about various Lync Server features, so that you
can calculate return on investment of your deployment, and plan the future growth of your deployment.
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Microsoft Registrar Server
Monitors the server performance statistics of theMicrosoft Lync Registrar Server. The Lync Server 2010
Registrar is a new server role that enables client registration and authentication and provides routing services.
It resides along with other components on a Standard Edition Server, Enterprise Front End Server, Director, or
Survivable Branch Appliance. A Registrar pool consists of Registrar Services running on the Lync Server pool
and residing at the same site.

License Consumption

Points-based Usage Capacity-based Usage

106 points for one instance of each Lync Server role.
(Additional points are used when deploying subtemplates for
different machines with the same role.)

Available with Community, Premium,
Ultimate or System Collector Editions.

Note: For the list of Solution Templates
available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the Microsoft Lync Server 2010 Solution Templates
This task describes the steps involved in entering variables for theMicrosoft Lync Server 2010 solution
template.

1. Prerequisite
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

Note: TheMicrosoft Lync Server 2010 solution provides a number of templates in a template
container, that can be deployed either individually, or simultaneously, to a group. This enables you to
select only the templates that you require. For details on deployingmultiple templates
simultaneously, see the Deploy multiple templates step in "How to Deploy Templates Using the
User Interface" on page 722.

UI Descriptions
Microsoft Lync Server 2010 Solution Template Page
User interface elements (Variable Values) are described below:
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UI Element Description

Host The host name of theMicrosoft Lync Server 2010 instance you want to monitor.

User The user namewith admin credentials on theMicrosoft Lync Server 2010 instance.

Password Password for the user on theMicrosoft Lync Server 2010.

Connection
method

Themethod used to connect to the server. Options are: NetBIOS, WMI, or SSH.

Default value:NetBIOS

Remote
server
encoding

The encoding of the remote server.

Default value:Cp1252

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote servers after the templates have
been deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected
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Chapter 82: Microsoft SharePoint 2010
Solution Template
You can use theMicrosoft SharePoint 2010 solution templates to providemonitoring of SharePoint
environments—to understand how the SharePoint Server 2010 system is running, and tomonitor important
events, performance counters, and services, found in SharePoint 2010 products.

TheMicrosoft SharePoint 2010 solution templates deploy a set of monitors (Microsoft Windows Event Log,
Microsoft Windows Resources, CPU, Disk Space, and SQL) that target services and aspects of the
Microsoft SharePoint 2010 performance and health. Thesemonitors encompass best practices monitoring for
Microsoft SharePoint 2010.

TheMicrosoft SharePoint 2010 solution templates provide comprehensivemonitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to configure
and deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.

Note:

l An in-depth description of theMicrosoft SharePoint 2010 Solution Template is available in the
SiteScopeMicrosoft SharePoint 2010 Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_SharePoint_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

l TheMicrosoft SharePoint 2010 solution templates are also supported in SiteScopes that are running
on UNIX versions if the remote server beingmonitored has been configured for SSH and the SSH
connectionmethod is used in the template. For details, see "Configure RemoteMonitoring Using
Secure Shell (SSH)" on page 439.

To access
Select the Templates context. In the template tree, expandSolution Templates > Microsoft SharePoint
2010, and select the required SharePoint template.

Learn About
SharePoint Environment
TheMicrosoft SharePoint 2010 solution template deploys monitors that target availability, performance, and
health of the following aspects of a SharePoint environment:

l IIS Process
l InfoPath Service
l Publishing Service
l Search Service
l Service Application
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l SharePoint Server
l SQLServer

License Consumption

Points-based Usage Capacity-based Usage

74 points per solution
template

Available with Community, Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the Microsoft SharePoint 2010 Solution Templates
This task describes the steps involved in deploying theMicrosoft SharePoint 2010 solution templates.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

Note: TheMicrosoft SharePoint 2010 solution provides a number of templates in a template
container, that can be deployed either individually, or simultaneously, to a group. This enables you to
select only the templates that you require. For details on deployingmultiple templates
simultaneously, see Deploy multiple templates step in "How to Deploy Templates Using the User
Interface" on page 722.

UI Descriptions
Microsoft SharePoint 2010 Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

Host The host name of theMicrosoft SharePoint instance.

User Name The user namewith admin credentials on themonitoredMicrosoft SharePoint instance.
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UI Element Description

Password Password for the user on themonitoredMicrosoft SharePoint instance.

Connection
method

Themethod used to connect to the server. Options are NetBIOS, WMI, and SSH.

Default value:NetBIOS

Remote
server
encoding:

Encoding for the remote server if the remote server is running an operating system version
that uses a different character encoding than the server on which SiteScope is running. This
enables SiteScope to display encoded content correctly.

Default value:Cp1252

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Tests the connection created from the template remote servers after the template has been
deployed. The test is performed in the background, enabling you to continue to use
SiteScope.

Default value:Not selected
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Chapter 83: Microsoft SQL Server Solution
Template
TheMicrosoft SQL Server solution templates are templates that you can use to deploy a collection of
monitors configured with default metrics that test the health, availability, and performance of Microsoft SQL
servers.

TheMicrosoft SQL Server solution templates provide comprehensiveMicrosoft SQL server monitoring
without requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the
time to configure and deploy performancemonitors, helps identify both real-time performance bottlenecks and
longer term trends, and adds only minimal overhead to production systems.

Note: An in-depth description of theMicrosoft SQL Solution Template is available in the SiteScope
Microsoft SQL Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_MSSQL_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
solution (Microsoft SQL Server 2005, 2008 orMicrosoft SQL Server 2008 R2, 2012, 2014).

Learn More
Supported Versions
l Microsoft SQL Server 2005, 2008 solution template supports Microsoft SQL Server 2005 and 2008.
l Microsoft SQL Server 2008 R2, 2012, 2014 solution template supports Microsoft SQL Server 2008 R2,
2012, and 2014.

Solution Template Monitors
TheMicrosoft SQL Server solution templates deploy monitors that target the following aspects of Microsoft
SQL server performance and health:

l CPU status and utilization details
l Memory status and utilization details
l Disk utilization information
l SQLServer availability
l SQLServer objects (Buffer Manager, Databases, Locks, Transactions, Batch request, Cache)
l SQLServer resources (space available, percentage of currently connected users, I/O utilization, latches,
mirroring, replication, data access)

l Errors in SQL Server
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TheMicrosoft SQL Server solutionmakes use of the SiteScope Database Counter monitor, Microsoft SQL
Server monitor, andMicrosoft Windows Resources monitor. For detailed information about thesemonitors,
see Database Counter Monitor, Microsoft SQL Server Monitor, andMicrosoft Windows Resources Monitor.

License Consumption

Points-based Usage Capacity-based Usage

Microsoft SQL Server - 18 points per
solution template

Microsoft SQL Server 2008 R2 - 43
points per solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing
edition, see the SiteScope Deployment Guide.

Tasks
How to Deploy the Microsoft SQL Server Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Microsoft SQL Server solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l The SiteScope server must be able to connect to the target Microsoft SQL host. Use theMicrosoft
Windows Resources Monitor to monitor the server performance statistics from remoteWindows
servers. TheMicrosoft Windows Resourcemonitor may require special configuration. For details, see
Microsoft Windows Resources Monitor in the SiteScopeMonitor ReferenceGuide.

l The target server must be added to SiteScope as aWindows remotemachine and should pass the
Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For details, see
"Configure SiteScope toMonitor RemoteWindows Servers" on page 402.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope toMonitor a RemoteMicrosoft Windows Server" on
page 402.

l The SQL Server user must haveVIEW SERVER STATE permissions on themonitored SQL Server
instance to retrieve data from SQLServer System Views. For more information about granting
permissions onMicrosoft SQL Server, see http://msdn2.microsoft.com/en-
us/library/ms186717.aspx.

Note: SiteScope and the target Microsoft SQL Server can run on the same host.

l (For Microsoft SQL Server 2014) Perform the following when using a remote database instance:
i. Enable the TCP/IP protocol for the database instance.
ii. Enable the firewall (add inbound rule for firewall)
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iii. On theStartmenu, click All Programs > Microsoft SQL Server 2014 > Configuration Tool
> SQL Server Configuration Manager. In SQL Server ConfigurationManager, in the console
pane, expandSQL Server Network Configuration, expandProtocols for <instance name>,
double-click TCP/IP, and then changeEnabled to “Yes”.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Microsoft SQL Server 2005, 2008
User interface elements (Variable Values) are described below:

UI Element Description

Microsoft SQL
Server URL

URL for themonitoredMicrosoft SQL Server instance.

l Replace ${host}with the host name on which theMicrosoft SQL Server is running.
This must be the same as the host name defined for theWindows remotemachine.
For details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on
page 406.

l Replace ${port}with the port number on which theMicrosoft SQL Server accepts
connections. By default, the port is 1433.

Example: jdbc:mercury:sqlserver://doors:1433

Microsoft SQL
Server
instance name

Name of the SQL Server service instance.

Default value:SQLServer (MSSQLSERVER)

Login to
Microsoft SQL
Server

Login name for the user on themonitoredMicrosoft SQL Server instance.

Microsoft SQL
Server
password

Password for the user on themonitoredMicrosoft SQL Server instance.

SERVER_LIST Name of the server you want to monitor. If the server you want to monitor is not in the
list, youmust define a connection profile to the server. For the steps you use to create a
Windows connection profile, see "Configure SiteScope toMonitor RemoteWindows
Servers" on page 402.
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UI Element Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Microsoft SQL Server 2008 R2, 2012, 2014
User interface elements (Variable Values) are described below:

UI Element Description

Microsoft SQL
Server 2008
R2, 2012, 2014
URL

URL for themonitoredMicrosoft SQL Server instance.

l Replace ${host}with the host name on which theMicrosoft SQL Server is running.
This must be the same as the host name defined for theWindows remotemachine.
For details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on
page 406.

l Replace ${port}with the port number on which theMicrosoft SQL Server accepts
connections. By default, the port is 1433.

Example: jdbc:mercury:sqlserver://doors:1433

Login to
Microsoft SQL
Server 2008
R2, 2012, 2014

Login name for the user on themonitoredMicrosoft SQL Server instance.

Password to
Microsoft SQL
Server 2008
R2, 2012, 2014

Password for the user on themonitoredMicrosoft SQL Server instance.

Microsoft SQL
Server 2008
R2, 2012, 2014
agent service
name

Name of the SQL Server agent service.

Default value:SQLServer (MSSQLSERVER)
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UI Element Description

Microsoft SQL
Server 2008
R2, 2012, 2014
service
instance name

Name of the SQL Server service instance.

Default value:SQLServer (MSSQLSERVER)

Microsoft SQL
Server 2008
R2, 2012, 2014
service name

Name of the SQL Server service.

Default value:SQLServer

Microsoft SQL
Server 2008
R2, 2012, 2014
service name
with escaped $ 
character

Name of the SQL Server service (same as previous field unless the service name
contains the $  character).

If the service name contains the $  character (used in regular expression counters), this
character should be escaped by adding a backslash ("\") in front of it. For example, a
SQL instance with the nameMYSQL$MYINSTANCE should be entered as
MYSQL\$MYINSTANCE.

SERVER_LIST Name of the server you want to monitor. If the server you want to monitor is not in the
list, youmust define a connection profile to the server. For the steps you use to create a
Windows connection profile, see "Configure SiteScope toMonitor RemoteWindows
Servers" on page 402.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Tips/Troubleshooting
NTLM Authentication Issue
When using NTLM authentication to deploy aMicrosoft SQL Server solution template, youmust make a copy
of the template and then remove the user names and passwords from theDatabase user name and
Database password fields for the followingmonitors:

l %CommandQueue Length
l % of lock memory
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l Database User Statistics
l Database availability
l Database cache
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Chapter 84: Microsoft Windows Host Solution
Template
TheMicrosoft Windows Host solution template is a template that you can use to deploy a collection of
monitors configured with default metrics that test the health, availability, and performance of theWindows
host.

For Microsoft Windows Resourcemonitors, you can create a Server-Centric report which displays data from
three different metrics about the server beingmonitored. For more information generating a Server-Centric
report, see "Create Server-Centric Reports" on page 1179.

Tip:We recommend using solution templates when creating theMicrosoft Windows ResourceMonitor,
because the requiredmonitors andmetrics are already configured.

TheMicrosoft Windows Host solution template provides comprehensiveWindows operating system
monitoring without requiring the SiteScope user or the IT organization to be experts on the application. It also
reduces the time to configure and deploy various performancemonitors, helps identify both real-time
performance bottlenecks and longer term trends, and adds only minimal overhead to production systems.

Note: An in-depth description of theMicrosoft Windows Host Solution Template is available in the
SiteScopeOperating System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected guide; the
password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and selectMicrosoft
Windows Host.

Learn About
Supported Versions
TheMicrosoft Windows Host solution template supports Microsoft Windows Server 2003, 2008, 2012 and
Microsoft Windows XP.

Solution Template Monitors
TheMicrosoft Windows Host solution template deploys monitors that target the following aspects of
Microsoft Windows performance and health:

l High-level CPU status and utilization details
l High-level Memory status and utilization details
l Disk utilization information
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License Consumption

Points-based Usage Capacity-based Usage

13 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the Microsoft Windows Host Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Microsoft Windows Host solution template.

Note: TheMicrosoft Windows Host Solution deploys aMicrosoft Windows ResourceMonitor for each
target host. This monitor is an additional monitor that is required for Server-Centric Report support.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l The SiteScope server must be able to connect to the target Windows host. Use theMicrosoft
Windows Resources Monitor to monitor the server performance statistics from remoteWindows
servers. TheMicrosoft Windows Resourcemonitor may require special configuration. For details, see
Microsoft Windows Resources Monitor in the SiteScopeMonitor ReferenceGuide.

l The target server must be added to SiteScope as aWindows remotemachine and should pass the
Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For details, see
"New/Edit Microsoft Windows Remote Server Dialog Box" on page 406.

Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For details,
see "How to Configure SiteScope toMonitor a RemoteMicrosoft Windows Server" on page 402.

l SiteScope and the target server can run on the same host if SiteScope is installed on aWindows
operating system supported by the template. The template supports Microsoft Windows XP,
Windows Server 2003, andWindows Server 2008.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for user interface deployment only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.
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UI Descriptions
Microsoft Windows Host Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. For the steps you use to create a
Windows connection profile, see "Configure SiteScope toMonitor RemoteWindows
Servers" on page 402.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 85: .NET Solution Template
The .NET solution templates enable you tomonitor .NET applications of servers that run aWindows operating
system. This solution template deploys a set of monitors that test the health, availability, and performance of
a .NET application and .NET environment on theWindows host.

The .NET solution templates provide comprehensive .NETmonitoring without requiring the SiteScope user or
the IT organization to be experts on the application. They also reduce the time to configure and deploy
monitors, help identify both real-time performance bottlenecks and longer term trends, and add only minimal
overhead to production systems.

Note: An in-depth description of the .NET Solution Template is available in the SiteScope .NET Best
Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_NET_
Best_Practices.pdf. This is a password protected guide; the password is provided after acquiring an HP
license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
.NET solution template.

Learn More
Supported Versions
The .NET solution templates support .NET 1.x and 2.x running onWindows Server 2003, 2012, andWindows
XP servers.

Solution Template Monitors
The .NET solution templates deploy monitors that target the following aspects of .NET performance and
health:

l .NET CLR Data. This category refers to the common language runtime data (environment of .NET
applications). It is designed to check several resource statistics for the .NET CLR for selected application.
The .NET solution template automatically configures monitors for server health.

l ASP.NET. This category is designed to check several resource statistics for the ASP.NET. It gathers
common information about application restarts and whole ASP.NET system stability. The .NET solution
template automatically configures monitors for server health.

l ASP.NET Applications. This category is designed to check several resource statistics for the selected
ASP.NET application. It gathers common information about application cache, errors, and other critical
information. The .NET solution template automatically configures monitors for server health.
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License Consumption

Points-based Usage Capacity-based Usage

One point per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the .NET Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
.NET solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l SiteScope server must be able to connect to the target Windows host. Use theMicrosoft Windows
Resources Monitor to monitor the server performance statistics from remoteWindows servers. The
Microsoft Windows Resourcemonitor may require special configuration. For details, seeMicrosoft
Windows Resources Monitor in the SiteScopeMonitor ReferenceGuide.

l The target server must be added to SiteScope as aWindows remotemachine and should pass the
Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For details, see
"New/Edit Microsoft Windows Remote Server Dialog Box" on page 406.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope toMonitor a RemoteMicrosoft Windows Server" on
page 402.

l SiteScope and the target .NET application can run on the same host if SiteScope is installed on a
Windows operating system supported by the template. The template supports Microsoft Windows XP
andWindows Server 2003.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.
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UI Descriptions
.NET Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

Server Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. See "Configure SiteScope toMonitor
RemoteWindows Servers" on page 402 for the steps you use to create aWindows
connection profile.

ASP.NET
Application
(ASP.NET
Application
only)

Name of the ASP.NET application you want to monitor. The namemust be as it appears in
the Task Manager.

Instance
(.NET CLR
Data only)

Name of the application you want to monitor. The namemust be the same as it appears in
the Task Manager, or can be whole system statistics (by default).

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 86: Oracle Database Solution
Template
You can use theOracle Database solution templates to deploy a set of monitors that test the health,
availability, and performance of anOracle database. The deployedmonitors check general system statistics,
such as cache hit ratios and disk I/O, and include tools that provide diagnostic information about important
aspects of the database.

This solution uses the Database Counter Monitor to collect performancemetrics from JDBC-accessible
databases. In addition, you can use theOracle Database solution template to deploy a collection of monitors
configured with default metrics.

Important systemmetrics are computed with data retrieved from system tables in the Oracle database. A
wide range of Oracle system tables such as V$SYSSTAT, V$LATCH, V$ROLL_STAT, and V$BUFFER_
POOL_STATISTICS are consulted to produce thesemetrics. In this way, the Oracle Database Solution
implements the equivalent of many of the systemmonitoring scripts that come bundled with the Oracle
installation.

TheOracle Database solution templates provide comprehensive Oracle databasemonitoring without requiring
the SiteScope user or the IT organization to be an expert on the application. They also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term trends,
and add only minimal overhead to production systems.

Note: An in-depth description of the Oracle Database Solution Template is available in the SiteScope
Oracle Database Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Oracle_Database_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select Oracle
Database 9i and 10g or Oracle Database 11g orOracle 12c.

Learn About
Supported Versions
TheOracle Database solution template supports Oracle 10g, 11g and 12c databases.

Solution Template Monitors
TheOracle Database solution template deploys monitors that target the following aspects of Oracle
performance and health:

l General System Statistics. Themost important V$SYSSTAT statistics aremonitored by default in the
monitors deployed by the Oracle Database Solution. Where applicable, thesemetrics are combined to
calculate deltas and rates on a per-second or per-transaction basis. Whenmonitoring the important
metrics from the V$ tables in the database, the Oracle Database Solution is a replacement for manually
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generated SQL scripts.
l Oracle Logs. Important Oracle log files aremonitored for ORA- errors. Users may customize these
monitors to look for specific text in a log file, depending on their database configuration.

l Diagnosing Database Problems. In addition to the deployedmonitors, Oracle Solution offers several
tools that can be used to gain diagnostic information about a database. Resource-intensive SQL
statements, shared server process contention, and the number of sessions waiting for specific events are
all examples of the diagnostic data that these tools can provide.

Oracle Database Solution Template Tools
TheOracle Database solution template deploys several tools that you can use to gather diagnostic
information about anOracle database. These tools are deployed to the same group as themonitors that are
deployed by the solution template. They are displayed inmuch the sameway as monitors but they are set as
disabled. These tools are identified by the bold text Solution Tool in theStatus field of the group content
table. Although the Solution tools are listed in themonitor table, they are not monitor instances. They do not
run automatically, do not display a status based on action results, nor do they trigger alerts. They are
preconfigured actions that make use of a SiteScope Diagnostic Tool to check certain statistics from the
Oracle database that may indicate a performance problem.

When the user clicks on one of these Solution Tools, SiteScopemakes a custom SQL query to the database
by using the Database Connection Test tool. The results of the query are found in a table at the bottom of the
page. From this page, the tool may be run as many times as necessary by clicking the Connect and Execute
Query button. Bear in mind that some tools may incur substantial overhead on the database, so executing
them in quick succession is not recommended.

List of Oracle Database Solution Tools
The following describes tools deployed as part of the Oracle Database Solution:
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Oracle Solution
Tool Name Description and Usage Guidelines

Top Ten SQL
Statements in
Logical IOs Per Row

This tool performs a query which is designed to locate themost resource-intensive
SQL statements being run in the database. The V$SQL table is queried for the ten
SQL statements which are performing themost logical IOs per row are displayed in
a table.

The statement IDs of these ten statements are displayed in a table, along with some
additional resource-usage data for each statement.

This additional data includes:

l Physical IO Blocks. The number of disk reads performed on behalf of the
statement.

l Logical IOs. The number of buffer gets performed on behalf of the statement.
l Rows Processed. The number of rows processed when executing the
statement.

l Logical IOs Per Row. The number of buffer gets performed per row that was
processed when executing the statement.

l Runs. The number of executions of the statement.
l Logical IOs Per Run. The number of buffer gets per statement execution.
Note: The action performed can have a significant affect on database resources and
should not be run frequently.

Number of Sessions
Waiting Per Event

This tool can be used in troubleshooting stuck sessions. When several sessions
become unresponsive, this tool can determine whether the stuck sessions are all
waiting on the same event. The tool action displays a table containing the number of
sessions waiting on specific events.

Shared Server
Process Contention
(CommonQueue
AverageWait Time)

This tool calculates the average wait time of the shared server message queue (the
CommonQueue as recorded in V$QUEUE). A high average wait timemay indicate
contention between shared server processes.

License Consumption

Points-based Usage Capacity-based Usage

Oracle Database 9i and 10g - 202
points per solution template

Oracle Database 12c - 156 points
per solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing
edition, see the SiteScope Deployment Guide.
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Tasks
How to Deploy Oracle Database Solution Templates
This task describes how to configure the server environment and enter variables for the Oracle Database
solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Youmust have CREATE SESSION system privileges to successfully deploy the Oracle Database 9i
and 10g solution template.

l Before deploying the Oracle Database solution template, consult the documentation for the Database
Counter Monitor and the Log File Monitor for information about some of the prerequisites and
parameters required by the solution template. For example, you findmore information on installing the
Oracle JDBC driver needed to communicate with the database and the format of the log file path
parameter.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

How to Run the Oracle Database Solution Tools
This task describes how to run the Oracle Database Solution Tools:

1. Click the group name for the group where the Oracle Solutionmonitors are deployed. TheGroup Detail
page opens.

2. Find the Solution Tool for the action that you want to run. See theName column for the Solution Tool for a
description of the action performed by that tool.

3. Click the Tools link to the right of the tool Name to run the action. The Database Connection Test page
opens. From this page, the tool may be run as many times as necessary by clicking theConnect and
Execute Query button.

Note:Wedo not recommend running the tools in quick succession, since some Solution Tools may
create significant overhead on the database depending on the query.

The upper portion of the Database Connection Test page displays the database connection parameters
used for the test. The results of the tool query are found in a table near the bottom of the page. Review the
results based on the Description and UsageGuidelines for that tool.
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UI Descriptions
Oracle Database Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

DatabaseConnection
URL

Connection URL to the database you want to connect to. The syntax is
jdbc:oracle:thin:@<server name or IP address>:<database server
port>;sid=<sid>.

Example: To connect to the ORCL database on amachine using port 1521 you
would use:

jdbc:oracle:thin:@206.168.191.19:1521:ORCL.

Note: The : and @ symbols must be included as shown.

DatabaseDriver Name of the JDBC driver to be used by this monitor. Each driver supports a
specific connection URL pattern, so it must match the URL entered in
Database Connection URL.

OracleAlertLogPath Full path to the Oracle alert log. ForWindows machines, this should be the
full UNC path. Enter the full path to the Oracle alert log. Consult your
database administrator or the Oracle documentation for information about
how to access this file.

OracleListenerLog
Path

Full path to the Oracle listener log. ForWindows machines, this should be the
full UNC path. Consult your database administrator or the Oracle
documentation for information about how to access this file.

DatabaseUserName User name that SiteScope should use to connect to the database.

DATABASEPASSWORD Password for the user name that SiteScope should use to connect to the
database.

Log File Encoding If the file content to bemonitored uses an encoding that is different than the
encoding used on server where SiteScope is running, enter the code page or
encoding to use. This may be necessary if the code page which SiteScope is
using does not support the character sets used in the target file. This enables
SiteScope tomatch and display the encoded file content correctly.

Examples: Cp1252, Cp1251, Cp1256, Shift_JIS, or EUC_JP.

SERVER_LIST Name of the server you want to monitor. If the server you want to monitor is
not in the list, youmust define a connection profile to the server.

For the steps you use to create a connection profile, see "Configure
SiteScope toMonitor RemoteWindows Servers" on page 402 or "Configure
SiteScope toMonitor Remote UNIX Servers" on page 420.
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UI Element Description

Database Hostname Name of the host where Oracle database is running. The host must be added
as a remote server in SiteScope.

Note: This is applicable only for the Oracle 12c Solution Template.

Database Port Port number on which the Oracle database service is running.

Note: This is applicable only for the Oracle 12c Solution Template.

Silent deployment Submits the template deployment request to a queue, and SiteScope handles
the deployment in the background. This enables you to continue to use
SiteScope without having to wait for the template deployment process to
finish. All submitted requests and their corresponding deployment results are
logged to <SiteScope root directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor properties
with remote server

Verifies the correctness of themonitor configuration properties in the template
against the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the
remote connection.

Default value:Selected

Chapter 86: Postgres Database Solution
Template
The Postgres Database solution template deploys a set of monitors that test the health, availability and
performance of a Postgres database.The deployedmonitors check general system statistics such as cache
hit ratios and disk I/O, and include tools that provide diagnostic information about important aspects of the
database.

The solution template uses the Database Counter monitor to collect performancemetrics and Port monitor to
check the availability of the database.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
Postgres Database solution template.

Learn More
Supported Versions
The Postgres Database solution template supports Postgres version 9.2 – 9.6 and Postgres Plus Advanced
Server (PPAS).
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License Consumption

Points-based Usage Capacity-based Usage

17 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

Tasks
How to Deploy the Postgres Database Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Postgres Database solution template.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
PostgresSQL Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

Port Port number where the database is running.

Default: 5432

Database
Name

Name of the database that you want to monitor.

Default: Openview.

Database
Hostname

Name of the host where the database is running.
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UI Element Description

Database
Connection
URL

The URL to the database connection. For example,
jdbc:postgresql://abc.domain:5432/openview
Default : jdbc:postgresql://[host]:[port]/openview

Database
Driver

The driver required to connect to the database.

Default:org.postgresql.Driver

Database
Username

Username credential to connect to the database.

Database
Password

Password required to connect to the database.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

Test remote
servers

Test connection to the remote server.
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Chapter 87: SAP Solution Templates
The SAP solution includes solution templates for themonitoring of key SAP components. The SAP solution
templates deploy a collection of monitors configured with metrics to report on availability and performance.
Thesemonitoring configurations have been researched using best practice data and expertise from various
sources.

The SAP solution templates provide comprehensive SAP monitoring without requiring the SiteScope user or
the IT organization to be experts on the application. They also reduce the time to configure and deploy
monitors, help identify both real-time performance bottlenecks and longer term trends, and add only minimal
overhead to production systems.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
SAP solution template.

Learn About
Supported Versions
The SAP solution templates support SAP R/3 servers (versions 4.5B and later).

Solution Template Monitors
The SAP solution templates deploys monitors that target the following aspects of SAP performance and
health:

l The SiteScope SAP R/3 Application Server solution template provides the tools you use tomonitor the
availability, usage statistics, and server performance statistics for SAP R/3 systems. This solution
template deploys a set of monitors that test the health, availability, and performance of SAP R/3 servers
(versions 4.5B and later).

l The SiteScope SAP NetWeaver Application Server solution enables you tomonitor the availability and
server statistics for SAP JavaWeb application server clusters. You can use this solution template to
deploy monitors for server-wide resources andmetrics.

License Consumption

Points-based Usage Capacity-based Usage

SAP NetWeaver Application Server -
13 points per solution template

SAP R/3 Application Server - 13 points
per solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load
Testing edition, see the SiteScope Deployment Guide.
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Tasks
How to Deploy the SAP Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
SAP solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l Youmust have SAP authorization of the remote system user. For details on theminimum SAP
permission required by SiteScope, see the sections on “AAAB - Cross-application Authorization
Objects” and “BC_A - Basis: Administration” in SAP RFC User privileges in the SAP documentation
(http://help.sap.com/saphelp_
nw70ehp1/helpdata/en/49/bb35b8623a489aa63abd9f5ebf2448/content.htm).

l For SAP R/3 Application Server:
o SAP Java Connector libraries should be copied to the required SiteScope folders.
o Youmust know the user name and password that SiteScopemust use to log into the SAP R/3

server.
For more information on system and configuration requirements, see SAP CCMS Monitor in the
SiteScopeMonitor ReferenceGuide. This monitor is deployed as part of the SAP R/3 solution
template.

l For SAP NetWeaver Application Server:
o SAP JavaWeb application server libraries must be copied to the required SiteScope folders.
o Youmust know the user name and password that SiteScopemust use to log into the SAP Java

Web application server.
For more information on system and configuration requirements, see SAP JavaWeb Application
Server Monitor in the SiteScopeMonitor ReferenceGuide. This monitor is deployed as part of the
SAP NetWeaver Application Server solution template.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
SAP R/3 Application Server
User interface elements (Variable Values) are described below:
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UI Element Description

SYSTEM_
NUMBER

System number for the SAP server.

USER_NAME User name required to connect to the SAP server.

Password Password required to connect to the SAP server.

CLIENT_
NUMBER

Client to use for connecting to SAP.

APPLICATION_
SERVER

Address of the SAP server you want to monitor.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

SAP NetWeaver Application Server
User interface elements (Variable Values) are described below:

UI Element Description

Password The password required to connect to the SAP JavaWeb Application Server.

PORT Port for the SAP JavaWeb Application Server.

USER_
NAME

User name required to connect to the SAP JavaWeb Application Server.

TARGET_
SERVER_
NAME

Address of the SAP JavaWeb Application Server you want to monitor.
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UI Element Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 88: Siebel Solution Templates
The SiteScope Siebel solution templates provide efficient and thoroughmonitoring of performance,
availability, and usage statistics for Siebel Application, Gateway, andWeb servers installed onMicrosoft
Windows and UNIX operating systems. There are separate solution templates for servers installed on UNIX
andWindows platforms.

The primary solution template for Siebel is the Siebel Application Server template. You use this template to
deploy monitoring for the core of the Siebel application. You use the Siebel Gateway Server and Siebel Web
Server templates if these optional components are deployed in the IT environment.

The Siebel solution templates provide comprehensive Siebel monitoring without requiring the SiteScope user
or the IT organization to be experts on the application. They also reduce the time to configure and deploy
various performancemonitors, help identify both real-time performance bottlenecks and longer term trends,
and add only minimal overhead to production systems.

Note: An in-depth description of the Siebel Solution Template is available in the SiteScope Siebel Best
Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_Siebel_
Best_Practices.pdf. This is a password protected guide; the password is provided after acquiring an HP
license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
Siebel solution template.

Learn More
Supported Versions
The Siebel solution templates support Siebel 6.x, 7.x, and 8.x application servers.

Solution Template Monitors
The Siebel Solution includes solution templates for monitoring the following key Siebel components:

l Siebel Application Server for UNIX/Windows. The SiteScope Siebel Application Server Solutions
enable you tomonitor the availability, usage statistics, and server performance statistics for Siebel
Application servers installed onWindows and UNIX platforms. These solution templates deploy a set of
monitors that test the health, availability, and performance of Siebel 6.x, 7.x, and 8.x application servers.

l Siebel Gateway Server for UNIX/Windows. The SiteScope Siebel Gateway Server Solutions enable
you tomonitor the availability and server statistics for Siebel Gateway Servers installed onWindows and
UNIX platforms. These solution templates deploy a set of monitors that test the health, availability, and
performance of Siebel Gateway Servers. You can use these solution templates to deploy monitors for
server-wide resources andmetrics.

l Siebel Web Server for UNIX/Windows. The SiteScope Siebel Web Server Solutions enable you to
monitor the availability and server statistics for Siebel Web servers installed onWindows and UNIX
platforms. These solution templates deploy a set of monitors that test the health, availability, and
performance of Siebel Web Servers.
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License Consumption

Points-based Usage Capacity-based Usage

Siebel Application Server 6.x-7.x for UNIX
- 93 points per solution template

Siebel Application Server 6.x-7.x for
Windows - 91 points per solution template

Siebel Application Server 8.x for UNIX -
98 points per solution template

Siebel Application Server 8.x forWindows
- 101 points per solution template

Siebel Gateway Server for UNIX - 6 points
per solution template

Siebel Gateway Server forWindows - 6
points per solution template

Siebel Web Server for UNIX - 19 points
per solution template

Siebel Web Server forWindows - 19
points per solution template

Available with Premium, Ultimate or System Collector
Editions.

Note: For the list of Solution Templates available with Load
Testing edition, see the SiteScope Deployment Guide.

Tasks
How to Deploy the Siebel Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Siebel Solution Template.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
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representative or use the “Contact Us” link in the HPE SiteScope Product page.

Solution
Template
Name Requirements

Siebel
Application
Server

l The Siebel Server Manager client must be installed only on aWindows machine
where SiteScope is running or that is accessible to the SiteScopemachine (even if
the Siebel application server is installed on UNIX). There are several options for how
you can do this. See the documentation for the Siebel Server Manager Monitor for
more information.

l Youmust know the install path for the Server Manager client to be able to setup
Siebel Server Manager monitors in SiteScope. If the client is installed on themachine
where SiteScope is running, this is the path on that machine. If the client is installed
on a remotemachine, youmust know the fully qualified path to the client executable
relative to that machine.

l Youmust know the name of the Siebel applications that are available in your network.
For example, call center, sales, and so on.

l Youmust know the Siebel databasemachine name, user name, password,
connection URL, and Database Driver.

l Youmust know the user and password that SiteScope uses for logging into the Siebel
server. This user must be granted Siebel Administrator responsibility on the Siebel
server.

l Youmust make sure that the following Siebel server component groups are enabled:

o Siebel Call Center (CallCenter)
o Siebel Remote (Remote)
o SystemManagement (System)
o Auxiliary SystemManagement (SystemAux) - Siebel 8.x only

l You need to know a significant list of Siebel system component names and their
corresponding aliases. For a listing of component names and aliases, see
"UI Descriptions" on the next page.
Note: Formore information on system and configuration requirements, see the
sections on the Siebel Web Server Monitor and DatabaseQuery Monitor. These
monitor types are deployed as part of the Siebel Application Server solution template.

Siebel
Web
Server

l SiteScope server must be able to connect to themachine where the Siebel Web
Server is running.

l Siebel Web Server Solution is designed for use with Siebel running onMicrosoft
Windows platforms.

l Template assumes that the Siebel Web Server is running onMicrosoft Internet
Information Server (IIS).
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2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
Siebel Solution Template Page
User interface elements (Variable Values) are described below for monitoring Siebel Application Server 6.x,
7.x, and 8.x onWindows and UNIX environments:

UI Element (A-Z) Description

Application Siebel Application Server machine name.

CG_Auxilary_System_
Management_Alias
(Siebel 8.x only)

Siebel Auxilary SystemManagement component group alias.

CG_Auxilary_System_
Management_Name
(Siebel 8.x only)

Siebel Auxilary SystemManagement component group name.

CG_Callcenter_Alias Siebel CallCenter component group alias.

CG_Callcenter_Name Siebel CallCenter component group name.

CG_System_
Management_Alias

Siebel SystemManagement component group alias.

CG_System_
Management_Name

Siebel SystemManagement component group name.

CP_Callcenter_Alias Siebel CallCenter component alias.

CP_Callcenter_Name Siebel CallCenter component name.

CP_Client_
Administration_Alias
(Siebel 6.x-7.x only)

Siebel Client Administration component alias.

CP_Client_
Administration_Nam
(Siebel 6.x-7.x only)

Siebel Client Administration component name.

CP_eService_Alias Siebel eService component alias.

CP_eService_Name Siebel eService component name.
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UI Element (A-Z) Description

CP_File_System_
Manager_Alias

Siebel File SystemManager component alias.

CP_File_System_
Manager_Name

Siebel File SystemManager component name.

CP_Server_Manager_
Alias

Siebel Server Manager component alias.

CP_Server_Manager_
Name

Siebel Server Manager component name.

CP_Server_Request_
Broker_Alias

Siebel Server Request Broker component alias.

CP_Server_Request_
Broker_Name

Siebel Server Request Broker component name.

CP_Server_Request_
Processor_Alias

Siebel Server Request Broker component alias.

CP_Server_Request_
Processor_Name

Siebel Server Request Processor component name.

Database_Connection_
URL

URL to the database connection.

Enter the connection URL to the database you want to connect to. The syntax
is jdbc:oracle:thin:@<server name or IP address>:<database server
port>;sid=<sid>.

Example: To connect to the ORCL database on amachine using port 1521
use:

jdbc:oracle:thin:@206.168.191.19:1521:ORCL.

Note: The colon and @ symbols must be included as shown.

Database_Driver Driver used to connect to the database.

Database_PASSWORD Password for the user name used to access the Siebel database.

Database_Username User name SiteScope should use to access the Siebel database.

Enterprise Siebel Enterprise server name.

Gateway Name of the Siebel Gateway server machine.

PASSWORD Password for the Siebel Client.

SERVER_LIST Name of the server where the Siebel Application Server is running.

Server_Logical_
Instance_Name

Siebel server logical name.
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UI Element (A-Z) Description

Server_Manager_Path Local path to the Siebel server manager client.

Example: D:\sea703\client\bin.

Siebel_Database_
Machine_Name

Siebel databasemachine name.

Siebel_Disk Disk drive namewhere Siebel is installed.

Siebel_Root_Dir Path of the shared Siebel root directory.

Example: The shared root directory for a Siebel 7.5.2 server would be: sea752.

Silent deployment Submits the template deployment request to a queue, and SiteScope handles
the deployment in the background. This enables you to continue to use
SiteScope without having to wait for the template deployment process to finish.
All submitted requests and their corresponding deployment results are logged
to <SiteScope root directory>\logs\silent_deployment.log.

Default value:Not selected

Username Siebel Client user name.

Verify monitor
properties with remote
server

Verifies the correctness of themonitor configuration properties in the template
against the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the
remote connection.

Default value:Selected

Siebel Gateway Server
User interface elements (Variable Values) are described below:

UI Element (A-Z) Description

SERVER_LIST Name of the server where the Siebel Gateway Server is running. Do not type
backslashes (\\), which indicates a UNC path as part of the name of the server.

Siebel_Disk Disk drive where the Siebel gateway server is running.

Siebel_Logical_
Instance_Name
(for UNIX only)

Siebel server logical name value (for UNIX only).

Siebel_Root_Dir Path to the Siebel root directory. This directory should contain at least an
Admin Console installation.
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UI Element (A-Z) Description

Silent deployment Submits the template deployment request to a queue, and SiteScope handles
the deployment in the background. This enables you to continue to use
SiteScope without having to wait for the template deployment process to finish.
All submitted requests and their corresponding deployment results are logged
to <SiteScope root directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with remote
server

Verifies the correctness of themonitor configuration properties in the template
against the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the
remote connection.

Default value:Selected

Siebel Web Server
User interface elements (Variable Values) are described below:

UI Element (A-Z) Description

Application Siebel application tomonitor.

Example: callcenter_enu. Consult with your Siebel administrator for
information about names of the installed Siebel applications.

Password Siebel Client password needed to log into the Siebel Web server.

SERVER_LIST Name of the Siebel Web server machine. Use the choose server to view the
server selection page. Use the Server drop-downmenu to select the server
where the Siebel Web server is running.

Siebel_Disk Disk drive name or drive letter where the Siebel Web server is installed.

Siebel_Logical_
Instance_Name

Siebel server logical name value (for UNIX only).

Siebel_Root_Dir Name of the shared Siebel root directory.

Example:Siebel root directory onWindows: sea752.

Silent deployment Submits the template deployment request to a queue, and SiteScope handles
the deployment in the background. This enables you to continue to use
SiteScope without having to wait for the template deployment process to finish.
All submitted requests and their corresponding deployment results are logged
to <SiteScope root directory>\logs\silent_deployment.log.

Default value:Not selected

Username Siebel Client user name needed to log into the Siebel Web server.
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UI Element (A-Z) Description

Verify monitor
properties with remote
server

Verifies the correctness of themonitor configuration properties in the template
against the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the
remote connection.

Default value:Selected
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Chapter 89: Solaris Host Solution Templates
The Solaris Host solution template is a template that you can use to deploy a collection of monitors configured
with default metrics that test the health, availability, and performance of the Solaris host.

For UNIX ResourceMonitors, you can create a Server-Centric report which displays data from three different
metrics about the server beingmonitored. For more information on generating a Server-Centric report, see
"Create Server-Centric Reports" on page 1179.

Tip:We recommend using solution templates when creating the UNIX ResourceMonitor, because the
requiredmonitors andmetrics are already configured.

The Solaris Host solution template provides comprehensive Solaris operating systemmonitoring without
requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the time to
configure and deploy various performancemonitors, helps identify both real-time performance bottlenecks and
longer term trends, and adds only minimal overhead to production systems.

Note: An in-depth description of the Solaris Host Solution Template is available in the SiteScope
Operating System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected guide; the
password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select Solaris Host.

Learn About
Supported Versions
The Solaris Host solution template supports Solaris 9 and 10.

Solution Template Monitors
The Solaris Host solution template deploys monitors that target the following aspects of Solaris performance
and health:

l CPU status and utilization details
l Memory status and utilization details
l File system status and utilization details

License Consumption

Points-based Usage Capacity-based Usage

13 points per solution
template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load Testing edition, see the
SiteScope Deployment Guide.

HPE SiteScope (11.33) Page 862 of 1206



Tasks
How to Deploy the Solaris Host Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
Solaris Host solution template.

Note: The Solaris Host solution template deploys a UNIX ResourceMonitor for each target host. This is
a supplemental monitor that is required for Server-Centric Report support.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l SiteScope server must be able to connect to the target Solaris host.

l The target server must be added to SiteScope as a UNIX remotemachine and should pass the UNIX
remote test (Remote Servers > UNIX Remote Servers). For user interface details, see "New/Edit
UNIX Remote Server Dialog Box" on page 422.

Note:

o The SiteScope server itself can also bemonitoring if it runs a supported Solaris operating
system.

o The template supports the Solaris versions supported by SiteScope. For details, see System
Requirements in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm).

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page for the Solaris Host solution template. For user
interface details, see the UI Descriptions section below.

UI Descriptions
Solaris Host Solution Template Page
User interface elements (Variable Values) are described below:
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UI Element Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the list,
youmust define a connection profile to the server. For the steps you use to create a UNIX
connection profile, see "Configure SiteScope toMonitor Remote UNIX Servers" on
page 420.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 90: VMware Capacity Management
Solution Templates
You can use the VMware Capacity Management solution templates to enable SiteScope to collect data from
VMwaremonitors and report it to the data store on the HP Operations agent. This data can then be used in
various supported reporting products, including HP Service Health Optimizer (SHO), HP's capacity
management solution, and Service Health Reporter (SHR), HP's service centric cross-domain reporting
solution.

The VMware Capacity Management solution template provides comprehensivemonitoring without requiring
the SiteScope user or the IT organization to be experts on the application. It also reduce the time to configure
and deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
VMware Capacity Management solution template (VMware Datastore, VMware Host, VMware Resource
Pool, VMware Virtual Machine).

Learn More
VMware Datastore Template
The VMware Datastore template uses the VMware Datastoremonitor to monitor performance related
resources (connectivity, capacity, free space, and snapshot size) on any VMware datastore virtual machines
(VMs) in the VMware datacenter.

When deploying the template, you need to specify the following template variables: connection_link (URL of
the VMware Datastore), username (of VMware Datastore administrator with view host permissions),
password (of the VMware Datastore), vc_name (VMware Datastore name), and select theVerify monitor
properties with remote server check box during template deployment.

For user interface details, see "VMware Datastore Deployment Values" on page 868.

Note: The VMware solution templatemonitors are not configured with threshold settings since the
reporting products require raw data and topology only.

VMware Host Template
The VMware Host template uses VMware Host monitors to monitor performance and configurationmetrics of
the VMware host server and its guest virtual machines. The VMware Host solution template deploys a set of
monitors against a particular VMware VirtualCenter. The templatemust be deployed for each host that you
want to monitor.

The VMware Host solution template deploys monitors that target the following aspects of VMware Host
performance:
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l VMware Host CPU
l VMware Host Memory
l VMware Host Storage
l VMware Host Network
l VMware Host State

Note: An in-depth description of the VMware Host Solution is available in the SiteScope VMware Host
Best Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_
VMware_Host_Best_Practices.pdf.

The template supports:

l VMware VirtualCenter 2.x
l VMware ESX 3.x, 4.0, 4.1
l VMware ESXi 3.5, 4.0, 4.1, 5.0, 5.1, 5.5, 6.0
l VMware ESX 2.5 via VirtualCenter 2.x
l VMware ESX 3.x via VirtualCenter 3.x
l VMware vSphere 4.0, 4.1, 5.0, 5.1 (also supported with SSO login), 5.5, 6.0
When deploying the template, you need to specify the following template variables: Host name, connection_
link (vCenter or Host URL), username (vCenter or Host usernamewith view host permissions), password
(vCenter or Host password), is vCenter (true if vCenter; false if Host), and select theVerify monitor
properties with remote server check box during template deployment.

For user interface details, see "VMware Host Deployment Values" on page 869.

The VMware Host monitors also report the following topology to APM:

l Cluster -> Host
l Datacenter -> Host
l Datacenter -> Cluster

VMware Resource Pool Template
The Resource Pool template uses the VMware Performancemonitor to monitor performance and
configurationmetrics for the Resource Pool. This template is per single Resource Pool, and it should be
deployed for all Resource Pools.

When deploying the template, you need to specify the following template variables: resource pool name,
vCenter url, username (vCenter usernamewith view Resource Pool permissions), password (vCenter
password), and select theVerify monitor properties with remote server check box during template
deployment.

For user interface details, see "VMware Resource Pool Deployment Values" on page 870.

The VMware Performancemonitor also reports the following topology to APM:

l Cluster -> Resource Pool
l ESX Host -> VM
l Cluster -> VM
l Cluster -> Resource Pool to VMs
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VMware Virtual Machine Template
The VM template uses the VMware Performancemonitor to monitor performance and configurationmetrics for
the VMs. The templatemust be deployed for each VM you want to monitor.

When deploying the template, you need to specify the following template variables: vm (VM name), vCenter
URL, username (vCenter usernamewith view VM permissions), password (vCenter password). We
recommend clearing theVerify monitor properties with remote server check box during template
deployment. Clearing this option deploys themonitor without connecting to the server, thereby enabling
template deployment on powered on and powered off VMs. When this option is selected (the default setting),
deployment fails for VMs that are not powered on.

For user interface details, see "VMware Virtual Machine Deployment Values" on page 870.

License Consumption

Points-based Usage
Capacity-based
Usage

Eachmonitor deployed by the template consumes an amount of points equal to the
number of distinct datastores and VM disks currently monitored by it (there are 2
monitors in the solution template). The distinction of the datastores/VM disks is within
themonitor. The same datastoremonitored by twomonitors will be charged 1 point by
eachmonitor. Example: If youmonitor 6 distinct datastores in the first monitor and 3
distinct VM disks in the secondmonitor: point consumption = 9

Available with
Community,
Ultimate, Premium
or System
Collector Editions.

Note: For the list
of Solution
Templates
available with
Load Testing
edition, see the
SiteScope
Deployment
Guide.

Tasks
How to Deploy the VMware Capacity Management Solution Templates
This task describes the steps involved in entering variables for the VMware Capacity Management solution
template.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.
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Note for the VMware Host Solution Template:

l The VMware Host Solution Template allows you tomonitor ESX hosts in two ways: via vCenter
or via the ESX host directly. We recommend that youmonitor ESX hosts directly to reduce load
on the vCenter machine.

l When a browsablemonitor is deployed in a template, the number of counters that match the
selected patterns is limited by the _maxCountersForRegexMatch parameter in the
 <SiteScope root directory>\groups\master.config file (this is in addition to the _
browsableContentMaxCounters parameter which limits the number of counters that browsable
monitors can have). If during deployment, the number of counters that match the patterns
exceeds this value, only the number of counters up to this value is saved. We recommend using
the same value for both these parameters (the default value for both of these parameters is 1000).

Tip:
We recommend deploying the solution template using a CSV file, since you can perform multiple
deployments at one time, without having tomanually enter variable values for each deployment in
the user interface.
You can create a CSV file for the VMware Capacity Management templates using the vSphere client
export to file option (File > Export > Export List). This enables you to export all VM names,
Resource Pool names, and Host names to the CSV file. After creating the file, you can edit the file
and add template variables such as vCenter URL, username, and password.

For details on deploying using a CSV file, see "How to Deploy Templates Using a CSV File" on
page 723.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

Tip:We recommend clearing theVerify monitor properties with remote server check box during
template deployment. Clearing this option deploys themonitor without connecting to the server,
thereby enabling template deployment on powered on and powered off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered on.

UI Descriptions
VMware Datastore Deployment Values
The VMware Datastore template uses the VMware Datastoremonitor to monitor performance related
resources (connectivity, capacity, free space, and snapshot size) on any VMware datastore virtual machines
(VMs) in the VMware datacenter.

User interface elements (Variable Values) are described below:

UI Element Description

connection_
link

URL of the VMware Datastore you want to monitor.
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UI Element Description

vc_name Name of the VMware Datastore you want to monitor.

username User name of the VMware Datastore administrator with view host permissions.

password Password of the VMware Datastore.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed. When this option is selected, deployment
time is slowed due to the remote connection.

Note:We recommend clearing this option during template deployment. Clearing this option
deploys themonitor without connecting to the server, thereby enabling template deployment
on powered on and powered off VMs. When this option is selected (the default setting),
deployment fails for VMs that are not powered on.

Default value:Selected

VMware Host Deployment Values
The VMware Host template uses VMware Host monitors to monitor performance and configurationmetrics for
the Hosts. The templatemust be deployed for each host that you want to monitor.

User interface elements (Variable Values) are described below:

UI Element Description

connection_
link

URL of the vCenter or host server you want to monitor.

username User name of the VMware VirtualCenter or host administrator with view host permissions.

password Password of the VMware VirtualCenter or host.

host Name of the VMware host you want to monitor.

is vCenter Enter true for vCenter, or false for the ESX host.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected
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UI Element Description

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed. When this option is selected, deployment
time is slowed due to the remote connection.

Note:We recommend clearing this option during template deployment. Clearing this option
deploys themonitor without connecting to the server, thereby enabling template deployment
on powered on and powered off VMs. When this option is selected (the default setting),
deployment fails for VMs that are not powered on

Default value:Selected

VMware Resource Pool Deployment Values
The Resource Pool template uses the VMware Performancemonitor to monitor performance and
configurationmetrics for the Resource Pool. The templatemust be deployed for each resource pool that you
want to monitor.

User interface elements (Variable Values) are described below:

UI Element Description

resource_
pool_name

Name of the Resource Pool want to monitor.

vcenter_url URL of the vCenter you want to monitor.

username User name of the VMware vCenter with view Resource Pool permissions.

password Password of the VMware vCenter.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed. This option should always be selected
during template deployment.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

VMware Virtual Machine Deployment Values
The VM template uses the VMware Performancemonitor to monitor performance and configurationmetrics for
the VMs. The Template is per single VM, and should be deployed for all VMs.

User interface elements (Variable Values) are described below:
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UI Element Description

vm Name of the VM you want to monitor.

vcenter_url URL of the vCenter you want to monitor.

username User name of the VMware vCenter with view VM permissions.

password Password of the VMware vCenter.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed. When this option is selected, deployment
time is slowed due to the remote connection.

Note:We recommend clearing this option during template deployment. Clearing this option
deploys themonitor without connecting to the server, thereby enabling template deployment
on powered on and powered off VMs. When this option is selected (the default setting),
deployment fails for VMs that are not powered on.

Default value:Selected
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Chapter 91: VMware Host Solution Template
You can use the VMware Host solution template to providemonitoring of different aspects of the VMware host
server. This includes monitoring of CPU, memory, network, state, and storage -related counters of the
VMware host server and its guest virtual machines.

The VMware Host solution template deploys a set of monitors against a particular VMware VirtualCenter.
Thesemonitors encompass best practices monitoring for the VMware host. This template includes the
VMware Host State, VMware Host CPU, VMware Host Memory, VMware Host Storage, and the VMware
Host Network monitors.

The VMware Host solution template provides comprehensivemonitoring without requiring the SiteScope user
or the IT organization to be experts on the application. It also reduce the time to configure and deploy
monitors, help identify both real-time performance bottlenecks and longer term trends, and add only minimal
overhead to production systems.

Tip:When to use which VMware Solution Template?

l If you want to monitor the VMware host for data collection and overall performance and availability,
you should use the VMware Host solution template.

l If you want to have the ability to find a specific performance problem and the root cause of it according
to VMware's best practices, you should use the "VMware Host For Performance Troubleshooting
Solution Template" on page 876. This template also includes most of themetrics included in the
VMware Host solution template.

Note: An in-depth description of the VMware Host Solution Template is available in the SiteScope
VMware Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_VMware_Host_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select theVMware
Host solution template.

Learn More
Supported Versions
The VMware Host solution template supports:

l VMware VirtualCenter 2.x
l VMware ESX 3.x, 4.0, 4.1
l VMware ESXi 3.5, 4.0, 4.1, 5.0, 5.1, 5.5, 6.0
l VMware ESX 2.5 via VirtualCenter 2.x
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l VMware ESX 3.x via VirtualCenter 3.x
l VMware vSphere 4.0, 4.1, 5.0, 5.1 (also supported with SSO login), 5.5, 6.0

Solution Template Monitors
The VMware Host solution template deploys monitors that target the following aspects of VMware Host
performance:

l VMware Host CPU
l VMware Host Memory
l VMware Host Network
l VMware Host Storage
l VMware Host State

License Consumption

Points-based Usage
Capacity-
based Usage

VMware Host monitors consume an amount of points equal to the number of distinct
hosts (ESX) and the VMs currently monitored by it. The solution template includes 5
VMware Host monitors, all of whichmonitor the ESX host, and 3 of the 5 alsomonitor
VMs on the ESX host. Example: If the ESX accommodates X VMs, the license
consumption will be as follows: (1 point per ESX + X points for X VMs) * 3 (number of
monitors that monitor ESX and VMs) + 2 (number of monitors that monitor ESX only) * 1
point per ESX If X = 4 (for example), license consumption: (1 + 4) * 3 + 2 = 17

Available with
Premium,
Ultimate or
System
Collector
Editions.

Note: For the
list of Solution
Templates
available with
Load Testing
edition, see the
SiteScope
Deployment
Guide.

Tasks
How to Deploy the VMware Host Solution Templates
This task describes the steps involved in entering variables for the VMware Host solution template.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
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For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

Tip:

l The VMware Host solution template allows you tomonitor ESX hosts in two ways: via vCenter or
via the ESX host directly. We recommend that youmonitor ESX hosts directly to reduce load on
the vCenter machine.

l We recommend deploying the solution template using a CSV file, since you can perform multiple
deployments at one time, without having tomanually enter variable values for each deployment in
the user interface. For details on deploying using a CSV file, see "How to Deploy Templates
Using a CSV File" on page 723.

Note:When a browsablemonitor is deployed in a template, the number of counters that match the
selected patterns is limited by the _maxCountersForRegexMatch parameter in the  <SiteScope
root directory>\groups\master.config file (this is in addition to the _
browsableContentMaxCounters parameter which limits the number of counters that browsable
monitors can have). If during deployment, the number of counters that match the patterns exceeds
this value, only the number of counters up to this value is saved. We recommend using the same
value for both these parameters (the default value for both of these parameters is 1000).

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Description
VMware Host Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

connection_
link

URL of the vCenter or host server you want to monitor (for loaded environments, it is
recommended to connect directly using a host server).

username User name of the VMware VirtualCenter or host administrator with view host permissions.

password Password of the VMware VirtualCenter or host.

host Name of the VMware host server you want to monitor.

is vCenter Enter true for vCenter, or false for the ESX host.
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UI Element Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed. Clearing this option deploys themonitor
without having to connect to the server, thereby enabling template deployment on powered-
on and powered-off VMs. When this option is selected (the default setting), deployment fails
for VMs that are not powered-on.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 92: VMware Host For Performance
Troubleshooting Solution Template
The VMware Host For Performance Troubleshooting solution template deploys a set of monitors that follow
VMware's official best practice scenarios for performance troubleshooting of VMware vSphere. These
monitors use SiteScope’s CalculatedMetrics to pinpoint specific performance problems on the VMware host,
and report the problematic ESX host and/or VMs. The template deploys the VMware Host CPU, Memory,
Network, State, and Storagemonitors to provide performance troubleshooting for-related counters on the
VMware host server and its guest virtual machines.

The VMware Host For Performance Troubleshooting solution template provides comprehensivemonitoring
without requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the
time it takes to configure and deploy monitors, helps identify both real-time performance bottlenecks and
longer term trends, and adds only minimal overhead to production systems.

Tip:When to use which VMware Solution Template?

l If you want to monitor the VMware host for data collection and overall performance and availability,
you should use the "VMware Host Solution Template" on page 872.

l If you want to have the ability to find a specific performance problem and the root cause of it according
to VMware's best practices, you should use the "VMware Host For Performance Troubleshooting
Solution Template" above. This template also includes most of themetrics included in the VMware
Host solution template.

Note: An in-depth description of the VMware Host For Performance Troubleshooting Solution Template
is available in the SiteScope VMware Host For Performance Troubleshooting Best Practices document,
available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_VMware_Perf_
Troubleshooting_Best_Practices.pdf. This is a password protected guide; the password is provided
after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select theVMware
Host For Performance Troubleshooting solution template.

Learn More
Supported Versions
The VMware Host For Performance Troubleshooting solution template supports:

l VMware VirtualCenter 2.x
l VMware ESX 3.x, 4.0, 4.1
l VMware ESXi 3.5, 4.0, 4.1, 5.0, 5.1, 5.5, 6.0
l VMware ESX 2.5 via VirtualCenter 2.x
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l VMware ESX 3.x via VirtualCenter 3.x
l VMware vSphere 4.0, 4.1, 5.0, 5.1 (also supported with SSO login), 5.5, 6.0

Aspects Covered by VMware Host Best Performance Troubleshooting
The VMware Host For Performance Troubleshooting solution template covers VMware best performance
troubleshooting practice diagrams that target the following aspects of VMware Host performance:

CPU Memory Network Storage

l Active VM Swap
Wait

l Guest CPU
Saturation

l High CPU Ready
Time on VMs
Running in an Under-
Utilized Host

l Host CPU
Saturation

l Active VMMemory
Compression

l Active VMMemory
Swapping

l HighGuest Memory
Demand

l HighMemory
Demand In a Host

l Past VMMemory
Swapping

l Dropped Receive
Packets

l Dropped Transmit
Packets

l Random Spikes in
Data Transfer Rate
on Network
Controllers

l Overloaded Storage
Device

l Slow Storage Device
l Under-Sized Storage
Device

l Random Spikes in
I\O Latency On a
Shared Datastore

For more details on the VMware best performance troubleshooting practice diagrams, see VMware's
Performance Troubleshooting for VMware vSphere 4.1 document
(http://communities.vmware.com/servlet/JiveServlet/downloadBody/14905-102-2-17952/vsphere41-
performance-troubleshooting.pdf).

The solution template targets VMware host performance by deployingmonitors (VMware Host
CPU/Memory/Network/Storage/State) with preconfigured counters and patterns. The patterns use regular
expressions in SiteScope's CalculatedMetrics. A pattern represents one or more counters.

Each of the above performance aspects is implemented in amonitor as a separate calculatedmetric that
returns 100 if a performance problem is encountered (Error state); otherwise it returns 1 (Good state).

Themonitors also have supporting calculatedmetrics that return problematic ESX, VM, VNIC, or DataStore
names. Supporting calculatedmetrics have the same name prefix as the diagram’s namewith a relevant
postfix (for example, Active VM Memory Compression - VM with Highest Compression Rate).

All of the calculatedmetrics have HostSystem as themonitored entity. Themonitored entity is set to a
specific HostSystem that was used upon template creation.
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License Consumption

Points-based Usage
Capacity-
based Usage

VMware Host monitors consume an amount of points equal to the number of distinct
hosts (ESX) and the VMs currently monitored by it. The solution template includes 5
VMware Host monitors, all of whichmonitor the ESX host, and 3 of the 5 alsomonitor
VMs on the ESX host. Example: If the ESX accommodates X VMs, the license
consumption will be as follows: (1 point per ESX + X points for X VMs) * 3 (number of
monitors that monitor ESX and VMs) + 2 (number of monitors that monitor ESX only) * 1
point per ESX If X = 4 (for example), license consumption: (1 + 4) * 3 + 2 = 17

Available with
Premium,
Ultimate or
System
Collector
Editions.

Note: For the
list of Solution
Templates
available with
Load Testing
edition, see the
SiteScope
Deployment
Guide.

Tasks
How to Deploy the VMware Host For Performance Troubleshooting Solution
Template
This task describes the steps involved in entering variables for the VMware Host For Performance
Troubleshooting solution template.

1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope Deployment
Guide. For license purchase inquiries (or if you require additional capacity), contact your HPE sales
representative or use the “Contact Us” link in the HPE SiteScope Product page.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

Tip:

l We recommend deploying the solution template using a CSV file, since you can perform multiple
deployments at one time, without having tomanually enter variable values for each deployment in
the user interface. For details on deploying using a CSV file, see "How to Deploy Templates
Using a CSV File" on page 723.

l When a browsablemonitor is deployed in a template, the number of counters that match the
selected patterns is limited by the _maxCountersForRegexMatch parameter in the
 <SiteScope root directory>\groups\master.config file (this is in addition to the _

Using SiteScope
Chapter 92: VMware Host For Performance Troubleshooting Solution Template

HPE SiteScope (11.33) Page 878 of 1206

http://www.hp.com/go/sitescope


browsableContentMaxCounters parameter which limits the number of counters that browsable
monitors can have). If during deployment, the number of counters that match the patterns
exceeds this value, only the number of counters up to this value is saved. We recommend using
the same value for both these parameters (the default value for both of these parameters is 1000).

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

Tip: The VMware Host For Performance Troubleshooting solution template allows you tomonitor
ESX hosts in two ways: via vCenter or via the ESX host directly. We recommend that youmonitor
ESX hosts directly to reduce load on the vCenter machine.

4. Adjust threshold settings - optional
Error orWarning thresholds are defined for the relevant calculatedmetrics according to the severity of the
performance problem detected. You can adjust the default threshold settings as required, and add
additional threshold settings.

5. Results
The solution template creates a new monitor group container in themonitor tree in which the individual
solutionmonitors are added. Themonitor group container is assigned a name in the format VMware Host
For Performance Troubleshooting on <server_name>where server_name is the server selected
from theServer box.
You can view, edit, and delete thesemonitors in the sameway as any other monitors in SiteScope.
When viewing reports on the solution templatemonitors, you should focus more on the regular counters
and less on the CalculatedMetrics.

Note:

l If a solution template deployment fails, a message displays reasons for the failure.

l If a calculatedmetric returns 100 (error state), you should refer to the supporting calculatedmetric
description (in the user interface or in the Best Practices guide) for more details.

UI Description
VMware Host For Performance Troubleshooting Solution Template Page
User interface elements (Variable Values) are described below:

UI Element Description

connection_
link

URL of the vCenter or host server you want to monitor.

username User name of the VMware VirtualCenter or host administrator with view host permissions.

password Password of the VMware VirtualCenter or host.
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UI Element Description

host Name of the VMware host server you want to monitor.

is vCenter Enter true for vCenter, or false for the ESX host.

High_CPU_
Usage

Value set on deployment, as a percentage, that defines high CPU usage for the host server.
If the host server's CPU usage exceeds this value it is considered high.

Default value: 80

Note: This variable valuemust be below 95.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed. Clearing this option deploys themonitor
without having to connect to the server, thereby enabling template deployment on powered-
on and powered-off VMs. When this option is selected (the default setting), deployment fails
for VMs that are not powered-on.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 93: WebLogic Solution Templates
TheWebLogic solution templates are templates that you can use to deploy a collection of WebLogic Monitors
configured with default metrics. Themonitors test the health, availability, and performance of aWebLogic
Application Server and its deployed applications and components. The deployedmonitors check server-wide
statistics such as memory usage, as well as metrics specific to individual J2EE components, such as the
number of activates and passivates of a particular EJB.

This solution automatically creates several groups by default whichmonitor important application server
metrics, but it also provides a user interface that enables you to select all or some of the individual
components that are available for monitoring.

TheWebLogic Solutionmonitor deployment process is highly customizable in that it enables you to select the
specific J2EE components on an application server which SiteScope should actively monitor.

TheWebLogic solution templates provide comprehensiveWebLogic monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to configure
and deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.

Note: An in-depth description of theWebLogic Solution Template is available in the SiteScopeWebLogic
Best Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_
WebLogic_Best_Practices.pdf. This is a password protected guide; the password is provided after
acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
WebLogic solution template.

Learn About
Supported Versions
TheWebLogic solution templates support WebLogic 6.x, 7.x, 8.x, 9.x, and 10.x servers.

Solution Template Monitors
TheWebLogic solution templates deploy monitors that target the following aspects of WebLogic performance
and health:

l Server Performance Statistics. This category refers to a collection of server-wide resources that are
exposed through themanagement interface of aWebLogic Application Server.

l Application Performance Statistics.Metrics for all of your deployed applications, EJBs, web
applications, and servlets are available for monitoring through theWebLogic Solution. The user is
responsible for selecting which of these J2EE components he would like to havemonitors automatically
deployed for. A set of metrics based onWebLogic best practices aremonitored for each selected J2EE
component.
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l WebLogic Solution Metrics. For the list of components that can bemonitored, see the SiteScope
WebLogic Best Practices document.

Selecting WebLogic Modules for Monitoring
TheWebLogic Solution presents a hierarchical list from which the user can select themodules to deploy
WebLogic Monitors against. This list is broken down into twomain sections:

l Per-server resources
l J2EE components organized by application
Some of themodules in these categories are automatically selected by default because they represent critical
components in the system (for example, the JVM statistics for the application server). The remainder of the
modules are not automatically selected. This enables you to customize the deployment of this solution to
focus on one application, a particular type of EJB, a set of servlets and web applications, or some other
aspect of the application server.

For themost part, the organization of this list of modules is intuitive. The hierarchy of applications, EJBs, web
applications, and servlets is very similar to the organization of these entities in theWebLogic Administration
Console. In almost every case, selecting amodule causes amonitor with all relevant metrics to be deployed
against that part of theWebLogic server. However, when selecting EJBs tomonitor, you notice that they are
broken down according to three types of metrics: Pool, Transaction, and Cache. The reason for this is
twofold: (1) it is more useful to be able tomonitor one aspect of a particular EJB instead perWebLogic Monitor
for purposes of alerting and organization, and (2) not all three of these types of metrics are available for all
EJBs.

Below is a brief description of themetrics that aremonitored for each type of EJB monitoring:

l Per-EJB Transaction Statistics. This category of EJB monitor contains metrics related to transactions
made for the EJB. Thesemetrics include the number of transactions rolled back, the number of
transactions that timed out, and the number of transactions that were successfully committed.

l Per-EJB Pool Statistics. This category of EJB monitor contains metrics related to the pool for the EJB.
When the user selects an EJB under this heading, many useful metrics aremonitored, including the
number of times an attempt to get a bean instance from the pool failed, the number of current available
instances in the pool, the number of threads currently waiting for an instance, and the number of times a
bean instance was destroyed due to a non-application exception.

l Per-EJB Cache Statistics. The cache statistics include any metrics relating to the caching of the
particular EJB. Metrics like the number of cache hits andmisses, and the number of activates and
passivates of the EJB aremonitored when an EJB under this heading is selected for monitoring.

License Consumption

Points-based Usage Capacity-based Usage

WebLogic 6.x, 7.x, 8.x Application
Server - 51 points per solution template

WebLogic 9.x-10.x Application Server -
63 points per solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load
Testing edition, see the SiteScope Deployment Guide.
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Tasks
How to Deploy the WebLogic Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
WebLogic solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l TheWebLogic solution template deploys aWebLogic Application Server Monitor for eachmodule that
is selected from the user interface. This monitor uses the Java JMX interface to access Runtime
MBeans on theWebLogic server. AnMBean is a container that holds the performancemetrics. You
may need to set certain permissions on theWebLogic server for SiteScope to be able tomonitor
MBeans. For an overview on configuring access toWebLogic servers for SiteScopemonitors, see
WebLogic Application Server Monitor in the SiteScopeMonitor ReferenceGuide.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section below.

4. Select WebLogic modules for monitoring
For a brief description of themetrics that aremonitored for each type of EJB monitoring, see "Selecting
WebLogic Modules for Monitoring" on the previous page.

5. Update themain browser window
Scroll to the bottom of theModule Selection window and click theSelect Modules button. This updates
themain browser window with a list of themodules you selected. You can then review your selections
and remove any modules for which you do not want to create amonitor.
When you are satisfied with the list of selectedmodules in themain browser window, click Submit.

UI Descriptions
WebLogic 9.x-10.x
TheMain Settings include the following elements:
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UI Element Description

WEBLOGIC_
URL

URL for theWebLogic 9.x or 10.x application server.

Default value: service:jmx:rmi:///jndi/iiop://<local
host>:7001/weblogic.management.mbeanservers.runtime

where <local host> is the name of themachine runningWebLogic Application Server 9.x
or 10.x.

Counters Displays the server performance counters you want to check with this monitor. Use the
Get Counters button to select counters.

Get
Counters

Opens theGet Counters dialog box, enabling you to select the counters you want to
monitor.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected

WebLogic 6.x, 7.x, 8.x
User interface elements (Variable Values) are described below:

UI Element Description

WEBLOGIC_
PORT

Port number that theWebLogic server is responding on.

Default value: 7001

WEBLOGIC_
PASSWORD

Password required to log into theWebLogic server.

WEBLOGIC_
USERNAME

User name required to log into theWebLogic server.

WEBLOGIC_
SERVER

Name or address of the server whereWebLogic is running.

WEBLOGIC_
TIMEOUT

Number of seconds to wait for a data request to arrive at theWebLogic server.

Default value: 180
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UI Element Description

WEBLOGIC_
JAR_FILE

Absolute path to the weblogic.jar file on the SiteScopemachine. This file must be
installed on the SiteScope server and can be downloaded from theWebLogic server.

Example:c:\bea\weblogic7\ebcc\lib\ext\weblogic.jar.

Counters Displays the server performance counters you want to check with this monitor. Use the
Get Counters button to select counters.

Get
Counters

Opens theGet Counters dialog box, enabling you to select the counters you want to
monitor.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of themonitor configuration properties in the template against the
remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Chapter 94: WebSphere Solution Templates
TheWebSphere solution templates are templates that you can use to deploy a collection of WebSphere
Monitors configured with default metrics. Themonitors test the availability, server statistics, and deployed
J2EE components for IBMWebSphere Application Servers. You can use this solution template to deploy
monitors for server-wide resources andmetrics (for example, thread pool and JVMmetrics). You can also
createmonitors for the deployed EJBs, Web Applications, and Servlets using this solution template.

TheWebSphere Solutionmonitor deployment process is highly customizable in that it enables you to select
the specific J2EE components on an application server which SiteScope should actively monitor.

TheWebSphere solution templates provide comprehensiveWebSpheremonitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to configure
and deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.

Note: An in-depth description of theWebSphere Solution Template is available in the SiteScope
WebSphere Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_WebSphere_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expandSolution Templates, and select the required
WebSphere solution template.

Learn About
Supported Versions
TheWebSphere solution templates support WebSphere Application Server 6.x, 7.x and 8.x.

Solution Template Monitors
TheWebSphere solution templates deploy monitors that target the following aspects of WebSphere
performance and health:

l Server Performance Statistics. This category refers to a collection of server-wide resources that are
exposed through themanagement interface of aWebSphere Application Server.

l Application Performance Statistics.Metrics for all of your deployed applications, EJBs, web
applications, and servlets are available for monitoring through theWebSphere Solution. The user is
responsible for selecting which of these J2EE components he would like to havemonitors automatically
deployed for. A set of metrics based onWebSphere best practices aremonitored for each selected J2EE
component.

l WebSphere Application Server Solution Metrics. For the list of components that can bemonitored,
see the SiteScopeWebSphere Best Practices document.
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License Consumption

Points-based Usage Capacity-based Usage

WebSphere 5.x Application Server -
20 points per solution template

WebSphere 6.x Application Server -
24 points per solution template

Available with Premium, Ultimate or System Collector Editions.

Note: For the list of Solution Templates available with Load
Testing edition, see the SiteScope Deployment Guide.

Tasks
How to Deploy the WebSphere Solution Template
This task describes the steps involved in configuring the server environment and entering variables for the
WebSphere solution template.

1. Prerequisites
l Solution Templates are only available in the user interface after acquiring an HPE license edition that
supports them. For information on licensing, refer to the Licensing section of the SiteScope
Deployment Guide. For license purchase inquiries (or if you require additional capacity), contact your
HPE sales representative or use the “Contact Us” link in the HPE SiteScope Product page.

l TheWebSphere server environment must be configured according to the environment being used. For
details, seeWebSphere Application Server Monitor in the SiteScopeMonitor ReferenceGuide.

Note: By default, theWebSphere 6.x Application Server solution template uses the internal JVM
mechanism. Accordingly, when using this solution template, configure themonitoring
environment to use internal Java. For details, see How to configure theWebSphere 6.0x server
environment using internal Java and How to configure theWebSphere 6.1x server environment
using internal Java.

2. Deploy the solution template
For themethods available for deploying a solution template and a detailed overview of the steps involved,
see "How to Deploy a SiteScope Solution Template" on page 767.

Note: If you deploy theWebSphere Application Server solution template using a CSV file, you need
to specify the path using double slashes. For example: C:\\Folder\\WAS_8.5

Perhaps, it need to be described in docs.
3. Enter deployment values for the solution template (for deployment through the user interface only)

Complete the items on the Deployment Values page as described in the UI Descriptions section below.

UI Descriptions
WebSphere Solution Template Page
User interface elements (Variable Values) are described below:
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UI Element Description

WEBSPHERE_
SERVER

Name of the server where theWebSphere Application is running. Do not type
backslashes (\\) that indicate a UNC path as part of the name of the server.

WEBSPHERE_
PORT

Port number of theWebSphere server.

Default value: 8880

WEBSPHERE_
USER_
NAME

User name that SiteScope should use to log on to theWebSphere Application server.

InWebSphere 6.x, Global Security is not supported in the solution template. This means
that you can type in any text however, the text box cannot be left empty. If you need to
work with Global Security, complete this template. Edit theWebSpheremonitor and, in
theMonitor Settings panel, update the Global Security boxes (Trust store, Trust store
password, Key store, Key store password).

WEBSPHERE_
PASSWORD

Password that SiteScope should use to log on to theWebSphere server.

InWebSphere 6.x, Global Security is not supported in the solution template. This means
that you can type in any text however, the text box cannot be left empty. If you need to
work with Global Security, complete this template. Edit theWebSpheremonitor and, in
theMonitor Settings panel, update the Global Security boxes (Trust store, Trust store
password, Key store, Key store password).

WEBSPHERE_
KEY_STORE_
FILE

Enter the path of the SSL key store file. This file is typically used to store personal
certificates, including private keys. This file is in the client monitor directory on the
SiteScopemachine.

Default value:C:\WebSphere\AppServer\profiles\default\etc\DummyClientKeyFile.jks

WEBSPHERE_
KEY_STORE_
PASSWORD

Password for the SSL key store file.

Default value:WebAS

WEBSPHERE_
TRUST_
STORE_FILE

Enter the path of the SSL trust store file. This file is typically used to store signer
certificates, which specify whether the signer of the server's certificate is trusted. This
file is in the client monitor directory on the SiteScopemachine.

Default value:
C:\WebSphere\AppServer\profiles\default\etc\DummyClientTrustFile.jks

WEBSPHERE_
TRUST_
STORE_
PASSWORD

Password for the SSL trust store file.

Default value:WebAS

WEBSPHERE_
CLIENT_
PROPERTIES_
FILE

The client properties file.

Default value: /properties/soap.client.props
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UI Element Description

WEBSPHERE_
DIRECTORY

Path to theWebSphere directory that contains the /java and /lib subdirectories from
theWebSphere Application Server.

InWebSphere 6.x, this directory must also contain /profiles subdirectory. This
subdirectory has all Key Store and Trust Store files needed for Global Security. The
server profile in /profiles subdirectory must be called default. If the server profile has
a different name, rename it to default.

WEBSPHERE_
VERSION

Select the version of theWebSphere Application server you aremonitoring (6.0x, 6.1x,
7.0x, 8.0x, 8.5x).

Default value: 6.0x forWebSphere 6.x solution template, 7.0x forWebSphere 7.x
solution template, 8.0x forWebSphere 8.x solution template.

WEBSPHERE_
USE_
EXTERNAL_
JV
(WebSphere 6.x
solution only)

Enables using external JVMs for monitoring. By default, theWebSpheremonitor uses
internal JVMs. External JVMs consume greater resources, take longer to start up, and
have bad error handling.

Note:You cannot use certificates added using Certificate Management if external JVMs
are used.

Default value: false

Counters Displays the server performance counters you want to check with this monitor. Use the
Get Counters button to select counters.

Get Counters Opens theGet Counters dialog box, enabling you to select the counters you want to
monitor.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.

Default value:Not selected

Verify monitor
properties with
remote server

Verifies the correctness of themonitor configuration properties in the template against
the remote server on which the template is deployed.

Note:When this option is selected, deployment time is slowed due to the remote
connection.

Default value:Selected
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Part 10: SiteScope Dashboard
You can view current performance data for the infrastructure elements beingmonitored by SiteScope in the
SiteScope Dashboard. It displays a table of groups andmonitors for the element highlighted in themonitor tree
or listed in the path. You can double-click each group or monitor node to navigate to child nodes andmonitors.
You can also perform actions on groups or monitors from the Dashboard. For details, see "View andManage
Data in the SiteScope Dashboard" on page 891.

Tip: Alternatively, you can use the Unified Console (amoremodern and intuitive Java-free interface) to
simplify themanagement of large, distributed environments, and to accelerate your ability to isolate and
diagnose problems. It also ideal for displaying enterprise-widemonitoring status andmanaging the event
lifecycle in a network operations setting. For details, see "Unified Console" on page 913.



Chapter 95: View and Manage Data in the
SiteScope Dashboard
The Dashboard displays current performance data for the infrastructure elements beingmonitored by
SiteScope and provides access to functions you use to define filters. The Dashboard displays a table of
groups andmonitors for the element highlighted in themonitor tree or listed in the path. You can double-click
each group or monitor node to navigate to child nodes andmonitors.

From the Dashboard, you can access Server-Centric reports, preconfigured reports, acknowledgemonitor
status, monitor tools, SiteScope Health Status, monitor history information, and enable/disable monitors and
alerts.

To access
Select theMonitors context. Select an object in themonitor tree, and click theDashboard tab in the right
pane.

Learn About
SiteScope Dashboard Overview
SiteScopemonitoring provides a real-time picture of system availability and performance. You configure
SiteScopemonitors to collect metrics from a range of infrastructure components, includingWeb, application,
database, and firewall servers. The status andmetrics are then aggregated for presentation in SiteScope
Dashboard.

Dashboard is linked to the SiteScopemonitor tree hierarchy. The data displayed in Dashboard represents the
selected context in themonitor tree. The highest level is the SiteScope node and any applicable monitor
groups. The lowest-level element for display in a Dashboard view is an individual SiteScopemonitor and its
measurements.

Dashboard includes functions that you can use to customize the display of monitor information. This includes
defining named filter settings to limit the display of data to thosematching a defined criteria. You can also
select various data display options.

Dashboard also includes hyperlinks andmenus that you can use to navigate through the hierarchy of monitor
elements, manually run amonitor, disable monitors, and access alert definitions.

Customizing the SiteScope Dashboard
You can customize the display and content of SiteScope Dashboard by setting the layout, configuring filters,
and saving the view to favorites.

Use the Dashboard filter to filter themonitors that are displayed the Dashboard view. Dashboard filters are
separate from SiteScope tree filters (see "Filter Objects in the SiteScope View" on page 65). You can use
either Dashboard filters or SiteScope tree filters to filter the display of nodes to specific monitor types.
However, Dashboard filters are applied to the results of any currently selected tree filter setting. If a tree filter
setting is active, this may prevent the Dashboard filter from findingmonitors that match the filter criteria, even
if suchmonitors do exist in the SiteScope environment.
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Tip: Generally, it is best to use filters together with theShow All Descendent Monitors view option.
Filters remain active until you change or reset the filter criteria in the Dashboard Filter window.

You can filter the SiteScope Dashboard by the following criteria:

l Monitor names containing a specific text string.
l Monitors monitoring a specific host or server.
l Monitors reporting an error.
l Measurement results containing a specific text string.
The filter criteria are not applied to groups, alerts, or reports. You can use SiteScope tree filters to filter other
elements.

You can save a filter setting by defining the filter settings and then saving the view as a Dashboard Favorite.

For task details, see "How to Customize the SiteScope Dashboard" on page 894.

Acknowledging Monitor Status
The acknowledgment function can be used to track resolution of problems that SiteScope detects in your
system and network infrastructure. With this function, SiteScope keeps a record of when the problem was
acknowledged, what actions have been taken, and by which user.

It also enables you to temporarily disable alerting on themonitors. This is useful to avoid redundant alerts
while a problem is being actively addressed. You can also use the acknowledgment function as a simple
trouble ticket system whenmore than one person uses SiteScope tomanage system availability.

Note: The acknowledgment function is available in Dashboard view and inMulti-View only. The
acknowledgment icon is displayed only in Dashboard Detailed views.

You can add an acknowledgment to individual monitors or monitor groups. An acknowledgment added to a
monitor applies only to that monitor. Any alert disable condition selected in the acknowledgment applies only
to that monitor instance. Acknowledging a group applies the acknowledgment description and alert disable
conditions to all monitors within the group. Acknowledgments applied to a group can be edited or deleted
individually for monitors in the group.

Only one acknowledgment can be in force for amonitor or group at any given time. Acknowledgment
comments and acknowledgment indicators continue to be displayed in the interface until they are deleted,
even after any applicable alert disable schedule has expired.

Acknowledgment data and comments are written to a log file on the SiteScopemachine. A new log entry is
made each time you add, edit, or delete an acknowledgment. After a problemmonitor or group is
acknowledged, or the acknowledged status is cleared, you can view the history in the Acknowledge Log. The
Acknowledge Log for an item can be viewed even if there is no acknowledgment currently in force.

For task details, see the "Acknowledgemonitors" step in "How to Analyze Data in the SiteScope Dashboard"
on page 895.

Testing Monitor Configuration Using Diagnostic Tools
SiteScope contains a number of tools that can be used to test themonitoring environment. You can use these
tools to query the systems you aremonitoring and view detailed results of the action. This may include simply
testing network connectivity or verifying login authentication for accessing an external database or service.
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The Tools button is enabled in the Dashboard when configuring or viewing themonitor instances listed
below:

Monitor Tool

Active Directory Replicationmonitor "LDAP Authentication Status Tool" on page 102

CiscoWorks monitor "SNMP Browser Tool" on page 121

CPU monitor "Performance Counters Tool" on page 113

Database Counter monitor "Database Connection Tool" on page 94

DatabaseQuery monitor "Database Connection Tool" on page 94

DB2 JDBC monitor "Database Connection Tool" on page 94

Dynamic Disk Spacemonitor "Performance Counters Tool" on page 113

DNS monitor "DNS Tool" on page 97

F5 Big-IP monitor "SNMP Browser Tool" on page 121

FTP monitor "FTP Tool" on page 100

LDAP monitor "LDAP Authentication Status Tool" on page 102

Mail monitor "Mail Round Trip Tool" on page 109

Memory monitor "Performance Counters Tool" on page 113

Microsoft Windows Event Logmonitor "Event Log Tool" on page 98

Microsoft Windows Performance Counter monitor "Performance Counters Tool" on page 113

News monitor "News Server Tool" on page 112

Oracle 9i Application Server monitor "URL Tool" on page 128

Pingmonitor "Ping Tool" on page 115

Port monitor "Ping Tool" on page 115

Servicemonitor "Services Tool" on page 118

SNMP monitor "SNMP Tool" on page 123

SNMP by MIB monitor "SNMP Browser Tool" on page 121

SNMP Trapmonitor "SNMP Trap Tool" on page 126

Technology Database Integrationmonitor "Database Connection Tool" on page 94

Technology SNMP Trap Integrationmonitor "SNMP Trap Tool" on page 126

URLmonitor "URL Tool" on page 128
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Monitor Tool

URLContent monitor "URL Tool" on page 128

Web Servicemonitor "Web Service Tool" on page 132

XMLMetrics monitor "XSL Transformation Tool" on page 136

For task details, see "How to Use SiteScope Diagnostic Tools to Test Monitor Configuration" on the next
page.

For the complete list of diagnostic tools that are available in SiteScope, click the Tools button in the lower left
pane of SiteScope. For details, see "SiteScope Tools" on page 91.

Tasks
How to Customize the SiteScope Dashboard
This task describes the steps involved in customizing the display and content of SiteScope Dashboard by
setting the layout, configuring filters, and saving the view to favorites.

1. Set the Dashboard layout
a. Prerequisites

Youmust be an administrator in SiteScope, or a user grantedEdit layout permissions to be able to
set the layout fields, andEdit favorites permissions to be able to add or delete items in the favorite
views list in the SiteScope Dashboard view. For details, see "User Management Preferences" on
page 625.

b. Select theMonitors context. In the Dashboard toolbar, click theDashboard Settings button.
c. Customize the display of group andmonitor information using the settings on the Dashboard

Settings dialog box.
For user interface details, see "Dashboard Settings Dialog Box" on page 900.

2. Select and set a Dashboard filter - optional
Configure and set a Dashboard filter by enteringmatch criteria and selecting from the options available
on the Dashboard Filter dialog box.
Any combination of filter options can be included in a single filter. For example, the filter definition can
filter on a combination ofMonitor type,Monitored target server, andStatus.
For user interface details, see "Dashboard Filter Dialog Box" on page 898.

Example:Dashboard Filter
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3. Save view to favorites
After defining the Dashboard filter and layout settings, you can save them as a named favorite view in the

Favorites list by clicking the arrow next to theManage Favorites button, and selectingSave to
Favorites.
For user interface details, see "Save to Dashboard Favorites Dialog Box" on page 904.

How to Use SiteScope Diagnostic Tools to Test Monitor Configuration
1. Select theMonitors context. In the Dashboard, select amonitor instance for which a diagnostic tool is

available (see "TestingMonitor Configuration Using Diagnostic Tools" on page 892).

2. Click the Tools button in the SiteScope Dashboard toolbar to run the tool with themonitor's existing
data as its input. The test results appear in theResults pane. To save the results to a file, click theSave
to File button.
For UI details, see "SiteScope Tools" on page 91.

How to Analyze Data in the SiteScope Dashboard
This task describes the steps to follow to analyze data in SiteScope Dashboard.
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1. Drill down to view monitor andmeasurement status and availability
When viewing SiteScope data in the Current Status view of Dashboard, you can drill down in themonitor
tree to view monitor andmeasurement status and availability.
For user interface details, see "SiteScope Dashboard - Current Status View" on page 905.

Example:Measurement status and availability for amonitor

2. View configured and triggered alerts
You can view data about alerts in the configured alerts and triggered alerts columns. If alerts are
configured for amonitor, you can double-click theConfigured Alert icon to see the list of configured
alerts, and select an alert to view or edit the alert properties.
To assist in troubleshooting, you can check the alert history for themonitor to determine whether this is a
reoccurring issue (all associated alerts are displayed in the alerts section).
For user interface details, see "SiteScope Dashboard - Current Status View" on page 905.

Example:Configured alerts

3. Disable monitors or monitors in group
Depending on the diagnosis, you can disable themonitor or monitors in group, or disable alerts
associated with themonitor or group and continue to use themonitor.
For user interface details, see "Enable/Disable Monitors in Group Dialog Box" on page 903.

4. Acknowledgemonitors

To acknowledgemonitor status, select amonitor or group and click theAdd Acknowledgment icon
or select Add Acknowledgment from the context menu, and enter the details in the Acknowledge
Monitors In Group dialog box.
For user interface details, see "AcknowledgeMonitors In Group Dialog Box" on the next page.
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Example:AcknowledgeMonitors In Group Dialog

5. Monitor your Microsoft Windows/UNIX server's resources
You can create aMicrosoft Windows or UNIX Resources monitor to monitor yourWindows or UNIX
Server, and generating a Server-Centric report. For task details, see "Create Server-Centric Reports" on
page 1179.

6. View monitor history
You enable and configuremonitor history in the General Preferences. For user interface details, see
"DashboardMonitor History View Options" on page 508.
To view monitor history, click theMonitor History button in SiteScope Dashboard. For user interface
details, see "SiteScope Dashboard - Monitor History View" on page 911.

Example:Monitor history view

Acknowledge Monitors In Group Dialog Box
Note: This topic is related to the following: "View andManage Data in the SiteScope Dashboard" on
page 891

This dialog box enables you to add or edit an acknowledgment for amonitor or monitor group to track
resolution of the problem.

UI Element Description

Acknowledge
comment

An acknowledgment comment which is displayed as a tooltip associated with the
acknowledgment icon in the Dashboard view and is recorded in the Acknowledge
Log. You can update the comment as new information becomes available. The
comment is displayed until the acknowledgment is deleted.
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UI Element Description

Enable all
associated alerts

Enables all associated alerts (default setting).

Disable all
associated alerts
indefinitely

Disables alerting immediately and continues suppressing alerting on the selected
monitor or group until this radio button is cleared and the alert definition is updated.

Note:Use of this optionmay result in loss of expected alert capability if the alert is
disabled to accommodate a temporary condition. It is important to review this status
at a later time, and tomanually enable the alert definition as necessary.

Disable all
associated alerts
for the next <time
period>

Disables alerting immediately and continues suppressing alerting on the selected
monitor or group for a duration that you specify.

Disable all
associated alerts
on a one time
schedule from
<timeA> to
<timeB>

Disables alerting during a period of time that you specify. This can be useful if the
system beingmonitored is expected to be unavailable during a certain period but you
want to continue to run themonitor without triggering an alert.

Disable
description

Description for alert icons associated with themonitors in the acknowledged context.
The text description is added to the tool tip text that is displayed when the pointer is
placed over any alert icon associated with themonitor in the Dashboard view. This
text is displayed only while the alert disable option is in force. It is not written to the
Acknowledge Log.

Undo one-time schedule

Cancel a one-time schedule disable alert.

View
Acknowledge
Log

View all acknowledgment entries for themonitor or group from which you invoke the
acknowledgment dialog box. The log contains the time and date of the
acknowledgment, user name of the acknowledger, the status of themonitor or group,
and the acknowledgment message.

Dashboard Filter Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page 894

This dialog box enables you to configure a Dashboard filter by enteringmatch criteria and selecting from the
menu options.

To access Select theMonitors context. In the Dashboard toolbar, click theDashboard Filter
button.

Important
information

Any combination of filter options can be included in a single filter. For example, the filter
definition can filter on a combination ofMonitor type,Monitored target server, andStatus.
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Relevant
tasks

"How to Analyze Data in the SiteScope Dashboard" on page 895

Global Settings
User interface elements are described below:

UI Element Description

Monitor name Text string or regular expression that matches the name of one of moremonitors.
When you apply this filter to the Dashboard view, only themonitors that match the
Monitor name criterion are displayed.

Monitor type Filters monitors by the selectedmonitor types.

Monitored target
server

Filters monitors by server name on a particular host or monitored server.

Status Filters monitors by reported status. The status filter criterion can be defined in terms of
monitor category status.

The following status options are available:

l Any Status. Show all monitors with any status. This is the default option. This can
be used in combination with theData Available option to filter out monitors that
are in error due to connectivity or availability factors.

l Disabled. Show only monitors reported as disabled.
l Error. Show only monitors reporting an error status.
l Good. Show only monitors reporting a good or OK status.
l Good, Warning, or Error. Show all monitors except those reported as disabled.
l Warning. Show only monitors reporting a warning status.
l Warning or Error. Show only monitors reporting a warning or error status.
l Warning or Good. Show only monitors reporting a warning or good status.
Example:Create a filter that displays only thosemonitors reporting a warning or error.

Status (with
Availability)

Creates a compound filter by combining themonitor status category with the data
availability status.

The following data availability status options are available:

l Data Available. Show monitors for which data is available, meaning themonitor
was able to retrievemeasurements from the target system.

l Data Unavailable. Show monitors for which data is not available, meaning
SiteScope was not able to retrievemeasurements from the target system.

Example:Create a filter that displays only thosemonitors reportingError andData
Available. This means that the filter shows monitors that indicate an error status for
which themonitor was able to receive data from themonitored system as opposed to
monitors that are reporting an error because themonitor was not able to communicate
with themonitored system (that is, Data Unavailable).
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UI Element Description

Summary text Filters monitors based on text included in their summary string. You can type a literal
text string or a regular expression tomatch a text pattern.

For details about regular expressions see "Regular Expressions" on page 153.

Acknowledged Filters monitors based on their Operator Acknowledgment status. To filter onmonitors
that have been acknowledged, select Yes from the drop-downmenu. To filter on
unacknowledgedmonitors, select No from the drop-downmenu.

Acknowledgment
notes

Filters monitors based on text that may appear in their Operator Acknowledgment
notes. You can type a literal text string or a regular expression tomatch a text pattern.

For details about regular expressions see "Regular Expressions" on page 153.

Alerts configured Filters monitors based on whether alerts have been configured on them. To filter on
monitors that have one or more alerts configured on them, select Yes from the drop-
downmenu. To filter onmonitors that do not have configured alerts, select No from
the drop-downmenu.

Alerts triggered Filters monitors based on whether they have triggered an alert event. To filter on
monitors that have generated one or more alerts, select Yes from the drop-down
menu. To filter onmonitors that have not generated alerts, select No from the drop-
downmenu.

Monitor History Settings
User interface elements are described below:

UI Element Description

Display time period Time frame for past events.

Default value:Past 1 hour

Monitor run status Required event status, relational operator, and data availability.

Default value:Any

Dashboard Settings Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page 894

This dialog box enables you to customize the display of group andmonitor data in the Dashboard views. This
enables you to display or suppress the display of monitor measurement details, alert information, and
acknowledgment functions.

To access Select theMonitors context. In the Dashboard toolbar, click theDashboard Settings
button.
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Important
information

l Layout options apply only to the Detailed view. They are ignored when using the Icon
view.

l Youmust be an administrator in SiteScope, or a user grantedEdit layout permissions to
be able to set the layout fields in the SiteScope Dashboard view. For details, see "User
Management Preferences" on page 625.

Dashboard Properties
User interface elements are described below:

UI Element Description

Dashboard
refresh rate (in
seconds)

Amount of time, in seconds, to wait between refreshing the Dashboard.

Default value: 60 seconds

Minimum value: 30 seconds

Maximum
dashboard
icons

Maximum number of icons that can be displayed in the Dashboard's Icon View.

Default value: 700

Maximum recommended value: 1500

Note: If the selected element has more icons than themaximum number that can be
displayed, try to create amore restrictive tree filter or configure a Dashboard filter
instead of increasing this setting.

Maximum
dashboard
objects

Maximum number of objects that can be displayed in the Dashboard table for a selected
element.

Default value: 4000

Note: If the selected element has more objects than themaximum number that can be
displayed, create amore restrictive tree filter or configure a Dashboard filter instead of
increasing this setting.

Show monitor
availability

Displays monitor availability icons in the Dashboard that indicate whether SiteScope
was able to connect to a remote system or if a remote system was unavailable due to a
connection problem.

Default value:Selected

Wrap text Automatically adjusts the row height to make all cell contents visible in the Dashboard.

Default value:Not selected
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Dashboard Table Layout
User interface elements are described below:

UI
Element Description

Lock
columns

Locks the order of the table's columns. Clear the setting to change the table column order by
dragging the column header to the right or the left.

Default value:Not selected

Table
Columns

Columns displayed in the detailed tables. Your selections are applied to all applicable group
andmonitor elements.

The columns available for display are:

l Type
l Summary
l Alerts Triggered
l Alerts Configured
l Description
l Status
l Target
l Ack(nowledged)
l Updated
l Name
l Group Name
l Tag
Default value:All the properties except Group Name and Tag are selected .

For details on the columns, see "SiteScope Dashboard - Current Status View" on page 905

Delete Dashboard Favorites Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page 894

This dialog box enables you to delete existing favorite views

To access Select theMonitors context. In the Dashboard toolbar, click the arrow next to theManage
Favorites button, and select Delete Favorites.

Important
information

Youmust be an administrator in SiteScope, or a user grantedEdit favorites permissions to
be able to add or delete items in the favorite views list in the SiteScope Dashboard view. For
details on this topic, see "User Management Preferences" on page 625.
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User interface elements are described below:

UI
Element Description

Existing
Favorites

Select the view or views you want to delete from the list of current favorite views. By default,
the list includes the following preconfigured favorites:

l All Objects
l Disabled
l Errors Only
l Errors andWarnings
l Good
l Good andWarnings
l NoData
l Warnings Only

Enable/Disable Monitors in Group Dialog Box
Note: This topic is related to the following: "How to Analyze Data in the SiteScope Dashboard" on
page 895

This dialog box enables you to select an option for enabling or disabling themonitor or all themonitors in the
group, regardless of the individual monitor setting in themonitor properties tab. If you select Disable monitor,
themonitors are disabled until you return to this dialog box and select Enable monitor.

To access Select theMonitors context. In the Dashboard, select amonitor or group, and click the
Enable/Disable Monitor button.

Important
information

If you disable amonitor or group using theDisable monitor option, the Dashboard shows
disabled manually as the status in theSummary column for the affected objects. You
must enable any object with a disabled manually status before you can set objects to be
disabled for a specific period of time. This is also true at the group level. For example, if
monitors in a group are disabled for a time period andmonitors in a subgroup of that group
have the disabled manually status, the subgroupmonitors remain disabled even after the
disable time period has lapsed for the parent group.

See also "Enable/Disable Monitor" on page 264

User interface elements are described below:

UI Element Description

Enable
monitor

Enables themonitors if they were previously disabled in themonitor properties.

Default value:Selected
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UI Element Description

Enable
temporarily
disabled
monitor only

Enables themonitors if they were previously disabled temporarily in themonitor
properties.

Disable
monitor

Whenmonitors in the group have been disabled, SiteScope continues to schedule the
monitors to run based on the Frequency setting for themonitor but themonitor action is
not run. SiteScope records amonitor data log entry for themonitors when they were
scheduled to be run but reports themonitor status as disabled in the place of
measurement data.

Disable
monitor for
the next <time
period>

Time period that themonitors should remain disabled. Select Seconds,Minutes, Hours,
orDays to define the disable time period as applicable.

Disable
monitor on a
one time
schedule from
<time> to
<time>

Temporarily disables themonitor for a time period in the future. The time period can span
more than one day.

Enter or select the start time and end time for the disable period using the format:
hh:mm:ss mm/dd/yyyy.

Note:At the group level, this disables all child monitors in the group on a one time basis.
(While this change is displayed inmonitor properties, it is not reflected if you check group
properties.)

Disable
description

Descriptive that appears as part of themonitor status in themonitor group display. The
disable status text also includes a string indicating which disable option is in force for the
monitor, for example Disabled manually indicates that themonitor was disabled using
theDisable monitor option.

Save to Dashboard Favorites Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page 894

This dialog box enables you to define combinations of Dashboard filter and layout settings (which were
selected using the Dashboard Filter dialog box and the Dashboard Settings dialog box) and save them as a
named favorite view.

To access Select theMonitors context. In the Dashboard toolbar, click the arrow next to theManage
Favorites button, and select Save to Favorites.

Important
information

l Dashboard favorites are limited to settings that are applicable to Dashboard views. This
means that Dashboard favorites do not save user-global view settings, or the context
that was selected in themonitor tree when the favorite was saved.

l Youmust be an administrator in SiteScope, or a user grantedEdit favorites permissions
to be able to add or delete items in the favorite views list in the SiteScope Dashboard
view. For details on this topic, see "User Management Preferences" on page 625.
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User interface elements are described below:

UI
Element Description

Name Select an option for saving the current Dashboard filter and layout settings to favorites:

l Existing. Enables you to replace one of the existing favorites with the current settings.
Displays a list of the existing favorite views. By default, the list includes all the preconfigured
favorites.

l New. Enables you save the current settings to a new favorite view with the display name
that you enter in the box.

SiteScope Dashboard - Current Status View
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page 894,
"How to Analyze Data in the SiteScope Dashboard" on page 895

Displays current performance data for the infrastructure elements beingmonitored by SiteScope and provides
access to functions you use to define filters. The Dashboard displays a table of groups andmonitors for the
element highlighted in themonitor tree or listed in the path. You can double-click each group or monitor node to
navigate to child nodes andmonitors.

From the Dashboard, you can access Server-Centric reports, preconfigured Quick reports, acknowledge
monitor status, monitor tools, SiteScope Health Status, monitor history information, and enable/disable
monitors and alerts.

To access Select theMonitors context. Select an object in themonitor tree, and click theDashboard
tab in the right pane.

Important
information

l By default, themaximum number of objects that can be displayed in the Dashboard table
for a selected element is 4000, and themaximum number of icons that can be displayed
in Icon View is 700. You canmodify these numbers by changing the values in the
Dashboard Settings dialog box. However, we recommend that you use the default
setting.

l If the selected element has more lines than themaximum number that can be displayed
in the Dashboard table, try creating amore restrictive tree filter or configure a Dashboard
filter.

l You can copy details from selected rows in the Dashboard using the Ctrl + C shortcut.

User interface elements are described below:

UI Element Description

Common Toolbar Elements

Show Child Groups and Monitors. Displays only those elements that are direct
children of the selected node. Subgroups andmonitors are displayed in separate
sections in the group andmonitor status information area.
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UI Element Description

Show All Descendent Monitors. Displays all descendent monitors of the selected
node. When the Icon view option is selected, only descendent monitor icons and names
are displayed.

Detailed View. Displays groups andmonitors in tabular list format with the element
name, status, and other information arranged in individual table rows.

Icon View. Displays groups andmonitors as an array of status icons with the name of
the element below the icon.

Up. Goes up one level in themonitor tree. This option is not available for SiteScope (the
highest level in the tree).

The Favorite box contains a drop-down list of the existing favorite views of Dashboard
filter and layout settings. You can select the one you want to display in the Current
Status or Monitor History view.

Note: The Favorites filter works on themonitor level whichmeans that it does not filter
groups. When working in theShow Child Groups and Monitors view, you can see
groups that are not in a state that match the filter. To see only monitors in the filter, use
theShow All Descendent Monitors view instead.

You can select from the following views:

l All Objects. Show all monitors with any status, even those reported as disabled.
l Disabled. Show only monitors reported as disabled.
l Errors Only. Show only monitors reporting an error or data unavailable status.
l Errors and Warnings. Show only monitors reporting a warning or error status.
l Good. Show only monitors reporting a good status.
l Good and Warnings. Show only monitors reporting a warning or good status.
l No Data. Show only monitors for which there is no data.
l Warnings Only. Show only monitors reporting a warning status.
Default value: <None>

Manage Favorites. Click the arrow, and select an option:

l Save to Favorites. Opens the Save to Dashboard Favorites dialog box which
enables you to save the current Dashboard filter and layout settings as a favorite
view. For user interface details, see "Save to Dashboard Favorites Dialog Box" on
page 904.

l Delete Favorites. Opens the Delete Dashboard Favorites dialog box which enables
you to delete existing favorite views. For user interface details, see "Delete
Dashboard Favorites Dialog Box" on page 902.

Dashboard Filter. Opens the Dashboard Filter dialog box. For user interface details,
see "Dashboard Filter Dialog Box" on page 898.

Dashboard Settings. Opens the Dashboard Settings dialog box. For user interface
details, see "Dashboard Settings Dialog Box" on page 900.
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UI Element Description

Current Status. Displays a table of groups andmonitors for the element highlighted in
themonitor tree or listed in the path.

Monitor History. Displays information about monitors, monitor groups, and alerts over
the last 24 hours. This information is filtered by the number of hours, monitor status, and
the number of data entries.

For more information on viewingmonitor history, see "SiteScope Dashboard - Monitor
History View" on page 911.

Run Monitors. Runs themonitor or any monitors configured in the group. This opens
an information window with the results.

Enable/Disable Monitors in Group. Opens the Enable/Disable Monitors in Group
dialog box which enables you to enable or disable themonitor or all themonitors in the
group, regardless of the setting in themonitor properties. If you select Disable
monitor, themonitors are disabled until you return to this dialog box and select Enable
monitor. For details on the Enable/Disable Monitors in Group user interface, see
"Enable/Disable Monitors in Group Dialog Box" on page 903.

Enable/Disable Associated Alerts. Opens the Enable/Disable Associated Alerts
dialog box which enables you to enable or disable all alerts associated with themonitor
or all monitors in the group. For more details, see "Enable/Disable Associated Alerts" on
page 265.

Add Acknowledgment. Opens the AcknowledgeMonitors In Group dialog box which
enables you to add an acknowledgment to amonitor. Acknowledgments are used to
track resolution of problems that SiteScope detects in your system and network
infrastructure. With this function, SiteScope keeps a record of when the problem was
acknowledged, what actions have been taken, and by which user.

For details on the AcknowledgeMonitors In Group user interface, see "Acknowledge
Monitors In Group Dialog Box" on page 897.

Delete Acknowledgment. Deletes themonitor's acknowledgment.

Quick Report. Creates a one-time SiteScopemanagement report using preconfigured
settings for the selectedmonitor. For more details on the report, see "Quick Report" on
page 1172.

Tools. Opens a diagnostic tool to test the selectedmonitoring environment. This button
is available only for thosemonitor instances for which there is an appropriate diagnostic
tool. For details on the SiteScope Tools, see "TestingMonitor Configuration Using
Diagnostic Tools" on page 892.

Export to CSV. Opens the Save dialog box which enables you to export data from all
columns currently displayed in the Dashboard table to a CommaSeparated Value
(CSV) file. You canmodify the type of data that is exported by selecting which columns
you want to display in Dashboard Settings. For details, see "Dashboard Settings Dialog
Box" on page 900.
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UI Element Description

Unified Console. Opens the SiteScope Unified Console which contains the following
views:

l Multi-View. Enables you to see andmanage the status of everything that is being
monitored in your IT infrastructure in a single view. You can group objects in different
ways to fit the perspective of different personas: you can display all SiteScope
groups andmonitors in a hierarchical treemap, display monitors grouped by target
remote server; or display monitors grouped by custom search/filter tags. For details,
see "Multi-View" on page 936.

l Event Console. Provides a central view for all notificationmessages about the
performance of your applications and servers. This accelerates your ability to
manage, identify, and resolve performance issues by analyzing events from a single
interface. For details, see "Event Console" on page 914.

l Ops View. This consolidated view enables you to work with Event Console and
Multi-View simultaneously. Event - monitor wiring identifies monitors and groups
associated with events (and vice versa), which helps you pinpoint and resolve
issues.

Table Elements

Acknowledge column. Indicates that a SiteScope user has acknowledged the current
status of amonitor andmay have temporarily disabled alert actions associated with that
monitor. This icon is only displayed in Dashboard Detailed views. Moving the pointer
over the icon displays the acknowledgment information as a tool tip. Double-click the
icon to open the Edit Acknowledge dialog box. For details on this topic, see
"AcknowledgingMonitor Status" on page 892.

Configured Alerts column. Indicates that one or more alerts are associated with the
group or monitor. If you double-click the icon, a tooltip displays the configured alerts.
Selecting an applicable alert definition name from the list opens the Edit Alert dialog box
enabling you to view or edit the alert properties. For details on this topic, see "Configure
SiteScope Alerts" on page 1072.

If all associated alerts have been disabled, the icon is displayed in gray.

For details on enabling or disabling alerts associated with specific groups andmonitors
(not the alerts themselves), see "Set upmonitor alerts - optional" on page 228.

For details on enabling or disabling alerts, see "Disable or EnableMonitor Alerts" on
page 1081.

Triggered Alerts column. Indicates that at least one alert has been triggered in the
monitor. If no alert was triggered, the icon is not displayed. If a single alert was
triggered, an icon representing the specific alert type is displayed. For a list of icons,
see "Alert Actions" on page 1095.

If multiple alerts were triggered, an icon representingmultiple alerts is displayed.
Clicking the alert icon displays alert details. The Triggered Alert column only appears for
a table that contains monitors. For details on this topic, see "Configure SiteScope
Alerts" on page 1072.
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UI Element Description

<Objects table> Lists the groups andmonitors for the element highlighted in themonitor tree or listed in
the path. You can double-click each group or monitor node to navigate to child nodes
andmonitors. Double-click amonitor to display the performance counters for that
monitor.

Name A display name (alias) for themonitor instance or group. When a new group is created,
you type its name. When a new monitor is created, you select its type from the list of
available monitors. If you do not override this type in theName box, themonitor is
identified by the type of monitor. You can then optionally type an alias that helps you
identify this monitor.

Status A colored icon is displayed for each node in a Dashboard view, representing the
operational status assigned to that component for its current performance level.

A color-coded arrow is also displayed for each element in a Dashboard view,
representing the data availability status of themonitor.

You can point at the icons to display themonitor status and availability. For a
description of themonitor status and availability icons, see "SiteScope Dashboard -
Current Status View" on page 905.

Type The type of monitor being displayed. You select themonitor type in the New Monitor
dialog box when you create themonitor instance.

Target Contains the name of the remote server containing themonitored object (if such a
server exists). If, for example, themonitor type is CPU, then the target would be the
name of the server on which the CPU beingmonitored is installed.

The name displayed in the Target column can be either the system ID of the server or
the user-assigned name (alias), depending on what was entered in theName box when
the server was added to themonitor tree.

If the group contains aMicrosoft Windows Resources monitor or UNIX Resources
monitor, the server name in the Target column appears as a link. You can click the link
to open the Server-Centric report for the server. For user interface details, see "Create
Server-Centric Reports" on page 1179.

Summary Formonitors, theSummary column displays themost recent measurement results
reported by themonitor. This may includemore than onemeasurement, depending on
themonitor type. For monitor groups, the summary displays the number of monitors
within the group and the number of monitors, if any, that are reporting an error status.

If a monitor has been disabled, it displays the disabled status (disabled manually,
disabled until x time, or disabled by <Downtime Name> from BSM).

Updated The date and time when the last event occurred in the group or monitor.
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UI Element Description

Description TheDescription column can contain either text that describes themonitor or group or it
can contain HTML that performs various actions when you click the link.

If this field contains text, you can double-click it to open a dialog box that displays the
full description in HTML format.

You can enter information in this column by selecting themonitor or group in themonitor
tree and selecting theProperties tab. In the page that opens, expandGeneralSettings
and enter a description in theMonitor/Group description box.

Group Name Contains the name of the group containing themonitor. This is useful for seeing the
position of themonitor and group in the SiteScope hierarchy, navigating to parent nodes,
and for grouping alerts by group namewhen viewing all descendants in the descendant
monitor view. Double-click theGroup Name cell to copy themonitor path to the
clipboard (useful for copying/pastingmonitor path information).

Status and Availability Levels

Icon Description

Good Status. All performancemeasurements are within the Good threshold level.

Warning Status. At least one performancemeasurement is within the Warning range, but no
measurements are within the Error or Poor range.

Error/Poor Status. At least one performancemeasurement is within the Error or Poor range. This
indicates either of the following:

l The performancemeasurement has a value, but at poor quality level.
l There is nomeasurement value due to some error.

Status Not Defined (No Data). There is no data for the group or monitor. This can be caused by any
of the following reasons:

l A new monitor has not yet run.
l Monitor counters have not yet been collected.
l Themonitors on which the group or monitor depend are not reporting aGood condition.

No Thresholds Breached Status. No thresholds were defined for themonitor counter, so no status
is assigned.

Disabled Manually. The group or monitor is currently disabled, and no data updates are being
received.

Data Collected Availability. Indicates that SiteScope was able to connect to the remote system
and perform the action defined by the respectivemonitor configuration. The resultingmonitor status
represents the results of themonitor action. If an error or warning is indicated, it represents an
accuratemeasure of the target system's performance or the availability of the target resource.

Availability Warning. Indicates that SiteScope has detected a possible problem with the
connectivity to the remote system.
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Icon Description

No Data Availability. Indicates that SiteScope was not able to connect to the remote system. Any
resulting error status for the respectivemonitor may be attributed to the failure to communicate with
a remote server. It does not necessarily mean the target resource has failed.

Dashboard Shortcut Menu
The following options are available by right-clicking in any column of a group or monitor object row:

UI Element (A-Z) Description

Add
Acknowledgment

Opens the Acknowledge dialog box which enables you to add an acknowledgment to
amonitor.

Delete
Acknowledgment

Deletes themonitor's acknowledgment.

Enable/Disable
Associated
Alerts

Opens the Enable/Disable Associated Alert dialog box which enables you to enable or
disable all the alerts for all monitors in the group. If you select Disable monitor, the
alerts are disabled until you return to this page and select Enable monitor.

Enable/Disable
Monitor
Enable/Disable
Monitors in
Group

Opens the Enable/Disable Monitor Settings dialog box which enables you to enable or
disable themonitor or all monitors in the group. If you select Disable, themonitors are
disabled until you return to this page and select Enable. For user interface details, see
"Enable/Disable Monitors in Group Dialog Box" on page 903.

Quick Report Creates a one-time SiteScopemanagement report using preconfigured settings for the
selectedmonitor. For more details, see "Quick Report" on page 1172.

Note: This menu item is displayed for monitors only.

Run Monitor(s) Runs the selectedmonitor or all monitors in the selected group.

Tools Opens a diagnostic tool that can help you troubleshoot monitor configuration
problems. For details on the available tools, see "SiteScope Tools" on page 91.

Note: This menu item is displayed for monitors only, and is available for specific
monitors only.

SiteScope Dashboard - Monitor History View
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page 894,
"How to Analyze Data in the SiteScope Dashboard" on page 895

This view displays information about monitors, monitor groups, and alerts collected during the last 24 hours.
This information is filtered by the number of hours, monitor status, and the number of data entries.

To access Select theMonitors context. In the Dashboard toolbar, click theMonitor History button.
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Important
information

l You enable this function by selectingEnable Dashboard Monitor History Viewin
Preferences > General Preferences > Dashboard Monitor History View Options.

l You can determine exactly how much data you want saved for this function so that your
database does not get overloaded.

l By default, themaximum number of objects that can be displayed in theMonitor History
table for a selected element is 4000, and themaximum number of icons that can be
displayed in Icon View is 70. You canmodify these numbers by changing the values in
the Dashboard Settings (selectMonitors, click theDashboard Settings button, and
expandDashboard Properties). However, we recommend that you use the default
setting. For details, see "Dashboard Settings Dialog Box" on page 900.

l If the selected element has more lines than themaximum number that can be displayed
in theMonitor History table, try creating amore restrictive tree filter or configure a
Dashboard filter.

l The DashboardMonitor History view is not supported in SiteScope for Load Testing.

User interface elements are described below:

UI
Element Description

Triggered Alert. Appears next to any monitor that triggered an alert.

Run
Time

Time themonitor ran.

Name Name of themonitor.

Status Themonitor's status at runtime (Error, Warning, or Good). For user interface details, see
"SiteScope Dashboard - Current Status View" on page 905.

Summary Description of themonitor run.

Availability

This box only appears if you have selectedShow monitor availability in the Details View
pane of Dashboard Layout.

Group

The name of the group to which themonitor belongs. This box appears only if you have
selectedShow all descendants in Dashboard.

Using SiteScope
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Part 11: Unified Console
Use the Unified Console to simplify themanagement of large, distributed environments and to accelerate your
ability to identify and resolve issues. It is also ideal for displaying enterprise-widemonitoring status in a
network operations setting. The Unified Console is refreshed after eachmonitor run and the last refresh date
and time is displayed on the top right corner of the page.

The Unified Console contains the following views:

l Event Console. Enables you to track the real time status of your monitored environment, prioritize and
dispatch events, andmanage the event lifecycle from a single interface. You can also see details of
historical events, which is useful for tracking the resolution of previous issues, and for identifying trends
and hidden patterns. For details, see "Event Console" on page 914.

l Multi-View. Enables you to see the status of everything that is beingmonitored in your IT infrastructure
in a single view without losing the hierarchical relationship between the data. You can group objects in
various different ways to fit the perspective of different personas. For details, see "Multi-View" on
page 936.

l Ops View. Combines the Event Console andMulti-View in a single view. Working side-by-side helps
you isolate and diagnose problems by identifying events associated with a selectedmonitor or monitor
group, or amonitor associated with a selected event, and to drill down and perform troubleshooting. For
details, see "Ops View" on page 954.

l Manage. Provides new self-servicemonitoring which extends template deployment and the ability to
updatemonitor configuration to non-admin users (after they have been granted the necessary
permissions), and reduces the amount of monitoring support required from the SiteScope administrator or
monitoring team. For details, see "Manage View" on page 955.

Tip: You can watch video demonstrations on usingMulti-View, usingMulti-View and Event Console, and
How toManage and Track Monitors in Multi-View Using Filters and Tags.

http://h20621.www2.hp.com/video-gallery/us/en/sss/743CFBEB-2BC3-4EED-8BCB-94DCA429DA40/r/video/
https://www.youtube.com/watch?v=-BFVcF6Kh-k
http://hpsw.co/r5D4GxA


Chapter 96: Event Console
SiteScope's Event Console enables you to track the real time status of your monitored environment,
prioritize and dispatch events, andmanage the event lifecycle from a single interface. This simplifies the
management of large, distributed environments, and accelerates your ability to identify and resolve issues.

Example:Unified Console displaying bothMulti-View (top) and Event Console

Tip: You can view a guided and narrated demonstration of the Event Console on YouTube:
http://youtu.be/-BFVcF6Kh-k.

To access
The Event Console is available in the Unified Console. You can access the Unified Console directly from a
browser or from the SiteScope Dashboard.

l To access the Event Console from a browser, enter the URL in aWeb browser in the format:
l http://<server_name>:<port>/SiteScope/WebMain#/eventconsole (for Event Console only)

l http://<server_name>:<port>/SiteScope/WebMain (for Event Console andMulti-View)

l To access the Unified Console from the SiteScope Dashboard, select theMonitors context, click the
Dashboard tab, and then click theUnified Console button. The Unified Console opens in Ops View,
which displays bothMulti-View and the Event Console. To display only the Event Console, click Event
Console .

Learn About
This section includes:

l "Event Console Overview" below
l "Supported Browsers and Screen Resolutions" on the next page
l "What is the Difference Between the SiteScope Event Console and theOMi Event Browser?" on the next
page

l "What are the User Roles and Required Permissions?" on page 916
l "Historical Event Log Files" on page 917
l "Capacity Recommendations and Best Practices" on page 918

Event Console Overview
The Event Console displays information about all events on your monitored systems. It provides the following
views:
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l Live Console. Use to view andmanage events on a day-to-day basis, and track event lifecycle state and
resolution progress. It provides a customizable display that enables users to sort, search, and filter events
by various event attributes, enabling them to focus on only the events they need to see.
In addition, you can use the Event Console in conjunction with Multi-View to assist with problem diagnosis
and resolution. Event-monitor wiring provides the ability to identify events associated with a selected
monitor or monitor group, or amonitor associated with a selected event, and to drill down and perform
troubleshooting.

l Event History. Use to see details of historical (closed) events. This is useful for tracking the resolution of
previous issues, and for identifying trends and hidden patterns.

The Event Console is fully supported on big and small screens, making it is ideal for viewing events and
monitor data in a network operations center. It is also supported on iPad and Android tablets.

Supported Browsers and Screen Resolutions
Supported Browsers and Devices

The following browsers are supported:

l Google Chrome browsers (latest certified version): 48.0.2564.116m.
l Mozilla Firefox (latest certified version): 38 ESR
l Safari (latest certified version): 8.0 for Mac
l Internet Explorer 10, 11
The followingmobile devices are supported:

l iPad 3 with Safari (iOS 8with latest updates)
l Android tablet with Chrome 34.0.1847 (or with any latest default browser of Android) Full HD display
Default Screen Resolution

l Large Desktop – 1680 x 1050 pixels
l Laptop – 1280 x 800 pixels
l iPad – 1024 x 768 pixels

What is the Difference Between the SiteScope Event Console and the OMi Event
Browser?
The SiteScope Event Console provides event management capabilities to mid-sized and enterprise user
groups that have a single SiteScope, or a light deployment without requiring an HPOM integration (there is no
need for a database or RTSM).

TheOperations Management (OMi) Event Browser is amarket-leading tool for event consolidation and
correlation. It is based on topology (RTSM) capabilities, and it requires integration with BSM and
HPOM products.
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What are the User Roles and Required Permissions?
User Permissions

The following permissions are required to perform Event Console actions for SiteScope users working with
SiteScope standalone, and for BSM users that connect to SiteScope from SAM Administration in BSM.

Action

Permission Required

SiteScope SAM Admin (in BSM)

View and edit
event console
preferences

View and edit event console preferences CHANGE or FULL CONTROL
permissions for SiteScope
Preferences

Manage
events

For unassigned events: Unassigned Event
Management (Assign user/Edit event details)

For assigned events: Assigned Event
Management (Assign user/Edit event details)

CHANGE permissions for SiteScope
Dashboard (regardless of whether an
event assigned to a user)

View events A user can view event details for events that are
associated with monitors for which they have
Allowed Groups permissions

User can view events for monitors in
groups for which the user has view
permissions

For details on SiteScope user permissions, see "User Management Preferences" on page 625. For details on
BSM user permissions, refer to the APM Platform Administration Guide.

User Roles

The following are some of the roles that are suited to working with the SiteScope Event Console, and the
recommended SiteScope user permissions required for fulfilling these roles:

Persona Role/Features
Recommended
Permissions

Dispatcher/NOC
Operator

(Monitoring
Team)

Role: Dispatches unresolved events, and tracks overall status
of monitored environment.

Features:

l Live Console provides clear view of all open events,
enabling quick dispatch to investigation team.

l Displays active event status and resolution progress,
enabling follow-up and escalation.

l Customizable display that enables dispatcher to easily find
and display the events they need to see (such as events
with high status, or events that have not yet been assigned
to a user).

l View and edit
event console
preferences

l Unassigned
Event
Management
(Assign
user/Edit event
details)

l Assigned Event
Management
(Assign
user/Edit event
details)
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Persona Role/Features
Recommended
Permissions

Application
Support
Team/SME

(Investigation
Team)

Role: Investigates and resolves events.

Features

l Ops View helps investigators to isolate and diagnose
problems by enabling them to see themonitor associated
with the triggered event in different perspectives (grouped
by monitor group, servers, or tags).

l Multi-View enables investigators to drill down to seemore
detailed information on associated groups andmonitors, re-
runmonitors to check if the problem still exists, generate
reports to view performance and availability over time, and
troubleshoot the problem.

l Investigator can update events with resolution progress,
enabling follow-up and escalation.

l View and edit
event console
preferences

l Assigned Event
Management
(Assign
user/Edit event
details)

SiteScope
Administrator

Role: Configures andmanages the Event Console. This
includes configuring settings for live and historical events,
LDAP server, and special logging configuration, creating event
filters, and defining alert actions that create an event in the
system. Also defines users and roles, and assigns the required
Event Console permissions.

Features: Administrator can:

l Track event resolution results and analyze statistics.
l View historical events; this is useful for analyzing event
history, hidden patterns, and the time it took to resolve
events by comparing the event creation time with the
closing time (closing time is available in the event history
log file only).

All Event Console
permissions

Historical Event Log Files
You can get information on all closed (non-active) events that were triggered from Event Console alert actions
from the Event History view in the Event Console, or from the event history log files, event_console_
history.log. Each closed event is written to the log, starting with the event closing time, and followed by the
rest of the information that is displayed in the Event Console view and Event Details dialog box.

SiteScope creates a new log each day to record all events that were closed during that 24 hour period. The
logs are in the format: event_console_history<YYYY_MM_dd>.log. SiteScope retains amaximum of 40
event history log files. Files older than the log retention period are automatically deleted.

The log files are available from <SiteScope root directory>\logs, as well as from the Log Files page (Server
Statistics > Log Files).

Events are written to the log (and to the Event History view in the Event Console) when:

1. An event is manually closed by the user.
2. TheSubmit close key condition check box is selected in the console event mapping (either in a
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customizedmapping created by user, or in the Default Console Event Mapping template, where it is
selected by default). When selected, a close key pattern of a new event is compared to the keys of all
previous events, and events with keys whichmatch the pattern are automatically closed. For details, see
"New/Edit Event Mappings Dialog Box - General Tab" on page 469.

3. The user configures the Log only setting in the console event mapping (either in the Default Console
Event Mapping template, or any other customizedmapping created by user) to:
l True. All events are sent or written directly to history as closed events (they are available in the
history log and Event History view).

l True for normal severity (the default setting). Events triggered for amonitor in normal severity (fired
when themonitor status changes to Good), are written directly to history as closed events (they are
available in the history log and Event History view).

4. An event is automatically closed by SiteScope. This can occur when:
l Themaximum number of live events that can be stored on the server has been reached. When this
occurs, themessage (CLOSED BY AUTOMATIC PURGE) is added to the event title.

l Themonitor on which the event was triggered is deleted. When this occurs, themessage (CLOSED
BY MONITOR DELETION) is added to the event title.

Capacity Recommendations and Best Practices
The Event Console is designed to display meaningful events on your monitored systems.

The SiteScope server is certified to handle a constant load of up to 40 events per minute and to display up to
5000 events in the Live Console or Event History views.

The recommended best practice is to configure the alert system to send alerts only on amonitor status
change and not on every monitor run. This should optimize the number of open events in the console, making
it easier for the relevant teams/users tomanage and handle them.

You can configure the number of live events that are displayed in the Event Console from Preferences >
Infrastructure preferences > Event Console Settings > Maximum number of live events. The default
setting is 1000 events, with amaximum setting of 5000. Once this limit is reached, the oldest events are
automatically closed and displayed in the Event History view, and are written to the event_console_
history.logwith (CLOSED BY AUTOMATIC PURGE)message, which enables you to identify these events.

You can also configure themaximum number of historical events that can be displayed (Maximum number
of historical events), and the number of previous hours of historical events to display (Number of previous
hours of historical events to retrieve) in the Event History view. By default, the Event History view can
display up to 1000 historical events from the last 48 hours (with amaximum display of 5000 events from the
last 168 hours). Once the display limit is reached, the oldest events are removed from the Event History view,
but they are still available in the event_console_history.log files (events are never removed from a log file).
The number of history files saved is 40 (one per day). When the 41st day is reached, the oldest file is deleted.

Note:

l You can configure the number of live events that are displayed in the Event Console from
Preferences > Infrastructure preferences > Event Console Settings > Maximum number of
live events. The default setting is 1000 events, with amaximum setting of 5000. Once this limit is
reached, the oldest events are automatically closed and displayed in the Event History view, and are
written to the event_console_history.logwith (CLOSED BY AUTOMATIC PURGE)message
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enabling you to identify these events.
l You can also configure themaximum number of historical events that can be displayed (Maximum
number of historical events), and the number of previous hours of historical events to display
(Number of previous hours of historical events to retrieve) in the Event History view. By default,
the Event History view can display up to 1000 historical events from the last 48 hours (with a
maximum of displaying 5000 events from the last 168 hours).
Once the display limit is reached, events are no longer displayed in the Event History view, but they
are still available in the event_console_history.log files (events are never removed from the log
files). You can configure the number of logs files that can be saved via the log4j.properties file.

Tasks
This section includes:

l "How to Configure andManage the Event Console (SiteScope Administrator)" below
l "How to Assign Events (Dispatcher/NOC Operator)" on page 921
l "How to Investigate and Resolve Events (Application Support Team)" on page 922
l "How to View Historical Events (Administrator/Application Support Team)" on page 923
l "How toManage Events Displayed in the Event Console (Any user)" on page 924

How to Configure and Manage the Event Console (SiteScope Administrator)
1. Define users and user roles, and assign the required Event Console permissions

Create users and user roles for the different user groups that need to work with the Event Console, and
assign them Event Console permissions as required, as described in "What are the User Roles and
Required Permissions?" on page 916.
For details on user permissions, see "User Management Preferences" on page 625.

2. Configure the Event Console settings
Select Preferences > Infrastructure Preferences > Event Console Settings, and configure the
following settings (as required):
Live/Historical Event settings:
l Enable/disable new triggered events being displayed in the Event Console. When the setting is
cleared, no new events are triggered from Event Console alert actions.

l Set themaximum number of live events that can be stored on the server and displayed in Live Events
view. This value cannot exceed 5000 (the default value is 1000). Once this limit is reached, the oldest
events are automatically closed and displayed in the Event History view, and are written to the event_
console_history.logwith (CLOSED BY AUTOMATIC PURGE)message enabling you to identify
these events.

l Set themaximum number of historical events that can be retrieved from the server logs for display in
the Event History view. This value cannot exceed 5000 (the default value is 1000). Once the display
limit is reached, the oldest events are removed from the Event History view, but they are still available
in the event_console_history.log files (events are never removed from a log file). The number of
history files saved is 40 (one per day). When the 41st day is reached, the oldest file is deleted.
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l Set the number of previous hours of historical events to retrieve from the server logs for display in the
Event History view. This value cannot exceed 168 hours, equivalent to 1 week (the default value is 48
hours).

LDAP settings (if SiteScope is integrated with an LDAP server):
l You can define themaximum number of LDAP users to retrieve from the LDAP server when loading
the users list to the Event Console. By default, the LDAP server returns up to 400 results (it can be
configured to retrieve amaximum of 1000). If you have an Active Directory domain that exceeds this
number of users, you cannot assign an event to an LDAP user that is not listed in the results retrieved
from the LDAP server, even if youmanually enter the email address of the user.

Event Console errors:
l Enable/disable errors being sent from the Event Console user interface to the log file on the SiteScope
server.

For setting details, see "Event Console Settings" on page 553.
3. Configure Event Console alert actions that, when triggered, create an event in the system

a. To create an alert for amonitor or group of monitors, right-click themonitor/group and select New >
Alert.

b. In the New Alert dialog box:
i. Enter a name for the alert, and select the targets to trigger the alert in the Alert Targets panel.

ii. In the Alert Actions panel, click New Alert Action , and select Event Console.
For user interface details on the New Alert dialog box, see "New/Edit Alert Dialog Box" on
page 1092.

c. In the Alert Action: Event Console dialog box, perform the following:
i. Enter a name for the alert action.
ii. Select the daily and weekly schedule to perform the alert action if the alert conditions aremet

and the alert is triggered. For details, see "Schedule Preferences" on page 608.
iii. Select an event mapping template for the Event Console.

The template contains themapping between event attributes names\keys and their content
(user canmap run time data in each attribute) that is used for sending events to the Event
Console when an alert is triggered.
You can use the default global mapping for all the events sent to Event Console, or choose the
common event mapping per alert action. For details, see "New/Edit Event Mappings Dialog
Box - General Tab" on page 469.

iv. Select the status trigger (see "Status Trigger Panel" on page 1114) and the trigger frequency
("Trigger Frequency Panel" on page 1115).

d. Save the alert settings.
When an alert is created, the icon is added next to the specified container in themonitor tree. The
alerts icon is also displayed in the Alerts Configured column in the SiteScope Dashboard next to
each group or monitor that has one or more configured alerts.
When an alert is triggered, the event corresponding to the triggered alert is displayed in the Event
Console.
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Notification of the event is also displayed in the SiteScope Dashboard (the Event Console alert
icon is displayed in the in Alerts Triggered column).

4. Configure Event Console filters
Create event filters to enable different user groups to focus on only the events they need to view.
Select Preferences > Event Console Preferences, and configure the event filters that determine which
events are displayed in the Event Console. By default, SiteScope includes the predefined "Assigned to
Me" event filter, which shows all events assigned to the logged in SiteScope user.
For task details, see "How to Configure Event Filters" on page 487.
For user interface details, see "New/Edit Event Filter Dialog Box" on page 488.

How to Assign Events (Dispatcher/NOC Operator)
The event dispatcher can view, organize, and assign events to specific users, and can escalate unresolved
issues.

1. Prerequisites
l To be able to assign users to events and edit event details, youmust be an administrator in
SiteScope, or a user granted the appropriateEvent console permissions (granted to all users by
default).

l A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 625.
2. Open the Event Console (for details, see "To access" on page 914).

By default, the Live Console view is selected which shows all active unresolved events.
Events are sorted according to the time that they are received; themost recent events are displayed at
the top of the list. We recommend sorting the event list by descending status, so that events in Error
status are assigned first.

3. Assign events to specific users.
a. Double-click an event to open the Event Details dialog box. For details, see "Event Details Dialog

Box" on page 931.
b. Set the following event attributes as required:

o Severity: Severity assigned to the selected event. Themonitor threshold status for console
events in SiteScope is mapped to the event severity level. The severity can be: Critical, Major,
Minor, Warning, Normal, Unknown. For details, see "Severity Mapping Preferences Dialog Box"
on page 489.

o Priority: Select a priority to which you want to assign to the event. The values can be None,
Lowest, Low, Medium, High, or Highest.

c. Type a user name to search in theAssigned User field, and select a SiteScope user to which you
want to assign the event. You can only assign an event to a user that appears in the list.
If SiteScope is enabled to use LDAP authentication, the list includes LDAP users that are part of the
contexts supplied in the LDAP configuration and user role. LDAP users have permissions according
to the configuration in their assigned User or User Role.

Note: By default, the LDAP server returns up to 400 results (it can be configured to retrieve a
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maximum of 1000). If you have an Active Directory domain that exceeds this number of users,
you cannot assign an event to an LDAP user that is not listed in the results retrieved from the
LDAP server, even if youmanually enter the email address of the user.

When assigning an event to a non-LDAP user, SiteScope validates the existence of the user. When
assigning an event to an LDAP user, it is up to the dispatcher to check the existence of the LDAP
user, since SiteScope cannot validate LDAP users.

4. Send event notifications.
a. Click theMail To button to open an email with subject line "SiteScope event notification". Themail

body contains a link to the event in the Event Console, with the correspondingmonitor on which the
alert was triggered displayed inMulti-View.

b. Enter the email address of the event recipients (the assigned user and any other users that you want
to be notified).

c. Add any other additional details to themail, and send themail.
5. Click Save to save changes made to the event details.

If SiteScope is unable to save the changes, place the cursor over the error icon, and use the
message to resolve the issue.

6. Periodically check the status of assigned issues.
If an issue remains unresolved for a period that exceeds your determined fix by date, you can raise the
event priority, or escalate the event (for example, send an email to the assigned user's manager).

How to Investigate and Resolve Events (Application Support Team)
1. Prerequisites

l To be able to assign users to events and edit event details, youmust be an administrator in
SiteScope, or a user granted the appropriateEvent console permissions (granted to all users by
default).

l A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 625.
2. When alerted of an event that has been assigned to you (either by email notification from the dispatcher,

or if you track events assigned to you using an event filter), open the event in the Event Console.
l From the email notification, click the Event Link which opens the specific event in the Event Console,
and displays its associatedmonitor in Multi-View.

l You can find events that have been assigned to you in the Event Console by using theAssigned to
Me event filter. This filter displays only those events that have been assigned to you (the logged in
user). You can also use other predefined filters to display events that match the selected criteria.
For more details on how to filter and organize events, see "How toManage Events Displayed in the
Event Console (Any user)" on page 924.

3. Double-click the event to open the Event Details dialog box, which provides additional details of the
event. For details, see "Event Details Dialog Box" on page 931.

4. Change the event State field to In Progress.
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5. Investigate the event.
You can investigate the event by:
l Opening the associated (wired) monitor to get details that can help you isolate the cause of the
problem.

l Navigating to the specific view or perspective in Multi-View to collect more information for the current
investigation (server-relatedmonitors, location-relatedmonitors).

l Generatingmonitor reports to see performance trends.

l Using themonitor instructions to perform certain actions on the problematic monitor.

6. After investigating the issue and taking the appropriate action, update the lifecycle state.
a. In the Event Details dialog box, update theState field, as appropriate. The values can beOpen, In

Progress, Resolved, or Closed.
b. You can also add investigation\resolution comments according to the event state and investigation

results, andmake changes to the following fields (as necessary):
o Title. Description of the event.
o Description.More detailed or supplementary information that describes the event. This might

include information about what threshold has been crossed (or other trigger conditions), and the
current values.

c. Click Save to save your changes. If you change an event to Closed state, the event is removed from
the Live Console view, and displayed in the Event History view.

7. Periodically check the Event Console for new events that might have been assigned to you, or for
existing events that remain unresolved.

How to View Historical Events (Administrator/Application Support Team)
You can get information on historical (non-active) events from the Event History view in the Event Console, or
from the log files.

1. In the Event Console, select theEvent History view. Historical events are displayed according to their
closing time (themost recently closed event is displayed first).
This view displays closed (non-active) events that were triggered from Event Console alert actions. By
default, the Event History view displays up to 1000 historical events from the last 48 hours.
The administrator canmodify themaximum number of historical events that can be displayed, and the
number of previous hours of historical events to display in the Event History view inPreferences >
Infrastructure Preferences > Event Console Settings.

Tip: Event History is also included in the event_console_history.logwhich is available from
(Server Statistics > Log Files), or from the <SiteScope root directory>\logs directory.

2. You can find and organize historical events in the Event History view by sorting the event order, using the
search, or by using the quick status filter as described in "How toManage Events Displayed in the Event
Console (Any user)" on the next page.
Each event contains all the information that is displayed in the Event Details dialog box. For details, see
"Event Details Dialog Box" on page 931.
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For details of when historical records are written to the Event History view (and to the log files), see
"Historical Event Log Files" on page 917.

Note:

l Event attributes in the Event History view are read-only and cannot bemodified.

l Predefined filters are not available in Event History.

How to Manage Events Displayed in the Event Console (Any user)
1. Prerequisites

l To be able to assign users to events and edit event details, youmust be an administrator in
SiteScope, or a user granted the appropriateEvent console permissions (granted to all users by
default).

l A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 625.
2. Prerequisites

l To be able to assign users to events and edit event details, youmust be an administrator in
SiteScope, or a user granted the appropriateEvent console permissions (granted to all users by
default).

l A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 625.
3. Open the Event Console (for details, see "To access" on page 914).

By default, the Live Console view is selected which shows all active unresolved events.
4. The events that are displayed differ according to whether you select Event Console or Ops View (Event

Console andMulti-View):
Event Console:
l When Event Console is selected, all active events are displayed by default (up to themaximum
number of events that can be stored on the server; set inMaximum number of live events). You
can filter this list using the quick status filter icons, or by selecting a predefined filter in the filter
selection field. For details on configuring event filters, see "Event Console Preferences" on page 487.

Ops View:
l WhenOps View is selected, the Event Console is displayed below Multi-View. The Event Console
displays all events that are associated with monitors for which the user has Allowed Groups
permissions. Events are sorted by default according to the time that they are received; most recent
events are displayed at the top of the list.

l When you select amonitor or group inMulti-View, the Event Console displays only those events that
are associated with the selectedmonitor or group.
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l When you click an event in the Event Console, Multi-View changes to display the associatedmonitor
together with its parent group (the associatedmonitor is highlighted with a blue border).

l Navigating between view types inMulti-View (Monitors\Servers\Tags) or filtering in Mullti-View does
not change the displayed events until you select a particular monitor or group inMulti-View.

Note: If a monitor or its associated alerts have been disabled, no new events associated with that
monitor are displayed in the console.

5. You can find or organize active events using the following tools:
l You can sort the event order by clicking the up/down arrow at the top of the relevant column (to sort by
status, severity, priority, state; other columns can be sorted alphabetically/numerically if the value is
a finite number).

l You can filter events by clicking the Filter button and selecting a predefined filter (defined in

"Event Console Preferences" on page 487). When a filter is selected , the filter icon changes to .
To clear the filter, click the button again and select No Filter. SiteScope includes a predefined
"Assigned toMe" event filter, which displays all events assigned to the logged in SiteScope user.

l Click the quick status filter icons to only show those events that have a
particular status. Click the icon again to clear the filter.

l You can useQuick Search to search events for a specific name or value in any displayed field.

Tips/Troubleshooting
Unified Console Limitations and Troubleshooting
l Unified Console should not be used in SiteScope for Load Testing installations.
l Themaximum number of Unified Consoles that can be open simultaneously is 20.
l If SiteScope is restarted while Unified Console and SiteScope windows are open, you are unable to login
back into SiteScope after the restart if you refreshed Unified Console before SiteScope (session is
invalidated and could not be restored after timeout j_security_check).
Workaround:Close all open SiteScope and Unified Console windows, and then reopen SiteScope and
Unified Console.

Event Console Troubleshooting
l If you get an unsupported browser message when using Internet Explorer, check that Browser Mode and
Document Mode are set correctly for the browser. We recommend settingBrowser Mode according to
the IE version, andDocument Mode to standards mode. To check themode, press the F12 key to open
the developer tools, and themode is displayed in themenu bar. Change themode settings as required.

l If the Event Console is not displaying events, check the following:
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l Predefined event filters are configured correctly (Preferences > Event Console Preferences).

l The logged in user has the required permissions to view ormanage events (Preferences > User
Management Preferences). For details, see "What are the User Roles and Required Permissions?"
on page 916.

l If the Event Console is missing columns, or the Event Details dialog box is corrupted, reset theMetaData
file as follows:
a. Open the Javamonitoring andmanagement instrumentation (JConsole) tool. For details, see "How to

Use the JMX Console" on page 56.
b. In JConsole, click theMBeans tab, and open

co.mercury.sitescope\Web\EventConsole\ConsoleMBean\Operations\resetTableMetadata.
c. Click the resetTableMetadata button.

l If a regular expression does not match any event when using a predefined filter, the full list of events is
displayed in the Event Console. You can use the Regular Expression Tool to check your regular
expressions. For details, see "Regular Expression Tool" on page 117.

Exporting Event Data
By default, active events are written to the persistency file and are automatically included in SiteScope
configuration data when importing/exporting data using the SiteScope Configuration Tool.

Historical events are written to the event_console_history.log files (as described in "Historical Event Log
Files" on page 917). To include historical events when importing or exporting data, you need to select Include
log files in the Import/Export Configuration option of the SiteScope Configuration Tool.

For details on using the SiteScope Configuration Tool, see the SiteScope Deployment Guide (<SiteScope
root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Event Console Error Log Files
You can get information on Event Console errors, client-side and server-side, in the following log files.

The log files are available from <SiteScope root directory>\logs, as well as from the Log Files page (Server
Statistics > Log Files). The event_console.logmust first be activated in order to make it available in the
Log Files page (as described below).

Log File Description

event_
console_
ui.log

Lists all error messages that were sent from the Event Console user interface to the event_
console_ui.log on the SiteScope server. For example, it includes "not authorized" errors
when the user does not have the required permissions.

Since SiteScope typically has multiple users, you can identify which error is sent for a
particular user by the error message which starts with <User display name> <session
ID> (such as, SiteScope Administrator DC8AF1DC325C3E745646AD6FC5C7A23C).

The name of the current log is event_console_ui.log. When the current log reaches its size
limit (by default, 1000 KB), it is closed and a new log is created. Older logs are named
event_console_ui.log.1, event_console_ui.log.2, and so forth. The higher the number
concatenated to the name, the older the log. Parameters for this log are configured in the
log4j.properties file.
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Log File Description

event_
console.log

Lists all server-side errors relating to the Event Console. To activate the log (andmake it
available in the Log Files page), youmust add the appender to the log4j.properties file (by
default, the log is opened to debug level). Logs level are configurable.

To activate the log:

1. Open the log4j.properties.debug file in the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava folder.

2. Search for the "Event Console Appenders and Loggers" section, and copy the relevant
lines (as explained in the log) to the log4j.properties file.

3. Save the changes. A SiteScope restart is not required.

Event Console User Interface
The Event Console enables you to display andmanage live and historic SiteScope events from a centralized
location.

To access l From the SiteScope Dashboard: In theMonitors context, click theDashboard tab, and
then click theUnified Console button.

l Open aWeb browser, and enter the following URL:
http://<server_name>:<port>/SiteScope/WebMain#/eventconsole (for Event
Console only) or
http://<server_name>:<port>/SiteScope/WebMain (for Event Console andMulti-
View).
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Important
information

l To be able tomanage events, youmust be an administrator in SiteScope, or a user
granted the appropriateEvent console permissions (granted to all users by default). For
details on user permissions, see "User Management Preferences" on page 625.

l A user can view event details for events that are associated with monitors for which they
haveAllowed Groups permissions. This applies to live and historical events.

Event Console:

l When Event Console is selected, all active events are displayed by default (up to the
maximum number of events that can be stored on the server; set inMaximum number
of live events). You can filter this list using the quick status filter icons, or by selecting a
predefined filter in the filter selection field. Event filters are configured in "Event Console
Preferences" on page 487.

l Double-click an event to display additional details of the selected event, and to update
the event details. For details, see "Event Details Dialog Box" on page 931.

l Events are sorted by default according to the time that they are received; themost recent
events are displayed at the top of the list.

Ops View:

l WhenOps View is selected, the Event Console is displayed below Multi-View. The
Event Console displays all events that are associated with monitors for which the user
has Allowed Groups permissions. Events are sorted by default according to the time
that they are received; most recent events are displayed at the top of the list.

l When you select amonitor or group inMulti-View, the Event Console displays only those
events that are associated with the selectedmonitor or group.

l When you click an event in the Event Console, Multi-View changes to display the
associatedmonitor together with its parent group (the associatedmonitor is highlighted
with a blue border).

l Navigating between view types inMulti-View (Monitors\Servers\Tags) or filtering in
Mullti-View does not change the displayed events until you select a particular monitor or
group inMulti-View.

See also l "Event Console" on page 914
l "Event Console Preferences" on page 487
l "Multi-View" on page 936

Event Console - Live Console and Event History View
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Tabs
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UI Element Description

Live Console View This view displays the list of active (non-closed) events that were triggered from
Event Console alert actions. The number of events displayed is determined by the
Maximum number of live events setting inPreferences > Infrastructure
Preferences > Event Console Settings. When this number is reached, the
oldest event is automatically closed, and removed from the Live Console view.
Discarded events are displayed in the Event History view and are written to the
event_console_history.log.

The number of events currently displayed in the Live Console is shown in
parenthesis in the view header when this view is selected. Note that this number
might not reflect the total number of live events if a filter has been applied to the
view.

Specific event attributes for live events can bemodified in the Event Details dialog
box. For details, see "Event Details Dialog Box" on page 931.

Event History View This view displays the list of closed (non-active) events that were triggered from
Event Console alert actions. By default, the Event History view displays historical
events from the last 48 hours. You canmodify the number of previous hours of
historical events to display in the Event History view, and themaximum number of
historical events that can be displayed, inPreferences > Infrastructure
Preferences > Event Console Settings.

The number of events currently displayed in the Event History is shown in
parenthesis in the view header when this view is selected. Note that this number
might not reflect the total number of events in the Event History view if a filter has
been applied to the view.

Records are displayed in the Event History view when:

1. An event is manually closed by the user.
2. An event is automatically closed by SiteScope after themaximum number of

live events that can be stored on the server has been reached.
3. The problem was reported in another event. A typical example is where the

same event occurs in the next monitor run (and alert trigger frequency is set to
every time the event occurs). In this scenario, SiteScope closes the previous
instance of the reported event.

Note:

l Event attributes in the Event History view are read-only and cannot be
updated.

l Historical events are not refreshable; they are retrieved on demand when
switching to Event History view.

l Event History is also included in the event_console_history.logwhich is
available from (Server Statistics > Log Files), or from the <SiteScope root
directory>\logs directory.

Event Console Toolbar
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UI Element Description

Quick Status Filter. Click the quick status filter icons to only show those events
that have a particular status. Click the icon again to clear the filter. By default, all
active events are displayed.

Quick Search. Enables you to search events for a specific name or value in any
displayed field. Type a string that you want to search for in the Quick Search box.
All events with text that match the search string are displayed in the Event
Console.

Select ColumnsSelect the columns to display in the Event Console.

By default, Status, Time,Title, Host, and State are displayed.

The other columns available for display are: Severity, Priority, Assigned User,
Category, Sub Category, Description, Key, Close Key.

Filter Events. (Available in Live Console view only) Opens the Event Filter
selector from which you can select a predefined event filter. By default, SiteScope
includes the predefined "Assigned toMe" event filter, which displays all events
assigned to the logged in SiteScope user.

Additional filters can be defined inPreferences > Event Console Preferences >
Event Filters. For details on defining a filter, see "How to Configure Event Filters"
on page 487.

When a filter is selected, the icon changes color to blue. To clear the filter, select
<No Filter> (icon changes to gray).

Table Columns

Status Displays themonitor threshold status in SiteScope that corresponds to the
console event.

The following icons indicate event status: Error, Warning, andGood.

Time The date and time when the event occurred in themonitored environment.

Title Description of the event.

Default value:Console Event was triggered due to alert '<<alertName>>' being
fired onmonitor '<<fullMonitorName>>'

Host The target monitoring host related to the event.

State The state used to describe the lifecycle state of the event.

The values can beOpen, In progress, Resolved, or Closed.

Priority Importance assigned to the selected event by the dispatcher.

The values can be None, Lowest, Low, Medium, High, or Highest.
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UI Element Description

Severity Severity of the occurrence related to the event. Severity mappings correlate the
monitor threshold status in SiteScope to the severity level in console events.

The default event severity mappings can be changed in the Severity Mapping
Preferences dialog box inPreferences > Event Console Preferences > Default
Settings > Edit Severity Settings.For details, see "Severity Mapping
Preferences Dialog Box" on page 489.

The severity values can be:

l Critical (by default, this corresponds tomonitors in Error status)
l Major
l Minor (by default, this corresponds tomonitors inWarning status)
l Warning
l Normal (by default, this corresponds tomonitors in Good status)
l Unknown (by default, this corresponds tomonitors in Unavailable status)

Assigned User User who is responsible for solving the issue.

Category Themonitor type to which the event belongs (for example, Ping, CPU).

Sub Category Themonitor group path, such as SiteScope\Test\CPU Utilization on
SiteScope Server.

Description More detailed or supplementing information (in addition to the “Title”) that describes
the event. This might include information about what threshold has been crossed
(or other trigger conditions), and the current values.

Key A unique string representing the type of event that occurred. Two events can have
the same key if both events represent the same situation in the environment (the
two events are duplicates). This field is not editable.

Close Key Enables the event that is sent to automatically close all the events whose key
attributematches this expression.

Note:SiteScope always adds "<*>" to the end of your close key pattern.

Event Details Dialog Box
The Event Details dialog box displays additional details of the selected event, and enables you to update the
Severity, Title, State, Priority, Assigned User, and Description attributes of the event.

To access 1. Open theUnified Console (http://<server_name>:<port>/SiteScope/WebMain),
and select Ops view to display Event Console andMulti-View, orEvent Console
to display Event Console only.

2. Double-click an event in the Event Console to open the Event Details dialog box.
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Important
information

l To be able tomanage events (assign users to events, edit event details), youmust be an
administrator in SiteScope, or a user granted the appropriateEvent console permissions
(granted to all users by default). For details on user permissions, see "User Management
Preferences" on page 625.

l A user can view event details for events that are associated with monitors for which they
haveAllowed Groups permissions.

l For default values (and examples) used in console event attributes, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 469.

l If there is an error in any of the editable fields, SiteScope is unable to save the changes.
Place the cursor over the error icon, and use themessage to help resolve the issue.

Relevant
tasks

l "Event Console" on page 914
l "Event Console Preferences" on page 487

See also "Multi-View" on page 936
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Event Details
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Opens an email with subject line "SiteScope event notification". The email
contains a link to the event in the Event Console. The link opens the Unified
Console, and displays the event in the Event Console, together with the
correspondingmonitor on which the event was triggered (and themonitor's
parent group) displayed inMulti-View.

Enter the email address of the event recipients (the assigned user and any
other users that you want to be notified), add any other additional details to the
mail, and send themail.

Status Displays themonitor threshold status in SiteScope that corresponds to the
console event. The status can be: Error, Warning, Good.

The event status is also indicated by the following icons that are displayed on
the left side of the dialog box:

Severity Severity assigned to the selected event. The severity can be: Critical, Major,
Minor, Warning, Normal, Unknown. This field is editable.

Note: Themonitor threshold status for console events in SiteScope is mapped
to the event severity. The default event severity mappings can be changed in
the Severity Mapping Preferences dialog box inPreferences > Event
Console Preferences > Default Settings > Edit Severity Settings. For
details, see "Severity Mapping Preferences Dialog Box" on page 489.

Time The date and time when the event occurred in themonitored environment.

Title Description of the event. This field is editable.

Host The target monitoring host related to the event.

State The point in the event lifecycle state that the selected event has reached. This
field is editable by selecting one of the following states:

l Open. Event is identified for investigation of the problems that caused the
event. It is either not assigned to a user or assigned but not yet being
worked on.

l In Progress. Assigned user has started working on the investigation of the
event's underlying problems. The name of the assigned user appears in the
User column.

l Resolved. Investigation into the selected event's underlying problem is
found and fixed.

l Closed. Event is removed from the list of active events.
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UI Element Description

Priority Priority assigned to the selected event. This field is editable.

The values can be None, Lowest, Low, Medium, High, or Highest.

Assigned User Name of the user who is responsible for solving the event's underlying
problem. This field is editable.

To assign a user, type the name of the SiteScope user to which you want to
assign the event in the search box. If SiteScope is enabled to use LDAP
authentication, the list includes LDAP users that are part of the contexts
supplied in the LDAP configuration and user role.

Note:By default, the LDAP server returns 400 results (it can be configured to
retrieve amaximum of 1000). If you have an Active Directory domain that
exceeds this number of users, you cannot assign an event to an LDAP user
that was not listed in the results retrieved from the LDAP server, even if you
manually enter the email address of the user.

Click theMail To button to send email notification.

Category Themonitor type to which the event belongs (for example, Ping, CPU).

Sub Category Themonitor group path, such as SiteScope\Test\CPU Utilization on
SiteScope Server.

Description More detailed or supplementing information (in addition to the “Title”) that
describes the event. This might include information about what threshold has
been crossed and the current values. This field is editable.

Key A unique string representing the type of event that occurred. Two events can
have the same key if both events represent the same situation in the
environment (the two events are duplicates).

Close Key Enables the event that is sent to automatically close all the events whose key
attributematches this expression. If no close key was selected, this event will
not close other events.

Custom Attributes

Name Value

Service id Enables customizing the service name that is sent from SiteScope events to
HPOM by entering the value of themonitor service ID. This is useful for
relating the SiteScopemonitor with the HPOM Service Name.

SiteScopeDrilldownURL Opens themonitor in the SiteScope Dashboard view from which the event
was triggered, enabling you to troubleshoot the issue.

Note: If there are several Network Interface Controllers (NIC) on a SiteScope
server and you want to specify which NIC to use in SiteScopeDrilldownURL,
you can specify the host of the appropriate NIC by adding _
configuredLocalhostName=<host> to the <SiteScope root
directory>\groups\ master.config file.

customerId The customer ID (1 by default).
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UI Element Description

Unified Console URL Opens the Event Console in the Unified Console.
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Chapter 97: Multi-View
Multi-View simplifies themanagement of large, distributed environments by providing a unified view into
the performance of everything that is beingmonitored in your IT infrastructure. It fully utilizes the screen to
display the near-real time status of all groups andmonitors without losing the hierarchical relationship between
the data. Multi-View is ideal for displaying enterprise-widemonitoring status in a network operations center.

UsingMulti-View, you can group objects in various different ways to fit the perspective of different personas.
For example, you can use it to display all SiteScope groups andmonitors in a hierarchical treemap; display
monitors grouped by target remote server; or display monitors grouped by custom search/filter tags. You can
also drill down to seemore detailed information on groups andmonitors to facilitate problem diagnosis and
troubleshoot server related issues.

You can also useMulti-View side-by-side with the Event Console to display andmanage all SiteScope events
from a centralized location.

Example:Multi-View showing the status of all groups andmonitors at the root level

Tip: You can view guided and narrated demonstrations on usingMulti-View, usingMulti-View and Event
Console, and How toManage and Track Monitors in Multi-View Using Filters and Tags.

To access
Multi-View is available in the Unified Console. You can access the Unified Console directly from a browser or
from the SiteScope Dashboard.

l To access the Unified Console from a browser, enter the URL in aWeb browser in the format:
l http://<server_name>:<port>/SiteScope/WebMain#/multiview (opens the Unified Console, with
focus onMulti-View)

l http://<server_name>:<port>/SiteScope/WebMain (opens the Unified Console, with focus on
Multi-View and Event Console)
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l To access the Unified Console from the SiteScope Dashboard, select theMonitors context, click the
Dashboard tab, and then click theUnified Console button. The Unified Console opens in Ops View,
which displays bothMulti-View and the Event Console. To display only Multi-View, click Multi-View .

Tip: You can haveMulti-View open and focus on:

l A particular group or monitor selected in themonitor tree. To do so, select the required group or
monitor you want to view, and then click Unified Console.

l SiteScope objects that meet the criteria that you define in a filter, or on a selected object in the
filter. To do so, select the required filter in the context toolbar of themonitor tree, or an object in the
filtered objects displayed in themonitor tree, and then click Unified Console.

Learn About
This section includes:

l "Multi-View Overview" below
l "Supported Browsers and Screen Resolutions" on the next page
l "Viewing Categories" on the next page
l "ConfiguringMulti-View Settings" on page 939

Multi-View Overview
Benefits of usingMulti-View include:

l Displays the near-real time status of all SiteScopemonitors and groups in a single view, enabling you to
more easily understand the overall impact of problems in your IT infrastructure. Groups andmonitors are
color-coded to provide quick, at-a-glance information on performance status.

l Displays monitors from different perspectives: grouped by target server view, tags view, and the standard
SiteScope hierarchy perspective. For example, application owners might want to see SiteScope objects
grouped by applications, while system administrators might prefer to have it grouped by servers. Both
personas might need to switch between the different dimensions.

l Ability to work side-by-side with the Event Console—a central view for all notificationmessages about the
performance of your applications and servers—to accelerate your ability to manage, identify, and resolve
performance issues. For details, see "Event Console" on page 914.

l Fully utilizes the screen to display the status of all groups andmonitors. Multi-View is fully supported on
big and small screens, making it is ideal for viewingmonitor data in a network operations center. It is also
supported on iPad and Android tablets.

l Provides filtering and drill down to view more detailed information on groups andmonitors, enabling you to
focus only on those groups andmonitors you want to view.

l Enables you to isolate the root cause of problems and perform troubleshooting actions tomitigate issues.
l Multi-View is HTML-based. It is supported in additional browsers, including Chrome and Safari, and it runs
in web browsers. You can access Multi-View directly using the
http://<SiteScope>:8080/SiteScope/MultiView link. For the list of supported browsers, see "Supported
Browsers and Screen Resolutions" on the next page.

l Multi-View is supported in MyBSMwhen SiteScope is connected to a BSM server, enabling you to
consolidatemultiple SiteScope views. The predefinedMyBSMMulti-View page also displays the status of
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the SiteScope profile CI of all SiteScope servers connected to the BSM system. This enables you to
access and troubleshoot SiteScope without having to drill down to the SiteScope instance.

Supported Browsers and Screen Resolutions
Supported Browsers and Devices

The following browsers are supported:

l Google Chrome browsers (latest certified version): 48.0.2564.116m.
l Mozilla Firefox (latest certified version): 38 ESR
l Safari (latest certified version): 8.0 for Mac
l Internet Explorer 10, 11
The followingmobile devices are supported:

l iPad 3 with Safari (iOS 8with latest updates)
l Android tablet with Chrome 34.0.1847 (or with any latest default browser of Android) Full HD display
Default Screen Resolution

l Large Desktop – 1680 x 1050 pixels
l Laptop – 1280 x 800 pixels
l iPad – 1024 x 768 pixels

Viewing Categories
There are various options for displaying and grouping objects in Multi-View.

These views also enable the same persona to switch between views and see SiteScope data from a different
perspective for problem analysis.

l Monitors View
Enables displaying all SiteScope groups andmonitors in a flattened view as a set of nested rectangles.
The hierarchical relationship between the data is retained, enabling drill down to different levels.
For task details, see "How to Select and Configure a View" on page 940.

l Servers View
The servers view provides a new grouping option to fit the perspective of different personas viewing
SiteScope data. It enables you to display SiteScopemonitors grouped by target servers. This is useful, for
example, for system administrators whomight prefer to view monitors grouped by remote servers.

Note: The Servers view displays only those remote servers that are displayed in the remote server
tree. It does not display the SiteScope server, non-persistence servers used for URL/Pingmonitors,
or browsable servers.

For task details, see "How to Select and Configure a View" on page 940.
l Tags View
The tags view provides a new grouping option to fit the perspective of different personas viewing
SiteScope data. It enables you to group SiteScopemonitors based onmonitor tags; eachmonitor is
displayed under a new group according to its tags. This lets you see the status of your system in several
ways. You can drill down on tags or tag values to display only themonitors to which these tags or tag
values have been assigned.
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For example, you can tagmonitors by geographic location, application, operating system, environment
type (test/development), and so forth. This provides maximum flexibility for customizing your viewing
perspective. For task details, see "How to Select and Configure a View" on the next page and "How to
Assign Custom Search/Filter Tags and View Monitors in the Tags View" on page 942.
To tagmonitors, youmust first define the tags and their values inPreferences > Search/Filter Tags, and
assign these tags to one or moremonitors in themonitor tree. When the Tags view is selected from the
drop-down list, only monitors with the selected tag assigned to them are displayed. For details on creating
search/filter tags and assigning them to SiteScope objects, see "How to Filter the View Using
Search/Filter Tags" on page 67.

Note:

l The Tags view is only available to an administrator in SiteScope, or a user grantedView tags
permissions. For details on user permissions, see "User Management Preferences" on page 625.

l If you choose to display all tags, the view may contain the samemonitors more than once if the
monitor has been assignedmultiple tags.

l Health Monitors
Enables displaying the SiteScope Health group of monitors that are deployed to check the performance
and availability of SiteScope itself. The SiteScope server name and health status to left of the SiteScope
server name are always displayed in theMulti-View header panel. The icon shows the status of the
SiteScope Health group based on the worst child (taking the worst status of all health monitors in the
group).
You can link to the SiteScope Health group from the SiteScope server name link, or from the SiteScope
Health filter in theMonitors view.
For task details, see "How to View SiteScope Server Health in Multi-View" on page 942.

Configuring Multi-View Settings
l You can configure the followingMulti-View properties in theMulti-View Settings panel of Infrastructure
Preferences. For details, see "Multi-View Settings" on page 543. Changing any of these settings requires
a SiteScope restart.
l Configuration change refresh frequency (seconds). Amount of time to wait between refreshing the
configuration changes inMulti-View. Configuration data includes adding, deleting, or moving a group or
monitor, and changing a group or monitor name. The default value is 60 seconds (this is also the
minimum value).

l Runtime data refresh frequency (seconds). Amount of time to wait between refreshing the runtime
data in Multi-View. Runtime data includes monitor or group status changes and enable/disable
information. The default value is 5 seconds (this is also theminimum value).

l Maximum number of Multi-Views. Once themaximum number of openMulti-Views has been
reached, a popup window informs the user, and no additional Multi-Views can be opened. The default
value is 20 (this valuemust be between 1 and 20). This number is dependent on the caching frequency;
increasing the cache clearing interval reduces the number of views that can be open simultaneously).

l Interval before clearing view cache since last used (seconds). Amount of time, in seconds, to wait
since a view was last used, before clearing the cache. This number impacts the number of Multi-Views
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that can be open simultaneously; increasing the cache clearing interval reduces the number of views
that can be open simultaneously. The default value is 120 seconds (theminimum value is 5).

l You can configure amail alert to be sent with a link to theMulti-View URL by adding the <multiViewUrl>
variable to themail template. For details, see "Configure SiteScope Alerts" on page 1072.

Tasks
This section includes:

l "How to Select and Configure a View" below
l "How to Assign Custom Search/Filter Tags and View Monitors in the Tags View" on page 942
l "How to View SiteScope Server Health in Multi-View" on page 942
l "How to Diagnose and Troubleshoot Problems inMulti-View" on page 943
l "How to Display Your Corporate Name or Logo in theMulti-View Header" on page 944
l "How to Get a URL That Links Directly to aMonitor or Group inMulti-View" on page 944

How to Select and Configure a View
This task describes how to select and configure a view inMulti-View.

1. Prerequisites.
l The groups displayed in the SiteScopeMulti-View are only those that can be accessed by the user
profile logged on to SiteScope. Similarly, the actions that can be performed on groups andmonitors
are dependent on the action permissions assigned to the user account. For details on user accounts,
see "User Management Preferences" on page 625.

l To use the Tags view, certain prerequisites are required. For details, see "How to Assign Custom
Search/Filter Tags and View Monitors in the Tags View" on page 942.

2. OpenMulti-View (see "To access" on page 936).

Note: If you openedMulti-View from the SiteScope Dashboard having selected a group or monitor in
themonitor tree, Multi-View focuses on the selected group or monitor.

3. To select or change the view, click the views drop-down list on the upper left side of theMulti-View
window, and select one of the following view categories:
l Monitors:Displays SiteScope groups andmonitors in a flattened view as a set of nested rectangles.
The hierarchical relationship between the data is retained, enabling drill down/up to different levels.

l Servers. Displays SiteScopemonitors grouped by target server. This provides a new grouping option
to fit the perspective of different personas viewing SiteScope data. It also enables viewing SiteScope
data from a different perspective for problem analysis.

l Tags. Displays SiteScopemonitors grouped by custom search/filter tags. This provides a new
grouping option to fit the perspective of different personas viewing SiteScope data. It also enables
viewing SiteScope data from a different perspective for problem analysis.

Click Apply to apply the selected view option.
4. To filter objects in Multi-View using filters pre-defined in the SiteScopemonitor tree, click the filters drop-
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down list (to the right of the views drop-down), and select a filter. The filters list displays the following:
l All Monitors. Displays all the groups andmonitors that are available in the SiteScopemonitor tree.

Tip: To enhance performance and tomaximize the benefits of usingMulti-View in loaded
configurations, we recommend that you select a filter, or drill down to those groups andmonitors
you want to view instead of displaying all SiteScope objects.

l <Filter name>. Filters defined in the SiteScopemonitor tree (if any). Filters can be defined with
different criteria that can be applied for viewing the data from different user perspectives, including
filtering by monitor name, monitor type, target server, tags, enabled/disabled status of monitors or
alerts, and BSM reporting settings. For details on defining a filter in themonitor tree, see "Filter
Objects in the SiteScope View" on page 65.

Note:When a new filter is created in themonitor tree, it is only visible in Multi-View after
refreshing the view (F5).

l SiteScope Health. The SiteScope health group of monitors display information about the
performance and availability of SiteScope itself. For details, see "SiteScope Server Health Monitors"
on page 989.

Click Apply to apply the selected filter option.
5. To display SiteScope groups andmonitors that meet a particular status criteria, click the status drop-

down list (to the right of the filters drop-down), and select the status criteria to display: Error, Error and
Warning, Disabled,Warning, No Data, Good and Warning, orGood. For details, see "Multi-View
Toolbar" on page 945.
Click Apply to apply the selected status criteria.

Tip: You can apply the status filter to a filter selected in the filters drop-down to view only those
monitors that meet the filter criteria and have a particular status.

6. You can drill down to display a selected subgroup within amulti-level context by clicking the subgroup in
the treemap or the appropriate subgroup link in the breadcrumbs. Only the selected subgroup and its
components are displayed in the treemap.
You can return to previous levels using the breadcrumbs.

Tip: If the Event Console is displayed, you can see all events associated with the selectedmonitors
or groups.

7. Place the cursor over a group or monitor which you want to view or troubleshoot, and click the information
icon to open theGroup/Monitor Details dialog box. For details, see the "Monitor Details Dialog Box" on

page 949 or "Group Details Dialog Box" on page 951.
You can use this information to help diagnose the root cause of problems and perform troubleshooting, as
described in "How to Diagnose and Troubleshoot Problems inMulti-View" on page 943.

Note: You canmodify Multi-View settings from Preferences > Infrastructure Preferences > Multi-
View Settings. For details of the configuration settings, see "ConfiguringMulti-View Settings" on
page 939.
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How to Assign Custom Search/Filter Tags and View Monitors in the Tags View

Tip: You can view a guided and narrated demonstration onmanaging and trackingmonitors using filters
and tags on YouTube: http://hpsw.co/r5D4GxA.

1. Prerequisites.
The Tags view is available only to an administrator in SiteScope, or a user grantedView Tag
permissions. For details on user permissions, see "User Management Preferences" on page 625.

2. Create a search/filter tag.
In SiteScopePreference > Search/Filter Tags, create custom search/filter tags for use in filtering the
display. You define the tags and their values. For example, you define a tag called Applicationwith the
possible values of HR, CRM, and Online Banking.

Note: To be able to add, edit, or delete search/filter tags and tag values, youmust be an
administrator in SiteScope, or a user grantedAdd, edit or delete tags permissions.

3. Assign the search/filter tag to one or more SiteScopemonitors.
a. In the SiteScopemonitor tree, select themonitor you want to tag.
b. In the Properties tab, expand theSearch/Filter Tags panel, and assign a tag and tag values to the

monitor.
c. Repeat for all monitors to which you want to assign this tag and value.

4. OpenMulti-View, and select Tags in the views drop-down list.
5. You can drill down on tags or tag values to display only themonitors to which the selected tag item has

been assigned.

For example, you can filter for all monitors that have the Application tag with the CRM tag value
assigned to them.

Note:

l The tag group status is based on the worst child rule (taking the worst status of all monitors in the
tag group). You cannot drill down to group details from this icon.

l The samemonitor can be displayedmore than once in the tags view if themonitor has been
assignedmultiple tags, and those tags are selected in the filter.

How to View SiteScope Server Health in Multi-View
1. OpenMulti-View (see "To access" on page 936).
2. Click the SiteScope server name link at the upper part of the window. The icon to left of the name shows

the status of the SiteScope Health group based on the worst child (taking the worst status of all health
monitors in the group).
(The SiteScope Health monitors can also be accessed from the filters drop-down list in theMonitors
view.)
For details on Health Monitors, see "SiteScope Server Health Monitors" on page 989.

Note: To return to themonitors and group treemap, select All Monitors in the filters drop-down list
and click Apply.
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3. Drill down to view problematic monitors as discussed in "How to Diagnose and Troubleshoot Problems in
Multi-View" below.

How to Diagnose and Troubleshoot Problems in Multi-View
You can diagnose the root cause of problems and perform troubleshooting fromMulti-View.

1. Identify themetrics in error

Place the cursor over amonitor which you want to view or troubleshoot, and click the information
icon to open theMonitor Details dialog box. Click theMetrics tab to view the list of monitor metrics with
error or warning status.

2. Rerun themonitor(s) to check if the problem still exists
In the Group/Monitor Details dialog box, click Run Now to verify the problem still exists. This action
reruns themonitor or themonitors in group.

3. Generate a report to view performance and availability over time
In the Details tab, click Generate Report to generate a report for the group/monitor. You can use this
report to help determine the nature of the problem, and to see how long the group or monitor has been in
error.

4. Disable themonitor or alerts to prevent additional notifications being triggered
Depending on the diagnosis, you can disable themonitor or monitors in group, or disable alerts
associated with themonitor or group and continue to use themonitor.
To assist in troubleshooting, you can check the alert history for themonitor to determine whether this is a
reoccurring issue (all associated alerts are displayed in the alerts section).

Note: The triggered alerts table is only displayed for users that have permissions to view alerts. For
details on user permissions, see "Permissions" on page 636.

5. Add an acknowledgment to track resolution of the problem

After reviewing alerts, click the button and add a comment acknowledging the
monitor status. The acknowledgment comment is displayed (after refreshing the view) as a tooltip
associated with the acknowledgment icon in the SiteScope Dashboard view, and is recorded in the
Acknowledge Log.

Note: Acknowledgments can only be deleted from the Acknowledge Log (available from the
AcknowledgeMonitors In Group dialog box in the SiteScope Dashboard). Deleted
acknowledgments are not displayed in the Acknowledgments list in Multi-View.

6. Drill down to group or monitor properties
To investigate the issue further, click Drill Down to Group/Monitor Properties to open the group or
monitor in Manage view in the Unified Console.

Note: For the newly-opened browser to work, youmust set -Xss1m in theRuntime Parameters
column of the Java Runtime Environment Settings dialog box (Java Control Panel > Java tab >
View) on themachine where the SiteScope user interface is opened.
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How to Display Your Corporate Name or Logo in the Multi-View Header
1. Prerequisites.

Youmust be a user with access to the SiteScope server file system.
2. Take a screen capture of the name or logo that you want to appear at the top of theMulti-View window.

l We recommend that you use an image with amaximum width of 300 pixels and a height of 40 pixels.
If the image exceeds these dimensions, it will not appear correctly in the header.

l Various image formats are supported, including gif, png, jpg, and bmp.

3. Save images using with the following name format: customLogo*.<image_format>.
4. Copy image files to the <SiteScope root directory>\templates.multiView folder.

Note: Custom images are supported when upgrading SiteScope; the images in the above folder are
included in the SiteScope import/export configuration.

5. After uploading image files, reload theMulti-View page to display the corporate name or logo in theMulti-
View Header.

How to Get a URL That Links Directly to a Monitor or Group in Multi-View
1. In the SiteScope Dashboard view, focus on the relevant group or monitor in themonitor tree, and then

click Unified Console. Multi-View opens in a browser and focuses on the selected group or monitor.
2. Copy the URL from the browser. You can then use this URL to drill down directly to the relevant group or

monitor in your infrastructure.

See also: "Event Console" on page 914

Tips/Troubleshooting
Unified Console Limitations and Troubleshooting
l Unified Console should not be used in SiteScope for Load Testing installations.
l Themaximum number of Unified Consoles that can be open simultaneously is 20.
l If SiteScope is restarted while Unified Console and SiteScope windows are open, you are unable to login
back into SiteScope after the restart if you refreshed Unified Console before SiteScope (session is
invalidated and could not be restored after timeout j_security_check).
Workaround:Close all open SiteScope and Unified Console windows, and then reopen SiteScope and
Unified Console.

Multi-View User Interface
UseMulti-View to get an overview of the performance status of everything that is beingmonitored in your IT
infrastructure in a single view. It provides filtering and drill down to enable you to focus only on those groups
andmonitors you want to view, helping you to isolate the root cause of problems and troubleshooting issues.

Using SiteScope
Chapter 97: Multi-View

HPE SiteScope (11.33) Page 944 of 1206



To
access

l From the SiteScope Dashboard: In theMonitors context, click theDashboard tab, and then
click theUnified Console button.

l From a browser: Enter theMulti-View URL in aWeb browser. The URL should be in the
format: http://<server_name>:<port>/SiteScope/MultiView

Relevant
tasks

"How to Select and Configure a View" on page 940

"How to Assign Custom Search/Filter Tags and View Monitors in the Tags View" on page 942

"How to View SiteScope Server Health in Multi-View" on page 942

"How to Diagnose and Troubleshoot Problems inMulti-View" on page 943

See also "Multi-View" on page 936

User interface elements are described below (unlabeled elements are shown in angle brackets):

Multi-View Toolbar
TheMulti-View Toolbar enables you to filter the view according to the needs of different personas, such as
system administrators, application owners, and so on, or to view SiteScope data from a different perspective
for problem analysis.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<SiteScope server name> Name of the SiteScope server currently displayed inMulti-View.

Click the server name to drill down to the SiteScope Health group of
monitors. The health monitors display information about the
performance and availability of SiteScope itself. For details, see
"SiteScope Server Health Monitors" on page 989.

The icon to left of the name shows the status of the SiteScope Health
group based on the worst child (taking the worst status of all health
monitors in the group).

Note:

l If you do not have view permissions for the Health group, the
server name link is inactive.

l To return to the groups andmonitors treemap, click theBack
button in your browser, or select All Monitors in the filter list and
then click Apply.

User If you enter a user name to log on to SiteScope, it appears on the
upper-right side of the window.

Opens the help for Multi-View.

Logs you out of Multi-View.
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UI Element Description

<View> Select a category by which to view objects in the treemap. You can
select a grouping option to fit the perspective of different personas
viewing SiteScope data, or to view SiteScope data from a different
perspective for problem analysis.

l Monitors. Groups the objects in treemap (groups andmonitors) in
a flattened view as a set of nested rectangles. The hierarchical
relationship between groups andmonitors is retained, enabling drill
down/up to different levels. This is the default setting.

l Servers. Groups monitors by target server. The Servers view
displays only those remote servers that are displayed in the remote
server tree. It does not display the SiteScope server, non-
persistence servers used for URL/Pingmonitors, or browsable
servers.

l Tags. Groups monitors by custom search/filter tags defined in
Preferences > Search/Filter Tags. Only monitors with the
assigned tag are displayed.

For more details on these categories, see "Viewing Categories" on
page 938.

<Filter> Enables filtering groups andmonitors in Multi-View by:

l All Monitors. This means that no filter has been selected, and all
SiteScope groups andmonitors are displayed inMulti-View.
Tip: To enhance performance and tomaximize the benefits of
usingMulti-View in loaded configurations, it is recommended to
select a filter, or drill down to those groups andmonitors you want
to view instead of displaying all SiteScope objects.

l <Filter name>. A filter pre-defined in the SiteScopemonitor tree.
Only those SiteScope groups andmonitors that meet the criteria of
the filter are displayed inMulti-View. Filters can be defined with
different criteria that can be applied for viewing the data from
different user perspectives. This includes filtering by monitor
name, monitor type, target server, tags, enabled/disabled status of
monitors or alerts, and BSM reporting settings. For details on
defining a filter in themonitor tree, see "Filter Objects in the
SiteScope View" on page 65.
Note:When a new filter is created in themonitor tree, it is only
visible in Multi-View after refreshing the view (F5).

l SiteScope Health. Displays the SiteScope Health group of
monitors. For details, see "SiteScope Server Health Monitors" on
page 989. This option is available only in theMonitors view, or from
theMulti-View header panel.
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UI Element Description

<Status> Displays only those SiteScope groups andmonitors that meet the
status criteria you select. The group status is based on the worst child
(taking the worst status of all SiteScopemonitors in the group).

Tip: It is recommended to select a status criteria when performing
troubleshooting, and to return to theAll Statuses view after
troubleshooting is complete.

l All Statuses. Shows all monitors or groups with any status,
including disabled and no data. This is the default setting.

l Error. Show only monitors or groups reporting an error status.
l Error and Warning. Show only monitors or groups reporting a
warning or error status.

l Disabled. Shows only monitors or groups reported as disabled.
l Warning. Shows only monitors or groups reporting a warning
status.

l No data. Shows only monitors or groups for which no data is
reported.

l Good and Warning. Shows only monitors or groups reporting a
warning or good status.

l Good. Show only monitors or groups reporting a good or OK
status.

For details on status levels, see "TreeMap Area" on the next page.

SiteScope applies the selected view, filter, and status settings and the
Multi-View display is updated accordingly.

If no items match the filter, or SiteScope is unable to display the
selected view, amessage is displayed. If it takes longer than 2
seconds to display the selected view, aCancel button is displayed,
enabling you to stop the filter. The current view is displayed until the
filter has been successfully applied.

<Breadcrumbs> Displays the levels through which you have navigated to get to the
current level. Appears horizontally across the top of the treemap.

Each level in the list of breadcrumbs is a link that can be clicked link
that you can use to trace your path of navigation, and focus on that
level in the treemap.

Note: Filters remain active until you change the filter criteria.
Therefore, somemonitors may not be displayed depending on the
status and filter criteria, and the selected view.
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Tree Map Area
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Status
Icons>

Displays the groups andmonitors for the element highlighted in themonitor tree or listed in the
breadcrumbs. Click a group to drill down to that object in the tree view. You can return to
previous levels using the breadcrumbs.

An icon is displayed for each object to represent the operational status assigned to that object
for its current performance level.

l Good Status. All performancemeasurements for the group or monitor are within the
Good threshold level.

l Warning Status. At least one performancemeasurement for the group or monitor is
within theWarning range, but nomeasurements are within the Error or Poor range.

l Error/Poor Status. At least one performancemeasurement for the group or monitor is
within the Error or Poor range.
This indicates either of the following:
l The performancemeasurement has a value, but at poor quality level.

l There is nomeasurement value due to some error.

l Status Not Defined (No Data). There is no data for the group or monitor. This can be
caused by any of the following reasons:
l A new monitor has not yet run.

l Monitor metrics have not yet been collected.

l Themonitors on which the group or monitor depend are not reporting aGood condition.

l Disabled Manually. The group or monitor is currently disabled, and no data updates
are being received.

l Group/Monitor Details.When you place the cursor over a group or monitor, the status
icon changes to the information icon. Click the icon to drill down to see details or
troubleshoot the group or monitor. For details, see the "Monitor Details Dialog Box" on the
next page or "Group Details Dialog Box" on page 951.
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UI
Element Description

<Group
Status>

The group status is based on the worst child (taking the worst status of all SiteScopemonitors in
the group). Group status reflects all themonitors in the group, regardless of whether they are
currently displayed (somemonitors may not be displayed depending on the status and filter
criteria, or if the user does not have permissions to see all monitors in the group). As a result, a
groupmight show Error status even though all monitors displayed in the group are in Good
status.

Note:

l If there is insufficient space to display either:
l All monitor names in a group, only themonitor status icon is displayed.

l All monitors in the group, the icon is displayed next to the group name.

Click the group name to drill down to see all themonitors within that group.
l If an unfiltered group is empty (it contains no entities), the node has a gray/white background

(depending on the selected background color) with no icon, and the status icon is
displayed.

l If a group that contains entities is empty after filtering, the group is color-coded according to
the worst child status of monitors in the group, and the icon is displayed to indicate that
the group contains entities.

l Node size is proportionate to the hierarchical level of the group, and not to the number of
objects in the group. The closer the group is to the SiteScope root node, the larger the node
size.

Monitor Details Dialog Box
TheMonitor Details dialog box enables you to view details and perform actions on the selectedmonitor.

To access In Multi-View, place the cursor over amonitor. The status icon changes to the information

icon. Click the icon to drill down to see details or troubleshoot themonitor.

Important
information

To perform actions in theMonitor Details dialog box, youmust be an administrator in
SiteScope, or a user granted the necessary permissions. For details on user permissions,
see "Permissions" on page 636.

Relevant
tasks

"How to Diagnose and Troubleshoot Problems inMulti-View" on page 943

See also "Multi-View" on page 936
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Details Tab

Status The status of themonitor (Good, Warning, Error, Disabled, No data).

Summary Displays themost recent measurement results reported by themonitor. This may
includemore than onemeasurement, depending on themonitor type. If a monitor is in
error status, a description of the error is displayed. If a monitor has been disabled, it
displays the disabled status (disabledmanually, disabled until x time, or disabled by
<Downtime Name> from BSM).

Last Run The date and time of the last monitor run.

Generate Report Click to create a one-time SiteScopeQuick report using pre-configured settings for
the selectedmonitor. For more details on the report, see "Quick Report" on
page 1172.

Run Now Click to run themonitor, and update the results in the Summary section. This button
is not available for amonitor in the Disabled state.

Description Contains information entered in theMonitor Description field of themonitor
properties.

Note: This field is not displayed if theMonitor Description field is empty.

Monitor State Displays the active state of themonitor (Enabled/Disabled).

l If themonitor is Enabled, theDisable button is displayed. Click to disable the
monitor. The color and icon of the box representing themonitor change to gray to
indicate that themonitor is inactive. Multi-View shows disabled manually,
Disabled from MultiView by user - <user name> in the Summary field.

l If themonitor is Disabled, theEnable button is displayed. Click to enable the
monitor. The color and icon of the box representing themonitor change according
to themonitor status.

For more details on changingmonitor state, see "Enable/Disable Monitors in Group
Dialog Box" on page 903.

Alerts State Displays the state of alerts associated with themonitor (Enabled/Disabled).

l Enabled. Indicates that alerts associated with themonitor are enabled. To
disable alerts associated with themonitor, click theDisable button.

l Disabled. Indicates that alerts associated with themonitor are disabled. To
enable alerts associated with themonitor, click theEnable button.

For more details on changing alert state, see "Enable/Disable Associated Alerts" on
page 265.
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UI Element Description

Triggered Alerts Displays details of all alerts triggered. This includes the following:

l Date. The date and time at which the alert was triggered
l Type. The type of alert action (for example, Post, Sound).
l Name. Name for this alert definition that is used to identify this alert definition in
the product display.

l Summary. Summary of the alert action performed.
Triggered alerts are only displayed for users that have view alerts permissions.

Acknowledgments
(Last 5)

Displays details of the last 5 acknowledgment comments added to themonitor. They
are used to track resolution of problems that SiteScope detects in your system and
network infrastructure. With this function, SiteScope keeps a record of when the
problem was acknowledged, what actions have been taken, and by which user.

Click the button to open the Add Acknowledgment dialog
box and add a comment acknowledging themonitor status.

Note:Acknowledgments can only be deleted from the Acknowledge Log (available
from the AcknowledgeMonitors In Group dialog box in the SiteScope Dashboard).
Deleted acknowledgments are not displayed in the Acknowledgments list in Multi-
View.

Drill Down to
Monitor
Properties

Opens the SiteScope instance in a new window, and drills down to the selected
monitor in Manage view in the Unified Console.

Note: For the newly-opened browser to work, youmust set -Xss1m in theRuntime
Parameters column of the Java Runtime Environment Settings dialog box (Java
Control Panel > Java tab > View) on themachine where the SiteScope user
interface is opened.

Metrics Tab

<List of metrics> Displays the name and value of monitor metrics that are in error or warning status.
You can sort themetrics table by metric name and value.

Group Details Dialog Box
TheGroup Details dialog box enables you to view details and perform actions on the selected group.

To access
In Multi-View, place the cursor over a group. The status icon changes to the information
icon. Click the icon to drill down to see details or troubleshoot the group.

Important
information

To perform actions in the Group Details dialog box, youmust be an administrator in
SiteScope, or a user granted the necessary permissions. For details on user permissions,
see "Permissions" on page 636.

Relevant
tasks

"How to Diagnose and Troubleshoot Problems inMulti-View" on page 943
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See also "Multi-View" on page 936

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Status The status of themonitors in the group (Good, Warning, Error, Disabled, No data).
The group status is based on the worst child (taking the worst status of all SiteScope
monitors in the group).

Summary Displays the number of monitors within the group and the number of monitors, if any,
that are reporting an error status.

Last Run The date and time of the last monitor run.

Generate Report Click to create a one-time SiteScopeQuick report using pre-configured settings for
all monitors in the selected group. For more details on the report, see "Quick Report"
on page 1172.

Run Now Click to run themonitors in the group, and update the results in the Summary
section. This button is not available for a group that is currently Disabled,

Description Contains information entered in the Group Description field of themonitor properties.

Note: This field is not displayed if the Group Description field is empty.

Monitors State Select the state for all monitors in the group:

l Enable All. Enables all monitors in the group. The status icons and color change
according to the group andmonitor status.

l Disable All. Disables all monitors in the group. The color and icon of each
monitor in the group change to gray to indicate that themonitor is inactive. Multi-
View shows disabled manually as the status in the Summary field.

Alerts State Select the state of alerts associated with monitors in the group:

l Enable All. Enables all alerts associated with monitors in the group.
l Disable. Disables indefinitely all alerts associated with monitors in the group.
For more details on changing alert state, see "Enable/Disable Associated Alerts" on
page 265.
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UI Element Description

Acknowledgments
(Last 5)

Displays details of the last 5 acknowledgment comments added to themonitor. They
are used to track resolution of problems that SiteScope detects in your system and
network infrastructure. With this function, SiteScope keeps a record of when the
problem was acknowledged, what actions have been taken, and by which user.

Click the button to open the Add Acknowledgment dialog
box and add a comment acknowledging amonitor status. If a group has subgroups
andmonitors within the subgroups, then the acknowledgment is added for all the
child items within the parent group (including all the subgroups andmonitors within
the subgroup).

Note:Acknowledgments can only be deleted from the Acknowledge Log (available
from the AcknowledgeMonitors In Group dialog box in the SiteScope Dashboard).
Deleted acknowledgments are not displayed in the Acknowledgments list in Multi-
View.

Drill Down to
Group Properties

Opens the SiteScope instance in a new window, and drills down to the selected
group inManage view in the Unified Console.

Note: For the newly-opened browser to work, youmust set -Xss1m in theRuntime
Parameters column of the Java Runtime Environment Settings dialog box (Java
Control Panel > Java tab > View) on themachine where the SiteScope user
interface is opened.
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Chapter 98: Ops View
Ops View combines the Event Console andMulti-View in a single view. Working side-by-side with the
Event Console andMulti-View helps you isolate and diagnose problems by enabling you to identify events
associated with a selectedmonitor or monitor group, or amonitor associated with a selected event, and to drill
down and perform troubleshooting. For details, see "Multi-View" on page 936 and "Event Console" on
page 914.

Example:Ops View

To access
You can access Ops View in the Unified Console directly from aweb browser or from the SiteScope
Dashboard.

l To access the Unified Console from a browser, enter the URL in the format:

http://<server_name>:<port>/SiteScope/WebMain#/consolidatedview

l To access the Unified Console from the SiteScope Dashboard, select theMonitors context, click the

Dashboard tab, and then click theUnified Console button. Ops View opens by default.
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Chapter 99: Manage View
TheManage view in the Unified Console provides self-servicemonitoring to non-admin users, and reduces
the amount of monitoring support required from the SiteScope administrator or monitoring team.

After being granted the necessary permissions by the SiteScope administrator, the application owner can
perform common administration actions such as deploy templates, updatemonitor configurations, update
custom properties for specific monitors, runmonitors, view associated alerts, and enable or disable monitors,
groups, and alerts.

Example:Manage view in the Unified Console

Note: The current version of themanagement part of theWeb user interface provides basic flows for self-
servicemonitoring. It does not include all capabilities currently available in the SiteScope Dashboard.

You cannot edit custom properties for all the available monitors. For details, see list of monitors whose
custom properties can be updated.

To access
TheManage view is available in the Unified Console. You can access the Unified Console directly from a
browser or from the SiteScope Dashboard.

l To access theManage view directly, open aWeb browser, and enter the following URL:

http://<SiteScope server>:<port>/SiteScope/WebMain#/manage/monitors

l To access the Unified Console from the SiteScope Dashboard, select theMonitors context, click the
Dashboard tab, and then click theUnified Console button. When the Unified Console opens, click
Manage .
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Learn About
This section includes:

l "Manage View Overview" below
l "Self-ServiceMonitoring - Use-Case Scenario" on the next page
l "Supported Browsers and Screen Resolutions" on the next page
l "Update Custom Properties of Monitors " on page 958

Manage View Overview
You can perform the following actions in theManage view of the Unified Console:

l Create a new remote server, edit a remote server, and delete a remote server.
l Create a new Memory monitor , Pingmonitor, or a CPU monitor.
l Create a new group.
l Deploy a group of monitors from an existing template (either directly from the user interface, or from an
external CommaSeparated Value (CSV) file).

l View and edit configuration properties for existingmonitors and groups.
l View and edit custom properties of monitors. See the list of monitors for which you can edit custom
properties.

l View the status and summary for groups andmonitors, including details of alerts that have been
configured on these groups andmonitors.

l Run amonitor or group of monitors.
l Disable and enable groups andmonitors.
l Disable and enable the triggeringmechanism for alerts associated with the group or monitor.
Benefits of usingManage view include:

l It provides self-servicemonitoring to non-admin users (after being granted the necessary permissions),
and reduces the amount of monitoring support required from the SiteScope administrator or monitoring
team. For details, see "Self-ServiceMonitoring - Use-Case Scenario" on the next page.

l A modern and intuitive Java-free interface that provides improved usability and new look and feel (uses
HTML5).

l Mobility. Supports iPad and Android tablets, and themost commonly used browsers including Chrome and
Safari. For the list of supported browsers, see "Supported Browsers and Screen Resolutions" on the next
page.

l Faster response time than the SiteScope Dashboard.
l It is fully supported on big and small screens, making it is ideal for viewingmonitor data in a network
operations center.

l To assist in troubleshooting, you can copy the link for a selected group or monitor (from the browser), and
send it to other users, enabling them to open the same location in themonitors tree fromManage view.

l Improved navigation. You can navigate back and forward in the browsing history of themonitor tree using
the Back and Forward browser buttons.
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Self-Service Monitoring - Use-Case Scenario
Self-servicemonitoring enables the SiteScope administrator or monitoring team to delegatemonitor creation
andmaintenance tasks to the application owner, and thereby reduce themonitoring support they need to
provide.

Let’s take a look at a couple of different scenarios.

Note: Both these scenarios presume that the SiteScope administrator has assigned the application
owner the necessary permissions he/she needs for accessing the groups and templates related to the
applications for which he/she is responsible (the administrator grants these permissions in User
Management Preferences).

Scenario 1 - Application Owner Wants to Modify Groups/Monitors under Their Application
Ownership

Peter, an application owner, receives a new critical event on his application. After investigating the issue,
Peter determines that the event was triggered unnecessarily, and that themonitor threshold should be
changed to avoid further false alerts.

Instead of opening a ticket for the SiteScope administrator to change the threshold settings (whichmight take
a while and does not require any additional expertise), Peter makes the necessary changes to themonitor
threshold settings (for which he was granted permissions).

Peter is able to resolve the issue faster, and reduce the time and effort required from the SiteScope
administrator.

Scenario 2 - Application Owner Wants to Create New Monitors from Templates Related to Their
Application Ownership

Susan needs to create a new set of monitors to track the availability and performance of a new application that
she owns.

Instead of opening a ticket for themonitoring team to create themonitors with the required settings, Susan
uses an existing template that has the required applicationmonitors already configured (for which she has
permissions), to deploy themonitors.

Supported Browsers and Screen Resolutions
Supported Browsers and Devices

The following browsers are supported:

l Google Chrome browsers (latest certified version): 48.0.2564.116m.
l Mozilla Firefox (latest certified version): 38 ESR
l Safari (latest certified version): 8.0 for Mac
l Internet Explorer 10, 11
The followingmobile devices are supported:

l iPad 3 with Safari (iOS 8with latest updates)
l Android tablet with Chrome 34.0.1847 (or with any latest default browser of Android) Full HD display
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Default Screen Resolution

l Large Desktop – 1680 x 1050 pixels
l Laptop – 1280 x 800 pixels
l iPad – 1024 x 768 pixels

Update Custom Properties of Monitors
With this version of SiteScope, you can update custom properties only for the followingmonitors:

l AmazonWeb Services Monitor
l AzureMonitor
l CPU Monitor
l Dynamic Docker Monitor
l JMX Monitor
l Log File Monitor
l Memory Monitor
l PingMonitor
l REST API Monitor
l Script Monitor
l ServiceMonitor
l URL Monitor
l URLContent Monitor
l URL List Monitor
l URLSequenceMonitor
l UNIX Resources Monitor
l VMware DatastoreMonitor
l VMware Host Monitors
l VMware PerformanceMonitor
l Windows Resources Monitor

Tasks
This section includes:

l "How to Assign Group and Template Permissions to Application Owners (SiteScope Administrator)"
below

l "How to Deploy Monitors from a Template (Application Owner)" on the next page
l "How to Edit Monitor Configurations to Prevent Unnecessary Alerts (Application Owner)" on page 960
l "How to Perform Actions onMultiple Monitors (Administrator/Application Owner)" on page 961

How to Assign Group and Template Permissions to Application Owners
(SiteScope Administrator)
Define users and user roles, and assign the required permissions for application owners.
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1. InPreferences > User Management Preferences, create users and user roles for the different
application owners. For details on user permissions, see "User Management Preferences" on page 625.

2. Assign permissions for accessing groups and templates to each application owner as required. By
default, a user has permissions to access all groups and templates.
l InPreferences > User Management Preferences > <application_owner_user> > Main Settings
> Allowed groups, add the groups that can be viewed andmodified by the application owner.

l InPreferences > User Management Preferences > <application_owner_user> > Main Settings
> Allowed template containers, add the template containers that can be used by the application
owner for creating new monitors.
For details on assigning allowed groups and template container permissions, see "Main Settings" on
page 634.

How to Deploy Monitors from a Template (Application Owner)
1. Permissions

To deploy monitors using templates, youmust have:
l The ability to view andmodify groups of monitors under your application ownership. The SiteScope
administrator determines the groups for which you have permissions in theAllowed groups list (in
Preferences > User Management Preferences > New/Edit User Profile > Main Settings).

l The ability to create new monitors from templates related to your application ownership. The
SiteScope administrator determines the template containers for which you have permissions in the
Allowed template containers list (inPreferences > User Management Preferences > New/Edit
User Profile > Main Settings).

For details on user permissions, see "User Management Preferences" on page 625.
2. Deploy monitors directly from the user interface - optional

a. Determine where you want to deploy the template.
o To deploy a template to the SiteScope root or to an existing group, skip to the next step.
o To deploy the template to a new group, right-click the location where you want to create a group

(under an existing group or the SiteScope root), select Create > Group, and configure the group
properties. For details, see "Create New Group" on page 980.

b. Right-click the SiteScope root node or the group in which you want to deploy the template, and select
Deploy Template.

c. In the Select Template page of the Deploy Template wizard, select a template with the required
applicationmonitors, and then click Next.

d. If the template requires that you specify a target remote server (when the SERVER_LIST system
variable is used), the Select Target Server page opens. Select the target host server or servers on
which to deploy the template, and then click Next.

e. If the template contains variables that need to be defined, the User-Defined Template Properties
page opens. Enter the required variable values to use to deploy the template, and then click Next.
For details on template variables, see "Template Variables" on page 673.

f. In the Template Deployment Summary page, preview the template configuration details. Click
Deploy to deploy the template.
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Tip: You can use thePrevious andNext buttons if you need tomake changes to the selected
template, server, or template properties.

g. A summary of the template deployment is displayed in the Deployment Results page. Click Exit to
close the wizard.

For wizard details, see "Deploy TemplateWizard" on page 984.
3. Deploy monitors using an external CommaSeparated Value (CSV) file - optional

a. Determine where you want to deploy the template.
o To deploy a template to the SiteScope root or to an existing group, skip to the next step.
o To deploy the template to a new group, right-click the location where you want to create a group

(under an existing group or the SiteScope root), select Create > Group, and configure the group
properties. For details, see "Create New Group" on page 980.

b. Right-click the SiteScope root node or the group in which you want to deploy the template, and select
Deploy Template.

c. In the select Template page of the Deploy Template wizard, select theUse CSV file check box, and
configure the required settings:
o Click theBrowse orChoose File button (depending on the browser) to select the CSV file to use

for template deployment. (This button is only displayed after you select the CSV option.)
o Encoding. Select the encoding for the remote server, if the remote server is running an operating

system version that uses a different character encoding than the server on which SiteScope is
running (the default is windows-1252).

o Verify monitor properties with Remote Servers. This option verifies the correctness of the
monitor configuration properties against the remote servers on which the changes are beingmade
(selected by default). When this option is selected, it takes more time tomake changes due to
the remote connections.

d. Click theDeploy button to deploy the template (this button is inactive until a CSV file is selected).
e. A summary of the template deployment is displayed in the Deployment Results page.

You can click the link to check the log file (silent_deployment.log) for a summary of the
deployment. For log file details, see "Log Files Page" on page 1018.
Click Exit to close the wizard. For wizard details, see "Deploy TemplateWizard" on page 984.

For details on deploying a template using a CSV file, see "Deploy a Template Using a CSV File" on
page 721 and "How to Deploy Templates Using a CSV File" on page 723.

How to Edit Monitor Configurations to Prevent Unnecessary Alerts (Application
Owner)
1. Prerequisites

For an application owner to be able to access groups and templates, the SiteScope administrator must
assign the application owner the required permissions (see "How to Assign Group and Template
Permissions to Application Owners (SiteScope Administrator)" on page 958. By default, a user has
permissions to access all groups and templates.

Note: Actions in the context menu for which a user does not have permissions grayed out
(unavailable).
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2. Investigate the event
When an alert is triggered on an application, the application owner receives a new event. Determine
whether the application is working correctly (event are sometimes unnecessarily triggered due to
incorrect threshold settings).
a. In Multi-View, select the group or monitor for which an event was sent, and click Drill Down to

Group/Monitor Properties. A new browser opens displaying the properties for the selected group or
monitor in Manage view.

b. Right-click the group or monitor and select Enable/Disable > Disable Alert Triggering to prevent
additional notifications being triggered.

c. Check the group or monitor status and summary.
o You can view the status of the group or monitor run, which is represented by an icon (Good,

Warning, Error, Disabled or No Data) in the status tree. Check theMonitor Status Details panel
for the specific metrics in error. For details, see "Group Properties" on page 969 or "Monitor
Properties" on page 973.

Tip: To assist in troubleshooting, you can copy the link for a selected group or monitor (from
the browser), and send it to other users, enabling them to open the same location in the
monitors tree fromManage view.

o If necessary, you can also disable a group or monitor by selectingEnable/Disable > Disable
Group/Monitor to prevent additional events being triggered. The icon group or monitor icon

changes to or to indicate that the group or monitor is inactive. Disabling a group or
monitor also disables all alerts associated with the group or monitor.

3. Adjust themonitor configuration settings.
If you determine that the event was triggered unnecessarily as a result of incorrect thresholds settings,
you can adjust themonitor thresholds to avoid further false alerts.
a. Make the necessary changes to the Threshold Settings. For details, see "Monitor Properties" on

page 973.
b. Click Save to save your changes (before navigating away from the page).

4. Re-run themonitor to check the new status.
a. Right-click themonitor, and select Run to re-run themonitor and check if the problem still exists.
b. After themonitor run has finished, check the run status and details in theMonitor Status Details

panel. For details, "Monitor Properties" on page 973.
5. Enable the alert triggeringmechanism.

a. Right-click the group or monitor and select Enable/Disable > Enable Alert Triggering to enable
the triggeringmechanism for alerts associated with themonitor.

b. Check that no additional unnecessary alerts are triggered.

Tip: You can also perform actions (runmonitors, enable/disable monitors, enable/disable alert triggering)
onmultiple monitors in themonitor tree. For details, see "How to Perform Actions onMultiple Monitors
(Administrator/Application Owner)" below.

How to Perform Actions on Multiple Monitors (Administrator/Application Owner)
You can perform actions (runmonitors, enable/disable monitors, enable/disable alert triggering) onmultiple
monitors in themonitor tree. To do so, you need to select the requiredmonitors, and add them to the Selected
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Monitors list.

1. Place the cursor over a group or monitor icon. The icon for that object swivels and is displayed as

or .

2. Click the group or monitor icon to select it. The group or monitor is displayed as selected ( or

) and all the other groups andmonitors are shown as selectable ( or ). The SelectedMonitors

icon is displayed to the right of the Filter by name box when one or moremonitors, or groups
containingmonitors, have been selected.

3. Repeat the above steps to add other monitors as required.

4. Click the SelectedMonitors icon to open the SelectedMonitors list. This list displays all monitors
that have been selected in the tree. The number of monitors in the SelectedMonitors list is shown in the
orange circle.

5. To perform an action on the selectedmonitors, right-click in the SelectedMonitors list, and select an
action (Run All Monitors, Enable/Disable All Monitors, Enable/Disable Alert Triggering).
The action is performed on the selectedmonitors and the list closes.

6. To remove amonitor from the SelectedMonitors list, click the icon. To remove all selectedmonitors,
click theClear button.

Tips/Troubleshooting
Unified Console Limitations and Troubleshooting
l Unified Console should not be used in SiteScope for Load Testing installations.
l Themaximum number of Unified Consoles that can be open simultaneously is 20.
l If SiteScope is restarted while Unified Console and SiteScope windows are open, you are unable to login
back into SiteScope after the restart if you refreshed Unified Console before SiteScope (session is
invalidated and could not be restored after timeout j_security_check).
Workaround:Close all open SiteScope and Unified Console windows, and then reopen SiteScope and
Unified Console.

Manage View User Interface
Use theManage view in the Unified Console to see SiteScope group andmonitor properties, and to perform
common administration actions.
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To access l To access theManage view directly, open aWeb browser, and enter the following URL:

http://<SiteScope server>:<port>/SiteScope/WebMain#/manage/monitors

l From the SiteScope Dashboard, select theMonitors context, click theDashboard tab,
and then click theUnified Console button. When the Unified Console opens, click
Manage .

Important
information

To perform actions, youmust be an administrator in SiteScope, or a user granted the
necessary permissions. For details on user permissions, see "Permissions" on page 636.

Relevant
tasks

l "How to Deploy Monitors from a Template (Application Owner)" on page 959
l "How to Edit Monitor Configurations to Prevent Unnecessary Alerts (Application Owner)"
on page 960

l "How to Perform Actions onMultiple Monitors (Administrator/Application Owner)" on
page 961

See also "Manage View" on page 955

User interface elements are described below (unlabeled elements are shown in angle brackets):

Tree Objects

UI Element Description

SiteScope root. Represents the SiteScope server and reports the status
based on the worst child rule (taking the worst status of all monitors in the
SiteScope instance).

Note: The status icon is not displayed if all monitor groups have been
disabled.

Group. Represents a SiteScope group or subgroup with enabledmonitors
reporting Good, Warning, or Error status.

Represents a SiteScope group or subgroup with no enabledmonitors.

Represents a SiteScope group or subgroup with nomonitors.

Represents a group on which an associated alert has been
configured.

Health. Represents the status of monitors that display information about
the performance and availability of SiteScope itself.
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UI Element Description

Monitor. Represents a SiteScopemonitor reporting Good, Warning, or
Error status.

Represents amonitor that has no data or that has been disabled.

Represents amonitor on which an associated alert has been
configured.

Select Multiple Groups/Monitors. Enables performing actions onmultiple
groups and/or monitors (such as running, enabling or disabling groups or
monitors, or alert triggering). Tomake groups and/or monitors selectable,
place the cursor over a group or monitor icon (the icon swivels), and select
the group or monitor.

A blue check mark is displayed, and all the other displayed groups and/or
monitors become selectable.

Tree Filter

UI Element Description

Filter. Enables filtering the display to show only the groups and/or
monitors that meet the criteria you define. After making a selection,

the filter icon changes to green ( ).

l Filter by name. Type a string by which you want to filter objects
appearing in the SiteScope root or a selected group. The filter runs
automatically after a letter is entered in the box, and displays all
matching results in the selected entity. Delete the string to clear
the filter, and show all groups and/or monitors in the selected
entity.
Note:
l The filter is case insensitive.

l Wildcards and boolean operators are not supported.

l All. Selects all the listed groups andmonitors.
l None. Clears all the selected groups andmonitors.
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UI Element Description

Selected Monitors. Enables you to perform an action (runmonitors,
enable/disable monitors, enable/disable alert triggering) onmultiple
monitors in themonitor tree. The SelectedMonitors icon is displayed
to the right of the Filter by name box when one or moremonitors, or

groups containingmonitors, have been selected (indicated by

). To perform an action, right-click in the list, and select the
action.

Click the SelectedMonitors icon to open the SelectedMonitors list.
This list displays all monitors that have been selected in the tree. The
number of monitors in the SelectedMonitors list is shown in the
orange circle.

The Select Monitors list displays the status of each selectedmonitor (

, , , ). To display monitor properties for a specific
monitor, click themonitor in the list. "Monitor Properties" on page 973
are displayed in the right pane.

To remove amonitor from the SelectedMonitors list, click the
icon. To remove all selectedmonitors, click theClear button.

Object Type Select the object types by which you want to filter the objects
appearing in the tree:

Status Select the status criteria by which you want to filter SiteScope groups
andmonitors:
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UI Element Description

Monitor Types Select themonitor types by which you want to filter in the tree. Only
monitor types configured on the SiteScope server are displayed in the
list.

You can filter the list of monitor types by typing a string in the Filter
list box. The filter runs automatically after a letter is entered in the
box, and displays all matching results. Select themonitor types by
which you want to filter (a check mark is displayed next to the each
selectedmonitor type). To refresh the filter and show themonitor
types list, delete the search string or click the x button.

Note: The Filter list box is only displayed if there aremore than 8
monitor types.

Clear Filter Clears the filter selection and shows all groups and/or monitors in the
selected entity. After clearing the filter, the filter icon is displayed in
gray.
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Manage View Context Menu

UI Element Description

Deploy Template Opens the Deploy Template wizard which enables you to deploy a group of
monitors from an existing user-defined template. This action is available on
the group entity only.

For details on the wizard, see "Deploy TemplateWizard" on page 984.

Note: This option is not available for a user that does not have the allowed
template permissions.

Create > Group Enables you to create a new group into which you can deploy template
monitors. This action is available on the group and SiteScope root entity
only.

Note: This option is not available when the logged-in user does not have
permissions to perform this action.

Run Runs themonitor or all monitors configured in the group. The run results
(status icon and run summary) are shown in "Monitor Properties" on
page 973 and "Group Properties" on page 969.

Note: This option is not available when the logged-in user does not have
permissions to perform this action.
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UI Element Description

Enable / Disable Monitor/Group. Enables or disables themonitor or all monitors in the
group, regardless of the setting in themonitor properties.

l If themonitor or group is enabled, theDisable Monitor/Group option is
displayed. Click to disable themonitor or monitors in the group. The icon
representing themonitor or group (and all monitors in the group) changes

to or respectively to indicate that themonitor or group is
inactive. Disabling amonitor or group also disables all alerts associated
with themonitor or group.

l If themonitor or group is disabled, theEnable Monitor/Group option is
displayed. Click to enable themonitor or group. The icon representing
themonitor or group (and all monitors in the group) changes to reflect the
status of the respectivemonitor or group.

For details on changingmonitor state, see "Enable/Disable Monitors in
Group Dialog Box" on page 903.

Note: These options are not available when the logged-in user does not
have permissions to perform the particular action.

Alert Triggering. Enables or disables the triggeringmechanism for alerts
associated with a group (all monitors in the group) or amonitor, regardless
of the setting in themonitor properties. You can disable the alert triggering
to prevent additional notifications being sent. To enable or disable alert
triggering, right-click amonitor or group, and select Enable/Disable Alert
Triggering.

If themonitor is enabled, only theDisable Monitor option is displayed (and
vice versa when themonitor is disabled). When selecting a group, both
Enable Alert Triggering andDisable Alert Triggering are displayed.

Note:

l These options are not available at the SiteScope root level or when the
logged-in user does not have permissions to perform the particular
action.

l Both options are not available at the SiteScope root level or when the
logged-in user does not have permissions to perform the particular
action.

l The alert triggering options are equivalent to the Enable/Disable
Associated Alerts options (under monitor properties) in the SiteScope
Dashboard. For details, see "Enable/Disable Associated Alerts" on
page 265.
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SiteScope Root Properties
Group Status Details

UI Element Description

The status of themonitors in the SiteScope root (Good, Warning, Error,
Disabled or No data). The SiteScope root status is based on the worst child
(taking the worst status of all SiteScopemonitors within the SiteScope
node).

Status details are updated when you run a group, or when you refresh the
tree (by default, the status is refreshed each 5 seconds).

Last Run The date and time of the last monitor run.

Summary Displays the number of monitors within the SiteScope node and the number
of monitors, if any, that are reporting an error status.

Alerts

Displays information about all global alerts associated with the SiteScope node. The fields in this panel are
not-editable.

UI Element Description

Name The name by which the alert is known in SiteScope.

Status The status of the alert (Enabled or Disabled).

Description A description of the alert (if one was provided).

Actions The alert action type and the name given to the alert action in the "Action Type Dialog
Box" on page 1099.

Notification
Path

Path of the SiteScope node.

Group Properties
Group Status Details

UI Element Description

The status of themonitors in the group (Good, Warning, Error, Disabled or
No data). The group status is based on the worst child (taking the worst
status of all SiteScopemonitors in the group).

Last Run The date and time of the last monitor run.
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UI Element Description

Summary Displays the number of monitors within the group and the number of
monitors, if any, that are reporting an error status.

General Settings

UI Element Description

Group
Name

Name that describes the content of the group, or the purpose of themonitors added to the
group. For example, <host_name> or <business_unitresource_name> or <resource_
type>.

Note:

l The group name cannot contain any of the following characters: ` ; " & | < > / \ + =
l The group name is case sensitive. This means that you can havemore than one group
with the same name provided they each have a different case structure.

Group
Description

Description of the group. This can include themost commonHTML tags for text styling,
such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed only when
viewing or editing the group's properties in the SiteScope Dashboard. For details on adding a
hyperlink, see "Add URL links to group descriptions - optional" on page 214.

Note:

l This field does not support JavaScript/iframes/frames or other advanced features. HTML
code entered in this box is checked for validity and security, and corrective action is
taken to fix the code (for example, code is truncated if it spans more than one line). If
malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:
l Tags: script, object, param, frame, iframe.

l Any tag that contains an attribute starting with on is declined. For example, onhover.

l Any attribute with javascript as its value.

l If the field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.

Source
Template

Displays the path of the source template if the group was created from a template.

If you are using deployed templates created in older versions of SiteScope, click the
Browse button, andmanually associate the root groups with the source template by
navigating to the source template.

Click the icon to remove the source template associated with the root group.
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Dependencies

UI Element Description

Depends On Themonitor on which you want to make the running of this monitor group dependent. For
concept details, see "Monitoring Group Dependencies" on page 221.

Click theBrowse button to open the Select Depends OnMonitor dialog box, and select the
monitor on which you want to create a dependency. For user interface details, see "Select
Depends OnMonitor Dialog Box" on page 270.

Click the icon to remove the selectedDepends On monitor.

Default: No dependency is set for amonitor group.

Dependency
Condition

TheDependency Condition that theDepends Onmonitor should have for the current
monitor group to run normally. If the selected condition is not satisfied then themonitor
selected in theDepends On box is automatically disabled. The conditions are:

l

l

l

Alert Settings

Note: This panel is displayed only if the group has associated alerts.

Displays information about the alerts associated with the selectedmonitor or group. The fields in this panel
are not-editable.

UI Element Description

Name The name by which the alert is known in SiteScope.

Status The status of the alert (enabled or disabled).

Description A description of the alert (if one was provided).

Actions The alert action type and the name given to the alert action in the "Action Type Dialog
Box" on page 1099.

Notification
Path

Path of the group or monitor associated with the alert.

Search/Filter Tags

Displays the tag names and tag values, if tags have already been created. Select the tags or tag values that
you want to assign to the group. If no tags are created, this section appears but is empty.

To choose all tag values under a tag name, click the tag name. To choose individual values under a tag,
expand the arrow next to the tag name and click the tag value . See the following table for the UI elements and
their descriptions.
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User interface elements are described below:

UI Element Description

Indicates all values in the
tag are selected for the
group.

Indicates the value is
selected for the group.

Opens the Add Tag dialog
box, enabling you to add
new keyword tags.

Tag Name The name of the
search/filter tag.

Maximum length: 255
characters

Tag Description Description of the
search/filter tag.

Click to add a new value to
the tag.

Value Name Name for the value to be
included in the tag. Each
tagmust include at least
one value. Each value
appears as a child object of
the tag namewhen defining
or editing tag settings for all
objects in the group.

Value Description Description for each value.
This description appears
only when editing the tag.

Click to remove a value.
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Monitor Properties
Monitor Status Details

UI Element Description

The status of themonitor (Good, Warning, Error, Disabled or No data).

Last Run The date and time of the last monitor run.

Alert Triggering The status of the triggeringmechanism for alerts associated with the
monitor:

Summary Displays themost recent measurement results reported by themonitor.
This may includemore than onemeasurement, depending on themonitor
type. Click Show All to display all themeasurements if there is insufficient
space.

If a monitor is in error status, a description of the error is displayed. If a
monitor has been disabled, it displays the disabled status (disabled
manually, disabled until x time, or disabled by <Downtime Name> from
BSM).

Status details are updated when you run amonitor, or when you refresh the
tree (by default, the status is refreshed each 5 seconds).

General Settings

UI Element Description

Name Name that describes the element or system beingmonitored. Use a useful naming
convention for all monitors to make creating view filters and category assignments more
effective.

Example:<hostname:resource_type> or <business_unit  resource_name monitored_
element>

Note: Themonitor name cannot be left blank, or contain any of the following characters: ` " <
>
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UI Element Description

Monitor
Description

Additional information to describe amonitor. This can include themost commonHTML tags
for text styling, such as <BR>, <HR>, and <B>. The description is displayed only when
viewing or editing themonitor's properties in the SiteScope Dashboard.

You can also include HTML tags to enable you to access URLs from the SiteScope
Dashboard. To add a hyperlink, enter the URL (UNC path is supported forWindows
remotes). For example, <a href="http://www.hp.com">My Link</a>. The URL is
displayed in theDescription field for the selectedmonitor in the SiteScope Dashboard.

Note: This field does not support JavaScript/iframes/frames or other advanced features.

Report
Description

Optional description for this monitor to make it easier to understand what themonitor does.
This description is displayed on each bar chart and graph inManagement Reports.

Example: Network traffic or main server response time.

Custom Properties

Custom properties can be updated fromManage View only for the followingmonitors:

l CPU Monitor
l Dynamic Docker Monitor
l Dynamic JMX Monitor
l JMX Monitor
l Log File Monitor
l Memory Monitor
l PingMonitor
l REST API Monitor
l Script Monitor
l ServiceMonitor
l UNIX Resources Monitor
l URLMonitor
l URL Content Monitor
l URL List Monitor
l URL SequenceMonitor
l VMware DatastoreMonitor
l VMware Host Monitor
l VMware PerformanceMonitor
l Windows Resources Monitor
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Monitor Run Settings

UI Element Description

Monitoring
Frequency

How often SiteScope attempts to run the action defined for themonitor instance. Each
monitor run updates the status of themonitor. Use the drop-down list to specify
increments of seconds, minutes, hours, or days.

Minimum value: 15 seconds

Frequency If
Error

Monitoring interval for monitors that have reported an error condition.

Example:Youmay want to run themonitor every 10minutes normally, but as often as
every 2minutes if an error has been detected. When themonitor's status is no longer in
error, themonitor reverts to the run interval specified in theMonitoring Frequency
setting.

Default value: empty

Note:

l Increasing themonitor run frequency affects the number of alerts generated by the
monitor.

l When configuring this setting in a template, the variable value can only be in time
units of seconds.

Monitor
schedule

Range schedule if you want themonitor to run only on certain days or on a fixed
schedule. The range schedules created inSchedule Preferences appear in the drop-
down list. For more information about creatingmonitor schedules, see "Schedule
Preferences" on page 608.

Default value: Every day, all day

Note: If you select a threshold schedule in the Threshold Settings, at least one threshold
schedulemust coincide with themonitor run schedule (at least oneminute of themonitor
run schedulemust be covered by one of the threshold schedules).

Dependencies

UI Element Description

Depends On Click Browse to open the Select Dependency dialog box, and select themonitor on which
you want to make the running of this monitor dependent. Use this option to prevent
redundant alerting frommultiple monitors that aremonitoring different aspects of a single
system.

Example:Create a systemmonitor to check the basic availability of a system and then
create other monitors that perform more detailed tests of that system. Set the detailed test
monitors to be dependent on the status of themonitor checking basic availability.

If the systemmonitor detects that the target system has become unavailable, the
dependency relationship automatically disables the other monitors. This also disables any
alerts that would have been generated by the dependent monitors.
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UI Element Description

Dependency
Condition

If youmake this monitor dependent on the status of another monitor (by using theDepends
On setting), use this option to select the status condition of theDepends Onmonitor for
the current monitor to run normally.

The status categories are:

l

l

l

l

Themonitor being configured is run normally as long as themonitor selected in the
Depends On box reports the condition selected in this box.

Example:Select and this monitor is enabled only when themonitor selected in
theDepends On box reports a status of Good. The current monitor is automatically
disabled if themonitor selected in theDepends On box reports a category or condition
other than Good. You can also enable dependent monitors specifically for when amonitor
detects an error.

Threshold Settings

UI Element Description

The default status is Monitor status if the threshold criteria for themonitor instance are not met. The
status categories are:

l

l

l
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UI Element Description

If Unavailable Status assignment for when themonitor is not available. Select from the
following options:

l Set monitor status according to Thresholds. Themonitor gets a new
status according to the thresholds.

l Set monitor status to Error. Themonitor's status is set to Errorwhen it is
unavailable without thresholds being checked.

l Set monitor status to Good. Themonitor's status is set to Goodwhen it is
unavailable without thresholds being checked.

l Set monitor status to Warning. Themonitor's status is set to Warning
when it is unavailable without thresholds being checked.

Note:A monitor instance can have a status of Unavailable as well as a status
of Good,Warning, or Error. Alerts are triggered according to availability,
status, or both availability and status, depending on how the alert is configured.
For details, see "Configure SiteScope Alerts" on page 1072.

On internal error Monitor status assignment if a configuration or internal error occurs:

l Set monitor status according to Thresholds. Themonitor's status is set
according to its current thresholds if a configuration or internal error occurs
(default setting). It is unreliable to rely on the threshold since there is no way
of knowing at what point the error occurred (and whether the threshold is
based on old data, updated data, or both). For example, amonitor may
remain in its current status even though themonitor did not run; change
status if thresholds were defined that were not applicable; or trigger false
alerts as if a remote was not available, when in fact, the remote was not
contacted.

l Set monitor status to Error. Themonitor's status is set to Error if a
configuration or internal error occurs without thresholds being checked.

l Set monitor status to Warning. Themonitor's status is set to Warning if a
configuration or internal error occurs without thresholds being checked.

l Set monitor status to Good. Themonitor's status is set to Good if a
configuration or internal error occurs without thresholds being checked.

l Treat monitor as unavailable. Themonitor is treated as being
Unavailable if a configuration or internal error occurs without thresholds
being checked.

Using SiteScope
Chapter 99: Manage View

HPE SiteScope (11.33) Page 977 of 1206



UI Element Description

Add Threshold Creates additional thresholds that determine themonitor status. Select the
status for which you want to add a threshold:

If you select Error,Warning, orGood, for each threshold, select themetric
and operator, and enter a value for themetric.

If you select Default, the default threshold settings are added to themonitor
instance, for the applicable status categories. You can edit any of the values for
the default thresholds.

Trigger
<Error/Warning/Good>
if

Conditions for themonitor instance to report anError,Warning, orGood
status. For each threshold, select themeasurement and operator, and enter a
value for themetric.

<Condition> Metrics parameter for determining the status of this monitor instance. The list of
metrics is dynamically updated based on the type of monitor you are
configuring.

Default value:Default metrics exist for many monitor types and differ
according tomonitor type. For many default metrics, there are corresponding
defaults for the operator and value boxes that are not editable.

<Operator> Metrics operator for determining the status of this monitor instance. The
following operators are available:

l (!=) not equal
l (<) less than
l (<=) equal or less than
l (=) equal
l (>) greater than
l (>=) equal or greater than
l contains - Contains the value entered
l does not contain - Does not contain the value entered
Note: To indicate data volatility (where current monitor readings significantly
deviate from previous runs), set status thresholds using a baseline. For details,
see "Set Monitor Thresholds Using a Baseline" on page 279.
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UI Element Description

<Value> Value applicable to themetrics parameter.

Note:

l If a monitor has an activated baseline, its metrics values are non-editable
and thePercentiles Table button is displayed. You can change baseline
threshold values by clicking the button and changing the current percentile
value from the Percentiles Table. For user interface details, see "Percentile
RangeMapping Table" on page 294.

l You cannot change themetrics value, operator or schedule for a baseline
threshold condition.

<Select Alert
Schedule>

Range schedule to determine the status of this monitor instance if you want to
define when to check themonitor run result against the threshold. This is useful,
for example, if you want to check themonitor run result against the threshold
only on certain days or during peak hours. The range schedules created in
Schedule Preferences appear in the drop-down list. For more information about
creatingmonitor schedules, see "Schedule Preferences" on page 608.

Note:When selecting threshold schedules, at least one threshold schedule
must coincide with theMonitor schedule in theMonitor Run Settings (at least
oneminute of themonitor run schedulemust be covered by one of the threshold
schedules).

Delete. Deletes the selected threshold.

Alert Settings

Note: This panel is displayed only if themonitor has associated alerts.

Displays information about the alerts associated with the selectedmonitor or group. The fields in this panel
are not-editable.

UI Element Description

Name The name by which the alert is known in SiteScope.

Status The status of the alert (enabled or disabled).

Description A description of the alert (if one was provided).

Actions The alert action type and the name given to the alert action in the "Action Type Dialog
Box" on page 1099.

Notification
Path

Path of the group or monitor associated with the alert.

Search/Filter Tags

Displays the tag names and tag values, if tags have already been created. Select the tags or tag values that
you want to assign to themonitor. If no tags are created, this section appears but is empty.
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To choose all tag values under a tag name, click the tag name. To choose individual values under a tag,
expand the arrow next to the tag name and click the tag value . See the following table for the UI elements and
their descriptions.

User interface elements are described below:

UI Element Description

Indicates all values in the
tag are selected for the
monitor.

Indicates the value is
selected for themonitor.

Opens the Add Tag dialog
box, enabling you to add
new keyword tags.

Tag Name The name of the
search/filter tag.

Maximum length: 255
characters

Tag Description Description of the
search/filter tag.

Click to add a new value to
the tag.

Value Name Name for the value to be
included in the tag. Each
tagmust include at least
one value. Each value
appears as a child object of
the tag namewhen defining
or editing tag settings for all
objects in themonitor tree.

Value Description Description for each value.
This description appears
only when editing the tag.

Click to remove a value.

Create New Group
The Create New Group dialog box enables you to create a new group into which you can deploy templates.
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To access In Manage view, right-click a group folder or the SiteScope root and select Create >
Group.

Relevant
tasks

"How to Deploy Monitors from a Template (Application Owner)" on page 959

See also "Manage View" on page 955

General Settings

UI Element Description

Group
name

Name that describes the content of the group, or the purpose of themonitors added to the
group. For example, <host_name> or <business_unitresource_name> or <resource_
type>.

Note:

l The group name cannot contain any of the following characters: ` ; "& | < > / \ + =
l The group name is case sensitive. This means that you can havemore than one group
with the same name provided they each have a different case structure.

Group
Description

Description of the group. This can include themost commonHTML tags for text styling,
such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed only when
viewing or editing the group's properties in the SiteScope Dashboard. For details on adding a
hyperlink, see "Add URL links to group descriptions - optional" on page 214.

Note:

l This field does not support JavaScript/iframes/frames or other advanced features. HTML
code entered in this box is checked for validity and security, and corrective action is
taken to fix the code (for example, code is truncated if it spans more than one line). If
malicious HTML code or JavaScript is detected, the entire field is rejected. The following
is prohibited HTML content:
l Tags: script, object, param, frame, iframe.

l Any tag that contains an attribute starting with on is declined. For example, onhover.

l Any attribute with javascript as its value.

l If the field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.

Source
Template

Displays the path of the source template if the group was created from a template.

If you are using deployed templates created in older versions of SiteScope, click the
Browse button, andmanually associate the root groups with the source template by
navigating to the source template.

Click the icon to remove the source template associated with the root group.
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Dependencies

UI Element Description

Depends On Themonitor on which you want to make the running of this monitor group dependent. For
concept details, see "Monitoring Group Dependencies" on page 221.

Click theBrowse button to open the Select Dependency dialog box, and select themonitor
on which you want to create a dependency. For user interface details, see "Select Depends
OnMonitor Dialog Box" on page 270.

Click the icon to remove the selectedDepends On monitor.

Default: No dependency is set for amonitor group.

Dependency
Condition

TheDependency Condition that theDepends Onmonitor should have for the current
monitor group to run normally. If the selected condition is not satisfied then themonitor
selected in theDepends On box is automatically disabled. The conditions are:

l

l

l

Search/Filter Tags

Select tags to apply to the group. You can select an individual tag or click to select all tags under a group.

Create NewMonitor
The Create New Monitor dialog box enables you to create any of the following new monitor –Memory, Ping or
CPU monitor.

To access In Manage view, click Monitors and then right-click a group folder or the SiteScope root and
select Create > Monitor.

Relevant
tasks

"How to Deploy Monitors from a Template (Application Owner)" on page 959

See also "Manage View" on page 955

Create a NewMonitor
1. Select from the list of monitors or type a string to search for themonitor. The Create New monitor wizard

is displayed.
2. Configure themonitor properties as required. For details, see the following UI descriptions:

l CPU Monitor Settings

l Memory Monitor Settings
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l PingMonitor Settings

3. Configure the commonmonitor settings as required. For details, see the following descriptions.
l "General Settings" on page 244

l "Monitor Run Settings" on page 245

l "Dependencies" on page 247

l "CalculatedMetrics Settings" on page 311

l "Threshold Settings" on page 248

l "Enable/Disable Monitor" on page 264

l "Enable/Disable Associated Alerts" on page 265

l "Search/Filter Tags" on page 266

l "Baseline Settings" on page 267

l "Logging Settings" on page 268

4. Save themonitor.

Create New Remote Server
The Remote Server tab enables you to add a new remote server, delete a remote server and edit the settings
of a remote. The Create New Remote Server dialog box enables you to create a new Windows or Unix remote
server.

To access From the Unified Console, click Manage > Remote Servers.

Relevant tasks "Configure SiteScope toMonitor RemoteWindows Servers" on page 402

"Configure SiteScope toMonitor Remote UNIX Servers" on page 420

See also "Configure theWMI Service for RemoteWindows Monitoring" on page 417

"Extend UNIX Monitoring Using Operating System Adapters" on page 428

"Enable SiteScope to Prefer IP Version 6 Addresses" on page 434

"Configure RemoteMonitoring Using Secure Shell (SSH)" on page 439

User Interface

Filter. Enables filtering the display to show only the
remote servers that meet the criteria you define. After

making a selection, the filter icon changes to green (
).
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Indicates aWindows remote server.

Indicates a Unix remote server.

Click to add a new remote server.

Tasks

How to Delete a Remote Server

You cannot delete a server from the list of remote servers if the server is referenced by amonitor. Right-click a
remote server and select Delete Remote Server. Click Remove to confirm the deletion in the Delete Server
box.

How to Edit a Remote Server

Click Manage > Remote Servers to view the properties page of the remote server. Make changes to the
remote server settings as required. Click Save to save the changes orSave & Test to save the changes and
test the remote server connection.

Deploy Template Wizard
This wizard enables you to create a group of monitors from an existing user-defined template.

To access In Manage view, right-click a group folder and select Deploy Template.

Important
information

To perform actions in the wizard, youmust be an administrator in SiteScope, or a user
granted the necessary permissions. For details on user permissions, see "Permissions" on
page 636.

Relevant
tasks

"How to Deploy Monitors from a Template (Application Owner)" on page 959

See also "Manage View" on page 955
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Select Template Page

UI
Element Description

<User-
defined
templates>

Select a template to use for deployingmonitors. Only user-defined templates are listed.

Expand the template container , and select the template you want to deploy.

Get
domain
servers
with
remote
servers

Select this check box to list remote servers within the domain of SiteScope host.

Use CSV
file

Select this check box if you want to deploy the template from an external CommaSeparated
Value (CSV) file. The CSV file is used to deploy the variable values defined in the template.
For details on deploying a template using a CSV file, see "Deploy a Template Using a CSV
File" on page 721 and "How to Deploy Templates Using a CSV File" on page 723.

Click theBrowse button (which is only displayed after you select the CSV option), and
select the CSV file to use for template deployment. After selecting a CSV file to use for
template deployment, click theDeploy button to deploy the template.

If the deployment is successful, the template objects are added to themonitor tree. You can
check the silent_deployment.log file for a summary of the deployment. For user interface
details, see "Log Files Page" on page 1018.

Note:

l TheUse CSV file option is only displayed after you have selected a template.
l After you select the CSV option, theNext button is replaced by Deploy button (this
button is inactive until you select a CSV file).

Selected Templates for Setting

UI Element Description

<List of monitors from the
selected template>

Displays the list of monitors under the selected groups.

Select to set the values for the variables defined in the templates.
You can use the predefined values or add your own values.

Use to delete a selected template.
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User-Defined Template Properties Page

UI Element Description

<Template Properties> Displays the variables used in the template objects if the selected
template was defined using template variables. You can use the
predefined values or add your own values. Variable values that are
mandatory are indicated by a red asterisk (*). For details, see "Template
Variables" on page 673.

If the selected template was defined without using template variables,
the properties are automatically filled with the default values that were
defined in template.

Note: This page is displayed only when the template contains variables
that need to be defined.

Template Deployment Summary Page

UI Element Description

Variables Displays the variables used in the templates and their values.

Selected Templates for Setting

UI Element Description

<List of selected monitors
from the selected template>

Displays the selectedmonitors from the selected templates.

Silent deployment Select this option to deploy the template silently. The template
deployment request is submitted to a queue and the deployment is
handled in the background. This enables you to continue to use
SiteScope without having to wait for the template deployment process to
finish. All submitted requests and their corresponding deployment results
are logged to <SiteScope root directory>\logs\silent_
deployment.log.

Verify monitor properties
with Remote Servers

Verifies the correctness of themonitor configuration properties against
the remote servers on which the changes are beingmade.

Default value:Selected

Note:When this option is selected, it takes more time tomake changes
due to the remote connections.

Deployment Results Page

UI Element Description

Template Name Name of the deployed template.
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UI Element Description

Deployment Status Displays the deployment results.

Indicates the deployment was successful, and lists the number
of objects (groups, monitor, alerts, remotes) that were deployed.
When deploying a template using a CSV file, the results include
a link to the log file (silent_deployment.log) which displays a
summary of the deployment. For log file details, see "Log Files
Page" on page 1018.

Indicates the template deployment failed, and lists reasons for
the failure.

Problems Lists an error code and a description of the problem.

Groups / Monitors / Alerts /
Remotes Deployed

Lists the number of deployed objects (groups, monitors, alerts, remote
servers) and the deployment status (Deployed/Deployment Failure) for
each object.
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Part 12: SiteScope Server Health
SiteScope provides several key indicators that you can use tomonitor the performance of the SiteScope
application.

The SiteScope Server Health is a specially designed group of monitors that display information about the
performance and availability of SiteScope itself. Health monitors retrieve data about SiteScope's resource
usage, key processes, monitor load, server parameters, and the integrity of key configuration files. For
details, see "SiteScope Server Health Monitors" on page 989.

In addition, you can use the key performancemetrics provided in the SiteScope Server Statistics context for
analyzing performance, stability, health, and debugging bottlenecks on the SiteScope server. This shows load
on the SiteScope server, a list of running and recently runmonitors, perfex pool summary, WMI statistics,
SSH connections, Telnet connections, and dynamic monitoring statistics. It also displays the SiteScope log
files. For details, see "SiteScope Server Statistics" on page 1011.

You can also get an overview of SiteScope server load and performance statistics directly from the SiteScope
Health Map and Performance Statistics logs without having to open the SiteScope user interface. For details,
see "SiteScope Health Map and Performance Statistics Logs" on page 1068.



Chapter 100: SiteScope Server Health
Monitors
SiteScope Server Health is a specially designed group of monitors that display information about the
performance and availability of SiteScope itself. Health monitors retrieve data about SiteScope's resource
usage, key processes, monitor load, server parameters, and the integrity of key configuration files.

Tip: You can also get an overview of SiteScope server performance using the "SiteScope Server
Statistics" on page 1011 context or from the "SiteScope Health Map and Performance Statistics Logs" on
page 1068.

To access
Select theMonitors context. In themonitor tree, click theHealth container to view the collection of available
health monitors that are deployed.

Learn About
SiteScope Server Health Overview
By default, the daily monitor logs record the SiteScope Health monitoring data and let you can create reports
on SiteScope's performance and operational health. These log files are useful for understanding SiteScope
performance issues, for troubleshootingmonitor and alert problems, and for reviewing SiteScope
management actions. For example, SiteScope's audit log contains configuration changes performed in the
new user interface, such as creation of monitors, templates, alerts, and so forth.

Together with the SiteScope Health monitoring, the SiteScope Progress Report provides several key
indicators you use tomonitor the performance of the SiteScope application.

SiteScope Health Group
SiteScope Health monitors canmonitor several key aspects of its own environment to help uncover monitor
configuration problems as well as SiteScope server load. SiteScope can alsomonitor its connectivity and
related data events when connected to APM.

Similar to regular monitors, Health monitors can be edited to reconfigure their frequency and thresholds.
Administrators can enhance the Health group by adding new monitors targeting additional servers and
environments.

The Health monitor group is displayed as a health icon within themain SiteScope container. You view the
contents of the Health monitor group by clicking theHealth container.

SiteScope Health monitoring includes the followingmonitor types:
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Monitor
Type Description

BAC
Integration
Configuration

Checks the correctness of the configuration between SiteScope and BAC/APM when
SiteScope is configured as a data collector for BAC/APM. For details, see "BAC Integration
ConfigurationMonitor" on page 994.

BAC
Integration
Statistics

Checks the traffic volume between SiteScope and BAC/APM when SiteScope is
configured as a data collector for BAC/APM. For details, see "BAC Integration Statistics
Monitor" on page 996.

Connection
Statistics

Checks the status of SSH and Telnet connections when used to connect to remote UNIX
orWindows servers. Also checks Perfex and Perfex dispatcher statistics and statuses for
each perfex pool. For details, see "Connection Statistics Monitor" on page 997.

Dynamic
Monitoring
Statistics

Checks performance of the dynamic monitoring framework when you have dynamic
monitors defined. For details, see "Dynamic Monitoring Statistics Monitor" on page 999.

Health of
SiteScope
Server

Checks a large number of server process and resources for the server on which SiteScope
is running. For details, see "Health of SiteScope Server Monitor" on page 1001.

License
Usage

Checks the availability and usage of SiteScopeOS Instance, URL, and Transaction
licenses. For details, see "License UsageMonitor" on page 1004.

Log Event
Checker

Checks for certain events logged to the SiteScope error log. For details, see "Log Event
Checker Monitor" on page 1007.

Monitor Load
Checker

Checks for data about the number of monitors being run or waiting to run. For details, see
"Monitor Load Checker Monitor" on page 1009.

SSL
Certificates
State

Checks the state of SSL certificates in the default keystore. For details, see "SSL
Certificates StateMonitor" on page 1010.

Skipped Monitor Events
A SiteScopemonitor is reported as skipped if themonitor fails to complete its actions before it is scheduled to
run again. This can occur with monitors that have complex actions to perform, such as querying databases,
stepping throughmulti-page URL sequences, waiting for scripts to run, or waiting for an application that has
hung.

For example, assume you have a URL SequenceMonitor that is configured to transit a series of eight Web
pages. This sequence includes performing a search whichmay have a slow response time. Themonitor is set
to run once every 60 seconds. When the system is responding well, themonitor can run to completion in 45
seconds. However, at times, the search request takes longer and then it takes up to 90 seconds to complete
the transaction. In this case, themonitor has not completed before SiteScope is scheduled to run themonitor
again. SiteScope detects this andmakes a log event in theSiteScopeskip_monitor.log. The SiteScope Log
Event Monitor detects this and signals an error status. For log file details, see "Log Files Page" on page 1018.

A monitor may also skip if it is amonitor type that requires a process from the process pool but the process
pool limit has been reached. Generally, this is not likely to happen but may occur in some situations with high
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monitoring load. The SiteScope Health Log Event Monitor also watches for process pool events. Skipped
monitors can cause loss of data when amonitor run is suspended due because a previous run has not
completed or has become hung by a unresponsive application. They can also cause SiteScope to
automatically stop and restart itself, an event that is alsomonitored by the SiteScope Health Log Event
Monitor. A restart is done in an effort to clear problems and reset monitors. However, this can also lead to
gaps inmonitoring coverage and data. Adjusting the run frequency at which amonitor is set to run or
specifying an applicable timeout value can often correct the problem of skippingmonitors.

Note:

l You can enable a setting that automatically disables monitors that exceed themaximum allowed skip
count. If this occurs, SiteScope shuts downwith an error and sends an email to the SiteScope
administrator about the skippingmonitor to signal the disable event. To enable this setting: In the
preferences view, click Infrastructure Preferences, and expand theSkip Monitor Settings panel.
Select theShutdown on monitor skips check box. You can also determine the time period that a
monitor is disabled. For details on skippedmonitor settings, see "Infrastructure Preferences" on
page 517.

l You can control themaximum number of processes available. Only change this setting if adjustments
tomonitor configurations do not resolve themonitor performance problems. The initial value is 200
processes per pool (by default, themaximum processes per pool is 20). To change this setting: In the
preferences view, click Infrastructure Preferences, and expand theGeneral Settings panel.
Configure the number of processes in theMaximum processes per pool box.

For information on troubleshootingmonitor skipping, see "Tips/Troubleshooting" on page 993.

Tasks
How to Analyze SiteScope Health Monitor Data
This task describes the steps involved in analyzing SiteScope Health monitor data and viewing the SiteScope
log files and server statistics.

1. Prerequisites
To access the log files and the Progress Report, youmust have the correct user privileges.
a. In the left pane, click Preferences and select User Management Preferences.
b. Right-click the user name, and select Edit User.
c. In the Edit User Profile dialog box, expandPermissions.
d. In theOther section, make sure that View server statistics andView logs are selected (these

settings are selected by default).
2. Deploy SiteScope Health monitors

Note: The SiteScope health monitors are normally present, because they are enabled automatically
when SiteScope is deployed.

If the SiteScope Health monitors are not present when you import a SiteScope to System Availability
Management in APM, youmust deploy themonitors.
For task details, see "How to Deploy SiteScope Health Monitors" on the next page.

3. View SiteScope Health monitors
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You can view the data collected by the SiteScope Health monitors in the SiteScope Dashboard.
For the list of SiteScope Health monitors, see "SiteScope Health Group" on page 989.

Example:Health monitors in the SiteScope Dashboard

4. View SiteScope log files
You can view the various SiteScope log files in the Log Files page in the Server Statistics context.
For user interface details, see "Log Files Page" on page 1018.

Example: Log files in the Log Files tab

5. View monitor performance data
You can view the load on the SiteScope server and a list of themost recently runmonitors in the Server
Statistics context.
For concept details, see "SiteScope Server Statistics" on page 1011.

How to Deploy SiteScope Health Monitors
This task describes how to deploy SiteScope Health monitors to a SiteScope installation if themonitors were
not present when you imported a SiteScope to System Availability Management in APM.
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Note: This task is part of a higher-level task. For details, see "How to Analyze SiteScope Health Monitor
Data" on page 991.

1. Open the SiteScope container to which you want to display the Health monitors. Confirm that the
SiteScope includes the Health monitor group container.

Note: The Health monitor group container is identified with a health indicator icon.

2. Find theHealth Templates in themonitor tree. Click to expand the container contents. The available
Health monitor templates are displayed.

3. Select the Health monitor template for the operating system onwhich the SiteScope you want to monitor
is running. The choices are:
l UNIX Health Monitors

l Windows Health Monitors

4. Right-click the template icon and select Copy from the actionmenu.
5. Right-click theHealthmonitor group container of the SiteScope to which you want to deploy the Health

monitors and select Paste. Themonitors in the selected template are then configured and deployed to the
selected SiteScope server.

Tips/Troubleshooting
Troubleshooting Skipped Monitors
Problem:Monitors start skipping and there are a number of Waiting threads in the threads dump.

Possible Cause: This could be caused by the JVM being blocked by an infinite loop problem between the
JVM and libc when using the IPv6 getaddrinfo() libraries with IPv4 addresses. The default is to prefer the IPv6
stack.

Possible Solution:Configure the java processes to prefer the IPv4 stack by specifying the following JVM
argument:

-Djava.net.preferIPv4Stack=true

This starts themonitor script and restarts SiteScope.

SiteScope on Linux restarts whenever there are more than 10 processes in the
defunct state.
This issue was fixed by adding the _sisDefunctProcessNumber parameter to the <SiteScope
root>\groups\master.config file, which enables you to set the number of defunct processes.

Problems Reporting Data to BSM
SiteScope Health monitors are also configured to report events that indicate a problem with the transfer of
SiteScopemonitor and configuration data to a APM installation.

Notes and limitations on reporting data to APM:

l SiteScope reports numeric metric values only to APM. It does not report metrics containing string values.
l Unable to register SiteScope in an HPE SaaS environment if its APM SaaS user contains special
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characters, such as the@ sign. The APM user account should contain alphabetic and/or numeric
characters only.

l Due to the complexity of somemonitoring deployments and network communications, SiteScopemay be
temporarily unable to communicate with the APM server. SiteScope Health monitoring includes several
monitors for watching connectivity and data transfers to the APM server.
If SiteScope is unable to connect to the APM Server, SiteScope continues to record and storemonitor
data files locally. After the number of data files exceeds a specified threshold, SiteScope saves the data
files in a cache folder with the syntax <SiteScope root
directory>\cache\persistent\topaz\data<index>.old. It also saves the heartbeat samples to bus_
<index>.old and configuration samples to config_<index>.old. You can configure the number of
data.old folders to keep by modifying the _topazMaxOldDirs property in the <SiteScope root
directory>\groups\master.config file.

Note: By default, the threshold number of data files is set to 1,000 files. You can change this setting
by modifying the _topazMaxPersistenceDirSize property in themaster.config file.

After the connection between SiteScope and the Agent Server is restored, youmust manually copy
the files from these folders to the <SiteScope root directory>\cache\persistent\topaz\data folder.
We recommend that you only copy these files when the data folder is empty to avoid overloading the
system with large amounts of data to upload. When the number of data.old folders exceeds a
specified threshold, by default 10 folders, the oldest folders are deleted.

BAC Integration Configuration Monitor
Use the BAC Integration Configurationmonitor to track the correctness of SiteScope's integration with the
BAC/APM configuration. This monitor is useful for viewing the number of groups, monitors, and
measurements reporting to BAC/APM that have an invalid path, internal name, or ID. It also displays the
number of duplicate Topaz IDs, and instances where the Topaz ID is (-1).

Note: Monitor data is relevant only if SiteScope is integrated as a data collector for BAC/APM.

To access
Select theMonitors context. In themonitor tree, expandHealth and click BAC Integration Configuration.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in BAC/APM)
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UI Descriptions

BAC Integration Configuration Monitor Settings
User interface elements are described below:

UI
Element Description

Counters l Total Groups. Total number of groups reporting data to BAC/APM.
l Total Monitors. Total number of monitors reporting data to BAC/APM.
l Duplicate BAC ID. Number of duplicate BAC IDs reported to BAC/APM. Every SiteScope
object has a unique BAC ID. If two objects have the same ID, only one of these objects can
send its data to BAC/APM. For troubleshooting on this subject, see "Tips/Troubleshooting"
below.

l BAC ID == (-1). Every SiteScope object has a unique BAC ID. If the ID value for a
SiteScope object is (-1), SiteScope does not send its data to BAC/APM. For
troubleshooting on this subject, see "Tips/Troubleshooting" below.

l Group with invalid path. If the SiteScope group does not have a valid path, SiteScope
does not send the group to BAC/APM.

l Groups with duplicate name. If the SiteScope group does not have a unique internal
name, SiteScope does not send the group to BAC/APM.

l Monitor with invalid path. If the SiteScopemonitor does not have a valid path, SiteScope
does not send themonitor to BAC/APM.

l Monitors without internal ID. If the SiteScopemonitor does not contain a unique internal
ID, SiteScope does not send themonitor to BAC/APM.

l Monitors without internal name. If the SiteScopemonitor does not contain a valid
internal name, SiteScope does not send this monitor to BAC/APM.

l Measurements with wrong category ID. If SiteScopemeasurements do not contain a
valid category ID, SiteScope does not send themeasurements to BAC/APM. For
troubleshooting on this subject, see "Tips/Troubleshooting" below.

l Target with BSM ID == (-1). Every remote target has a unique BAC ID. If the ID value is (-
1), SiteScope does not send its data to BAC/APM. For troubleshooting on this subject, see
"Tips/Troubleshooting" below.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.

Tips/Troubleshooting

General Notes/Limitations
l If there are objects with duplicate BAC IDs or with BAC ID == (-1):
l Open a JMX Console (there is one provided in <SiteScope root directory>\java\bin\jconsole.exe),
and enter 28006 (the default port) in thePort field.
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l In theMBeans tab, select com.mercury.sitescope/Integration/Bac/Tools/
BacIntegrationToolsJMX.

o For objects with duplicate BAC IDs, activate fixDuplicateBACConfiguration().
o For objects with BAC ID == (-1), activate fixMinusOneBACConfiguration().

l It is also recommended to activate softSync() to send the new configuration to BAC/APM.

l If measurements have the wrong category ID, restart SiteScope.

BAC Integration Statistics Monitor
Use the BAC Integration Statistics monitor to check the health of APM/BAC. This health monitor enables you
to track the volume of traffic between SiteScope and BAC/APM. SiteScope sends metrics to BAC/APM
every minutes.

Note: Monitor data is relevant only if SiteScope is integrated as a data collector for BAC/APM.

To access
Select theMonitors context. In themonitor tree, expandHealth and click BAC Integration Statistics.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in BAC/APM)

UI Descriptions

BAC Integration Statistics Monitor Settings
User interface elements are described below:

UI
Element Description

Counters l Currently Logging to Business Availability Center. Displays the amount of metrics
currently logging per minute to BAC/APM.

l Number of Topology Scripts in Queue. Displays the number of topology scripts waiting
to be run. These scripts forward topology data to BAC/APM andmust be run whenever
there is a configuration change in SiteScope. The queue can grow when a SiteScope is first
registered to BAC/APM or when there aremany configuration changes made in the
SiteScope.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.
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Connection Statistics Monitor
Use the Connection Statistics monitor to collect data on SSH and Telnet connection behavior and statistics
for the Perfex and Perfex dispatcher pool. This provides an overview of global connection handles which is
useful for analyzing connection problems and remote server configuration issues.

To access
Select theMonitors context. In themonitor tree, expandHealth and click Connection Statistics Monitor.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in APM)
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UI Descriptions

Connection Statistics Monitor Settings
User interface elements are described below:

UI Element Description

SSH
Connection
Counters

l Total opened. Total number of all opened SSH connections. If this number is
significantly higher than theCurrently allocated resources counter, this indicates a
configuration problem. Check the following:

l Connection cache was disabled

l An incorrect login or password was used

l The remote server timeout is too short

l Total closed. The number of SSH connections closed since the last SiteScope
restart.

l Total failed to open V1. The number of SSH connections that failed to open using
SSH version 1. By default, SiteScope tries to connect using V1 before trying to
connect with V2. If this number is high, we recommend selecting theSSH version 2
only option on the problematic remote server.

l Total failed to open V2. The number of SSH connections that failed to open using
SSH version 2. If this number is high, verify the correct login and password was used
for the remote server, and verify the SSH version on the remote server (V1 or V2).

l Reused. The number of reused SSH connections since the last SiteScope restart.
l Currently allocated resources. The number of SSH connections that are currently
open.

l Currently in use. The number of SSH connections that are currently open and in use
runningmonitors.

l Average call time for last 10 minutes. Average call time during the last minutes.
l Total Average Call Time. Average call time.

Telnet
Connection
Counters

l Total opened. The number of telnet connections opened since the last SiteScope
restart.

l Total closed. The number of telnet connections closed since the last SiteScope
restart.

l Reused. The number of reused telnet connections since the last SiteScope restart.
l Currently allocated resources. The number of telnet connections that are currently
open.

l Currently in use. The number of telnet connections that are currently open and in use
runningmonitors.
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UI Element Description

Perfex/Perfex
dispatcher
Connection
Counters

l Idle processes. The number of processes currently in idle state.
l Used processes. The number of processes currently in used state.
l Total processes. The total number of processes (idle processes + used processes).
l Process pool queue length. The number of monitors currently waiting for an available
perfex. This value can indicate that there are toomany monitors running on perfex, or
that the perfex pool is too small.

l Average wait time for free process. The average amount of time to wait, in
milliseconds, for a process to be available. If this value exceeds 30,000milliseconds
(30 seconds), monitors will start to fail. A high average wait time indicates that you
need to increase the number of processes in the pool.

l Average run time. The average amount of time, in milliseconds, that a perfex takes to
run. This gives an indication of the following:

l Network speed. The amount of time it takes to send a request and receive a response
from the server.

l Perfex availability. How long it takes on average to complete the run and to return the
perfex to the pool.

l The number of monitors using perfex.

l Processes waiting for server timeout. The number of processes that have exceeded
the call timeout and are waiting for a server timeout to close the connection, or that are
waiting for an answer to return to the pool.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.

Dynamic Monitoring Statistics Monitor
Use the Dynamic Monitoring Statistics monitor to get an overview of the performance of the dynamic
monitoring framework when you have dynamic monitors defined. It is useful for viewing performance
statistics and for analyzing problems when using the dynamic monitoringmechanism to automatically update
dynamic monitoring counters and thresholds.

To access
Select theMonitors context. In themonitor tree, expandHealth and click Dynamic Monitoring Statistics.

This information is also available from theServer Statistics context by clicking theDynamic Monitoring
tab.
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Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in APM)

UI Descriptions

Dynamic Monitoring Statistics Monitor Settings
User interface elements are described below:

UI Element Description

Definitions:

*Dynamic task. The periodic action of retrieving counters from the server, and finding among them the
counters that match the patterns defined for themonitor.

**Counters file. Counters are saved to an xml file located under the <SiteScope root
directory>\templates.application folder.

Average task run time (milliseconds) Average amount of time, in milliseconds, it took for a dynamic
task* to run.

Average task run time during last 10
minutes (milliseconds)

Average amount of time, in milliseconds, it took for a dynamic
task* to run during the last 10minutes.

Average task wait time (milliseconds) Average amount of time, in milliseconds, it took for a dynamic
task* to start running since the time it was received.

Average task wait time during last 10
minutes (milliseconds)

Average amount of time, in milliseconds, it took for a dynamic
task* to start running since the time it was received, during the
last 10minutes.

Number of clashes between dynamic
monitoring framework and
concurrent user changes during last
10 minutes

Number of times unable to save dynamic monitoring framework
changes as a result of the user making concurrent changes (so
as not to override user changes), during the last 10minutes.

Number of times the maximum
number of matching counters was
exceeded during last 10 minutes

Number of times that thematching counters (for patterns) from
the server exceeded the limit during the last 10minutes.

Number of times there were no
matching counters from server
during last 10 minutes

Number of times there were nomatching counters for patterns
from the server during the last 10minutes.
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UI Element Description

Number of times unable to extract
counters from file during last 10
minutes

Number of times unable to extract counters from the counters
file** (during the last 10minutes.

Number of times unable to retrieve
counters from server during last 10
minutes

Number of times unable to retrieve counters from the server
during the last 10minutes.

Number of times unable to run
dynamic tasks because of resource
exhaustion during last 10 minutes

Number of times unable to run dynamic tasks* because the
maximum dynamic monitoring framework thread pool and
queue size limits were reached, during the last 10minutes.

You can configure these settings inPreferences >
Infrastructure Preferences > Dynamic Monitoring Settings.
For details, see "Infrastructure Preferences" on page 517.

Number of times unable to save
changes during last 10 minutes

Number of times unable to save counter changes to SiteScope
persistency during the last 10minutes.

Number of unsaved counter files
during last 10 minutes

Number of times unable to delete existing counter files** or
save new counter files during the last 10minutes.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.

Health of SiteScope Server Monitor
Use the Health of SiteScope Server monitor to check server resources and process statistics on the server
where SiteScope is running. This includes monitors for CPU, disk space, memory, and key processes.

A problem with resource usage on the SiteScope server may be caused by monitors with configuration
problems ormay simply indicate that a particular SiteScope is reaching it performance capacity. For example,
high CPU usage by SiteScopemay indicate that the total number of monitors being run is reaching a limit.
High disk space usagemay indicate that the SiteScopemonitor data logs are about to exceed the capacity of
the local disk drives. For details on SiteScope data logging options, see "Log Preferences Overview" on
page 597.

To access
Select theMonitors context. In themonitor tree, expandHealth and click Health of SiteScope Server.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
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imported a SiteScope to System Availability Management in APM)

UI Descriptions

Health of SiteScope Server Monitor Settings
User interface elements are described below:

UI Element Description

Counters (on UNIX) Current Monitors Run PerMinute
Current Monitors Running
Current Monitors Waiting
MaximumMonitors Run PerMinute
MaximumMonitors Running
MaximumMonitors Waiting
Used Disk Space on SiteScope Drive (accessible on SiteScope installed on
UNIX)
MegaBytes Available on SiteScope Drive
Physical Memory Free
Physical Memory FreeMegabytes
Swap Free
Swap FreeMegabytes
Load Avg 5min
SiteScope Process Memory
SiteScope Process Thread Count
SiteScope Process Handle Count
Average CPU
PageIns/sec
PageOuts/sec
SwapIns/sec
SwapOuts/sec
ContextSwitches/sec
Net_TotalPacketsIn/sec
Net_TotalPacketsOut/sec
Net_TotalCollisions/sec
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UI Element Description

Counters (on
Windows)

Memory

Page Faults/sec
Pool Paged Bytes
Pool Nonpaged Bytes
% Committed Bytes In Use
Available MBytes

System

Context Switches/sec
File Data Operations/sec
System Up Time
Processor Queue Length
Processes
Threads

Processor

_Total

l % Processor Time
% DPC Time

Process

java

l Thread Count
Pool Paged Bytes
Pool Nonpaged Bytes
Handle Count

Network Interface

MS TCP Loopback interface

l Bytes Total/sec
Current Bandwidth
Bytes Received/sec
Bytes Sent/sec
<Ethernet_hardware> (hardware specific to the particular SiteScope server)
Bytes Total/sec
Current Bandwidth
Bytes Received/sec
Bytes Sent/sec

LogicalDisk

<logical_drive> (hardware specific to the particular SiteScope server)

l % Free Space
FreeMegabytes
Avg. Disk Bytes/Transfer

_Total
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UI Element Description

l % Free Space
FreeMegabytes
Avg. Disk Bytes/Transfer

PhysicalDisk

_Total

l Current Disk Queue Length
Disk Transfers/sec

<physical_disk(s)> (hardware specific to the particular SiteScope server)

l Current Disk Queue Length
Disk Transfers/sec

Server

Bytes Total/sec
Errors Logon
Errors Access Permissions
Errors System
Files Open
Server Sessions

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.

Tips/Troubleshooting

Notes/Limitations
l Process/perfex counters were removed from the SiteScope Server Health monitor and are no longer
supported.

l Whenworking in templatemode, themaximum number of counters that you can select is 100. If you
import a templatemonitor from an earlier version of SiteScope, or perform a copy to template action, the
number of counters is not limited.

License Usage Monitor
Use the License UsageMonitor to check the availability and usage of SiteScope licenses for the local
SiteScope installation. It displays the number of OS Instance, URL, and Transaction licenses available, being
used, and remaining, the total number of license days remaining, and the license status if the license capacity
used by SiteScope exceeds the license capacity available.

If you havemigrated your license to point-basedmodel, youmust manually recreate the License Usage
monitor after migration to refresh the dashboard with the point-based license information.

To access
Select theMonitors context. In themonitor tree, expandHealth and click License Usage Monitor.
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Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in APM)

l How to recreate License Usagemonitor after licensemigration
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UI Descriptions

License Usage Monitor Monitor Settings
User interface elements are described below:

UI Element Description Threshold

Counters License days remaining Error if < 10 days

Warning if < 30 days

License type

OS Instance licenses % remaining Error if < 10

Warning if < 30

OS Instance licenses remaining

OS Instance licenses total

OS Instance licenses used

Over-licensed status Error if == 'true'

status Error if != 'ok'

Good if == 'ok'

Transaction licenses % remaining

Transaction licenses remaining

Transaction licenses total

Transaction licenses used

URL licenses % remaining Error if < 10

Warning if < 30

URL licenses remaining

URL licenses total

URL licenses used

How to recreate License Usage Monitor after License Migration
After youmigrate your licensemodel, youmust recreate the License Usagemonitor to refresh the SiteScope
dashboard to view the points-based license information.

To recreate the License Usagemonitor, follow these steps:

1. Select theMonitors context. In themonitor tree, expandSiteScope > Health. Right-click the License
Usage Monitor 11.2x and select Delete.
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2. Right-click theHealth group and select Recreate missing health monitors. The License Usage
Monitor is recreated with the point-based license information and details are displayed on the dashboard.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.

Log Event Checker Monitor
Use the Log Event Monitor to monitor the local SiteScope installation error.log file for certain events. These
events include log entries indicating that amonitor has been skipped or there was a problem in reporting data
to another application.

When an error is detected (for example, amonitor skips), the Log Event Health monitor remains in error status
until you click theReset button in Log Event Health Monitor Settings.

To access
Select theMonitors context. In themonitor tree, expandHealth and click Log Event Checker.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in APM)

UI Descriptions

Log Event Health Monitor Settings
User interface elements are described below:
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UI
Element Description

Counters l skipped #1. A monitor has skipped its scheduled run once.
l skipped #2. A monitor has skipped its scheduled run two times.
l skipped #3. A monitor has skipped its scheduled run three times.
l skipped #4. A monitor has skipped its scheduled run four times.
l skipped #5. A monitor has skipped its scheduled run five times.
l SiteScope is shutting down. SiteScope has been shut down.
l Reached the limit of processes in the process pool. The number of processes
requested from the process pool exceeds the number of processes available in the pool.

l Error. data reporter failed to report chunk of data. There was a fault in the transfer of
SiteScopemonitor measurement data to APM.

l Error. config reporter failed to report chunk of data. There was a fault in the transfer of
SiteScope configuration data to System Availability Management in APM.

l Error. HP Business Service Management failed to process data. APM reported a fault
in processing data sent from SiteScope.

l Error. CacheSender. Got to the max number of cached files. SiteScope has reached
themaximum number of cached data file awaiting transfer to APM. This may occur if data
transfer between SiteScope and APM has been interrupted.

l Error. CacheSender. Got to the max old dir size. SiteScope has reached themaximum
directory size for cached data file awaiting transfer to APM. This may occur if data transfer
between SiteScope and APM has been interrupted.

l HP Business Service ManagementSEVERE. APM reported a data transfer or
processing fault with a status of SEVERE.

l Commit verification failed.
l Error loading monitor.
l Error contacting mirror server.
l Error: open SSH connections limit reached.
l Error: failure in baseline process.
l Error: failed to parse rule.
l Topology Reporter failed to report.

Reset
counter
values

Resets themonitor counter values to 0.

Note:When an error is detected (for example, amonitor skips), the Log Event Health monitor
remains in error status until you click theReset button.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.
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Monitor Load Checker Monitor
Use theMonitor Load Checker monitor to check how many monitors are running and how many are waiting to
be run.

Watchingmonitor load is important to helpmaintain monitoring performance and continuity. If the number of
monitors waiting approaches or exceeds the number of monitors running, adjustments should bemade to
monitor configurations to reduce the number of monitors waiting to run. Generally, this can be done by
reducing the run frequency of somemonitors.

To access
Select theMonitors context. In themonitor tree, expandHealth and click Monitor Load Checker.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in APM)

UI Descriptions

Monitor Load Checker Monitor Settings
User interface elements are described below:

UI Element Description

Counters l Current Monitors Run PerMinute
l Current Monitors Running
l Current Monitors Waiting
l MaximumMonitors Run PerMinute
l MaximumMonitors Run PerMinuteMeasuredOn Time
l MaximumMonitors Running
l MaximumMonitors RunningMeasuredOn Time
l MaximumMonitors Waiting
l MaximumMonitors WaitingMeasuredOn Time

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.
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SSL Certificates State Monitor
Use the SSLCertificates Statemonitor to check the state of SSL certificates in the default keystore
(<SiteScope root directory>\java\lib\security\cacerts). This is where client certificates that are imported
for monitoring URL, WebSphere Application Server, or VMware-based servers are stored.

To access
Select theMonitors context. In themonitor tree, expandHealth and click SSL Certificates State.

Tasks

Related tasks
l "How to Analyze SiteScope Health Monitor Data" on page 991
l "How to Deploy SiteScope Health Monitors" on page 992 (if Health monitors were not present when you
imported a SiteScope to System Availability Management in APM)

UI Descriptions

SSL Certificates State Monitor Settings
User interface elements are described below:

UI Element Description

Days before
expiration

If a certificate is due to expire within the specified number of days (but has not yet
expired), it is added to theCertificates expiring soon counter.

Default value: 7 days

Counters l Expired certificates. Comma-separated list of already expired certificates
l Certificates expiring soon. Comma-separated list of certificates that are due to expire
within the period specified inDays before expiration.

l Number of expired certificates
l Number of certificates expiring soon

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 242.
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Chapter 101: SiteScope Server Statistics
The SiteScope Server Statistics context provides an overview of several key SiteScope server performance
metrics that can be used for analyzing SiteScope performance, stability, health, and for debugging
bottlenecks. It includes statistics that show load on the SiteScope server, a list of runningmonitors and the
most recently runmonitors, perfex pool summary, WMI statistics, SSH connections, Telnet connections, and
dynamic monitoring statistics. It also displays the SiteScope log files. The Server Statistics context is
updated every 20 seconds.

Tip: Alternatively, you can get an overview of SiteScope server performance using the "SiteScope
Health Map and Performance Statistics Logs" on page 1068. These logs provide easy access to
SiteScope load and performance statistics without having to open the SiteScope user interface.

To access
Select theServer Statistics context, and then select the required Server Statistics menu option in the left
pane.

Learn About
Server Statistics Overview
The Server Statistics context includes the following pages:

Page Description

Dynamic
Monitoring

Displays statistics when using the dynamic monitoringmechanism to automatically update
counters and thresholds for dynamic monitors. For details of the user interface, see
"Dynamic Monitoring Page" on page 1015.

General Displays key SiteScope server load statistics, including the number of monitors running
and waiting, and a list of runningmonitors by type. For details of the user interface, see
"General Page" on page 1017.

Log Files Displays the list of log files in SiteScope that are useful for understanding SiteScope
performance issues, for troubleshootingmonitor and alert problems, and for reviewing
SiteScopemanagement actions. For details of the user interface, see "Log Files Page" on
page 1018.

Perfex
Process
Pool

Displays a process manager summary, and statistics tables for the perfex and perfex_
dispatcher pools. For details of the user interface, see "Perfex Process Pool Page" on
page 1023.

PowerShell
Process
Pool

Displays a statistics tables for the PowerShell process pool which is used by theMicrosoft
Exchange Basemonitor. For details of the user interface, see "PowerShell Process Pool
Page" on page 1025.
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Page Description

Running
Monitors

Displays a list of which SiteScopemonitors are running, and whichmonitors have run
recently, at what time, and what was the returned status. For details of the user interface,
see "RunningMonitors Page" on page 1026.

SSH
Connections

Displays SSH statistics and SSH connection summary when using SSH to connect to
remote UNIX orWindows servers. For details of the user interface, see "SSH Connections
Page" on page 1027.

Telnet
Connections

Displays telnet statistics when using telnet to connect to remote UNIX orWindows
servers. For details of the user interface, see "Telnet Connections Page" on page 1029.

WMI
Statistics

Displays the process manager summary forWindows Management Instrumentation (WMI)
statistics. For details of the user interface, see "WMI Statistics Page" on page 1030.

SiteScope Log Files
SiteScopemaintains a number of log files that are useful for understanding SiteScope performance issues, for
troubleshootingmonitor and alert problems, and for reviewing SiteScopemanagement actions.

Log files can be accessed using the Log File menu in the Server Statistics context. When you click a log file, a
new browser window opens displaying the text of the log file. You can use the scroll bars to view the contents
of the log or use the browser's text Find utility to locate specific information. For example, you can search for a
unique text string that appears in amonitor's Name property to locate entries for a particular monitor instance.
For details on the various SiteScope log files, see "Log Files Page" on page 1018 and "Audit Log File" on
page 1031.

The log files are written in plain text and stored in the <SiteScope_root_path>\logs directory. In the default
configuration, these log files are tab-delimited text files. Understanding the order and content of these files is
useful for examining particular monitor results or for porting the SiteScopemonitor results to another
database. For details, see "SiteScope Log File Columns" on the next page.

Note: SiteScope log files do not support Unicode characters—all non-English characters appear
corrupted in the logs. As a workaround, use a SiteScope server installed on a corresponding operating
system locale. For example, use SiteScope installed on a JapaneseWindows operating system for a
Japanese locale.

Accessing SiteScope Log Files
SiteScopemaintains a number of log files that are useful for understanding SiteScope performance issues, for
troubleshootingmonitor and alert problems, and for reviewing SiteScopemanagement actions.

Log files can be accessed using the Log File menu in the Server Statistics context. When you click a log file, a
new browser window opens displaying the text of the log file. You can use the scroll bars to view the contents
of the log or use the browser's text Find utility to locate specific information. For example, you can search for a
unique text string that appears in amonitor's Name property to locate entries for a particular monitor instance.
For details on the various SiteScope log files, see "Log Files Page" on page 1018 and "Audit Log File" on
page 1031.

The log files are written in plain text and stored in the <SiteScope_root_path>\logs directory. In the default
configuration, these log files are tab-delimited text files. Understanding the order and content of these files is
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useful for examining particular monitor results or for porting the SiteScopemonitor results to another
database. For details, see "SiteScope Log File Columns" below.

Note: SiteScope log files do not support Unicode characters—all non-English characters appear
corrupted in the logs. As a workaround, use a SiteScope server installed on a corresponding operating
system locale. For example, use SiteScope installed on a JapaneseWindows operating system for a
Japanese locale.

SiteScope Log File Columns
When SiteScope runs amonitor instruction to test the availability of components in the infrastructure, the
monitor results are written to data log files. The first six columns of each log entry in a SiteScopemonitor data
log are the same for eachmonitor type. After the first six columns of each log entry, the content of each
column is specific for eachmonitor type (see specific monitor listed below).

Note: Field names change dynamically according to your SiteScopemonitor configuration. Tomanually
generate a list of field names for data logged to a database, see "How to Generate Field Names for Data
Logged to a Database" on page 598.

The following table describes the content of these columns. The columns in each log file are written as tab-
delimited text.

Column Data in Column

1 Time and date the sample was recorded.

2 Category (for example, good, error, warning, nodata).

3 Monitor group namewhere themonitor defined (also called ownerID).

4 Monitor title text.

5 stateString (this is the status string that shows up on theGroup details page).

6 id:sample number (a unique ID for this monitor where group + id is a unique key for amonitor).
The sample number is a unique sample number for that monitor.

For log file columns for specific monitors, see "Monitor Specific Log ColumnContent" on page 1036.

Interpreting SiteScope Server Load Statistics
Monitoring Load can be a key indicator of SiteScope scaling problems, monitor configuration problems, or
network performance issues. The following is a brief explanation of the SiteScopemonitor executionmodel
and interpreting the server performance data in the context of this model.

A SiteScopemonitor instance is essential as an instruction set that is run by the SiteScope application on a
regularly scheduled interval. While amonitor instance is defined, SiteScope queues themonitor for execution
based on the run (update) frequency and schedule options. If themonitor instance is marked as disabled, it is
still scheduled in the queue but the normal instructions are not run.

As a Java-based application, SiteScopemakes use of multi-threading to accomplish parallel execution of
monitor tasks. Eachmonitor instance scheduled for execution is assigned a thread. Once it is assigned a
thread, themonitor instance becomes aMonitor Running. It remains bound to the thread until themonitor
execution instruction has either received a result or the timeout value, if applicable, has been reached.
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Even in this model, monitor execution is not instantaneous and there is a finite limit to the number of monitor
threads that can be run in parallel. If not more threads are available, a monitor that is queued for execution
becomes aMonitor Waiting for an execution thread.

It is difficult to assign specific values and limits to SiteScopeMonitoring Load because the specifics of the
server capacity and network deployment can vary widely. Themonitoring loadmay also vary significantly
over time simply due to transient network traffic issues or SiteScopemonitor configuration problems.

One key warning signal for interpretingmonitoring load is the ratio of Monitors Waiting toMonitors Running.
Generally, having somemonitors waiting for execution is not a problem unless the ratio of Monitors Waiting to
Monitors Running is consistently 1:2 or higher. For example, if the number of monitors running is at the
maximum of 100 and there are 50monitors waiting, this represents a ratio of 1monitor waiting for every two
running.

Note: The initial maximum number of monitor execution threads for the _maxMonitorsRunning= setting
controlled by the <SiteScope root directory>\groups\master.config file is 400 (the default value is 30
inmaster.xml).

The graph below presents a visualization of the relationship betweenMonitors Running andMonitors Waiting.
This graph is based on the _maxMonitorsRunning setting of 100monitors. The green region shows that
SiteScope can run all queuedmonitors until the number of queuedmonitors exceeds 100. At that level,
additional monitors that are scheduled to run are given the status of MonitorWaiting. The red region
represents an area where the number of monitors waiting is more than twice the number of monitors running.
This is a certain indication that your SiteScopemonitor configurations are not well aligned with the capacity of
the server and network.

You can adjust the followingmonitor configuration settings if there are consistently toomany monitors
waiting:

l Frequency. This is the basic schedule parameter for every monitor type. A large number of Monitors
Running andMonitors Waiting can often be explained by a large number of monitors set to run (or update)
at short intervals. Theminimum update interval is 15 seconds. Depending on a number of system factors,
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there are several monitor actions whichmay takemore than 15 seconds to complete. For example, Web
transactions, database queries, logging onto remote servers, and some regular expressionmatches may
delay monitor completion. Use the "Monitor Summary Report" on page 1175 to check the Frequency
setting for groups of monitors and consider increasing the value for somemonitors.

l Verify error. Regular or extensive use of this option has the effect of rapidly increasing themonitor run
queue whenever the applicable SiteScopemonitors detect an error condition. While this option has its
purpose, it should not be used by default on every monitor. Use the "Monitor Summary Report" on
page 1175 to list monitors that may have theVerify error setting enabled.

For details on SiteScope server performance data, see "RunningMonitors Page" on page 1026.

Tasks
How to Analyze SiteScope Server Statistics from the SiteScope user interface
This task describes the steps involved in analyzing SiteScope server statistics and log files.

1. Prerequisites
To access the Server Statistics context, youmust be an administrator in SiteScope, or a user granted
View server statistics permissions (this settings is selected by default).
For details on user permissions, see "Permissions" on page 636.

2. View SiteScope server statistics
You can view the load on the SiteScope server, a list of running andmost recently runmonitors, perfex
process pool, WMI, SSH connections, telnet connections, and dynamic monitoring statistics in the
Server Statistics context.
See below for user interface details.

3. View SiteScope log files
You can view the various SiteScope log files in the Log Files page in the Server Statistics context.
For user interface details, see "Log Files Page" on page 1018.

Dynamic Monitoring Page
This page displays statistics when using the dynamic monitoringmechanism to automatically update
dynamic monitoring counters and thresholds. This is useful for viewing performance and for analyzing
problems in dynamic monitoring.

To access Select Server Statistics context > Dynamic Monitoring

Important
information

l Only an administrator, or a user grantedView server statistics permissions, can view
themonitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 625.

l This information is also available from theMonitors context (expand theHealth folder
and click Dynamic Monitoring Statistics).

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" above

See also "SiteScope Server Statistics" on page 1011
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User interface elements are described below:

Parameter Description

Definitions:

*Dynamic task. The periodic action of retrieving counters from the server, and finding among them the
counters that match the patterns defined for themonitor.

**Counters file. Counters are saved to an xml file located under the <SiteScope root
directory>\templates.application folder.

Average task wait time during last 10
minutes (milliseconds)

Average amount of time, in milliseconds, it took for a dynamic
task* to start running since the time it was received, during the
last 10minutes.

Average task wait time (milliseconds) Average amount of time, in milliseconds, it took for a dynamic
task* to start running since the time it was received.

Average task run time during last 10
minutes (milliseconds)

Average amount of time, in milliseconds, it took for a dynamic
task* to run during the last 10minutes.

Average task run time (milliseconds) Average amount of time, in milliseconds, it took for a dynamic
task* to run.

Number of unsaved counter files
during last 10 minutes

Number of times unable to delete existing counter files** or
save new counter files during the last 10minutes. .

Number of clashes between dynamic
monitoring framework and
concurrent user changes during last
10 minutes

Number of times unable to save dynamic monitoring framework
changes as a result of the user making concurrent changes (so
as not to override user changes), during the last 10minutes.

Number of times the maximum
number of matching counters was
exceeded during last 10 minutes

Number of times that thematching counters (for patterns) from
the server exceeded the limit during the last 10minutes.

Number of times unable to extract
counters from file during last 10
minutes

Number of times unable to extract counters from the counters
file** during the last 10minutes.

Number of times unable to save
changes during last 10 minutes

Number of times unable to save counter changes to SiteScope
persistency during the last 10minutes.

Number of times unable to run
dynamic tasks because of resource
exhaustion during last 10 minutes

Number of times unable to run dynamic tasks* because the
maximum dynamic monitoring framework thread pool and
queue size limits were reached, during the last 10minutes.

You can configure these settings inPreferences >
Infrastructure Preferences > Dynamic Monitoring Settings.
For details, see "Infrastructure Preferences" on page 517.

Number of times unable to retrieve
counters from server during last 10
minutes

Number of times unable to retrieve counters from the server
during the last 10minutes.
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Parameter Description

Number of times there were no
matching counters from server
during last 10 minutes

Number of times there were nomatching counters (for patterns)
from the server during the last 10minutes.

Total number of unsaved counter
files

Total number of times unable to delete existing counter files or
save new counter files.

Total number of clashes between
dynamic monitoring framework and
concurrent user changes

Total number of times unable to save dynamic monitoring
framework changes as a result of the user making concurrent
changes (so as not to override user changes).

Total number of times the maximum
number of matching counters was
exceeded

Number of times that thematching counters (for patterns) from
the server exceeded the limit.

Total number of times unable to
extract counters from file

Total number of times unable to extract counters from the
counters file**.

Total number of times unable to save
changes

Total number of times unable to save counter changes to
SiteScope persistency.

Total number of times unable to run
dynamic tasks because of resource
exhaustion

Total number of times unable to run dynamic tasks* because
themaximum dynamic monitoring framework thread pool and
queue sizes limits were reached.

You can configure these settings inPreferences >
Infrastructure Preferences > Dynamic Monitoring Settings.
For details, see "Infrastructure Preferences" on page 517.

Total number of times unable to
retrieve counters from server

Total number of times unable to retrieve counters from the
server.

Total number of times there were no
matching counters from server

Total number of times there were nomatching counters (for
patterns) from the server.

General Page
This page enables you to view an overview of several key SiteScope server performance statistics, including
the current andmaximum number of runningmonitors, waitingmonitors, andmonitor runs per minute. It also
displays a list of monitor types that are currently running, and the number of running instances for each type.

To access Select Server Statistics context > General

Important
information

Only an administrator in SiteScope, or a user grantedView server statistics permissions,
can view themonitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 625.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011
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User interface elements are described below:

UI Element Description

Overall Statistics

Monitors running Current column. Displays the number of monitors queued for execution,
based on their update frequency or schedule, that currently have execution
threads. This means they are being run.

Maximum andMeasured on columns. Display themaximum number of
monitors that ran and when they ran.

Monitors waiting Current column. Displays the number of monitors queued for execution,
based on their update frequency or schedule, that currently are awaiting
execution threads. This means they are not being run.

Maximum andMeasured on columns. Display themaximum number of
monitors that were waiting at any one time and when this occurred.

Monitors run per minute Current column. Displays a rolling average of the last 10minutes of
monitoring, and tracks the rate (per minute) at whichmonitors are being run.

Maximum andMeasured on columns. Display themaximum number of
monitors running per minute at any one time and when they ran.

executionCount* Number of monitors executed during the last minute (Default statistics
frequency; can be changed in log4j.properties).

averageTime* Averagemonitor execution time inmilliseconds. (Collected for themonitors
counted in executionCount.)

driftAverageTime* Average time inmilliseconds calculated (for themonitors counted in
executionCount ) by the following formula: Monitor start time - Last monitor
start time - Monitor frequency (in milliseconds).

This metric shows the average deviation of monitors start time comparing
to the pure schedule. Usually somemicro-deviations are added by the
monitor run scheduler to avoid burst of scheduledmonitor runs all at the
same time. Huge numbers should be a signal to check if there are skipped
monitors or monitors in no data due to time-outs.

* Metric can be viewed in the server_statistics.log file located in the <SiteScope_root_path>\logs
directory.

Running Monitors by Type

<running monitors list> Displays a list of monitor types that are currently running and the number of
running instances for each type.

Log Files Page
This page enables you to inspect the SiteScope log files.
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To access Select Server Statistics context > Log Files.

Important
information

l SiteScope log files do not support Unicode characters—all non-English characters
appear corrupted in the logs. As a workaround, use a SiteScope server installed on a
corresponding operating system locale. For example, use SiteScope installed on a
JapaneseWindows operating system for a Japanese locale.

l To create a dedicated log for a specific monitor, see "Logging Settings" on page 268. To
disable separatemonitor logging for all monitors, see "Disable separate logging for
monitors" on page 600.

Relevant
tasks

l "How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

l "How to Configure the Audit Log" on page 1036

See also l "SiteScope Log Files" on page 1012
l "Monitor Specific Log ColumnContent" on page 1036
l "Audit Log Entries" on page 1032
l "SiteScope Health Map and Performance Statistics Logs" on page 1068

Log Files Table
User interface elements are described below:

UI
Element Description

Changes the sort order in the columns by clicking the arrow in the column title. A small up or
down arrow is displayed to the left of the arrow which indicates the sort order.

Note:Clicking the arrow in the Type column title opens the list of log types, which enables you
to filter the list by the log type you want to display. To clear the filter, click the arrow again, and
select (All).

Type The log file type. For details on the different types of log files, see "Log File Types" below.

Log File The name of the log file. Double-click a log file link to open the file in yourWeb browser.

Size The size of the log file.

Last
Modified

The time and date on which the log file was last modified.

Log File Types
User interface elements are described below:

UI Element Description

Audit Logs Logs containing all configuration changes that were performed from the
user interface, such as creation of monitors, templates, alerts and so on.
For details on audit logs, see "Audit Log File" on page 1031.
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UI Element Description

BSM Integration Logs Contain information about connectivity andmonitor data transfer when
SiteScope is configured to report to APM. These logs are stored in the
<SiteScope root>\logs\bac_integration folder.

l bac_integration.log. Contains all messages registered by the BSM
integration framework.

l bac_integration_tools.log. Contains messages generated by tools
which check BSM integration consistency on every SiteScope restart.

l discovery.log. Contains messages generated by the topology reporting
module,

l eti_resolver.log. Contains messages generated by themodule
responsible for resolving health indicator to metric (counter) mappings.

l quota_control.log. Not currently used.

Daily Logs Contains links to the logs containing individual monitor measurements.
SiteScope creates a new monitor log each day to record all monitors run
during that 24 hour period. These logs are the basis for SiteScope Reports.

The daily logs are in the format:

l SiteScope<YYYY_MM_DD>.v2.log. These logs contain more detailed
monitor run results than the legacy logs.

l SiteScope<YYYY_MM_DD>.log. The legacy daily log files.
Note:

l Themonitor logs can become very large depending on themonitor
environment. This may make it impractical to view them using aWeb
browser.

l By default, both types of daily log file are generated. If you are not using
baselining, it is recommended to disable the legacy daily log by setting
the property _shouldLogToLegacyDailyLog= to false in the
<SiteScope root>\groups\master.config file.

l To disable logging to both types of daily log files, change the property _
dailySiteScopeLogs=true in the <SiteScope
root>\groups\master.config file to _dailySiteScopeLogs=. When
disabled, a log file namedSiteScope.log is created instead, which is
updated each day; this means that there is no historical data of monitor
run results for SiteScope reports. (For daily log files, you can determine
the number of logs of monitoring data to keep in theDaily logs to keep
setting inPreferences > Log Preferences. Once a day, SiteScope
deletes any logs that exceed the specified number of logs to keep.)
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UI Element Description

Error Logs Contains a variety of messages relating to the operation of SiteScope. This
includes a record of errors that SiteScopemay have encountered when
trying to perform monitor actions or data communication actions. It also
includes messages indicating when SiteScope was stopped or started and
if there aremonitors that are skipping because they are unable to complete
their task. This is the default log file for any messages, which were not
routed to a special log file.

The name of the current error log is error.log. When the current error log
reaches its size limit, it is closed and a new log is created. Older logs are
named error.log.1, error.log.2, and so forth. The higher the number
concatenated to the name, the older the log.

Run Monitor Logs Contains information about specific monitor runs and actions related to
managingmonitors. This can be useful in troubleshootingmonitors.

Other Logs

Contains various different log file types, such as:

alert.log Records alert information whenever SiteScope generates an alert. This can
be used to troubleshoot alert actions and to confirm that alerts were sent.

amazon_ec2_
integration.log

Contains information relating to the Amazon EC2 Integration log (empty if
no integration defined).

baselining.log Contains errors and informational messages that occurred during the
baseline thresholds calculation.

data_integration.log Contains messages for the Generic Data Integration (empty if no
integration defined) .

downtime.log Contains messages generated by monitors disabled by the BSM
CI Downtime feature.

dynamic_monitoring_
changes.log

Contains scheduled actions for all of the dynamic monitors.

event_console_history.log Contains messages of all closed (non-active) events that were triggered
from Event Console alert actions. For details on whenmessages are
written to this log, see "Historical Event Log Files" on page 917.

event_console_ui.log Contains messages of events triggered from Event Console alert actions
that are displayed in the Event Console.

ha.log Contains messages generated by the SiteScope Failover Manager shared
disk solution (deprecated since SiteScope 11.20).
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UI Element Description

health_map.log Contains a summary status of SiteScope performance. It includes the
following performancemetrics: number of runningmonitors, number of
waitingmonitors (monitors queue size), monitor average run time (per
monitor type), number of currently open SSH. For details, see "SiteScope
Health Map and Performance Statistics Logs" on page 1068.

high_availability.log Contains messages generated during SiteScope Failover mirroring
operations.

HPSiteScopeOperations
ManagerIntegration.log

System log for event integration with the OperationManager Agent.

HPSiteScopeOperations
ManagerIntegration.HA.log

System log for event integration with the OperationManager Agent for
SiteScope Failover configuration.

monitorCount.log Counts the total number of monitors and license instances used in
SiteScope. It also specifies the number and license usage for each type of
server health monitor. This log is updated once a day when SiteScope
starts (and not on every change). You can refresh the log file at any time by
selectingHelp > About SiteScope.

mirror.log Contains messages generated by SiteScope Failover and initial
configuration information.

oa_metric_integration.log Contains information relating to the integration with the Operations Agent.

Operator.log An optional log file used to record SiteScope operator actions, primarily
information from use of the Acknowledgment function. This log is created
when an acknowledgment is added to one or moremonitors.

Post Log File An optional log file used to record HTTP Post requests made to the
SiteScope server. This can be used to track administrative actions
performed. This log is enabled only when the _postLogFile=true setting
exists in the <SiteScope root directory>\groups\master.config file.

remotes_multi_test Displays the remote server connection test results when the test was
performed for multiple remotes.

request_statistics.log Displays the Tomcat request statistics filter.

server_statistics.log Contains information about usedmemory and system resources.

server_statistics_raw.log When the log level is changed to DEBUG, this file contains detailed
information about used process and perfex pools.
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UI Element Description

silent_deployment.log Records details on submitted requests for silent deployments and their
corresponding deployment results. It also includes error messages for
silent deployments that fail. This log is updated once a day when SiteScope
starts (and not on every change).

Note:When deploying a template using a CSV file, non-English characters
used in the CSV file are not supported in the silent_deployment log file. The
deployment values are displayed correctly in the user interface if the correct
encoding option is selected.

SiteScope_<group>_
<monitorName>.log

Contains log data for a selectedmonitor instance in the <SiteScope root
directory>\logs\monitor_runs folder. This folder contains one file per
monitor instance. The format of log file names is determined according to
themonitor path in the SiteScope tree, as follows: SiteScope_<group>_
<monitorName>.log

This log is enabled after amonitor run when separatemonitor logging is
enabled. To enable separatemonitor logging, see "Logging Settings" on
page 268.

skip_monitor.log Contains information about skippedmonitor runs. For every skip
occurrence, a line is added with the date and time of the skip, name (and
ID) of themonitor, server name, number of skips, and themonitor status (if
themonitor was disabled).

template_persistency_
upgrade.log

Contains messages that occurred while importing templates to
persistency.

upgrade.log Contains messages that occurred while working with the upgrader.

Perfex Process Pool Page
This page displays the process manager summary, and pool statistics and statuses for each perfex pool.
Perfex is a command line interface used to process event counters. Perfex prints the values of various
hardware performance counters after the given command is complete. Perfex_dispatcher is a process used
for Microsoft Windows Resources monitors.

To access Select Server Statistics context > Perfex Process Pool

Important
information

l Only an administrator, or a user grantedView server statistics permissions, can view
themonitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 625.

l In environments that have load capacity issues, youmight need to change the _
internalKillProcessOnTimeout property value to =true in the <SiteScope
root>\groups\master.config file. However, you should not use this parameter without
first consulting with HPE support.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015
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See also "SiteScope Server Statistics" on page 1011

User interface elements are described below:

UI Element Description

Process Manager Summary

Calls per
minute

The number of process calls on the SiteScope server, per minute.

Double
failures

The number of times SiteScope failed to connect to a remote server, after making two
consecutive connection attempts. For connection failure details, check the runmonitor
and error logs.

Stopped
processes

The number of processes that stopped due to error, for example, if the process timed out,
since the last SiteScope restart.

Created
processes

The number of processes created by SiteScope for all pools since the last restart. If there
is a large number of created processes and stopped processes, increase the perfex
timeout value inPreferences > Infrastructure Preferences > General Settings >
Perfex timeout (seconds).

Cleaned
processes

SiteScope cleans processes if they exceed themaximum idle time. The default time
before cleaning idle processes is 10minutes. You can change the idle processes
maximum time inPreferences > Infrastructure Preferences > General Settings >
Maximum idle time for perfex process in minutes. Cleaning processes improves the
memory footprint on the SiteScopemachine. Cleaning processes is especially important
during a network slowdownwhen perfexes take longer to finish. As a result, more
perfexes are created, but they are not used.

Pool Statistics - perfex/perfex_dispatcher

Process pool
queue length

The number of monitors currently waiting for an available perfex. This value can indicate
that there are toomany monitors running on perfex, or that the perfex pool is too small.

Average wait
time for free
process
(milliseconds)

The average amount of time to wait, in milliseconds, for a process to be available. If this
value exceeds 30,000milliseconds (30 seconds), monitors will start to fail. A high
average wait time indicates that you need to increase the number of processes in the
pool.

Average run
time
(milliseconds)

The average amount of time, in milliseconds, that a perfex takes to run. This gives an
indication of the following:

l Network speed. The amount of time it takes to send a request and receive a response
from the server.

l Perfex availability. How long it takes on average to complete the run and to return the
perfex to the pool.

l The number of monitors using perfex.

Idle
processes

The number of processes currently in idle state.
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UI Element Description

Used
processes

The number of processes currently in used state.

Total
processes

The total number of processes (idle processes + used processes).

Maximum
process pool
size

Themaximum number of processes allowed per process pool. The default value is 200.
You can change themaximum process pool size in Infrastructure Preferences >
General Settings > Maximum processes per pool.

Processes
waiting for
server
timeout

The number of processes that have exceeded the call timeout and are waiting for a server
timeout to close the connection, or that are waiting for an answer to return to the pool.

PowerShell Process Pool Page
This page displays a statistics tables for the PowerShell process pool which is used by theMicrosoft
Exchange Basemonitor. You can impact Microsoft Exchange Basemonitor performance by changing
PowerShell pool parameters inPreferences > Infrastructure Settings > General Settings.

You can also see these statistics in <SiteScope root directory>\logs\server_statistics.log. When you use
theMicrosoft Exchange BaseMonitor, statistics lines for the PowerShell pool look like the following in the log
file:

[StatisticsLogger] INFO - PoolName=PowerShellPool active processes:1; idle processes:0;
total processes:1; max pool size:20; pool utilization:5.00%

To access Select Server Statistics context > PowerShell Process Pool

Important
information

Only an administrator, or a user grantedView server statistics permissions, can view the
monitor performance data pages. For details on user permissions, see "User Management
Preferences" on page 625.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011

"Infrastructure Preferences" on page 517

User interface elements are described below:

UI Element Description

PowerShell Pool Statistics
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UI Element Description

Active
processes

The number of PowerShell processes that are currently being used.

By default, themaximum number of active PowerShell processes (per key) is 20. You can
change this value in Infrastructure Preferences > General Settings > PowerShell pool:
maximum number of active processes (per key).

Idle
processes

The number of PowerShell processes which are not currently being used, but maintain a
connection with aMicrosoft Exchange Server.

By default, themaximum number of idle PowerShell processes (per key) is 8. You can
change this value in Infrastructure Preferences > General Settings > PowerShell pool:
maximum number of idle processes (per key).

Themaximum wait time until a new or idle PowerShell process is available is 1000
milliseconds by default. You can change this value in Infrastructure Preferences >
General Settings > PowerShell pool: maximum wait time until new or idle process is
available (milliseconds).

Theminimum amount of time that an object can sit idle in the pool before the object is eligible
for eviction is 5minutes by default. You can change this value in Infrastructure
Preferences > General Settings > PowerShell pool: minimum idle time for processes
(milliseconds).

By default, the eviction thread checks for idle objects every 15minutes. You can change this
value in Infrastructure Preferences > General Settings > PowerShell pool: minimum
idle time for processes (milliseconds).

Total
processes

The total number of PowerShell processes that exist in the PowerShell pool at the current
time (idle processes + active processes).

Maximum
PowerShell
pool size

Themaximum number of PowerShell processes which can be in the pool simultaneously.

The default value is 20. You can change themaximum number of PowerShell processes
which can be in the pool simultaneously in Infrastructure Preferences > General Settings
> PowerShell pool: maximum number of processes.

PowerShell
pool
utilization
(%)

The percentage of PowerShell pool utilization.

Running Monitors Page
This page enables you to view a list of which SiteScopemonitors are running, and whichmonitors have run
recently, at what time, and what was the returned status.

To access Select Server Statistics context > Running Monitors

Important
information

Only an administrator, or a user grantedView server statistics permissions, can view the
monitor performance data pages. For details on user permissions, see "User Management
Preferences" on page 625.
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Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011

User interface elements are described below:

UI
Element Description

Running Monitors

Run
Time

The run time, in seconds, for themonitor that is currently being run.

Skips The number of skips for themonitor that is currently being run. A SiteScopemonitor is reported
as skipped if it fails to complete its actions before it is scheduled to run again.

Group
Name

The group to which themonitor that is currently being run belong.

Monitor
Name

The name of the SiteScopemonitor that is currently being run. Clicking themonitor name link
opens the Dashboard page for the selectedmonitor. Monitors with longer run time or skips are
colored in red.

Current
Status

The status returned by themonitor that is currently being run.

Recent Monitor Runs

Time
and
Date

The date and time themonitor ran. Themonitors are displayed in the order that havemost
recently completed running.

Group
Name

The group to which themonitor belongs.

Monitor
Name

The name of themonitor that SiteScope ran.

Current
Status

The status returned by themonitor (good, warning, error) andmeasurement summary details.

SSH Connections Page
This page displays Secure Shell (SSH) statistics and a summary of SSH connections when using SSH to
connect to remote UNIX orWindows servers.

To access Select Server Statistics context > SSH Connections
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Important
information

Only an administrator, or a user grantedView server statistics permissions, can view the
monitor performance data pages. For details on user permissions, see "User Management
Preferences" on page 625.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011

User interface elements are described below:

UI Element Description

SSH Statistics

Total
opened

Total number of all opened SSH connections. If this number is significantly higher than the
Currently allocated resources counter, this indicates a configuration problem. Check the
following:

l Connection cache was disabled
l An incorrect login or password was used
l The remote server timeout is too short

Total
closed

The number of SSH connections closed since the last SiteScope restart.

Total
cleaned

The number of SSH connections cleaned since the last SiteScope restart.

Total failed
to open V1

The number of SSH connections that failed to open using SSH version 1. By default,
SiteScope tries to connect using V1 before trying to connect with V2. If this number is high,
we recommend selecting theSSH version 2 only option on the problematic remote server.

Total failed
to open V2

The number of SSH connections that failed to open using SSH version 2. If this number is
high, verify the correct login and password was used for the remote server, and verify the
SSH version on the remote server (V1 or V2).

Reused The number of reused SSH connections since the last SiteScope restart.

Currently
allocated
resources

The number of SSH connections that are currently open.

Currently in
use

The number of SSH connections that are currently open and in use runningmonitors.

Average
Call Time
for Last 10
Minutes

The average SSH call time during the last 10minutes.

Total
Average
Call Time

The average call time.
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UI Element Description

SSH Connections Summary

<Host
name>

For each target remote server, there is a row that displays the following information:

l Machine Name. The name of themonitored remote server.
l Sessions in Use. The number of open SSH sessions on themonitored remote server.
l Idle Sessions. The number of idle SSH sessions on themonitored remote server.
l Maximum Sessions. Themaximum number of SSH sessions (idle or in use) on the
monitored remote server.

l Queue Length. The number of SSH sessions in the queue.
l Average Wait Time. The average amount of time to wait, in milliseconds, for a free
SSH session.

l Average Call Time for Last 10 Minutes. The average SSH call time during the last 10
minutes.

l Total Average Call Time. The total of average call time.
Note:SiteScope has a limit of 500 concurrent SSH connections.

Telnet Connections Page
This page displays telnet statistics when using telnet to connect to remote UNIX orWindows servers.

To access Select Server Statistics context > Telnet Connections

Important
information

Only an administrator, or a user grantedView server statistics permissions, can view the
monitor performance data pages. For details on user permissions, see "User Management
Preferences" on page 625.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011

User interface elements are described below:

Parameter Description

Telnet Statistics

Total opened The number of telnet connections opened since the last SiteScope restart.

Total closed The number of telnet connections closed since the last SiteScope restart.

Reused The number of reused telnet connections since the last SiteScope restart.

Currently allocated
resources

The number of telnet connections that are currently open.
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Parameter Description

Currently in use The number of telnet connections that are currently open and in use running
monitors.

Telnet Connections Summary

<Host name> For each target remote server, there is a row that displays the following
information:

l Machine Name. The name of themonitored remote server.
l Sessions in Use. The number of open telnet sessions on themonitored
remote server.

l Idle Sessions. The number of idle telnet sessions on themonitored remote
server.

l Maximum Sessions. Themaximum number of telnet sessions (idle or in use)
on themonitored remote server.

l Queue Length. The number of telnet sessions in the queue.
l Average Wait Time. The average amount of time to wait, in milliseconds, for
a free telnet session.

Note:SiteScope has a limit of 500 concurrent telnet connections.

WMI Statistics Page
This page displays the process manager summary forWindows Management Instrumentation (WMI)
statistics. You can useWMI to access system counter data from objects in the performance libraries. This is
the same performance data that appears in the Perfmon utility.

To access Select Server Statistics context >WMI Statistics

Important
information

Only an administrator, or a user grantedView server statistics permissions, can view the
monitor performance data pages. For details on user permissions, see "User Management
Preferences" on page 625.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1015

See also "SiteScope Server Statistics" on page 1011

User interface elements are described below:

UI
Element Description

Process Manager Summary

Calls per
minute

The number of process calls on the SiteScope server, per minute.
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UI
Element Description

Double
failures

The number of times SiteScope failed to connect to a remote server, after making two
consecutive connection attempts. For connection failure details, check the runmonitor and
error logs.

Stopped
processes

The number of processes that stopped due to error, for example, if the process timed out,
since the last SiteScope restart.

Created
processes

The number of processes created by SiteScope for all pools since the last restart. If there is a
large number of created processes and stopped processes, increase the perfex timeout value
inPreferences > Infrastructure Preferences > General Settings > Perfex timeout
(seconds).

Cleaned
processes

SiteScope cleans processes if they exceed themaximum idle time. The default time before
cleaning idle processes is 10minutes. You can change the idle processes maximum time in
Preferences > Infrastructure Preferences > General Settings > Maximum idle time for
perfex process in minutes. Cleaning processes improves thememory footprint on the
SiteScopemachine. Cleaning processes is especially important during a network slowdown
when perfexes take longer to finish. As a result, more perfexes are created, but they are not
used.

Processes
waiting
for server
timeout

The number of processes that have exceeded the call timeout and are waiting for a server
timeout to close the connection, or that are waiting for an answer to return to the pool.

Audit Log File
SiteScope's audit log provides you with a record of actions performed in SiteScope, the time they were
performed, and by whom. It includes details of changes made by a user to the SiteScope configuration, and
for every change (where applicable) it displays the value before and after the change. It is also lists the full
path of the entity being audited.

To access
You can access the current audit log from <SiteScope root directory>\logs\audit.log or through the
SiteScope application. For details on viewing the audit log, see "Log Files Page" on page 1018.

Learn About

Audit Log File Overview
The audit log contains configuration changes performed in the new user interface, such as:
creation/update/copy/deletion of monitors, groups, templates, alerts, reports and so forth. An entry is also
made for user login/logout, user password changes, preference setting changes, and for monitors that are run
manually. To help a user determine performance issues when generating SiteScope reports, the audit log also
includes details of the report type, its targets, and the user that generated the report.
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As each operation is performed, an entry is made in the audit log. Operations that involve several steps
typically have a separate start and end entry line.

Example:

2011-11-10 08:04:41 - User: SiteScope Administrator. Operation performed: UPDATE Monitor
'SiteScope\autosanity\cpu' start:

2011-11-08 14:43:56 - User: SiteScope Administrator. Operation performed: Monitor
'SiteScope\autosanity\cpu' update: '_alertDisabled' updated from '-1' to ''.

2011-11-08 14:43:56 - User: SiteScope Administrator. Operation performed: UPDATE Monitor
'SiteScope\autosanity' end.

The name of the current audit log is audit.log. When the current audit log reaches its size limit, it is closed
and a new log is created. Older logs are named audit.log.1, audit.log.2, and so forth. The higher the
number concatenated to the name, the older the log. For details on setting the size limit and themaximum
number of backup audit logs to be kept, see "How to Configure the Audit Log" on page 1036.

Most operations performed in themonitor tree are recorded in the audit log. For details on audit log entries, see
"Audit Log Entries" below.

For a list of operations that are not recorded in the audit log, see "Tips/Troubleshooting" on page 1036.

Audit Log Entries
Each line of the audit log describes an operation performed in SiteScope. Operations that involve several
steps typically have a separate start and end entry line.

The audit log lists a record of actions for the following changes performed in SiteScope:

Entity Changed Actions Logged in the Audit Log

Group/Monitor/Template
Entities

l created in. The location where the user created an entity.
l update: 'entity' from '<x>' to '<y>'. The entity that a user updated, and the
values before and after the update.

l deleted from. The location where the user deleted an entity.
l copied to. The user copied information from one entity to another.
l moved to. The user moved information from one entity to another.

Preferences l created. The user created the preference.
l deleted. The user deleted the preference.
l update: 'entity' from '<x>' to '<y>'. The entity that a user updated, and the
values before and after the update.

Templates l DEPLOY template. The template that was deployed, including the deployed
objects (groups, monitor, remote server).

l REDEPLOY template.The changes that were published to deployed
groups/monitors after a template has been updated.

l IMPORT template.Template configurations imported from external files.

This section also includes:
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l "Actions Recorded for Monitor/Group/Alert/Report/Template/Remote Entities" below
l "Actions Recorded for SiteScope Preferences" on the next page
l "Actions Recorded for Other SiteScopeOperations Entered in the Audit Log" on page 1035

Actions Recorded for Monitor/Group/Alert/Report/Template/Remote Entities
This table lists the actions performed on SiteScope entities that are entered in the audit log :

Entity Action

Group

(monitor/template
mode)

l Create
l Update
l Delete
l Copy/Cut/Paste
l Copy to template (monitor mode only)
l Global Search and Replace (monitor mode only)
l Manual run of all child monitors (monitor mode only)

Monitor

(monitor/template
mode)

l Create
l Update
l Delete
l Copy/Copy to Template (templatemode)
l Move (Cut/Paste)
l Enable/Disable
l Manual run (monitor mode only)
l Global Search and Replace (monitor mode only)

Monitor
Acknowledgment

(monitor mode only)

l Add
l Edit
l Delete

Template

(templatemode only)

l Create
l Delete
l Copy/Cut/Paste
l Deploy
l Publish changes
l Import through user interface or by putting files in the <SiteScope root
directory>\persistency\import folder

l Update contained entities
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Entity Action

Template Variable

(templatemode only)

l Create
l Update
l Delete
l Copy/Cut/Paste

Template Container

(templatemode only)

l Create
l Update
l Delete
l Copy/Cut/Paste

Alert

(monitor/template
mode)

l Create
l Update
l Delete
l Copy/Cut/Paste
l Enable/Disable (monitor mode only)
l Global Search and Replace (monitor mode only)

Alert Action

(monitor/template
mode)

l Create
l Update
l Delete
l Copy
l Global Search and Replace (monitor mode only)

Report

(monitor mode only)

l Create
l Update
l Delete
l Copy
l Global Search and Replace

Remote Server

(remote
servers/template
mode)

l Create
l Update
l Delete
l Copy/Cut/Paste

Actions Recorded for SiteScope Preferences
This table lists the actions performed on SiteScope preferences that are entered in the audit log:

Preference Action

General Preferences Update
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Preference Action

Infrastructure Preferences Update

Log Preferences Update

Email/Pager/SNMP/Common Events Mapping (default) Update

Email/Pager/SNMP/Common Events Mapping (instance) l Create
l Update
l Delete

Schedule Preferences l Create
l Update
l Delete

User Management Preferences l Create
l Update
l Delete

Credential Preferences l Create
l Update
l Delete

Search/Filter Tags l Create
l Update
l Delete

Certificate Management l Create
l Delete

Actions Recorded for Other SiteScope Operations Entered in the Audit Log
This table lists other SiteScope operations that are recorded in the audit log:

Other Action

Downtime l Add
l Update
l Delete

Health Logging l Enable
l Disable

APM Integration l Register
l Unregister
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Other Action

Authentication l Login
l Logout

Licensing l Import
l Remove

External files Import

Tasks

How to Configure the Audit Log
This task describes the steps involved in configuring themaximum size of the audit log.

1. Open the log4j.properties file located in the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\ directory.

2. SetMaxFileSize to themaximum number of lines in the log.
3. SetMaxBackupIndex to themaximum number of backup audit logs to be kept before the oldest audit log

is deleted.

Example: IfMaxBackupIndex is 5, nomore than 5 backup audit logs are kept. If 5 backup log files
exist, then after the current audit.log file reaches MaxFileSize size, audit.log.5 is deleted,
audit.log.4 is renamed to audit.log.5, audit.log.3 to audit.log.4 and so forth. The current
audit.log is renamed audit.log.1 and a new audit.log is created.

Tips/Troubleshooting

General Notes/Limitations
l Audit log entries can be created only in English. This means that audit log entries are also displayed only in
English, regardless of what language you use to view SiteScope.

l When template changes are published to SiteScope objects, the audit log shows which objects were
updated, but it does not show the before and after values.

l Downtime changes are logged in the audit log without the before and after values.
l There is no enhanced auditing when configuration changes aremade through SOAP methods.

Monitor Specific Log Column Content
After the first six columns of each log entry, the content of each columnmay vary according to themonitor
type. The following tables display the data written to themonitor results log for the indicatedmonitor types.
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ApacheMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 Counter 1 Value

8 Counter 2 Value

9 Counter 3 Value

10 Counter 4 Value

11 Counter 5 Value

12 Counter 6 Value

13 Counter 7 Value

14 Counter 8 Value

15 Counter 9 Value

16 Counter 10 Value

17 Counter 11 Value

18 Counter 12 Value

19 Counter 13 Value

20 Counter 14 Value

21 Counter 15 Value

22 Counter 16 Value

23 Counter 17 Value

24 Counter 18 Value

25 Counter 19 Value

26 Counter 20 Value
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ASP Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

BroadVision Application Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

BrowsableWindows Performance Counters Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error
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Check Point Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 Counter 1 Value

8 Counter 2 Value

9 Counter 3 Value

10 Counter 4 Value

11 Counter 5 Value

12 Counter 6 Value

13 Counter 7 Value

14 Counter 8 Value

CiscoWorks Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

Citrix Monitor

Column Data in Column

1 data

2 category
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Column Data in Column

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

ColdFusion Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

Composite Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

8 % items in error

9 % items in warning

10 items in error

11 items in warning

12 items ok

13 items checked
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CPU Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 utilization

8 utilization cpu # 1

9 utilization cpu # 2

Note: The number of individual CPU utilization counters (utilization cpu # 1, utilization cpu # 2, and so
forth) may vary depending on the environment and themonitor settings.

Database Counter Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

DatabaseQuery Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString
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Column Data in Column

6 _ id

7 status

8 round trip time

9 result column 1

10 result column 2

11 rows

12 content match

DB2 JDBC Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

Directory Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 number of files

8 total of file sizes

9 directory exists

10 access permitted
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Column Data in Column

11 time sincemodified

Disk SpaceMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

8 MB free

DNS Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

9 statusText

e-Business TransactionMonitor

Column Data in Column

1 data

2 category

3 ownerID
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Column Data in Column

4 Title

5 stateString

6 _id

7 % items ok

8 % items in error

9 % items in warning

10 items in error

11 items in warning

12 items ok

13 items checked

F5 Big-IP Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

File Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 size
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Column Data in Column

8 file age

9 content match

Formula Composite Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 Result

8 status

FTP Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

9 size

Health of SiteScopeMonitor

Column Data in Column

1 data

2 category
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Column Data in Column

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

IPMI Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

LDAP Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

Link Check TransactionMonitor

Column Data in Column

1 data
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Column Data in Column

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 link errors

8 total links

9 total graphics

10 average

Log Event Health Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 .*skipped #1.*

8 .*skipped #2.*

9 .*skipped #3.*

10 .*skipped #4.*

11 .*skipped #5.*

12 .*SiteScope shutting down.*

13 .*Reached the limit of processes in the process pool.*

14 .*Error. data reporter failed to report chunk of data.*

15 .*Error. config reporter failed to report chunk of data.*

16 .*Error. Topaz failed to process data.*
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Column Data in Column

17 .*Error. CacheSender. Got to themax number of cached files.*

18 .*Error. CacheSender. Got to themax old dir size.*

19 .*Topaz SEVERE.*

20 .*Commit verification failed.*

21 .*target not found in LDAP.*

22 Counter 16 Value

23 Counter 17 Value

24 Counter 18 Value

25 Counter 19 Value

26 Counter 20 Value

Log File Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 matches/min

8 lines/min

Mail Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id
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Column Data in Column

7 round trip time

8 status

9 content match

10 Send time

11 Receive time

MAPI Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 Round Trip

Memory Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 percent used

8 MB free

9 pages/sec

10 virtual memory used%

11 virtual memory MB free

12 physical memory used%
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Column Data in Column

13 physical memory MB free

Microsoft IIS Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

Microsoft SQL Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

Microsoft Window Dial-UpMonitor (Deprecated)

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 total time

8 % monitors good
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Column Data in Column

9 monitorCount

10 monitorErrorCount

11 monitorWarningCount

12 time to connect

13 time to authorize

Microsoft Windows Event LogMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 match count

8 records examined

9 matches in interval

Microsoft Windows Media Player Monitor (Deprecated)

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 Counter 1 Value

8 Counter 2 Value

9 Counter 3 Value

10 Counter 4 Value
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Column Data in Column

11 Counter 5 Value

12 Counter 6 Value

13 Counter 7 Value

14 Counter 8 Value

15 Counter 9 Value

16 Counter 10 Value

17 Counter 11 Value

18 Counter 12 Value

19 Counter 13 Value

20 Counter 14 Value

21 Counter 15 Value

22 Counter 16 Value

23 Counter 17 Value

24 Counter 18 Value

25 Counter 19 Value

26 Counter 20 Value

Microsoft Windows Media Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

Microsoft Window Performance Counter Monitor

Column Data in Column

1 data

2 category
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Column Data in Column

3 ownerID

4 Title

5 stateString

6 _id

7 Counter 1 Value

8 Counter 1 Percent Derivation

9 measurement0

10 lastMeasurement0

11 Counter 2 Value

12 Counter 2 Percent Derivation

13 measurement1

14 lastMeasurement1

15 Counter 3 Value

16 Counter 3 Percent Derivation

17 measurement2

18 lastMeasurement2

19 countersInError

Microsoft Windows Resources Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error
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Microsoft Windows Services StateMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 Number of Services Currently Not Running

8 Number of Services Currently Running

9 Number Changed to Running

10 Number Changed to Not Running

11 Number of Services Added

12 Number of Services Deleted

13 Services Changed to Not Running

14 Services Changed to Running

15 Services Added

16 Services Deleted

Network BandwidthMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error
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News Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

9 number of articles

Oracle 9i Application Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 Counter 1 Value

8 Counter 2 Value

9 Counter 3 Value

10 Counter 4 Value

11 Counter 5 Value

12 Counter 6 Value

13 Counter 7 Value

14 Counter 8 Value

15 Counter 9 Value

16 Counter 10 Value
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Column Data in Column

17 Counter 11 Value

18 Counter 12 Value

19 Counter 13 Value

20 Counter 14 Value

21 Counter 15 Value

22 Counter 16 Value

23 Counter 17 Value

24 Counter 18 Value

25 Counter 19 Value

26 Counter 20 Value

Oracle DatabaseMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

PingMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status
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Column Data in Column

8 round trip time

9 % packets good

Port Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

Radius Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

Real Media Player Monitor (Deprecated)

Column Data in Column

1 data

2 category

3 ownerID
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Column Data in Column

4 Title

5 stateString

6 _id

7 Counter 1 Value

8 Counter 2 Value

9 Counter 3 Value

10 Counter 4 Value

11 Counter 5 Value

12 Counter 6 Value

13 Counter 7 Value

14 Counter 8 Value

15 Counter 9 Value

16 Counter 10 Value

17 Counter 11 Value

18 Counter 12 Value

19 Counter 13 Value

20 Counter 14 Value

21 Counter 15 Value

22 Counter 16 Value

23 Counter 17 Value

24 Counter 18 Value

25 Counter 19 Value

26 Counter 20 Value

Real Media Server Monitor

Column Data in Column

1 data

2 category
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Column Data in Column

3 ownerID

4 Title

5 stateString

6 _ id

SAP PerformanceMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

Script Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 round trip time

ServiceMonitor

Column Data in Column

1 data

2 category
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Column Data in Column

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 processes

9 cpu

10 memory

SNMP Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 status

8 value

SNMP TrapMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 matches/min

8 matches/min
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Column Data in Column

9 value

10 value2

11 value3

12 value4

SNMP by MIB Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

SunONEWeb Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

SybaseMonitor

Column Data in Column

1 data

2 category

3 ownerID
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Column Data in Column

4 Title

5 stateString

6 _ id

7 counters in error

TUXEDOMonitor (Deprecated)

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

UNIX Resources Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error

URL Content Monitor

Column Data in Column

1 data

2 category

3 ownerID
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Column Data in Column

4 Title

5 stateString

6 _id

7 status

8 round trip time

9 statusText

10 size

11 age

12 dns time

13 response time

14 download time

15 connect time

16 content match

17 matchValue2

18 matchValue3

19 matchValue4

20 matchValue5

21 matchValue6

22 matchValue7

23 matchValue8

24 matchValue9

25 matchValue10

URL List Monitor

Column Data in Column

1 data

2 category

3 ownerID
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Column Data in Column

4 Title

5 stateString

6 _id

7 duration

8 errors

9 good

10 left

URL Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 status

8 round trip time

9 statusText

10 size

11 age

12 content match

13 dns time

14 response time

15 download time

16 connect time

17 overall status

18 total errors
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URL SequenceMonitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 status

8 round trip time

9 statusText

10 step 1 connect time

11 step 1 dns time

12 step 1 download time

13 step 1 response time

14 step 1 roundtrip time

15 step 2 connect time

16 step 2 dns time

17 step 2 download time

18 step 2 response time

19 step 2 roundtrip time

Note: The number of URL Sequence step parameters (step 1 *** time, step 2 *** time, and so forth) may
vary depending on the environment and themonitor settings.

WebLogic Application Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title
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Column Data in Column

5 stateString

6 _id

7 counters in error

Web Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 hits

8 bytes transferred

9 hits/min

10 bytes/min

WebSphere Application Server Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 counters in error

WebSphere Performance Servlet Monitor

Column Data in Column

1 data
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Column Data in Column

2 category

3 ownerID

4 Title

5 stateString

6 _id

7 counters in error

XMLMetrics Monitor

Column Data in Column

1 data

2 category

3 ownerID

4 Title

5 stateString

6 _ id

7 counters in error
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Chapter 102: SiteScope Health Map and
Performance Statistics Logs
You can view SiteScope server load and performance statistics by accessing the SiteScope Health Map and
Performance Statistics Logs. This provides access to SiteScope load and performance statistics directly
from log files without having to open the SiteScope user interface.

Tip: You can also view this information using the "SiteScope Server Health Monitors" on page 989 or
from the "SiteScope Server Statistics" on page 1011 context.

To access
Navigate to the <SiteScope_root_path>\logs directory, and open the health_map.log or perf_
statistics.csv file.

Note: The health_map.log is also available from the Log Files page in the Server Statistics context. For
details, see "Log Files Page" on page 1018.

Learn About
Health Map and Performance Statistics Logs Overview
You can use the following log files to get a summary of SiteScope server performance:

l health_map.log. Provides an overview of SiteScope server load statistics for the following performance
metrics: number of runningmonitors, number of waitingmonitors (monitor queue size), monitor average
run time (per monitor type), and number of currently open SSH connections. It provides an aggregate of
performance statistics over different time periods (for example, monitor run average time over the last
hour). You can check the samemetrics over different time frames by shifting the time between
performancemetrics.

l perf_statistics.csv. Enables you to generate a report that represents SiteScope performance over time.
The report includes the following performancemetrics: timestamp, number of runningmonitors, number of
waitingmonitors (monitors queue size), monitor average run time (per monitor type), and number of
currently open SSH connections. This log is in CSV format; therefore it can be converted into a graph that
enables you to compare SiteScope performance statistics over time (see the task that follows). You can
change the log reporting frequency in the <SiteScope root directory>\groups\master.config file.

Tasks
How to Get a Status Summary of SiteScope Performance Using a Log File
This task describes the steps involved in getting an overview of SiteScope server load and performance
statistics without opening the SiteScope user interface.

1. Navigate to the <SiteScope root directory>\conf\core\Tools\log4j\PlainJava directory and open the
log4j.properties file.
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2. Search for theHealthMapLogger definition, and change the log level to DEBUG.
After the log level is changed, the health map is updated every 60 seconds with SiteScope server load
data in the following format:

[MONITOR COUNT] [MIN AVG] [MIN MAX] [HOUR AVG] [HOUR MAX] [DAY AVG] [DAY MAX]
[# RUNNING]
[# WAITING]
[# SSH CONNECTIONS]
[RUN AVG TYPE 1]
…
[RUN AVG TYPE N]

The log reporting frequency value for health map is hard-coded and cannot be changed.
3. View SiteScope server performance data in the log file.

Example of health_map.log

Note: Monitor runtime average units aremilliseconds.

For more information on log files, see "Log Files Page" on page 1018.

How to Generate a Report Representing SiteScope Performance Over Time Using
a Log File
This task describes the steps involved in getting an overview of SiteScope server load and performance
statistics without opening the SiteScope user interface.

1. Navigate to the <SiteScope root directory>\conf\core\Tools\log4j\PlainJava directory and open the
log4j.properties file.

2. Search for thePerformanceStatisticsLogger definition, and change the log level to DEBUG.
After the log level is changed, the current performance statistics are updated every 60 seconds with
SiteScope server load data in the following format:

[TIMESTAMP],[#RUNNING MONITORS],[#WAITING MONITORS],[# SSH CONNECTIONS],[RUN AVG TYPE 1],…,[RUN
AVG TYPE N]

You can change the log reporting frequency by modifying the _statisticsReportFrequencyMillis
property value in the <SiteScope root directory>\groups\master.config file.

Note: The _statisticsReportFrequencyMillis property affects the report frequency of all statistics
loggers (monitor statistics, pool statistics, andmemory statistics).
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3. View SiteScope server performance data in the log file.

Example of perf_statistics.csv

4. Convert the log data into a graph (optional)
You can open the .csv file in Excel and convert the log file data into a graph. This enables you to compare
SiteScope performance statistics over time.

Example of performance statistics log converted into a graph
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Part 13: Alerts
SiteScope can be configured to send alerts to notify key personnel and have SiteScope initiate corrective
actions whenever it detects a problem in the IT infrastructure. For details on SiteScope alerts, see "Configure
SiteScope Alerts" on page 1072.

You can alter the content and format of alert messages by customizing SiteScope alert templates. You can
also customize alert templates tag styles if you have a parser that needs a specific delimiter or to change the
bracket delimiters used to identify variables. For details, see "Customize Alert Templates" on page 1117.

You customize the alert templates by adding or removing text, by adding property variables (as listed in the
"Properties Available in Alerts, Templates, and Events" on page 1126), or changing the order of text or
property variables that are included in the template.

There are several types of alert actions, such as sending email messages or SNMP traps. SiteScope can also
be configured to automatically run recovery scripts or batch files when an error or warning status is detected.
This is normally done by creating a Script Alert that acts as a trigger for the script. For details about writing
scripts for script alerts, see "Write Scripts for Script Alerts" on page 1122.



Chapter 103: Configure SiteScope Alerts
SiteScope alerts are notification actions that are triggered when the conditions for the alert definition are
detected. You use an alert to send notification of an event or change of status in an infrastructure element or
system. For example, an alert can be triggered when a SiteScopemonitor detects a change from Good to
Error indicating that themonitored system has stopped responding.

Alerts are also used with Preventative Analytics to send notification when a business monitor has crossed the
baseline threshold. For details, see "Configure Predictive Analytics" on page 1188.

Note: You can also use the SiteScope API when working with alerts. For details, see "SOAP-based
APIs" on page 139.

To access
Select theMonitors context. In themonitor tree, right-click the SiteScope object for which you want to
generate an alert, and select New > Alert.

Learn About
SiteScope Alerts Overview
An alert definition contains settings that tell SiteScope what monitors can trigger the alert, what condition to
watch for, what information to send, and who should be the recipients of the alert. For example, you can
create an alert that includes instructions for SiteScope to send the specific server address and error code to
your pager or email when an error condition is detected on a particular system. You can also have SiteScope
respond to problems by automatically initiating recovery or action scripts with Script Alert. For example, you
can configure a Script Alert to run a script to restart a server if a monitor detects that a system is no longer
responding and CPU utilization has reached 100%. For details on the alert types, see "Action Type Dialog
Box" on page 1099.

SiteScope alerts can be configured in several ways. Alerts can be associated with one or more individual
monitors, with one or more groups of monitors, a combination of monitors and groups, or globally for all
monitors and groups. Global and group-wide alerting is generally themost efficient but may not provide the
needed control.

Alert Actions
When you create an alert scheme in SiteScope, you create alert actions to be triggered when the alert
conditions aremet. You create alert actions using the Alert Action dialog box. While in the dialog box, you
determine the following:

l The type of alert action. For a detailed list of available alert actions, see "Action Type Dialog Box" on
page 1099.

l The settings for the type of alert being sent. For example, you can define the recipients and their
addresses for an email alert action.

l The status condition that triggers the alert. For example, you can instruct SiteScope to trigger an alert
action when amonitor's status changes to error or unavailable.
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l The trigger settings that determine when the alert is triggered and when it is sent. For details, see
"UnderstandWhen SiteScope Alerts Are Sent" on page 1078.

You can createmultiple alert actions for an alert scheme.

l Multiple methods of delivery. You can create an alert action to send a sound alert and another alert
action to send an email alert. Both are sent when the alert is triggered.

l Schedule-dependent delivery. You can also set different schedules for the different actions within the
same alert definition. For example, you can schedule an email alert action to be sent during regular working
hours and an SMS alert action for evening and night hours. Both are triggered by the same change in
condition but are sent at different times, depending on when the alert is triggered.

l Action dependencies. You can alsomake one alert action dependent on another alert action. This
enables you to instruct SiteScope to send one type of alert when the trigger condition is first met and send
another type of alert only when the first type of alert has been sent a number of times.

You can copy an alert action into other monitors or groups for use by other alerts. To use alert actions for other
alerts, youmust copy the alert and paste it into another monitor or group. All the alert actions for the alert are
copied into the new alert. You can then edit the alert to be triggered for the new target monitor or group.

For details on working with different alert types, see "Action Type Dialog Box" on page 1099.

Alert Filters
You can use the Filter Settings function on each alert definition page to create filter criteria to control global
and group alerts to more specific criteria. Filter criteria can be used to restrict the alert to only monitors of a
certain type, that contain a certain text string, tag, or other filter criteria. For example, creating a global alert
with a filter criteria for CPU Monitor creates an alert that is triggered only for the CPU monitor type. You can
also control individual monitor alerts using tags. For example, you can create an individual monitor alert with a
filter criteria for selected tags that is triggered only if themonitor contains one of these tags. If you set up a
global or root alert and assign tags to it, and assign the same tags to a group, an alert is not triggered for this
group of monitors if none of themonitors in the group contain the same tags as in the alert.

Alert Types
When you create an alert scheme in SiteScope, you create alert actions to be triggered when the alert
conditions aremet. You create alert actions using the Alert Action dialog box. SiteScope includes the
following alert types:

l "Disable or EnableMonitors Alert Properties" on page 1104
l "Email Alert Properties" on page 1104
l "Event Console Alert Properties" on page 1106
l "Log Event Alert Properties" on page 1106
l "Post Alert Properties" on page 1108
l Rest Alert Properties
l "Script Alert Properties" on page 1109
l "SNMP Trap Alert Properties" on page 1112
l "Sound Alert Properties" on page 1113
l "Trigger Properties" on page 1114

Alert Associations and Considerations
The table below displays an overview of the different alert associations and considerations.
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Alert
Class Description

Global
Alerts

Alerts that are triggered when any monitor on a given SiteScope reports the category status
defined for the alert.

New groups andmonitors added after the alert definition is created are automatically
associated with the alert.

The following display is an example of a global alert associated with the SiteScope node. All
monitors can trigger this alert.

Note: We do not recommend creating a global alert because the alert can potentially be
triggered by every group andmonitor within SiteScope.
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Alert
Class Description

Group
Alerts

Alerts that are triggered when any monitor within the associated group or groups reports the
category status defined for the alert.

The following is an example of a group alert. Any monitor or subgroup within the group
WebServers can trigger this alert.

A icon displayed to the left of a group in the Alert Targets panel indicates that all monitors
and subgroups contained within that group have been selected. New subgroups andmonitors
added within the associated group or groups after the alert definition is created are
automatically associated with the alert ("all selected" status).

A icon displayed to the left of a group indicates that not all monitors and subgroups contained
within that group have been selected ("partially selected" status). If you remove amonitor from
Alert targets defined for a group that is in the "all selected" status, the group changes to the
"partially selected" status, and any monitors that you subsequently add to the group are not
automatically associated with the alert. If you delete all monitors from the group that are not
associated with the alert, the group automatically reverts to the "all selected" status and
behaves accordingly (see previous paragraph).
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Alert
Class Description

Individual
Monitor
Alerts

Alerts that are triggered when an associatedmonitor reports the category status defined for the
alert.

The following is an example of an individual monitor alert. Only the associatedmonitor can
trigger this alert.

New monitors added after the alert definition is created are not automatically associated with
the alert but can be added by editing the alert definition.

Tip:While you can create as many SiteScope alert definitions as required, you should plan and
consolidate alerts to keep the number of alert definitions to aminimum. This facilitates alert
administration and helps reduce redundant alert messages or actions.

Tasks
How to Configure an Alert
This task describes the steps involved in configuring an alert definition.

1. Prerequisites
Only a SiteScope administrator user, or a user granted the appropriate alerts permissions can view,
create, or edit alerts. For details on user permissions, see "Permissions" on page 636.

2. Create an alert
You can create a new alert or copy an existing alert into any group or monitor container in the SiteScope
tree.
l Create a new alert. Right-click the container to which you want to associate the alert, and select
New > Alert. Enter a name for the alert, select the targets to trigger the alert, and configure an alert
action (in theAlert Actions panel, click New Alert Action to start the Alert Action wizard). For each
alert scheme, you can create one or more alert actions. For user interface details, see "New/Edit Alert
Dialog Box" on page 1092.

l Copy an Alert Definition. In the Alerts tab, select the alert you want to copy, and paste it into the
desired group or monitor container. The alert target automatically changes to the group or monitor into
which the alert is copied.

Note: The option to create alerts using the Pager or SMS action type is no longer available, and
we plan to remove support for these alert action types in the next version of SiteScope.
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Caution: If you copy an alert definition from one group container to another, theAlert targets for
the pasted alert are automatically reset to include all of the children of the container into which the
alert is pasted. After pasting an alert, edit the alert definition properties to be sure that the
assignedAlert targets are appropriate to the new alert context and your overall alerting plan.

3. Test the alert
Select the alert in the Alerts tab of themonitor tree and click Test. Select themonitor instance you want
to test and click OK. A dialog box opens with information about the alert test.

Note: Themonitor you select does not have to be reporting the same status category that is
selected to trigger the alert to test the alert. For example, themonitor does not have to currently be
reporting an error to test an alert that is triggered by error conditions.

4. Customize an alert's message content and template tag style
You can customize SiteScope alert templates to alter the content and format of alert messages. For
details, see "How to Customize an Alert's Message Content" on page 1118.
You can also customize SiteScope alert templates tag styles if you have a parser that needs a specific
delimiter or to change the bracket delimiters used to identify variables. For details, see "How to
Customize Alert Template Tag Styles" on page 1120.

5. Results

An alert is added to the specified container in themonitor tree (indicated by the icon). The alerts icon
is also displayed in SiteScope Dashboard next to each group or monitor that has one or more configured
alerts.

Example:

6. Disable an alert - optional
You can disable alerts from theAlerts tab. Select the alerts that you want to disable, and click the
Disable button. Alerts disabled from the Alerts tab cannot be triggered; this overrides the associated
alerts status set for amonitor in themonitor Properties tab or Dashboard.

Note: For details on disabling alerts associated with specific groups andmonitors (not the alerts
themselves), see "Set upmonitor alerts - optional" on page 228.

Tips/Troubleshooting
Tips for Reducing False Alerts Resulting from Network Connectivity Issues
l Alerting strategy: Make sure you are using themost appropriate trigger frequency for the system being
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monitored. This enables you to control when alerts are sent in relation to when a given condition is
detected. For details, see "UnderstandWhen SiteScope Alerts Are Sent" below.

l Protect against false alarms. Create dependencies to prevent redundant alerting frommultiple monitors
that aremonitoring different aspects of a single system (for example, making dependency on a dedicated
network health monitor such as Ping). For details, see "Monitoring Group Dependencies" on page 221.

l Adjust the timeout values according to the specific connectionmethod used for gathering data from the
remote servers (SSH, WMI, NetBIOS and so forth) and according to the specific monitor types used.

Exporting Alert Configurations to a Report
You can export alert configurations to an Excel file in order to analyze it (to understand whichmonitors have
alerts and which do not).

To export the Alerts table content to Excel:

1. Select all rows in the Alerts table.
2. Press CTRL + C.
3. Paste to an Excel file.

Note:While most of the column values appear as string values as in the user interface, somemay
contain internal IDs.

Understand When SiteScope Alerts Are Sent
SiteScope triggers the alert as soon as any monitor it is associated with matches the alert trigger condition.
The trigger settings options in the Alert Action dialog box enable you to control when alerts are sent in relation
to when a given condition is detected. For example, you can choose to have SiteScope send an alert only
after an error condition persists for a specific interval corresponding to a given number of monitor runs. This is
useful for monitors that run frequently that monitor dynamic, frequently changing environment parameters. In
some cases, a single error conditionmay not warrant any intervention. For details about configuring trigger
settings, see "Trigger Frequency Panel" on page 1115.

The following examples illustrate how different alert configurations send alerts after the error condition has
persisted for more than onemonitor run. It is important to note that the sample interval corresponds to how
often themonitor is run. If a monitor runs every 15 seconds and the alert is set to be sent after the third error
reading, the alert is sent 30 seconds after the error was detected. If themonitor run interval is once every hour
with the same alert setup, the alert is not sent until 2 hours later.

Example 1 - Always, after the condition has occurred at least N times:

Example 1a. An alert is sent for each timemonitor is in error after condition persists for at least three
monitor runs. Compare this with Example 1b below.

Alert setup Always, after the condition has occurred at least 3 times

sample interval 0 1 2 3 4 5 6 7 8

status
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Alert setup Always, after the condition has occurred at least 3 times

count c=0 c=1 c=2 c=3
alert!

c=4
alert!

c=5
alert!

c=0 c=1 c=2

Example 1b. An alert is sent for each timemonitor is in error after condition persists for at least three
monitor runs. Shows how the count is reset when themonitor returns one non-error reading between
consecutive error readings. Compare this with Example 1a above.

Alert setup Always, after the condition has occurred at least 3 times

sample interval 0 1 2 3 4 5 6 7 8

status

count c=0 c=1 c=2 c=0 c=1 c=2 c=3
alert!

c=0 c=0

Example 2 - Once, after the condition has occurred exactly N times:

An alert is sent only once if monitor is in error for at least threemonitor runs, regardless of how long the
error is returned thereafter.

Alert setup Once, after the condition has occurred exactly 3 times

sample interval 0 1 2 3 4 5 6 7 8

status

count c=0 c=1 c=2 c=3
alert!

c=4 c=5 c=6 c=7 c=8

Example 3 - Initially, after X times, and repeat every Y times:

Example 3a. An alert is sent on the fifth timemonitor is in error and for every third consecutive error
reading thereafter. Compare this with Example 3b below.

Alert setup Initially, after 5 times, and repeat every 3 times

sample interval 0 1 2 3 4 5 6 7 8

status

count c=0 c=1 c=2 c=3 c=4 c=5
alert!

c=6 c=7 c=8
alert!

Example 3b. An alert is sent on the third timemonitor is in error and for every fifth consecutive error
reading thereafter. Compare this with Example 3a above.
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Alert setup Initially, after 3 times, and repeat every 5 times

sample interval 0 1 2 3 4 5 6 7 8

status

count c=0 c=1 c=2 c=3
alert!

c=4 c=5 c=6 c=7 c=8
alert!

Example 4 - Configuring Multiple Alerts:

Because you can createmultiple alerts and associate more than one alert to amonitor, you can tell
SiteScope to takemore than one action for a given situation. For example, you can create one alert that
tells SiteScope to page you whenever any monitor returns an error status. You can then create another
alert that tells SiteScope to run a script file to delete files in the /tmp directory on your server if your Disk
SpaceMonitor returns an error. If your disk becomes too full, SiteScope would page you because of the
first alert definition and would run the script to delete files in the /tmp directory because of the second alert
definition.

SiteScope alerts are generated when there is a change in state for amonitor reading. Thus you can set an
alert for OK or warning conditions as well as error conditions. One way to take advantage of this is to add
two alerts, one alert on error, and one alert on OK. Set alerts to be sent after the condition is detected 3
time. For the OK alert, check the box markedOnly alert if monitor was previously in error at least 3
times. This prevents unmatched OK alerts, such as when amonitor was disabled for any reason
(manually, by schedule, or by depends on) and then starts up again. This can also be used so that an OK
alert is only sent after a corresponding error alert was sent. With these two alerts, you get a page when a
link or service goes down (monitor detects change from OK to error), and another when it comes back up
(monitor detecting change from error to OK).

The following is an example of using two alerts with amonitor. An Alert on error sent once for error
after condition persists for at least threemonitor runs. Alert on OK sent once for good status after at
least one error or warning interval.

Alert on Error Setup
On
Error Once, after the condition has occurred exactly 3 times

Alert on OK Setup On
OK

Once, after the condition has occurred exactly 1 times and
Only alert if monitor was previously in error at least 3 times

Sample Interval 0 1 2 3 4 5 6 7 8

Status

Count c=0 c=1 c=2 c=3
alert!

c=4 c=5 c=6 c=7 c=1
alert!

After themonitor's status changes, the relevant status count is reset to zero.

Database Alerts
Database alerts can forward system fault data and other status information to any SQL-compliant database.
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The following diagram illustrates the Database alert:

You need the following to be able to use the Database alert type:

l Access to a SQL compliant database.
l The applicable database connection URLwhich the SiteScope server uses to connect to the database.For
examples of common database connection URLs, see the "Setup Requirements and User Permissions"
section for the relevant databasemonitor.

l Installation of the applicable databasemiddleware driver that the SiteScope application uses to
communicate with the database on the SiteScope server. For examples of common database driver
strings, see the "Setup Requirements and User Permissions" section for the relevant databasemonitor.

l Database tables that have been created and structured tomatch the corresponding SQL statement that
SiteScope uses to enter the alert into the database.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Disable or Enable Monitor Alerts
Disable or EnableMonitor alerts can turn off and turn on the triggering of alerts for monitors. This is useful for
times when server maintenance or other activities are being performed that would logically result in errors for
somemonitors and cause unnecessary alerts to be generated.

The following diagram illustrates an example of this alert type used to disable several monitors based on the
condition reported to onemonitor.
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This alert type provides a functionality similar to theDepends on function for building group dependencies
betweenmonitors andmonitor groups. One important difference is that monitors disabled by this type of alert
are not automatically re-enabled when the status of the subject monitor or group changes back to the original
state. You can create one alert with anAlert Category of Error that disables monitors. You can then create a
second alert with anAlert Category of Good that enables the samemonitors.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Email Alerts
Email alerts send event notifications from SiteScope to a designated email address as seen in the following
diagram.

You need the following to be able to use the Email alert type:

l Access to an active email server
l One ormore email accounts that can receive the email alerts
l SiteScope Email Preferences set to work with the external email server
For more information on configuring SiteScope email recipients, see "Email Preferences" on page 482.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.
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Note: Email alerts are in plain text format. To receive email alerts with a line break between eachmonitor
listed in the alert, youmust configureMicrosoft Outlook not to remove line breaks.

Event Console Alerts
Event Console alerts are used to send event notification to an event console. This enables you to view and
manage all SiteScope events from a centralized location; SiteScope Dashboard, Multi-View, or from a
standalone Event Console.

For more information on configuring SiteScope to use Event Console alerts, see "Event Console Alert
Properties" on page 1106.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Log Event Alerts
Log Event alerts can be used to extend the types of events that are logged to aWindows Application Event
Log. This provides a way to forward event data to log query systems that may not normally be logged by the
Windows operating system.

The following diagram illustrates the Log Event alert:

You need the following to be able to use the Log Event alert type:

l Access to theWindows Event Log service. By default, this is the Event Log on themachine where
SiteScope is running. The alert definition can be configured to send log events to another server.

l SiteScope running on aMicrosoft Windows platform.

Caution: If you are using SiteScope's Microsoft Windows Event LogMonitor, youmust use care when
using the Log Event alert type because it is possible create an endless loop condition that can fill your
Event log file. This can happen when aMicrosoft Windows Event LogMonitor detects an event that
triggers a Log Event alert, which in turn puts an new event into the event log, which the Event LogMonitor
then detects, and then triggers the Log Event alert, and so forth. To avoid this, Log Event alert types
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should not be associated with Microsoft Windows Event LogMonitors.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Pager Alerts (Deprecated)
Note: This alert action type is no longer available, and HPE plans to remove support for it in the next
version of SiteScope. For backward compatibility, this alert action type can be enabled by adding the
property _enableDeprecatedAlertActions=pager to the <SiteScope root
directory>\groups\master.config file. The value is not case-sensitive, and should be separated by a
comma if other values are listed.

Pager alerts can be used to send event notification to electronic pagers. This is particularly useful when
access to email may not be available. Depending on the type of pager you use and the capabilities of the
pager service, you can configure the Pager Alert to send a pager message with an abbreviated description of
the problem or detected condition.

The following diagram illustrates the Pager alert:

You need the following to be able to use the Pager alert type:

l Access to an active pager service
l A modem which the SiteScope server can use to connect to the pager service
l One ormore pagers that can receive the pager alerts
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Post Alerts
Post alert use the CommonGateway Interface protocol to forward POST data to a CGI enabled program. This
can be used to forward event data to CGI script on another server that is a front-end for a trouble ticket system
or reporting database. This alert type also provides a way of sending alert information through a firewall using
HTTP or HTTPS without having tomake other security changes.
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The following diagram illustrates the Post alert:

You need the following to be able to use the Post alert type:

l HTTP access between the SiteScope server and the server running the CGI script or server.
l Format and syntax of the CGI POST request to the applicable CGI script or server.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Script Alerts
Script alerts can automatically initiate recovery scripts. You can configure a Script alert to run a command to
restart a server or a service.

Themost important components of Script Alerts are:

l The script definition itself.
l Themonitor or monitors that are assigned to trigger the alert.
l The script to be run by the alert.
The alert message template and resulting alert message file may also need to be considered depending what
the script needs to do. You can use a script template, together with theParameters setting to pass data to
your script.

The following diagram illustrates the general concept of the script alert for both a local script and a script on a
remote host.
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The script alert definition or instance and themonitor or monitors that trigger the alert are handled as with other
alerts or monitors in SiteScope. For example, youmay create amonitor to watch aWeb server running on a
remote UNIX server. You can create a Script Alert associated with that monitor that runs a script to kill and
restart theWeb server process if themonitor reports an error.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

This section also includes:

l "Managing Script Files" below
l "Passing Data to a Script" on the next page
l "Running Different Types of Scripts" on the next page
l "Troubleshooting Scripts" on the next page

Managing Script Files
Creating the script file to be called or run by the Script Alert definition is another key step in using this
automation capability in SiteScope. The specific commands and actions taken by the script are up to you. The
script file should be written as a plain text file compatible with the operating system where the script is to be
run. This may be the same server where SiteScope is running or it may be on a remotemachine to which
SiteScope has access.

To run a script on themachine where SiteScope is running, the script file must be saved in the <SiteScope
root_directory>\scripts directory on the SiteScopemachine where the Script Alert is defined.

To run a script on a remotemachine, youmust save the script in a directory called \scripts in the home
directory tree for the user account that SiteScope has execute permissions for on the remotemachine.

The current execution directory when a script is run is <SiteScope root directory>\classes\ and not the
<SiteScope root directory>\scripts\ directory. For commands run by the script itself, the relative execution
directory is <SiteScope root directory>\classes\. Use full paths for any other file system commands or
programs called by your script so that you do not need to worry about the current directory. Also, the server
system environment variables may not have been set up for the script execution. This is another reason to
use full paths for executables called by the script. If a script works when you run it from the command line but
not from SiteScope, then youmust determine what the error is.
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Passing Data to a Script
SiteScope passes a number of parameters to the script as command line arguments. You can use this option
to pass data to a script that can be used tomodify a script's action. This adds versatility to the Script Alert. By
default, a SiteScope Script Alert passes seven command line arguments to a script. These are:

l The path of the scripts directory.
l The name of themonitor that caused the alert.
l The current status of themonitor.
l The path to the Alert Message File.
l The ID code of themonitor.
l The group themonitor is in.
l Any additional parameters specified on theParameters text box in the alert form.
Two of these default arguments enable the script to access evenmore data. One is the Alert Message File
and the other is theParameters text box. The Alert Message File is a temporary text file created by SiteScope
based on the alert template chosen for the Script Alert instance. Depending on the template you create or use,
the Alert Message File may contain custom information as well as data specific to themonitor that triggered
the alert. By passing the path to the Alert Message File to the script, you can have the script access this data.

You use the Parameters text box to specify individual monitor parameter data to be passed to the script. You
can includemultiple parameters by separating the parameters with spaces. This effectively enables you to
increase the total number of parameters passed to the script.

The path of the scripts directory can be useful in setting a execution path to another program as well as setting
a directory path for any output written by the script.

For more information and examples of passing parameters and data to scripts, see "Write Scripts for Script
Alerts" on page 1122.

Running Different Types of Scripts
You can run non-batch scripts, for example VBScript or Perl scripts, without wrapping them into a batch file.

l You can see scripts with any extensions by adding the _scriptMonitorExtensions property to the
<SiteScope root directory>\groups\master.config file. For example, to see .pl, .py, or .php scripts,
use the following format:
_scriptMonitorExtensions=.pl;.py;.php

l You can run script interpreters with script extensions by adding the _scriptInterpreters property to the
<SiteScope root directory>\groups\master.config file as follows: _
scriptInterpreters=pl=c:/perl/perl.exe;py=c:/python/python.exe;php=c:/php/
php.exe

Troubleshooting Scripts
This section describes troubleshooting and limitations when working with SiteScope scripts.

l The scripts are run with the permissions of the account used by the SiteScope service. Some scripts may
need extra permissions and youmust use the Services control panel to change the login account for
SiteScope and then stop and start SiteScope. For example, scripts that restart services or reboot remote
machines or scripts that copy protected files.

l Because the script is run by the SiteScope service, anything done as part of your login may not have
occurred in the script. For example, you cannot rely onmapped drives, environment variables, or other
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login script items. In addition, it cannot receive any interactive input from a keyboard or other input device.
Any script action or command that requires a user confirmation or input would cause the script to hang. Do
not include any interactive commands requiring a user action as part of the script. Also, opening aWIN32
application (for example, Notepad) also causes the script to hang because it is waiting for the user to exit
or close the application before continuing with the script execution.

l If there are quotationmarks in the Script Alerts status summary, SiteScope doubles the quotationmarks in
the Script Alert results. Take this into account when defining a content match filter.

Rest Alerts
Rest alert sends data to any application URL using the JSON or XML format. This alert sends notifications
from SiteScope to the application via the URL. To use the Rest alert type, youmust configure SiteScope with
the URL of any REST service.

SMS Alerts (Deprecated)
Note: This alert action type is no longer available, and HPE plans to remove support for it in the next
version of SiteScope. For backward compatibility, this alert action type can be enabled by adding the
property _enableDeprecatedAlertActions=SMS to the <SiteScope root
directory>\groups\master.config file. The value is not case-sensitive, and should be separated by a
comma if other values are listed.

SMS alerts are designed to transmit the name of the SiteScopemonitor that has reported an event condition
and the status of that monitor as the content of themessage. It is an alternative to the Pager alert for
communicating event notifications tomobile users without using email.

Note: At present, the SMS alert can only be sent from SiteScope by using the hardware specified in this
section. For alternative ways of sending SMS messages using SiteScope, see the HPE Software Self-
solve Knowledge Base (https://softwaresupport.hp.com/group/softwaresupport/search-result). To enter
the knowledge base, youmust log on with your HP Passport ID.
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The following diagram illustrates the SMS Alert:

You need the following to be able to use the SMS alert type:

l An available serial communications port on the SiteScopemachine that is sending the SMS alerts.
l A serial-to-wireless device interface cable, RS-232 Adapter Cable Nokia DLR-3P to connect the wireless
transmitting device to themachine where SiteScope is running.

l An SMS-enabled wireless device connected to the SiteScopemachine that is sending the alerts (that is,
the Nokia 6310 phone using the interface cable).

l The necessary software to enable the SMS Alert (normally included with SiteScope 7.6c1 and later).

Note: Make sure that you do not have Nokia Data Suite, Palm Hot Sync, or any PDA software running
on the server where SiteScope is running. These programs can bind the COM ports and prevent the
dialer from working correctly.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

SNMP Trap Alerts
SNMP Trap alerts forward event data from any type of SiteScopemonitor to an SNMP enabled host or
management system. This means that SiteScope can be used tomonitor and report events for applications
and systems that do not have their own SNMP agent. For example, this can be used to sendmeasurement
data from a SiteScopeMicrosoft Windows Performance Counter basedmonitor type or a URLmonitor in the
form of an SNMP trap.

The following diagram illustrates the SNMP Trap Alert.
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You need the following to be able to use the SNMP trap alert type:

l Access to the applicable SNMP network ports
l SiteScope SNMP Preferences set to work with the applicable SNMP management console
Encoding for outgoing SNMP Trap Alerts can be determined by configuring the _snmpTrapEncoding
parameter in the <SiteScope root directory>\groups\master config file.

For more information on configuring SiteScope to use SNMP alerts, see "SNMP Preferences" on page 618.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

Sound Alerts
Sound alerts play a sound or audio file on themachine on which SiteScope is running when an alert is
generated. The alert is effective only if the SiteScope server is in an area regularly occupied by support staff
and the server is equipped with a sound card capable of processing the associated sound file.

Alternatively, SiteScope can be configured to embed an alert audio file into theWeb pages served by
SiteScope. This audio file is included with any SiteScope page that includes an error status for any monitor,
such as themain pane or group detail pages. While this enables audio notification to all SiteScope clients
through the user interface, it is not a true SiteScope alert and thus does not enable the same configuration
options as the Sound Alert.

For details on how to configure SiteScope to play sounds through the browser to indicate when an event
occurs in the user interface, see the "How to Configure SiteScope to Play Sounds for User Interface Events
(Not for Monitor Status)" on page 1120.

For other information on sound alerts, refer to the HPE Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result). To enter the knowledge base, you
must log on using your HPE Passport ID.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.
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Trigger Alert
The Trigger alert triggers an alert without invoking any specific action. It should be used when you want the
alert to send event information to HPOM or BSM without performing any additional action. Note that Send
events in the HP Operations Manager Integration Settings panel of the alert must be selected.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1072.

SiteScope Alerts User Interface
This section includes:

l "SiteScope Alerts Page" below
l "New/Edit Alert Dialog Box" on the next page
l "Action Type Dialog Box" on page 1099
l "Alert Action Dialog Box" on page 1101
l "Action Type Settings Panel" on page 1102
l "Status Trigger Panel" on page 1114
l "Trigger Frequency Panel" on page 1115

SiteScope Alerts Page
This page displays information about the alerts associated with the selectedmonitor or group. It also includes
Analytics alerts configured when using Preventative Analytics (see "Configure Predictive Analytics" on
page 1188). Use this page to add, edit, or delete alert definitions.

To access In themonitor or template tree, select a group or monitor that has the alert symbol
displayed next to it. In the right pane, click theAlerts tab to display the alerts configured for
the object.

Important
information

l Alerts created for a specific monitor or group are displayed in the object's Alerts on
Monitor/Group list. Targetedmonitors or groups are displayed in theAlerts Associated
with Monitor/Group list.

l Each table column can be sorted in ascending or descending order by right-clicking the
column title. An up or down arrow indicates the sort order.

l You can also use the SiteScope API when working with alerts. For details, see "SOAP-
based APIs" on page 139.

l You can copy details from selected rows in the Alerts tableusing the Ctrl + C shortcut.
l Youmanage Analytics alerts from this page.

Relevant
tasks

"Configure SiteScope Alerts" on page 1072

See also "Configure SiteScope Alerts" on page 1072
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User interface elements are described below:

UI Element Description

Show Child Alerts. Displays only those alerts that are direct children of the selected node.

Show All Descendent Alerts. Displays all descendent alerts of the selected node.

New Alert. Opens the New Alert dialog box enabling you to configure an alert, and add it to
the selected SiteScope group or monitor. For user interface details, see "New/Edit Alert
Dialog Box" below.

Note: This button is available in theAlerts on Monitor/Group table only

Edit Alert. Opens the Edit Alert dialog box enabling you to edit the properties of the selected
alert. For user interface details, see "New/Edit Alert Dialog Box" below.

Copy.Makes a copy of the alert.

Note:

l This button is available in theAlerts on Monitor/Group table only.
l Analytics alerts cannot be copied to another target monitor or group.

Paste. Pastes the alert to a selected location in the tree.

Note: This button is available in theAlerts on Monitor/Group table only.

Delete Alert. Deletes the alert from the tree.

Enable. Enables the alert associated with themonitor/group.

Disable. Disables the alert associated with themonitor/group.

Test. Tests the alert definition on a selected server.

Select All. Selects all listed alerts.

Clear Selection. Clears the selection.

Name The name by which the alert is known in SiteScope.

Status The enabled/disabled status of the alert.

Description A description of the alert.

Action
Name

The alert action type and the name given to the alert action in the "Action Type Dialog Box"
on page 1099.

Path Path of the group or monitor associated with the alert.

New/Edit Alert Dialog Box
This dialog box enables you to define alerts for a SiteScope, a group, or amonitor.
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To access Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or
select an existing alert in the Alerts tab (monitor or template view) and click theEdit Alert

button.

Important
information

l Only a SiteScope administrator user, or a user granted the appropriate alerts
permissions can view, create, or edit alerts. For details on user permissions, see
"Permissions" on page 636.

l The option to create alerts using the Pager or SMS action type is no longer available,
and we plan to remove support for Pager and SMS Alert action types in the next
version of SiteScope.

l If the name or description field contains an ampersand (&), less than (<), or greater
than (>), they are automatically escaped, for example, &amp;, &lt;, or &gt;.

Relevant
tasks

"How to Configure an Alert" on page 1076

See also l "Configure SiteScope Alerts" on page 1072
l "Action Type Dialog Box" on page 1099
l "Alert Action Dialog Box" on page 1101
l "Common Event Mappings" on page 465

This dialog box includes the following panes:

l "General Settings" below
l "Alert Targets" on the next page
l "Alert Actions" on page 1095
l "HP Operations Manager Integration Settings" on page 1096
l "Enable/Disable Alerts" on page 1097
l "Filter Settings" on page 1098
l "Search/Filter Tags" on page 1099

General Settings
User interface elements are described below:

UI Element Description

Name Name for this alert definition. This name is used to identify this alert definition in the product
display.

Note: The alert name cannot contain any of the following characters: ' "

Alert
description

Description of the alert. This description does not appear in any other context. It appears
only when editing the alert.
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Alert Targets
User interface elements are described below:

UI
Element Description

Alert
targets

Use the context menu tree to select the groups, monitors, or both, to trigger this alert. The
context menu includes the currently selected object and all of the child objects. To select an
object, select the check box to the left of the object name. Any combination of groups or
monitors can be selected.

Alternatively, youmay select the SiteScope root and then define an alert filter rule in the Filters
Settings to limit alerting to those objects that match the conditions set in the filter. For details,
see "Filter Settings" on page 1098.

l A icon displayed to the left of a group indicates that all monitors and subgroups contained
within that group have been selected ("all selected" status).

New subgroups andmonitors added within the associated group or groups after the alert
definition is created are automatically associated with the alert.

l A icon displayed to the left of a group indicates that not all monitors and subgroups
contained within that group have been selected ("partially selected" status).

If you remove amonitor from Alert targets defined for a group that is in the "all selected"
status, the group changes to the "partially selected" status, and any monitors that you
subsequently add to the group are not automatically associated with the alert. If you delete
all monitors from the group that are not associated with the alert, the group automatically
reverts to the "all selected" status and behaves accordingly (see previous bullet).
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Alert Actions
User interface elements are described below:

UI
Element Description

New Alert Action. Opens the Action Type dialog box enabling you to define an action to be
done when an alert is triggered. For user interface details, see "Action Type Dialog Box" on
page 1099.

Edit Alert Action. Opens the Action Type dialog box enabling you to edit the alert action. For
user interface details, see "Action Type Dialog Box" on page 1099.

Delete Alert Action. Deletes the alert action. It does not disable the associatedmonitors.

Duplicate. Duplicates the alert action.

Select All. Selects all listed alert actions.

Clear Selection. Clears the selection.

<Alert
Action
Type
icon>

Indicates the type of action defined in the alert.

Database. Sends an alert message with a description of the problem as a record to a SQL
database.

Disable or Enable Monitors. Manually controls the generation of alerts.

Email. Sends an email message to one or more email addresses with a description of the
error or warning.

Log Event. Logs events to theMicrosoft Windows Event Log

Post. Submits a CGI POST containing a description of amonitor condition to a CGI script,
servlet, or other CGI-enabled program.

Script.SiteScope can run scripts or batch files when the alert trigger condition is detected.
The script or batch file that is called can run a system command or a program in any language
that can be called from a command line entry.

SNMP Trap. Sends an SNMP trap to an SNMP host or management console.

Sound. Plays a sound or audio file on themachine on which SiteScope is running when an
event has been detected.

Trigger. Triggers an alert without invoking any specific action. It should be used when you
want the alert to send event information to HPOM or BSM without performing any additional
action. Note that Send events in the HP Operations Manager Integration Settings panel of the
alert must be selected.

Name The name given to the action to be done when the alert is triggered. It is not the name of the
alert.
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UI
Element Description

Category The category selected in the Status Trigger panel that triggers the alert action. For details on
the Status Trigger user interface, see "Status Trigger Panel" on page 1114.

When The schedule selected in the Trigger Frequency panel for when the alerts are sent. For details
on the Trigger Frequency user interface, see "Trigger Frequency Panel" on page 1115.

Schedule The daily or weekly schedule selected in the Action Type Settings panel. For details on the
Action Type Settings user interface, see "Alert Action Dialog Box" on page 1101.

Target Contains target data for the action type. Below you can see the content of the target column
according to type:

l Database. Contains the URL entered in theDatabase connection URL box.
l Disable or Enable. Contains the targets selected in the Targets list.
l Email. Contains the email recipients selected in theSend email to section.
l Log Event. Contains the log event recipients selected in theSend email to section.
l Post. Contains the URL entered in thePost to url form box.
l Script. Contains the script selected in theScript box.
l SNMP Trap. Contains the SNMP traps selected in theSNMP Trap list.
l Sound. (The column is empty)
l Trigger. (The column is empty)

HP Operations Manager Integration Settings

Note: The HP Operations Manager Integration Settings panel is available only if the Operations Agent is
installed and connected to an HPOM/APM server, andEnable sending events is selected in the
HP Operations Manager Integration dialog box (Preferences > Integration Preferences >
HP Operations Manager Integration > HP Operations Manager Integration Main Settings). For
details, see "How to Enable SiteScope to Send Events to HPOM or OMi" in Integrating SiteScope with
HP Operations Manager Products in the SiteScope Help. You can check the HPE Software Integrations
site for the latest version of this guide.

User interface elements are described below:

UI
Element Description

Send
events

Enables sending events to the HPOM/APM server when an alert is triggered.

Default value:Selected
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UI
Element Description

Use
monitor's
event
mapping

If selected, when an alert is triggered, SiteScope sends an event using the event mapping
template associated with themonitor that triggered the alert.

If cleared, SiteScope sends an event using the alert event attribute values. These values are
filled according to the selected alert event mapping preference. TheEvent mapping setting
below is available only when alert event mapping is used.

Default value:Not selected

Event
mapping

The event mapping template that is used for sending events for themonitor instance. The
template contains mappings between SiteScope runtime data of the alert and themonitor that
triggered the alert (metric level runtime data is not available) and the attribute values that are
used for sending events.

Select the desired event mapping template, or use the default mapping. Click New orEdit to
open the Common Event Mappings dialog box and configure a new events preference or
modify an existing one. For user interface details, see "New/Edit Event Mappings Dialog Box -
General Tab" on page 469 and "New/Edit Event Mappings Dialog Box - Custom Attributes
Tab" on page 473.

Note: This setting is active only whenUse monitor's event mapping is cleared.

Event
type
indicator

You can enter an event type indicator for the alert that is sent with this event. This is the
mapping between themeasurement and its indicator. This is optional, and events without an
indicator are still sent.

Manually entering an indicator is useful since the CI type of a triggered alert is not always
knownwhen the alert is configured (for group alerts or alerts for monitors reporting CI type per
metric).

Note: The indicator cannot be resolved automatically, since the alert instancemight be
associated with more than onemonitor or be triggered by more than one counter.

Event
type
indicator
state

You can enter the event type indicator state that is sent with this event. This is the event
severity level (Unknown, Normal, Warning, Minor, Major, Critical) that is mapped to the
threshold that caused this status change. This field is optional, and events without an indicator
state are still sent.

Note: The indicator state cannot be resolved automatically, since the alert instancemight be
associated with more than onemonitor or be triggered by more than one counter.

Enable/Disable Alerts
Use tomanually control the generation of alerts. This can be useful when the systems beingmonitored are off-
line for maintenance or if the recipient of the alerts is unavailable for a period of time.
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User interface elements are described below:

UI Element Description

Enable alert Overrides any disable action on the alert and enables the alert for execution based
on the conditions defined.

Disable alert
indefinitely

Prevents SiteScope from executing the alert action even if the alert condition is met
until this radio button is cleared and the alert definition is updated.

Note:Use of this optionmay result in loss of expected alert capability if the alert is
disabled to accommodate a temporary condition. It is important to review this status
at a later time, and tomanually enable the alert definition as necessary.

Disable alert for
the next <time
period>

Prevents the execution of the alert action for the time period you type, even if the
alert condition is met. The alerts are disabled immediately and re-enabled when the
time period expires.

Disable on a one
time schedule
from <time1> to
<time2>

Prevents SiteScope from executing the alert action for the time period indicated,
even if the conditions aremet. The alerts are disabled at the beginning of the time
period and re-enabled after the time period expires.

Disable
description

(Optional) Description of the purpose of the disable operation.

Filter Settings
Creates filter conditions to limit the alert action to only thosemonitors that match the criteria you entered. You
can define alerts for a large number of monitors and then apply a filter so that only specific monitors within the
selected list trigger the alert. This can simplify the creation of alert definitions and alert management. To
disable alert filtering, clear the applicable fields and update the alert definition.

User interface elements are described below:

UI
Element Description

Name
match

Suppresses the alert for all associated groups or monitors except those with a specific text
appearing as part of their name.

l Enter a regular expression in this text box tomatch a name string pattern. For details, see
"Regular Expressions" on page 153.

l Enter all or part of themonitor name string you want to use as a filter criteria. For example,
entering the string URL: limits this alert to monitors whose name contains the string URL:.

Note: Thematch is case sensitive.
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UI
Element Description

Status
match

Suppresses the alert for all associatedmonitors except those returning a specific status text.

l Enter a string that you expect to appear in the status text for themonitor you want to trigger
this alert. For example, if you type the text timeout, an alert is only triggered by amonitor
associated with this alert that also has a status of timeout.

l Enter a regular expression in this text box tomatch a status string pattern. For details, see
"Regular Expressions" on page 153.

Note: Thematch is case sensitive.

Monitor
type
match

Limits the alert action to amonitor type from the set of monitors associated with this alert.
Select themonitor types you want to include from theMonitor Type List andmove them to the
Selected Monitor Type List button.

Tags
match

Limits the alert action to only thosemonitors associated with this alert that have the tag values
selected. Select the tags you want to include.

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope, this
section appears but is empty. If tags have been created, they are listed here and you can select
them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Action Type Dialog Box
This dialog box enables you to select the action to be done when an alert is triggered.

To access 1. Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or
select an existing alert in the Alerts tab (monitor or template view) and click theEdit
Alert button.

2. In the Alert Actions section of the New/Edit Alert dialog box, click theNew Alert
Action button.
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Important
information

l You can select only one type of alert at a time.
l If you are editing an alert, you cannot change the action type. For example, if an alert's
action type was Email, you cannot change it to Sound.

l The option to create alerts using the Pager or SMS action type is no longer available, and
we plan to remove support for Pager and SMS Alert action types in the next version of
SiteScope.

Relevant
tasks

"How to Configure an Alert" on page 1076

See also l "Configure SiteScope Alerts" on page 1072
l "New/Edit Alert Dialog Box" on page 1092
l "Alert Action Dialog Box" on the next page

User interface elements are described below:

UI
Element Description

Database
Sends an alert message with a description of the problem as a record to a SQL database. You
can then use database tools to providemore advanced recording, sorting, and reporting on your
monitoring data. For details on Database Alerts, see "Database Alert Properties" on page 1102.

Disable
or
Enable
Monitors

Automatically enables or disables monitors or monitor groups based on a change of state in
another monitor.

Note: This action is not available when creating a template alert. For details on Disable/Enable
Monitor Alerts, see "Disable or EnableMonitors Alert Properties" on page 1104.

Email Sends an email message to one or more email addresses with a description of condition that
triggered the alert. For details on Email Alerts, see "Email Alert Properties" on page 1104.

Event
Console

Sends events to the SiteScope Event Console. For details on Event Console Alerts, see
"Event Console Alert Properties" on page 1106.

Log
Event

Logs events to theMicrosoft Windows Event Log.

Entries in the event log can then be viewed with the Event Viewer and/or used by other
software utilities that perform centralized alerting from the event log. For details on Log Event
Alerts, see "Log Event Alert Properties" on page 1106.

Post Submits a CGI POSTmessage to a CGI script, servlet, or other CGI-enabled program. The
message contains a description of amonitor condition. For details on Post Alerts, see "Post
Alert Properties" on page 1108.

Rest Sends events to any application URL that supports REST service. For details on Rest Alerts,
see Rest Alert Properties.
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UI
Element Description

Script SiteScope can run scripts or batch files when the alert condition is met. The script or batch file
can run a system command or a program in any language that can be called from a command
line entry.

You can use this alert to run recovery scripts that automatically respond to critical conditions or
failures (for example, to reboot a server or to copy files). For details on Script Alerts, see "Script
Alert Properties" on page 1109.

SNMP
Trap

Sends an SNMP trap to an SNMP management console or host. This enables SNMP reporting
of system parameters not normally supported by SNMP agents. For details on SNMP Trap
Alerts, see "SNMP Trap Alert Properties" on page 1112.

Sound Plays a sound or audio file on themachine on which SiteScope is running when an event has
been detected. For details on Sound Alerts, see "Sound Alert Properties" on page 1113.

Trigger Triggers an alert without invoking any specific action. It should be used when you want the alert
to send event information to HPOM or APM without performing any additional action. Note that
Send events in the HP Operations Manager Integration Settings panel of the alert must be
selected. For details on Trigger Alerts, see "Trigger Properties" on page 1114.

Alert Action Dialog Box
Use the Alert Action dialog box to define the settings that are specific to the alert type and to configure actions
to be taken when an alert is triggered.

To access 1. Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or
select an existing alert in the Alerts tab (monitor or template view) and click theEdit
Alert button.

2. In the Alert Actions section of the New/Edit Alert dialog box, click theNew Alert
Action button. In the Action Type dialog box, select an action type.

Important
information

l The Action Alert dialog box consists of three panes:
l Action Type Settings. The Action Type settings vary according to the type of alert
action you selected in the "Action Type Dialog Box" on page 1099. For details of action
type properties, see "Action Type Settings Panel" on the next page.

l Status Trigger. For details, see "Status Trigger Panel" on page 1114.

l Trigger Frequency. For details, see "Trigger Frequency Panel" on page 1115.

Relevant
tasks

"How to Configure an Alert" on page 1076

See also l "Configure SiteScope Alerts" on page 1072
l "New/Edit Alert Dialog Box" on page 1092

The following element is common to all action types:
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UI Element Description

New
Variable

Click to define a new variable. For details, see "New Variable Dialog Box" on page 692.

This button is available only from New/Edit Alert Dialog Box and New Action Dialog Box for
template alerts.

Action Type Settings Panel
The contents of this panel depend on the action type you selected in the Action Type dialog box.

To access Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or select
an existing alert in the Alerts tab (monitor or template view) and click theEdit Alert
button. In the Alert Actions section of the New/Edit Alert dialog box, click theNew Alert
Action button. In the Action Type dialog box, select an action type.

Important
information

The option to create alerts using the Pager or SMS action type is no longer available, and we
plan to remove support for Pager and SMS Alert action types in the next version of
SiteScope.

Relevant
tasks

"Configure SiteScope Alerts" on page 1072

See also "Alert Action Dialog Box" on the previous page

This section includes:

l "Database Alert Properties" below
l "Disable or EnableMonitors Alert Properties" on page 1104
l "Email Alert Properties" on page 1104
l "Event Console Alert Properties" on page 1106
l "Log Event Alert Properties" on page 1106
l "Post Alert Properties" on page 1108
l "Script Alert Properties" on page 1109
l "SMS Alert Properties" on page 1111
l "SNMP Trap Alert Properties" on page 1112
l "Sound Alert Properties" on page 1113
l "Trigger Properties" on page 1114

Database Alert Properties
User interface elements are described below:

UI Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.
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UI Element Description

Database
connection
URL

Enter the URL to a database connection.

Note for using Windows Authentication: If you want to access the database using
Windows authentication, type jdbc:mercury:sqlserver://<server name or
IP address>:1433;DatabaseName=<database name>;
AuthenticationMethod=type2 as the connection URL, and
com.mercury.jdbc.sqlserver.SQLServerDriver as your database driver. Leave the
Database user name andDatabase password boxes empty, because theWindows user
credentials of the account from which the SiteScope service is running are used to establish
a connection to the database.

Database
driver

Enter the Java class name of the JDBC database driver.

SiteScope uses the same database driver for both primary and backup database
connections. If a custom driver is used, the driver must also be installed in the <SiteScope
root directory>/java directory. For more information about setting up database drivers for
SiteScope, see "DatabaseQuery Monitor".

SQL
statement

Enter the SQL statement used to add the alert to the database.

Items enclosed in angle brackets (< and >) are replaced with fields from themonitor that
triggered the alert.

Default value: INSERT INTOSiteScopeAlert VALUES('<time>', '<group>', '<name>',
'<state>')

Database
user name

Enter the user name to connect to the database if required.

Database
password

Enter the password to connect to the database if required.

Backup
database
connection
URL

If a backup database for SiteScope alert logging is required, enter the URL to the backup
database connection to use if themain database connection fails.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to
22:00. You can select an existing schedule that has been created in Schedule Preferences,
or you can create a new schedule. For details, see "Schedule Preferences" on page 608.

You can also use variables in this field. To do so, enter%% to display the list of available
variables.

Default value:Every day, all day
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Disable or Enable Monitors Alert Properties
User interface elements are described below:

UI Element Description

Action name The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

Group/Monitors
action

Select whether this alert action disables or enables amonitor when the alert is triggered.

Default value:Disable

Targets Select the groups andmonitors that should be affected by the action of this alert. The
Targets list includes all groups andmonitors configured for the SiteScope. You can
select any groups or monitors running in any group for this alert action and add them to
theSelected Targets list.

Example: This alert action is being configured for a Disk Spacemonitor. An alert
triggered for this monitor can disable all CPU monitors monitoring the same server.

Default value:None selected

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions
aremet and the alert is triggered. The schedule helps prevent alert actions being
performed at inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 608.

Default value:Every day, all day

Apply action to
subgroups of
the selected
groups

If selected, the alert action also applies to subgroups of the selected groups.

Default value:Not selected

Email Alert Properties
User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

Example: If you want to configure an alert to check the CPU of all Solaris machines and send
an email message when some alert is triggered, you could define the alert name in General
Settings to be Solaris_CPU and the action name to be send_email.
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UI
Element Description

Recipients Select one or more Email recipients for the alert from the Email Alert Recipients list. The list
displays the recipients that have been configured inMail Preferences. For details, see "Email
Preferences" on page 482.

Default value:None selected

Note:Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" on page 484.

Addresses Enter one or more email addresses separated by a comma (","). The addresses are checked
for valid syntax according to the official standard RFC 2822, but not for other errors (for
example, that the email user exists).

Note: If theAddresses box contains data, selections from the Email Alert Recipients list are
ignored.

Subject Select the subject field template for the email alert actionmessage. The Typical template
includes the following values:

l the subject of themessage (SiteScope Alert)
l the category of themonitor alert (error, warning, ok, or no data)
l the name of themonitor or monitor title
l the status returned by themonitor
l the address, in parenthesis, of the SiteScope installation that sent the alert
Default value: Typical

Example: SiteScope Alert, error, URL: http://gate.company.com, unknown host name
(gate.company.com)

Schedule Email recipients have a predefined schedule.

Template Select the template for the email alert action.

In an Email alert action, select theShortMail template for a shorter email message. Other
options enable you to choose the level of detail to include in Email alerts.

Default value: Typical. This template includes the following values: Monitor:
<groupID>:<name>; Tags <tag>; Group: <group>; Status: <state>; Sample #: <sample>;
Time: <time>

Note: You can add additional templates into the <SiteScope
root directory>\templates.mail directory. For details on the available templates, you can
open the files in this directory in a text editor to see what values are sent with each option. For
details, see "Customize Alert Templates" on page 1117.

Mark this
action to
close alert

When the status changes and the alert trigger condition is no longer true, this action closes
the alert and sends a close notification by adding the wordClose to themessage sent.

Default value: Not selected
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Event Console Alert Properties
User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed between
the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to 22:00. You
can select an existing schedule that has been created in Schedule Preferences, or you can
create a new schedule. For details, see "Schedule Preferences" on page 608.

You can also use variables in this field only for template alerts. To do so, enter%% to display
the list of available variables.

Default value:Every day, all day

Event
Mapping

Select an event mapping template for the Event Console, or create a new event mapping. The
template contains themappings between SiteScope run time data and the attribute values that
are used for sending events to the event console when ametrics status change event is
triggered. For user interface details, see "New/Edit Event Mappings Dialog Box - General Tab"
on page 469 and "New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page 473.

Log Event Alert Properties
User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

Send to Enter the name of theWindows machine where the event is to be appended to the event log.

Default value: localhost (themachine where SiteScope is running).

Template Select the template for the log event type alert action.

Default value: Typical

Note: You can view the contents of the existing templates or add additional templates in
<SiteScope root directory>\templates.eventlog. For more details on alert templates, see
"Customize Alert Templates" on page 1117.
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UI
Element Description

Message Enter themessage prefix to be sent to the event log.

You can add a link to open SiteScope in the context of the alertedmonitor by entering the
following string:
Login: <sitescopeurl>/servlet/Main?activeid=<_internalId>
&activerighttop=dashboard&view=new&dashboard_view=
Details&dashboard_model=true&dashboard_favorite=test.

Event
source

Enter the string used to set the <Source> field of the logged event.

Syntax:must be text.

Default value:SiteScope

Event ID Enter the number used to set the <ID> field of the event that is logged.

Syntax:must be numeric.

Default value: 1000

Event
type

Select the event type used for the event.

Default Value:Usemonitor status. This means that the Event Type is Error for an Error
status, Warning forWarning, and Informational for monitors reporting a status of Good.

Event
category
ID

Enter a number to be used as the <category ID> for the event created by this alert.

Default value: 0

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered.

You can also use variables in this field. To do so, enter%% to display the list of available
variables. The schedule helps prevent alert actions being performed at inappropriate times or
outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed between
the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to 22:00. You
can select an existing schedule that has been created in Schedule Preferences, or you can
create a new schedule. For details, see "Schedule Preferences" on page 608.

Default value:Every day, all day

Mark this
action to
close
alert

When the status changes and the alert trigger condition is no longer true, this action closes the
alert and sends a close notification by adding the wordClose to themessage sent.

Default value: Not selected
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Post Alert Properties
User interface elements are described below:

UI Element Description

Action name The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

Post to URL
form

Enter the URL of the CGI script that SiteScope should submit to the alert. For example,
http://admindb.server.net/cgi-bin/error.pl.

Syntax:Youmust include the string http://. There is syntax checking for a valid URL
address.

Template Select the template for the post alert action type.

Default value: Typical

Note: You can view the contents of the existing templates or add additional templates in
the <SiteScope root directory>\templates.post directory. For more details on alert
templates, see "Customize Alert Templates" on page 1117.

Authorization
user name

Enter the user name to access the URL of the CGI script in a Post Alert. Not all CGI
scripts require a user name.

Alternatively, leave this entry blank and type the user name in theDefault authentication
user name section in the General Settings (Preferences > General Preferences). Use
this method to define common authentication credentials for use with multiple monitors.

Authorization
password

Enter the password for the Authorization user name in a Post Alert.

Alternatively, leave this entry blank and type the password in theDefault authentication
password section in thePreferences > General Preferences. Use this method to define
common authentication credentials for use with multiple monitors.

HTTP proxy Enter the domain name and port of an HTTP Proxy Server used to access the URL of the
CGI script.

Proxy server
user name

Enter the user name to access the URL of the CGI script, if required by the proxy server.

Your proxy server must support Proxy-Authenticate.

Proxy server
password

Enter the password to access the URL of the CGI script, if required by the proxy server.

Your proxy server must support Proxy-Authenticate.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to
22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule Preferences"
on page 608.

Default value:Every day, all day
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Rest Alert Properties
User interface elements are described below:

UI Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

Rest to
URL form

Enter the URL of the application where you want to send alerts from SiteScope.

For example, to send alerts to the Slack messaging application, provide the
URL https://<text>.slack.com/<TOKEN KEY>, where <TOKEN KEY> is the value that
Slack provides when the user creates a team in the Slack application.

Template Select the template for the Rest alert action type.

Default value: Name of the template.

Note: You can view the contents of the existing templates or add additional templates in the
<SiteScope root directory>\templates.rest directory. For more details on alert templates,
see "Customize Alert Templates" on page 1117.

HTTP
Method

Select the HTTP method for the Rest alert action.

Default Value: POST

Format
Type

Select the format type for the Rest alert action.

Default Value: JSON

Additional
Parameters

Enter any parameter that REST API supports. Youmust enter all the additional parameters
used in the template. The format for providing the parameters is <name> = <value> with
multiple parameters separated by commas. The <name> specified heremust match the
parameter name specified in the template.

Note: If there are additional parameters specified in the template and if you do NOT specify
in this field, then it results in an error. You can see the error messages in the alert.log file in
the SiteScope Logs directory located at <install_dir>/Sitescope/logs .

Script Alert Properties
User interface elements are described below:

UI Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.
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UI Element Description

Server Select the server on which the script should be run.

The scripts directory must be in the directory tree of the remote login account that enables
remote scripts to be run by SiteScope.

Default value: SiteScope Server

Note when working in template mode: The drop-down list is displayed as a text box to
enable using a template variable in this field.

Script Select the script to run in response to the selected condition.

You can create as many custom scripts as you need. Place them in <SiteScope root
directory>\scripts directory or the applicable scripts directory on a remotemachine.
SiteScope lists all files found in this directory on the selected server in the drop-down list.

Default value: restartServer.bat

Parameters Additional monitor parameters that you can pass to your script, such as:

l path of the scripts directory
l name of themonitor that caused the alert
l current status of themonitor
l path to the alert message file
l ID of themonitor
l monitor group
These parameters are sent as the seventh, eighth, ninth, and so forth, command line
arguments respectively.

The parameters available to be passed to the script are dependent on the type of monitor that
triggers the alert.

Syntax:Surround the property name variable in the properties list with angle brackets (< >).
For example, to pass the server name to the script, type <_machine> in the text box. To pass
more than one extra parameter, separate the parameters with a single space. This is the
sameway the arguments would be added on the command line.

Default value:No value. The Script Alert always passes the above parameters to a script as
command line arguments. They do not need to be listed here.

Output
encoding

Select the encoding of the script output. This enables SiteScope tomatch and display the
encoded file content correctly.

Default value:windows-1252

Template Select the template for the script alert action type.

Default value: Typical

Note: You can view the contents of the existing templates or add additional templates in the
 <SiteScope root directory>\templates.script directory. For more details on alert
templates, see "Customize Alert Templates" on page 1117.
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UI Element Description

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered.

You can also use variables in this field. To do so, enter%% to display the list of available
variables. The schedule helps prevent alert actions being performed at inappropriate times or
outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to
22:00. You can select an existing schedule that has been created in Schedule Preferences,
or you can create a new schedule. For details, see "Schedule Preferences" on page 608.

Default value:Every day, all day

Timeout
(seconds)

Amount of time, in seconds, to wait for the script to run successfully before timing out.

Default value: -1 (no timeout)

SMS Alert Properties

Note: The option to create alerts using the SMS action type is no longer available, and HPE plans to
remove support for it in the next version of SiteScope. However, this alert action type can be enabled for
backward compatibility by adding the property _enableDeprecatedAlertActions=SMS to the
<SiteScope root directory>\groups\master.config file. The value is not case-sensitive, and should be
separated by a comma if other values are listed.

User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

SMS
number

Enter the telephone number required by the SMS service that identifies the destination for the
message.

Syntax:Numeric only. Maximum of 16 digits.
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UI
Element Description

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered.

You can also use variables in this field. To do so, enter%% to display the list of available
variables. The schedule helps prevent alert actions being performed at inappropriate times or
outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed between
the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to 22:00. You
can select an existing schedule that has been created in Schedule Preferences, or you can
create a new schedule. For details, see "Schedule Preferences" on page 608.

Note: This alert is available only in theWindows platform. In the Schedule field for this
template action, you can use variables.

Default value:Every day, all day

SNMP Trap Alert Properties
User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

SNMP
Trap

Select one or more SNMP Traps to trigger an alert.

Default value:None selected

Template Select a template for the SNMP trap alert action type.

Each line in the template is sent as a separate SNMP variable. The template file can also be
modified using:

l [Agent Host: <hostname-or-ip-address>] as the first line of the template, to send the
trap with that hostname or IP address as the source of the trap. By default, the IP address
of themachine that SiteScope is running on is used as the source of the trap.

l [Command: <command name>] to override the default command.
l [Type: <var-type>] to override the default type of the object.
[OID: <object id>] to change the default object id. For example, use this to change a var-
binding variable object id.

Default value: Typical

Note: You can view the contents of the existing templates or add additional templates in the
<SiteScope root directory>\templates.snmp directory. For more details on alert templates,
see "Customize Alert Templates" on page 1117.

Message Enter an optional prefix to be added to the SNMP trap sent by this alert.
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UI
Element Description

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed between
the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to 22:00. You
can select an existing schedule that has been created in Schedule Preferences, or you can
create a new schedule. For details, see "Schedule Preferences" on page 608.

You can also use variables in this field only for template alerts. To do so, enter%% to display
the list of available variables.

Default value:Every day, all day

Mark this
action to
close
alert

When the status changes and the alert trigger condition is no longer true, this action closes the
alert and sends a close notification by adding the wordClose to themessage sent.

Sound Alert Properties
User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

Sound
file

Select the sound to be played from <SiteScope root directory>\templates.sound directory.
Additional sounds can be added to the directory in AU format (8 bit, &#micro;law, 8000 Hz,
one-channel) with an .au suffix.

Default value:Default

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed between
the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to 22:00. You
can select an existing schedule that has been created in Schedule Preferences, or you can
create a new schedule. For details, see "Schedule Preferences" on page 608.

You can also use variables in this field. To do so, enter%% to display the list of available
variables.

Default value:Every day, all day

Using SiteScope
Chapter 103: Configure SiteScope Alerts

HPE SiteScope (11.33) Page 1113 of 1206



Trigger Properties
User interface elements are described below:

UI
Element Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of the
alert.

Example: If you want to configure an alert to check the CPU of all Solaris machines and send
a notification to Operations Manager when some alert is triggered, you could define the alert
name in General Settings to be Solaris_CPU and the action name to be notify OM.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions aremet
and the alert is triggered. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.

For example, if you want monitors to run 24/7, but want alert actions to be performed between
the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00 to 22:00. You
can select an existing schedule that has been created in Schedule Preferences, or you can
create a new schedule. For details, see "Schedule Preferences" on page 608.

You can also use variables in this field. To do so, enter%% to display the list of available
variables.

Default value:Every day, all day

Status Trigger Panel
Use the Status Trigger panel to select the status of the object type that triggers an alert action. Alerts are
triggered when the status changes from one state to another. Select the category that triggers the alert action.

To
access

Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or select an
existing alert in the Alerts tab (monitor or template view) and click theEdit Alert button. In

the Alert Actions section of the New/Edit Alert dialog box, click theNew Alert Action
button. In the Action Type dialog box, select an action type.

Note: Analytic alerts can be configured for monitors only, and from themonitor view only.

Relevant
tasks

"Configure SiteScope Alerts" on page 1072

See also "Alert Action Dialog Box" on page 1101

User interface elements are described below:

UI Element Description

Unavailable Alerts are triggered if themonitoredmachine was previously available and is currently no
longer available.
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UI Element Description

Error Alerts are triggered if themonitor was previously reporting a different status (default option
for regular alerts).

Warning Alerts are triggered if themonitor was previously reporting a different status.

Good Alerts are triggered if themonitor was previously reporting a different status.

Analytics (Available for Analytics alerts only) Alerts are triggered if the baseline threshold for the
monitor is crossed (default option for analytics alerts). For details, see "Configure Predictive
Analytics" on page 1188.

Trigger Frequency Panel
Use the Trigger Frequency panel to select the trigger frequency.

To access Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or select
an existing alert in the Alerts tab (monitor or template view) and click theEdit Alert
button. In the Alert Actions section of the New/Edit Alert dialog box, click theNew Alert
Action button. In the Action Type dialog box, select an action type.

Important
information

l The available options vary according to what you chose in the "Status Trigger Panel" on
the previous page.

l Formore detailed information on the options here, see "UnderstandWhen SiteScope
Alerts Are Sent" on page 1078.

Relevant
tasks

"Configure SiteScope Alerts" on page 1072

See also "Alert Action Dialog Box" on page 1101

User interface elements are described below:

UI Element Description

Escalate, after
action <>
occurred exactly
<N>times

Select this option if the alert action you are creating is dependent on another alert
action. Youmust select the name of the alert action on which this alert action is
dependent and the number of times the first alert action is triggered before this alert
action is triggered.

Example: You created an alert action to send a sound alert when a certain condition
is met. You want an Email alert to be sent when the sound alert action has been
triggered 3 times. Select the name of the sound alert action and 3.

Note: This option is displayed only if another alert action has been defined for the
alert.

Using SiteScope
Chapter 103: Configure SiteScope Alerts

HPE SiteScope (11.33) Page 1115 of 1206



UI Element Description

Always, after the
condition has
occurred at least
<N> times

After the alert conditions have occurred at least N times, the alert is triggered every
time the alert conditions aremet again after the initial trigger.

Enter theminimum number of times the alert conditionmust bemet before the alert is
triggered the first time.

Syntax: numeric only

Range: 1-99

Once, after the
condition has
occurred exactly
<N> times

The alert is triggered only once after the alert condition is met for the Nth time.

Enter the number of times the alert conditions must bemet before the alert is
triggered.

Default value: Selected

Syntax: numeric only

Range: 1-99

Initially after <X>
times, and repeat
every <Y> times

The alert is triggered after the alert condition occurs X consecutive times, and then
the alert is triggered every consecutive Y occurrences that the alert conditions are
met. For example, if X is set to 3, and Y is set to 4, then the alert action would be done
on the 3rd, 7th, 11th, and so forth, occurrences of the alert condition.

Syntax: numeric only

Range: 1-99

Once, after <N>
group errors

This is displayed if you choseError in the Status Trigger panel.

The alert is triggered only after any monitor in the group has reported the alert
condition exactly N consecutive times.

Note: This option is available only for SiteScope groups.

Once, after all
monitors in this
group are in error

This is displayed if you choseError in the Status Trigger panel.

The alert is triggered the first time all monitors in the group are in error (the alert does
not includemonitors of subgroups).

Note: This option is available only for SiteScope groups.

Only alert if
monitor was
previously in
error/warning at
least <N> times

This is displayed if you choseGood orWarning in the Status Trigger panel.

This option suppresses the triggering of the alert until the subject monitor or group has
reported a status of either of the following:

l Error orWarning for alert category Good
l Good orError for alert categoryWarning, for at least the number of times that
you entered
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Chapter 104: Customize Alert Templates
SiteScope uses templates when generating alert messages and reports. In most cases, you select the
template you want to use in the Alert page when you create an alert. You can customize the existing
templates or create your own by making a copy of an existing template. You customize the alert templates by
adding or removing text, by adding property variables (as listed in the "Properties Available in Alerts,
Templates, and Events" on page 1126), or changing the order of text or property variables that are included in
the template.

Learn About
Customizing Alert Template Overview
Tomake a custom alert template available to SiteScope, youmust save any customized alert templates into
the directory containing the templates for the applicable alert type. For the list of directory names containing
SiteScope alert templates you can copy and customize, see "Alert Template Directories" on the next page.

The templates in these groups are text files that include property variable markers. You use a text editor to
create or modify these templates. The new templates saved into the directories shown become available to
the applicable alert on the Alert page.

The following is an example of the default template used for the Email Alert. The first section is the alert
header. The first line in the alert header includes a link to the SiteScope installation which sent the problem.
This provides you with a way to access the SiteScope installation reporting the problem.

Below the link is a block of text that further summarizes what caused the alert. This includes:

l The name of themonitor that triggered the alert.
l The group to which themonitor belongs.
l The alert status reported by themonitor.
l The sample ID number indicating how many times themonitor ran before the condition was reported.
l The time of day when the error occurred.

This alert is from SiteScope at <SiteScopeURL>
Monitor: <groupID>:<name>
Group: <group>
Status: <state>
Sample #: <sample>
Time: <time>
----------------------Detail ---------------------
<mainParameters>
<mainStateProperties>

The names that appear within <brackets> are property variable markers. When the alert is generated,
SiteScope replaces thesemarkers with the corresponding values of the variable for themonitor or monitor
group that has triggered the alert.
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You add or edit the text portions of the template. For example, you could change the first line of the template
above to read:

A Web monitoring alert was generated by the SiteScope installation found at
<SiteScopeURL>

Alert Template Directories
The following is a list of the directory names containing SiteScope alert templates you can copy and
customize.

Template
Group Description Location

Event Log Format and content of data written into event logs. <SiteScope root directory>\
templates.eventlog

History Format and content of email messages that notify recipients
that a report has been generated.

<SiteScope root directory>\
templates.history

Email Format and content of alert messages sent by email. <SiteScope root directory>\
templates.mail

Template Group, Description, Location, Pager Format, and content of
pager alerts.

<SiteScope root directory>\
templates.page

Post Format and content of messages submitted to a CGI script by
a post alert.

<SiteScope root directory>\
templates.post

Rest Format and content of messages submitted to the URL of any
REST service.

<SiteScope root directory>\
templates.rest

Script Format and content of messages sent to a script when a script
alert is triggered.

<SiteScope root directory>\
templates.script

SNMP Format and content of messages sent by SNMP when a
SNMP trap is triggered.

<SiteScope root directory>\
templates.snmp

Tasks
How to Customize an Alert's Message Content
This task describes how to customize SiteScope alert templates to alter the content and format of alert
messages.

1. Open a text editor that has access to the alert template directories on the SiteScopemachine.
For a list of the directory names containing SiteScope alert templates, see "Alert Template Directories"
above.

2. Open an existing template file of the alert type you want to customize within a text editor.
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3. Make changes to the template. Depending on the alert type, you can add or remove text, change the
order of text or property variables, or add other property variables. To add specific properties, add the
applicable property variable name between < > bracket pairs to the template.
For a list of specific property variables, see "Properties Available in Alerts, Templates, and Events" on
page 1126.

4. Save the changes to a unique filenamewithin the directory for the applicable alert type. The new template
is added to the Action Type Settings Template drop-down list.

How to Shorten an Email Alert Message
You can shorten the length of an email alert by removing properties that provide unneeded information. For
example, if there is no added value in reporting the time of a specific alert, you can remove the <time>
property from the template.

Tip:We recommend that you use the Typical template (the default setting) as a base for your customized
template.

1. In the <SiteScope root directory>\templates.mail directory, open the Typical template file. Remove
the line Time: <time>.

2. Save the changes to a new file name.

How to Change an SNMP Alert Message
You can change the SNMP Alert message from displaying the SNMP monitor's status to displaying a list of
counters that are in Error state along with their values. This causes themessage to only contain counters
that breached the Error threshold and to omit all other counters.

1. In the <SiteScope root dir>\templates.SNMP directory, open theDefault template file in a text editor.
The file contains the line:
SiteScope\<group>\<name>\<sample>\<state>\

2. Replace the string <state>with the string <errorOnly>. The angle brackets (<,>) must remain around
the text.

Note: If you want to display a list of counters that are in Warning state, replace the string <state>
with the string <warningOnly>.

3. Edit <SiteScope root dir>\groups\master.config file and add the line
_errorOnlyDelimiter=,

with other similar error definitions.

In this example, the delimiter is a comma (,), but you can also use a space (" ") or a tab (\t). The added
line inmaster.config looks something like:

_errorSoundURL=
_errorOnlyDelimiter=,
_errorOnlyNewlineFormat=true

Note:

l If you used the string <warningOnly>, youmust use the string _
warningOnlyDelimiter=<delimiter> inmaster.config.

l If no _errorOnlyDelimiter is defined inmaster.config, the default delimiter is a space (" ").
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How to Configure SiteScope to Play Sounds for User Interface Events (Not for
Monitor Status)
You can configure SiteScope to play sounds in the browser to indicate when an event occurs in the user
interface. If the parameter _errorSoundURL is configured, you will hear the error sound if an error occurs in the
user interface. For example, an alert sound will be played if you leave the name field empty when creating a
group, or if you create a schedule which you associate with a few monitors, and then you try to delete the
schedule. You can change the alert sound that is played, by changing the _warningSoundURL= or _
goodSoundURL= setting.

Note: The alert sound is not played when there is a change inmonitor status.

1. Open the <SiteScope root directory>\groups\master.config file in a text editor.
2. Find the _errorSoundURL setting.
3. Change the setting to:

_errorSoundURL=http://<SiteScope host>:<SiteScope port>/
SiteScope/templates.sound/alarm.au

4. Save themaster.config file.
5. Stop and start SiteScope.
6. After this change, any time an event occurs in the user interface, SiteScope plays an alarm sound (in this

case, Alarm.au from the <SiteScope>\templates.sound directory). You can change the sound that is
being played by modifying the source in the tag above. If you want to add sound for warning or good
event, then you can similarly change the _warningSoundURL= or _goodSoundURL= setting.

How to Customize Alert Template Tag Styles
This task describes how to change the delimiter between items in the list if, for example, you have a parser
that processes alert messages and needs a specific delimiter. You can also change the bracket delimiters
that are used to identify variables. This is useful if you want themessage read by XML and a variable replaced
by an XML string.

1. Edit the template file for which you want to change the bracket delimiter. For example: <SiteScope root
directory>\templates.mail\.

2. Use a text editor to add the following lines to the top of the relevant file:

[Tag-Style:{}]

Enter the characters after the colon (in this example {}) that should be used as the delimiter instead of the
html brackets (<>).

3. Edit the relevant variables to be bracketed by the new characters defined in the Tag-Style string. For
example: {state}.

How to Customize Email Alert with the MM/DD/YYYY format
This task describes how to change the data format in the email alert.

1. Edit the template file for which you want to change the date format. For example: <SiteScope root
directory>\templates.mail\.

2. Use a text editor to replace the existing date tag with the <eur-date> tag.
3. Save the template file.
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Tips/Troubleshooting
Tips
We recommend that you create custom alert templates using new file names. If youmodify one of the default
templates provided with SiteScope and save the changes to the same file, the changes that youmakemay be
lost if you reinstall SiteScope or upgrade the SiteScope installation.
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Chapter 105: Write Scripts for Script Alerts
SiteScope has the ability to run scripts or batch files when an error or warning status is detected. This is
normally done by creating a Script Alert that acts as a trigger for the script. The script or batch file can run any
system command or call other programs written in any language. You can use this to create recovery scripts
to automatically respond to critical conditions or failures.

Learn About
Working with Scripts in SiteScope
The script file that a SiteScope Script alert uses to runmust be located in the <SiteScope root
directory>\scripts folder or on a remote UNIX machine (for remote scripts). For example, if SiteScope is
installed in the directory C:\SiteScope and your script is called actionTest.bat, SiteScope tries to run the
following command line in response to Script Alerts you have created:

C:\SiteScope\scripts\actionTest.bat C:\SiteScope\scripts monitor_name

where C:SiteScope\scripts is the first command line parameter, monitor_name is the second command
line parameter, and so forth.

Note:While the local script run by the Script Alert must reside in <SiteScope root directory>\scripts,
the execution path is <SiteScope root directory>\classes directory. You should use full paths for any
file system commands or programs called by the script to avoid problems with defining the current
execution directory.

The action taken by a script is determined by the creator of the script. SiteScope passes several command
line arguments to each script called by a Script Alert. You can use this to have program scripts take action
based on information sent from SiteScope. By default, SiteScope passes the following parameters to each
Script alert as command line arguments:

l The path of the scripts directory.
l The name of themonitor that caused the alert.
l The current status of themonitor.
l The path to the alert message file.
l The ID code of themonitor.
l The group in which themonitor is located.
l Any additional parameters specified in theParameters box in the alert form.
These command line arguments can be accessed by the target script using the normal command line variable
conventions. These conventions are%1, %2, %3 and so forth, forWindows systems, and $1, $2, $3 and so
forth, for UNIX scripts (depending on the scripting shell or language used). The first six parameters (that is,
%1 through%6) are passed by default to each script. To pass other parameters, the property variables or
parameters must be added to the Script Alert Settings in the Parameters box tomake them available to the
script (see "Script Alert Properties" on page 1109). The first variable or text entered in the Parameters box is
then accessible as %7 by the script, the second parameter is accessed as %8, and so forth.

An example script written in Perl to access Script Alert parameters:
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print "pathname to scripts directory: $ARGV[0]\n";
print "name of monitor causing alert: $ARGV[1]\n";
print "current status monitor: $ARGV[2]\n";
print "pathname to alert message file: $ARGV[3]\n";
print "id code of monitor: $ARGV[4]\n";
print "group for the monitor: $ARGV[5]\n";

The following is an example batch file for Microsoft Windows to echo the parameters passed to the script:

echo pathname to scripts directory: %1
echo name of monitor causing alert: %2
echo current status monitor: %3
echo pathname to alert message file: %4
echo id code of monitor: %5 echo group for the monitor: %6

In addition to the default parameters, there are two other mechanisms for passing parameters and data to
scripts. One is to use the additional Parameters box in the Script Alert Settings. The seventh default
parameter passed to the script, which is any additional parameters specified on the alert form, enables you to
specify one or more custom parameters to be sent to the script. The other is to access the Alert Message file.
For details, see "How to Pass Parameters and Data to Scripts.Using the Script Alert Settings" below and
"How to Pass Parameters and Data to Scripts Using the Alert Message File" on the next page.

Tasks
How to Pass Parameters and Data to Scripts.Using the Script Alert Settings
This task describes the steps involved in passing parameters and data to scripts using the script alert
settings. This is the simplest way to send additional custom parameters and data to a script.

1. Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or select an existing
alert in the Alerts tab (monitor or template view) and click theEdit Alert button. In the Alert Actions

section of the New/Edit Alert dialog box, click theNew Alert Action button.
2. In the Action Type dialog box, select theScript action type, and configure the script alert as described in

"Script Alert Properties" on page 1109.
Specify additional custom parameters and data to script is to use in theParameters box.
These parameters can be hard-coded values. You can includemultiple parameters by separating the
individual parameters by spaces. For example, assume you want to pass the four text strings shown
below to a script. To do this you type them in the Parameters box as follows:

These would then become the seventh (7th) through tenth (10th) command line parameters sent to the
script. The followingWindows batch file script would print the default parameters as well as the
additional example custom parameters entered in the Parameters box of the Action Types Settings
Page:

echo pathname to scripts directory: %1
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echo name of monitor causing alert: %2
echo current status monitor: %3
echo pathname to alert message file: %4
echo id code of monitor: %5
echo group for the monitor: %6
echo seventh parameter(customA): %7
echo eighth parameter(customB): %8
echo ninth parameter:(customC) %9
shift
echo tenth parameter(customD): %9

Note: To use tenth parameter (or more), youmust use the "shift" command.

How to Pass Parameters and Data to Scripts Using the Alert Message File
This task describes passing parameters and data to scripts using the Alert Message file. This is a file that is
created by SiteScope using the alert template specified in the Alert Action dialog box ("Action Type Settings
Panel" on page 1102). You can create your own custom alert templates and pass custom text strings or any of
the SiteScope parameters available.

The following shows the default NTEventLog template included with SiteScope. The parameters marked with
< > brackets are replaced with the applicable values to and written to the Alert Message file each time the
applicable Script Alert is triggered.

For a list of the common properties found in SiteScope alert templates, see "Properties Available in Alerts,
Templates, and Events" on page 1126.

The NTEventLog Script Alert Template
Type: <eventType>
Event Time: <eventTime>
Source: <event>
Source ID: <eventID>
Category: <eventCategory>
Machine: <eventMachine>
Message: <eventMessage>
Monitor: <name>
Group: <group>
Sample #: <sample>
Time: <time>
<mainParameters>
<mainStateProperties>

To use this data in a script, your script needs to access the Alert Message file at the pathname location
specified by the fourth default command line parameter (see "Working with Scripts in SiteScope" on
page 1122). Then the script has to parse the content of the Alert Message file to extract the data you want to
use in your script.

For more examples of how to write recovery scripts, look at the script files in the
<SiteScope root directory>\scripts directory. You can use the actionTest.bat example template to create
your own script. The perlTest.pl example shows how to call a Perl script. The restartIIS.bat,
restartService.bat, and restartServer.bat scripts implement common recovery actions.

Using SiteScope
Chapter 105: Write Scripts for Script Alerts

HPE SiteScope (11.33) Page 1124 of 1206



For the UNIX environment, the examples scripts are called action Test.sh and perlTest.pl.

Using SiteScope
Chapter 105: Write Scripts for Script Alerts

HPE SiteScope (11.33) Page 1125 of 1206



Chapter 106: Properties Available in Alerts,
Templates, and Events
The following properties can be found or used in SiteScope alerts, alert and email templates, and common
event mappings for sending events to management consoles.

This section includes:

l "Alerts, Alert Template, and Event Properties" below
l "Common Event Template Properties" on page 1135
l "Microsoft Windows Event LogMonitor Properties" on page 1136
l "Email Report Properties" on page 1136

Alerts, Alert Template, and Event Properties
The following is a list of the common properties found in SiteScope alerts, alert templates, and attributes used
in common event mappings (for monitor and alert events).

Note:

l Attributes in event mappings have an additional left ("<") and right (">") angle bracket which is not
shown in the table below.

l a indicates whether properties can be used in alerts and/or common event mappings (associated
with amonitor or an alert).

l Where properties are included in specific alert templates, the relevant templates are listed in the
Included in Alert Template column.

Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<alertHelpURL> URL of the SiteScope help including
the alert topic.

NoDetails

Traceroute

WithDiagnostic

a a a

<alertShortAnalyticsResults> Correlation that shows the monitor
status of the 5 highest counters of the
Analytics Target monitors.

This property is supported for alert
events (monitor status change only)
in the SiteScope Event Console and
OMi. It is not supported in Generic
Event Integration or for metrics status
changes events (monitor events).

a a

<alert::actionID> The ID for the alert action. a

<alert::actionName> The name of the alert action. a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<alert::description> Text description for the alert
definition.

a

<alert::disable
Description>

Description of the purpose of the
disable operation.

a

<alert::id> The alert ID. a

<alert::name> The name of the alert. a

<all> All of the properties of the monitor. a a a

<allThresholds> Returns all the thresholds in the
monitor in the email alert.

a a a

<analyticsResults> Shows a summary of analytics
results, which includes:

l Name of analyzed monitor and
name of analytics object.

l All correlation results or top 500
best fitting ones per analyzed
(source) monitor metric.

l For an alert triggered by a static
threshold: metrics that are in the
status for which the alert was
triggered.

l For an alert triggered by
Analytics: metrics of the monitor
which are out of the baseline
sleeve.

This property is not supported in
events; for alert events (monitor
status change); use the
<alertShortAnalyticsResults>
property instead.

AnalyticsMail

<bacMonitorID> The monitor's APM ID. a

<bacSessionID> The APM profileID. a

<category> The monitor category. Typical a a a

<changedToErrorOnly> Shows only the metrics that have
changed to error status.

a a a

<changedToWarningOnly> Shows only the metrics that have
changed to warning status.

a a a

<changedToGoodOnly> Shows only the metrics that have
changed to good status.

a a a

<classifier>
(or _<classifier>)

Returns the first threshold in the
monitor in the email alert.

a a a

<currentTime> The time that the alert is run. a a a

Using SiteScope
Chapter 106: Properties Available in Alerts, Templates, and Events

HPE SiteScope (11.33) Page 1127 of 1206



Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<customerId> Customer ID for SAAS environment a a a

<_description> Displays the description entered in
the Report description field of the
monitor's General Settings that
makes it easier to understand what
the monitor does. This description is
displayed on each bar chart and
graph in Management Reports.

a a a

<diagnosticText> Calculates a string from other
properties that the monitor is able to
return. The translation can be
different for different types of monitors
because every monitor can choose a
different value combination for this
property.

Default User

NoDetails

WithDiagnostic

a a a

<diagnosticTrace
Route>

This tag is filled only for warning and
error conditions when the Traceroute
Email template is used with the URL
Content monitor.

Traceroute

WithDiagnostic

a a a

<errorCounterOnly> List of the monitor counters in error
status (returns counter name only).

a a a

<errorOnly> List of the monitor counters in error
status (returns counter name and
counter value).

Typical a a a

<firstgroupdescription> Partial group description. Only the
first description from several different
ones.

a a a

<fullgroupdescription> Full group’s description. a a a

<FullGroupId> Full path from the SiteScope root
directory to the group,
exclude\SiteScope.

a a a

<fullMonitorName> Full path from the SiteScope root
directory to the monitor. For example,
\SiteScope\MyGroup\MyCPUMonitor.

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<gethostname> Displays the host name for the
monitor. This is used to prevent the
wrong host name being displayed in
alerts where it does not have the
target server name. For a URL
monitor, this property displays the
URL in the format: www.<host
address or domain name>/
(without the resource prefix and
path).

Note: This property does not show
the host name if the target server is
the localhost machine (the machine
where SiteScope is running).

a

<goodCounterOnly> List of the monitor counters in good
status (returns counter name only).

Typical a a a

<goodOnly> List of the monitor counters that are in
good status.

Typical a a a

<group> Name of the group in which the
monitor is located.

AllErrors

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlogt

PagerMail

ShortMail

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<groupdescription> Full group’s description and group’s
parent description.

a a a

<groupID> ID of the group. Default

Typical

WithDiagnostic

XMLMail

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<group.propertyname> Property of the group in which the
monitor is located. Group properties
that can be used in the tags include:
_externalId, _
dependsCondition, _name, and _
topazId.

a a a

<group.parent.
propertyname>

Property of the parent group of the
group in which the monitor is located.
Group properties that can be used in
the tags include: _externalId, _
dependsCondition, _name, and _
topazId.

a

<_httpPort> Port number used to access
SiteScope (as in Email Report
Properties)

NTEventlog a a a

<id> Current monitor’s ID number. It
identifies the monitor within the group

XMLMail a a a

<_instructiontext> Enables instructions or help text to be
included in SiteScope messages
when events are sent to Operations
Manager/OMi.

a a a

<mainParameters> List of the main monitor properties
that are set as parameter.

Default

Default User

NTEventlog

WithDiagnostic

a a a

<mainStateProperties> List of main monitor properties that
are set as state properties. These are
the result statistics that are shown on
the Reports.

Default

Default User

NTEventlog

WithDiagnostic

a a a

<matchedLine> Use for Multi Log monitor when the
"For each log entry matched" option
is selected in Run alerts. When this
property is used, the monitor status
displays the whole line instead of just
the matched content and the file
where it was found.

a

<monitorClass> The monitor’s class name. a a

<monitorDrilldownUrl> Creates a hyperlink in the event to
the monitor URL.

a a a

<monitorDrilldown
Url
Secured>

Creates a hyperlink in the event to
the monitor URL without login
information in the link itself.

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<_monitorDescription> Displays the description of the
monitor entered in the Monitor
description field of the monitor's
General Settings.

a a a

<monitorName> Name of the monitor.

(same as "<name>")

a a a

<<monitorServiceId>> Enables customizing the service
name that is sent from SiteScope
events to HPOM by entering the
value of the monitor service ID. This
is useful for relating the SiteScope
monitor with the HPOM Service
Name.

a a a

<monitorType> The type of monitor, such as CPU. a a a

<monitorTypeDisplay
Name>

The Monitor’s class Topaz name a a a

<monitorUUID> Monitor’s UUID a a a

<mountName> Returns mount names. This is
applicable when monitoring remote
UNIX servers while using the
Dynamic Disk Space monitor.

a a a

<multiViewUrl> Creates a hyperlink to the SiteScope
Multi-View URL.

a a a

<name> Name of the monitor.

(same as "<monitorName>")

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlog

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<newSiteScopeURL> URL of the SiteScope server. Default

Typical

a a a

<processtext> Process Stats, only relevant if the
object has a machine.

a a a

<remoteMachineName> Displays the name of the configured
remote server used by the monitor.

a a a

<sample> Sample # AllErrors

AnalyticsMail

Default

Default User

NoDetails

NTEventlog

PagerMail

ShortMail

Traceroute

Typical

Typical.mail

WithDiagnostic

XMLMail

a a a

<sitescopeurl> URL of the SiteScope server with
extra account information.

a a a

<siteScopeBaseUrl> URL of the SiteScope server in a
different format.

a a a

<siteScopeHost> URL of the SiteScope host name. a a a

<secondaryParameters> Lists the main state properties and
other internal properties.

a a a

<secondaryState
Properties>

Lists the main state properties and
other internal properties.

a a a

<sitescopeURL> The URL to the main page of
SiteScope for admin access.

AllErrors

Default User

NoDetails

Traceroute

WithDiagnostic

a a a

<sitescopeuserurl> The URL to the main page of
SiteScope for user access.

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<state> Status string reported by the monitor.

(same as stateString)

AllErrors

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<tag> Tags of the monitor (if exists). AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlog

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<tag:[tagName]> Displays the value or values of the
Search/Filter tag with the [tagName]
assigned to the monitor that triggered
the alert.

Example: You have a tag named
AppServer with value Apache
assigned to a monitor, and you
include <tag:AppServer> in the alert
template configured for that monitor.
If an alert is triggered, the new
property is replaced with Apache in
the alert text.

a a a

<targetHost> Name of the target host. a a a

<targetIP> IP of the target host. a a a

<targetIPAsHEX> IP of the target host in HEX fomat. a a a

<targetIPVersion> Retrieves monitor host IP version
(IPV6 or IPV4).

a a a

<templateDeployPath> Displays the path of the template
group from which the monitor was
deployed.

a a a

<time> Time that the monitor completed the
last run.

AllErrors

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlog

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<time-date> The date portion of the time that the
monitor completed.

a a a

<time-time> The time portion of the time that the
monitor completed.

a a a

<warningCounterOnly> List of the monitor counters in
warning status (returns counter name
only).

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<warningOnly> List of the monitor counters in
warning status (returns counter name
and counter value).

Typical a a a

<unifiedConsoleUrl> Opens the Ops View in the Unified
Console, which displays Multi-View
and the Event Console.

a a

<_webserverAddress> IP address for the SiteScope Server
(as in Email Report Properties)

NTEventlog a a a

Common Event Template Properties
The followingmetric specific properties are resolved from themonitor‘s counter data and should be used in the
Common Event Template for monitor events only.

These properties are relevant for monitor events because they are triggered by a specific metric change. They
are not relevant for alert events because they are triggered by a status change, which is a single state that can
be resolved from several metric changes.

Available Properties Description

<metric> The name of the counter that triggered the alert.

<metricValue> The ETI value associated with the threshold that has been crossed.

<newStatus> Current status of themetric.

<oldStatus> Previous status of themetric.

<etiValue> The ETI value associated with the threshold that has been crossed.

<etiType> The ETI type associated with the counter that crossed the threshold that created
the event.

<thresholdCrossed> The display name of the threshold setting that was crossed.

<thresholdCrossedFull> The full string representation of the threshold setting that was crossed. It also
contains the ETI value and the status associated with this threshold, which
uniquely identifies the threshold.

<severity> Severity of the occurrence that the event relates to.

<ciHint> Information about the CI that is related to the event. This attribute is for providing
one or several hints that enables the event processing to find the correct "related
CI".
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Available Properties Description

<subCiHint> Information used to identify a subcomponent of a CI. This CI subcomponent is
used to calculate an aggregated status within APM's Service Health for selected
CIs.

If an HI is populated by events frommultiple components, you can specify a
component name in this field in order to ensure the correct calculation of the HI
state.

Example: If you have a Computer CI with two CPUs, cpu #1 and cpu #2, events
from both CPUs will be sent to the sameCPU Load HI. By default, the events
will overide each other and create an incorrect HI state. To prevent this, you can
populate ComponentCi with values "cpu #1" and "cpu #2" which will cause the
HI state to be calculated as an aggregated state between the two events.

<alertName> The name of the alert.

Microsoft Windows Event Log Monitor Properties
The following properties can only be used in theMicrosoft Windows Event Logmonitor. They can be used in
SiteScope alerts, alert templates, and common event mappings (monitors and alerts).

Available Properties Included in Templates

<eventCategory> NTEventlog

<eventID> NTEventlog

<eventMachine> NTEventlog

<eventSource> NTEventlog

<eventType> NTEventlog

Email Report Properties
The following properties are applicable to the email templates stored in the <SiteScope>\templates.history
directory:

Available Properties Description

_httpPort Port number used to access SiteScope

_webserverAddress IP address for the SiteScope Server

basicAlertSummary Basic information on what alerts have been triggered

detailAlert Summary More detailed information on alerts

reportIndexURL URL to the index page for themanagement report

reportPeriod Time period for this report
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Available Properties Description

reportURL URL to the HTML version of themanagement report

summary Summary andmeasurement information

textReportURL URL to the comma-delimited file generated by SiteScope

userReportIndexURL URL to the index page for a user-accessible report

userTextReportURL URL to the comma-delimited file generated by a user-accessible report

userXMLReportURL URL to the XML file generated by a user-accessible report

xmlReportURL URL to the XML file generated by themanagement report
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Part 14: Reports
SiteScope reports display information about how the servers and applications you aremonitoring have
performed over time. SiteScope reports are important tools in monitoring and troubleshooting operational
performance and availability and reviewing themonitored environment.

You can create a report for a single monitor, several monitors, or even a number of monitor groups. Report
definitions include report content options such as tables of specific monitor measurements, summaries of
results, and graphs. For details, see "Create SiteScope Reports" on page 1139.

You can also create a Server-Centric report for Microsoft Windows and UNIX Resources monitors, which
displays data from three different metrics about the remote server beingmonitored. For details, see "Create
Server-Centric Reports" on page 1179.

SiteScope reports can be valuable tomany people in your organization, includingmanagement personnel in
Sales, Marketing, Customer Support, andOperations. User accounts can be created to enable these users
restricted access to the SiteScope service to view reports. For more information, see "User Management
Preferences" on page 625.

Note: Reports are not available in SiteScope Load Testing edition.



Chapter 107: Create SiteScope Reports
SiteScope can collect multiple preselectedmetrics from a specific server and combine them into a single
graph—giving you quick access to key performancemonitoring data for any server in your environment. One
of the key benefits of server-based reporting is the ability to drill down into reports to troubleshoot server
related issues.

To access
Select theMonitors context. In themonitor tree, select the SiteScope object for which you want to generate a
report, and click theReports tab.

Note: Reports are not available with SiteScope Load Testing edition.

Learn About
SiteScope Report Types
The following describes the report types that are available in SiteScope and their usage.

Report Type Description

Alert Reports Alert reports provide information about SiteScope alerts generated during a specified
period of time. You create an Alert report on an ad hoc basis. As a result, Alert report
settings are not saved to the SiteScope configuration data for later use.

BSM
Configuration
Changes
Report

Displays statistics about the configuration reporting to APM. It should be used for
troubleshooting purposes only. The report is generated from APM. If there aremultiple
SiteScopes reporting to APM, the information displayed in this report includes information
not only for the specific SiteScope selected. The report logs exceptions, such as a failure
to enter data into the profile database.

Note: The report is available only when accessing SiteScope from SAM Administration
and if the user has permission to view SiteScope logs.

Management
Reports

Management reports provide a summary of infrastructure availability and performance
data for a given period of time. Management reports are generated automatically based on
their preset schedule from data collected by SiteScopemonitors. According to the preset
schedule, SiteScope reads the applicable log files and generates the report based on the
monitor metrics for the time interval specified. You can save the report data in a file
suitable for exporting to third-party applications. For more details, see "SiteScope
Management Reports" on the next page.

Monitor
Reports

Monitor reports enable you to review configuration properties and settings for existing
monitors. You create aMonitor report on an ad hoc basis. As a result, Monitor report
settings are not saved to the SiteScope configuration data for later use.
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Report Type Description

Quick
Reports

Quick reports enable you to view monitor data for specific monitors or groups of monitors
during specific time periods. You create a Quick report on an ad hoc basis. As a result,
Quick report settings are not saved to the SiteScope configuration data for later use.

Server-
Centric
Reports

ForMicrosoft Windows and UNIX Resources monitors, you can create a Server-Centric
report which displays data from three different metrics (CPU utilization, memory
utilization, and network utilization) about the remote server beingmonitored. For more
details, see "Create Server-Centric Reports" on page 1179.

SiteScope Management Reports
Reports are added as elements to the Reports tab in themonitor view. They can be added as a child to the
SiteScope node, to a group, or to an individual monitor. Reports are displayed in the left menu tree by a icon
next to the group or monitor for which it was created, as shown in the example below.

Reports have a scope based on the container to which they are added. You add a report to the container or
element that contains all of themonitors whose data you want to include in the report. You then use the
Report Targets panel to narrow the selection of monitors to be included in the report.

When you select a node with a report icon, the Report tab displays two tables. TheReports on table displays
the reports created on this node. TheReports Associated with table displays the reports created on an
ancestor node and applied to this node using the target selection.

You can create as many SiteScope report definitions as you want. However, you should plan and consolidate
reports to keep the number of report definitions to aminimum. This can facilitate report administration and help
reduce redundant report messages or actions. When creating a report for a large number of monitors, consider
making separate reports based on the type of monitor or measurement. For example, when reporting on
system resources for 20 different remote servers, consider making one report with monitors that measure
numeric values such as CPU or disk space and another report for monitors that report basic availability such
as services or processes.

By default, SiteScope keeps the 10most recently generated reports. This means that hourly reports are
available for the last 10 hours, daily reports are available for 10 days, weekly reports are available for 10
weeks, and so forth. You can change this report storage period by changing the value of the _
maximumReports setting in the <SiteScope root directory>\groups\master.config file.

Deleting aManagement report definition discontinues the generation of applicable report. Previously
generated reports continue to be available until the underlying data is removed.

You can copy and paste a report definition. The report definition settings are pasted to the new location with
the exception of theReport targets setting, which are automatically reset to include all of the children of the
container into which the report is pasted. After pasting a report, edit the report definition properties to be sure
that the assignedReport targets are appropriate to the new report context and your overall reporting plan.

You can add a banner to aManagement report by entering the text/HTML in theDescription field of the report.
To create a banner and apply it to all reports that are created, add the _reportHeaderHTML= property and the
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banner text to the <SiteScope root>\groups\master.config file. For example: _
reportHeaderHTML=<p><b>MY CUSTOM BANNER</b></p>

SiteScope Monitor Data Log Files
SiteScopemonitor data available for generating reports is limited to the amount of log data stored on the
SiteScope server. By default, SiteScope retains monitor data log files for 40 days. The log files are rotated and
files older than the log retention period are automatically deleted.

Note:

l Keepingmonitor data logs for longer periods can cause a data storage problem for the SiteScope
server depending on the total number of monitors configured and how often themonitors run per day.
You shouldmonitor the size of log files in the <SiteScope root directory>\logs directory to estimate
the data accumulation rate.

l We recommend allocating aminimum of 10GB storage space on the SiteScope server, and 30 GB for
a high load environment (16,000monitors configured at 2,000monitor runs per minute).

You can change the length of time that SiteScope retains monitor data using the log preferences. You can
configure SiteScope to export monitor data to an external SQL-compliant database tomaintain monitor data
for longer periods or to make the data available to other reporting applications. For details, see "Log
Preferences" on page 597.

Customizing Reports
You can customize the look and feel of SiteScope reports by adding CSS rules to a custom CSS file. CSS, or
Cascading Style Sheets, is a style sheet language used for describing the look and for formatting a document
written in amarkup language.

To do so, add CSS rules to the reports-style-custom.css file is located in <SiteScope root
directory>\conf\custom_css\report.

You can find some examples below. To use any of these examples, just copy and paste them into the
reports-style-custom.css file. Note that these are only examples, and you can add your own rules to adjust
the style of reports as you choose.

Examples:

/*change header style:*/
H2 {
color: #0096d6;
font-weight:500;
margin:0;
font-size:28px;
}

/*change table style:*/
.data-table th, .data-table td {
color: #404040;
font-size: 14px;
border:1px solid #e5e5e5;
height:17px;
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line-height:34px;
padding: 1px 2px 2px 1px;
text-align:center;
padding-left: 5px;
padding-right: 5px;
background-color:white;
}

/*change table header style:*/
.data-table th {
background-color:#efefef;
font-weight:700;
}

/*change table title style:*/
H3,table.data-table caption{
margin:0;
padding:5px;
padding-left:0px;
padding-right:0px;
color:#0096d6;
font-weight:700;
font-size:18px;
text-align:left;
}

Tasks
How to Create a Report
This task describes the steps involved in creating a SiteScope report.

1. Prerequisites
To be able to generate or manage reports, youmust be an administrator in SiteScope, or a user granted
the required reports permissions in User Management Preferences. For details on user permissions, see
"User Management Preferences" on page 625.
If you want to send reports through email, youmust configure the email options (Preferences > Email
Preferences > Default Settings > Edit). For details on email preferences, see Email Preferences.

2. Select a report type
Right-click the group or monitor container in which you want to create a report, and click Reports, or
create a new report from the Reports tab. Select the report type you want to add or generate (only the
Management report is added; all other reports are ad hoc and are not saved in SiteScope).
For details of report types, see "SiteScope Report Types" on page 1139.

3. Configure the report settings
Select themonitors to include in the report and configure the report settings.
For details on configuring the various reports, see "Create SiteScope Reports" on page 1139.
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Note: By default, a report includes data from all monitors within the selected container. For Alert
Reports, you cannot remove any of themonitors in the selected container from the report.

4. Results
Management reports are added to the selected container in themonitor tree (indicated by a report
symbol). All other reports are generated and displayed in yourWeb browser. For details, see "Create
SiteScope Reports" on page 1139.

Note: For information about troubleshooting and limitations of SiteScope reports, see
"Troubleshooting and Limitations" below.

Tips/Troubleshooting
Troubleshooting and Limitations
l When formatting aMonitor report in .csv format, SiteScope replaces some special characters in monitor
properties with different characters. For example, it replaces a comma (,) with a blank space, a double
quotationmark (") with a single quotationmark ('), and other special HTML characters are replaced with
their entities.

l Monitor reports can only be sent by email via the standard SMTP port (25).
l To view certain report elements on SiteScope for UNIX/Linux, it is necessary that an X Window system
be installed and running on the server where SiteScope is running.

l To be able to open reports generated in SiteScope version 9.0 and later after upgrading the SiteScope
installation, create amanual backup of the reports folder <SiteScope root directory>\htdocs, and copy it
to the new installation directory.

l Indicator values are not displayed in SiteScope reports.
l The <SiteScope root directory>\groups\master.config file no longer supports adding your own styling
keys to customize reports. If necessary, you can add styling keys to a custom .css file located in
<SiteScope root directory>\conf\custom_css\report\reports-style-custom.css as described in
"Customizing Reports" on page 1141.

SiteScope Reports User Interface
This section includes:

Creating Reports:

l "New/Edit SiteScopeManagement Report Dialog Box" on the next page
l "New SiteScopeQuick Report Dialog Box" on page 1151
l "New SiteScopeMonitor Report Dialog Box" on page 1156
l "New SiteScope Alert Report Dialog Box" on page 1159
l "Create Server-Centric Reports" on page 1179
l "GraphMetrics Options" on page 1163
l "Mail Details Dialog Box" on page 1164
Viewing Reports:
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l "Reports Page" on page 1166
l "Management Report" on page 1167
l "Quick Report" on page 1172
l "Monitor Summary Report" on page 1175
l "Alert Report" on page 1178
l "Server-Centric Report" on page 1184

New/Edit SiteScope Management Report Dialog Box
This dialog box enables you to create a report that provides a summary of system availability data for a given
time period.

To access Select theMonitors context, and in themonitor tree:

l Right-click the SiteScope node, amonitor group, or amonitor, and select Reports >
Management, or

l Select the SiteScope object for which you want to generate a report, and in theReports
tab, select Create New Report > Management.

Note: Reports are not available with SiteScope Load Testing edition.

Important
information

l To be work with Management reports, youmust be an administrator in SiteScope, or a
user granted theAdd, edit, or delete management report andGenerate management
report permissions in User Management Preferences. For details on user permissions,
see "User Management Preferences" on page 625.

l You can add a banner to aManagement report by entering the text/HTML in the
Description field of the report. To create a banner and apply it to all reports that are
created, add the _reportHeaderHTML= property and the banner text to the <SiteScope
root>\groups\master.config file. For example: _reportHeaderHTML=<p><b>MY
CUSTOM BANNER</b></p>

l Since data for reports is taken from the daily log files (and it takes time for this data to be
written to the log file), theremight be a slight gap in this data being correctly represented
in reports. Therefore, we recommendwaiting about aminute between generating reports
with different Measurement Graph drop down values to avoid incorrect data being
displayed.

l HTML code entered in report text boxes is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans more
than one line). If malicious HTML code or JavaScript is detected, the entire field is
rejected. The following is prohibited HTML content:
l Tags: script, object, param, frame, iframe.

l Any tag that contains an attribute starting with on is declined. For example, onhover

l Any attribute with javascript as its value.

Relevant
tasks

"Create SiteScope Reports" on page 1139
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See also l "Reports" on page 1138
l "Reports Page" on page 1166
l "Management Report" on page 1167

This section includes:

l "General Settings" below
l "Report Targets" below
l "Display Settings" below
l "Filter and Scheduling Settings" on page 1147
l "Report Distribution" on page 1148
l "CalculationMethod" on page 1150
l "Management Settings" on page 1150
l "Search/Filter Tags" on page 1151

General Settings
User interface elements are described below:

UI Element Description

Report title Enter a title for this Management Report. This name is used to identify this Management
Report definition in the product display.

Description (Optional) Use this text box to describe other information about this report definition. For
example, include information about the purpose, target, setup date, or audience for this
report.

Note: If this field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.

Report Targets
User interface elements are described below:

UI
Element Description

Report
targets

Select the groups, monitors, or both, to be included in this report in the context menu tree. The
context menu includes the currently selected container and all of the child containers.

Default value: The current container and all child elements are selected.

Display Settings
User interface elements are described below:

UI Element Description

Thresholds
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UI Element Description

All thresholds Creates a table of monitor error, warning, and good threshold settings for all of the
monitors included in the report. If selected, this table is displayed as the first report
section.

Default value:Not selected

Error
thresholds

Creates a table of individual error readings recorded by themonitors during the report
period.

Default value:Selected

Warning
thresholds

Creates a table of individual warning readings recorded by themonitors during the report
period.

Default value:Selected

Good
thresholds

Creates a table of individual good readings recorded by themonitors during the report
period.

Default value:Selected

Uptime and Readings

Uptime
Summary and
Measurement
Summary
tables

Creates two report tables: Uptime Summary andMeasurement Summary. For
details of the data included in these tables, see "Management Report" on page 1167.

Default value:Selected

Uptime: Include
warnings

Includes any monitor readings that are reported as warnings in the overall Uptime
calculation.

Default value:Not selected

Uptime: Ignore
warnings

Suppresses monitor readings reported as warnings from the overall Uptime and
Readings Summary section.

Note: This option only suppresses the display of theWarning% column in the table; it
does not change the calculation of the Uptime%.

Default value:Not selected

Uptime: Ignore
errors

Suppresses monitor readings reported as errors from the overall Uptime and Readings
Summary section.

Note: This option only suppresses the display of the Error % column in the table; it does
not change the calculation of the Uptime%.

Default value:Not selected

General

Measurements
graph

For graph reports, use the drop-down list to choose a graphical measurement to be
included in the report. For details of the options, see "GraphMetrics Options" on
page 1163.
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UI Element Description

Monitor
readings

Creates a table of individual readings recorded by themonitors during the report period,
including all readings (error, good, and warning). This report table may also include
blank "buckets" depending on the period of the report and how often themonitors ran
during the period.

Default value:Selected

Alerts table Select an option to include a table of alerts sent for themonitors in the report. The
options for the alerts table level are:

l No alerts table. No table of alerts is included in the report (default)
l Basic alerts table. Displays the time and summary information for each alert sent.
l Show detailed alerts table for all alerts. Displays detailed alert information for
each alert in the report.

l Show detailed alerts table for failed alerts. Displays the time and summary
information for each alert, and a full diagnostics breakdown for each failed alert.

Detailed
monitor
information

Displays all of the information gathered for eachmonitor on the report. Otherwise, only
the primary data is displayed for eachmonitor.

Default value:Not selected

Example: If this box is checked on a URL SequenceMonitor, the timing information for
each step in the sequence is displayed in the report.

Time in error Creates a table summary listing eachmonitor selected for the report with a summary of
how many minutes themonitor status was calculated as being in error for the period of
the report.

Default value:Not selected

Filter and Scheduling Settings
User interface elements are described below:

UI
Element Description

Monitor
filter

Select a subset of thosemonitors to be shown in the report —those that have had the specified
status sometime during the report's time frame. You can select only monitors in error or
warning, monitors in error, monitors in warning, monitors that were OK, or all monitors.

Default value:Show all monitors

Example:ChoosingShow only monitors in error displays report data only if that monitor
had spent time in error sometime during the time interval of the report.
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UI
Element Description

Schedule
filter

Select a schedule filter option for showing only a subset of the data in the report—those
monitors that have samples during the time period of the schedule.

Default value: The report shows data for the full period of the report (Every day, all day).

Example:Choosing Weekdays, 09:00-18:00 displays report data for the selectedmonitors
with samples from the 9am to 6pm time period, Monday through Friday. Only this data is used
for all the calculations.

Time
period
for report

Select the time period for which you want to view monitoring data. You can choose to report on
data for a set number of hours, for the last day, the last several days, the past week, past
month, or month-to-date for the current calendar month.

Daily andmonth-to-date reports are generated every day at the scheduled time. Weekly reports
are generated on Sundays at the scheduled time, andmonthly reports are generated on the first
day of themonth following the current month so that they contain an entire month's worth of
data.

Default value: Last day

End of
report
period

Choose an end time for the report by selecting a time from the drop-down list. For example, you
may want to have your reports run frommidnight to midnight.

Default value:At time report is run (SiteScope generates reports starting at the indicated time
and ending at the time the report was generated)

Report Distribution
User interface elements are described below:

UI
Element Description

HTML
format

Select if you want the reports sent in HTML format. Use this option to include the SiteScope
report graphics. If you do not select this option only a text summary of the report is sent.

Default value:Not selected

Send
report to
email
address

To have the report forwarded by email when it is generated, enter the email addresses to which
this report should be sent each time its generated. To send the reports to multiple email
addresses, separate the email addresses with commas. The report is sent as an .HTML file
attached to the email.

Note:Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the "Email
Preferences Default Settings Dialog Box" on page 484.
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UI
Element Description

Format
template

Select a template for SiteScope to use to create the email message. You can choose from the
following templates or make a copy of one of these and customize it to meet your own needs.

l HistoryLongMail - Choose this option to send a detailed history report. It contains both
user and administration links.

l HistoryLongXMLMail - Choose this option to send a detailed history report. It contains
both user and administration links for reports & XML files.

l HistoryMail - Choose this option to send a history report. This is the default option.
l HistoryMailAlertDetail - Choose this option to have all alerts included in the report that is
sent by email.

l HistoryMailNoLinks - Choose this option to send the report without any links in it.

Comma-
delimited
file

Select to save a generatedmanagement report to a comma-delimited text file which you can
then import into a spreadsheet application.

SiteScope automatically saves these files in the <SiteScope root directory>\htdocs
directory. To find the exact location of the saved file on your machine, click theView Report
tab for the report, andmove the pointer over the text link for the report in the Information For
column. The full path to the file is listed in the status bar of yourWeb browser. To open the
saved file on your machine, click the text link to go to the Report page. If you enter an email
address in theEmail text box, SiteScope sends a copy of the comma-delimited file to that
address.

Default value: Not selected

Note: The comma-delimited file creates two columns for eachmonitor reading; one containing
the value with units, and the other containing just the value. This is to make it easier to import
the comma-delimited data into a third-party application whichmay not automatically separate
data values from the text describing the units.

Send
comma-
delimited
file by
email

If you enter an email address in the text box, SiteScope sends a copy of the file to that
address.
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UI
Element Description

XML file Select this box to save a generatedmanagement report to an XML text file. SiteScope
automatically saves these files in the <SiteScope root directory>\htdocs directory. To find
the exact location of the saved file on your machine, click theView Report tab for the report,
andmove the pointer over the xml link for the report in the Information For column. The full
path to the file is listed in the status bar of yourWeb browser. To open the saved file on your
machine, click the xml link to go to the Report page. If you enter an email address in theEmail
text box, SiteScope sends a copy of the comma-delimited file to that address.

Default value: Not selected

Note: The XML file creates two columns for eachmonitor reading; one containing the value
with units, and the other containing just the value. This is to make it easier to import the XML
data into a third-party application whichmay not automatically separate data values from the
text describing the units.

Send
XML file
by email

If you enter an email address in the text box, SiteScope sends a copy of the XML file to that
address.

Calculation Method
User interface elements are described below:

UI
Element Description

Time
between
samples

Use this time scale option to choose the time interval betweenmonitor readings. You can
choose intervals that range from once every minute to once a day, or you can use the
automatic scaling. When automatic scaling is used, SiteScope determines how many
readings were taken over the chosen time period for the givenmonitors and then selects an
appropriate interval for themanagement report.

Default value:Automatic time scale

Maximum
graph
value

Select a vertical scale option to choose themaximum value displayed on a graph. Choosing a
specific scale valuemakes it easier to compare graphs from different monitors and times.

Default value:Automatic vertical scale

Management Settings
User interface elements are described below:

UI
Element Description

Disable
report

Select to temporarily disable the generation of this report. To enable the report again, clear the
box.

Default value:Not selected
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UI
Element Description

Generate
report at
(HH:MM)

The time that you want SiteScope to create this management report. The report contains
information for the last day, week, or month, ending at the time the report is run. For example, if
a daily report is generated at 18:00 (6:00 p.m.), it contains data generated between 18:00 the
previous day and 18:00 of the current day. The default value is 00:00 which represents
midnight.

Default value: 04:00

Tip: Try to schedule reports to be generated during off-peak hours relative to overall monitoring
tasks and load, since report generationmay temporarily affect overall SiteScope performance
and responsiveness (depending on the number of monitors and time period of the report). If you
are generatingmany reports each day, consider staggering theGenerate report at value for
different reports

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the SiteScope, this
section appears but is empty. If tags have been created, they are listed here and you can select
them as required.

For concept details, see "Filter Objects in the SiteScope View" on page 65.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 617.

Note: A bar graph is generated using standard HTML, so it can be printed from all browser types. Line
graphs are generated using a java applet andmay not print directly from all browsers.

New SiteScope Quick Report Dialog Box
This dialog box enables you to create a one-time SiteScopemanagement report for any monitor or group of
monitors over a given time period.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, amonitor
group, or amonitor, and select Reports > Quick. (Alternatively, select the SiteScope object
for which you want to generate a report, and in theReports tab, select Create New Report
> Quick). Configure the report properties, and click Generate Report.

You can also create a report using preconfigured settings by selecting amonitor and clicking

theQuick Report button in the SiteScope Dashboard.

Note: Reports are not available with SiteScope Load Testing edition.
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Important
information

l The time interval for a Quick report is not incremented automatically. This means that a
Quick report always contain the data for the absoluteReport period interval defined in
the report definition. To view more recent data using aQuick report, edit theReport
period setting.

l To generate a report, youmust be an administrator in SiteScope, or a user granted the
Generate quick report permission in User Management Preferences. For details on
user permissions, see "User Management Preferences" on page 625.

l Since data for reports is taken from the daily log files (and it takes time for this data to be
written to the log file), theremight be a slight gap in this data being correctly represented
in reports. Therefore, we recommendwaiting about aminute between generating reports
with different Measurement Graph drop down values to avoid incorrect data being
displayed.

l Whenworking in APM, Quick Report definitions in SAM Administration are stored only
with the APM context. Quick Report definitions are not stored in, and do not persist on
the SiteScope server.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also l "Reports" on page 1138
l "Quick Report" on page 1172

This section includes:

l "Report Targets" below
l "Display Settings" on the next page
l "Filter and Scheduling Settings" on page 1155
l "Report Format" on page 1155
l "Report Distribution" on page 1156
l "CalculationMethod" on page 1156

Report Targets
User interface elements are described below:

UI
Element Description

Report
targets

Select the groups, monitors, or both, to be included in this report in the context menu tree. The
context menu includes the currently selected container and all of the child containers.

Default value: The current container and all child elements are selected.
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Display Settings
User interface elements are described below:

UI Element Description

Thresholds

All thresholds Creates a table of monitor error, warning, and good threshold settings for all of the
monitors included in the report. If selected, this table is displayed as the first report
section.

Default value:Not selected

Error
thresholds

Creates a table of individual error readings recorded by themonitors during the report
period.

Default value:Selected

Warning
thresholds

Creates a table of individual warning readings recorded by themonitors during the report
period.

Default value:Selected

Good
thresholds

Creates a table of individual good readings recorded by themonitors during the report
period.

Default value:Selected

Uptime and Readings

Uptime
Summary and
Measurement
Summary
tables

Creates two report tables: Uptime Summary andMeasurement Summary. For
details of the data included in these tables, see "Quick Report" on page 1172.

Default value:Selected

Uptime: Include
warnings

Includes any monitor readings that are reported as warnings in the overall Uptime
calculation.

Default value:Not selected

Uptime: Ignore
warning

Suppresses monitor readings reported as warnings from the overall Uptime and
Readings Summary section.

Default value:Not selected

Note: This option only suppresses the display of theWarning% column in the table; it
does not change the calculation of the Uptime%.

Uptime: Ignore
errors

Suppresses monitor readings reported as errors from the overall Uptime and Readings
Summary section.

Default value:Not selected

Note: This option only suppresses the display of the Error % column in the table; it does
not change the calculation of the Uptime%.
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UI Element Description

General

Measurements
graph

For graph reports, use the drop-down list to choose a graphical measurement to be
included in the report. For details of the options, see "GraphMetrics Options" on
page 1163.

Default value:Bar Graph - one graph per measurement

Monitor
readings

Creates a table of individual readings recorded by themonitors during the report period,
including all readings (error, good, and warning). This report table may also include
blank "buckets" depending on the period of the report and how often themonitors ran
during the period.

Default value:Selected

Alerts table Select an option to include a table of alerts sent for themonitors in the report. The
options for the alerts table level are:

l No alerts table. No table of alerts is included in the report (default).
l Basic alerts table. Displays the time and summary information for each alert sent.
l Show detailed alerts table for all alerts. Displays detailed alert information for
each alert in the report.

l Show detailed alerts table for failed alerts. Displays the time and summary
information for each alert, and a full diagnostics breakdown for each failed alert.

Detailed
monitor
information

Displays all of the information gathered for eachmonitor on the report. Otherwise, only
the primary data is displayed for eachmonitor.

Example: If this box is checked on a URL SequenceMonitor, the timing information for
each step in the sequence is displayed in the report.

Default value:Not selected

Time in error Creates a table summary listing eachmonitor selected for the report with a summary of
how many minutes themonitor status was calculated as being in error for the period of
the report.

Default value:Not selected
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Filter and Scheduling Settings
User interface elements are described below:

UI
Element Description

Monitor
filter

Select a subset of thosemonitors to be shown in the report —those that have had the specified
status sometime during the report's time frame. You can select only monitors in Error or
Warning, monitors in Error, monitors inWarning, monitors that were OK, or all monitors.

Default value:Show all monitors

Example:ChoosingShow only monitors in error displays report data only if that monitor
had spent time in error sometime during the time interval of the report.

Schedule
filter

Select a schedule filter option for showing only a subset of the data in the report—those
monitors that have samples during the time period of the schedule.

Default value: The report shows data for the full period of the report (Every day, all day).

Example:ChoosingWeekdays, 09:00-18:00 displays report data for the selectedmonitors
with samples from the 9am to 6pm time period, Monday through Friday. Only this data is used
for all the calculations.

Report
period

Specify the time period for which you want to view monitoring data. Enter the time from which
you want the report coverage to start in the From boxes and the time to which you want to
cover in the To boxes.

Default value: The time period is from one hour before the time that the Quick Report is
generated until the current time. You can set the default time period for includingmonitoring
data in the Quick report by configuring theDefault time length for report (hours) setting in
Preferences > Infrastructure Preferences > Report Settings.

Note: Times should be entered in 24-hour format.

Report Format
User interface elements are described below:

UI
Element Description

Report in Select the format to be used in displaying the report: HTML format, Text format or XML
format.

Default value:HTML format
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Report Distribution
User interface elements are described below:

UI
Element Description

Send
report
to email
address

To have the report forwarded by email when it is generated, enter the email addresses to which
this report should be sent each time its generated. To send the reports to multiple email
addresses, separate the email addresses with commas. The report is sent as a .HTML file
attached to the email.

Note:Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the "Email
Preferences Default Settings Dialog Box" on page 484.

Calculation Method
User interface elements are described below:

UI
Element Description

Time
between
samples

Use this time scale option to choose the time interval betweenmonitor readings. You can
choose intervals that range from once every minute to once a day, or you can use the
automatic scaling. When automatic scaling is used, SiteScope determines how many
readings were taken over the chosen time period for the givenmonitors and then selects an
appropriate interval for themanagement report.

Default value:Automatic time scale

Maximum
graph
value

Select a vertical scale option to choose themaximum value displayed on a graph. Choosing a
specific scale valuemakes it easier to compare graphs from different monitors and times.

Default value:Automatic vertical scale

New SiteScope Monitor Report Dialog Box
This dialog box enables you to create a report that provides detailed information about themonitors defined in
one or moremonitor groups.

To access Select theMonitors context, and in themonitor tree:

l Right-click the SiteScope node, amonitor group, or amonitor, and select Reports >
Monitor, or

l Select the SiteScope object for which you want to generate a report, and in theReports
tab, select Create New Report > Monitor.

Note: Reports are not available with SiteScope Load Testing edition.

Important
information

To generate a report, youmust be an administrator in SiteScope, or a user granted the
Generate monitor summary report permission in User Management Preferences. For
details on user permissions, see "User Management Preferences" on page 625.

Using SiteScope
Chapter 107: Create SiteScope Reports

HPE SiteScope (11.33) Page 1156 of 1206



Relevant
tasks

"Create SiteScope Reports" on page 1139

See also l "Reports" on page 1138
l "Monitor Summary Report" on page 1175

This section includes:

l "Monitor Report Toolbar" below
l "Monitor Report Table Toolbar" on the next page

Monitor Report Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element Description

Collapse report filter. Click to collapse or expand the report filter.

When the report filter is selected, the SiteScopemonitor tree is displayed. Select the groups,
monitors, or both, to be included in this report. The tree includes the currently selected container
and all of the child containers.

Default value: The current container and all child elements are selected.

Run. After you have selected the groups andmonitors to include in the report, click theRun
button to run the report.
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UI
Element Description

Format report data as... Click to display the options available to format the report. Once the
report is formatted you can save it to your local machine.

Select the format for the file:

l Printer-Friendly. Formats the report so it is ready to be send to a printer.
Tip:Before printing, ensure that printer settings are set to print the selected frame, and not to
print frames as laid out on screen.
To obtain optimal print results if you are usingMicrosoft Internet Explorer, enable the Print
background color and images option (Tools > Internet Options > Advanced tab >
Printing).

l PDF. Formats the report using the PDF format. To enable displaying characters in all
languages in your PDF file, youmust make sure the Arial UnicodeMS font file is available on
your server as follows:

1. Navigate to the font library on your system. For example, inWindows: C:\Windows\Fonts
2. Download the Arial UnicodeMS font into the selected font library. The font is available
from: http://www.microsoft.com/typography/fonts/family.aspx?FID=24.
3. Restart the server.

l CSV. Formats the report using the .csv format.
l Excel. Formats the report using the Excel format.
l XML. Formats the report using the XML format.

l Help. Accesses the online help for this menu option.

Export report to... Displays the options available to export the report.

l Email. Opens theMail Details dialog box where you can configure how to send the report
using email. For details on the user interface, see "Mail Details Dialog Box" on page 1164.
Note:
l SiteScope is unable to export the report to email if themail server is defined to use SSL
SMTP (in the "Email Preferences Default Settings Dialog Box" on page 484).

l Monitor reports can only be sent by email via the standard SMTP port (25).

l Help. Accesses the online help for this menu option.

Monitor Report Table Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Report targets> Displays themonitors to be included in this report, and the information
selected in the Select Columns dialog box.
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UI Element Description

Reset Column Width. Resets the table columns' width to its default
setting. You can adjust the width of the table's columns by dragging
the borders of the column to the right or the left.

Select Columns. Select themonitor information to display in the
report columns. Data is shown in the report table for the selected
parameters only if the particular option has been selected, such as
Disabled and Frequency, or if a value has been supplied, such as
Monitor Description. If the option or value has not been defined in
the particular monitor setup, the column is blank for that parameter for
that monitor.

Note:Hold down the SHIFT key to select a set of adjacent groups.
Use CTRL-click to select non-adjacent items.

Divides a table of data or a list of reports into pages. Youmove from
page to page by clicking the relevant button:

l To view the next/last page in the report, click theNext/Last page
button.

l To view previous/first page in the report, click thePrevious
page/First page buttons.

<Monitor information columns> Displays the SiteScopemonitors to be included in this report, and the
information for the selected columns. For the list of available columns
and descriptions, see "Monitor Summary Report" on page 1175.

To sort a report by a specific column, click the column header. If the
column is sortable, a small arrow icon is displayed. The direction of
the arrow indicates the column's sorting direction
(ascending/descending).

Click the icon to change the sorting direction.

When a column is used to sort the report, the column header is colored
a darker blue.

New SiteScope Alert Report Dialog Box
This dialog box enables you to create a report used to display SiteScope alerts sent over a given time period.

To access Select theMonitors context, and in themonitor tree:

l Right-click the SiteScope node, amonitor group, or amonitor, and select Reports >
Alert.

l Select the SiteScope object for which you want to generate a report, and in theReports
tab, select Create New Report > Alert.

Note: Reports are not available with SiteScope Load Testing edition.
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Important
information

To generate an alert report, youmust be an administrator in SiteScope, or a user granted the
Generate alert report permission in User Management Preferences. For details on user
permissions, see "User Management Preferences" on page 625.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also l "Reports" on page 1138
l "Alert Report" on page 1178

This section includes:

l "Alert Report Toolbar" below
l "Alert Report Table Toolbar" on page 1162

Alert Report Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Filter/Collapse report filter. Click to collapse or expand the report filter. When the
report filter is selected:

l Select a time-range that you want the report to cover from the Time-range bar
(described below).

l Select the groups, monitors, or both, to be included in this report from the left pane.
The tree includes the currently selected container and all of the child containers. By
default, the current container and all child elements are selected.

l Select the Alert types to be included in this report from the right pane. By default, all
alert types are selected.
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UI Element Description

<Time-range bar> The report's granularity includes: the time-range and the time-unit.

l View. Select a time-range that you want the report to cover: Past hour, Past day,
Past week, Hour, Day, Week, or Custom (a user-defined time period)

l Use the buttons as follows:
l Back. Displays the report one time frame earlier than the currently displayed
time frame.
For example, if the value of theView box is Day, clicking this button displays data
for one day earlier than the currently displayed report.

l Forward. Displays the report one time frame later than the currently displayed
time frame.
For example,if the value of theView box is Hour, clicking this button displays data
for one hour later than the currently displayed report.

l From-To. Click the links to display a calendar where you can configure the start and
end date and time for the report.The calendar contains the following buttons:
l Current. Selects today's date in the calendar.

l Cancel. Closes the calendar without making any changes.

l OK. Updates the date link for the selected date and closes the calendar.

Run. After you have selected the time-range, groups, monitors, and alert types to include
in the report, click theRun button to generate the report.
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UI Element Description

Format report data as... Displays the options available to format the report. Once the
report is formatted you can save it to your local machine.

Select the format for the file:

l Printer-Friendly. Formats the report so it is ready to be send to a printer.

Tip:Before printing, ensure that printer settings are set to print the selected frame,
and not to print frames as laid out on screen. To obtain optimal print results if you are
usingMicrosoft Internet Explorer, enable the Print background color and images
option (Tools > Internet Options > Advanced tab > Printing).

l PDF. Formats the report using the PDF format. To enable displaying characters in
all languages in your PDF file, make sure the Arial UnicodeMS font file is available
on your server as follows:
1. Navigate to the font library on your system. For example, inWindows:
C:\Windows\Fonts

2. Download the Arial UnicodeMS font into the selected font library. The font is
available from the following web site:
http://www.microsoft.com/typography/fonts/family.aspx?FID=24.
3. Restart the server.

l CSV. Formats the report using the .csv format.
l Excel. Formats the report using the Excel format.
l XML. Formats the report using the XML format.

l Help. Accesses the online help for this menu option.

Export report to... Displays the options available to export the report.

l Email. Opens theMail Details dialog box where you can configure how to send
the report using email. For details on the user interface, see "Mail Details Dialog Box"
on page 1164.
Note:SiteScope is unable to export the report to email if themail server is defined to
use SSL SMTP (in the "Email Preferences Default Settings Dialog Box" on
page 484).

l Help. Accesses the online help for this menu option.

Alert Report Table Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Reset Column Width. Resets the table columns' width to its default
setting. You can adjust the width of the table's columns by dragging the
borders of the column to the right or the left.

Using SiteScope
Chapter 107: Create SiteScope Reports

HPE SiteScope (11.33) Page 1162 of 1206

http://www.microsoft.com/typography/fonts/family.aspx?FID=24


UI Element Description

Select Columns. Select themonitor information to display in the report
columns. Data is shown in the report table for the selected parameters only if
the particular option has been selected, such as Disabled and Frequency, or
if a value has been supplied, such as Monitor Description. If the option or
value has not been defined in the particular monitor setup, the column is
blank for that parameter for that monitor.

Note:Hold down the SHIFT key to select a set of adjacent groups. Use
CTRL-click to select non-adjacent items.

Divides a table of data or a list of reports into pages. Youmove from page to
page by clicking the relevant button:

l To view the next/last page in the report, click theNext/Last page button.
l To view previous/first page in the report, click thePrevious page/First
page buttons.

<Alert information
columns>

Displays information about SiteScope alerts generated during a specified
period of time for themonitors and alert types selected in the filter. The
information displayed corresponds to the fields selected in the Select
Columns dialog box. For the list of available columns and descriptions, see
"Alert Report" on page 1178.

Note: The report includes all alerts, including alerts from parent groups that
target the selected object.

To sort a report by a specific column, click the column header. If the column
is sortable, a small arrow icon is displayed. The direction of the arrow
indicates the column's sorting direction (ascending/descending).

Click the icon to change the sorting direction.

When a column is used to sort the report, the column header is colored a
darker blue.

Graph Metrics Options
This table includes a description of the graphmetrics options that can be included in the report:

Graph Description

None - no
graph

No graphs are included in the report. The report only includes the tabular data contents
you have selected.

Bar graph -
one graph per
measurement

This bar graph option displays a single type of metric per graph and per monitor during the
specified time frame. For reports onmultiple monitors, this results in themost number of
graphs with one bar graph generated for each type of metric for eachmonitor.
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Graph Description

Line Graph -
one graph per
measurement

This line graph option displays a separate line graph for each type of metric for a single
monitor. Like the bar graph option, this results in themost number of line graphs with one
line graph generated for each type of metric for eachmonitor selected for the report
regardless of any compatibility of metric type.

Line Graph -
group per
monitor
instance

This line graph option groups all similar metrics from a single monitor instance into a
single graph per monitor. For monitor types that contain similar metrics with the same
unit of measurement, (for example, the URL, URLContent, and URL Sequencemonitors
have DNS time, connect time, response time, download time, and roundtrip time which
are all measured inmilliseconds), the report contains one image for these similar metrics
per monitor.

Line Graph -
group same
measurement
types

Select this option to display the samemetrics gathered by several different monitor
instances into single graphs. Metrics of different monitor instances are the same if they
have the following same settings:

l Type
l Units
l Name
A line graph is generated for each set of samemetrics regardless of the number of
monitors selected for the report.

Line Graph -
group
compatible
measurements

Select this option to display the samemetrics gathered by several different monitor
instances of the samemonitor type on a single graph. Metrics of different monitor
instances are the same if they have the following same settings:

l Type
l Units
l Name
The option is intended tominimize the total number of line graphs generated. The number
of graphs generated is still dependent on the compatibility of the selectedmonitor types
and the samemetrics collected by thosemonitors. If all of themonitors selected for the
report are of the same type, for example URLmonitors, then a single graph is generated
for each set of samemetrics (each single graph contains colored lines for eachmonitor).

Note: A bar graph is generated using standard HTML, so it can be printed from all browser types. Line
graphs are generated using a java applet andmay not print directly from all browsers.

Mail Details Dialog Box
This dialog box enables you to configure a report to be sent via email.

To access Click Export report to... and select Email.
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Important
information

If you choose to use amail option that displays the report content in the email client, verify
that the email client does not employ security restrictions which prevent the running of
scripts contained in HTMLmail. Email clients that do employ such restrictions may be
unable to properly display all the report's content.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also l "Reports" on page 1138
l "New SiteScopeMonitor Report Dialog Box" on page 1156
l "Monitor Summary Report" on page 1175

User interface elements are described below:

UI Element Description

Subject Enter a descriptive subject, or accept the default value.

To Enter an email address to which you want to send the report.

Reply-to Enter an email address for receiving replies.

Comments Enter relevant comments, if required.

Send report as Specify the format in which you want to send the report. Choose from the following
options:

l HTML mail. The report is displayed in the email client (the email client must
support, and be configured to display, HTML).

l HTML attachment. The report is displayed in HTML format in a browser.
Note:Youmust have a connection to a SiteScopemachine to enable you to view
the attachment.

Include Images Select the option to include all report resources (for example, graphics) in the email.

Clear the option to remove the images from the email. In such a case, the images are
located on SiteScope servers, and you need a network connection to SiteScope to
access the servers and view the report images.

Note: This option is displayed only whenHTML mail has been selected in theSend
report as field.

Send as
Internet
Explorer
Archived HTML
(.mht)

Select for all report resources (for example, graphics) to be displayed in the browser,
whichmust support MHT format (such as Microsoft Internet Explorer). It is not
necessary to have a connection to a SiteScopemachine to enable you to view the
attachment.

Note: This option is displayed only whenHTML attachment has been selected in the
Send report as field.

Zipped
Attachment

Select to send the attachment in zipped format.

Note: This option is displayed only whenHTML attachment has been selected in the
Send report as field.
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Reports Page
This page displays information about the reports defined in SiteScope. Use this page to add, edit, or delete
report definitions. If a report has been set up for a SiteScope object (group or monitor), the report symbol is
displayed next to the object icon in themonitor tree.

To access Select theMonitors context. In themonitor tree, select the SiteScope object for which you
want to generate a report, and click theReports tab.

Important
information

l Reports created for a specific monitor or group are displayed in the object's Reports on
Monitor/Group list. Targetedmonitors or groups are displayed in theReports
Associated with Monitor/Group list.

l Only a SiteScope administrator user, or a user granted the appropriate report permissions
can generate reports and add or edit management reports. For details on user
permissions, see "Permissions" on page 636.

Relevant
tasks

"Create SiteScope Reports" on page 1139

User interface elements are described below:

UI Element Description

Show Child Reports. Displays only those reports that are direct children of the selected
node.

Show All Descendent Reports. Displays all descendent reports of the selected node.

New Report. Enables you to select the type of report you want to configure. Only
Management reports are added to the Reports tab (all other report types are created on an ad
hoc basis, and are not saved in SiteScope). For user interface details, see "New/Edit
SiteScopeManagement Report Dialog Box" on page 1144.

Note: This button is available in theReports on Monitor/Group table only.

Edit Report. Enables you to edit the properties of the selectedManagement report. For
details on the Edit Management Report user interface, see "New/Edit SiteScope
Management Report Dialog Box" on page 1144.

Copy Report.Makes a copy of the selected report.

Note: This button is available in theReports on Monitor/Group table only.

Paste Report. Pastes the report to the selected location in the tree.

Note: This button is available in theReports on Monitor/Group table only.

Delete Report. Deletes the selectedManagement report from the Reports tab.

Generate Report. Generates aManagement report for a selectedmonitor or group. For user
interface details, see "Management Report" on the next page.

Select All. Selects all listed reports.
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UI Element Description

Clear Selection. Clears the selection.

Type Indicates the report type.

Title The name by which the report is known in SiteScope.

Description A description of the report.

Enabled Indicates whether the generation of this report is enabled.

Path Displays a link to the ancestor node that is targeting this object.

Note: This column is available in theReports associated with table only.

Management Report
This report displays a summary and specific details of infrastructure availability and performance data for
monitors andmonitor groups over a given period of time. UseManagement reports to detect emerging trends
and correct potential problems before they become a crisis.
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To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, amonitor
group, or amonitor container, and select Reports > Management. Configure the report
properties, and click OK. In the Reports tab, select the report and click theGenerate Report

button. Click the date-coded link for the report period you want to view. If no reports have
been generated, or if you want to create an updated report, click theGenerate button.
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Important
information

l Management reports do not support non-English labels.
l Indicator values are not displayed in SiteScope reports.
l When setting counters for Custommonitors with a string (not numeric) or using
browsable-basedmonitor counters that contain a string (not numeric) value, the
maximum and average values in theMeasurement Summary table are shown as 'n/a'.
This also occurs if you change the counter value type (for example, if you set the counter
with a numeric value, and later change it to a string value or visa versa).

l Since data for reports is taken from the daily log files (and it takes time for this data to be
written to the log file), theremight be a slight gap in this data being correctly represented
in reports. Therefore, we recommendwaiting about aminute between generating reports
with different Measurement Graph drop down values to avoid incorrect data being
displayed.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also l "New/Edit SiteScopeManagement Report Dialog Box" on page 1144
l "Reports Page" on page 1166

This section includes:

l "Report Content - Index Page" below
l "Report Content - Management Report Page" below

Report Content - Index Page
The following elements are included in theManagement report index page (unlabeled elements are shown in
angle brackets):

UI Element Description

<License
details>

License details are displayed at the bottom of the page. It includes the active license
edition, and a summary of the capacity types available, being used, and remaining.

Most Recent
Report

Click to display themost recent Management report available for the currently selected
monitor or group.

Information
For <report
time and data>

Click to display theManagement report for the time period specified in the link for the
currently selectedmonitor or group. For details on theManagement Report page, see
Report Content - Management Report Page.

Generate Click to create a new report for the currently selectedmonitor or group, regardless of
when the report was normally scheduled to be generated.

Report Content - Management Report Page
The following elements are included in theManagement report page (unlabeled elements are shown in angle
brackets):
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UI Element Description

Table Format Click the Table Format link to go to themeasurements data in table format in the
currently selected report.

Error List Click theError List link to go to the list of monitors with error status in the currently
selected report.

Warning List Click theWarning List link to go to the list of monitors with warning status in the
currently selected report.

Good List Click theGood List link to go to the list of monitors with good status in the currently
selected report.

Index of
Reports

Click the Index of Reports link to go to the index of Management reports. For details on
theManagement Report index page, see "Management Report" on page 1167.

Uptime
Summary

This table includes the following:

l Name. The name of monitors included in the report.
l Uptime %. The percentage of monitor readings reported as good.
l Warning %. The percentage of monitor readings reported as warning.
l Error %. The percentage of monitor readings reported as error.
l Last. The last reading of themonitor for the report period.

Measurement
Summary

This table includes the following:

l Name. The name of monitors included in the report.
l Measurement. The parameter beingmonitored (for error condition).
l Max. Themaximum value recorded for theMeasurement parameter during the report
period.

l Avg. The average value of the readings recorded for the report period.
l Last. The last reading of themonitor for the report period.
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UI Element Description

<Measurement
Graphs>

Measurement data in graph format for eachmonitored instance for the report period.

Bars highlighted in red or yellow indicate that themeasurement exceeded the error or
warning status threshold for themonitor; green indicates themeasurement was in good
status (below left).

If part of the bar is displayed in gray (below right), this shows themaximum value of the
measurement where the bar is an average value based on the aggregation of several data
samples. (This is configured using the Time between samples option in the
Calculation Method section of the New/Edit SiteScopeManagement Report dialog
box.) Graphs typically show raw data (without the gray bar) for short period reports
(where Time between samples is set to "Automatic time scale" and it is possible to
display raw data for the time range selected), and aggregated data for longer period
reports

Example:

<Measurement
Tables>

Measurement data in table format, shown at 30minute increments, for eachmonitored
instance for the report period. Entries highlighted in red or yellow indicate that the
measurement exceeded the error or warning status threshold for themonitor. Blue
indicates that themonitor was disabled.

<Error List
Table>

Lists themonitor instances that exceeded the error status threshold for themonitor.
Entries are highlighted in red.

<Warning List
Table>

Lists themonitor instances that exceeded the warning status threshold for themonitor.
Entries are highlighted in yellow.

<Good List
Table>

Lists themonitor instances that were in the good status threshold for themonitor. Entries
are highlighted in green.
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Quick Report
This report displays a summary and specific details of infrastructure availability and performance data for
monitors andmonitor groups over a given period of time. Quick reports are generated on an ad hoc basis and
are not saved to the SiteScope configuration data.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, amonitor
group, or amonitor container, and select Reports > Quick. Configure the report properties,
and click Generate Report.

Alternatively, you can create a report using preconfigured settings, by selecting amonitor

and clicking theQuick Report button in the SiteScope Dashboard toolbar.
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Important
information

l The time interval for a Quick report is not incremented automatically. This means that the
report always contains the data for the absoluteReport Period interval defined in the
report definition. To view more recent data using aQuick report, edit theReport Period
setting.

l Since data for reports is taken from the daily log files (and it takes time for this data to be
written to the log file), theremight be a slight gap in this data being correctly represented
in reports. Therefore, we recommendwaiting about aminute between generating reports
with different Measurement Graph drop down values to avoid incorrect data being
displayed.

l Whenworking in APM, Quick Report definitions in SAM Administration are stored only
with the APM context. Quick Report definitions are not stored in and do not persist on the
SiteScope server.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also "New SiteScopeQuick Report Dialog Box" on page 1151

Report Content
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<License
details>

License details are displayed at the bottom of the page. It includes the active license
edition, and a summary of the capacity types available, being used, and remaining.

Table Format Click to go to themeasurements data in table format in the currently selected report.

Error List Click to go to the list of monitors with error status in the currently selected report.

Warning List Click to go to the list of monitors with warning status in the currently selected report.

Good List Click to go to the list of monitors with good status in the currently selected report.

Uptime
Summary

This table includes the following:

l Name. The name of monitors included in the report.
l Uptime %. The percentage of monitor readings reported as good.
l Warning %. The percentage of monitor readings reported as warning.
l Error %. The percentage of monitor readings reported as error.
l Last. The last reading of themonitor for the report period.
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UI Element Description

Measurement
Summary

This table includes the following:

l Name. The name of monitors included in the report.
l Measurement. The parameter beingmonitored (for error condition).
l Max. Themaximum value recorded for theMeasurement parameter during the report
period.

l Avg. The average value of the readings recorded for the report period.
l Last. The last reading of themonitor for the report period.

<Measurement
Graphs>

Measurement data in graph format for eachmonitored instance for the period of the
report.

Bars highlighted in red or yellow indicate that themeasurement exceeded the error or
warning status threshold for themonitor; green indicates themeasurement was in good
status (below left).

If part of the bar is displayed in gray (below right), this shows themaximum value of the
measurement where the bar is an average value based on the aggregation of several data
samples. (This is configured using the Time between samples option in the
Calculation Method section of the New/Edit SiteScopeManagement Report dialog
box.) Graphs typically show raw data (without the gray bar) for short period reports
(where Time between samples is set to "Automatic time scale" and it is possible to
display raw data for the time range selected), and aggregated data for longer period
reports.

Example:
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UI Element Description

<Measurement
Tables>

Measurement data in table format, shown at 30minute increments, for eachmonitored
instance for the period of the report. Entries highlighted in red or yellow indicate that the
measurement exceeded the error or warning status threshold for themonitor. Blue
indicates that themonitor was disabled.

<Error List
Table>

Lists themonitor instances that exceeded the error status threshold for themonitor.
Entries are highlighted in red.

<Warning List
Table>

Lists themonitor instances that exceeded the warning status threshold for themonitor.
Entries are highlighted in yellow.

<Good List
Table>

Lists themonitor instances that were in the good status threshold for themonitor. Entries
are highlighted in green.

Monitor Summary Report
This report displays information about the configuration and current settings of monitors in the groups you
have selected to include in the report. Use this report to view setup information onmonitors as well as the
organization andmakeup of groups of monitors.

For example, you can check and comparemonitor run frequencies (the Frequency setting) if you are having
problems with monitor skips. For details onmonitor skips, see "SiteScope Server Health Monitors" on
page 989.

You can also use the report to check for monitor dependencies that can impact alerting. For details on
dependencies, see "Monitoring Group Dependencies" on page 221.
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To
access

Select theMonitors context. In themonitor tree, right-click the SiteScope node, amonitor
group, or amonitor container, and select Reports > Monitor. Configure the report settings, and
click theRun button to generate the report.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also "New SiteScopeMonitor Report Dialog Box" on page 1156

Report Content
User interface elements are described below:

UI Element Description

Monitor Title Display name for themonitor.

Monitor Type The type of monitor being displayed.

Group The group name to which themonitor belongs.

Frequency The frequency at which themonitor is set to run.

Depends on Lists any dependent monitors, if the running of this monitor is dependent on the status of
other monitors.

Points Points consumed by themonitor.

Note: This column is available for selection only if your SiteScope instance is on points-
based licensemodel.

URL Any URL beingmonitored.

Host The name of the remote server containing themonitored object.

Machine Machine name.

OID TheObject ID of the parameters beingmonitored.

Disabled Indicates whether themonitor is disabled.

Schedule Themonitor schedule, if a schedule other than the default schedule is selected.

Error
Frequency

If theError frequency option is selected, themonitoring interval, in seconds, for
monitors that have reported an error condition.

Timeout The timeout setting for themonitor.

Verify Error Displays On if theVerify error option is selected. This option automatically runs the
monitor again if it detects an error.

Report
Description

The text description for the report if entered in the report Description box.

Using SiteScope
Chapter 107: Create SiteScope Reports

HPE SiteScope (11.33) Page 1176 of 1206



UI Element Description

Monitor
Description

The text description for themonitor if entered in theMonitor Description box.

User Name User name if required for authentication.

Proxy Proxy server name, if used.

Thresholds The threshold conditions for themonitor instance.

Tags Search/filter tags assigned to amonitor.

Parameters List of property objects and their values which aremarked as parameters.

Report monitor
and related CI
topology

Indicates whether SiteScope reports monitor and related CI topology data to APM's
RTSM (Run-time ServiceModel).

Topology type Themonitor's topology that is used for reporting data to APM's RTSM. Typically, the
default CI type for themonitor is used (for most monitors, this is Computer).

Custom CI
type

CI type key attributes are displayed according to the CI type selected (only where the
non-default CI type for themonitor is selected).

Custom
Topology
Properties

Displays the key attribute values for the selected CI type:

l Name. Name of the CI (for BusinessApplication, BusinessService, Computer, DB2,
InfrastructureService, JBoss AS, Oracle, Oracle iAS, SQL Server, Sybase,
WebLogic AS, andWebSphere AS CI types).

l Server. Container CI for the selected CI. This attribute is required for DB2, JBoss
AS, Oracle, Oracle iAS, SQL Server, Sybase, WebLogic AS, WebSphere AS, and
Windows CI types.

l Organization Type. Identifier used to differentiate levels within an organization.
This attribute is required for BusinessApplication, BusinessService, and
InfrastructureService CI types.

l Organization Name. Name of the organization. This attribute is required for
BusinessApplication, BusinessService, and InfrastructureService CI types.

Send events Indicates whether SiteScope sends events to HPOM or Operations Management when
there is ametric status change for themonitor instance.

Report metrics
to agent

Indicates whether SiteScopereports metrics for themonitor instance to the Operations
Agent, from which HPOM andOperations Management can collect the data.

Event Mapping The template used for mapping SiteScope runtime data to the attribute values that are
used for sending events for themonitor instance.

BSM Service
Health affected
by

The preference (events or metrics) for influencing APM's Service Health when both
SiteScope events andmetrics are reported to Service Health (since indicators for
SiteScope events andmetrics both affect CIs).

Note: This field is empty when there is no integration with BSM.
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Alert Report
This report displays information about SiteScope alerts generated during a specified period of time for the
monitors in the selected container.

Important
information

When generating a report for amonitor, the report does not include alerts from parent groups
that target the selectedmonitor.

To access Select theMonitors context. In themonitor tree, right-click the SiteScope node, amonitor
group, or amonitor container, and select Reports > Alert. Configure the report settings, and
click theRun button to generate the report.

Relevant
tasks

"Create SiteScope Reports" on page 1139

See also "New SiteScope Alert Report Dialog Box" on page 1159

Report Content
User interface elements are described below:

UI
Element Description

Monitor The name of themonitor on which the alert was triggered.

Type The type of alert action (for example, Mailto, Sound).

Status The status of the alert (for example, Pass, Failed).

Message The type of message in the alert (for example, Default, alarm).

Date The date and time at which the alert was triggered.

Group The name of the group on which the alert was triggered.

Detail Displays detailed alert information for each alert in the report. This includes a full diagnostics
breakdown for each failed alert.
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Chapter 108: Create Server-Centric Reports
You can create a Server-Centric report for Microsoft Windows and UNIX Resources monitors, which displays
data from three different metrics about the remote server beingmonitored.

The report includes tables listing the top five processes by CPU utilization andmemory consumption. You
can navigate the graph and change the time of the data displayed in the tables. This enables you to focus in on
a problematic period in the graph to locate the processes running at that time.

To access
Select theMonitors context. In themonitor tree, right-click the selectedmonitor, group, or the SiteScope
root, and select Reports > Server-Centric.

Learn About
Server-Centric Reports Overview
The Server-Centric Report displays the followingmetrics on the same graph:

l CPU Utilization. For UNIX ResourceMonitors, this metric is calculated as an average of three counters:
system processing utilization, user processing utilization, and input/output processing utilization. For
Microsoft Windows Resources Monitors, themetric is calculated as processing capacity used out of total
processing capacity.

l Memory Utilization. Calculated as memory used out of total available memory.
l Network Utilization. Calculated by system-specific counters. Calculating network utilization is
supported only forWindows servers.

Eachmetric is displayed by a separate line of a unique color on the graph. The report enables you to easily
make a visible correlation between the different metrics.

Server-Centric Report Measurements
The following table displays the counters whichmust be selected when defining themonitor for the Server-
Centric report manually:

Operating System
Type (Platform) Server-Centric Mandatory Counters

Microsoft Windows
ResourceMonitor

Memory\% Committed Bytes In Use

Processor\_Total\% Processor Time
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Operating System
Type (Platform) Server-Centric Mandatory Counters

UNIX Resource
Monitor (on Solaris
platform)

CPU utilization\%sys

CPU utilization\%usr

CPU utilization\%wio

Memory\swap_avail

Memory\swap_resv

UNIX Resource
Monitor (on AIX
platform)

Processor\x\%sys

Processor\x\%usr

Processor\x\%wio

where x = 1, 2, 3...(all CPUs present on AIX)

Note: The average utilization is calculated based on the CPU entitled for each
VM. This matches the CPU utilization values as shown by the CPU monitor for
any AIX VM.

UNIX Resource
Monitor (on Linux
platform)

Memory\MemFree

Memory\MemTotal

Processor\Average\System

Processor\Average\User

Processor\Average\User low

Processor\Total\System

Processor\Total\User

Processor\Total\User low

Note: Themetric "Total" is required to save themonitor.

Tasks
How to Create a Server-Centric Report
This task describes the steps involved in creating amonitor to monitor yourWindows and UNIX server, and
generating a Server-Centric report.

1. Prerequisites
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To be able to generate Server-Centric reports, youmust be an administrator in SiteScope, or a user
granted theGenerate server centric report permission in User Management Preferences. For details on
user permissions, see "User Management Preferences" on page 625.

2. Create aMicrosoft Windows or UNIX Resources monitor
Tomonitor your Microsoft Windows or UNIX server, youmust create aMicrosoft Windows or UNIX
Resources monitor. You can create themonitor manually, or by using solution templates
(recommended).
l For details onmanually creating aMicrosoft Windows Resources or UNIX Resources monitor, see:

o Microsoft Windows Resources Monitor
o UNIX Resources Monitor

Note:When defining themonitor manually, youmust perform the following:

o Select Enable Server-Centric report in the requiredmonitor settings page.
o Select the requiredmetrics for themonitors, according to the table in "Server-Centric Report

Measurements" on page 1179.

l For details on creating amonitor using solution templates (this is recommended because the
templates contain all the requiredmeasurement counters, see:

o "Microsoft Windows Host Solution Template" on page 836
o "AIX Host Solution Template" on page 773
o "Linux Host Solution Template" on page 811
o "Solaris Host Solution Templates" on page 862

3. Generate the Server-Centric report
You can generate the report using either of the following:
l Navigate to the SiteScope Dashboard, display the data for the applicable Microsoft Windows or UNIX
Resources monitor, and click the server name in the Target column in the row that corresponds to
your resources monitor.

l In themonitor tree, right-click the selectedmonitor, group, or the SiteScope root, and select Reports
> Server-Centric. In the Server-Centric Report dialog box, select the remote target (Windows/UNIX
Resources monitor withEnable Server-Centric Report check box selected) for which you want to
generate a report, and click theRun button.

For user interface details, see "Server-Centric Report" on page 1184.
4. Analyze data in the report

The report enables you to view three different metrics of your server in the same graph – CPU utilization,
memory utilization, and network utilization. It also lists the top five processes by CPU utilization and
memory consumption. You can drill down to specific times by clicking a data point on the graph.

How to Create a Server-Centric Report – Use-Case Scenario
This use-case scenario describes how to create a Server-Centric report.

1. Background
David Foster, a SiteScope user at AcmeCompany, wants to create a report that provides data on CPU
utilization, memory utilization, and network utilization for amonitored server, Apollo.
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2. Configuring a remote server
Before he creates the report, David configures SiteScope tomonitor the remoteWindows server,
Apollo, and configures the server in Microsoft Windows Remote Servers.

3. Deploying aMicrosoft Windows Host solution template

After enabling SiteScope tomonitor data on Apollo, David deploys theMicrosoft Windows Host solution
template into the selected group container, and selects Apollo as the server to monitor. David uses the
solution templates when creating theMicrosoft Windows Resourcemonitor, because the required
monitors andmetrics for generating a Server-Centric report are already configured.

After David deploys the solution template, SiteScope creates a group named Windows monitors for
Apollo that contains theMicrosoft Windows Resources monitor.

4. Creating a Server-Centric report
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David generates the Server-Centric report for Apollo from the Current Status view of Service Health.

The Server-Centric report opens, displaying the CPU Utilization, Memory Utilization, and Network
Utilizationmetrics on the same graph. David can use this data to view the top processes by CPU
utilization andmemory consumption during different times, and focus in on problematic periods to locate
the processes running at that time.

Example:Measurement status and availability for amonitor
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UI Descriptions
Server-Centric Report
This report displays themetrics CPU utilization, memory utilization, and network utilization for a selected
server.

Important
information

l This report is available only on those servers beingmonitored by aMicrosoft Windows
Resources monitor or UNIX Resources monitor withEnable Server-Centric Report
selected.

l Wehighly recommend that you deploy thesemonitors using the applicable solution
templates for thesemonitors. The templates are pre-configured with the correct
measurement counters and options already selected.

l The Server-Centric report is not supported in Firefox 2.x.
l If a monitor encounters a problem and returns non-applicable data, that data point is
skipped. Thus, youmay seemissing data points in the graph.
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Report Settings
User interface elements are described below:

UI
Element Description

Filter/Collapse report filter. Click to display/hide the time range settings for the report.

Run. Creates a report for the date range displayed in the date links (Filter).

Format. Formats the report data to a file for exporting. Select the format for the file. The
options are printer-friendly, CSV, Excel, or XML.

Export. Exports the report data in an email. Select the option for sending the file. The options
are HTMLmail, HTML attachment, or PDF.

Note:

l To use the export functionality, youmust add the SiteScopemachine to the trusted sites.
l SiteScope is unable to export the report to email if themail server is defined to use SSL
SMTP (in the "Email Preferences Default Settings Dialog Box" on page 484).

Back. Displays the report one time frame earlier than the currently displayed time frame.

Example: If the value of theView box is Day, clicking this button displays data for one day
earlier than the currently displayed report.

Forward. Displays the report one time frame later than the currently displayed time frame.

Example: If the value of theView box is Day, clicking this button displays data for one day
later than the currently displayed report.

View Time range for which you want to view the report. Available time ranges include the following:

l Custom (enables you to configure any range)
l Hour, Day, Week
l Past hour, Past day, Past week

From/To
<date
links>

Click the From link to configure a start date and time for the report. Click the To link to
configure an end date and time for the report. The calendar contains the following buttons:

l OK. Updates the date link for the selected date and closes the calendar.
l Current. Selects today's date in the calendar.
l Cancel. Closes the calendar without making any changes.
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Report Content
User interface elements are described below:

UI Element Description

<Tooltip> Hold the pointer over any data point on the graph to display a tooltip showing the value at
the selected time of the utilization for the selectedmetric, as well as the date and time.

You can click on a data point in the graph to focus in on a shorter timer range. The data
tables are updated to show results for the time of the data point you selected (clicking any
of the three data points for the same time updates the report in the sameway).

You can return to the Server-Centric summary report using the breadcrumbs at the top of
the page.

Server name Name of the server appears above the Utilization graph.

Utilization
graph

Displays utilization over time. The different colored lines represent CPU utilization,
memory utilization, and network utilization. All threemetrics are scaled as percents (that
is, out of 100% utilization).

You can click on a data point in the graph to focus in on a shorter timer range. The data
tables are updated to show results for the time of the data point you selected (clicking any
of the three data points for the same time updates the report in the sameway). This is
useful when you notice a point with particularly high utilization. By clicking on the point,
you can determine the cause of the high utilization.

Note: Network utilization is supported forWindows servers only.

Top 5 CPU
Utilization
Processes
table

Displays the top five processes in terms of CPU utilization at any point in the graph. The
table displays the process name and the CPU utilization value as a percent of total
available CPU processing potential.

Top 5
Memory
Consumption
Processes
table

Displays the top five processes in terms of memory consumption at any point in the graph.
The table displays the process name and thememory consumption value in kilobytes.
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Part 15: Predictive Analytics
Predictive Analytics helps protect businesses from the impact of IT issues by predicting potential problems in
critical applications and informing you of issues that can affect the business flow. SiteScope uses baseline
and correlation calculations to analyze system problems and provide details to assist with root cause analysis
so that you can anticipate issues before business flows are impacted.

For details, see "Configure Predictive Analytics" on page 1188.



Chapter 109: Configure Predictive Analytics
Predictive Analytics enables SiteScope to anticipate potential problems on business monitors and alert users
of issues in critical applications before they occur. It uses a run-time analytics engine that can predict IT
problems by analyzing abnormal system behavior, and alerting IT managers of business flow degradation
before an issue impacts their business. It also uses a correlation calculation to identify similar trends between
system and business metrics around the time that the event occurred, and provides details to assist with root
cause analysis to help expedite problem resolution.

Tip: You can view a guided and narrated demonstration on how to anticipate potential problems in
applications using SiteScope Analytics on YouTube: http://hpsw.co/Ln5i6C9.

To access
Select theMonitors context. In themonitor tree, right-click the SiteScopemonitor for which you want to use
predictive analytics, and select Predictive Analytics > New Predictive Analytics.

Alternatively, select themonitor, click theAnalytics tab in the right pane, and then click New Predictive
Analytics.

Learn About
Definitions
Predictive Analytics relies on SiteScope's ability to monitor both business application transactions and the
infrastructure layer of the business IT environment.

l Source Monitor. This is themonitor you want to analyze. Typically, this would be a business or
applicationmonitor (such as URL, Database, or JMX) that is used tomonitor performance on your
business critical application. This is themonitor against whichmetrics from the selected target monitors
are correlated. By default, somemonitor types cannot be defined as the sourcemonitor for analytics.

l Target Monitors. Metrics from thesemonitors will be correlated with metrics from the sourcemonitor
around the time that an issue is detected in the business application, in order to identify similar trends and
to pinpoint the cause of the problem in the application. While these would typically be system
infrastructuremonitors (such as CPU, Ping, or Memory), any monitor type can be defined as a target for
the analytics calculation. By default, you can select up to 700 target monitors. You can increase (or
decrease) this value according to your system's hardware capacity inMaximum number of target
monitors in "Analytics Settings" on page 549.

Key Features of Predictive Analytics
SiteScope's Predictive Analytics offers the following key features:

l Anticipates potential IT problems before they occur - SiteScope detects behavioral changes
(anomalies) on the applicationmonitor metrics, and sends predictive alerts before a problem starts to
affect your business.

l Speeds up problem resolution by providing details to assist with root cause analysis - SiteScope
identifies the impact of system infrastructuremonitors on the business application and provides the details
beneficial to assist with root cause analysis based on this correlation in predictive alerts.
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l Prevents or reduces downtime - Potential issues are identified, and reported before their full effects are
felt in the IT systems. This gives you vital time to take action before IT systems and services are
impaired.

l Provides a new view displaying an impact tree - This is a filtered view within Multi-View that displays
the business monitor and its correlated target systemmonitors in a single view. This helps you to examine
more closely the impact of system infrastructuremonitors on the business application and to diagnose the
root cause of issues.

WhoCan Benefit from Predictive Analytics?

l Application Support Team - Reduces the time to resolve problems using root cause analysis
information. As soon as SiteScope detects an anomaly on the sourcemonitor (before the static threshold
is crossed), it provides details which can assist you to identify the cause of the problem.

l Monitoring Team - Provides enhanced services with proactive issue detection. It also enables the
SiteScope administrator to invest less time on applicationmonitoring configuration (defining static
thresholds), since applicationmonitor thresholds are automatically calculated and updated using a
baseline.

l Application Owner/Users - Provides an improved user experience to application owners and users.
Earlier problem detection helps make the applicationmore robust and stable.

Predictive Analytics - How it Works
Every time an end user performs an action on a business application, this impacts the application in some
way—for example, the application's business metrics might be inserted into a database or logged to a file.
Since SiteScope is able tomonitor business metrics (such as transaction count, round trip time) and system
metrics (such as CPU, freeMB), any time a user performs an action on the application, SiteScope analytics
can track the impact of system performance on the business application.

If SiteScope detects abnormal behavior in the application, it performs a correlation calculation to identify
similar trends between system and business metrics around the time that the event occurred, and sends this
information to users as a predictive alert. The alert contains the anomalies in the applicationmetrics (to help
users anticipate upcoming problems on themonitored business applications), and lists all correlated system
monitors that might be the cause of the problem in the application (to assist troubleshooting).
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Predictive Analytics Flow

Predictive Analytics uses the followingmechanism to anticipate, and notify you of potential problems in your
infrastructure, so that you can deal with them before they impact the business:

1. Calculates an analytics baseline for the business application monitor
When analytics is started, SiteScope collects metrics data from the business monitor over a period of
time. After enough data has been collected, SiteScope creates a baseline sleeve that determines
whether futuremetric values are normal.

2. Predictive Analysis stage: Anticipates potential problems before the static threshold is crossed
SiteScope uses the baseline calculation results (from the previous step) to predict upcoming problems. It
uses an algorithm that recognizes variations in business metrics, and allows for the detection and
forecast of abnormal events, performance, and availability issues. Because of this, SiteScopemight
warn you of an anomaly in a business metric that needs addressing, but is still not categorized as
requiring immediate attention, since that particular anomaly has no effect on the business application.
When an anomaly is identified, SiteScope triggers an alert that informs users of a potential issue in the
business application. This can provide an early warning of a critical event before the full impact is felt by
the business.
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When is the baseline calculation performed?
The baseline calculation is performed once a week only, using data collected during the previous month
(these settings are configurable inBaseline calculation frequency (milliseconds) andBaseline
calculation data period (milliseconds) in "Analytics Settings" on page 549).

Note: A minimum of 50monitor samples is required for the baseline calculation. If there are
insufficient metrics in the daily logs, SiteScope waits until enoughmetrics data has been
accumulated before it starts the first baseline calculation. If you change the baseline calculation
period, youmay also need to change theBaseline results aging period (milliseconds) (in
"Analytics Settings" on page 549) to enable the baseline calculation to be activated immediately
after the SiteScope restart.

3. Root Cause Analysis stage: Provides details to assist with the cause of the problem after the
analytics baseline is crossed
When an issue is detected in the business application (after applicationmetrics have crossed the
analytics baseline), SiteScope searches for a correlation between the applicationmonitor and system
monitors that you defined, and provides a list of all correlated systemmonitors that might be the cause of
the problem in the application. It uses a correlation algorithm to identify similar trends between system
and business metrics around the time that the event occurred. This is configurable in theCorrelation
data retention period (hours) setting in "Analytics Settings" on page 549.
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When is the correlation calculation performed?
The correlation calculation is first performed after analytics is configured, and an initial alert is sent after
the calculation has finished if Send alert when correlation calculation has finished is selected in the
Analytics Alerts panel.
Thereafter, the correlation calculation is performed when an analytics alert is triggered (each time the
business monitor crosses the analytics baseline), and when there is a change to the analytics target
monitor (for example, if a target monitor is added or removed from the analytics targets tree in the
Analytics tab).
How much data is included in the calculation?
The correlation calculation is performed on the last 10 hours of samples (configurable inCorrelation
data retention period (hours) in the "Analytics Settings" on page 549). New correlation calculation
results override previous correlation results.
How is the correlation calculated?
Metric correlations is calculated using an algorithm that searches for metrics whose values go up or
down at more or less the same rate and time. The linear correlation compares themetrics of the source
and target monitors, and finds parallels between different metrics for a specific time frame.
Metric correlations are calculated by comparing selected basemetrics from the business monitor with
metrics from the systemmonitors. Metric correlations can be viewed in the Correlations table in the
Analytics tab.
What samples are used in the correlation results?
The correlation results are calculated using all themetrics in the selectedmonitors area.
l The correlation calculation takes eachmetric for each business monitor, and performs the correlation
for 10metrics (first 10 lexicographically).

l For each of the abovemetrics amaximum of 25,000 scores will be computed (selected from the
respective target monitor metrics).

l In the alert email, up to 500 scores will be displayed for each of the 10metrics of the business
monitor. If there aremore than 500 scores per business metric, the ones with the highest value will be
selected.
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What correlation results are displayed in the Analytics tab and in the Analytics alert?
If the selected business monitor metric has crossed the analytics baseline, the correlation calculation
results are displayed. The Correlation table in the Analytics tab displays the correlation score per
monitor, while the alert provides more detailed results which show the correlation score per metric.
Only target metrics that have a correlation score above theCorrelation score threshold (%) (by
default, 60%) are considered correlated, and are displayed in the Analytics tab and in the analytics alert.
Metrics with a score lower than this value are not considered correlated, and are excluded from the
results. This setting can bemodified in "Analytics Settings" on page 549.

Example: Correlation calculation results in the Analytics tab
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Example: Analytics alert triggered by the business applicationmonitor crossing the analytics
baseline

Automatic Detection
SiteScope periodically receives data from samples that monitor the business application.

SiteScope detects anomalies and sends predictive alerts based on the following:

l Metrics. A metric represents the time/value combinations provided for a specific field in a sample. When
analytics is started, SiteScope collects metric data from incoming samples over a period of time.

l Metrics Baseline Sleeve. After sufficient metric data has been collected, SiteScope creates a baseline
for themetric and calculates themean and standard deviation. Themean and standard deviation values
are used to create the baseline sleeve which determines whether futuremetric values are considered
normal. By default, the baseline sleeve is calculated using a coefficient of + or - 3 times the standard
deviation from ametric's mean value.
Once the baseline sleeve for ametric is created, ametric is considered to be abnormal if its value is higher
or lower than themean value, plus or minus themetric's standard deviationmultiplied by the coefficient.

Note: Since SiteScope Analytics is based onmathematical and statistical algorithms, this might
result in encounteringmathematical skews. You should take this into consideration and test your
Analytics alerts to find themost suitable sleeve coefficient for your business monitors.
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Automatic Tagging
Tags are used to enable filtering of the sourcemonitor and its target monitors, so that thesemonitors can be
displayed in a single Impact view in SiteScope's Multi-View, and within themonitor tree filter (when filtering by
tags).

SiteScope automatically generates an analytics tag value for each analytics configuration and assigns it to
the sourcemonitor. If the sourcemonitor encounters a problem and an analytics alert is triggered, SiteScope
takes this tag and assigns it to the target monitors that are considered correlated (where the correlation score
is higher than 60%). The tag value is in the format analytics_<monitor_name>, followed by a number in
parenthesis if there is more than onemonitor with the same name.

When an analytics alert is triggered (and theAnalyticsMail template is used), the email alert contains a link to
Multi-View, filtered to include the sourcemonitor and its correlated target systemmonitors only. For details,
see "Multi-View" on page 936.

You can alsomanually create custom tags for source and target monitors, and then assign them as required in
order to display monitors grouped by this custom tag inMulti-View. For details, see "How toManually Assign
Tags to Analytics Monitors" on page 1200.

Understanding Analytics Alerts
When is an analytics alert triggered?

1. The first time analytics is configured for amonitor.
A dummy alert is sent after the initial correlation calculation has finished (providedSend alert when
correlation calculation has finished is selected in the Analytics Alerts panel).

2. When a business applicationmonitor crosses the analytics baseline.
If SiteScope detects behavioral changes (anomalies) on the applicationmonitor metrics, it sends
predictive alerts about potential issues before a problem starts to affect the business (provided the Alert
status trigger setting is set toAnalytics). This occurs before the business applicationmonitor crosses
the static threshold.

3. When a business applicationmonitor crosses the static threshold.
If the Alert status trigger setting is set toGood/Warning/Error, an alert is triggered after the business
applicationmonitor crosses the static threshold and the status changes to the selected trigger status.

Analytics Alert Details

Tip: For an example of an Analytics alert, see "What correlation results are displayed in the Analytics tab
and in the Analytics alert?" in "Predictive Analytics - How it Works" on page 1189.

The Analytics email alert provides a summary of analytics results, which includes the following:

l Analyzedmonitor details. This includes the name and description of the analyzed (source) monitor, the
analyzedmonitor type, a list of themost recent measurement results reported by themonitor, and the date
and time of the last monitor run.

l Alert reason. Reason for the alert being sent (one of the three reasons listed above).
l Links to Impact View. This is a filtered view that displays only the analyzedmonitor and its target monitors
in a single view, enabling you tomore easily analyze and diagnose the root cause of the event. For task
details, see "How to Diagnose and Troubleshoot Problems" on page 1199.

l Status. This is the status of all metrics on the analyzedmonitor (according to which alert type was
triggered).
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l For an alert triggered by Analytics (analytics baseline was crossed), displays analyzedmonitor metrics
which are out of the baseline sleeve.

l For an alert triggered by a static threshold, displays analyzedmonitor metrics that are in the status for
which the alert was triggered.

l Highest correlation scores. Contains up to 500 best-fitting correlation scores for each analyzedmonitor
metric. The correlation score represents a percentage value above which a correlation result is considered
correlated. The score determines what results are displayed in the analytics alert. Metrics with a score
lower than this value are not considered correlated, and are excluded from the results. For details on the
correlation calculation, see "What samples are used in the correlation results?" in "Predictive Analytics -
How it Works" on page 1189.

Note: To benefit from analytics alerts, the alert action type, template, and status trigger settings must be
configured as described in "How to Configure Predictive Analytics" on the next page.

If you selected any trigger status other thanAnalytics, an alert is triggered only when the status changes
to the selected status.

Diagnose and Troubleshoot Issues from Impact View
You can view the impact of the correlation calculation for an analyzedmonitor in Impact View. This is a filtered
view within Multi-View that displays the business monitor and its correlated target systemmonitors in a single
view.

You can perform the following to diagnose and troubleshoot problems:

l You can drill down on amonitor to view more detailed information, enabling you to focus only on those
monitors you want to view.

l Examine the behavior of an abnormal metric. For example different metrics might exhibit abnormal
behavior at about the same time, indicating that the abnormal metrics are symptoms of the same problem.
Other metrics might be connected logically, for example they may be part of the same data collector,
application, or location.

l Examinemore closely the correlation between different metrics. Close correlation results between base
metrics and selectedmetrics, might indicate that the selectedmetric is an additional symptom of the same
problem, or it might be ametric that you should investigate further to find the root cause of the problem.

For task details, see "How to Diagnose and Troubleshoot Problems" on page 1199.

Note: Because an analytics alert is a predictive alert that is triggered even though the business monitor
did not cross the static thresholds, the business monitor can be displayed in green (OK) status while its
correlated systemmonitors are in red (error) status.

Example:Predictive alert showing the CPU monitor in error before the business applicationmonitor has
crossed the static threshold.
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Performance Impact of Predictive Analytics
l It supports analyzing and tracking of up to 100 business monitors, with correlation of 700 systemmonitors
for each business monitor.

l It has no impact on CPU or network resources.
l It uses less than 5% on disk throughput consumption, and less than 100MB memory consumption.

Tasks
How to Configure Predictive Analytics

Tip: You can view a guided and narrated demonstration on how to anticipate potential problems in
applications using SiteScope Analytics on YouTube - http://hpsw.co/Ln5i6C9.

This task describes the steps involved in configuring predictive analytics.

1. Prerequisites
l Make sure you have the necessary permissions for viewing groups andmonitors and performing
actions on them. To add or edit analytics and analytics alerts, youmust have edit monitor permissions
for the selected sourcemonitor. For details on user permissions, see "Permissions" on page 636.

l Configure amonitor to monitor your business application. For details on configuring amonitor, see
"How to Create and Deploy aMonitor" on page 226.

2. Select themonitor to be analyzed
a. In themonitor tree, right-click themonitor you want to analyze, and select Predictive Analytics >

New Predictive Analytics. The New Predictive Analytics dialog box opens.
b. In the General Settings panel, enter the name that describes themonitor being analyzed, or use the
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default name (Analytics for monitor:<monitor name>). Enter a description for themonitor being
analyzed if required.

3. Select the target monitors
In the Analytics Targets panel, select the target monitors or groups (typically, system infrastructure
monitors). Metrics from the target monitors will be correlated with metrics from the sourcemonitor around
the time that an issue is detected in the business application, in order to identify similar trends which can
help pinpoint the cause of the problem in the application.

4. Define analytics alerts
In the Analytics Alerts panel, configure an alert that will be invoked each timemetrics from the source
monitor cross the analytics threshold. This includes selecting the type of alert action and the settings for
the type of alert being sent.

Note: Youmust configure at least one alert for eachmonitor being analyzed.

a. In the Analytics Alerts panel, click New Alert . The New Alert dialog box opens.

b. In the Alert Actions panel, click New Alert Action , and select an alert action type.
We recommend using theEmail alert action type because it uses a customized analytics template
that provides details to assist with root cause analysis for sourcemonitors that cross the threshold.

c. Enter the required settings in the Action Type Settings panel. For details, see "Action Type Settings
Panel" on page 1102.
If you selected the Email alert action, we recommend using theAnalyticsMail template (selected by
default). The analytics email alert includes the following details to assist with root cause analysis for
sourcemonitors that cross the threshold:
o A link to the correlated systemmonitors.
o Correlation score (percentage).
o A list of the systemmonitors that crossed their baseline.

d. In the Status Trigger panel, use theAnalytics option for triggering predictive alerts (selected by
default). When this option is selected, an email alert is sent every time the baseline of the business
monitor is crossed. For details on the Analytics email alert, see "Understanding Analytics Alerts" on
page 1195.

Note: If you select one of the other statuses (Unavailable/Error/Warning/Good), an alert is
sent according to the static threshold and the alert action configuration in Trigger Frequency
settings.

e. In the Trigger Frequency panel, configure the trigger settings that determine when the alert is
triggered and when it is sent.
For details, see "Trigger Frequency Panel" on page 1115.

f. Click OK to save the alert action settings, and then click OK to save the new alert settings.
g. You can test the analytics alert by selecting the alert in the Alert Actions panel, and clicking the Test

button. A dialog box opens with information about the alert test.

Note: Themonitor you select does not have to be reporting the same status category that is
selected to trigger the alert to test the alert. For example, themonitor does not have to currently
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be reporting that the analytics threshold has been crossed to test an alert that is triggered by
analytics conditions.

5. Define analytics tags - Optional
SiteScope automatically generates an analytics tag value for each analytics configuration which it
assigns to the business monitor. This tag enables the analytics email alert to include a link toMulti-
View, filtered to include the relevant business monitor's tag.
You can alsomanually create a custom tag and assign it to different sourcemonitors. This enables you
to display multiple sourcemonitors grouped by this custom tag inMulti-View. For details, see "How to
Manually Assign Tags to Analytics Monitors" on the next page.

6. Save the analytics settings
Click Save to save the settings and start the analytics mechanism.
When the calculation is finished, an initial alert is sent if Send alert when correlation calculation has
finished is selected in the Analytics Alerts panel. In the Correlation table, you can see systemmonitor
metrics that are correlated to the business monitor. You can see a correlation value (%) for each system
monitor. For details, see "Analytics Tab / New Predictive Analytics Dialog Box" on page 1201.

How to Diagnose and Troubleshoot Problems
1. Analyze information in the analytics alert

When business applicationmonitor metrics cross the static or analytics threshold, an alert is triggered.
Analyze the information in the alert (according to which threshold was crossed).
l For an alert triggered by business monitor metrics crossing the static threshold, the alert displays all
themetrics that are in the status for which the alert was triggered. For example, all metrics whose
status changed to error.

l For an alert triggered by business monitor metrics crossing the analytics baseline, the alert displays
all business metrics that crossed the analytics baseline threshold. This includes themetric name,
metric value, and themetric's upper and lower baseline band.

l Highest correlation scores. Contains up to 500 best-fitting correlation scores for each analyzed
(source) monitor metric. The correlation score represents a percentage value above which a
correlation result is considered correlated. The higher the score, the closer the correlation. This helps
to identify the impact of system infrastructuremonitors on the business application and provides the
details beneficial to assist with root cause analysis.

For a description of the information contained in the alert, see "Understanding Analytics Alerts" on
page 1195.

2. Diagnose the root cause of problems using Impact View
a. Open Impact View

Click the link in the analytics alert to open Impact View. This is a filtered view within Multi-View that
displays the business monitor and its correlated target systemmonitors.

b. Identify themetrics in error

Place the cursor over amonitor which you want to view or troubleshoot, and click the information
icon to open theMonitor Details dialog box. Click theMetrics tab to view the list of monitor metrics
with error or warning status.
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c. Rerun themonitor to check if the problem still exists
In the Group/Monitor Details dialog box, click Run Now to verify the problem still exists. This action
reruns themonitor or themonitors in group.

d. Generate a report to view performance and availability over time
In the Details tab, click Generate Report to generate a report for the group/monitor. You can use this
report to help determine the nature of the problem, and to see how long the group or monitor has been
in error.

e. Disable themonitor or alerts to prevent additional notifications being triggered
Depending on the diagnosis, you can disable themonitor or monitors in group, or disable alerts
associated with themonitor or group and continue to use themonitor.
To assist in troubleshooting, you can check the alert history for themonitor to determine whether this
is a reoccurring issue (all associated alerts are displayed in the alerts section).

Note: The triggered alerts table is only displayed for users that have permissions to view alerts.
For details on user permissions, see "Permissions" on page 636.

f. Add an acknowledgment to track resolution of the problem

After reviewing the alerts, you can click theAdd Acknowledgment button and add a comment
acknowledging themonitor status. The acknowledgment comment is displayed (after refreshing the
view) as a tooltip associated with the acknowledgment icon in the SiteScope Dashboard view, and is
recorded in the Acknowledge Log.

Note: Acknowledgments can only be deleted from the Acknowledge Log (available from the
AcknowledgeMonitors In Group dialog box in the SiteScope Dashboard). Deleted
acknowledgments are not displayed in the Acknowledgments list in Multi-View.

g. Drill down to group or monitor properties
To investigate the issue further, click Drill Down to Group/Monitor Properties to open the group
or monitor in Manage view in the Unified Console. For details, see "Manage View" on page 955.

How to Fine Tune Analytics Settings
You canmodify the default analytics baseline and correlation calculation settings inPreferences >
Infrastructure Preferences > Analytics Settings. For details, see "Analytics Settings" on page 549.

Tip: For optimal SiteScope performance, we recommend that you use the default settings. If you are
unsure of the settings to use, contact SiteScope customer support.

How to Manually Assign Tags to Analytics Monitors

Note: SiteScope automatically generates an analytics tag value for each analytics configuration which it
assigns to the business monitor. For details, see "Automatic Tagging" on page 1195.

You canmanually create custom tags for business and systemmonitors. Tags are used to enable viewing the
business monitor and its correlated target systemmonitors in a single view in SiteScopeMulti-View, and for
filtering themonitor tree by tag filter. For details, see "Multi-View" on page 936 and "Filter Objects in the
SiteScope View" on page 65.
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For example, you could define a tag called Analytics with the possible values of Business monitors,
System monitors, and Application monitors, and then assign them as required in order to display
monitors grouped by this custom tag inMulti-View. For details, see "How to Assign Custom Search/Filter
Tags and View Monitors in the Tags View" on page 942.

In addition, you can create a new tag in the Analytics tab and this tag will automatically be assigned to the
correlatedmonitors once correlation is triggered.

How to Remove Predictive Analytics from a Source Monitor
To delete predictive analytics for amonitor, right-click themonitor in themonitor tree, and select Predictive
Analytics > Delete Predictive Analytics.

When deleting predictive analytics from a sourcemonitor, all related objects are delete. This includes
correlation and baseline objects, analytics alerts associated with themonitor, and analytics tags on the
source and target monitors.

UI Descriptions
Analytics Tab / New Predictive Analytics Dialog Box
The New Predictive Analytics dialog box enables you to add, edit, or delete analytics for amonitor.

The Analytics tab enables you to add or edit analytics definitions, and displays analytics settings that have
been configured for themonitor instance. It also displays correlation results which identify similar trends
between the source and target monitor metrics that can assist with root cause analysis.

User interface elements are described below:

UI Element Description

Correlation Results

(Not available in the New Predictive Analytics dialog box)

Opens the New Predictive Analytics dialog box, enabling you to configure analytics
for the selectedmonitor. (All settings in the New Predictive Analytics dialog box are
described in this table.)

Note:

l This button is not displayed if analytics has been configured for themonitor.
l This button is grayed out if analytics has been disabled, or if themonitor is of a
type excluded for analytics (configurable inExcluded monitor types in
"Analytics Settings" on page 549).

This Monitor's
Metric

Lists metrics from the business monitor. Select themetric for which you want to see
correlation results in the Correlation table.
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UI Element Description

Correlation Results

(Not available in the New Predictive Analytics dialog box)

Correlation table Displays correlation results above the configured threshold if a correlation was found
for the selectedmetric. This information helps to identify the impact of system
infrastructuremonitors on the business application and provides the details beneficial
to assist with root cause analysis.

The correlation calculation is first performed after analytics are configured. Thereafter,
it is calculated each time the business monitor crosses the baseline, and when there
is a change to the analytics target. If the selected business monitor metric has not
crossed the baseline threshold, no correlation results are displayed.

If the selected business monitor metric has crossed the baseline threshold, the
correlation calculation results for that business metric are displayed. Only target
metrics that have a correlation score above theCorrelation score threshold (%)
(configured in "Analytics Settings" on page 549) are displayed here. Metrics with a
score lower than this value are not considered correlated, and are excluded from the
results.

l Target Monitor. Displays a list of metrics from the target systemmonitors that
are correlated to the selected business monitor metric that have a correlation
score above the correlation threshold score.

l Correlation Score. The result is displayed as a correlation percentage value for
the highest metric score in granularity from the target monitor; it does not display a
metric for each target metric as it does in the alert.

The panel displays the last time that the correlation results were calculated.

Note: This table is only displayed when analytics is configured. Results are displayed
after the required number of hours of historical data has been collected (configurable
inCorrelation calculation data retention period (hours) in "Analytics Settings" on
page 549).

General Settings

Analytics name Name that describes themonitor being analyzed. Use a useful naming convention for
all monitors to make creating view filters more effective.

Default value: SiteScope creates a default name in the format:

Analytics for monitor:<monitor name>.

Analytics
description

Description of themonitor being analytics (if required). This description does not
appear in any other context. It appears only when editing the analytics properties.

Analytics Targets
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UI Element Description

Correlation Results

(Not available in the New Predictive Analytics dialog box)

Select Monitors Click to open the Select Monitors Form, and select the target systemmonitors or
monitor groups to be analyzed. Metrics from the target monitors will be correlated with
metrics from the business applicationmonitor around the time that an issue is
detected in the business application, in order to identify similar trends, and to help
pinpoint the cause of the problem in the application.

The Targets list includes all groups andmonitors (except Health monitors and the
monitor instance selected for analytics) configured for the SiteScope.

After making a selection, the target monitors and groups are displayed witha in the
Analysis Targets list.

Use the following in the Select Monitors Form to find and select the systemmonitors
to be analyzed:

Collapse All. Collapses all branches in the tree.

Expand All. Expands all branches in the tree.

Select All. Selects all listedmonitors

Clear Selection. Clears the selection.

Quick Search. Enables you to search for monitors by name or that contain a
specific value that you enter in this field. For details, see "Quick Search" on page 64.

Selected
monitors

Displays tree of all target monitors that have been selected for analysis.

The total number of selected targets is displayed beneath the tree (maximum 700
counters).

Default value:None selected.

Analytics Alerts

Send alert when
correlation
calculation has
finished

Sends an email alert to notify you that the first correlation calculation has finished.

Default value:Not selected

<Alerts
associated with
monitor>

Lists all the analytics alerts associated with this monitor.

New Alert Action. Opens the Action Type dialog box enabling you to define an action
to be done when an alert is triggered. For user interface details, see "Action Type
Dialog Box" on page 1099.
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UI Element Description

Correlation Results

(Not available in the New Predictive Analytics dialog box)

Edit Alert Action. Opens the Action Type dialog box enabling you to edit the alert
action. For user interface details, see "Action Type Dialog Box" on page 1099.

Delete Alert Action. Deletes the alert action. It does not disable the associated
monitors.

Enable. Enables the alert associated with themonitor.

Disable. Disables the alert associated with themonitor.

Test. Tests the alert definition on a selected server.

Select All. Selects all listed alerts.

Clear Selection. Clears the selection.

Name The name by which the alert is known in SiteScope.

Status The enabled/disabled status of the alert.

Description A description of the alert.

Action Name The name given to the alert action in the "Action Type Dialog Box" on page 1099.

Analytics Tags

Analytics Auto
Tags

Tagging enables monitors grouped by the same tag to be displayed in a single Impact
View in SiteScope's Multi-View.

SiteScope automatically generates an analytics tag value for each analytics
configuration and assigns to the sourcemonitor. If the sourcemonitor encounters a
problem and an analytics alert is triggered, SiteScope takes this tag and assigns it to
the target monitors. The tag value is in the format analytics_<monitor_name>,
followed by a number in parenthesis if there is more than onemonitor with the same
name.

In addition to using the a Analytics Auto Tag, you can create and assign additional tag
values to a sourcemonitor, so that you can display only themonitors to which these
tags or tag values have been assigned. For details on creating custom tags, see
"How to Assign Custom Search/Filter Tags and View Monitors in the Tags View" on
page 942.

Add Tag Opens the New Tag dialog box, enabling you to add new keyword tags. The tag that is
manually created in the Analytics tab is dynamically assigned to business and
system (correlated) monitors every time correlation is calculated.

For user interface details, see "Search/Filter Tags" on page 614.

Using SiteScope
Chapter 109: Configure Predictive Analytics

HPE SiteScope (11.33) Page 1204 of 1206



Tips/Troubleshooting
Notes and Limitations
l Settings in the Analytics tab are grayed out if analytics have not been configured for themonitor instance.
l Settings in the Analytics tab are unavailable if:

l TheAnalytics enabled setting has been disabled in Infrastructure Preferences > Analytics
Settings. (Analytics are enabled by default.)

l The selectedmonitor is listed as an excludedmonitor type in Infrastructure Preferences > Analytics
Settings > Excluded monitor types list.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an email
client is configured on this system, click the link above and an email window opens with the following
information in the subject line:

Feedback on Using SiteScope (SiteScope 11.33)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and send
your feedback to sitescope-doc-feedback@hpe.com.

We appreciate your feedback!
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